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Get Started
Overview
Get Started with
Application Intelligence
Platform
Release Notes
Supported
Environments and
Versions
Install and Upgrade
Architecture and Model
User Interface

Monitor and Measure
Applications
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Mobile EUEM
Infrastructure
Service Endpoints

Documentation by
Platform

Instrument Your App
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Java

PHP

Mac
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Web
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Troubleshoot and
Resolve
Troubleshooting
Techniques
Slow Response Times
Errors
Health Rule Violations
Mobile Applications

Analyze and Improve

Alert and Respond
Policies
Health Rules
Actions

Administer the
Platform
Administer the
Controller
Administer Agents

Extend and Integrate
Use the REST API
Add Metrics with a
Monitoring Extension
AppDynamics for
Databases

Operational Metrics
Business Metrics
Metric Browser

What's New in 3.9.0
New Node.js App
Agent
Updated flow maps
New dashboard
templates
For more new features
see Platform Release
Notes

Learn more by
watching:
<p> </p>
Application Intelligence: A
Quick Tour
<p> </p>
What is a Health Rule?
More videos...
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Popular Pages
Install and Upgrade
Controller System
Requirements
Install the Java Agent
Get Started with
Application Intelligence
Platform
Use the AppDynamics
REST API
Configure Web PHP
Entry Points

Search the 3.9
Documentation

Don't Have
AppDynamics?
Get the Download...

More Resources
Education
Community

Application Intelligence Platform
The AppDynamics Application Intelligence Platform provides application performance
management for modern application architectures. Designed for distributed SOA
environments, AppDynamics Application Intelligence Platform helps you to manage service
levels, reduce mean-time-to-repair for problems, plan for application efficiency, and automate
typical life-cycle actions for distributed applications.

The AppDynamics Application Intelligence Platform eliminates blind spots by enabling your
business to see everything in its application environment, act with certainty based on this view
and then know—faster—how application performance is affecting your business.
AppDynamics delivers the application intelligence you need to deliver the application performance
your users demand by:
Collecting data

Instrumentation: Watch every line of code
Distributed transaction tracing: Follow the business transaction across all tiers of the
application
Transaction auto-learning engine: Inspect execution code, payload, libraries and
methods
Real-time service discovery: Map architecture topology and service dependencies
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Smart agents: Filter and transfer data to the management server
Processing data

Real-time stream processing: Process complex metric and event streams
Behavioral learning engine. Continuously adjust dynamic baselines
Acquiring knowledge

Intuitive UI: simple and easy to use for dev, ops and business users
Dynamic transaction flow maps: visual representation of the application topology
Multi-dimensional drill down: cross-correlated drill down in the UI
Real-time business metrics (RTBM): real-time correlation of performance metrics and
business metrics
Compare releases: performance regression analysis for agile releases
Custom dashboards: drag-and-drop HTML5 dashboards
AppDynamics offers an extensible platform including:
Monitoring extensions: Integrate metrics from other monitoring systems and services
including databases, LDAP servers, web servers and more.
Alerting extensions: Create custom notifications to integrate AppDynamics health rule
violations and events with your alerting or ticketing system.
Cloud auto-scaling extensions: Integrate cloud orchestration functionality such as
creating, destroying, restarting, configuring and validating machine and image instances.
REST API extensions: Retrieve data from your AppDynamics system, including application
and infrastructure metadata, metrics, events and transaction snapshots.

For details about the Platform and its modules see the following documentation:
Platform

Expand all Collapse all

End User Experience
Management

Application Performance
Management

Expand all Collapse all

Expand all Collapse all

Server Monitoring

Expand all Collapse all

Database Monitoring

Expand all Collapse all

Get Started with Application Intelligence Platform
Your First Installation
You have access to a Controller
and know its URL

Log in to the Controller and
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You need a Controller

Sign up and get a free trial
account.

What is a Controller? What is an
Agent?

Architecture
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click the Agent Download
Wizard tab.
Download and install the
agents that correspond to
your application
environment.

Logical Model
Get the Download...

Quick Overview Handout
Decide whether you will
AppDynamics Quick
use an on-premise or Sa
Overview 11x17 PDF for
aS Controller. For
11x17 tabloid printing, booklet
information about the style
different approaches, see
AppDynamics Quick
Differences when usingOverview 8 1/2 x 11 PDF for
a SaaS Controller.
letter printing, page style

See Get Started with
AppDynamics SaaS or Get
Started with AppDynamics
On-Premise.

Next Steps
Operators

Developers

Administrators

Quick Start for Operators

Quick Start for Developers

Quick Start for Administrators

Get Started with AppDynamics SaaS
Follow these steps to get started with AppDynamics.
If you are reading a PDF of this
document, use your Help Center
login to access the
documentation at http://docs.ap
pdynamics.com.

Expert Advice
Deploying APM in the Enterprise... the Path of
the Rock Star
By Jim Hirschauer

Get Your SaaS Account
Information from
AppDynamics
Design Your AppDynamics Deployment
Download and Install the AppDynamics App and Machine Agents
Download and Install the AppDynamics Web and Mobile Agents
SaaS Login Credentials
Connecting Agents to Your SaaS Controller Service
Access the AppDynamics UI from a Browser
Review the Dashboards and Flow Maps
Review Defaults and Configure Business Transactions, if Needed
Review Defaults and Configure Client-Side Monitoring, if Needed
Review Defaults and Configure Databases and Remote Services, if Needed
Review Default Heath Rules and Set Up Policies
Review Default Error Detection
Explore Additional Data and Metric Features

Copyright © AppDynamics 2012-2014

Page 13

Configure Advanced Features
Start Monitoring and Troubleshooting
Questions?
Get Your SaaS Account Information from AppDynamics

After signing up for AppDynamics SaaS, you receive a Welcome email containing important
account information, including the Account Owner login. Save this information.
Design Your AppDynamics Deployment

Learn about Monitor Business Transactions and identify which critical business transactions
you want to monitor.
Learn about how to map your application components to the AppDynamics business
application, tier, and node model. See Logical Model and Name Business Applications,
Tiers, and Nodes.
Based on the model, plan how you will specify AppDynamics application, tier, and node
names during installation.
Decide whether you want to monitor client-side usage with End User Experience
Management.
For Java environments, decide whether you want to use object instance tracking.
Download and Install the AppDynamics App and Machine Agents

Download the AppDynamics application agents from the Download Center. AppDynamics app
agents collect data from your application servers and other monitored systems and report to the
Controller. Select the agents that are appropriate for your environment:
App Agent for Java
App Agent for .NET
App Agent for PHP
App Agent for Node.js
Standalone Machine Agent
See Download AppDynamics Software.
Follow the instructions to install the AppDynamics Agents.
Download and Install the AppDynamics Web and Mobile Agents

Install the client-side agents in your mobile applications and web pages. See instructions for
mobile and web.
SaaS Login Credentials

SaaS Controller login credentials are included in the welcome email from AppDynamics.
To add additional login accounts contact the AppDynamics Support Team.
The SaaS Controller login is an Account Administrator credential. The Account Administrator can
create other users for the account. See Account Administrator.
Connecting Agents to Your SaaS Controller Service

For agents to successfully connect to the Controller, configure the Controller host and port
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information using either the controller-info.xml file or the system properties of your JVM startup
script.
To use HTTPS communication, enable SSL by setting the <controller-ssl-enabled> agent
configuration property to "True". For details see App Agent for Java Configuration Properties, .NET
Agent Configuration Properties, and Standalone Machine Agent Configuration Properties.
The default ports for the SaaS Controller service are:
Port 80 for HTTP
Port 443 for HTTPS
If you need to specifically open up the communication ports (80 or 443) for the AppDynamics
SaaS Controller IP address please request the IPs from the AppDynamics Support Team.
Access the AppDynamics UI from a Browser

Once you have installed the agents, launch your web browser and connect to the AppDynamics
User Interface (UI). For SaaS, the URL includes the account name from the Welcome email:
http://<account-name>.saas.appdynamics.com/controller

When using SSL, use port 443 or https to access the Controller.
Review the Dashboards and Flow Maps

AppDynamics automatically discovers the Business Transactions in your application environment.
Browse the Application Dashboard and see the Flow Maps to visualize your application. You can
resize and move icons around on the flow maps.
Review Defaults and Configure Business Transactions, if Needed

The default configurations may need to be further customized for your environment. For example,
AppDynamics may have discovered transactions that you want to group together or even exclude,
because you want to concentrate on the most important transactions. There may be business
transactions that are not yet discovered for which you need to configure detection rules. See:
Monitor Business Transactions
Configure Business Transaction Detection
Review Defaults and Configure Client-Side Monitoring, if Needed

End User Experience Monitoring (EUM) provides performance information from the point of view of
the client, whether that client is a web browser or a mobile native application. See:
End User Experience Management
Set Up and Configure Mobile EUEM
Set Up and Configure Web EUM
Review Defaults and Configure Databases and Remote Services, if Needed

AppDynamics automatically discovers "backends" such as databases, message queues, etc. by
following calls in the Java or .NET code. Look at the databases and remote services dashboards
to make sure all necessary backends are revealed. If needed, configure how backends are
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detected.
Review Default Heath Rules and Set Up Policies

AppDynamics provides default Health Rules that define performance parameters for business
transactions, such as the conditions that indicate a slow transaction, or when too much memory is
being used. You can adjust the thresholds that define when a health rule is violated, create new
health rules, and set up policies to specify actions to automate when health rules are violated.
Review Default Error Detection

AppDynamics detects errors and exceptions. You can review and, if needed, modify the error
detection rules. For example, some errors you may want to ignore.
Explore Additional Data and Metric Features

Explore these features to gain more insight into application performance:
Detect Problems Caused by Application Data
Business Metrics
(for Java environments) JMX Metrics
Machine Agent Custom Metrics
Service Endpoints (Java only)
Configure Advanced Features

Additional features you may want to use include:
Visualize Performance Using Custom Dashboards
Automation
Extensions and Integrations
Start Monitoring and Troubleshooting

Start getting the benefits of AppDynamics! See:
AppDynamics in Action Videos
AppDynamics Features
Questions?

For questions about using AppDynamics contact the AppDynamics Support Team.
Use a SaaS Controller
Your SaaS Controller URL
Login Credentials
Connecting Agents to Your SaaS Controller Service
SMTP Service for SaaS
Contact Support
If you are using the SaaS service for the AppDynamics Controller, simply open a web browser at
the URL of the AppDynamics UI and log in with your AppDynamics credentials.
Your SaaS Controller URL
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Your SaaS Controller URL is included in the welcome email from AppDynamics.
The URL is of the following form:
http(s)://<customer>.saas.appdynamics.com/controller

Login Credentials

Login credentials are included in the welcome email from AppDynamics.
To add additional login accounts contact the AppDynamics Support Team.
Connecting Agents to Your SaaS Controller Service

For agents to successfully connect to the Controller, configure the Controller host and port
information using either the controller-info.xml file or the system properties of your JVM startup
script.
To use HTTPS communication, enable SSL by setting the <controller-ssl-enabled> agent
configuration property to "True". For details see App Agent for Java Configuration Properties, .NET
Agent Configuration Properties, and Standalone Machine Agent Configuration Properties. See
also Implement SSL on SaaS.
The default ports for the SaaS Controller service are:
Port 80 for HTTP
Port 443 for HTTPS
Important If you need to configure network access rules to permit App Agents in your network
to reach the AppDynamics SaaS Controller, permit outgoing connections for the subnet range of
the SaaS Controllers, 69.27.44.0/24, on ports 80 or 443.
SMTP Service for SaaS

To enable email and SMS notifications you must configure SMTP. See Configure the SMTP
Server.
Each machine that hosts a SaaS Controller includes an SMTP service. To use the provided SMTP
service, the configuration for SaaS Controllers settings are:
SMTP Host: localhost
SMTP Port: 25
No authentication is needed.
Contact Support

For questions about the service contact the AppDynamics Support Team.

Get Started with AppDynamics On-Premise
Follow these steps to get started
with AppDynamics.

Expert Advice

If you are reading a PDF of this
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document, you can access
additional documentation at http:
//docs.appdynamics.com.

Deploying APM in the Enterprise... the Path of
the Rock Star
By Jim Hirschauer

Design Your
AppDynamics
Deployment
Size and Verify the Controller Environment
Download AppDynamics
Install the AppDynamics Controller
Download and Install the AppDynamics App and Machine Agents
Install the AppDynamics Web and Mobile Agents
Review the Dashboards and Flow Maps
Review Defaults and Configure Business Transactions, if Needed
Review Defaults and Configure Client-Side Monitoring, if Needed
Review Default Health Rules and Set Up Policies
Review Default Error Detection
Explore Additional Data and Metric Features
Configure Advanced Features
Start Monitoring and Troubleshooting
Design Your AppDynamics Deployment

Learn about Monitor Business Transactions and identify which critical business transactions
you want to monitor.
Learn about how to map your application components to the AppDynamics business
application, tier, and node model. See Logical Model and Name Business Applications,
Tiers, and Nodes.
Based on the model, plan how you will specify AppDynamics application, tier, and node
names during installation.
Decide whether you want to monitor client-side usage with AppDynamics End User
Experience.
For Java environments, decide whether you want to use object instance tracking.
Size and Verify the Controller Environment

Verify that you have the resources to support system requirements and the Controller
performance profile. The profile reflects the number of nodes and AppDynamics applications
that the Controller will monitor. For details see Controller System Requirements.
Download AppDynamics

Download the AppDynamics software components from the Download Center. For details
see Download AppDynamics Software.
Install the AppDynamics Controller

The AppDynamics Controller is the central management server where all data is stored and
analyzed. All AppDynamics Agents connect to the Controller to report data, and the Controller
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provides a browser-based user interface for monitoring and troubleshooting application
performance. A wizard installs the Controller in just a few minutes. Install the AppDynamics
Controller only if you are using the on-premise Controller deployment option.
Follow the instructions to install an on-premise Controller.
Important installation and configuration considerations include:
High Availability
Backups
SSL and Certificates
User Authentication with LDAP or SAML
Download and Install the AppDynamics App and Machine Agents

Download the AppDynamics application agents from the Download Center. AppDynamics app
agents collect data from your application servers and other monitored systems and report to the
Controller. Select the agents that are appropriate for your environment:
App Agent for Java
App Agent for .NET
App Agent for PHP
App Agent for Node.js
Standalone Machine Agent
See Download AppDynamics Software.
Follow the instructions to install the AppDynamics Agents.
Install the AppDynamics Web and Mobile Agents

Install the client-side agents in your your mobile applications and web pages. See instructions for
mobile and web.

Access the AppDynamics UI from a Browser
Once you have installed the Controller and agents, launch your web browser and connect to the
AppDynamics User Interface (UI).
For an on-premise Controller, the URL pattern is:
http://<controller-host>:<controller-port>/controller

When using SSL, use port 443 or https to access the Controller.
Review the Dashboards and Flow Maps

AppDynamics automatically discovers the Business Transactions in your application environment.
Browse the Application Dashboard and see the Flow Maps to visualize your application. You can
resize and move icons around on the flow maps.
Review Defaults and Configure Business Transactions, if Needed

The default configurations may need to be further customized for your environment. For example,
AppDynamics may have discovered transactions that you want to group together or even exclude,
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because you want to concentrate on the most important transactions. There may be business
transactions that are not yet discovered for which you need to configure detection rules. See:
Monitor Business Transactions
Configure Business Transaction Detection
Review Defaults and Configure Client-Side Monitoring, if Needed

End User Experience Management (EUEM) provides performance information from the point of
view of the client, whether that client is a web browser or a mobile native application. See:
End User Experience Management
Set Up and Configure Mobile EUEM
Set Up and Configure Web EUEM

Review Defaults and Configure Databases and Remote Services, if Needed
AppDynamics automatically discovers "backends" such as databases, message queues, etc. by
following calls in the application code. Look at the databases and remote services dashboards to
make sure all necessary backends are revealed. If needed, change how backends are detected.
Review Default Health Rules and Set Up Policies

AppDynamics provides default Health Rules that define performance parameters for business
transactions, such as the conditions that indicate a slow transaction, or when too much memory is
being used. You can adjust the thresholds that define when a health rules is violated, create new
health rules, and set up policies to specify actions to automate when health rules are violated.
Review Default Error Detection

AppDynamics detects errors and exceptions. You can review and, if needed, modify the error
detection rules. For example, some errors you may want to ignore.
Explore Additional Data and Metric Features

Explore these features to gain more insight into application performance:
Detect Problems Caused by Application Data
Business Metrics
(for Java environments) JMX Metrics
Standalone Machine Agent Custom Metrics
Service Endpoints (Java only)
Configure Advanced Features

Additional features you may want to use include:
Visualize Performance Using Custom Dashboards
Automation
Extensions and Integrations
Start Monitoring and Troubleshooting

Start getting the benefits of AppDynamics! See:
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AppDynamics in Action Videos
AppDynamics Features

Download AppDynamics Software
Accessing the AppDynamics Download Center
Download Tips
AppDynamics Software Components
Access to Older Versions
Downloading from the Linux Shell
Learn More
Accessing the AppDynamics Download Center

You should have received a Welcome email from AppDynamics. The Welcome email contains
credentials for you to log in to the AppDynamics Support Center.
If you have not received this Welcome email, contact your AppDynamics Sales Representative or
email support@appdynamics.com.
Access the AppDynamics Download Center (http://download.appdynamics.com) and browse to the
appropriate section on the Download Center to download the relevant files.
Download Tips

Always copy or transfer the downloaded files in binary mode.
If you have downloaded a binary on Windows, and you are moving it to a Unix environment, the
transfer program must use binary mode.
For each file you download, verify that the download is complete and that the file is not
corrupted. Run a checksum tool and compare the results against the checksum information on the
download site.
AppDynamics Software Components

AppDynamics
Software
Component

Description

SaaS

On-Premise

Controller

Central management
server where all data
is stored and
analyzed.

N/A

Required
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Java App Server
Agent

Instrumentation Agent
for Java virtual
machines.
This component must
be installed on each
Java application
server you want to
instrument through
AppDynamics.

Required for Java

Required for Java

.NET App Server
Agent
(includes a Machine
Agent by default)

Instrumentation Agent
for .NET Common
Language Runtime
(CLR).
This component must
be installed on those
worker processes that
you want to
instrument through
AppDynamics.

Required for .NET

Required for .NET

PHP Agent

App agent for PHP
installations.

Required for PHP

Required for PHP

Machine Agent

Collects hardware
performance metrics
and can be installed
on any machine in
your environment.
The Machine Agent
can be extended to
collect data from
other subsystems.

Optional

Optional

GeoServer

For End User
Management. See Cu
stomize Your Web
EUEM Deployment.

Optional

Optional

Access to Older Versions

The AppDynamics Download Center provides downloads of older versions of the products.
For On-Premise installations: Go to "AD Pro-OnPremise".
For SaaS installations: Go to "AD Pro-SaaS".
On the top-right corner, click on the drop-down list to select the version that you want to download.
Downloading from the Linux Shell

To download AppDynamics software from a Linux shell, you can use the wget utility or cURL.
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When using these tools, you first need to authenticate to the AppDynamics domain and store the
resulting session ID in a file. Next, send the request to download the software, passing the session
information file as a cookie.
For example, on Fedora you can use the following wget commands:
wget --save-cookies cookies.txt --post-data
'username=<USERNAME>&password=<PASSWORD>'
https://login.appdynamics.com/sso/login/

wget --content-disposition --load-cookies cookies.txt '<URL_TO_FILE>'

On the Windows platform add the --no-check-certificate option.
The equivalent cURL commands are:
curl -c cookies.txt -d 'username=<USERNAME>&password=<PASSWORD>'
https://login.appdynamics.com/sso/login/

curl -O -b cookies.txt <URL_TO_FILE>

You can discover the URL for the file to download at the AppDynamics Download Center.
Learn More

Supported Environments and Versions
Agent - Controller Compatibility Matrix

Quick Start for Developers
Get Started

Tutorials for Java

Get Started on SaaS

Use AppDynamics for the
First Time with Java
Understanding Events
Understanding Flow Maps
Understanding Slow
Transactions
Understanding the
Transaction Scorecard
Understanding Server Health
Understanding Exceptions

Get Started On-Premise
Features Overview
Monitor Your Applications

Monitor Business
Transactions
Web EUEM
Monitor Events
Monitor Application Change
Events
Monitor Background Tasks
Backend Monitoring
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Troubleshoot Application
Performance

Troubleshoot Slow Response
Times
Troubleshoot Health Rule
Violations
Transaction Snapshots
Troubleshoot Node Problems
Troubleshoot Errors
See Detailed Data Using
Diagnostic Sessions
Troubleshoot Java Memory
Issues

Page 23

Monitor Infrastructure
Monitor CLRs
Monitor Hardware

Quick Start for Architects
Get Started

Basic Configuration

Advanced Configuration

Supported Environments and
Versions
Get Started on SaaS
Get Started On-Premise

Configure Business
Transaction Detection
Configure Policies
Configure Baselines
Configure Thresholds
Configure Error Detection
Set Up and Configure Web
EUEM
Getting Started Wizard for
Alerts
Visualize Performance Using
Custom Dashboards

Hierarchical Configuration
Model
Configure Data Collectors
Configure Code Metric
Information Points
Configure Custom Exit Points
Configure Call Graphs
Configure Background Tasks
Remove Stale Backends
Configure and Use Custom
Memory Structures for Java
Configure JMX Metrics from
MBeans
Configure Multi-Threaded
Transactions (Java)
Configure and Use Object
Instance Tracking for Java
Configure Transaction
Snapshots
Configure Memory Monitoring
(Java)
Build an Alerting Extension
Export and Import Business
Application Configurations

Concepts

Features Overview
Architecture
Logical Model
Mapping Application Services
to the AppDynamics Model
Detect Anomalies Using
Dynamic Baselines
Set Performance Boundaries
Using Thresholds
Glossary

Analyze

Business Metrics
Infrastructure Metrics
Reports
Compare Releases
Integration

Extensions and Integrations
Use the AppDynamics REST
API
Automation

Workflow Overview
Cloud Computing Workflows

Quick Start for Administrators
Get Started

Basic Administration

Advanced Administration

Architecture
Get Started on SaaS
Get Started On-Premise
Logical Model

Platform Release Notes
Supported Environments and
Versions
Install and Upgrade
Name Business Applications,
Tiers, and Nodes

Security
Best Practices for Failover
Scenarios for Java
Administer Agents
Administer the Controller
User Authentication and

Copyright © AppDynamics 2012-2014

Page 24

Permissions
AppDynamics for Large
Enterprises

Quick Start for Operators
Overview

Set Up

Tutorials for Java

Application Intelligence
Platform

Set User Preferences
Visualize Performance Using
Custom Dashboards

Use AppDynamics for the
First Time with Java
Understanding Events
Understanding Flow Maps
Understanding Slow
Transactions
Understanding the
Transaction Scorecard
Understanding Server Health
Understanding Exceptions

Set User Preferences
Change User Account Settings
To change your password
To change your display name and contact email
Configure View Preferences
To configure view preferences
Advanced Features
About Debug Mode
Users in the Controller UI can change their passwords, account settings, date and time format,
and other user-specific settings in the User Preferences tab.
The User Preferences tab is also where users can enable the use of non-English languages in the
Controller UI. Setting the Controller UI to use system fonts allows it to display text in the font
configured for the system running the browser.
Change User Account Settings

The user account settings include the user's password, display name, and contact email. These
settings are attributes of local users (that is, users validated against credentials stored in
AppDynamics). If your Controller is configured to use an external authentication mechanism
instead, such as SAML or LDAP, you need to change the equivalent settings in the external
system instead.
To change your password

1. From the upper right menu bar of the Controller UI, click the User icon and then My
Preferences.
2. Click the Change Password button.
3. Enter your current password in the Current Password field.
4. Type your new password in the New Password and Confirm New Password fields, and
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4.
then click Save.
You will need to enter the new password the next time you log in.
To change your display name and contact email

The display name is the name that the Controller uses to identify you in certain screen text and
messages. For example, it appears in notifications to other Controller users when you share a
dashboard with them.
1. In the Controller UI, access your user preferences by clicking the User icon and then My
Preferences.
2. Click the Edit Account button.
Note that your username cannot be changed. To effect a change of a username, you would
need to have an administrator delete your account and create another one with the new
name.
3. Enter new values for:
Display Name: Your new display name in the UI.
Email: The email address where you want to receive notifications from the Controller.
4. Enter your current password in the Current Password field. The Controller uses this field to
ensure your identity before making changes to your account. If you do not provide the
correct password, your changes will not be applied.
5. Click the Save button.
The change take effect immediately.
Configure View Preferences

The Controller UI allows individual users to customize certain view preferences in the UI, such as
the time and date format and style elements of the UI.
To configure view preferences

1. In the Controller UI, access your user preferences by clicking the User icon and then My
Preferences.
2. In the View Preferences of the page, configure any of the following settings as desired:
Date Format: By default, the format is MM/DD/YY (for example, 09/25/14). Choose an
alternate format from the drop-down menu.
Use 24 hour Time Format: Enable this option if you want the UI to represent time in
24-hour time format instead of 12 hour clock format.
Enable Help Pop-ups: Help popups provide help text in context in the Controller UI.
By default, they are enabled. To prevent help popups from appearing in the UI, clear
this checkbox.
Alternatively, you can prevent individual popups by selecting the Don't Show Again c
heckbox when the popup appears. To clear the list of popups marked as "Don't Show
Again", click the Reset All button.
Graph Color Scheme for the Metric Browser: Select either Light or Dark to change
the metric browser color scheme.
Graph Color Scheme for All Other Graphs: Select either Light or Dark to
change the navigation panel color scheme.
Maximum number of Backends to display in graphical views: This setting limits
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the number of backend systems that appear in flowcharts or other graphical depictions
of your application environment. The default is 20.
Font: Determines the font type used in the UI. For screen text, the Controller UI uses
a font set that it embeds by default. If the operating system of the computer on which
you access the Controller UI uses a non-English language, you can configure the UI
to use non-English languages by setting the font to use system fonts instead.
Mouse Wheel Legacy Mode: If scrolling in the Controller UI using your mouse scroll
doesn't work properly, you should try enabling the Mouse Wheel Legacy Mode optio
n. This may be necessary if accessing the Controller UI with certain older browsers.
3. You may need to log out of the UI and log back in to see the effects of your changes.
Advanced Features

AppDynamics cloud automation features allow you to set up workflows that are triggered by policy
conditions. By default, the features are hidden in the UI. You need to specifically enable the
features to configure cloud auto-scaling features.
To enable cloud automation features in the UI, enable the Show Cloud Auto-Scaling option.
Enabling this option displays the Cloud Auto-Scaling link at the bottom left side of the UI, under
the Alert & Respond menu.
See Workflow Overview for information about using cloud scaling automation features. See Policie
s for information about specifying policy conditions that trigger workflows.
About Debug Mode

The debug mode in the Controller UI is primarily intended for internal use by the AppDynamics
development team.
In some cases, you may be asked to enable debug mode in consultation with AppDynamics
Support, for example, when you are troubleshooting an issue. However, it is important to note that
certain debug mode options can negatively impact Controller performance. For this reason, you
should only enable debug mode when directly advised to do so by AppDynamics Support.

Install and Upgrade
This section shows you where to go to download and install AppDynamics software.
Quick Installation
Standard Installation
More Topics

Quick Installation
For instructions on how to perform a quick, basic installation suitable for small-scale evaluation
environments, see the Quick Install instructions.
For instructions suitable for demos, see Installation Cheatsheet for Small Environments.

Standard Installation
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Before you install see:
Architecture
Logical Model
Download AppDynamics Software
On-Premise Controller
Install the Controller
Upgrade the Controller
Verify App
Agent-Controller
Communication
App Agent for Java
Install the Java Agent
Upgrade the Java
Agent
Uninstall the Java
Agent
App Agent for .NET
Install the .NET Agent
Upgrade the .NET
Agent
Uninstall the .NET
Agent
App Agent for PHP
Install the PHP Agent
Uninstall the PHP
Agent
Upgrade the PHP
Agent
Machine Agent
Install the Standalone
Machine Agent

More Topics
This section includes the following topics:
Quick Install
Installation Cheatsheet for Small Environments
Supported Environments and Versions
Install the Controller
Install Agents
Controller Licenses
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Connect the Controller and Agents
Upgrade the Controller
Uninstall the Controller
Migrate the Controller between Machines
Install the On-Premise End User Experience Management Processor

Quick Install
On-Premise Only: Install The Controller
Install Agents for JVMs
Install Agents for .NET CLRs
Install Agents for PHP Apps
Install the Standalone Machine Agent
The following topics describe how to get an instance of AppDynamics up and running quickly. The
agent installs are for app agents from the Agent Download Wizard in the Controller.
If you downloaded the agent from the AppDynamics download zone, see Install App Agents
from the AppDynamics Download Zone.
If you are using the Controller on-premise, you must install the latest Controller before
proceeding with agent installs. For more information contact AppDynamics Support.

On-Premise Only: Install The Controller
These steps assume that you want to perform a relatively straightforward installation suitable for a
small-scale evaluation environment, and that you do not require high availability, multi-tenancy, or
other features intended for production deployments.
Install the Pro Trial Controller on Linux
Install the Pro Trial Controller on Windows
Install Agents for JVMs

Quick Install for the Java Agent
Install Agents for .NET CLRs

Quick Install for the .NET Agent
Install Agents for PHP Apps

Quick Install for the PHP Agent
Install the Standalone Machine Agent

Quick Install for the Standalone Machine Agent

To see full installation documentation instead, see Install the Controller and Install Agents.
Install the Pro Trial Controller on Linux
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Pre-installation Checklist for Linux
Run the Linux Installer
Post-Installation Checklist for Linux
Next Steps
Learn More

Learn by watching: Installing on Linux

This topic describes how to install a trial instance of the AppDynamics Controller on Linux. The
trial Controller is identical to the full-service Controller, with all the same features, but subject to a
15-day trial license. If you are installing a standard Controller see Install the Controller on Linux.
Pre-installation Checklist for Linux

Confirm the operating system requirements at Controller System Requirements:
Redhat Enterprise Linux (RHEL) 6.1, 6.2
CentOS 6.1, 6.2
Fedora 14
Ubuntu 8, 12
Open SUSE 11.x
SUSE Linux Enterprise Server
Cloud: Amazon EC2, Rackspace, Azure
Confirm browser and Flash support:
Mozilla FireFox 6+
Internet Explorer 9+
Safari 6+
Google Chrome 16+
The Controller UI requires Flash Player 10 or greater; AppDynamics recommends
version 11.
Confirm disk space requirements:
50 GB
Confirm CPU, RAM and Disk I/O capacity:
2 GB RAM
2 CPU Cores
1.5 GHz minimum
Disk I/O: 50 MB/sec write, 50 MB/sec read, 1.5 MB/sec random
The Controller requires that libaio be installed on the machine prior to installation. For more
information see Install libaio on Linux.
Make sure the file descriptor limit is set to at least 65535. For more information see Configur
e File Descriptor Limits on Linux.
Download the 32-bit or 64-bit Linux installer file from the Downloads tab on the Support
page. You'll need to register on the web site to get access to the installer download.
Change the access permissions for the installer file to permit execution.
Make sure that the Controller will be accessible to the application agents and browser
clients. If needed, open the firewall to the HTTP port that the Controller will use for HTTP or
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HTTPS communication, 8090 or 8181, by default.
Run the Linux Installer

1. At the command line, execute the Controller installer .sh file.
By default the installer tries to start in GUI mode. If the system does not have a GUI
desktop, the installer starts in console mode. You can force the installer to start in console
mode by passing the -c option to the installer. The following steps assume the installer is in
GUI mode.
2. In the Welcome screen click Next.
3. Scroll to the bottom of the license agreement, click accept and then Next.
4. Click Yes to grant AppDynamics permission to collect usage data statistics from your Controller.
AppDynamics uses the data to improve the quality of its products and services.
5. Accept the default installation directory by clicking Next.
6. Enter the password for the database user that the Controller uses to access the bundled
MySQL database.
7. Verify the default host name and Application Server Primary Port.
Note the primary port number, 8090 by default. You will need this later to log in to the
Controller UI from the browser.
8. Verify the other required ports suggested by the installer and click Next. The installer checks
the availability of the ports before presenting them on the screen. If necessary, click Edit
Ports, modify the defaults, and save your changes to use different ports.
9. Choose single-tenancy mode for the Controller, then click Next.
10. Enter the password for the Controller root user. This is a built-in account with global
administrative privileges in the Controller. This user can access certain settings not available
to account administrators, such as data retention settings.
11. Enter a username and password for the account administrator in the Controller and then
click Next. This user will be able to access the Controller UI and create other users.
Note that accounts are used in multi-tenancy Controllers to partition access to monitored
applications among users. Single-tenancy Controllers only have a single, implicit account.
See AppDynamics Administrator for more information about the types of administrators.
Usernames and password cannot include the @ character. Also, if this account will
be used to access the REST API, additional limitations on the use of special
characters in usernames apply. See Configure Users for more information.

12. Select the Demo performance profile then click Next.
13. Select the default data directory path and Elastic Search data directory path then click Next.
14. In the High Availability screen, select Not Applicable, as you are not enabling HA for this
Controller, and click Next.
The installer begins installing the Controller files. When it's done, it attempts to start the Controller. You
can verify the installation as described next.

Post-Installation Checklist for Linux
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Verify Controller Installation
Configure Swappiness if the Linux Kernel is Newer than 2.1.10
Verify Controller Installation

When the installer completes the Controller automatically starts.
To verify the success of your installation, open a browser to the URL that you configured for the
Controller.
http://<application_server_host_name>:<http_listener_port>/controller

For the port, use the Application Server Primary Port configured by the installer, which is 8090 by
default.
Configure Swappiness if the Linux Kernel is Newer than 2.1.10

For better performance, configure swappiness. For details see Configure Swappiness on Linux.
This feature is available only for Linux kernel versions greater than 2.1.10.
Verify Controller Installation
Configure Swappiness if the Linux Kernel is Newer than 2.1.10
Next Steps

Now that you have installed and verified the Controller, you must install agents to instrument and
monitor your application.
1. Open a browser to the URL that you configured for the Controller.
http://<host_name>:<port>/controller

2. Log in with the username and password you specified for the account administrator user in
step 10 above.
The first time you log in, the Getting Started page appears.
3. Click the Download Agent Wizard tab to get started on installing the app agents. For more
information, see Quick Install for the Java Agent.
After installation, make sure to verify that your App Agent and Controller are talking to each other.
Once that's done, you're ready to dig deeper into what AppDynamics can do.
Learn More

Start or Stop the Controller
Self-Service Install - App Agents for Java
Install the Pro Trial Controller on Windows
Pre-installation Checklist for Windows
Run the Windows Installer
Post-installation Checklist for Windows
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Next Steps
Learn More
This topic describes how to install a trial instance of the AppDynamics Controller on Windows. The
trial Controller is identical to the full-service Controller, with all the same features, but subject to a
15-day trial license. If you are installing a standard Controller see Install the Controller on Linux.
Pre-installation Checklist for Windows

Confirm the operating system requirements at Controller System Requirements:
Windows Server 2003
Windows Server 2008, Windows Server 2008 R2
Windows Server 2012 R1 Standard and Datacenter, Windows Server 2012 R2
Standard and Datacenter
Windows 7 Pro
Windows 8
Confirm browser and Flash support:
Mozilla FireFox 6+
Internet Explorer 9+
Safari 6+
Google Chrome 16+
The Controller UI requires Flash Player 10 or greater; AppDynamics recommends
version 11.
Confirm disk space requirements:
50 GB
Confirm CPU, RAM and Disk I/O capacity:
2 GB RAM
2 CPU Cores
1.5 GHz minimum
Disk I/O: 50 MB/sec write, 50 MB/sec read, 1.5 MB/sec random
Verify that you have administrative privileges on the Windows machine to launch the
Controller installer.
Download the 32-bit or 64-bit Windows installer file from the Downloads tab on the Support
page. You'll need to register on the web site to get access to the installer download.
Make sure that the Controller will be accessible to the application agents and browser
clients. If needed, open the firewall to the HTTP port that the Controller will use for HTTP or
HTTPS communication, 8090 or 8181, by default.
Run the Windows Installer

1. After downloading the installer, in the Windows Start menu, right-click on the Command
Prompt icon and choose Run as administrator.
2. Navigate to the download directory and execute the installer .exe file.
3. In the Welcome screen click Next.
4. Scroll to the bottom of the license agreement page, click accept and then Next.
5.
Copyright © AppDynamics 2012-2014

Page 33

5. Click Yes to grant AppDynamics permission to collect usage data statistics from your controller.
AppDynamics uses the data to improve the quality of its products and services.
6. Accept the default installation directory by clicking Next.
7. Verify the default host name and Application Server Primary Port.
Note the primary port number, 8090 by default. You will need this later to log in to the
Controller UI from the browser.
8. Verify the other required ports suggested by the installer and click Next. The installer checks
the availability of the ports before presenting them on the screen. If necessary, click Edit
Ports, modify the defaults, and save your changes to use different ports.

9. Choose single-tenancy mode for the Controller, then click Next.
10. Enter the password for the Controller root user. This is a built-in account with global
administrative privileges in the Controller. This user can access certain settings not available
to account administrators, such as data retention settings.
11. Enter a username and password for the account administrator in the Controller and then click Ne
xt. This user will be able to access the Controller UI and create other users.
Note that accounts are used in multi-tenancy Controllers to partition access to monitored
applications among users. Single-tenancy Controllers only have a single, implicit account. See A
ppDynamics Administrator for more information about the types of administrators.
Usernames and password cannot include the @ character. Also, if this account will
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be used to access the REST API, additional limitations on the use of special
characters in usernames apply. See Configure Users for more information.

12. Select the Demo performance profile then click Next.
13. Select the default data directory path then click Next.
14. In the High Availability screen, select Not Applicable, as you are not enabling HA for this
Controller, and click Next.
The installer begins installing the Controller files. When it's done, it attempts to start the Controller.
You can verify the installation as described next.
Post-installation Checklist for Windows

Verify Controller Installation
Configure the Controller to Run as a Windows Service
Exclude the Controller Data Directory from Virus Scanning and Indexing
Verify Controller Installation

To verify your installation, do one of the following:
Click the link to the Controller provided in the installer's "Finish" screen.
Open a browser to the URL that you configured for the Controller.
http://<controller-host>:<controller-port>/controller

For the port, use the Application Server Primary Port configured by the installer, which is
8090 by default.
Configure the Controller to Run as a Windows Service

By default the Controller is not installed as a Windows service. AppDynamics strongly
recommends that the Controller runs as a service on Windows.
See Install the Controller as a Windows Service for information on configuring the installed
Controller to run as a service on Windows.
Exclude the Controller Data Directory from Virus Scanning and Indexing

See the operational guidelines in Install the Controller on Windows for more information about
excluding the Controller data directory from virus scanning and indexing services on Windows.
Verify Controller Installation
Configure the Controller to Run as a Windows Service
Exclude the Controller Data Directory from Virus Scanning and Indexing
Next Steps

Now that you have installed and verified the Controller, you can install agents to instrument and
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monitor your application.
1. Open a browser to the URL that you configured for the Controller.
http://<controller-host>:<controller-port>/controller

2. Log in with the username and password you specified for the account administrator user in
step 10 above.
The first time you log in, the Getting Started page appears.
3. Click the Download Agent Wizard tab to get started on installing the app agents. For more
information, see Quick Install for the Java Agent.

After installation, make sure to verify that your App Agent and Controller are talking to each other.
Once that's done, you're ready to dig deeper into what AppDynamics can do.
Learn More

Install the Controller as a Windows Service
Start or Stop the Controller
Self-Service Install - App Agents for .NET
Self-Service Install - App Agents for Java
Quick Install for the Java Agent
Before You Begin
Instrumenting Your JVM with the Java Agent
Download the Java Agent
Install the Agent on the App Server
Apply load to your application
View your application
Learn More
Use these instructions to install the Java Agent using the Agent Download Wizard in the
Controller.
If you downloaded the agent from the AppDynamics download zone, see Install the Java Agent.
Before You Begin

1. Confirm you have access to a
Controller, the web application
where you monitor your
application performance:
If you use a SaaS
controller,
AppDynamics sent
you the Controller
host location in your
Welcome Email.
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If you use an
on-premise
Controller, you
configured the host
and port at install
time.

2. Identify the startup script for
you the JVM for your
application. To enable the
agent, you edit the startup
script.
Show more information on startup scripts...

Instrumenting Your JVM with the Java Agent

There are four steps to instrument your JVM and begin monitoring:
1. Download: Use the Agent Download Wizard to configure and download the agent.
2. Install: Unzip the agent on your server and add it to your JVM startup script.
3. Apply Load: Restart your application and apply load to activate instrumentation.
4. View Your Application: Log on to the Controller to monitor application performance.
Download the Java Agent

The Agent Download Wizard walks you through configuration steps and helps you download the
agent.
Show me the Download Agent Wizard steps...
1. Log on to the Controller and
click the Agent Download
Wizard tab.
The download wizard configures the
agent with information to connect to the
Controller.
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2. Click Java, then click Next.

3. Click to Select JVM, then
click Next.

4. The Controller Location URL
window displays the
connection info for the
Controller. Click Next.
Click SSL to enable SSL
encryption between the agent
and the Controller. Enter the
SSL port. For AppDynamics
SaaS, the SSL port is 443.

5. Enter an application name
or, click an existing application
name if one exists. Then click

Copyright © AppDynamics 2012-2014

Page 38

Next.
For new users, it is OK to use
the default MyApp. You can
change it later when know
more about how you want to
organize your applications in
AppDynamics.

6. Enter a tier name. Then click
Next.
For new users, it is OK to use
the default MyTier. You can
change it later when know
more about how you want to
organize your applications in
AppDynamics.

7. Click Click here to
Download to download the
Java Agent.

Copyright © AppDynamics 2012-2014

Page 39

Now you're ready to install the
agent on your app server.

Install the Agent on the App Server
After you download the agent, install it to your app server. The final window of the Agent Download
Wizard includes brief instructions for installing the agent.
Show me the steps to install the agent...
1. Log on as an administrator to the machine running your Java application. Unzip the
AppServerAgent.zip file.

For example, on Linux unzip the agent to home/appdynamics. This is the <agent home>
directory.
unzip AppServerAgent.zip -d /opt/appdynamics/appagent

2. Edit your startup configuration file to include the Java Agent.
Show more information on startup scripts...

Now you're ready to restart your application and put some load on it.
Apply load to your application

1. Restart the JVM.
2. Apply load to your application.
The agent instruments the application code and reports metrics back to the Controller. You're
ready to begin monitoring.
View your application

Log on to the Controller to see
your application in action.
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From here, you can install more
agents or you can begin
monitoring your application. The
links below will help you get
started:

Learn More

Application Intelligence Platform
Quick Install for the Standalone Machine Agent
Quick Install for the .NET Agent
Before You Begin
Instrumenting Your CLR with the .NET Agent
Download the .NET Agent
Install the agent on your app server
Apply load to your application
View your application
Learn More
Use these instructions to install the .NET Agent using the Agent Download Wizard in the
Controller.
If you downloaded the agent from the AppDynamics download zone, see Install the .NET Agent.
Before You Begin

1. Confirm you have access to a
controller, the web application
where you monitor your
application performance:
If you use a SaaS
controller,
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AppDynamics sent
you the controller
host in your
Welcome Email.
If you use the
on-premise
controller, you
supplied the host
and port at install
time.

2. Verify you've enabled COM+
on your system. See To verify
COM+ Services are enabled.
Instrumenting Your CLR with the .NET Agent

There are four steps to instrument your CLR and begin monitoring:
Quick Install: .NET Agent
1.
&lt;p&gt; &lt;/p&gt;
Download
Direct link: https://appdynamo.wistia.com/medias/q7fmhuzkdw
: Use the Agent Download Wizard to configure and download the agent.
2. Install: Run the MSI installer package and the AppDynamics Agent Configuration utility.
3. Apply Load: Apply load to activate instrumentation.
4. View Your Application: Log on to the Controller to monitor application performance.
Download the .NET Agent

The Agent Download Wizard walks you through configuration steps and helps you download the
agent.
Show me the Download Agent Wizard steps...
1. Log on to the Controller and
click the Agent Download
Wizard tab.
The download wizard guides you
through the download process.
2. Click .NET, then click Next.
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3. Click to select 32-bit or
64-bit system, then click Next.

7. Click Click here to
Download to download the
App Agent for .NET.

Now you're ready to install the
agent on your app server.
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Install the agent on your app server
After you download the agent, install it to your app server. The final window of the Agent Download
Wizard includes brief instructions for installing the agent.
1. Run the MSI installer package and accept the default settings.
2. When the installation completes, leave Launch AppDynamics Agent Configuration checked
. Click Finish.
3. The .NET Agent Configuration utility launches. Proceed through the configuration steps and
accept the default settings.
If you're using a SaaS Self-Service Controller, you must include your account name
and access key in the Controller Configuration window.
In the Application Configuration window, enter a name for your business application in
the New Application field.
For new users, it is OK to enter "MyApp". You can change it later when know more
about how you want to organize your applications in AppDynamics.
For Pro Trial installations, AppDynamics recommends you use Automatic tier
naming in the Assign IIS applications to tiers window.
Detailed Configuration Instructions
For step by step instructions, see Configure the .NET Agent.
To instrument Windows services, see Enable the .NET Agent for Windows Services.
To instrument standalone applications, see Enable the .NET Agent for Standalone
Applications.
4. On the Configuration Summary window, leave Restart IIS checked to start monitoring
immediately. Uncheck Restart IIS if you don't want to restart IIS. Monitoring will not begin
until the next time IIS restarts.
If you leave Restart IIS checked, the configuration utility restarts IIS, so now you're ready to put
load on your application.
Apply load to your application

If you are instrumenting a production application, this will happen with customer interaction.
Otherwise, create some test load on your application. The agent instruments the application code
and reports metrics back to the Controller. You're ready to begin monitoring.
View your application

Copyright © AppDynamics 2012-2014

Page 44

Log on to the Controller to see
your application in action.
From here, you can install more
agents or you can begin
monitoring your application. The
links below will help you get
started:

Learn More

Application Intelligence Platform
Quick Install for the PHP Agent
Before You Begin
Instrumenting Your PHP Application with the App Agent for PHP
Download the PHP Agent
Install the agent on your app server
Apply load to your application
View your application
Learn More
Use these instructions to install the PHP Agent using the Agent Download Wizard in the Controller.
If you downloaded the agent from the AppDynamics download zone, see Install the PHP Agent.
Before You Begin

1. Confirm you have access
to a controller, the web
application where you
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1.

monitor your application
performance:
If you use a SaaS
controller,
AppDynamics sent
you the controller
host in your
Welcome Email.
If you use the
on-premise
controller, you
supplied the host
and port at install
time.
2. Verify you have root
access to run the install.
3. Verify support for your
environment at Supported
Environments and
Versions for PHP.

Instrumenting Your PHP Application with the App Agent for PHP

There are four steps to instrument your PHP application and begin monitoring:
1. Download: Use the Agent Download Wizard to configure and download the agent.
2. Install: Unzip the agent on your server and run the install script.
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3. Apply Load: Restart your web server and application and apply load to activate
instrumentation.
4. View Your Application: Log on to the Controller to monitor application performance.
Download the PHP Agent

The Agent Download Wizard walks you through configuration steps and helps you download the
agent.
Show me the Download Agent Wizard steps...
1. Log on to the Controller and
click the Agent Download
Wizard tab.
The download wizard configures the
agent with information to connect to the
Controller.
2. Click PHP, then click Next.

3. Click to Select Operating
System and 32-bit or 64-bit
bit System, then click Next.

4. The Controller Location URL
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window displays the
connection info for the
Controller. Click Next.
Click SSL to enable SSL
encryption between the agent
and the Controller. Enter the
SSL port. For AppDynamics
SaaS, the SSL port is 443.

5. Enter an application name
or, click an existing application
name if one exists. Then click
Next.
For new users, it is OK to use
the default "MyApp". You can
change it later when know
more about how you want to
organize your applications in
AppDynamics.
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6. Enter a tier name. Then click
Next.
For new users, it is OK to use
the default "MyTier". You can
change it later when know
more about how you want to
organize your applications in
AppDynamics.

7. Click Click here to
Download to download the
App Agent for PHP.

Now you're ready to install the
agent on your app server.

Install the agent on your app server
After you download the agent, install it to your app server. The final window of the Agent Download
Wizard includes brief instructions for installing the agent.
1. Log on as an administrator to the machine running your PHP application. Unzip the agent
zip file into a directory that can be accessed the same user that runs Apache or php-fpm.
For example, for a 64 bit agent on Linux:
unzip appdynamics-php-agent-x64-linux-tar-self-service.zip -d
/opt/appdynamics/appagent

2.
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2. Run the installer script.
sudo bash runme.sh

By default the PHP agent installer uses the PHP directory specified in your
environment's PATH variable to determine where to install the agent. If you are using
a different PHP installation not specified in the PATH environment variable, follow
the instructions below to run the installer with custom options instead of using the
installer script.
Install the PHP Agent using a Shell Script
Install the PHP Agent using RPM
Now you're ready to restart your application and put some load on it.
Apply load to your application

1. Restart your web server.
2. Apply load to your application.
The agent instruments the application code and reports metrics back to the Controller.
You're ready to begin monitoring.
View your application

Log on to the Controller to see
your application in action.
From here, you can install more
agents or you can begin
monitoring your application. The
links below will help you get
started:

Learn More
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Application Intelligence Platform
Quick Install for the Standalone Machine Agent
Quick Install for the Node.js Agent
Before You Begin
Instrumenting Your Node.js Application with the Node.js Agent
Set up the Node.js Agent
Install and Configure
Apply load to your application
View your application
Learn More
Use these instructions to install the Node.js Agent using the Agent Download Wizard in the
Controller.
If you downloaded the agent from the AppDynamics download zone, see Install the Node.js Agent.
Before You Begin

1. Confirm you have access
to a controller, the web
application where you
monitor your application
performance:
If you use a SaaS
controller,
AppDynamics sent
you the controller
host in your
Welcome Email.
If you use the
on-premise
controller, you
supplied the host
and port at install
time.
2. Verify you have root
access to run the install.
3. Verify support for your
environment at Supported
Environments and
Versions for Node.js.
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Instrumenting Your Node.js Application with the Node.js Agent

There are four steps to instrument your Node.js application and begin monitoring:
1. Setup: Use the Agent Download Wizard to set up the agent.
2. Install and Configure: Run the install script and configure the connection to the controller.
3. Apply Load: Restart your application and apply load to activate instrumentation.
4. View Your Application: Log on to the Controller to monitor application performance.
Set up the Node.js Agent

The Agent Download Wizard walks you through configuration steps and helps you download the
agent.
Show me the Download Agent Wizard steps...
1. Log on to the Controller and
click the Agent Download
Wizard tab.
The download wizard configures the
agent with information to connect to the
Controller.
2. Click Node.js, then click Ne
xt.
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3. The Controller Location URL
window displays the
connection info for the
Controller. Click Next.
Click SSL to enable SSL
encryption between the agent
and the Controller. Enter the
SSL port. For AppDynamics
SaaS, the SSL port is 443.

4. Enter an application name
or, click an existing application
name if one exists. Then click
Next.
For new users, it is OK to use
the default "MyApp". You can
change it later when know
more about how you want to
organize your applications in
AppDynamics.
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5. Enter a tier name. Then click
Next.
For new users, it is OK to use
the default "MyTier". You can
change it later when know
more about how you want to
organize your applications in
AppDynamics.

Install and Configure

1. From the root directory of
your Node.js application run this
command: npm install
appdynamics
2. Insert the require statement
generated by the wizard in the
application source code at the
first line of the main module
(such as the server.js file),
before any other require
statements. You can copy the
code in the wizard and paste it
directly into your application.
Each require statement is
especially generated for your
app based on the values you
configured in the previous setup
steps.
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Now you're ready to restart your application and put some load on it.
Apply load to your application

1. Restart your application
2. Apply load to your application.
The agent instruments the application code and reports metrics back to the Controller.
You're ready to begin monitoring.
View your application

Log on to the Controller to see
your application in action.
From here, you can install more
agents or you can begin
monitoring your application. The
links below will help you get
started:

Learn More

Application Intelligence Platform
Quick Install for the Standalone Machine Agent
Quick Install for the Standalone Machine Agent
Before You Begin
Monitoring Performance with the Standalone Machine Agent
Download the Machine Agent
Install the agent on your app server
View your application
Learn More
The AppDynamics Machine Agent, also called the Standalone Machine Agent, is a standalone
Java program that collects performance statistics about your environment. It can be deployed on
any machine that hosts application servers, database servers, messaging servers, Web servers,
etc. It has an extensible architecture.
Use these instructions to install the Standalone Machine Agent using the Agent Download Wizard
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in the Controller.
If you downloaded the agent from the AppDynamics download zone, see Install the Standalone
Machine Agent.
Before You Begin

1. Confirm you have access to a
controller, the web application
where you monitor your
application performance:
If you use a SaaS
controller,
AppDynamics sent
you the controller
host in your
Welcome Email.
If you use the
on-premise
controller, you
supplied the host
and port at install
time.

Monitoring Performance with the Standalone Machine Agent

There are three steps to install the Standalone Machine Agent and begin monitoring:
1. Download: Use the Agent Download Wizard to configure and download the agent.
2. Install: Unzip the agent on your server and launch it.
3. View Your Application: Log on to the Controller to monitor application performance.
Download the Machine Agent

The Agent Download Wizard walks you through configuration steps and helps you download the
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agent.
Show me the Download Agent Wizard steps...
1. Log on to the Controller and
click the Agent Download
Wizard tab.
The download wizard configures the
agent with information to connect to the
Controller.
2. Click Standalone Machine
Agent, then click Next.

4. The Controller Location URL
window displays the
connection info for the
Controller. Click Next.
Click SSL to enable SSL
encryption between the agent
and the Controller. Enter the
SSL port. For AppDynamics
SaaS, the SSL port is 443.

7. Click Click here to
Download to download the
Standalone Machine Agent.
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Now you're ready to install the
agent on your app server.

Install the agent on your app server
After you download the agent, install it to your app server. The final window of the Agent Download
Wizard includes brief instructions for installing the agent.
Show me the steps to install the agent...
1. Log on as an administrator to the machine. Unzip the MachineAgent.zip file.
For example, to unzip the agent on Linux. This is the <machine agent home> directory:
unzip MachineAgent.zip -d /opt/appdynamics/machineagent

2. Launch the Standalone Machine Agent.
java -jar <machine agent home>/machineagent.jar

You're ready to begin monitoring.
View your application

Log on to the Controller to see
your application in action.
From here, you can install more
agents or you can begin
monitoring your application. The
links below will help you get
started:
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Learn More

Application Intelligence Platform

Installation Cheatsheet for Small Environments
Infrastructure
On-Premise Controller Requirements
AppDynamics for Databases Requirements
Network
Getting Started
This cheatsheet lists the steps required to get a basic AppDynamics installation, suitable for
demos and small performance profiles. These steps typically take a few hours, excluding any
process delays for provisioning servers or making other infrastructure changes.
Infrastructure

The AppDynamics solution requires a central Controller. It can be hosted as SaaS by
AppDynamics or you can install it on-premise.
On-Premise Controller Requirements

For an on-premise Controller, the controller configuration required depends on the number of
JVMs to be monitored. Requirements for the small profiles are:
Controlle
r
performa
nce
profile

Supporte
d OS
platform
s
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Disk
storage

Disk I/O
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Agent
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Demo

Linux (32
& 64-bit)
Windows
(32 &
64-bit)

2 CPU
Cores
1.5 GHz
minimum

2 GB

50 GB

50
MB/sec
50
MB/sec
1.5
MB/sec

up to 5

5 K max

Small

Linux (32
& 64-bit)
Windows
(32 &
64-bit)

4 CPU
Cores
1.5 GHz
minimum

4 GB

100 GB

50
MB/sec
50
MB/sec
1.5
MB/sec

6-10

25 K
max

AppDynamics for Databases Requirements

AppDynamics for Databases is an on-premise solution and can be installed on the same server as
the AppDynamics Pro Controller, or on a different server. In either case it requires 1 CPU and
2GB of RAM to monitor a single database instance. If you install it on the Controller server, these
resources are in addition to the Controller resources. Also, change the default port number so it
doesn't conflict with the Controller. See Prevent and Resolve Port Number Conflicts.
Network

AppDynamics requires the following network configurations:
Every app agent, and therefore every server on which an agent is installed, needs to be able
to communicate with a Controller using HTTP(S) on a port of your choosing (8090 and 8091
are the defaults). For SaaS, use 80 or 443.
Browsers used to view the AppDynamics UI need access to the Controller on one or both of
those ports.
(On-Premise) The Controller must be able to access the internet on port 443 to enable
AppDynamics' End User Monitoring feature, because it retrieves aggregated web view stats
from agg.eum-appdynamics.com.
AppDynamics for Databases must be able to connect as a JDBC client to the database to be
monitored, and be accessible on its HTTP listen port from browsers used to view its UI.
Any load balancers between Java components in the network must not strip the
AppDynamics correlation headers from the HTTP traffic.
Getting Started

There is a getting started guide in the documentation. In summary, you:
(For On-Premise) Install the AppDynamics Controller on the server provided for it and apply
the license file
Install the Java Agent, Install the .NET Agent, Install the PHP Agent, and Install the Node.js
Agent
Enable End User Monitoring in the Controller
Add the javascript EUM agent to the application's web pages
Install AppDynamics for Databases on the server provided for it
Add a collector for your database instance(s)
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Configure the integration between AppDynamics and AppDynamics for Databases
Install the Standalone Machine Agent to get additional infrastructure metrics and to use a
monitoring extension.
At this point, AppDynamics should be configured and monitoring all traffic flowing through the
application.

Supported Environments and Versions
Supported Platform Matrix for the AppDynamics Controller
Controller Operating System Requirements
Supported Web Browsers for the Controller UI
LDAPv3 Support
Supported Platform Matrix for the Java Agent
JVM Support
JVM Language Frameworks Support
Application Servers
Application Server Configuration
Message Oriented Middleware Support
Message Oriented Middleware Configuration
JDBC Drivers and Database Servers Support
Business Transaction Error Detection
NoSQL/Data Grids/Cache Servers Support
NoSQL/Data Grids/Cache Servers Configuration
Java Frameworks Support
Java Frameworks Configuration
RPC/Web Services API Support
RPC/Web Services API Framework Configuration
Supported Platform Matrix for the .NET Agent
Supported Runtime Environments
OS Versions
Microsoft .NET Frameworks
Runtime Environments
Microsoft Windows Azure
Unsupported Frameworks
Automatically Discovered Business Transactions
Supported Loggers for the .NET Agent
Remote Service Detection
Supported Windows Azure Remote Services
Data Storage Detection
Supported ADO.NET Clients
Supported Platform Matrix for the PHP Agent
PHP Versions
PHP 5.2 Note
PHP ZTS Note
PHP Web Servers
Operating Systems
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Architecture
PHP Frameworks and Protocols
Transaction Naming
HTTP Exit Points
Database Exit Points
Cache Exit Points
Web Service Exit Points
Message Queue Exit Points
Opcode Cache Compatibility
Correlation with AppDynamics for Databases
Supported Platform Matrix for the Node.js Agent
Node.js Versions
Operating Systems
Transaction Naming
HTTP Exit Points
Database Exit Points
Cache Exit Points
Supported Platform Matrix for the Standalone Machine Agent
Supported Platforms for Default Hardware Monitor Plugin
Supported Platform Matrix for Web EUEM
Web End User Experience Management Browser Compatibility
Web End User Experience Management (EUEM) Compatibility in Java Environments
Web End User Experience Management (Web EUEM) Compatibility in .NET
Environments
Supported Runtime Environments for .NET Web EUEM
Supported Platform Matrix for Mobile EUEM
Operating Systems
iDevice Architecture
iOS Environments
Android Environments
Supported Compute Clouds for Automating Workflow
Supported Platform Matrix for the AppDynamics Controller
Controller Operating System Requirements

The Controller is supported on the following Operating Systems:
Linux (32 and 64-bit)
Red Hat Enterprise Linux (RHEL) 6.1, 6.2;
RHEL 6.3, 6.4, and 6.5.
CentOS 6.1, 6.2; CentOS 6.3, 6.4, and 6.5.
Fedora 14
Ubuntu 8, 12
Open SUSE 11.x
SUSE Linux Enterprise Server
Cloud: Amazon EC2, Rackspace, Azure
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Microsoft Windows (32 and 64-bit)
Windows Server 2003
Windows Server 2008, Windows Server
2008 R2
Windows Server 2012 R1 Standard and
Datacenter, Windows Server 2012 R2
Standard and Datacenter
Windows 7 Pro
Windows 8
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Supported Web Browsers for the Controller UI

The AppDynamics UI works best with the latest version of any modern browser along with the latest
version of Flash. The Controller UI has been tested with the following browsers and versions:

IE 9+
Safari 6+
Chrome 16+
Firefox 6+
Opera and older versions of Firefox, IE, and Safari browsers may still operate well but some
features may not display as intended.
The Controller UI requires Flash Player 10 or greater; AppDynamics recommends version 11.
LDAPv3 Support

You can use an external directory server to authenticate and authorize user access to the
Controller UI. The Controller works with directory servers that comply with LDAP (Lightweight
Directory Access Protocol) version 3. While the Controller should be able to work with any
LDAPv3-compliant server, it has been verified against these LDAP products:
Microsoft Active Directory for Windows Server 2008 SP2+
OpenLDAP, 2.4+
See Administer the Controller.
Supported Platform Matrix for the Java Agent
JVM Support
JVM Language Frameworks Support
Application Servers
Application Server Configuration
Message Oriented Middleware Support
Message Oriented Middleware Configuration
JDBC Drivers and Database Servers Support
Business Transaction Error Detection
NoSQL/Data Grids/Cache Servers Support
NoSQL/Data Grids/Cache Servers Configuration
Java Frameworks Support
Java Frameworks Configuration
RPC/Web Services API Support
RPC/Web Services API Framework Configuration
Supported Platform Matrix for the Java Agent

This page documents known environments in which the Java Agent has been used to instrument
applications. The Java Agent can target specific Java bytecode. This provides wide-ranging
flexibility, so if an environment is not listed here, this does not preclude the Java Agent from being
able to extract valuable performance metrics. Contact AppDynamics Support or Sales for
additional details.
Notes:
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A dash ("-") in a table cell indicates that this column is not relevant or not supported for that
particular environment.
In cases where no version is provided, assume that all versions are supported. Contact
AppDynamics Support or Sales for confirmation.
For environments that require additional configuration, a separate table describing or linking
to configuration information follows the support matrix.
For environments supported by AppDynamics End User Monitoring, see Supported
Environments and Versions - Web EUM.
JVM Support

These are the known JVM environments in which the Java Agent has been used to instrument
applications.
Vendor

Implem
entation

Version

Operati
ng
System

Object
Instance
Trackin
g

Automat
ic Leak
Detectio
n

Custom Memory Structures

Content
Inspecti
on

Access
Trackin
g

Require
s JVM
Restart
?

Oracle

Java
HotSpot

7
Update
45+

Solaris
Sparc
64,
Window
s, Linux

-

-

-

-

-

Oracle

Java SE
(Standa
rd
Edition)
New in
3.9

8

Solaris
Sparc
64,
Window
s, Linux

Yes

Yes

Yes

Yes

Yes

BEA

JRockit

1.5

-

-

Yes

Yes

Yes

Yes

BEA

JRockit

1.6, 1.7

-

-

Yes

Yes

-

-

Oracle

JRockit
JVM

28.1+

Linux
Intel 64
Window
s

-

-

-

-

-

IBM

JVM

1.5.x,
1.6.x,
1.7.x

-

-

-

-

-

-

SUN

JVM

1.5, 1.6,
1.7

-

Yes

Yes

Yes

Yes

-

Copyright © AppDynamics 2012-2014

Page 64

Open
Source

OpenJD
K

1.6

Linux,
window
s,
everywh
ere

-

Yes

-

-

-

HP

OpenV
MS

-

-

-

-

-

-

-

Notes:
Both JDKs and JREs Supported
Object instance tracking, automatic leak detection, and custom memory structure monitoring
are not supported with the IBM Java Agent on an IBM JVM. As a workaround, to get
automatic leak detection and custom memory structure monitoring, you can use the Java
agent for Sun and JRockit JVM on the IBM JVM. However, doing so will likely result in a
negative performance impact. In either case, object instance tracking is not supported on
IBM JVM's.
All JVMs must be restarted after enabling the Automatic Leak Detection feature.
For examples of instrumenting new language constructs in Java SE 8, see Instrumenting
New Constructs Available in Java 8.
JVM Language Frameworks Support

No additional configuration is required for these frameworks.
Vendor

JVM
Language
Framework

Version

Correlation/
Entry
Points

Exit Points

Transports

Notes

Open
Source /
Typesafe
Reactive Pl
atform

Akka Actor

2.1 - 2.3

Yes

Yes

Netty

Remoting
exit/entry
supported.
Persistenc
e
(experimen
tal module
in v2.3) is
not
currently
supported.

Open
Source

Groovy

-

Yes

Yes

Open
Source /
Typesafe
Reactive
Platform

Play for
Scala

2.1 - 2.3

Yes

-

HTTP over
Netty

Includes
framework
specific
entry points
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Open
Source /
Typesafe
Reactive
Platform

Spray.io

-

No

No

No

Pivotal

Grails

-

-

-

-

Currently
not
supported

The Typesafe Reactive Platform is a JVM-based runtime and collection of tools used to build reacti
ve applications. This includes Scala, Play, Akka, and Spray.io.
Application Servers

These are the known application server environments in which the Java Agent has been used to
instrument applications. Some require additional configuration. Click the link on the server or OSGi
Runtime name in the following support matrix for information about additional configuration
required or related configuration topics. Application servers are usually found by the Java Agent as
an entry point.
Vendor

Applicatio
n Server /
OSGi
Runtime

Version

SOA
Protocol

RMI
Supported

JMX

Entry
Points

Apache

Felix

-

-

-

-

Yes

Apache

Sling

-

-

-

-

Yes

Apache

Tomcat

5.x, 6.x,7.x

-

-

Yes

Apache

Resin

1.x - 4.x

-

-

-

-

Adobe

Cold
Fusion

8.x, 9.x

-

No

-

Yes

Equinox

-

-

-

-

Yes

Eclipse

Jetty

6.x, 7.x

-

-

-

-

IBM

InfoSphere

8.x

-

-

-

Yes

IBM

WebSpher
e

6.1

JAX-WS

-

-

Yes

IBM

WebSpher
e

7.x

JAX-WS

Yes, detect
and
correlate

Yes for
WebSpher
e PMI

Yes

IBM

WebSpher
e

8.x

JAX-WS

Yes, detect
and
correlate

-

Yes

Open
Source

Liferay
Portal

-

-

-

-

-
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GlassFish
Enterprise
Server

2.x

-

-

Yes

Yes

Oracle

GlassFish
Server and
GlassFish
Server
Open
Source
Edition

3.1+

-

-

Yes for
AMX

Yes

Oracle and
BEA

WebLogic
Server

9.x+

JAX-WS

Yes, detect
and
correlate
for 10.x

Yes

Yes

Application
Server
(OC4J)

-

-

Yes, detect
and
correlate
for 10.x

-

Yes

-

Grails, with
Tomcat
7.x,
Glassfish
v3,
Weblogic
12.1.1
(12c)

-

-

-

-

-

JBoss
Server

7+

-

-

-

Yes

-

JBoss
Server

4.x, 5.x

-

Yes, detect
and
correlate

-

Yes

JBoss AS

6.x, 7.x
standalone
)

JBoss EAP

6.11, 6.2.0

Application Server Configuration

For application server environments that require additional configuration, this section provides
some information and links to topics that help you configure the environment. Environments in the
Application Server Support table that require additional configuration, link to the configuration table
below.
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Application Server

Topics for Required and Optional
Configuration

Apache Felix

To configure Apache Felix for Glassfish
To configure Felix for Jira or Confluence
See also Unable to get metrics from the
Java App Server Agent on GlassFish

Apache Sling

OSGi Infrastructure Configuration#To
configure Apache Sling

Apache Tomcat

Apache Tomcat Startup Settings
Tomcat as a Windows Service
Configuration

Apache Resin

Resin Startup Settings

Apache Cold Fusion

Configuration is required for transaction
discovery, see
Servlet Entry Points

Equinox

To configure Eclipse Equinox

Eclipse Jetty

Jetty Startup Settings

IBM InfoSphere

IBM WebSphere and InfoSphere Startup
Settings

IBM WebSphere

IBM WebSphere and InfoSphere Startup
Settings

Sun GlassFish Enterprise Server

GlassFish JDBC connection pools can be
manually configured using MBean attributes
and custom JMX metrics
GlassFish Startup Settings
Modify GlassFish JVM Options

Oracle GlassFish Server

including GlassFish Server Open Source
Edition
GlassFish Startup Settings
Modify GlassFish JVM Options

Oracle and BEA WebLogic Server

Oracle WebLogic Startup Settings

JBoss Server

JBoss and Wildfly Startup Settings

Message Oriented Middleware Support

These are the known message oriented middleware environments in which the Java Agent has
been used to instrument applications. Some require additional configuration. Click the link on the
messaging server name in the following support matrix for information about additional
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configuration required or related configuration topics. Message oriented middleware servers are
usually found by the Java Agent as an entry point.
Vendor

Messaging
Server

Version

Protocol

Correlatio
n/Entry
Points

Exit Points

JMX

Apache

ActiveMQ

5.x+

JMS 1.x

Yes

Yes

Yes

Apache

ActiveMQ

5.x+

STOMP

No

-

Yes

Apache

ActiveMQ

5.8.x+

AMQP 1.0

No

-

Yes

Apache

ActiveMQ

5.x+

SOAP

Yes

-

Yes

Apache

Axis

1.x, 2.x

JAX-WS

Yes

Yes

-

Apache

Apache
CXF

2.1

JAX-WS

Yes

Yes

-

Apache

Synapse

2.1

HTTP

Yes

Yes

-

Fiorano

Fiorano
MQ

-

-

-

-

IBM

IBM MQ

6.x, 7.x

-

-

-

-

IBM

IBM Web
Application
Server (WA
S)

6.1+, 7.x

Embedded
JMS

-

Yes

-

IBM

IBM
WebSpher
e MQ

-

JMS

Yes

Yes

-

JBoss MQ

4.x

-

-

-

Yes

JBoss

JBoss
Messaging

5.x

-

-

-

Yes

JBoss

HornetQ

-

-

-

-

Yes

Open MQ

-

-

-

-

-

Mulesoft

Mule ESB

3.4

HTTP

Yes

Yes

-

Oracle

Jave
Message
Service
New in 3.9

2.0

JMS

correlation
of the
listener
is disabled
by default

Yes

Oracle

Oracle AQ

-

JMS

-

Yes
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Oracle /
BEA

WebLogic

9.x+

JMS 1.1

Yes

Yes

Yes

Progress

SonicMQ

-

-

-

-

-

Pivotal

RabbitMQ

-

HTTP

-

Yes

-

Rabbit

RabbitMQ
Spring
Client

-

-

Yes

Yes

-

Spring

Spring
Integration

2.2.0

JMS

Yes

Yes

Yes

Message Oriented Middleware Configuration

For message oriented middleware environments that require additional configuration, this section
provides some information and links to topics that help you configure the environment.
Environments in the Message Oriented Middleware Support table that require additional
configuration, link to the configuration table below.
Messaging Server
Apache ActiveMQ
Apache Axis

Topics for Required and Optional
Configuration
JMS Message Queue Exit Points
Default exclude rules exist for Apache Axis,
Axis2, and Axis Admin Servlets. See also,
Web Service Entry Points

Apache Synapse
IBM MQ

To enable correlation, set node property en
able-soap-header-correlation=true.
No additional configuration is required.
See also, Default Backends Discovered by the
App Agent for Java

IBM Web Application Server

No additional configuration is required. See
also,
JMS Message Queue Exit Points

IBM WebSphere MQ

IBM Websphere MQ Message Queue Exit
Points

Mule ESB

Mule ESB Startup Settings
Mule ESB Support
See also HTTP Exit Points for Java

BEA WebLogic

Oracle WebLogic Startup Settings
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Pivotal RabbitMQ

No additional configuration is required. See
also,
Default Backends Discovered by the App
Agent for Java and
RabbitMQ Message Queue Exit Points

RabbitMQ Spring Client

No addition configuration is required, See also,
Message Queue Exit Points for Java

Spring Integration

Spring Integration Support
See also, JMS Message Queue Exit Points

JDBC Drivers and Database Servers Support

These are the known JDBC driver and database server environments in which the Java Agent has
been used to instrument applications. AppDynamics can follow transactions using these drivers to
the designated database.
JDBC Vendor

Driver Version

Driver Type

Database
Server

Database
Version

Apache

10.9.1.0

Embedded or
client

Derby

-

Apache

-

-

Cassandra

-

Progress

DataDirect

data connectivity
for ODBC and
JBDC driver
access, data
integration, and
SaaS and cloud
computing
solutions

-

-

IBM

JDBC 3.0
version 3.57.82
or JDBC 4.0
version 4.7.85

DB2 Universal
JDBC driver

DB2

9.x

IBM

JDBC 3.0
version 3.66.46
or JDBC 4.0
version 4.16.53

DB2 Universal
JDBC driver

DB2

10.1

IBM

-

Type IV

Informix

-

Microsoft

4

Type II

MS SQL Server

2012*

Oracle MySQL,
MySQL
Community

5.x

Type II, Type IV

MySQL

5.x
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Open Source

Connector/J
5.1.27

Type IV

MySQL

5.x

Open Source

-

Type IV

Postgres

8.x, 9.x

Oracle

9.x

Type II, Type IV

Oracle Database

8i+

Sybase

jConnect

Type IV

Sybase

-

Teradata

-

Teradata
New in 3.9
Notes:

Type II is a C or OCI driver
Type IV is a thin database client and is a pure Java driver
Business Transaction Error Detection

The Java Agent supports the following logging frameworks for business transaction error
detection:
Log4j
java.util.logging
If you are using a different logger, see Configuring Error Detection Using Custom Loggers.
NoSQL/Data Grids/Cache Servers Support

These are the known NoSQL, data grids and cache server environments in which the Java
Agent has been used to instrument applications. Some require additional configuration. Click the
link on the database, data grid or cache name in the following support matrix for information about
additional configuration required or related configuration topics.
Vendor

Database/Data
Grid/Cache

Version

Correlation/Entry
Points

JMX

Apache

Casandra (Data
Stax, REST) and
Cassandra
CQL3

1.x

Correlation

Yes

Apache

Apache Lucene Apache Solr

1.4.1

Entry Points

Yes

JBoss

JBoss Cache
TreeCache

-

-

-

Terracotta

EhCache

-

-

-

Open Source

Memcached

-

-

-

Open Source

MongoDB

-

-

-

Oracle

Coherence

3.7.1

Custom-Exit

Yes
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JBoss

Infinispan

5.3.0+

Correlation

-

NoSQL/Data Grids/Cache Servers Configuration

For NoSQL, data grids, and cache server environments that require additional configuration, this
section provides some information and links to topics that help you configure the environment.
Environments in the NoSQL/Data Grids/Cache Servers Support table that require additional
configuration, link to the configuration table below.
Database/Data Grid/Cache

Topics for Required or Optional
Configuration

Apache Cassandra (DataStax, REST) and
Cassandra CQL3

Cassandra Exit Points for Java
Apache Cassandra Startup Settings
Default Backends Discovered by the App
Agent for Java

Apache Lucene - Apache Solr

Solr Startup Settings

JBoss

JBoss Startup Settings

Terracotta EhCache

EhCache Exit Points

Open Source Memcached

Memcached Exit Points

Open Source MongoDB

Configurations for Custom Exit Points for
Java

Oracle Coherence

Coherence Startup Settings

Java Frameworks

Support

These are the known Java framework environments in which the Java Agent has been used to
instrument applications. Some require additional configuration. Click the link on the Java
framework name in the following support matrix for information about additional configuration
required or related configuration topics.
Vendor

Framewo
rk

Version

SOA
protocol
(WebSer
vices)

Auto
Naming

Entry
Points

Adobe

BlazeDS

-

HTTP
and JMS
adaptor

-

Yes
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Adobe

ColdFusi
on

8.x, 9.x

-

-

Yes

-

Configura
tion
required
for
transactio
n
discovery

Apache

Cassandr
a with
Thrift fra
mework

-

-

-

Yes

Yes

Apache
Thrift
Entry and
Exit
points are
detected

Apache

Struts

1.x, 2.x

-

-

Yes

Apache

Tapestry

5

-

-

Yes

-

Not by
default

Wicket

-

-

No

Yes

-

Not by
default

WebObje
cts

5.4.3

HTTP

Yes

Yes

-

Yes

CometD

2.6

HTTP

Yes

Yes

-

-

Eclipse

RCP
(Rich
Client
Platform)

-

-

-

-

-

-

Google

Google
Web
Toolkit
(GWT)

2.5.1

HTTP

Yes

Yes

-

-

JBoss

JBossWS
Native
Stack

4.x, 5.x

Native
Stack

-

-

-

-

Apple
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Open
Source

Direct
Web
Remoting
(DWR)

-

-

-

-

-

-

Open
Source

Enterpris
e Java
Beans (E
JB)

2.x, 3.x

-

-

Yes

-

-

Open
Source

Grails

-

-

-

Yes

-

Not by
default

Open
Source

Hibernate
JMS Liste
ners

1.x

-

-

-

-

-

Open
Source

Java
Abstract
Windowin
g Toolkit
(AWT)

-

-

-

-

-

-

Open
Source

Java
Server
Faces (J
SF)

1.x

-

Yes

Yes

-

Not by
default

Open
Source

Java
Server
Pages

2.x

-

Yes

-

-

Yes

Open
Source

Java
Servlet
API

2.x

-

-

-

-

-

Open
Source

Jersey

1.x, 2.x

REST,
JAX-RS

Yes

Yes

No

Not by
default

Open
Source

WebSock
et

1.0 (Java
EE 7,
JSR-356)

-

Yes,
BT
Naming
not
configura
ble

Yes,
correlatio
n
not
supporte
d

Yes

Detection
is
automatic

Open
Source Google

AngularJ
S

-

-

-

Yes

-

-

Copyright © AppDynamics 2012-2014

Page 75

Oracle

Coherenc
e with
Spring
Beans

2.x, 3.x

-

-

-

-

-

Oracle

Swing
(GUI)

-

-

-

-

-

-

Oracle

WebCent
er

10.0.2,10
.3.0

-

-

-

-

-

Open
Source

JRuby
HTTP

-

-

-

Yes

-

Not by
default

Spring

Spring
MVC

-

-

-

Yes

-

Not by
default

Java Frameworks Configuration

For the Java framework environments that require additional configuration, this section provides
some information and links to topics that help you configure the environment. Environments in the
Java Frameworks Support table that require additional configuration, link to the configuration table
below.
Java Framework
Adobe BlazeDS
Adobe ColdFusion

Topics for Required or Optional
Configuration
Message Queue Exit Points for Java
Configuration is required for transaction
discovery
Java Web Application Entry Points
Servlet Entry Points

Apache Cassandra with Thrift framework

No additional configuration is required. See
also,
Default Backends Discovered by the App
Agent for Java

Apache Struts

Struts Entry Points

Apache Tapestry

Java Web Application Entry Points
Servlet Entry Points

Wicket

Java Web Application Entry Points
Servlet Entry Points
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Apple WebObjects

Business transaction naming can be
configured via getter-chains, see
Getter Chains in Java Configurations
Identify Transactions Based on POJO
Method Invoked by a Servlet

CometD

See also, HTTP Exit Points for Java

Open Source Enterprise Java Beans (EJB)

EJB Entry Points

Open Source Hibernate JMS Listeners

No additional configuration is required. See
also,
Advanced Options in Call Graphs

Open Source Java Server Faces (JSF)

Java Web Application Entry Points and Ser
vlet Entry Points

Open Source Java Server Pages

Servlet Entry Points

Open Source Jersey

JAX-RS Support and node properties:
rest-num-segments
rest-transaction
rest-uri-segment-scheme

Open Source JRuby HTTP

Java Web Application Entry Points
Servlet Entry Points

Open Source WebSocket

Node property: websocket-entry-calls-enabled

Spring MVC

Java Web Application Entry Points
Servlet Entry Points

RPC/Web Services API Support

These are the known Java framework environments in which the Java Agent has been used to
instrument applications. Some require additional configuration. Click the link on the RPC, web
services or API framework name in the following support matrix for information about additional
configuration required or related configuration topics.
Vendor

RPC/W
eb
Service
s API
Framew
ork

Version

SOA
Protocol
WebSer
vices

Auto
Naming

Correlati
on/Entry
Points

Exit
Points

Configur
able BT
Naming
Properti
es

Detectio
n

Apache

Apache
CXF

2.1

JAX-WS

Yes

Yes

Yes

Yes

Yes
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Apache

Apache
Commo
ns

-

HTTP
Client

Yes

Yes

Yes

-

Yes

Apache

Apache
Thrift

-

-

Yes

Yes

Yes

Yes

Yes

IBM

WebSp
here

6.x

JAX-RP
C

-

-

-

-

-

IBM

WebSp
here

7.x, 8.x

JAX-RP
C

-

-

-

-

-

IBM

Websph
ere

7.x, 8.x

IIOP

-

-

-

-

-

JBoss

JBoss

4.x, 5.x

RMI

Yes

Yes

Yes

Yes

Yes

Open
Source

java.net.
Http

-

HTTP

Yes

-

Yes

Yes

Yes

Oracle

GlassFi
sh
Metro

-

JAX-WS

-

-

-

-

-

Oracle

GlassFi
sh
Metro
with
Grails

-

JAX-WS

-

Yes

-

-

Not by
Default

Oracle

Oracle
Applicati
on
Server

ORMI

-

no

-

-

-

-

Oracle

WebLog
ic

10.x

T3, IIOP

Yes

Correlati
on: Yes,
Entry:
No

Yes

-

Yes

Oracle

WebLog
ic

9.x, 10.x

JAX-RP
C

-

-

-

-

-

Sun

Sun
RMI

-

IIOP

-

Not by
Default

-

-

-

Sun

Sun
RMI

-

JRMP

-

By
Default

Yes

host/por
t

Yes

-

Web
Service
s

-

SOAP
over
HTTP

-

Yes

Yes

-

-
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RPC/Web Services API Framework Configuration

For the RPC and web service API environment that require additional configuration, this section
provides some information and links to topics that help you configure the environment.
Environments in the RPC/Web Services API Framework Support table that require additional
configuration, link to the configuration table below.
RPC/Web Services API

Topics for Required or Optional
Configuration

Apache Commons

HTTP Exit Points for Java

Apache Thrift

Binary Remoting Entry Points for Apache
Thrift
Default Backends Discovered by the App
Agent for Java

IBM WebSphere

IBM WebSphere and InfoSphere Startup
Settings,
App Agent for Java on z-OS or Mainframe
Environments Configuration See also,
Unable to browse MBeans on
WebSphere Application Server,
Default configuration excludes
WebSphere classes

JBoss

JBoss and Wildfly Startup Settings

Open Source java.net.Http

HTTP Exit Points for Java

Oracle WebLogic

Oracle WebLogic Startup Settings
Default configuration excludes WebLogic
classes

Web Services

Create Match Rules for Web Services
Web Service Entry Points
Web Services Exit Points for Java

Supported Platform Matrix for the .NET Agent
Supported Runtime Environments

This section lists the environments where the .NET Agent does some automatic discovery after
little or no configuration.
OS Versions

Microsoft* Windows* Server 2003 (32-bit and 64-bit)
Microsoft Windows Server 2008 (32-bit and 64-bit)
Microsoft Windows Server 2008 R2
Microsoft Windows Server 2012
Microsoft .NET Frameworks
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Microsoft .NET Framework versions 2.0, 3.0, 3.5, 4.0, 4.5
Runtime Environments

Microsoft IIS versions 6.0, 7.0, 7.5, 8.0, 8.5
Microsoft SharePoint 2010, 2013 as services running inside IIS
Managed Windows Services
Managed Standalone Applications
Microsoft Windows Azure

Windows Azure Cloud Services (Web Roles and Worker Roles)
Unsupported Frameworks

Microsoft .NET versions 1.0, 1.1
Unmanaged native code
Windows Azure Web Sites
Automatically Discovered Business Transactions

The .NET Agent discovers BTs for the following frameworks by default. The agent enables
detection without additional configuration.
Type

Custom Configuration
Options

Downstream Correlation

ASP.NET

Yes

Yes

ASP.NET MVC 2
ASP.NET MVC 3
ASP.NET MVC 4
ASP.NET MVC 5

Yes

Yes

.NET Remoting

No

Requires configuration.
See Enable Correlation for
.NET Remoting.

Windows Communication
Foundation (WCF)

No

Yes

Web Services including SOAP

No

Yes

No

Yes

IBM WebSphere MQ

No

Yes

RabbitMQ

Yes

Yes

No

Yes

Message Queues
Apache ActiveMQ NMS
framework and related MQs

TIBCO Enterprise Message
Service
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TIBCO Rendezvous

No

Yes

The App Agent for .NET automatically discovers entry points for ASP.NET web forms with
the Async property set to "true" in the Page directive.
Supported Loggers for the .NET Agent

Log4Net
NLog
System Trace
Windows Event Log
If you are using a different logger, see Custom Logger Definitions.
Remote Service Detection

The .NET Agent automatically detects the following remote service types. The agent enables
detection by default. You don't need to perform extra configuration.
Type

Custom
Configuration
Options

Async Detection †

Downstream
Correlation

Directory Services,
including LDAP

No

No

N/A

HTTP

Yes

Requires
configuration.
See Monitor Async
Transactions for .NET
.

Yes

.NET Remoting

Yes

No

Requires
configuration.
See Enable
Correlation for .NET
Remoting.

WCF

Yes

Requires
configuration.
See Monitor Async
Transactions for .NET
.

Yes

WCF Data Services

Yes

No

No

Web Services,
inlcuding SOAP

Yes

Requires
configuration.
See Monitor Async
Transactions for .NET
.

Yes

Message Queues
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Apache ActiveMQ
NMS framework and
related MQs

Yes

No

Yes

IBM WebSphere
MQ (IBM XMS)

Yes

No

Yes

Microsoft Message
Queuing (MSMQ)

Yes

No

N/A

Microsoft Service
Bus / Windows Azure
Service Bus

No

No

Yes

TIBCO Enterprise
Message Service

Yes

No

Yes

Yes

No

Yes

No

No

No

TIBCO Rendezvous
Windows Azure
Queue

† The agent discovers asynchronous transactions for the Microsoft .NET 4.5 framework. See
Monitor Async Transactions for .NET for details.

Supported Windows Azure Remote Services

Type

Configuration
can be customized

Downstream
Correlation

Azure Blob

No

No

Azure Queue

No

No

Microsoft Service Bus

No

Yes

Data Storage Detection

The .NET Agent automatically detects the following data storage types. The agent enables
detection by default. You don't need to perform extra configuration.
Type

Configuration Can
Be Customized

AppD for Databases?

ADO.NET (see supported
clients below)

Yes

No

Windows Azure Blob Storage

No

No

Supported ADO.NET Clients

AppDynamics can monitor any ADO.NET client version and type. Clients we've tested include the
following:
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Database Name

Database Version

Client Type

Oracle

10, 11, 12

ODP.NET

Oracle

10, 11, 12

Microsoft Provider for Oracle

MySQL

5.x

Connector/Net and ADO.NET

Microsoft SQL Server *

2005, 2008, 2012

ADO.NET

* Microsoft, SQL Server, and Windows are registered trademarks of Microsoft Corporation in
the United States and other countries.
Supported Platform Matrix for the PHP Agent
PHP Versions

Supported PHP Versions

Comment

5.2

Does not detect mysqli backends instantiated
with the new keyword. See note below.

5.3
5.4
5.5
PHP 5.2 Note

The PHP Agent is incompatible with PHP 5.2 applications that use the new keyword to instantiate
a mysqli backend.
For example, AppDynamics will not detect the mysqli backend created by a PHP 5.2 application
that uses an expression like this:
// Does not get detected.
$db = new mysqli("localhost", "user", "password", "database");

The workaround is to change such expressions to use mysqli_connect():
$db = mysqli_connect("localhost", "user", "password", "database");

PHP ZTS Note

The PHP Agent is incompatible with the mode of PHP called Zend Thread Safety (ZTS).
If you are using ZTS, AppDynamics suggests that you review your dependencies on ZTS to
confirm that you actually need it, and if you do not, to switch to non-ZTS mode.
If you have a legacy infrastructure which requires ZTS or an app library that needs it, such as
pthreads, contact AppDynamics Support.
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PHP Web Servers

Supported Web Server

Version

Comment

Apache

2.2

in prefork mode using
mod_php

Apache

2.4

in prefork mode using
mod_php

Apache

2.2

in worker MPM mode using
mod_fastcgi with php-fpm or
mod_fcgid with php-cgi

Apache 2.4

2.4

in worker MPM mode using
mod_fastcgi with php-fpm or
mod_fcgid with php-cgi

Supported Operating
System

Version

Comment

RHEL/CentOS

5.8+

SELinux is disabled.

Ubuntu/Debian

10+

SELinux is disabled.

Any Web Server compatible
with php-fpm

Operating Systems

Architecture

Supported Architecture
32-bit
64-bit
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PHP Frameworks and Protocols

Framework/Protocol

Version

Entry Point Type

Drupal

7

Drupal entry

WordPress

3.4 & 3.5

Wordpress

Zend

1&2

PHP MVC

CodeIgniter

2.x

PHP MVC

FuelPHP

1.5x & 1.6x

PHP MVC

Magento

1.5, 1.6 & 1.7

PHP MVC

Symfony

1&2

PHP MVC

CakePHP

2.x

PHP MVC

HTTP

PHP Web

CLI

PHP CLI

If your PHP framework is not listed here, the agent detects your entry points as PHP Web and
names the business transactions based on the first two segments of the URI (the default naming
convention for PHP Web transactions). So it is still possible to monitor applications on
"unsupported" frameworks. You can modify the naming convention used for PHP Web Entry
points. See PHP Web Transaction Naming.
Transaction Naming

Framework/Environment

Default Transaction Naming

Drupal

page callback name

Wordpress

template name

PHP MVC Frameworks

controller:action

PHP Modular MVC Frameworks

module:controller:action

PHP Web

URI

PHP Web Service

service name.operation name

PHP CLI

last two segments of the script's directory path
plus the name of the script

Virtual host prefixing is available for all supported entry point types except PHP CLI.
HTTP Exit Points

Supported HTTP Exit Points
curl/curl-multi
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drupal_http_request()
fopen(), file_get_contents()
NuSOAP 0.9.5
Zend_HTTP_Client::request()
Database Exit Points

Supported Database Exit Points
MySQL old native driver
MySQLi Extension
OCI8
PDO
Cache Exit Points

Supported Cache Exit Points

Version

Memcache
Memcached
Predis

0.8.5

Predis is supported on PHP versions 5.3 and higher.
Although Predis is a full PHP client library, the PHP Agent supports Predis as an exit point only,
not as an entry point.
Web Service Exit Points

Supported Web Service Exit Points
NuSOAP 0.9.5
Message Queue Exit Points

Supported Message Queue Exit Points
RabbitMQ
RabbitMQ support requires the amqp extension.
See also Monitor RabbitMQ Backends for PHP.
Opcode Cache Compatibility

Alternative PHP Cache (APC)

Copyright © AppDynamics 2012-2014

Page 86

Correlation with AppDynamics for Databases

AppDynamics for Databases version 2.7.4 or higher is required if you want to correlate
AppDynamics for Databases with the PHP Agent.
Supported Platform Matrix for the Node.js Agent
Node.js Versions

Supported Node.js Versions
0.8
0.10
Operating Systems

Supported Operating System
Linux 32-bit
Linux 64-bit
Mac OSX v10.9.2
Transaction Naming

Entry Type

Default Transaction Naming

Node.js Web

URI

HTTP Exit Points

Supported HTTP Exit Points
Node.js HTTP client library
See http://nodejs.org/api/http.html for information about the Node.js HTTP client library.
Database Exit Points

Supported Database Exit Points
MongoDB
MySQL
PGSQL
Cache Exit Points

Supported Cache Exit Points
Memcached
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Redis
Supported Platform Matrix for the Standalone Machine Agent

The standalone Machine Agent provides platform-level metrics. It has a default built-in plugin for
hardware monitoring. See Install the Standalone Machine Agent.
Supported Platforms for Default Hardware Monitor Plugin

Operating System

Architecture

Versions

Linux

x86

2.2, 2.4, 2.6 kernels

Linux

amd64

2.6 kernel

Linux

ppc

2.6 kernel

Linux

ppc64

2.6 kernel

Linux

ia64

2.6 kernel

Linux

s390

2.6 kernel

Linux

s390x

2.6 kernel

Solaris

Sparc-32

2.6, 7, 8, 9, 10

Solaris

Sparc-64

2.6, 7, 8, 9, 10

Solaris

x86

8, 9, 10

Solaris

x64

8, 9, 10

AIX

ppc

4.3, 5.1, 5.2, 5.3, 6.1

AIX

ppc64

5.2,5.3,6.1

HP-UX

PA-RISC

11

HP-UX

ia64

11

FreeBSD

x86

4.x

FreeBSD

x86

5.x, 6.x

FreeBSD

x64

6.x

FreeBSD

x86,x64

7.x,8.x

OpenBSD

x86

4.x,5.x

NetBSD

x86

3.1

Mac OS X

PowerPC

10.3, 10.4

Mac OS X

x86

10.4, 10.5, 10.6

Mac OS X

x64

10.5, 10.6
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Windows

x86

NT 4.0, 2000 Pro/Server,
2003 Server, XP, Vista, 2008
Server, 7

Windows

x64

2003 Server, Vista, 2008
Server, 7

The following Linux distributions have been certified:
Distribution

Versions

Red Hat

6.2, 7.3, 8.0, 9.0

RHEL

3, 4, 5, 6

CentOS

3, 4, 5

Fedora

2, 3, 4, 5, 6, 7, 8, 9, 10

SuSE

8, 9, 10, 11

Ubuntu

6.06, 8.04, 8.10, 9.04

Debian

2.6, 3.0, 3.1, 3.2, 4.0, 5.0

VMware ESX

2.x, 3.0

XenServer

3.1, 3.2, 4.0, 4.1, 5.0

Slackware

10, 11

Mandrake

10

Scientific Linux

5

Gentoo
Note: If you are using a 64-bit Operating System, use only a 64-bit Java Runtime Environment
(JRE). For more details see Supported Platform Matrix for Default Hardware Monitoring Plugin.
Supported Platform Matrix for Web EUEM
Web End User Experience Management Browser Compatibility

The following Web browsers are certified for the JavaScript agent for Web EUEM.
Browser

Windows

Linux

Mac

iOS
(iPhone
and iPad)

Android
(Phone
and
Tablet)

Supports
Resource
Timing
API

Chrome
23.x

x

x

x

x

x

x

Chrome
26.x
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Chrome
27.x

x

Chrome
28.x

x

x

x

x

x

x

Chrome
29.x

x

Firefox 3.0

x

x

x

Firefox 3.5

x

x

x

Firefox 3.6

x

Firefox 4.x

x

x

x

Firefox 5.x

x

x

x

Firefox 6.x

x

x

x

Firefox 7.x

x

x

x

Firefox 8.x

x

x

x

Firefox 9.x

x

x

x

Firefox
10.x

x

x

x

Firefox
11.x

x

x

x

Firefox
12.x

x

x

x

Firefox
13.x

x

x

x

Firefox
14.x

x

x

x

Firefox
15.x

x

x

x

Firefox
16.x

x

x

x

Firefox
17.x

x

x

x

Firefox
18.x

x

x

x

Firefox
19.x

x

x

x
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Firefox
20.x

x

x

x

Firefox
21.x

x

x

x

IE 10

x

IE 9.x

x

IE 8.x

x

IE 7.x

x

IE 6.x

x

x

Mobile
Safari 5.1

x

Mobile
Safari 6

x

Safari 5.x

x

x

Safari 6.x

x

Opera 11

x

Opera 12

x

x

x
x

Web End User Experience Management (EUEM) Compatibility in Java Environments

Manual injection for the JavaScript agent is available for all Java web application environments.
In addition, the following frameworks are certified for the following Web EUEM instrumentation
strategies.
All these frameworks support manual injection of the JavaScript agent for Web EUEM.
Additional supported script injection strategies are listed in the Script Injection column. See
Set Up Your Application for Web EUEM for details.
Web Application/
AJAX Frameworks

Version

Certified App Server

Script Injection

JSP

Servlet 2.3

Tomcat 7x ,
GlassFish v3,
Weblogic (Assisted
only)

Automatic / Assisted

JSF

MyFaces,
ICEFaces,
ADF

Tomcat 7x , Glassfish
v3

Manual

Tapestry

5.0
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Struts

2

Tomcat 7x, GlassFish
v3

Automatic / Assisted

Spring MVC

Tomcat 7x

Automatic / Assisted

Grails

Tomcat 7x, Glassfish
v3, Weblogic 12c

Manual

Wicket

Tomcat 7

Automatic / Assisted

Web Objects

Manual

Liferay

Manual

ZK

Manual

JQuery

Tomcat 7

Automatic / Assisted

MooTools

Tomcat 7

Automatic / Assisted

DWR

Tomcat 7, Glassfish
V3, Weblogic 12c

Automatic / Assisted

YUI

Tomcat 7

Automatic / Assisted

EXT JS

Tomcat 7

Automatic / Assisted

Dojo Web tool kits

Tomcat 7, Glassfish
V3, Weblogic 12c

Automatic / Assisted

GWT

Manual

angular JS

Manual

backbone

Manual

Web End User Experience Management (Web EUEM) Compatibility in .NET Environments

AppDynamics certifies Web EUEM instrumentation for the following .NET frameworks.
All listed frameworks support manual injection of the JavaScript agent for Web EUEM.
Additional supported script injection strategies are listed in the Script Injection column. See
Set Up Your Application for Web EUEM for details.
Web Application/ AJAX
Frameworks

Versions

Additional Supported Script
Injection Methods

ASP.NET Web Forms (.aspx)

3, 4

Automatic, Assisted
Injection-Using Attribute
Injection

ASP.NET MVC Web Forms
(.aspx)

3, 4

Automatic, Assisted
Injection-Using Attribute
Injection
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ASP.NET MVC Razor

3, 4, 5

Assisted Injection-Using
Attribute Injection

Microsoft SharePoint

2007, 2010

Automatic

AppDynamics does not support Web EUEM instrumentation of legacy ASP (.asp) pages.
Supported Runtime Environments for .NET Web EUEM

Microsoft IIS versions 6.0, 7.0, 7.5, 8.0

Supported Platform Matrix for Mobile EUEM
Operating Systems

Supported Operating System

Version

iOS

5.1.1+

Android

2.3.3+

iDevice Architecture

Apple 32-bit ARM
Apple 64-bit A7
iOS Environments

Supported Framework

Version

XCode

5+

Android Environments

Supported Framework

Version

Ant
Gradle

1.8, 1.10, 1.12

Maven

3.1.1+

Supported Compute Clouds for Automating Workflow

In order to create workflows that allow the automatic creation and deletion of cloud-based
instances in response to load, the AppDynamics controller must have access to a
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cloud-provider-specific cloud connector extension. The AppDynamics Community provides many
of these cloud connector extensions. You can download supported cloud connector extensions
from the AppDynamics Exchange.

Install the Controller
This section describes how to install the AppDynamics Controller on its supported platforms. It
covers the following topics:
Controller System Requirements
Install the Controller on Linux
Install the Controller on Windows
Install an On-Premise Controller Silently
Controller Install and Admin FAQ
Controller System Requirements

The AppDynamics Controller
Controller System Requirements
Controller Operating System Requirements
Supported Web Browsers for the Controller UI
LDAPv3 Support
Controller Hardware Requirements
Use Dedicated Hardware for the Controller
Controller Performance Profiles
Calculating Performance Profiles for a .NET Environment
Hardware Requirements per Performance Profile
Additional Disk I/O Information
Off-Board Storage System Considerations
Additional Sizing Considerations
Event Store
Asynchronous Call Monitoring and End User Experience Monitoring
(EUEM)
Linux file descriptor limit
Running the Controller on Virtual Machines
To measure available Disk I/O
Network Bandwidth Requirements
Additional Requirements
Learn More
The AppDynamics Controller

The AppDynamics Controller is the central management server where the data for an
AppDynamics deployment is stored, analyzed, and presented. The Controller serves the user
interface (UI) for configuring and monitoring your environment. All AppDynamics Agents connect
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to the Controller to report data.
The Controller uses an embedded Glassfish application server and an embedded MySQL
database. It has a browser-based Administration interface for various system parameters.
The Controller and App Agents provide full internationalization support, with support for doubleand triple-byte characters. This support provides the following abilities:
Users can enter double- or triple-byte characters into text fields in the UI
The Controller can accept double- or triple-byte characters from applications
Controller System Requirements
Controller Operating System Requirements

The Controller is supported on the following Operating Systems:
Linux (32 and 64-bit)
Red Hat Enterprise Linux (RHEL) 6.1, 6.2;
RHEL 6.3, 6.4, and 6.5.
CentOS 6.1, 6.2; CentOS 6.3, 6.4, and 6.5.
Fedora 14
Ubuntu 8, 12
Open SUSE 11.x
SUSE Linux Enterprise Server
Cloud: Amazon EC2, Rackspace, Azure

Microsoft Windows (32 and 64-bit)
Windows Server 2003
Windows Server 2008, Windows Server
2008 R2
Windows Server 2012 R1 Standard and
Datacenter, Windows Server 2012 R2
Standard and Datacenter
Windows 7 Pro
Windows 8

Supported Web Browsers for the Controller UI

The AppDynamics UI works best with the latest version of any modern browser along with the latest
version of Flash. The Controller UI has been tested with the following browsers and versions:

IE 9+
Safari 6+
Chrome 16+
Firefox 6+
Opera and older versions of Firefox, IE, and Safari browsers may still operate well but some
features may not display as intended.
The Controller UI requires Flash Player 10 or greater; AppDynamics recommends version 11.
LDAPv3 Support

You can use an external directory server to authenticate and authorize user access to the
Controller UI. The Controller works with directory servers that comply with LDAP (Lightweight
Directory Access Protocol) version 3. While the Controller should be able to work with any
LDAPv3-compliant server, it has been verified against these LDAP products:
Microsoft Active Directory for Windows Server 2008 SP2+
OpenLDAP, 2.4+
Controller Hardware Requirements
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The Controller performs large-scale real-time data analysis and correlation supporting multiple
agents at any given time. It constantly persists large amounts of data to the storage system. For
the Controller to be responsive, it must have appropriate hardware. Use these recommendations
in the performance profiles to determine the hardware needed for your Controller.
These recommendations represent a good starting point only, your requirements may vary
depending on the number of metrics per minute generated in your environment.
Use Dedicated Hardware for the Controller

AppDynamics strongly recommends that you install the Controller on a dedicated machine. The
hardware requirements described in this document assume that no other major processes are
running on the machine where the Controller is installed. A Controller with more than 250 nodes m
ust run on a dedicated machine.
For information about using a Virtual Machine for the Controller, see Running the Controller on
Virtual Machines.
Controller Performance Profiles

Size the Controller hardware requirements using a performance profile based on the number of
nodes in your environment and the number of metrics per minute being reported to the
controller. For general information about applications and nodes, see Logical Model.
The Controller performance profiles are based on the number of nodes. When the number of app
servers is static, it is easy to determine. However, WebSphere on z/OS, dynamic cloud
environments, and .NET environments dynamically spawn new agents. For z/WebSphere and
clouds you need to consider historic data to estimate the correct sizing. For .NET see Calculating
Performance Profiles for a .NET Environment.
Controller
Performance Profile

Number of Nodes*

Number of Business
Apps

Recommended for
VMs

Demo

Up to 5

1

OK

Small

Up to 10

1

OK

Medium

Up to 50

5

OK

Large

Up to 250

5

Not supported**

Extra Large****

250-500

20

Not supported**

Custom - Contact
Support or TAM****

Over 500

Over 20

Not supported**

* In a Java environment there is usually one AppDynamics App Agent for Java per node. In
contrast, one AppDynamics App Agent for .NET may support multiple nodes. See Calculating
Performance Profiles for a .NET Environment to arrive at the number of nodes for a .NET
environment.
** AppDynamics neither recommends nor supports Large or Extra Large deployments in
virtual environments.
*** For configuration information applicable to deployments in the Extra Large performance
profile and larger (500+ nodes), see Tuning for Large Scale Deployments.
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Calculating Performance Profiles for a .NET Environment

The .NET Agent dynamically creates nodes depending on the monitored application's
configuration in the IIS server. An IIS server can create multiple instances of each monitored IIS
application. For every instance the .NET Agent creates a node. For example, if an IIS application
has 5 instances the .NET Agent will create 5 nodes.
The maximum number of instances of a particular IIS application is determined by the number of
worker processes configured for its application pool. Consider the following diagram:

The diagram shows three application pools: AppPool-1, AppPool-2, and AppPool-3 with the
following characteristics:
AppPool-1 and AppPool-3 can have a maximum of two worker processes (known as a web
garden)
AppPool-2 can have one worker process
If applications are assigned to application pools as follows:
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AppPool-1: AppA and AppB
AppPool-2: AppC, AppD and AppE
AppPool-3: AppF
Use the following formula to estimate the number of nodes:
AppPool-1 *
+
AppPool-2 *
+
AppPool-3 *
= Number of

number of applications * max number of worker processes
number of applications * max number of worker processes
number of applications * max number of worker processes
Nodes

In this case the numbers would be:
AppPool-1 nodes = 4 (2 applications * 2 worker processes)
AppPool-2 nodes = 3 (3 applications * 1 worker process)
AppPool-3 nodes = 2 (1 application * 2 worker processes)
for a total of 9 nodes.
To find the number of CLRs that will be launched for a particular .NET Application / App Pool:
1. Open the IIS manager and see the number of applications assigned to that AppPool.
2. Check if any AppPools are configured to run as a Web Garden. This would be a multiplier
for the number of .NET nodes coming from this AppPool as described above.
Also see: http://technet.microsoft.com/en-us/library/cc725601(v=ws.10).aspx.
Hardware Requirements per Performance Profile

For larger deployments with hundreds of nodes, sizing the hardware for a Controller depends upon
the number of agents and the complexity of your business transactions. The number of metrics
can become very large. The following recommendations are a starting point.
Controlle
r
performa
nce
profile

Supporte
d OS
platform
s

CPU # of
cores

RAM

Disk
storage

Disk I/O
write/rea
d/rando
m read

Agent
Count*

Metrics
Count/mi
nute

Demo

Linux (32
& 64-bit)
Windows
(32 &
64-bit)

2 CPU
Cores
1.5 GHz
minimum

2 GB

50 GB

50
MB/sec
50
MB/sec
1.5
MB/sec

up to 5

5 K max
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Small

Linux (32
& 64-bit)
Windows
(32 &
64-bit)

4 CPU
Cores
1.5 GHz
minimum

4 GB

100 GB

50
MB/sec
50
MB/sec
1.5
MB/sec

6-10

25 K
max

Medium

Linux
(64-bit)
Windows
(64-bit)

8 CPU
Cores
3.3 GHz
minimum

16 GB

4,000
GB

60 MB/se
c
60 MB/se
c
1.6 MB/s
ec

11-50

250 K
max

Large

Linux
(64-bit)
Windows
(64-bit)

24 CPU
Cores
2.5 GHz
minimum

32 GB
RAM

5,000 GB

100 MB/s
ec
100 MB/s
ec
3 MB/sec

51-250

512 K
max

Extra
Large**

Linux
(64-bit)

24 CPU
Cores
2.5 GHz
minimum

64 GB
RAM

10,000
GB

125 MB/s
ec
125 MB/s
ec
5 MB/sec

251-500

1 Million
max

* Also see Controller Performance Profiles. The agent count requirements do not reflect the
use of End User Monitoring (EUM). See Additional Sizing Considerations for more information
about EUM.
** When sizing in the Extra Large profile range or higher, contact your AppDynamics
Technical Account Manager or the AppDynamics Support Team for assistance.
For information on hardware requirements for AppDynamics for Databases, see AppDynamics for
Databases, Hardware Requirements.
The Demo profile is only for demonstration and evaluation environments and is not suited for
production installations.
Additional Disk I/O Information

The AppDynamics Controller always writes and reads using the following block sizes:
Read block size: 16 K
Write block size: 64 K
When considering I/O requirements listed in Hardware Requirements per Performance Profile,
keep in mind that while onboard disks typically satisfy the I/O requirements, in a SAN environment,
the bottleneck in terms of I/O write and read speed becomes the latency between the CPU and the
SAN-based storage. For information on I/O and off-board storage, see the next section, Off-Board
Storage System Considerations.
Off-Board Storage System Considerations
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AppDynamics strongly recommends that you avoid installing the Controller or putting the
Controller's data directory, db/data, on an NFS-mounted filesystem. NFS adds latency and
throughput constraints that can affect Controller performance and even lead to data corruption.
Similarly, you should avoid iSCSI or other SAN technologies that are subject to quality of service
issues from the underlying network.
For best performance, if not using on-board disk storage, consider using a robust Fiber Channel,
FCoE, or iSCSI over 10Gbit Ethernet SAN. Whatever underlying technology you use, keep in mind
that your system must provide disk data read and write speeds over the connection between the
CPU and storage that are equivalent to the disk I/O requirements listed in Hardware Requirements
per Performance Profile. In all cases, be sure to thoroughly load test the deployment with
real-world traffic load before putting the Controller into a live environment.
Additional Sizing Considerations
Event Store

The Event Store is an Elastic Search-based file store used by the Database Monitoring feature. If
you intend to use Database Monitoring, you should provide for an additional 40 GB of disk space
to accommodate the Event Store on the Controller machine.
Asynchronous Call Monitoring and End User Experience Monitoring (EUEM)

Monitoring asynchronous calls and using End User Monitoring (EUM) typically increases the
number of metrics collected. As a result:
The Small profile is not supported for installations with extensive async monitoring and/or
use of EUM.
A Medium profile running 40+ agents may need to upgrade to a configuration closer to a
Large profile if extensive async monitoring and/or EUM are added.
Specifically the features affect the workload of the system as follows:
Monitoring asynchronous calls increases the number of metrics per minute to a maximum
number of 23000 per minute.
EUEM
Web EUEM can increase the number of individual metric data points per minute by up
to 22000
Mobile EUEM can increase the number of individual metric data points per minute by
as much as 15 to 25K per instrumented application, if your applications are heavily
accessed. The actual number depends on how many network requests your
applications receive.
The number of separate EUEM metric names saved in the Controller database can
be larger than the kinds of individual data points saved. For example a metric name
for a metric for iOS 5 might still be in the database even if all your users have
migrated away from iOS 5. So the metric name would no longer have an impact on
resource utilization, but it would count against the default limit in the Controller for
metric names per application. The default limit for names is 200,000 for Web EUEM
and 100,000 for Mobile EUEM.
Linux file descriptor limit

For Linux environments, it is important to set the file descriptor limit to at least 65535. For more
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details see Configure File Descriptor Limits on Linux.
Running the Controller on Virtual Machines

The Controller can run on virtual machines, but with a few additional considerations:
Large or extra large deployments in virtual machine environments are not supported.
The Controller license is bound to the MAC address of the host machine. To run the
Controller on a virtual machine, you must ensure that the host virtual machine uses a fixed
MAC address.
The virtual machine that hosts the Controller must meet hardware resource requirements
that are equivalent to physical machines, including I/O performance.
To ensure that your virtualized storage subsystem is providing the required I/O capacity, run the
following disk I/O rate tests.
To measure available Disk I/O

These tests write 32 GB of data to your disk and may take some time to complete. They produce
numbers for write, rewrite, read, reread,random read, and random write.
1. Download the free IOzone tool.
Download IOzone for Linux
Download IOzone for Windows
2. Execute the following commands:
For Linux

For Windows

Test for WriteSpeed

/opt/iozone/bin/iozone -s
32000m -r 64k -i 0 -i 1 -w -f
/<path-to-your-partition>/tes
t1

<path-to-your-partition>/Ben
chmarks/Iozone3.353/iozon
e -s 32000m -r64k -i 0 -i 1
-w -f test1

Test for RandomRead

/opt/iozone/bin/iozone -s
32000m -r 16k -i 2 -w -f
/<path-to-your-partition>/tes
t1

<path-to-your-partition>/Ben
chmarks/Iozone3.353/iozon
e -s 32000m -r16k -i 2 -w -f
test1

3. Verify available disk I/O.
The results from these tests should match the Disk I/O requirements specified in Hardware
Requirements Per Performance Profile.
Network Bandwidth Requirements

See Install Agents for information on bandwidth usage in an AppDynamics deployment.
Additional Requirements

In addition to the correct sizing of the hardware, special tuning of the operating system, the
Glassfish application server, the MySQL as well as the Controller itself is required for very large
installations, as detailed in Tuning for Large Scale Deployments.
Learn More
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Logical Model
Configure File Descriptor Limits on Linux
Controller Sizing FAQ
Controller Sizing FAQ
Q: We are running a 3.8.x version of AppDynamics. To upgrade to 3.9, do we need to upgrade the hardware?

A: If your existing Controller is handling your metric load now and you are not changing your
licensing, you should be fine when you upgrade to 3.9. To determine if you are close to exceeding
your Controller's capacity, please contact AppDynamics.
Q: How do I determine if my Controller is at or near its ability to adequately handle its metric load?

A: The following are indications of Controller performance issues:
1. The Controller UI performs slowly. For short time ranges, such as 15 or 30 minutes,
responses that take longer than 10 to 20 seconds can indicate that your Controller is under
stress.
2. When the Controller's metric reporting lags 7 to 10 minutes behind the current time, it can be
an indication that your Controller is under stress. A lag of about 3 to 5 minutes is normal.
3. When monitoring the Controller environment, you see that CPU, memory, and disk metrics
are at about 75% capacity.
Contact AppDynamics Support for assistance.
Measuring Disk Performance Using a Script

To edit the script
To evaluate performance
You can use IOzone to benchmark I/O performance. See http://www.iozone.org/ for information
about IOzone.
Running iostat in parallel with IOzone gives a better overall picture.
To start IOzone and iostat in parallel, you can use our script. Click ScriptToMeasureDiskIO to
download our script. Then edit it.
To edit the script

1. Change the -s 32g to reflect ½ of your total physical RAM. For example, if your machine has
32GB RAM use --s 16g.
2. Set the -F parameter to point to the same partition that your database is in.
3. The -t parameter defines the number of read/write threads. Change the -t parameter if you have
more than 500 nodes.
Set the -t parameter to match the number of files in the -F parameter. For example, if t=4, then 4
test files must be specified for -F. Use 8 for the write test (with 8 files for -F) and 4 for the read test
(with 4 files for -F).
To evaluate performance

1. Check if the rewrite/reread from IOzone meets the Controller requirements for your profile.
2. Check if the MIN value in the iostat.logs is higher than the minimum values of the Controller
requirements.
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See Controller System Requirements for the Controller requirements.
Contact AppDynamics Support if you have questions.
Install the Controller on Linux
The Controller Installer for Linux
Learn by watching: Installing on Linux
Pre-installation Checklist for Linux
Download and Launch the Linux Installer
Installer Modes
Download and launch the Controller on Linux
To download and start the Controller installation:
Installing the Controller on Linux
To install the Controller on Linux in GUI Mode
To install the Controller on Linux in Silent Mode
Verifying Controller Installation
Next Steps for Linux
Apply the License File
Configure swappiness if the Linux kernel is newer than 2.1.10
Configure Backups
Learn More
For an overview of the Controller and its requirements, including supported operating systems, see
Controller System Requirements.
The Controller Installer for Linux

The AppDynamics Controller installer for Linux is an executable binary that you can run in GUI
mode, console mode, or in silent mode by passing the installer a response file.
All software components required for Controller installation are bundled with the installer, so you
do not normally need to install additional software to install the Controller.
Pre-installation Checklist for Linux

For optimum stability and performance, AppDynamics strongly recommends that you install
the Controller on a dedicated machine.
The disk space requirements differ for each of the Controller Performance Profiles. Verify
that there is enough disk space for the performance profile that describes your environment.
Verify that you have the right CPU, RAM and Disk I/O capacity for the performance profile
you plan to install. Run the Disk I/O measurement tests described at To measure available
Disk I/O.
The Controller requires that libaio be installed on the same machine. For more information
see Install libaio on Linux.
Make sure the file descriptor limit is set to at least 65535. For more information see Configur
e File Descriptor Limits on Linux.
Install the Controller on a 64-bit Linux system if you plan to use a Medium, Large, or Extra
Large Performance Profile. For details see Controller Performance Profiles.
For the Extra Large performance profile, AppDynamics recommends XFS and RAID, and
additional Linux settings. See Tuning for Large Scale Deployments.
When performing the installation, the installer attempts to start up the system. Depending on
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system resources or other factors, this can take a considerable amount of time. If startup
exceeds the 30 minute default timeout, the installer exits but leaves changes on disk, so that
you can troubleshoot the issue. When finished, remove the installation directory manually
and restart the installation. Optionally, you can extend the timeout by passing the
ad-timeout-in-min command line parameter with the new value in minutes to the installer.
Verify that you have Read/Write/Execute permissions on the directory where you install the
Controller.
Verify that a ZIP/UNZIP utility is installed on the machine to which you will download the
installer.
Make sure that your network permits the Controller to communicate with agents and
AppDynamics UI on its HTTP or HTTPS port.
During the installation procedure you configure several accounts for the Controller, including the
database account, a root user in the Controller, and an administrator in the Controller. The userna
mes and password for Controller cannot include the @ character. Also, if this user will be used to
authenticate REST calls to the Controller REST API, additional limitations on the use of special
characters in usernames apply. See Configure Users for more information.
You do not need to be logged into the operating system as a superuser such as the root user to
install the Controller. If you do not have privileges to write to the /opt directory, the installer puts
the Controller in your user home directory.
Download and Launch the Linux Installer

The Controller is available at AppDynamics Download Center.
Installer Modes

The Controller installer can run in three different modes:
GUI: By default the installer tries first to start in GUI mode. If the system is not set up to
display the GUI, it will start in console mode.
Console: You can force the installer to start in console mode by passing the -c option to the
installer.
Silent: You can force the installer to start in silent mode by passing the -q -varfile <path-to-respo
nse-file> option. See Install an On-Premise Controller Silently for more information about silent
mode and the response file.
Download and launch the Controller on Linux
To download and start the Controller installation:

1. Download the Linux Controller binary (controller_linux_<version>.sh) file from AppDynamics
Download Center.
2. Assign execute permissions to the downloaded installer binary.
3. Launch the installer by executing the controller_linux_<version>.sh that you downloaded.
To start the installer in console or silent mode, use the -c or -q options as above. For example, to
install in console mode:
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./controller_32bit_linux.sh -c

The following steps describe the installation process in the context of the GUI mode. However,
these steps correspond to the console installer steps, so they can be used to perform the console
installation as well.
Installing the Controller on Linux
To install the Controller on Linux in GUI Mode

1. In the Welcome screen click Next.
The license agreement displays.
2. Scroll down to the bottom and accept the license agreement, then click Next.

3. Click Yes to grant or No to deny AppDynamics permission to collect usage data statistics
from your Controller.
The data collected helps AppDynamics improve its products and services.
4. Set the path of the Controller installation directory in the Destination directory field, then click
Next.
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5. Enter the password for the database user that the Controller will use to access the database
it uses to store data. The installer creates a user account named root in the database with
the password you specify.

6. Enter the host name (or IP address) and primary port that the AppDynamics App Agents and
browsers will use to connect to the Controller.

7. Scroll down to verify the default configuration of the Controller ports. If needed, click Edit
Ports, modify the ports, and then click Next.
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Note that the installer checks to make sure that each port is available on the system before
suggesting it. If a default port number is already in use, it chooses the next highest available
number for the port. For example, if the usual default port of 8090 for the Controller
application server is taken, the installer suggests 8091. You only need to edit a default port
number if you know it will cause a future conflict or if you have some other specific reason
for choosing another port.
8. Choose single-tenancy or multi-tenancy mode for the Controller, then click Next.

See Controller Tenant Mode for more information about these modes.
9. Enter the password for the root user account in the Controller.
The Controller root user is a special type of administrative account that has global privileges
in the Controller. The root user credentials let you access the global AppDynamics
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9.

administration console, where you can create and manage AppDynamics accounts and
configure other Controller-wide settings. See Access the Administration Console for more
information about the console.
10. Configure initial account settings, as follows:
If you selected single-tenancy mode, enter the username and password for the
administrator of the built-in account.

If you selected multi-tenancy mode:
a. Enter a name for the initial account in the system, along with a username and
password for the administrator for the initial account.

b. Review and record the settings for the initial account settings and click Next.
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You will need to configure the App Agents with this account key and account
name to associate the application with a particular account.
11. Select the Controller performance profile that matches your requirements and click Next.

The installer limits the choice of profiles to Demo and Small profile on 32-bit systems. When
you click Next, the installer checks your system for minimum requirements and warns you if
any are not met.
12. In the data directory settings, enter the path to the MySQL data directory and to the Elastic
Search data directory and then click Next.
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The Controller stores configuration and metric data in the directory indicated in the MySQL
data directory field. The Elastic Search data directory is used by Database Monitoring featur
es. If you are storing MySQL data somewhere other than the default location, say in a
separate disk partition, it is likely that the Elastic Search data directory would need to be put
in the same location. If you are not sure whether you will use database monitoring, you can
keep the default location for now and change the data directory location later, if needed, in
the events_service/analytics-processor/conf/analytics-all.properties file.
13. Select the high availability configuration for the Controller or Not Applicable if you are not
enabling HA for this Controller. For more information see Manage Controller High Availability
.

With the initial configuration settings gathered, the installer copies the files to the installation
directory and configures the new instance.
To install the Controller on Linux in Silent Mode

See Install an On-Premise Controller Silently.
Verifying Controller Installation

Wait for the installation status screen to show that the installation is complete. The Controller starts
automatically when installation is completed.
To verify the success of your installation, open a browser to the URL for the Controller.
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http://<application_server_host_name>:<http-listener-port>/controller

Next Steps for Linux

Apply the License File
Configure swappiness if the Linux kernel is newer than 2.1.10
Configure Backups
Apply the License File

To access the Controller UI, you need to have a valid license. For a trial installation, the license
file (license.lic) is bundled in your download. Otherwise, you may have acquired the license file
from AppDynamics. If needed, copy the license file to the Controller installation directory:
After moving a license file to the Controller home, allow up to 5 minutes for the license change to
take effect.
Configure swappiness if the Linux kernel is newer than 2.1.10

For better performance, configure swappiness. For details see Configure Swappiness on Linux.
This feature is available only for Linux kernel versions greater than 2.1.10.
Configure Backups

See Controller Data Backup and Restore.
Learn More

AppDynamics University: AppDynamics Pro Controller installation video Tutorial
Installation Troubleshooting and FAQ
Controller System Requirements
Install an On-Premise Controller Silently
Controller Tenant Mode
Manage Controller High Availability
Install libaio on Linux
Configure File Descriptor Limits on Linux
Configure Swappiness on Linux
Controller Data Backup and Restore
Install libaio on Linux

Red Hat and CentOS
Ubuntu
Fedora
Debian
Learn More
Before it begins Controller installation, the installer checks whether the target Linux system has the
libaio library installed. This library facilitates asynchronous I/O operations on the system.
This topic provides instructions on how to install libaio for some common flavors of Linux operating
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system.
Red Hat and CentOS

Use the following command to install the libaio package:

yum install libaio

Ubuntu

Use the following command to install the libaio package:

sudo apt-get install libaio1

Fedora

Install the RPM for the libaio package from the Fedora website.
Debian

Use the following command to install the libaio package:

mkdir /usr/libaio

cd /usr/libaiot

wget
http://http.us.debian.org/debian/pool/main/liba/libaio/libaio1_0.3.106-3_i386.de
b

ar -x libaio1*.deb

tar zxvf data.tar.gz

sudo cp lib/* /emul/ia32-linux/lib/

Learn More

Install the Controller on Linux
Configure File Descriptor Limits on Linux

Limiting the Number of File Descriptors
To check the limits for number of file descriptors
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To configure limits on a per-user basis in the limits.conf file
To configure limits for number of file descriptors in the profile
Learn More
This topic explains the importance of checking file descriptor limits and provides the steps to
modify the limit for Controller installations on Linux.
Limiting the Number of File Descriptors

If you do not set the limits for number of file descriptors, AppDynamics may produce warnings
such as:
Warning in database log: "Could not increase number of max_open_files to more than xxxx".
Warning in server log: "Cannot allocate more connections".
These warnings indicate that the Controller database is attempting to open more file descriptors
than is permitted by the operating system. This issue can affect product integrity in larger
Controller installations.
AppDynamics recommends that the maximum number of file descriptors be set to 65535 for
installations in Linux environments.
To check the limits for number of file descriptors

As the root user, execute following command:
ulimit -S -n

If this value is less than 65535, change it to 65535 either in the profile or limits.conf file.
On Fedora as well as Ubuntu (and probably other modern Linux distributions) using
/etc/security/limits.conf is the preferred method. You should put the ulimit command in /etc/profile
only if the /etc/security/limits.conf does not exist.
To configure limits on a per-user basis in the limits.conf file

1. Open the limits.conf file for edit:
/etc/security/limits.conf

2. Add the following lines:
<login_user>
<login_user>

hard
soft

nofile 65535
nofile 65535

Where "login_user" is the username of the Linux user who runs the Controller, such as
"appdynamics".
3. Enable these limits by editing:
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/etc/pam.d/common-session

4. Add the line:
session required pam_limits.so

5. When you log in again as the "appdynamics" user, the limits should apply.
To configure limits for number of file descriptors in the profile

1. As the root user, add the following entry to the /etc/profile:
ulimit -n 65535

2. Reboot the host server and check the limit again.
Learn More

Install the Controller on Linux
Controller System Requirements
Configure Swappiness on Linux

The Swappiness Parameter in Linux
To configure swappiness
Learn More
The Swappiness Parameter in Linux

The swappiness parameter controls how often the Linux kernel to move processes out of physical
memory and onto the swap disk. Because disks are much slower than RAM, this can lead to
slower response times for system and applications if processes are too aggressively moved out of
memory.
The default value is usually "60". For better AppDynamics performance, the recommended value
is "0" (zero).
To configure swappiness

1. Check the current value for swappiness.

/sbin/sysctl -a | grep swappiness

2. Configure the swappiness parameter.
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echo 0 > /proc/sys/vm/swappiness

Edit the /etc/sysctl.conf file and add following line:

vm.swappiness = 0

Learn More

Install the Controller on Linux
Start the Controller Automatically on Linux

Starting the Controller Automatically
To configure automatic Controller startup on Linux:
Learn More
Starting the Controller Automatically

You can configure the Controller to start automatically when the host computer starts by creating
an initialization script for the Controller and adding the script to the host system's startup utility.
The following instructions provide general guidelines for setting up the Controller to start
automatically on Linux. The exact steps you need to perform may differ depending on your Linux
distribution and environment.
Be sure to refer to the documentation for your Linux distribution for the specific steps appropriate
for your environment. Also, you may wish to start with or refer to any sample startup scripts
provided with your system, if available. For example, Debian systems provide a sample
initialization script at: /etc/init.d/skeleton
To configure automatic Controller startup on Linux:

1. Create an initialization script file that starts and stops the Controller. The following listing
shows a very simple example:
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#!/bin/sh
#
# Init file for AppDynamics Controller
#
# chkconfig: 2345 60 25
# description: Controller for AppDynamics
APPD_BIN="/home/appd/AppDynamics/Controller/bin"
case "$1" in
start)
exec $APPD_BIN/startController.sh
;;
stop)
exec $APPD_BIN/stopController.sh
;;
restart)
$0 stop
$0 start
;;
status)
exit 1
;;
*)
echo "Usage: $0 {start|stop|restart|status}"
exit 1
esac

In your script, set the APPD_BIN value to the path of the bin directory in your Controller
home directory, /home/appd/AppDynamics/Controller/bin in the example.
The startController.sh and stopController.sh scripts start and stop both the Controller and
the database. If the database resides on a separate machine, use the "controller.sh start"
and "controller.sh stop" commands to start the Controller appserver only.
2. Enable execution permissions for the script. For example, given an initialization script
named controller, you would enter:
sudo chmod 775 controller

3. Place the script in the initialization directory on your system, typically /etc/init.d. Alternatively,
create a symbolic link to the script from the init.d directory to the script if you want to keep it
in another location.
4.
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4. Add the script as a service as follows:
On Red Hat and most Linux Operating Systems, run these commands, replacing
"appdcontroller" with the name of your file or symbolic link:
chkconfig --add controller
chkconfig --level 2345 appdcontroller on

On Ubuntu and Debian Operating Systems, run this command, replacing
"appdcontroller" with the name of your file or symbolic link:
update-rc.d -f appdcontroller start 99 2 3 4 5 .

In the command:
start is the argument given to the script (start, stop).
99 is the start order of the script (1 = first one, 99 = last one)
2 3 4 5 are the runlevels to start
Be sure to include the dot (.) at the end of the command.
5. Test that the Controller is successfully installed as a service by using these command to
stop it (if running) and start it again:
service appdcontroller stop
service appdcontroller start

The Controller now starts automatically at system startup.
Learn More

Install the Controller
Install the Controller as a Windows Service
Configure the Machine Agent to Automatically Start on Linux
Install the Controller on Windows

The AppDynamics Controller Installer for Windows
Pre-installation Checklist for Windows
Guidelines for Running the Controller on Windows
Download and Launch the Windows Installer
To download and launch the Controller Installer for Windows
To install the Controller on Windows
Verifying Controller Installation
Next Steps for Windows
Apply the License File
Configure the Controller to Run as a Windows Service
Exclude the Controller Data Directory from Scanning and Indexing
Configure Backups
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Learn More
This topic describes how to install the AppDynamics Controller in a Windows environment.
For an overview of the Controller and its requirements, including supported operating systems, see
Controller System Requirements.
The AppDynamics Controller Installer for Windows

The AppDynamics Controller installer for Windows is an executable binary that you can run in GUI
mode, console mode, or in silent mode by passing the installer a response file from the command
line.
All software components required for Controller installation are bundled with the installer, so you
do not normally need to install additional software to install the Controller.
Pre-installation Checklist for Windows

For optimum stability and performance, AppDynamics strongly recommends that you install
the Controller on a dedicated machine.
The disk space requirements differ for each of the Controller Performance Profiles. Verify that
there is enough disk space for the performance profile that describes your environment.
Confirm the correct CPU, RAM and Disk I/O capacity for the Controller Performance Profile you
plan to install. Run the Disk I/O measurement tests described at To measure available Disk I/O.
When performing the installation, the installer attempts to start up the system. Depending on
system resources or other factors, this can take a considerable amount of time. If startup
exceeds the 30 minute default timeout, the installer exits but leaves changes on disk, so that
you can troubleshoot the issue. When finished, remove the installation directory manually
and restart the installation. Optionally, you can extend the timeout by passing
the ad-timeout-in-min command line parameter with the new value in minutes to the installer.
Open the HTTP port that the Controller will use to communicate with agents and the
AppDynamics UI.
Verify that you have administrative privileges on the Windows machine to launch the Controller
installer.
During the installation procedure you configure several accounts for the Controller, including the
database account, a root user in the Controller, and an administrator in the Controller.
The usernames and password for Controller cannot include the @ character. Also, if this user will
be used to authenticate REST calls to the Controller REST API, additional limitations on the use of
special characters in usernames apply. See Configure Users for more information.
Guidelines for Running the Controller on Windows

In addition to the general prerequisites listed in Pre-installation Checklist for Windows, several
operational guidelines apply to running the AppDynamics Controller on Windows. These
guidelines are specifically intended to prevent the possibility of Controller data corruption due to
conflicts with other Windows processes.
You can configure your system as described by the guidelines after installing the Controller, but it
is important to note what changes your system will need before starting installation.
After installing the Controller, configure it to run as a Windows service. If you start the
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Controller manually rather than as a service, Controller processes will be terminated on user
logout. Terminating the Controller in this manner can result in corrupted Controller data. For
instructions on installing the Controller as a service, see Install the Controller as a Windows
Service.
Configure virus scanners on the target machine to ignore the AppDynamics database
directory. Code is never executed from the data directory, so it is generally safe to exclude
this directory from virus scanning. The default location of the data directory is
<Controller_Installation_Directory>\db\data.
Exclude the Controller data directory (<Controller_Installation_Directory>\db\data) from
scanning by Windows Defender. If you are not sure whether Windows Defender is running
on the system, check for it in your local Services list. You can either configure the Controller
data directory to be excluded in the Windows Defender Control Panel, or disable the service
altogether if it is not needed. For details on how to view services and exclude directories in
Windows Defender, refer to the documentation for your version of Windows.
Ensure that the Windows indexing service is configured to ignore the Controller data
directory (<Controller_Installation_Directory>\db\data):
The data directory does not contain any files that are meaningful to the indexer, so it can be
excluded from indexing. To exclude the directory from indexing, you can add the directory to
the excluded directories list in the Indexer Control Panel, disable indexing in directory
preferences, or stop the indexing service entirely.
To add the directory to the excluded directory list, follow these steps:
1. From the Control Panel Indexing Options dialog, click the Modify button.
2. In the Indexed Locations dialog, navigate to and select the Controller data directory:
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3. Clear the check box for the data directory and click OK.
Configure the Windows Update preferences so that the server is not automatically restarted
after an update. To configure the restart policy:
1. Open the Local Group Policy Editor window (search for and run the
"gpedit" executable).
2. Navigate to the Windows Update component. In the tree, you can find it under Local
Computer Policy -> Computer Configuration -> Administrative Templates ->
Windows Components.
3. Double-click on the "No auto-restart..." setting, as shown in the following figure.
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4. Select the Enabled option and click Apply.
Never stop the Controller or its individual services (the AppDynamics Application service or
AppDynamics Database services) from the task manager. To stop and restart the
AppDynamics processes, after setting up the Controller to run as a service, start the
command prompt program as administrator and run the scripts for starting and stopping the
service, as documented in Install the Controller as a Windows Service.
If you do not follow these guidelines and the database log
(<Controller_Installation_Directory>\logs\database.log) contains errors indicating missing .frm or
.ibd files, it is possible that the Controller data has become corrupted. In this case, open a help
ticket with AppDynamics support.

Download and Launch the Windows Installer
To download and launch the Controller Installer for Windows

1. Download the Controller installer for either 32- or 64-bit Windows from the AppDynamics
Download Center.
2. From the Windows Start menu, right-click on the Command Prompt icon and choose Run as
administrator.
3. At the command prompt, navigate to the download directory and run the installer as follows:
In GUI mode:
controller_32bit_windows-<version>.exe

To run the installer in console mode or against in non-interactive mode (with settings taken
from a configuration file), use the -c or -q options, respectively.
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For example, to install in console mode:
controller_32bit_windows.exe -c

See Install an On-Premise Controller Silently for information on installing in non-interactive
mode.
To install the Controller on Windows

1. In the Welcome screen click Next.
The license agreement displays.
2. Scroll down to the bottom and accept the license agreement, then click Next.

3. Click Yes to grant or No to deny AppDynamics permission to collect usage data statistics from
your controller.
The data collected helps AppDynamics improve its products and services.
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4. Set the path of the Controller installation directory in the Destination directory field, then click
Next.

5. Enter the password for the database user that the Controller will use to access the database
where it stores its data. The installer creates a user account named root in the database with the
password you specify.

6. In the Application Server Host Name field type the host name (or IP address), or accept the
default.
7. Verify the port numbers to be used by the Controller. To change a default port, click Edit Ports a
nd enter the new port number.
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Note that the installer checks the availability of each port on the target machine before
suggesting it. If a default port number is already in use, it chooses the next highest available
number for the port. For example, if the usual default port of 8090 for the Controller
application server is taken, the installer suggests 8091. You only need to edit a default port
number if you know it will cause a future conflict or if you have some other specific reason
for choosing another port.
Examine the default configuration of the internal Controller ports and modify the settings as
necessary if other services are bound to these ports. Then click Next.
8. Verify the displayed configured settings and click Back if you want to change any of them. Click
Next to continue.
9. Choose single-tenant or multi-tenant mode for the Controller, then click Next.
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See Controller Tenant Mode for more information about these modes.
10. Enter the password for the root user account in the Controller.

The Controller root user is a special type of administrative account that has global privileges
in the Controller. The root user credentials let you access the global AppDynamics
administration console, where you can create and manage AppDynamics accounts and
configure other Controller-wide settings. See Access the Administration Console for more
information about the console.
11. Configure initial account settings, as follows:
If you selected single-tenancy mode, enter the username and password for the
administrator of the built-in account.
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If you selected multi-tenancy mode:
a. Enter a name for the initial account in the system, along with a username and
password for the administrator for the initial account.

b. Review and record the settings for the initial account settings and click Next.
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You will need to configure the App Agents with this account key and account
name to associate the application with a particular account.
12. Select the Controller performance profile that matches your requirements, then click Next.

Note that only Demo and Small profile deployments are available for installation on 32-bit
systems. When you click Next, the installer checks your system for minimum requirements
and warns you if any are not met.
13. In the data directory settings, enter the path to the MySQL data directory and to the Elastic
Search data directory and then click Next.
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The Controller stores configuration and metric data in the directory indicated in the MySQL data
directory field. The Elastic Search data directory is used by Database Monitoring features. If you
are storing MySQL data outside the default location, say in a separate disk partition, it is likely
that the Elastic Search data directory would need to be put in the same location. If you are not
sure whether you will use database monitoring, you can keep the default location for now and
change the data directory location later, if needed, in the events_service\analytics-processor\con
f\analytics-all.properties file.

14. Select the high availability configuration for the Controller or Not Applicable if you are not
enabling HA for this Controller. Then click Next. For more information see Manage Controller
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High Availability.

With the initial configuration settings gathered, the installer copies the files to the installation
directory and configures the new instance.
Verifying Controller Installation

Wait for the installation status screen to show that the installation is complete. Then the Controller
will automatically start.
To verify the success of your installation, do one of the following:
Click the link to the Controller provided in the installer's "Finish" screen.
Open a browser to the URL that you configured for the Controller.
http://<application_server_host_name>:<http-listener-port>/cont
roller

Next Steps for Windows

Apply the License File
Configure Backups
Install the Controller as a Windows Service (optional)
Restart the Controller If You Reboot
Apply the License File

To access the Controller UI, you need to have a valid license. For a trial installation, the license file
(license.lic) is bundled in your download. Otherwise, you may have acquired the license file from
AppDynamics. If needed, copy the license file to the Controller installation directory:
After moving a license file to the Controller home, allow up to 5 minutes for the license change to
take effect.
Configure the Controller to Run as a Windows Service

By default the Controller is not installed as a Windows service. AppDynamics strongly
recommends that the Controller runs as a service on Windows.
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See Install the Controller as a Windows Service for information on configuring the installed
Controller to run as a service on Windows.
Exclude the Controller Data Directory from Scanning and Indexing

See operational guidelines for information on how to exclude the Controller data directory from
scanning by virus detection software or Windows Defender and from indexing by the Windows indexing
service.
Configure Backups

See Controller Data Backup and Restore.
Learn More

Installation Troubleshooting and FAQ
Controller System Requirements
Install an On-Premise Controller Silently
Install the Controller as a Windows Service
Controller Tenant Mode
Manage Controller High Availability
Controller Data Backup and Restore
Start or Stop the Controller
Install the Controller as a Windows Service

Before Starting
To install the Controller as a Windows service
To stop and start the Controller as a Windows service
To upgrade the Controller as a Windows service
Learn More
On Windows platforms, AppDynamics strongly recommends that you set up the AppDynamics
Controller to run as a Windows service. See Windows operating guidelines in Install the Controller
on Windows for more information about this recommendation. As a Windows service, the
Controller runs in the background and starts up automatically on the host machine.

Before Starting
Before following these steps to install the Controller as a service, we suggest that you verify that
the Controller is not already installed as a service on the host. To do so, open the Services viewer
from the Administrative Tools and look for two services, AppDynamics Controller and AppDyna
mics Database.
The scripts described in the following procedures must be run as an administrator.
Running the scripts as a non-administrator user results in problems with the operation of
the service.
To install the Controller as a Windows service

1. If the Controller is not already installed, install the Controller. See Install the Controller on
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1.
Windows.
2. Shut down the Controller as follows:
a. Open a Command Prompt window.
b. Navigate to the /bin directory of the Controller installation directory.
c. Stop the Controller processes:
stopController.bat

3. In the Windows Start menu, right-click on the Command Prompt icon and choose Run as
administrator.
4. At the command prompt, run the
<Controller-Installation-Directory>/bin/installControllerSvcs.bat script.
The script installs the Controller Windows service and configures the service to start
automatically.
5. Reboot the host machine after the Controller is shut down.
The Controller Windows service starts automatically.
To stop and start the Controller as a Windows service

1. In the Windows Start menu, right-click on the Command Prompt icon and choose Run as
administrator.
2. At the command prompt:
Stop the Controller as a service by executing the
<Controller-Installation-Directory>/bin/stopControllerSvcs.bat script.
Start the Controller as a service by executing the
<Controller-Installation-Directory>/bin/startControllerSvcs.bat script.
To upgrade the Controller as a Windows service

1. Back up the Controller data. See Upgrade the Controller for more information on backing up
the Controller for an upgrade.
2. Stop the Controller, as described above.
3. In the Windows Start menu, right-click on the Command Prompt icon and choose Run as
administrator.
4. At the command prompt, uninstall the Windows service by running the
<Controller_Installation_Directory>/bin/uninstallControllerSvcs script.
5. Restart the computer to clear the services cache on the system.
6. Install the latest version of the Controller and then configure the Controller as a Windows
service, as described above.
Learn More

Install the Controller on Windows
Start the Controller Automatically on Linux
Install an On-Premise Controller Silently
Before Starting
Running the Installer in Silent Mode
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To install a Controller silently
Installation Settings in response.varfile
Sample Response File
Linux
Windows
Learn More
This topic describes how to perform a silent installation of the Controller using a response file. A
response file installation does not require user interaction.
Before Starting

Before performing a silent install of the Controller, read the system requirements and
prerequisites:
For all platforms, see Controller System Requirements.
For Linux, see Pre-installation Checklist for Linux.
For Windows, see Pre-installation Checklist for Windows.
Running the Installer in Silent Mode

After ensuring that your system meets the requirements, you can perform the installation.
To install a Controller silently

1. Create the response.varfile file that contains the installation settings to use.
The file is not included with the installer, so you'll need to create the file yourself.
2. Run the Controller installation command passing the response.varfile as an argument. For
example:
On Linux, enter:
./controller_64bit_linux.sh -q -varfile
/home/user/response.varfile

On Windows, open a command prompt window as administrator and enter:
controller_64bit_windows.exe -q -varfile
C:\temp\response.varfile

In the sample commands, the -q switch directs the installer to run in unattended mode, while
-varfile points to the response file to use.
To view other options for unattended installation, pass only the -h switch to the installer.
Installation Settings in response.varfile

Configure your installation using these response file settings:
Setting
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serverHostName

Server host name or IP address that
AppDynamics agents and the AppDynamics UI
use to connect to the Controller. Note that
"localhost" and "127.0.0.1" are not valid
settings.

serverPort

The primary HTTP port for the application
server. If not specified, the installer uses the
default, 8090.

databasePort

The database port. If not specified, the installer
uses the default, 3388.

adminPort

The application server's administration port. If
not specified, the installer uses the default,
4848.

jmsPort

The application server's JMS port. If not
specified, the installer uses the default, 7676.

iiopPort

The application server's IIOP port. If not
specified, the installer uses the default, 3700.

sslPort

The secure HTTP port for the application
server. If not specified, the installer uses the
default, 8181.

controllerConfig

The performance profile type for the instance:
demo, small, medium, large, or huge. See Con
troller Hardware Requirements for information
about how the types correspond to sizes.

controllerTenancyMode

The tenancy mode: single or multi. Single
tenancy is recommended for most
installations. See Controller Tenant Mode for
more information.

haControllerType

The high availability mode for this instance:
primary, secondary, or notapplicable. If not
specified, defaults to notapplicable, which
means that HA is not enabled.

accountName

Your AppDynamics account name. Ignored if
controllerTenancyMode=single.

accountAccessKey

Your AppDynamics account access key.
Ignored if controllerTenancyMode=single.
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rootUserPassword

The Controller root user password. The root
user is a Controller user account with
privileges for accessing the system
Administration Console. New in 3.8.4 This
password is used for the admin user of the
built-in Glassfish application server as
well. The Glassfish admin user lets you access
the Glassfish console and the asadmin utility.

rootUserRePassword

The root user password repeated for validation
purposes.

userName

The username of the initial administrator
account in the Controller UI. Ignored if
controllerTenancyMode=multi. See AppDynam
ics Administrator.
Usernames and password cannot
include the @ character. Also, if this
account will be used to access the
REST API, additional limitations on the
use of special characters in usernames
apply. See Configure Users for more
information.

password

The password for the admin user. You will
need this to log into the AppDynamics web UI,
where you can create other administrative
users and change the password. Ignored if
controllerTenancyMode=multi.

rePassword

The admin user password repeated. Ignored if
controllerTenancyMode=multi.

sys.installationDir

Directory in which to install the Controller. If
not specified, it is installed into the default
directory of the target environment, such as
AppDynamics/Controller under the user's
home on Linux systems.

sys.languageId

en

disableEULA

true

enableUDC

Set to true or false to specify whether to permit
data statistics collection from your controller.

mysqlRootUserPassword

The password of the user account that the
Controller uses to access its MySQL database.

realDataDir

The path to the Controller's data directory.
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elasticSearchDataDir

The path to the Elastic Search file store. Elasti
c Search is used by Database Monitoring featu
res. By default, the directory is located in the
Controller home. However, if you are putting
the MySQL data directory in an alternate
location, such as on a separate partition, the
Elastic Search data directory would likely need
to be put there as well.

Sample Response File

The following listings show sample response files for Linux and Windows systems.
Linux

The following sample shows a response.varfile for Linux systems:
#sampleresponse file for AppDynamics Controller 3.8
controllerConfig=demo
iiopPort=3700
serverPort=8090
serverHostName=demoserver
haControllerType=notapplicable
controllerTenancyMode=single
adminPort=4848
sys.languageId=en
jmsPort=7676
sys.installationDir=/home/appduser/AppDynamics/Controller
mysqlRootUserPassword=DRvYYv9eq6
databasePort=3388
userName=admin
password=pa55word
rePassword=pa55word
sslPort=8181
realDataDir=/home/appduser/AppDynamics/Controller/db/data
elasticSearchDataDir=/home/appduser/AppDynamics/Controller/events_se
rvice/analytics-processor
disableEULA=true
rootUserPassword=pa55word2
rootUserRePassword=pa55word2

Windows

On Windows, you need to escape the colon and backslashes in the directory paths in the
response file.
The following sample shows a response.varfile for Windows systems:
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#sampleresponse file for AppDynamics Controller 3.8
controllerConfig=demo
iiopPort=3700
serverPort=8090
serverHostName=demoserver
haControllerType=notapplicable
controllerTenancyMode=single
adminPort=4848
sys.languageId=en
jmsPort=7676
sys.installationDir=C\:\\AppDynamics\\Controller
mysqlRootUserPassword=DRvYYv9eq6
databasePort=3388
userName=admin
password=pa55word
rePassword=pa55word
sslPort=8181
realDataDir=C\:\\AppDynamics\\Controller\\db\\data
elasticSearchDataDir=C\:\\AppDynamics\\Controller\\events_service\\a
nalytics-processor
disableEULA=true
rootUserPassword=pa55word2
rootUserRePassword=pa55word2

Learn More

Install the Controller
Controller Install and Admin FAQ
Controller Installation FAQ
Q. What should I do if I forget the credentials during Controller installation?
Q. Can I install the Controller on a virtual machine?
Q. Do I need a multi-tenant installation?
Q. What is Controller High Availability mode and when should I choose it?
Q. Is the Controller upgrade seamless or will the existing data get purged?
Q. Will my current license work during an upgrade?
Q. Can a 32-bit Controller installation be upgraded to a 64-bit installation?
Q. How do I troubleshoot timeout errors during Controller installation?
Controller Administration FAQ
Q. How do I start and stop the Controller?
Q. After I log out of Windows, why can't I see the Controller?
Q. How do I uninstall the Controller?
Q. How do I access the Controller's application server?
Q. After the Controller shuts down, why is there no increase in the amount of free
memory on Linux system?
Q. Why am I getting "Caused by: java.net.ConnectException: Connection refused"
message in the server.log file?
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Q. Why do I get a stack overflow exception when installing the Controller installation
on a Windows machine?
Q. What troubleshooting information should I collect if I observe heavy load on the
Controller machine?
Q. How to trigger automatic collection of Controller logs?
Q. Why is there no data in the Metrics Browser?
Controller Installation FAQ
Q. What should I do if I forget the credentials during Controller installation?

During installation, you are prompted to provide a username and password for an administrator
account for the Controller. This is the account you use to access the AppDynamics User Interface
(UI) for the first time. If you lose this information, contact AppDynamics Support Team to reset the
password for the admin user.
Q. Can I install the Controller on a virtual machine?

The AppDynamics Controller can be installed on virtual machines. However, make sure that the
virtual machine meets the hardware resource requirements equivalent to physical machines. The
virtualized storage subsystem must provide the required I/O capacity. To verify the I/O capacity,
you can run Disk I/O rate tests. For details see Controller System Requirements.
Q. Do I need a multi-tenant installation?

You can configure the AppDynamics Controller in either single-tenant (single account) or
multi-tenant (multiple account) modes. AppDynamics recommends single-tenant mode for most
installations. For more details, see Controller Tenant Mode.
You choose the tenancy mode when you run the Controller installer. If you need to modify the
tenancy mode later, see Controller Tenant Mode.
Q. What is Controller High Availability mode and when should I choose it?

When using AppDynamics you may need to ensure the availability of the Controller. Availability
refers to the ability to cope with and if necessary recover from hardware or software failures.
A high availability mode configuration is two machines, both running the AppDynamics Controller.
If the primary machine is brought down, the secondary machine assumes the workload.
Configure HA mode for the Controller in either of the following situations:
When you want to ensure that any critical software or hardware failure cannot disrupt
Controller operations.
When you want to avoid the complexity of performing hot backups.
For more information see Controller High Availability.
Q. Is the Controller upgrade seamless or will the existing data get purged?

The Controller upgrade is seamless and retains all the existing client configurations, data, and
reports.
See Upgrade the Controller.
Q. Will my current license work during an upgrade?
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If you are moving from an older version to a newer version and have a license for the older
version, then that license should work when upgrading the Controller to a new version.
However, if you had a temporary license for the old version and now have a new license, then this
new license will not work on the old Controller. In this case, you should upgrade the Controller to
the latest version.
Q. Can a 32-bit Controller installation be upgraded to a 64-bit installation?

Yes. Follow the usual upgrade procedure at Upgrade the Controller.
Q. How do I troubleshoot timeout errors during Controller installation?

While installing the Controller, the installer attempts to start up the Controller application server
and database. At first database startup, the installer attempts to create the database schema,
tables, and other artifacts needed by the Controller.
By default, the installer waits five minutes for the Controller to start and three minutes for the
database. When installing a medium or large profile Controller or into certain types of
environments such as virtual machines, the time it takes to start up the system can exceed the
default startup timeout period. In this event, the installer aborts the installation and presents an
error message indicating that the Controller could not be started in the allotted timeout window.
If you encounter this timeout error during installation, try increasing the timeout periods. Pass a
custom timeout value as a command-line argument to the installer in the following format:
-Vad-timeout-in-min=<Controller_timeout>
-Vstartup-timeout-in-min=<database_timeout>

If performing a silent install with the response file, add the ad-timeout-in-min (Controller timeout)
or startup-timeout-in-min (database timeout) parameters to the installation response file with
values for the new timeout periods.
Controller Administration FAQ
Q. How do I start and stop the Controller?

See Start or Stop the Controller.
Q. After I log out of Windows, why can't I see the Controller?

The Controller is not installed as a Windows service by default. If you log out off in Windows, in
most cases you will shut down the Controller.
To verify whether the Controller is shut down, check for the status of Controller Glassfish and
MySQL processes. If these processes are active, that means the Controller is not shut down.
AppDynamics recommends you install the Controller as a service on Windows. For more
information see Install the Controller as a Windows Service.
Q. How do I uninstall the Controller?

See Uninstall the Controller.
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Q. How do I access the Controller's application server?

The AppDynamics Controller is a J2EE application that uses the GlassFish Application Server.
Use the following URL to access the Controller's application server:
http://Controller_Host:4848/login.jsf

The default port for the Controller Application Server is 4848 and is configured during Controller
installation. If you set a different value for this port, use that value in the URL.
To log in to the application server administrative console, use "admin" as the username and the
password that is located in the <controller_install_directory>/.passwordfile file.
Q. After the Controller shuts down, why is there no increase in the amount of free memory on Linux system?

You should not worry about the "free memory" value as it will always trend towards zero. The
Linux kernel tries to keep its cache as large as possible. As a result, the Linux kernel does not
release the memory even after process termination. The memory is freed only if it is required by
another process.
Q. Why am I getting "Caused by: java.net.ConnectException: Connection refused" message in the server.log file?

AppDynamics recommends that you verify the embedded MySQL database for the Controller
when you get following exception in server.log file of the Controller.
*Server log exception:* "Caused by: java.net.ConnectException:
Connection refused"

To verify that the Controller database is running properly use one of the following commands on
Linux environment:
Linux

Windows

Description

lsof -i:3388

SysInternals Process
Explorer, will provide you list
of files
opened by process with pid
3388.

List open files opened by
process
with pid 3388.

netstat -anp | grep 3388

netstat -ano | find "3388"

List all networking ports
opened by process
with pid 3388.

ps -aef | grep mysql

tasklist /v | find "mysql"

Lists all processes and then
checks if the process
with name "mysql" is active
and alive.

If no processes are found, it indicates that the Controller database was incorrectly terminated.
Start the Controller database again and verify the Controller server.log file for any error
messages.

Copyright © AppDynamics 2012-2014

Page 139

Q. Why do I get a stack overflow exception when installing the Controller installation on a Windows machine?

This exception is usually caused when you set the -Xss option to a lower value. We recommend
changing this value to 96000.
Q. What troubleshooting information should I collect if I observe heavy load on the Controller machine?

If the Controller machine experiences heavy load, contact the AppDynamics Support Team with
the following information:
Send all the <Controller_Installation_Directory>/logs/files, in particular the server.log files.
You can also use the log file utility to collect the Controller logs.
If the Controller runs out of memory, it generates a heap dump. Send all the
<Controller-Installation-Directory>/appserver/glassfish/domains/domain1/config/hprof files.
Send all the
<Controller-Installation-Directory>/appserver/glassfish/domains/domain1/config/gc.log files.
Send information about the hardware and operating system configuration of the machine
that is currently hosting the Controller, including operating system, bit version, CPU cores,
clock speed, disk configuration, and RAM.
Indicate the Performance profile of Controller. See Controller Performance Profiles.
Q. How to trigger automatic collection of Controller logs?

Use the following console commands to trigger automatic capture of Controller log files:
On Linux, run:
controller.sh zip-logs

On Windows, open an elevated command prompt (in the Windows start menu, right-click on
the Command Prompt icon and choose Run as Administrator) and run:
controller.bat zip-logs

Q. Why is there no data in the Metrics Browser?

This may indicate that the agents are not correctly configured. Begin troubleshooting by looking at
the server.log file.
All log files for Controller are located in the <Controller_Installation_Directory>/logs folder.
Error Message
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Error receiving metrics (node not properly
modeled yet: Could not find component for
node:

This error means the app agent tried to upload
metric data for a specific node, but the node
does not belong to any tier. Nodes must
belong to tiers and these tiers must belong to a
business application in order to receive metric
data for that node. See Logical Model.

Received Metric Registration request for a
machine that is NOT registered to any nodes.
Sending back null!

This error indicates that the Controller received
a registration request for metrics for a Machine
Agent that listed a machine ID not yet
associated with any node. Configure the
Machine Agent to associate with the correct
application, tier, and node. See Install the
Standalone Machine Agent.

Agent upload blocked, as its reporting a time
well into the future.

The App Agents attempt to report metric data
using Controller time. The agents retrieve the
time from the Controller every five minutes and
report times using a skew of the local machine
time, if different.
If for some reason the App Agent reports
metrics that are time-stamped ahead of the
Controller time, the Controller rejects the
metrics. To avoid this event, ensure that the
system times for the machine on which the
Controller is running and the machines for the
app agents are in synchronization.

Install Agents
Installing an AppDynamics app agent can be a manual process for small environments with just a
few monitored applications, or an automated process for an environment with a large number of
agents or if you need to deploy agents on an ongoing basis.
Manual installation

For information on manually installing agents, see the following links.
For Java application monitoring, see:
Quick Install for the Java Agent, or
Install the Java Agent
For .NET application monitoring, see:
Quick Install for the .NET Agent, or
Install the .NET Agent
For PHP application monitoring, see:
Quick Install for the PHP Agent, or
Install the PHP Agent
For node.js application monitoring, use 'npm install' to get and install the agent. You do not
need to download the agent manually. See Quick Install for the Node.js Agent or Install the
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Node.js Agent for more details.
Automated Installation

For automated deployment guidelines, see Deploy AppDynamics.
Network Requirements for App Agent Deployment

The following guidelines are intended to help you estimate how much bandwidth overhead will be
added to your environment by deploying AppDynamics agents.
Keep in mind that the exact bandwidth required for a deployment will vary greatly depending on
the nature of your application, the agent configuration, and the AppDynamics features you are
using. The best way to determine the bandwidth overhead is to test the AppDynamics deployment
in a staging environment that mirrors as closely as possible the live operating environment.
1. The approximate bandwidth used by a single Java Agent with the default configuration is 5
to 8 kilobytes per second.
2. Scaling of additional agents is linear. That is, if the average bandwidth usage for an app
agent in a given deployment is 5 kilobytes, adding 10 means that bandwidth usage will be 5
× 10, or 50 kilobytes.
3. While the average bandwidth used is 5 to 8 kbytes per second, agents send data to the
Controller in bursts rather than as a steady stream of data. When testing bandwidth usage, t
o determine the actual kbytes per second used by an agent, you need to observe and
average out traffic over the course of at least several minutes.
4. When testing bandwidth usage in the environment, keep in mind that different types of tiers
will generate a different amount of load. For instance, a database tier tends to generate
more traffic between the agent and Controller than an application server tier. For the best
possible estimate, the test should take this into account.
Related Topics

Name Business Applications, Tiers, and Nodes
Name Business Applications, Tiers, and Nodes

Naming Guidelines
Naming Components in a Java Environment
Automatic Naming for Application, Tier, and Node
Naming Components in a .NET Environment
Naming Components in a PHP Environment
Naming Components in a Node.js Environment
Renaming Icon Labels in the UI
Learn More

This topic discusses naming AppDynamics business applications, tiers, and nodes. For an
overview see Mapping Application Services to the AppDynamics Model.
Naming Guidelines
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The maximum length of a tier name is 100 characters and the maximum length of a node name is
500 characters.
Warning: Do not use ampersands (neither "&" nor its XML encoding, "&amp;") in application or
other component names.
Node names must be unique across the entire business application.
Naming Components in a Java Environment

When you start an App Agent for Java on a monitored system, you have the option of passing
values to the agent that will be used as the application, tier, and node name for the system.
Alternatively you can configure names in the controller-info.xml file. Use these guidelines when
configuring custom names:
Configure items that are common for all the nodes in the controller-info.xml file.
Configure information that is unique to a node in the JVM startup script.
Each node name must be unique.
AppDynamics names Java nodes automatically; also you can specify your own node names. In a
cloud or auto-scale environment, where nodes come and go regularly, it may be best to let
AppDynamics give each node a unique name.
For multiple JVMs on a single machine, see:
Configure App Agent for Java on Multiple JVMs on the Same Machine that Serves the Same
Tier
Configure App Agent for Java on Multiple JVMs on the Same Machine that Serve Different
Tiers
See also:
Install the Java Agent
App Agent for Java Configuration Properties
Automatic Naming for Application, Tier, and Node

The Java Agent javaagent command accepts an argument named uniqueID that AppDynamics
uses to automatically name the node and tier for this Java Agent. For example, using this
command argument AppDynamics will name the node and tier "my-app-jvm1":
-javaagent:<agent_home>/javaagent.jar=uniqueID=<my-app-jvm1>

When uniqueID is used and the application name is not provided either through the system
property or in the controller-info.xml, AppDynamics creates a new business application called
"MyApp".
The naming mechanism is used by the Java Agent Download Wizard process. See Quick Install.
Naming Components in a .NET Environment

The App Agent for .NET Configuration Utility automatically names the nodes, and you should not
change them. See Naming Conventions for .NET Nodes.
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See also:
Install the .NET Agent
.NET Agent Configuration Properties
Configure the .NET Agent
Naming Components in a PHP Environment

A PHP runtime instance maps to a node. Your naming convention may depend on your exact
environment. Use a name that clearly identifies the Web service that corresponds to the node. So
me options are:
hostName-appName-nodeName
hostName-tierName-nodeName
appName-nodeName
tierName-nodeName
IP address
fully qualified domain name
See also:
Install the PHP Agent
Naming Components in a Node.js Environment

A Node.js process maps to an AppDynamics node. The nodes are named by combining the prefix
that you specify for the nodeName in the requires statement that you add to the application source
code when you install the Node.js agent with a hyphen and a digit. See Modifying the Application
Code. For example, if you designate a prefix of MyNode for the nodes in the MyTier tier, the nodes
in that tier are named MyNode-0, MyNode-1, MyNode-2 and so on.
Renaming Icon Labels in the UI

Default or environment-based
names may not be very
user-friendly. You can use
labels to make nodes and tiers
more recognizable.

Labeling Your Components
Use labels that are recognizable to the people in
your group or company.

1. In the Application, Node, or
Tier Dashboard, click Actions
-> Edit Properties.
2. In the Properties dialog, type a new name.
3. Click Save.
Note: renaming in the UI is not persistent in the configuration. It changes the labels in the UI only.
Learn More

Mapping Application Services to the AppDynamics Model
Logical Model
Naming Conventions for .NET Nodes
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Controller Licenses
The License File for On-Premise Installations
Learn More
This topic discusses how to manage Controller licenses.
The License File for On-Premise Installations

A temporary license is included with the trial version of AppDynamics Pro. You do not need to
install it manually in most cases.
The license file, named license.lic, is located in the Controller home directory. This single license
enables the Controller. It also determines the number and types of app agents permitted in the
deployment. If you need to install a license file manually for any reason, simply copy the new
license file to the Controller home directory. After placing the license in the directory, the Controller
may take a minute or two to detect the new license. Alternatively, you can restart the Controller to
force it to detect the new license.
You do not need to deploy the license file for SaaS installations.
You do not need to install separate license files for the individual app agents themselves. If a
Controller is licensed for five app agents, for example, the first five agents that connect to the
Controller will be permitted. To effect a transfer of an app agent license, you simply shut down the
application that runs the agent or uninstall the agent from the monitored application, and start up
and connect the new application.
Contact the AppDynamics Sales Operations team at salesops@appdynamics.com with any
license-related questions or issues.
Learn More

License Information

Connect the Controller and Agents
Configuring the App Agent Connection to the Controller
Configuration File Locations for App Agents
Java Agent
.NET Agent
PHP Agent
Node.js Agent
Machine Agent
Common Controller Connection Properties
Securing the Connection
Controller Security
On-premise Controller
SaaS Controller
App Agent Security
Standalone Machine Agent Security
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Verify the Connection
Learn More
Configuring the App Agent Connection to the Controller

Before an App Agent can upload data to the Controller, you must configure its connection to the
Controller. Agents connect to the Controller through the same port as the browser connection for
the UI, on port 8090 by default.
If needed, you can configure the agent to connection through a web proxy for the Controller. It can
also connect to the Controller using an SSL connection. See Security for information on using
SSL.
Configuration File Locations for App Agents

Although the different agents have similar configuration properties, the way you configure the
Controller connection varies slightly among the different types of agents, as described here.
Java Agent

Configure Controller connectivity for the App Agent for Java the following places:
<agent install directory>/conf/controller-info.xml
In the system properties (-D options) in the JVM startup script
The system properties override the settings in the controller-info.xml.
See Where to Configure App Agent for Java Properties.
.NET Agent

Configure the agent properties in the config.xml file in the agent Config directory. If you run the
.NET Agent Configuration Utility, it writes the conifg.xml to the following locations:
Windows Server 2008 and later
%ProgramData%\AppDynamics\DotNetAgent\Config\config.xml

Windows Server 2003
%AllUsersProfile%\Application Data\AppDynamics\DotNetAgent\Config\config.xml

The App Agent for .NET includes the AppDynamics Agent Configuration utility to assist
configuration. See Configure the .NET Agent.
For more information, see:
Agent Configuration Properties (.NET)
Configure the .NET Agent
PHP Agent

Configure Controller connectivity for the App Agent for PHP in the php.ini file.
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When you install the PHP agent, provide the relevant Controller connection information. The install
script writes the configuration to php.ini.
For more information, see:
Install the PHP Agent using a Shell Script
Install the PHP Agent using RPM
Controller Information in the PHP Configuration Files
Node.js Agent

All the controller information is in the require statement that you add to the code when you
instrument the application.
See Install the Node.js Agent.
Machine Agent

Configure Controller connectivity for standalone machine agents in <machine agent install
directory>/conf/controller-info.xml.
Common Controller Connection Properties

The Controller configuration properties common to all agents are:
Controller Host
Controller Port
Controller SSL Enabled
Application Name
Tier Name
Account Name for SaaS
Account Access Key or Password for SaaS
Securing the Connection

The on-premise Controller is installed with an active secure port by default. App Agents can use
the secure port to connect to the Controller.
The certificate used for the connection out-of-the-box is a self-signed certificate. The .NET agents
cannot connect on a secure port that uses a self-signed certificate, so you will need to apply your
own certificate to the port. App Agents connecting to an AppDynamics SaaS Controller also must
use an HTTPS connection.
Controller Security

The default secure listening port for the AppDynamics Controller are:
For on-premise Controllers, port 8181
For SaaS Controllers, port 443
On-premise Controller

To implement SSL for controller-agent communication do the following:
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Set the application server primary port to the SSL port, by default 8181. See Controller Port
Settings.
Install a trusted certificate, see Controller SSL and Certificates.
Configure your agents for SSL. See the following sections, App Agent Security and Machine
Agent Security, for more information.
SaaS Controller

The SaaS Controller is already configured for SSL, so to enable your environment for SSL you
only need to do the following:
Configure your agents for SSL by enabling SSL and setting the port connection for the SaaS
Controller to 443. See the following sections, App Agent Security and Machine Agent
Security, for more information.
App Agent Security

To configure your agents for SSL, set these SSL-related properties:
Set controller-ssl-enabled to true.
Set the controller-port to the correct value for either on-premise or SaaS Controller.
In multi-tenant and SaaS environments, App Agents authenticate themselves to the Controller
using the required account name and account access key values set in the connection properties
configuration file.
Standalone Machine Agent Security

For information on the security settings related to the Standalone Machine Agent connection to the
Controller, see Standalone Machine Agent Configuration Properties.
Verify the Connection

Follow these instructions to verify that the Java or .NET App Agent is reporting to the
AppDynamics Controller.
1. Access the AppDynamics Controller UI:
For an on-premise Controller, open a browser at:
http://<Application_Server_Host_Name>:<HTTP_Listener_Port>/controller

For a SaaS Controller, open a browser at the URL provided to you by AppDynamics.
http(s)://<customer>.saas.appdynamics.com/controller

2. Provide user credentials:
For on-premise Controller installations, provide the credentials for the "admin" user as
configured during AppDynamics Controller installation.
For the SaaS Controller Service, use the credentials provided to you by
AppDynamics.
3.
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3. In the left navigation panel, click on an application.
4. Click Servers -> App Servers -> <TierName>.
The Tier Dashboard for the selected tier appears.
5. Click the Nodes tab.
When an App Agent is reporting to the Controller, the App Agent Status column shows a
green up arrow icon.

If the agent is not reporting to the Controller, see troubleshooting information:
Resolving Configuration Issues App Agent for Java
Resolve .NET Agent Installation and Configuration Issues
Learn More

Verify App Agent-Controller Communication
App Agent for Java Configuration Properties
.NET Agent Configuration Properties
Controller Information in the PHP Configuration Files
Configure the .NET Agent
Install the PHP Agent using a Shell Script
Install the PHP Agent using RPM
Install the Node.js Agent
Standalone Machine Agent Configuration Properties

Upgrade the Controller
About Controller Upgrades
Prior to Upgrade
Back up the Existing Controller
To back up the Controller instance
Apply the Upgrade
To upgrade the Controller
To upgrade Controllers configured in HA mode
Troubleshooting the Upgrade
Learn More
About Controller Upgrades

To upgrade the Controller, you run the installer for the version of the Controller to which you want
to upgrade on the Controller machine. When a Controller instance is already present, the installer
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detects the instance and prompts you to upgrade that instance. If there are multiple Controller
instances on the machine, the installer detects the last one installed.
The Controller installer supports upgrading from a given version to any later version, so you don't
need to apply updates for each intermediate version to update the Controller by several versions.
However, be sure to read the release notes for all intermediate versions to learn about the new
features and known issues that may apply to you.
Upgrading from an older version of the Controller (earlier than 3.4.0) can result in errors
related to database schema changes. If you encounter errors during upgrade, contact App
Dynamics Support for assistance.
During an upgrade, the Controller does not process metrics from the agents because it is not
running. You are not required to stop the agents during the Controller upgrade.
Prior to Upgrade

Read the Release Notes and Key Updates and Known Issues for any information that might
affect your particular upgrade.
Back up your Controller home directory and data directory as described in Back up the
Existing Controller.
Check the most recent Controller System Requirements to determine whether you need to
update your systems and/or change your performance profile. See Hardware Requirements
Per Performance Profile.
Review the Controller Sizing FAQ.
If you have changed any Glassfish settings that are not JVM options, note your changes. You
will have to reset them after upgrade. Controller upgrade does not persist properties manually
set in the domain.xml file or with the Glassfish asadmin utility. For related information see Modify
GlassFish JVM Options.
The database user password storage mechanism changed in Release 3.8. If upgrading from
3.7.x or earlier, note these considerations related to the database user password:
If you have not changed the Controller's database user password since the original
installation, the upgrade should work with no additional intervention required.
If you have removed the password from the file where it was stored before 3.8,
<Controller_install_dir>/.install4j/response.varfile, and don't provide the password as a
command-line argument to the installer or in the response file, you will be prompted to
provide the password during the upgrade. In this case, you need to copy the password
from the old response.varfile file prior to upgrading, and enter that password during
upgrade. Alternatively, you can pass the password to the installer:
As a command-line argument to the installer, using -VmysqlRootUserPassword
=<newpassword>, or
As the mysqlRootUserPassword variable in
<Controller_Home>/.install4j/response.varfile.
If you want to change the password, you must do it either after the upgrade or before.
You cannot change the password through the installer during an upgrade.
For more information about how to change and administer the database user password, see
Controller Data and Backups.
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Back up the Existing Controller

Before applying an upgrade to the Controller, you must back up the existing installation. If the
upgrade does not finish successfully for any reason, you will need to use the backup files to
restore the installation to its previous state. Do not attempt to upgrade again without restoring the
installation. See Troubleshooting the Upgrade for more information.
You need to back up the existing Controller home and the data directory for the Controller. Be
default, the data directory resides under the Controller home in the db directory.
To back up the Controller instance

1. Stop the Controller application server and database.
For Linux, run:
<controller_installation_directory>/bin/controller.sh
stop-appserver
<controller_installation_directory>/bin/controller.sh
stop-db

For Windows, run the following command in an elevated command prompt (right-click
on the Command Prompt icon in the Windows Start menu and choose Run as
administrator):
<controller_installation_directory>\bin\controller.bat
stop-appserver
<controller_installation_directory>\bin\controller.bat
stop-db

2. Back up the Controller home by copying the entire Controller home directory to a backup
location. Note the following points:
If the data home for the Controller is not under the Controller directory, be sure to
back up the database directory as well.
If it's not possible to back up the entire data set, you can selectively back up the most
important tables. To do so, use the Metadata Backup SQL script described and
attached to the Controller Data Backup and Restore page.
Apply the Upgrade

The following steps describe how to upgrade the Controller on Windows and Linux. To upgrade a
Controller that is running as a service on Windows, see Install the Controller as a Windows
Service.
You use the Controller installer in GUI mode, console mode, or silent mode to perform the
upgrade.
If using silent mode to apply the upgrade, pass the response file that the installer generated at first
installation to the installer. This response file is at the following location
<Controller_home_directory>/.install4j/response.varfile
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If you have made any changes to the settings as originally configured by the installer—such as to
the connection port numbers, tenancy mode, or data directory—you must make the same change
in the response file before starting the upgrade.
You must also add the existing root user password to˜ the file, rootUserPassword
and rootUserRePassword. If you do not, the installer prompts you to add the password.
To upgrade the Controller

1. Download the latest release from AppDynamics Download Center.
If you prefer to use the Linux shell, see Downloading from the Linux Shell.
2. If they are running, stop the Controller application server and database. The Controller cannot
be running during the upgrade. No data is collected from the time you shut down and start
the new version of the Controller.
For Linux, run:
<controller_installation_directory>/bin/controller.sh
stop-appserver
<controller_installation_directory>/bin/controller.sh
stop-db

For Windows, run the following command in an elevated command prompt (right-click
on the Command Prompt icon in the Windows Start menu and choose Run as
administrator):
<controller_installation_directory>\bin\controller.bat
stop-appserver
<controller_installation_directory>\bin\controller.bat
stop-db

3. Launch the Controller installer. You can launch it from anywhere on the file system. Confirm that
the installation directory is the same as the previous Controller installation directory on this
machine. The Controller will automatically migrate the data only when the existing installation
directory is specified. Once the installer detects the old version of the Controller in that location,
it will perform an upgrade instead of doing a fresh install.
The installer completes the upgrade and restarts the Controller.
4. (Optional for Windows) If you want to install the Controller as a Windows service, see Install the
Controller as a Windows Service.
5. If you made any manual changes to the configuration files listed, re-apply those changes to the
equivalent files in the upgraded instance. The installer does not automatically propagate
changes you have made to those files.
Contact Technical Support if you have questions about mapping configuration changes
across versions.
6. Open a browser and access the AppDynamics user interface:
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6.

http://<Controller_Host>:<Controller_Port>/controller

If the UI does not display the new Controller, refresh your browser cache to view the new UI.
To upgrade Controllers configured in HA mode

If you configure the high availability mode for the AppDynamics Controller, you must upgrade both
the primary and the secondary Controller.
1. On the secondary Controller, stop the application server:
<controller_installation_directory>/bin/controller.sh
stop-appserver

2. Upgrade the primary Controller using the instructions provided in the To upgrade the
Controller. Be sure to back up the existing files.
When you upgrade the primary Controller, the schema changes are replicated to the
secondary Controller. Then, when you launch the Controller installer on the secondary
Controller, the installer checks the schema version and, because the schema version is the
same as the new version, the installer skips any schema upgrades and only upgrades
software for the secondary Controller.
3. Verify that on the secondary Controller all the data has been replicated correctly.
a. Open a command line utility and go to the <controller_installation_directory>/bin directory.
b. Log into the secondary Controller database:
For Linux, run:
controller.sh login-db

For Windows, run the following command in an elevated command prompt
(right-click on the Command Prompt icon in the Windows Start menu and choose R
un as administrator):
controller.bat login-db

c. Execute following command:
SHOW SLAVE STATUS\G

This step should provide you following result:

Copyright © AppDynamics 2012-2014

Page 153

Seconds_Behind_Master: $Number_Of_Seconds_Behind_Master

If you get a non-zero number for this test, wait until the number becomes zero.

4. Start the application server for the secondary Controller:
a. Navigate to the <controller_installation_directory>/bin directory.
b. Use following command to start the application server for the Controller:
For Linux, run:
<controller_installation_directory>/bin/controller.sh
start-appserver

For Windows, in an elevated command prompt, run:
<controller_installation_directory>\bin\controller.bat
start-appserver

5. Upgrade the secondary Controller using the instructions provided in the To upgrade the
Controller.
6. Stop the application server for the secondary Controller.
a. From the command line, go to the secondary Controller's
<controller_installation_directory>/bin directory.
b. Use following command to stop the application server for the secondary Controller:
For Linux, run:
controller.sh stop-appserver

For Windows, in an elevated command prompt, run:
controller.bat stop-appserver

Both the primary and secondary Controllers are now upgraded.
Troubleshooting the Upgrade

The installer attempts to restart the Controller and database after applying an update or
installation. For large databases and depending on the system resources, this can take a
considerable amount of time. If the Controller installer cannot finish starting up the Controller within
a set time-out period (30 minutes by default), it exits the installation or upgrade.
If the upgrade does not succeed for any reason, the installer does not roll back changes on disk.
This give you an opportunity to diagnose and troubleshoot the issue before reattempting the
installation or upgrade.
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To troubleshoot the issue, check the installation log at <Controller_home>/.install4j/installation.log,
along with any other Controller log files.
After diagnosing the issue, you need to manually revert the installation back to its state prior to
starting the upgrade. To do so, replace the existing Controller directory and data home directories
with the backup directories you created before starting the upgrade. Then apply your remediation
changes, and restart the update or installation.
If necessary, you can increase the default time out period for system startup in the installer. To do
so, set the ad-timeout-in-min property to the new time in minutes in the response.varfile under
Controller_home/.install4j directory or from the command line as an argument to the installer.
Learn More

Controller Data Backup and Restore
Controller High Availability
Access the Administration Console
Install an On-Premise Controller Silently

Uninstall the Controller
To uninstall the Controller
Learn More
The Controller includes a utility that removes the Controller and all associated files from the
machine. The uninstaller is located in the Controller home directory.
To uninstall the Controller

1. On Windows, open an elevated command prompt by right-clicking on the Command Prompt
icon in the Windows Start Menu and choosing Run as Administrator.
2. From the command line, navigate to <Controller_Installation_Directory>/bin.
3. Stop the Controller. See Start or Stop the Controller.
4. Navigate to <Controller_Installation_Directory>.
5. Execute the uninstaller script to uninstall the Controller, as follows:
On Linux:
uninstallController

On Windows:
a. If the Controller runs as a Windows service, first enter this command:
run bin\uninstallControllerSvcs.bat

b. Next run:
run uninstallController.exe
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Learn More

Administer the Controller
Install the Controller
Install the Controller as a Windows Service

Migrate the Controller between Machines
Migrate by Copying the Data Directory
To migrate Controller data to new machine
Migrating by Copying the Entire Controller Directory
To migrate by copying the Controller directory to a new machine
Controller Migration FAQ
After moving the data to the new machine, why do I get a 443, permission denied
error?
Can I take a hot backup and use that for the new machine?
Do I need a new license if moving the Controller from a virtual to a physical
environment?
This topic describes how to migrate an existing Controller from a physical or virtual machine to a
physical machine. Prior to migrating consider backing up the existing Controller.
Migrate by Copying the Data Directory

The following instructions take you through the steps for installing the Controller on a new machine
and migrating the Controller data from an old machine.
To migrate Controller data to new machine

1. Ensure that the performance profile of the new machine matches the old machine. For
profile information see Controller System Requirements.
2. Ensure that the new Controller version matches the old Controller version. If necessary, upg
rade the old Controller first.
3. Back up the MySQL root user password from <Controller_Installation_Directory>/db/.rootpw.
4. Install a new Controller on the destination machine.
The old and new Controllers must be
the same version.
5. After installing the new Controller, shut the new Controller down. For details see Start or
Stop the Controller.
6. Rename the old Controller machine to a new name and IP address.
7. Rename the new Controller machine to the name and IP address of the old Controller
machine.
8. Get the new MAC address and provide it to AppDynamics Sales at
salesops@appdynamics.com to get a new license file.
9. Export the App Tier configurations from the old Controller and save them to the new
machine. For details see Export and Import Business Application Configurations.
10. Shut down the old Controller. By shutting down the old Controller before copying its data,
you ensure that all the data is moved to the new machine. For details see Start or Stop the
Controller.
11.
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11. On the new machine, rename the data directory,
<Controller_Installation_Directory>/db/data, so that it is not overwritten by the original data.
For example, rename "data" to "data_default".
12. Copy the data directory from the original Controller machine to the new machine.
13. Copy files that may contain configuration customizations from the original Controller
directory to the equivalent directory on the new machine. The files to copy are:
<Controller_Installation_Directory>/db/db.cnf
<Controller_Installation_Directory>/appserver/glassfish/domains/domain1/config/dom
ain.xml
<Controller_Installation_Directory>/appserver/glassfish/domains/domain1/config/ (any
other customizations in this directory)
<Controller_Installation_Directory>/appserver/glassfish/domains/domain1/appagent
<Controller_Installation_Directory>/appserver/glassfish/domains/domain1/applications
/controller/controller-web_war/WEB-INF/flex/services-config.xml (if using SSL)
14. Start the Controller on the new machine. For details see Start or Stop the Controller.
Migrating by Copying the Entire Controller Directory

Instead of migrating a data directory to a new Controller installation, as described in the previous
section, it's possible to migrate a Controller between machines by simply copying the entire
Controller directory.
However, there are two requirements to performing the migration in this manner:
The new machine should have the same IP address and host name as the old machine.
The new machine should have the exact same directory structure as the old installation
location.
To migrate by copying the Controller directory to a new machine

1. Shut down the old Controller. Shutting down the Controller before copying its data ensures
that all data will be moved to the new machine. For details see Start or Stop the Controller.
2. Copy the <Controller_Installation_Directory> from the old machine to the new machine.
C
opy the directory into the exact same directory structure.
3. Start the Controller on the new machine. For details see Start or Stop the Controller.
IMPORTANT: Do not ever start the Controller on the old machine again!
Controller Migration FAQ
After moving the data to the new machine, why do I get a 443, permission denied error?

This can happen if port 443 is bound to some other application. Change the HTTPS port, for
example, from 443 to 5443.
Can I take a hot backup and use that for the new machine?

You can perform the migration with data from either a hot or cold backup, but it is important to get
the backup of the data directory from <Controller_Installation_Directory>/db. However,
AppDynamics strongly recommends that you perform a cold backup of the data.
A hot backup will not bring the Controller down for a long time, but you will still lose the data when
you migrate. This is because hot backup will only have the data from the point that the hot backup
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started and not when it ended.
Do I need a new license if moving the Controller from a virtual to a physical environment?

If the physical machine has the same MAC address, you can reuse the license. If that is not the
case, please contact the AppDynamics Support Team to request a new license.

Install the On-Premise End User Experience Management Processor
Installation Overview
Demo Mode Versus Production Mode
Controller Configuration
System Requirements for the EUEM Processor
Running the Installer
Installing On-Premise EUEM in Demo Mode
Installing On-Premise EUEM in Production Mode
Configuring the Controller for a production EUEM deployment
Installing the EUEM Processor for a production deployment
Using a Custom Keystore
Customizing HTTPS Support Manually
Change the EUEM Processor port
Tell the agent where to send the beacons
All the applications reporting to a particular controller use the same EUEM
Processor
Each application uses a different EUEM Processor
Using the Silent Installer
To use the silent installer
Starting and Stopping the EUEM Processor
Troubleshooting the On-Premise EUEM Installation
End user data does not appear in the Controller
License exception on starting the EUEM Processor
Modifying Settings
Verify Configuration After Controller Upgrade
Installation Overview

With SaaS EUEM, AppDynamics hosts the EUEM Processor, Controller, and other backend
services for you. Setting up EUEM in this case only requires ensuring that the Web and Mobile
EUEM agents are correctly deployed and configured. Alternatively, you can install and run the
EUM services and Controller yourself, as described here. An on-premise deployment allows you to
store and maintain the data generated by EUEM entirely within your own data center.
The EUEM Processor receives data from the EUEM agents, processes it, stores it, and makes it
available to the AppDynamics Controller. If you already have an on-prem AppDynamics Controller,
you need to make sure you have upgraded to a compatible version and apply a few configuration
changes to the Controller to enable it to work with the on-premise EUEM Processor.
The EUEM installer installs the EUEM Processor and configures the Controller to work with
EUEM. To install the Controller, see Install the Controller.
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Demo Mode Versus Production Mode

The EUEM installer operates in one of two modes: demo mode or production mode. Demo mode is
intended for very small-scale demonstration or evaluation environments. In demo mode, the installer
configures the Controller for EUEM support and installs the EUEM Processor on the same machine.
In production mode, the Controller and EUEM Processor are expected to reside on separate, dedicated
machines. To deploy EUEM in a production environment you therefor need to run the installer on
two machines: first on the Controller machine, to make the necessary updates on the Controller
instance, and then again on the EUEM Processor host, to install and configure the Processor.

Specifically, the tasks and the order in which they should be performed are:
For a production environment on-premise EUEM:
1. Run the installer on the Controller host.
2. Run the installer on the EUEM server host.
For a small-scale demonstration environment, simply run the installer once on the Controller
host.
In a production environment, the EUEM Processor is intended to operate behind a reverse proxy.
There are several reasons for this. A reverse proxy relieves the performance burden of SSL
termination from the EUEM processor machine. It also helps ease certificate management and
security administration in general. Further, as the connection point for agent beacons, the
processor needs to have the security layer of a proxy between itself and the external Internet.
In demo mode, the EUEM processor listens for connections on port 80 or 443. The secure port
uses a built-in, self-signed certificate.
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Controller Configuration

On-premise EUEM requires Controller version 3.8.2 or later. If installing EUEM with an existing
on-premise Controller, whether in a production or test environment, be sure to back up the
Controller before starting.
The installer makes these changes to the Controller:
Creates an EUEM database schema in the MySQL database shared with the Controller
Registers the EUEM Processor instance with the Controller
Provisions the EUEM-enabled license in the Controller
The Controller will need to be restarted at the end of the configuration changes applied by the
installer. If necessary, perform the Controller configuration procedure with the installer at a time
when restarting the Controller has minimum impact on service availability.
System Requirements for the EUEM Processor

The requirements and guidelines for the EUEM Processor machine (basic EUEM usage) are:
40 GB extra disk space
64-bit Windows or Linux operating system
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Processing: 4 cores
10 Mbps network bandwidth
Minimum 8GB memory total (4GB is defined as max heap in JVM)
NTP enabled on both the EUEM Processor host and the Controller machine. The machine
clocks need to be able to synchronize.
A machine with these specs can be expected to handle around 10K page requests a
minute or 10K simultaneous mobile users. Adding on-premise Analytics capability requires
increasing these requirements - particularly disk space - considerably, depending on the use
case.
Running the Installer

The following instructions describe how to run the installer in GUI mode on Linux systems. GUI
mode provides a wizard-based approach to installation. Alternatively, you can use a response file
for unattended installation or console mode. While the steps and screenshots demonstrate the
installation on Linux, the steps to perform a Windows installation are equivalent. The instructions
note where there are differences based on the operating systems.
To start the installer in console mode, start the installer with the -c. For a response file, use the -q
switch and specify the response file to use. For example:
-q -varfile /home/user/response.varfile

See Using the Silent Installer for a sample response file.
Installing On-Premise EUEM in Demo Mode

If you do not already have an existing on-prem Controller, install it as described in Install the
Controller. See Controller Configuration for more information.
Get the EUEM Processor installer from the AppDynamics Download Center. Before starting,
download the installer distribution and extract it on the target machine.
Install the on-premise EUEM in Demo mode as follows:
1. At the command line, navigate to the directory where you extracted the installer archive and
start the installer as follows:
On Linux, run the following command:
./euem-installer-64bit-linux.sh

On Windows, run the following command:
euem-installer-64bit-windows.bat

2. In the Welcome screen, click Next.
The License Agreement page appears.
3.
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3. Scroll to the end of the license agreement, click Accept, and click Next.
4. Select the directory in which you want to install the EUEM Processor and click Next.

5. Choose Demo for the installation mode and click Next. In this mode, the installer looks for a
Controller on the current machine and applies changes to it. It then installs the EUEM
Processor on the same machine.

6. Enter the hostname for the EUEM processor and verify or edit the default listening ports. Th
e hostname and ports shown here are where the EUEM Agents send their beacons. Use the
hostname for the machine as addressed on the network rather than "localhost" to ensure
that the EUEM Processor can be registered correctly in the Controller configuration.
7.
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7. Enter the Controller home directory and click Next. You can specify the directory by clicking
Browse and selecting it in the Select Directory dialog box.

8. In the AppDynamics Controller Database Information fields, enter the connection settings
used by the Controller to access its MySQL database, along with settings for a new user
account in the database to be used by the EUEM Processor.
Using localhost to indicate the database host will help you avoid permissions issues.
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The installer connects to the Controller database and adds a new table for on-premise
EUEM, eum_db.
9. In the EUEM Database Password field, enter a password for a new database user for
EUEM, eum_user. Confirm the password and click Next
The installer performs the installation based on your settings.
10. When the installer is finished, note the information in the Complete page. It contains next
steps and information on how to start the EUEM Processor. Click Finish to close the
installer.
11. Restart the Controller to complete the installation.
The address that the agents use to send their beacons to the EUEM Processor needs to be
updated. For Web EUEM, the Controller updates the JavaScript agent. Simply re-download and
deploy it, as described in Set Up and Configure Web EUM. For Mobile EUEM, the mobile
applications themselves need to updated, using the mobile SDKs. For more information, see Cust
omize Your Android Instrumentation and Customize Your iOS Instrumentation.
Installing On-Premise EUEM in Production Mode

Installing on-premise EUEM for a production environment requires running the EUEM installer on
two machines:
On the Controller host
On the EUEM Processor host
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The order in which you perform the tasks is important. The EUEM installer must be run on the
Controller host before you run the installer on the EUEM Processor host.
Before starting, verify the Controller installation and version and back up the Controller.
Get the EUEM Processor installer from the AppDynamics Download Center. Before starting,
download the installer distribution and extract it on the target machine and on the Controller
machine.
Configuring the Controller for a production EUEM deployment

Configure the Controller for an on-premise EUEM deployment in production mode as follows:
1. At the command line, navigate to the directory where you extracted the installer archive and
start the installer as follows:
On Linux, run the following command:
./euem-installer-64bit-linux.sh

On Windows, run the following command:
euem-installer-64bit-windows.bat

2. In the Welcome screen, click Next.
The License Agreement page appears.
3. Scroll to the end of the license agreement, click Accept, and click Next.
4. Select the directory in which you want to install the EUEM Processor and click Next.

5. Choose Production Controller Configuration for the installation mode and click Next. In
this mode, the installer looks for a Controller on the current machine and configures it to
work with on-premise EUEM.
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6. Enter the hostname for the EUEM Processor along with the HTTP or HTTPS listening ports.
These values should be the hostname and port that the Controller uses to connect to the
EUEM Processor on the network.
7. Enter the Controller home directory and click Next. You can specify the directory by clicking
Browse and selecting it in the Select Directory dialog box.
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8. In the AppDynamics Controller Database Information fields, enter the connection settings
used by the Controller to access its MySQL database, along with settings for a new user
account in the database to be used by the EUEM Processor.
Using localhost to indicate the database host will help you avoid permissions issues.
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The installer connects to the Controller database and adds a new table for on-premise
EUEM, eum_db.
9. In the EUEM Database Password field, enter a password for a new database user for
EUEM, eum_user. Confirm the password and click Next
The installer performs the installation based on your settings.
10. When the installer is finished, note the information in the Complete page. It contains any
next steps. Click Finish to close the installer.
11. Restart the Controller to complete the installation.
Now run the installer on the EUEM Processor target machine, as described next.
Installing the EUEM Processor for a production deployment

After setting up the Controller on the Controller host, run the on-premise EUEM installer on the
machine on which you want to install the EUEM Processor.
1. At the command line, navigate to the directory where you extracted the installer archive and
start the installer as follows:
On Linux, run the following command:
./euem-installer-64bit-linux.sh
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On Windows, run the following command:
euem-installer-64bit-windows.bat

2. In the Welcome screen, click Next.
The License Agreement page appears.
3. Scroll to the end of the license agreement, click Accept, and click Next.
4. Select the directory in which you want to install the EUEM Processor and click Next.

5. Choose Production EUEM Processor Installation for the installation mode and click Next.
In this mode, the installer installs and configures the EUEM Processor on the current
machine.
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6. Enter the hostname or IP address of the Controller and the HTTP or HTTPS listening port
for the EUEM Processor.
The default EUEM HTTP port is 7001 and HTTPS is 7002. These are the ports to which the
agents connect to send EUEM data. For secure connections from agents, you should
terminate SSL at a reverse proxy that sits in front of the EUEM Processor in the network
path and forward connections to this port.
Using a reverse proxy is the best practices method of setting up HTTPS connections for
an on-prem EUEM Processor. If this is not possible in your installation, however, it is
possible to to set HTTPS support manually. See Customizing HTTPS Support Manually.
7. In the database connection settings, enter the connection information the EUEM Processor
will use to connect to the Controller database. Also enter the password you specified for the
EUEM user when configuring the Controller in the previous section.
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With the initial configuration information gathered, the installer now completes the setup of the
EUEM Processor.
The processor does not start automatically at the completion of installation. To start it, use the
commands described in Starting and Stopping the EUEM Processor.
The address that the agents use to send their beacons to the EUEM Processor needs to be
updated. For Web EUEM, the Controller updates the JavaScript agent. Simply re-download and
deploy it, as described in Set Up and Configure Web EUM. For Mobile EUEM, the mobile
applications themselves need to updated, using the mobile SDKs. For more information, see Cust
omize Your Android Instrumentation and Customize Your iOS Instrumentation for more
information.
Using a Custom Keystore

New in 3.9.4 The installer opens a secure listening port for the EUEM Processor that uses a
default certificate in a bundled keystore. The keystore file is located at eum-processor/bin/ssugg.k
eystore. You can replace the default keystore and certificate as follows:
1. Place the new keystore file under the bin directory of your EUEM Processor home directory.
2. Open the onprem.properties file in the bin directory for editing.
3. Add the following properties to the file (if not already present), setting their values to the
name of the custom keystore file and password for the certificate, respectively:
com.appdynamics.eum.server.keystore.filename=custom.keystore
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3.

com.appdynamics.eum.server.keystore.password=custom.password
4. Restart the EUEM processor.
Customizing HTTPS Support Manually

In 3.9.4 and later, the installer configures an HTTPS listening port with a default keystore for the
EUEM Processor. In previous versions, to use HTTPS, you must do two things:
1. Change the EUEM Processor port
2. Tell the agent where to send the beacons
Change the EUEM Processor port

1. In the EUEM Processor host, open <EUEM_home>/eum-processor/bin/onprem.prope
rties with a text editor.
2. Make the following edits and additions to the file:
com.appdynamics.eum.server.port.https=<port-number> // the port
on the EUEM Processor for HTTPS traffic
com.appdynamics.eum.server.httpsProduction=true // enables
HTTPS support for production

3. Save the file.
Tell the agent where to send the beacons

There are two different scenarios for this step.
All the applications reporting to a particular controller use the same EUEM Processor

In this case the simplest thing is to modify the domain.xml file on the controller itself.
1. In the Controller host, open <Controller_home>/appserver/glassfish/domains/d
omain1/config/domain.xml with a text editor.
2. Add the following property:
<jvm-options>-Dappdynamics.controller.eum.beacon.hostNameHttps=
<processor host>:<https port></jvm-options>

where <processor host> is the EUEM Processor hostname and <https port> is the
HTTPS port you configured in the previous step.
3. Save the file.

Each application uses a different EUEM Processor

In this case, the simplest thing is to use the Controller UI to modify the EUEM Process for each
application.
1. In the Controller UI for each application, access the EUEM configuration screen. Click Confi
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1.

2.
3.
4.
5.
6.

gure->Instrumentation.
Select End User Experience tab.
Select Web Page JavaScript Instrumentation sub-tab.
Expand Advanced.
Expand Customize Your Deployment.
Enter the EUEM Processor hostname and port in the EUM Data Collector URL (Optional)
field.

7. Click Save.
Using the Silent Installer

Instead of using the installer in GUI mode, you can use the silent installer to perform an
unattended installation. The silent installer takes a response file as a source for the initial
configuration settings. It's useful for scripting installation or performing large scale deployments.
To use the silent installer

1. Create a file named response.varfile on the machine on which you will run EUEM installer
with the following contents.
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#Response file for AppDynamics End User Experience Management
3.9.0.0
#
sys.adminRights$Boolean=false
euem.httpPort=80
euem.httpsPort=443
euem.Host=<euem_processor_hostname>
mysql.databaseRootUser=root
sys.languageId=en
mysql.databasePort=3388
mysql.dbHostName=localhost
sys.installationDir=/AppDynamics/EUEM
euem.InstallationMode=demo
controller.installationDir=<path_to_controller_home>
controller.Host=localhost
eumDatabasePassword=<eum_user_password>
eumDatabaseReEnterPassword=<eum_user_password>
mysqlRootUserPassword=<root_user_password>

2. Adjust values of the installation parameters based on your own environment and
requirements. In particular, modify the directory paths and passwords to match your
environment.
3. The installation mode in the response.varfile above is set to demo mode. For production
mode, run the installation with the response.varfile twice, once on the Controller machine
and again on the EUEM Processor host:
a. To set up the Controller, change the mode by changing the euem.InstallationMode
value to:

euem.InstallationMode=production-controller-setup

b. For the EUEM Processor installation, change the mode to:
euem.InstallationMode=production-eum-setup

4. Run the installer with the following command:
./euem-installer-64bit-linux.sh -q -varfile response.varfile

On Windows, use:
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euem-installer-64bit-windows.bat -q -varfile response.varfile

Starting and Stopping the EUEM Processor

Start the EUEM Processor as follows:
On Linux, from the eum-processor directory, run the following command to start the
production EUEM Processor:
./bin/eum.sh start

For a demonstration environment, run the command as sudo, as follows:
sudo ./bin/eum.sh start

On Windows, start the EUEM Processor by running:
c:\AppDynamics\EUEM>.\bin\eum-process-start

Note that this does not return control back to the terminal.

To stop the EUEM Processor:
On Linux, from the eum-processor directory, run:
./bin/eum.sh stop

On Windows, stop the EUEM Processor by pressing the CTRL-C key sequence in the
terminal in which it is running.
Troubleshooting the On-Premise EUEM Installation

The following sections provide troubleshooting information for the EUEM installation.
End user data does not appear in the Controller

If end user data does not appear in the Controller, follow these steps to troubleshoot the
installation:
1. Check the Controller logs for errors in attempting to connect to the EUEM processor. Also,
see if the Controller UI allows you to enable EUEM. If so, it's likely that the connection
between the Controller and EUEM Processor is working.
2.
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2. Check the logs of the EUEM Processor, especially <EUEM_home>/logs/eum-processor.log.
In the log, verify that the processor started successfully and is receiving beacons from
agents.
3. Make sure that the EUEM JavaScript Agent is actually injected into the monitored page and
that the agent can load the remote JavaScript.
4. Use browser debugging tools to check for JavaScript errors in the monitored page.
5. If you're still not able to identify and correct the issue, contact AppDynamics Support.
License exception on starting the EUEM Processor

If after installation the EUEM Processor fails to start with a EUEM license exception, try installing
the license manually.
With the Controller running and accessible to the EUEM Processor machine, install the license
manually as follows:
1. Verify that the JAVA_HOME/bin is in the system PATH variable and points to a Java 1.7
instance.
2. In Windows, open an elevated command prompt (run as administrator).
3. From the command line, navigate to the eum-processor directory under your EUEM
Processor home.
4. Run the following script:
On Linux:
./bin/provision-license
On Windows:
bin\provision-license.bat
Modifying Settings

The installer writes most of the configuration settings to the following configuration file:
<EUEM_home>/eum-processor/bin/onprem.properties
After installation is complete, you can edit the file to modify any of the user configurable settings,
as described in the comments within the file.
The properties file OnPremStore.properties defines the location of the file store used by EUEM. By
default, this storage location is in the EUEM home directory. The data store location can be
changed, but it must be a location that is writable by the user starting the EUEM Processor. At
startup, the EUEM processor checks that it can write to the file store location
Verify Configuration After Controller Upgrade

Upgrading the Controller configured for on-premise EUEM may overwrite certain Controller
configuration customizations originally applied by the EUEM installer. After you upgrade the
Controller version, verify and if needed restore EUEM configuration settings manually.
To verify and restore the EUEM settings in the Controller configuration:
1. From a terminal, navigate to the following directory:
<Controller_home>/appserver/glassfish/domains/domain1/config
2. Open the domain.xml for editing and the backup of the domain.xml file that was generated
during the upgrade process. The backup file is located in the same directory and is named
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2.
with the following pattern:
domain.xml_yyyyMMdd_HHmmss.bak
Where yyyyMMdd_HHmmss is the time at which the backup was created.
3. Compare the following JVM options under the java-config element. The domain.xml version
should match the one in your backup domain.xml file.
<java-config>
...
<jvm-options>-Dappdynamics.controller.eum.cloud.hostName=http:/
/controller.example.com:80</jvm-options>
<jvm-options>-Dappdynamics.controller.eum.beacon.hostName=hostn
ame1</jvm-options>
</java-config>

4. Replace the values of the appdynamics.controller.eum.cloud.hostName
and appdynamics.controller.eum.beacon.hostName options in domain.xml with those in the
backup file and save the file.
5. Restart the Controller.

Architecture and Model
This topic summarizes the components of AppDynamics and how they work together to monitor
your application environment. Topics include:
AppDynamics Pro Architecture
AppDynamics Controller and UI
AppDynamics App Agents
AppDynamics Machine Agents
AppDynamics Web EUEM
AppDynamics Mobile EUEM
AppDynamics for Databases
AppDynamics Pro Architecture

An AppDynamics deployment consists of a Controller (either on-premise or SaaS) and its UI, app
agents, and machine agents. Additional components include Web End User Experience
Management, Mobile EUEM, and AppDynamics for Databases.
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AppDynamics Controller and UI

The AppDynamics Controller is the central repository and analytics engine where all performance
data is stored, baselined, and analyzed. The Controller is specially designed for large-scale
production environments, and can scale to manage hundreds to thousands of application servers.
The AppDynamics Controller can be installed on-premise or it can be accessed as software as a
service (SaaS). A SaaS Controller is managed at AppDynamics and you connect to it from a web
browser using HTTP/HTTPS. An on-premise Controller is managed by you on your server in a
data center or in the cloud.
You access performance data interactively using the Controller UI or programmatically using the
AppDynamics REST API.
AppDynamics App Agents

AppDynamics app agents use automatic code injection to instrument your application and report to
the AppDynamics Controller. AppDynamics app agents are installed on your JVM, .NET, or PHP
application.
Patent-pending Dynamic Flow Mapping™ technology continuously discovers, maps, and tracks all
business transactions, services, and backends in your web application architecture 24×7.
Patent-pending Deep-on-Demand Diagnostics™ technology learns code execution behavior for
each business transaction. It automatically detects problems and collects deep diagnostics data to
troubleshoot them.
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AppDynamics Machine Agents

One or more machines (real or virtual) constitute the hardware and operating system on which
your application runs. Machines can be instrumented by an AppDynamics machine agent, which
collects data about machine performance and sends it to the Controller.
AppDynamics Web EUEM

AppDynamics Web End User Experience Management (Web EUEM) allows you to see how your
web application is performing from the point of view of your end user. You can answer questions
like: Which 1st or 3rd party Ajax or iframe calls are slowing down page load time? How does
server performance impact end user experience in aggregate or in individual cases? You can drill
into the data to explore how users experience your application in their Web browsers.
AppDynamics Mobile EUEM

Mobile Application End User Experience Management (Mobile EUEM) provides visibility into the
end-user experience of your mobile users. If you have also instrumented your application servers,
you can get end-to-end visibility from the mobile device all the way to multiple tiers on the
server-side.
AppDynamics for Databases

AppDynamics Pro along with AppDynamics for Databases gives you end-to-end visibility into the
performance of your applications, helping you dramatically reduce the time it takes to find and fix
database performance issues.

Logical Model
Business Application
Tiers
Nodes
Learn More
This topic describes the basic elements of the AppDynamics model.
Before deploying AppDynamics, also see Mapping Application Services to the AppDynamics
Model.
Business Application

An AppDynamics business application models all components or modules in an application
environment that provide a complete set of functionality. Think of it as all the web applications,
databases, and services that interact or "talk" to each other or to a shared component. When web
applications, databases, and services interact, AppDynamics can correlate their activities to
provide useful and interesting performance data.
AppDynamics lets you monitor multiple business applications, though it does not correlate events
between them.
Because a single node belongs to a single business application, you can also think of a business
application as a kind of namespace for all your nodes. See Nodes.
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Business applications contain tiers, and tiers contain nodes.
Tiers

A tier represents a key module in an application environment, such as a website or processing
application or a virtual machine. Tiers help you logically organize and manage your business
application so that you can scale multiple nodes, partition metrics, define performance thresholds,
and respond to anomalies. The metrics from one tier tell a different story than those from another
tier; AppDynamics helps you define different policies and processes for each tier. A tier can belong
to only one business application.
A tier is composed of one node or a group of nodes. For example, in the Acme sample application
the Inventory tier has one node whereas the E-Commerce tier has 2 nodes.
Nodes grouped into a tier may have redundant functionality or may not. An example of a
multi-node tier with redundant nodes is when you have a set of clustered application servers or
services. An example of a multi-node tier with different nodes is when you have a set of services
that do not interact with each other though you want to roll up their performance metrics together.
Keep in mind that an environment can have similar nodes that are used by different applications,
so similar nodes should not always belong to the same tier. An example is a complex environment
that has two HTTP web servers that serve two separate applications.
Business applications contain tiers. The traffic in a business application flows between tiers. This
flow is represented in AppDynamics flow maps along with performance data for the traffic. There is
always a tier that is the starting point for a Business Transaction, indicated by a Start label on the
flow map.
Nodes

A node is the basic unit of processing that AppDynamics monitors. By definition a node is
instrumented by an AppDynamics agent, either an app agent or machine agent or both. App
agents are installed on:
JVMs
Windows .NET applications (IIS, executables, or services)
PHP Runtime Instances
Node.js processes
Machine agents are installed on virtual or physical machine operating systems.
Nodes belong to tiers. An app agent node cannot belong to more than one tier. A machine agent
cannot belong to more than one tier; however you can install more than one machine agent on a
machine.
Learn More

Mapping Application Services to the AppDynamics Model
Name Business Applications, Tiers, and Nodes
Features Overview
Glossary

Mapping Application Services to the AppDynamics Model
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Your Application and the AppDynamics Model
How AppDynamics Represents Your Application
AppDynamics Business Applications
AppDynamics Tiers
How to Map
Learn More
AppDynamics and your team may use different terminology to describe your application
environment. This topic discusses how to map the services in your application environment to the
AppDynamics model, which uses the terms "business applications", "tiers", and "nodes". For an
overview of these terms see Logical Model.
Your Application and the AppDynamics Model

Your distributed application environment most likely consists of various services, including:
Web applications served from an application server (JVM, IIS, PHP Web server, etc.)
Databases or other data stores
Remote services such as message queues and caches
AppDynamics maps your application environment into a hierarchical system of business
applications, tiers, nodes and backends.
The node represents the actual application server that is instrumented by an AppDynamics app
agent.
Business applications and tiers are logical constructs used to represent your environment in the
AppDynamics model.
Business applications contain tiers and tiers contain nodes. A node cannot belong to more than
one tier, and a tier cannot belong to more than one business application.
A backend is a component that is not instrumented by an AppDynamics app agent, but the model
allows you to monitor the flows from the instrumented nodes to the backends. These flows often
reveal the root cause of a problem that is first identified on an instrumented node.
How AppDynamics Represents Your Application

The flowmap below describes a single business application for the Acme Online Book Store.
E-Commerce, Order Processing and Inventory are the tiers.
The boxes inside the tiers represent instrumented nodes. The E-Commerce tier has two
nodes, the Order Processing and Inventory tiers each has one node.
The database backends are XE-Oracle, Inventory-MySQL, APPDY-MySQL and two Oracle
10.0.0s.
The message queue backend is Active MQ--Order Queue.
The blue lines represent the flow of traffic through the entire application.
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Because the services provided by the E-Commerce, Inventory, and Order Processing interacting
tiers are all modeled as part of the same business application, it is possible, for example, for
AppDynamics to trace the root cause of poor performance of a node in the front-end E-Commerce
tier to a slow SQL call from the downstream Inventory tier to the INVENTORY-MySQL database.
Without this correlation among the services, this information would not be available.
AppDynamics Business Applications

You can use a single AppDynamics business application to model all of the application
environment's services that provide a complete set of functionality. Think of the business
application as all the services that interact to support the application's mission. When these
services (web applications, databases, remote services, etc.) interact, they are modeled as part of
the same business application, and AppDynamics can correlate performance metrics among them
to provide a complete picture of the application's performance. A complete picture helps you
identify the root cause of any problems that are detected. If any of the services upon which the
application depends are missing from the model, you may miss information about a component
that is causing problems to appear in a different component. AppDynamics cannot provide
correlation between separate business applications.
For example, a single shopping business application may be composed of an inventory
application, a e-commerce front-end application, and databases. The inventory application and
e-commerce front-end application could be modeled as tiers in a single AppDynamics "business
application".
On the other hand, if you do not care about correlation among these services and instead want to
maintain separate access control to the various components, you could model the services as
separate business applications.
It is also appropriate to have multiple business applications for sets of services that do not interact
with each other. A typical example of using multiple business applications is when you have
separate staging, testing, and production environments for the same website. In this case the
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three business applications are essentially copies of each other.
AppDynamics Tiers

An AppDynamics tier represents an instrumented service (such as a web application) or multiple
services that perform the exact same functionality and may even run the same code. These
services may be thought of as "applications" in your application environment, but if they interact
with one another AppDynamics usually models them as tiers in the same "business application".
A tier can be composed of one node or multiple redundant nodes. One example of a multi-node
tier is a set of clustered application servers or services.
There is no interaction among nodes within a single tier. Interaction occurs between tiers in a
business application, as illustrated in the flowmap.
How to Map

The mapping of tiers to business applications and of nodes to tiers occurs in the configuration of
the app agent, either in the options to the app agent startup script or in the controller-info-xml file.
For example, in an all-Java environment, to map Node_8000 and Node_8003 to the E-Commerce
tier in the AcmeOnLine business application, the startup options for Node_8000 would be
-Dappdynamics.agent.applicationName=AcmeOnLine
-Dappdynamics.agent.tierName=E-Commerce
-Dappdynamics.agent.nodeName=Node_8000

and for Node_8003
-Dappdynamics.agent.applicationName=AcmeOnLine
-Dappdynamics.agent.tierName=E-Commerce
-Dappdynamics.agent.nodeName=Node_8003

To map Node_8002 in the Inventory tier in the same business application, the configuration would
be
-Dappdynamics.agent.applicationName=AcmeOnLine
-Dappdynamics.agent.tierName=Inventory
-Dappdynamics.agent.nodeName=Node_8002

and to map Node_8001 in the Order Processing tier in the same application
-Dappdynamics.agent.applicationName=AcmeOnLine
-Dappdynamics.agent.tierName=Order Processing
-Dappdynamics.agent.nodeName=Node_8001

Details vary depending on the platform of the agent. See the installation and configuration
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properties documentation for the particular app agent that you are configuring.
Learn More

Logical Model
Name Business Applications, Tiers, and Nodes
App Agent for Java Configuration Properties
.NET Agent Configuration Properties
Install the PHP Agent
Install the App Agent for Node.js

Administration Guide
This section provides information on installing, setting up, and administering the AppDynamics
Controller, App Agents, and Machine Agents. This information is targeted for system
administrators and installers of the AppDynamics Pro products.

Administration Topics
This section covers the following topics:
Administer the Controller
Administer Agents
Deploy AppDynamics
Automation

Administration Topics for SaaS Controller
While some topics in this section apply to on-premise Controllers exclusively, many topics are
relevant to AppDynamics Pro SaaS users as well. In particular these pages, along with their child
pages, are likely to be of interest to administrators and account owners for AppDynamics Pro
SaaS Controllers:
Agent - Controller Compatibility Matrix
Install Agents
Connect the Controller and Agents
Access the AppDynamics UI
User Authentication and Permissions
Internationalization
Administer Agents
Export and Import Business Application Configurations
Automation
Automation

Administer the Controller
This section describes how to administer the AppDynamics Pro Controller. Administration tasks
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include provisioning users, tuning performance, troubleshooting and maintaining the system, and
more.
This section covers these topics:

Access the AppDynamics UI
Access the Administration Console
Start or Stop the Controller
Setting Up an SSH Key for Controller Access
Controller Version
Modify GlassFish JVM Options
User Authentication and Permissions
Controller Data and Backups
Export and Import Business Application Configurations
Controller Performance
Internationalization
Controller Tenant Mode
Customize System Event Notifications
Controller Logs
Controller Audit Log
For installation information, see Install the Controller. For information about deploying
AppDynamics to its live operating environment, see Deploy AppDynamics.
Access the AppDynamics UI
Once you have installed the Controller and agents, launch your web browser and connect to the
AppDynamics User Interface (UI).
On-Premise Controller UI URL

http://<controller-host>:<controller-port>/controller

Login Credentials

On-premise Controller admin login credentials are configured during installation.
Account Name in the URL

In Multi-Tenant Mode you can have multiple account names. You can pass the account name to
the Controller UI using the URL:

http://<account-name>.saas.appdynamics.com/controller?account=Customer1

When you pass the account name in the URL, the login screen Account field will contain the name.
Learn More

Install and Upgrade
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Use a SaaS Controller
Access the Administration Console
Access the Controller Admin Console
To access the Controller Administration Console
Accessing the Glassfish Admin Console
To access the Glassfish administration console
Learn More
Access the Controller Admin Console

To configure global Controller administration settings, you use the AppDynamics Administration
Console. The AppDynamics Administration Console should not be confused with the
administration console for the underlying GlassFish application server or with the administration
page accessible in the general AppDynamics UI. The AppDynamics Administration Console lets
you configure certain global settings such as metric retention periods, UI notification triggers,
tenancy mode, and accounts in multi-tenancy mode.
In general, AppDynamics recommends that you do not change Controller settings in the console
except under the guidance of AppDynamics Support or as specifically directed by documentation.
To access the Controller Administration Console

1. In a browser enter the URL of the Administration Console:
http://<Controller_Host>:<port>/controller/admin.html

The console is served on the same port as the Controller UI, port 8090 by default.
2. Log in with the root user password. The root user is a built-in global administrator for the
Controller. Use the password you set for this user when installing or upgrading to version
3.8. For more information on root and other types of administrative users, see Administrative
Users.
The Administration Console appears as follows:
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For information on changing the Controller root user password, see Administrative Users.
Accessing the Glassfish Admin Console

In rare cases, you may need to log in to the administration console for the underlying Glassfish
server. For example, you may need to access Glassfish to add an HTTP listener or modify
Glassfish logging settings. The admin console provide a graphical interface for performing many of
the same tasks you can perform using the asadmin command-line utility. You can access the
console using the built-in user account named admin.
To access the Glassfish administration console

1. If you do not know the password for the admin user, you can get it from a file in the
Controller home directory named .passwordfile. The password is the value of
the AS_ADMIN_PASSWORD variable. The Controller installer generates this password
automatically.
2. In a web browser, open the following URL:
http://<Controller_Host>:4848

Note that port 4848 is the default port number for the Glassfish administration console. This
value is determined by the port for the network-listener named admin-listener in the
domain.xml file.
Also note that for security reasons the server does not accept remote connections by
default. If you attempt to access the console remotely, you will see the following error:
"Secure Admin must be enabled to access the DAS remotely."
3. Log in as user admin, with the password you retrieved in step 1.
For information on changing the Glassfish admin user password, see Administrative Users.
Learn More

Administrative Users
Install the Controller on Linux
Install the Controller on Windows
Start or Stop the Controller
About the Controller Start and Stop Scripts
Start and Stop the Controller
To start the Controller
To stop the Controller
Start and Stop the Controller App Server
To start the Controller app server
To stop the Controller app server
Start and Stop the Controller Database
To start the Controller database
To stop the Controller database
Learn More
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About the Controller Start and Stop Scripts

The scripts to start and stop the Controller are located in the
<Controller_Installation_Directory>/bin directory.
The startController script starts up both the database and the underlying Glassfish application
server for the Controller. Alternatively, you can stop and start the database or application server
individually. This makes it possible, for example, to turn off data collection (by shutting down just
the app server, for instance) while performing database operations. For most cases, however, you
can simply use the startController script to start the entire system at once. Similarly, the
stopController scripts turn off both the Glassfish application server and the database.
To avoid the possibility of data corruption errors, be sure to stop the application server and
database gracefully (that is, by using the stop scripts described on this page) before shutting off or
rebooting the machine on which the Controller is running.
On Windows, the commands must be run in an elevated command prompt, which you can open
by right-clicking on the Command Prompt icon in the Windows Start menu and choosing Run as
administrator.
Start and Stop the Controller
To start the Controller

Open a command line console and execute the following command:
For Linux, run:
<Controller_Installation_Directory>/bin/startController.sh

For Windows, run the following command in an elevated command prompt:
<Controller_Installation_Directory>\bin\startController.bat

To stop the Controller

Open a command line console and execute the following command:
For Linux, run:
<Controller_Installation_Directory>/bin/stopController.sh

For Windows, run the following command in an elevated command prompt:
<Controller_Installation_Directory>\bin\stopController.bat

Start and Stop the Controller App Server
To start the Controller app server
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Open a command line console and execute the following command:
For Linux, run:
<Controller_Installation_Directory>/bin/controller.sh start-appserver

For Windows, run the following command in an elevated command prompt:
<Controller_Installation_Directory>\bin\controller.bat start-appserver

To stop the Controller app server

Open a command line console and execute the following command:
For Linux, run:
<Controller_Installation_Directory>/bin/controller.sh stop-appserver

For Windows, run the following command in an elevated command prompt:
<Controller_Installation_Directory>\bin\controller.bat stop-appserver

Start and Stop the Controller Database
To start the Controller database

Open a command line console and execute the following command:
For Linux, run:
<Controller_Installation_Directory>/bin/controller.sh start-db

For Windows, run the following command in an elevated command prompt:
<Controller_Installation_Directory>\bin\controller.bat start-db

To stop the Controller database

Open a command line console and execute the following command:
For Linux, run:
<Controller_Installation_Directory>/bin/controller.sh stop-db
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For Windows, run the following command in an elevated command prompt:
<Controller_Installation_Directory>\bin\controller.bat stop-db

Learn More

Modify GlassFish JVM Options
Setting Up an SSH Key for Controller Access
To set up SSH Key Pairs Using DSA
To set up SSH Key Pairs Using RSA
You can set up SSH (Secure Shell) with public/private key pairs so that you do not have to type
the password each time you access a Controller machine by SSH. Setting up keys allows scripts
and automation processes to access the Controller easily. You can generate DSA or, if you want
stronger encryption, RSA keys.
To set up SSH Key Pairs Using DSA

1. Run the ssh command that sets up the key pair:
% ssh-keygen \-t dsa

2. At the following prompt, press Enter to accept the default key location, or type another:
Generating public/private dsa key pair.
Enter file in which to save the key (~/.ssh/id_dsa):

3. Press return at the password prompt:
Enter passphrase (empty for no passphrase):

4. Press Return again to confirm the password:
Enter same passphrase again:

You should see the following information:
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Your identification has

been saved in \~/.ssh/id_dsa

Your public key has been saved in

\~/.ssh/id_dsa.pub

The key fingerprint is: <Some really long string>

If SSH continues to prompt you for your password, verify your permissions in your remote
.ssh directory. It should have only your own read/write/access permission (octal 700):
% chmod 700 \~/.ssh

5. Open the local ~/.ssh/id_dsa.pub file and paste its contents into the ~/.ssh/authorized_keys
file on the remote host.
6. Update the permissions on the authorized_keys file on the remote host as follows:
% chmod 600 \~/.ssh/authorized_keys

To set up SSH Key Pairs Using RSA

Run the ssh command that sets up the key pair:
% ssh-keygen \-t rsa

The generated files will be named id_rsa and id_rsa.pub, instead of id_dsa and id_dsa.pub.
Otherwise, the remaining steps are identical to those beginning with step 2 in To set up SSH Key
Pairs Using DSA.
Controller Version
Checking the Controller Version
To determine the version of the Controller
Bundled Component Versions
Glassfish Server
MySQL Database
Java Version
Learn More
Checking the Controller Version

In the AppDynamics UI, you can see the version of the Controller from the About AppDynamics
dialog box, as follows.
To determine the version of the Controller

1. Launch the AppDynamics UI in a browser.
2.
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2. Click Help -> About AppDynamics.
From the command line of the Controller machine, you can get the version number from the
README.txt file located in the Controller home directory.
Bundled Component Versions

The Controller relies on bundled infrastructure components for functions such as data storage.
This page lists the version numbers of key components bundled with the current version of the
Controller. This information may be useful when troubleshooting environment issues.
Important: AppDynamics maintains and updates the bundled components as part of the standard
Controller upgrade process. You should not attempt to upgrade a bundled component
independently of the Controller upgrade procedure.
Glassfish Server

The Glassfish server is installed in <Controller_Installation_Directory>/appserver.
The Glassfish server version is Glassfish 3.1.2.2.
MySQL Database

The AppDynamics Controller uses MySQL as its default database. It uses MySQL to store
information about:
Design of your applications (all meta-data about business transactions, tiers, policies etc.)
History of the performance of your applications (metric data)
Transaction Snapshot Data and Events
History of incidents that occurred (both resolved and unresolved incidents are stored)
The MySQL database is installed in <Controller_Installation_Directory>/db.
The MySQL version is MySQL 5.5.37.
Java Version

The Controller bundles and uses Java 1.7.
Learn More

Access the AppDynamics UI
Modify GlassFish JVM Options
Synopsis
Description
Restart
Linux
Windows
Examples
Modify a startup parameter for the Java Application Launcher
Modify Multiple Startup Parameters for the Java Application Launcher
Modify Multiple Java System Properties
Learn More
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AppDynamics provides a utility for modifying JVM options for the Controller. The
modifyJvmOptions utility is used to modify the JVM options in the Controller's domain.xml file.
Changes made with the utility are retained across Controller upgrades.
To run the utility, invoke the modifyJvmOptions from the /bin subdirectory of the Controller home
directory:
On Linux use modifyJvmOptions.sh
On Windows, run modifyJvmOptions.bat in an elevated command prompt
Any change to a Java option requires a Controller application server restart to take effect.

You can edit Controller settings that are not JVM options by manually editing the domain.xml file or
by using the GlassFish asadmin utility.
Synopsis

modifyJvmOptions [add | delete ] (jvm-option-name=jvm-option-value) [@jvm-option-name=jvmoption-value* ]
Separate multiple JVM options using the @ sign.
On Microsoft Windows, you will need to enclose the entire JVM option names and values string in
double quotation marks. The examples illustrate this requirement.
Description

The modifyJvmOptions utility adds or deletes command-line options that are passed to the Java
application launcher when GlassFish Server is started. These are in addition to the options that
are preset in the GlassFish Server.
Use modifyJvmOptions to add or delete the following types of options:
Java system properties: These options are set using the -D option of the Java Application
launcher
Startup parameters for the Java application launcher: These options are set using the
dash (-) character
The utility does not validate your settings, so make sure you use valid values. Invalid options can
cause Controller startup to fail.
To add multiple options, either run the utility once for each option or use an @ character to
separate the options. Use care when attempting to add multiple options at once. If you use a
character separator other than @ character, it will result in a single key with the intended additional
keys as part of the key value.
To update an existing option value, use the modifyJvmOptions utility to delete the existing option
first, then add the same option with the new value.
To delete, supply the full key name and value of the option. You cannot delete an option by key
name only. For example:
modifyJvmOptions.sh delete "-Dunixlocation=\root\example
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To see a list of existing options in the domain configuration, use the list command,
"modifyJvmOptions.sh list" or "modifyJvmOptions.bat list".
Restart

After you have finished adding or deleting options using modifyJvmOptions, stop and restart the
GlassFish app server:
Linux

<controller_installation_directory>\bin\controller.sh stop-appserver
<controller_installation_directory>\bin\controller.sh start-appserver

Windows

The following commands must be run in an elevated command prompt, which you can access by
right-clicking on the Command Prompt icon in the Windows Start menu and choosing Run as
administrator.
<controller_installation_directory>\bin\controller.bat stop-appserver
<controller_installation_directory>\bin\controller.bat
start-appserver

Examples
Modify a startup parameter for the Java Application Launcher

The following command sets the maximum available heap size to 1024MB using
modifyJvmOptions.sh:
modifyJvmOptions.sh add "-Xmx1024m"

The following command deletes the maximum available heap size parameter set in the previous
command:
modifyJvmOptions.sh delete "-Xmx1024m"

Modify Multiple Startup Parameters for the Java Application Launcher

The following command sets the maximum available heap size to 1024 and requests details about
garbage collection using modifyJvmOptions.bat.
To run the command, open an elevated command prompt by right-clicking on the Command
Prompt icon in the Windows Start menu and choosing Run as administrator.
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modifyJvmOptions.bat add "-Xmx1024m@-XX\:+PrintGCDetails"

The following command deletes the startup parameters set in the previous command
modifyJvmOptions.bat delete "-Xmx1024m@-XX\:+PrintGCDetails"

Modify Multiple Java System Properties

The following commands add and delete multiple Java system properties using
modifyJvmOptions.bat. Note that the quotation marks enclosing the argument string are required.
The commands must be run in an elevated command prompt, which you can access by
right-clicking on the Command Prompt icon in the Windows Start menu and choosing Run as
administrator.
modifyJvmOptions.bat add
"-Dunixlocation=/root/example@-Dvariable=\$HOME@-Dwindowslocation=d\
:\\sun\\appserver@-Doption1=value1"
modifyJvmOptions.bat delete
"-Dunixlocation=/root/example@-Dvariable=\$HOME@-Dwindowslocation=d\
:\\sun\\appserver@-Doption1=value1"

The following commands add and delete multiple Java system properties using
modifyJvmOptions.sh. Quotation marks enclosing the argument string are not required.
modifyJvmOptions.sh add
-Dunixlocation=/root/example@-Dvariable=\$HOME@-Dwindowslocation=d\:
\\sun\\appserver@-Doption1=value1
modifyJvmOptions.sh delete
-Dunixlocation=/root/example@-Dvariable=\$HOME@-Dwindowslocation=d\:
\\sun\\appserver@-Doption1=value1

Learn More

Start or Stop the Controller
User Authentication and Permissions
About User Authentication
About User Roles
Related information
About User Authentication

The AppDynamics Controller UI imposes role-based access controls to users.
The Controller can authenticate user credentials against local user accounts or by relying on an
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external LDAP server or SAML-based authentication provider.
Authentication provider settings are located in the Administration tab of the AppDynamics
interface:

To access the Administration settings, click Settings -> Administration. You need to be logged in
as a user with the administrator or account owner role to see the Administration link in the UI.
In the Authentication Provider tab, you can choose one of three authentication options: local
authentication (labelled AppDynamics), LDAP, or SAML. LDAP and SAML require additional
configuration. See Related Information for additional information on completing the configuration
for these authentication providers.
The other configuration option in the Administration tab, Integrations, enables you add and
configure extension modules for the AppDynamics Controller. See Extensions and
Integrations for more information.
Authentication settings in the Controller are specific to an account within the Controller. If you have
a multi-tenant on-premise Controller, you need to configure authentication settings in each account
individually.
About User Roles

Each user in the AppDynamics UI must have at least one role. The role determines the user's
permissions in the UI, including what the user see in the UI or change in the configuration.
AppDynamics comes with a set of predefined roles, including, for example, administrator, account
owner, and dashboard viewer role.
You cannot modify the built-in roles, but you can create your own. Custom roles are typically
created to allocate permissions based on application, since not all users need or should have
access to monitoring information for all applications.
To make it easier to assign to a large number of users, you can use groups. You can create local
groups in the Controller or map existing groups from an LDAP server.
The following section provides links to additional information on these topics.
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Related information

Configure Authentication Using SAML describes how to set up SAML user authentication.
Configure Authentication Using LDAP describes how to set up LDAP user authentication.
Configure Users describes local user accounts.
Configure Groups describes how to create groups to assign roles to multiple users at a time.
Configure Roles describes how to set up user permissions.
Administrative Users

About the root User and Account Owners
Change the Controller root User Password
To change the root user password
Change the Glassfish admin User Password
To change the Glassfish admin user password
Learn More
This topic describes the root user and other types of administrative users in AppDynamics.
About the root User and Account Owners

The root user is a built-in Controller user with global administrator privileges in the Controller
environment. Only the root user can access the System Administration Console, the web page
where you can create and manage accounts in multi-tenant Controllers and configure global
Controller settings in both single- or multi-tenant Controllers.
The root user can be thought of as a superuser for the Controller. Unlike other types of users, you
cannot remove the root user account or create other superuser accounts in the Controller. The
password for the root user is first set at installation time, but you can change it after installation by
following the steps below.
While the root user has global administrative privileges, account administrators act as
administrators only within individual accounts in a multi-tenant Controller. It's typically the role of
the root user to create accounts and an initial administrator for the account, and the role of each
account administrator to create additional users within the account.
For information, see Configure Roles and Configure Users.
Change the Controller root User Password

You can change the root user password from the AppDynamics administration console page.
To change the root user password

1. In a browser, log in to the administration console as described in Access the Administration
Console.
2. Click the Settings icon from the right side of the menu bar and then Administration.
3. In the Users tab, select the root user and click the Change Password link.
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4. Enter the new password for the root user in the New Password and Repeat New
Password fields.
5. Click Save.
If you do not have the root user password for your installation and need to reset it, contact
AppDynamics Support.
Change the Glassfish admin User Password

The Controller uses the built-in administrator account in the underlying Glassfish application
server. To change the password for this user, you need to change it in two places, in Glassfish and
in the password file used by the Controller, as follows.
To change the Glassfish admin user password

1. In a browser, log into the Glassfish admin console as the administrator as described in Acce
ss the Administration Console.
2. Click Domain from the navigation tree on the left.
3. Open the Administrator Password tab.
4. Type and retype the new password in the password fields, and click Save.
5. Change the AS_ADMIN_PASSWORD value in the .passwordfile file located in the Controller
home directory to match the new password.
The password change takes immediate effect.
Learn More

Create New Accounts
Install the Controller on Linux
Install the Controller on Windows
Configure Users

Create and Administer Local Users
To Create an AppDynamics User
To Assign a User to a Group
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To Assign a Role to a User
To Modify a User's Settings
To Delete a User
To Duplicate a User
Learn More
Create and Administer Local Users

This section describes how to create a local user in the AppDynamics Controller UI. You use this
procedure to create users if you are not using an external provider, such as LDAP or SAML.
To Create an AppDynamics User

1.
2.
3.
4.

As an administrator in the Controller UI, click Settings -> Administration.
Click the Users tab.
Click the Create New User button.
Enter the information for the following fields:
Username
Name
Email
New Password
Repeat New Password
The username and password fields do not accept the "@" symbol. Also, while the UI does not
prevent you from using them, do not use spaces, tabs or these special characters in usernames
of accounts that will be used to access the REST API:
&

@ : \ / " [ ] | < > + = ; , ? * '

The REST API cannot authenticate user credentials that include these characters.
5. Choose at least one role for the new user.
If you do not choose a role before saving, a warning message appears in the UI. You can
assign the user to a role later, but the user will not be able to use any features in the UI until
assigned a role.
6. Optionally, choose a group for the user.
7. Click Save.
To Assign a User to a Group

After creating a user, you can assign the user to a group.
1. From the user list in the Users tab of the Administration page, select the user whom you
want to assign to one or more groups. You can enter a string in the filter field to locate a
specific user.
2. From the Groups list, check the Member check boxes of the groups to which you want to assign
the selected user. Note that:
You can enter a string in the filter field to locate a specific group.
Click Select All to check all the groups and Unselect All to uncheck all the groups.
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2.

A single user can be assigned to multiple groups.

3. Click Save.
You can also assign users to a group from the Groups tab. See Configure Groups.
To Assign a Role to a User

1. In the left panel, select the user to which you want to assign one or more roles. You can
enter a string in the filter field to locate a specific user.
2. In the Roles list in the right panel, check the Member checkboxes of the roles that you want to
assign to the selected user. Note that:
You can enter a string in the filter field to locate a specific role.
Click Select All to check all the roles and Unselect All to uncheck all the roles.
A single user can be assigned multiple roles.
3. Click Save.
You can also assign roles to a user from the Roles tab.
Warning: Do not remove yourself from all groups or from all roles. Also, if the only roles of which
you are a member are custom roles, do not delete those custom roles or remove permissions from
them. Doing these things can result in your being locked out of AppDynamics with no permissions
at all. If this happens, contact AppDynamics Support.
To Modify a User's Settings

1.
2.
3.
4.

In the User list in the left panel, select the user to modify.
Click the Edit icon.
Enter the new username or name in the fields in the right panel.
To change the password, click Change Password and then enter the new password values in
the Password and Repeat Password fields in the right panel.
5. Click Save.
To Delete a User

1. In the User list in the left panel, select the user to delete.
2. Click Delete.
To Duplicate a User

1. In the User list in the left panel, select the user to duplicate.
2. Click the Duplicate User icon.
3. Enter a new name and password for the duplicated user.
The new user gets the groups and roles of the user from which the user was copied.
Learn More

Configure Groups
Configure Roles
Configure Groups
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Create and Manage Groups
To Create an AppDynamics Group
To Assign a User to a Group
To Assign A Role to a Group
To Modify A Group's Settings
To Delete a Group
Learn More
Create and Manage Groups

A group is a set of users that can be granted sets of permissions through assignment of roles. It is
more efficient to assign roles to a group than to assign the same roles to each user individually.
If you are are using LDAP to authenticate all AppDynamics Controller users you do not need to
create AppDynamics groups.
To Create an AppDynamics Group

1.
2.
3.
4.

As an administrator in the Controller UI, click Settings -> Administration.
Click the Groups tab.
Click the Create New Group button.
Enter the information for the following fields:
a. Name
b. Description
5. Click Save.
To Assign a User to a Group

1. From the left panel in the Groups window, select the group.
You can enter a string in the filter field to locate a specific group.
2. In the Users list in the right panel, check the Member check boxes for the users to add to the
selected group or groups.
You can enter a string in the filter field to locate a specific user.
You can click Select All to check all the users and Unselect All to uncheck all the
users.
A single user can belong to multiple groups.
3. Click Save.
To Assign A Role to a Group

1. From the left panel in the Groups window, select the group or groups to which you want to
assign roles. You can enter a string in the filter field to locate a specific group.
2. In the Roles list in the right panel, check the Member check boxes of the roles that you want
to assign to the selected group or groups.
You can click Select All to check all the roles and Unselect All to uncheck all the
roles.
You can enter a string in the filter field to locate a specific role.
A single group can be assigned multiple roles.
3. Click Save.
To Modify A Group's Settings
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1. From the left panel in the Groups window, select the group to modify.
2. Enter the new values in the fields in the right panel.
3. Click Save.
To Delete a Group

1. In the group list in the left panel, select group to delete.
2. Click Delete.
Learn More

Configure Roles
Configure Users
Configure Authentication Using LDAP
Configure Authentication Using SAML
Configure Roles

Predefined Roles
Custom Roles
Permission Inheritance for Default Permissions
Account-Level Permissions
Application- and Tier-Level Permissions
Custom Dashboard Permissions
Learn More
Roles define a set of privileges that AppDynamics Controller users have within the AppDynamics
managed environment. This is also called "role-based access control", or "RBAC".
Roles provide an easy way to define and clone a set of permissions for a user or a group without
having to configure every user's or every group's permissions individually.
A user or group can have multiple roles.
Predefined Roles

AppDynamics provides the following predefined roles:
Account Owner: Can manage security settings (users, groups, roles) as well as view and
modify applications and dashboards. This role is also known as the account administrator.
Administrator: Can view and modify components that change state: applications, business
transactions, dashboards, etc. Can view and edit all applications and all custom dashboards.
Custom Dashboard Viewer: Can only view custom dashboards. Cannot do anything else.
Read Only User: Can view but not edit all applications.
Workflow Executor: Can execute workflows.
You can view the configurations for predefined roles but you cannot change them. See View
Predefined Roles.
Although you cannot modify the predefined roles, you can add or remove users and groups from
the predefined roles by checking or clearing the Member check box in the Roles panel. See Config
ure Users and Configure Groups.
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Custom Roles

You can create custom roles to manage user access by the application/tier level, the custom
dashboard level, and the account level. When creating a role, you can create the role from scratch
or duplicate an existing role, save it under another name, and then modify it as a custom role.
See Configure Custom Roles.
Permission Inheritance for Default Permissions

For application-level and custom dashboard permissions, AppDynamics provides a default set of
permissions, named Default. The default permissions are inherited by new applications and new
custom dashboards. The Default permissions are listed first in the Application Permissions subt
ab of the Roles tab.
Tier-level permissions are inherited from the containing application.
Account-Level Permissions

Permissions that can be granted at the account level include:
Administer: Users with this permission can edit users, groups, roles, and the authentication
provider.
Configure Email/SMS: Users with this permission can edit email and SMS settings used by
AppDynamics to send alerts. See Configure the SMTP Server and Notification Actions.
Execute Workflows: Users with this permission can execute workflows. See Workflow
Overview.
Application- and Tier-Level Permissions

The following table lists the permissions that you can grant at the application level and tier
levels. To enable or disable the application-level permissions for a role, see Configuring
Application Level Permissions on Configure Custom Roles.
Permission name

Activities enabled in the UI

Learn more

Configure Transaction
Detection

Create, edit, or delete
transaction detection (can
be at the tier level)*

Configure Business
Transaction Detection

Configure Backend Detection

Create, edit, or delete
backends (can be done at
tier level)

Backend Monitoring
Configure Backend Detection
(Java)
Configure Backend Detection
for .NET

Configure Error Detection

Create, edit, or delete error
detection

Configure Error Detection

Configure Diagnostic Data
Collectors

Create, edit, or delete
diagnostic data collector*

Configure Data Collectors
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Configure Call Graph Settings

Edit call graph settings (no
SQL)
Turn on or off capture raw
SQL (call graph and SQL
bind must both be on)

Configure Call Graphs

Configure JMX

Create, edit, or delete JMX
Metric

Configure JMX Metrics from
MBeans
Create, Import or Export JMX
Metric Configurations

Configure Memory Monitoring

Configure object instance
tracking (can be done at
tier level)
Configure custom memory
structure (can be done at
tier level)

Configure Memory Monitoring
for Java

Configure EUM

Configure EUM

Set Up and Configure Web
EUEM

Configure Information Points

Create, edit, or delete
information points*

Configure Code Metric
Information Points

Configure Health Rules

Create, edit, or delete
Health Rules

Configure Health Rules

Configure Actions

Create, edit, or delete
Actions on Agent
Properties UI
Create, edit, or delete
Policy
Create, edit, or delete
Email Digests

Notification Actions

Configure Business
Transactions

Modify default slow
thresholds
Start diagnostic session

Configure Thresholds

Configure Baselines

Create, edit, or delete
baselines

Configure Baselines

Configure SQL Bind Variables

Turn on or off capture raw
SQL (must have both Call
Graph and SQL Bind on)*

Configure Call Graphs

Copyright © AppDynamics 2012-2014

Policies
Email Digests

Page 204

Configure Agent Properties

Create, edit, or delete
agent configuration (can
be done at tier level)
Enable or disable
automatic leak detection
(can be done at tier level)
Enable or disable object
instance tracking (can be
done at tier level)
Enable or disable custom
memory structure (can be
done at tier level)

App Agent Node Properties

Set JMX MBean Attributes
and Invoke Operations

Edit MBean attributes or
invoke actions on
operations

Monitor JMX MBeans

Configure Service Endpoints

Create, edit, or delete
service end points

Monitor Service Endpoints

Configure Monitoring Level
(Production/Deployment)

Switch between production
and development mode

Monitoring in a Development
Environment

* Asterisks indicate activities that may be considered sensitive for purposes of security and data
privacy. Carefully consider the security and data privacy policies of your organization before
granting these permissions.
Custom Dashboard Permissions

Permissions that can be granted at the custom dashboard level include:
View
Edit
Delete
Custom dashboards are a good way to present selected metrics for a user who only needs a
relatively narrow or focussed view of the data. For example, such as user could be an executive
who only needs a high-level view of system performance and activity. You can grant such users
permission to view custom dashboards created especially for them.
Learn More

Configure Custom Roles
View Predefined Roles
View Predefined Roles

About Predefined Roles
To View a Predefined Role
Learn More
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About Predefined Roles

You can view the predefined roles and assign them to users and groups if you have the required
permissions.
If the checkbox for a permission in a role configuration is checked, the permission is granted to
users with that role. If the checkbox is clear, the permission is denied.
See Configure Roles for general information about roles.
To View a Predefined Role
1.
2.
3.
4.

As an administrator or account owner in the Controller UI, click Settings -> Administration.
Click the Roles tab.
In the left panel select the role that you want to view.
In the right panel, click the Account Level Permissions tab to see the role's permission at
the account level.
5. Click the Custom Dashboards tab to view the role's permissions for viewing, editing, and
deleting custom dashboards.
6. Click the Application Permissions tab to see the role's permissions at application and tier
levels. You need to expand the applications to see the tier-level permissions.
a. Select the application or tier for which you want to view the configuration. You need to
expand the applications tabs to view the tiers.
b. Click the Edit icon.
The Edit Permissions window opens showing the edit permissions for the selected
predefined role for the selected application or tier. Although you cannot edit these
permissions, you can view which permissions have been granted and then determine
whether the default role meets your needs for the selected application or tier or
whether you need to configure a custom role. See Configure Custom Roles.
c. Click Close to close the Edit Permissions window.
Learn More

Configure Roles
Access Role Configuration
Configure Custom Roles

Configuring Custom Roles
To Create a Custom Role
Configuring Application Level Permissions
To Configure the Default Application Permissions
To Configure Application Permissions
To Configure Tier-Level Permissions
Configuring Custom Dashboard Permissions
To Configure the Default Custom Dashboard Permissions
To Configure Permissions for Individual Dashboards
Configuring Account Level Permissions
To Configure Account Level Permissions
Modifying a Custom Role
To Modify a Custom Role
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Learn More
Create custom roles if you want to grant permissions to users and groups using roles that are
configured differently from the predefined roles. See View Predefined Roles to see exactly which
permissions are granted and denied by the predefined roles.
You can configure custom roles very finely to grant users certain permissions in a single
application or even a single tier or set of tiers or custom dashboard.
See Configure Roles for information about the types of permissions that roles grant.
Configuring Custom Roles

After you have created a custom role, select it and configure the three categories of permissions
by clicking the tabs:
Application Level Permissions
Custom Dashboard Permissions
Account Level Permissions
To Create a Custom Role
1. As an administrator or account owner in the Controller UI, click Settings -> Administration.
2. Click the Roles tab.
3. Either:
a. In the left panel, click the Add icon to create a new role.
b. In the right panel, enter the name of the role and an optional description.
c. Click Save.
Or:
a. Select an existing role in the left panel.
b. Click the Duplicate icon.
c. In the Duplicate Role window, overwrite the default name with your name for the new role.
d. Click Duplicate.
e. In the left panel, select the newly created role.
f. In the right panel, edit the name and description for the new role.
g. Click Save.
Configuring Application Level Permissions

In this tab you can configure:
the role's default application-level permissions
the role's custom permissions for specific applications and tiers
Custom roles can be very fine-tuned at the application level and tier levels. For example, you
could create an AcmeManager role with certain delete and edit permissions that apply only to the
Acme bookstore application and another AcmeUser role with only view permissions or possibly
also with a more limited set of edit permissions for the Acme bookstore application. You can also
create roles at the tier level; for example, an InventoryManager role or an InventoryUser role with
certain permissions only the Inventory tier and not for any of the other tiers in the application.
Every role has a set of default application-level permissions that are inherited by all new
applications in the account. For a custom role you can reconfigure these default permissions. You
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can also override the inherited permissions for custom roles by reconfiguring application-level and
tier-level permissions.
To Configure the Default Application Permissions
1. With the custom role that you are configuring selected in the left panel, in the right panel
click the Application Permissions tab.
2. To grant the role permission to create new applications, check the Can Create Applications
check box. Otherwise leave it clear.
3. In the Default row do the following:
To permit users with this role to view applications check the View check box. To deny
them view permission, clear the View check box.
To
permit
users
with this
role to
delete
the
applicati
on
check
the
Delete
check
box. To
deny
them
delete
permission, clear the Delete check box.
To permit users to edit AppDynamics configurations:
i. Click the Edit icon.
ii. In the Edit Permissions window check the check boxes for the configurations that
the role can perform and clear them for the configurations that it cannot perform.
For information about the permissions that can be granted at the application level and tier
levels, see Application Level Permissions
4. Click OK in the Edit Permissions window.
5. Click Save at the top of the pane to save the default configuration.
To Configure Application Permissions
You can configure a custom role to have different permissions in different applications.
1. With the custom role that you are configuring selected in the left panel, in the right panel
click the Application Permissions tab.
2. In the row for the application for which you want to configure the role's permissions, do one of
the following:
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2.

If you want the role to inherit the default application-level permissions, select Inherit from
Default from the dropdown menu if it is not already selected.

Or:
If you do not want the role to inherit the default application-level permissions, select Custo
mized from the dropdown menu and then follow steps 3 and 4 as described above in To
Configure the Default Permissions for the application's row instead of for the Default row.

3. Repeat the previous step for every application that you want to configure.
4. Click Save at the top of the pane to save the configuration.
To Configure Tier-Level Permissions
By default, a role's permissions in a tier are inherited from the role's permissions in the tier's
containing application. You can override this behavior to configure a custom role to have specific
permissions in different tiers.
1. In the Application Permissions tab, expand the application in which you want to configure
the role's tier-level permissions.
2. In the row for the tier for which you want to configure the role's permissions, do one of the
following:
If you want the role to inherit the application permissions for the tier, select Inherit from
Application from the dropdown menu if it is not already selected.
Or:
If you do not want the role to inherit the application permissions for the tier, select Custom
ized from the dropdown menu and then follow steps 3 and 4 as described above in To
Configure the Default Permissions for tier's row instead of for the Default row.
3. Repeat the previous step for every tier that you want to configure.
4. Click Save at the top of the pane to save the configuration.
Configuring Custom Dashboard Permissions

In this tab you can configure:
the role's default custom dashboard permissions
the role's permissions for specific custom dashboards
Every dashboard inherits the default custom dashboard permissions unless you override them by
configuring separate permissions for individual dashboards. For example, you could have a
custom dashboard called SalesDashboard and a custom role SalesRole, and another custom
dashboard called FinanceDashboard and a custom role FinanceRole. The SalesRole could be
configured to have permissions in the SalesSdashboard but no permissions in the
FinanceDashboard and vice-versa.
To Configure the Default Custom Dashboard Permissions
1. With the custom role that you are configuring selected in the left panel, in the right panel
click the Custom Dashboard Permissions tab.
2. To grant the role permission to create new custom dashboards, check the Can Create
Custom Dashboards check box. Otherwise leave it clear.
3. In the default row do the following:
To permit users with this role to view custom dashboards, check the View check box. To
deny them view permission, clear the View check box.
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3.

To permit users with this role to edit custom dashboards, check the Edit check box. To
deny them edit permission, clear the Edit check box.
To permit users with this role to delete custom dashboards, check the Delete check box.
To deny them delete permission, clear the Delete check box.

4. Click Save at the top of the pane to save the default configuration.
To Configure Permissions for Individual Dashboards
You can configure a custom role to have different permissions in different custom dashboards.
1. With the custom role that you are configuring selected in the left panel, in the right panel
click the Custom Dashboard Permissions tab.
2. In the row for the custom dashboard for which you want to configure the role's permissions:
To permit users with this role to view the custom dashboard, check the View check box.
To deny them view permission, clear the View check box.
To permit users with this role to edit the custom dashboard, check the Edit check box.To
deny them edit permission, clear the Edit check box.
To permit users with this role to delete the custom dashboard, check the Delete check
box. To deny them delete permission, clear the Delete check box.
3. Repeat the previous step for every custom dashboard that you want to configure.
4. Click Save at the top of the pane to save the configuration.
Configuring Account Level Permissions

To Configure Account Level Permissions
1. With the role selected in the left panel, in the right panel click the Account Level
Permissions tab.
2. Check the check boxes for the tasks that can be performed by the selected custom role. see Acc
ount Level Permissions for descriptions of these permissions.
3. Clear the check boxes for the tasks that cannot be performed by this role if they are not already
clear.
4. Click Save.
Modifying a Custom Role

Modifying a custom role is similar to creating a new role.
To Modify a Custom Role
1. Select the role to modify in the left panel of the role configuration screen.
The role configuration is visible in the right panel.
2. Edit the role as you would for a creating a new custom role, as described in the preceding
sections.
Learn More

Configure Roles
Assign Roles to Users and Groups

To Assign a Role from the Role Configuration Screen
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Learn More
This topic describes how to assign roles to existing users and groups. You can also assign existing
roles when you create users and groups from the user and group configuration screens. See To
Assign A Role to a User and To Assign A Role to a Group.
See Configure Roles for general information about configuring roles.
To Assign a Role from the Role Configuration Screen
1.
2.
3.
4.
5.

As an administrator or account owner in the Controller UI, click Settings -> Administration.
Click the Roles tab.
In the left Role Name panel select the Role that you want to assign.
In the right panel, click the Users and Groups with this Role tab.
To assign a role to a user or withhold a role from a user:
a. Locate the user or users to whom you want to assign the selected role from the Users list.
You can enter a string in the filter field to locate a specific user.
b. Check the Member checkboxes of the users to whom you want to assign the role. A single
user can be assigned multiple roles. You can click Select All to check all the users.
c. Clear the Member check boxes of the users from whom you want to withhold the role. You
can click Unselect All to clear all the users.
6. To assign a role to a group or withhold a role from a group:
a. Locate the group or groups in the Groups list. You can enter a string in the filter field to
locate a specific group.
b. Check the Member check boxes of the groups to which you want to assign the role. A
single group can be assigned multiple roles. You can click Select All to check all the
groups.
c. Clear the Member check boxes of the groups from whom you want to withhold the role.
You can click Unselect All to clear all the groups.
Learn More

Access Role Configuration
Configure Groups
Configure Users
Configure Authentication Using LDAP

Introduction
Preparing the LDAP directory for AppDynamics integration
Using paged results for large result sets
LDAP Authentication with a SaaS AppDynamics Controller
What Happens if the LDAP Server Becomes Unavailable
Before Starting
Configuring LDAP Authentication
To Configure the Connection to the LDAP Server
To Configure the Query to Find Users
To Configure the Query to Find Groups
To Assign AppDynamics Permissions to an LDAP User
To Assign AppDynamics Permissions to an LDAP Group
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Configuring the LDAP Cache Synchronization Frequency
To Configure the LDAP Synchronization Frequency
Learn More
Introduction

The AppDynamics Controller can authenticate users against external Lightweight Directory Access
Protocol (LDAP) servers. The Controller integrates with servers that use LDAP version 3 protocol.
To configure LDAP authentication in the Controller, you need to configure connection settings to
the LDAP server and the queries that return user or group data. By mapping LDAP groups to
roles, you can provision permissions in the AppDynamics Controller based on LDAP groups.
Preparing the LDAP directory for AppDynamics integration

To use an LDAP authentication provider, your AppDynamics Controller needs to be able to
connect to the external LDAP server. A good practice is to create a user account in LDAP
specifically for the Controller to use to authenticate itself to the server and run the queries. The
Controller user only needs to have search privileges in LDAP.
While you can map existing LDAP group definitions to roles in AppDynamics, your existing groups
may not correspond directly to roles in AppDynamics. The easiest way to map LDAP groups to
Controller roles is to create a group in LDAP for each role you want mapped in AppDynamics. This
gives you a manageable, 1-to-1 correspondence between your LDAP groups and AppDynamics
roles.
For example, a possible LDAP group scheme for mapping in AppDynamics would be:
AppDynamics-AppA-ReadOnly
AppDynamics-AppA-Admins
AppDynamics-AppA-DashboardViewers
AppDynamics-AppB-ReadOnly
AppDynamics-AppB-Admins
AppDynamics-AppB-DashboardViewers
The sample group names imply having custom roles in AppDynamics targeted to specific
applications, AppA and AppB.
Naming the groups with a common prefix, as the "AppDynamics-" prefix in our sample, allows you
to use a relatively simple LDAP group filter. A group filter for the sample groups could be:
(&(objectClass=group)(cn=AppDynamics-*))

Using paged results for large result sets

LDAP servers are sometimes configured to limit the number of entries it can return in a query
response. If the results of your user or group query exceed that limit, AppDynamics reports a
max_results_exceeded error.
To avoid this error, first try to refine your query filter to produce a smaller result set. Of course, the
results still need to include the users who will need to access the AppDynamics UI. See To
Configure the Query to Find Users and To Configure the Query to Find Groups.
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If your LDAP server supports it, you can also enable paged results in the Controller LDAP
configuration. With paged results, the LDAP server divides the result set into separately
transmitted blocks.
The paged results feature applies to the behind-the-scenes interaction between the AppDynamics
Controller and the backend LDAP server. It does not affect the UI view of the data.
LDAP Authentication with a SaaS AppDynamics Controller

Depending on your organization's security policies, it may not be possible to use LDAP
authentication with the SaaS AppDynamics Controller, since doing so requires opening your
firewall to permit Controller access to your corporate LDAP server.
However, if you do want to enable LDAP authentication with SaaS AppDynamics Controller, you
will need to permit access through the firewall for the IP range of 69.27.44.0/24, the IP address
range assigned to AppDynamics SaaS Controllers. The firewall rule should permit incoming LDAP
requests from the Controller at the LDAP port you configure.
What Happens if the LDAP Server Becomes Unavailable

If you have configured the controller to use LDAP for authentication and the LDAP server becomes
unavailable for any reason, AppDynamics falls back to local user authentication. Given this
possibility, you should provision local user accounts in AppDynamics for users who need to access
AppDynamics in the event that the LDAP server becomes unavailable.
Before Starting

To perform LDAP configuration you must have:
An LDAP server. There is a one-to-one correspondence between an AppDynamics account
and an LDAP server.
An account on an AppDynamics SaaS or on-premise Controller
Account administrator privileges on the AppDynamics Controller, as described in Administrative
Users.
Network connectivity between your LDAP server and the Controller. If using a SaaS Controller,
the LDAP server may not be accessible to the Controller without enabling access through your
network firewall. See LDAP Authentication with a SaaS AppDynamics Controller.
Configuring LDAP Authentication

At a high level, the steps for setting up LDAP authentication include:
Configure the connection to the LDAP server.
Configure and test the LDAP query that returns users to be provisioned in the AppDynamics
Controller.
Configure the LDAP query that returns the LDAP groups to be mapped to AppDynamics roles.
Map the users or groups to roles in AppDynamics.
To Configure the Connection to the LDAP Server

1. As an administrator or account owner in the Controller UI, click Settings -> Administration.
2. Click the Authentication Provider tab.
3.
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3. Select LDAP. The LDAP configuration settings appear.
4. If your user or group query will return more entries than permitted by the LDAP server and the
server support paged results, configure paged results as follows:
Enable Paging: Check this option to have the Controller request paged results from the
server when submitting user or group queries.
Page Size: Enter the number of entries per round-trip from the AppDynamics Controller to
the LDAP server. The default is 500.
The page size should be the total number of entries to be returned divided by the number of
round trips between the LDAP server and the Controller that are tolerable. For example, if you
expect to receive 1200 results in a query and you can tolerate a maximum of two round trips, set
the page size to 600 (1200 /2).
See Using paged results for large result sets for more information.
5. In the Connection String section of the LDAP configuration screen, enter the information
AppDynamics uses to connect to the LDAP server:
Host: Address of the LDAP server. Required.
Port: Port that the LDAP server listens on. Default is 636 for an SSL connection and 389 if
not using SSL. Required.
Use SSL: Enabled by default to use a secure connection to the LDAP server. Clear if not
using SSL.
Enable Referrals: Enabled by default to support LDAP referrals. A referral is when an
LDAP server forwards an LDAP client request to another LDAP server. Each referral
event is referred to as a hop.
Maximum Referral Hops: The maximum number of referrals that AppDynamics will follow
in a sequence of referrals. Default is 5.
Bind DN: Distinguished Name of the user on the LDAP Server on whose behalf the
AppDynamics application searches. Required.
Password: Password of the user on the LDAP server. Required. Your settings should look
something like this:
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6. Click Test Connection to ensure that the connection string works properly.
7. When the connection test is successful, click Save.
To Configure the Query to Find Users

1. Navigate to the LDAP configuration page if it is not already open. See To Configure the
Connection to the LDAP Server.
2. In the Users Query section of the LDAP configuration screen, enter the information to use to find
LDAP users:
3. Base DN: Location in the LDAP tree to begin recursively searching for users. Required.
4. Filter: Optional LDAP search string that filters the items matched from the base DN. See RFC22
54 for information about LDAP search filters.
5. Login Attribute: The LDAP field that corresponds to the username users will enter when logging
in to the AppDynamics UI. The default is "uid". For Active Directory, this would typically be
“sAMAccountName".
6. Display Name Attribute: The LDAP field to be used as the user's display name.
7. Group Membership Attribute: Optional user group membership field. Recommended for faster
retrieval.
8. Email Attribute: Optional user email address.
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9. To test the configuration, click Test Query.
This launches a screen displaying the first few users returned by the query.
10. Click Save.
To Configure the Query to Find Groups

Optionally, you can map LDAP groups to user roles in the AppDynamics Controller. To do this, you
need to set up the LDAP query that returns the LDAP groups to map, as follows.
1. Navigate to the LDAP configuration page if it is not already open. See To Configure the
Connection to the LDAP Server.
2. In the Groups Query section of the LDAP configuration screen, enter the information to use
to find LDAP groups:
Base DN: Location in the LDAP tree to begin recursively searching for groups. Required.
Enable Nested Groups: Option to include nested LDAP groups to a depth of 10.
Filter: Optional LDAP search string that filters the items matched from the base DN. See R
FC2254 for information about LDAP search filters.
Name Attribute: The LDAP field that contains the name of the group. Default is "cn".
Required.
Description Attribute: The LDAP field that contains a description of the group. Optional.
User Membership Attribute: Identifies members of the groups. Optional.
Referenced User Attribute: Optional child attribute of the User Membership Attribute.
Disabled if the parent is empty. Identifies property of the user that the user membership
attribute contains.

3. To test the configuration, click Test Query.
A screen appears that displays the first few groups returned by the query.
4. When the query test is successful, click Save.
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You can now assign permissions in the AppDynamics Controller to users or groups.
To Assign AppDynamics Permissions to an LDAP User

1. In the Security Configuration window, click the Users tab.
If LDAP is enabled and correctly configured, the AppDynamics Controller fetches the user
names from the LDAP server.
2. Select the name of the user to whom you want to assign permissions.
3. In the Roles panel, check the roles that you want to assign to this user. You can assign multiple
roles to a user.

4. Click Save.
To Assign AppDynamics Permissions to an LDAP Group

LDAP Group configuration is optional.
1. In the Security Configuration window, click the Groups tab.
If LDAP is enabled and correctly configured, AppDynamics fetches the group names of
users in LDAP.
2. Select the name of the group to which you want to assign permissions.
3. In the Roles panel, check the roles that you want to assign to this group. You can assign multiple
roles to a group.
4. Click Save.
Configuring the LDAP Cache Synchronization Frequency

The Controller keeps information about LDAP users and groups in a local cache. It regularly
connects to the LDAP server to synchronize its cache with the LDAP server.
The Controller caches information about users and group membership. It does not cache user
passwords. Accordingly, the Controller authenticates the user credentials against the LDAP server
at the start of every user session.
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If a user account is removed from LDAP, the change is reflected immediately; that is, the user will
not be able to log in to the Controller UI from that point. However, if the user has an existing
session in the Controller UI, that session continues until the user logs out or the session expires.
If the user's access to the Controller is based on group membership and the user is removed from
the group but maintains an account in the LDAP server, the user will be able to log in to the
Controller until the next time synchronization with the LDAP server occurs. By the default
synchronization frequency setting, this ability to access the Controller UI could continue for up to
an hour.
You can modify the default synchronization frequency of one hour as described in the following
procedures.
To Configure the LDAP Synchronization Frequency

1. Stop the Controller application server:
On Linux, run:
./controller.sh stop-appserver

On Windows, run this command from an elevated command prompt (which you can
open by right-clicking on the Command Prompt icon in the Windows Start menu and
choosing Run as administrator):
controller.bat stop-appserver

2. Open the
<Controller-Installation-Directory>/appserver/glassfish/domains/domain1/config/domain.xml
file for editing.
3. In the <jvm-options> element, add a system property named
appdynamics.ldap.sync.frequency with the desired synchronization frequency in
milliseconds.
For example, to have the Controller synchronize to the LDAP server every 15 minutes
(900000 milliseconds), add:
<jvm-options>-Dappdynamics.ldap.sync.frequency=900000</jvm-opti
ons>

The default is 3600000 milliseconds (1 hour).
4. Save the file.
5. Restart the Controller app server:
On Linux, run:
./controller.sh start-appserver

On Windows, run the following in an elevated command prompt:
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controller.bat start-appserver

Learn More

Configure Roles
Configure Groups
Configure Users
Configure Authentication Using SAML

About SAML Authentication
SAML Response Requirements
Sample Request and Response
Configure SAML Settings
To Configure a SAML Identity Provider
Use Automated SAML Groups and Controller User Role Associations
Learn More
About SAML Authentication

You can configure the Controller to use SAML as an external authentication provider for the
Controller UI. The Controller's SAML support allows you to include Controller UI access control
into your organization's existing single sign-on systems.
The AppDynamics SAML integration conforms to the Security Assertion Markup Language 2.0
(SAML 2.0) specification, so any SAML 2.0-compliant identity provider can be used with
AppDynamics.
To configure SAML-based single sign-on for the Controller, you must have:
An account with a supported identity provider. You need your SAML Login URL and the
x.509 certificate supplied by your identity provider. The Controller performs Service Provider
(SP)-initiated logins using the SAML identity provider login URL you specify.
An account and access to an AppDynamics SaaS or on-premise Controller. The client
browser must have access to both the Controller and the identity provider service.
Account Administrator privileges on the AppDynamics Controller, as described in Adminis
trative Users.
Before configuring the SAML settings in the AppDynamics Controller, verify that the Account
Administrator user who will log into the Controller and set up the SAML authentication also
exists as a user in the identity provider. After configuring the SAML settings in AppDynamics
and logging out, this user will be forced to log in again as that Account Administrator this
time using the identity provider for authentication.
SAML Response Requirements

The Controller expects the following custom attributes in the SAML assertion sent by the identity
provider:
NameID – SAML Response should identify the user who is logging in. This value must be
unique among all users in the Controller account, so typically this value will be the unique
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username for the user. The Controller uses the SAML authentication assertion NameID
value as the user name for the user account in the Controller UI.
If this field is not specified in the response or for any reason you do not want to map this
field to the username in the Controller user account, you can use the custom userName SA
ML attribute to specify the value to use for the username for the Controller user.
emailAddress – The user's email address.
Groups – This is required if you want to map SAML groups to Controller roles.
Assertion Consumer (ACS) URL – The assertion consumer value should be http[s]://{appdyn
amics_controller_url}/controller/saml-auth
Relay State – For the relay state parameter, the provider should use http[s]://{appdynamics_
controller_url}/controller
entityid (PingIdentity) – For the entity ID parameter, the provider should use http[s]://{appdy
namics_controller_url}/controller
accountName – If the Controller is multi-tenant mode, the SAML response must contain a
custom SAML attribute named accountName that indicates the account to which the user is
attempting to authenticate.
Note that the display name for a user is constructed by combining the firstName and lastName
attributes from the SAML response, if present. If the attributes are not present, the Controller uses the
userName value as the display name for the user.
The Controller does not expect the SAML response to be encrypted, but it should be signed and is
typically BASE-64 encoded.
The OneLogin widget described in SAML Configuration for OneLogin provides mappings for the
required parameters. For other SAML providers, you need to ensure that the values are returned
directly.
Sample Request and Response

Here is a sample request from the Controller to the SAML service provider:
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<samlp:AuthnRequest
xmlns:samlp="urn:oasis:names:tc:SAML:2.0:protocol"
ID="_161f8cdf-3c27-4a60-9158-b7be76ba2090"
Version="2.0"
IssueInstant="2014-07-08T18:58:09.42Z"
ProtocolBinding="urn:oasis:names:tc:SAML:2.0:bindings:HTTP-POST"
AssertionConsumerServiceURL="http://{appdynamics_controller_url}/con
troller/saml-auth?accountName={account_name}”
>
<saml:Issuer
xmlns:saml="urn:oasis:names:tc:SAML:2.0:assertion">http://{appdynami
cs_controller_url}/controller</saml:Issuer>
<samlp:NameIDPolicy
Format="urn:oasis:names:tc:SAML:1.1:nameid-format:unspecified"
AllowCreate="true"
/>
</samlp:AuthnRequest>

Here is a sample response from the SAML service provider:
<samlp:Response xmlns:saml="urn:oasis:names:tc:SAML:2.0:assertion"
xmlns:samlp="urn:oasis:names:tc:SAML:2.0:protocol"
ID="Rb178cb4b8e8b9bcdc2634b4a50a16031f26f56d61"
Version="2.0"
IssueInstant="2014-07-08T19:01:36Z"
Destination=""
InResponseTo="_161f8cdf-3c27-4a60-9158fdfd-b7be76ba2090"
>
<saml:Issuer>https://{saml_provider_url}</saml:Issuer>
<samlp:Status>
<samlp:StatusCode
Value="urn:oasis:names:tc:SAML:2.0:status:Success" />
</samlp:Status>
<saml:Assertion xmlns:xs="http://www.w3.org/2001/XMLSchema"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
Version="2.0"
ID="pfxef90db96-f96f-5187-b381-4dd890e07105"
IssueInstant="2014-07-08T19:01:36Z"
>
<saml:Issuer>https://{saml_provider_url}</saml:Issuer>
<ds:Signature xmlns:ds="http://www.w3.org/2000/09/xmldsig#">
<ds:SignedInfo>
<ds:CanonicalizationMethod
Algorithm="http://www.w3.org/2001/10/xml-exc-c14n#" />
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<ds:SignatureMethod
Algorithm="http://www.w3.org/2000/09/xmldsig#rsa-sha1" />
<ds:Reference
URI="#pfxef90db96-f96f-5187-b381-4dd890e07105">
<ds:Transforms>
<ds:Transform
Algorithm="http://www.w3.org/2000/09/xmldsig#enveloped-signature" />
<ds:Transform
Algorithm="http://www.w3.org/2001/10/xml-exc-c14n#" />
</ds:Transforms>
<ds:DigestMethod
Algorithm="http://www.w3.org/2000/09/xmldsig#sha1" />
<ds:DigestValue>QaG4sf2JpLvlynfsyVkU9OyaK92FmFo=</ds:DigestValue>
</ds:Reference>
</ds:SignedInfo>
<ds:SignatureValue>{Signature}</ds:SignatureValue>
<ds:KeyInfo>
<ds:X509Data>
<ds:X509Certificate>{Cert}</ds:X509Certificate>
</ds:X509Data>
</ds:KeyInfo>
</ds:Signature>
<saml:Subject>
<saml:NameID
Format="urn:oasis:names:tc:SAML:1.1:nameid-format:emailAddress”>{use
rname}</saml:NameID>
<saml:SubjectConfirmation
Method="urn:oasis:names:tc:SAML:2.0:cm:bearer">
<saml:SubjectConfirmationData
NotOnOrAfter="2014-07-08T19:04:36Z"
Recipient=""
InResponseTo="_161f8cdf-3c27-4a60-9158-b7be76ba2090"
/>
</saml:SubjectConfirmation>
</saml:Subject>
<saml:Conditions NotBefore="2014-07-08T18:58:36Z"
NotOnOrAfter="2014-07-08T19:04:36Z"
>
<saml:AudienceRestriction>
<saml:Audience/>
</saml:AudienceRestriction>
</saml:Conditions>
<saml:AuthnStatement AuthnInstant="2014-07-08T19:01:35Z"
SessionNotOnOrAfter="2014-07-09T19:01:36Z"
SessionIndex="_350bd2d0-e900-0131-e7a8-782bcb56fcaa"
>
<saml:AuthnContext>
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<saml:AuthnContextClassRef>urn:oasis:names:tc:SAML:2.0:ac:classes:Pa
sswordProtectedTransport</saml:AuthnContextClassRef>
</saml:AuthnContext>
</saml:AuthnStatement>
<saml:AttributeStatement>
<saml:Attribute Name="Groups"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:basic"
>
<saml:AttributeValue
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:type="xs:string"
>{group1}</saml:AttributeValue>
<saml:AttributeValue
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:type="xs:string"
>{group2}</saml:AttributeValue>
</saml:Attribute>
<saml:Attribute Name="accountName"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:basic"
>
<saml:AttributeValue
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:type="xs:string"
>{account_name}</saml:AttributeValue>
</saml:Attribute>
<saml:Attribute Name="emailAddress"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:basic"
>
<saml:AttributeValue
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:type="xs:string"
>{user@domain.com}</saml:AttributeValue>
</saml:Attribute>
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</saml:AttributeStatement>
</saml:Assertion>
</samlp:Response>

Configure SAML Settings

You configure a SAML identity provider for the Controller from the authentication provider tab in
the Controller UI.
This page contains general steps for setting up SAML integration. See SAML Configuration
for OneLogin for sample steps that show how to configure SAML with an actual identity
provider.
To Configure a SAML Identity Provider

1. As an administrator or account owner in the Controller UI, click Settings -> Administration.
2. Click the Authentication Provider tab.
3. Select the SAML radio button for the authentication provider to use.
The SAML configuration screen appears:

4. In the Login URL field, enter the SAML Login URL. This is the address to which the
Controller will send Service Provider (SP)-initiated login requests.
5. In the Logout URL field, enter the URL to which the browser should redirect when the user logs

Copyright © AppDynamics 2012-2014

Page 224

5.
out. This is useful for redirecting the user back to the identity provider instead of to the
AppDynamics login screen. This field is optional.

6. In the Certificate field, paste the x.509 certificate from your identity provider configuration
between the BEGIN CERTIFICATE and END CERTIFICATE delimiters. Do not copy the BEGIN
CERTIFICATE and END CERTIFICATE from certificate field.
7. In the Default Roles section, select the roles to grant to new users of the SAML-enabled
controller by checking the Member check box for the role. You must grant at least one default
role, and you can select multiple roles. See Configure Roles for information about roles and
permissions.
The roles that you assign here will be granted to new users when they first log in to the
SAML-enabled controller if those users have not been previously created directly in the
Controller. Users created prior to SAML enablement or directly within the controller prior to
the user's initial login retain their original roles.
Typically SAML users get the default roles assigned in this configuration. In exceptional
cases an account owner may want to grant individual users different roles. See To Assign A
Role to a User.
8. Click Save.
Use Automated SAML Groups and Controller User Role Associations

The Controller can assign roles to SAML-authenticated from attributes drawn from the SAML
identity assertion for the user. The Controller takes the group name from the user identity assertion
from SAML and matches it to the role with the same name defined in the Controller configuration.
To use automated mapping between SAML group and Controller role:
The SAML identity response from the authentication provider must return the group
associations for authenticated users.
The group names must be in an attribute named "Groups".
The group name as presented by the SAML system and the role name in the Controller
must be identical.
As an example, given the following SAML assertion, the Controller would map the "Workflow
Executor" and "CartAppAdmin" group names to the identically named roles in the Controller.
<saml:AttributeStatement>
<saml:Attribute Name="Groups"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:basic">
<saml:AttributeValue xsi:type="xs:string">Workflow
Executor</saml:AttributeValue>
<saml:AttributeValue
xsi:type="xs:string">CartAppAdmin</saml:AttributeValue>
</saml:Attribute>
</saml:AttributeStatement>

No additional SAML configuration is required in the Controller to use SAML group-to-role mapping.
If SAML authentication is enabled in the Controller, as described in the previous section, it
automatically checks SAML assertions for the Groups attribute.
However, be sure to note the following behavior related to SAML group-to-role mapping:
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If the SAML system returns the Groups attribute, but the values of the attribute cannot be
matched to any role in the Controller, the user authentication succeeds (the user logs in) but
will not have any privileges in the Controller UI.
If the SAML assertion does not include the Groups attribute, the Controller assigns the
default roles you configure for authentication, as described in the previous section.
If the SAML assertion identifies multiple groups that map to roles in the Controller, the
privileges defined by all matching roles are aggregated for the user.
Learn More

SAML Configuration for OneLogin
Disable SAML Authentication for an Account
Configure Users
Disable SAML Authentication for an Account

To disable SAML Authentication
You can disable SAML authentication for an account from the AppDynamics administration
console.
To disable SAML Authentication
1. Log into the administration console.
See Access the Administration Console.
2. In the left navigation panel click Accounts.
3. From the accounts list select the account for which you want to disable SAML
authentication.
4. Click the Edit icon.
The account settings for the account are displayed. If SAML is enabled, the setting appears
as follows.

5. Click Disable.
SAML Configuration for OneLogin

To configure AppDynamics SAML Settings for OneLogin
To configure OneLogin Settings for AppDynamics
Learn More
This topic describes how to configure SAML-based single sign-on (SSO) authentication for
Controller access with a particular identity provider, OneLogin. See Configure Authentication Using
SAML for general information about SAML integration.
To configure AppDynamics SAML Settings for OneLogin
1. As an administrator or account owner in the Controller UI, access the Authentication
Provider tab. See Configure Authentication Using SAML for information on accessing the
tab.
2. Select SAML as the provider.
3. In the Login URL field, enter the SAML Login URL from your OneLogin configuration. The SAML
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3.
Login URL is the URL to the SSO service at the identify provider. The identity provider provides
this URL to the Controller.
If you do not know your SAML Login URL, you can locate it in your OneLogin configuration:

a. Log in to your OneLogin account.
b. Click the Apps tab in the first set of tabs.
c. Click edit next to the application for which you want to view the Login URL.
Click the Company Apps tab in the second set of tabs if it is not already selected.
d. Click Single Sign-on in the third set of tabs.
The SAML Login URL is the HTTP SAML Endpoint in the Sign-on method section.

4. In the Logout URL field in the AppDynamics form, enter the URL to which the browser should
redirect when the user logs out. This is useful for redirecting the user back to the identity
provider instead of to the AppDynamics login screen. This field is optional. For example, the
following logout URL redirects the user to the OneLogin application dashboard:
https://app.onelogin.com/client/apps
5. In the Certificate field in the AppDynamics form, paste the x.509 certificate from your OneLogin
configuration between the BEGIN CERTIFICATE and END CERTIFICATE delimiters. Do not
copy the BEGIN CERTIFICATE and END CERTIFICATE from the OneLogin x.509 certificate
field.
To find your x.509 certificate in your OneLogin configuration:
a. Log in to your OneLogin account.
b. Click the Security tab in the first set of tabs.
c. Click SAML in the second set of tabs.
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c.

6. In the Default Roles section in the AppDynamics form, select the roles to grant to new users of
the SAML-enabled controller by checking the Member check box for the role. You can select
multiple roles in the list. See Configure Roles for information about roles and permissions.
The roles that you assign here will be granted to new users when they first log in to the
SAML-enabled controller if those users have not been previously created directly in the
Controller. Users created prior to SAML enablement retain their original roles.
You must grant at least one default role.
7. Click Save.
To configure OneLogin Settings for AppDynamics
In your OneLogin account, configure the SAML Consumer URL with the host, port and optional
account name values from the AppDynamics Controller. The Consumer URL is where the identify
provider posts the SAML Authentication Assertion.
1. Log in to your OneLogin account.
2. Click the Apps tab in the first set of tabs.
3. Click edit next to the AppDynamics Connector.
Click the Company Apps tab in the second set of tabs if it is not already selected.
4. In the third set of tabs click Configuration.
5. Enter the Consumer URL for the AppDynamics connector.
It has the format:
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http[s]://<controller-host>:<controller-port>/controller/saml-auth
The host and port for your Controller account are supplied by AppDynamics.

6. Provide the AppDynamics account name if your controller is configured in multi-tenant mode and
if the user normally enters an account name on login. If your controller is configured in
single-tenant mode or if the user does not supply an account name on login, you can leave the
Account Name field blank.
See Controller Tenant Mode for information about controller tenant modes.
7. Save your settings.
Learn More

Configure Authentication Using SAML
Disable SAML Authentication for an Account
Controller Data and Backups
About Controller Data Storage
Controller Data Directory Location
Manage the Database User Password
Moving the Controller Data Directory
To relocate the Controller data directory
Related Links
This topic provides an overview of how to configure and administer Controller data storage.
About Controller Data Storage

The Controller requires persistent data storage to store the following type of information:
Design of your applications (all metadata about business transactions, tiers, policies, and so
on)
History of the performance of your applications (metric data)
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Transaction snapshot data and events
History of incidents that occurred (both resolved and unresolved incidents)
Controller Data Directory Location

By default, the AppDynamics Controller uses MySQL as its storage mechanism. The Controller
bundles a MySQL instance with the Controller. At installation time, the installer creates the
necessary tables and artifacts in the database.
By default, the database files and data are stored in: <Controller_Installation_Director>/db.
Manage the Database User Password

The installer creates the user account that the Controller uses to log into the database to perform
database-related operations. The username of the account is "root", and the password is the one
you supply to the installer during the installation process.
If you changed the password for the Controller's database user in the database management
system, you need to configure the Controller to use the new password. By default, the Controller
stores the password on disk at the following location:
<Controller_installation_dir>/db/.rootpw
When it access the database, it attempts to read the password from that location. For security
reasons, or to facilitate automation, you may choose to keep the password in an environment
variable or by supplying it at the command line instead of the file.
When attempting to access the data, the Controller reads the database user password from these
sources and in the priority shown:
From the MYSQL_ROOT_PASSWD environment variable
From the file <Controller_installation_dir>/db/.rootpw
From user input to a command line prompt
If you do not keep the password in the environment variable or the .rootpw file, you will need to
supply it in response to a command line prompt whenever performing an operation that involves
accessing the database, such as starting the Controller (since this requires starting the database),
starting the database, stopping the database, or logging into the database.
Moving the Controller Data Directory

After installation you can move the data directory to a new location. The following conditions can
make it necessary to move the data:
When you want to store the Controller data on a SAN in order to get higher I/O performance
and redundancy.
If there is not enough disk space available during Controller installation.
Note: If you are using symlinks, you must create the symlink outside of the root Controller
install directory and move the data directory to the new volume after you install the Controller.
Warning: Do not mount a file system on <Controller_Installation_Directory>/db/data. During
Controller upgrade, the installer moves the data directory to data_orig. Upgrade will fail if the
installer cannot complete this move.
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To relocate the Controller data directory

1. Stop the Controller and its database. See Start or Stop the Controller.
2. Modify following properties in the <Controller_Installation_Directory>/db/db.cnf file to point to
the new location of the data directory.
datadir
tmpdir
log
slow_query_log_file

3. Copy (or move) the existing data directory <Controller_Installation_Directory>/db to the new
location.
For example, to copy the data on Linux:
cd <Controller_Installation_Directory>/db/
cp data <new-location>

4. Start the Controller. See Start or Stop the Controller.
5. Check the database.log and server.log for any errors related to the database connection.
Related Links

See the following topics for more information on administering AppDynamics data:
Controller Data Backup and Restore

About Controller Backups
Best Practices for Backups
Light Backup (Level 1)
Metadata Backup (Level 2)
Complete Backup (Level 3)
Backup Tools
Using mysqldump to Back Up the Controller
Sample mysqldump Script
Import Data with mysqldump
Using a Backup to Migrate to a New Physical Server
Learn More
About Controller Backups

AppDynamics strongly recommends that you perform routine data backups of the Controller
installation environment. Backups help to improve the disaster recovery preparedness of your
organization. Any data generated since the last backup may be lost.
There are two general approaches to backing up the system, using a disk snapshot mechanism,
such as Linux Volume Manager, or using database backup tools. The BackupTools section
describes tools that support each approach. While most backups are taken to guard against data
loss in the event of a failure, they can also be used when upgrading the Controller and when
migrating the Controller from one server to another.
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This page provides an overview of the tasks and considerations related to backing up the
Controller. For information specific for your environment and situation, contact AppDynamics
Support.
Best Practices for Backups

Backing up the entire system each night may not be feasible when dealing with the large amount
of data typically generated by a Controller deployment. To balance the risk of data loss against the
costs of performing backups, a typical backup strategy calls for backing up the system at different
scopes at different times. That is, you may choose to perform partial backups more frequently and
full backups less frequently, relatively speaking.
The scope of a Controller backup can be categorized into these levels:
Level 1: A light backup of the installation environment only
Level 2: A metadata backup involving all metadata associated with the installation except big
data tables.
Level 3: Backs up all data, either by performing a cold backup of the /data directory or a hot
backup using a third-party tool.
Given these levels, a possible backup strategy would be to perform a level 1 and level 2 backup
very frequently, say nightly, and a level 1 and level 3 backup about once a week. The following
sections provide more details about these levels.
Light Backup (Level 1)

A light backup targets Controller configuration files like db.cnf, domain.xml, and so on. This type of
backup lets you avoid having to reinstall and reconfigure the Controller in case of machine failure.
To perform this type of backup, simply shut down the Controller and copy everything in the
Controller installation directory EXCEPT the data directory.
While it is recommended that you copy the entire Controller home except the data directory when
performing a light backup, particularly before performing a Controller upgrade, there are scenarios
in which you may wish to copy only site-specific configuration files. This may be the case, for
example, if migrating an existing Controller configuration to a new Controller installation. For a list
of those files, see Migrate the Controller between Machines.
Metadata Backup (Level 2)

A metadata backup exports the data that encapsulates the environment monitored by the
Controller. Metadata defines the applications monitored by the Controller, business transactions,
policies, and so on. It does not include what can be thought of as "runtime data", the big data
tables that contain the metrics, snapshots, events, and top summary stats (top SQL, top URLs,
and so on) generated in the monitored environment. By backing up metadata, you can avoid
having to reconfigure monitored applications in the Controller in the event of a failure.
To perform this type of backup, run the script described in Using mysqldump to back up the
Controller.
Complete Backup (Level 3)

A complete backup saves all runtime data associated with the Controller installation. It captures
the actual metrics data, snapshots, and so on.
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The AppDynamics Controller uses the default storage engine for MySQL, InnoDB. Since InnoDB
supports transactions (in contrast to MyISAM), you cannot simply copy data files directly while the
Controller is running. You need to stop the Controller before copying data files. However, some
third-party backup tools, such as Percona XtraBackup, do not rely on transactions so you can
perform a hot backup of your system (that is, back up the Controller database while it is running).
You can perform a complete backup as either:
A cold backup of the /data directory. A cold backup means that, with the Controller app
server and database shut down, you create an extra copy of the Controller database using,
for example, the "cp -r" command, the tar utility, rsync, or others.
A hot backup, which means the Controller is running. For a hot backup, use a third-party tool
such as Xtrabackup, LVM snapshotting, or other third-party tool.
This type of backup allows you to skip the Level 2 backup, since it will include the metadata tables,
but you would still need to perform the Level 1 backup to back up the Controller home directory.
Backup Tools

This section lists a few third-party tools that you can use to back up Controller data. The list is not
exhaustive; you can use any tool capable of backing up MySQL data with the Controller. However,
the tool should back up the data as binary data.
For Linux systems:
Percona XtraBackup
InnoDB Hot Backup
For Windows systems:
Zmanda Recovery Manager for MySQL
An alternative to using a database backup tool is to use a disk snapshot tool to replicate the disk
or partition on which the Controller data resides. Options are:
ZFS volume manager. For more information, see Using ZFS methods for data backup.
The Linux Logical Volume Manager (LVM) or a tool based on LVM such as mylvmbackup pr
ovide a similar capability.
Details for performing this type of backup are beyond the scope of this documentation. For more
information, refer to administration documentation applicable to your specific operating system.
Also, contact AppDynamics Support for scripts that can automate back up tasks in your
environment.
Using mysqldump to Back Up the Controller

The mysqldump utility is a MySQL backup tool that is included with the Controller instance of
MySQL.
While mysqldump is not recommended for use on large data tables, such as the Controller metric
data tables, it is useful for backing up Controller metadata. Metadata defines the monitored
domain for the Controller, including applications, business transactions, alert configurations, and
so on.
The following instructions assume that the binary path for the Controller's MySQL instance is in the
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PATH variable. The path to the Controller's instance of MySQL must precede any other MySQL
path on your system. This prevents conflicts with other database management systems on your
machine, such as a MySQL instance included by default with Linux.
The database binary files for the Controller database are in <controller_install_dir>/db/bin.
To use mysqldump:
1. Get the root user password for the Controller database. You can get the password for the
root user from the following file:
<Controller_install_directory>/db/.rootpw
2. Run the mysqldump executable, passing the root username, password, and output file. The
executable is located in the following directory:
<Controller_install_directory>/db/bin
The command should be in the form:
mysqldump -u root -p<password> <ignore-table_statements> >
/tmp/metadata_dump.sql

For a full example that shows which tables to exclude for a metadata backup, see the contents of
the metadata backup script described in the next section.
Sample mysqldump Script

The following script illustrates how to use mysqldump to export Controller metadata while
excluding runtime data tables by script.
Linux: ControllerMetadataBackup.sh
Windows: ControllerMetadataBackup.cmd
To use the script, download the version appropriate for your operating system and modify it as
described in the script comments.
Import Data with mysqldump

After generating a mysqldump export file, you can import it into an empty database as follows:
$install/db/bin/mysql -u controller -psingcontoller controller <
metadata_dump.sql

Using a Backup to Migrate to a New Physical Server

You can use either a hot or cold backup procedure to migrate Controller data to a new server.
However, we recommend performing cold backups. While a hot backup does not bring down the
Controller for an extended amount of time, it does introduce the possibility of data loss, since hot
backups capture the state of the data only when the hot backup starts.
To perform a cold backup, simply shut down the Controller and back up the data directory located
in <Controller_Installation_Directory>/db.
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Learn More

Controller High Availability
App Agent for Java Configuration Properties
.NET Agent Configuration Properties
Controller Disk Space and the Database

Disk Space Considerations
Managing Disk Space
Automatic Shutdown When Disk Space is Low
To disable automatic shutdown for a running Controller
Learn More
This topic discusses best practices for managing disk space for the MySQL database used by the
Controller.
Disk Space Considerations

To ensure database integrity, the Controller automatically shuts itself down when available disk
space falls below 1 GB.
Before it reaches that point, however, the Controller displays a low disk space alert in the UI and
writes an error level event to server.log. The point at which the Controller generates the alert
depends on its profile, as follows:
For large and huge profiles: 10 GB or less
For all other profiles: 2 GB or less
The Controller shuts itself down when there is less than 1 GB on the disk regardless of the
Controller profile type. You can disable automatic shutdown based on disk space as described
below.
It's important to note that the Controller monitors the disk or partition that it is installed on. If the
Controller data resides on a different disk or partition from the Controller home directory, you will
need to monitor available space on that disk or partition separately.
Managing Disk Space

If the disk space is low, you need to reduce the size of the Controller database.
To manage how much disk space the Controller database uses, you change the amount of data
retained in the Controller database. See Database Size and Data Retention.
Automatic Shutdown When Disk Space is Low

You can prevent the Controller from automatically shutting down when its disk space falls below 1
GB if needed. This behavior is intended to avoid the possibility of DB corruption. But in certain
situations, such as when the Controller is installed on a separate partition from the data, it may
make sense to disable this feature.
To disable automatic shutdown for a running Controller

1. Shut down the Controller. See Start or Stop the Controller.
2. Open the
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<Controller-Installation-Directory>/appserver/glassfish/domains/domain1/config/domain.xml file for
editing.
3. Add the following:
<jvm-options>-Dignore.disk.space=true</jvm-options>

4. Save the file.
5. Restart the Controller.
Learn More

Database Size and Data Retention
Controller System Requirements
Start or Stop the Controller
Database Size and Data Retention

Information Stored by the On-Premise Controller
Modifying Event, Transaction Snapshot, and Incidents Data Retention Settings
To change the retention period for event, snapshot, and incident data
Modifying Metric Data Retention Periods
To change the data retention period for metrics
Limiting the Business Transaction Registration Retention Period
To change the business transaction retention period
Troubleshooting Controller Database Growth Issues
Learn More
This topic explains the default data retention periods for data stored by the AppDynamics
On-Premise Controller.
Information Stored by the On-Premise Controller

The Controller database stores the following types of data in its MySQL database:
The design of your applications (all metadata about business transactions, tiers, policies,
etc.)
A record of Events and Transaction Snapshots
Historical data about application performance (metric data)
History of incidents that occurred, whether they were resolved or not (policy violations, very
slow transactions, etc.)
You can change the amount of data you retain in the Controller database by changing the
retention period for events, snapshots, and metric data.
Lowering the retention settings purges data that is aged out by the new retention setting and
reduces the amount of data stored by the Controller on an ongoing basis.
You can tune the retention settings for various types of data, as described below. In particular,
lowering the snapshot retention (snapshots.retention.period) and hourly metric retention (metrics.r
etention.period) times can have a significant effect in reducing the amount of retained data. Those
settings are a good place to start when tuning your system to reduce disk space consumption.
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Modifying Event, Transaction Snapshot, and Incidents Data Retention Settings

You can modify the default retention periods for events, snapshot and incidents data.
Setting longer retention periods can significantly affect database size and Controller
performance. AppDynamics strongly recommends that you monitor your system carefully if
you change any of these settings from the default, and be prepared to roll back your
changes if necessary.
To change the retention period for event, snapshot, and incident data

1. Log in to the Controller administration console using the root account password. See Acces
s the Administration Console.
http://<controller-installer-host>:<port>/controller/admin.html

Use the root account password to access the Admin console when the Controller is installed
in single- or multi-tenant mode. If you have not set this password, call AppDynamics Support
to get the default password.
2. Click Controller Settings.
3. Change the data retention period for incident and event data and transaction snapshots are
determined by the following parameters:
Property Name

About the property

Default

Allowed Values

events.retention.peri
od

The retention time
for events in hours.

336 hours (2 weeks)

1 to 840 hours (5
weeks)

snapshots.retention.
period

Determines the
retention time for
transaction
snapshot data in
hours.

336 hours (2 weeks)

1 to 840 hours (5
weeks)

incidents.retention.p
eriod

Determines the data
retention time for
incidents, including
policy violations or
very slow
transactions, in
hours.

336 hours (2 weeks)

1 to 840 hours (5
weeks)

After you lower one of the data retention period settings, data in the database that falls outside the
scope of the new data retention period is discarded. As a result, the size of the database should
drop anywhere from 30 to 60 minutes after you make the change. If it does not, see Troubleshooti
ng Controller Database Growth Issues.
Modifying Metric Data Retention Periods
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You can modify the default metric data retention periods. The metric retention periods control how
long data is retained at 1-minute, 10-minute, and 1-hour resolution (see Metric Data Display in
Graphs).
There are a few important points to note before changing metric data retention periods:
Setting longer retention periods for metric data can quickly and significantly affect database
size and Controller performance. If you need to review details for an issue that occurred
during a period for which you have only 10-minute or 1-hour data, AppDynamics provides
access to diagnostic data at a more detailed level than might be visible on a graph, so
increasing the default retention periods is not often necessary. See Viewing Details for Older
Data.
While metric retention periods apply to the data kept in the Controller database, some of the
data that appears in the Controller UI — in particular, data at the 1 and 10 minute granularity
level that appears in the tier and application dashboards — is actually drawn from the
Controller cache rather than from the database.
If you set the 1 and 10 minute metric retention periods to an overall retention period that
exceeds the cache retention period, the performance of the Controller UI will be adversely
affected, since the UI will have to retrieve the data from the database rather than from the
cache. The cache retention period is determined by the caches.retention.period setting,
which you can modify in the Administration Console, as described below.
There is a special case in which you can lose minute data. If metrics.min.retention.period is
under 36 hours and you change it to 36 hours or higher, or if metrics.min.retention.period is
36 hours or higher and you change it to a value under 36 hours, special repartitioning is
required, and therefore you will lose all the minute data after you save the settings.
To change the data retention period for metrics

1. Log in to the Controller administration console. See Access the Administration Console.
http://<controller-installer-host>:<port>/controller/admin.html

Use the root account password to access the Admin Console. If you have not set this
password, call AppDynamics Support to get the default password.
2. Click Controller Settings.
3. Change the data retention period by modifying the values for the following settings and
saving. The settings are:
Property name
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metrics.min.retentio
n.period

The number of
hours 1-minute data
will be retained in
hours. Its value
should always be
less than the value
for
metrics.ten.min.rete
ntion.period.

4 hours

1 to 42 hours

metrics.ten.min.rete
ntion.period

The number of
hours 10-minute
data will be retained
in hours. Its value
should always be
greater than the
value for
metrics.min.retentio
n.period and less
than
metrics.retention.per
iod.

48 hours

2 to 504 hours (3
weeks)

metrics.retention.per
iod

The number of days
1-hour data will be
retained in days. Its
value should always
be greater than the
value for
metrics.ten.min.rete
ntion.period.

365 days

30 to 730 days (2
years)

For example, if you change the metrics.min.retention.period property to 3, metric data displayed
for all time ranges less than or equal to 3 hours will be shown at one-minute resolution. Metric data
for time ranges greater than 3 hours and less than metrics.ten.min.retention will be shown at
10-minute resolution, and metric data for older time ranges will be shown at 1-hour resolution.
Another example: If you change the metrics.ten.min.retention property to 168, all time ranges less
than or equal to 168 hours (1 week), and greater or equal to min.retention.period will be displayed
at 10-minute resolution.
The values in the UI Time Range dropdown menu do not change even if the data retention
periods are reconfigured.
Limiting the Business Transaction Registration Retention Period

The business transaction retention period determines how long the Controller retains a "stale
business transaction" as a registered business transaction. A stale business transaction one that
has not received a request in a given period of time.
By default, the business transaction registration is retained forever. You can specify a set timeout
period for the business transaction if needed. If it has not seen a request in the period of time you
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configure, the business transaction registration is discarded, making the business registration slot
available for another business transaction.
To change the business transaction retention period

1. Log in to the Controller administration console. See Access the Administration Console.
2. Click Controller Settings.
3. Set the business.transaction.retention.period setting to the new retention time value in hours
and save. The default value is 0, which means that the business transaction registration is
retained forever. The minimum retention time is 24 hours and the maximum is 0 (i.e., no
limit).
Troubleshooting Controller Database Growth Issues

If changing the data retention settings does not improve the rate of database growth for your
system, first make sure you have restarted the Controller since making the configuration changes.
If you still see no improvement, file a support ticket that describes the problem along with a listing
of your data directory. To generate the listing, run the following command on the Controller
machine:
ls <Controller_Home>/db/data/controller/ -lS > controller.output

The command writes the output to the controller.output file, which you can attach to your support
ticket.
Learn More

Controller Disk Space and the Database
Infrastructure Metrics
Export and Import Business Application Configurations
Copying Business Application Configurations
To export an application configuration
To import configuration information
Learn More
This topic describes how to export and import the application configuration in the Controller.
Application export/import allows you to back up just a single application configuration in the
Controller (as opposed to the entire Controller instance, as described in Controller Data Backup
and Restore).
Other artifacts can be exported as well. For Java entry points, custom match rules, and exclude
rules, see Import and Export Transaction Detection Configuration for Java. For JMX
configurations, see Create, Import or Export JMX Metric Configurations.
Copying Business Application Configurations

You can export a business application configuration and import it as a new business application.
The two applications can be on the same or different Controllers. If on different Controllers they
must be using the same major version of AppDynamics.
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The configuration information is in an XML file that includes:
Snapshot collection settings
Call graph settings
SLA configurations
Error configuration
Stall configuration and Business Transaction thresholds
HTTP and SQL Data gatherer settings
Tier information
Node definitions
Custom entry point configurations for Business Transactions
Memory configurations
Metric baselines
Information point configurations
The configuration information does not include account data for:
Users
User preferences
Dashboards
LDAP configuration
Email/Notification configuration
These application level configurations are not included:
Policies
Databases & Remote Services
Schedules
Metrics and other runtime data are not included in the configuration.
To export an application configuration

1. In the Application Dashboard, click Action (the lightning bolt) -> Export.
2. Click Export.
AppDynamics creates an XML file containing application configurations.
Alternatively, you can use the Action -> Export menu in the All Applications Dashboard.
To import configuration information

You must have an Administrator role to import an application configuration. See Configure Roles.
Application import will not work over HTTPS if you use a self-signed SSL certificate. Use a
customer certificate. See Controller SSL and Certificates.
1.
2.
3.
4.

In the Application Dashboard, click Import Application.
Select the XML file that was exported.
Enter a name for the application.
Click Import.

AppDynamics creates a new application with the copied configuration.
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Learn More

Create, Import or Export JMX Metric Configurations
Hierarchical Configuration Model
Upgrade the Java Agent
Upgrade the .NET Agent
Controller Performance
Monitoring Controller Performance
To monitor heap usage
To check the Controller server log for errors
Performance Issues
To troubleshoot Controller performance issues
To troubleshoot Controller issues
Monitoring Controller Performance

To monitor Controller performance:
Monitor heap usage
Review the server log file
To monitor heap usage

On a Windows machine: Use the Task Manager to measure the memory usage for the
Controller.
On a Linux machine: Use the top command to get statistics for the memory data.
ps -elf (expect to see a "java" process and a "mysql" process)
top (expect to see java and mysql with cpu greater then 0)

To check the Controller server log for errors

1. Open a console and navigate to the <Controller_Installation_Directory>/logs/server.log file.
2. Open the log file and look for any anomalies.
Performance Issues

If you observe degradation in Controller performance it may be due to one of the following:
The hardware resources for the Controller might not match the correct Controller profile.
The Controller performance profile may be incorrectly configured.
To troubleshoot Controller performance issues

1. Confirm that the hardware matches the Controller profile you use. For details see Controller
System Requirements.
2. Confirm that your disk performance matches the recommended thresholds for minimum disk
performance. For details see Controller System Requirements.
3. Conform that the Java SDK version is exactly the same as the Java version on the
Controller. To display the version of Java used by the Controller:
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3.
Open the command line utility.
Go to <Controller_Installation_Directory>/jre/bin
Run java -version.
To troubleshoot Controller issues

If problems persist, contact AppDynamics Support.
Internationalization

Internationalization Support in AppDynamics
Setting the UI Font Mode
To enable double-byte characters in the UI
Learn More
Internationalization Support in AppDynamics

AppDynamics supports double- and triple-byte characters in the agents, Controller, and UI. The
support enables you to:
Enter double- or triple-byte characters into text fields in the UI
View double- or triple-byte characters from applications
Setting the UI Font Mode

By default the Controller UI uses single-byte fonts. Users can set the font mode in the Controller UI
to use system fonts. This enables them to view UI text in languages other than English, depending
on the localization setting of the operating system.
To enable double-byte characters in the UI

1. In the user profile menu at the top right of the Controller UI, click My Preferences.
2. In the View Preferences panel, click Use System Font.
You do not have to explicitly save this preference. The setting takes effect immediately.
For more information about user preferences, see Set User Preferences.
Learn More

Install the Controller
Set User Preferences
Controller Tenant Mode
Differences Between Multi- and Single-Tenant Mode
Switching from Single- to Multi-Tenant Mode
To switch from single- to multi-tenant mode
Accounts for Multi-Tenant Mode
To create accounts in multi-tenant mode
Next Steps
Learn More
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Differences Between Multi- and Single-Tenant Mode

You can configure an on-premise AppDynamics Controller for single-tenancy or multi-tenancy
modes. You choose the initial tenancy mode for the Controller at installation time. As indicated in
the installer, you can switch the tenancy mode from single- to multi-tenant mode after installation.
Switching from multi- to single-tenant mode, however, is not supported.
The differences between the modes are:
In multi-tenant mode
You can create multiple accounts (tenants) in the Controller.
Each account will have its own set of users and Applications.
The Controller login page includes an additional field where users need to choose an
account to log in to.
Essentially, multi-tenant mode allows you to partition users and access to application data in
a logical, secure way.
In single-tenant mode
There is only one account (tenant) in the Controller system.
All users and applications are part of this single built-in account, so all users have access to
all monitored Applications in this mode.
The account is not exposed to users in the Controller UI. The account field in the log in page
is omitted for single tenant mode.
AppDynamics recommends single-tenant mode for most installations.
Switching from Single- to Multi-Tenant Mode

In addition to the steps below, to switch the tenancy mode you need to modify the configuration of
any deployed app agent or machine agent that connects to this Controller. The agents must
specify the accounts with which they are associated in the multi-tenant Controller. See Next Steps
below for more information.
A Controller license does not enforce or distinguish a particular tenancy mode for the Controller,
but the total number of licensed agents for all accounts cannot exceed the number of agents for
which you are licensed.
To switch from single- to multi-tenant mode

1. Log in to the AppDynamics Administration Console, as described in Access the
Administration Console.
2. Click Controller Settings.
3. Set the value for the multi-tenant.controller property to "true".
Switching from multi-tenancy to single-tenancy is not supported.
4. Save the settings.
5. Log out and refresh your browser.
You can now create accounts for the multi-tenant Controller, as described next.
Accounts for Multi-Tenant Mode
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In multi-tenant mode you create accounts from the Admin Console interface.
To create accounts in multi-tenant mode

1. Log in to the AppDynamics Administration Console, as described in Access the
Administration Console.
2. Click Accounts.
3. If you are switching from single- to multi-tenant mode, you will see the default accounts used
for single-tenant mode. This window also provides information on the number of licenses
provisioned for the agents in your environment.
4. Click Add (the + icon).
5. Provide the details about the Account.
Users will log into the AppDynamics UI using this Account Name.
6. Create credentials for the Controller administrator.
The user with administrator privileges can then create users for that Account. For details
see Configure Users.
7. Click Create account.
You should now reconfigure any deployed agents to associate them with the new account.
Next Steps

If there are existing app agents and machine agents deployed for this Controller, you will need to
update their configuration settings to associate the agents with one of the accounts you created.
For details see App Agent for Java Configuration Properties, .NET Agent Configuration Properties,
and Standalone Machine Agent Configuration Properties.
Learn More

Controller Users
App Agent for Java Configuration Properties
.NET Agent Configuration Properties
Standalone Machine Agent Configuration Properties
Install the Java Agent
Install the .NET Agent
Install the Standalone Machine Agent
Customize System Event Notifications
Tuning Notification Trigger Conditions
Learn More
Tuning Notification Trigger Conditions

Certain system events trigger event notification popups in the Controller UI.
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You can fine tune the events that trigger notification popups in the Administration Console.
1. Log in to the Administration Console.
2. Use the left navigation bar to select Administration->Controller Settings.
3. Locate the system.notification.event.types property.

4. Set the types of events you want to see by adding them to the comma separated string in
the dialog box. If you want to block notifications of a particular type of event, leave it out of
the list. No spaces are allowed between commas.
Possible values are:
Event Value

What This Event Notification Means

LICENSE

There is an issue with the status of your
license.

DISK_SPACE

There is an issue with the amount of disk
space left on your system.

CONTROLLER_AGENT_VERSION_INCO
MPATIBILITY

A mismatch between the version of the
agent and the version of the controller has
been detected.
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CONTROLLER_EVENT_UPLOAD_LIMIT_
REACHED

The limit on the number of events per
minute that can be uploaded to the
controller from this account has been
reached. Once the limit is reached no more
events — other than certain key ones —
are uploaded for that minute.

CONTROLLER_RSD_UPLOAD_LIMIT_RE
ACHED

The limit on the number of request segment
data (RSDs) per minute that can be
uploaded to the controller from this account
has been reached. RSDs are related to
snapshots. Once the limit is reached no
more RSDs — other than certain key ones
— are uploaded for that minute.

CONTROLLER_METRIC_REG_LIMIT_RE
ACHED

The limit for registering metrics for this
account has been reached. No further
metric registrations are accepted.

CONTROLLER_ERROR_ADD_REG_LIMI
T_REACHED

The limit for registering error Application
Diagnostic Data (ADDs) for this account
has been reached. No further error ADD
registration is accepted.

CONTROLLER_ASYNC_ADD_REG_LIMIT
_REACHED

The limit for registering async ADDs for this
account has been reached. No further
async ADD registration is accepted.

AGENT_ADD_BLACKLIST_REG_LIMIT_R
EACHED

If the Agent attempts to register an ADD
above the limit, the Controller rejects the
attempt and adds the ADD to a blacklist.
There is a limit to the size of the blacklist.
This event indicates that that limit has been
reached.

AGENT_METRIC_BLACKLIST_REG_LIMI
T_REACHED

If the Agent attempts to register a metric
above the limit, the Controller rejects the
attempt and adds the metric to a
blacklist. There is a limit to the size of the
blacklist. This event indicates that that limit
has been reached.

For help resolving the underlying issues indicated by these notifications, contact
AppDynamics support.
Learn More

Access the Administration Console
Controller Logs
Log Files Generated by the Controller
Manage Log Files
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To change the default location or names of the Controller logs
Configuring Debug Logging for the Controller
To change default logging level for Controller components
Learn More
Log Files Generated by the Controller

The Controller creates these log files in the <Controller_Installation_Directory>/logs directory:
database.log: Contains error log information generated by MySQL.
server.log: Contains logs generated by the Controller and Glassfish.
startAS.log: Contains output generated by the underlying Glassfish domain for the
Controller.
Manage Log Files

The application server is preconfigured to rotate the server.log file regularly, based on settings in
the domain configuration file.
For the other log files, database.log and startAS.log, you need to set up log rotation to prevent
them from consuming excessive disk space. You also need to set up log rotation for an additional
log file, <Controller_Installation_Directory>/db/data/slow.log. This log contains information about
slow MySQL queries.
The tool you use to perform the rotation depends on your operating system. On Linux, you can use
the mysql-log-rotate script. The script is included with the Controller database installation at
<Controller_Installation_Directory>/db/support-files. You need to modify the script for your
environment, since it is not set up to rotate the database.log file by default. On other systems, you
need to create or install a script that performs log rotation and make sure that it get run regularly,
for example, by cron or an equivalent task scheduler.
To change the default location or names of the Controller logs

1. In a web browser, log in to the Controller's Glassfish administration console, as described in
Access the Administration Console.
2. From the left-side navigation tree, expand Configurations -> server-config and click Logg
er Settings.
3. Set the new location for server.log by modifying the Log File value.
The default value points to the logs directory located at the root of the Controller home
directory.
${com.sun.aas.instanceRoot}/../../../../logs/server.log

If you specify a directory that does not exist, it is created when you restart the application
server.
4. Change the database.log location by opening the
<Controller_Installation_Directory>/db/db.cnf file.
5. Set the value of the log-error property to the new location of the database.log file. This
directory location must exist before you restart the Controller or you will get start-up errors.
6.
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6. Change the startAS.log location by opening the
<Controller_Installation_Directory>/bin/controller.sh file.
7. Edit the log location specified in the following line to reflect the new location:
nohup ./asadmin start-domain domain1 >
$INSTALL_DIR/logs/startAS.log

8. Open the
<Controller_Installation_Directory>/appserver/glassfish/domains/domain1/config/domain.xml
file, and change the log location specified in the following:
log-root attribute of the domain element.
file attribute of the log-service element.
tx-log-dir attribute of the transaction-service element.
9. Copy if desired any existing logs from the default directory
(<Controller_Installation_Directory>/logs) to the new location.
10. Restart the Controller. See Start or Stop the Controller.
11. Verify that the database.log, server.log, and startAS.log files are being written to the new
location and remove the old log files.
Configuring Debug Logging for the Controller

The Controller logs provide information about possible errors in Controller operations. By default,
the Controller writes to the log at the INFO level. When debugging your Controller deployment, you
may need to increase the logging level to generate additional information.
You can set the logging level by Controller component, which include:
Agents
Business Transactions (BTS)
Events
Incidents
Information Points (IPS)
Metrics
Orchestration
Rules
Snapshots
To change default logging level for Controller components

By default, the Controller generates logs at the INFO level. You can change the level for one or all
of the components. This may be needed, for example, when you are debugging your system, and
want the Controller to generate more information in the form of logs. On the other hand, you may
wish to reduce logging verbosity to minimize the reduce the rate of growth of log files. The
following steps describe how to change the default log levels.
1. In a web browser, log in to the Controller's Glassfish administration console, as described in
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1.
Access the Administration Console.
2. From the left-side navigation tree, expand Configurations -> server-config and click Logg
er Settings.
3. Click the Log Levels tab.
4. Modify those components that start with "com.appdynamics". By sorting the list by name,
you can quickly access the com.appdynamics components. For each component, modify the
log level by choosing a new level from the Log Level menu. For example, to debug the
system, we suggest setting the log level to FINE.
5. Click Save.
Learn More

Controller Log Files for Troubleshooting
Start or Stop the Controller
Controller Disk Space and the Database
Controller Audit Log

What is Audited
Structure of Audit Log
Enabling or Disabling Audit Logging
Audit Log Retention
The Controller keeps an audit log you can use to monitor user activity and configuration changes
in the Controller.
The Controller keeps audit log data in the controller_audit table.
Audit logging is available only to on-premise controllers.
What is Audited

The following actions are logged during user authentication:
LOGIN*
LOGIN_FAILED*
The following entities are audited for creation, modification and removal:
APPLICATION_COMPONENT
APPLICATION_COMPONENT_NODE*
USER
GROUP
ACCOUNT*
ACCOUNT_ROLE
WORKFLOW*
GLOBAL_CONFIGURATION
NOTIFICATION_CONFIG
DASHBOARD
JMX_CONFIG*
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BUSINESS_TRANSACTION*
BUSINESS_TRANSACTION_GROUP*
CUSTOM_EXIT_POINT_DEFINITION*
CUSTOM_MATCH_POINT_DEFINITION
TRANSACTION_MATCH_POINT_CONFIG
BACKEND_DISCOVERY_CONFIG
ERROR_CONFIGURATION
DOT_NET_ERROR_CONFIGURATION
CALL_GRAPH_CONFIGURATION
SQL_DATA_GATHERER_CONFIG
MEMORY_CONFIGURATION
EUM_CONFIGURATION
AGENT_CONFIGURATION
APPLICATION_DIAGNOSTIC_DATA
POJO_DATA_GATHERER_CONFIG
HTTP_REQUEST_DATA_GATHERER_CONFIG
POLICY*
RULE*
When a user or agent modifies one of these objects, one of the following actions is logged:
OBJECT_CREATED
OBJECT_UPDATED
OBJECT_DELETED
Structure of Audit Log

The structure of the controller_audit table is:
column

value

ts_ms

creation time in milliseconds

account_name

user account of user performing the action

account_id

account id of user performing the action

user_name

user name of user performing the action

user_id

user id of user performing the action

object_name

entity type of modified object

object_id

id of modified object

action

audited action, one of: OBJECT_CREATED,
OBJECT_UPDATED, OBJECT_DELETED,
LOGIN, LOGIN_FAILED

Enabling or Disabling Audit Logging

Audit logging is enabled by default. You can disable Controller audit logging from the Controller
Administration Console. See Access the Administration Console for information on how to access
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the console.
To turn audit logging on or off, set the audit.enabled setting to true or false.
Audit Log Retention

By default the Controller retains audit logs for 720 hours.
You can adjust the retention period in the Controller Administration Console by modifying the
audit.log.retention.period setting. See Access the Administration Console.

Administer Agents
This section describes how to administer the AppDynamics Pro App Agents and the Standalone
Machine Agent. It covers these topics:
Metrics Limits
App Agent Node Properties
Manage App Agents
Administer Standalone Machine Agents
Remove Unused Nodes
Agent Log Files
Agent to Controller Communications
For information on administering the Controller, see Administer the Controller.
Metrics Limits
About Metric Limits
Modifying Metric Limits Per Agent
Modifying Global Metric Limits
About Metric Limits

AppDynamics agents instrument the transactions flowing through your application and report all
critical metrics to the Controller. In order to ensure that you only have to look at metric information
that is most relevant to your application, agents operate under a few limits.
Different limits apply to app agent and per machine agent, as follows:
For an app agent, the maximum number of registered metrics is 5000 by default.
For a machine agent, the maximum number of registered metrics is 200 by default.
If the limit is reached, an error event is generated of type AGENT_METRIC_REG_LIMIT_REACH
ED with a summary of "Metric registration limit of n reached." No new metrics are created until the
agent restarts. You can increase the default limit if necessary, as described next.
Modifying Metric Limits Per Agent

You can increase or decrease the default metric registration limits for machine agents or app
agents. Use caution when increasing the metric registration limits. Increasing the limit can increase
the resource overhead for agents and Controller.
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On Java
On Java platforms, modify the limit using the agent.maxMetrics system property. For example, to
increase the machine agent metric limit specify the maximum number of metrics as an argument when
starting the machine agent in the following format:
-Dappdynamics.agent.maxMetrics=<max-number-of-metrics>

For example, when starting the machine agent, increase the maximum number of metrics that can
be registered to 300 as follows:
nohup java -Dappdynamics.agent.maxMetrics=300 -jar machineagent.jar &

.NET
On .NET platforms, set the maxMetrics property as an environment variable. This setting only
affects the app agent. For example:
appdynamics.agent.maxMetrics=5500

Modifying Global Metric Limits

The maximum number of registered metrics for a single Controller across all agents is 2 million by
default.
This limit is controlled by the metric.registration.limit property. You can view or modify the property
in the Controller Properties page in the Controller Administration Console.
App Agent Node Properties

To edit a registered node property
To register a node property
To apply the configuration to all nodes
Learn More
Node properties affect AppDynamics behavior for monitoring a node, for example, enabling or
disabling features or setting maximum values for the number of discovered business transactions
or the minimum number of requests to evaluate before triggering a diagnostic session. Node
properties are inherited from the parent application or tier or customized for a specific node.
You can edit the values of the default node properties either in the app-agent-config.xml file or
from the UI. To see the default node properties, follow steps 1 through 3 in To edit a registered
node property.
In addition to the default node properties, there are additional custom node properties that
AppDynamics Support may recommend that you set to solve a particular problem. The custom
node properties are not available unless you register them.
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To edit a registered node property

1. In the left navigation pane, access the node dashboard for the node for which you want to
configure a property. For example, click Servers - > App Servers -> <tier> -> <node>. The
Node Dashboard opens.
2. In the Node Dashboard, click Agents->Configure The App Server Agent Configuration
window opens.
You can change to another application, tier, or node for which you want to edit a node
property by selecting it in the left pane.
3. Select Use Custom Configuration.
4. From the list of node properties, select the property that you want to edit. You can use the
search box on the upper right to find the property by name.
5. Click the Edit Property icon.
6. In the Edit Agent Property window, update the value of the property.
7. Click Save.

You can copy the configuration to other nodes, to the tier, or apply it to the entire application.
To register a node property

1. In the left navigation pane, click Servers - > App Servers -> <tier> -> <node>. The Node
Dashboard opens.
2. In the Node Dashboard, click Agents->Configure The App Server Agent Configuration
window opens.
3. In the left panel, select the application, tier, or node for which you want to register a node
property.
4. Select Use Custom Configuration.
5. Click the + plus icon at the top of the list of current node properties.
6. In the Create Agent Property window, enter the values for:
the property name
a description of the property
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6.

the type from the drop-down menu
the value of the property
To find a list of the available properties with the appropriate values, see App Agent
Node Properties Reference or App Agent Node Properties Reference by Type.
7. Click Save.
You can copy the configuration to other nodes, to the tier, or apply it to the entire application.
To apply the configuration to all nodes

If you just Save but do not click Apply to All Nodes, the new configuration applies to new nodes
going forward but does not overwrite custom configuration for existing nodes.
If you are configuring at the application level, click Apply to All Nodes if you want the new
configuration to overwrite all nodes in the entire application, including nodes with custom
configuration. This erases the previous custom configurations for the application.
If you are configuring at the tier level, click Apply to All Nodes in this tier if you want the new
configuration to overwrite all nodes in the tier including nodes with custom configuration. This
erases the previous custom configurations for the tier.
Learn More

App Agent Node Properties Reference
Hierarchical Configuration Model
App Agent Node Properties Reference

This reference page contains information about app agent node properties. The properties are
listed in alphabetical order.
adaptive-callgraph-granularity
ado-new-resolvers
api-thread-activity-timeout-in-seconds
api-transaction-timeout-in-seconds
aspdotnet-mvc-naming-controlleraction
async-tracking
async-transaction-demarcator
bci-log-config
boot-amx
callgraph-granularity-in-ms
capture-404-urls
capture-error-urls
capture-raw-sql
capture-set-status
capture-spring-bean-names
collect-user-data-sync
collection-capture-period-in-minutes
disable-custom-exit-points-for
dev-mode-suspend-cpm
disable-exit-call-correlation-for
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disable-exit-call-metrics-for
disable-percentile-metrics
disabled-features
dont-show-packages
downstream-tx-detection-enabled
enable-default-http-error-code-reporter
enable-info-point-data-in-snapshots
enable-instance-monitoring
enable-interceptors-for-security
enable-json-bci-rules
enable-object-size-monitoring
enable-soap-header-correlation
enable-startup-snapshot-policy
enable-transaction-correlation
enable-xml-bci-rules
end-to-end-message-latency-threshold-millis
find-entry-points
force-hotspot-if-diag-session
heap-storage-monitor-devmode-disable-trigger-pct
hotspot-collect-cpu
jdbc-callable-statements
jdbc-connections
jdbc-dbcam-integration-enabled
jdbc-prepared-statements
jdbc-resultsets
jdbc-statements
jmx-appserver-mbean-finder-delay-in-seconds
jmx-rediscover-mbean-servers
jrmp-enable
log-request-payload
maximum-activity-trace-stack-depth
max-business-transactions
max-call-elements-per-snapshot
max-concurrent-snapshots
max-jdbc-calls-per-callgraph
max-jdbc-calls-per-snapshot
max-service-end-points-per-node
max-service-end-points-per-thread
max-urls-per-error-code
min-duration-for-jdbc-call-in-ms
min-load-per-minute-diagnostic-session-trigger
minimum-age-for-evaluation-in-minutes
minimum-number-of-elements-in-collection-to-deep-size
minimum-size-for-evaluation-in-mb
on-demand-snapshots
percentile-method-option
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percentiles-to-report
rest-num-segments
rest-transaction-naming
rest-uri-segment-scheme
rmqsegments
show-packages
slow-request-deviation
slow-request-monitor-interval
slow-request-threshold
spring-integration-receive-marker-classes
thread-correlation
thread-correlation-classes
thread-correlation-classes-exclude
thread-cpu-capture-overhead-threshold-in-ms
websocket-entry-calls-enabled
adaptive-callgraph-granularity

Description: This property enables adaptive snapshots. The call graph granularity for adaptive
snapshots is based on the average response time for the business transaction during the last one
minute and is thus adaptive. The following distribution is used:
Granularity of 10 ms for average response time of <= 10 seconds
50 ms for 10 to 60 seconds
100 ms for 60 to 600 seconds
200 ms for > 600 seconds
Type: Boolean
Default value: false
Platform: Java, .NET
ado-new-resolvers

Description: Enable database detection and naming for ODP.NET backends labeled
"Unknown0".
Type: Boolean
Default value: true
Platform: .NET
api-thread-activity-timeout-in-seconds

Description: This property provides a time-out value that comes into play when you have added
global transactions to your application using APIs from the AppDynamics SDK. In the event that
the added transaction spawns additional threads that do not return or complete, this property
provides a safety valve time-out value. The value is in seconds. The removeCurrentThread
method is invoked after the specified time out period.
Type: Integer
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Default value: 300 seconds
Range: Minimum =1; Maximum=3600
Platform: Java
api-transaction-timeout-in-seconds

Description: This property provides a time-out value that comes into play when you have added
global transactions to your application using APIs from the AppDynamics SDK. In the event that
the added transaction does not return or complete, this property provides a safety valve time-out
value. The time-out value is in seconds. The endTransaction method is invoked after the specified
time-out period.
Type: Integer
Default value: 300 seconds
Range: Minimum=1; Maximum=3600
Platform: Java
aspdotnet-mvc-naming-controlleraction

Description If set to true, this property configures the agent to identify ASP.NET MVC business
transactions as Controller/Action. See Identify MVC Transactions by Controller and Action.
Type: Boolean
Default value: false
Platform: .NET
async-tracking

Description: Enable detection of asynchronous exit points. See Monitor Async Transactions for
.NET.
3.9.0 and 3.9.1 only: Also enable thread correlation for for ThreadPoolQueueUserWorkItem.
Type: Boolean
Default value: false
Platform: .NET
async-transaction-demarcator

Description: This class name and method name combination marks the end of an asynchronous
distributed transaction.
Use the format ClassName/MethodName. For example, foo/bar where foo is the class name and
bar is the method name.
Type: String
Default value: none
Platform: Java
bci-log-config
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Description: Use this property to configure the bytecode transformer log (BCT log). This log
shows what AppD instruments and what classes are loaded in the JVM. The initial file (the 0.log) is
saved to preserve the context of the server start up and is not rolled over. The subsequent files
rotate. The format of the file name is ByteCodeTransformer.<timestamp>.<N>.log. The time stamp
is represented as YYYY_MM_DD_HH_mm_ss. N increments starting from zero.
For example:
ByteCodeTransformer.2012_09_12_20_17_57.0.log

Because the file size is checked every 15 seconds, the files may be a bit larger than the specified
threshold value before they are rolled over.
The first log file generated is named as follows:ByteCodeTransformer.<timestamp>.0.log
The value for this property is of the format: "20,5,4".
Type: String
Default value: 20,5,4
Example:
For value = 20,5,4
20 = size, in MB, of the first log file, the .0 version
5 = size in MB for each subsequent rolling file
4 = the number of ByteCodeTransformer log files to keep
Platform: Java
boot-amx

Description: If set to true, enables support for Glassfish AMX MBeans. See GlassFish Startup
Settings for more information about Glassfish server support.
Type: Boolean
Default value: true
Platform: Java
callgraph-granularity-in-ms

Description: Specifies the granularity for call graphs for this node. The global configuration is
ignored if this property is used. This value is ignored if the adaptive-callgraph-granularity property
is set to true. A value of zero (default) means the global configuration (from Configure -->
Instrumentation --> Call Graph Settings) is used. Does not need a restart.
Type: Integer
Default value: 0 (zero)
Range: Minimum=0; Maximum=5000
Platform: Java, .NET
capture-404-urls
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Description: This property disables or enables the capture of the URLs causing 404 errors. The
URLs are reported as ERROR events every 15 minutes and are viewable through the Event
Viewer. The JVM needs a restart if retransformation is not supported for the JVM version.
404 errors usually mean that no application code is executed, so there is nothing to snapshot.
You can get insight into the 404 error by setting this property to true. It reports all the URLs which
caused 404 error.
The capture-404-urls node property is deprecated in AppDynamics v. 3.6 and replaced with
capture-error-urls.
Type: Boolean
Default value: false
Platform: Java
capture-error-urls

Description: This property enables or disables the capture of the following HTTP errors:
401 - Unauthorized
500 - Internal Server Error
404 - Page Not Found
All other error codes are put in a generic HTTP error code bucket.
For these 4 categories, the agent collects URLs, limited to 25 per category per minute, and sends
an event out every 5 minutes.
You can see these URLs when you drill down on an error code by clicking Troubleshoot -> Errors
-> Exceptions tab -> HTTP Error Codes.
Type: Boolean
Default value: true
Platform: Java
capture-raw-sql

Description: If capture-raw-sql is enabled, SQL calls with dynamic parameters (i.e., question mark
parameters) are captured by the agent and shown in the Controller UI with the dynamic
parameters bound to their runtime values.
For example, consider Java code that constructs a SQL call as follows:
stmt = new PreparedStatement("select * from user where ssn = ?")
stmt.bind(1, "123-123-1234")
stmt.execute()

With capture-raw-sql enabled, AppDynamics captures the SQL call in the following form:
select * from user where ssn = '123-123-1234'
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If capture-raw-sql is disabled, the SQL call appears with question mark parameters not bound to
values.
Disabling capture-raw-sql and using question mark parameters in SQL prepared statements give
you a mechanism for preventing sensitive data from appearing in the Controller UI.
It is important to note that the sensitive values must be parameterized in the original, prepared
statement form of the SQL statement, as shown above. The following statement would result in the
potentially sensitive information (the ssn value) appearing in the UI whether capture-raw-sql is enabled
or disabled.
stmt = new PreparedStatement("select * from user where ssn ='123-123-1234'")

If you change this node property in an environment that is using the IBM JVM, you need to restart
the JVM. This is because the feature requires retransformation of certain JDBC classes, which is
not possible with the IBM agent.
Setting the option as an agent property affects the SQL capture mode for the node. You can
configure the behavior for all nodes using the Capture Raw SQL option described in Configure Call
Graphs.
Type: Boolean
Default value: false
Platform: Java, .NET
capture-set-status

Description: Directs the agent to capture errors where the webservice is using setStatus() to send
back an error. By default only sendError() is instrumented by the agent.
Type: Boolean
Default value: false
Platform: Java
capture-spring-bean-names

Description: New for 3.8.1 When a class is mapped to multiple Spring bean names, by default
only the name of the first Spring bean found displays. This can be misleading. For example, when
you see a call graph for web service A that has Spring beans from web service B. Setting this
property to false shows only the class name when these conflicts occur and does not show the
Spring bean name.
Type: Boolean
Default value: true
Platform: Java
collect-user-data-sync

Description: Collect user data from diagnostic POJO data collectors synchronously. Does not
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require a restart.
Type: Boolean
Default value: true
Platform: Java
collection-capture-period-in-minutes

Description: Total interval in minutes since server restart for which collections are captured for
leak evaluation. The property takes effect only after the node restart.
Type: Integer
Default value: 30
Range: Minimum=5; Maximum=N/A
Platform: Java
disable-custom-exit-points-for

Description: There is a limited set of "custom" exit points configured by default. You can disable
these preconfigured custom exit points by specifying the type here using this property. Allowed
values are: SAP, Mail, LDAP, MongoDB. For multiple values, use a comma separated list.
Type: String
Default value: none
Platform: Java
dev-mode-suspend-cpm

Description: The maximum number of transactions monitored per minute during development
mode before the system switches out of development mode into normal operation mode.
Type: Integer
Default value: 500

Range: Minimum=0; Maximum=N/A
Platform: Java
disable-exit-call-correlation-for

Description: Disable exit call correlation for a specific type of call. For example, HTTP, JMS, RMI.
By default all exit call correlations are enabled.
Type: String
Default value: none
Platform: Java, .NET
disable-exit-call-metrics-for

Description: Disables exit call monitoring for a specific type of exit call; for example, HTTP, JMS,
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WEB_SERVICE. If this property is set, the average data (calls/min, avg response time) for the
specific exit call type is not collected. However, for a snapshot all details are collected. Set this
property if the application makes a large number of exit calls per transaction and the avg metrics
are not important.
For lists of backends that are automatically discovered see Backend Monitoring.
Type: String
Default value: By default all exit call metrics are enabled.
Platform: Java, .NET
disable-percentile-metrics

Description: Percentile metrics for business transaction response time can be displayed in the
Metric Browser or Custom Dashboard. Percentiles are generally a better indicator than averages
because they are not sensitive to outliers while averages can get distorted. Enable this property if
you want to view the percentile metrics. In versions prior to 3.9, this property is used in conjunction
with the percentiles-to-report node property where you can change the percentile point to report.
You can change this property in the app-agent-config.xml file or from within the UI.
Percentile metrics can be interpreted as follows: the 95th percentile point indicates that 95% of all
response times were less than the metric value. It provides a sense of how the response times are
distributed. For example if the metric Observed (Average) or percentile value is 300ms, it implies
that 95% of the business transaction response times are less than 300ms, and therefore implies
that 95% of the business transaction response times are within acceptable ranges. It also implies
that 5% of the requests have been taking more time and could be a cause for concern.
Under certain circumstances, you may want to change how the percentile is calculated. For more
information, see percentile-method-option node property.
Changes to this property do not require that you restart the agent.
Type: Boolean, true or false
Default value: New in 3.9 By default this property is set to 'false' and all percentile metrics are
enable. When set to 'false', the 95th percentile metrics are captured and reported.
Platform: Java
disabled-features

Description: New in 3.9.2 Specifies types of data for which agent reporting should be suppressed.
This property provides the ability to disable data collection mechanisms at the agent, enabling
application owners to limit data reported by the agent for security or privacy reasons. The
configuration you perform here, as an agent configuration file property, overrides any Controller
configuration that affects the data.
As identified in the configuration, the data categories you can disable are:
LOG_PAYLOAD: Log payload, i.e., the node property "log-request-payload"
RAW_SQL: Raw SQL statements
CUSTOM_EXIT_SNAP_DATA: Snapshot data in custom exits
METHOD_INV_DATA_COLLECTOR: Diagnostic data collectors — method invocation
HTTP_DATA_COLLECTOR: Diagnostic data collectors — HTTP requests
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INFO_POINT: Information points
ALL: All of the above
NONE: None of the above (this is equivalent to the default agent behavior)
You specify the data category as the value attribute of the disabled-features property. You can
have multiple data categories excluded by listing each separated by commas. For example
<app-agent-configuration>
<configuration-properties>
....
<property name="disabled-features"
value="RAW_SQL,LOG_PAYLOAD"/>
</configuration-properties>
.....
</app-agent-configuration>

Type: String
Default value: None
Platform: Java
dont-show-packages

Description: Do not show these packages / class names in addition to the ones configured in the
global call graph configuration, for the call graphs captured on this node. Does not need a restart.
Type: String
Default value: none
Platform: Java, .NET
downstream-tx-detection-enabled

Description: If the agent cannot reach the controller for a prolonged period, it turns off most
services and notifies the continuing tiers that upstream transaction was detected and is not being
monitored. Set this property to true to enable the continuing tiers to detect their own transactions in
the event of network failure on the upstream tiers.
Type: Boolean
Default value: false
Platform: Java, .NET
enable-default-http-error-code-reporter

Description: This property disables or enables automatic HTTP error code reporting for error
codes between 400 - 505.
Type: Boolean
Default value: true
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Platform: Java, .NET
enable-info-point-data-in-snapshots

Description: This property disables or enables the capture of information point calls in snapshots.
When this property is set to true, information point calls appear in the User Data section of the
snapshot.
Type: Boolean
Default value: false
Platform: Java, .NET
enable-instance-monitoring

Description: This property enables or disables Instance tracking on this node. Does not need a
JVM restart.
Type: Boolean
Default value: false
Platform: Java
enable-interceptors-for-security

Description: This property enables or disables security interceptors on this node. Set this property
to true in environments where the Java 2 Security Manager is enabled. If the Java 2 Security
Manager is enabled, and this property is not set to true, then the agent will encounter
SecurityExceptions, and will not be able to collect the data that it should. Does not need a JVM
restart.
Type: Boolean
Default value: false
Platform: Java
enable-json-bci-rules

Description: Set this property to true to enable JSON bytecode instrumentation rules.
AppDynamics instruments the get and getString methods within the package/class org.json.JSON
Object when you set this value to true. Needs a JVM restart.
Type: Boolean
Default value: true. This only affects new applications; applications created with a 3.7.x controller
will still have this property set by default to false.
Platform: Java
enable-object-size-monitoring

Description: This property is related to Automatic Leak Detection (ALD) and enables or disables
Object Size monitoring on this node. Changing this property does not need a JVM restart. ALD is
supported for JVM version 1.6 and up.
Type: Boolean
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Default value: false
Platform: Java
enable-soap-header-correlation

Description: This property controls correlation with web service transactions. When enabled, a
node which receives a web service transaction may correlate that transaction with any
downstream transactions. The ability to correlate depends on the particular web
services framework. When disabled, the agent will not perform correlation through any web service
tiers.
Type: Boolean
Default value: false
Platform: Java, .NET

enable-spring-integration-entry-points
Description: This property disables or enables the default detection of Spring Integration entry
points. Set to 'false' to disable.
Default detection of Spring Integration entry points is based on MessageHandler. In cases where a
lot of application flow happens before the first MessageHandler is executed,
set this property to 'false',
configure suitable POJO entry points,
and specify the property spring-integration-receive-marker-classes.
See also Spring Integration Support.
Type: Boolean
Default value: true
Platform: Java
enable-startup-snapshot-policy

Description: This property disables or enables the policy for start-up transaction snapshot. This
means snapshots are collected for all BTs for all invocations for the first 15 minutes of an
application server start.
Type: Boolean
Default value: false
Platform: Java, .NET
enable-transaction-correlation

Description: This property disables or enables transaction correlation. It does not require a
restart.
Type: Boolean
Default value: true
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Platform: Java, .NET
enable-xml-bci-rules

Description: This property enables Java XML Binding and DOM Parser bytecode instrumentation
rules. Set to true to enable. The change takes effect after a JVM restart.
Type: Boolean
Default value: true. This only affects new applications; applications created with a 3.7.x controller
will still have this property set by default to false.
Platform: Java
end-to-end-message-latency-threshold-millis

Description: Enables end-to-end message latency monitoring for distributed asynchronous
systems by setting up a threshold. Any message taking more time than the threshold is viewable
through the Event Viewer.
Type: Integer
Default value: 0
Range: Minimum=0; Maximum=36000
Platform: Java
find-entry-points

Description: Set this property to true to log all potential entry points that are hitting instrumented
exit points or loggers to the Business Transactions log file.
Use this property when you suspect that some traffic is not being detected as business
transactions.
Note that this property should be enabled for debugging only. It is strongly recommended to
disable this property in production setup by changing the value from true to false.
Type: Boolean
Default value: false
Platform: Java, .NET
force-hotspot-if-diag-session

Description: Set this property to true to collect hotspot snapshots for all transactions for which
there is a manual diagnostic session defined. See also hotspot-collect-cpu.
Type: Boolean
Default value: false
Platform: Java
heap-storage-monitor-devmode-disable-trigger-pct

Description: The maximum Java heap utilization percentage for development mode. If the heap
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utilization exceeds this value, Development mode is automatically disabled.
Type: Integer
Default value: 90
Range: Minimum=0, Maximum=100
Platform: Java
hotspot-collect-cpu

Description: Set this property to true to collect CPU time, instead of real time, within hotspot
snapshots, if the snapshots are collected as a result of the force-hotspot-if-diag-session=true prop
erty.
Type: Boolean
Default value: false
Platform: Java
jdbc-callable-statements

Description: Use this property to indicate the implementation classes of the java.sql.CallableState
ment interface that should be instrumented. For example, to instrument calls to Times Ten (an
unsupported database), you could set this property to the following:
com.timesten.jdbc.JdbcOdbcCallableStatement

Type: String
Default value: none
Platform: Java
jdbc-connections

Description: Use this property to indicate the implementation classes of the java.sql.Connection in
terface that should be instrumented. For example, to instrument calls to Times Ten (an
unsupported database), you could set this property to the following:
com.timesten.jdbc.JdbcOdbcConnection

Type: String
Default value: none
Platform: Java
jdbc-dbcam-integration-enabled

Description: New for AppDynamics for Databases 2.8 Use this property to integrate the Java
Agent with AppDynamics for Databases. When this property is enabled, you can link to
AppDynamics for Databases from a Transaction Snapshot Flow Map where an exit call is to an
Oracle database, and analyze the SQL statements that were running at the time of the snapshot.
This property works in conjunction with the AppDynamics for Databases license and database
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collector that has been previously set up. Integration must also be setup from the Admin pages of
the Controller UI. For more information, see Integrate and Use AppDynamics for Databases with
AppDynamics Pro.
Changes to this property do not require a JVM restart for JDK 1.6 and higher. Older 1.5 JVMs do
not support class reloading, so for those environments a restart is required.
Type: Boolean
Default value: false
Platform: Java
jdbc-prepared-statements

Description: Use this property to indicate the implementation classes of the java.sql.PreparedStat
ement interface that should be instrumented. For example, to instrument calls to Times Ten (an
unsupported database), you could set this property to the following:
com.timesten.jdbc.JdbcOdbcPreparedStatement

Type: String
Default value: none
Platform: Java
jdbc-resultsets

Description: New in 3.9 Use this property to indicate the implementation classes of the
java.sql.ResultSet interface that should be instrumented. For example, to instrument calls to Times
Ten (an unsupported database), you could set this property to the following:
com.timesten.jdbc.JdbcStatement

Type: String
Default value: none
Platform: Java
jdbc-statements

Description: Use this property to indicate the implementation classes of the java.sql.Statement
interface that should be instrumented. For example, to instrument calls to Times Ten (an
unsupported database), you could set this property to the following:
com.timesten.jdbc.JdbcOdbcStatement

Type: String
Default value: none
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Platform: Java
jmx-appserver-mbean-finder-delay-in-seconds

Description: When an app server starts up, the associated MBean server starts and the MBeans
are discovered. The timing of these activities varies by app server and by configuration. If this
activity is not completed in the time that the AppD agent is expecting to discover the MBeans, then
the MBean Browser will not show them. Using this node property, you can delay the discovery of
MBeans to make sure that agent discovers all the domains after complete start up of the app
server. For example, you can set the delay to a time which is 1.5 times of the server startup time.
The default delay for AppD agent is two minutes.
Type: Numeric, seconds
Default value: 200
Platform: Java
jmx-rediscover-mbean-servers

Description: When an app server starts up, the associated MBean server starts and the MBeans
are discovered. The timing of these activities varies by app server and by configuration. If this
activity is not completed in the time that the AppD agent is expecting to discover the MBeans, then
the MBean Browser will not show them. Using this node property, you can trigger the rediscovery
of MBeans to make sure that the agent discovers all the domains after complete start up of the
app server. Set this property to 'true' and restart the JVM/server.
Type: Boolean
Default value: false
Platform: Java
jrmp-enable

Description: This property enables or disables AppDynamics support for Sun RMI over Java
Remote Protocol (JRMP). You should test Sun RMI JRMP support in a staging environment before
using it on production systems. Enable Sun JRMP support by setting this property to 'true'.
Type: Boolean
Default value: false
Platform: Java

leak-diagnostic-interval-in-minutes
Description: Interval at which diagnostic data, content summary and activity trace, is captured for
leaking collections.
Type: Integer
Default value: 30
Range: Minimum=2; Maximum=N/A
Platform: Java
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log-request-payload

Description: Set this property to true to log the request payload (HTTP
parameters/cookies/session keys etc) as part of a transaction snapshot. New in 3.9.2,
log-request-payload includes logging of WCF HTTP parameters for .NET.
Type: Boolean
Default value: false
Platform: Java, .NET
maximum-activity-trace-stack-depth

Description: This determines the depth of the stack trace to capture as part of an activity trace
session. By default, the size of the code paths for OIT (Object Instance Tracking), ALD (Automatic
Leak Detection) and MIDS (Memory Intensive Data Structures) are set to 10. To increase this limit,
use this property.
A larger depth has higher overhead on the system. AppDynamics recommends that you
increase the default value of this property only temporarily, and remove it or set it back to
10 once you get the desired output.
Type: Integer
Default: 10
Platform: Java
max-business-transactions

Description: Sets a limit on the number of business transactions discovered once an agent is
started. The limit helps to ensure that the Controller I/O processing capability and agent memory
requirements are appropriate for a production environment.
Warning: Contact AppDynamics Support before changing this setting.
See All Other Traffic Business Transaction.
Type: Integer
Default value: 50
Range: Minimum=N/A; Maximum=200
Platform: Java, .NET
max-call-elements-per-snapshot

Description: This property represents the maximum number of elements that are collected for any
call graph for a snapshot. When the limit is reached, the agent stops collecting more data for this
call graph, reports what has been collected to that point, and marks the call graph with a warning
that the limit was reached. it is not recommended to dramatically increase this number as it may
have overhead implications.
Type: Integer
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Default value: 5000
Platform: Java, .NET
max-concurrent-snapshots

Description: The maximum number of total snapshots that are allowed, including continuing
transactions. When the queue goes over the value set, additional snapshots are dropped. This
property is ignored while in Development mode.
Type: Integer
Default value: 20 (v.3.5.x)
Range: Values must be positive integers. No other constraints.
Platform: Java, .NET
max-jdbc-calls-per-callgraph

Description: Maximum number of JDBC/ADO.NET exit-call stack samples per call graph. Only
queries taking more time than the value of min-duration-for-jdbc-call-in-ms are reported. Changing
the value does not require a restart.
Type: Integer
Default value: 100
Range: Minimum=1; Maximum=1000
Platform: Java, .NET
max-jdbc-calls-per-snapshot

Description: Maximum number of JDBC/ADO.NET exit calls allowed in a snapshot. Calls after the
limit are not recorded. Changing the value does not require a restart.
Type: Integer
Default value: 500
Range: Minimum=1; Maximum=5000
Platform: Java, .NET
max-service-end-points-per-node

Description: Maximum total number of service endpoints that can be defined on a single node.
Increasing the value of this property enables more service end points to be defined on a particular
node. This number ensures a maximum limit on overhead due to service endpoints on an agent
such that only the service endpoints that are within the limit are evaluated.
Type: Integer
Default value: 100
Range: Minimum=0; Maximum=N/A
Platform: Java, .NET
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max-service-end-points-per-thread

Description: Maximum number of service endpoints that can defined on a single thread of
transaction execution. If this property is set to the default value of one and there are two service
endpoints defined that impact one specific transaction, at any point in time only the one service
endpoint will be evaluated. If a second service endpoint is detected in context of the first one, the
second is ignored. But, if the second service endpoint starts after the first one ends, the second
service endpoint will be evaluated. Increase this property to monitor additional service endpoints
on a thread. This number ensures a maximum limit on overhead and number of metrics due to
service endpoints on each thread execution.
Type: Integer
Default value: 1
Range: Minimum=0; Maximum=N/A
Platform: Java, .NET
max-urls-per-error-code

Description: Increases the number of URLs the agent can track that produced a certain error.
Once the maximum has been reached, all remaining errors are classified as "unknown."
Type: Numeric
Default value: 50
Platform: Java
min-duration-for-jdbc-call-in-ms

Description: A JDBC/ADO.NET call taking more time than the specified time (in milliseconds)is
captured in the call graph. The query continues to show up in a transaction snapshot. Setting this
value too low (< 10ms) may affect application response times. Changing the value does not
require a restart
Type: Integer
Default value: 10
Range: Minimum=0; Maximum=N/A
Platform: Java, .NET
min-load-per-minute-diagnostic-session-trigger

Description: Indicates the number of requests per Business Transaction to evaluate before
triggering a diagnostic session. This is useful to prevent diagnostic sessions when there is not
enough load.
Type: Integer
Default value: 10
Range: Minimum=N/A; Maximum=N/A
Platform: Java, .NET
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minimum-age-for-evaluation-in-minutes

Description: Automatic Leak Detection (ALD) tracks all frequently used Collections. For a
Collection object to be identified and monitored it must meet the conditions defined by the ALD
properties. This property is the first criteria that needs to be met. The value is the minimum age of
the Collection in minutes. The property takes effect after node restart.
From the point the collection is captured, it is monitored if it is still available for the specified period
without getting
garbage collected. If it survives then it is evaluated for size checks and if it meets the criteria then
it is monitored for long term growth in size.
Warning: If you reduce the default there may be a performance hit on the CPU and memory
because AD needs to process more collections.
Type: Integer
Default value: 30
Range: Minimum=5; Maximum=N/A
Platform: Java
minimum-number-of-elements-in-collection-to-deep-size

Description: Automatic Leak Detection (ALD) tracks all frequently used Collections. For a
Collection object to be identified and monitored for it must meet the conditions defined by the ALD
properties. This property sets the number of elements threshold.
Warning: If you reduce the default there may be a performance hit on the CPU and memory
because AD is processing more collections.
Type: Integer
Default value: 1000
Platform: Java
minimum-size-for-evaluation-in-mb

Description: Automatic Leak Detection (ALD) tracks all frequently used Collections. For a
Collection object to be identified and monitored it must meet the conditions defined by the ALD
properties. This property sets the minimum initial size in megabytes for a collection to qualify for
monitoring. The collection must also survive for the period specified in the
minimum-age-for-evaluation-in-minutes property.
Warning: If you reduce the default there may be a performance hit on the CPU and memory
because AD is processing more collections.
Type: Integer
Default value: 5
Range: Minimum=1; Maximum,=N/A
Platform: Java
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on-demand-snapshots

Description: Collect snapshots for all business transactions executed in this node. Does not need
a restart. This property is ignored while in Development mode.
Type: Boolean
Default value: false
Platform: Java, .NET
percentile-method-option

Description: You can choose one of two different algorithms to calculate percentiles in
AppDynamics:
P Square algorithm (default): This option consumes the least amount of storage and incurs the
least amount of CPU overhead. The accuracy of the percentile calculated varies depending on the
nature of the distribution of the response times. You should use this option unless you doubt the
accuracy of the percentiles presented.
Quantile Digest algorithm: This option consumes slightly more storage and CPU overhead but may
offer better percentiles depending on how the response times are distributed.
This property is used in conjunction with the disable-percentile-metrics and in versions prior to 3.9
the percentiles-to-report node properties.
Changes to this property do not require that you restart the agent.
Type: Numeric
Values: 1 or 2
Default value: By default this property is set to 1, which uses the P Square algorithm to calculate
the percentile.
Platform: Java
percentiles-to-report

Description: Deprecated in version 3.9. In versions prior to 3.9, percentile metrics for business
transaction response time can be displayed in the Metric Browser or Custom Dashboard. By
default, the system will capture the 95th percentile metrics. You can change the percentile
captured here. If you change this value from its default, you will need to register the property as
described in To register a property. This property is used in conjunction with the disable-percentilemetrics node property which must be set to 'false' in order to capture the percentile metrics. Under
certain circumstances, you may want to change how the percentile is calculated. For more
information, see the percentile-method-optionnode property.
Changes to this property do not require that you restart the agent.
Type: Numeric
Range: Minimum=1; Maximum=99
Default value: By default this property is set to 95.
Platform: Java
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rest-num-segments

Description: The property, rest-num-segments specifies the n in the first-n-segments parameter
in rest-uri-segment-scheme. If this property is 0 or less, then the value of this property is ignored.
The value of this property is also ignored if rest-uri-segment-scheme=full.
Type: String
Default value: 2
Platform: Java
rest-transaction-naming

Description: This node property accepts any or all of the following parameters in string form. Anyt
hing that does not match a parameter is treated as text that is appended to the business
transaction name. Properties can be separated with any character.
The agent takes each parameter and fills in the proper value based on the annotations and
properties of the Java class:
{class-name}: The app agent will fill in the name of the Java class mapped to the REST
resource
{method-name}: The method being called
{class-annotation}: Path annotation applied to the class
{method-annotation}: Method annotation applied to the method (does not always exist)
{rest-uri}: URI of the REST resource. The REST URI is further configured using the following
properties:
rest-uri-segment-scheme
rest-num-segments
{http-method}: HTTP method
Type: String
Default value: {rest-uri}.{http-method}
Platform: Java
Examples: Using Default Settings and Using rest-transaction-naming Properties
rest-uri-segment-scheme

Description: The property, rest-uri-segment-scheme has three valid values: first-n-segments,
last-n-segments, and full. This property indicates how many segments of the URI to use for the
URI in {rest-uri}. This option is case-sensitive. If the value of this property is full, then the value of r
est-num-segments is ignored.
Type: String
Default value: first-n-segments
Platform: Java
rmqsegments

Description: The App Agent for .NET (agent) automatically discovers RabbitMQ remote services.
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Use the rmqsegments node property to refine the queue backend name to include some or all
segments of the routing key. You must be familiar with your implementation RabbitMQ exchanges
and routing keys. See RabbitMQ Exchanges and Exchange Types.
The RabbitMQ routing key is a string. The agent treats dot-separated (".") substrings of the routing
key as segments. Set the value for rmqsegments to an integer that represents the number of
routing key segments to include in the name. For more information, see To refine RabbitMQ
backend naming.
Type: Numeric
Values: Integer representing the number of routing key segments to include in the name.
Default Value: 0
Platform: .NET
show-packages

Description: For the call graphs captured on this node, show the specified packages or class
names in addition to the ones configured in the global call graph configuration. Does not need a
restart.
Type: String
Default value: none
Platform: Java, .NET
slow-request-deviation

Description: The value in milliseconds for the deviation from the current average response time.
This setting is used for evaluation of slow in-flight transactions. Also see the
slow-request-threshold property for more details.
Type: Integer
Default value: 200
Range: Minimum=10; Maximum=3600
Platform: Java, .NET
slow-request-monitor-interval

Description: In-flight requests are checked for slowness in the interval specified by this property.
The value is specified in milliseconds.
Type: Integer
Default value: 100
Range: Minimum=0; Maximum=3600
Platform: Java, .NET
slow-request-threshold

Description: In-flight requests taking more time than this threshold (in ms) with a deviation greater
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than the slow-request-deviation property from the current average response time are monitored to
capture hot spots.
Type: Integer
Default value: 500
Range: Minimum=0; Maximum=3600
Platform: Java, .NET

spring-integration-receive-marker-classes

Description: Use this property to specify the class and method you have identified as suitable
POJO entry points for Spring Integration.
Based on the MessageHandler interface, the App Agent for Java by default automatically
discovers exits for all channels except 'DirectChannel.' In cases where a lot of application flow
happens before the first MessageHandler is executed,
set enable-spring-integration-entry-points=false,
configure suitable POJO entry points,
and declare each suitable POJO entry point class/method in this property spring-integrationreceive-marker-classes.
If the application code polls for messages in a loop, the span of each loop iteration is tracked as a
transaction. Tracking begins when the loop begins and end it when the iteration ends. To
safeguard against cases where pollableChannel.receive() is not called inside a loop, specify this
property for each class/method combination that polls messages in a loop.
After setting this property, restart the application server for changes to this property to take effect.
See also Spring Integration Support.
Type: Comma-separated string of fully-qualified class /method name, such as
spring-integration-receive-marker-classes = <fully qualified name of class/method>,<> ....
Example: For example, to enable tracking for the following:
class MessageProcessor
{
void process()
{
while(true)
{
Message message = pollableChannel.receive()
}
}
}

set this property as follows:
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spring-integration-receive-marker-classes = MessageProcesser/process

Platform: Java
thread-correlation

Description: New in 3.9.2, Enable thread correlation for the .NET Agent. See Enable Thread
Correlation for .NET.

Type: Boolean
Default value: false
Platform: .NET
thread-correlation-classes

Description: For multi-threaded applications, use this property to configure classes to be included
in Java thread correlation when simple prefix-matching (matching on STARTSWITH) is sufficient
to identify the classes.
The thread-correlation-classes property specifies the classes to include for thread correlation. This
property can be used together with the thread-correlation-classes-exclude property.
The configured correlation takes effect without requiring a restart of the managed application.
Also see: Configure Multi-Threaded Transactions for Java.
Type: Comma-separated string of fully-qualified class names or package names
Default value: none
Platform: Java
thread-correlation-classes-exclude

Description: For multi-threaded applications, use this property to configure classes to be excluded
in Java thread correlation when simple prefix-matching (matching on STARTSWITH) is sufficient
to identify the classes. This property specifies the classes to exclude from thread correlation. This
property can be used in conjunction with the thread-correlation-classes node property.
The configured correlation takes effect without requiring a restart of the managed application.
Also see: Configure Multi-Threaded Transactions (Java only).
Type: Comma-separated string of fully-qualified class names or package names
Default value: none
Platform: Java
thread-cpu-capture-overhead-threshold-in-ms

Description: Involved in BT CPU Monitoring. The is the time allotted to collect and calculate
Thread CPU Time for 1000 iterations. You might need to increase this value if you see a symptom
where there is no CPU usage information in the BT overview or in any of the snapshots. Restart is
needed after changing this value.
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Also see: SUN JDK 1.6 on Linux
INFO level logs similar to the following will be logged if the agent is unable to collect the Thread
CPU Time during the allotted time. As you can see in the logs below, the agent stops monitoring
thread CPU time when this happens:
====================================
[Thread-0] 23 Oct 2013 17:07:18,704 INFO XMLConfigManager - Full Agent
Registration Info Resolver using node name [app07.com]
..
[Thread-0] 22 Oct 2013 14:19:26,346 INFO JVMThreadCPUTimeCalculator - Disabling
BT CPU Monitoring. Time taken to calculate Thread CPU Time for [1000] iterations
is [15 ms] which is greater than the allowed budget of [10 ms].
..
[Thread-0] 23 Oct 2013 17:07:19,273 INFO JVMThreadCPUTimeCalculator - Disabling
BT CPU Monitoring. Time taken to calculate Thread CPU Time for [1000] iterations
is [15 ms] which is greater than the allowed budget of [10 ms].
======================================

Type: Integer
Default: 10 ms
Platform: Java
websocket-entry-calls-enabled

Description:New in 3.9 When set to false, no WebSocket entry calls are detected.
Type: Boolean
Default value: true
Platform: Java
App Agent Node Properties Reference by Type

Learn More
This topic lists the app agent node properties by type.
Type

Property

Automatic Leak Detection

minimum-age-for-evaluation-in-minutes
minimum-number-of-elements-in-collection-todeep-size
minimum-size-for-evaluation-in-mb

Bytecode injection (BCI)

bci-log-config
enable-interceptors-for-security
enable-json-bci-rules
enable-xml-bci-rules
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Object Instance Tracking (OIT )

collection-capture-period-in-minutes
enable-collection-monitoring
enable-instance-monitoring
enable-object-size-monitoring
leak-diagnostic-interval-in-minutes

JMX Property

heap-storage-monitor-devmode-disable-trigger
-pct

Transaction Monitoring

ado-new-resolvers
aspdotnet-mvc-naming-controlleraction
api-thread-activity-timeout-in-seconds
api-transaction-timeout-in-seconds
async-tracking
async-transaction-demarcator
capture-404-urls
capture-error-urls
capture-raw-sql
capture-set-status
capture-spring-bean-names
disable-custom-exit-points-for
disable-exit-call-correlation-for
disable-exit-call-metrics-for
disable-percentile-metrics
downstream-tx-detection-enabled
enable-default-http-error-code-reporter
enable-soap-header-correlation
enable-spring-integration-entry-points
enable-transaction-correlation
end-to-end-message-latency-threshold-millis
find-entry-points
jdbc-callable-statements
jdbc-connections
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jdbc-dbcam-integration-enabled
jdbc-prepared-statements
jdbc-resultsets - New in 3.9
jdbc-statements
jmx-appserver-mbean-finder-delay-in-seconds
jmx-rediscover-mbean-servers
jrmp-enable
log-request-payload
max-business-transactions
max-service-end-points-per-node
max-service-end-points-per-thread
max-urls-per-error-code
min-load-per-minute-diagnostic-session-trigger
rmqsegments
percentile-method-option
percentiles-to-report - Deprecated in version
3.9
rest-num-segments
rest-transaction-naming
rest-uri-segment-scheme
slow-request-deviation
slow-request-monitor-interval
socket-collection-bci-enable
spring-integration-receive-marker-classes
thread-correlation
thread-correlation-classes
thread-correlation-classes-exclude
max-service-end-points-per-node
max-service-end-points-per-thread
max-urls-per-error-code
websocket-entry-calls-enabled - New in 3.9
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Transaction Snapshots

adaptive-callgraph-granularity
callgraph-granularity-in-ms
dev-mode-suspend-cpm
dont-show-packages
enable-startup-snapshot-policy
force-hotspot-if-diag-session
hotspot-collect-cpu
max-call-elements-per-snapshot
max-concurrent-snapshots
max-jdbc-calls-per-callgraph
max-jdbc-calls-per-snapshot
min-duration-for-jdbc-call-in-ms
on-demand-snapshots
show-packages
slow-request-threshold
thread-cpu-capture-overhead-threshold-in-ms

Miscellaneous

collect-user-data-sync

Learn More

App Agent Node Properties Reference
Hierarchical Configuration Model
Manage App Agents
To access the AppDynamics Agents administration page
Associating App Agents with an Application
To associate an agent with a business application
Resetting App Agents to Purge Data
To reset app agents
Enabling and Disabling App Agents
To enable or disable an app agent
Deleting App Agents
To delete an app agent
Other Actions
To view the Node Dashboard of an agent
To view the machine agent on the same node as an app agent
To find the app agent version number
Learn More
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You can manage the app agents that are connected to the Controller from the App Server Agents
administration page. From this page, you can view information about an app agent, disable an app
agent, reset an app agent, and more.
To access the AppDynamics Agents administration page

There are two ways to access the page:
From the Home page, click View Agents.
In the upper right corner of the menu bar, click Settings -> AppDynamics Agents.
AppDynamics lists all agents for all business applications by default.
Associating App Agents with an Application

If you start an application server with an app agent without specifying the application with which it
is associated, the agent appears in the app agents list as an unassociated agent. You can
associate an agent with an application manually from the App Agents administration page.
To associate an agent with a business application

1. From the Agents list in the App Server Agent panel, select the unassociated app agent from
the list.
If you have a long list of agents, you can choose Agents not associated with an
Application from the View dropdown men in the upper right corner to display only app
agents that are not currently associated with an application.

2. Click Associate with Application. This button is enabled only if you select an app agent
that is connected to the Controller but not already associated with an application.
Resetting App Agents to Purge Data

Resetting the app agent purges all existing data for the agent, including metrics and discovered
transactions. You do not need to restart the application server to reset agent data.
After you have reconfigured business transaction or backend detection, you may need to reset the
agents. If new detection rules are not detecting newer transactions or backends:
1. Delete all existing transactions and backends.
See Business Transactions List Operations for information about the deleting business
transactions in the UI. See Remote Services Dashboard and Databases List and Dashboard
for information about deleting backends in the UI.
2. Use the Reset option to start the agent detecting the transactions and backends from
scratch.
Resetting an app server agent causes the Controller to:
Purge all data such as metrics, discovered Business Transactions, and so on, gathered by
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that agent.
Reset the Business Transaction limit counter to zero for that agent.
Resetting an agent flushes the in-memory business transactions, exit calls, and registration
information for the agent. It does not re-instrument or remove existing instrumentation.
After a reset, the business transactions and backends are re-registered and new metrics are
created.
You may lose a few minutes worth of data between the reset and re-registration operations.
To reset app agents

1. Navigate to the App Server Agents panel in the AppDynamics Agents administration page.
See To access the AppDynamics Agents administration page.
2. Reset app agents by either:
Clicking Reset Agents to reset all agents for this Controller.
Selecting the specific agents to reset from the list, and click Reset Selected App
Agent(s) to reset only the selected agents.
Enabling and Disabling App Agents

An app server agent polls the Controller every minute to check whether the agent is enabled or
disabled. If an App Agent for Java is disabled, it stops capturing all data except for JVM JMX
metrics such as heap memory, memory pools, garbage collection, and thread count.
Disabling an agent can help with troubleshooting. For example, it lets you easily compare the
difference in the agent's run-time overhead when capturing or not capturing data, without going
through the trouble of uninstalling the agent. Disabling the agent does not require the application
server to be shut down or restarted.
All agents connected to the Controller count against the agent license limits for that Controller.
Since a disabled agent is still connected to the Controller, even though it only reports minimal app
server-related data, it still occupies an agent license for the Controller.
To enable or disable an app agent

1. In the Controller left navigation pane, click Servers -> App Servers -> <Tier> -> <Node>.
2. In the Node Dashboard, click the Agents tab.
3. To deactivate the agent, click Agent is Off.
It takes about a minute for the operation to take effect.
To activate the agent, click Agent is On.
Deleting App Agents

Deleting an app agent in the AppDynamics Agents window removes the agent and any associated
data from the Controller database. This does not affect the instrumentation of the application
server. If the application server is still running with an app agent, or if it is subsequently restarted
with an app agent, the agent re-registers and appears again in the Controller database and in the
UI..
To completely remove an app agent completely so that it does not register again, uninstall it. See
the uninstall instructions for your agent's platform.
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To delete an app agent

1. In the AppDynamics Agents window, select an app agent.
2. Click Delete Agent from System.
Other Actions
To view the Node Dashboard of an agent

1. In the AppDynamics Agents window, select an app agent.
2. Click View Node Dashboard.
See Node Dashboard.
To view the machine agent on the same node as an app agent

1. In the AppDynamics Agents window, select the app agent in the App Server Agents list.
2. Click View Machine.
Alternatively:
1. In the navigation pane, click Servers -> App Servers -> <Tier> -> <Node>.
2. In the Node Dashboard, click the Agents tab.
3. Click the Machine Agent subtab.
To find the app agent version number

1. In the Controller left navigation pane, click Servers -> App Servers -> <Tier> -> <Node>.
2. In the Node Dashboard, click the Agents tab.
3. Click the App Server Agent subtab.
Learn More

Administer Standalone Machine Agents
Uninstall the Java Agent
Uninstall the .NET Agent
Uninstall the PHP Agent
Uninstall the Node.js Agent
Administer Standalone Machine Agents
This section covers the Standalone Machine Agent. It does not cover the embedded machine
agent included with the App Agent for .NET.
For information about how to use the Standalone Machine Agent see Standalone Machine Agent.
The Standalone Machine Agent uses a built-in hardware monitor to report metrics and hardware
utilization data. The hardware monitor is a script that writes data to STDOUT of a process. The
Standalone Machine Agent is always running and reports to the Controller once a minute.
Standalone Machine Agent Configuration Properties

Where to Configure Standalone Machine Agent Properties
Example Machine Agent controller-info.xml File
Example Startup Configuration Using System Properties
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Standalone Machine Agent Properties
Agent-Controller Communication Properties
Controller Host Property
Controller Port Property
Standalone Machine Agent Identification Properties
Application Name Property
Tier Name Property
Node Name Property
Multi-Tenant Mode Properties
Account Name Property
Account Access Key Property
Proxy Properties for the Controller
Proxy Host Property
Proxy Port Property
Other Properties
Controller SSL Enabled Property
Enable Orchestration Property
Force Agent Registration Property
Unique Host ID Property
Learn More
Where to Configure Standalone Machine Agent Properties

You can configure Standalone Machine Agent properties:
in the controller-info.xml file located in the <MachineAgent Install Directory>/conf directory
in the system properties (-D options) section in the JVM start-up script:
java options -jar jarfile arguments
The system properties override the settings in the controller-info.xml file. Note that the system
properties are case-sensitive.
Example Machine Agent controller-info.xml File
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<?xml version="1.0" encoding="UTF-8"?>
<controller-info>
<controller-host>192.10.10.10</controller-host>
<controller-port>8090</controller-port>
<controller-ssl-enabled>false</controller-ssl-enabled>
<enable-orchestration>false</enable-orchestration>
<account-name></account-name>
<account-access-key></account-access-key>
<application-name></application-name>
<tier-name></tier-name>
<node-name></node-name>
<force-agent-registration>false</force-agent-registration>
</controller-info>

Example Startup Configuration Using System Properties

A bash example. Note that the system properties are case-sensitive.
-Dappdynamics.controller.hostName=192.168.1.20
-Dappdynamics.controller.port=8090
-Dappdynamics.agent.applicationName=ACMEOnline
-Dappdynamics.agent.tierName=Inventory
-Dappdynamics.agent.nodeName=inventory1 org.tomcat.TomcatServer

Standalone Machine Agent Properties

This section describes the Standalone Machine Agentconfiguration properties, including their
controller-info-xml elements and their system property options.
Agent-Controller Communication Properties
Controller Host Property

Description: This is the host name or the IP address of the AppDynamics Controller, e.g.
192.168.1.22 or myhost or myhost.abc.com. This is the same host that you use to access the
AppDynamics browser-based user interface.
Element in controller-info.xml: <controller-host>
System Property: -Dappdynamics.controller.hostName
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Type: String
Default: None
Required: if the Enable Orchestration property is false.
If Enable Orchestration is true, and if the agent is deployed in a compute cloud instance created by
an AppDynamics workflow, do not set the Controller host unless you want to override the
auto-detected value. See Enable Orchestration Property.
Controller Port Property

Description: This is the HTTP(S) port of the AppDynamics Controller. This is the same port that
you use to access the AppDynamics browser-based user interface. If the Controller SSL Enabled
property is set to true, specify the HTTPS port of the Controller; otherwise specify the HTTP port.
See Controller SSL Enabled Property.
Element in controller-info.xml: <controller-port>
System Property: -Dappdynamics.controller.port
Type: Positive Integer
Default: The default values are 8090 for HTTP and 8181 for HTTPS.
Required: Yes, if the Enable Orchestration property is false.
If Enable Orchestration is true, and if the agent is deployed in a compute cloud instance created by
an AppDynamics workflow, do not set the Controller port unless you want to override the
auto-detected value. See Enable Orchestration Property.
Standalone Machine Agent Identification Properties

If the Standalone Machine Agent is installed on a machine that does not have an App Server
agent, configure the application name, tier name and the node name. Otherwise these
configurations are not required for the Standalone Machine Agent.
Application Name Property

Description: This is the name of the logical business application that this JVM node belongs to.
Note that this is not the deployment name(ear/war/jar) on the application server.
If a business application of the configured name does not exist, it is created automatically.
Element in controller-info.xml: <application-name>
System Property: -Dappdynamics.agent.applicationName
Type: String
Defaults: None
Required: If a registered app server agent is already installed on the same host as this machine
agent, this configuration is not required.
Tier Name Property

Description: This is the name of the logical tier that this JVM node belongs to. Note that this is
not the deployment name (ear/war/jar) on the application server.
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If a tier of the configured name does not exist, it is created automatically.
Element in controller-info.xml: <tier-name>
System Property: -Dappdynamics.agent.tierName
Type: String
Defaults: None
Required: If a registered app server agent is already installed on the same host as this machine
agent, this configuration is not required.
Node Name Property

Description: This is the name of the JVM node.
Element in controller-info.xml: <node-name>
System Property: -Dappdynamics.agent.nodeName
Type: String
Defaults: None
Required: If a registered app server agent is already installed on the same host as this
Standalone Machine Agent, this configuration is not required.
Multi-Tenant Mode Properties

If the AppDynamics Controller is running in multi-tenant mode or if you are using the AppDynamics
SaaS Controller, specify the account name and account access key for this agent to authenticate
with the Controller.
If the Controller is running in single-tenant mode (the default) there is no need to configure these
values.
Account Name Property

Description: This is the account name used to authenticate with the Controller.
If you are using the AppDynamics SaaS Controller, the Account Name is provided in the Welcome
email sent by AppDynamics.
Element in controller-info.xml: <account-name>
System Property: -Dappdynamics.agent.accountName
Type: String
Default: None
Required: Yes for AppDynamics SaaS Controller and other multi-tenant users; no for
single-tenant users.
Account Access Key Property

Description: This is the account access key used to authenticate with the Controller.
Element in controller-info.xml: <account-access-key>
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System Property: -Dappdynamics.agent.accountAccessKey
Type: String
Default: None
Required: Yes for AppDynamics SaaS Controller and other multi-tenant users; no for
single-tenant users.
Proxy Properties for the Controller

These properties route data to the Controller through a proxy.
Proxy Host Property

Description: This is the proxy host name or IP address.
Element in controller-info.xml: Not applicable
System Property: -Dappdynamics.http.proxyHost
Type: String
Default: None
Required No
Proxy Port Property

Description: This is the proxy HTTP(S) port.
Element in controller-info.xml: Not applicable
System Property: -Dappdynamics.http.proxyPort
Type: Positive Integer
Default: None
Required: No
Other Properties
Controller SSL Enabled Property

Description: This property specifies whether the agent should use SSL (HTTPS) to connect to
the Controller. If SSL Enabled is true, set the Controller Port property to the HTTPS port of the
Controller. See Controller Port Property.
Element in controller-info.xml: <controller-ssl-enabled>
System Property: -Dappdynamics.controller.ssl.enabled
Type: Boolean
Default: False
Required: No
Enable Orchestration Property
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Description: When set to true, this property enables Standalone Machine Agent workflow task
execution.
It also enables auto-detection of the controller host and port when the app server is a compute
cloud instance created by an AppDynamics orchestration workflow. In a cloud compute
environment, auto-detection is necessary for the Create Machine tasks in the workflow to run
correctly.
See Controller Host Property and Controller Port Property.
The machine agent polls for task executions only when orchestration is enabled.
If the host machine on which this agent resides is not created through AppDynamics workflow
orchestration, this property should be set
to false.
Element in controller-info.xml: <enable-orchestration>
System Property: Not applicable
Type: Boolean
Default: False
Required: No
Force Agent Registration Property

Description: Set to true only under the following conditions:
The agent has been moved to a new application and/or tier from the UI
and
You want to override that move by specifying a new application name and/or tier name in
the agent configuration.
If there is already a registered app server agent installed on the same host as this machine agent,
this override does not work. If you want to override the UI in this case, you must force the agent
registration change from the app server agent configuration.
Element in controller-info.xml: <force-agent-registration>
System Property: Not applicable
Type: Boolean
Default: False
Required: No
Unique Host ID Property

Description: This property logically partitions a single physical host or virtual machine.
You can use the unique host id when you want to use the same node name for multiple nodes on
the same physical machine.
Set the value to a string that is unique across the entire managed infrastructure. The string may
not contain any spaces.
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If this property is set on the Standalone Machine Agent, it must be set on the app agent as well.
Note that if more than one app agent is running on the host, to see machine agent metrics it is
necessary to run a new Standalone Machine Agent instance every time you specify a different
unique host id on that host.
Element in controller-info.xml: Not applicable
System Property: -Dappdynamics.agent.uniqueHostId
Type: String
Default: None
Required: No
Learn More

Install the Standalone Machine Agent
Machine Agent Install and Admin FAQ
Modify Machine Agent Data Collection Metrics

Machine Agent Metrics
To customize default Machine Agent metric collection
Machine Agent Metrics

By default, AppDynamics Machine Agent reports metrics for only network mounted and local
disks. Also, only the external network traffic is aggregated (to ensure backward compatibility with
previous versions of AppDynamics).
However, you can customize this default behavior by modifying the auto-generated configuration
file, task-template.xml. The task-template.xml file provides information about the current
configuration of the Machine Agent.
To customize default Machine Agent metric collection

Step 1: Open the task-template.xml file.
AppDynamics creates this file in the <Machine_Agent_Directory>/monitors/JavaHardwareMonitor/
directory when the Machine Agent starts up for the first time.
Step 2: Modify the task-template.xml file.
A sample task-template.xml file is given below:
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<config>
<disk
<disk
<disk
<disk
<disk
<disk
<disk
<disk
<disk
<disk

aggregate="false" enabled="false">sunrpc</disk>
aggregate="true" enabled="true">/dev/sdb1</disk>
aggregate="false" enabled="false">proc</disk>
aggregate="false" enabled="false">none</disk>
aggregate="false" enabled="false">devpts</disk>
aggregate="true" enabled="true">/dev/sda1</disk>
aggregate="false" enabled="false">nfsd</disk>
aggregate="true" enabled="true">/dev/mapper/saas4-binlog</disk>
aggregate="false" enabled="false">sysfs</disk>
aggregate="false" enabled="false">tmpfs</disk>

<network
<network
<network
<network
<network
</config>

aggregate="true"
aggregate="true"
aggregate="true"
aggregate="true"
aggregate="true"

enabled="true">lo</network>
enabled="false">sit0</network>
enabled="true">eth0:1</network>
enabled="true">eth0</network>
enabled="false">eth1</network>

To enable aggregation operation for localhost (lo) network metrics, change the value of the
aggregate attribute (for the network element "lo") to "true".
To enable monitoring for a virtual disk, set the value of the enabled attribute to "true" for that
disk.
Step 3: Rename the task-template.xml file to task.xml.
It is important to rename the task-template.xml file (else it will be overwritten by Machine
Agent). The task-template.xml file is automatically generated by Machine Agent.
If you want the Machine Agent to monitor a special device that is not enabled, add a file
named "task.xml" in the <Machine_Agent_Directory>/monitors/JavaHardwareMonitor/
directory. The format of the task.xml file must be exactly the same format aa the
task-template.xml file.
Not all disks and networks have to be listed in task.xml. If the machine agent finds a disk or
a network that is not listed in task.xml, default properties are applied.
Step 4: Restart the Machine Agent.
Restart the machine agent for the changes to take effect.
Machine Agent Install and Admin FAQ

Why is the Machine Agent not displayed on the Flow Map?
Are the metrics monitored by the Machine Agent included in the Infrastructure Health
indicator in the Main Dashboard?
How can I configure the Machine Agent to run automatically when the machine starts?
Instructions for Linux environments
Instructions for Microsoft Windows environments
How do I shut down the Machine Agent?
If the machine is hosting servers that belong to multiple business applications, how do I
assign the Machine Agent to multiple applications?
Why are all the metrics for disk reads and writes and/or network I/O statistics zero?
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Learn More
Why is the Machine Agent not displayed on the Flow Map?

The Machine Agent monitors a particular machine and not a particular application server or JVM.
The Machine Agent can therefore refer to multiple Nodes running on the same machine. A Flow
Map, on the other hand, displays the communication between different Nodes during application
execution, or the Business Transaction flow from Tier to Tier. A Machine Agent cannot be a part of
the flow and therefore is not shown in the Flow Map.
Are the metrics monitored by the Machine Agent included in the Infrastructure Health indicator in the Main Dashboard?

Yes, the health indicator is driven by health rule violations in the given time period and health rule
violations are configured on hardware metrics collected by the Machine Agent. Health Rules for all
possible metrics are not configured out-of-the-box, so you might want to configure additional
health rule according to your requirements. For details see Configure Health Rules.
How can I configure the Machine Agent to run automatically when the machine starts?

To enable the machine agent to run as a Linux (or Windows) service, use the instructions listed
below:
Instructions for Linux environments
Instructions for Microsoft Windows environments
Instructions for Linux environments
1. Create a script file as shown below:

Copyright © AppDynamics 2012-2014

Page 295

#!/bin/sh
#
---------------------------------------------------------------------------# Typical AppDynamics Machine Agent Startup
#
---------------------------------------------------------------------------#CHANGE ME: Set to the agent's install directory
JAVA=java
#CHANGE ME: Set to the agent's install directory
AGENT_HOME=/opt/appdynamics/machineagent
AGENT="$AGENT_HOME/machineagent.jar"
# Agent Options
# Uncomment and make available as needed
# -Dappdynamics.agent.applicationName
: application that the agent
participates in
# -Dappdynamics.agent.logging.dir
: directory to put logs
(agent "user" must have write permissions
# -Dmetric.http.listener=true | false
: open a kill port
# -Dmetric.http.listener.port
: the port to send kill messages
AGENT_OPTIONS=
#AGENT_OPTIONS="$AGENT_OPTIONS
-Dappdynamics.agent.applicationName=<application-name>"
#AGENT_OPTIONS="$AGENT_OPTIONS -Dappdynamics.agent.logging.dir="
#AGENT_OPTIONS="$AGENT_OPTIONS -Dmetric.http.listener=true | false
#AGENT_OPTIONS="$AGENT_OPTIONS -Dmetric.http.listener.port=<port>"
#Consolidation Step - allows you to easily add or remove the agent
#Call the nohup $JAVA $AGENT_OPTIONS -jar $AGENT &

2. Add the script to the rc script.
For Red Hat and most Linux Operating
Systems
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Add the script file created in Step-1 in
/etc/rc.local
For example:
echo '/path/to/startup/script.sh start' >>
/etc/rc.local

Add the script file created in Step-1 as shown
below:
For example:
update-rc.d -f script.sh start 99 2 3 4 5.
where
start is the argument given to the script
(start, stop).
99 is the start order of the script (1 = first
one, 99= last one)
2 3 4 5 are the runlevels to start
IMPORTANT: Do not forget to add dot(.)
at the end.

Instructions for Microsoft Windows environments
See Configure the Machine Agent to Automatically Start on Windows.
How do I shut down the Machine Agent?

If the machine agent process is running in the background, you can stop it by simply entering the
kill command with the process ID as the argument. If it is running in the foreground in a console,
you can press Ctrl+C to shut down the agent.
Note that the Machine Agent implements a shutdown hook, so issuing the kill command (or Ctrl+C)
from the operating system causes the the agent to perform a graceful shut down.
If the machine is hosting servers that belong to multiple business applications, how do I assign the Machine Agent to multiple
applications?

You can configure the Machine Agent with its own Application/Tier/Node properties. If there are
Nodes belonging to multiple business applications, you can run multiple Machine Agents each
configured to report metrics for a different Node, Tier, and Application. For details see Install the
Standalone Machine Agent.
Background information: You cannot "assign" a Machine Agent to multiple business application
per se. A Machine Agent on a specific machine is automatically associated with all Nodes running
on that machine. A Node is associated with a single business application. Therefore an application
is associated with the Machine Agents of its Nodes. By default Machine Agents inherit the
Application/Tier/Node names of the App Agents installed on the same hardware.
Why are all the metrics for disk reads and writes and/or network I/O statistics zero?

This situation may occur when a 32-bit JRE is used with 64-bit operating system. To solve this
problem, use a 64-bit JRE with the 64-bit operating system.
Learn More

Install the Standalone Machine Agent
Standalone Machine Agent Configuration Properties
Logical Model
Configure Multiple Standalone Machine Agents for One Machine for Java

Unique Host ID Property
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Configuring Multiple Standalone Machine Agents
To configure two standalone machine agents for two applications running on the same
machine
Sample Configuration
Learn More
If you have different applications running on the same machine, to get hardware metrics for each
application, run separate standalone machine agents on the same machine.
To do this, create multiple copies of the Standalone Machine Agent. Then configure each
Standalone Machine Agent / app agent pair to use the same applicationName and uniqueHostId.
The uniqueHostId makes it appear to the Controller that the application is running on different
machines. See Application Name Property and Unique Host ID Property.
Unique Host ID Property

The uniqueHostId property is required when multiple standalone machine agents are run on same
machine or host.
When an app agent runs on the same machine as a machine agent, configure the same
uniqueHostId property value on for both the app agent and the machine agent. If there are multiple
app agent/machine agent pairs on the same host, each pair should have a different uniqueHostId
property.
When different tiers in the same application are associated with different machine agents,
configure a different different uniqueHostId property for each app agent-tier/machine agent pair.
To retain historical data if the nodes are moved to a different machine, use the hostname of the old
machine from which the nodes were moved as the UniqueHostId parameter when you configure
the app agent/machine agent pair on the new host. For example, if the hostname of the original
machine was "12345.sample.com", on the new host start the app agent and the machine agent
with:
-Dappdynamics.agent.uniqueHostId=12345.sample.com

Configuring Multiple Standalone Machine Agents

The following instructions assume two applications and two standalone machine agents on a
single machine, but they can be interpolated to cover more than two.
To configure two standalone machine agents for two applications running on the same machine

1. Download two copies of the Standalone Machine Agent, one for each application.
2. Assign the standalone machine agents different names, for example: "MachineAgent1" and
"MachineAgent2".
If there are custom scripts running on the standalone machine agents, they must not use the
same resources.
3. Configure the first application/machine agent pair for the first application:
a. Delete the app agent node from the Controller UI.
b. Configure the applicationName and uniqueHostID properties for the app agent.
c.
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3.

c. Configure the applicationName and uniqueHostID properties for the machine agent
using the same application name and unique host id values that you used for the app
agent configuration.
4. Configure the second application/machine agent pair for the second application:
a. Delete the app agent node from the Controller UI.
b. Configure the applicationName and uniqueHostID properties for the app agent. These
values must be different from the values used for the first application.
c. Configure the applicationName and uniqueHostID properties for the Standalone
Machine Agent using the same applicationName and uniqueHostId values that you
used for the app agent configuration.
5. Restart all JVMs.
Sample Configuration

The following image shows a sample configuration of two physical machines with two applications
each. In it:
Machine1 runs App1, which is instrumented with one app agent (AppAgent1) and one
Standalone Machine Agent (MachineAgent1).
Machine1 also runs App2, which is instrumented with one app agent (AppAgent2) and one
Standalone Machine Agent (MachineAgent2).
Machine2 runs App1, which is instrumented with one app agent (AppAgent3) and one
Standalone Machine Agent (MachineAgent3).
Machine2 also runs App2 is instrumented with one app agent (AppAgent4) and one
Standalone Machine Agent (MachineAgent4).

Given this deployment, the Controller would report separate metrics for each of Machine1_App1,
Machine1_App2, Machine2_App1, and Machine2_App2.
Learn More

App Agent for Java Configuration Properties
Standalone Machine Agent Configuration Properties
Supported Environments and Versions (Standalone Machine Agent)
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Supported Platform Matrix for the Standalone Machine Agent
Supported Platforms for Default Hardware Monitor Plugin
Supported Platform Matrix for the Standalone Machine Agent

The standalone Machine Agent provides platform-level metrics. It has a default built-in plugin for
hardware monitoring. See Install the Standalone Machine Agent.
Supported Platforms for Default Hardware Monitor Plugin

Operating System

Architecture

Versions

Linux

x86

2.2, 2.4, 2.6 kernels

Linux

amd64

2.6 kernel

Linux

ppc

2.6 kernel

Linux

ppc64

2.6 kernel

Linux

ia64

2.6 kernel

Linux

s390

2.6 kernel

Linux

s390x

2.6 kernel

Solaris

Sparc-32

2.6, 7, 8, 9, 10

Solaris

Sparc-64

2.6, 7, 8, 9, 10

Solaris

x86

8, 9, 10

Solaris

x64

8, 9, 10

AIX

ppc

4.3, 5.1, 5.2, 5.3, 6.1

AIX

ppc64

5.2,5.3,6.1

HP-UX

PA-RISC

11

HP-UX

ia64

11

FreeBSD

x86

4.x

FreeBSD

x86

5.x, 6.x

FreeBSD

x64

6.x

FreeBSD

x86,x64

7.x,8.x

OpenBSD

x86

4.x,5.x

NetBSD

x86

3.1

Mac OS X

PowerPC

10.3, 10.4

Mac OS X

x86

10.4, 10.5, 10.6

Mac OS X

x64

10.5, 10.6
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Windows

x86

NT 4.0, 2000 Pro/Server,
2003 Server, XP, Vista, 2008
Server, 7

Windows

x64

2003 Server, Vista, 2008
Server, 7

The following Linux distributions have been certified:
Distribution

Versions

Red Hat

6.2, 7.3, 8.0, 9.0

RHEL

3, 4, 5, 6

CentOS

3, 4, 5

Fedora

2, 3, 4, 5, 6, 7, 8, 9, 10

SuSE

8, 9, 10, 11

Ubuntu

6.06, 8.04, 8.10, 9.04

Debian

2.6, 3.0, 3.1, 3.2, 4.0, 5.0

VMware ESX

2.x, 3.0

XenServer

3.1, 3.2, 4.0, 4.1, 5.0

Slackware

10, 11

Mandrake

10

Scientific Linux

5

Gentoo
Note: If you are using a 64-bit Operating System, use only a 64-bit Java Runtime Environment
(JRE). For more details see Supported Platform Matrix for Default Hardware Monitoring Plugin.
Remove Unused Nodes

About Unused Nodes
Node Activity and Agent Licensing
Configuring Node Activity Settings
To configure inactive node expiration and removal settings:
Learn More
About Unused Nodes

If a node has been out of contact with the Controller for a certain amount of time, the Controller
marks the node as a historical node. The Controller suspends certain types of processing activities
for the node (such as rule evaluation), but continues to present data for the node in the UI.
If the node resumes contact with the Controller before the node deletion period expires, the
Controller restores it to an active state. Otherwise, it is permanently removed from the Controller
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and the node level data is no longer accessible in the UI. However, the tier- and application-level
historical metric data for the node remain available even after the node is deleted.
By default, the Controller considers a node historical after about 20 days of inactivity and deletes
the node after 30 days. For a highly dynamic application environment in which nodes are created
and destroyed frequently, it usually makes sense to shorten the node activity timeout period. This
allows recycled nodes to be treated as such in the Controller.
Another consideration for historical nodes is that their names can be assigned to new nodes if
node name reuse is enabled. Node name reuse is an App Agent for Java option that allows the
Controller to present data generated by multiple, short-lived nodes in a given tier as a single
logical node.
Node Activity and Agent Licensing

For licensing purposes, the Controller releases the license for the agent if the Controller has not
received data from the agent in the previous 5 minutes. This license availability behavior is not
affected by the historical node status or node deletion timeout settings.
Configuring Node Activity Settings

The node activity settings are global settings that the root AppDynamics administrator can modify
from the administration console, as follows.
To configure inactive node expiration and removal settings:

1. As a user with global administrator administrator privileges, log in to the Controller
administration console. For more information, see Access the Administration Console.
2. Click Controller Settings.
3. Set the retention and deletion properties based on the requirements for your environment.
AppDynamics recommends that you set the permanent deletion period at least an hour
more than the retention period.
node.permanent.deletion.period: Time (in hours) after which a node that has lost
contact with the Controller is deleted permanently from the system. The default is 720
hours.
node.retention.period: Time (in hours) after which a node that has lost contact with
the Controller is deleted. In this case, the AppDynamics UI will not display the node,
however the system will continue to retain it. The default is 500 hours.
Learn More

Access the Administration Console
Agent Log Files
This section helps you understand and use Agent log files.
Overview of Agent Log Files

About Agent Log Files
Logging Levels
Controlling the Logging Level (Java and PHP)
Controlling the Logging Level (.Net)
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Log File Sizes and Life Cycle Details
Agent Log
Proxy Log
Business Transactions Log
Bytecode Transformer Log
JMX Log
Standalone Machine Agent Log
REST Log
Learn More
About Agent Log Files

Agent log files can help you resolve agent configuration and application instrumentation issues
that prevent you from obtaining the information you need to optimize the performance of your
environment. When submitting log files to AppDynamics Support, ensure you send the entire
contents of the agent logs directory available as a zip file for download when you request the
agent logs.
Agent log files are created automatically when the agent starts up. The logs available are agent
dependent.
The log files that you will probably find most useful to resolve instrumentation challenges and
assist you in configuring your environment are:
for discovering errors, Agent Log and Proxy Log
for resolving instrumentation problems, ByteCode Transformer Log
The following topics provide a brief overview of these logs:
Agent Log
Proxy Log
Business Transactions Log
ByteCode Transformer Log
JMX Log
Machine Agent Log
Rest Log
Logging Levels

These are the five levels of logging, in the descending order of amount of information collected:
all: Logs all events.
trace: Reports finer-grained informational events than the debug level that may be useful to
debug an application.
debug: Reports fine-grained informational events that may be useful to debug an
application.
info: Default log level. Reports informational messages that highlight the progress of the
application a coarse-grained level.
warn: Reports on potentially harmful situations.
error: Reports on error events that may allow the application to continue running.
Controlling the Logging Level (Java and PHP)
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By default, the logging level for most log files is set to "info". The finer the granularity, the faster the
log file consumes disk space.
You can control the logging level for the App Agent for Java and App Agent for PHP agent by
changing the value of the "level value" parameter in the log4j.xml file in the agent installation\logs
directory.
<logger name="com.singularity" additivity="false">
<!-- to control the logging level of the agent log files, use the level
attribute below. value="all|trace|debug|info|warn|error"-->
<level value="info"/>
<appender-ref ref="AgentLogger"/>
<appender-ref ref="RESTLogger"/>
</logger>

Controlling the Logging Level (.Net)

You can control the logging level for the App Agent for .Net by changing the value of the "min
level" parameter in the AppDynamicsAgentLog.config file in the agent installation directory. The
log configuration is per server. The coordinator/.NET machine agent and the .NET agents all read
the same configuration file and write to the same set of output files.
<rules>
<logger name="com.appdynamics.REST.HeartBeatLog" minLevel="Info"
writeTo="RESTHearbeat" final="true" />
<logger name="*" minLevel="Warn" writeTo="warnfile" />
<logger name="com.appdynamics.BusinessTransactions" minLevel="Info"
writeTo="btlog" final="true" />
<logger name="com.appdynamics.bci.*" minLevel="Info" writeTo="bcifile"
final="true" />
<logger name="com.appdynamics.REST.*" minLevel="Info" writeTo="RESTfile"
final="true" />
<logger name="AppDynamics.Agent.Coordinator.Recovery.*" minLevel="Info"
writeTo="CoordinatorRecovery" final="true" />
<logger name="com.appdynamics.METRICS.MetricSender" minLevel="Info"
writeTo="RESTfile" final="true" />
<logger name="AppDynamics.Winston.*" minLevel="Info" writeTo="Winston"
final="true" />
<logger name="com.appdynamics.tm.AFastBackendResolver" minLevel="Warn"
writeTo="logfile" final="true" />
<logger name="com.appdynamics.ManagedAgentAPI.DumpStats" minLevel="Trace"
writeTo=" SamplingInfo" final="true" />
<logger name="*" minLevel="Info" writeTo="logfile" />
</rules>

Log File Sizes and Life Cycle Details

Log File

App Agent for...

Max Size

Agent

Java, .Net

5 MB
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Agent

PHP (PHP extension module)

20 MB

Proxy

PHP (Java proxy)

5 MB

Business Transaction

Java, .Net, PHP

5 MB

ByteCode Transformer

Java, .Net

20 MB

JMX

Java

5 MB

Machine Agent

Machine

5 MB

REST

Java, .Net, PHP

5 KB

When the maximum file size is reached, a new log is created. First file is named ...0.log,
second file is ...1,log, and so on.
maximum of five files per set.
maximum of five sets. If the maximum number of sets is reached, when a new set is
created, the oldest set is deleted.
Agent Log

App Agent for ...

Log Name

Java

agentYear_mon_day_hr_min.#.log

PHP (PHP extension component)

agent.#.log

PHP (Java proxy)

proxyYear_mon_day_hr_min.#.log

.NET

AgentLog.#.txt

These logs are generated by all App agents and report the activity of the agents as they monitor
your applications. At the beginning of the log file, it shows the start up of the agent monitoring
services and displays configuration settings. The agent log also contains the sequence of agent
runtime activity and exceptions that are encountered. When you are troubleshooting various
issues in an AppDynamics deployment, you can find useful information in this log.
Examples of information in the log:
agent version and build date
JVM runtime version - Java only
configuration changes
backend detection
exceptions
output from Logging Session requests
Proxy Log

App Agent for ...

Log Name

PHP (proxy)

proxyYear_mon_day_hr_min.#.log

The Proxy log is generated by the App Agent for PHP. This log file is useful for determining why
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snapshots are not being taken and for diagnosing communication issues with the controller.
Business Transactions Log

App Agent for ...

Log Name

Java

BusinessTransactionsYear_mon_day_hr_min.
#.log

.Net (proxy)

BusinessTransactionsLog.#.txt

PHP

BusinessTransactionsYear_mon_day_hr_min.
#.log

The Business Transactions log is generated by all agents and logs the following information:
discovered business transactions
discovery stack trace for each entry point
dropped business transactions, which show up in the "default BT" when there is business
transaction overflow. Only executed methods show up in the business transaction log. If the
business functionality is not exercised by the application, the code is not executed, and the
methods are not examined as potential entry points.
Bytecode Transformer Log

App Agent for ...

Log Name

Java

ByteCodeTransformerYear_mon_day_hr_min.
#.log

.Net

ByteCode.txt

The ByteCode Transformer log is generated by the App Agent for Java and App Agent for .Net
and contains the information associated with the AppDynamics bytecode instrumentation (BCI)
engine. The BCI engine is used to inject interceptors. The BCI engine logs the classes being
loaded in the application.
This log is critical for troubleshooting all the things that depend on bytecode instrumentation
including: Java entry points, exit points, loggers, errors, exceptions, and async threads.
Examples of information in the log:
agent version and build date
each Java class that was examined and whether the methods were considered for bytecode
instrumentation
each method that was instrumented
This log file is useful to:
verify entry point instrumentation
verify backend instrumentation
troubleshoot missing metrics
JMX Log
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App Agent for...

Log Name

Java

JMXYear_mon_day_hr_min.#.log.log

JMX log entries contain information about JMX interactions between the AppDynamics agent and
the monitored server's JMX domains. These log entries are useful for diagnosing problems
associated with JMX metrics, or issues with JVM metrics, which are reliant on JMX.
The JMX entries can be useful in debugging why MBeans don't appear or why metrics created
from MBeans do not appear in the controller UI.
Standalone Machine Agent Log

Agent

Log Name

Standalone Machine

machine-agent.#.log

The machine agent log captures information from the Standalone Machine Agent as it monitors the
health of the server in terms of the server's usage of CPU, memory, disk, and network interfaces.
REST Log

App Agent for...

Log Name

Java

RESTYear_mon_day_hr_min.#.log

.Net

RESTCommunications.#.txt

PHP (proxy)

RESTYear_mon_day_hr_min.#.log

This log contains information about the AppDynamics agent and controller communication. The log
contains request and response payload data between the agent and the controller, the raw details
of communications between the agent and the controller. By default, the REST log contains INFO
level logging for all registration requests up to a limit of 1MB every five minutes.
You can use this log to troubleshoot issues with detecting and reporting business transactions,
backends, events, and metric reporting.
The communication between the agent and controller consists of the following:
configuration data
node identification
machine registration
business transaction registration
metric registration
event registration
snapshot capture/upload to controller database
metric data upload to controller database
event data upload to controller database
output from Logging Session requests
Learn More

Request Agent Log Files
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Request Agent Log Files

Prerequisites
Start an Agent Logging Session
Request and Download Agent Log Files
Request and Download Thread Dump Samples
Submitting Log Files to Support
Learn More
Prerequisites

Ensure you have enough disk space to create the logs before starting a logging session.
Log file requests fail if there is not enough disk space available.
For the App Agent for .Net, ensure the agent has the same permissions as your site's
application pools. For more information, see Troubleshooting Log Issues.
You can download a zip of the log file directory from the UI but you can also find the logs at the
following locations:
Agent name

Log file location

App Agent for Java

<agent install directory>/logs/<Node_Name>

App Agent for .Net

<agent install directory>/logs/

App Agent for PHP

<agent install directory>/logs/

Standalone Machine Agent

<agent install directory>/logs/

Requesting the agent logs is a two-step process
1. Start an Agent Logging Session. Here you can start a logging session to see specific
AppDynamics logger information in the agent log files. Once the logging session completes
you can request the agent log files.
2. Request and Download Agent Log Files Follow this procedure to download all the log files,
download the output from a specified third-party logger you have installed, or download
thread dump samples.
Start an Agent Logging Session

1. On the Agents tab of the Node dashboard, scroll down to the Agent Operations panel.

Copyright © AppDynamics 2012-2014

Page 308

2. Click Start Agent Logging Session.
The Agent Logging Session window opens.
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3. From the drop-down list, click the duration for the logging session.
4. Click the check boxes for the debug logger types to initiate. You can select any number of these
logger types. The selected loggers control the type of information the logging session captures.
The following describes the debug logger types available.
Logging Session Type

Description (What kind of info and when to
use this)

Application Wide Configuration

Application configuration changes

BT Registration

Transaction, exit identification, self resolution

Current Time

Requests to synch up the clock skew between
the controller and the agent

Events

Changes in application state that are of
potential interest
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Metric Data

Metric data

Metric Registration

Metric registration

One Way Agent

For system (machine) agent only, information
from the capture feature

Request Segment data

Snapshot upload of request segment

System Agent Registration

System (machine) agent registration

System Agent Reregistration

System (machine) agent reregistration

System Agent Polling Handler

System (machine) agent configuration request

Task Execution

Relates to the machine agent where you can
create a task to execute on a machine, such
as restart application server and run a script

Top Summary Stats

Request to upload the 'most expensive
backend' summary

Application Configuration

Configuration change requests

Transient Channel

Activity of transient channel which is used to
upload and download instructions for 'JMX
console' live data

5. Click Start Agent Logging Session.
Each session type that you clicked appears in the session panel, with a start time and end time
based on what you picked in the Duration of logging session to run drop-down list. If you don't see
the session you requested, click Refresh.

Request and Download Agent Log Files

When the End Time of the logging session has been reached, you can request the log files. You
can also manually take thread dumps from the Agents tab of the node dashboard. When you
request the log files, the agent zips the contents of the logs directory and then sends the logs to
the controller as a single file for download.

Copyright © AppDynamics 2012-2014

Page 311

1. On the Agents tab of the Nodes dashboard, scroll down to the Agent Operations panel.
2. Click Request Agent Log Files.
The Request Agent Log Files window opens.

3. By default the agent zips all logs in the agent log directory into one zip file.
For the AppDynamics Agent for Java or PHP, you can select one of the other options:
Output from a specific logger at a set level, for a fixed duration: To use this option contact
AppDynamics Support. For a list of supported loggers, see Supported Environments and
Versions (Java).
Thread dump samples The agent takes a thread dump according to the specified collection
interval and specified number to collect. After the interval elapses the thread dumps are
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uploaded by the agent as a zip file. See Request and Download Thread Dump Samples
4. (Optional) Enter a name for your request. The name you provide identifies your request in the
name of the generated zip file. For example, the name CurrentTime produces a zip file named
similar to CurrentTime_Node_8000_1390503141046.zip.
5. After the logging session duration expires and the log file has been written to disk, click Reques
t Agent Log Files and the logged request and response output appears in the Controller UI. You
must Request the log files before you can download them. See Request and Download Thread
Dump Samples
The AppDynamics controller processes your request. The status field changes as follows:
PENDING - request submitted
IN_PROGRESS - request being processed
TIMEDOUT - the request was not able to produce the desired result within the time specified
in the Collection Interval (ms) field. This problem could occur for reasons such as:
The responding server went down.
The Internet connection went down.
The request parameters sent are incorrect.
SUCCESSFUL - request is ready
If the status is SUCCESSFUL, you can click the file icon to download the zipped agent log files
directory.
If the status is PENDING, click Refresh. The zipped agent log files directory can only be
downloaded when the status shows as SUCCESSFUL.

Note: If you accidentally request the logs for a node that is not valid, for example IIS is turned off
for that node, the request eventually changes to IN_PROGRESS, but does not progress to
SUCCESSFUL. You can remove such a request manually by selecting it, right-clicking and
selecting Delete Data from the contextual menu.
Request and Download Thread Dump Samples

For App Agents: App Agent for Java and App Agent for PHP
You can request log files and manually take thread dumps from the Agents tab of the node
dashboard. Requesting the log files causes the agent log files directory to be zipped up into one
file for download convenience.
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1. On the Agents tab of the Nodes dashboard, scroll down to the Agent Operations panel.
2. Click Request Agent Log Files.
The Request Agent Log Files window appears.

By default all logs in the agent log directory for this node are collected into a zip file.
3. Click Thread dump samples, enter the number of samples to collect and the interval at which
the samples should be collected.
The agent takes a thread dump according to the specified collection interval and specified
number to collect. After the interval elapses the thread dumps are uploaded by the agent as a zip
file.
4. (Optional) Enter a name for your request. The name you provide is used to identify your request
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in the name of the generated zip file. For example, the name CurrentTime produces a zip file
named similar to CurrentTime_Node_8000_1390503141046.zip.
5. After the logging session duration has expired and the log file has been written to disk, click Req
uest Agent Log Files and the logged request and response output appears in the Controller.
The AppDynamics controller processes your request. The status field changes as follows:
PENDING - request submitted
IN_PROGRESS - request being processed
TIMEDOUT - the request was not able to produce the desired result within the time specified
in the Collection Interval (ms) field. This problem could occur for reasons such as:
The responding server went down.
The Internet connection went down.
The request parameters sent are incorrect.
SUCCESSFUL - request is ready
If the status is SUCCESSFUL, you can double-click a thread dump sample in the list to
download the zip file containing the thread dump that you want.
If the status is PENDING, click Refresh. When the logs are ready, the status changes to
SUCCESSFUL. The zipped agent log files directory can only be downloaded when the status
shows as SUCCESSFUL.

Note: If you accidentally request the thread dump samples for a node that is not valid, for example
IIS is turned off for that node, the request eventually changes to IN_PROGRESS, but does not
progress to SUCCESSFUL. You can remove such a request manually by selecting it, right-clicking
and selecting Delete Data from the contextual menu.
Submitting Log Files to Support

When submitting log files to AppDynamics Support, ensure you send the entire contents of the
agent logs directory available as a zip file for download when you request the agent logs.
Learn More

Overview of Agent Log Files
Agent to Controller Communications
This page addresses agent to Controller communications.
Agent to Controller Interactions
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Agent Behavior When the Controller is Not Reachable
What Happens When you Disable an Agent from the Controller UI?
Agent to Controller Interactions

Each AppDynamics agent has multiple communication channels for different purposes that initiate
connections to the Controller independently at different time intervals.
The agent configuration channel queries the Controller for any new configuration changes
every 60 seconds and downloads the changes when they are available.
The agent metric channel posts all new periodic metrics, including JMX, Windows
performance counters, and business transaction metrics to the Controller every 60 seconds.
If there are new business transactions that haven’t been seen before by the agent, they are
posted to the Controller for registration every 10 seconds.
If the agent has collected any new snapshots or events, they are posted to the Controller
every 20 seconds.
Agent Behavior When the Controller is Not Reachable

The Controller may become unreachable when there are network problems, agent errors or when
the Controller server is down for a variety of reasons.
If the Controller is unreachable for one minute:
The agent goes into standby mode during which it does not detect any transactions.
Any collected snapshots and events are dropped and lost. Snapshots and events are
dropped because they consume too much memory to cache.
All metrics that have not been posted to the Controller are stored in memory. The memory
impact of retaining metrics is minimal.
New business transaction registrations that have not been posted to the Controller are
stored in memory
The agent attempts to connect to the Controller every minute, and resumes normal activity
when it can download its full configuration.

If the Controller becomes reachable in the following minute or two:
All metrics that have been stored in memory are posted to the Controller.
New business transaction registrations that have been stored in memory are posted to the
Controller.
Snapshots and events collected in the 20 seconds prior to the reconnection are posted to the
Controller.
If the Controller is not reachable after three failed attempts that are one minute apart:
The agent is muted; all business transaction interceptors are disabled. The interceptors are
still called when monitored application entry point methods are executed, but they are
unproductive. No new business transactions are discovered or registered. Correlation exit
points will set a header such as “notxdetect=true”, which tells downstream tiers to also
ignore the transaction.
JMX metrics are stored in the application server memory and transmitted to Controller after
reconnection; so, there are no gaps in the metric history.
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Periodic metrics for the last three minutes are stored in memory; metrics older than three
minutes are purged from memory.
The agent configuration channel and the metric channel continue to attempt to connect to
the Controller once each minute.
If the Controller is not reachable after five minutes:
The license is freed for another agent to use.
If the connection is later successful and the agent and is able to download its full configuration and
a license:
All periodic metrics, such as JMX metrics and Windows performance counters for the last
three minutes are posted to the Controller. The Controller drops metrics that were collected
too long ago in the past, such as when rollups are already completed.
The agent is reactivated, business transaction interceptors are re-enabled, business
transactions are monitored and possibly snapshotted, new business transactions will be
discovered and registered, and downstream correlation is re-enabled.
What Happens When you Disable an Agent from the Controller UI?

business transaction interceptors are disabled and no transaction metrics, snapshots or
events are collected.
The agent continues to collect periodic JMX and Windows performance counter metrics.
The agent continues to be registered with the Controller and continues to consume a
license. The only way to free up a license is to restart the app server without the agent,
removing the agent from the JVM.
See Enabling and Disabling App Agents.

Deploy AppDynamics
Planning the Deployment
Deployment Tasks
Network Requirements
Correlation HTTP Header
Clock Management
Learn More
Planning the Deployment

Deploying AppDynamics to its live operating environment introduces requirements and
considerations beyond those applicable to an evaluation or staging installation.
Security, availability, scalability, and performance all play an important role in production
deployment planning. The system resources of the machine that hosts the Controller in a live
environment must be able to support the expected workload.
For information on installation, see Install and Upgrade.
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This topic covers considerations applicable to deploying AppDynamics to its live environment.
Deployment Tasks

A typical deployment of AppDynamics involves these tasks and considerations:
Ensure that target systems meet the Controller System Requirements for the Controller's
expected workload.
For high volume environments, tune the OS and Controller settings for high workload. Also
be sure to verify and if necessary set the file descriptor limits as advised in Configure File
Descriptor Limits on Linux.
Implement Manage Controller High Availability to ensure service continuity in the event of a
failure of the Controller server.
Configure the network environment. If deploying the Controller with a reverse proxies,
configure passthrough of Controller traffic. Also note other Network Requirements for the
deployment environment.
Implement security requirements for your environment. If clients will connect to the
Controller by HTTPS, install your custom SSL server certificate on the Controller.
Generate a password management strategy for the built-in system accounts in the Controller
and platform.
Make sure the mail server is properly configured for the Controller in the target environment
and define your alerting strategy.
Devise your backup strategy. A typical backup strategy consists of frequent partial backups
with intermittent full backups.
Plan your configuration maintenance and enhancement strategy. Changes to the
configuration should be staged in a non-critical environment, and rolled into the live
environment only after thorough testing. The AppDynamics UI offers the ability to export and
import configuration settings from various contexts, including from the transaction detection
settings, health rules, or the full application.
Deploying App Agents is likely to be an ongoing task, especially in dynamic environments
where monitored systems are regularly taken down and new ones brought up. There are two
basic strategies for deploying large numbers of App Agents across a managed environment:
1. Deploy the agents independently of the application inside the application server. This
method ensures that re-deployments of the application do not overwrite the agent
deployment.
2. Integrate deployment of AppDynamics agents into the deployment of applications.
This more sophisticated approach requires modifying the existing application
deployment automation scripts.
For details, see:
Multi-Agent Deployment for Java
Unattended Installation for .NET
Network Requirements

Deploying the Controller often calls for configuration changes to existing network components,
such as to firewalls or load balancers in the network. If the Controller will reside behind a load
balancer or reverse proxy, you need to set up traffic forwarding for the Controller. You may also
need to open ports used by AppDynamics on firewalls or any other device through which traffic
must traverse.
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The following are general considerations for the environment in which you deploy
AppDynamics. See Installation Cheatsheet for Small Environments for other network configuration
requirements.
Correlation HTTP Header

AppDynamics adds a custom header to traffic in the monitored environment
named singularityheader. This header enables AppDynamics to correlate traffic across tiers. It's
important to ensure that any load balancer, proxy or firewall in the network between monitored
tiers or between the tiers and the Controller preserves the header added by AppDynamics.
Clock Management

To ensure consistent event time reporting across the AppDynamics deployment, the App Agents
attempts to synchronize its time with the Controller time.
It does so by retrieving the time from the Controller every five minutes. It then compares the
Controller's time to its own local machine's clock time. If the times are different, whether ahead or
behind, it applies a time skew based on the difference to the timestamps for the metrics it reports
to the Controller.
If, despite the agent's attempt to report metrics based on the Controller time, the Controller
receives metrics that are time-stamped ahead of its own time, the Controller rejects the metrics. To
avoid this possibility, AppDynamics recommends maintaining clock-time consistency throughout
your monitored environment.
Learn More

Security
Controller Port Settings
Deploy with a Reverse Proxy
Controller High Availability
Tuning for Large Scale Deployments
Configure the SMTP Server
Security

Securing your Deployment
Learn More
This topic introduces security topics for an AppDynamics deployment.
Securing your Deployment

AppDynamics includes security features that help to ensure the safety and integrity of your
deployment.
The Controller is installed with an HTTPS port enabled by default. SSL secures client connections
and allows client to authenticate the Controller. The Controller UI supports HTTP Basic
Authentication, along with SAML and LDAP authentication. Role-based access controls in the UI
allow you to manage user privileges.
While the security features of the Controller are enabled out of the box, there are some steps you
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should take to ensure the security of your deployment. These steps include but are not limited to:
The SSL port uses a self-signed certificate. If you intend to terminate SSL connection at the
Controller, you should replace the default certificate with your own, CA-signed certificate. If
you replace the default SSL certificate on the Controller, you will also need to install the Con
troller's public key on the App Agent machine.
As an alternative to terminating SSL at the Controller, you can deploy the Controller
behind a reverse proxy that terminates SSL. This relieves the Controller from having
to process SSL connections.
Along with a secure listening port, the Controller provides an unsecured, HTTP listening port
as well. You should disable the port or block access to the point from any untrusted
networks.
Make sure that your App Agents connect to the Controller or to the reverse proxy, if
terminating SSL at a proxy, with SSL enabled.
The Controller and underlying components, Glassfish and MySQL, include built-in user
accounts. Be sure to change the passwords for the accounts regularly and in general, follow
best practices for password management for the accounts. For information on changing the
passwords for built-in users, see Administrative Users.
Learn More

The following topics provide much more information about securing your AppDynamics
deployment:
Controller SSL and Certificates
Enable SSL for Java
Connect the Controller and Agents
App Agent for Java SSL Configuration Properties
Enable SSL for .NET
Controller SSL and Certificates

About Controller Certificates
Before Starting
Create a Certificate and Generate a CSR
Import an Existing Keypair into the Keystore
To import an existing keypair into the Controller keystore:
Verify the Controller is secured using SSL
Change Keystore Password
To change Glassfish passwords
Set the Security Protocol
Configure the Controller Security Protocol
Configure Agent Security Protocol
About Controller Certificates
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The Controller comes with a preconfigured HTTPS port (port 8181 by default), secured with a
self-signed certificate.
For production use, AppDynamics strongly recommends that you replace the self-signed certificate
with a certificate signed by a third-party CA or your own internal CA. If you are deploying .NET
Agents, you must replace the self-signed certificate with one signed by a CA, since the .NET
agents do not work with self-signed certificates.
This page describes how to replace the existing key in the default keystore. Replacing the entire
keystore is not recommended, unless you first export the existing artifacts from the default
keystore and import them into your own keystore.
The default Controller keystore includes the following artifacts:
glassfish-instance: A self-signed private key provided the Glassfish application server.
s1as: A self-signed private key provided with the Glassfish application server used by the
Controller for secure communication on port 8181.
The keystore may also contain eum_client and agg_appdynamics. These are the private key
and keychain used by the AppDynamics End User Monitoring product. Do not attempt to modify or
remove them.
You can view the contents of the keystore yourself using the keytool utility. To do so, from the
<Controller_home>/jre/bin directory, run the following command, entering that password changeit
when prompted:
keytool -list -v -keystore
../../appserver/glassfish/domains/domain1/config/keystore.jks

The exact steps to implement security typically vary depending on the security policies for the
organization. For example, if your organization already has a certificate to use, such as a wildcard
certificate used for your organization's domain, you can import the existing certificate into the
Controller keystore. Otherwise, you'll need to generate a new one along with a certificate signing
request. The following sections take you through these scenarios.
Before Starting

The following instructions describe how to configure SSL using the Java keytool utility bundled
with the Controller installation. You can find the keytool utility in the following location:
<Controller_Installation_Directory>/jre/bin
The steps assume that the keytool is in the operating system's path variable. To run the
commands as shown, you first need to put the keytool utility in your system's path. Use the method
appropriate for your operating system to add the keytool to your path.
While the directory paths in this topic use forward slashes, the instructions apply to both Linux and
Windows Operating System environments. The steps note where there are differences in the use
of commands between operating systems.
Create a Certificate and Generate a CSR
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If you don't have a certificate to use for the Controller, create it as follows. In these steps, you
generate a new certificate within the Controller's active keystore, so it has immediate effect.
The steps are intended to be used in a staging environment, and require the Controller to be shut
down and restarted. Alternatively, you can generate the key as described here but in a temporary
keystore rather than the Controller's active keystore. After the certificate is signed, you can import
the key from the temporary keystore to the Controller's keystore.
1. At a command prompt, change directories to the following location:
<Controller_Installation_Directory>/appserver/glassfish/domains/domain1/co
nfig

2. Create a backup of the keystore file. For example, on Linux, you can run:
cp keystore.jks keystore.jks.backup

On Windows, you can use the copy command in a similar manner.
3. If it's still running, stop the Controller.
4. Delete the existing certificate with the alias s1as from the keystore:
keytool -delete -alias s1as -keystore keystore.jks

5. Create a new key pair in the keystore:
keytool -genkeypair -alias s1as -keyalg RSA -keystore keystore.jks
-keysize 2048

Follow the onscreen instructions to configure the certificate. Note that:
For the first and last name, enter the domain name where the Controller is running, for
example, controller.example.com.
Enter the default password for the key, changeit.
This generates a self-signed certificate in the keystore. We'll generate a signing request for
the certificate next. You can now restart the Controller and continue to use it. Since it still
has a temporary self-signed keystore, browsers attempting to connect to the Controller UI
will get a warning to the effect that its certificate could not be verified.
6. Generate a certificate signing request for the certificate you created as follows:
keytool -certreq -alias s1as -keystore keystore.jks -file AppDynamics.csr

7. Submit the certificate signing request file generated by the command (AppDynamics.csr in
our example command) to your Certificate Authority of choice.
When it's ready, the CA will return the signed certificate and any root and intermediary

Copyright © AppDynamics 2012-2014

Page 322

7.

certificates required for the trust chain. The response from the Certificate Authority should
include any special instructions for importing the certificate, if needed. If the CA supplies the
certificate in text format, just copy and paste the text into a text file.
8. Import the signed certificate:
keytool -import -trustcacerts -alias s1as -file mycert.cer -keystore
keystore.jks

This command assumes the certificate is located in a file named mycert.cer.
9. If you get the error "Failed to establish chain from reply", install the issuing Certificate
Authority's root and any intermediate certificates into the keystore. The root CA chain
establishes the validity of the CA signature on your certificate. Although most common root
CA chains are included in the cacerts.jks truststore, you may need to import additional root
certificates. To do so:
keytool -import -alias [Any_alias] -file
<Path_to_Root_or_Intermediate_Cert> -keystore
<Controller_Install_Directory>/jre/lib/security/cacerts

When done importing the certificate chain, try importing the signed certificate again.
Import an Existing Keypair into the Keystore

These steps describe how to import an existing public and private key into the Controller keystore.
We'll step through this scenario assuming that the existing public and private keys need to be
converted to a format compatible with Java Keystore, say from DER format to PKCS#12. You'll
need to use OpenSSL to combine the public and private keys, and then keytool to import the
combined keys into the Controller's keystore.
Most Linux distributions include OpenSSL. If you are using Windows or your Linux distribution
does not include OpenSSL, you may find more information on the OpenSSL website.
This assumes that we have the following files:
private key: private.key
signed public key: cert.crt
CA root chain: ca.crt
The private key you use for the following steps must be in plain text format. Also, when performing
the following procedures, do not attempt to associate a password to the private key as you convert
it to PKCS12 keystore form. If you do, the following steps can be completed as described, but you
will encounter an exception when starting up the Controller, with the error message:
"java.security.UnrecoverableKeyException: Cannot recover key".
To import an existing keypair into the Controller keystore:

1. Use OpenSSL to combine your existing private key and public key into a compatible Java
keystore:
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1.

openssl pkcs12 -inkey private.key -in cert.crt -export -out keystore.p12

2. If you haven't already, stop the Controller.
3. Change to the keystore directory:
cd
<Controller_Installation_Directory>/appserver/glassfish/domains/domain1/co
nfig/

4. Create a backup of the keystore file. For example, on Linux, you can run:
cp keystore.jks keystore.jks.backup

On Windows, you can use the copy command in a similar manner.
5. Delete the self-signed certificate with alias s1as from the default keystore:
keytool -delete -alias s1as -keystore keystore.jks

6. Import the PKCS#12 key into the default keystore:
keytool -importkeystore -srckeystore keystore.p12 -srcstoretype pkcs12
-destkeystore keystore.jks -deststoretype JKS

7. If you get the error "Failed to establish chain from reply", install the issuing Certificate
Authority's root and any intermediate certificates into the keystore. The root CA chain
establishes the validity of the CA signature on your certificate. Although most common root
CA chains are included in the cacerts.jks truststore, you may need to import additional root
certificates. To do so:
keytool -import -alias [Any alias] -file <Path to Root/Intermediate Cert>
-keystore <Controller Install Directory>/jre/lib/security/cacerts

When done, try importing the signed certificate again.
8. Update the alias name on the PKCS12 key you just imported:
keytool -changealias -alias "1" -destalias "s1as" -keystore keystore.jks

9. Start the Controller.
Verify the Controller is secured using SSL
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To make sure the configuration works, use a browser to connect to the Controller over the default
secure port, port 8181:
https://<controller-host>:8181/controller

Make sure the Controller entry page loads in the browser correctly. Also verify that the browser
indicates a secure connection. Most browsers display a lock icon next to the URL to indicate a
secure connection.
After changing the certificate on the Controller, you will need to import the public key of the
certificate to the agent truststore. For information on how to do this, see the topic specific for the
agent type:
EUM aggregator: Troubleshoot Your EUM Setup
Java Agent: Enable SSL (Java)
.NET: Enable SSL (.NET)
When finished, you can turn of the default, non-secure port at 8080. You can disable the port from
the Glassfish administration console.
Change Keystore Password

The default password for the keystore used by the Controller is changeit. This is the default
password for the Glassfish keystore, and is a well-known (and thus insecure) password. For a
secure installation, you need to change it.
Changing the password in this manner does not affect the administration password you
use to access the Glassfish administration console (that is, the console served at:
http://<hostname>:4848). See Administrative Users for information on changing that
password.
To change the password you must use the Glassfish administration tool (rather than the keytool
utility directly). Using the Glassfish administration tool allows the Glassfish instance to access the
keys at runtime.
If you change the keystore password directly using the keytool, the Controller generates the
following error message at start up:
Caused by: java.lang.IllegalStateException: Keystore was tampered with,
or password was incorrect

If you encounter this scenario, change the password using the asadmin utility, as described next.
To change Glassfish passwords

1. Stop the Controller.
2. Change the Glassfish master password:
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2.

<Controller_Installation_Directory>/appserver/glassfish/bin/asadmin
change-master-password --savemasterpassword=true

3. Restart the Controller and make sure it starts error free.
Changing the master password with asadmin changes the password for the keystore and for the
s1as key. It does not change the password of any additional keys you have added to the keystore,
however. If you have added keys to the keystore, you need to change their password to match the
new master password. Use the keytool to change their passwords as follows:
keytool -keypasswd -alias myserver -keystore keystore.jks
-storepass <new master password>

Set the Security Protocol

The Controller uses the TLSv1.2 security protocol for secure connections by default. If you are
using the Controller with an older version of an agent, you may need to modify the Controller's
default security protocol to be compatible with the agent. See Agent - Controller Compatibility
Matrix for the version matches to which this requirement applies.
Configure the Controller Security Protocol

To modify the security protocol on the Controller, use the asadmin command-line utility provided
by the underlying Glassfish application server. The following command shows how to set the
protocol for the secure HTTPS listener on the Controller to SSLv3.
$INSTALL_HOME/appserver/glassfish/bin/asadmin --user admin
--passwordfile $INSTALL_HOME/.passwordfile set
configs.config.server-config.network-config.protocols.protocol.httplistener-2.ssl.ssl3-enabled=true

As shown, you need to provide administrator credentials to run the command. The credentials
should be the same one you use to access the Glassfish Admin Console, which is described on Ac
cess the Administration Console page.
Configure Agent Security Protocol

On the agent side, the .NET agent negotiates with the Controller on the SSL protocol to use based
on settings in the container, so you do not typically need to configure the security protocol used by
the App Agent for .NET.
The table in Agent - Controller Compatibility Matrix lists the security protocol used by different
versions of the App Agent for Java. If you need to modify the default security protocol, either
because you are using an older version of an agent that is incompatible with the Controller or it is
incompatible with an intervening proxy, you can pass a -D system property to the agent.
To specify the use of a specific protocol, pass one of these values SSL, TLS, TLSv1.2, or
TLSv1.1 as the value of the system property:
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-Dappdynamics.agent.ssl.protocol
Configure the Security Protocol

Configure the Security Protocol used by the Controller
To enable TLS and SSL3 for a Controller on Windows
To enable TLS and SSL3 for a Controller on Linux
Configure the Security Protocol for Agents
Configure the Security Protocol used by the Controller

New in 3.8.1 The Controller uses the TLSv1.2 security protocol for secure connections by default.
It is possible to change the security protocols used by the Controller.
This is most likely to be necessary if you are using the Controller version 3.8.1 or later with agents
that don't support TLSv1.2. These agents include:
App Agent for Java version 3.8.1 or earlier (see Agent - Controller Compatibility Matrix for
complete SSL compatibility information)
App Agents running on .NET Framework 4.5 or earlier
If upgrading the agents or .NET framework is not possible, you will need to enable TLSv1 and
SSL3 on the Controller using the asadmin command-line utility, as described here.
These changes require a restart of the Controller application server and thus, will result in service
downtime. You should attempt to apply this change during a service window in which a restart of
the Controller will have the least impact.
To enable TLS and SSL3 for a Controller on Windows

1. Open the Glassfish administrator password file at
<Controller_Home>\appserver\glassfish\config\setpwd.gf
2. Copy the value for the AS_ADMIN_NEWPASSWORD key to your favorite password
manager or temporary file.
3. From a command prompt, change to the Glassfish bin directory, as follows:
cd <Controller_Home>\appserver\glassfish\bin

4. Run the asadmin utility as follows:
asadmin.bat set
configs.config.server-config.network-config.protocols.protocol.
http-listener-2.ssl.ssl3-enabled=true

5. Enter the user name "admin" when prompted.
6. Paste the password you copied from setpwd.gf when prompted.
7. Run the command again to enable TLS:
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7.

asadmin.bat set
configs.config.server-config.network-config.protocols.protocol.
http-listener-2.ssl.tls-enabled=true

8. Enter the user name "admin" when prompted.
9. Paste in the password copied from setpwd.gf when prompted.
10. Restart the Controller application server as described in Start or Stop the Controller.
To enable TLS and SSL3 for a Controller on Linux

1. From the command-line, view the password for the application server administrator:
cat <Controller_Home>/appserver/glassfish/config/setpwd.gf

2. Copy the value for the AS_ADMIN_NEWPASSWORD key to your favorite password
manager or a temporary file.
3. Change to the Glassfish bin directory as follows:
cd Controller/appserver/glassfish/bin

4. Run the asadmin utility as follow to enable SSL3:
./asadmin set
configs.config.server-config.network-config.protocols.protocol.
http-listener-2.ssl.ssl3-enabled=true

5. Enter user name "admin" when prompted.
6. Paste the password you copied from setpwd.gf when prompted.
7. Run the utility again to enable TLS:
./asadmin set
configs.config.server-config.network-config.protocols.protocol.
http-listener-2.ssl.tls-enabled=true

8. Enter user name "admin" when prompted.
9. Paste in password copied from setpwd.gf when prompted.
10. Restart the Controller application server as described in Start or Stop the Controller.
Configure the Security Protocol for Agents

On the agent side, the .NET agent negotiates with the Controller on the SSL protocol to use based
on settings in the container, so you do not typically need to configure the security protocol used by
the App Agent for .NET.
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The table in Agent - Controller Compatibility Matrix lists the security protocol used by different
versions of the App Agent for Java. If you need to modify the default security protocol, either
because you are using an older version of an agent that is incompatible with the Controller or it is
incompatible with an intervening proxy, you can pass a -D system property to the agent.
To specify the use of a specific protocol, pass one of these values SSL, TLS, TLSv1.2, or
TLSv1.1 as the value of the agent SSL protocol system property, -Dappdynamics.agent.ssl.protocol.
Controller Port Settings
Controller Ports
Reinstalling the Controller with New Port Settings
To reinstall the Controller with new port settings
Editing Controller Port Configurations
To change the primary server listening port:
To change the database port:
To change the Glassfish admin listening port:
To change the JMS port:
To change the IIOP listening port:
When deploying AppDynamics, whether using an on-premise or SaaS Controller, you will likely
need to open ports in a network firewall or configure a load balancer to enable communication
between the Controller and App Agents and client browsers. For SaaS, you only need to adjust
your infrastructure to accommodate the HTTPS port provided to you by AppDynamics. For an
on-premises deployment, however, you may need to make additional adjustments.
This topic lists the ports used by the Controller.
Controller Ports

By default the Controller uses the following ports for internal communication among its
components:
Port Name

Default

Application server primary port (HTTP)

8090

Application server primary port (HTTPS)

8181

Database server port

3388

Application server admin port

4848

Application server JMS port

7676

Application server IIOP port

3700

At installation time, the install wizard may suggest other port numbers if the default ports are used
on the target system, or you can enter different ports manually. After installation, you can change
the port settings by either reinstalling the Controller or by editing the port configuration as defined
in the underlying GlassFish application server, as described here.
Reinstalling the Controller with New Port Settings
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Use the reinstall procedure if you want to modify connection settings without editing configuration
files.
To reinstall the Controller with new port settings

1. Shut down the Controller. For instructions see Start or Stop the Controller.
2. Create a complete backup of the Controller installation directory and all of its sub-directories.
3. Re-install the Controller in the same installation directory as your original Controller and choose
the new port settings while running the installer. For instructions see Install the Controller on
Linux or Install the Controller on Windows.
Even though the versions are the same, this step is handled as an upgrade by the Controller
installer.
Editing Controller Port Configurations

If reinstalling the Controller is not convenient, you can edit the ports manually by editing
configuration files used by the application server for the Controller domain.
The following sections list the settings you need to modify to change a port. After making manual
edits to configuration files, you will need to restart the Controller to have your changes take effect.
To change the primary server listening port:

1. In the Controller home directory, navigate to the
appserver/glassfish/domains/domain1/config/ directory.
2. Open domain.xml for editing.
3. Change the port number as it appears in these locations:
The value of the network-listener element with the attribute id="http-listener-1" for the
primary listening port, or http-listener-2 for the secure listening port to the new port
setting.
The JVM argument values for the Controller HTTP port and Controller services port
under the config element named server-config.
4. For each deployed agent, navigate to proxy/conf in the agent home directory and change
the controller-port value in controller-info.xml.
5. Change the serverPort or sslPort number in the Controller home directory:
.install4j/response.varfile. This ensures that the new port number will not be overwritten
upon upgrade.
To change the database port:

1. Under the Controller home directory, edit the file
appserver/glassfish/domains/domain1/config/domain.xml to change the database listening
port where it appears under the jdbc-connection-pool element named controller_mysql_pool. It
appears as the value of the property named portNumber.
2. Edit the file
appserver/glassfish/domains/domain1/imq/instances/imqbroker/props/config.properties to
change the "imp.persist.jdbc.mysql.property.url" variable so that it includes the new port
number. This variable is the JDBC connection string.
3. In db/db.cnf, set the "port=" variable to your new port setting.
4. In the bin/controller.bat (.sh), change the "DB_PORT" variable to your new port setting.
5.
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5. Edit .install4j/response.varfile to change the databasePort value to the new port. This
ensures that the new port number will not be overwritten in a future Controller upgrade.
To change the Glassfish admin listening port:

1. In appserver/glassfish/domains/domain1/config/domain.xml, change the port attribute value
of the http-listener element to the new port. This is the element with an id attribute value of
"admin-listener".
2. Also in the Controller home directory, change the adminPort value in
.install4j/response.varfile. This ensures that the new port number will not be overwritten in a
future Controller upgrade.
To change the JMS port:

1. In appserver/glassfish/domains/domain1/config/domain.xml, change the port attribute value
for the jms-host element with the name attribute of default_JMS_host.
2. Change the jmsPort value in .install4j/response.varfile. This ensures that the new port
number will not be overwritten in a future Controller upgrade.
To change the IIOP listening port:

1. In appserver/glassfish/domains/domain1/config/domain.xml, edit the port attribute value of
the iiop-listener element with an id attribute of orb-listener-1.
2. Change the iiopPort value in <controller_home>/.install4j/response.varfile. This ensures that
the new port number will not be overwritten in a future Controller upgrade.
Deploy with a Reverse Proxy
Concepts
General Guidelines
Using Nginx as a Simple HTTP Reverse Proxy
To route Controller traffic through an Nginx reverse proxy:
Using Apache as a Reverse Proxy
To configure Apache with mod_proxy_http
Configure SSL Termination at the Reverse Proxy
Configure the Proxy for SSL Termination
Configure the Controller for SSL Termination at the Proxy
To configure a mixed protocol channel for an SSL proxy:
Using SSL from the Reverse Proxy to the Controller
Concepts

A common data center design involves putting backend services such as the AppDynamics
Controller in a network behind a DMZ. For the Controller, a network proxy residing in the DMZ acts
as an end-point for the Controller by presenting a virtual IP address for the Controller, since App
Agents and UI browser clients connect to the Controller through the virtual IP.
In addition to providing a security layer, a reverse proxy allows you to move a Controller to another
machine or switch between high availability pairs without having to reconfigure and restart
monitored applications.
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In the sample scenario shown by the diagram, the reverse proxy listens for incoming requests on a
given path, /controller in this case, on port 80. It forwards matching requests to the HTTP listening
port of the primary Controller at appdhost1:8090. In terms of network impact in this scenario,
switching active Controllers from the primary to the secondary in this scenario only requires the
administrator to update the routing policy at the proxy so that traffic directed to the secondary
instead of the primary.
If clients use SSL, the reverse proxy can terminate SSL connections or maintain SSL through to
the Controller. Terminating SSL at the proxy removes the processing burden from the Controller
machine. It can also simplify administration for the data center as a whole by centralizing SSL key
management to a single point and it allows you to use alternative PKI infrastructures like
OpenSSL.
About these Instructions

There are various types of devices and software that can act as a reverse proxy. For example, Ngi
nx, HAProxy, Apache Web Server, or an application-level load balancer such as F5's BIG-IP can
all act as a reverse proxy for the Controller.
This page provides general considerations for setting up the Controller with a reverse proxy. It also
provides sample configurations for a few specific types of proxies.
It is important to note that this information is intended for illustration purposes only. The
configuration requirements for your own deployment is likely to vary greatly, depending on the
existing environment, the applications being monitored, and the practices and policies of your
organization.
While AppDynamics supports Controllers that are deployed with a reverse proxy, AppDynamics
Support cannot guarantee help with specific set up questions and issues particular for your
environment or the type of proxy you are using. For this type of information, please consult the
documentation provided with your proxy technology. Alternatively, try posting the question to the A
ppDynamics community.
General Guidelines

The following describe general requirements, considerations, and features for deploying the
AppDynamics Controller and App Agents with a reverse proxy.
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In the Controller configuration, add a JVM option named
-Dappdynamics.controller.ui.deeplink.url to the domain configuration file, domain.xml, or
using the modifyJvmOptions utility. As the value of the option, provide the hostname or
virtual IP address for the Controller as exposed at the proxy. For example:
<java-config ...>
...
<jvm-options>-Dappdynamics.controller.ui.deeplink.url=controlle
r.corp.example.com<jvm-options>
</java-config>

The Controller uses this value to compose the deep link URLs it exposes in the UI.
If the proxy sits between monitored tiers in the application, make sure that the proxy passes
through the custom header that AppDynamics adds for traffic correlation, singularityheader.
Most proxies pass through custom headers by default.
For App Agents, the Controller Host and Controller Port connection settings should point to
the VIP or hostname and port exposed for the Controller at the reverse proxy. For details
see Connect the Controller and Agents.
If using SSL from the agent to the proxy, ensure that the security protocols used between
the App Agent and proxy are compatible. See the compatibility table for the SSL protocol
used by each version of the agent.
If the proxy (or other network device) needs to check for the availability of the Controller, it
can use Controller REST resource at: http://<host>:<port>/controller/rest/serverstatus. If the
Controller is active and if in high availability mode, is the primary, it returns an XML
response similar to this one:
<serverstatus vendorid="" version="1">
<available>true</available>
<serverid/>
<serverinfo>
<vendorname>AppDynamics</vendorname>
<productname>AppDynamics Application Performance
Management</productname>
<serverversion>003-008-000-000</serverversion>
</serverinfo>
</serverstatus>

If the Controller is in standby Controller this resource returns an error response.
The following sections provide notes and sample configurations for a few specific types of proxies,
including Nginx and Apache Web Server.
Using Nginx as a Simple HTTP Reverse Proxy

Nginx is a commonly used web server and reverse proxy available at http://nginx.org/.
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To use Nginx as a reverse proxy for the Controller, simply include the Controller as the upstream
server in the Nginx configuration. If deploying two Controllers in a high availability pair
arrangement, include the addresses of both the primary and secondary Controllers in the
upstream server definition.
The following steps walk you through the set up at a high level. It assumes you have already install
ed the Controller and have an Nginx instance, and you only need to modify the existing
configuration to have Nginx route traffic to the Controller.
The sample network layout represented in the configuration in these steps is:

To route Controller traffic through an Nginx reverse proxy:

1. If the Controller is running, shut down the Controller.
2. Add a JVM option named -Dappdynamics.controller.ui.deeplink.url to the domain
configuration file, domain.xml, or using the modifyJvmOptions utility.
3. In the Nginx home directory on the reverse proxy machine, open the conf/nginx.conf file for
editing.
4. In the configuration file, add a cluster definition the specifies each Controller as an upstream
server. For example:
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upstream appdcontroller {
server 127.0.15.11:8090 fail_timeout=0;
}
server {
listen 80;
server_name appdcontroller.example.com;
expires 0;
add_header Cache-Control private;
location / {
proxy_set_header
proxy_set_header
proxy_set_header
proxy_set_header
$proxy_add_x_forwarded_for;
proxy_pass

Host $host;
X-Real-IP $remote_addr;
X-Forwarded-Proto https;
X-Forwarded-For

http://appdcontroller;

}
}

In the sample, the Controller resides on 127.0.15.11 and has the fully qualified domain name
appdcontroller.example.com.
5. Restart the Nginx server to have the change take effect.
6. Restart the Controller.
After the Controller starts, it should be able to receive traffic through Nginx. As an initial test of the
connection, try opening the Controller UI via the proxy, that is, in a browser, go to
http://<virtualip>:80/controller. For the App Agents, you'll need to configure their proxy host and
port settings as described in the general guidelines above.
Using Apache as a Reverse Proxy

To use Apache as a reverse proxy, you need to make sure the appropriate Apache module is
installed and enabled in your Apache instance. For HTTP proxying, this is typically
mod_proxy_http. The mod_proxy_http module support proxied connections that use HTTP or
HTTPS.
To configure Apache with mod_proxy_http

1. If the Controller is running, shut it down.
2. Add a JVM option named -Dappdynamics.controller.ui.deeplink.url to the domain
configuration file, domain.xml, or using the modifyJvmOptions utility.
3. On the machine that runs Apache, check whether the required modules are already loaded
by your Apache instance by running this command:
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3.

apache2ctl -M

In the output, look for proxy modules as follows:
proxy_module (shared)
proxy_http_module (shared)

The proxy_module is a dependency for proxy_module_http.
4. If they are not loaded, enable the Apache module as appropriate for your distribution of
Apache. For example, on Debian/Ubuntu:
a. Type the following:
sudo a2enmod proxy_http

b. Restart Apache:
sudo service apache2 restart

5. Add the proxy configuration to Apache. For example, a configuration that directs clients
requests to the standard web port 80 at the proxy host to the Controller could look similar to
this:
<Proxy *>
Order deny,allow
Allow from all
</Proxy>
ProxyRequests
ProxyPreserveHost

Off
On

ProxyPass /controller
http://controller.example.com:8090/controller
ProxyPassReverse /controller
http://controller.example.com:8090/controller

6. Apply your configuration changes by reloading Apache modules. For example, enter:
sudo service apache2 reload

7. Start the Controller.
After the Controller starts, test the connection by opening a browser to the Controller UI as

Copyright © AppDynamics 2012-2014

Page 336

exposed by the proxy. To enable AppDynamics App Agents to connect through the proxy, be sure
to set the proxy host and port settings in the proxy, as described in the general guidelines above.
Also be sure to apply any of the other general guidelines described in the general guidelines
above.
Configure SSL Termination at the Reverse Proxy

This section describes how to set up security when the client-side connection to the proxy uses SSL
that's terminated at the proxy. This assumes that the proxy and Controller are in a secured data center
and the App Agents or UI browser client connections are from a potentially insecure network.

Terminating SSL at a proxy offloads the burden of SSL processing from the Controller to the
proxy. This configuration is strongly recommended when deploying the Controller to large scale,
high workload environments. Terminating SSL at a proxy also provides the benefit of having a
central point in the data center for security certificate and key management.
This section provides an sample configuration for Nginx, but the concepts translate to other types
of reverse proxies as well.

Configure the Proxy for SSL Termination

To perform SSL termination at the reverse proxy, you need to:
Ensure that the App Agents can establish a secure connection with the proxy. See Agent Controller Compatibility Matrix for SSL settings for various versions of the agent. Ensure that
the proxy includes a server certificate signed by an authority that is trusted by the agent.
Otherwise, you will need to install the proxy machine's server key.
If using .NET App Agents in your environment, verify that the reverse proxy server uses a
server certificate signed by a certificate authority (CA). The .NET App Agent does not permit
SSL connections based on a self-signed server certificate.
Configure the proxy to forward traffic between it and the Controller to a secure port between
it and the client.
Configure a mixed-use (SSL and non-SSL) channel on the listening port on the Controller,
as described below. Use caution when configuring the Controller in this manner. In this
mode, the Controller assumes
The client App Agents and browser clients under this configuration must use the secure port
to communicate with the Controller (i.e., the proxy). Configuring a mixed channel on the
Controller as described here causes the agents to perform as if they were using a secure
port. Therefore, you need to ensure that they use a secure port only.
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A complete example configuration with Nginx performing SSL termination for the Controller would
look something like this:
upstream appdcontroller {
server 127.0.15.11:8191 fail_timeout=0;
}
server {
listen 80;
server_name appdcontroller.example.com;
return 301 https://$host$request_uri;
}
server {
listen 443;
server_name appdcontroller.example.com;
ssl on;
ssl_certificate /etc/nginx/server.crt;
ssl_certificate_key /etc/nginx/server.key);
ssl_session_timeout 5m;
ssl_protocols SSLv2 SSLv3 TLSv1 TLSv1.1 TLSv1.2;
ssl_ciphers
ALL:!ADH:!EXPORT56:RC4+RSA:+HIGH:+MEDIUM:+LOW:+SSLv2:+EXP;
ssl_prefer_server_ciphers
on;
expires 0;
add_header Cache-Control private;
location / {
proxy_set_header
proxy_set_header
proxy_set_header
proxy_set_header
$proxy_add_x_forwarded_for;
proxy_redirect
proxy_pass
}
}

Host $host;
X-Real-IP $remote_addr;
X-Forwarded-Proto https;
X-Forwarded-For
http:// https://;
http://appdcontroller;

This example builds on the configuration shown in the simple passthrough example. In this one, any
request received on the non-SSL port 80 is routed to port 443. The server for port 443 contains the
settings for SSL termination. The ssl_certificate_key and ssl_certificate directives should identify the
location of the server security certificate and key for the proxy.
The configuration also indicates the SSL protocols and ciphers accepted for connections. The security
settings need to be compatible with the AppDynamics App Agent security capabilities, as described on
the Agent - Controller Compatibility Matrix page.
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To work with the Controller, you must configure the Controller with a mixed-channel HTTP listener, as
described in the following section, Configure the Controller for SSL Termination at the Proxy.
Configure the Controller for SSL Termination at the Proxy

Be sure to set up the proxy to redirect server side traffic to the secure channel on the client side if
you are performing this configuration. If you enable a mixed use channel, as described here, you
need to be sure that the clients are configured to use the secure channel.
To configure a mixed protocol channel for an SSL proxy:

1. Stop the Controller application server:
./controller.sh stop-appserver

2. Open the services-config.xml file for editing. You can find it in the following directory:
<Controller_installation_home>/appserver/glassfish/domains/doma
in1/applications/controller/controller-web_war/WEB-INF/flex

3. Find the channel-definition element with an id value of my-secure-amf.
4. Replace the default value of the class attribute of the endpoint URL element,
flex.messaging.endpoints.SecureAMFEndpoint, with a new value of
flex.messaging.endpoints.AMFEndpoint. The resulting element should look like this:
<channel-definition id="my-secure-amf"
class="mx.messaging.channels.SecureAMFChannel">
<endpoint
url="https://{server.name}:{server.port}/{context.root}/message
broker/amfsecure" class="flex.messaging.endpoints.AMFEndpoint"/>
<properties>
<add-no-cache-headers>false</add-no-cache-headers>
<connect-timeout-seconds>10</connect-timeout-seconds>
</properties>
</channel-definition>

5. Start the application server:
./controller.sh start-appserver

Using SSL from the Reverse Proxy to the Controller

Have the proxy connect to the Controller with SSL requires a minor modification to the proxy
configuration. Simply specify the use of HTTPS as the protocol to connect to the backend or
upstream server. In other words, for the Nginx configuration, this simply requires you to modify the
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proxy_pass value as follows:
proxy_pass

https://appdcontroller;

To complete the configuration, make sure you have configured SSL on the Controller as described
in Controller SSL and Certificates.

Controller High Availability

Overview of High Availability
Connecting Agents to Controllers in an HA Scenario
TTL (Time To Live) of DNS A Records
Configuring Agents for an HA Controller
Learn More
This page provides an overview of using Controllers in HA mode. While this page provides an
overview, the detailed steps for setting up an HA pair (along with procedures for failing over and
failing back between the Controllers) vary depending on your environment and Controller profile.
For detailed instructions, along with scripts that can automate procedures related to high
availability, contact AppDynamics Support.
Overview of High Availability

Deploying a pair of Controllers in High availability mode helps to minimize the disruption caused by
server or network failure, administrative downtime, or other interruptions. In HA mode, two
Controllers operate as a failover pair, one acting as the primary Controller and the other as the
secondary.
Controllers acting as an HA pair must be the same version and their environments must match.
In HA mode, each Controller has its own MySQL database with a full set of the data generated by
the Controller. The primary Controller has the master MySQL database, which replicates data to
the secondary Controller's slave MySQL database. HA mode uses a MySQL Master-Master
replication type of configuration. The disk space must be equivalent in the HA pair.
The following figure shows the deployment of an HA pair at a high level. In this scenario, the
agents connect to the primary Controller through a load balancer, F5, as depicted in the diagram.
Agents and Controllers are distributed in different data centers for redundancy. The Controllers
must have a network connection to enable MySQL replication.
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Connecting Agents to Controllers in an HA Scenario

Under normal conditions, the App Agents and Machine Agents communicate with the primary
Controller. If the primary Controller becomes unavailable, the agents need to communicate with
the secondary Controller. The agents require information about both Controllers to ensure that this
communication occurs.
Each Controller and MySQL database has a unique IP address, for example:
Primary Controller has an IP address of 101.xxx.xxx.xxx
Primary (master) MySQL Database has an IP address of 201.xxx.xxx.xxx
Secondary Controller has an IP address of 102.xxx.xxx.xxx
Secondary (slave) MySQL Database has an IP address of 202.xxx.xxx.xxx
When you configure the agents, AppDynamics recommends using the Controller DNS address
(controller.company.com) instead of the IP address. For example, initially controller.company.com
will have the IP address of 101.xxx.xxx.xxx. When the primary fails you can change the DNS to
102.xxx.xxx.xxx without changing each of the agents.
For the load balancing scenario, the load balancer could have an IP address of 103.xxx.xxx.xxx
and it balances the load between 101.xxx.xxx.xxx and 102.xxx.xxx.xxx. The agents need to be
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configured with the load balancer virtual IP address for the Controller pair.
TTL (Time To Live) of DNS A Records

If using the DNS addresses as the switching mechanism for agents, the system administrator of
the DNS server should set the TTL (time to live) of the DNS A records to a short time (about 60
seconds), to more frequently refresh the IP address of the HA Controller in the agent DNS caches.
This ensures that the agent gets a new name to IP translation for the HA Controller every minute
or so. Otherwise the agent will continue to send messages to the failed controller until the TTL
expires. If the TTL is set to the default of 84600, the agents keep using the old IP for a whole day
and may not failover to the secondary controller in a timely fashion.
Configuring Agents for an HA Controller

When configuring the agents for a Controller in HA mode, you set the <controller-host> properties
in the controller-info.xml (Java, PHP) or config.xml (.NET) files for an App Agent and in the
controller-info.xml file for a Machine Agent.
If using the DNS name for the controller-host property use the DNS name as the controller-host
value. For example:
<controller-host>controller.company.com</controller-host>

If using a load balancer, the value would be the virtual IP (VIP) for the Controller or a hostname for
the VIP.
For the .NET Agent, set the Controller high availability attribute to true in the config.xml. See .N
ET Agent Configuration Properties.
For more information see Install and Upgrade.
Learn More

Controller Data Backup and Restore
App Agent for Java Configuration Properties
.NET Agent Configuration Properties
Tuning for Large Scale Deployments
Linux Settings
File System and RAID Recommendations
Glassfish Configuration
To configure Glassfish
To update the Glassfish settings
MySQL Configuration
To configure MySQL
Controller Configuration
To change the Controller settings
Additional Setup for Environments with More than 500 Nodes
Split Traffic on Two HTTP listeners
To split traffic on two HTTP listeners
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Learn More
A large scale AppDynamics deployment typically requires some additional performance tuning,
both to the Controller configuration and to the host environment. A large scale deployment is one
in which the Controller monitors 250 or more nodes. This matches the Extra Large performance
profile, as defined in Controller Performance Profiles.
The recommendations on this page are provided as general guidelines only. For details on the
recommendations and for advice specific for your Extra Large profile deployment, consult with
your AppDynamics Support representative.
In addition to the guidelines and configuration settings described here, it is especially important
that any machine that hosts the Controller in high workload environments meets Controller System
Requirements.
Linux Settings

Use the following settings for the operating system on which the Controller runs:
Use the Deadline scheduler.
Set swappiness to 0. See Configure Swappiness on Linux for more information.
Set the open file limit to 819200 or greater. See Configure File Descriptor Limits on Linux for
more information.
Set the per-process open file limit for soft and hard limits to 819200 or greater.
Allow Web server to retry longer during stalls by setting higher TCP timeouts.
If using the Splunk extension, increase the maximum number of user processes to 2048.
File System and RAID Recommendations

Recommended file system: XFS.
Recommended RAID version: There are only minor performance differences between RAID
5, 6, and 10. The reasons to use one over another are purely for level of safety and space
requirements. The more disks you have in any RAID configuration, the better the
performance, since you have more stripes to work concurrently in doing disk I/O.
Recommended RAID configuration:
Use a RAID Controller with a Battery Backup Unit (BBU) to allow the database to use
O_DIRECT sync mode as the flush method for faster disk writes. Never set
O_DIRECT without a BBU. You can specify this setting using the
innodb_flush_method variable in <Controller_install_directory>/db/db.cnf. When not
specified in the file (as is the case by default), MySQL uses the default flush method,
fdatasync. See the MySQL documentation for more information.
Disable individual hard drive from using onboard cache. All caching is to be done by
RAID Controller.
For Storage Area Network (SAN) deployments, use multipath I/O for optimal performance
and availability.
For either SAN or RAID controller systems, use the following file system mount options for
your database storage mountpoint: "noatime,nodiratime,nobarrier,data=writeback"
On board disks are the easiest option to assure performance.
When you use remote disks (such as SAN or NAS) the configuration must be able to
support very heavy disk I/O with very low latency. Requirements for the Controller database
are similar to any production database that you run.
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LVM partitions can be useful especially for doing quick hot backups with LVM snapshots.
Glassfish Configuration

New in 3.7 The Glassfish server used by the Controller is now version 3.1.2.2, and the path
to the domain.xml file changed. If you have previously applied Glassfish settings as
described in this document, you need to update those settings as per the instructions
below.
The Controller uses Glassfish version 3.1.2.2 as its embedded application server. For better
scalability and performance, you should tune Glassfish with settings based on your final hardware
sizing.
For more information about configuring Glassfish see the Glassfish documentation.
To configure Glassfish

1. Shut down the Controller.
2. Edit the following file under the Controller home directory:
/appserver/glassfish/domains/domain1/config/domain.xml
The settings in the file are described in To update the Glassfish settings.
3. Restart the Controller.
To update the Glassfish settings

1. Set the thread count (XX) to a value of 12 X # of CPU cores.
In the tag <thread-pools> change the line containing "http-thread-pool" to:
<thread-pool name="http-thread-pool" max-thread-pool-size="XX"
min-thread-pool-size="16" max-queue-size="32768"></thread-pool>

If your Controller instance was upgraded from an earlier version, delete the following
element if present, as it applies to Glassfish v2 only:
<request-processing header-buffer-length-in-bytes="8192"
initial-thread-count="16" request-timeout-in-seconds="300"
thread-count="XX" thread-increment="1"/>

2. Replace the TCP transport element under server-config with the following. Here we've set
the depth of the connection pool queue to 32K to allow for connections to queue up instead
of being dropped during peak load bursts. Replace the XX value in the acceptor-threads
attribute with the number of cores in your system.
<transport buffer-size-bytes="32768"
max-connections-count="32768" name="tcp" keep-alive="true"
acceptor-threads="XX"></transport>
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Note that there are two transport elements with the name value of tcp in the file. Be sure to
modify the first one, below the server-config element.
If your Controller instance was upgraded from an earlier version, delete the following
element if present, as it applies to Glassfish v2 only:
<connection-pool max-pending-count="32768"
queue-size-in-bytes="32768" receive-buffer-size-in-bytes="32768"
send-buffer-size-in-bytes="32768"/>

3. Increase the buffer size. In the <protocols> section under <protocol name="http-listener-1">,
change the next line to:
<http request-timeout-seconds="300" max-connections="-1"
request-body-buffer-size-bytes="32768"
header-buffer-length-bytes="32768" timeout-seconds="300"
default-virtual-server="server" send-buffer-size-bytes="32768">

4. Set the Heap size to approximately 20 to 40% of the RAM size on your machine: higher
Heap size for lower RAM sizes, lower Heap for high-end RAM sizes. Set Xmn to 1/3 of the
Xmx setting.
<jvm-options>-Xmx30g</jvm-options>
<jvm-options>-Xms30g</jvm-options>
<jvm-options>-Xmn10g</jvm-options>

5. Replace the garbage collection settings with these specially tuned settings:
<jvm-options>-XX:+UseConcMarkSweepGC</jvm-options>
<jvm-options>-XX:+UseParNewGC</jvm-options>
<jvm-options>-XX:+ScavengeBeforeFullGC</jvm-options>
<jvm-options>-XX:TargetSurvivorRatio=80</jvm-options>
<jvm-options>-XX:SurvivorRatio=6</jvm-options>
<jvm-options>-XX:+UseBiasedLocking</jvm-options>
<jvm-options>-XX:MaxTenuringThreshold=15</jvm-options>
<jvm-options>-XX:ParallelGCThreads=16</jvm-options>
<jvm-options>-XX:+OptimizeStringConcat</jvm-options>
<jvm-options>-XX:+UseStringCache</jvm-options>
<jvm-options>-XX:MaxPermSize=256m</jvm-options>
<jvm-options>-XX:+UseCompressedOops</jvm-options>
<jvm-options>-XX:+UseCMSInitiatingOccupancyOnly</jvm-options>
<jvm-options>-XX:CMSInitiatingOccupancyFraction=95</jvm-options>

MySQL Configuration
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The Controller uses MySQL as its the database server. You should tune MySQL for scalability and
better performance.
To configure MySQL

1. Shut down the Controller.
2. Configure the settings in the database configuration file,
<Controller_Installation_Directory>/db/db.cnf, with these values. Since some of these
name/value pairs are already in the db.cnf file, search in the file for each of the variables by
name. If a variable already exists, simply replace the assigned value. Otherwise, add the
name/value pair to the file.
thread_cache_size=120
table_definition_cache=500
open-files-limit=40960
innodb_open_files=3000
table_open_cache=4000
lock_wait_timeout=300
query_cache_size=0
long_query_time=4
innodb_flush_method=O_DIRECT # ONLY DO IF YOU HAVE BATTERY BACKED RAID !
innodb_buffer_pool_size= 11264M # This should be based on available RAM.
This value should be approximately 40 to 60% of the RAM size.

3. Restart the Controller.
4. Your database should now be running with the new settings, but we suggest that you verify
your database settings. To do so:
a. Log in to the database:
<Controller_installation_directory>/bin/controller.sh
login-db

b. Enter the "SHOW VARIABLES;" command and verify that the variables are assigned
the values you expect as reported in the command output.
Controller Configuration

You need to adjust some Controller settings for configurations that handle large amounts of traffic.
This includes increasing the events, snapshots, and buffer sizes, increasing the read and write
thread counts, decreasing the node retention and node permanent deletion periods, etc.
To change the Controller settings

1. Make sure Controller is running.
2. Log into the Controller Administration console at <host>:<port>/controller/admin.html using
the root password.
See Access the Administration Console.
3. In the Administration Console, select Controller Settings.
4. Modify each of the following settings, clicking Save to save each update.
disable.historic.transactional.flow = true
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4.
Allows dashboards to draw quickly by using cache values from the cache setting
above. For large deployments this should always be set this to true to avoid timeout
errors.
business.transaction.retention.period = 48
events.buffer.size = 50
snapshots.buffer.size = 200
metrics.buffer.size = 600
node.permanent.deletion.period = 168
node.retention.period = 6
read.thread.count = 3
Number of threads to use simultaneously to do READS from the database. Set this to
20% of the number of CPU cores but not greater than 4.
write.thread.count = 4
Number of threads to use simultaneously to load data into the database. Set this to
the same value as read.thread.count but not greater than 4.
Additional Setup for Environments with More than 500 Nodes

Additional recommendations apply for environments that consists of more than 500 nodes. For
these environments, AppDynamics recommends that you split traffic from the UI and App Agents
to different ports on the Controller, as described below.
In addition, AppDynamics recommends terminating SSL at a load balancer or HTTP proxy in front
of the Controller. This alleviates the workload of SSL processing from the Controller. For
information on configuring a reverse proxy, see Deploy with a Reverse Proxy.
Split Traffic on Two HTTP listeners

The Controller is preconfigured with two active HTTP listeners, one for SSL and the other for
non-SSL. While you can create an additional HTTP listener, in most cases it will make sense to
split traffic from agents and the UI between the two existing ports.
To split traffic on two HTTP listeners

1. Edit the domain.xml file. There are already two listeners (look for “http-listener” tags), one for
SSL and another for non-SSL access. One of them is being used by your agents. Find the
other one, and use it as your GUI listener.
2. Change the port number and remove the SSL line if needed. The GUI listener should look
similar to the following example:
<http-listener acceptor-threads="1" address="0.0.0.0"
blocking-enabled="false" default-virtual-server="server"
enabled="true" family="inet" id="http-listener-1" port="8080"
security-enabled="false" server-name="" xpowered-by="true">
<property name="proxiedProtocols" value="ws/tcp"/>
</http-listener>

Learn More

Controller System Requirements
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Measuring Disk Performance Using a Script
Configure the SMTP Server
To configure the SMTP server
To troubleshoot notifications
Learn More
To enable email or SMS notifications from the Controller, you need to configure SMTP server
settings for your environment.
To configure the SMTP server

1. As an administrator in the Controller UI, click Settings -> Email / SMS Configuration.
2. Check Enable Email/SMS Notifications.
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3. Provide connection information about the SMTP host, port, connection information, and
authentication.
Use a SaaS Controller
Each machine that hosts a SaaS Controller includes an SMTP service. To use the
provided SMTP service, the configuration for SaaS Controllers settings are:

SMTP Host: localhost
SMTP Port: 25
No authentication is needed.
4. If you want to add any text to the beginning of the notification, type it into the Notification
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4.
Header Text field.
5. If using SMS, select a carrier from the pulldown list or add a custom carrier's gateway name
"@mySMScarrier.com".
6. Test the configuration by sending an email.

7. Save the settings.
To troubleshoot notifications

If you do not receive notifications for health rule violations, it could be because the SMTP server
timeout is set too short a period of time. To troubleshoot this problem:
1. Log in to the Administration Console.
2. Select the Controller Settings option.
3. Increase the mail.smtp.socketiotimeout global configuration property. The default setting is 30
seconds.
Learn More

Notification Actions
SMTP Service for SaaS

Automation
AppDynamics Automation and Cloud Auto-Scaling

AppDynamics Pro allows you to set up
workflows to automate commonly used
tasks, like running scripts and making
configuration changes that may require
several steps to complete. It also gives
you a mechanism to trigger automatic
cloud-based scaling, creating and deleting
instances in the cloud in response to load
or other metrics.

Expert Advice
"Cloud Auto Scaling using AppDynamics"
by Pranta Das

To show general automation and cloud-scaling features in the UI

Automation and cloud features in the AppDynamics UI are hidden by default. To show the
automation features:
1. In the upper right menu bar click the User icon

-> My Preferences.

2. In the Advanced Features panel check Show Cloud Auto-Scaling features.
The main Cloud Auto-Scaling menu displays in the lower part of the left navigation bar, and Alert
& Respond->Cloud Auto-Scaling also displays. These give you access to cloud-scaling features
and workflow creation.
You can access the automation functionality in two places, based on the granularity of your use.
The scope of the main Cloud Auto-Scaling menu is global for the controller tenant.
The scope of the Alert & Respond->Cloud Auto-Scaling menu is the application.
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To get an overview of workflow creation, see Workflow Overview.

Learn More
Best Practices for Monitoring a Dynamic Cloud Environment
Workflow Overview
Workflows
Task Templates
Workflow Creation Prerequisites
An AppDynamics workflow is a set of commonly executed actions organized together into a
repeatable, automated flow. Workflows can be run manually, on a repeating schedule, or as the
action taken by a policy that has been triggered by a performance event, like a health rule
violation. For more information about health rules, policy, and actions see Health Rules, Policies
and Actions.
Workflows

AppDynamics workflows are divided into steps, based on five basic step-types, which indicate
generally the type of action each is designed to accomplish:
Create new Machines and and configure Them
As the name implies, this step-type is used to launch new instances in the cloud, and to
complete any necessary configuration tasks on them once they are started.
Terminate Machines
This step-type is used to terminate cloud instances and to complete any related tasks.
Configure existing Machines
This step-type is used to complete any necessary tasks on cloud-based machines that are
already deployed.
Configure a specific Machine
This step-type is used to complete any necessary tasks on any running machines
instrumented with the Machine Agent, cloud-based or not.
Manual
This step-type pauses workflow execution until required manual steps are taken.
Workflows are executed by the Machine Agent, which must be available on every target machine.
Task Templates

The basic work of the launch and terminate step-types is taken care of by the step-type itself, but
all other workflow work is defined and executed using tasks. Tasks are sequential units of code
execution, with defined inputs and outputs. AppDynamics provides templates for common tasks,
such as running Ant on a supplied build file or creating a specified schema in a MySQL database.
You use these templates to create your own tasks, with the inputs and outputs you need.
In addition, there are task templates that are used to launch shell or batch scripts.
You can also create custom task templates.
Workflow Creation Prerequisites

To prepare for creating workflows, you need to do the following:
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1. If you have not already done so, Install the Standalone Machine Agent for every machine on
which you wish to run workflows.
If you are using .NET, you must also install the Standalone Machine Agent, as the embedded
.NET machine agent does not support workflow automation. See Install Standalone Machine
Agent in .NET environment.
2. If you want to use any shell/batch scripts in your workflows, create them.
3. If you want to use workflows to interact with the cloud, register your cloud provider and the
images on that cloud provider that you are going to use to create your machines and make sure
you have the appropriate AppDynamics cloud connector available to use. See Cloud Computing
Workflows.
4. Check the Task Library and make sure you have task templates appropriate to your needs.

Learn More
Create a Workflow and Workflow Steps
Cloud Computing Workflows
Policies
Create a Workflow and Workflow Steps

Create a New Workflow
Create Workflow Steps
Select the Step-Type
To add a "Create New Machine" step
To add a "Terminate Machines" step
To add a "Configure existing machines" step
To add a "Configure a particular machine" step
To add a "Manual" step
This topic describes how to create a workflow in a specific application. Before you start, make
sure you have completed all the prerequisites. See Workflow Creation Prerequisites.
A workflow is constructed as a hierarchy:
The workflow is the root of the hierarchy. It has a name.
Workflow steps are the children of the workflow. They are based on step-types. Each of the
steps also has a name.
Each workflow step may have tasks, as needed. They are based on task templates. Each
task has a name.
Create a New Workflow

1. In the left navigation pane of the UI, select the appropriate application
2. Click Alert & Respond -> Cloud Auto-Scaling -> Workflows.
Cloud Auto-Scaling features (under User -> My Preferences -> Advanced Features) must be
enabled for this item to be visible. See Automation.
3. Click New +.
3. Enter a name and provide a brief description. The name is how you will access the workflow
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when you create policies and schedules.
4. Click Create Workflow.
5. Go on to create a set of workflow steps, adding them individually until you have completed your
set up. See Create Workflow Steps.
6. Click Save.

Create Workflow Steps

To create a workflow, you create a set of workflow steps. Each step has a step-type, and may
have one or more tasks that it must complete.
Select the Step-Type

You must first select the kind of workflow step you are creating.
3. Click the Steps + icon to designate the step-type of the workflow.
The Create Workflow Step window appears.
4. Give the step a name.
5. Select the type of step:
Create new Machines and and configure Them
As the name implies, this step-type is used to launch new instances in the cloud, and
to complete any necessary configuration tasks on them once they are started.
Terminate Machines
This step-type is used to terminate cloud instances and to complete any related tasks.
Configure existing Machines
This step-type is used to complete any necessary tasks on cloud-based machines that
are already deployed.
Configure a specific Machine
This step-type is used to complete any necessary tasks on any running instrumented
machines, cloud-based or not.
Manual
This step-type pauses workflow execution until required manual steps are taken.
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See below for specific instructions for each step-type.

6. Use the Tasks + icon to add any necessary tasks to the step. See Add Tasks for Workflow
Steps.
7. Click Steps + icon to add the next step.
8. Click the Save icon in the upper left corner when you have completed your workflow.
To add a "Create New Machine" step

1.Highlight the appropriate icon.
2. Select the cloud provider you wish to use from the Select a Compute Cloud dropdown. If you
have not yet registered your provider, you can click Register a Compute Cloud. See Compute
Clouds for more information on registering cloud providers.
3. Select the machine image you wish to use from the Select an Image dropdown. If you have not
yet registered your provider, you can click Register an Image. See Machine Images and Instances
for more on registering machine images.
4. Indicate the number of machines you wish to create with this workflow step.
5. In case there are connection issues, specify a timeout, after which the workflow will stop trying
to complete the flow.
6. Click Create Workflow Step to create the step for your workflow.
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You are returned to the Steps + screen.
4. You can now add any tasks to the workflow step you have just created. See Add Tasks for
Workflow Steps.
To add a "Terminate Machines" step

Use this step to terminate a specific machine or a group of machines in the cloud that were
created using the “Create new Machines and Configure them” step.
1. Select the computer provider that is running the instance and the machine image that was used
in creating the machine.
2. Select the tier or tiers running on the machines to terminate.
3. In case there are connection issues, specify a timeout, after which the workflow will stop trying
to complete the flow.
4. Indicate the number of machines that match the criteria to terminate.
5. Click Create Workflow Step to create the step for your workflow.
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5. You are returned to the Steps + screen.
6. You can now add any tasks to the workflow step you have just created. See Add Tasks for
Workflow Steps.
To add a "Configure existing machines" step

Use this step to run tasks on the virtual machines that were previously created as a “Create new
Machines and Configure them” step.
1. Select the computer provider that is running the instance and the machine image that was used
in creating the machine.
2. Select the tier or tiers to be configured
5. Click Create Workflow Step to create the step for your workflow.
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5. You are returned to the Steps + screen.
6. You can now add any tasks to the workflow step you have just created. See Add Tasks for
Workflow Steps.
To add a "Configure a particular machine" step

Use this step to run tasks on a machine on any machine that is running on your system that is
instrumented with the Standalone Machine Agent.
1.Select the machine you wish to affect from the list.
2. Click Save.
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3. You can now add any tasks to the workflow step you have just created. See Add Tasks for
Workflow Steps.
To add a "Manual" step

Use this step if your workflow needs manual user intervention.
1. Click Save to create this step for your workflow.
When a workflow with this step-type in it is run, you must re-start the workflow manually when
you have completed your non-automated work.
Add Tasks for Workflow Steps

Tasks are the basic unit of execution for a workflow. You create tasks from templates in the task
library. Once they are created and customized they can be added to each step of a workflow.
To understand how to create a workflow and workflow steps, see Create a Workflow and Workflow
Steps.
The Task Library

You use the Task Library to select task templates from which to make your tasks. There are three
kinds of templates in the Task Library:
Default task templates:
AppDynamics ships with templates for many common tasks. See Available Task Templates.
Templates that launch your shell or batch scripts:
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You can automate the running of scripts in blocking or non-blocking mode. See Create
Custom Tasks Using Shell or Batch Scripts
Task templates that you create.
See Create a New Task Template Using XML.
Create a Task

1.In the left nav bar of the UI, select an application.
2. Click Alert & Respond -> Cloud Auto-Scaling -> Tasks.
3. Click New +. The Create Task window opens.
3. Give the task a name.
4. Scroll through the task template list to find a suitable template.
5. Click the template name: the parameter UI is displayed.

6. Select the Input Parameters tab to specify what values should serve as the input to the
task. Asterisks indicate the required parameters.
If appropriate, you can use a workflow variable which is evaluated at runtime. Click the variable
icon

to access the Select Variable popup.
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The types of workflow variables include:
Shared Variables: This variable stores a value that is accessible by more than one task.
Tier IP Addresses: This variable returns a comma separated list of IP addresses of nodes
in a tier.
Machine IP: This variable returns the IP address of the machine where the task is
executing.
Task Output: This variable returns a value which is output from another task. To use a
task's output, the Task must define output parameters, and it must have executed before the
Task that uses it.
6. Select the Output Parameter Binding tab and enter values if needed.
7. Click Create Task.
8. Repeat to create as many tasks as necessary.
A list of tasks is created.
Add a Task to a Workflow Step

1.In the left nav bar of the UI, select an application.
2. Click Alert & Respond -> Cloud Auto-Scaling -> Workflows.
3. To add the task to an existing workflow, select the workflow and click Edit. Or you can create a
new workflow. See Create a Workflow and Workflow Steps.
4. Click the Task + icon in the workflow step to which you wish to add the task.
5. Select the task to add to your workflow from the list.
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6. Click Add Selected Task to Workflow.
Edit an Existing Task

1.In the left nav bar of the UI, select an application.
2. Click Alert & Respond -> Cloud Auto-Scaling ->Tasks.
3. Select the task to edit from the list.
3. Click Edit or double-click to open the Task window.
4. Make your changes.
5. Click Save.
Learn More

Custom Tasks
Available Task Templates

The following task templates are available in the Task Template Library by default.
AddTomcatWorker
Ant
Apt
Attribu
BUnzip2
BZip2
Cab
CheckSum
Chgrp
Chmod
Chown
ConcatFiles
ControlOutcomeTask
CopyFile
CopyFiles
CreateDirectory
CreatMySqlSchema
DeleteDirectory
DeleteFile
DeleteFiles
DownloadFile
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Ear
ExecuteShellScript
ExecuteShellScriptNonBlocking
ExecuteSql
FixCRLF
GUnzip
GZip
Jar
Javac
Jspc
MoveDirectory
MoveFile
MoveFiles
PatchFile
RemoveTomcatWorker
ReplaceRegEx
ReplaceToken
RestartApache
RestartMySQL
RestartTomcat
Rmic
Rpm
SecureCopy
SetProxy
SignJar
StartMySQL
StartServer
StartTomcat
StopMySql
StopTomcat
SynchDirectory
Tar
TouchFile
TruncateFile
UniqueKeyGenerator
UnTar
UnZip
War
Zip
Custom Tasks

Create a New Task Template Using XML
XML File Types
The Task Library
Create your task.xml file
Create your run.xml file
Package the XML files as a zip archive
Add the zip archive as a task template
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Create Custom Tasks Using Shell or Batch Scripts
Create Your Own Task Launcher Based on a Java Class
Learn More
There are three ways to create custom tasks for your workflows.

Create a New Task Template Using XML

AppDynamics provides a set of default task templates. See Available Task Templates. You can
also create your own task templates using XML and the default task launcher, AntTask.
XML File Types

You must create two XML files to create a new template. You must use these names.
task.xml: defines the argument list for the input/output parameter tabs on the UI and links it
to the task launcher
run.xml: defines the syntax for running the task command
The Task Library

Look through the Task Library to find a template similar to the one you are creating and download
the template zip file.
1.
2.
3.
4.
5.
6.
7.
8.

In the left navigation pane of the UI, select the appropriate application
Click Alert & Respond -> Cloud Auto-Scaling -> Tasks
Click New+. The Create Task dialog opens.
Click View All Task Templates at the bottom left. The Task Template Library opens in the
main window.
Click Cancel to close the Create Task dialog.
Find a similar task template.
In the Task Zip File, click the zipfile name.
Open the zip file. It should contain both a run.xml and a task.xml. If it doesn't, download a
different zip file.

Create your task.xml file

Using the downloaded task.xml file as a model, create your task.xml. See the BZip2 sample
below.
Choose a name, display-name, and a description to show up in the task template list.
The type is always java.
The task-argument element contains as many argument elements as the task command has
arguments.
The name attribute is the name displayed in the Input Parameters tab UI.
The description attribute is the content of the tool tip displayed in the Input Parameters
tab UI.
The is-required attribute indicates if the argument is required
Additional attributes, like type, allowed values, etc. depend on the task.
The java-task and impl-class elements always contain com.singularity.ee.agent.systemagen
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t.task.ant.AntTask. This is the task launcher class.
<task>
<name>BZip2</name>
<display-name>BZip2</display-name>
<description>Zips to a bzip file using BZip2 algorithm</description>
<type>java</type>
<task-arguments>
<argument name="source-file" description="Source tar file to zip"
is-required="true" />
<argument name="destination-file" description="Destination file to create"
is-required="true" />
</task-arguments>
<java-task>
<impl-class>com.singularity.ee.agent.systemagent.task.ant.AntTask
</impl-class>
</java-task>
</task>

Create your run.xml file

Using the downloaded run.xml file as a model, create your run.xml. See the BZip2 sample below.
You must begin this file with an XML declaration.
The project, property, and target names must be as they are in the sample. The file args.p
roperties is populated based on input from the Input Parameters UI
The element inside the target element is the syntax to run the task command. The
arguments come from args.properties.

<?xml version="1.0" encoding="UTF-8"?>
<project name="run" default="run" basedir=".">
<property file="args.properties" />
<target name="run">
<bzip2 src="${source-file}" destfile="${destination-file}"/>
</target>
</project>

Package the XML files as a zip archive

Add the task.xml and run.xml files to a zip archive and name this zip archive the name of the task.
Add the zip archive as a task template

1. From the Cloud Auto-Scaling menu select Task Library.
2. Click New+. The Create Task Template dialog appears.
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2.

3. Provide the name and description for the task.
4. Upload the Zip file containing the XML task files.
5. Click Create Task Template.
AppDynamics adds the task template to the Task Library. See Add Tasks for Workflow Steps for
using this template.
Create Custom Tasks Using Shell or Batch Scripts

You can also create custom tasks by using a shell or batch script.
1.
2.
3.
4.
5.
6.

Create the shell or batch script file on the system.
In the left nav bar of the UI, select an application.
Click Alert & Respond -> Cloud Auto-Scaling -> Tasks.
Click New +. The Create Task window opens.
Give the task a name.
From the task list, select the task template ExecuteShellScript
or ExecuteShellScriptNonBlocking, as necessary.
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7. Browse to find the script file.
8. Click Create Task.
Create Your Own Task Launcher Based on a Java Class

If you need to create a completely new task that cannot be accomplished by using the AntTask
launcher or by using a shell or batch script, you must create a Java class that implements the
public com.singularity.ee.agent.systemagent.api.ITask interface bundled with the
Machine Agent.
Your class must implement the following two methods:
execute(), which takes input in the form of name-value pairs and the execution context for
the task, and returns the task output
stop(), which stops the process immediately
This class is referenced in the task.xml file, in the <java-task> element.
AppDynamics highly recommends using shell/batch scripts instead whenever possible. See for
more information Create Custom Tasks Using Shell or Batch Scripts .
Contact the AppDynamics Support Team if you need additional help in creating a Java task.

Learn More

Workflow Overview
Add Tasks for Workflow Steps
Cloud Computing Workflows
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Steps for Setting Up Cloud Computing Workflows
Learn More
Before you can create a workflow for cloud orchestration, you need to set up your cloud-specific
components.
Steps for Setting Up Cloud Computing Workflows

1. Sign up for an account with a supported cloud services provider. You will need to use the
credentials you are given to register your provider with AppDynamics, so that it can act on
your behalf. You must also set up your account with images of the entities you want to be
able to launch in the cloud, for example, AMIs for AWS.
2. Set up a connector so that AppDynamics can interact with your cloud provider and then
provide AppDynamics with your cloud provider credentials. See Compute Clouds. Once it is
set up, the registered cloud appears as an option in the Select a Compute Cloud drop-dow
n menu used for creating a workflow.
3. Define the kinds of machines you want to be available to use in your workflows - for
example, the format, OS, and instance type - depending on the cloud type you are working
on. Tell AppDynamics the images you want to be able to launch in the cloud. See Machine
Images and Instances. Once they are set up, the images appear in the Select an Image dro
p-down menu used for creating a workflow.
Learn More

Compute Clouds
Machine Images and Instances
Compute Clouds

Deploy the Cloud Connector
For SaaS Customers
For On-Prem Customers
Make Cloud Auto-Scaling Visible on the Controller UI
Register Your Cloud Account with AppDynamics
You must configure AppDynamics so that it can connect to your cloud provider.

Deploy the Cloud Connector
You need to deploy a cloud connector to provide an interface between AppDynamics and your
cloud provider. If there is no existing connector for your cloud provider, you can create your own.
See Create Your Own Compute Cloud Connector.
For SaaS Customers

Open a support ticket. The connector for your provider is deployed for you.
For On-Prem Customers

1.Log in to the AppDynamics Exchange on AppDynamics Community.
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http://community.appdynamics.com/t5/AppDynamics-eXchange/idb-p/exten
sions

2. Under the Categories column on the left side, select Cloud Connector. The connectors appear
in the right column.
3. To see more detailed instructions for use, click the name of the connector in which you are
interested, or simply click Download.
4. Unzip the downloaded file into the <controller-install-dir>/lib/connectors director
y of your Controller instance.
Make Cloud Auto-Scaling Visible on the Controller UI

The rest of the process is done through the UI.
1. Restart the Controller and log into the Controller UI.
2. Click the User Icon in the upper right corner and select My Preferences.

3. Check the Show Cloud Auto-Scaling features checkbox

4. Return to your application. This should be on the bottom left of your screen:

Register Your Cloud Account with AppDynamics

AppDynamics needs to have the credentials for your cloud provider account.
1.Click Cloud Auto-Scaling.
2. Select Compute Clouds.
3. Click + Register Compute Cloud to register a compute cloud.
4. Enter the name and description of the compute cloud instance.
5. From the Type drop-down menu select the type of cloud from the list of solutions that
AppDynamics supports for automation integration.
6. Enter the account credentials that are specific to the cloud provider. These typically include an
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identifier or name, the access key and the secret access key.
6. Click Register Compute Cloud.
7. Go on to select your preferred machine images on Machine Images and Instances.
Create Your Own Compute Cloud Connector

The AppDynamics IConnector interface allows you to create custom compute cloud connectors to
support additional cloud service providers.
To create an AppDynamics Connector you:
Implement the IConnector interface
Define three sets of XML metadata
The AppDynamics Controller dynamically registers a new cloud auto-scaling extension at startup.
See the Connector Development Guide.
Contact AppDynamics Support for assistance in building and deploying a new extension.
Also see Build an AppDynamics Extension.
Connector Development Guide

Metadata
compute-center-types XML Schema
Element Definitions
compute-center-type
Connector-impl-class-name
Property-definition
Machine-descriptor-definition
image-repository-types
Image-types
Implementing the IConnector Interface
void setControllerServices(IControllerServices controllerServices)
int getAgentPort()
createMachine(IComputer computeCenter, IImage image, IMachineDescriptor
machineDescriptor)
refreshMachineState(IMachine)
restartMachine(IMachine)
terminateMachine(IMachine)
void deleteImage(IImage image)
void refreshImageState(IImage image)
void validate(IComputeCenter computeCenter)
void configure(IComputeCenter computeCenter)
void unconfigure(IComputeCenter computeCenter)
void validate(IImageStore imageStore)
void configure(IImageStore imageStore)
void unconfigure(IImageStore imageStore)
void validate(IImage image)
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void configure(IImage image)
void unconfigure(IImage image)
Deploying a Connector
The AppDynamics IConnector interface allows custom implementations of orchestration
functionalities such as creating, destroying, restarting, configuring, and validating machine and
image instances directly from the AppDynamics Controller user interface.
To create an AppDynamics Connector, the user must implement the IConnector interface and
define three sets of xml metadata. The AppDynamics Controller has the ability to dynamically
register any new connector every time it starts.
In addition to this topic see the Cloud Connector API Javadoc.
Metadata

The Metadata provides the Controller with the necessary information to register the new compute
center, image, and image repository. The Controller uses the metadata to dynamically form the
user interface and link the IConnector implementation to the Controller. The three XML files must
be named as the following compute-center-types, image-repository-types, image-types.
compute-center-types XML Schema

<xs:schema attributeFormDefault="unqualified" elementFormDefault="qualified"
xmlns:xs="http://www.w3.org/2001/XMLSchema">
<xs:element name="compute-center-types">
<xs:complexType>
<xs:sequence>
<xs:element name="compute-center-type" maxOccurs="unbounded"
minOccurs="1">
<xs:complexType>
<xs:sequence>
<xs:element type="xs:string" name="name"/>
<xs:element type="xs:string" name="description"/>
<xs:element type="xs:string" name="connector-impl-class-name"/>
<xs:element name="property-definitions">
<xs:complexType>
<xs:sequence>
<xs:element name="property-definition" maxOccurs="unbounded"
minOccurs="1">
<xs:complexType>
<xs:sequence>
<xs:element type="xs:string" name="name"/>
<xs:element type="xs:string" name="description"/>
<xs:element type="xs:string" name="required"/>
<xs:element type="xs:string" name="type"/>
<xs:element type="xs:string"
name="default-string-value"/>
<xs:element type="xs:string"
name="string-max-length"/>
<xs:element type="xs:string"
name="allowed-string-values"/>
<xs:element type="xs:string"
name="default-file-value"/>
</xs:sequence>
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</xs:complexType>
</xs:element>
</xs:sequence>
</xs:complexType>
</xs:element>
<xs:element name="machine-descriptor-definitions">
<xs:complexType>
<xs:sequence>
<xs:element name="property-definition" maxOccurs="unbounded"
minOccurs="1">
<xs:complexType>
<xs:sequence>
<xs:element type="xs:string"
<xs:element type="xs:string"
<xs:element type="xs:string"
<xs:element type="xs:string"
<xs:element type="xs:string"
name="default-string-value"/>
<xs:element type="xs:string"
name="string-max-length"/>
<xs:element type="xs:string"
name="allowed-string-values"/>
<xs:element type="xs:string"
name="default-file-value"/>
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:sequence>
</xs:complexType>
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</xs:element>
</xs:schema>

Element Definitions compute-center-type
List of compute-center-type associated with the IConnector implementation. Each
compute-center-type will be registered under the Compute Clouds tab in the UI, for example:

Name: Compute Center Type name.
Description: Compute Center Type name shown on the Controller GUI.
For example:

<description>Amazon Elastic Computing Cloud</description>

Connector-impl-class-name
Full name of the IConnector implementation class.
Property-definition
List of property definitions for the compute center. These definitions are used to dynamically
generate the property text fields such as AWS Account ID, Access Key, and Secret Access Key.
Name: Name of the property field. Such as “AWS Account ID” in Figure 1.
Description: Description of the property.
Required: Checks if the property field cannot be empty. State true/false.
Type: Type of the property field. STRING/FILE
Default-string-value: Default initialization value of the STRING property.
String-max-length: Maximum number of characters allowed to be stored in the property
field
Allowed-string-values: List of allowed string values, delimited by comma. If specified this
property will be displayed as a drop down list of all the allowed string values.
Default-file-value: Default FILE type property value
For example, using the “AWS Account” property:
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<property-definition>
<name>AWS Account ID</name>
<description>AWS Account ID</description>
<required>true</required>
<type>STRING</type>
<default-string-value></default-string-value>
<string-max-length>80</string-max-length>
<allowed-string-values></allowed-string-values>
<default-file-value></default-file-value>
</property-definition>

Machine-descriptor-definition
Contains list of property definitions associated with a machine instance object of that Compute
Center type. These properties can be seen in Launch Instance window under the Images tab. For
example, an EC2 Launch Instance Window showing Amazon Elastic Computing Cloud Compute
Type MachineDescriptor Definitions:

image-repository-types
When each compute cloud is registered, a corresponding imagestore object is created. The
imagestore name, description, connector-impl-class-name, and property-definitions should mirror
the Compute Center property-definitions.
The image-repository-types XML schema:
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<xs:schema attributeFormDefault="unqualified" elementFormDefault="qualified"
xmlns:xs="http://www.w3.org/2001/XMLSchema">
<xs:element name="image-repository-types">
<xs:complexType>
<xs:sequence>
<xs:element name="image-repository-type" maxOccurs="unbounded"
minOccurs="1">
<xs:complexType>
<xs:sequence>
<xs:element type="xs:string" name="name"/>
<xs:element type="xs:string" name="description"/>
<xs:element type="xs:string" name="connector-impl-class-name"/>
<xs:element name="property-definitions">
<xs:complexType>
<xs:sequence>
<xs:element name="property-definition" maxOccurs="unbounded"
minOccurs="1">
<xs:complexType>
<xs:sequence>
<xs:element type="xs:string" name="name"/>
<xs:element type="xs:string" name="description"/>
<xs:element type="xs:string" name="required"/>
<xs:element type="xs:string" name="type"/>
<xs:element type="xs:string"
name="default-string-value"/>
<xs:element type="xs:byte" name="string-max-length"/>
<xs:element type="xs:string"
name="allowed-string-values"/>
<xs:element type="xs:string"
name="default-file-value"/>
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:schema>

Image-types
Each image type defines an image type found under the Images tab. For example:
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The image-types XML schema:
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<xs:schema attributeFormDefault="unqualified" elementFormDefault="qualified"
xmlns:xs="http://www.w3.org/2001/XMLSchema">
<xs:element name="image-types">
<xs:complexType>
<xs:sequence>
<xs:element name="image-type" maxOccurs="unbounded" minOccurs="1">
<xs:complexType>
<xs:sequence>
<xs:element type="xs:string" name="name"/>
<xs:element type="xs:string" name="description"/>
<xs:element name="property-definitions">
<xs:complexType>
<xs:sequence>
<xs:element name="property-definition">
<xs:complexType>
<xs:sequence>
<xs:element type="xs:string" name="name"/>
<xs:element type="xs:string" name="description"/>
<xs:element type="xs:string" name="required"/>
<xs:element type="xs:string" name="type"/>
<xs:element type="xs:string"
name="default-string-value"/>
<xs:element type="xs:byte" name="string-max-length"/>
<xs:element type="xs:string"
name="allowed-string-values"/>
<xs:element type="xs:string"
name="default-file-value"/>
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:sequence>
</xs:complexType>
</xs:element>
<xs:element name="supported-compute-center-types">
<xs:complexType>
<xs:sequence>
<xs:element type="xs:string" name="compute-center-type"/>
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:schema>

Implementing the IConnector Interface

void setControllerServices(IControllerServices controllerServices)
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When the connector implementation is created it is passed a handle to the Controller services. The
implementor must maintain a reference to this object if it is needed when invoking other connector
operations. This method will be most likely implemented as the following:

private IControllerServices controllerServices;
public void setControllerServices(IControllerServices controllerServices)
{
this.controllerServices = controllerServices;
}

int getAgentPort()
Retrieve the agent port for machine instances managed through this connector. Most likely it is the
value returned by calling the controllerServices.getDefaultAgentPort() method. For example:

controllerServices.getDefaultAgentPort();

createMachine(IComputer computeCenter, IImage image, IMachineDescriptor machineDescriptor)
Creates a new machine instance in the specified compute center, using the specified image. The
type of machine instance and the hardware configuration etc, are specified in the machine
instance descriptor. The implementation should try to not block the call until the machine instance
is fully started. If possible, it should start the machine instance creation and return a Machine
handle with the state set to MachineState.STARTING. The refreshMachineState(IMachine)
method can then be called to check when machine instance startup is complete. If the Machine
handle is created through the IControllerServices interface then its state will automatically be set to
MachineState.STARTING. For example:
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Public IMachine createMachine(IComputeCenter computeCenter, IImage image,
IMachineDescriptor machineDescriptor) throws InvalidObjectException,
ConnectorException
{
//retrieve property definitions stored in IComputeCenter, IImage, and
IMachineDescriptor //objects
String accountId =
controllerServices.getStringPropertyValueByName(computeCenter.getProperties(),
“Account ID”);
String accessKey =
controllerServices.getStringPropertyValueByName(computeCenter.getProperties(),
“Access Key”);
String imageId =
controllerServices.getStringPropertyValueByName(image.getProperties(), “Image
ID”);
String machineSize =
controllerServices.getStringPropertyValueByName(machineDescriptor.getProperties(
), “Image Size”);
//To grab a file property, the code must iterate through the corresponding
property //array. For example:
Byte[] bytes = null;
For(IProperty i: image.getProperties)
{
If (i.getDefinition.getType == PropertyType.FILE)
{
If (i.getDefinition.getName().equals(“Property Name”);
{
bytes = ((IFileProperty)i).getFileBytes();
Break;
}
}
}
/*
Code to create a new machine instance on the specified compute center
*/
int agentPort = controllerServices.getDefaultAgentPort();
IMachine machine = controllerServices.createMachineInstance(“machine instance
id”, “unique internal name”, computeCenter, machineDescriptor, image,
agentPort);
return machine;
}

refreshMachineState(IMachine)
The refreshMachineState method is used by the controller to poll the status of a particular
IMachine object. If the MachineState of an IMachine object is not marked as STARTED, the
controller will poll its status at an interval. If the MachineState is set as STARTED, the controller
will assume the machine instance is running and will not invoke this method. For example:
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public void refreshMachineState(IMachine machine) throws InvalidObjectException,
ConnectorException
{
//get the IMachine instance name, usually stores the corresponding machine
instance id
String machineId = machine.getName();
//Each IMachine object has access to its IComputeCenter, IMachineDescriptor, and
IImage //objects
String zone =
controllerServices.getStringPropertyValueByName(machine.getMachineDescriptor().g
etProperties(), “Zone”);
/*
Code to grab machine instance status
Invoke any post build actions
*/
/*
The IMachine object Machine state must be set accordingly.
MachineState.STOPPED will mark the IMachine as stopped and delete the IMachine
object from the controller. Machinestate can be set manually to STOPPED if the
machine instance no longer exists
MachineState.STARTED will set the IMachine as started. The controller will no
longer poll the machine instance status in STARTED state.
*/
machine.setState(MachineState.STARTING);
}

restartMachine(IMachine)
Restarts the specified machine instance. The implementation should try to not block the call until
the machine instance is fully restarted. If possible it should begin the machine restart and return
immediately. Afterwards the Machine handle state will be set automatically to
MachineState.STARTING. The refreshMachineState(IMachine) method can then be called to
check when machine instance restart is complete.
terminateMachine(IMachine)
Terminates the specified machine instance. The implementation should try to not block the call
until the machine instance is fully terminated. If possible, it should start the machine termination
and return immediately. Afterwards the Machine handle state will be set automatically to
MachineState.STOPPING. The refreshMachineState(IMachine) method can then be called to
check when machine instance termination is complete.
void deleteImage(IImage image)
Delete the image from the underlying dynamic capacity provider.
void refreshImageState(IImage image)
Refreshes the image state of the specified image. This callback is needed since the image save
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and image copy can take a considerable amount of time to complete. Instead of blocking on the
image save and image copy operations, the connector implementation should return quickly.
Afterwards, the controller will poll the image state through this operation to see when the image
save or image copy is complete. When complete, it is the responsibility of the connector
implementation to set the image state to ImageState.READY.
void validate(IComputeCenter computeCenter)
Validates if a Compute Center has the valid Properties and rest of the fields. For example:

public void validate(IComputeCenter computeCenter) throws
InvalidObjectException, ConnectorException
{
String accountId =
controllerServices.getStringPropertyValueByName(computeCenter.getProperties(),
“AWS Account ID”);
String accessKey = controllerServices.getStringPropertyValueByName(computeCenter
.getProperties(), “Access Key”);
String secretKey = controllerServices.getStringPropertyValueByName(computeCenter
.getProperties(), “Secret Access Key”);

/*
Validate if the user credentials are correct. Throw exception if properties are
invalid.
*/
}

void configure(IComputeCenter computeCenter)
Does any configuration that needs to be done for the Compute Center to be able to be used by
Singularity Dynamic Provisioning Manager. This may include creating access accounts, creating
permissions, etc.
void unconfigure(IComputeCenter computeCenter)
Un-does any configuration that was done for the Compute Center to be able to be used by
Singularity Dynamic Provisioning Manager. This may include deleting access accounts, deleting
permissions, etc.
void validate(IImageStore imageStore)
Validates if an Image Store has the valid Properties and rest of the fields.
void configure(IImageStore imageStore)
Does any configuration that needs to be done for the Image Store to be able to be used by
Singularity Dynamic Provisioning Manager. This may include creating access accounts, creating
permissions, etc.
void unconfigure(IImageStore imageStore)
Un-does any configuration that was done for the Image Store to be able to be used by Singularity
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Dynamic Provisioning Manager. This may include deleting access accounts, deleting permissions,
etc.
void validate(IImage image)
Validates if an Image has the valid Properties and rest of the fields.
void configure(IImage image)
Does any configuration that needs to be done for the Image to be able to be used by Singularity
Dynamic Provisioning Manager. This may include creating access accounts, creating permissions,
etc.
void unconfigure(IImage image)
Un-does any configuration that was done for the Image to be able to be used by Singularity
Dynamic Provisioning Manager. This may include deleting access accounts, deleting permissions,
etc.
For more information regarding the IController interface and its related classes, see the Cloud
Connector API Javadoc.
Deploying a Connector

To deploy a connector
1. Compile the IConnector implementation into a Jar file.
2. Package the compiled jar and the xml metadata into one directory.
3. Put the directory in: <controller-install-dir>/lib/connectors.
4. Restart the Controller by running the stopController and startController scripts under
<controller-install-dir>/bin.
You should see the new connector in the Compute Clouds and Images tab under Systems.
Machine Images and Instances

Registering Images
To test an image registration by launching the image manually
Learn More
You must register the images you have prepared on your cloud provider, so that AppDynamics
knows which ones to use in launching machine instances on the cloud.
Before you register your images, you must register the cloud provider with AppDynamics. See Co
mpute Clouds.
Registering Images

You need to define the environment that you want AppDynamics to use in creating cloud-based
workflows.
1. Click the Cloud Auto-Scaling menu in the bottom left navigation panel.
2. In the menu click Images.
3. Click +Register Image.
4. Enter a name and description of the image that will appear when you are creating workflows.
5. Select the operating system that you want this machine to use.
6. Select the cloud provider that you have previously registered. For instructions about registering
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providers, see Compute Clouds.
7. Select the format that the image is in - for example, AMI.
8. Provide the image name and any other information required by your provider
9. Click Save.
To test an image registration by launching the image manually

After an image has been registered, you can use this interface to test your set up.
1. In the Images window, select the image that you want to use.
2. Click Launch Instance.
All running instances of this image are listed under the details for the image or in the Machines
window.
The following screenshot displays instances for the "Ecommerce Node V1" image. You can also
restart or terminate the instances from this screen.

Learn More
Compute Clouds
Cloud Computing Workflows
Supported Compute Clouds
Supported Compute Clouds for Automating Workflow

In order to create workflows that allow the automatic creation and deletion of cloud-based
instances in response to load, the AppDynamics controller must have access to a
cloud-provider-specific cloud connector extension. The AppDynamics Community provides many
of these cloud connector extensions. You can download supported cloud connector extensions
from the AppDynamics Exchange.

Controller UI Guide
The AppDynamics UI
provides a rich visual
display of your
application's
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performance. In addition
to the default dashboards
you can create
customized views of the
key performance metrics
of your applications.

AppDynamics Home Page
This topic describes the AppDynamics Home page. When you log into the AppDynamics
Controller UI, you see three tabs similar to the following:

From the Home tab, you can:
Access your application dashboards
Access the Analytics window
Create and View Custom Dashboards
Access the Database Monitoring window
View and manage installed agents
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Access the Agent Download Wizard
Access various system-wide Settings
From the Getting Started tab, you can:
Access agent download wizards and getting started information for the various Product
Modules
Access information for new users
Explore the product documentation
Access videos,extensions, and other community resources
Access Support
From the Agent Download Wizard tab, you can:
Access a download wizard for each Product Module

Dashboards
AppDynamics Dashboards
Elements Common to all Dashboards
Learn More
AppDynamics Dashboards
Elements Common to all Dashboards

The top icons in the upper right corner are available on every view.
The Help dropdown menu contains links to information resources, support, and
enables you to disable the help pop-ups.
The Settings dropdown menu provides access to system-level information, including
email notifications, a list of agents reporting to this controller, and license information. For
more information see:
User Authentication and Permissions
Email and SMTP
License Information
Manage App Agents
The User dropdown menu shows the current user, enables you to log out, and to
access user preferences. For more information see:
Set User Preferences
The second row icons are available on the dashboards to help you navigate.
The house

button returns you to the Home page.
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The right and left buttons
The refresh
This

go to previously accessed views, just like in a browser.

button causes the display to update to the latest data.

button takes you to the All Applications List.

The breadcrumbs
current view.
The video

button links to available videos.

The help page
The link

indicate the path to the

button opens the applicable page in the product documentation.
button copies a link to the current view to the clipboard.

The Compare
dropdown enables you to choose to compare to the baseline or
not and to access the baseline configuration window.
The global Time Ranges
drop-down list in the upper right sets the time
range for all metrics shown for the application.
Learn More

Visualize Performance Using Custom Dashboards
All Applications Dashboard
Accessing the Applications Dashboard
How the Applications Dashboard is Organized
Top Menus
Application Panel Links and Menus
Application Summary Panels
Health Rule Violations
Key Metrics
Business Transaction Health
Server Health
Learn More
This topic describes the Applications Dashboard. You can monitor all AppDynamics business
applications from the Applications Dashboard.
Accessing the Applications Dashboard

1. To access the Applications Dashboard, log into the AppDynamics Controller at the URL
given in your welcome email.
2. On the AppDynamics account home page, click View All Applications. The following screen
shot shows the graphical view.
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2.

3. To return to the Applications Dashboard, click View All Applications

.

How the Applications Dashboard is Organized

The Applications Dashboard displays all business applications and the key performance indicators
of each. By default, business applications are listed in descending order based on load (calls per
minute), with the highest load listed first.
Top Menus

The top two menus are common to all dashboards. See Dashboards.
The third row menu is specific to each dashboard. In the All Applications dashboard you can:
Click Create Application to add a new business application to AppDynamics.
Click Import Application to import a business application configuration to AppDynamics.
See Export and Import Business Application Configurations.
Use the View icons to change between graphical and list views.
Use the Sort By drop down menu when you have a longer list of business applications and
need to sort through them.
Application Panel Links and Menus

Each business application listing has a link to the application's dashboard.
For convenience each application listing has menus for commonly-performed actions, including:
Events opens the Events window that lists all events.
Alert and Respond opens the Alert and Respond menu.
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Troubleshoot opens the Troubleshoot menu.
Analyze opens the Analyze menu.
Configure opens the Configure menu.
Actions ->
View Dashboard displays the application dashboard
Delete Application
Edit Application Properties lets you edit the name and description of the application.
Export Application saves an application configuration for reuse. See Export and
Import Business Application Configurations.
Application Summary Panels

For each business application, the Applications Dashboard shows these panels:
Health Rule Violations
Key Metrics
Business Transaction Health
Server Health
Health Rule Violations

The Health Rule panel shows how many health rule violations, if any, occurred during the selected
time range. Click Health Rule Violations to Troubleshoot Health Rule Violations.
Key Metrics

The key metrics panels show key performance indicators for each business application:
Load: number of calls and calls per minute
Response Time: average response time
Errors: number of errors
Click Errors to Troubleshoot Errors.
Business Transaction Health

The Business Transaction Health panel shows the combined health for all business transactions in
the application. The health of each business transaction is based on any health rule violations
triggered during the selected time range. The color bar indicates:
Green - no violations
Yellow - at least one violation
Red - at least one critical violation
Click Business Transaction Health to open the Business Transactions List and find more details.
See Troubleshoot Health Rule Violations.
Server Health

The Server Health panel shows combined health for all tiers and nodes in the application. The
health of each tier and node is based on any health rule violations triggered during the selected
time range. The color bar indicates:
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Green - no violations
Yellow - at least one violation
Red - at least one critical violation
Click Server Health to see details about all the tiers and nodes in the App Servers List. See Troub
leshoot Health Rule Violations.
Learn More

Dashboards
Application Dashboard
Application Dashboard
Accessing the Application Dashboard
How the Application Dashboard is Organized
Action Menu (Lightning Bolt)
Application Dashboard Tabs
Dashboard Tab
Compare Menu
Top Business Transactions Tab
Transaction Snapshots Tab
Transaction Analysis Tab
Machine Snapshots Tab
Learn More
Each business application has its own Application Dashboard, which shows high-level status
information for a single business application in the selected time range.
Accessing the Application Dashboard

On the All Applications Dashboard, click an application name to view the dashboard for that
application. The Application Dashboard opens.
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How the Application Dashboard is Organized

The Application Dashboard shares the same common components as other Dashboards, including
Time Ranges.
Action Menu (Lightning Bolt)

The Action menu (lightning bolt
application.

) provides commonly-performed actions for a business

Edit Application Properties: Lets you edit the name and description of the application.
Delete: Deletes the application and all its data from AppDynamics. Not reversible.
Export: Exports an application configuration for reuse. See Export and Import Business
Application Configurations.
Reset Agents: Resets agents by purging existing data and starting the agents detecting the
transactions and backends from scratch.
View Old Dashboard: Displays the dashboard in the previous release's format.
Application Dashboard Tabs

The Application Dashboard has these tabs:
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Dashboard
Top Business Transactions
Transaction Snapshots
Transaction Analysis
Machine Snapshots
Dashboard Tab

The Dashboard Tab displays summary panels similar to the All Applications Dashboard:
Application flow map: Graphically depicts performance across the all tiers, nodes and
backends for all business transactions in the application. See Flow Maps.
Events: Lists events that are by default configured to display in the dashboard: Health Rule
Violation Started, Code Problems, Application Changes and Custom events. See Events
Business Transaction Health: shows the combined health for all business transactions in
the application. The health of each business transaction is based on any health rule
violations triggered during the selected time range. The color bar indicates:
Green - no health rule violations
Yellow - at least one health rule violation
Red - at least one critical health rule violation
Click Business Transaction Health to open the Business Transactions List and find
more details. See Troubleshoot Health Rule Violations.
Server Health: shows combined health for all tiers and nodes in the application. The health
of each tier and node is based on any health rule violations triggered during the selected
time range. The color bar indicates:
Green - no health rule violations
Yellow - at least one health rule violation
Red - at least one critical health rule violation
Click Server Health to see details about all the tiers and nodes in the App Servers
List. See Troubleshoot Health Rule Violations.
Transaction Scorecard: number and percentage of transactions that are normal, slow, very
slow, stalled or errors. See Scorecards.
Exceptions: list the total number and number-per-minute of:
Exceptions
HTTP Error Codes
Error Page Redirects
Click the Exceptions link to see the list of exceptions. See To Troubleshoot
Exceptions for more information.
Service Endpoints: Lists the configured service endpoints.
Key Performance Indicators: See KPI Graphs.
Compare Menu

The Compare menu is visible when the Dashboard tab is selected.
By default the performance displayed in the dashboard is compared against the daily trend, which
is the performance over the last 30 days. From the Compare menu you can direct AppDynamics to
use a different baseline or no baseline. You can also configure baselines. For more information
about baselines see Detect Anomalies Using Dynamic Baselines and Configure Baselines.
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Top Business Transactions Tab

The Top Business Transactions Tab shows the key performance indicators for the most expensive
business transactions sorted by the following criteria:
Load
Response Time
Errors
Number of Slow Transactions
Number of Stalls
Number of Health Rule Violations
If you click View All in any of the panels in this tab, the business transaction list opens displaying
all the key performance indicators for the business transactions in one panel. See Business
Transactions List.
Transaction Snapshots Tab

The Transaction Snapshots Tab displays the transaction snapshots for the selected time range.
From a transaction snapshot you call drill down to the root cause of a performance problem. See T
ransaction Snapshots.
Transaction Analysis Tab

The Transaction Analysis tab displays application performance over the selected time range as a
graph. Use the graph to analyze the impact of different events on the application's response time.
See Transaction Analysis Tab.
Machine Snapshots Tab

When an application has at least one .NET tier, the application dashboard displays the Machine
Snapshots tab. It lists the machine snapshots for the selected time range. From a machine
snapshot you can drill down to view environmental conditions, such as running processes and
memory usage for a particular machine. See Machine Snapshots for .NET.
Learn More

Dashboards
Flow Maps
Configure Baselines
Time Ranges
Transaction Analysis Tab
Business Transactions List
Transaction Snapshots
Business Transaction Dashboard
Accessing a Business Transaction Dashboard
How the Business Transaction Dashboard is Organized
Business Transaction Flow Map
Action Menu
Business Transaction Dashboard Tabs
Dashboard Tab
Events Tab
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Slow Response Times Tab
Errors Tab
Transaction Snapshots Tab
All Snapshots Subtab
Slow and Error Transactions Subtab
Diagnostic Sessions Subtab
Periodic Collection Subtab
Transaction Analysis Tab
Learn More
The Business Dashboard provides single-click access to all performance indicators for any
detected business transaction.
Each business transaction has its own dashboard.
Accessing a Business Transaction Dashboard

To view a dashboard for a particular business transaction:
1. Select the business application.
2. In the left navigation pane, click Business Transactions.
AppDynamics displays the business transaction list.
3. From the list select the business transaction for which you want to see the dashboard.
4. Either double-click on the business transaction or click View Dashboard.

How the Business Transaction Dashboard is Organized

The Business Transaction Dashboard shares the same components as other Dashboards,
including Time Ranges.
Business Transaction Flow Map

The Business Transaction Dashboard contains a Flow Map of the discovered tiers, nodes,
databases, remote services. See Flow Maps.
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Action Menu

The Action menu provides commonly-performed actions for a business transaction.
Monitor -> View Metrics By Individual Nodes: displays metrics for each node in the tier in
which the business transaction started.
Troubleshoot -> View Health Rule Violations: displays all the health rule violations for the
business transaction for the selected time range.
Troubleshoot -> Start Diagnostic Session: starts a diagnostic session on the business
transaction. See See Detailed Data Using Diagnostic Sessions.
Analyze -> Analyze Response Time vs Load: See Scalability Analysis.
Misc -> View Old Dashboard: Displays in the previous release format.
Configure -> Thresholds: See Configure Thresholds.
Configure -> Data Collectors: See Configure Data Collectors.
Rename: Rename the business transaction.
Delete: The delete action prevents the transaction from being monitored. However, it will be
added to the Business Transactions List if it is discovered again by AppDynamics. To
prevent a business transaction from being monitored at all, exclude the transaction.
Exclude: Use the exclude action to prevent the selected transaction from being discovered
by AppDynamics.
Set as Background Task: Converts the business transaction to a background task. See Mo
nitor Background Tasks.
Business Transaction Dashboard Tabs

The Business Transaction Dashboard has these tabs:
Dashboard
Events
Slow Response Times
Errors
Transaction Snapshots
Transaction Analysis
Dashboard Tab

Because the design for Business Transaction Dashboard is modeled on the Application
Dashboard, you can drill down for transaction snapshots, errors and events directly from the
dashboard.
Events Tab

The Business Transaction Dashboard Events tab lists the events for the transaction and summary
information about each.
Type: type of event. See Events.
Summary: description of the event.
Time: date and time when the event occurred.
Business Transaction: link to the Business Transaction Dashboard for the event.
Tier: link to the tier on which the event occurred.
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Node: link to the Node Dashboard for the node on which the event occurred.
Actions Executed: Actions executed in response to events
This is an embedded copy of the event list in which only events for the selected business
transaction are reported. You can modify the event types reported in this list. For more information
about the events list see Filter and Analyze Events.
Slow Response Times Tab

The Slow Response Times tab graphs slow transactions and displays the transaction snapshots
for the slow and stalled transactions for the selected time range.
Select a transaction snapshot from the list and click View Transaction Snapshot to drill down to
the cause of the error. See Transaction Snapshots.
Errors Tab

The Errors tab graphs and displays the error transaction snapshots for the selected time range.
Select a transaction snapshot from the list and click View Transaction Snapshot to drill down to
the cause of the error. See Transaction Snapshots.
Transaction Snapshots Tab

The Transaction Snapshots tab has the following subtabs:
All Snapshots
Slow and Error Transactions
Diagnostic Sessions
Periodic Collection
The Slow and Error Transactions or Diagnostic Sessions subtabs are the quickest route to drill
down to the root cause of slow, stalled or error transactions.
All Snapshots Subtab

This subtab displays all the transaction snapshots captured for the selected time range. Error
transaction snapshots are coded red, slow transaction snapshots are coded yellow, and stalled
transaction snapshots are coded purple.
You can select a snapshot from the list and double-click it or click View Snapshot to drill down to
the root cause of the problem. See Transaction Snapshots for more information.
Slow and Error Transactions Subtab

This subtab displays only snapshots for slow and error transactions.
Diagnostic Sessions Subtab

This subtab displays diagnostic sessions that have already been started. It also lets you start a
diagnostic sessions by clicking Start Diagnostic Session.
A diagnostic session captures detailed data about the processing of a transaction as transaction
snapshots over a defined period of time. The snapshots include full call graphs. See See Detailed
Data Using Diagnostic Sessions.

Copyright © AppDynamics 2012-2014

Page 394

Periodic Collection Subtab

This subtab displays transaction snapshots that have been configured to be collected periodically,
whether or not the transactions are slow or error. See Configure Transaction Snapshots for
information about enabling and disabling periodic snapshot collection.
Transaction Analysis Tab

The Transaction Analysis tab shows the Transaction Analysis Tab graph for the business
transaction.
Learn More

Flow Maps
Filter and Analyze Events
Business Transactions List
Viewing Business Transactions in a List
To access the Business Transactions List
Business Transaction Performance Data
Health
Key Performance Indicators
Slow and Stalled Requests
CPU Usage
Other
To configure viewing options on the Business Transaction List
Filtering the Business Transaction List
To filter the Business Transactions List
Business Transactions List Actions
Troubleshoot
Analyze
Configure
Other
Exclude Versus Delete
Learn More
Viewing Business Transactions in a List

AppDynamics displays all business transactions for a single business application on the Business
Transactions List. The configurable list shows the key performance indicators (KPIs) for the
business transactions during the configured time range.
To access the Business Transactions List

1. From the Home page or the All Applications dashboard, select a business application.
2. Below the application name click Business Transactions.
The list shows all the transactions for a business application with configurable columns that
display performance data.
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Click a column to sort the business transactions based on the data in that particular column.
3. To access a dashboard for a specific business transaction, select the business transaction
and click View Dashboard. See Business Transaction Dashboard.
Sometimes you see an "All Other Traffic" business transaction on a tier. For details about what this
is and how to handle it see All Other Traffic Business Transaction.
Business Transaction Performance Data

Performance metrics are relevant for the configured time range.
Health

This column shows red, yellow, or green icons corresponding to the health rule settings for the
business transaction. Click the icon to get more information. See Default Health Rules.
Key Performance Indicators

Response Time (ms): Average response time (ART) spent processing the business
transaction, for all instances of the business transaction, from start to end of the entry point
invocation.
Max Response Time (ms): Longest time spent processing an instance.
Min Response Time (ms): Shortest time spent processing an instance.
Calls: Call volume, the total number of invocations of the entry point for the business
transaction (all instances).
Calls/min: Average number of instances per minute.
Errors/min: Number of errors over all instances. See Configure Error Detection.
Error %: Percentage of instances that are errors.
Slow and Stalled Requests

Slow Transactions: The number of instances that meet the criteria defined for a slow
transaction.
Very Slow Transactions: Number of instances that meet the criteria defined for a very slow
transaction.
Stalled Transactions: Number of instances that meet the criteria defined for a stalled
transaction.
% Slow Transactions: Percentage of instances that are slow over the selected time frame.
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% Very Slow Transactions: Percentage of instances that are very slow over the selected
time frame.
% Stalled Transactions: Percentage of instances that stalled over the selected time frame.
Criteria for slow, very slow, and stalled transaction performance is determined by thresholds. See
Configure Thresholds.
CPU Usage

CPU usage metrics are available when either a standalone machine agent or embedded machine
agent is installed on the node's machine.
CPU Used (ms): Average time spent using the CPU. An invocation might wait or be blocked
when it is not using the CPU.
Block Time (ms): Average time spent when invocations are blocked for thread
synchronization and locks.
Wait Time (ms): Average time spent when invocations are in a thread sleep or wait state.
Other

Tier: Display name of the originating tier for the business transaction.
Type: Type of entry point. The types that are listed depends on the app agent (Java, .NET,
PHP, etc.).
To configure viewing options on the Business Transaction List

You can select the key performance indicators that appear on the list.
1. Select View Options to configure which performance data is displayed in the list.

2. Select the metrics you want to see in the list.
The Health column always displays.
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Filtering the Business Transaction List

You can filter the display of business transactions based on different criteria such as:
Transactions with Performance Data: By default the list displays only business
transactions that have performance data. Uncheck this option to list all defined business
transactions.
Average Response Time: Filter the list based on greater than an average response time in
milliseconds.
Calls / min: Filter based on a greater than average number of instances/minute.
Groups: Show only business transaction groups.
Transaction Type: Filter transactions based on entry point types. The types that are listed
depends on the app agent (Java, .NET, PHP, etc.).
User Transactions: List only regular business transactions (not background task
transactions).
Background Tasks: List only background tasks.
Tier: List all business transactions for a particular tier.
Transaction Name: List according to a comma-separated list of transaction names.
To filter the Business Transactions List

1. Click Filters next to the Search box in the upper right corner of the list to toggle the Filters
toolbar.
2. In the toolbar, check the criteria that define the business transactions to display.

Business Transactions List Actions

Select a business transaction and right-click, or click More Actions. You can perform the following
actions on the selected business transaction.
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Troubleshoot

View Health Rule Violations: View all the health rule violations for the selected transaction
in the time range.
Start Diagnostic Session: Manually start a diagnostic session on the selected transaction.
By default diagnostic sessions are triggered only when an instance experiences problems or
violates health rule thresholds.
Analyze

Analyze Response Time vs Load Time: Opens the Scalability Analysis window where you
can compare average response time versus calls (instances) per minute for a business
transaction.
Configure

Configure Thresholds: Configure thresholds for the selected business transaction
Other

Rename: By default, all business
transactions are identified using default
naming schemes for different types of
requests (see Identifying Business
Transactions Using Entry Points). You can
rename business transactions.
Delete: You can delete the selected
transaction from the list. However, it will be
added back to the Business Transactions
List if it is discovered again by
AppDynamics. To stop a business
transaction from being monitored at all,
use Exclude Transactions.
Tip: Delete is useful when you create a new
custom match rule that will replace detection of
existing business transactions. You delete the
business transactions discovered by the old rule
and new transactions are discovered by the new
rule. For example, if you have three business
transactions named BT_A, BT_B, and BT_C and
you create a custom match rule to discover them
as a single business transaction BT_ABC, you
would delete the old transactions so that they no
longer count towards the business transaction
limit.
Exclude Transactions: Remove the
selected transaction or transactions from
the Business Transactions List.
AppDynamics retains the accumulated

Copyright © AppDynamics 2012-2014

Page 399

metrics, but stops monitoring the
transaction. Excluded transactions are not
counted against the business transaction
limits.
Tip: Excluding transactions from the UI is
helpful if you think you may want to resume
monitoring the transaction in the future, as the
underlying configuration is still present. To
change the configuration itself see Configure
Business Transaction Detection#Exclude Rules.
View Excluded Transactions: View
transactions that were excluded from the
Business Transactions List and resume
monitoring them if needed.
Set as Background Task: The transaction
will be treated as a background task and
its metrics will not be counted with the
application or tier business transaction
metrics.
Tip: Average response time and calls per
minute for background tasks are typically much
different than those for business transactions
based on user requests. For example average
response time could be very high for a large
batch processing job. It is important to monitor
background task metrics separately so as not to
skew the metrics that are based on user
requests. See Monitor Background Tasks.
Create Group: Gather different business
transactions into a single logical group.
Delete Group: Delete a group. This does
not delete the business transactions in the
group.
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Exclude Versus Delete

The differences between excluding
and deleting from the Business
Transaction List are:
Deleting a Business Transaction
Removes the accumulated
metrics for the transaction
Unless you change the
discovery rules, a business
transaction that has been
deleted will be discovered again
(when the corresponding
function in the application is
used) and the transaction will
simply reappear.
Excluding a Business Transaction
(using the UI features)
Retains the accumulated metrics
Exclude is reversible because
the transaction is still persistent
in the Controller database. You
can un-exclude it and start
monitoring it again.
Learn More

Business Transaction Dashboard
All Other Traffic Business Transaction
Tier Dashboard
Accessing the Tier Dashboard
How the Tier Dashboard is Organized
Action Menu
Tier Dashboard Tabs
Dashboard Tab
Compare Menu
My Dashboards Tab
Nodes Tab
Health Subtab
Hardware Subtab
Memory Subtab
Events Tab
Slow Response Times Tab
Slow Transactions Subtab
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Slow DB & Remote Service Calls Subtab
Errors Tab
Transaction Snapshots Tab
All Snapshots Subtab
Slow and Error Transactions Subtab
Diagnostic Sessions Subtab
Periodic Collection Subtab
Transaction Analysis Tab
IIS AppPools Tab (.NET Only)
Learn More
The Tier Dashboard provides single-click access to all performance indicators for a particular tier
(server), including health and key metric information for each node. You can also view the Metric
Browser from the Tier Dashboard.
Accessing the Tier Dashboard

To view the Tier Dashboard for a particular tier:
1. Select the business application.
2. In the left navigation pane, click Servers -> App Servers -> <Tier>.
AppDynamics displays the Tier Dashboard for the selected tier.

How the Tier Dashboard is Organized
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The Tier Dashboard shares the same common components as other Dashboards, including Time
Ranges.
Action Menu

The Action menu provides commonly-performed actions for a tier.
Analyze -> Analyze Response Time vs Load and Analyze CPU vs Load open the Scalab
ility Analysis window.
Report -> Export PDF Report instantly generates a PDF report. See Reports.
Configure opens the Configuration main menu screen.
Configure transaction detection opens the Transaction Detection tab of the
Configure Instrumentation window. See Configure Business Transaction Detection.
Configure App Server Agent opens the App Server Agent Configuration window.
See App Agent Node Properties.
Configure Backends resolving to this Tier lets you change the association of a
remote service or backend with this tier. You can either associate the backend with
another tier by clicking Resolve to a Different Tier and selecting the new tier from the
dropdown menu or by clicking the Delete button to disassociate it from all tiers, in
which case the backend appear as an independent component ("unresolved
backend") on the application flow map.
Edit Properties opens the Tier Properties window. You can change the name (label)
of the tier and write a description for it. If the tier is an instrumented app server, the
Type is automatically set.
Delete Tier deletes the tier from the flow map.
Tier Dashboard Tabs

The Tier Dashboard has these tabs:
Dashboard Tab
Nodes Tab
Events Tab
Slow Response Times Tab
Errors Tab
Transaction Snapshots Tab
Transaction Analysis Tab
IIS AppPools Tab (.NET Only)
Dashboard Tab

The Dashboard Tab displays:
Tier Flow Map: The Tier Dashboard contains a Flow Map of the selected tier. See Flow
Maps.
Events: Lists events that are by default configured to display in the dashboard: Health Rule
Violation Started, Code Problems, Application Changes and Custom events. See Events
Node Health: shows the combined health for all nodes in the tier. The health of each node
is based on any health rule violations triggered during the selected time range. The color bar
indicates:
Green - no health rule violations
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Yellow - at least one health rule violation
Red - at least one critical health rule violation
Transaction Scorecard: number and percentage of transactions that are normal, slow, very
slow, stalled or errors. See Scorecards.
Exceptions: list the total number and number-per-minute of:
Exceptions
HTTP Error Codes
Error Page Redirects
Click the Exceptions link to see the list of exceptions. See To Troubleshoot
Exceptions for more information.
Key Performance Indicators: See KPI Graphs.
Compare Menu

The Compare menu is visible when the Dashboard tab is selected.
By default the performance displayed in the dashboard is compared against the daily trend, which
is the performance over the last 30 days. From the Compare menu you can direct AppDynamics to
use a different baseline or no baseline. You can also configure baselines. For more information
about baselines see Detect Anomalies Using Dynamic Baselines and Configure Baselines.
My Dashboards Tab

This tab is where you create and view new custom dashboard templates for the tier.
Create a new Custom Dashboard: enables you to create and design a tier dashboard
template
Associate Existing Dashboard with this Tier: enables you to associate dashboards
created on other tiers with this tier
If there are existing dashboard templates associated with the tier, an option drop-down list enables
you to:
View existing dashboard templates already associated with the tier
Access windows to:
Create Dashboards
Associate Dashboards
Manage Dashboards
Nodes Tab

The Nodes Tab has these subtabs:
Health
Hardware
Memory
On any subtab, select a node and click View Dashboard or double-click on a node in the list to
open its Node Dashboard.
Health Subtab

The Nodes Health subtab lists nodes that are part of the tier and summary information about each.
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Name: the name of the node.
Health: health rule violation status.
App Agent Status: whether the agent is up (running and connected to the Controller) and
the percentage of time it has been up over the selected time period. An uptime of 53% over
the last hour, for example, means that the agent has been successfully reporting to the
controller for 32 minutes of the previous hour.
App Agent Version: version of the agent.
JVM: version of the JVM or CLR.
Last JVM Restart: date and time of the last JVM/CLR restart.
Machine Agent Status: if there is a machine agent on the node server, whether it up
(running and connected to the Controller) or not.
Hardware Subtab

The Nodes Hardware subtab lists information about the physical server that is hosting the node. If
the Machine Agent is not installed on the physical device, no data will be available.
Memory Subtab

The Memory subtab lists information about the JVM or CLR of the node.
Events Tab

The Tier Dashboard Events tab lists the events for the tier and summary information about each.
Type: type of event. See Events.
Summary: description of the event.
Time: date and time when the event occurred.
Business Transaction: link to the Business Transaction Dashboard for the event.
Tier: link to the tier on which the event occurred.
Node: link to the Node Dashboard for the node on which the event occurred.
This is an embedded copy of the event list in which only events for the selected tier are reported.
You can modify the event types reported in the list. For more information about the event list see F
ilter and Analyze Events.
Slow Response Times Tab

The Slow Response Times tab has two subtabs:
Slow Transactions
Slow DB & Remote Service Calls
Slow Transactions Subtab

This subtab is also accessible from the Troubleshoot menu.
See Troubleshoot Slow Response Times.
Slow DB & Remote Service Calls Subtab

This subtab is also accessible from the Troubleshoot menu.
See Troubleshoot Slow Response Times.
Errors Tab
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The Errors tab has two subtabs:
Error Transactions
Exceptions
These subtabs are also accessible from the Troubleshoot menu.
See Troubleshoot Errors.
Transaction Snapshots Tab

The Transaction Snapshots tab has these subtabs:
All Snapshots
Slow and Error Transactions
Diagnostic Sessions
Periodic Collection
The Slow and Error Transactions or Diagnostic Sessions subtabs are the quickest route to drill
down to the root cause of slow, stalled or error transactions.
All Snapshots Subtab

This subtab displays all the transaction snapshots captured for the selected time range. Error
transaction snapshots are coded red, slow transaction snapshots are coded yellow, and stalled
transaction snapshots are coded purple.
You can select a snapshot from the list and double-click it or click View Snapshot to drill down to
the root cause of the problem. See Transaction Snapshots for more information.
Slow and Error Transactions Subtab

This subtab displays only snapshots for slow and error transactions.
Diagnostic Sessions Subtab

This subtab displays diagnostic sessions that have already been started. It also lets you start a
diagnostic sessions by clicking Start Diagnostic Session.
A diagnostic session captures detailed data about the processing of a transaction as transaction
snapshots over a defined period of time. The snapshots include full call graphs. See See Detailed
Data Using Diagnostic Sessions.
Periodic Collection Subtab

This subtab displays transaction snapshots that have been configured to be collected periodically,
whether or not the transactions are slow or error. See Configure Transaction Snapshots for
information about enabling and disabling periodic snapshot collection.
Transaction Analysis Tab

The Transaction Analysis tab shows the Transaction Analysis Tab graph for the selected tier.
IIS AppPools Tab (.NET Only)

This tab displays the nodes in the IIS App Pool. See Monitoring IIS Application Pools.
Learn More
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Dashboards
Flow Maps
Configure Baselines
Time Ranges
Transaction Analysis Tab
Business Transactions List
Transaction Snapshots
Events
Node Dashboard
Accessing the Node Dashboard
To view the Node Dashboard for a particular node
How the Node Dashboard is Organized
Action Menu
Node Dashboard Tabs
Dashboard Tab
Compare Menu
My Dashboards Tab
Hardware Tab
Memory Tab
JVM Tab (Java Only)
JMX Tab (Java Only)
CLR Tab (.NET Only)
Events Tab
Slow Response Times Tab
Slow Transactions Subtab
Slow DB & Remote Service Calls Subtab
Errors Tab
Transaction Snapshots Tab
All Snapshots Subtab
Slow and Error Transactions Subtab
Diagnostic Sessions Subtab
Periodic Collection Subtab
Transaction Analysis Tab
Agents Tab
App Server Agent Subtab
To Request Agent Log Files
To Configure and Start an Agent Logging Session
Machine Server Agent Subtab
Agent Diagnostic Stats Subtab
Learn More
The Node Dashboard displays the overall health, key metrics, and provides single-click access to
all of the performance indicators for a particular node.
Accessing the Node Dashboard
To view the Node Dashboard for a particular node
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1. Select the business application.
2. In the left navigation pane, click Servers -> App Servers -> <Tier> -> <Node>.
AppDynamics displays the Node Dashboard for the selected node.

How the Node Dashboard is Organized

The Node Dashboard shares the same common components as other Dashboards, including Time
Ranges.
Action Menu

The Action menu provides commonly-performed actions for a node
Troubleshoot -> View Slow and Error Transactions displays transaction snapshots for
the selected time range by node. See Transaction Snapshots.
Troubleshoot -> View Health Rule Violations displays the list of health rule violations. See
Troubleshoot Health Rule Violations.
Troubleshoot -> View Agent Diagnostic Events displays the list of agent diagnostic
events. See App Agent for Java Diagnostic Data.
Analyze -> Analyze Response Time vs Load and Analyze CPU vs Load open the Scalab
ility Analysis window.
Analyze -> Analyze Node Problems displays the node problem viewer. See Troubleshoot
Node Problems.
Report -> Export PDF Report instantly generates a PDF report. See Reports.
Configure -> Configure App Server Agent opens the Node Properties configuration
window. See App Agent Node Properties.
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Edit Properties lets you modify the type of the node.
Move Node lets you move the node to another tier.
Delete Node deletes the node from the flow map.
Node Dashboard Tabs

The Node Dashboard has these tabs:
Dashboard Tab
Hardware Tab
Memory Tab
JVM Tab (Java Only)
JMX Tab (Java Only)
CLR Tab (.NET Only)
Events Tab
Slow Response Times Tab
Errors Tab
Transaction Snapshots Tab
Transaction Analysis Tab
Agents Tab
Dashboard Tab

The Dashboard Tab displays:
Node Flow Map: The Node Dashboard contains a Flow Map for the selected node. The
User/External symbol in the Flow Map represents all traffic to the selected node in the
selected tier that is not accounted for by calls from other tiers. See Flow Maps.
Events: Lists events that are by default configured to display in the dashboard: Health Rule
Violation Started, Code Problems, Application Changes and Custom events. See Events
Transaction Scorecard: Number and percentage of transactions that are normal, slow,
very slow, stalled or errors. See Scorecards.
Exceptions: list the total number and number-per-minute of:
Exceptions
HTTP Error Codes
Error Page Redirects
Click the Exceptions link to see the list of exceptions. See To Troubleshoot
Exceptions for more information.
Key Performance Indicators: See KPI Graphs.
Compare Menu

The Compare menu is visible when the Dashboard tab is selected.
By default the performance displayed in the dashboard is compared against the daily trend, which
is the performance over the last 30 days. From the Compare menu you can direct AppDynamics to
use a different baseline or no baseline. You can also configure baselines. For more information
about baselines see Detect Anomalies Using Dynamic Baselines and Configure Baselines.
My Dashboards Tab

This tab is where you create and view new custom dashboard templates for the node.
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Create a new Custom Dashboard: enables you to create and design a node dashboard
template
Associate Existing Dashboard with this Node: enables you to associate dashboards
created on other nodes with this node
If existing dashboard templates are associated with the node, an option drop-down list enables
you to:
View existing dashboard templates already associated with the node
Access windows to:
Create Dashboards
Associate Dashboards
Manage Dashboards
Hardware Tab

The Hardware tab graphs metrics about the physical server that hosts the node. These metrics
include:
CPU Utilization
Memory Utilization
Disk I/O
Network I/O
These metrics are available if a machine agent is installed on the machine that hosts the node.
Memory Tab

The Memory tab has four subtabs:
Heap and Garbage Utilization
Automatic Leak Detection
Object Instance Tracking
Custom memory Structures
See Troubleshoot Java Memory Issues.
JVM Tab (Java Only)

The JVM tab displays the JVM version, startup options, system options and environment
properties for the node. See App Agent for Java Configuration Properties for information about the
startup options.
Java only.
JMX Tab (Java Only)

The JMX tab lets you monitor JMX metrics. See Monitor JMX MBeans.
Java only.
CLR Tab (.NET Only)

The CLR tab displays CLR properties, CLR startup properties, CLR metadata, and environment
variables.
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Events Tab

The Events tab lists the events for the node and summary information about each.
Type: type of event. See Events.
Summary: description of the event.
Time: date and time when the event occurred.
Business Transaction: link to the Business Transaction Dashboard for the event.
Tier: link to the tier on which the event occurred.
Node: link to the Node Dashboard for the node on which the event occurred.
Actions Executed: action executed in response to the event, if any
This is an embedded copy of the event list in which only events for the selected node are reported.
You can modify the event types reported in the list. For more information about the event list see F
ilter and Analyze Events.
Slow Response Times Tab

The Slow Response Times tab has two subtabs:
Slow Transactions
Slow DB & Remote Service Calls
Slow Transactions Subtab

This subtab is also accessible from the Troubleshoot menu.
See Slow and Stalled Transactions.
Slow DB & Remote Service Calls Subtab

This subtab is also accessible from the Troubleshoot menu.
See Slow Database and Remote Service Calls.
Errors Tab

The Errors tab has two subtabs:
Error Transactions
Exceptions
These subtabs are also accessible from the Troubleshoot menu.
See Troubleshoot Errors.
Transaction Snapshots Tab

The Transaction Snapshots tab has these subtabs:
All Snapshots
Slow and Error Transactions
Diagnostic Sessions
Periodic Collection
The Slow and Error Transactions or Diagnostic Sessions subtabs are the quickest route to drill
down to the root cause of slow, stalled or error transactions.
All Snapshots Subtab
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This subtab displays all the transaction snapshots captured for the selected time range. Error
transaction snapshots are coded red, slow transaction snapshots are coded yellow, and stalled
transaction snapshots are coded purple.
You can select a snapshot from the list and double-click it or click View Snapshot to drill down to
the root cause of the problem. See Transaction Snapshots for more information.
Slow and Error Transactions Subtab

This subtab displays only snapshots for slow and error transactions.
Diagnostic Sessions Subtab

This subtab displays diagnostic sessions that have been started and enables you to start
diagnostic sessions by clicking Start Diagnostic Session.
A diagnostic session captures detailed data about the processing of a transaction as transaction
snapshots over a defined period of time. These snapshots include full call graphs. See See
Detailed Data Using Diagnostic Sessions.
Periodic Collection Subtab

This subtab displays transaction snapshots that have been configured to be collected periodically,
whether or not the transactions are slow or error. See Configure Transaction Snapshots for
information about enabling and disabling periodic snapshot collection.
Transaction Analysis Tab

The Transaction Analysis tab shows the Transaction Analysis Tab histogram for the selected
node.
Agents Tab

The Agents Tab provides information about the agent instrumenting the node. It contains these
subtabs:
App Server Agent
Machine Agent
Agent Diagnostic Stats
App Server Agent Subtab

This subtab describes the properties of the app agent.
It also enables you to request the agent log files and to configure and start logging of specific
types of requests for a specified duration. This gives you fine control of what to log.
To Request Agent Log Files
See Request Agent Log Files.
To Configure and Start an Agent Logging Session
See Configure and Start an Agent Logging Session (Java and PHP only).
Machine Server Agent Subtab

This subtab describes the properties of the machine agent, if a machine agent is installed on the
machine that hosts the node.
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Agent Diagnostic Stats Subtab

This subtab displays agent diagnostic statistics, such as how many transactions successfully
registered or how many metrics were uploaded. You can click a statistic to see it graphed in the
Metric Browser.
See App Agent for Java Diagnostic Data.
Learn More

App Agent Node Properties
Filter and Analyze Events
App Servers List
Accessing the App Servers List
Viewing the App Servers List
How the App Servers List is Organized
Menus
View Dashboard
Create Tier
View Toggle
Tier and Node Count
Search
Tabs
Health Tab
Hardware Tab
Memory Tab
Java Memory
.NET Memory
PHP Memory
Learn More
This topic describes the App Servers List window.
Accessing the App Servers List

AppDynamics displays all application servers in a business application on the application server
list.
To access this list, in the left navigation pane click Server -> App Servers.
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Viewing the App Servers List

To sort the servers based on the data in a particular column, click the column header.
To filter the list, enter the app server to filter on in the filter field.
To view the list in organized by app server, click the tree icon. To see it organized by node,
click the grid icon.
How the App Servers List is Organized
Menus
View Dashboard

You can select a tier or node and click View Dashboard to see its dashboard. See Tier Dashboard
and Node Dashboard.
Create Tier

The Create Tier button lets you set up another tier. See Creating New Tiers.
View Toggle

The View toggle changes the list from a tree view, ordered by tier, to a flat grid view.
Tier and Node Count

The App Servers List tells you how many tiers and nodes are in the application.
Search

The search box filters the list of nodes. This is helpful when you have many nodes.
Tabs

The App Servers List has three tabs: Health, Hardware, and Memory. Click the tab that matches
the type of information that you are interested in.
Health Tab

The Health tab has the following columns:
# of Nodes
This column shows the number of nodes (app servers) in the tier. This column is visible only
in tree view.
Health
The color of the Health icon describes the extent to which a server, or one of its nodes, is
experiencing node-level health rule violations. Healthy servers green; servers with
warning-level violations are yellow/orange; servers with critical-level violations are red.
For more information see See Tutorial - Server Health and Troubleshoot Health Rule
Violations.
App Agent Status
A green up-arrow icon indicates that the app agent is reporting to the Controller.
A red down-arrow icon indicates that the app agent is not reporting to the Controller.
If the app agent is not reporting, see:
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Resolving Configuration Issues App Agent for Java
Resolve .NET Agent Installation and Configuration Issues
App Agent Version
This column shows the version of the app agent running on the node.
JVM (Java only)
This column shows the name and version of the JVM.
Last JVM Restart (Java only)
This column shows the timestamp of the last JVM restart.
CLR (.NET only)
This column shows the name and version of the CLR.
Last CLR Restart (.NET only)
This column shows the timestamp of the last CLR restart.
Machine Agent Status
A green up-arrow icon indicates that the machine agent is reporting to the Controller.
A red down-arrow icon indicates that the machine agent is not reporting to the Controller.
If the machine agent is not reporting, the column shows a dash. Either an agent is not
installed or it is not reporting for some other reason. In Java or PHP environments see Troub
leshooting Machine Agent Installation. For .NET see Configure Machine Agents in a .NET
Environment.
Hardware Tab

If a machine agent is not installed on the physical device, no data will be available in the Hardware
tab.
The Hardware tab has the following columns:
CPU % (current)
CPU % (average) - over the selected time range
Memory % (current)
Memory % (average) - over the selected time range
Disk IO KB reads/sec
Disk IO KB writes/sec
Network IO KB reads/sec
Network IO KB writes/sec
For more information see Monitor Hardware.
Memory Tab

The Memory tab shows memory information relevant to your application environment.
Java Memory

The Memory tab has the following columns for Java servers:
JVM % Heap
Max Heap
JVM CPU Burnt (ms/min)
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GC Time Spent (ms/min)
Major Collections
Major Col time min (ms)
Minor Col time min (ms)
For more information, see Troubleshoot Java Memory Issues.
.NET Memory

The Memory tab has the following columns for .NET servers:
Current Heap Utilization (MB)
Average Heap Utilization (MB) - over the selected time range
Committed Heap
CPU Burnt (% proc time)
Induced Collections
Time Spent on Collections (%)
PHP Memory

PHP memory management is different than other languages. Relevant memory metrics supplied
by the App Agent for PHP are in the Metric Browser.
Learn More

Creating New Tiers
Monitor App Servers
Logical Model
Dashboards
Databases List and Dashboard
The Database Server List
To access the Database Server List
To delete databases from the list
The Database Dashboard
To access a Databases Dashboard
How the Database Dashboard is Organized
Action Menu
Database Tabs
Dashboard Tab
Compare Menu
Slowest Database Calls Tab
Linking to AppDynamics for Databases
Learn More
Each database has its own dashboard and is listed in the Database Servers List.
The Database Server List

AppDynamics displays all detected database servers on the database server list along with the
key performance indicators of calls to them: response time, calls, calls per minute, errors, and
errors per minute.
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To access the Database Server List

In the left navigation pane, click Servers -> Databases.
To sort the servers based on the data in a particular column, click the column header.
To filter the list, enter the string to filter on in the filter field.
To delete databases from the list

1. Select the database or databases that you want to delete from the list.
2. Click the delete icon.
The database or databases no longer appear in the UI.
The Database Dashboard

Access a dashboard from the Databases List.

To access a Databases Dashboard

1. In the left navigation pane click Servers -> Databases.
2. From the Databases List select a database.
3. Click View Dashboard.
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How the Database Dashboard is Organized
Action Menu

The Action menu provides these actions for a remote service:
Rename Backend: Renames the database.
Resolve Backend to Tier: Associates the database with the tier that you select so that the
backend appears in the grid view of the tier and not as an independent component
("unresolved backend") on the application dashboard flow map. You can reverse this
operation from the Configure Backends resolving to this Tier item in Actions menu in the
tier dashboard.
Delete Backends: Removes instances of the database from the controller and all agents.
An agent can re-discover the database and register it with the controller.
Database Tabs

The dashboard has two tabs:
Dashboard Tab
Slowest Database Calls Tab
Dashboard Tab

The Dashboard tab displays information about calls to the database:
Flow map: shows traffic from the calling tier to the database. See Flow Maps.
Backend Properties: varies according to database type.
Key Performance Indicators: See KPI Graphs.
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Compare Menu

The Compare menu is visible when the Dashboard tab is selected.
By default the performance displayed in the dashboard is compared against the daily trend, which
is the performance over the last 30 days. From the Compare menu you can direct AppDynamics to
use a different baseline or no baseline. You can also configure baselines. For more information
about baselines see Detect Anomalies Using Dynamic Baselines and Configure Baselines.
Slowest Database Calls Tab

The Slowest Database Calls tab lists up to ten calls to the database with the longest execution
time, by tier and for all tiers.
Each call shows the SQL Query, Average Time, Number of Calls during the time range, and
maximum execution time (Max Time). The Max Time is used to determine which calls are
displayed in the Slowest Database Calls list.
If transaction snapshots are available for a slow call, you can click View Snapshots link. From
there you can select a snapshot and click View Transaction Snapshot to drill down to the root
cause of the slow database call.

Linking to AppDynamics for Databases

Users of AppDynamics for Databases can link to that product by right-clicking on a database from
the database list or from the database icon on any flow map.
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This linkage gives you deep visibility into the performance of an application's SQL queries.
Learn More

Dashboards
Flow Maps
Transaction Snapshots
Troubleshoot Slow Response Times
Detect Anomalies Using Dynamic Baselines
Configure Baselines
Integrate with AppDynamics for Databases
Remote Services Dashboard
Accessing a Remote Services Dashboard
To access a Remote Service Dashboard
How the Remote Services Dashboard is Organized
Action Menu
Remote Service Tabs
Dashboard Tab
Compare Menu
Slowest Remote Service Calls Tab
To drill down into the Slowest Remote Services
Learn More
Each remote service has its own dashboard.
Accessing a Remote Services Dashboard

Access a dashboard from the Remote Services List.
To access a Remote Service Dashboard

1. In the left navigation pane select Servers -> Remote Services.
2. From the Remote Services List select a remote service.

3. Click View Dashboard.
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How the Remote Services Dashboard is Organized
Action Menu

The Action menu provides these actions for a remote service:
Rename Backend: Renames the remote service
Resolve Backend to Tier: Associates the service with the tier that you select so that the
backend appears in the grid view of the tier and not as an independent component
("unresolved backend") on the application dashboard flow map. You can reverse this
operation from the Configure Backends resolving to this Tier item in Actions menu in the
tier dashboard.
Delete Backends: Removes instances of the service from the controller and all agents. An
agent can re-discover the service and register it with the controller.
Remote Service Tabs

The dashboard has these tabs:
Dashboard Tab
Slowest Remote Service Calls Tab
Dashboard Tab

The Dashboard tab displays information about calls to the service:
Flow map: shows traffic to and from the service. See Flow Maps.
Backend Properties: varies according to service type
Key Performance Indicators: See KPI Graphs.
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In the flow map, click the call from the app server to the remote service to view the key
performance indicators (KPIs) and the business transaction breakdown for the calls to the service.
Compare Menu

The Compare menu is visible when the Dashboard tab is selected.
By default the performance displayed in the dashboard is compared against the daily trend, which
is the performance over the last 30 days. From the Compare menu you can direct AppDynamics to
use a different baseline or no baseline. You can also configure baselines. For more information
about baselines see Detect Anomalies Using Dynamic Baselines and Configure Baselines.
Slowest Remote Service Calls Tab

The Slowest Remote Service Calls tab lists the ten calls to the service with the longest execution
time, by tier.
Each call shows the Average Time, Number of Calls during the time range, and Max Time. The
Max Time is used to determine which calls are in the list.
To drill down into the Slowest Remote Services

1. Select the call in the list.
The query and its key performance metrics display in the right panel.
2. If transaction snapshots are available for the selected call, click either View Snapshots at the
end of the query row or the Correlated Snapshots tab in the lower panel.
3. From the snapshots list that appears select the snapshot that you want to examine and click Vie
w Transaction Snapshot.
4. In the snapshot flow map that displays, click Drill Down to view the transaction snapshot.
See Transaction Snapshots.
Learn More

Monitor Remote Services
Troubleshoot Slow Response Times
Transaction Snapshots
Dashboards
Flow Maps
Detect Anomalies Using Dynamic Baselines
Configure Baselines
EUM Dashboard

Accessing the EUM Dashboard
How the EUM Dashboard is Organized
Learn More
Accessing the EUM Dashboard

If end user monitoring is not configured for your application, you will not see the EUM menu item
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or any EUM data. See Set Up and Configure Web EUEM for information about configuring EUM.
To access the End User Monitoring (EUM) Dashboard:
1. Select the business application for which EUM has been enabled..
2. In the left navigation pane, click End User Experience.
The EUM Dashboard opens.

How the EUM Dashboard is Organized

The EUM Dashboard displays end user experience information in two tabs:
Geographic Distribution
Browser Distribution
The Geographic Distribution view consists of three panels:
A main panel in the upper left containing that displays geographic distribution on a map or a
grid
A panel on the right displaying summary information: total end user response time, page
render time, network time and server time
Trend graphs in the lower part of the dashboard that dynamically display data based on the
level of information displayed in the other two panels
The geographic region for which the data is displayed throughout the dashboard is based on the
region currently showed on the map or in the summary panel. For example, if you zoom down from
global view to France in the map, the summary panel and the graphs display data for France.
The Browser Distribution view displays key performance indicators and graphs of average
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response time and by browser and browser version.
Learn More

Web EUEM
Set Up and Configure Web EUEM

Events
Event Categories
Health Rule Violation Events
Slow Transactions
Errors
Code Problems
Application Changes
AppDynamics Internal Diagnostics
Custom Events
Notifications of Events
Archiving Events
To Archive an Event
To Find Archived Events
Learn More
An event is a change in application state that is of potential interest.
AppDynamics summarizes events generated for a specific AppDynamics entity - a business
application, business transaction, tier or node- on the Dashboard tab of the entity's dashboard.

AppDynamics reports all events for an application in the application Events List. To access the
events list, select Events from the left navigation pane.

The events that occurred within the period indicated by the time range dropdown menu appear in
the Events List.
You can filter the types of events displayed in the list by checking which events you are interested
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in. You can learn more about a specific event by selecting it from the list and viewing its details.
To view and set event filters, click Show Filters. To hide them, click Hide Filters.
AppDynamics also displays the list of events for the entity in the Events tab of the business
transaction, tier or node dashboards.
Event Categories

The event categories are:
Health Rule Violations
Slow Transactions
Errors
Code Problems
Application Changes
AppDynamics Internal Diagnostics
Custom
The event categories include events of different types.
Health Rule Violation Events

Health Rule events include:
Health Rule Violation Started - Warning
Health Rule Violation Started - Critical
Health Rule Violation Continues - Warning
Health Rule Violation Continues - Critical
Health Rule Violation Upgraded - Warning to Critical
Health Rule Violation Downgraded - Critical to Warning
Health Rule Violation Ended
New in 3.9.1 Health Rule Violation Canceled (this event is generated for an incident if the
originating health rule is deleted or modified so that the violating condition no longer applies)
New in 3.9.4 Health rules which cannot currently be evaluated (when a necessary metric is
not available, when a necessary baseline is not available, when a new health rule has just
been added, or when the system has just restarted) are now displayed with a status of a
greyed-out question mark or "Unknown"
You can filter the specific health rules by affected entity to specify which event data should be
displayed.
For information about health rules and health rules violations see Health Rules and Troubleshoot
Health Rule Violations.
Slow Transactions

Slow transactions include:
Slow
Very Slow
Stalled
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AppDynamics provides default thresholds that define slow, very slow and stalled transactions, but
you can reconfigure them for your environment. See Configure Thresholds.
Errors

Error events include error snapshots and all application server exceptions.
You can restrict the errors for which events are displayed by selecting only errors caused by
specific exceptions. If you do not select specific exceptions, all the error events are displayed.
Code Problems

Code problems include:
Code Deadlock
See Detect Code Deadlocks for Java.
Resource Pool Limit Reached
This event is generated when the maximum size for any resource pool, such as a thread
pool or a connection pool, is reached.
Application Changes

Application change events include:
Application Deployment
This event is manually registered. See Monitor Application Change Events. Alternatively you
can Create a Custom Event.
App Server Restarts
This event is generated when an app server is restarted.
Application Configuration Change
This event is manually registered. See Monitor Application Change Events. Alternatively you
can Create a Custom Event.
AppDynamics Internal Diagnostics

The AppDynamics Internal Diagnostics events include:
Diagnostic Session
This event is generated when a diagnostic session is started. See See Detailed Data Using
Diagnostic Sessions.
Agent Enabled / Disabled
This event is generated when an agent is enabled or disabled. See Manage App Agents.
Bytecode Transformer Log
This event is generated when an entry is added to the bytecode transformer log. This log
shows what AppD instruments and what classes are loaded in the JVM. See bci-log-config f
or information about bytecode transformer log.
Agent Diagnostics Event
This event is generated when agent diagnostic data is created. You can access agent
diagnostic data from the Action menu on the node dashboard. See Action Menu and App
Agent for Java Diagnostic Data.
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AppDynamics Internal Diagnostics
This event is used by AppDynamics for internal debugging.
Internal UI Event
This event is used by AppDynamics for debugging data sent from the agent to the controller
to the UI.
Custom Events

You can create a Custom event using the REST API.
See Create a Custom Event.
Notifications of Events

You can create email digests to notify recipients when specific events occur. See Configure Email
Digests.
Archiving Events

Normally events are purged after a configurable time - by default, two weeks. To save an event
beyond the normal snapshot lifespan – for example, if you want to make sure an event associated
with a particular problem is retained for future analysis – archive the event.
Customers with on-premise controllers can modify the default two-week period by configuring the
events.retention.period in the Controller Settings section of the Administration console.
To Archive an Event

1. Display the Events list.
2. Select one or more events.
3. Click the Archive button in the toolbar.
When you are viewing your Events list, a small icon in the far right column indicates that an event
has been archived.
To Find Archived Events

To view archived events in the Events list, sort on the far right column. All archived events will be
displayed together.
Learn More

Filter and Analyze Events
Events Reference
Configure Email Digests
Monitor Application Change Events
Health Rules
Email Digests
Monitor Events
An event is something that happens in the managed environment that may require attention.
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Events are classified according to their event type.
See:
You can configure an email digest to send notification of certain events to a recipient list. See Ema
il Digests.
Filter and Analyze Events

Filtering Events
To View the Event Filter
To Filter Events
To Filter Error Events
To Filter By Custom Events
Analyzing Events
To View Event Details
To view the events list, select Events from the left navigation pane.
The events list reports the most recent events in your application. If the Fetch More link is visible
you can click it to retrieve older events.

You can get details about an event in the list. The content of the details depends on the type of
event. If the event is an application change, such as an application restart, the details might be a
static description of the event. If the event is a slow transaction or an error, the details are
transaction snapshots from which you can drill down to the root cause of the problem.
Filtering Events

If all of the checkboxes in the entire event filter are clear, no events are filtered out and all events
are reported.
If one or more of the checkboxes in the event filter are checked, all events are filtered out except
for those event types that are checked.
You can filter events to display by event type and by object.
To View the Event Filter

To display the event filter, click Show Filter.
To hide the event filter, click Hide Filter.
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In the FILTER BY EVENT TYPE section of the filter panel, you can filter based on the event type
(such as Slow Transactions or Code Problems) and subtype (such as Slow Transactions -> Very
Slow Transactions or Code Problems -> Code Deadlock).
You can filter health rule violation events on the health rule type and on specific health rules. For
example, you can specify events caused by business transaction performance health rules or only
node health rule violations events caused by the "Memory utilization is too high" health rule.
When you filter by AppDynamics entity type in the FILTER BY OBJECT section of the filter panel,
you can select specific business transactions or tiers and nodes for which to report events. If you
filter by business transaction, filtering by tier and/or node is disabled. If you filter by tier and/or
node, filtering by business transaction is disabled.

If you filter by event type but not by object (in other words, at least one of the event type filters is
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checked but all of the object filters are clear) the events of the selected type are displayed for all
AppDynamics entities (business transactions, tiers, and nodes).
To Filter Events

1. In the left panel of the event viewer, check the check boxes for the types of events to display.
2. Clear the check boxes for the types of events not to display.
To clear all the check boxes, click Clear Criteria.
To Filter Error Events
If you are filtering Error events, checking the Errors checkbox causes all error snapshots and all
errors caused by application server exceptions to be displayed. To reduce the number of error
events, you can filter the list by specifying that only error snapshots caused by specific exceptions
should be displayed. To do this:
1. In the Errors section of the Event filter panel click Select Specific Exceptions.
2. In the list of exceptions that appears, click the exception or exceptions for which you want to see
error events.

3. Click Select.
If you select any exceptions, only error snapshots caused by the selected exceptions are
displayed.
If you do not select any exceptions, all error snapshots caused by all exceptions are displayed.
To Filter By Custom Events
1. In the Filter by Custom Events section of the Event filter panel, click "+" to create a new filter.
The Add Custom Event Filter appears.
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2. Define the custom event type and, if desired, particular properties on that event, as key/value
pairs. Selecting the match value All indicates a logical AND. Selecting the match value Any
indicates a logical OR. Click Save.
In the case of Any, at least one property must exist and match. In the case of All, all properties
must exist and match.
Analyzing Events
To View Event Details

1. In the events list select the event for which you want to see details.
2. Click View Event Details.
Usually AppDynamics displays a summary of the event in a new window.

If the event produced a transaction snapshot, as for example in the case of a slow transaction
event, AppDynamics displays the transaction snapshot associated with the event. From there you
can drill down to the root cause. See Transaction Snapshots. Note that by default, transaction
snapshots are purged from the database after two weeks. If you want to be able to review a
snapshot that is more than two weeks old, you should archive the snapshot before it is purged.
Monitor Application Change Events
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Configuring Application Change Monitoring
Events Automatically Discovered by Default
Events That You Register
To manually register an application change event
Events from Third-Party Systems
Correlating Application Change Events With Other Events
To correlate application changes with other events
Learn More
You can monitor changes in your application, such as new code roll-outs or configuration changes
to application servers, and correlate these changes with other monitoring data.
AppDynamics can record application changes as events that appear in the Events List.
Configuring Application Change Monitoring

There are three ways AppDynamics registers application change events:
By default configuration
By manual registration
By adding external events using REST
Events Automatically Discovered by Default

App server configuration changes are automatically discovered. You can see them in the Events
List.

Click the snapshot icon on the right to see details about the change.
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Events That You Register

You can add an event to the system. For example you could register the date/time when you
updated a part of your application. Then you can correlate that event with other events.
To manually register an application change event

1. In the Events List click Register Application Change.

2. In the Register Application Change window enter a brief description of the application event.
3. Select the type, scope and date/time of the event.
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4. Click Register Application Change.
Events from Third-Party Systems

You can add events from other systems using the REST API to Create a Custom Event. For
example, you can add events from your release management system so that an event is created
in AppDynamics for every corresponding release of your product.
Correlating Application Change Events With Other Events

You can compare the system performance across all the application changes. For example, you
can compare between the old and the modified values of any application configuration event.
You can add application changes to other events to be displayed together on a histogram.
To correlate application changes with other events

1. In the Application Dashboard click the Transaction Analysis tab.
2. Click Show Events.
3. Click show event filters.
4. Select Application Changes.
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5. Click Search.
In this example the Transaction Analysis histogram shows a break in the blue response time line
that corresponds with an event.
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Drilling down into the event shows the details and snapshots.
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Learn More

Events
Transaction Analysis Tab
Use the AppDynamics REST API
Events Reference
Viewing Events
To view standard events in the AppDynamics console
To retrieve events using the REST API
Event Types
ACTIVITY_TRACE
ADJUDICATION_CANCELLED
AGENT_ADD_BLACKLIST_REG_LIMIT_REACHED
AGENT_ASYNC_ADD_REG_LIMIT_REACHED
AGENT_CONFIGURATION_ERROR
AGENT_DIAGNOSTICS
AGENT_ERROR_ADD_REG_LIMIT_REACHED
AGENT_EVENT
AGENT_METRIC_BLACKLIST_REG_LIMIT_REACHED
AGENT_METRIC_REG_LIMIT_REACHED
AGENT_STATUS
ALREADY_ADJUDICATED
APPLICATION_CONFIG_CHANGE
APPLICATION_DEPLOYMENT
APP_SERVER_RESTART
AZURE_AUTO_SCALING
CONTROLLER_AGENT_VERSION_INCOMPATIBILITY
CONTROLLER_ASYNC_ADD_REG_LIMIT_REACHED
CONTROLLER_ERROR_ADD_REG_LIMIT_REACHED
CONTROLLER_EVENT_UPLOAD_LIMIT_REACHED
CONTROLLER_METRIC_REG_LIMIT_REACHED
CONTROLLER_RSD_UPLOAD_LIMIT_REACHED
CUSTOM
CUSTOM_ACTION_END
CUSTOM_ACTION_FAILED
CUSTOM_ACTION_STARTED
DEADLOCK
DIAGNOSTIC_SESSION
DISK_SPACE
EMAIL_SENT
EUM_CLOUD_BROWSER_EVENT
INFO_INSTRUMENTATION_VISIBILITY
INTERNAL_UI_EVENT
LICENSE
MEMORY
MEMORY_LEAK_DIAGNOSTICS
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NORMAL
OBJECT_CONTENT_SUMMARY
POLICY_CLOSE
POLICY_DOWNGRADED
POLICY_OPEN_CRITICAL
POLICY_OPEN_WARNING
POLICY_UPGRADED
RESOURCE_POOL_LIMIT
RUNBOOK_DIAGNOSTIC SESSION_END
RUNBOOK_DIAGNOSTIC SESSION_FAILED
RUNBOOK_DIAGNOSTIC SESSION_STARTED
RUN_LOCAL_SCRIPT_ACTION_END
RUN_LOCAL_SCRIPT_ACTION_FAILED
RUN_LOCAL_SCRIPT_ACTION_STARTED
SLOW
SMS_SENT
STALLED
SYSTEM_LOG
THREAD_DUMP_ACTION_END
THREAD_DUMP_ACTION_FAILED
THREAD_DUMP_ACTION_STARTED
VERY_SLOW
WORKFLOW_ACTION_END
WORKFLOW_ACTION_FAILED
WORKFLOW_ACTION_STARTED
Learn More
Every AppDynamics event is an instance of one of the event types described in this topic. This
topic does not include event types that are not currently used.
Viewing Events

The Events window in the AppDynamics console displays information about events. In the console
these events are grouped into the following categories:
Health Rule Violations
Slow Transactions
Errors
Code Problem
Application Changes
AppDynamics Configuration Warnings
AppDynamics Internal Diagnostics
AppDynamics Data
Custom
You can view events and select the types of events you want to see reported in the Events page.
To view standard events in the AppDynamics console

1.
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1. In the left navigation panel click Events.
2. If filters are hidden click Show Filters to see the event types.
Events of event types that are checked are displayed when they occur.
To retrieve events using the REST API

In addition to the standard event types, you can retrieve events of additional event types using the
REST API. Pass the event types of events that you want to retrieve in the event-types parameter
of the REST call. See Retrieve event data.
Tip: You can see a list of all event types in the Events panel if the UI is in debug mode.
With the UI in debug mode, click the View Events (old) link and click Show Filters.
Note that in the list, event types are identified by code identifier rather than their UI
names. See Set User Preferences for information on setting debug mode.
Event Types
ACTIVITY_TRACE

Description: The agent sent an internal event containing activity traces.
Activity traces enable tracing a code path that passes through a specified class/method. The App
Agent for Java uses them to provide object instance tracking (OIT) and automatic leak detection
(ALD)
Visible in UI: Only in debug mode
Learn More: Troubleshoot Java Memory Leaks, Configure and Use Object Instance Tracking for
Java
ADJUDICATION_CANCELLED

Description: A designated approver has canceled a thread dump or remediation action that was
triggered by a policy.
Visible in UI: Only in debug mode
Learn More: Actions Requiring Approval, Policies
AGENT_ADD_BLACKLIST_REG_LIMIT_REACHED

Description: The agent Application Diagnostic Data (ADD) blacklist registration limit has been
reached.
Visible in UI: Only in debug mode
Learn More: Customize System Event Notifications
AGENT_ASYNC_ADD_REG_LIMIT_REACHED

Description: The agent async Application Diagnostic Data (ADD) registration limit has been
reached.
Visible in UI: Only in debug mode
AGENT_CONFIGURATION_ERROR
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Description: An agent configuration error has been detected.
Category: AppDynamics Configuration Warnings
UI Display name: Agent Configuration Error
Visible in UI: Yes
Learn More: Resolving Configuration Issues App Agent for Java, Resolve .NET Agent Installation
and Configuration Issues
AGENT_DIAGNOSTICS

Description: Diagnostic information concerning agent activity, such as business transaction
overflow or HTTP error code diagnostics, has been sent.
Category: AppDynamics Internal Diagnostics
UI Display name: Agent Diagnostics Event
Visible in UI: Yes
Learn More: App Agent for Java Diagnostic Data
AGENT_ERROR_ADD_REG_LIMIT_REACHED

Description: The agent error Application Diagnostic Data (ADD) registration limit has been
reached.
Visible in UI: Only in debug mode
AGENT_EVENT

Description: Generic internal event.
Category: AppDynamics Internal Diagnostics
UI Display name: Agent Event
Visible in UI: Yes
AGENT_METRIC_BLACKLIST_REG_LIMIT_REACHED

Description: The agent metric blacklist registration limit has been reached.
Visible in UI: Only in debug mode
Learn More: Metrics Limits, Customize System Event Notifications
AGENT_METRIC_REG_LIMIT_REACHED

Description: The agent metric registration limit has been reached.
Visible in UI: Only in debug mode
Learn More: Metrics Limits, Customize System Event Notifications
AGENT_STATUS

Description: The agent has been enabled or disabled.
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Category: AppDynamics Internal Diagnostics
UI Display name: Agent Enabled / Disabled
Visible in UI: Yes
Learn More: Manage App Agents
ALREADY_ADJUDICATED

Description: A designated approver has previously approved or cancelled a thread dump or
remediation action that was triggered by a policy.
Visible in UI: Only in debug mode
Learn More: Actions Requiring Approval, Policies
APPLICATION_CONFIG_CHANGE

Description: Application configuration has been changed interactively by the user or though the
REST API.
Category: Application Changes
UI Display name: Application Configuration Change
Visible in UI: Yes
APPLICATION_DEPLOYMENT

Description: An application has been deployed.
Category: Application Changes
UI Display name: Application Deployment
Visible in UI: Yes
APP_SERVER_RESTART

Description: An application server has been restarted.
Category: Application Changes
UI Display name: App Server Restart
Visible in UI: Yes
AZURE_AUTO_SCALING

Description: Internal event that reports Azure auto-scaling progress to the UI. Seen at the bottom
of the Azure auto-scaling screen.
Visible in UI: Only in debug mode
CONTROLLER_AGENT_VERSION_INCOMPATIBILITY

Description: The agent version is newer than Controller version.
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Category: AppDynamics Configuration Warnings
UI Display name: Agent Version is newer than Controller version
Visible in UI: Yes
Learn More: Agent - Controller Compatibility Matrix, Install the Controller
CONTROLLER_ASYNC_ADD_REG_LIMIT_REACHED

Description: The Controller limit for registering async Application Diagnostic Data (ADDs) for this
account has been reached
Visible in UI: Only in debug mode
Learn More: Customize System Event Notifications
CONTROLLER_ERROR_ADD_REG_LIMIT_REACHED

Description: The limit for registering error Application Diagnostic Data (ADDs) for the account has
been reached.
Visible in UI: Only in debug mode
Learn More: Customize System Event Notifications
CONTROLLER_EVENT_UPLOAD_LIMIT_REACHED

Description: The limit on the number of events per minute that can be uploaded to the controller
for the account has been reached.
Visible in UI: Only in debug mode
Learn More: Customize System Event Notifications
CONTROLLER_METRIC_REG_LIMIT_REACHED

Description: The limit for registering metrics for the account has been reached.
Visible in UI: Only in debug mode
Learn More: Metrics Limits, Customize System Event Notifications
CONTROLLER_RSD_UPLOAD_LIMIT_REACHED

Description: The request segment data (RSD) limit for the account has been reached.
Visible in UI: Only in debug mode
Learn More: Customize System Event Notifications
CUSTOM

Description: These are custom events thrown by REST API calls or machine agent API calls.
Category: Custom Event
UI Display name: Depends on the event.
Visible in UI: Depends on the event.
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Learn More: Create Events
CUSTOM_ACTION_END

Description: A custom action has ended.
Visible in UI: Only in debug mode
Learn More: Custom Actions, Policies
CUSTOM_ACTION_FAILED

Description: A custom action has failed.
Visible in UI: Only in debug mode
Learn More: Custom Actions, Policies
CUSTOM_ACTION_STARTED

Description: A custom action has started.
Visible in UI: Only in debug mode
Learn More: Custom Actions, Policies
DEADLOCK

Description: The agent has detected code deadlock.
Category: Code Problems
UI Display name: Code Deadlock
Visible in UI: Yes
Learn More: Detect Code Deadlocks for Java
DIAGNOSTIC_SESSION

Description: A diagnostic session has started.
Category: AppDynamics Internal Diagnostics
UI Display name: Diagnostic Session
Visible in UI: Yes
Learn More: See Detailed Data Using Diagnostic Sessions
DISK_SPACE

Description: The controller is running out of disk space.
Category: AppDynamics Configuration Warnings
UI Display name: Controller Disk Space Low
Visible in UI: Yes
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Learn More: Controller System Requirements, Controller Disk Space and the Database, Databas
e Size and Data Retention
EMAIL_SENT

Description: Email was sent to notify the recipient of an event.
Visible in UI: Only in debug mode
Learn More: Email Digests, Notification Actions
EUM_CLOUD_BROWSER_EVENT

Description: A browser snapshot was stored in the database.
Visible in UI: Only in debug mode
Learn More: End User Experience Management, Browser Snapshots
INFO_INSTRUMENTATION_VISIBILITY

Description: Information was written to the Bytecode Transformer Log. This log contains
information associated with the AppDynamics bytecode instrumentation (BCI) engine.
Category: AppDynamics Internal Diagnostics
UI Display name: Agent Event
Visible in UI: Yes
Learn More: Request Agent Log Files, App Agent Node Properties Reference
INTERNAL_UI_EVENT

Description: These are the XResponder.handleGeneralServerFaultEvent events.
Category: AppDynamics Internal Diagnostics
UI Display name: Controller API Call Threw an Exception
Visible in UI: Yes
LICENSE

Description: The AppDynamics license has expired.
Category: AppDynamics Configuration Warnings
UI Display name: License Expired
Visible in UI: Yes
Learn More: License Information, Controller Licenses
MEMORY

Description: Events for automatic leak detection and custom memory structures.
Visible in UI: Only in debug mode
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Learn More: Troubleshoot Java Memory Issues
MEMORY_LEAK_DIAGNOSTICS

Description: The agent sends this internal event with memory leak data. The UI uses this on the
memory monitoring screens in the node dashboards.
Visible in UI: Only in debug mode
Learn More: Troubleshoot Java Memory Issues
NORMAL

Description: A business transaction is normal (not slow, very slow or stalled).
Visible in UI: Only in debug mode
Learn More: Configure Thresholds, Detect Anomalies Using Dynamic Baselines
OBJECT_CONTENT_SUMMARY

Description: The agent sent an internal event with object content summary for collections,
caches, etc.
Visible in UI: Only in debug mode
POLICY_CLOSE

Description: A health rule violation ended.
Category: Policy Violations
UI Display name: Health Rule Violation Ended
Visible in UI: Yes
Learn More: Health Rules, Policies
POLICY_DOWNGRADED

Description: A health rule violation was downgraded from critical to warning.
Category: Policy Violations
UI Display name: Health Rule Violation Downgraded - Critical to Warning
Visible in UI: Yes
Learn More: Health Rules, Policies
POLICY_OPEN_CRITICAL

Description: A critical health rule was violated.
Category: Policy Violations
UI Display name: Health Rule Violation Started - Critical
Visible in UI: Yes
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Learn More: Health Rules, Policies
POLICY_OPEN_WARNING

Description: A warning health rule was violated.
Category: Policy Violations
UI Display name: Health Rule Violation Started - Warning
Visible in UI: Yes
Learn More: Health Rules, Policies
POLICY_UPGRADED

Description: A health rule violation was upgraded from warning to critical.
Category: Policy Violations
UI Display name: Health Rule Violation Upgraded - Warning to Critical
Visible in UI: Yes
Learn More: Health Rules, Policies
RESOURCE_POOL_LIMIT

Description: A resource pool limit, such as a thread pool or connection pool, has been reached.
Category: Code Problems
UI Display name: Resource Pool Limit Reached
Visible in UI: Yes
Learn More: Remediation Actions, Policies
RUNBOOK_DIAGNOSTIC SESSION_END

Description: A diagnostic session that was started by a diagnostic action triggered by a policy has
ended.
Visible in UI: Only in debug mode
Learn More: See Detailed Data Using Diagnostic Sessions, Diagnostic Actions, Policies
RUNBOOK_DIAGNOSTIC SESSION_FAILED

Description: A diagnostic session that was started by a diagnostic action triggered by a policy has
failed.
Visible in UI: Only in debug mode
Learn More: See Detailed Data Using Diagnostic Sessions, Diagnostic Actions, Policies
RUNBOOK_DIAGNOSTIC SESSION_STARTED

Description: A diagnostic session that was started by a diagnostic action triggered by a policy has
started.
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Visible in UI: Only in debug mode
Learn More: See Detailed Data Using Diagnostic Sessions, Diagnostic Actions, Policies
RUN_LOCAL_SCRIPT_ACTION_END

Description: A local script that was started by a remediation action triggered by a policy has
ended.
Visible in UI: Only in debug mode
Learn More: Remediation Actions, Policies
RUN_LOCAL_SCRIPT_ACTION_FAILED

Description: A local script that was started by a remediation action triggered by a policy has
failed.
Visible in UI: Only in debug mode
Learn More: Remediation Actions, Policies
RUN_LOCAL_SCRIPT_ACTION_STARTED

Description: A local script that was started by a remediation action triggered by a policy has
started.
Visible in UI: Only in debug mode
Learn More: Remediation Actions, Policies
SLOW

Description: A business transaction is now slow.
Category: Slow Transactions
UI Display name: Slow Transactions
Visible in UI: Yes
Learn More: Troubleshoot Slow Response Times, Configure Thresholds
SMS_SENT

Description: An SMS was sent to notify the recipient of an event.
Visible in UI: Only in debug mode
Learn More: Notification Actions
STALLED

Description: A business transaction has stalled.
Category: Slow Transactions
UI Display name: Stalled Transactions
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Visible in UI: Yes
Learn More: Troubleshoot Slow Response Times, Configure Thresholds
SYSTEM_LOG

Description: Thrown when events occur during workflow execution.
Category: AppDynamics Data
UI Display name: Automation Event
Visible in UI: Yes
Learn More: Workflow Overview
THREAD_DUMP_ACTION_END

Description: A thread dump action ended.
Visible in UI: Only in debug mode
Learn More: Diagnostic Actions, Policies
THREAD_DUMP_ACTION_FAILED

Description: A thread dump action failed.
Visible in UI: Only in debug mode
Learn More: Diagnostic Actions, Policies
THREAD_DUMP_ACTION_STARTED

Description: A thread dump action failed.
Visible in UI: Only in debug mode
Learn More: Diagnostic Actions, Policies
VERY_SLOW

Description: A business transaction is now very slow.
Category: Slow Transactions
UI Display name: Very Slow Transactions
Visible in UI: Yes
Learn More: Troubleshoot Slow Response Times, Configure Thresholds
WORKFLOW_ACTION_END

Description: A cloud auto-scaling action has ended.
Visible in UI: Only in debug mode
Learn More: Cloud Auto-Scaling Actions, Policies, Workflow Overview
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WORKFLOW_ACTION_FAILED

Description: A cloud auto-scaling action has failed.
Visible in UI: Only in debug mode
Learn More: Cloud Auto-Scaling Actions, Policies, Workflow Overview
WORKFLOW_ACTION_STARTED

Description: A cloud auto-scaling action has failed.
Visible in UI: Only in debug mode
Learn More: Cloud Auto-Scaling Actions, Policies, Workflow Overview
Learn More

Events
Monitor Events
Use the AppDynamics REST API

Flow Maps
How Flow Maps Display Business Transactions across an Application
Application Flow Map
Business Transaction Flow Map
Interacting with Flow Maps
Clicking on a tier
Clicking on a backend
Clicking on a flow line
Time Range
Health Indicators
Comparing Against Baseline Data
Customizing the Content of Flow Maps
To customize the contents of a flow map
To specify tiers to display
To specify databases and remote services to display
Individual and Shared Flow Maps
Individual Customized Flow Maps
Shared Flow Maps
Flow Map Scope and Inheritance
Changing the Layout of the Flow Map
To move the entire map
To automatically arrange the layout
To move the flow map icons
To maximize the size of the layout
To zoom in or out of the layout
To change the tier, node, or backend labels
Managing Flow Maps
To manage your flow maps
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Learn More
This topic describes AppDynamics flow maps and how to use them to monitor applications.
How Flow Maps Display Business Transactions across an Application

An AppDynamics flow map is a graphical representation of the tiers and backends in an
application. Depending upon flow map customizations, some tiers and backends may be hidden
from view.
Flow maps are an integral part of the application, tier, node, and business transaction dashboards.
These flow maps have similar aspects and but differ slightly.
In a flow map, a tier is represented by a circle. The number inside the circle indicates how many
nodes are in the tier.
Backends are represented by various icons depending on the type of the backend.
Flows are represented by lines with the arrows on the line indicating the direction of the traffic.
See Health Indicators for information about the colors of tiers and flows.
Old Style Flow Maps
The AppDynamics UI is being updated. At this writing, the flow maps in the application and
business transaction dashboards use the new UI while the tier, node, database, remote
service and transaction snapshot dashboards use the old UI. If the screenshots on this
page do not resemble the flow map in front of you, see the documentation for the old style
flow maps at 3.8 Flow Maps.
Application Flow Map

The Application Flow Map shows the topology of the application.

Business Transaction Flow Map

The Business Transaction Flow Map shows the activity of a single business transaction. It
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indicates the tier that starts the transaction (the originating tier) with the START label.
The metrics reported on an application flow map are different from the metrics on a business
transaction flow map. See Understanding Transaction Metrics on Flow Maps.

Interacting with Flow Maps

You can click on an item in a flow map to access more detailed information about a particular tier,
backend or flow.
You can and drag and drop items in the flow map to change how the items are arranged.
You can configure how much data is represented in a flow map.
You can right-click on a tier or backend and select actions from a context menu, such as View
Dashboard or Delete Tier for a tier or View Dashboard or Drill Down for a backend.
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Clicking on a tier

Clicking on a tier in an application flow map displays a mini-dashboard with tabs containing
summary information about the tier, its nodes, slowest database and remote calls, and business
transactions. The KPIs are for calls that pass through the tier.

From the Business Transactions tab of this mini-dashboard you can see the KPIs for the business
transactions that the tier participates in. You can click a button to view the business transaction
dashboard for a selected transaction.
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Clicking on a tier in a business transaction flow map displays summary, node health and business
transaction information.

Clicking on a backend

Clicking on a backend an an application or business transaction flow map displays the KPIs for
calls into the backend.
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Clicking on a flow line

Clicking on a flow line in an application dashboard displays a mini- dashboard for the flow, which
includes tabs for its KPIs, slowest database and remote calls, and business transactions.

Clicking on a flow line in a business transaction dashboard displays the KPIs for transactions
through the selected flow.
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Time Range

For all dashboards, the Time Range setting determines how much data, using a given time range,
is represented in the flow map.
If you are using an on-premise Controller, the metrics along the flow lines in the flow maps, as well
as metrics viewed by clicking on a tier or backend, are for the current time range.
If you are using a SaaS Controller, flow maps show a maximum of the last 60 minutes of data,
regardless of whether the Time Range is set to a larger range. Other graphs on the dashboard
display according to the selected Time Range.
Health Indicators

Health refers to the extent to which an application, business transaction, tier, or node operates
within acceptable performance limits that are set either by baselines or health rules. Health is also
reported in the various scorecards displayed to the right of the flow map. For more information
about health see Scorecards. For more information about health rules see Health Rules.
The color of the flow lines can be a health indicator.
A blue line indicates that the agent is not comparing against a baseline.
A green line indicates that the response time is not significantly worse than the baseline.
A yellow line indicates that the response time is slow in comparison to the baseline.
A red line indicates that the response time is very slow in comparison to the baseline.
Dotted lines represent asynchronous activity.
Annotated links show the current calls per minute and average call duration metrics. Click the flow
line or its link to see more details about response time, call metrics, and errors. See Measure
Distributed Transaction Performance for more information.
The color of a tier or node in the flow map is also a health indicator.
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Comparing Against Baseline Data

On the lower right section of the flow map, you may see an informational link: Not comparing
against baseline data. This indicates that the agent has not been running long enough to collect
data to establish a baseline. For more information see Detect Anomalies Using Dynamic Baselines
and Configure Baselines.
Customizing the Content of Flow Maps

You can customize an application or business transaction flow map to show only certain tiers or
backends to simplify your view. Do this if you want the flow map to display only the flows that you
are interested in monitoring and hide the rest. If you do not customize the default flow map, the
controller displays all of the tiers and backends it detects that are applicable to the context of the
particular flow map.
The scope of the custom flow map depends on which dashboard you are customizing. For
example if you click the flow map menu from an application dashboard, the scope of the new flow
map is the application.
You can specify which tiers to display by name or by performance criteria; for example, "Display
only tiers from where the load exceeds fifty calls per minute and the average response time
exceeds 10,000 ms.
Similarly you can specify which databases and remote services to display by name or performance
criteria; for example, "Display only backends receiving at least 400 calls per minute and generating
more than 10 errors per minute."
You can also specify that backends of the same type be grouped on the flow map as a single
backend, which backends should never be grouped, and which backends should be hidden.
To customize the contents of a flow map

1. From the flow map menu in the upper right corner, click Edit Current Flow Map.

2. Optionally rename the flow map if you are creating a custom flow map. If you want your
customizations to apply to the default flow map or if you are modifying an existing flow map
it is not necessary to rename the flow map.
3. If you want to share your customizations with other members of your team check the Shared
check box. When you share a custom flow map, it is listed in the flow map menu for all
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3.

users.
4. If you want the current zoom and pan settings to be saved when you log back in to the
controller at a later time, check the Persist Zoom and Pan check box.
To specify tiers to display

1. Follow the steps in To customize the contents of a flow map.
2. Select the Tiers tab if it is not already selected.
If you want to specify the tiers to display using performance criteria, check all of the criteria
that you want to apply and then insert the value of each criterion in the appropriate text field.
Note that the average response time field is in milliseconds.
For example, the following flow map displays only tiers in which, for the selected time
range, the average response time is greater than 10000 ms, the load is greater than 50 calls
per minute, and the error rate is averaging greater than 4 errors per minute.

3. If you want to specify the tiers to display by name, check the Show only the specified
Tiers check box. Then in the expanded dialog that appears, add the tiers that you want to
hide to the to the Hidden Tiers list and the tiers that you want to display to the Visible Tiers
list by selecting the tier and clicking the Add or Remove button as appropriate.
For example, the following flow map displays the Order Processing Server and Inventory
Server tiers and hides the ECommerce Server tier.
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4. Click Apply to apply the changes. You can then view the results of the configuration on the
flow map.
If you want to revert to the flow map you had before the changes, clear the check boxes to
the left of the criteria and move the tiers back to their original lists and click Apply again.
5. Click Save to save the customized flow map or Cancel to cancel the changes.
To specify databases and remote services to display

1. Follow the steps in To customize the contents of a flow map.
2. Select the Databases and Remote Services tab if it is not already selected.
3. If you want to group backends of the same type so that they are represented by a single
icon on the flow map, check the Automatically group databases and remote services of
the same type when there are at least check box and enter the minimum number of
backends of the same type to be grouped. For example, if you enter 4 and the agent detects
only 3 HTTP backends, the HTTP backends are not grouped.
The icon below shows that two JDBC backends have been grouped

If you click an icon like this in the flow map you can see information on the individual
backends in the group:
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Backend Types
Backends are grouped into types and the types can vary with the agent and the agent
version, since backend support is constantly being added. To see the supported backend
types, you can examine the automatically discovered backend types for your agents. To
do this, in the left navigation panel click Configure->Instrumentation, then click the
Backend Detection tab and then the agent subtab. The backend types are listed In the
Automatic Backend Discovery panel.
4. If you want to specify the databases and remote services to display using performance
criteria, check all of the criteria that you want to apply and then insert the value of each
criterion in the appropriate text field. Note that the average response time field is in
milliseconds.
For example, the following flow map displays only backends in which, for the selected time
range, the load is greater than 500 calls per minute.

5. If you want to specify which databases and backends to display by name, check the Hidden
check box for each backend that you want to hide or clear it for each backend that you want
to display.
6. If you want to specify that certain backends should never be grouped, irregardless of the
applicability of the Automatically group databases and remote services of the same
type . . . setting, check the Ungroupable check box for that backend.
The following configuration specifies that the INVENTORY-MySQL DB LOCALHOST
database never be displayed in the flow map and the Active MQ-Order Queue message
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queue always displayed as an individual backend (not grouped) no matter how many
message queues are in the flow map.

Individual and Shared Flow Maps
Individual Customized Flow Maps

When a team is monitoring an application environment, team members can have their own views
into the business application. Each user can create a custom flow map and save it for their own
use.

Shared Flow Maps

You can share a single flow map with the entire team. When you share a custom flow map, it is
listed in the Default Map menu for all users.
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Flow Map Scope and Inheritance

By default the scope of a flow map depends on the context of the dashboard; that is, the
application, business transaction, tier, or node. If there is not a flow map for the specific object, the
UI uses the flow map of the parent object. For example if there is no custom flow map for a given
node, the UI first looks for the tier flow map of the tier that contains the node, and if there is no tier
flow map it uses the application flow map.
The application scope is the highest scope, so by default all flow maps use this scope. To better
monitor at different levels of scoping, you can customize flow maps at all levels of the hierarchy
and save them. See Customizing the Content of Flow Maps.
Changing the Layout of the Flow Map
To move the entire map

Click and hold in the background of the icons and flows, and move the mouse to reposition the
map.
To automatically arrange the layout

The view option icons at the top right let you toggle the dashboard display modes between views
of the flow map:
Icon

Layout
Default Flow Map View
Grid View
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Circular View
Auto Arrange (smart view with the fewest
crossing flows)
Auto Fit
Maximize
To move the flow map icons

To move a flow map icon, click and drag it to a new position. The flow lines will follow and stay
with the icon.
To maximize the size of the layout

To have the flow map take up the entire AppDynamics window, click the Maximize icon to enlarge
the flow map. Click it again to restore the flow map to its original size.
To zoom in or out of the layout

To zoom in or out of the image, drag the zoom slider at the left of the flow map. Alternatively you
can use the mouse scroll wheel.
To change the tier, node, or backend labels

The labels below the icons are based on the names of the tier, node, database or remote service
or backend. To rename these items use the Actions-Edit Properties item in the appropriate Tier, N
ode, Remote Services and Database dashboard.
Managing Flow Maps
To manage your flow maps

1. From the flow map menu in the upper right corner, click Manage Your Flow Maps.
2. Do one of the following:
To create a new flow map, click the Add icon and enter a name for the flow map.
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To remove a flow map, select the flow map in the list and click the Delete icon.
To copy a flow map, select the flow map in the list and click the Copy icon.
Learn More

Dashboards
Scorecards
Logical Model
Monitor Business Transactions
Measure Distributed Transaction Performance
Understanding Transaction Metrics on Flow Maps
Detect Anomalies Using Dynamic Baselines
Understanding Transaction Metrics on Flow Maps
Application, Tier, and Node Flow Map
Business Transaction Flow Map
Snapshot Flow Maps
Example of Metric Differences between Flow Maps
Learn More
Flow maps appear in various contexts in the AppDynamics UI. The overall flow map is the
application flow map. It shows the architecture and activity for the entire system. Additionally, there
are flow maps that show activity at the node or tier level, for a specific snapshot, or for a business
transaction.
The type of value shown for a metric in a flow map may differ depending on the context of the flow
map. This page describes the contexts and notes cases in which the types of values shown in the
maps vary depending on the flow map context.
Application, Tier, and Node Flow Map

The application flow map shows activity across all business transactions in the application for the
selected time range. The tier and node flow maps show the same type of data, but for the subset
of the application flow map that involves a particular tier or node.
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For response times, this type of flow map displays calls per minute and average response time for
calls from a tier to backends, such as databases and remote services, without reference to a
particular business transaction.
Business Transaction Flow Map

In contrast to the metric values in an application flow map, the metrics in a business transaction
flow map reflect the calls per minute and average response times for a given execution of that
business transaction.
The difference in context implies a different calculation method for certain metrics. The calls
between tiers are calculated based on each execution of the business transaction, rather than
based on each execution of the call. The section below takes a closer look at this example.
Snapshot Flow Maps

A snapshot flow map illustrates the metrics associated with a single snapshot. The metrics values
shown in the map are specific to a particular execution of the transaction.
Example of Metric Differences between Flow Maps

Whereas the application flow map shows metrics for all business transactions in the application,
the values in the business transaction flow map are oriented by the business transaction. For
back-end services, this change in context changes the significance of the response times on the
map.
To understand the difference, consider the following application flow map. It shows that the
Inventory tier made 1283 calls to the Oracle-10.0.0 database per minute in the selected time
range. The average response time for the calls was 298 ms.
Application Flow Map
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In contrast, the following business transaction flow map shows roughly the same time range for the
Checkout business transaction. However, it indicates that the average time
per business transaction spent on calls from the Inventory tier to the "Oracle - 10.0.0 database" is
420.4 ms. This happens to be 65.9% of the time used for the entire Checkout business
transaction.
Business Transaction Flow Map

Why the apparent difference? The goal of the application flow map is to show the overall activity in
the system, without reference to any particular business transaction. So it shows the average time
for each backend call to the database across all business transactions.
Since the business transaction flow is oriented by business transaction, however, its flow map
shows the average time spent in calls to the backend database per transaction. A single execution
of this business transaction may make more than one call to the database.
You can verify this by clicking the "420.4ms(65.9%)" metric link to open the detail view of the
business transaction stats.

As shown, the Checkout business transaction makes 1.4 database calls on average
per transaction. The average time for all calls made by each transaction is 420.4 ms, which is the
time shown in the business transaction flow map. Each of those calls took on average 298 ms,
however, which is the time shown in the application flow map.
Learn More
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Dashboards
Flow Maps

Metric Browser
The Metric Browser displays values of various metrics for your managed application over the time
specified in the time range drop-down menu.
Using the Metric Browser
Metric data points
Adding Metrics to the Tree
How the Metric Browser is Organized
Backends
End User Monitoring
Overall Application Performance
Business Transaction Performance
Application Infrastructure Performance
Errors
Information Points
Analyzing Performance for a Specific Time Range
Working with Baselines
To Display Baseline Patterns
To Display Baseline Deviations
Exporting Metric Data
To Export Metric Data

Using the Metric Browser
To use the Metric Browser:
In the left navigation pane, click Analyze -> Metric Browser.
To graph a metric, drag it from the left pane to the graph. If you drag multiple metrics, each
metric is shown using a different color.
To change the color of a metric, click its color chip in the graph legend.
To remove a metric from the graph select it in the graph and click Remove from Graph or
to remove all the metrics from the graph click Remove All.
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Metric data points

For most types of metrics in the browser, you can click any of the points in the graph to view more
information about the metric observed at that point in time. The information shown includes the
metric identifier, date and time of the observation, along with any of the following values relevant to
the metric:
Obs (observed average): the average of all data points seen for that interval. For the
Percentile Metric for the App Agent for Java, this is the percentile value. For a cluster or a
time rollup, this represents the weighted average across nodes or over time.
Min: the minimum data point value seen for that interval
Max: the maximum data point value seen for that interval
Sum: the sum of all data point values seen for that interval. For the Percentile Metric for the
App Agent for Java, this is the product of the percentile value multiplied by the Count.
Count: the number of data points seen in that interval
By selecting the check box that corresponds to the metric information at the bottom of the graph,
such as Min, Max, Count, or Sum, you can graph that information for the metric over the time
range shown in the browser. Only the types of information relevant to the metric can be selected.
Adding Metrics to the Tree

There are a few points to note about the metrics that appear in the metric browser tree:
The actual metrics that appear in the browser may differ for different monitored platforms.
Some metrics, such as the Percentile Metric available for the Java agent, are not enabled by
default and must be first enabled before they are available in the Metric Browser.
Some metrics can be added by editing the node properties. For information about enabling the
capture of these statistics, see App Agent Node Properties and App Agent Node Properties
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Reference.
The tree can also include custom metrics. See Add Metrics with a Monitoring Extension for
information on custom metrics.
How the Metric Browser is Organized

AppDynamics metrics are organized into the following categories:
Backends
End User Monitoring
Overall Application Performance
Business Transaction Performance
Application Infrastructure Performance
Errors
Information Points
To see the metrics in each category, access the Metric Browser and expand the categories in the
left pane of the browser until you get to the leaves.

Backends
Backend monitoring provides key performance metrics for calls to databases and remote services.
End User Monitoring

End user monitoring (EUM) provides key performance metrics about your end users' experience
starting from the users' Web browsers instead of at the application server. See Web EUEM for
general information.
EUM metrics in the metric browser appear only if EUM is enabled for your application. See Enablin
g and Disabling EUM.
Overall Application Performance

Overall application performance metrics are displayed at application, tier, and node levels. All
node-level metrics are shown under individual nodes for each tier. Overall performance metrics
include metrics for the external calls between two tiers or between a tier and a database or remote
service.
Business Transaction Performance

Business transaction performance metrics are available for the business transactions and groups
of business transactions. The Metric Browser lists metrics for a business transaction under the tier
where the business transaction is invoked. The Metric Browser also displays metrics for external
calls from the tiers.
Metrics available include, but are not limited to:
Average Request Size: HTTP request content length for each business transaction.
Average Response Time (ms): Average response time (ART) spent processing the
business transaction, for all instances of the business transaction, from start to end of the
entry point invocation.
Calls per Minute: Average number of instances per minute.
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Errors per Minute: Number of errors per minute across all instances.
Normal Average Response Time (ms): Average response time per minute of all instances
except slow, very slow and stalled transactions.
Number of Slow Calls: Number of instances that meet the criteria defined for a slow
transaction.
Number of Very Slow Calls: Number of instances that meet the criteria defined for a very
slow transaction.
If a standalone machine agent is installed, these metrics are available:
Average Block Time (ms): Average time spent when invocations are blocked for thread
synchronization and locks.
Average CPU Used (ms): Average time spent using the CPU. An invocation might wait or
be blocked when it is not using the CPU.
Average Wait Time (ms): Average time spent when invocations are in a thread sleep or
wait state.

Application Infrastructure Performance
Application infrastructure performance metrics are displayed for the entire application and for
individual nodes. Expand the individual nodes item to see metrics at the node level. Infrastructure
metrics cover:
Agent performance
Hardware resources
JMX
JVM and CLR

Utilizing JMX Metrics in Troubleshooting
Errors

Error metrics for the specific errors are shown by tier and then by individual node.
Information Points
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Metrics are provided for each configured information point. See Business Metrics.
Analyzing Performance for a Specific Time Range

You can analyze performance for a specific time range in the metric browser.
To analyze performance for a time range, click at the start of the time range in the graph and drag your
mouse or pointing device to the end of the time range. Release the mouse to select the range and
bring up the time range menu.

From the menu, you can choose from these options:
View transaction snapshots for the selected time range. Click this item to view Transaction
Snapshots generated during the selected time range. Viewing transaction snapshots is
especially useful when the data in the Metric Browser is displayed at the 10-minute or
60-minute resolution (see How Information is Displayed Over Time in Graphs).
Drill down into the selected time range. Click this item to open a workbench for the selected
time range. The workbench is essentially a Dashboard for the application that shows activity for
the selected time range.
Set the global time range. Click this item to use your selected time range as the global
custom time range in the Controller UI.
Working with Baselines

You can see how data in the Metric Browser compares to baseline values. Monitoring baseline
deviation is a good way to be aware of performance metrics that might be violating your Service
Level Agreements (SLAs).
For information about the automatic calculations for the baseline patterns see Detect Anomalies
Using Dynamic Baselines.
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To Display Baseline Patterns

1. Drag and drop one or more metrics metrics on the graph.
2. Select the baseline pattern to use from the drop-down menu.

To Display Baseline Deviations

1. Drag and drop the metrics that you want to monitor on the graph.
2. In the graph legend, select the metric you want to analyze.
3. Click the Settings tab in the left panel.
4. In the Baseline Shading section, select the range of deviations to shade for the selected
metric.
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Exporting Metric Data
You can export metric data that is currently displayed to a graphic file (PNG), a CSV file, a PDF
file, or to the clipboard. Exported data includes all the data displayed, even if there is a time range
selected. If you want to export data only for a specific time range, first set a global time range and
then export.
To Export Metric Data

1. Drag and drop one or more metrics that you want to export onto the graph.
2. For a PNG export, right-click the graph and choose Export as PNG. You can then specify a
name and location for the PNG file.
3. For a CVS or PDF file, click Export Data and choose Export to CSV or Export as PDF
Report.
4. Do one of the following:
For a CVS export, check the check boxes for the data to be exported and click either Exp
ort to Clipboard to copy the data to the clipboard in text format, or Export to File. You
can then specify a name and location for the CSV file.
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The exported column options (sum, count, value, and so on) are described in the Using
the Metric Browser section.
For a PDF export, in the Export Complete window, click Save Report. You can then
specify a name and location for the PDF file.

Metric Data Display in Graphs
This topic explains how AppDynamics displays and consolidates (rolls up) data in graphical
displays, displaying data at either one-minute, ten-minute, or one-hour resolution.
How Information is Displayed Over Time in Graphs
One-Minute Resolution
Ten-Minute Resolution
One-Hour Resolution
How The Last Interval is Displayed in a Graph
Viewing Details about Older Data
Learn More
How Information is Displayed Over Time in Graphs

Depending on your environment, AppDynamics measures hundreds, thousands, or even tens of
thousands of metric values each minute. To display these results over time in a meaningful way,
graphs in AppDynamics roll up and display totals, averages, and so on for either 1-minute,
10-minute, or 1-hour intervals, based on how long ago the metric was measured. You can view
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details about a period no matter what resolution is being displayed (see Viewing Details for Older
Data).
In graphs throughout the AppDynamics user interface, you can hover over a point on the graph to
get the value of the metric data measured during the interval represented by the point. The point
represents the beginning of the interval. The length of the interval depends on the selected time
range. Default settings are listed below.
For up to 4 hours, data is rolled up every 1 minute, and displayed at 1-minute resolution.
Each point on the graph represents a 1-minute interval; the point represents the beginning of
the interval. Therefore, the data displayed for a 5:00 AM point represents the values
measured from 5:00 AM to the millisecond before 5:01 AM.
After 4 hours, data is rolled up every 10 minutes, and displayed at 10-minute resolution.
Each point on the graph represents a 10-minute interval; the point represents the beginning
of the 10-minute interval. Therefore, the data displayed for a 5:00 AM point represents the
values measured from 5:00 AM to the millisecond before 5:10 AM.
After 48 hours, data is rolled up every hour, and displayed at 1-hour resolution. Each point
on the graph represents a 1-hour interval; the point represents the beginning of the hour.
Therefore, the data displayed for a 5:00 AM point represents the values measured from 5:00
AM to the millisecond before 6:00 AM.
After 365 days, data at 1-hour resolution is deleted.
Your administrator can adjust the amount of time data is retained at each resolution, although
retaining data for longer than these default values is not generally recommended. See Modifying
Metric Data Retention Periods.
One-Minute Resolution

If you view data on a graph for any period in the previous 4 hours, each value you see represents
a rollup of all the values measured during that minute. For example, if response time for an
application is measured for 300 calls in a minute, the response time values of those 300 calls are
averaged to present the Average Response Time (ART) for that minute. When you hover over a
point on the graph, the Count figure represents how many times the metric data was measured
during that minute.
In the graph below, response time was measured 125 times between 5:08 and 5:09 PM, and the
ART for that minute was 973 ms.
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In the following graph from the Metric Browser, the time range was set for the last three hours, so
the interval is one minute. The errors per minute value displayed at the 12:22 PM point represents
the number of errors recorded during the minute from 12:22 PM to the millisecond just before
12:23 PM.

Ten-Minute Resolution

From 4 to 48 hours, metric data is displayed at a 10-minute resolution. If you view data in a graph
for a period that is between 4 and 48 hours old, each value you see represents a rollup of the
values measured during that 10-minute period.
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One-Hour Resolution

After 48 hours, metric data is displayed at a 1-hour resolution. If you view data in a graph for a
period that is more than 48 hours old, each value you see represents a rollup of the values that
were measured during that hour.
The following graph is from an application dashboard in which the time range was set for the last
three days, so the interval is one hour. The Average Response Time displayed at the 6:00 AM
point represents the average of the response time values measured during the hour from 6:00 AM
to the millisecond just before 7:00 AM.
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How The Last Interval is Displayed in a Graph

Because of the way rolled-up data is displayed, it may look as if data is not included for the last
increment in the time range. However, the last data point in fact represents the last interval in the
range.
For example, when you set a time range from 8 AM to 12 PM for a day that has been rolled up into
1-hour data points, you might expect to see five data points, one for 8 AM, 9 AM, 10 AM, 11 AM
and 12 PM . However, the returned data consists of four data points for the hours 8 AM, 9 AM,
10 AM and 11 AM. The first data point, 8:00 AM, represents data collected from 8 AM to the
millisecond just before 9 AM. The last data point, 11:00 AM, represents data collected from 11 AM
to the millisecond just before 12 PM. So you are in fact seeing data from 8 AM to 12 PM, even
though the last data point in the graph is 11 AM.

Viewing Details about Older Data

If you need to review details for an issue that occurred during a period for which you have only
10-minute or 1-hour data, AppDynamics provides access to diagnostic data via Transaction
Snapshots. For example, suppose you are seeing values for 2 AM and 3 AM three days ago, but
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you need to examine details about a problem you were alerted about that occurred at 2:15 AM that
morning. You view Transaction Snapshots for the hour between 2 AM and 3 AM to see details
about what happened during that time period. By default, snapshots are retained for two weeks,
and individual snapshots can be archived. See Transaction Snapshots.
if you are viewing a graph in the Metric Browser, you can select a specific period in the graph and
drill down to see Transaction Snapshots and other information. See Analyzing Performance for a
Specific Time Range.
Learn More

Metric Browser
Time Ranges

Transaction Analysis Tab
Accessing the Transaction Analysis Tab
How Transaction Analysis is Organized
Time Slices
Average Response Time
Statistics for a Time Slice
The Transaction Analysis tab represents the response time, which has a direct effect upon the
user experience, of a business application as a histogram. AppDynamics classifies the response
time based on the patterns of business transactions.
Accessing the Transaction Analysis Tab
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How Transaction Analysis is Organized
Time Slices

The vertical bars represent a slice of time against which AppDynamics has gathered performance
metrics such as response time. The bar metrics are stacked and color-coded according to the
response times of the requests, as:
Normal - green
Slow - yellow
Very Slow - red
Stalls - grey
You can see details by hovering over different parts of the graph.
Use the Time Range menu in the upper right to change the time period for which data is
displayed.
Average Response Time

The blue line represents the average response time. Spikes in response time indicate that the user
experience is degrading.
The average response time dynamic baseline appears as a dotted line.
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Statistics for a Time Slice

You can select a time slice by dragging your pointing device over the histogram. This displays a
window that summarizes the key performance indicators and transaction scorecard over the
selected time slice.

You can click Select as Global Time Range to reset the time range used in other screens in the
AppDynamics UI to the time slice that you have set in the transaction analysis screen. This
initiates a reload of the dashboards.
Click the Events tab to see the events generated over the selected time period. See Events.

Time Ranges
How the Controller UI Handles Time Zone Differences
The Time Range Dropdown
Custom Time Ranges
To see performance data from a particular time range
To create a new custom time range
How Time Ranges Affect Data Rollup and Display
Learn More
How the Controller UI Handles Time Zone Differences

In a distributed system, the metrics collected at the Controller may be generated in different parts
of the world and different time zones. Before sending metrics to the Controller, App Agents
normalize the times associated with the metrics by applying a UTC (Coordinated Universal Time)
offset appropriate for their region.
In the Controller UI, all times are displayed in the user's local time. To render local times, the UI
applies the offset needed to render UTC time into the user's time zone as configured on the
computer on which the browser is running.
While the time zone used in the UI is taken from the local environment and cannot be modified
apart from changing the computer's system time, each UI user can modify the format of the time
display, as described in Set User Preferences.
The Time Range Dropdown

The Time Range dropdown menu is available at the top right of all dashboards and the Metric
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Browser. Use it to set the time range for the data displayed in dashboards.

When you change a time range with the Time Range dropdown menu in one dashboard, the
change is reflected in other dashboards in the AppDynamics UI. An exception is the Scalability
Analysis screen where, by design, a change in the time range does not affect the time range in
Scalability Analysis.
For predefined or custom time ranges that are greater than three weeks, graphs in the UI such as
the Slow Transaction graph show the 14th of each month as the time points on the x-axis. For a
time range that is less than two full months, this means that the graph may only have a single
point, the middle of the month encompassed by the time range. To view the specific day and hour
associated with each data point shown in the graph, use your mouse to hover over the graph
data.
Custom Time Ranges

If the time range you need does not appear in the Time Range menu, specify the range as a
custom time range. A custom time range can include ranges that terminate at a point in the past.
This give you flexibility for analyzing trends.
You can save custom time ranges as a named range for viewing later or for sharing with
teammates.
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To see performance data from a particular time range

1. From the Time Range menu, click Custom. The date and time options appear.

2. Select the dates and times of the range. The UI updates with the data from that range.
To create a new custom time range

1. Follow the steps in the previous section, then click the floppy disk icon.
2. Enter a name and description for the time range.
3. Click OK.
Alternatively,
1.
2.
3.
4.
5.

From the Time Range menu, click Manage Custom Time Range.
Click New.
In the Manage Custom Time Ranges window click the Add icon.
In the Create Time Range window name and describe the details of the time range.
Optionally, select "Share with everyone" so that other users will see it in their Time Ranges
menu.
6. Click Create.
The custom time range appears as a new option in your time range menu.
How Time Ranges Affect Data Rollup and Display

Over time, AppDynamics rolls up metric data in the following manner:
For up to 4 hours, data is rolled up every 1 minute.
After 4 hours, data is rolled up every 10 minutes.
After 48 hours, data is rolled every 60 minutes.
For more information, see Metric Data Display in Graphs.
Learn More

Metric Data Display in Graphs

Scorecards
A scorecard summarizes the performance of a business transaction at the application, tier, or node
level within a specified time range. It covers the number and percentage of business transaction
instances (calls) that are normal, slow, very slow, stalled, or errors based on the configured
thresholds for these criteria.
Slow and very slow transactions have completed. Stalled transactions never completed or timed
out. Configurable thresholds define the level of performance for the slow, very slow and stalled
categories. See Configure Thresholds.
Scorecards appear in many places in the UI, including the application, tier, node, and business
transaction dashboards.
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The call counts in the score cards in different dashboards have different meanings:
In the application dashboard, the business transaction health scorecard aggregates the
metrics for all the completed business transactions in the application, including the default
business transactions. The number of calls is based on the number of business transactions
that are have completed. The percentages for those calls are based on the average for all
the completed business transactions in the application. For example, if the scorecard
displays 3% for very slow transactions, on average 3% of the calls for completed business
transactions in the application were slow.
In a tier dashboard, the transaction scorecard aggregates the metrics for all the nodes in the
tier. The number of calls is based on the number of requests that the tier handled, including
continuing transactions, threads spawned, and so forth.
A node dashboard is similar to the tier dashboard in that it is based on the number of
requests the node handled. The transaction scorecard displays the metrics for the single
node.
In a business transaction dashboard, the transaction scorecard displays the metrics for entry
point to an instance of a business transaction.

KPI Graphs
The Key Performance Indicator (KPI) graphs are displayed in the lower section of the various
dashboards.
For most dashboards the KPIs are:
load: number of calls and number of calls per minute
average response time (ART)
errors: number of errors and errors per minute

The graphs show performance in terms of the KPIs for the selected time range.
You can hover with your pointing device at various points along the top of the graph to see the

Copyright © AppDynamics 2012-2014

Page 483

precise metric at a certain point in time.
You can click a link (value in blue) at the top of the graph to see the metric in the Metric Browser.

Call Graphs
Call Graphs
To view call graphs
To Filter and Search for a Class Name in a Call Graph
Diagnosing the Root Cause of Problems Using Call Graphs
Troubleshoot Problems using Call Graphs
Understanding Data Captured in Call Graphs
Class/Method Names and Time spent
External Calls Invoked by a Method
Viewing Call Graph Hot Spots
Advanced Options
Classes displayed in the call graphs
Packages and Namespaces excluded from the call graph
Configure instrumentation
Learn More
This topic describes call graphs for code-level diagnostics.
Call Graphs

A call graph lists the methods in a call stack and provides information about each call. Call graphs
help you diagnose performance issues and optimize the flow of a complex business transaction.
AppDynamics call graphs provide the following information:
Call information: This includes the total execution time, the node name for the call graph,
and the time stamp for the start of execution.
Method execution sequence: An easily readable method execution sequence with the
class names and the method names of each method.
Application component information: Application component information such as
Servlet names, Struts Action classes, EJB names, Spring Bean IDs and proxies,
message listeners, etc. POJOs are represented by class name, unless the POJO is a
special type of component such as a struts action invoker. The class name is available
for all call graph elements including those having logical class names.
Code line number: The line number of the element in the source code, if available.
Time distribution for each method: The time distribution for each method along with the
percentage of the total time in the call graph.
Exit call information: Links to more information about exit calls such as JDBC, JMS, and
Web Services.
Application component summary information: Summary information for each element in
the call graph.
In addition you can:

Copyright © AppDynamics 2012-2014

Page 484

Filter the call graph list using criteria such as application components, time, or all or part of
the name.
Select an element of the list and set it as the root of the list to drill down into large call
graphs more efficiently.
Export the call graph to PDF to share the information with other team members.

There are two kinds of call graphs: full and partial. Full call graphs capture the entire call
sequence and are captured periodically for general monitoring purposes. Partial call graphs
capture the call sequence from the point at which the call sequence has been determined to be
slow or have errors, and thus may not include the initial steps in the sequence.
Aggressive Slow Snapshot Collection - Java Only
By configuring call graphs to collect slow threshold transaction collections, you can ensure
that fewer partial call graphs will be captured. For more information, see Enable / Disable
Aggressive Slow Snapshot Collection.
To view call graphs

1. From a dashboard, click the Transaction Snapshots tab.
2. Do one of the following:
Click All Snapshots to see all snapshots.
Click Slow and Error Transactions to see snapshots for slow and error transactions.
Click Periodic Collection to see snapshots collected periodically.
2. Select a particular transaction snapshot and click View Transaction Snapshot.
3. Click the Drill Down icon to see the call graph for the snapshot.
By default the originating call graph in a business transaction, generated by the entry point on the
entry point tier, displays.
To Filter and Search for a Class Name in a Call Graph
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The call graph is displayed when you click on the drill down option on the snapshot. You can
filter and search for a particular class name on the call graph. To do this, use the search box
available on the left side of the call graph.
Diagnosing the Root Cause of Problems Using Call Graphs
Troubleshoot Problems using Call Graphs

You can use call graphs to troubleshoot the problems in the flow
map. Drill down into each tier using the Drill Down option. If there is
only one invocation, AppDynamics displays the call graph.
When there are multiple invocations for that tier which participated in
the transaction, the Action -> Drill Down menu displays a list of all
call graphs for the node. Each call graph represents a call into the
node. For example, if JVM A makes two remote calls to JVM B, then
JVM B will have two call graphs.
Understanding Data Captured in Call Graphs
Class/Method Names and Time spent

Call graphs represent the sequence of execution of code on the
application server. Each row represents a method call and the tree
represents the execution sequence.
The total time spent in the call graph is displayed on the top left
corner of the call graph.

The Time (ms) column in the call graph shows the time spent in each
method.
External Calls Invoked by a Method

If a method invokes external calls outside of the app server, such as
a JDBC query or a Web Service call, there is a link to the call in the
call graph.
The following example shows the details of a JDBC call that include
the query, the execution time of the query, the number of times that
the application code iterated over the query results (ResultSet
Count) and the time in milliseconds that the application code spent
iterating over the results (ResultSet Time).
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If the detail screen has a Drill Down link, you can get a call graph for
the calls downstream from the original call.
Viewing Call Graph Hot Spots

The most expensive methods are listed in the Hot Spots section of
the transaction snapshot.
Advanced Options
Classes displayed in the call graphs

The sequence of Java method invocations in a call graph can
include hundreds of classes. These classes are categorized as:
Application classes
AppServer/Container/Middleware classes (For example:
Tomcat runtime classes, Websphere runtime classes, etc.)
JDBC Driver/External infrastructure library classes (For
example: Oracle Driver classes, Axis Web Service runtime
classes, Hibernate classes, etc.)
Third party utility libraries (For example: Apache commons
libraries)
Java/J2EE core libraries
Adding all of these classes together in a call graph is
counterproductive for troubleshooting. The only mandatory classes
required, are the classes from first category- the Application classes.
You might require the other classes only in certain situations. To
make the call graph more readable and to avoid the overhead of
processing the timing information for all the non-application classes,
other classes are not shown in the call graph.
Packages and Namespaces excluded from the call graph

A call graph can have a list of packages (Java) or namespaces
(.NET) that are not displayed. To access this list, click on the
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message for "Some packages/namespaces have been excluded
from the Call graph" message.

The PHP and Node.js agents do not support call graph exclusion.
Configure instrumentation

You can right-click on any item in a call graph and select Configure
Instrumentation for this Class/Method.

The Configure Instrumentation window presents a drop-down menu
form which you can select the type of configuration that you want to
create for the method.

Copyright © AppDynamics 2012-2014

Page 488

This short interactive video
traces the typical steps of
identifying the cause of
communication issues
between tiers in your
application.
Learn More

Configure Call Graphs
Configure Code Metric Information Points
Configure Custom Exit Points for Java
Configure and Use Object Instance Tracking for Java
Configure Memory Monitoring for Java
POJO Entry Points
Configure Data Collectors
Tracing Multi-Threaded Transactions (Java)
Configure Call Graphs
Call Graph Settings
To access call graph configuration screens
Call Graph Granularity
Packages or Namespaces to Exclude from Call Graphs
To exclude specific packages or namespaces from call graphs
To Include Specific Sub-packages (Sub-namespaces) or Classes from the
Excluded Packages
SQL Capture Settings
Slow Transaction Snapshot Collection
Aggressive Slow Snapshot Collection (Java only)
To Enable / Disable Aggressive Slow Snapshot Collection
Learn More
Call Graph Settings

The Call Graph Settings window lets you configure thresholds that affect performance, which
packages or namespaces to include in call graphs, and how much detail about SQL statements to
capture.
To access call graph configuration screens

1. In the left navigation pane, click Configure -> Instrumentation.
2.
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2. Click the Call Graph Settings tab.
3. Click the sub tab for the framework you are configuring.
Whenever you create or modify a call graph setting in these screens, click the Save Call Graph
Settings button to save your configuration.
Call Graph Granularity

You can control the granularity for call-graphs using following settings:
Control granularity for Methods: To ensure low performance overhead, choose a
threshold in milliseconds for method execution time. Methods taking less than the time
specified here will be filtered out of the call graphs.
Control granularity for SQL calls: You can also specify a threshold for SQL queries. SQL
queries taking more than the specified time in milliseconds will be filtered out of the
call-graphs. Also see App Agent for Java Performance Tuning.
Packages or Namespaces to Exclude from Call Graphs

A call graph can potentially contain hundreds of methods. You can exclude packages for Java or
namespaces for .NET with classes that you do not want to monitor.
For Java, some packages are excluded by default. These are visible in the Excluded Packages
list. The packages that are excluded by default cannot be removed. However, you can include a
particular sub-package from an excluded package. See To Include Specific Sub-packages
(Sub-namespaces) or Classes from the Excluded Packages.
To exclude specific packages or namespaces from call graphs

1. Click Add Custom Package Exclude (Java) or Add Custom Namespace Exclude (.NET).
2. Enter the name and description of the package or namespace to exclude.
3. Click Add.
To Include Specific Sub-packages (Sub-namespaces) or Classes from the Excluded Packages

1. Click Add Always Show Package/Class (Java) or Add Always Show Namespace/Class (
.NET).
2. Specify the subpackage/class or namespace/class and a description to include in the call graph
at all times.
3. Click Add.
SQL Capture Settings

The SQL capture settings control whether SQL statements are captured and presented in the
Controller UI with dynamic parameters bound to their runtime values.
For example, consider Java code that constructs a SQL call as follows:
stmt = new PreparedStatement("select * from user where ssn = ?")
stmt.bind(1, "123-123-1234")
stmt.execute()
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With the capture raw SQL option enabled, AppDynamics captures and presents the SQL call in the
following form:
select * from user where ssn = '123-123-1234'

If capture raw SQL is disabled, the SQL call appears in its original form, with question mark
parameters not bound to values. Disabling capture-raw-sql and using question mark parameters in
SQL prepared statements give you a mechanism for preventing sensitive data from appearing in
the Controller UI.
It is important to note that the sensitive values must be parameterized in the original, prepared
statement form of the SQL statement, as shown above. The following statement results in the
potentially sensitive information (social security number) appearing in the Controller UI
whether capture raw SQL is enabled or disabled, since the sensitive data is not parameterized.
stmt = new PreparedStatement("select * from user where ssn ='123-123-1234'")

To configure SQL capture settings, in the Call Graph Settings tab, scroll down to the SQL
Capture Settings section and choose one of the following options:
Capture Raw SQL: Select this option to have SQL statements that are composed as
prepared statements captured with dynamic parameters bound to runtime values. By
default, private SQL data and queries that take less than 10 ms are not captured.
When you enable Capture Raw SQL in .NET environments, the agent captures the
parameters for ADO.NET stored procedure calls even though the parameters are not
represented by question marks. It does not capture stored procedure local variables that are
not available to the CLR.
Filter Parameter values: Select this option to have SQL statements that are composed as
prepared statements captured without dynamic parameters bound to runtime values.
Slow Transaction Snapshot Collection

AppDynamics captures the full execution path of a request after its execution time exceeds the
business transaction threshold for slow requests. Before a request becomes problematic (slow,
stalled or error), AppDynamics captures partial call graphs that do not show the invocation stack
from before the request started to slow.
Aggressive Slow Snapshot Collection (Java only)

For Java only, you can configure more aggressive snapshot collections to capture the full
execution path of requests before thresholds are crossed.
New in 3.9 Prior to 3.9, hot spot learning was performed by the agent. To improve performance
and more accurately collect snapshot information, this functionality was moved to the Controller in
3.9. With this change there are fewer partial call graphs so you are able to more quickly analyze
the root cause of slow transactions.
By default the agent disables aggressive snapshot collection to minimize overhead. Enable it when
you start to experience performance problems in order to diagnose the root cause.
This configuration affects snapshot collection at the application level. You can also enable and
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disable this feature at the node level using the enable-hotspot-snapshots node property. For
information about setting node properties see App Agent Node Properties.
To Enable / Disable Aggressive Slow Snapshot Collection

<em>Enable/DIsable Aggressive Slow Snapshot Collection</em>
Enable Aggressive Slow Snapshot Collection
1. Select the application for which you want to enable or disable aggressive snapshot
collection.
2. In the left navigation panel click Configure -> Instrumentation.
3. Click the Call Graph Settings tab. and then the Java Call Graph Settings sub-tab.
At the bottom of the Call Graph Settings window, in the Slow Transaction Snapshot
Collection section, check the Enable Aggressive Slow Snapshot Collection checkbox to
enable aggressive collections. Clear the checkbox to disable aggressive collection.
4. Click Save Call Graph Settings.
Learn More

Call Graphs
App Agent for Java Performance Tuning
Transaction Snapshots

Information Points
AppDynamics provides information points as a way to monitor:
Code metrics: how a method is performing across the
application, from all business transactions
Business metrics: data from a method's parameters or return
values, across the application
Information points gather data outside of the context of a business
transaction. In this way they are distinct from data collectors. See
Data Collectors Versus Information Points.

Extensions and Integrations
Add Metrics to AppDynamics Using Monitoring Extensions
Available Monitoring Extensions
Creating a Monitoring Extension
Alerting Extensions
Available Alerting Extensions
Creating an Alerting Extension
Performance Testing Extensions
Available Performance Testing Extensions
Create a Performance Testing Extension
Cloud Auto-Scaling Extensions
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Available Cloud Auto-Scaling Extensions
Creating a Cloud Auto-Scaling Extension
Ecosystem Integrations
Retrieve Data from AppDynamics Using the REST API
Add AppDynamics Events
Learn More
AppDynamics provides many ways for you to extend AppDynamics Pro and integrate metrics with
other systems.

Add Metrics to AppDynamics Using Monitoring Extensions
Using the standalone Machine Agent you can create extensions that add metrics to the set that
AppDynamics already collects and reports to the Controller. These can include metrics that you
collect from other monitoring systems. They can also include metrics that your system extracts
from services that are not instrumented by AppDynamics, such as databases, LDAP servers, web
servers, C programs, etc.
Available Monitoring Extensions

Many monitoring extensions are already available. Go to the AppDynamics Exchange and view
extensions in the Monitoring category.
Creating a Monitoring Extension

To learn how to write your own monitoring extensions see Add Metrics with a Monitoring Extension
.

Alerting Extensions
Available Alerting Extensions

Many alerting extensions are already available. Go to the AppDynamics Exchange and view
extensions in the Alerting category.
See also Configure Integrations.
Creating an Alerting Extension

You can create a custom notification to integrate AppDynamics health rule violations and events
with your alerting or ticketing system. See Alert and Respond.
To learn how to write your own custom notification see Build an Alerting Extension.

Performance Testing Extensions
Available Performance Testing Extensions

Many performance testing extensions are already available. Go to the AppDynamics Exchange an
d view extensions in the Performance Testing category.
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Integrate AppDynamics with Apica
Integrate with HP LoadRunner
Create a Performance Testing Extension

To learn how to write your own performance testing extension see Use the AppDynamics REST
API.

Cloud Auto-Scaling Extensions
AppDynamics works with other vendors to provide system integrations.
Available Cloud Auto-Scaling Extensions

Many cloud extensions are already available. Go to the AppDynamics Exchange and view
extensions in the Cloud Connector category.
For instructions on registering compute clouds, see Compute Clouds.
Creating a Cloud Auto-Scaling Extension

To learn how to write your own cloud auto-scaling extension see Create Your Own Compute Cloud
Connector.

Ecosystem Integrations
See:

Retrieve Data from AppDynamics Using the REST API
You can programmatically retrieve data from AppDynamics and use it elsewhere, for example:
Passing it to an alerting system, unified monitoring portal, phone app, etc.
Pushing it to a corporate warehouse with other corporate data.
Passing it to a tool that analyzes systems in your organization.
You can retrieve any metric available in the AppDynamics Metric Browser using the REST API,
such as:
Metadata that describes your applications, tiers, nodes, business transactions, etc.
Real data such as metrics, events, transaction snapshots, health rule violations, etc.
To learn how to retrieve additional metrics and data, see Use the AppDynamics REST API.

Add AppDynamics Events
You can create custom events using POST requests in the REST API. These can be events of
type APPLICATION_DEPLOYMENT or of type CUSTOM.
You can create application deployment events, in addition to the ones that AppDynamics provides,
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to notify AppDynamics when you upgrade your application, push new code, etc. This lets you
correlate these application deployment activities with other data inside AppDynamics. This is
useful for regression analysis, root cause analysis, and performance studies. A useful practice is
to include injection of your application deployment event into AppDynamics as part of the build
process for deploying a new version of your application.
You can create custom events to be reported in the AppDynamics event viewer and in the events
panels on the AppDynamics dashboards. Then you can create alerts triggered by these events as
you do for AppDynamics standard events.
To learn how to add your own events see Create Events.

Learn More
Build an AppDynamics Extension
Request an Extension

Use the AppDynamics REST API
Introduction
Authentication
Invalid Characters for Usernames
Retrieve all business applications
Example - Retrieve list of all business applications.
Retrieve all Business Transactions in a particular business application
Example - Retrieve list of all business transactions for the ACME Book Store.
Retrieve all tiers in a business application
Example - Retrieve the list of all tiers for the ACME Book Store.
Retrieve machine, agent, and IP information about all nodes in a business application
Example - Retrieve machine, agent and IP information about the nodes in application
3
Retrieve machine, agent, and IP information about a node by node name
Example - Retrieve information about Node_8001 in application 3.
Retrieve machine, agent, and IP information about all the nodes in a tier
Example - Retrieve information about the nodes in the E-Commerce tier in the ACME
Online Book Store.
Retrieve information about a tier, including the tier ID and number of nodes, in a tier by tier
name
Example - Retrieve information about the ECommerce tier in the ACME Online Book
Store.
Retrieve metrics
To Copy the REST URL for a Metric
To Copy the Metric-Path Parameter
Structure of Returned Metrics
Values of Returned Metrics
Retrieve metric hierarchy
Example - Retrieve the metric hierarchy for the ACME Book Store Application.
Use Wild cards in Metric-Path Parameter
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Example - Retrieve the average response time for all the tiers in the application
using the wild card character for the tier name.
Example - Retrieve the CPU %Busy metric for all the nodes in the ECommerce
tier using the wild card character for the node name.
Example - Retrieve the CPU %Busy metric for all the nodes in all the tiers using
wild card characters for the tier and node names.
Example - Retrieve the Calls per Minute metric for all the business transactions
on the ECommerce tier using the wild card character for the business
transaction name
Retrieve metrics for a time range
Example - Retrieve the average response time for the past 15 minutes on the
ECommerce server.
Example - Retrieve the multiple metrics, for the past 15 minutes, for the
ViewCart.sendItems transaction on the ECommerce server.
Example - Retrieve the average cpu used by the All Other Traffic business
transaction during the past 15 minutes on the ECommerce server.
Example - Retrieve snapshots for the 15 minutes after Mon, 13 Aug 2012
08:20:41 for the ACME Book Store Application.
Example - Retrieve snapshots for the 15 minutes before Mon, 13 Aug 2012
08:20:41 for the ACME Book Store Application.
Example - Retrieve snapshots for the time range between Mon, 13 Aug 2012
08:20:41 and Mon, 13 Aug 2012 08:22:21 GMT for the ACME Book Store
Application.
Retrieve all health rule violations in a particular business application
Retrieve all policy violations in a particular business application
Example - Retrieve the list of all policy violations in the ACME Book Store for the past
hour.
Retrieve event data
Example - Retrieve the list of events of type "APPLICATION_ERROR" or
"DIAGNOSTIC_SESSION" of any severity that occurred in the specified time range.
Create Events
Application Deployment Event Integration
Create a Custom Event
Retrieve transaction snapshots for a Business Transaction for a time range
Example - Retrieve list of transaction snapshots for the ACME Book Store.
Example - Retrieve list of transaction snapshots including the snapshot fields that are
associated with an Http Parameter data collector.
Create and modify AppDynamics users
Include or exclude a business transaction from monitoring
Example - Exclude business transaction 166 from monitoring.
Retrieve all controller global configuration values
Example - Retrieve list of all global configuration values
Retrieve a single controller global configuration value
Example - Retrieve the global metrics buffer size.
Configure Global Controller Settings
Mark Nodes as Historical
Example - Mark nodes 44 and 45 as historical.
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Retrieve all policy violations in a particular business application
Example - Retrieve the list of all open policy violations in the ACME Book Store for the
past 1000 minutes.
Introduction

You use the REST API to retrieve information from AppDynamics programmatically.
The AppDynamics REST API is implemented using Representational State Transfer (REST)
Services. The data can be returned in either the JavaScript Object Notation (JSON) or the
eXtensible Markup Language (XML) format. The default output format is XML.
The URIs in the Monitor APIs are a set of REST services that open access to Monitor data
collected by AppDynamics. Each URI can be found by accessing:
http://<Controller_Host>:<Controller_Port>/controller/rest/<REST_URI>

You can find more general information about REST on Wikipedia.
You may find the REST Python Client Extension to be a useful tool.
For information about importing and exporting transaction detection configurations using REST,
see Import and Export Transaction Detection Configuration for Java.
Authentication

To invoke the REST APIs, provide basic HTTP authentication credentials as well as your account
information. These are:
Account: the AppDynamics tenant account name
Username: a user in that account
Password: the password for that account
If you have installed an on-premise Controller on a single-tenant platform or if you are using the
AppDynamics SaaS Controller, your default account is "customer1". In this case the username to
log in with would be:
<your_username>@customer1
If you are using a multi-tenant Controller, you need to log in with a username in your multi-tenant
account:
<your_username>@<your_accountname>
Invalid Characters for Usernames

Usernames that contain the following characters are not authenticated for REST API calls:
\ / " [ ] : | < > + = ; , ? * @, ' tab space

If you have already created usernames that contain any of the disallowed characters, such as
"user:customer66", create a new username without the disallowed chartacter for the purpose of
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accessing the REST APIs.

Retrieve all business applications

URI: /controller/rest/applications
Input parameters
Parameter Name

Parameter Type

Value

Mandatory

Output

Query

HTTP Request
parameter included as
part
of the URL to change
the output format.
Valid values are
"XML" (default) or
"JSON".

No

Example - Retrieve list of all business applications.

URI

Sample object output

/controller/rest/applications

XML

/controller/rest/applications?output=JSON

JSON

Retrieve all Business Transactions in a particular business application

URI: /applications/<application-name | application-id>/business-transactions
Input parameters
Parameter Name

Parameter Type

Value

Mandatory

<application-name |
application-id>

URI

Provide either the
application name or
application id.

Yes

Copyright © AppDynamics 2012-2014

Page 498

exclude

Query

If false, the query
retrieves only the
business transactions
that are included for
monitoring. If true, the
query retrieves only
the excluded
business transactions.
Excluded business
transactions are those
that have been
configured to be
excluded from
monitoring either from
the UI or through the
REST interface. The
default is false.

No

Output

Query

HTTP Request
parameter included as
part of the URL to
change the output
format.
Valid values are
"XML" (default) or
"JSON".

No

Example - Retrieve list of all business transactions for the ACME Book Store.

URI

Sample object output

/controller/rest/applications/ACME Book Store
Application/business-transactions

XML

/controller/rest/applications/ACME Book Store
Application/business-transactions?output=JSO
N

JSON

Retrieve all tiers in a business application

URI: /controller/rest/applications/<application-name|application-id>/tiers
Input parameters
Parameter Name

Parameter Type

Value

Mandatory

<application-name |
application-id>

URI

Provide either the
application name or
application id.

Yes
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Output

Query

HTTP Request
parameter included as
part
of the URL to change
the output format.
Valid values are
"XML" (default) or
"JSON".

No

Example - Retrieve the list of all tiers for the ACME Book Store.

URI

Sample object output

/controller/rest/applications/ACME Book Store
Application/tiers

XML

/controller/rest/applications/ACME Book Store
Application/tiers?output=JSON

JSON

Retrieve machine, agent, and IP information about all nodes in a business application

URI: /controller/rest/applications/<application-name|application-id>/nodes
Input parameters
Parameter Name

Parameter Type

Value

Mandatory

<application-name |
application-id>

URI

Provide either the
application name or
application id.

Yes

Output

Query

HTTP Request
parameter included as
part
of the URL to change
the output format.
Valid values are
"XML" (default) or
"JSON".

No

Example - Retrieve machine, agent and IP information about the nodes in application 3

URI

Sample object output

/controller/rest/applications/3/nodes

XML

Retrieve machine, agent, and IP information about a node by node name

URI: /controller/rest/applications/<application-name | application-id>/nodes/<node-name>
Input parameters
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Parameter Name

Parameter Type

Value

Mandatory

<application-name |
application-id>

URI

Provide either the
application name or
application id.

Yes

<node-name>

URI

Provide the node
name

Yes

Output

Query

HTTP Request
parameter included as
part
of the URL to change
the output format.
Valid values are
"XML" (default) or
"JSON".

No

Example - Retrieve information about Node_8001 in application 3.

URI

Sample object output

/controller/rest/applications/3/nodes/Node_800
1

XML

Retrieve machine, agent, and IP information about all the nodes in a tier

URI: /controller/rest/applications/<application-name | application-id>/tiers/<tier-name>/nodes
Input parameters
Parameter Name

Parameter Type

Value

Mandatory

<application-name |
application-id>

URI

Provide either the
application name or
application id.

Yes

<tier-name>

URI

Provide the tier name.

Yes

Output

Query

HTTP Request
parameter included as
part
of the URL to change
the output format.
Valid values are
"XML" (default) or
"JSON".

No

Example - Retrieve information about the nodes in the E-Commerce tier in the ACME Online Book Store.

URI
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/controller/rest/applications/ACME Online Book
Store/tiers/E-Commerce/nodes/

XML

Retrieve information about a tier, including the tier ID and number of nodes, in a tier by tier
name

URI: /controller/rest/applications/<application-name | application-id>/tiers/<tier-name>
Input parameters
Parameter Name

Parameter Type

Value

Mandatory

<application-name |
application-id>

URI

Provide either the
application name or
application id.

Yes

<tier-name>

URI

Provide the tier name.

Yes

Output

Query

HTTP Request
parameter included as
part
of the URL to change
the output format.
Valid values are
"XML" (default) or
"JSON".

No

Example - Retrieve information about the ECommerce tier in the ACME Online Book Store.

URI

Sample object output

/controller/rest/applications/ACME Online Book
Store/tiers/ECommerce

XML

/controller/rest/applications/ACME Online Book
Store/tiers/ECommerce?output=JSON

JSON

Retrieve metrics

AppDynamics groups the metrics that it collects into following categories:
Backends
End User Monitoring
Overall Application Performance
Business Transaction Performance
Application Infrastructure Performance
Errors
Information Points
To see the structure of the metric hierarchy of a business application in the AppDynamics UI,
expand the nodes in the Metric Browser:
1. In the left navigation pane, select the application for which you are retrieving metrics.
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2. Click Analyze -> Metric Browser.
3. In left panel expand the nodes in the metric tree.

You can copy the URI for fetching any metric directly from any node in the Metric Browser. This is
the easiest way to construct a query to retrieve a particular metric. You can also copy just the
metric path portion of the query.
The child elements in the metric path expression are separated by the pipe character (|). The pipe
character must not appear at the beginning or end of the metric path expression.
The easiest way to construct a query to retrieve a metric is to select the metric in Metric Browser,
copy the REST URL, rand paste it into your browser. An alternative is select the metric and copy
the metric path, and construct the query by prefacing the metric path with
"metric-data?metric-path=".
To Copy the REST URL for a Metric

To copy the REST URL for any metric captured by AppDynamics:
1. Open the Metric Browser as described above.
2. Select the item for which you want to retrieve metrics in the metric tree. You can retrieve the
URL at any level of the tree.
3. Right-click the item and select Copy REST URL from the drop-down menu.
4. Paste the URL into your Web browser to run the query.
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The following example copies the URL for the Average Response Time in the Inventory-MSQL DB
for the Acme Online Book Store application for the time period that was selected in the metric
browser.

The copied query is
http://ec2-23-20-107-243.compute-1.amazonaws.com:8090/controller/res
t/applications/AcmeOnlineBookStore
/metric-data?metric-path=Backends%7CINVENTORY-MySQL%20DB%7CAverage%2
0Response%20Time%20(ms)&time-range-type=BEFORE_NOW&duration-in-mins=
15

The time range in the request is based on the setting of the time range in the Metric Browser when
you copied the URL. You can edit a copied query to change the time range and duration. See Retri
eve metrics for a time range for more information.
To Copy the Metric-Path Parameter

You also copy only the metric path for a specific metric.
To copy a metric path:
1. Open the Metric Browser as described above.
2. Select the item for which you want to retrieve metrics in the metric tree. You can retrieve the
metric path at any level of the tree.
3. Right-click the item and select Copy Full Path from the drop-down menu.
4. Use the metric path to construct your query.
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The copied data is
Business Transaction Performance|Business Transactions|E-Commerce|Add
to cart

Structure of Returned Metrics

The data is returned in a tree structure. If a child element is a container item, its <type> tag is set
to "folder". Otherwise the <type> tag for the child element is set to "leaf".
A folder <type> tag indicates that the metric has child elements. The API retrieves the first
generation of child elements. You can expand only the children of the folder type.
Values of Returned Metrics

Results are returned in a metricValues structure that contains the following fields:
current
Value for the current minute. Used only when the time rollup type used by the Controller is
current.
count
Number of times the agent collected the metric over the selected time period.
max
min
The "min" and "max" values are the minimum and maximum values reported across the
selected time period. These are not used for all metric types.
occurrences
Number of data samples taken by the Controller to calculate the standard deviation.
standardDeviation
Intermediate values calculated by the Controller during time rollup used to calculate
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standard deviation.
startTimeInMillis
The startTimeInMillis is the start time of the time range to which the result metric data
applies, in UNIX epoch time.
sum
Total accumulated value for the metric over the selected time period.
useRange
Used internally by the Controller to process the metric.
value
The "value" value is one of the following for all metric values reported across the configured
evaluation time length:
arithmetic average, if the metric time rollup type is average
sum, if the metric time rollup type is sum
latest, if the metric time rollup type is current
By default, the values of the returned metrics are rolled up into a single data point (rollup=true). To
get separate results for all the values within the specified time range, set the rollup parameter to
false in the query.
The returned metricValues structure typically looks like this:
Sample XML output with rollup=true
<metricValues>
<metric-value>
<startTimeInMillis>1411678680000</startTimeInMillis>
<value>14</value>
<min>0</min>
<max>0</max>
<current>6</current>
<sum>205</sum>
<count>30</count>
<standardDeviation>0.0</standardDeviation>
<occurrences>0</occurrences>
<useRange>false</useRange>
</metric-value>
</metricValues>

Sample XML output with rollup=false
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<metricValues>
<metric-value>
<startTimeInMillis>1411678680000</startTimeInMillis>
<value>28</value>
<min>0</min>
<max>0</max>
<current>13</current>
<sum>28</sum>
<count>2</count>
<standardDeviation>0.0</standardDeviation>
<occurrences>0</occurrences>
<useRange>false</useRange>
</metric-value>
<metric-value>
<startTimeInMillis>1411678740000</startTimeInMillis>
<value>17</value>
<min>0</min>
<max>0</max>
<current>9</current>
<sum>17</sum>
<count>2</count>
<standardDeviation>0.0</standardDeviation>
<occurrences>0</occurrences>
<useRange>false</useRange>
</metric-value>
<metric-value>
. . .
. . .
</metricValues>

Sample JSON output with rollup=true
"metricValues": [ {
"count": 30,
"current": 8,
"max": 0,
"min": 0,
"occurrences": 0,
"standardDeviation": 0,
"startTimeInMillis": 1411682880000,
"sum": 145,
"useRange": false,
"value": 10
}]

Sample JSON ouput with rollup=false
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"metricValues":
[
{
"count": 2,
"current": 1,
"max": 0,
"min": 0,
"occurrences": 0,
"standardDeviation":
"startTimeInMillis":
"sum": 2,
"useRange": false,
"value": 2
},
{
"count": 2,
"current": 1,
"max": 0,
"min": 0,
"occurrences": 0,
"standardDeviation":
"startTimeInMillis":
"sum": 4,
"useRange": false,
"value": 4
},
. . .
. . .

0,
1411682760000,

0,
1411682820000,

Retrieve metric hierarchy

URI: /controller/rest/applications/<application-name| application-id>/metrics
Input parameters
Parameter Name

Parameter Type

Value

Mandatory

<application-name |
application-id>

URI

Provide either the
application name or
application id.

Yes

metrics

Query

Copyright © AppDynamics 2012-2014

Yes

Page 508

Output

Query

HTTP Request
parameter included as
part of the URL to
change the output
format.
Valid values are
"XML" (default) or
"JSON".

No

Example - Retrieve the metric hierarchy for the ACME Book Store Application.

URI

Sample object output

/controller/rest/applications/ACME Book Store
Application/metrics

XML

/controller/rest/applications/ACME Book Store
Application/metrics?output=JSON

JSON

Use Wild cards in Metric-Path Parameter

You can use the asterisk (*) wild card in the metric data to request metric data for all the instances
of AppDynamics entity, such as a business transaction name, tier name or node name, in the
metric path.
Example - Retrieve the average response time for all the tiers in the application using the wild card character
for the tier name.

URI

Sample object output
/controller/rest/applications/ACM
E Book Store
Application/metric-data?metric-pa
th=Overall Application
Performance|*|Average Response
Time
(ms)&time-range-type=BEFORE_NOW&d
uration-in-mins=15

/controller/rest/applications/ACM
E Book Store
Application/metric-data?metric-pa
th=Overall Application
Performance|*|Average Response
Time
(ms)&time-range-type=BEFORE_NOW&d
uration-in-mins=15&output=JSON
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Example - Retrieve the CPU %Busy metric for all the nodes in the ECommerce tier using the wild card
character for the node name.

URI

Sample object output
/controller/rest/applications/ACM
E Book Store
Application/metric-data?metric-pa
th=Application Infrastructure
Performance|ECommerce
Server|Individual
Nodes|*|Hardware
Resources|CPU|%Busy&time-range-ty
pe=BEFORE_NOW&duration-in-mins=15

/controller/rest/applications/ACM
E Book Store
Application/metric-data?metric-pa
th=Application Infrastructure
Performance|ECommerce
Server|Individual
Nodes|*|Hardware
Resources|CPU|%Busy&time-range-ty
pe=BEFORE_NOW&duration-in-mins=15
=JSON

XML

JSON

Example - Retrieve the CPU %Busy metric for all the nodes in all the tiers using wild card characters for the tier
and node names.

URI

Sample object output
/controller/rest/applications/ACM
E Book Store
Application/metric-data?metric-pa
th=Application Infrastructure
Performance|*|Individual
Nodes|*|Hardware
Resources|CPU|%Busy&time-range-ty
pe=BEFORE_NOW&duration-in-mins=15
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/controller/rest/applications/ACM
E Book Store
Application/metric-data?metric-pa
th=Application Infrastructure
Performance|*|Individual
Nodes|*|Hardware
Resources|CPU|%Busy&time-range-ty
pe=BEFORE_NOW&duration-in-mins=15
&output=JSON

JSON

Example - Retrieve the Calls per Minute metric for all the business transactions on the ECommerce tier using
the wild card character for the business transaction name

URI

Sample object output
/controller/rest/applications/ACM
E Book Store
Application/metric-data?metric-pa
th=Business Transaction
Performance|Business
Transactions|ECommerce
Server|*|Calls per
Minute&time-range-type=BEFORE_NOW
&duration-in-mins=15

/controller/rest/applications/ACM
E Book Store
Application/metric-data?metric-pa
th=Business Transaction
Performance|Business
Transactions|ECommerce
Server|*|Calls per
Minute&time-range-type=BEFORE_NOW
&duration-in-mins=15&output=JSON

XML

JSON

Retrieve metrics for a time range

You can fetch the data for any specified metrics for any time range.
Note that metric data REST URIs restrict the amount of data that can be returned. The maximum
is 200 metrics.
URI: /controller/rest/applications/<application-name>/metric-data
Input parameters
Parameter Name
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<application-name |
application-id>

URI

Provide either the
application name or
application id.

Yes

metric-path

Query

The metric expression
to get the metric
data.
Use the pipe
character to separate
the parent and child
name elements in the
tree.
The Pipe
delimiter must not
appear at the
beginning or at the
end of the metric
expression.

Yes
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time-range-type

Query

Possible values are:
BEFORE_NOW
To use the
"BEFORE_NOW"
option, you must also
specify the
"duration-in-mins"
parameter.
BEFORE_TIME
To use the
"BEFORE_TIME"
option, you must also
specify the
"duration-in-mins" and
"end-time"
parameters.
AFTER_TIME
To use the
"AFTER_TIME"
option, you must also
specify the
"duration-in-mins" and
"start-time"
parameters.
BETWEEN_TIMES
To use the
"BETWEEN_TIMES"
option, you must also
specify the
"start-time" and
"end-time"
parameters. The
"BETWEEN_TIMES"
range includes the
start- time and
excludes the
end-time.

Yes

duration-in-mins

Query

Duration (in minutes)
to return the metric
data.

If time-range-type is B
EFORE_NOW, BEFO
RE_TIME, or AFTER
_TIME

start-time

Query

Start time (in
milliseconds) from
which the metric data
is returned in UNIX
epoch time.

If time-range-type is A
FTER_TIME or BET
WEEN_TIMES
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end-time

Query

End time (in
milliseconds) until
which the metric data
is returned in UNIX
epoch time.

If time-range-type is B
EFORE_TIME or BET
WEEN_TIMES

rollup

Query

Default is true.
If true, value as single
data point is returned.
If false, all the values
within the specified
time range are
returned.

No

Output

Query

HTTP Request
parameter included as
part of the URL to
change the output
format. Valid values
are "XML" (default) or
"JSON".

No

Example - Retrieve the average response time for the past 15 minutes on the ECommerce server.

URI

Sample object output

/controller/rest/applications/ACME Book Store
Application/metric-data?metric-path=Overall
Application Performance|ECommerce
Server|Average Response Time
(ms)&time-range-type=BEFORE_NOW&durati
on-in-mins=15

XML

/controller/rest/applications/ACME Book Store
Application/metric-data?metric-path=Overall
Application Performance|ECommerce
Server|Average Response Time
(ms)&time-range-type=BEFORE_NOW&durati
on-in-mins=15&output=JSON

JSON

Example - Retrieve the multiple metrics, for the past 15 minutes, for the ViewCart.sendItems transaction on the
ECommerce server.

URI

Sample object output

/controller/rest/applications/ACME Book Store
Application/metric-data?metric-path=Business
Transaction Performance|Business
Transactions|ECommerce
Server|ViewCart.sendItems|*&time-range-type
=BEFORE_NOW&duration-in-mins=15

XML
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/controller/rest/applications/ACME Book Store
Application/metric-data?metric-path=Business
Transaction Performance|Business
Transactions|ECommerce
Server|ViewCart.sendItems|*&time-range-type
=BEFORE_NOW&duration-in-mins=15

JSON

Example - Retrieve the average cpu used by the All Other Traffic business transaction during the past 15
minutes on the ECommerce server.

Enter "APPDYNAMICS_DEFAULT_TX" for the All Other Traffic" transaction for the tier. See All
Other Traffic Business Transaction for general information about the All Other Traffic business
transaction.
URI

Sample object output

/controller/rest/applications/ACME Book Store
Application/metric-data?metric-path=Business
Transaction Performance|Business
Transactions|ECommerce
Server|APPDYNAMICS_DEFAULT_TX|Avera
ge CPU Used
(ms)&time-range-type=BEFORE_NOW&durati
on-in-mins=15

XML

Example - Retrieve snapshots for the 15 minutes after Mon, 13 Aug 2012 08:20:41 for the ACME Book Store
Application.

URI

Sample object output

/controller/rest/applications/3/request-snapshot
s?time-range-type=AFTER_TIME&start-time=
1344846041495&duration-in-mins=15

XML

/controller/rest/applications/3/request-snapshot
s?time-range-type=AFTER_TIME&start-time=
1344846041495&duration-in-mins=15&output
=JSON

JSON

Example - Retrieve snapshots for the 15 minutes before Mon, 13 Aug 2012 08:20:41 for the ACME Book Store
Application.

URI

Sample object output

/controller/rest/applications/3/request-snapshot
s?time-range-type=BEFORE_TIME&end-time
=1344846041495&duration-in-mins=15

XML

/controller/rest/applications/3/request-snapshot
s?time-range-type=BEFORE_TIME&end-time
=1344846041495&duration-in-mins=15&outpu
t=JSON

JSON
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Example - Retrieve snapshots for the time range between Mon, 13 Aug 2012 08:20:41 and Mon, 13 Aug 2012
08:22:21 GMT for the ACME Book Store Application.

URI

Sample object output

/controller/rest/applications/3/request-snapshot
s?time-range-type=BEFORE_TIME&end-time
=1344846041495&duration-in-mins=15

XML

/controller/rest/applications/3/request-snapshot
s?time-range-type=BEFORE_TIME&end-time
=1344846041495&duration-in-mins=15&outpu
t=JSON

JSON

Retrieve all health rule violations in a particular business application

URI: /controller/rest/applications/<application-name|application-id>/problems/healthrule-violations
Input parameters
Parameter Name

Parameter Type

Value

Mandatory

<application-name |
application-id>

URI

Provide either the
application name or
application id.

Yes
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time-range-type

Query

Possible values are:
BEFORE_NOW
To use the
"BEFORE_NOW"
option, you must also
specify the
"duration-in-mins"
parameter.
BEFORE_TIME
To use the
"BEFORE_TIME"
option, you must also
specify the
"duration-in-mins" and
"end-time"
parameters.
AFTER_TIME
To use the
"AFTER_TIME"
option, you must also
specify the
"duration-in-mins" and
"start-time"
parameters.
BETWEEN_TIMES
To use the
"BETWEEN_TIMES"
option, you must also
specify the
"start-time" and
"end-time"
parameters. The
"BETWEEN_TIMES"
range includes the
start- time and
excludes the
end-time.

Yes

duration-in-mins

Query

Duration (in minutes)
to return the metric
data.

If time-range-type is B
EFORE_NOW, BEFO
RE_TIME, or AFTER
_TIME

start-time

Query

Start time (in
milliseconds) from
which the metric data
is returned.

If time-range-type is A
FTER_TIME or BET
WEEN_TIMES
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end-time

Query

End time (in
milliseconds) until
which the metric data
is returned.

If time-range-type is B
EFORE_TIME or BET
WEEN_TIMES

Output

Query

HTTP Request
parameter included as
part of the URL to
change the output
format. Valid values
are "XML" (default) or
"JSON".

No

Retrieve all policy violations in a particular business application

This URI is maintained for compatibility with pre-3.7 versions. Use Retrieve all health rule
violations in a particular business application for 3.7 and later.
URI: /controller/rest/applications/<application-name|application-id>/problems/policy-violations
Input parameters
Parameter Name

Parameter Type

Value

Mandatory

<application-name |
application-id>

URI

Provide either the
application name or
application id.

Yes
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time-range-type

Query

Possible values are:
BEFORE_NOW
To use the
"BEFORE_NOW"
option, you must also
specify the
"duration-in-mins"
parameter.
BEFORE_TIME
To use the
"BEFORE_TIME"
option, you must also
specify the
"duration-in-mins" and
"end-time"
parameters.
AFTER_TIME
To use the
"AFTER_TIME"
option, you must also
specify the
"duration-in-mins" and
"start-time"
parameters.
BETWEEN_TIMES
To use the
"BETWEEN_TIMES"
option, you must also
specify the
"start-time" and
"end-time"
parameters. The
"BETWEEN_TIMES"
range includes the
start- time and
excludes the
end-time.

Yes

duration-in-mins

Query

Duration (in minutes)
to return the metric
data.

If time-range-type is B
EFORE_NOW, BEFO
RE_TIME, or AFTER
_TIME

start-time

Query

Start time (in
milliseconds) from
which the metric data
is returned.

If time-range-type is A
FTER_TIME or BET
WEEN_TIMES
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end-time

Query

End time (in
milliseconds) until
which the metric data
is returned.

If time-range-type is B
EFORE_TIME or BET
WEEN_TIMES

Output

Query

HTTP Request
parameter included as
part of the URL to
change the output
format. Valid values
are "XML" (default) or
"JSON".

No

Example - Retrieve the list of all policy violations in the ACME Book Store for the past hour.

URI

Sample object output

/controller/rest/applications/ACME Book Store
Application/problems/policy-violations?time-ra
nge-type=BEFORE_NOW&duration-in-mins=6
0&output=XML

XML

/controller/rest/applications/ACME Book Store
Application/problems/policy-violations?time-ra
nge-type=BEFORE_NOW&duration-in-mins=6
0&output=JSON

JSON

Retrieve event data

You can capture data for the event types listed in the event-types parameter.
URI: /controller/rest/applications/<application-name|application-id>/events
Parameter Name

Parameter Type

Value

Mandatory

<application-name |
application-id>

URI

Provide either the
application name or
application id.

Yes
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time-range-type

Query

Possible values are:
BEFORE_NOW
To use the
"BEFORE_NOW"
option, you must also
specify the
"duration-in-mins"
parameter.
BEFORE_TIME
To use the
"BEFORE_TIME"
option, you must also
specify the
"duration-in-mins" and
"end-time"
parameters.
AFTER_TIME
To use the
"AFTER_TIME"
option, you must also
specify the
"duration-in-mins" and
"start-time"
parameters.
BETWEEN_TIMES
To use the
"BETWEEN_TIMES"
option, you must also
specify the
"start-time" and
"end-time"
parameters. The
"BETWEEN_TIMES"
range includes the
start- time and
excludes the
end-time.

Yes

duration-in-mins

Query

Specify the duration
(in minutes) to return
the metric data.

If time-range-type is B
EFORE_NOW, BEFO
RE_TIME, or AFTER
_TIME

start-time

Query

Specify the start time
(in milliseconds) from
which the metric data
is returned.

If time-range-type is A
FTER_TIME or BET
WEEN_TIMES
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end-time

Query

Specify the end time
(in milliseconds) until
which the metric data
is returned.

If time-range-type is B
EFORE_TIME or BET
WEEN_TIMES

event-types

Query

Specify the
comma-separated list
of event types for
which you want to
retrieve event
information. See the
Events Reference for
the valid event types.

Yes

severities

Query

Specify the
comma-separated list
of severities for which
you want to retrieve
event information.

Yes

The severities are:
INFO
WARN
ERROR
Output

Query

HTTP Request
parameter included as
part of the URL to
change the output
format. Valid values
are "XML" (default) or
"JSON".

No

Example - Retrieve the list of events of type "APPLICATION_ERROR" or "DIAGNOSTIC_SESSION" of any
severity that occurred in the specified time range.

URI

Sample object output

/controller/rest/applications/ACME%20Book%
20Store%20Application/events?time-range-typ
e=BEFORE_NOW&duration-in-mins=30&even
t-types=%20APPLICATION_ERROR,DIAGNO
STIC_SESSION&severities=INFO,WARN,ER
ROR&output=XML

XML
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/controller/rest/applications/ACME%20Book%
20Store%20Application/events?time-range-typ
e=BEFORE_NOW&duration-in-mins=30&even
t-types=%20APPLICATION_ERROR,DIAGNO
STIC_SESSION&severities=INFO,WARN,ER
ROR&output=JSON

JSON

Create Events

You can create APPLICATION_DEPLOYMENT and CUSTOM events.
Application Deployment Event Integration

The AppDynamics REST API lets you integrate events of type "APPLICATION_DEPLOYMENT"
with other systems.
For example, suppose you want to create an event automatically in your AppDynamics monitored
system for every new release. To integrate these systems, use the following REST API to create
an event of type "APPLICATION_DEPLOYMENT" in your managed environment.
This is a POST request. You should receive the event ID after successful invocation of the
request.
URI: /controller/rest/applications/<application-name|application-id>/events
Input parameters
Parameter Name

Parameter Type

Value

Mandatory

<application-name |
application-id>

URI

Provide either
application name or
application id.

Yes

summary

Query

Provide the summary
for the event.

Yes

comment

Query

Provide the
comments (if any) for
the event.

Yes

eventtype

Query

APPLICATION_DEPL
OYMENT

Yes

Create a Custom Event

The AppDynamics REST API lets you create a custom event.
This is a POST request. You should receive the event ID after successful invocation of the
request.
URI: /controller/rest/applications/<application-name|application-id>/events
Input parameters
Parameter Name

Copyright © AppDynamics 2012-2014

Parameter Type

Value

Mandatory

Page 523

<application-name |
application-id>

URI

Provide either
application name or
application id.

Yes

summary

Query

Provide a summary
describing the event.

No

comment

Query

Provide a comment
for the event.

Yes

eventtype

Query

CUSTOM

Yes

customeventtype

Query

Provide a name for
the "type"; for
example, the source,
like "nagios"

No

node

Query

Provide the affected
node name

No

tier

Query

Provide the affected
tier name

Yes, if node or bt is
specified

bt

Query

Provide the affected
business transaction
name

No

propertynames

Query

Provide a property
name, ie, the "key"

No

propertyvalues

Query

Provide the property
value, ie, the "value"

No

/controller/rest/applications/<application-name|application-id>/even
ts?eventtype=CUSTOM&customeventtype=nagios&summary=test1&propertynam
es=key1&propertynames=key2&propertyvalues=value1&propertyvalues=valu
e2

Note the pattern for custom properties: propertynames and propertyvalues get matched up by
order position, so to set N property values, you need N occurrences of propertynames and N
occurrences of propertyvalues.

Custom URLS for Notifications
This is an HTTP POST operation.
Single tenants in a multi-tenant controller instance can specify a custom "vanity" URL for
notification purposes, so that instead of a URL like "paid8.appdynamics.com" the host is displayed
as something like "mycompany.appdynamics.com" in the notification.
URI: /controller/rest/accounts/<customer-name>/update-controller-url
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Input parameters
Parameter Name

Parameter Type

Value

Mandatory

<customer-name>

URI

Provide the customer
account name

Yes

Body (Application/JSON)
{
"controllerURL": "http://<my-custom-hostname:port>"
}
Retrieve transaction snapshots for a Business Transaction for a time range

URI: /controller/rest/applications/<application-id>/request-snapshots
Input parameters
Parameter
Name

Parameter Type

Value

Mandatory

<application-id>

URI

Provide either
the application
name or
application id.

Yes
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time-range-type

Query

Possible values
are:
BEFORE_NOW

Yes

To use the
"BEFORE_NOW
" option, you
must also specify
the
"duration-in-mins
" parameter.
BEFORE_TIME
To use the
"BEFORE_TIME
" option, you mu
st also specify
the
"duration-in-mins
" and "end-time"
parameters.
AFTER_TIME
To use the
"AFTER_TIME"
option, you must
also specify the
"duration-in-mins
" and "start-time"
parameters.
BETWEEN_TIM
ES
To use the
"BETWEEN_TIM
ES" option, you
must also specify
the "start-time"
and "end-time"
parameters. The
"BETWEEN_TIM
ES" range
includes the
start- time and
excludes the
end-time.
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duration-in-mins

Query

Duration (in
minutes) to
return the data.

If
time-range-type
is BEFORE_NO
W, BEFORE_TI
ME, or AFTER_
TIME

start-time

Query

Start time (in
milliseconds)
from which the
data is returned.

If
time-range-type
is AFTER_TIME
or BETWEEN_TI
MES

end-time

Query

End time (in
milliseconds)
until which the
data is returned.

If
time-range-type
is BEFORE_TIM
Eor BETWEEN_
TIMES

guids

Query

Array of
comma-separate
d guids for the
transaction
snapshots. If not
specified,
retrieves all
snapshots in the
specified time
range.

No

archived

Query

True to retrieve
archived
snapshots.
Default is false.

No
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deep-dive-policy

Query

Array of
comma-separate
d snapshot
policy filters to
apply. Valid
values are:

No

SLA_FAILUR
E
TIME_SAMP
LING
ERROR_SA
MPLING
OCCURREN
CE_SAMPLI
NG
ON_DEMAN
D
HOTSPOT
HOTSPOT_L
EARN
APPLICATIO
N_STARTUP
SLOW_DIAG
NOSTIC_SE
SSION
ERROR_DIA
GNOSTIC_S
ESSION
POLICY_FAI
LURE_DIAG
NOSTIC_SE
SSION
DIAGNOSTI
C_SESSION
INFLIGHT_S
LOW_SESSI
ON
application-comp
onent-ids

Query
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Array of
comma-separate
d tier IDs to filter.
Default is all the
tiers in the
application.

No
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application-comp
onent-node-ids

Query

Array of
comma-separate
d node ID
filters. Default is
all the nodes in
the application

No

business-transac
tion-ids

Query

Array of
comma-separate
d business
transaction ID
filters. Default is
all the business
transactions in
the application.

No

user-experience

Query

Array of
comma-separate
d user
experiences
filters. Valid
values are:

No

NORMAL
SLOW
VERY_SLO
W
STALL
ERROR
first-in-chain

Query

Copyright © AppDynamics 2012-2014

If true, retrieve
only the first
request from the
chain. Default is
false.

No
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need-props

Query

If true, the values
of the following
snapshot
properties are
included in the
output. These
values
correspond to
the values of the
data-collector-typ
e parameter.
If false, these
values are empty
in the REST
output.
The default is
false. New in
3.7.11.

No

errorDetails
errorIDs
httpParamete
rs
businessData
cookies
httpHeaders
sessionKeys
responseHea
ders
logMessages
transactionPr
operties
transactionEv
ents
dotnetPropert
y
need-exit-calls

Query

If true, exit calls
are included in
the result.
Default is false.

No

execution-time-in
-milis

Query

If set, retrieves
only data for
requests with
execution times
greater than this
value.

No
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session-id

Query

If set, retrieves
data only for this
session id.

No

user-principal-id

Query

If set, retrieves
data only for this
user login.

No

error-ids

Query

Array of
comma-separate
d error codes to
filter by. Default
is to retrieve all
error codes.

No

starting-request-i
d,
ending-request-i
d

Query

If set, retrieves
data only for this
range of request
IDs.

No

error-occurred

Query

If true, retrieves
only error
requests. Default
is false.

No

diagnostic-snaps
hot

Query

If true, retrieves
only diagnostic
snapshots. Defa
ult is false.

No

bad-request

Query

If true, retrieves
only slow and
error
requests. Default
is false.

No

diagnostic-sessio
n-guid

Query

Array of
comma-separate
d diagnostic
session guids to
filter.

No

data-collector-na
me

Query

Used with
data-collector-val
ue to filter
snapshot
collection based
on the value of a
data collector. N
ew in 3.6.1.

No
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data-collector-val
ue

Query
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Used with
data-collector-na
me to filter
snapshot
collection based
on the value of a
data collector. N
ew in 3.6.1.

If
data-collector-na
me is set.
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data-collector-typ
e

Query

Used with
data-collector-na
me and
data-collector-val
ue to filter
snapshot
collection based
on the value of a
data collector. N
ew in 3.6.1. Som
e of the values
contain spaces.
All are
case-sensitive
and where
indicated the
spaces are
required. Valid
values are:
Error IDs
Stack Traces
Error Detail
Http
Parameter
Business
Data (This
type is a
method
invocation
data
collector.)
Cookie
Http Header
Session Key
Response
Header
Log Message
Transaction
Property
Transaction
Event
Dotnet
Property
isProtoBuf
EUM
Request
GUID
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Output

Query

HTTP Request
parameter
included as part
of the URL to
change the
output format.
Valid values are
"XML" (default)
or "JSON".

No

Example - Retrieve list of transaction snapshots for the ACME Book Store.

URI

Sample object output

/controller/rest/applications/AcmeOnlineBookS
tore/request-snapshots?time-range-type=BEF
ORE_NOW&duration-in-mins=2

XML

/controller/rest/applications/AcmeOnlineBookS
tore/request-snapshots?time-range-type=BEF
ORE_NOW&duration-in-mins=2&output=JSO
N

JSON

Example - Retrieve list of transaction snapshots including the snapshot fields that are associated with an Http
Parameter data collector.

URI

Sample object output

controller/rest/applications/2/request-snapshot
s?time-range-type=BEFORE_NOW&duration-i
n-mins=120&data-collector-type=Http%20Para
meter&data-collector-name=param1&data-coll
ector-value=%5B100%5D&need-props=true]

XML

controller/rest/applications/2/request-snapshot
s?time-range-type=BEFORE_NOW&duration-i
n-mins=120&data-collector-type=Http%20Para
meter&data-collector-name=param1&data-coll
ector-value=%5B100%5D&need-props=true&o
utput=JSON]

JSON

Create and modify AppDynamics users

This is an HTTP POST operation.
The create and modify user URIs are identical except for the user-id parameter, which is not
passed for the create operation. The user-id is generated by the create operation.
A response code of 200 indicates success.
URI: /controller/rest/users
Input parameters
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Parameter Name

Parameter Type

Value

Mandatory

user-name

Query

user name

Yes

user-id

Query

user id

No for a create; yes
for an update

user-display-name

Query

display name

Yes

user-roles

Query

comma-separated list
of roles

No

user-password

Query

user password

Yes for create;
optional for update

user-email

Query

user email

Yes

Include or exclude a business transaction from monitoring

This is an HTTP POST operation.
To exclude a business transaction from monitoring, set the exclude parameter to true.
To turn on monitoring for a currently excluded business transaction, set the exclude parameter to
false.
Send the list of business transactions to be excluded or re-included as xml payload, not as
parameters.
A sample business-transaction-list is:
<business-transactions>
<business-transaction>
<id>15</id>
</business-transaction>
<business-transaction>
<id>16</id>
</business-transaction>
</business-transactions>

Make sure the Content-Type header is set to "application/xml".
URI: /controller/rest/applications/<application-name | application-id>/business-transactions
Input parameters
Parameter Name

Parameter Type

Value

Mandatory

<application-name |
application-id>

URI

Provide either the
application name or
application id.

Yes

exclude

Post

true|false

Yes

Example - Exclude business transaction 166 from monitoring.
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URI
/controller/rest/applications/AcmeOnlineBookStore/business-transactions?exclude=true
This is the way the request appears in the Google Advanced REST Client:

Retrieve all controller global configuration values

These are the values that you set interactively from the Controller Settings screen in the
AppDynamics Administration console.
Access requires the "root" password, which was created for the AppDynamics admin user when
the controller was installed. See Access the Administration Console.
URI: /configuration
Input parameters
Parameter Name

Parameter Type

Value

Mandatory

Output

Query

HTTP Request
parameter included as
part
of the URL to change
the output format.
Valid values are
"XML" (default) or
"JSON".

No
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Example - Retrieve list of all global configuration values

URI

Sample object output

/controller/rest/configuration

XML

/controller/rest/configuration?output=JSON

JSON

Retrieve a single controller global configuration value

URI: /configuration?name=<controller_setting_name>
Input parameters
Parameter Name

Parameter Type

Value

Mandatory

name

Query

Name of the
Controller setting to
retrieve

Yes

Output

Query

HTTP Request
parameter included as
part of the URL to
change the output
format.
Valid values are
"XML" (default) or
"JSON".

No

Example - Retrieve the global metrics buffer size.

URI

Sample object output

/controller/rest/configuration?name=metrics.bu
ffer.size

XML

/controller/rest/configuration?name=metrics.bu
ffer.size&output=JSON

JSON

Configure Global Controller Settings

This is an HTTP POST operation.
URI: /controller/rest/configuration
Input parameters
Parameter Name
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Parameter Type

Value

Mandatory
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name

Query

name of a controller
setting; to see all the
names, retrieve all the
values as described in
Example - Retrieve
list of all global
configuration values

Yes

value

Query

value to set

Yes

Mark Nodes as Historical

This is an HTTP POST operation.
Pass as parameters a comma-separated list of one or more node ids of the nodes to be marked as
historical. You can specify up to a maximum of 25 node ids to be marked.
AppDynamics stops collecting metrics for a node that is marked as historical.
By default AppDynamics marks as historical (soft deletes) a node that has lost contact with the
Controller for the number of hours configured in the node.retention.period controller setting. The
default is 500 hours.
Information from a historical node can be retrieved until the node has lost contact with the
controller for the number of hours configured in the node.permanent.deletion.period, after which
time the historical node is permanently deleted. The default is 720 hours.
URI: /controller/rest/mark-nodes-historical?application-component-node-ids=44,45
Input parameters
Parameter Name

Parameter Type

Value

Mandatory

application-componen
t-node-ids

Query

comma-separated list
of node ids

Yes

Example - Mark nodes 44 and 45 as historical.

URI

Sample object output

/controller/rest/mark-nodes-historical?applicati
on-component-node-ids=44,45

XML

Retrieve all policy violations in a particular business application

URI: /controller/rest/applications/<application-name|application-id>/problems/policy-violations
Input parameters
Parameter Name

Parameter Type

Value

Mandatory

<application-name |
application-id>

URI

Provide either the
application name or
application id.

Yes
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time-range-type

Query

Possible values are:
BEFORE_NOW
To use the
"BEFORE_NOW"
option, you must also
specify the
"duration-in-mins"
parameter.
BEFORE_TIME
To use the
"BEFORE_TIME"
option, you must also
specify the
"duration-in-mins" and
"end-time"
parameters.
AFTER_TIME
To use the
"AFTER_TIME"
option, you must also
specify the
"duration-in-mins" and
"start-time"
parameters.
BETWEEN_TIMES
To use the
"BETWEEN_TIMES"
option, you must also
specify the
"start-time" and
"end-time"
parameters.

Yes

duration-in-mins

Query

Duration (in minutes)
to return the metric
data.

If time-range-type is B
EFORE_NOW, BEFO
RE_TIME, or AFTER
_TIME

start-time

Query

Start time (in
milliseconds) from
which the metric data
is returned.

If time-range-type is A
FTER_TIME or BET
WEEN_TIMES

end-time

Query

End time (in
milliseconds) until
which the metric data
is returned.

If time-range-type is B
EFORE_TIME or BET
WEEN_TIMES
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incident-status

Query

If OPEN, retrieve only
the policy violations
that are open. If
RESOLVED, retrieve
only the policy
violations that are
resolved.

No

Output

Query

HTTP Request
parameter included as
part of the URL to
change the output
format. Valid values
are "XML" (default) or
"JSON".

No

Example - Retrieve the list of all open policy violations in the ACME Book Store for the past 1000 minutes.

URI

Sample object output

/controller/rest/applications/2/problems/policyviolations?time-range-type=BEFORE_NOW&d
uration-in-mins=1000&incident-status=OPEN

XML

/controller/rest/applications/2/problems/policyviolations?time-range-type=BEFORE_NOW&d
uration-in-mins=1000&incident-status=OPEN&
output=JSON

JSON

Example Integrations Using the AppDynamics REST API

Python Client for the REST API
Mobile Application
Jenkins Plugin
Python Client for the REST API

REST Python Client Extension
Mobile Application

See Going Mobile with AppDynamics REST API for information about a monitoring application that
runs on a smart phone.
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The code is available at: https://github.com/unixunion/appdyngauges
Courtesy Kegan Holtzhausen, thank you!
Jenkins Plugin

This plugin makes it possible to integrate data from AppDynamics into your Jenkins build.
The plugin is available at: https://wiki.jenkins-ci.org/display/JENKINS/AppDynamics+Plugin
Courtesy Miel Donkers, thank you!
Use Curl to Access AppDynamics REST APIs
You can fetch the contents of the AppDynamics REST API calls using curl. curl dumps the XML
results to standard output.
The syntax is:
curl --user <appdynamics-username>@<appdynamics-account-name:<appdynamics-password> '
<URI>'
For example, this command gets the applications on the "demo" server:
curl --user user1@customer1:secret
'http://demo.appdynamics.com/controller/rest/applications'

This command gets the tiers in application 2:
curl --user user1@customer1:secret
'http://demo.appdynamics.com/controller/rest/applications/2/tiers'

This command gets the average response time in the Ecommerce tier of the ACME Online Book
Store application over the past two hours:
curl --user user1@customer1:secret
'http://demo.appdynamics.com/controller/rest/applications/Acme%20Onl
ine%20Book%20Store/metric-data?metric-path=Business%20Transaction%20
Performance%7CBusiness%20Transactions%7CE-Commerce-2%7CCheckout%7CAv
erage%20Response%20Time%20(ms)&time-range-type=BEFORE_NOW&duration-i
n-mins=120'

Add Metrics with a Monitoring Extension
About Custom Metrics
Type of Monitoring Extensions
About Custom Metrics

You can supplement the existing metrics in the AppDynamics Controller UI with your own custom
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metrics. Like built-in metrics, your custom metrics are subject to the following AppDynamics
features:
automatic baselines and anomaly detection
availability for display on custom dashboards
availability for use in policies
visibility of all metrics in the Metric Browser, where you can display external metrics along
with AppDynamics metrics on the same graph
To create custom metrics, you create a monitoring extension. In your extension, you define the
name and path of your metric (where it appears in the metric browser tree), what type of metric it is
(sum, average, and so on), and how the data for the metric should be rolled up as it ages.
A custom metric can be common across nodes or associated with a specific tier. When you create
a metric, you specify the path in which it will appear in the metric tree. To make a common custom
metric, use the root tree path Custom Metrics in your metric declaration. To make a tier-specific
metric, specify the metric path associated with that component. For details, see the topics on
creating Java or Script-based custom metrics listed below.
Type of Monitoring Extensions

You can implement custom metrics using the following mechanisms.
Using a script: You can write a shell script (LINUX) or batch file (Windows) to report custom
metrics every minute to the Standalone Machine Agent. The Standalone Machine Agent
passes these metrics on to the Controller.
For more information, see Build a Monitoring Extension Using Scripts.
Using Java: Your custom metrics may be too complicated to collect using a script. For
example, you may need to perform complex calculations or call a third party API to get the
metrics. In this case you can extend the JavaServersMonitor class to collect the metrics and
report them to the Standalone Machine Agent. Your Java program extends the
JavaServersMonitor class to provide your custom functionality.
See Build a Monitoring Extension Using Java.
Using HTTP: If you enable the agent HTTP listener, you can post HTTP requests to the
Standalone Machine Agent to send it custom metrics every minute. This is done by starting
the Standalone Machine Agent with a Jetty HTTP listener.
See Standalone Machine Agent HTTP Listener for information on starting the HTTP listener
and sending it metrics.
Using Performance Counters in a .NET environment: You can add additional
performance counters to the standard hardware metrics reported by the embedded .NET
Embedded Machine Agent by configuring the <perf-counters> element in the .NET
Embedded Machine Agent's application.config file.
See Enable Monitoring for Windows Performance Counters.
Build a Monitoring Extension Using Java
Machine Agent Required
Before You Begin
Process for Creating a Monitoring Extension in Java
Your Monitoring Extension Class
Metric Path
Metric Name
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Metric Processing
Aggregation
Time Roll Up
Cluster Roll Up
Sample Monitoring Extension Class
The monitor.xml File
Sample monitor.xml Files
Using Your Monitoring Extension as a Task in a Workflow
A Java monitoring extension enables the AppDynamics Machine Agent to collect custom metrics,
which you define and provide, and to report them to the Controller. This is an alternative to adding
monitoring extensions using scripts.
When you capture custom metrics with a monitoring extension, they are supported by the same
AppDynamics services that you get for the standard metrics captured with the AppDynamics
application and machine agents. These services include automatic baselining, anomaly detection,
display in the Metric Browser, availability for display on custom dashboards and availability for use
in policies to trigger alerts and other actions.
This topic describes the procedure for creating a monitoring extension in Java.
Machine Agent Required

A monitoring extension requires a standalone Machine Agent installed on the machine that hosts
the application that you want to monitor.
If you do not know whether you have a Machine Agent installed:
1. In the upper right corner of AppDynamics console, click Setup.
2. Click AppDynamics Agents.
The list of agents appears with the Machine Agents below the app agents. You can get summary
information about the machine and the application associated with each machine agent.
If you do not already have a Machine Agent installed, install one. See Install the Standalone
Machine Agent.
To the Machine Agent, a monitoring extension is a task that runs on a fixed schedule and collects
metrics. The task can be either AJavaTask, which executes a task within the machine agent
process, or AForkedJavaTask, which executes a task in its own separate process.
Before You Begin

Before creating your own extension from scratch, look at the extensions that have been created
and shared among members of the AppDynamics community. The extensions are described and
their source is available for free download at:
https://github.com/Appdynamics/
New extensions are constantly being added. It is possible that someone has already created
exactly what you need or something close enough that you can download it and use it after making
a few simple modifications.
Process for Creating a Monitoring Extension in Java
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To create a monitoring extension in Java:
1. Create your extension class. See Your Monitoring Extension Class.
2. Create a monitor.xml configuration file. See The monitor.xml File.
3. Create a zip file containing these two files plus any dependent jar files.
4. Create a subdirectory (<your_extension_dir>) in your AppDynamics Machine Agent directory
under Machine Agent/monitors.
5. Unzip the zip file into Machine Agent/monitors/<your_extension_dir>.
6. Restart the Machine Agent.
Your Monitoring Extension Class

Create a monitoring extension class by extending the AManagedMonitor class in the
com.singularity.ee.agent.systemagent.api package.
You will also need the following helper classes in the same package:
com.singularity.ee.agent.systemagent.api.MetricWriter:
com.singularity.ee.agent.systemagent.api.TaskExecutionContext;
com.singularity.ee.agent.systemagent.api.TaskOutput;
com.singularity.ee.agent.systemagent.api.exception.TaskExecutionException
The Javadoc for these APIs is available at:
https://rawgithub.com/Appdynamics/java-sdk/master/machine-agent-api/MachineAgentAPIJavado
cs/index.html
Your monitor extension class performs these tasks:
Populates a hash map with the values of the metrics that you want to add to AppDynamics.
How you obtain these metrics is specific to your environment and to the source from which
you derive your custom metrics.
Describes the metrics using the MetricWriter class.
Uploads the metrics to the Controller using the execute() method of the TaskOutput class.
Metric Path

All custom metrics processed by the Machine Agent appear in the Application Infrastructure
Performance tree in the metric hierarchy.
Within the Application Infrastructure Performance tree you specify the metric path, which is the
position of the metric in the metric hierarchy, using the "|" character. The first step in the metric
path must be "Custom Metrics."
For example:
Custom Metrics|WebServer|
Custom Metrics|WebServer|XXX|, CustomMetrics|WebServer|YYY|
If the metrics apply to a specific tier, use the metric path for the tier, with "Component" followed by
a colon ":" and the tier ID. The metric will appear under the specified tier in the metric path. For
example:
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Server|Component:18|
Server|Component:18|CustomMetric|Path|
To discover the component ID of a tier, select the tier from the Controller UI application tree. The
component ID appears in the URL of the browser.

You can insert a custom metric alongside an existing type of metric. For example, the following
declaration causes the custom metric named pool usage to appear alongside the JMX metrics:
name=Server|Component:18|JMX|Pool|First|pool usage,value="$pool_value
The metric can then be used in health rules as would other types of JMX metrics.
You can test the appearance of your custom metric in the Controller API by posting the
metric data to the machine agent's REST API. Pass the path, name type and values of the
metric as URL arguments. See Standalone Machine Agent HTTP Listener for more
information.
Metric Name

Metric names must be unique within the same metric path but need not be unique for the entire
metric hierarchy.
It is a good idea to use short metric names so that they will be visible when they are displayed in
the Metric Browser.
Prepend the metric path to the metric name when you upload the metrics to the Controller.
Metric Processing

The Controller has various qualifiers for how it processes a metric with regard to aggregation, time
rollup and tier rollup. You specify these options with the enumerated types provided by the
MetricWriter class. These types are defined below.
Aggregation

The aggregator qualifier specifies how the values reported during a one-minute period are
aggregated.
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Aggregator Type

Description

METRIC_AGGREGATION_TYPE_AVERAGE

Average of all reported values in the minute.
The default operation.

METRIC_AGGREGATION_TYPE_SUM

Sum of all reported values in the minute. This
operation causes the metric to behave like a
counter.

METRIC_AGGREGATION_TYPE_OBSERVA
TION

Last reported value in the minute. If no value is
reported in that minute, the value from the last
time it was reported is used.

Time Roll Up

The time-rollup qualifier specifies how the Controller rolls up the values when it converts from
one-minute granularity tables to 10-minute granularity and 60-minute granularity tables over time.
Roll up Strategy

Description

METRIC_TIME_ROLLUP_TYPE_AVERAGE

Average of all one-minute data points when
adding it to the 10-minute or 60-minute
granularity table.

METRIC_TIME_ROLLUP_TYPE_SUM

Sum of all one-minute data points when
adding it to the 10-minute or 60-minute
granularity table.

METRIC_TIME_ROLLUP_TYPE_CURRENT

Last reported one-minute data point in that
10-minute or 60-minute interval.

Cluster Roll Up

The cluster-rollup qualifier specifies how the controller aggregates metric values in a tier.
Roll up Strategy

Description

METRIC_CLUSTER_ROLLUP_TYPE_INDIVI
DUAL

Aggregates the metric value by averaging the
metric values across each node in the tier.

METRIC_CLUSTER_ROLLUP_TYPE_COLLE
CTIVE

Aggregates the metric value by adding up the
metric values for all the nodes in the tier.

For example, if a tier has two nodes, Node A and Node B, and Node A has 3 errors per minute
and Node B has 7 errors per minute, the INDIVIDUAL qualifier reports a value of 5 errors per
minute and COLLECTIVE qualifier reports 10 errors per minute. INDIVIDUAL is appropriate for
metrics such as % CPU Busy where you want the value for each node. COLLECTIVE is
appropriate for metrics such as Number of Calls where you want a value for the entire tier.
Sample Monitoring Extension Class

The NGinXMonitor class gets the following metrics from the Nginx Web Server and adds them to
the metrics reported by AppDynamics:
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Active Connections: number of active connections
Accepts: number of accepted requests
Handled: number of handled requests
Requests: total number of requests
Reading: number of reads
Writing: number of writes
Waiting: number of keep-alive connections
Here is the source for the extension class.
package com.appdynamics.monitors.nginx;
import
import
import
import
import
import
import

java.io.BufferedReader;
java.io.IOException;
java.io.StringReader;
java.util.HashMap;
java.util.Map;
java.util.regex.Matcher;
java.util.regex.Pattern;

import org.apache.log4j.Logger;
import com.singularity.ee.agent.systemagent.api.AManagedMonitor;
import com.singularity.ee.agent.systemagent.api.MetricWriter;
import com.singularity.ee.agent.systemagent.api.TaskExecutionContext;
import com.singularity.ee.agent.systemagent.api.TaskOutput;
import
com.singularity.ee.agent.systemagent.api.exception.TaskExecutionExce
ption;
import com.singularity.ee.util.httpclient.HttpClientWrapper;
import com.singularity.ee.util.httpclient.HttpExecutionRequest;
import com.singularity.ee.util.httpclient.HttpExecutionResponse;
import com.singularity.ee.util.httpclient.HttpOperation;
import com.singularity.ee.util.httpclient.IHttpClientWrapper;
import com.singularity.ee.util.log4j.Log4JLogger;
/**
* NGinXStatusMonitor is a class that provides metrics on NGinX
server by using the
* NGinX status stub.
*/
public class NGinXMonitor extends AManagedMonitor
{
/**
** The metric prefix indicates the metric's position in the
AppDynamics metric hierarchy.
** It is prepended to the metric name when the metric is uploaded
to the Controller.
** These metrics can be found in the AppDynamics metric hierarchy
under
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** Application Infrastructure Performance|{@literal <}Node{@literal
>}|Custom Metrics|WebServer|NGinX|Status
*/
private final static String metricPrefix = "Custom
Metrics|WebServer|NGinX|Status|";
/* Needed to connect to the Controller. Some environments may
also require credentials. */
protected volatile String host;
protected volatile String port;
protected volatile String location;
/* Hash map to store metric values obtained from the source,
in this example the NGinX server. */
private Map<String,String> resultMap = new HashMap<String,String>();
protected final Logger logger =
Logger.getLogger(this.getClass().getName());
/**
** Main execution method that uploads the metrics to the
AppDynamics Controller.
** @see
com.singularity.ee.agent.systemagent.api.ITask#execute(java.util.Map,
com.singularity.ee.agent.systemagent.api.TaskExecutionContext)
*/
public TaskOutput execute(Map<String, String> arg0,
TaskExecutionContext arg1)
throws TaskExecutionException
{
try
{
host = arg0.get("host");
port = arg0.get("port");
location = arg0.get("location");
/* Gets the values for the metrics and
populates the resultsMap. */
populate();
/* Outputs the metrics: metric name, value
and processing qualifiers. */
printMetric("Activity|up", 1,
MetricWriter.METRIC_AGGREGATION_TYPE_OBSERVATION,
MetricWriter.METRIC_TIME_ROLLUP_TYPE_SUM,
MetricWriter.METRIC_CLUSTER_ROLLUP_TYPE_COLLECTIVE);
printMetric("Activity|Active Connections",
resultMap.get("ACTIVE_CONNECTIONS"),
MetricWriter.METRIC_AGGREGATION_TYPE_OBSERVATION,
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MetricWriter.METRIC_TIME_ROLLUP_TYPE_CURRENT,
MetricWriter.METRIC_CLUSTER_ROLLUP_TYPE_INDIVIDUAL
);
printMetric("Activity|Server|Accepts",
resultMap.get("SERVER_ACCEPTS"),
MetricWriter.METRIC_AGGREGATION_TYPE_OBSERVATION,
MetricWriter.METRIC_TIME_ROLLUP_TYPE_AVERAGE,
MetricWriter.METRIC_CLUSTER_ROLLUP_TYPE_COLLECTIVE
);
printMetric("Activity|Server|Handled",
resultMap.get("SERVER_HANDLED"),
MetricWriter.METRIC_AGGREGATION_TYPE_OBSERVATION,
MetricWriter.METRIC_TIME_ROLLUP_TYPE_AVERAGE,
MetricWriter.METRIC_CLUSTER_ROLLUP_TYPE_COLLECTIVE
);
printMetric("Activity|Server|Requests",
resultMap.get("SERVER_REQUESTS"),
MetricWriter.METRIC_AGGREGATION_TYPE_OBSERVATION,
MetricWriter.METRIC_TIME_ROLLUP_TYPE_AVERAGE,
MetricWriter.METRIC_CLUSTER_ROLLUP_TYPE_COLLECTIVE
);
printMetric("Activity|Reading", resultMap.get("READING"),
MetricWriter.METRIC_AGGREGATION_TYPE_OBSERVATION,
MetricWriter.METRIC_TIME_ROLLUP_TYPE_AVERAGE,
MetricWriter.METRIC_CLUSTER_ROLLUP_TYPE_COLLECTIVE
);
printMetric("Activity|Writing", resultMap.get("WRITING"),
MetricWriter.METRIC_AGGREGATION_TYPE_OBSERVATION,
MetricWriter.METRIC_TIME_ROLLUP_TYPE_AVERAGE,
MetricWriter.METRIC_CLUSTER_ROLLUP_TYPE_COLLECTIVE
);
printMetric("Activity|Waiting", resultMap.get("WAITING"),
MetricWriter.METRIC_AGGREGATION_TYPE_OBSERVATION,
MetricWriter.METRIC_TIME_ROLLUP_TYPE_AVERAGE,
MetricWriter.METRIC_CLUSTER_ROLLUP_TYPE_COLLECTIVE
);
/* Upload the metrics to the Controller. */
return new TaskOutput("NGinX Metric Upload Complete");
}
catch (Exception e)
{
return new TaskOutput("Error: " + e);
}
}
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/**
* Fetches Statistics from NGinX Server
* @throws InstantiationException
* @throws IllegalAccessException
* @throws ClassNotFoundException
* @throws IOException
*/
protected void populate() throws InstantiationException,
IllegalAccessException, ClassNotFoundException, IOException
{
IHttpClientWrapper httpClient = HttpClientWrapper.getInstance();
HttpExecutionRequest request = new
HttpExecutionRequest(getConnectionURL(), "", HttpOperation.GET);
HttpExecutionResponse response =
httpClient.executeHttpOperation(request, new Log4JLogger(logger));
Pattern numPattern = Pattern.compile("\\d+");
Matcher numMatcher;
BufferedReader reader = new BufferedReader(new
StringReader(response.getResponseBody()));
String line, whiteSpaceRegex = "\\s";
while ((line=reader.readLine()) != null)
{
if (line.matches("Active connections"))
{
numMatcher = numPattern.matcher(line);
numMatcher.find();
resultMap.put("ACTIVE_CONNECTIONS", numMatcher.group());
}
else if (line.matches("server"))
{
line = reader.readLine();
String[] results = line.trim().split(whiteSpaceRegex);
resultMap.put("SERVER_ACCEPTS", results[0]);
resultMap.put("SERVER_HANDLED", results[1]);
resultMap.put("SERVER_REQUESTS", results[2]);
}
else if (line.contains("Reading"))
{
String[] results = line.trim().split(whiteSpaceRegex);
resultMap.put("READING", results[1]);
resultMap.put("WRITING", results[3]);
resultMap.put("WAITING", results[5]);
}
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}
}
/**
* Returns the metric to the AppDynamics Controller.
* @param metricName Name of the Metric
* @param metricValue Value of the Metric
* @param aggregation Average OR Observation OR Sum
* @param timeRollup Average OR Current OR Sum
* @param cluster
Collective OR Individual
*
* Overrides the Metric Writer class printMetric() by building the
string that provides all the fields needed to
* process the metric.
*/
public void printMetric(String metricName, Object metricValue,
String aggregation, String timeRollup, String cluster)
{
MetricWriter metricWriter = getMetricWriter(getMetricPrefix() +
metricName,
aggregation,
timeRollup,
cluster
);
metricWriter.printMetric(String.valueOf(metricValue));
}
protected String getConnectionURL()
{
return "http://" + host + ":" + port + "/" + location;
}
protected String getMetricPrefix()
{
return metricPrefix;
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}
}

The monitor.xml File

Create a monitor.xml file with a <monitor> element to configure how the machine agent will
execute the extension.
1. Set the <name> to the name of your Java monitoring extension class.
2. Set the <type> to "managed".
3. The <execution-style> can be "continuous" or "periodic".
Continuous means to collect the metrics averaged over time; for example, average
CPU usage per minute. In continuous execution, the Machine Agent invokes the
extension once and the program runs continuously, returning data every 60 seconds.
Periodic means to invoke the monitor at a specified frequency. In periodic execution
the Machine Agent invokes the extension, runs it briefly, and returns the data on the
schedule set by the <execution-frequency-in-seconds> element.
4. If you chose "periodic" for the execution style, set the frequency of collection in
<execution-timeout-in-secs> element. The default frequency is 60 seconds. If you chose
"continuous" this setting is ignored.
5. Set the <type> in the <monitor-run-task> child element to "java".
6. Set the <execution-timeout-in-secs> to the number of seconds before the extension times
out.
7. Specify any required task arguments in the <task-arguments> element. The default
arguments that are specified here are the only arguments that the extension uses. They are
not set anywhere else.
8. Set the <classpath> to the jar file that contains your extension's classes. Include any
dependent jar files, separated by semicolons.
9. Set the <impl-class> to the full path of the class that the Machine Agent invokes.
Sample monitor.xml Files

The following monitor.xml file configures the NGinXMonitor monitoring extension. This extension
executes every 60 seconds.
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<monitor>
<name>NGinXMonitor</name>
<type>managed</type>
<description>NGinX server monitor</description>
<monitor-configuration></monitor-configuration>
<monitor-run-task>
<execution-style>periodic</execution-style>
<execution-frequency-in-seconds>60</execution-frequency-in-seconds>
<name>NGinX Monitor Run Task</name>
<display-name>NGinX Monitor Task</display-name>
<description>NGinX Monitor Task</description>
<type>java</type>
<execution-timeout-in-secs>60</execution-timeout-in-secs>
<task-arguments>
<argument name="host" is-required="true"
default-value="localhost" />
<argument name="port" is-required="true"
default-value="80" />
<argument name="location" is-required="true"
default-value="nginx_status" />
</task-arguments>
<java-task>
<classpath>NginxMonitor.jar</classpath>
<impl-class>com.appdynamics.nginx.NGinXMonitor</impl-class>
</java-task>
</monitor-run-task>
</monitor>

The next monitor.xml file configures the MysqlMonitor. This monitor executes every 60 seconds,
has four required task arguments and one optional task argument and one dependent jar file.
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<monitor>
<name>MysqlMonitor</name>
<enabled>true</enabled>
<type>managed</type>
<description>Monitors Mysql database system </description>
<monitor-configuration></monitor-configuration>
<monitor-run-task>
<execution-style>periodic</execution-style>
<execution-frequency-in-seconds>60</execution-frequency-in-seconds>
<name>Mysql Monitor Run Task</name>
<display-name>Mysql Monitor Task</display-name>
<description>Mysql Monitor Task</description>
<type>java</type>
<execution-timeout-in-secs>60</execution-timeout-in-secs>
<task-arguments>
<argument name="host" is-required="true"
default-value="localhost" />
<argument name="port" is-required="true"
default-value="3306" />
<argument name="user" is-required="true"
default-value="root" />
<argument name="password" is-required="true"
default-value="welcome" />
<!-The tier under which the metrics should appear in the
metric browser.
If this argument is left out then the metrics will be
registered in every tier.
-->
<argument name="tier" is-required="false"
default-value="1stTier" />
</task-arguments>
<java-task>
<classpath>mysql.jar;mysql-connector-java-5.1.17-bin.jar</classpath>
<impl-class>com.singularity.ee.agent.systemagent.monitors.database.m
ysql.MysqlMonitor</impl-class>
</java-task>
</monitor-run-task>
</monitor>

Using Your Monitoring Extension as a Task in a Workflow

Your monitoring extension can be invoked as a task in a workflow if you upload the zip file to the
task library. Use the instructions in To package the XML files as a Zip archive to upload the Java
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monitor to the Task Library.
Standalone Machine Agent HTTP Listener
To activate the HTTP listener
To send metrics
To send events
To upload metrics
To upload events
To shut down the standalone machine agent
You can send metrics to the Standalone Machine Agent using its HTTP listener. You can report
metrics through the Standalone Machine Agent by making HTTP calls to the agent instead of
piping to the agent through sysout.
To activate the HTTP listener

Restart the Standalone Machine Agent using metric.http.listener:
java -Dmetric.http.listener=true -Dmetric.http.listener.port=<port_number>
-jar machineagent.jar

If you do not specify the optional metric.http.listener.port, it defaults to 8293.
To send metrics

GET | POST /machineagent/metrics

To send events

GET /machineagent/event

To upload metrics

You can use GET or POST to upload metrics to the Metric Browser under Application
Performance -> <Tier> where the tier is the one defined for the Standalone Machine Agent. For
example:
http://host:port/machineagent/metrics?name=Custom Metrics|Test|My
Metric&value=42&type=average

Valid values for type are:
average
sum
current
To upload events
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Send events using HTTP get requests to:
http://localhost:8293/machineagent/event?type=<event_type>&summary=<summary_text
>

Event_type is one of the following:
error
info
summary
warning
To shut down the standalone machine agent

GET /machineagent/shutdown

Build a Monitoring Extension Using Scripts

Metric Qualifiers
Aggregation Qualifier
Time Roll Up Qualifier
Cluster Roll Up Qualifier
Adding a Monitoring Extension
Step 1. Create a directory under the Machine Agent monitors directory
Step 2. Create the script file
Step 3. Copy the script file to the directory created in Step 1
Step 4. Create the monitor.xml file
Step 5. Copy the monitor.xml file to the directory created in Step 1
Step 6. Restart the standalone Machine Agent
Step 7. Verify execution of the monitoring extension script
Example: Create a monitoring extension for open files
Learn More
You can write a monitoring extension script (formerly known as a custom monitor) to add custom
metrics to the metric set that AppDynamics already collects and reports to the Controller. Your
script reports the custom metrics every minute to the standalone Machine Agent. The standalone
Machine Agent passes these metrics to the Controller.
This topic describes the steps for adding custom metrics using a shell script and includes an
example.
Metric Qualifiers

The metric qualifiers determine how the Controller processes the data for your custom metric.
There are three types:
Aggregation qualifier
Time roll-up qualifier
Cluster roll-up qualifier
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Aggregation Qualifier

The aggregator qualifier specifies how the standalone Machine Agent aggregates the
values reported during a one-minute period.
This value is an enumerated type. Valid values are:
Aggregator

Description

AVERAGE

Average of all reported values in that
minute. The default operation.

SUM

Sum of all reported values in that minute.
This operation behaves like a counter.

OBSERVATION

Last reported value in the minute. If no
value is reported in that minute, the value
from the last time it was reported is used.

Time Roll Up Qualifier

The time-rollup qualifier specifies how the Controller rolls up the values when it converts
from one-minute granularity tables to 10-minute granularity and 60-minute granularity tables
over time.
The value is an enumerated type. Valid values are:
Roll up Strategy

Description

AVERAGE

Average of all one-minute values when
adding it to the 10-minute granularity table;
average of all 10-minute values when
adding it to the 60-minute granularity table.

SUM

Sum of all one-minute values when adding
it to the 10-minute granularity table; sum of
all 10-minute values when adding it to the
60-minute granularity table.

CURRENT

Last reported one-minute value in that
10-minute interval; last reported ten-minute
value in that 60-minute interval.

Cluster Roll Up Qualifier

The cluster-rollup qualifier specifies how the Controller aggregates metric values in a tier (a
cluster of nodes).
The value is an enumerated type. Valid values are:
Roll up Strategy

Description

INDIVIDUAL

Aggregates the metric value by averaging
the metric values across each node in the
tier.
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COLLECTIVE

Aggregates the metric value by adding up
the metric values for all the nodes in the
tier.

For example, if a tier has two nodes, Node A and Node B, and Node A has 3 errors per minute
and Node B has 7 errors per minute, the INDIVIDUAL qualifier reports a value of 5 errors per
minute and and COLLECTIVE qualifier reports 10 errors per minute. INDIVIDUAL is appropriate
for metrics such as % CPU Busy where you want the value for each node. COLLECTIVE is
appropriate for metrics such as Number of Calls where you want a value for the entire tier.
Adding a Monitoring Extension
Step 1. Create a directory under the Machine Agent monitors directory

The /monitors directory in the Machine Agent installation directory is the repository for all
monitoring extensions. For each new extension, create a sub-directory under the /monitors
directory. The sub-directory requires read, write, and execute permissions.
For example, to create a monitoring extension that monitors open files in the JVM, create a
sub-directory named "openfiles" under the <Machine_Agent_installation/monitors> directory.

Step 2. Create the script file

A script writes data to STDOUT. The Machine Agent parses STDOUT and sends information to
the Controller every minute. Use the following instructions to create the script file.
1. Specify a name-value pair for the metrics.
Each metric has a name-value pair that is converted to a java 'long' value. A typical metric
entry in the script file has the following structure:
name=<metric name>,value=<long value>
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Use the following format:
Format
Standard Form

Hardware Resources| Instrument
Name=Instrument Value

Fully Qualified Form

Hardware Resources| <metric
name>,value=<long value>

2. Define the category of the metric, for example:
Infrastructure (for the default hardware metrics, see Monitor Hardware)
JVM (for the default metrics, see Monitor JVMs)
Custom Metrics
Custom metrics must have the path prefixes:
Custom Metrics
Server|Component:<id>
Metrics with the Custom Metrics prefix are common across all tiers in your application.
Metrics with the Server|Component:<id> prefix appear only under the specified tier.
To discover the component ID of a tier, select the tier from the Controller UI application tree.
The component ID appears in the URL of the browser.

The "|" character separates the branches in the metric hierarchy, telling the Controller where
the metric should appear in the metric tree:
Custom Metrics|Hardware Resources|Disks|Total Disk Usage %
Custom Metrics|Hardware Resources|Disks|Disk 1|Current Disk
Usage %

You can insert a custom metric alongside an existing type of metric. For example, the
following declaration causes the custom metric named pool usage to appear alongside the
JMX metrics:
Server|Component:18|JMX|Pool|First|pool usage
The metric can then be used in health rules as would other types of JMX metrics.
3. To monitor multiple metrics in the same script file, print a different line for each one. For
example:
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3.

name=Custom Metrics|Hardware Resources|Disks|Total Disk Usage %,
value=23
name=Custom Metrics|Hardware Resources|Disks|Disk 1|Current Disk
Usage %, value=56

Step 3. Copy the script file to the directory created in Step 1

Ensure that the Agent process has execute permissions not only for the script file but also for the
contents of the file.
Step 4. Create the monitor.xml file

Follow the steps listed below to create your monitor.xml file:
1. For each custom monitor create a monitor.xml file.
The monitor.xml file executes the script file created in Step 2. You can edit the following
sample file to create your file.
<monitor>
<name>HardwareMonitor</name>
<type>managed</type>
<description>Monitors system resources - CPU, Memory,
Network I/O, and Disk I/O.</description>
<monitor-configuration>
</monitor-configuration>
<monitor-run-task>
<!-- Edit execution-style as needed. -->
<execution-style>periodic</execution-style>
<name>Run</name>
<type>executable</type>
<task-arguments></task-arguments>
<executable-task>
<type>file</type>
<!-- Use only one file element per os-type. -->
<file os-type="linux">linux-stat.sh</file>
<file os-type="mac">macos-stat.sh</file>
<file os-type="windows">windows-stat.bat</file>
<file os-type="solaris">solaris-stat.sh</file>
<file os-type="sunos">solaris-stat.sh</file>
<file os-type="aix">aix-stat.sh</file>
</executable-task>
</monitor-run-task>
</monitor>

The os-type attribute is optional for the executable-task file element when only one os-type
is specified. One monitor.xml file executes one script per os-type.
2. Select the execution style from one of the following:
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2.

Execution Style

Description

Example

Continuous

Choose "Continuous", if you
want data collection
averaged over time.
(For example: Averaging
CPU over minute).
This ensures that the script
keeps running until the
machine agent process is
terminated.(!) For the
monitor to be declared as
'continuous', the script
should also run in an infinite
loop.

while [ 1 ]; do
... the actual script goes
here ...
sleep 60
done

Periodic

Choose periodic, if you want
data to be reported from
system performance
counters periodically.

The periodic task runs every
minute by default.
Use following parameter in
the XML file, if you want the
periodic task to run with any
other frequency:
<monitor-run-task> element.
<execution-frequency-inseconds>120</execution-fr
equency-in-seconds>
For all the other frequency
settings, the data is
aggregated.

3. Add the name of this script file to the <file> element in the monitor.xml file. Be sure to use
the correct os-type attribute. The os-type value should match the value returned from
calling System.getProperty("os.name"). See http://docs.oracle.com/javase/1.5.0/docs/api/jav
a/lang/System.html#getProperties%28%29(opens in new window).
<file os-type="your-os-type">{script file name}</file>

You can use either the relative or absolute path of the script.
Step 5. Copy the monitor.xml file to the directory created in Step 1
Step 6. Restart the standalone Machine Agent

After restarting the standalone Machine Agent, you should see following message in your log file:
Executing script [<script_name>] on the console to make sure your
changes work with the machine agent.
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Step 7. Verify execution of the monitoring extension script

To verify the execution of extension, wait for at least one minute and check the metric data in the
Metric Browser.
You can now create alerts based on any of these metrics.
Example: Create a monitoring extension for open files

This section provides instructions to create a custom monitor for monitoring all the open files for
JVMs.
1. Create a new directory in the custom monitor repository.
2. Create the script file.
This is a sample script. Modify this script for the specific process name (for example: Author,
Publish, and so on).
lookfor="<process name 1>"
pid=`ps aux | grep "$lookfor" | grep -v grep | tr -s " " | cut
-f2 -d' '`
count1=`lsof -p $pid | wc -l | xargs`
lookfor="<process name 2>"
pid=`ps aux | grep "$lookfor" | grep -v grep | tr -s " " | cut
-f2 -d' '`
count2=`lsof -p $pid | wc -l | xargs`
echo "name=JVM|Files|<process name 1>,value="$count1
echo "name=JVM|Files|<process name 2>,value="$count2

3. Create the monitor.xml and point this XML file to the script file created in step 2.
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<monitor>
<name>MyMonitors</name>
<type>managed</type>
<description>Monitor open file count </description>
<monitor-configuration>
</monitor-configuration>
<monitor-run-task>
<execution-style>continuous</execution-style>
<name>Run</name>
<type>executable</type>
<task-arguments>
</task-arguments>
<executable-task>
<type>file</type>
<file>openfilecount.sh</file>
</executable-task>
</monitor-run-task>
</monitor>

Learn More

Administer Standalone Machine Agents
Notification Actions
Machine Agent Install and Admin FAQ
Supported Environments and Versions

Build an Alerting Extension
Custom Notifications and Custom Actions
Creating a Custom Action
To create a custom action script
Contents of the custom.xml File
Information Passed to the Custom Action Script from AppDynamics
Parameters passed by a health rule violation
Parameters passed for an event that is not a health rule violation event
Sample Alerting Extension
Learn More
If you are using an on-premise controller, you can set up a custom action on the controller
instance to integrate notification of AppDynamics health rule violations and events with an alerting
or ticketing system. Use a push approach by creating custom notifications that pass the
information to your alerting system.
Custom Notifications and Custom Actions

A custom notification lets you integrate alerts about AppDynamics health rule violations and events
into your own alerting system. This integration extension requires:
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An on-premise controller
A custom.xml file that provides information about the custom notification
An executable script that accepts parameters from AppDynamics about the events and
health rule violations that trigger an alert
Configuring AppDynamics events or policies to trigger the custom notification via a custom
action
Creating a Custom Action
To create a custom action script

1. At the top level of the Controller installation directory, create a directory named "custom" with a
sub-directory named "actions".
<controller_install_dir>/custom/actions

2. In the <controller_install_dir>/custom/actions directory, create a subdirectory for each custom
action script that you will install. For example,
<controller_install_dir>/custom/actions/jira

for an action that interfaces with a JIRA system.
3. For each custom action that you want to implement, create an executable script (.bat extension
for Windows, .sh extension for Linux) that can accept and process the parameters passed to it by
AppDynamics. See Information Passed to the Custom Action Script from AppDynamics for details
on the parameters.
Create this script in the appropriate subdirectory that you created in step 2.
Set correct executable permissions for the shell scripts in a Linux environment. For example:
chmod 770 script1.sh.
Ensure that the script file has the correct character encoding. This is especially important when
creating a Unix shell script on a Windows machine.
4. In the <controller_install_dir>/custom/actions directory, create a custom.xml file that describes
the location and name of your custom action script(s).
See Contents of the custom.xml File.
5. After you have installed the script(s) and the custom.xml file, restart the Controller.
6. Verify the script manually.
To verify the script:
a. Open a command-line console on the Controller host machine.
b. Execute the script file from the command line console.
7. Create the custom action in the AppDynamics UI. See Custom Actions.
Contents of the custom.xml File
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The custom.xml file has an <actions> element for every custom action on the controller.
The <type> element contains the subdirectory that contains the script file.
The <executable> element contains the name of the script.
Sample custom.xml file
<custom-actions>
<action>
<type>jira</type>
<executable>script1.bat</executable>
</action>
<action>
<type>bugzilla</type>
<executable>script2.sh</executable>
</action>
</custom-actions>

Information Passed to the Custom Action Script from AppDynamics

The custom action script must handle the parameters passed to it from a health rule violation
event or any other type of event.
Parameters passed by a health rule violation

For a health rule violation, the custom action script is invoked with the following string parameters:
Health Rule Violation
Parameter

Repeated Parameter

Notes

APP_NAME

none

name of the business
application

APP_ID

none

application ID number

PVN_ALERT_TIME

none

alert time, such as: Thu Dec
22 15:03:56 PST 2011

PRIORITY

none

priority number

SEVERITY

none

allowed values: INFO, WARN,
or ERROR (In the
AppDynamics UI they are
called "Info", "Warning", and
"Critical")

TAG

none

or the empty string if no tag
was specified by the user

HEALTH_RULE_NAME

none

name of the health rule that
was violated

HEALTH_RULE_ ID

none

health rule ID number

Copyright © AppDynamics 2012-2014

Page 565

PVN_TIME_PERIOD_IN_MIN
UTES

none

health rule violation time
period in minutes

AFFECTED_ENTITY_TYPE

none

allowed types: APPLICATION,
APPLICATION_COMPONEN
T (aka Tier),
APPLICATION_COMPONEN
T_NODE,
BUSINESS_TRANSACTION,
APPLICATION_DIAGNOSTIC
_DATA (aka Error)

AFFECTED_ENTITY_NAME

none

the affected entity name

AFFECTED_ENTITY_ID

none

the affected entity id

NUMBER_OF_EVALUATION
_ENTITIES

none

number of entities (BT, App,
Tiers, Nodes, Errors, JMX
counters, etc..) violating
health rule conditions

EVALUATION_ENTITY_TYP
E

Yes, one for each evaluation
entity

allowed types: APPLICATION,
APPLICATION_COMPONEN
T (aka Tier),
APPLICATION_COMPONEN
T_NODE,
BUSINESS_TRANSACTION,
APPLICATION_DIAGNOSTIC
_DATA (aka Error), JMX

EVALUATION_ENTITY_NAM
E

Yes, one for each evaluation
entity

the evaluation entity name (for
JMX it is the counter name)

EVALUATION_ENTITY_ID

Yes, one for each evaluation
entity

the evaluation entity id or
<NULL> for JMX

NUMBER_OF_TRIGGERED_
CONDITIONS_PER_EVALUA
TION_ENTITY

Yes, one for each evaluation
entity

number of times to loop
through the triggered
condition parameters for each
evaluation entity

triggered condition

Yes, listed below

if more than one condition is
triggered, the parameters
repeat for each triggered
condition, where "x"
increments the number
representing the condition
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SCOPE_TYPE_x

the scope of the parameter,
whether the scope is the
application, tier, or node:
APPLICATION,
APPLICATION_COMPONEN
T,
APPLICATION_COMPONEN
T_NODE

SCOPE_NAME_x

the name of the scope, such
as: ACME Book Store
Application

SCOPE_ID_x

the scope id

CONDITION_NAME_x

the health rule condition name

CONDITION_ID_x

the health rule condition id

OPERATOR_x

allowed operators:
LESS_THAN,
LESS_THAN_EQUALS,
GREATER_THAN,
GREATER_THAN_EQUALS,
EQUALS, NOT_EQUALS.

CONDITION_UNIT_TYPE_x

the condition for the threshold
parameter: ABSOLUTE,
BASELINE_STANDARD_DE
VIATION,
BASELINE_PERCENTAGE,
BASELINE_PERCENTILE

USE_DEFAULT_BASELINE_
x

a Boolean parameter (true or
false) applicable only when
the condition unit type is one
of the BASELINE_ types

BASELINE_NAME_x

applicable only when the
condition unit type is one of
the BASELINE_ types and the
use default baseline
parameter is "false"

BASELINE_ID_x

applicable only when the
condition unit type is one of
the BASELINE_ types and the
use default baseline
parameter is "false"

THRESHOLD_VALUE_x

health rule threshold setting
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OBSERVED_VALUE_x

value that violated the health
rule threshold

SUMMARY_MESSAGE

none

summary of the notification,
such as: "Health rules have
been violated."

INCIDENT_ID

none

The incident identifier number
for this health rule violation.
Incident ID is unique within
the Controller. The field is
defined as int(11) which
means it takes four bytes of
space that is 32 bits of space
with 2^(31) - 1 = 2147483647
max value and -2147483648
min value. One bit is for sign.

DEEP_LINK_URL

none

controller deep link URL, such
as:
http://<controller-host-url>/#lo
cation=APP_INCIDENT_DET
AIL&incident=
Append the incident ID to the
URL to provide a link to the
Controller UI for this policy
violation

EVENT_TYPE

none

POLICY_OPEN_WARNING,
POLICY_OPEN_CRITICAL,
POLICY_CLOSE,
POLICY_OPEN_UPGRADED
,
POLICY_OPEN_DOWNGRA
DED, POLICY_CANCELLED,
POLICY_CONTINUES_WAR
NING, and
POLICY_CONTINUES_CRITI
CAL

Parameters passed for an event that is not a health rule violation event

For an event that is not a health rule violation event, the custom action script is invoked with the
following string parameters:
Event Notification
Parameter

Repeated Parameter

Notes

APP_NAME

none

name of the business
application

APP_ID

none

application ID number
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EN_TIME

none

event notification time, for
example: Wed Jan 04
09:36:55 PST 2012

PRIORITY

none

priority number

SEVERITY

none

Allowed values: INFO, WARN,
or ERROR (In the
AppDynamics UI they are
called "Info", "Warning", and
"Critical")

TAG

none

or <NULL> if it was not
specified by the user

EN_NAME

none

name of the event notification

EN_ID

none

event notification ID number

EN_INTERVAL_IN_MINUTES

none

event notification interval in
minutes

NUMBER_OF_EVENT_TYPE
S

none

determines how many times
to loop through the event type
map parameters

event type

yes, listed below

if there is more than one event
type, the parameters repeat
for each event type, where "x"
increments the number
representing the event type
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EVENT_TYPE_x

type of event, such as:
ERROR,
APPLICATION_ERROR,
APPLICATION_INFO, STALL,
BT_SLA_VIOLATION,
DEADLOCK,
MEMORY_LEAK,
MEMORY_LEAK_DIAGNOST
ICS, LOW_HEAP_MEMORY,
ALERT, CUSTOM,
APP_SERVER_RESTART,
BT_SLOW, SYSTEM_LOG,
INFO_INSTRUMENTATION_
VISIBILITY, AGENT_EVENT,
INFO_BT_SNAPSHOT,
AGENT_STATUS,
SERIES_SLOW,
SERIES_ERROR,
ACTIVITY_TRACE,
OBJECT_CONTENT_SUMM
ARY,
DIAGNOSTIC_SESSION,
HIGH_END_TO_END_LATE
NCY,
APPLICATION_CONFIG_CH
ANGE,
APPLICATION_DEPLOYMEN
T, AGENT_DIAGNOSTICS,
MEMORY, LICENSE

EVENT_TYPE_NUM_x

number of events of this type

NUMBER_OF_EVENT_SUM
MARIES

none

number of event summaries in
the notification; determines
how many times to loop
through the event summary
parameters

event summary

yes, listed below

if there is more than one event
summary, the following
parameters repeat for each
event summary, where "x"
increments the number
representing the event
summary

EVENT_SUMMARY_ID_x

event summary ID number

EVENT_SUMMARY_TIME_x

event summary time, for
example: Wed Jan 04
09:34:13 PST 2012
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DEEP_LINK_URL

EVENT_SUMMARY_TYPE_x

type of event, such as:
APPLICATION_CONFIG_CH
ANGE,
APP_SERVER_RESTART,
DIAGNOSTIC_SESSION,
STALL

EVENT_SUMMARY_SEVERI
TY_x

event severity, such as: INFO,
WARN, or ERROR (In the
AppDynamics UI they are
called "Info", "Warning", and
"Critical")

EVENT_SUMMARY_STRING
_x

event summary string, such
as: Application Server
environment variables
changed

none

http://<controller-host-url>/#lo
cation=APP_EVENT_VIEWE
R_MODAL&eventSummary=
Append each event summary
ID to the URL to provide a link
to the Controller UI for this
event

The current custom action implementation will most likely pass more than nine parameters to the
executing script.
In Windows and Linux environments, more than nine command line parameters can be processed
only if the SHIFT command is used.
For more information, see Command Line parameters.
Sample Alerting Extension

You can download an alerting extension that interfaces with the PagerDuty alerting and incident
tracing system.
Learn More

Actions
Custom Actions
Policies
Extensions and Integrations
Configure Policies

Ecosystem Integrations
Configure Integrations

To configure integrations
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You can enable and perform basic configuration with external products from the Administration
window.
To configure integrations

1. As an administrator in the Controller UI, click Settings -> Administration.
2. Click the Integration tab. If the tab doesn't appear, click the right arrows to view additional
tabs.
3. In the left panel select the product for which you want to configure integration.
The fields specific to the selected product appear in the right panel.
4. Check the Enabled check box to enable the integration. Clear this check box to disable the
integration.
5. Provide the product-specific information in the text fields.
6. Click Save.
Integrate AppDynamics with DB CAM
Prerequisites for DB CAM Integration
Configuring AppDynamics to Interface with DB CAM
Configure DB CAM at the Account Level
To Configure One AppDynamics Account for DB CAM Integration
Configure DB CAM at the Agent Level
Linking to DB CAM from AppDynamics
To Link to DB CAM from a Dashboard
To Link to DB CAM from a Transaction Snapshot
Learn More
You can link to DB CAM for any DB CAM-monitored database that is discovered by AppDynamics.
This integration provides access to the database performance metrics provided by DB CAM.
Prerequisites for DB CAM Integration

To use this integration you must have a DB CAM license.
DB CAM must be configured to monitor the databases that you want to link to from AppDynamics.
Configuring AppDynamics to Interface with DB CAM

You configure DB CAM integration at the account level and at the app agent level.
Configure DB CAM at the Account Level

Configure the integration at the account level using the Administration Console at
<host>:<port>/controller/admin.html

Create two new properties as name-value pairs in each account for which you want to enable DB
CAM integration.
To Configure One AppDynamics Account for DB CAM Integration

1. Login to the Administrator Console with the administrator root password.
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2. Select Accounts.
3. In the accounts list, double-click the account for which you want to configure DB CAM
integration.
4. In the upper right corner of the account screen, click Additional Account Properties.
5. In the Additional Account Properties screen, click Add Property to add the DB_CAM_URL
property.
6. In the left field enter "DB_CAM_URL".
7. In the right field enter the URLl of the AppDynamics Controller that you are configuring using the
syntax
http[s]://<host>:<port>

8. Click Add Property again to add the DB_CAM_ENABLED property.
9. In the left field enter "DB_CAM_ENABLED".
10. In the right field enter "true".
11. Click OK to save the properties.
12. Log out of the Administrator Console.

Configure DB CAM at the Agent Level

For each app agent for which you want to enable access to deep diagnostics from DB CAM:
1. Open the AppServerAgent/conf/app-agent-config.xml file for the app agent.
2. Locate the TransactionMonitoringService element:
<agent-service name="TransactionMonitoringService" enabled="true">

3. Add the jdbc-dbcam-integration-enabled property for the service:
<agent-service name="TransactionMonitoringService" enabled="true">
<service-dependencies>BCIEngine,SnapshotService</service-dependencie
s>
<configuration-properties>
<property name="jdbc-dbcam-integration-enabled"
value="true"/>

4. Save the file.
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Linking to DB CAM from AppDynamics

You can link to DB CAM from any AppDynamics flow map that displays a discovered DB
CAM-monitored database. The flow map could be in a dashboard or a transaction snapshot.
If you link to DB CAM from a dashboard you will land in the DB CAM instance dashboard. If you
link to be DB CAM from a transaction snapshot, you will land in the DB CAM Session Drill Down
screen.
To Link to DB CAM from a Dashboard

1. In the flow map of a dashboard, right-click on the link below a database icon.
2. Click Search in DBCam.

DB CAM launches and displays the instance dashboard for the selected database.

To Link to DB CAM from a Transaction Snapshot

1. In the flow map of a transaction snapshot, right-click on the link below the database icon.
2. Click Search in DBCam.
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DB CAM launches and displays the session drill down for the selected database.

Learn More

Access the Administration Console
Dashboards
Flow Maps
Transaction Snapshots
Monitor Databases
DB CAM
Integrate AppDynamics with Apica
AppDynamics integrates with:
Apica WebPerformance
Apica ProxySniffer
Apica LoadTest
Apica users can drill down from these Apica products into the AppDynamics console to investigate
the root cause of performance problems.
For more information about the integration with Apica see the AppDynamics blog and Apica blog a
nnouncements.
Integrate AppDynamics with Splunk
Prerequisites for Configuring Splunk Integration
To Configure AppDynamics to Interface with Splunk
Launching a Splunk Search from AppDynamics
Prerequisites
To launch a Splunk search
Seeing Performance Data from AppDynamics in Splunk
Viewing AppDynamics Notifications in Splunk
Learn More
The AppDynamics-Splunk integration enables you to get a 360-degree view of your application
performance by leveraging the AppDynamics "inside-the-app" view and the Splunk
"outside-the-app" view.
The integration provides three capabilities. You can do the following:
Launch Splunk searches using auto-populated queries from in-context locations in the

Copyright © AppDynamics 2012-2014

Page 575

AppDynamics Console based on criteria such as time ranges and node IP address.
Push notifications on policy violations and events from AppDynamics to Splunk so that a
Splunk user can use those to launch deep dives in AppDynamics. See Viewing
AppDynamics Notifications in Splunk. This enables you to see what was going on in the logs
around the time of a specific event as well as navigate to AppDynamics-provided details at
that point in time.
Mine performance data from AppDynamics using the Controller REST API, and push it into
Splunk. See Seeing Performance Data from AppDynamics in Splunk.
Watch this webinar:http://info.appdynamics.com/AppDynamicsSplunkWebinarRecording.html to
hear John Martin, Sr. Director of Production Engineering at Edmunds.com, give an overview of
how he uses AppDynamics and Splunk together, to gain the visibility he needs to manage the
performance of his award-winning consumer car website, Edmunds.com. This video covers the
use cases initiated from Splunk using the AppDynamics App for Splunk.
This topic covers the Splunk search capability that is launched from AppDynamics.
Prerequisites for Configuring Splunk Integration

To use the Search Splunk capability, you need to configure AppDynamics to communicate with
your Splunk Server. To do this you need the following:
Proper AppDynamics administrator credentials
For single tenant installations, login as the AppDynamics Administrator (root
administrator)
For multi-tenant installations login as the Account Administrator for the specific tenant
using Splunk.
The URL and port number for the Splunk server.
See the Splunk website for information about Splunk.
To Configure AppDynamics to Interface with Splunk

1. Logged in with administrator privileges, in the Home window click Settings -> Administration.

3. In the Administration window, click the Integration tab.
4. Click Splunk in the Integrations list.
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5. Check the Enabled check box to enable the integration.
6. Enter the Splunk URL and port number.
7. (Optional) Enter Extra Query Parameters. These parameters are appended to each Splunk
search initiated from AppDynamics.
8. Click Save.
Launching a Splunk Search from AppDynamics

You can launch a search of your Splunk logs for a specific time frame associated with a
transaction snapshot from several points in AppDynamics.
Prerequisites

Splunk credentials: The first time that you launch a Splunk search, you are prompted to
provide your Splunk credentials. After this, your credentials are cached by the browser.
Your Splunk Server is up and running.
Your browser is configured to allow pop-ups.
Enable Pop-ups
The first time that you access the Splunk Server, you are prompted to log in. If nothing
happens, it is most likely that either your browser is blocking the Splunk login pop-up or the
Splunk Server is not running.
To launch a Splunk search

You can access the Search Splunk option from the following locations:
1. The node dashboard:
a. Navigate to a node dashboard.
b. Click More Actions.
c. Select Search Splunk under the Integrations section.
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c.

2. The list of transaction snapshots:
a. From the business transaction dashboard, select the Transaction Snapshot tab.
b. Select a transaction snapshot and right-click to access a list of options or click More
Actions to see Search Splunk in the list of options.
More Actions:

c. Right-click list:
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d. Select Search Splunk
3. The Transaction Snapshot Flow Map:
a. Locate the Search Splunk option at the top of the flow map.

4. The Call Drill Down Summary pane:

Seeing Performance Data from AppDynamics in Splunk

This feature is initiated using the Splunk eXtension.
Viewing AppDynamics Notifications in Splunk

This feature is initiated using the Splunk eXtension.
Learn More
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Splunkbase Apps
Splunk documentation
Integrate with AppDynamics for Databases
Prerequisites for AppDynamics for Databases Integration
Configuring AppDynamics to Interface with AppDynamics for Databases
To Configure AppDynamics to Interface with AppDynamics for Databases
To Configure the App Agent for Java to Interface with the AppDynamics for Databases
Oracle Collector
This topic describes how you can you link to AppDynamics for Databases from a monitored
database, server, or storage system (NetApp) that is discovered by AppDynamics and supported
by AppDynamics for Databases This integration provides access to the deep database
performance metrics provided by AppDynamics for Databases .
Prerequisites for AppDynamics for Databases Integration

To use this integration you must have an AppDynamics for Databases license.
AppDynamics for Databases must be configured to monitor the databases that you want to
link to from AppDynamics.
You need the URL of the AppDynamics for Databases server. The URL of the server is
comprised of its IP address or hostname and the port number of the server separated with a
colon. The port number defaults to 8090 when you install the server, so if you haven't
changed it, that's what it will be.
For example the URL of an AppDynamics for Databases server could
be, http://win-s7cnim71mii:8090 or http://192.168.0.27:9090
You can find the IP address of the machine where you installed the AppDynamics for
Databases server as follows:
Windows: Open a cmd window, enter "ipconfig /all". You'll see the IP address of
the server there.
Linux: Open a terminal window and enter "ifconfig -a". This command will tell
you what your IP address is. Go to http://www.wikihow.com/Check-Ip-Address-i
n-Linux for other ways to find your IP address.
In addition, if you are installing AppDynamics for Databases and the AppDynamics
controller on the same host, you may need to change the port number AppDynamics for
Databases uses because the default port number for both products is 8090. We
recommend that you use port 9090. For information about changing the port number on
AppDynamics for Databases , see Install AppDynamics for Databases and AppDynamics
Controller on the Same Host.
See Linking to AppDynamics for Databases, and Integrate and Use AppDynamics for Databases
with AppDynamics Pro for information on how to access AppDynamics for Databases from the
Controller UI.
See the AppDynamics for Databases documentation for information about using AppDynamics for
Databases.
Configuring AppDynamics to Interface with AppDynamics for Databases
To Configure AppDynamics to Interface with AppDynamics for Databases
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1. In the upper right corner of the menu bar, click Settings.
2. From the dropdown menu, click Administration.
3. Click the Integration tab.
4. Click AppDynamics for Databases in the Integrations list.

5. Check the Enabled check box to enable the integration.
6. Enter the URL and port number of your AppDynamics for Databases installation as follows:
http://<IPAddress or Hostname>:<server port number>
7. Click Save.
To Configure the App Agent for Java to Interface with the AppDynamics for Databases Oracle Collector

From a Transaction Snapshot Flow Map where the exit call is to an Oracle database, you can link
to AppDynamics for Databases to see and analyze the exact SQL that was running at the time of
the transaction snapshot. To enable this functionality, for the node containing the Oracle database,
you must set the App Agent for Java node property jdbc-dbcam-integration-enabled=true.
Configure Custom Metrics for the z-OS Machine Agent

Start the Resource Management Facility (RMF)
To initialize and start the RMF
To install the scripts
To confirm that the scripts are successful
Learn More
This topic describes how to configure custom metrics in a z-OS environment.
Start the Resource Management Facility (RMF)

AppDynamics requires the RMF (Resource Management Facility) to collect the data for the
required metrics.
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To initialize and start the RMF

1. Connect to the EPTDFRH user and initialize the ETPGZCK user, if not already done.
2. Connect to TSO and provide the details of IBMUSER.
3. Upon a successful connection, choose the SD (System Display and Search Facility) option.
4. Use the following commands to initialize and start the RMF:

/S RMF

/F RMF,START III

/S GPMSERVE,MEMBER=01

5. Access the following URL to confirm the RMF startup:

http://192.86.32.72:8803/

After successful RMF startup, the URL should display a valid HTML page.
6. Click Explore and then Metrics to display all the available metrics for SVSCPLEX, SYSPLEX.
To install the scripts

1. Download and unzip the attached zos-machine-agent.zip file to the
<machine-agent-install-directory>/monitors/ directory.
2. Select the required metric locations, and add them to urls.list file in the zos-monitor directory.
For example:
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% CPU utilization
=
http://192.86.32.72:8803/gpm/perform.xml?resource=S0W1,*,PROCESSOR&i
d=8D0460
% users
=
http://192.86.32.72:8803/gpm/perform.xml?resource=%22,SVSCPLEX,SYSPL
EX%22&id=8D0D50
% using for i/o by MVS image
=
http://192.86.32.72:8803/gpm/perform.xml?resource=%22,SVSCPLEX,SYSPL
EX%22&id=8D1DA0
% CSA utilization by MVS image =
http://192.86.32.72:8803/gpm/perform.xml?resource=%22,SVSCPLEX,SYSPL
EX%22&id=8D2410
% users by MVS image
=
http://192.86.32.72:8803/gpm/perform.xml?resource=%22,SVSCPLEX,SYSPL
EX%22&id=8D0D60

To confirm that the scripts are successful

Once the above steps are performed successfully, start the Machine Agent in debug mode.
The following information in the Machine Agent log confirms that the processing is successful.

[Worker-7] 28 Mar 2012 19:59:02,128 INFO ExecTask - Started Executable Command
[[G:\AppDynamics\64bit\3.3.4\
MachineAgent-3.3.4.0RC\monitors\CustomMonitor\metrics.bat]]
[Worker-7] 28 Mar 2012 19:59:02,128 DEBUG ExecTask - Will wait for process exit
, before sending execution status.
[Worker-1] 28 Mar 2012 19:59:04,651 DEBUG MonitorOutputHandler - Monitor line
parsed:name=Custom Metrics|zos|% CPU utilization (CP), value=3
[Worker-1] 28 Mar 2012 19:59:04,653 DEBUG MonitorOutputHandler - Reporting
metric after reading metric [Custom Metrics|zos|% CPU utilization (CP)]
[Worker-1] 28 Mar 2012 19:59:04,653 DEBUG MonitorOutputHandler - Reporting
Metric Name [Custom Metrics|zos|% CPU utilization (CP)] Value [3]
[Worker-7] 28 Mar 2012 19:59:04,654 DEBUG ExecTask - Process exited with code: 0

Learn More

App Agent for Java on z-OS or Mainframe Environments Configuration

Lite and Pro Editions
AppDynamics Lite Features
Transition from Pro Trial to
AppDynamics Lite
Learn More
Get the AppDynamics Pro Trial!

At the end of the trial period, AppDynamics Self-Service Pro Trial transitions to the free product
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edition, AppDynamics Lite. AppDynamics has retired previous versions of AppDynamics Lite.

AppDynamics Lite Features
AppDynamics Lite provides the same application monitoring and troubleshooting features as
AppDynamics Pro. The free version includes the following agents:
1 Java Agent
1 .NET Agent
1 PHP Agent
1 Node.js Agent
4 Standalone Machine Agents
AppDynamics Lite includes the following End User Experience Management features:
1 million page views a year for Web EUEM
20 monthly active users for Mobile EUEM
AppDynamics Lite restricts queries to the last 24 hours both from the user interface and via
API. To retain history greater than 24 hours, upgrade to AppDynamics Pro.

Transition from Pro Trial to AppDynamics Lite
When the trial period ends and AppDynamics detects an expired AppDynamics Pro Trial
license, the Controller resets all agents. For details about agent reset, see Resetting App
Agents.
After the reset, the Controller limits agent registration to one each of the Java Agent, the .NET
Agent, the PHP Agent and the Node.js Agent. The Controller permits the first agent of each
type to register and use a license.
AppDynamics recommends you uninstall any agents you don't use:
Uninstall the Java Agent
Uninstall the .NET Agent
Uninstall the PHP Agent
Uninstall the App Agent for Node.js

Learn More
Application Intelligence Platform

Best Practices
Operational Best Practices

Team Best Practices
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Operational Best Practices
Best Practices for Modeling an Application in AppDynamics

Modeling Your Application
Need a PDF?
in AppDynamics
Example of Optimizing for
an AppDynamics
Download: Best Practices for Modeling an
Business Application
Application in AppDynamics
AppDynamics
Components and Your
Application Environment
Nodes and Your Application Environment
Naming Nodes
Mapping Tiers to Your Environment
Naming Tiers
Tiers and Business Transactions
Mapping Business Applications to Your Environment
Multiple Business Applications
Naming Business Applications
Modeling for a Successful Failover Strategy
Learn More
Modeling Your Application in AppDynamics

AppDynamics models your application environment into a hierarchical set of business applications,
tiers, and nodes. The hierarchy is important; a node cannot belong to more than one tier, and a tier
cannot belong to more than one business application. Once you understand the model and
configure your AppDynamics business application, tiers, and nodes, you can monitor your
application traffic through all its services to correlate the information in your environment and
rapidly identify existing and potential problems.
Metrics and Correlation
When your business application is optimized, you receive useful metrics and see correlation
among different elements in your system. Otherwise, you may not be able to see how the
traffic and events inter-relate.
Business Transactions
When your business application is optimized, both auto-discovered and manually configured
business transactions accurately follow traffic through your system. Otherwise you may see
too many or too few business transactions, and they may not provide all of the information
you need.
Dashboards
When your business application is optimized, both standard and custom dashboards provide
overall views that help you accurately assess the health of the components in your system.
Otherwise, dashboards display only a small portion of the big picture.
To avoid rework, the best course of action is to optimize your configuration early in the process.
Example of Optimizing for an AppDynamics Business Application
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Later sections discuss the details of mapping AppDynamics terminology to your model, including
business applications, tiers, and nodes. The term "business application" is one of the most
important to understand. There may be a difference between the way the AppDynamics user
interface uses the term "application" or "business application" and the way you might understand
the term "application."
Let's examine a use case where you are using AppDynamics to monitor an online travel agency.
The agency manages three web sites: Flights.com, Lodging.com, and Cruises.com. In addition,
they have two backend services: an inventory system and a purchasing system for credit card
processing. Each web site communicates with each back end to fulfill their customer requests.

If you interpret the way AppDynamics uses "business application" to match the way you think of
applications, programs, or services internally, you might set up five different applications in
AppDynamics. However, because you have set up five separate applications, AppDynamics can't
correlate any traffic between them. The dotted lines below indicate inability to communicate within
AppDynamics.
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In this scenario, you might notice a high number of errors on the credit card service, but because
you have modeled your system as five separate applications, you have no way of determining
where the traffic is originating. The problem might be related to a bad node on the Cruises.com
web site, but AppDynamics has no way to give you this information.
Instead of creating five different business applications in AppDynamics, the correct approach is to
create a single business application in which each of the five local applications is modeled as a
tier. That is, think of an AppDynamics "application" as an entire business environment, not as a
single application. In the illustration below, there is one application, the Travel Booking Application,
and five tiers – three customer-facing tiers and two backend tiers.

In this model, AppDynamics can correlate the traffic between the Cruises.com tier and the
Purchasing tier and could display it in the UI, send an alert, or provide other types of visibility into
your system.
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Additionally, if you run multiple environments that don't need to communicate with each other,
such as Test and Production, it makes sense to model them as separate business applications.
Someone can be monitoring one of them without being distracted by any errors or alerts being
generated in the other one.

AppDynamics Components and Your Application Environment

The key AppDynamics components that model your environment are nodes, tiers, and business
applications, along with business transactions. By understanding the AppDynamics "world view"
you can better map your environment to AppDynamics.

Copyright © AppDynamics 2012-2014

Page 588

Nodes and Your Application Environment

The node is the simplest AppDynamics term to understand - a node represents a single JVM,
CLR, or other platform. A node is the basic unit of processing that AppDynamics monitors. A node
is normally instrumented by an AppDynamics agent, either an app agent or machine agent or both.
App agents are installed on JVMs and other platforms. Machine agents are installed on virtual or
physical machine operating systems.
Nodes belong to tiers. An app agent node cannot belong to more than one tier. A machine agent
cannot belong to more than one application; however you can install more than one machine
agent on a machine.
Naming Nodes

AppDynamics names nodes automatically based on a number of rules. Each node name must be
unique.
Consider renaming Java or PHP nodes to reflect the real-world names used in your organization.
Whenever possible make sure the names are meaningful, especially to infrastructure and NOC
personnel, who are most likely to be working directly with the nodes.
In the .NET environment, nodes are named automatically based on the application name, to
assure that the node and the application are always directly linked. AppDynamics recommends
that you don't rename .NET nodes. For more information, see Naming Conventions for .NET
Nodes.
For PHP, a PHP runtime instance maps to a node. Your naming convention may depend on your
exact environment. Some options are:
hostName-appName-nodeName
hostName-tierName-nodeName
appName-nodeName
tierName-nodeName
IP address
fully qualified domain name
In a cloud or auto-scale environment, nodes come and go regularly, so it is difficult to regularly
assign human-readable names to the nodes. In this environment, it's probably best to just let
AppDynamics give each node a unique name.
For more information see Name Business Applications, Tiers, and Nodes.
Mapping Tiers to Your Environment

An AppDynamics tier represents an instrumented service (such as a web application) or multiple
services that perform the exact same functionality, and may even run the same code. A tier
represents a key service in an application environment, such as a website or processing
application. Tiers help you logically organize and manage your business application so that you
can scale multiple nodes, partition metrics, define performance thresholds, and respond to
anomalies. The metrics from one tier tell a different story than those from another tier;
AppDynamics helps you define different policies and processes for each tier.
A tier in AppDynamics is what you may refer to as a component, a service, or a module. In other
words, a tier is any business element that has a common set of functionality and that should be
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viewable in aggregate, with no difference in the individual parts. In AppDynamics, you can view a
dashboard for an entire tier, which provides you with a different window into your system than you
might get from viewing the dashboard for each individual node in the tier.
In the AppDynamics model, a tier is composed of one node or multiple redundant nodes. For
example an Inventory tier may have one node, whereas an E-Commerce tier may use 3 nodes.
Nodes grouped into a tier may have redundant functionality or may not. An example of a
multi-node tier with redundant nodes is when you have a set of clustered application servers or
services. An example of a multi-node tier with different nodes is when you have a set of services
that do not interact with each other, though you want to roll up their performance metrics together.
The traffic in a business application flows between tiers. This flow is represented in AppDynamics
flow maps along with performance data for the traffic. There is always a tier that is the starting
point for a business transaction, indicated by a Start label on a flow map. Traffic can also flow from
a Tier to a backend, such as a database.
The number of tiers you model in AppDynamics depends on a number of factors. Some sites
might have only a few tiers, while large sites may have hundreds of tiers contained in a single
application.
Naming Tiers

As with nodes, tier names should reflect the terminology used by the teams responsible for them.
For example, if you consider a tier to be an "E-Commerce" tier, but your team members all refer to
it as the "store," then name the tier "Store," not "E-Commerce." The purpose of naming is to make
it easy for people to understand where a problem is when they are working with AppDynamics or
receive an alert. Using commonly-understood terms prevents miscommunication and delays in
dealing with problems or errors.
Typically, tiers are named for the logical purpose they serve: "Inventory", "Store", "Messaging",
"AccountsDB", etc. However, other naming schemes that you may want to consider are:
The term used for the set of servers when you discuss them in an IT meeting.
A generalized name for the functionality provided by the servers in the tier, such as LDAP,
User Management, Messaging, or ESB.
Adding information to the name to indicate its importance, type, etc. For example:
Critical - Payment Processor backend
Critical - Log on
Important - Search Flights
The name of the application layers served, such as Web, Business Logic, Resources, Data
Access.
For load-balanced nodes, you can use the virtual IP or hostname associated with the
common virtual IP.
A name consistent with your host naming convention.
For more information see Name Business Applications, Tiers, and Nodes.
Tiers and Business Transactions

The business transaction is the mechanism by which AppDynamics orders and aligns performance
indicators (response time, throughput, and so on) with the business perspective. AppDynamics
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uses business transactions to organize all user requests to represent accurately the load on your
business application and to provide diagnostic deep-dive data into requests that experience errors
or perform slower than the usual trend.
Every business transaction is defined within the context of a tier. Therefore, if you want to
optimally configure your business transactions, first model your tiers to reflect your unique
business requirements. You can create custom business transactions that apply to every tier in
your business application; in many cases it is more useful to associate specific business
transactions with specific tiers.
Business transactions represent either a category or a type of user request that depicts the
primary functions of your application. Examples of business transactions include:
In an e-commerce application, user actions such as logging in, searching for items, adding
items to the cart, etc.
In a content portal, the content sections that users navigate such as sports, world news,
entertainment, etc.
In a stock trading application, operations such as receiving a stock quote, buying and
selling stocks, etc.
To ensure visibility into your most important operations, it is critical that you optimize your business
transactions. After setting up your environment based on the recommendations in this paper, see
Best Practices for Business Transactions for more information on configuring and optimizing
business transactions.
Mapping Business Applications to Your Environment

An AppDynamics business application includes all of your application environment's services that
provide a complete set of functionality. For clarity, documentation uses the term "business
application" when explaining the AppDynamics model, to differentiate it from what you probably
envision by the word "application." In the AppDynamics user interface, however, you see the term
"application."
Think of a business application as all the web applications, databases, and services that interact or
"talk" to each other or to a shared service. In many cases a business application consists of
several local applications, as well as databases and other backend systems.
When web applications, databases, and services interact, AppDynamics can correlate their
activities to provide useful and interesting performance data when they are part of in a single
business application. If services exchange information, then they should be monitored in the
same business application; assign them the same business application name when you configure
AppDynamics agent properties during installation.
For example, suppose your company implements a shopping application environment that is
composed of an inventory application, e-commerce front end application, and databases. All of
these services interact with one or more of the others, so they should be in the same
AppDynamics business application. If you create separate business applications for each element
(inventory, e-commerce front end, etc.) you won't be able to correlate traffic between them to
identify why a problem, such as slow response time, occurs.
Multiple Business Applications
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AppDynamics lets you monitor multiple business applications; however, as explained above,
activities cannot be correlated among business applications. If you want events to correlate, make
sure the services are in the same business application.
A good example of using multiple business applications is when you have staging, testing, and
production environments for the same website. In this case, you can set up multiple business
applications, because the environments don't communicate with one another and thus no
correlation is required.
Even the largest organizations might have only one business application for their entire production
environment.
Once you have determined which applications you will monitor in AppDynamics, use the following
guidelines as you are modeling nodes and tiers:
If multiple nodes communicate with each other, put them in the same application.
If multiple nodes deploy the same code, such as in a cluster, put them in the same
application and in the same tier.
Naming Business Applications

Use the same guidelines as those that apply to naming tiers - use names everyone in your
company will recognize. Because most companies have only one business application for their
entire production environment, the business application name might be as simple as
"CompanyName" or "Production." You want to make sure that everyone who is viewing information
for the business application in the AppDynamics UI knows exactly what they are looking at. Make
the names you choose as clear and transparent as you can.
For more information, see Name Business Applications, Tiers, and Nodes.
Modeling for a Successful Failover Strategy

One additional factor to consider when modeling your environment concerns maintaining
monitoring visibility in the case of a failover operation. When you have two data centers configured
to implement a failover strategy, you must configure AppDynamics on both your main data center
and your backup data center before a failover occurs.
The hours immediately following a failover are critical, as you must ensure that the failover has
succeeded and that service has been restored via the backup data center. Obviously, if your
system is failing over, something has gone wrong somewhere - losing visibility into your system at
the same time you are diagnosing and recovering from a failover means you are "flying blind" at a
time when visibility is more important than ever.
To avoid this scenario and be fully prepared for a failover, install agents on all the nodes in your
backup data center, create the same AppDynamics business application(s) in each data center,
use the same AppDynamics configuration settings in each application, and so on. Preparing ahead
for failover assures that you will be able to have proper monitoring and alerting immediately after
failover, using the same business transactions, baselines, and other elements critical to your
monitoring model.
The need for fully implementing AppDynamics on a failover system is often overlooked. Your
AppDynamics model needs to go hand-in-hand with any failure testing plan to ensure that your
company’s strategy will work in case of a real emergency. For an overview of implementing APM
on a backup system, see this Planning for Failure with Application Performance Management blog
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post. For more specific information and instructions for configuring your backup data center to
assure successful failover, see Best Practices for Failover Scenarios for Java.
Learn More
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Delete Unwanted Business Transactions
Periodically Review the Business Transactions
Another Option: Use Service Endpoints
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Optimize Your Business Transaction Configurations for the Most Effective Monitoring

Optimally configured business
transactions are crucial to your
business, and AppDynamics
provides a suggested
methodology for developing
your own set of key business
transactions. For an overview of
what business transactions are
and how they work, see Monitor
Business Transactions.

Business Transactions
Optimally configured business transactions help
you determine which operations are important, and
focus on those operations without distraction.

Business transactions reveal a great deal about how your application is performing. Optimized
business transactions provide metrics that accurately reflect what is happening in your application
environment. When business transactions are effectively configured you can make the best use of
monitoring and alerting tools available in AppDynamics, such as Policies and Health Rules.
Effectively configured business transactions can affect how much time your team spends on
reviewing alerts. When your business transactions are configured for optimum insight into your
applications, AppDynamics reports "Slow" and "Very Slow" operations only for true outliers. You
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won't get too many alerts with no way to prioritize them, or too few alerts and miss key monitoring
information.
When it comes to business transactions, less is more. Regular monitoring of a list of ten or twenty
optimally configured business transactions is much more effective than monitoring a list of
hundreds of business transactions. To state it in the simplest terms, optimally configured business
transactions improve your signal-to-noise ratio. Business transactions that don't give you useful,
actionable information become "noise" that can lead your teams to overlook information that is
truly important to your business and, ultimately, your bottom line.
Recommended Approach to Configuring Business Transactions

A common strategy for developing a useful list of business transactions is to review those that are
auto-discovered, and then using their metrics (such as Calls per Minute) to determine which calls
represent key business transactions. While this technique is effective, you can make it even more
effective by proactively asking your stakeholders which business transactions they need to
monitor, and then you "hide" the rest. By having a very short list of business transactions,
everyone knows where to focus their time and attention.
The process of developing a short but highly relevant list of business transactions includes:
Identify the business transactions that each team has identified as important for each tier
they need to monitor.
Validate your business transaction list throughout your organization.
Configure custom configuration rules for business transactions for each tier.
Collect all other business transactions in a "catch-all" category.
Delete any unnecessary business transactions.
Review your business transactions periodically, and modify custom configuration rules as
needed.
Identify Important Business Transactions

Many AppDynamics users agree that each tier that requires business transaction monitoring is
usually an externally facing application or component, and has a relatively small number of key
business transactions that need to be carefully monitored. Some clients suggest starting with only
one business transaction per tier! By reviewing each tier with its team owners and asking them
which operations are critical to them, you can develop a list of key business transactions for that
tier.
It is also important to solicit input from product managers and other members of management
regarding important operations. Management often has a different perspective from someone who
is working with the application to address issues that occur. Remember that the goal of business
transactions is to enable everyone to focus their energy only on issues that actually require
ongoing review. It can be tempting to create a large number of business transactions just to "see
what's going on." This approach can lead to important issues getting overlooked. Instead, start
small and be selective about what you choose to monitor.
While each team may have ideas about what their key business transactions are, one easy way to
validate this is to allow a very large number of business transactions to be auto-discovered, and
then sort the list by Calls per Minute. Usually the most trafficked operations are the most critical
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ones to monitor. For example, in an E-Commerce tier, the most trafficked operations might be
Search, Add to Cart, Remove from Cart, and Pay. In a banking tier, key transactions might be
Login, Deposit, Withdraw, and Transfer.
Validate the Business Transaction List

Once the business transactions are identified, show your list to people throughout the company,
including management personnel who are not involved with day-to-day monitoring tasks. If they
understand what you have configured without asking clarification questions, you’ve done it right! If
it takes several minutes to explain what you are monitoring with a particular business transaction,
you may need to reassess whether that business transaction actually represents an operation that
your teams should be monitoring.
Configure Business Transactions

The next step is to implement custom business transaction match rules for each tier. For
organizations running websites, the match rule may be as simple as looking at the key URIs; for
example, any URI that contains the term "search" could be configured as a business transaction
named "Search."

For others, configuring different types of business transactions, such as Struts Actions, POJOs,
EJBs, or others might be appropriate.
When configuring custom match rules, you can use the Priority field to tune the way the business
transactions are discovered. Higher priority business transactions are discovered before lower
priority business transactions. 0 is the lowest priority.
Be sure to give your business transactions names that everyone at your organization will
understand. For example, don't name a business transaction "Product Lookup" if the company
refers to that functionality as "search engine 5." When looking at the business transaction list,
team members should be able to immediately identify the process or operation associated with
that business transaction.
For more detailed instructions on configuring business transactions see Configure Business
Transaction Detection.
Collect Extra Business Transactions in a "Catch-all"

After you have configured all your custom match rules, create a Catch-all rule to collect all other
website traffic; this action ensures that your final Business Transaction List is highly relevant.
Configure it to be discovered last, so your other custom business transactions get discovered first.
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To create this rule, create a custom match rule, with the following configuration:
Name it "Catch-all" or what makes sense in your organization
Use the default value for the Entry point type ("servlet" for Java, "ASP .NET" for .NET, "PHP
Web" for PHP, etc.) to catch the most common entry points
Set the Priority to "0" so that it will be the last custom match rule to execute
Set the Match value to "URI is not empty" so that any operations that don't match previous
rules will be discovered by this rule

Business transactions collected by the Catch-all rule are different from the "All Other Traffic"
business transaction that you might currently see in the Business Transaction List. AppDynamics
creates "All Other Traffic" when the number of discovered business transactions exceeds the
default maximum, as described in All Other Traffic Business Transaction. Once you optimally
configure your business transactions, you probably won't see "All Other Traffic".
Delete Unwanted Business Transactions

Once you have configured all your business transactions and AppDynamics has had time to
discover them, delete all the business transactions on the list that you no longer want to monitor.
(To delete business transactions, multi-select them, right-click, and click Delete.) When you are
through, your list should contain only the business transactions you have specifically configured.
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AppDynamics won't begin identifying business transactions based on your new custom match
rules until the existing list of business transactions is under the default maximum.
If you accidentally delete some business transactions that you in fact want to keep, don't worry.
Within a few minutes, any missing business transactions that meet your configuration
specifications will reappear on the list.
Periodically Review the Business Transactions

When you've completed the configuration process, the Business Transactions List for each tier
should be small and focused precisely on those operations that are critical to monitor. If you have
configured your Catch-all rule correctly, no other business transactions should be appearing.
However, as you’re building new code and developing new functionality over time, you may
discover that some important operations are not being displayed on the Business Transaction List.
You may also be receiving repeated alerts on Catch-all, which can be difficult track down and
resolve.
Therefore, it is useful review these "Catch-all" transactions with your teams on a regular basis,
perhaps monthly or quarterly. If there are business transactions being defined as Catch-all that
you need to track separately, create new custom match rules to define them as new business
transactions. Remember to give them a priority greater than zero.
If additional business transactions are in fact being discovered, you haven't optimally configured
your Catch-all rule. Or alternately, some operations that are being discovered because of one of
your custom match rules are no longer critical due to changes in the code or in your underlying
architecture, and you no longer need to see them on the Business Transactions List.
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In these cases, review your configuration rules and determine how to handle these transactions.
You have a few options, including:
Create or correct your Catch-all rule, then delete the unwanted business transactions from
the list, as described in Collect all other Business Transactions in a "Catch-all" category and
Delete unwanted Business Transactions.
Leave the business transaction as is.
If you decide the business transaction is in fact a useful one for your environment, do
nothing (although you might want to rename it). AppDynamics will continue to monitor it.
Add, modify, or delete a configuration rule, and then delete the business transaction.
This technique is essentially a process of tuning your configuration rules to more closely
reflect the business transactions you want to monitor.
Exclude the business transaction (right-click and choose Exclude).
Excluding a business transaction means that AppDynamics retains existing metrics for the
business transaction, but no longer monitors it. To resume monitoring the business
transaction, you can un-exclude it (click the More Actions menu and select View Excluded
Transactions). Excluded transactions do not count against the default limits. You might
exclude a business transaction if you don't want to create a rule for this transaction at the
moment, but also don't want to see it on a regular basis. You can un-exclude it at any time to
make it reappear on the Business Transactions List.
Another Option: Use Service Endpoints

In complex, large-scale applications, you as an owner of specific application services spanning
one or more logical tiers may need metrics on your specific service as opposed to metrics across
an entire business transaction or entire tier. Service endpoints allow you to obtain a subset of
metrics and associated snapshots for your service such that you can focus on the information truly
of interest to you. Using service endpoints, you can define a set of entry points into your specific
service to create a customized view in the AppDynamics UI that displays all the key performance
indicators, associated snapshots and metrics that affect only those services. You can understand
the performance of your service and quickly drill down to snapshots that affect your service,
instead of sifting through snapshots for the entire tier or business transaction.
Service endpoints are similar to business transactions except that they report metrics only at the
entry point and do not track metrics for any downstream segments. Service endpoints are not
automatically detected like business transactions are detected; you must specify the entry points
for service endpoints. Service endpoints support the same entry point types as business
transactions and you configure them in a similar way.
For more information, see Monitor Service Endpoints.
Learn More
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Adopt Proactive Monitoring with AppDynamics Alerts

When operations professionals monitor AppDynamics dashboards, they can easily see diagnostic
information on a variety of system conditions. However you cannot always be sure that someone
is watching dashboards at all times. In addition to relying on dashboards to let you know when
problems occur, you can implement AppDynamics alerts that directly inform operations staff when
an issue needs attention.
By using AppDynamics alerts effectively, you can find and fix problems before they get serious
enough to affect your customers. For example, instead of alerting when a system crashes,
AppDynamics can alert you when a crash may be imminent, such as when CPU usage is too high
or when memory is near its limit. This type of alert gives you time to diagnose and resolve the
problem, and prevent a crash from occurring.
Effective alerts can help you shift your support practices from purely reactive, responding to a
customer or internal complaint about an issue only after it occurs, to proactive, by preventing
issues from affecting users in the first place.
Adopting proactive monitoring practices has many benefits, including:
Reduction in support calls
Increased customer satisfaction
Increased revenue due to more uptime and lower response times
Increased hours of sleep enjoyed by on-call support staff
When adopting proactive monitoring practices, it is important to develop a complete alerting
strategy. The steps for doing this are:
Determine what should trigger an alert
Integrate AppDynamics into an alerting workflow
Create, test, and debug AppDynamics alerts
Resolve issues directly using remediation actions and workflow automation
Integrate AppDynamics with third-party alerting and ticketing applications
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Develop a playbook for responding to AppDynamics alerts
Determine What Should Trigger an Alert

An effective proactive alerting strategy focusses on issues that are mission-critical. Too few alerts
may result in important issues not being reported. If people get too many alerts, they may start
ignoring them. A production issue that has no impact on the underlying business should not be a
candidate for alerting, as it will create noise. Alert on issues that are worth waking someone up
for.
The process for determining what alerts to create involves working with the relevant teams to
determine their application's KPIs (key performance indicators). Based on the KPIs, define what
conditions indicate a critical issue in the production application that needs immediate attention,
and identify metrics that should trigger alerts, such as memory usage. You can also review
historical events in the application lifecycle, and consult all application owners about what they
consider critical to their success.
For example, suppose you have a "checkout" business transaction that has an average response
time (ART) of 1000 ms. Based on historical information, you know that if the ART goes over 3000
ms, customers start abandoning their carts, and if it goes over 9000 ms, customers start
contacting support or complaining on social media sites. In this example, you would want someone
to be notified if the ART approaches 3000 ms, and a larger or different group to be notified if it
approaches 9000 ms. By proactively notifying the staff who can then use AppDynamics to
diagnose the problem and get the ART down to its normal time, you increase the likelihood that
the problem will never reach a level that affects your customers and, by extension, your revenue.
Consider creating alerts for the following conditions:
The response time of a key website operation (purchase, search) is too slow.
Availability has fallen below your SLA threshold.
The error rate for a critical operation, such as Business Transaction error rate, is over 10%.
A database or remote service has stopped responding or is too slow, for example:
when a travel site needs pricing info from a hotel chain, and the call to the hotel chain
becomes very slow, or
when an LDAP server is not responding.
A JVM has crashed (see JVM Crash Guard).
You can email an alert to any person or team who needs to address the issue. For example, you
may want AppDynamics alerts to route through a centralized alerting system to your network
operations center and also a ticketing system.
You can also use alerting techniques to send what you might call "warnings" to specific people or
teams. For example, your development team may like to know when a heap is approaching its
maximum capacity. This problem might not be serious enough to warrant an immediate call to
action, but having the information would give the team a "heads-up" that they might need to review
something in their environment.
You can also create alerts specific to AppDynamics for Databases. For more information, see Alert
on Performance Metrics.
Integrate AppDynamics into an Alerting Workflow

Many organizations using AppDynamics already have an alerting workflow in place to notify the

Copyright © AppDynamics 2012-2014

Page 600

appropriate staff about a problem that needs immediate attention. For example, assume that your
current alerting process looks something like this diagram:

After integrating AppDynamics alerts into your workflow, the AppDynamics piece of the process
could look like this diagram:

After you have determined what alerts are needed, train team members how to interpret
AppDynamics alerts and how to use AppDynamics to find and resolve the problem.
Depending on the alert, a notification email might contain a node name, a tier name, a business
transaction name, and/or an application name. Teams are usually familiar with node names in
alerts; they may need to learn about other AppDynamics terminology. AppDynamics recommends
that you train NOC and other personnel by reviewing the AppDynamics interface and
demonstrating flow maps, business transactions, the app/tier/node hierarchy, and various
diagnostic techniques such as "drilling down" to find the root cause of a problem.
Remember to set up accounts and permissions
Make sure that everyone who will be receiving alerts has an AppDynamics account and the
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correct permissions to follow up on issues.
Create, Test, and Debug Email Alerts

After your teams know how to respond to AppDynamics alerts, you're ready to start setting them
up.
To implement alerting in AppDynamics, you:
Define health rules thresholds and other events that monitor critical status in your application
Create policies that trigger when that status indicates a problem is emerging
Configure actions to respond to those policy triggers.
For more information and instructions see Alert and Respond.
Customers often use the "Email" option as the action. An email notification contains a deep link to
the details of the event that triggered it. Clicking this deep link takes you directly to the place to
start troubleshooting the problem. For more information, see Email Notifications.
AppDynamics recommends that you use a staging system when you first develop AppDynamics
alerts, to verify that you are sending the optimal type and number of alerts. Create alerts that
operations staff will respond to because they know the alert reflects a serious issue.
Here are a few suggestions for setting up and verifying alerts on the staging system:
For each policy, set up an action to send an email to only yourself, or to a few core team
members.
Tune the alerts:
If you get a lot of false positives, tweak your enabling conditions to trigger fewer alerts.
Some conditions you might want to look at include: setting different threshold or
baseline values, using a different evaluation period, including more than one condition
in a health rule to narrow down when the alert will be triggered, alerting on a different
metric (such as "max" instead of "value").
Compare alerts being sent with system health information displayed in AppDynamics.
If there are issues for which alerts are not triggered when they should be, tweak your
policy conditions to send more alerts.
Route a single email alert to your central monitoring system or the NOC.
Check that it arrives; that the system routes it correctly; that NOC knows how to
resolve the issue, etc.
Once you've confirmed the alert is getting routed and addressed correctly, route all
alerts through your standard process.
When you are confident that you are sending the correct alerts from AppDynamics, explore
options other than sending emails.
Create actions related to diagnostics, running remediation scripts, etc. See the
upcoming section, Resolve Issues Using Remediation and Workflow Automation.
If you use a centralized routing platform, see the next section, Integrate with Third-Party
Alerting and Ticketing Applications.
Resolve Issues Using Remediation and Workflow Automation

Once you gain confidence in the validity of your alerts in AppDynamics, you can identify situations
appropriate for using policy-based actions that run remediation scripts. For example, you can
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restart a JVM when its CPU processing time hits 90%, instead of sending an email to a team for
them to restart it manually. You can also send them email so that they know the remediation
occurred.
Remediation can accelerate mean time to resolution (MTTR), and reduce costs by allowing
AppDynamics to take action to remediate the problem without waiting for the issue to be handled
by staff. When you are confident about what actions to take based on the type of alert, you can
configure a policy so the actions happen automatically when an appropriate alert fires. Depending
on your agent (Java, .NET, etc.) you can automatically perform diagnostics such as thread dumps
or snapshots. Performing diagnostics and also sending an email can reduce the MTTR, as the
diagnostic data is already available when they respond to the email. For more information, see Re
mediation Actions.
An additional automated resolution option is workflow automation. Workflow automation lets you
spin up or down JVMs, configure JVMs, and so on. If you are running AppDynamics in a cloud
environment, you can use the cloud auto-scaling feature to perform these same tasks in your
compute cloud. As with diagnostics and remediation, automating these tasks leaves your staff free
to concentrate on other issues. Cloud auto-scaling can also directly reduce costs; by keeping up
only as many instances are required for a particular load, you are not paying for instances that are
not necessary. For more information, see Workflow Overview and Cloud Computing Workflows.
Note: Workflow Automation and some remediation actions require the Standalone Machine Agent.
Integrate with Third-Party Alerting and Ticketing Applications

After you have built and tested an alerting workflow that incorporates the specific alerts generated
by AppDynamics, you are ready to integrate those alerts with any third-party alerting/notification
system you might already have in place. By using your existing system, your staff has a much
shorter learning curve when it comes to reacting to AppDynamics alerts. Their process changes
very little as they start to receive new types of alerts.
If you use a ticketing system to track problems, AppDynamics recommends integrating alerts into
that system as well. Linking your existing ticketing system to AppDynamics helps make it easy for
everyone to stay current with issues and their resolution, while avoiding duplication or extra data
entry work.
AppDynamics has developed a number of product extensions to integrate with third party alerting
and ticketing systems. To see a list of currently available extensions, go to the AppDynamics
Exchange and filter on the Alerting category. If you are using an alerting system that is not
available on the AppDynamics Exchange, you can build your own (see Build an Alerting Extension
) or request that AppDynamics build one (see Request an extension). For information on
integrating an extension you have built with AppDynamics, see Custom Actions.
Pull Alerts Into Other Systems Using REST

If you have a program that pulls alerts from other systems, you can use the AppDynamics REST
API to pull alerts and other events out of AppDynamics. You can do this by polling every few
minutes. Once the alerts are extracted from AppDynamics, the program can then route the alert
using information such as tier, node, or business transaction names. See Use the AppDynamics
REST API.
Develop a Playbook
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Many NOC organizations use playbooks that specify the steps for staff to take to resolve certain
types of alerts, when to escalate to a higher level of support, etc. Add the steps for responding to
AppDynamics alerts to a playbook.
For example, you might include a section on general steps to take if the issue is related to
business transactions, or to a node, tier, or application. An entry for business transactions might
say, "Display the Business Transaction List in AppDynamics and search for the business
transaction named in the email, then drill down to start looking for the root cause of the problem."
Include a link to Troubleshoot and Resolve in your playbook, for quick examples of how to
troubleshoot different types of issues.
If your system connects to external services, include instructions for addressing issues. For
example, an alert is received when an external hotel system (shown as a backend remote system
in AppDynamics) is not responding. Include information about the standard process for contacting
the external team in the playbook. The playbook might read "Send an email with the subject
'System not responding' to support@hotelSupport.com" or "Send a summary of the issue to
external_support@yourCompany.com; they will contact hotel support personnel."
Learn More
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AppDynamics in the Software Development Life Cycle

While upgrading to a new version or changing the configuration of an AppDynamics agent or
controller can be easy to accomplish, any change to your production environment may involve
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some risk. To best manage change, AppDynamics strongly recommends the following:
Install any AppDynamics modifications in your test environment before you deploy changes
to your production environment.
Make AppDynamics a standard part of your software development life cycle (SDLC) so that
you can successfully manage the process of upgrading agents, changing configurations and
other AppDynamics tasks.
Develop an operations playbook that describes consistent, repeatable procedures for
updating AppDynamics and a change log to track test and deployment activities.
Testing in a Test Environment

AppDynamics strongly recommends that you test all changes in a test or pre-production
environment.
If you don't have a test or pre-production environment, and must implement all changes directly in
a production environment, be very conservative in how you roll out any changes. In addition to
following the guidelines in this topic, take these additional suggestions into consideration.
Plan incremental deployments. For example, don't upgrade all your agents and controllers at
once; upgrade one or two and test them before implementing the rest.
Implement changes first in areas with the lowest potential business impact. For example,
verify changes in low-impact systems before deploying to those that handle payment data.
Assign additional monitoring staff for the first weeks after changes are implemented. Make
sure they have a clear path for escalating issues or rolling back changes in a timely manner.
Integrate AppDynamics Into Your SDLC

AppDynamics recommends the following process for upgrading or changing configurations:
Notify all key AppDynamics users of the intended change and review any impact to those
users.
Make changes in a test environment on a test controller (if one exists). Configure the test
environment as a separate Business Application in AppDynamics.
Monitor the environment where the change occurred for at least 1-2 weeks and ensure there
are no negative consequences to the change.
After approval has been given, push changes to the pre-production environment.
Once again, carefully evaluate for the next 1-2 weeks to ensure no problems have been
introduced by the change.
After approval has been given, perform the change in the production environment on the
production controller.
Once again, carefully evaluate for the next 1-2 weeks to ensure no problems have been
introduced by the change.
Document the changes that have been performed for later review if needed.
You may have an SDLC process that rolls out changes to your own software environment
according to your particular process. Some companies push several changes a day while others
push a few changes a year. Integrate AppDynamics into your existing process.
For example, when you deploy new application code, deploy any AppDynamics changes that have
been tested and reviewed at the same time. As you upgrade and re-deploy a tier, get the most
current versions of the AppDynamics agent and controller and include them in the deployment. In
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other words, think of AppDynamics as just one more element in your standard development
environment.
Understand the Possible Effects of Changes

There are three primary types of AppDynamics changes you could make at any time:
Adding or upgrading an agent
Upgrading a controller
Changing a configuration option
AppDynamics suggests that you review the following considerations for each of these types of
changes.
Agent Changes

You may need to deploy additional agent of the same type already deployed on your site, such as
increasing from 50 to 100 agents. Additional agents can affect the amount information being
displayed in the UI because more of your environment is being instrumented. Check the Controller
performance profiles to determine whether you need to update Controller system resources. Your
change management process should let your users know to expect this additional data.
You may need to add a new type of agent, such as adding App Agents for .NET to an environment
that already has App Agents for Java. Since AppDynamics features vary somewhat by platform,
you may want to configure similar or additional agent-specific features. For example, you might
have a Health Rule based on JVM Garbage Collection Time. If you begin monitoring .NET
applications, you could add a comparable Health Rule for CLR Garbage Collection Time.
Before upgrading an agent, read the Platform Release Notes, the Agent - Controller Compatibility
Matrix, and the agent upgrade topics:
Upgrade the Java Agent
Upgrade the .NET Agent
Upgrade the PHP Agent
Controller Changes

Because upgrading the controller involves a period of downtime, consider making controller
changes during periods of low traffic. In the ideal scenario you have multiple controllers, one in test
or pre-prod and one in production, so that you can follow standard SDLC practices and test your
changes on a non-production controller first.
Always have a backup system in place, so you can roll back to a previous controller version if
necessary. For more information see Controller Data Backup and Restore.
AppDynamics highly recommends that you implement a High-Availability (HA) environment to
minimize downtime in case of an emergency.
Before upgrading a controller, read the Platform Release Notes, the Agent - Controller
Compatibility Matrix, and Upgrade the Controller.
You can review controller logins and configuration changes in the Controller Audit Log.
Configuration Changes

Changing AppDynamics configurations can involve modifying agent behavior through the
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AppDynamics user interface, or changing controller settings through the controller admin interface
(available to on-premise customers only). These types of changes may require additional
resources.
Changing node properties, business transactions detection settings, or backend detection settings
may affect existing baselines, health rules, alerts, etc. Make sure all stakeholders review requests
for these types of changes and know how to implement them correctly.
Use an AppDynamics Operations Playbook

To ensure that changes are implemented in the least disruptive manner, write up a process
document that outlines the procedures for requesting, approving, and implementing changes. An
operations playbook helps you maintain consistent procedures, reduce risk, and retain the
knowledge through any employee turnover.
What to Include in Your Operations Playbook

Include the following types of information in your playbook:
The process for requesting a change (file a help ticket, send email to a specific team, etc.).
Who is responsible for monitoring change requests.
What actions can be taken in response to a change request.
Who decides when and what changes to implement; specifically, which persons or teams
can give the go-ahead to make a change.
Who can make what kinds of changes; who has the appropriate permissions.
Who is responsible for verifying that testing has been successfully completed.
Who can approve deploying a change to the production environment.
There are a number of types of changes that can be made, either on the hardware (i.e. who can
install a new version of the agent) or in the software (i.e. which users can access agent and
controller configuration settings). Implement permission settings as required and document your
decisions in the operations playbook.
Use a Change Log to Track the Process

Because you are deploying changes that can affect your entire business, AppDynamics
recommends a change tracking process that everyone involved agrees to follow. At any point, you
must know the status of your system and be able to roll back any change as needed.
Before making changes to agents, list every agent installed on any tier you plan to modify,
including its version number, in the change log. To see a list of existing agents, click Setup ->
AppDynamics Agents in the upper right corner of the UI.
Implement Changes According to Your Operations Playbook

Once all the necessary people have reviewed and approved the changes to be made, you can
start testing and implementing the changes. Back up any config files or settings that you plan to
change. Continue making backups as you make changes, so you can roll back any change at any
point.
Test and revise your plans as necessary, tracking any revisions in the change log, until you are
satisfied your implementation is robust. In general, a testing cycle could last for 1 to 2 weeks.
When your testing is complete, back up necessary files and settings in your production business
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application and deploy your changes out according to the process specified in your operations
playbook. To make sure everything is working as expected, AppDynamics recommends that you
periodically compare releases for a couple of weeks to monitor the revised environment. Also
periodically review the Controller Audit Log.
Review and Revise Your Operations Playbook

After you have gone through a change process, check with the team about how the process
worked and whether any steps need to be added or updated. An operations playbook is a living
document that reflects your company's work style, addresses all the pertinent issues, and provides
developers, testers, and operations professionals with all the information they need to implement
changes to AppDynamics in a timely manner.
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This topic describes how to set up AppDynamics monitoring in multiple data centers for failover
scenarios using AppDynamics App Agent for Java and Standalone Machine Agent. You configure
AppDynamics so that you can monitor your application under normal circumstances and preserve
your production-level baselines so you can continue monitoring in case of failover.
The most valuable time to have AppDynamics monitoring and alerting enabled is right after a
failover, as this is the most likely time that significant problems have occurred. The procedure that
we recommend sets up AppDynamics to use production-level baselines for your application after
failover even when the failover node has no significant load history.
You accomplish this by performing the following tasks:
Create the AppDynamics business application in each data center, using the same
AppDynamics configuration settings in each application. Configure all nodes in one data
center to point to the application for that data center.
In case of failover of production load to another data center, flip the node configuration to
point the nodes to the alternate application.
Configure Applications for Production and Backup Data Centers

Set up two data centers with exactly the same structure in terms of tiers, nodes and business
transactions. One data center is for production, the other for backup.
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Configure the App Agents for Java for both applications to use the same Controller.
In addition, configure the Application Name, Tier Name, Node Name, and Unique Host ID
properties for every app agent and every standalone machine agent in both data centers. The
Unique Host ID property provides identification for a node when you use the same node name for
multiple nodes on the same physical machine. It is absolutely required to enable the model
described here. For information on how to set it, see Unique Host ID Property.
To configure the app agents

1. Configure the Controller Host property and Controller Port property for the app and standalone
machine agents so that these settings are the identical for all the agents in both data centers. This
sets the agents in both data centers to use the same Controller.
2. Configure the app agent and the standalone machine agent Application Name, Tier Name,
Node Name, and Unique Host ID properties for the application that you will deploy at the
production datacenter and at the backup datacenter.
The Application Name and Unique Host ID properties must have different settings on the
production and backup data centers. AppDynamics recommends that you use a string, such as
"Prod", to identify one application as the production application and another string such as
"Backup" to identify the other as the backup application. Whatever convention you use, it is
absolutely necessary for the Unique Host ID properties to have different values on the production
and backup servers. It does not matter whether the Tier Name and Node Name properties are
different or the same in both data centers.
The configuration below suggests an appropriate naming scheme.
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Flip Nodes During Datacenter Failover

If data center failover occurs:
1. Rename the Application name and Unique Host ID properties in the agent configurations in the
production application to point to the backup application and vice-versa.
2. Restart the servers.
To rename the properties

1. Rename the Application Name and Unique Host ID properties of the app and standalone
machine agents for the application on the backup datacenter to the names that were originally
configured for the application at the production datacenter.
2. Reconfigure the Application Name and Unique Host ID properties of the app and standalone
machine agents for the application on the production datacenter to the names that were originally
configured for the application at the backup datacenter.
Now your app agent and standalone machine agent configurations should look like this:

To restart the servers

1. Stop each standalone machine agent process and re-start it so that it will pick up its new
properties.
2. Restart each application server.
This will restart the app agents with their new properties.
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3. Verify that the agents that were originally sending data to the backup application are now
sending the new load data to the production application and that the agents that were originally
sending data to the production application are sending new load data to the backup application.
Best Practices for Monitoring a Dynamic Cloud Environment
The Dynamic Nature of
Need a PDF?
the Cloud
Using AppDynamics in
Elastic Cloud
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the UI
Tracking Configuration Changes
Analyzing When to Add or Remove Nodes
Alerting on Dependent Services
Learn More
The Dynamic Nature of the Cloud

With more and more companies moving to a dynamic cloud environment and away from fixed size
data center installments, new challenges have arisen for monitoring cloud applications. While the
end goals (SLA, root cause analysis, etc) remain the same, some of the ways you use
AppDynamics can change to better accomplish your goals.
Applications running in the cloud tend to include components or services (which map to
AppDynamics nodes or tiers) that can come online or go offline at any time. The dynamic nature of
the cloud lends itself to dynamic processes for building and deploying applications. To assure
visibility and rapid responses to issues that occur, cloud deployments drives several new
monitoring requirements.
While using a cloud environments means that you do not directly manage hardware, it is still
critical that you understand your overall system architecture. Managers, architects, and operations
teams need to know what the current architecture is, how many components are in production and
what they are, how many nodes are running throughout the site, etc. This information is important
for managing budgets and planning for growth.
For applications using AppDynamics, a picture of the current architecture at any given time is
available in the Application Dashboard. AppDynamics automatic discovery mechanisms
continuously update the dashboard as new systems come online, so you always have an
up-to-date view.
Using AppDynamics in Elastic Cloud Environments

Dynamic cloud environments are often called "elastic" because they grow or shrink constantly
based on the load. Rapid elasticity is not possible in a data center where you have been allocated
fixed number of machines. In a cloud environment you can spin up new machines or spin down
others as needed.
Managing Nodes and Backends in the UI

Because AppDynamics continuously discovers new nodes and backends, you may want to
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configure it to better manage the visualization of them in flow maps and lists.
Reducing the List of Nodes

As machines come and go in the cloud, the list of nodes in the AppDynamics UI grows, because it
displays both used and unused nodes. By default, the Controller considers a node historical after
about 20 days of inactivity and deletes the node after 30 days. You can modify how long unused
nodes are retained in the UI. The Controller uses two retention time settings to specify what
happens to a node after it has been out of contact with the Controller for a specified period of time.
(These settings are available for on-premise Controllers only).
Node retention time (node.retention.period) specifies the number of hours (500 by default)
after which the Controller suspends certain types of processing activities for the node (such
as rule evaluation), but continues to present data for the node in the UI.
Node deletion time (node.permanent.deletion.period) specifies the number of hours after
which the node is permanently deleted from the system.
To reduce the list of unused nodes in the UI you can adjust the node retention time to a small
number, such as just a few hours. Reducing node retention time means nodes that have been
terminated will disappear from the UI in only a few hours, which enables you to focus on nodes
that are in use. If the node has just temporarily shut down, it will reappear in the UI when the node
restarts.
Eventually, unused nodes need to be removed from the system, and by default they are removed
after 720 hours. You can shorten the node deletion time to 48 hours, or whatever is a reasonable
amount of time to wait for a node to reappear in your environment. In some cases if a node hasn't
been in contact with the Controller for a long time there is probably no need to retain its data and
you can permanently delete it. For more information, see Remove Unused Nodes.
Reducing the List of Backends

Just as instrumented nodes may come and go, so may uninstrumented components such as
database or remote service backends. For example, you might have multiple caches residing on a
single dedicated backend server; that is, the server running the cache program is listening on a
number of different ports. By default, AppDynamics will interpret each of these calls/ports as
individual nodes. To reduce the number of redundant backends displayed in the UI, you can
display them all as a single node on the flow map. In this example you would create a custom
backend detection rule based on machine name. Then each time AppDynamics discovers a call to
this machine, instead of creating a new node, it will resolve the call to the same backend name, so
you only see one "cache" node in the flow map. For more information, see Configure Backend
Detection for Java or Configure Backend Detection for .NET.
Another method is to resolve specific backends into a custom tier. For example, instead of the
node-naming solution above, you can create a "Cache" tier and then use REST API automation to
resolve all calls that contain the string "cache" into that tier. For more information, see Creating
New Tiers and Use the AppDynamics REST API.
Tracking Configuration Changes

In a less dynamic application environment, flow maps do not change much from one day to the
next. When monitoring in the cloud, however, as new systems come online or go offline, the site
as a whole may be affected. In AppDynamics you can use the Compare Releases feature to track
differences between two periods of time, such as yesterday vs. today. Compare Releases can
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show subtle differences and helps you track any adverse regressions in the architecture. For
example, Compare Releases can indicate if communications from Tier A to Tier B worked well
yesterday but do not work today, and you can investigate what code change may have caused the
difference. For more information, see Compare Releases.
Another option is to mark a release using our REST API to insert a release event with relevant
information that makes sense to you. You can automate it as part of your standard processes. For
details see Application Deployment Event Integration.
Analyzing When to Add or Remove Nodes

When planning or revising your cloud management strategy, it's useful to have metrics that
indicate when you need to spin up and spin down new nodes. You can use AppDynamics automati
on to add nodes based on specified conditions, but first you need to determine what those
conditions are.
The AppDynamics Correlation Analysis feature can help you gather the information you need.
Specifically, you want to correlate node count (or app agent count) with the average response time
for each tier.
In the Correlation Analysis window compare these metrics:
X axis – Application Infrastructure Performance -> <tier name> -> Agent -> App ->
Availability (represents the number of nodes)
Y axis – Overall Application Performance -> <tier name> -> Average Response Time
The response time should be good for all levels of node counts. If response time degrades at any
level, it can mean that there are not enough nodes present at that given time to handle the load.
Use this data to investigate further. In a test environment you can create and modify a workflow for
cloud orchestration to launch new nodes under different conditions.
Through Correlation Analysis you might discover that you can actually spin down nodes earlier
than you have currently specified. If you are using an external system such as Amazon AWS to
host your cloud-based system, spinning down nodes sooner can save you money.
Alerting on Dependent Services

Cloud-based application environments are not just a series of nodes that can be allocated. Many
other services are provided as part of the cloud infrastructure. They can include a load balancer,
load scaler (which adds/removes nodes), storage system, data system, etc. In a perfect world the
cloud provider ensures those systems are up 100% of the time, and quickly alerts application
owners if is an issue. However when systems develop problems even the cloud providers may not
quickly realize the impact or identify and notify the affected application owners.
While it is not possible for you to run an AppDynamics agent on a cloud infrastructure service, it is
possible to create alerts on key performance indicators by leveraging backend detection and
custom exit points. You can capture critical dependencies, monitor the traffic, set alerts and
notifications, and exposed their status in Visualize Performance Using Custom Dashboards. For
details see Backend Monitoring and Alert and Respond.
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Introduction

Application Performance Management is sometimes considered a tool of primary use to teams
directly responsible for responding to performance issues, such as Ops or NOC. However, when
problems occur, people looking for the root cause might believe that the problem lies with the
code. Developers can use a number of features in the AppDynamics platform to determine if the
code is contributing to an issue and quickly drill down to the responsible statements or calls. Even
better, the AppDynamics platform can provide developers with insights into issues in the code
which are not currently problematic, but which could be improved in ways that can prevent
code-related problems from affecting customers in the first place.
This paper provides an overview of techniques that can provide special insights to developers,
along with suggestions on how to best use the AppDynamics platform to address and resolve
issues that occur.
Set Up a Developer Working Environment

By definition, developers need to work in an environment that pushes implementation to the limit,
sometimes breaking things to learn how to prevent problems in production. There are a few steps
you can take to make this break-and-fix cycle easier to manage, while reducing risk to code
running in production.
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Implement a Sandbox Controller

To facilitate experimentation and hands-on learning in the development environment, consider
setting up a sandbox controller for use with agents the developers deploy. Ideally this would be a
separate controller, but a separate account on your current controller can also work. This account
should have fairly open permissions, so that development teams are free to create their own
applications, tiers, and nodes, and can configure their own business transactions, service end
points, information points and other monitoring (discussed later in this paper).
If you have an on-premise controller, you may want to consider reducing the metrics.retention.peri
od property, (see Database Size and Data Retention). For example, you might reduce it to 30
days, because you may not need historical data for long periods of time in this environment.

Monitor in a Non-Production Environment With the Java Agent
Using the AppDynamics platform in a non-production environment is useful for capturing and
troubleshooting issues before you move them into production while your applications are under
development. For flexibility into the amount of visibility into your environment, the Java Agent provi
des the following monitoring levels:
Production is the normal operational mode that optimizes agent performance for your
environment, where you have set the balance between transaction visibility and overhead.
Development mode can be used in non-production environments where overhead is less
of a concern. When Development mode is enabled, the system relaxes various limits
associated with data capture. Development mode disables all limits that are intended to
reduce overhead in favor of increasing the amount of data captured, such as disabling limits
to the number of call graphs and SQL statements to capture.
Safeguards: You can configure a maximum number of calls per minute or maximum
heap utilization value where you want the AppDynamics platform to re-enable all of
the limits.
For more information, see Monitoring in a Development Environment in the latest product
documentation.

Compare Releases
You can compare metrics for two different time periods on a split screen. This feature is
particularly useful for determining how a change in the application code might affect performance,
cause or reduce errors, and so on. For example, the following illustration shows that execution
times have dropped dramatically between the two specified periods. The slowest execution time
decreased from 44148 ms to 6381 ms.
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For more information, see Compare Releases.

Use Features of Special Value to Developers
Service Endpoints

Developers often want to monitor services they own in a production environment. While business
transactions are designed to monitor end-to-end transactions that are key to the business, service
endpoints enable developers to monitor service calls independently from business transactions.
This is especially useful configured on downstream tiers, where multiple business transactions
may invoke the same services.
Configuring service endpoints is very similar to configuring business transactions. Once
configured, AppDynamics tracks metrics for the service endpoint, and captures snapshots. The
main difference is that service endpoints are not tracked across tiers.
For more information, and to see if service endpoints are supported for your platform, see Service
Endpoint Monitoring in the latest product documentation.
Information Points
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Information points enable developers to track the performance of any method call in their
application. This feature can be used to monitor the performance of individual API calls. You can
also add match conditions to monitor only certain method invocations, for example those matching
a given parameter value. In addition, information points enable you to configure custom metrics
that extract numeric data from your application so that you can monitor the data as metrics in
AppDynamics. This enables you to add additional monitoring to your application without modifying
your code. For example, you can use information points to track the sizes of queues and caches,
or the average task size.
Information points are similar to service end points, but are more lightweight because they do not
capture snapshots. Another difference is that information points can track custom metrics, while
service endpoints cannot. Information points can be used to capture business metrics or code
metrics; the latter is of most interest to developers. For more information, see Code Metrics in the
latest product documentation.
Data Collectors

Data collectors enable you to collect additional data when an AppDynamics agent captures a
transaction snapshot. A data collector can capture data from an HTTP request, or for a particular
method invocation. Use data collectors to capture diagnostic information that can help you
troubleshoot performance problems. For example, you may want to capture the user or client ID in
order to identify the user making the request. Or you may want to understand what kind of request
is being made, such as the type of booking, or the query string used in a search.
Ideally you would set up the data collectors you want ahead of time, so that the diagnostic data is
available in case you run into a production issue. But if you need to set up additional data
collectors while troubleshooting production problems, you can quickly capture a set of snapshots
by triggering an on-demand diagnostic session after you configure the data collectors. These new
snapshots will contain the data collected by the newly configured data collectors.
For more information, see Data Collectors. To understand the difference between data collectors
and information points, see Data Collectors Versus Information Points.
Techniques to Find and Resolve Issues
Proactively Monitor Slow and Error Transactions

Transactions that are slow or encounter an error can be early indicators of scalability problems.
Consider monitoring services that you own by occasionally reviewing slow and error snapshots,
even if the average response time looks normal. The snapshot call graphs can provide you with
insight into potential contention points and vulnerable code paths. After reviewing the snapshot, if
you find that the response time or error is not an issue, consider adjusting the thresholds for the
business transaction, or configuring call graphs and adding the error to the ignore list.
Tip: If the call graph is not providing you with sufficient detail to troubleshoot the root
cause of a performance problem, consider including additional packages. See Configure
Call Graphs.
You can also adjust the stall threshold for the transaction. AppDynamics captures a stack dump
when it stops monitoring the transaction. This stack dump shows the state of the transaction and
which method was in progress when the stack dump was taken. If the call is blocked, this stack
dump provides the exact location of the blocked call.
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For more information and instructions on performing the tasks in this section, see the following
topics.
Configure Error Detection
Troubleshoot Errors
Troubleshoot Slow Response Times
Call Graphs
Configure Call Graphs
Thresholds
Configure Thresholds
Troubleshoot Memory Issues

The AppDynamics Node Dashboard includes a memory tab that provides insight into JVM and
CLR memory usage. Metrics displayed include overall memory usage, the frequency of garbage
collections, and time spent by the garbage collector reclaiming unused memory. The node
dashboard also shows the memory usage of the various memory pools over time.

You can investigate a memory spike by correlating time of the spike with other activity that you
observe. For example:
Specify a time range around the time of the spike and look in the Business Transaction
Dashboard to find out which business transactions deviated from normal.
In the Tier Dashboard, examine any errors, stalls, deadlocks, or slow calls that occurred
during the time range.
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Examine a few Transaction Snapshots to see the code executing at this time and drill down
to the root cause of the problem.
To investigate problems as quickly as possible, AppDynamics can alert you when a certain
condition exists. You can create a policy based on a health rule for the condition (for example
when heap size exceeds 80%) that sends an email to the developers. See Alert and Respond.
Manage Garbage Collection

If major garbage collections occur frequently, or consume a lot of time, application latency might
increase, as many garbage collection algorithms suspend other application tasks as they compact
the memory pools. A large amount of time spent garbage collecting also affects application
throughput; CPU cycles spent on garbage collection reduce the amount of processor time
available to process user requests.
Frequent major garbage collections are also an indication that the heap may be improperly tuned.
Short-lived objects should be collected during minor garbage collections, before they get promoted
to long-lived (“old generation”) memory pools. If the memory pools reserved for short-lived (“young
generation”) objects are too small, objects may be promoted prematurely, and as a result both
minor and major garbage collections occur more frequently than needed.
Track Object Instances

Another cause of frequent garbage collection is the creation of many short-lived objects that end
up filling up the young generation memory pools. If you suspect this to be the case, you can use
the object instance tracking feature of the Java application agent to map what kinds of objects are
created most frequently. Once the object types and memory allocation patterns have been
identified, you can then start an allocation tracking session to identify the business transactions
and code paths that are responsible for the excessive object allocations.
The object instance tracking feature causes some additional overhead. We recommend
using it only in pre-production environments. If you enable it in production, monitor the
results closely and disable as soon as you have obtained needed information. This feature
is available for the Java Agent and the .NET agent.
For more information and instructions on performing the tasks in this section, see the following
topics.
Configure and Use Object Instance Tracking for Java
Troubleshoot Java Memory Thrash
Monitor Memory Usage with Object Instance Tracking for .NET

Troubleshoot Memory Leaks with the Java Agent
If you track the long-lived (old generation) memory pools over multiple major garbage collection
cycles, and observe that the minimum amount of memory used (the valleys in the graph) is
steadily increasing over time, the application may be suffering from a memory leak.
The Java Agent offers an automatic leak detection feature to help identify the source of the
memory leak. This feature tracks collections over time to identify growing collections. The
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minimum collection age and size is configurable. If a potential memory leak is found, you can
inspect the collection content or use access tracking to determine which code paths are accessing
the growing collection.
The automatic leak detection feature causes some additional overhead. We recommend
using it only in pre-production environments. If you enable it in production, monitor the
results closely and disable it as soon as you have the needed information.
For more information and instructions on performing the tasks in this section, see the following
topics.
Configure Automatic Leak Detection for Java
Troubleshoot Java Memory Leaks
Best Practices for NOC and Other Front-Line Support Staff
Monitor Key Indicators
Monitor Overall
Application Health
Monitor Business
Transactions
Monitor Tier and Node
Problems
General Node
Health
Hardware
Memory (Java)
Custom Dashboards
Learn More
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Network Operations Center (NOC) and and other front-line support staff can use AppDynamics to:
Assess overall application health by viewing key performance metrics.
Accurately identify trouble spots.
Immediately triage problems and either repair them or alert the right team.
Help the team maintain low mean time to recovery (MTTR).
Monitor Key Indicators

Custom dashboards help you quickly identify problems without showing too many details about
applications operations and development. Custom dashboards can include only the key indicators
that management wants you to monitor.
See Visualize Performance Using Custom Dashboards.
Monitor Overall Application Health

You can get an idea of overall application health by viewing the Application Dashboard.
The Application Dashboard flow map shows all the tiers (app servers) in the application and how
traffic moves between them.
For details see Application Dashboard.
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By default AppDynamics uses colors to show the health of each service: green indicates normal
operation, yellow or orange indicates a warning condition, red indicates a critical condition. By
clicking on yellow, orange, or red indicators, you can quickly pinpoint troublesome areas in need of
further investigation.
Monitor Business Transactions

AppDynamics business transactions organize application traffic into logical operations that map to
user requests, such as Login, Search, Checkout, etc. Each business transaction has its own Busin
ess Transaction Dashboard.
Open the Business Transactions List to sort business transactions by load, performance, error
counts, etc.

Tip: Immediately investigate any business transaction with an error rate over 10% or a
red icon in the Health column. A red health icon indicates that performance is
abnormally slow compared to the baseline. See Detect Anomalies Using Dynamic
Baselines.
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Monitor Tier and Node Problems

To see all the nodes (app servers) in an application:
1. In the left navigation pane click Servers -> App Servers.
2. In the View selection click the grid view icon.

AppDynamics lists of all the nodes in the application. Each node represents an app server.
You can sort the nodes in ascending or descending order based on the value of any column
header by clicking the column header.
When you identify a server with problems, double-click it in the list to see its Node Dashboard.
From the Node Dashboard you can investigate problems for a particular server in detail or you can
forward the URL of the Node Dashboard to the team that is responsible for maintaining that server.
There are three subtabs in the list: Health, Hardware and Memory.
General Node Health

While still in Grid View, in the App Servers List click the Health tab. Then click the Health column
header to sort the nodes by health so that the unhealthy nodes (red followed by yellow) are at the
top of the list.
If the health status of a node is red or yellow, double-click the node to see its Node Dashboard.
Hardware

While still in Grid View, in the App Servers List click the Hardware tab.

Sort the nodes by CPU % (avg) in descending order to see where CPU usage is excessive.
Then sort the nodes by Mem % (avg) to identify servers that are running out of RAM.
Double-click any node in which CPU % or Mem % is excessive to see its Node Dashboard.
Memory (Java)

While still in Grid View, in the App Servers List click the Memory (Java) tab. If you are running
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Java JVMs in your environment, they are displayed.
Sort the nodes by GC Time Spent in descending order to identify where garbage collection is
taking too long and possibly hindering app performance.

Tip: If a node's garbage collection time or heap % is excessive, double-click the node to
see its Node Dashboard. In the Node Dashboard's Memory tab you can get detailed
information about the server's memory usage.
Custom Dashboards

Custom dashboards help you successfully identify problems without overloading you with all the
details. Operations management can create custom dashboards for you that include only the key
indicators that they want you to monitor. See Create a Custom Dashboard. Here is an example:

Learn More

Quick Start for Operators
Troubleshoot and Resolve
Best Practices for Operations Professionals
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Monitor Overall
Need a PDF?
Application Health
Monitor Business
Download: Best Practices for Operations
Transactions
Professionals
Monitor Tiers and Nodes
General Node
Health
Hardware
Memory (Java)
Analyze Incidents
Use Policies, Health Rules, and Actions
Deep Links in Notifications
Share Deep Links
Suggestions for Customizing AppDynamics
Custom Dashboards
Executive Dashboard
Key Performance Indicator Dashboard
System Operations Dashboard
DevOps Dashboard
E-Com Hosts Dashboard
Policies and Alerts
Learn More
Operations Professionals can use AppDynamics to:
Assess overall application health by viewing key performance metrics
Accurately identify trouble spots
Immediately triage problems and either repair them or alert the responsible team
Help the team maintain low mean time to recovery (MTTR)
If you are new to AppDynamics, see Application Performance Management.
Monitor Overall Application Health

You can get an idea of overall application health by viewing the Application Dashboard.
The Application Dashboard shows all the tiers and nodes (representing app servers) in the
business application and how traffic moves between them. The bottom of the dashboard shows
key performance indicators.
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The Time Range pulldown in the upper right of the window sets the duration for the monitoring
session. Change the time range to see a larger set of monitoring data.
Color indicators show the health of each subsystem; green indicates normal operation, yellow or
orange indicates a warning condition, red indicates a critical condition. Click on yellow, orange, or
red indicators to quickly investigate trouble spots.
Monitor Business Transactions

Business transactions organize application load into logical operations that represent user
requests, such as Login, Search, Checkout, etc. Operations management can make sure that
business transactions are properly configured based on the most important user operations. See
Monitor Business Transactions.
In the Application Dashboard click the Top Business Transactions tab to quickly see business
transactions sorted by various possible performance issues.

Copyright © AppDynamics 2012-2014

Page 625

Sometimes the same business transaction has issues in multiple performance areas.
Double-click a business transaction listing to open its Business Transaction Dashboard. Look at
the Events panel to see if there are any code problems or the Transaction Scorecard for errors
and click on them. For example the Events panel can quickly reveal a code deadlock.
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Tip: Immediately investigate any business transaction with an error rate over 10% or a
red icon in the Health column. A red icon indicates that performance is abnormally slow
compared to its baseline.
Monitor Tiers and Nodes

To see all the tiers and nodes (application servers) in a business application do one of the
following to open the App Servers List:
In the left navigation panel click Servers -> App Servers.
In the Application Dashboard click Server Health.
There are three tabs in the App Servers List: Health, Hardware and Memory (Java). In any tab
click the Grid View icon to see a list of nodes.

You can sort the nodes in ascending or descending value by clicking a column header.
When you identify a slow or stalled node, double-click its listing to open its Node Dashboard. From
the Node Dashboard you can investigate in detail. You can forward the URL of the Node
Dashboard to the team that is responsible for maintaining it.
General Node Health

While still in Grid View, in the App Servers List click the Health tab. Then click the Health column
header to sort the nodes so that the unhealthy nodes (red followed by yellow) are at the top of the
list.
If the health status of a node is red or yellow, double-click the node to open its Node Dashboard.
Hardware

While still in Grid View, in the App Servers List click the Hardware tab.

Sort the nodes by CPU % (avg) in descending order to see where CPU usage may be excessive.
Sort the nodes by Mem % (avg) to identify servers that are running out of RAM.
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Double-click any node in which CPU % or Mem % is excessive to open its Node Dashboard.
Memory (Java)

While still in Grid View, in the App Servers List click the Memory (Java) tab. If you are running
Java JVMs in your environment, they are displayed.
Sort the nodes by GC Time Spent in descending order to identify where garbage collection is
taking too long and possibly hindering app performance. Sort the nodes by JVM % Heap in
descending order to see if the heap is getting too full.

For nodes in which garbage collection time or heap percentage (%) is excessive, double-click the
node to open its Node Dashboard. Click the Memory tab to see detailed information about memory
usage.

Analyze Incidents

AppDynamics reports all changes in application state as events. Click Events in the left navigation
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pane to see the list of events for the selected time range.
You can double-click any event in the list to get details about the event. In the details window that
opens you can get more information about the event. The type of information depends on the type
of event. For example, a health rule violation event produces an event summary with a button that
links to the dashboard of the affected entity at the time that the event occurred.
See Filter and Analyze Events for information about viewing events.
Use Policies, Health Rules, and Actions

Policies enable proactive monitoring, allowing you to identify and escalate problems before they
become critical. You can configure policies to alert operations staff when any event occurs.
There are default health rules that you can modify. You can create additional health rules based
on other critical infrastructure metrics. Then you match health rules violation events to actions to
take when these events occur.
Operations may also receive notifications generated by policies related to application performance
that have been created by other teams.
You can also configure actions for events that are not health rule violations. See Notification
Actions for details about configuring notifications to alert staff about health rule violations and other
events that you specify.
Deep Links in Notifications

Notifications sent by email contain deep links to details about the rule that was violated or the
event that was generated. This is an example of an alert with a deep link:

Share Deep Links

In addition to deep links in alerts, any time you are observing a dashboard or troubleshooting an
issue in AppDynamics, the URL in the browser is a deep link to a place where anyone can get a
head start investigating. For example, if you are examining a Node Dashboard for a node that is
experiencing problems, the deep link might be:
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http://demo2.appdynamics.com/controller/#location=APP_NODE_MANAGER&t
imeRange=last_6_hours.BEFORE_NOW.-1.1355787148826.360&application=4&
node=17&memoryViewMode=0

If you are examining a transaction snapshot for a stalled request, the deep link might look like this:
http://demo2.appdynamics.com/controller/#location=APP_SNAPSHOT_VIEWE
R&timeRange=last_15_minutes.BEFORE_NOW.-1.1355782673575.15&applicati
on=4&rsdTime=Custom_Time_Range.BETWEEN_TIMES.1355787536803.135578573
6803.0&requestGUID=5d994c90-a99f-419f-a6b8-61ad6b202ab1

When you escalate a problem to other teams, such as developers, email them the deep link.
These links are much more succinct and useful for troubleshooting and resolving issues than log
files and long descriptions about where to look.
Conversely, when a problem is escalated to you by another team, request the deep link provided
by AppDynamics to help you start troubleshooting.
Suggestions for Customizing AppDynamics

Organizations can use custom dashboards, policies, and alerts to customize AppDynamics for
NOC and Support staff. Customizations can focus on metrics that the organization deems
important to track and the values that define good and bad performance.
Custom Dashboards

Custom dashboards help you successfully identify problems without overloading you with all the
details. Operations management can create custom dashboards for you that include only the key
indicators that they want you to monitor. See Create a Custom Dashboard. Here are some
examples:
Visualize Performance Using Custom Dashboards
Executive Dashboard
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Key Performance Indicator Dashboard

System Operations Dashboard
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DevOps Dashboard
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E-Com Hosts Dashboard
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Policies and Alerts

Operations management can create policies that define thresholds for acceptable performance.
Policies can automatically alert you when performance crosses those thresholds.
Tip: Send email alerts generated by health rule violations to the NOC. See Notification
Actions.
You can click through on the deep link in the email alert, do basic triage, and then escalate the
problem to the right team. Include the deep link in the notification so that the next team can quickly
start working on it.
If the NOC already uses an alarming system, a more sophisticated approach is to integrate alerts
from AppDynamics into that system using custom notifications. See Custom Actions.
Learn More

Troubleshoot and Resolve
Best Practices for Performance and Quality Assurance Engineers
Compare Performance
Metrics
Compare Application Flow
Compare Critical Code
Test Load
Examine Errors and
Exceptions
Examine Memory Usage
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Monitor in a Development Environment
Learn More
Performance and QA engineers can use AppDynamics to help certify new versions of applications
before they are released to production. You can quickly detect problems and errors and discover
their root cause.
You can:
Identify performance regression.
Identify functionality regression.
Compare critical sections of code.
Perform load testing to verify response to peak load.
Discover new errors being produced by the new release.
Identify changes in memory usage that could have negative effects on the system.
Monitor code in a non-production environment, where overhead is less of a concern, to gain
better visibility.
You can create summary before and after performance reports in PDF format for management.
See Reports.
Compare Performance Metrics

Before and after the release, use the AppDynamics Metric Browser to graph key performance
metrics for each business transaction. Compare graphs taken before and after the new release.
For example, the graph below shows average response time over a twelve hour period. See Infras
tructure Metrics.

You can compare summary performance indicators (load, average response time, error rate) from
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two different time periods, by business transaction, by tier (application component) or by node
(app server). Note the difference in load and response time between the two days in the Compare
Releases window below. See Compare Releases.

Compare Application Flow

You can see changes in application flow by comparing flow maps generated before and after the
new release. You can view flow maps by business transaction in its Business Transaction
Dashboard or by tier in each Tier Dashboard.

Flow maps display the flow of traffic, the sequence of calls and their frequency, between tiers.
They can tell you if a component is calling obsolete services and if it is not calling vital services.
For example in the comparison below you can see that in addition to the difference in call rates the
CONTROLLER-MySQL DB in the Dec 6 flow map is no longer present in the Dec 8 flow map.
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Compare Critical Code

Transaction snapshots provide information about the executing code (using call graphs), the SQL
that was executed, the HTTP that was sent, cookie values, etc. Configurable settings control when
snapshots are collected. By default snapshots are collected on a periodic basis and when a
business transaction is slow or has errors.
You can analyze differences in code paths before and after a new release. See To Compare
Snapshots.
Tip: Record any changes in code that affect performance in the new release and show
them to developers. It is much faster to resolve problems if you have clearly identified
some discrepancies than just to complain that operations have slowed. You can copy a
link of the transaction snapshot to the clipboard by clicking the clipboard icon in the
upper right corner of the snapshot.
Collect snapshots of all key transactions that effect the performance in important systems. On
Java platforms you can make sure to collect some full call graphs on key operations to capture the
complete execution path of slow transactions starting from before the time that they started to
slow. See Configure Call Graphs.
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Test Load

Apply maximum load on the test system while monitoring it with AppDynamics to see how your site
performs under stress. You can use load testing tools to simulate load on your system.
You can measure how response time and CPU utilization degrades with increased load. Scalability
analysis helps you to determine the capacity that your system can support and to spot any
reduction in performance introduced with new releases. See Scalability Analysis.

Examine Errors and Exceptions

Click Troubleshoot -> Errors to view the volume of errors and exceptions that are being
produced by various tiers.
Click the Exceptions subtab to look for exceptions that were introduced by the new code. Also
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look for exceptions that are not new but are becoming more frequent. Errors that are trending up
are potentially just as serious as new errors.

Drill down to the exception detail to see the historical frequency of an exception that is new or
trending up.
To drill down on an exception:
1. Double-click the exception.
2. Click the Occurrences of this Exception tab to see all the occurrences in the selected time
range.
3. Click the Stack Traces for this Exception tab to see a stack trace.

Examine Memory Usage

Another important regression to monitor is memory usage for each node.
Click the Memory tab in the Node Dashboard to analyze:
The type of garbage collection strategy being used.
How often collections occur.
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How much memory is being used.

The Node Dashboard is a good place to see any changes that may have degraded performance,
such as lower heap size or a different garbage collection strategy. Any degradation this area can
lead to performance problems.
Monitor in a Development Environment

Using AppDynamics in a non-production environment is useful for capturing and troubleshooting
issues while your applications are under development before you move them into production. To
facilitate greater flexibility into the amount of visibility into your environment, AppDynamics
provides the following monitoring levels when using the App Agent for Java,
Production is the normal operational mode that optimizes agent performance for your
environment, where you have set the balance between transaction visibility and overhead.
Development can be used in non-production environments where overhead is less of a
concern. When Development mode is enabled, the system relaxes the various limits
associated with data capture. AppDynamics disables all limits that are intended to reduce
overhead in order to increase the amount of data captured, such as disabling limits to the
number of call graphs and SQL statements to capture. As a safeguard, when the load
reaches the maximum number of calls per minute you pre-defined or heap utilization
reaches the maximum value you defined for Development, AppDynamics re-enables all of
the limits.
For more information, see Monitoring in a Development Environment.
Learn More
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Troubleshoot and Resolve

Glossary
Action
Agent
Alert
Alert Digest
Anomaly Detection
Ajax Request
Application Performance Management
APM
App Server
App Agent
Application
Application Dashboard
ART
Average Response Time
Backend
Background Task
Baseline
Baseline Deviation
Baseline Pattern
BCI
Browser Snapshot
Business Application
Business Metric
Business Transaction
Bytecode Injection
Call Graph
Compute Cloud
Controller
Detection
Diagnostic Session
Discovery
Distributed Application
End User Monitoring
End User Response Time
Entry Point
Error
Error Transaction
Exception
EUM
Event
Exit Point
Flow Map
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Health
Health Rule
Health Rule Violation
High Availability (HA) Cluster
Histogram
Home Page
Hot Spot
iframe
Information Point
Instrumentation
Key Performance Indicator
KPI
Machine
Machine Agent
Managed Application
Match Condition
Node
On-Premise
Pageview
Policy
Remote Service
REST
Request
SaaS
Scorecard
Service Endpoint
Task
Tier
Tag, trace, and learn
Threshold
Trace, tracing
Transaction Correlation
Transaction Snapshot
Transaction Splitting
Workflow
Action

An action is an automatic response to an event, based on a policy. There are various types of
actions including sending alerts, taking diagnostic snapshots, remediation through scripts, cloud
auto-scaling, or custom.
Agent

AppDynamics agents collect data about application, machine, mobile, and web page performance
and report it to a Controller. AppDynamics has app agents, machine agents, mobile agents, and a
JavaScript agent. See App Agent, Bytecode Injection.
Alert
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An alert notifies a recipient list of a problem or event; by email, SMS or customized to interface
with external notification systems.
Alert Digest

An alert digest compiles alerts and sends the compilation sent by email or SMS to a recipient list at
a configured time interval.
Anomaly Detection

Anomaly detection refers to the identification of metrics whose values are out of the normal range,
where normal range is based on dynamic baselines that AppDynamics has created based on the
previous performance of these metrics.
Ajax Request

An Ajax request is a request for data sent from a page using the XHR API. This API is used to
send HTTP or HTTPS requests to a web server and to load the server response data back into the
requesting page. The Ajax request is tracked as a child of the requesting page using EUM.
Application Performance Management

Application performance management monitors and manages the performance and availability of
software applications in a production environment, focusing on relating IT metrics to business
values.
According to Gartner research, application performance management includes: end user
experience monitoring, application runtime architecture discovery and modeling, business
transaction management, application component deep-dive monitoring, and application data
analytics.
APM

See Application Performance Management.
App Server

An app server or application server provides software applications with services such as security,
data services, transaction support, load balancing, and management of large distributed systems.
Examples are a Java Virtual machine (JVM) or a Common Language Runtime (CLR).
App Agent

An application agent or app agent monitors an application server or CLR. App agents report data
to the Controller. See Node.
Application

See Business Application.
Application Dashboard

The application dashboard graphically represents high-level structural and status information for a
single business application. The application dashboard includes a flow map, grid view, summary of
key performance indicators.
ART
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See Average Response Time.
Average Response Time

Average interval between the time the user request is received by the application server and the
time that the response is returned to the application server. Does not include the network time for
the request to reach the server or the time for the response bytes to reach the caller. Different from
End User Response Time.
Backend

A backend is a software component that is not instrumented directly, but its traffic flow can be
monitored. Databases and remote services such as messaging queues are collectively known as
backends.
Background Task

A background task or a batch job is a scheduled program that runs without user intervention.
Baseline

A baseline provides a known point of reference against which performance is measured. Dynamic
baselines are based on observed performance over time. Static baselines are based on specific
values.
Baseline Deviation

A baseline deviation is the standard deviation from a baseline at a point in time. It is represented
as an integer value. Baseline deviation can be used to configure health rule conditions based on
the number of deviations. For example, you can configure a warning condition as 2 standard
deviations from the baseline and a critical condition as 4 standard deviations from the baseline.
Baseline Pattern

A baseline pattern defines the base time period of data used to create baselines. It can be a fixed
time range or rolling time range, in which the most recent x number of days is always used.
BCI

See Bytecode Injection.
Browser Snapshot

A browser snapshot presents a set of diagnostic data for an individual base page, iFrame or Ajax
request. The data reports the end-user's experience starting with the Web browser. Browser
snapshots are taken at periodic intervals and when certain performance thresholds are reached.
Business Application

An AppDynamics business application models all components or modules in an application
environment that provide a complete set of functionality. AppDynamics correlates the components'
activities to provide performance data.
Business Metric

A business metric captures data from a method's parameters or return values to report on the
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performance of the business, such as revenue per transaction or number of orders. Business
metrics are implemented using Information Points.
Business Transaction

A business transaction represents an collection of user requests that accomplish a logical user
activity, such as log in or check out, across a distributed business application. A single request is a
business transaction instance.
Bytecode Injection

Bytecode injection modifies a compiled class at runtime by injecting code into it immediately before
it is loaded and run.
Call Graph

A call graph represents the calling relationships among subroutines in an application. It makes up
a part of a transaction snapshot that is used to identify root cause of a performance problem.
Compute Cloud

A compute cloud delivers computing and storage capacity as a service. Examples are Amazon
EC2, OpenStack, etc.
Controller

A Controller collects, stores, calculates baselines for, and analyzes performance data collected by
agents. You can use On-Premise or SaaS Controllers.
Detection

Detection is the process by which AppDynamics identifies a business transaction or backend in a
managed application. Detection is also referred to as discovery.
Diagnostic Session

A diagnostic session is a session in which transaction snapshots are captured, with full call
graphs. A diagnostic session can be started manually through the user interface or configured to
start automatically when thresholds for slow, stalled, or error transactions are reached.
Discovery

See Detection.
Distributed Application

A distributed application runs on multiple computers in a network. Some of the computers can be
virtual machines.
End User Monitoring

End User Experience Monitoring (EUM) provides performance information from the point of view of
the client, whether that client is a web browser or a mobile native application. This is different from
other types of AppDynamics monitoring, which typically begin at the application server. EUM
collects a different set of metrics than the server-side app agents.
End User Response Time
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Average interval between the time that an end-user initiates a request and the completion of the
page load of the response in the user's browser. In the context of an Ajax request, the interval
ends when the response has been completely processed. Not to be confused with Average
Response Time.
Entry Point

An entry point is a method or operation in your application code that begins or extends a business
transaction. AppDynamics automatically detects business transaction entry points for common
frameworks, and you can configure entry points to customize how AppDynamics detects business
transactions.
Error

An error in AppDynamics indicates an unhandled exception in the context of a business
transaction, a logged error of the appropriate severity, or any exception called during an exit call,
which prevents the transaction from working properly.
Error Transaction

An error transaction is an error that occurred during transaction execution. An error transaction
can be caused by a logged error or a thrown exception.
Exception

An exception is a code-based anomalous or exceptional event, usually requiring special
processing. It can occur in the context of a business transaction and outside of a business
transaction
EUM

See End User Monitoring.
Event

An event represents an action or occurrence detected by the system that can be handled by the
system. There are different event types.
Exit Point

An exit point is a call from an app server to a backend database, remote service or to another app
server. AppDynamics automatically detects many exit points and you can configure custom exit
points.
Flow Map

A flow map graphically represents the tiers, nodes, and backends and the process flows between
them in a business application.
Health

Health in AppDynamics refers to the extent to which the application being monitored operates
within the acceptable performance limits defined by health rules. Health is indicated by a
green/yellow/red color scheme.
Health Rule
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Health rules allow you to select specific metrics as key to the overall health of an application and
to define ranges for acceptable performance of those metrics. You can customize default health
rules and you can create new ones.
Health Rule Violation

A health rule violation exists if the conditions of a health rule are true.
High Availability (HA) Cluster

A cluster of computers that hosts duplicate server applications with the purpose of reducing down
time. The HA cluster, also called a failover cluster, is enabled by redundant systems that
guarantee continued delivery of service during system failure.
Histogram

A histogram is a graphical representation of the distribution of data, shown as adjacent rectangles,
erected over discrete intervals (bins), with an area proportional to the frequency of the
observations in the interval.
Home Page

The Web page you see when you first log into the AppDynamics Controller, before you have
selected an application. See AppDynamics Home Page.
Hot Spot

Hot spots refers to the most expensive method calls in a transaction snapshot or process snapshot
(Node.js).
iframe

An iframe is an "inline frame", an HTML document that is embedded in another HTML document.
It is tracked as a child page using EUM.
Information Point

An information point instruments a method in application code outside the context of any business
transaction. It is used for monitoring the performance of the method itself or for capturing data from
the method's input parameters or return value.
Instrumentation

Instrumentation is the mechanism by which performance data is gathered. Agents instrument Java
or .NET applications. See Bytecode Injection.
Key Performance Indicator

Key performance indicators are main metrics that an organization uses to measure its success. In
AppDynamics, the key performance indicators are assumed to be load (number of calls and calls
per minute), average response time, and errors (number of errors and errors per minute.)
KPI

See Key Performance Indicator.
Machine
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A machine consists of hardware and an operating system. It hosts application services and it can
be virtual.
Machine Agent

A machine agent instruments a machine to report data about hardware and the network to the
Controller. AppDynamics provides both a Standalone Machine Agent and an embedded machine
agent in the App Agent for .NET. The Standalone Machine Agent functionality can be extended to
add additional metrics. The embedded .NET Machine Agent can have additional performance
counter metrics.
Managed Application

A managed application is an application with servers that are instrumented by AppDynamics.
Match Condition

A match condition frames a test consisting of a match criterion (such as a method name, servlet
name, URI, parameter, hostname, etc.), a comparison operator typically selected from a
drop-down list, and a value. Used in many types of AppDynamics configuration to specify entities
to be included in or excluded from monitoring.
Node

A node is the basic unit of processing that AppDynamics monitors. An app agent or machine agent
or both instrument a node. Nodes belong to tiers. See Instrumentation, Tier.
On-Premise

On-Premise refers to an AppDynamics Pro installation where the controller is installed on
machines at your site. Alternatively, AppDynamics offers AppDynamics Pro as an SaaS.
Pageview

A pageview is an instance of a web page being loaded into a Web browser.
Policy

A policy consists of a trigger based on events and an action respond to the event. A policy
provides a mechanism for automating monitoring, alerting, and problem remediation.
Remote Service

A remote service provides a service to a distributed application outside of the JVM or CLR.
Examples are a Java Message Service or Web Service. See Backend.
REST

The AppDynamics REST API is implemented using Representational State Transfer (REST)
Services. You use the REST API to retrieve information from AppDynamics programmatically.
Request

A request is a single instance of a business transaction; for example, 500 requests per minute for
the "Checkout" business transaction.
SaaS
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SaaS is an acronym for Software as a Service. AppDynamics provides AppDynamics Pro as an
SaaS where the controller is hosted on AppDynamics in-house machines and monitors your
applications, communicating over the internet with app server, Java, .NET, infrastructure, and
database agents installed in your environments. You can, alternatively, install the AppDynamics
Pro controller on your own equipment, an installation type referred to as On-Premise.
Scorecard

A visual summary of the performance of a business transaction within a specified time range,
covering percentage of instances that are normal slow, very slow, stalled or errors.
Service Endpoint

Service endpoints provide a subset of the metrics for a tier, focused on a specific application
service. You configure entry points for the app service and AppDynamics provides metrics and
associated snapshots specific to the service.
Task

A task codifies a unit of work as a set of instructions and is a component of a step in a workflow.
Tier

A tier represents a key service in an application environment, such as a website or processing
application. A tier is composed of one or more nodes or backends. An "originating tier" is the tier
that receives the first request of a business transaction. A "downstream tier" is a tier that is called
from another tier. See Node and Backend.
Tag, trace, and learn

Tag, trace, and learn is a methodology used for tracing code execution and discovering the
business transaction context.
Threshold

A threshold is a configurable boundary of acceptable or normal business transaction or
background task performance.
Trace, tracing

Tracing is following the execution of software code and recording information about the execution,
usually for debugging or performance monitoring purposes.
Transaction Correlation

Transaction correlation is the internal mechanism that allows AppDynamics to do transaction
tracing in modern web applications, tying together distributed components into a single entity, the
business transaction, for monitoring purposes.
Transaction Snapshot

A transaction snapshot is a set of diagnostic data for a business transaction instance across all
app servers through which the business transaction has passed, at a specific point in time.
Transaction snapshots help you troubleshoot the root causes of performance problems.
Transaction Splitting
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The process of using a dynamic value to customize how Business Transactions are identified.
Workflow

A workflow builds a sequence of steps in which each step consists of one or more tasks that are
executed on a machine instrumented by a Standalone Machine Agent.

AppDynamics Support
If you have questions about using AppDynamics please file a support ticket (http://help.appdynami
cs.com/tickets/new) and attach any logs that are related to your issue.
To get log files from the Controller, see Controller Log Files for Troubleshooting.
To get heap, histogram, and thread dumps see Controller Dump Files.

Use the Documentation Wiki
Locate Information Using Search
Locate Information Using Labels
Use Comments for Feedback
Download a PDF of the Documentation
Generate a PDF or Word File from a Page
Locate Information Using Search

There are two search boxes on most pages of the documentation site:
The search field on the right side of the top menu bar searches the entire site.
The search field in the left navigation pane searches within the current space only.
For advanced search options, go directly to the Advanced Search page.
Locate Information Using Labels

Labels are keywords or tags that are added to pages. To view the labels defined in the system,
1. Click Browse -> Labels. The wiki displays a list of popular labels.
2. Click on any label to find pages tagged with that label.
Note: Labels are handy but may not return all instances of a topic. Use Search for more
fine-grained results.
Use Comments for Feedback

AppDynamics is happy to receive your feedback!
If you have a user account on the documentation wiki, you can leave comments or questions on
pages. Scroll to the bottom of a page and click Add Comment to add a comment. Comments are
regularly monitored.
To send feedback or questions directly to the AppDynamics documentation team, click the Contac
t Us link at the bottom of the page and send us an email.
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Download a PDF of the Documentation

The entire documentation is available to download in PDF format from the Download Doc PDFs pa
ge.
Generate a PDF or Word File from a Page

1. Navigate to the page.
2. Click Tools -> Export to PDF or Tools -> Export to Word.

Controller Dump Files
Controller Troubleshooting Information Needed by the AppDynamics Support Team
To get the heap and histogram dump files
To take four thread dumps at three second intervals
Provide the AppDynamics Support Team with the files
Controller Troubleshooting Information Needed by the AppDynamics Support Team

If requested, collect the following files to send to the AppDynamics Support Team.
To get the heap and histogram dump files

Get the process id of the Controller to use in subsequent commands.
ps -ef | grep java

Get the heap dump before garbage collection using following command:
<java-jdk-install-dir>/bin/jmap
-dump:format=b,file=heap_before_live.bin <Controller_pid>

Get the histogram before garbage collection using following command:
<java-jdk-install-dir>/bin/jmap -histo <Controller_pid> | head
-200 > histo_before_live.txt

Get the histogram before garbage collection using following command:
<java-jdk-install-dir>/bin/jmap -histo:live <Controller_pid> |
head -200 > histo_after_live.txt

2. Save the generated files:
heap_before_live.bin
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histo_before_live.txt
histo_after_live.txt
To take four thread dumps at three second intervals

Using the Controller process ID, execute following command:
kill -3 <Controller_pid>

Save the
<Controller_Installation_Directory>/appserver/glassfish/domains/domain1/logs/jvm.log file.
Provide the AppDynamics Support Team with the files

heap_before_live.bin
histo_before_live.txt
histo_after_live.txt
jvm.log

Controller Log Files for Troubleshooting
Log Files that Record Possible Problems
Learn More
Use install.log and the files in the Controller logs directory to troubleshoot Controller errors.
Log Files that Record Possible Problems

The following log files may reveal errors:
install.log:
This file contains information about events of the install process such as extraction,
preparation and other post-processing tasks. It is located at
<Controller_Installation_directory>.
server.log:
This file contains log information for the embedded Glassfish application server used by the
Controller. It is located at <Controller_Installation_directory>/logs.
database.log:
This file contains log information for the MySQL database that is used by the Controller. It is
located at <Controller_Installation_directory>/logs.
installation.log:
This file contains log information about the installation specific to Install4j. It is located at
<Controller_Installation_directory>/.install4j.
Also include the entire .install4j directory and the latest <OS_Temporary_Directory>/i4j_log*,
for example /tmp/i4j_log*.
If after analyzing the logs you have questions, please file a support ticket and attach any logs that
are related to your issue. See AppDynamics Support for suggestions.
Learn More
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Controller Logs

License Information

From the top menu bar click Settings
-> License to see information about the
AppDynamics licenses installed on your system.
The License window shows the name of your customer account and the type of license (Trial, etc.)
used for the account. It lists the number of agent licenses and expiration dates.
Contact salesops@appdynamics.com with any license questions or issues.
Controller Licenses
Web EUEM License
Mobile APM License

End User Experience Management
End User Experience Management (EUEM) provides performance information from the point of
view of the client, whether that client is a web browser or a mobile native application. This is
different from other types of AppDynamics monitoring, which typically begin at the application
server. You can monitor web use, mobile use, or both, depending on your needs.

EUEM helps you determine the extent to which poor user experience may be caused by problems
in the browser or local app, or in the network, by showing you a breakdown of how much of the
total end-user time is spent requesting service and then rendering the response data. In addition,
for mobile apps it provides crash snapshots that include stack traces of the application at the time
of the crash. EUEM gives you visibility into client usage on a global basis, showing you, for
example:
where your heaviest loads originate
where your slowest end-user response
times occur
how performance varies by location
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how performance varies by client type,
device, browser and browser version, or
network connection
how performance varies by application and
application version, operating system
version, device, carrier for mobile apps
what your slowest Web requests/Ajax
requests are and what is causing the
slowdown
what your slowest mobile network requests
are and what is causing the slowdown
how application server performance
impacts the performance of your web and
mobile traffic

EUEM produces its own data set that is separate from the data reported by app agents.

This EUEM data is visible in various EUEM dashboards, beginning with this top-level combined
Web/Mobile geo dashboard, as well as in the Metric Browser. In addition, EUEM can link with
server-side business transaction information collected by the app agents to give you a complete
view of your end users' experience from the client request, through the backend, and on to the
client response.
To learn more about EUEM, see:
Since EUEM produces additional metrics, you may need to re-evaluate your current
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configuration's ability to handle the additional load. See Additional Sizing Considerations.

The EUEM Geo Dashboard
The EUEM Geo Dashboard
Using Map View
Map Actions
Configuring Map View Options
To access the map view options configuration tool
To configure circle sizes representing load or errors
To display the map control widget
To view a dark colored or light colored map
Unknown Locations in Map and Grid Views
Learn More
The EUEM Geo Dashboard lets you monitor Web and Mobile EUEM global performance from a
single dashboard.

There are also separate geo dashboards for Web EUEM and Mobile EUEM.

The EUEM Geo Dashboard
The dashboard is divided into three panels:
A main panel in the upper left that displays geographic distribution of end users on a map, if
you clicked the map view icon or on a grid if you clicked the grid view icon.
You can switch between map view and grid view by clicking these icons.
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You can expand the map panel or the grid panel to fill the entire dashboard by
toggling the expand icon in the upper right corner of the panel.
You select whether your want to view the map by total requests by location or by total
errors by location.

A panel on the right displaying:
A dropdown menu for selecting how to display key timings: as an arithmetic average,
or by percentiles.

See Configure Web Percentile Metrics and Configure Mobile Percentile Metrics for
information on setting up the percentiles you want to use.
Summary load metrics for end-user requests from Web browsers, iOS applications
and Android applications.
Graph of the summary load for the selected time range. You can click the links to see
the rates displayed in the Metric Browser.
Highest web end user response times. This list displays the slowest requests from
Web browsers. Click View All if you want to view all the page and Ajax requests. See
The Pages and Ajax Requests View for more information about this view.
Highest mobile network request times. This list displays the slowest requests from
mobile applications.
Trend graphs in the lower part of the dashboard that dynamically display:
Average Web browser end-user response time.
Average mobile network request time for each mobile platform.
Number and rate of page views with JavaScript errors from Web browsers and
number and rate of HTTP errors and network errors from mobile applications.
The metrics displayed throughout this geo dashboard are for the country currently selected on the
map or in the grid. For example, if you zoom down from World view to France in the map, the
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dashboard displays data for France.

Using Map View
The main panel in map view displays a map superimposed with circles that represent application
load or errors by country, depending on your selected view.
If your view is total requests by location, the size of a circle indicates the relative amount of traffic
in a country: the larger the circle the higher the load.
If your view is total errors by location, the size of a circle indicates the relative number of errors in
a country: the larger the circle the higher the error rate.
See Configuring Map View Options for information about how to adjust the size range.
You can hover over a point in time in any graph to get the precise values for the metric for that
moment.

Map Actions

You can perform the following actions directly in the map:
Click any country on the map to drill down into metrics for that country. The country is
colored blue to indicate that it is drilled down. To return to the world view from the country
view, click World in the left corner of the map.

Copyright © AppDynamics 2012-2014

Page 657

View summary statistics for a region by hovering over its circle.

Zoom the entire map using the slider on the left. You can also use your mouse wheel to
increase or decrease the map's zoom level.
Reposition the map by clicking and dragging it or by clicking the directional arrows in the
map control widget.

Configuring Map View Options
You can configure the dashboard display in a variety of ways:
The ranges of the circle sizes that indicate relative load or errors on the map.
Whether to display the zoom slider and Home button on the map.
Whether to display a dark or light colored map.
All of these configurations are saved for the next time you log into AppDynamics.
To access the map view options configuration tool

Click the gear icon in the upper right corner of the map or grid panel to get the configuration
window.
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To configure circle sizes representing load or errors

Adjust the max load circle size slider to make the circles ranges larger or smaller.
To display the map control widget

Check Show Map Controls. To hide them clear this check box. The map controls let you reposition
the map using arrows and zoom the map using + and - buttons. After moving or zooming the map,
if you want to return to the default zoomed out home view, click the globe icon in the center of the
map control widget.
To view a dark colored or light colored map

To view a dark colored map check View Dark Map. To view a light colored map clear this check
box.
Unknown Locations in Map and Grid Views

An unknown location is one for which the agent cannot determine the country from which the
request originated.
In map view, you may also see a location named "Unknown" in the highest request times and
highest loads panels to the right of the map.
In grid view, aggregated metrics for the unknown locations are displayed under the location name
"Unknown".
You may also see metrics reported for a location named "Anonymous Proxy". The data for
Anonymous Proxy represents the aggregated metrics from one or more private IP addresses that
the agent cannot identify

Learn More
The Web EUEM Geo Dashboard View
The Mobile EUEM Geo Dashboard
Web EUEM Metrics
Mobile EUEM Metrics
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Use the On-Premise EUEM Processor
The JavaScript and Mobile agents bundle their information into a beacon and send it to the EUEM
Cloud for processing, after which the Controller fetches the results and displays them in the UI. In
some case, however, you may wish to keep beacon processing within your own environment. In
these cases you may choose to deploy the EUEM Processor, which performs the same tasks as
the EUEM Cloud, but in an on-premise version. The on-prem version behaves exactly as the
Cloud version, with a few exceptions.

Installing the On-Premise EUEM Processor
Detailed information on installing the Processor can be found in Install the On-Premise End User
Experience Management Processor.

Configuring the On-Premise Data Store Expiration
As part of the Analytics functionality used by EUEM, the Processor stores some data, like crash
reports, in a local blob store. To make sure the Controller doesn't request data from the blob store
that is no longer there, if you wish to change the default setting of 30 days, you need to set make
sure the data expiration times in the Processor itself and in the Controller are compatible. The
value in the Processor should be at least one day greater than the value in the Controller.
Setting Data Store Expiration in the Processor

1. Open $APPDYNAMICS_HOME/eum-deploy/eum-processor/bin/onprem.propertie
s with a text editor.
2. Change the property eum.aggregator.mobile.crash.expireInDays to whatever
value you wish. The unit is days.
3. Restart the Processor.
Setting Data Store Expiration in the Controller

1. Log in to the Controller administration console using the root account password. See Acces
s the Administration Console.
http://<controller-host>:<port>/controller/admin.html

Use the root account password to access the Admin console when the Controller is installed
in single- or multi-tenant mode. If you have not set this password, call AppDynamics Support
to get the default password.
2. Click Controller Settings.
3. Change the data expiration property events.retention.period to a value that is least
one day less than the value you set in onprem.properties. The unit for this property is h
ours.
4. Save your change.
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Updating the Processor Geo Server
The On-Premise Processor ships with MaxMind's IP geo lite database for managing geo-location
of IP addresses. The first Tuesday of every month MaxMind updates the database. To keep your
version of the database current, you need to update your copy of the database manually To do
this:
1.
2.
3.
4.
5.
6.
7.

Go to the MaxMind web site, http://dev.maxmind.com/geoip/legacy/geolite/.
Download a binary copy of GeoLite City.
Unzip the downloaded file to get GeoLiteCity.dat.
Rename the file to GeoIPCity.dat.
Stop the Processor.
Copy the new GeoIPCity.dat to <Processor-install-dir>/bin, replacing the old copy.
Restart the Processor.

Web EUEM
Web End User Experience Management (Web EUEM) allows you to see how your web application
is performing from the point of view of your end user. You can answer questions like:
Which 1st or 3rd party Ajax or iframe calls are slowing down page load time?
How does server performance impact end user experience in aggregate or in individual
cases?
You can drill into the data to explore how users experience your application in their Web browsers.

Using Web EUEM to Monitor your Application
Web EUEM offers multiple ways to look at your data, in real time. You can:
Understand and improve your web page's performance
Know how your pages, Ajax requests, and iframes are performing over time. See The
Pages and Ajax Requests View.
Gain insight into individual requests, with detailed charts on how your pages, Ajax
requests, and iframes load and build in your end user's browsers, with links, if
enabled, to reports on server-side performance. See Browser Snapshots.
Find your worst performing pages by multiple common metrics. See Top Pages.
Reduce errors
Learn which pages are loading with JavaScript errors, and the script file and line
number that are creating the problem. See Browser Snapshots.
Learn about your users
See how your web users are connecting to your application, by device/platform and
browser. See Usage Stats.
Find out where in the world your web users are and how your application is performing
across countries and regions. See The Web EUEM Geo Dashboard View and Usage
Stats.
For more information on using EUEM for monitoring, see Monitor Your Applications with Web
EUEM.
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How It Works

Setting Up and Configuring Web EUEM
Web EUEM is easy to set up. It is also highly configurable. You can:
instrument your application to work with Web EUEM. For more information, see Set Up
Your Application for Web EUEM.
set up how your information appears in the Controller UI. For more information see Configur
e the Controller UI for Web EUEM.
customize your deployment. For more information, see Customize Your Web EUEM
Deployment.
For more information on setting up Web EUEM, see Set Up and Configure Web EUEM.

Licensing and Enabling Web EUEM
Web EUEM requires a separate license, and must be enabled before it is available for use. Until it
is enabled it does not appear in the left navigation bar of the Controller UI.
For information about licensing, see Web EUEM License.
For information on enabling or disabling EUEM, see Set Up and Configure Web EUEM.

Learn More
End User Experience Management

Monitor Your Applications with Web EUEM
Web EUEM presents information in five ways:
As a map-based dashboard, for overview monitoring
As detailed lists of all page, Ajax, and iframe requests types
As snapshots of individual requests with customizable break-outs of information for both
typical and problem requests
As overview usage statistics by browser and device/platform
As multi-faceted data from a complete data store
The Web EUEM Geo Dashboard

The Web EUEM Geo Dashboard view provides high level insight into how your application is
performing across the world. The size of a dot indicates the number of page views or Ajax
requests from that region, and the color indicates the average End User Response time in that
region (red is slow). You can click to drill down to areas of specific interest. You can also see the
same information presented in tabular form by clicking the grid icon in the upper left of the panel.
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For more information, see The Web EUEM Geo Dashboard View.
Pages & Ajax Requests

The Pages & Ajax Requests view shows you detailed lists of how each of your pages, Ajax
requests, and iframes are performing over time. You can look at All Pages or select Top Pages to
see the worst performing pages sorted by common metrics like Page views with JavaScript Errors
and First Byte Time. And you can drill down to a graphical dashboard showing a wide range of
charted performances characteristics for any specific request type.
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For more information, see The Pages and Ajax Requests View.
Browser Snapshots

The Browser Snapshot view provides access to detailed information for individual requests, either
based on real user actions, or, in beta, synthetic agents. The list includes both periodic snapshots
of requests operating within normal boundaries and problem snapshots of requests that have
exceeded one or more configurable performance criteria. Double-clicking a specific item takes
you to a detailed graphical representation of the execution flow of that request and other data
associated with it.
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For more information see Browser Snapshots.
Usage Stats

The Usage Stats view presents aggregated usage data based on the browser type and
device/platform employed by your users. The view also breaks out performance by type and usage
by country.

For more information, see Usage Stats.
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Analyze - Beta

The Analyze view allows you to query a repository of every single event that Web EUEM has
collected.

For more information, see Analyze Web EUEM.
Enabling Web EUEM

Web EUEM requires a separate license, and must be enabled before it is available for use. Until
Web EUEM is enabled it does not appear in the left navigation bar of AppDynamics GUI.
For information about licensing, see Web EUEM License.
For information on enabling or disabling EUEM, see Set Up and Configure Web EUEM.
The Web EUEM Geo Dashboard View
The Web EUEM Geo Dashboard
How the Web EUEM Geo Dashboard is Organized
Using Map View
Geographic Drill-Down
Map Actions
Configuring Map View Options
To Configure the Map
Unknown Locations in Map and Grid Views
Learn More
There are four Geo Dashboards in EUEM:
The overall Web/Mobile Geo Dashboard
The Web EUEM Geo Dashboard
The iOS Geo Dashboard
The Android Geo Dashboard
This topic discusses the Web EUEM Geo Dashboard.
The Web EUEM Geo Dashboard

You access the Web EUEM Geo Dashboard by selecting the application and clicking End User
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Experience -> Web in the left navigation bar and making sure the Geo Dashboard tab is selected.
All Geo Dashboards display key EUEM performance metrics by geographic location. You can
quickly see which regions have the highest loads, the longest response times, and the most
errors. You can understand at a glance which locations are active and of the active locations,
which are slow. Then you can use this information to drill down into more detailed information for
the slowest regions. Green circles indicate normal user experience, yellow warning, and red
critical.
For example, in the Dashboard below you can see that the highest end-user response time (which
implies the worst end-user experience) is currently in Australia, with France second, and the
highest load (number of total page requests) is in China.

How the Web EUEM Geo Dashboard is Organized

The dashboard is divided into three panels:
A main panel in the upper left displaying geographic distribution of end users on a map, if
you selected the map view icon, or on a grid if you clicked the grid view icon.
You can switch between map view and grid view by clicking these icons.
You can expand the map panel or the grid panel to fill the entire EUEM Dashboard by
toggling the expand icon in the upper right corner of the panel.
A panel on the right displaying:
A dropdown for selecting how to display key timings: arithmetic averages or
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percentiles.
Summary metrics for the selected time range: End User Response Time, First Byte
Time, HTML Download and DOM Build Time, and Resource Fetch Time. Click the En
d User Response Time link to see this metric in the Metric Browser and
compare/correlate with other metrics as you wish.
Regions with highest end user response times.
Regions with the highest load (total number of requests for the selected time range)

A lower panel dynamically displaying graphs of key performance indicators (KPI):
The number and rate of page requests (load)
Average end user response time,
Number and rate of page views with JavaScript errors

The metrics displayed throughout the dashboard are for the region currently selected on the map
or in the grid. For example, if you zoom down from world view to France in the map, the summary
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panels and the trend graphs display data for France.
See Web EUEM Metrics for definitions of the metrics.
Using Map View

The main panel in map view displays a map superimposed with circles that represent average end
user experience by region.
Geographic Drill-Down

You can hover over any region on the map to get summary metrics for that region.

Right-clicking lets you access browser snapshots for the region. See Browser Snapshots.

You can double-click any region on the map to drill down into metrics for that region.
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When you drill down into the countries with the the highest levels of monitored traffic, a detailed
map with the country's subregions is displayed. You can then drill down further into the
subregions.

For locations for which detailed maps are not available, the country or region is colored blue to
indicate that it is drilled down. Even when detailed maps are not available for subregions, EUEM
metrics are still collected and reported for the supported subregions in the summary panels and
trend graphs.
For a complete list of the supported regions by country see Web EUEM Countries and Regions by
Geo Dashboard.
Map Actions

You can perform the following actions directly in the map:
Zoom into and drill down to a subregion in the map by clicking on the subregion.
To zoom out to restore the currently selected region to the world or country, click the
link in the location control in the upper left corner of the map. For example, if you have
drilled down to India and then to West Bengal and now want to return to global view,
select "World" in World > India > West Bengal.
View summary statistics for a region by hovering over its circle.
Zoom the entire map using the slider on the left. You can also use your mouse wheel to
increase or decrease the map's zoom level.
Reposition the map by clicking and dragging it or by clicking the directional arrows in the
map control widget.
Configuring Map View Options

You can configure the dashboard display in a variety of ways:
The metric to use for creating the colored circles:
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End user response time
First byte time
Front end time
The ranges for values that trigger the performance indicator colors on the map
The circle sizes that indicate relative load on the map
Whether to show:
Map Controls
The US States in the global view
The Dark view of the map
All of these configurations are saved for the next time you log into AppDynamics.
To Configure the Map

1. In the Geo Dashboard, click the gear icon in the upper right corner of the map or grid panel to
get the configuration window.

2. Select the value you want the load circles to represent.
3. Adjust the color thresholds by using one of the following two methods:
Adjust the threshold slider.
For example, if you want circles to be red whenever the end user response time is 182
milliseconds or greater, slide the maximum value of the yellow slider value to 182.
Edit the threshold slider to set specific values. Double-click the text field that indicates the
slider threshold value to make it editable, enter the value of the threshold in the text field,
and press the tab key.
For example, the following example sets the maximum yellow slider value to 500.

You can enter as large a value as you like in the field (larger than the current maximum
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displayed value of the slider) and displayed range of values for the circle color ranges will
adjust accordingly.
3. To configure circle sizes representing load (total number of end user requests), adjust the slider
to make the circle ranges larger or smaller.
4. To display the map control widget, check Show Map Controls. To hide them clear this check
box.
The map controls let you reposition the map using arrows and zoom the map using + and buttons. After moving or zooming the map, if you want to return to the default zoomed out home
view, click the globe icon in the center of the map control widget.
5. To show the individual state boundaries in the United States in global view, check Show US
States in global View.
Metrics for individual states are displayed as if they were countries. Click the state in the United
States map to display EUEM data for that individual state.
6. To view your map with a dark colored background, check View Dark Map.
Unknown Locations in Map and Grid Views

Requests can originate from locations for which the JavaScript agent has no map data. These
requests are labeled as Unknown.
You may see this message at the bottom of the map when you are drilled in on a country for which
EUEM does not have regional data:
"Geographic information for some requests is unavailable and is not displayed on the map; switch
to grid view for unknown regions."
In the map view, you may also see a location named "Unknown" in the highest response times and
highest loads panels to the right of the map.
In grid view, aggregated EUEM metrics for Unknown locations are displayed under the location
name "Unknown".
The number of Unknown entries displayed depends on the current map settings:
If the map is set to world view and the Show US States in global view option is selected,
you may see two Unknown entries: one for the aggregated metrics from the unknown
countries and another for the unknown states.
If the map is set to world view and the Show US States in global view option is clear or if
the map is set to country view, there is a single Unknown entry which displays the
aggregated metrics from the unknown regions in the current country. For example, if there
are three unknown regions in Russia reporting metrics, the entry for Unknown represents
the aggregated metrics for those three regions.
You may also see a metric reported for a location named "Anonymous Proxy". The data for
Anonymous Proxy represents the aggregated metrics from one or more private IP addresses that
the JavaScript agent cannot identify.
One of the effects of Unknown regions is that it possible for a country to display as slow (red
circles) on the global map, but when you drill down to the country all its regions appear normal
(green circles). Or a country may display as normal on the global map, but some subregions may
display as slow when you drill down.
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Learn More

Dashboards
Web EUEM Metrics
Browser Snapshots
Set Up and Configure Web EUEM
Customize Your Web EUEM Deployment
Host a Geo Server
The Pages and Ajax Requests View

What is a Page?
Types of Pages
Using the Pages & Ajax Requests View
Accessing the All Pages Tab
How the All Pages List is Organized
Accessing Top Pages
More Actions Menu
Page Limits
Learn More
What is a Page?

In Web EUEM a page represents an individual source for the information that an end-user sees in
a single browser window.
Types of Pages

A base page is the core HTML page.
A base page may also include one or more iframes, which can be nested.
A base page or an iframe can also make one or more Ajax requests to fetch data to display on the
Web page.
You can collect Web EUEM metrics for base pages, iframes and Ajax requests.
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Each base page, iframe, and Ajax request type is assigned a unique name. Each page type has a
dashboard that graphically displays key metric information for that specific item, based on its type.
Using the Pages & Ajax Requests View

The Pages & Ajax Requests view has two tabs: the All Pages tab and the Top Pages tab. The
All Pages tab displays a list showing a high-level summary of all the monitored base pages,
iframes, and Ajax request types in the application, along with their key performance indicators. The
Top Pages tab displays the ten worst performing items grouped by common metrics - Requests
per Minute, Page Render Time, and so forth. Use this tab for a quick start to troubleshooting.
Accessing the All Pages Tab

To access the All Pages list:
1. In the left navigation bar, click End User Experience -> Web
2. Select the Pages & Ajax tab
The All Pages tab is displayed.
How the All Pages List is Organized

Each monitored base page, iframe and Ajax request type is displayed in the list.
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The Name column shows the name of the item as it is configured, always in lower-case. See Confi
gure Page Identification and Naming for information on how to configure page names.
The Type column indicates whether the row represents a base page, iframe or Ajax request.
The remaining columns report EUEM metrics for the items. See Web EUEM Metrics. You can
specify which metrics to display by clicking View Options.
Click a column header to sort the pages based on the column's metric. For example, if you want to
sort the slowest pages in terms of Page Render Time with the slowest pages at the top of the list,
click the Page Render Time column header. You can toggle the column to switch between
ascending and descending order.
To view the page dashboard for a specific page, select the page and click View Dashboard or just
double-click the page. See Page, Ajax, and Iframe Dashboards for more information.
To filter the types of pages displayed in the list, select the type at the top of the list. For example,
to see only Ajax requests, select Ajax Requests and clear Pages and IFrames. You can also use
the With Load checkbox to see only pages that have load in the selected time frame.
Accessing Top Pages

Click the Top Pages tab as a shortcut to troubleshooting the ten worst performing pages in terms
of various metrics.
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Click on an item in one of the lists to display the dashboard for the item. Click View All to return to
the unified list of all the pages.
More Actions Menu

In the More Actions menu in the All Pages tab, you can select a page in the list and perform the
following actions on that page
Exclude: Use this option to direct the agent to ignore this page and stop reporting metrics
for it.
You can use the View Excluded Pages option to see pages that have been excluded and
then you can "unexclude" them.
Rename: Use this option to rename the page in the console.
Delete Item: Use this option to remove the page from the list. If the agent discovers the
page again it will reappear in the list. To prevent it from re-appearing use Exclude.
View Excluded Pages: Use this option to see pages you have previously excluded.
Page Limits

There is a limit of 500 total base pages + iframes and 500 Ajax calls that can be individually
tracked per application. If your usage exceeds these limits, the Controller begins to drop metrics.
If your installation is approaching these limits, you can modify how your metrics are collected by:
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limiting the number of pages you instrument. If you are using manual injection, remove the
JavaScript agent from pages that are less important. See Set Up Your Application for Web
EUEM for more on injection types. If you are using automatic injection, create request match
rules and request exclude rules to restrict injection to pages that meet certain criteria. See T
o Create Match Rules for Automatic Injection.
using custom naming rules to group similar pages together. See Configure Page
Identification and Naming.

Learn More
Page, Ajax, and Iframe Dashboards
Configure Page Identification and Naming
Dashboards
Web EUEM

Page, Ajax, and Iframe Dashboards

Accessing These Dashboards
Full Dashboard Breakdowns
Learn More
Dashboards provide simple click access to a graphic representation of End User Experience
Management (EUEM) metrics for pages, iframes and Ajax requests types. Use them to gather an
understanding on how each part of your application is performing overall.
Each page, iframe, and Ajax request type has its own dashboard.
Accessing These Dashboards

To view a dashboard for a page, iframe or Ajax request type:
1. Select your business application.
2. In the left navigation bar, click End User Experience -> Web
3. Select the Pages & Ajax Requests tab.
AppDynamics displays the request list.
4. From the list select the page, iframe or Ajax request in which you are interested.
5. Either double-click on the item or click View Dashboard.
Full Dashboard Breakdowns

The Page and Iframe Dashboards
The Ajax Dashboard

Learn More

Web EUEM
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Dashboards
Web EUEM Metrics
The Pages and Ajax Requests View
Browser Snapshots
The Page and Iframe Dashboards

The Summary Section
Overall Performance
Server Connect
Server Time
Browser Render Time
Page Resources Requested
Learn More
Page and iframe Dashboards are divided into six areas:
A summary, with a waterfall graph of the entire load sequence. To see details for each set
of data, use the Trends/Details checkboxes. to see browser snapshots associated with this
item, click View Snapshots For This Page.
Four sections of Trends/Details across time for the main performance categories
Overall performance
Time between the request and the first byte of the response
Time taken by the server to process the request through the completion of the HTML
download for the item
Time taken to process and render the item, including any external resources, in the
browser
Detailed information on the performance of Ajax requests and iframes for this item
The Summary Section

This section gives you a quick overview of the item's performance over time.
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Key performance indicators - End User Response Time, Load, Cache Hits, and Page Views with
JS errors - across the time period selected in the time frame dropdown from the upper right side of
the GUI -

are displayed across the top of the summary area.
A waterfall graph displays the average times needed for each aspect of the page load process.
For more information on what each of the metrics measures, hover over its name on the left. A
popup appears with a definition. For more detailed information, see Web EUEM Metrics.
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To see detailed breakouts of the data behind the graph, check the Trend/Detail box by the data
group in which you are interested. To turn the details off, uncheck.
Some metrics - for example, TCP Connection Time - only appear if they have a non-zero value.
Overall Performance

This section displays detailed trend graphs of key performance metrics measured across time,
based on the time period selected in the timeframe dropdown. To see detailed information for a
specific moment, hover over the graph and a popup with that information appears.
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To see any of the listed total metrics in the context of the metric browser, click the desired value
(shown in link blue) on the left side of the panel. The metric browser appears, with that metric
displayed. You can then use the metric browser to compare other related values in a single
display.
Server Connect

This section displays detailed trend graphs of initial server connection metrics measured across
time, based on the time period selected in the timeframe dropdown. To see detailed information
for a specific moment, hover over the graph and a popup with that information appears. These
metrics measure:
the time the user's request takes in negotiating its initial connection with the server, which
may include broken-out DNS, TCP Connect, and SSL/TLS time. The Total Server Connect
value is always displayed.
the time between that initial connection and the time the first byte of information is returned
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back to the user's browser

To see any of the listed total metrics in the context of the metric browser, click the desired value
(shown in link blue) on the left side of the panel. The metric browser appears, with that metric
displayed. You can then use the metric browser to compare other related values in a single
display.
Server Time

This section displays detailed trend graphs of server processing and delivery time, based on the
time period selected in the timeframe dropdown. To see detailed information for a specific
moment, hover over the graph and a popup with that information appears. These metrics measure:
the total time for processing all server-side business transactions for this item
the total time for the browser to completely download all the HTML document content
if correlated with a server-side app agent, related business transactions on the server
To ensure you get the most accurate server time and related business-transaction times,
upgrade your server agents to version 3.8.0 or newer. Otherwise in some cases your times
will be based on averages rather than the exact time of the individual event. To get the
most accurate times using pre-3.8.0 agents, you should enable JS_FOOTER injection,
either through using Automatic Injection or Assisted Injection-Using Attribute Injection.
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To see any of the listed total metrics in the context of the metric browser, click the desired value
(shown in link blue) on the left side of the panel. The metric browser appears, with that metric
displayed. You can then use the metric browser to compare other related values in a single
display.
Browser Render Time

This section displays detailed trend graphs of the time taken to render the final item, based on the
time period selected in the timeframe dropdown. To see detailed information for a specific
moment, hover over the graph and a popup with that information appears. These metrics measure:
the time taken by the browser to create the DOM from the end of the HTML download
the time taken to fetch any external resources, for example the results of a third party Ajax
request

To see any of the listed total metrics in the context of the metric browser, click the desired value
(shown in link blue) on the left side of the panel. The metric browser appears, with that metric

Copyright © AppDynamics 2012-2014

Page 683

displayed. You can then use the metric browser to compare other related values in a single
display.

Page Resources Requested
This section displays detailed graphs of when in the page load cycle individual external - first and
third party - resources are fetched, and how much time is taken to fetch them, all based on the
time period selected in the timeframe drop down. To see detailed information for a specific
moment, hover over the graph and a popup with that information appears. These metrics measure:
average time and load associated with that resource
whether the request is blocking or non-blocking
the request and response time per resource request
the type - iframe or Ajax - of the resource

To see the dashboard for any of the listed resources, click the name.
Learn More

The Ajax Dashboard

The Ajax Dashboard

The Summary Section
Overall Performance
Server Time
Learn More
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The Ajax Dashboard is divided into three areas:
A summary, with a waterfall graph of the entire load sequence. To see details for each set
of data, use the Trends/Details checkboxes.
Two sections of Trends/Details across time for the main performance categories
Overall performance
Time taken by the server to process the request through the browser's incorporation
of the data into the HTML document
The Summary Section

This section gives you a quick overview of the item's performance over time.

Key performance indicators - End User Response Time, Load, and Ajax Request Errors - across
the time period selected in the time frame dropdown from the upper right side of the GUI -

are displayed across the top of the summary area.
Check the With Load checkbox to only see data based on current load.
A waterfall graph displays the average times needed for each aspect of the ajax request load
process.
For more information on what each of the metrics measures, hover over its name on the left side
of the graph. A popup appears with a definition. See the graphic above for an illustration. For
more detailed information, see Web EUEM Metrics.
To see detailed breakouts of the data behind the graph, check the Trend/Detail box by the data
group in which you are interested.
Overall Performance
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This section displays detailed trend graphs of key performance metrics measured across time,
based on the time period selected in the timeframe dropdown. To see detailed information for a
specific moment, hover over the graph and a popup with that information appears.

To see any of the listed total metrics in the context of the metric browser, click the desired value
(shown in link blue) on the left side of the panel. The metric browser appears, with that metric
displayed. You can then use the metric browser to compare other related values in a single
display.
Server Time
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This section displays detailed trend graphs of server processing and delivery time, based on the
time period selected in the timeframe dropdown. To see detailed information for a specific
moment, hover over the graph and a popup with that information appears. These metrics measure:
the total time for processing all server-side business transactions for this item
the time for the browser to completely download all the Ajax response
the total time for the browser to process the document response, including incorporating the
data into the HTML document
if correlated with a server-side app agent, related business transactions on the server
To ensure you get the most accurate server time and related business-transaction times,
you should enable JS_FOOTER injection, either through using Automatic Injection or Assis
ted Injection-Using Attribute Injection for at least the footer. If you cannot use one of those
injection types, you can get business transaction times, but in some cases your times will
be based on averages rather than the exact time of the individual business transaction.

To see any of the listed total metrics in the context of the metric browser, click the desired value
(shown in link blue) on the left side of the panel. The metric browser appears, with that metric
displayed. You can then use the metric browser to compare other related values in a single
display.
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Learn More

The Page and Iframe Dashboards
Browser Snapshots

Access a Browser Snapshot
Select the Browser Snapshots tab
Configure the Browser Snapshot List
Open the Snapshot
Generate a Synthetic Snapshot (Beta)
Browser Snapshot Types
Learn More
Browser snapshots capture and display a broad set of metrics associated with a single request.
You can drill down into errors, and, if your app server is instrumented with server-side app agents,
see any server-side transaction snapshots associated with that request.
When Web EUEM is enabled, the JavaScript agent collects browser snapshots for:
every base page, iframe, and Ajax request; these serve as a heartbeat snapshot
the slowest page by every region, every device and every browser
unique JavaScript errors; identified by script name and line number
unique Ajax errors; identified by the HTTP error code in the Ajax response
For more information about browser snapshot collection, Configure Browser Snapshot Collection.
Access a Browser Snapshot

To access the Browser Snapshots list, in the left navigation bar, click End User Experience ->
Web.
Select the Browser Snapshots tab

A list of available browser snapshots appears. You can change the timeframe of your search by
changing the Time Frame dropdown menu.
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Key
Normal user experience
Slow user experience
Very slow user experience
JavaScript errors. To see more information on the error, hover over the icon and a popup with
summary information appears.
Correlated server side transaction snapshot exists
Snapshot based on real user action
Snapshot based on synthetic agent action
Snapshot includes resource timing information
Configure the Browser Snapshot List

Configure sorting
Sort the snapshots by clicking a column header. For example, click the End User Response
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Time (ms) column header to sort the snapshots in descending order, with the highest
response times at the top of the list
Configure the columns to display
Click View Options to configure the columns to display in the browser snapshot list.

Filter the list
You can filter the list to display only browser snapshots that meet certain criteria. For
example, the following configuration restricts browser snapshots to JavaScript and AJAX
errors that occurred on Internet Explorer
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Open the Snapshot

Double-click the snapshot that you want to examine, or
Select the snapshot that you want to examine and click View Browser Snapshot.
Generate a Synthetic Snapshot (Beta)

Synthetic snapshots use geographically distributed agents to create snapshots of web page
download performance without the idiosyncratic and potentially skewing effects of real user last
mile performance. A subset of this functionality is available as a generally available Beta for 3.9.
See Synthetic Browser Snapshots for more information.

Browser Snapshot Types
There are three browser snapshot types, depending on whether the original object was a page, an
iframe, or an Ajax request.
Page Browser Snapshots
Ajax Request Browser Snapshots
Iframe Browser Snapshots
Learn More

Page, Ajax, and Iframe Dashboards
Transaction Snapshots
Configure Browser Snapshot Collection
Web EUEM Metrics
Configure EUEM Browser Snapshot Thresholds
Set Up and Configure Web EUEM
Set Up Your Application for Web EUEM
Add Custom User Data to a Browser Snapshot
Configure JavaScript and Ajax Error Detection
Page Browser Snapshots

Waterfall Graph
JavaScript Errors
Details
The Server Side Transaction Snapshot Flow Map, for Correlated Business Transactions
Unknown Metrics in Browser Snapshots
More on Cookies and EUEM Data
Learn More
Page-based snapshots give you a detailed look at an individual page request. The Summary tab
covers general characteristics of the page. For information on the Resource Details tab, see Page
Browser Snapshots: Resource Details.
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Waterfall Graph

The top of the page snapshot Summary tab displays a waterfall graph of the overall transaction
timing for the page. The snapshot is labeled either a Real User Snapshot or a Synthetic
Snapshot, based on the origin of the request. You can hover over each of the metrics to see a
popup definition for that metric.

For a detailed description of what these metrics mean, see Web EUEM Metrics.
Generate a Synthetic Snapshot (Beta)
Synthetic snapshots use geographically distributed agents to create snapshots of web page
download performance without the idiosyncratic and potentially skewing effects of real user last
mile performance. A subset of this functionality is available as a generally available Beta for 3.9.
See Synthetic Browser Snapshots for more information.

Related Business Transactions and Transaction Snapshots
If server-side correlation has been set up, a link to any related business transaction is shown:

Clicking the link takes you to the flow map for that business transaction on the server side.
If the business transaction created a transaction snapshot, links to the business transaction, tier,
and node flow maps is displayed, along with a direct link (
map.
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Conversely, the transaction snapshot flow map also contains a link to any related browser
snapshot. For more information, see The Server Side Transaction Snapshot Flow Map for
Correlated Business Transactions.
JavaScript Errors

If there are JavaScript errors on the page, they are displayed below the waterfall graph:

The JavaScript Errors panel shows you:
the script file that contained the error
the line on which the error occurred
any information associated with the error
You can configure errors to ignore if you are seeing too many errors that are not of interest. See C
onfigure JavaScript and Ajax Error Detection.

Details
Then detailed text-based information is shown.
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The Details panel gives you basic information about the request:
basic statistics about the page, including when the request was made, how much time it
took, and where it was fetched from
where on the web the request is from, including the originating IP address and any referring
page
what is being used to view the response
where geographically the request is from
what the request GUID is - this GUID uniquely identifies this specific request throughout the
system
any related browser snapshots, such as for an Ajax request within the page
if configured, any user data associated with this request. See Add Custom User Data to a
Browser Snapshot for more information.
The Server Side Transaction Snapshot Flow Map, for Correlated Business Transactions
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Transaction snapshots on the server are triggered when slow or stalled transactions are identified,
when a diagnostic session is started, or periodically based on a configured interval. In general,
slow, very slow and stalled transactions are more likely to trigger a transaction snapshot on the
server than transactions operating within normal range. For more information about when
server-side transaction snapshots are captured see Transaction Snapshots and Configure
Transaction Snapshots.
POJO-based business transaction snapshots
Correlating between business transaction snapshots and browser snapshots uses the
request GUID and cookies. In order for the server-side agent to be able to write the
cookies, it needs a servlet response object. In the case where the BT Entry Point is
defined by a POJO, this object will not be available unless the Configure->Instrumentatio
n->Transaction Detection->Transaction Monitoring option is Enabled for Servlets.

To return to the browser snapshot, click the Browser Snapshot link in the upper right, outlined in
red.
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Unknown Metrics in Browser Snapshots

Web EUEM captures metrics using your end-users' web browsers. Occasionally you may see
Unknown data reported for one or metrics in a browser snapshot. This occurs on older or less
sophisticated browsers that do not support collection of a given metric.
See EUEM Metrics Availability for details about which metrics may not be captured based on
browser capabilities.
More on Cookies and EUEM Data

EUEM uses two different kinds of short-lived cookies to help it collect data and correlate events:
The ADRUM cookie: written by the JavaScript agent, this cookie contains the referral page
URL and some timing information to assist gathering First Byte Time for some browser
types.
For privacy purposes, the URL of the referral page is hashed.
The ADRUM_X_Y_Z cookies: written by the server-side agent when the page is served from
an instrumented server. These cookies help correlate EUEM data with related server-side
performance data.
If EUEM detects that the page is HTTPS, the cookies are HttpsOnly. None of the cookies
contain any personally identifiable information (PII).
Learn More

Page Browser Snapshots: Resource Details
Ajax Request Browser Snapshots
Iframe Browser Snapshots

Page Browser Snapshots: Resource Details

Overview
Resource Waterfall
Domains Requested
Learn More
Page-based snapshots give you a detailed look at an individual page request. If the browser that
was used supports the Resource Timing API, the Resource Details tab gives you a detailed
breakdown for the performance of resources - scripts, css files, fonts, SVGs, and images - as they
are loaded into the page. For information on the Summary tab, see Page Browser Snapshots.
Overview

The overview panel gives you a quick summary of the number of each type of resource being
loaded and the domains from which they have been requested.
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This example is based on a request by a real user, not a synthetic agent.
Generate a Synthetic Snapshot (Beta)
Synthetic snapshots use geographically distributed agents to create snapshots of web page
download performance without the idiosyncratic and potentially skewing effects of real user last
mile performance. A subset of this functionality is available as a generally available Beta for 3.9.
See Synthetic Browser Snapshots for more information.
Resource Waterfall

The Resource Waterfall provides a snapshot of when, relatively, each resource was loaded in the
page load process (before First Byte Time, before DOM Ready Time, before Onload), including
the name of the resource, the domain from which it was fetched, the type of resource, and how
long it took. You can filter the items by type using the dropdown box in the upper right, and search
using the search box.
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To see more details click any of the blue timelines. These are from the primary domain or
cross-domains that have set the Time-Allow-Origin Header.

Grey timelines indicate cross-domains that have not set the Time-Allow-Origin Header. Working
with your CDN provider to add this header can mean you get better information on sharded and
CDN served content.
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Domains Requested

The Domains Requested panel gives you insight into how the various domains from which you are
fetching resources are performing. You sort the list by clicking on the top of the column you wish
to use as a key.

Learn More

Ajax Request Browser Snapshots
Iframe Browser Snapshots

Ajax Request Browser Snapshots

Waterfall Graph
Details
Learn More
Ajax request browser-based snapshots give you a detailed look at an individual Ajax request.The
Summary tab covers general characteristics of the page. For information on the Resource Details
tab, see Ajax Request Browser Snapshots: Resource Details.
Waterfall Graph

The top of the Ajax snapshot displays a waterfall graph of the overall transaction timing for the
Ajax request.The snapshot is labeled either a Real User Snapshot or a Synthetic Snapshot, based
on the origin of the request. You can hover over each of the metrics to see a popup definition for
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that metric.

For a detailed description of what these metrics mean, see Web EUEM Metrics.
Generate a Synthetic Snapshot (Beta)
Synthetic snapshots use geographically distributed agents to create snapshots of web page
download performance without the idiosyncratic and potentially skewing effects of real user last
mile performance. A subset of this functionality is available as a generally available Beta for 3.9.
See Synthetic Browser Snapshots for more information.
Details

Below the graph text-based information is shown.

Much of the information is the same as you see for page-based browser snapshots. The main
differences are:
if there is an Ajax error, the error code returned with it is listed
the parent page from which the Ajax call originates is listed
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You can configure errors to ignore if you are seeing too many errors that are not of interest. See C
onfigure JavaScript and Ajax Error Detection.
Learn More

Ajax Request Browser Snapshots: Resource Details
Page Browser Snapshots
Iframe Browser Snapshots

Ajax Request Browser Snapshots: Resource Details

Overview
Resource Waterfall
Domains Requested
Learn More
Ajax-based snapshots give you a detailed look at an individual Ajax request. If the browser that
was used supports the Resource Timing API, the Resource Details tab gives you a detailed
breakdown for the performance of resources - scripts, css files, fonts, SVGs, and images - as they
are loaded into the page. For information on the Summary tab, see Ajax Request Browser
Snapshots.
Overview

The overview panel gives you a quick summary of the number of each type of resource being
loaded and the domains from which they have been requested.

This example is based on a request by a real user, not a synthetic agent.
Generate a Synthetic Snapshot (Beta)
Synthetic snapshots use geographically distributed agents to create snapshots of web page
download performance without the idiosyncratic and potentially skewing effects of real user last
mile performance. A subset of this functionality is available as a generally available Beta for 3.9.
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See Synthetic Browser Snapshots for more information.
Resource Waterfall

The Resource Waterfall provides a snapshot of when, relatively, each resource was loaded in the
page load process (before First Byte Time, before DOM Ready Time, before Onload), including
the name of the resource, the domain from which it was fetched, the type of resource, and how
long it took. You can filter the items by type using the dropdown box in the upper right, and search
using the search box.

To get more detail, you can click any blue timeline. These are from the primary domain or
cross-domains that have set the Time-Allow-Origin-Header.
Grey timelines indicate cross-domains that have not set the Time-Allow-Origin-Header. Working
with your CDN provider to add this header can mean you get better information on sharded and
CDN served content.
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Domains Requested

The Domains Requested panel gives you insight into how the various domains from which you are
fetching resources are performing. You sort the list by clicking on the top of the column you wish
to use as a key.

Learn More

Page Browser Snapshots
Iframe Browser Snapshots
Iframe Browser Snapshots

Learn More
Iframe-based browser snapshots give you a detailed look at an individual iframe request. The
display is identical to Page Browser Snapshots except in the Summary section, where the parent
page is also displayed.

Learn More

Page Browser Snapshots
Ajax Request Browser Snapshots
Synthetic Browser Snapshots

Setting Up a Synthetic Snapshot - Beta
Using Synthetic with an On-Premise EUEM Processor
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Synthetic snapshots use geographically distributed agents to create snapshots of web page
download performance without the idiosyncratic and potentially skewing effects of real user last
mile performance. Compare synthetic snapshots with real user snapshots from the same region to
get a deeper understanding of what is impacting any, particularly outlier, performance issues. You
can also use synthetic snapshots to test for SLA compliance.
Setting Up a Synthetic Snapshot - Beta

For the beta, you can generate an on-demand snapshot of any public URL.

Using the UI, enter
the URL you wish to evaluate
from the dropdown, the location from which you wish the request to come
from the dropdown, the browser you wish to use
Click Generate Snapshot
When the process is complete, the resulting synthetic snapshot shows up in the normal Browser
Snapshot list. Clicking through to the snapshot produces a format identical to that of the Real
User snapshot, except that it is identified as a Synthetic Snapshot.
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Using Synthetic with an On-Premise EUEM Processor

If you are using an on-prem Processor, you need to make sure your firewall is set appropriately so
that the Processor can make the necessary connection. Your firewall must allow OUTBOUND
connections to synthetic.api.appdynamics.com:443. To check, from the Processor host, use cur
l -v or other tool to navigate to https://synthetic.api.appdynamics.com/. You should get a 404.
Usage Stats
The Usage Stats view presents aggregated usage data based on your users'
browser type
device/platform
The view also breaks out performance by type and usage by country.
Usage Statistics by Browser

Accessing Usage Statistics by Browser
Overall Browser Distribution
Performance by Browser
Learn More
You can monitor end user experience by browser and by browser version.
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The browser dashboard helps you discover:
the slowest browsers in terms of total end-user response time.
the slowest browsers to render the response page.
the browsers that most of your end users use.
the browsers that most of your end users use in a particular country or region.
Accessing Usage Statistics by Browser

1. In the left navigation bar click: End User Experience -> Web.
2. Select the Usage Stats tab.
3. Click the Browsers tab if it is not already selected.
Overall Browser Distribution

The Overall Distribution chart shows the percentages of your end users using different browsers.
To see the total number of calls, average end user response time, and percentage of the total load
for a particular browser, hover over the browser section in the chart.

To see the distribution by browser version, check Show Browser Versions.
Performance by Browser

The Performance by Browser list below the chart displays a row for each browser or each browser
version if Show Browser Versions is checked.
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The columns contain EUEM metrics by browser.
To see the Statistical View - with timings by percentile for End User Response Time, DOM Ready
Time, and First Byte Time - click the Details View dropdown.
Not all browsers support all metrics. See Web EUEM Metrics.
The performance for all IOS browsers - Chrome, Safari,etc - is displayed under iOS
Mobile because of the way all IOS browsers report themselves.
Click a column to sort the browsers based on the column's metric. For example, if you want to sort
the slowest browsers in terms of Download Time with the slowest browsers at the top of the list,
click the Download Time column. You can toggle the column header to switch between ascending
and descending order.
To filter the list to see only rows for a particular browser, enter the browser in the filter field.
Distribution by Country
The Distribution by Country list, below the Distribution by Browser list, breaks out the browser
distribution of your end users by country. You can sort by any browser by clicking the browser's
column header.
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This list is particularly useful when viewed in conjunction with the worst performing regions panel
in the geo dashboard. If a particular county is experiencing poor performance, it is possible that a
significant percentage of your users in that country use a poorly-performing browser. This list can
help you to determine whether the browser is a contributing factor.
Learn More

Web EUEM Metrics
Time Ranges
The Web EUEM Geo Dashboard View
Monitor Your Applications with Web EUEM
Usage Statistics by Device or Platform
Usage Statistics by Device or Platform

Accessing Usage Statistics by Device/Platform
Overall Device Distribution
Performance by Device
Learn More
You can monitor the end user experience of each type of device/platform that your end users use
to access your application.
The device dashboard helps you discover:
The slowest devices in terms of total end-user response time
The slowest devices to connect to the server
The devices that most of your end users use
The devices that most of your end users use in a particular country or region
Accessing Usage Statistics by Device/Platform

1.
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1. In the left navigation bar click: End User Experience -> Web.
2. Select the Usage Stats tab.
3. Click the Devices tab if it is not already selected.
Overall Device Distribution

The Overall Distribution chart shows the percentages of your web end users by their
devices/platforms.
This chart shows mobile access via browsers only.
To see the total number of calls, average end user response time, and percentage of the total load
for a particular device, hover over the device in the chart.

Performance by Device

The Performance by Device list below the chart displays a row for each device.
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The columns show the various EUEM metrics by device. See Web EUEM Metrics.
To see the Details View, click the Statistical View dropdown.
Click a column to sort the devices based on the column's metric. For example, if you want to sort
the slowest devices in terms of Download Time with the slowest devices at the top of the list, click
the Download Time column. You can toggle the column header to switch between ascending and
descending order.
To filter the list to see only rows for a particular device, enter the device in the filter field.
Distribution by Country
The Distribution by Country list breaks out the device distribution of your end users by country.

This list is particularly useful in conjunction with the worst performing regions panel in the Geo
Dashboard. If a particular county is experiencing poor performance, it is possible that a significant
percentage of your users in that country use a poorly performing device. This list can help you to
determine whether the device is a contributing factor.
Learn More

Web EUEM Metrics
Time Ranges
The Web EUEM Geo Dashboard View
Monitor Your Applications with Web EUEM
Usage Statistics by Browser
Analyze Web EUEM
Accessing the Analyze Web EUEM Beta
The Overview Histogram
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Load by Location
Usage Stats
Filter the Display
Web EUEM collects data on every load event that you have instrumented, and takes detailed
snapshots periodically and in case of detected performance issues. Metrics on the Pages & AJAX
Requests list in the Controller UI are based on pre-calculated averages and percentiles.
Sometimes users want to calculate custom combinations of the data, such as page performance in
a specific geography. With Analyze Web EUEM, every single event is stored and can be queried
using the Analyze tab so you can perform custom calculations like this one. The Beta allows you to
investigate a number of useful metrics.
Accessing the Analyze Web EUEM Beta

1. In the left navigation bar click: End User Experience -> Web.
2. Select the Analyze tab.
The Overview Histogram

The first panel displays a histogram of three key metrics: End User Response Time, First Byte
Time, and DOM Ready Time. The top right displays the average value for each of the metrics.
Below that is a histogram with the metric type that you have selected using the buttons. Hover
over any of the bars to see more details.

To drill down on any time range drag your mouse across and release.
Load by Location

The second panel displays a world map indicating load.
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Hover over an area to see the number of calls originating there. Click to drill down into a specific
geographic area.
Usage Stats

The third panel presents usage statistics: by browser, OS, and device type.

Hover over a chart segment to see details. Click a chart segment to filter by that item.
Filter the Display

You can add filters by clicking on the item that interests you in location or usage, or you can set a
filter using the Filter button in the upper left corner.

Copyright © AppDynamics 2012-2014

Page 713

Using the various dropdowns gives you access to your filter choices. To apply you filters, click
Apply. To close the filter dropdown, click the Filter button again. To remove filters, click Clear
Criteria.

Set Up and Configure Web EUEM
EUEM License
Accessing Web EUEM Configuration
Web EUEM Prerequisites
Enable and Disable Web EUEM
Inject the JavaScript Agent for Web EUEM into Your Application Pages
Configure On-Prem Controller HTTP Proxy Settings (Optional)
Additional Web EUEM Configurations
Learn More
You must have an EUEM license to access Web EUEM. See EUEM License.
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End User Experience Management (EUEM) must be enabled at the application level. Its UI is
visible in the Controller GUI only if EUEM is enabled. You can enable and then disable EUEM if
you decide not to use the feature. See Enable and Disable EUEM.
Metrics are collected on your end users' experience in their Web browsers using a special
JavaScript for agent for Web EUEM. Your web application must be configured to insert this agent
into the web pages it serves in order for them to monitored. This process is called injection. See S
et Up Your Application for Web EUEM.
EUEM License

A special EUEM license key is required. It covers both Web EUEM and Mobile EUEM.
For on-premise customers, the license key is set up within the Controller license file. If you added
EUEM after your initial installation, you may need to upload and install the new Controller license
file. See Controller Licenses. If you are a SaaS customer, the EUEM license is set up in the SaaS
Controller for you.
Each JavaScript agent for Web EUEM provides a certain number of page views per year. For
information on how to examine your current page view usage, see Web EUEM License.
Accessing Web EUEM Configuration

1. In the left navigation menu, click Configure -> Instrumentation.
2. Click the End User Experience tab.
Always remember to click Save in the EUEM configuration screens whenever you
make a change.
Web EUEM Prerequisites

To turn on Web EUEM functionality you need to:
enable End User Monitoring
inject the JavaScript agent into your application pages
Enable and Disable Web EUEM

1. At the top of the End User Experience configuration screen:
check Enable End User Experience Monitoring to enable Web EUEM.
clear Enable End User Experience Monitoring to disable Web EUEM.

2. Click Save in the Web EUEM configuration screen after you have made your change.
Inject the JavaScript Agent for Web EUEM into Your Application Pages

The JavaScript agent for Web EUEM collects EUEM metrics. See Web EUEM Metrics.
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The JavaScript agent for Web EUEM must be inserted into the headers of the pages for which you
want to see these metrics. There are several ways to accomplish this. See Set Up Your
Application for Web EUEM.
Configure On-Prem Controller HTTP Proxy Settings (Optional)

If you have an on-premise Controller that uses an HTTP proxy host and port to communicate with
the Internet, you need to add the following JVM options to the Controller configuration so that the
Controller can communicate with the EUEM Cloud aggregator, which performs EUEM data
processing:
1. Set appdynamics.controller.http.proxyHost to the proxy host name or IP address.
2. Set appdynamics.controller.http.proxyPort to the proxy HTTP port.
3. If the proxy requires authentication, set credentials for the Controller using these options:
Set appdynamics.controller.http.proxyUser to the user name that the Controller should
use to authenticate to the proxy.
Set appdynamics.controller.http.proxyPasswordFile to the plain text file that contains
the password for the user.
You can use the modifyJvmOptions utility to do this. Then stop and restart the app server.
For example, the following commands show how to modify the HTTP proxy options for a Controller
on Linux, then stop and start the Controller's app server.
<Controller_installation_directory>/bin/modifyJvmOptions.sh add
-Dappdynamics.controller.http.proxyHost=myhost@-Dappdynamics.control
ler.http.proxyPort=8888
<Controller_installation_directory>/bin/controller.sh stop-appserver
<Controller_installation_directory>/bin/controller.sh start-appserver

Be sure to use the @ character to separate multiple options, as shown in the example.
Alternatively, run the modifyJvmOptions utility once for each option to be added.
The following commands modify the HTTP proxy options for a Controller that runs on Windows,
then stops and starts the Controller's app server. The quotation marks enclosing the options string
is required on Windows. Run the commands from an elevated command prompt, which you open
by right-clicking on the Command Prompt icon in the Windows Start menu and choosing Run as
administrator.
<Controller_installation_directory>\bin\modifyJvmOptions.bat add
"-Dappdynamics.controller.http.proxyHost=myhost@-Dappdynamics.contro
ller.http.proxyPort=8888"
<Controller_installation_directory>\bin\controller.bat stop-appserver
<Controller_installation_directory>\bin\controller.bat
start-appserver

If you need to modify these properties later, first run modifyJvmOptions with the delete command
to delete the old setting, then use the add command to add the new ones.
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See Modify GlassFish JVM Options for more information about this utility.
To modify the Controller configuration file directly, edit the domain configuration file:
<Controller_installation_directory>/appserver/glassfish/domains/domain1/config/d
omain.xml

Add the following JVM option to the existing java-config element:
<jvm-options>
-Dappdynamics.controller.http.proxyHost=myhost
-Dappdynamics.controller.http.proxyPort=8888
</jvm-options>

Additional Web EUEM Configurations

You can also configure:
Page Identification and Naming
JavaScript and Ajax Error Detection
Browser Snapshot Thresholds
Browser Snapshot Collection Rules
Deployment Customization
Learn More

Web EUEM License
Set Up Your Application for Web EUEM
Browser Snapshots
Modify GlassFish JVM Options
Configure the Controller UI for Web EUEM
You can manage how the Web EUEM information appears in the Controller UI, including:
the display names for your pages, Ajax requests, and iframes
the errors that should be shown in the UI, and the ones that should not be shown
You can also configure:
the thresholds for slow, very slow, and stalled transactions
when browser snapshots should be taken
percentile levels you would like to display, if any
In addition, you can customize your deployment, including:
using a custom geo server for geo-location
using a custom location for the JavaScript agent
using a custom EUEM data collector location
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Configure Page Identification and Naming

Access Page Naming Rules
Logic of Page Naming Rule Evaluation
Default Page Naming Rules
Custom Page Naming Rules
Custom Page Exclude Rules
Learn More
You can configure the display names by which various pages, Ajax requests, and iframes are
referred to and sorted in controller lists and dashboards.
You can:
use the AppDynamics default naming rule, which you can leave as is or modify.
create custom naming rules to override the default convention.
disable the default naming rule and use only your own custom naming rules.
create custom exclude rules to exclude from monitoring pages that meet certain criteria.
In this topic, the term "pages" includes iframes, Ajax requests, and base pages.
No matter how the page is named, AppDynamics always reports the page name in lower-case.
Access Page Naming Rules

1. Access the EUEM configuration screen if you are not already there. Configure->Instrumentati
on
2. Select the End User Experience tab.
3. Select the Web Page Naming, Error Detection, Thresholds, etc. sub tab
4. Expand Configure how Pages, AJAX Requests, and Iframes will be named.
Whenever you make any changes, click Save to save the configuration.
Logic of Page Naming Rule Evaluation

This is the order in which AppDynamics evaluates the page naming rules.
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Default Page Naming Rules

If you enable the default naming configuration and do not modify it, AppDynamics identifies and
names your pages using the first 2 segments of the page URL.
You can modify the default configuration in the Default Naming Configuration section. For
example, you can include the protocol or domain in the name, or use different segments of the
URL, or run a regular expression on the URL, or include query parameters in the name. For
example, you can use the Show Domain option to identify third-party Ajax or iframe calls.

If you do not want to use the default convention at all, disable it by clearing the Enabled check box.
In this case you must configure at least one custom page naming rule so that AppDynamics can
identify and name pages.
Custom Page Naming Rules
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You can create custom rules for identifying and naming pages.
To create a custom page naming rule, click the plus icon in the Custom Naming Rules section.
Then configure the custom rule for AppDynamics to use to identify and name the page.
This configuration screen is similar to the default configuration screen but it includes a priority field.
The priority specifies which rule to apply to the naming of a page if it could be identified by more
than one rule. For example, if CustomRuleA specifies Use the first 3 segments of the URL and
has a priority of 9 and CustomRuleB specifies Use the last 3 segments of the URL and has a
priority of 8, a page in which the URI has more than 3 segments will be named by CustomRuleA
because it has a higher priority.
The default rule, if enabled, has a priority of 0.
In the example below, you might have multiple pages that include "search/r/region" in their URLs,
so "search/r/region01", "search/r/region23", and so forth. You want to name all the pages from that
set as a single page named "search/r/region". Using the Run regex on URI option, you remove
the domain name and the number at the end of the URL, grouping all your "/search/r/region" URLs
into a single set. Because all the URLs contain "search/r/region", AppDynamics now collects
information for them all under the single page name "search/r/region". Otherwise it would use the
default page naming rule, or, if another rule with a priority greater than 4 exists, that higher priority
rule.

Custom Page Exclude Rules

You can configure custom exclude rules for pages. Any page with a URL matching the
configuration is excluded from monitoring.
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Learn More

Set Up and Configure Web EUEM
The Pages and Ajax Requests View
Page, Ajax, and Iframe Dashboards
Set Custom Page Names with JavaScript
Configure JavaScript and Ajax Error Detection

Access Error Detection Rules
Enabling and Disabling Web EUEM Error Detection
Configuring Rules to Ignore Errors based on Script or Error Message
Configuring Rules to Ignore Errors by Page
Configuring Rules to Ignore Errors by URL
Learn More
You can enable and disable reporting of JavaScript and Ajax request errors.
You can configure which errors are included in the error count by specifying which errors to
"ignore".
"Ignored errors" are not really ignored. They are still tracked, but the error count in the
places where error totals are reported on the user interface is not incremented
When enabled, JavaScript and Ajax request errors are reported throughout the Web EUEM UI: in
the geo page, in the user stats browser and device dashboards, in the page list, and in browser
snapshots.
You can specify errors to ignore:
by script and / or error message
by page
by URL
Access Error Detection Rules

1. Access the EUEM configuration screen if you are not already there. Configure->Instrumentati
on.
2. Select End User Experience tab.
3. Select Web Page Naming, Error Detection, Thresholds, etc. sub-tab.
4. Expand Configure Detection of JavaScript and AJAX Errors.
When you complete your changes, remember to click Save.
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Enabling and Disabling Web EUEM Error Detection

In the Configure Detection of JavaScript and Ajax Errors screen:
Check/clear the Enable JavaScript Error Capture check box to enable/disable JavaScript
error display.
Check/clear the Enable Ajax Request Error Capture check box to enable/disable Ajax error
display.
If both check boxes are clear, no JavaScript or Ajax request errors are displayed.
Even if capture is enabled globally, you can configure certain errors to be ignored so that they are
not counted in the error totals.
Configuring Rules to Ignore Errors based on Script or Error Message

You can configure the agent to ignore specific JavaScript errors that are identified by:
a matching string pattern in the name of the script that generated the error
line number in the script
a matching string pattern in the error message
You can specify one, two or all three of these criteria. Configure more criteria to increase the
granularity of which errors you ignore.
For example, the following configuration, in which all three fields are specified, means "Ignore all
errors generated by line 27 of a script whose name starts with "Nightly" and whose error message
contains the string "WARNING::".

If the line number was not specified (e.g. set to 0), the configuration would mean "Ignore all errors
generated any line of a script whose name starts with "Nightly" and whose error message contains
the string "WARNING::".
If neither the line number nor the error message field were specified, the configuration would mean
"Ignore all errors generated by any line of a script whose name starts with "Nightly".
If the error message were the only field specified, the configuration would mean "Ignore all errors
generated by any script when the error message contains the string "WARNING::".
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To modify an existing ignore rule, select the rule in the list and click the edit icon.
To remove an ignore rule, select the rule in the list and click the delete icon.
Configuring Rules to Ignore Errors by Page

You can also ignore all errors generated by a specific page, iframe, or Ajax request.
Configure one rule for every page for which you want to ignore all errors.

To remove an ignore rule, select it in the list and click the minus icon.
Configuring Rules to Ignore Errors by URL

You can ignore all errors generated by a specific URL.
Configure one rule for every URL for which you want to ignore all errors.
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To remove an ignore rule, select it in the list and click the minus icon.
Learn More

Set Up and Configure Web EUEM
Browser Snapshots
Configure EUEM Performance Thresholds

Access EUEM Threshold Rules
Configure EUEM Threshold Rules
Learn More
You can configure the thresholds that define slow, very slow, and stalled end-user requests.
These thresholds are used to set up browser snapshots.

You can define EUEM thresholds either
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as a multiple of the standard deviation; for example, "Experience is slow if end user
response time is slower than 3 X the standard deviation.
as a static value; for example, "Experience is stalled if end user response time is slower than
30000 ms."
The default thresholds are:
Slow = 3 x standard deviation
Very Slow = 4 x standard deviation
Stalled = 45000 ms
Access EUEM Threshold Rules

1. Access the EUEM configuration screen if you are not already there. Configure->Instrumentatio
n.
2. Select End User Experience tab.
3. Select Web Page Naming, Error Detection, Thresholds, etc. sub-tab.
4. Expand Thresholds for Slow User Experience.
When you complete your changes, remember to click Save.
Configure EUEM Threshold Rules

1. Select the relevant radio button to indicate whether the threshold is based on standard
deviations or static values.
2. Type the values in the fields or select them using the scrollbars for one or more of the
following:
a. the Slow Threshold.
b. the Very Slow Threshold.
c. the Stalled threshold.
3. Click Save.
Learn More

Browser Snapshots
Configure Browser Snapshot Collection
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Access Snapshot Collection Rules
Configure Snapshot Collection Rules
Learn More
By default, when Web EUEM is enabled the JavaScript agent captures periodic browser
snapshots (page, iframe, and Ajax) every 60 seconds and other snapshots when performance
thresholds are crossed or errors are encountered.
You can:
enable/disable slow snapshot collection, that is snapshots of requests where the End User
Response Time is higher than the configured threshold.
enable/disable periodic snapshot collection.
enable/disable error snapshots, that is snapshots of requests for which a JavaScript error is
reported or an Ajax request receives an HTTP error response. An error response is any
HTTP code equal to or greater than 400.
If all three kinds of browser snapshot types - periodic, error, and slow response time - are
disabled, the agent does not collect any browser snapshots.
Access Snapshot Collection Rules

1. Access the EUEM configuration screen if you are not already there. Configure->Instrumentati
on.
2. Select End User Experience tab.
3. Select Web Page Naming, Error Detection, Thresholds, Percentiles etc. sub-tab.
4. Expand Event Policy Configuration
When you complete your changes, remember to click Save.
Configure Snapshot Collection Rules

1. Do one or more of the following:
Use Enable Slow Snapshot Collection to enable/disable slow response time snapshot
collection.
Use Enable Periodic Snapshot Collection to enable/disable periodic snapshot collection.
Use Enable Error Snapshot Collection to enable/disable error snapshot collection
2. Click Save.
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Learn More

Browser Snapshots
Set Up and Configure Web EUEM
Configure Web Percentile Metrics

Access Configure Percentile Metrics
Configure Percentile Metrics
Learn More
In many places across the Controller UI you can choose to display metrics using either averages
or percentiles. A percentile is a measure that indicates a value below which a given percentage of
values in a set falls: for example, the 99th percentile means that 99% of all values are below this
level. Using percentiles can be a good way to reduce the impact of extreme outliers in
performance metrics, which can be useful in the often noisy environments of end user experience
monitoring.
You can:
enable/disable percentile metric display
set up to four different percentile levels to be applied to metrics
Access Configure Percentile Metrics

1. Access the EUEM configuration screen if you are not already there. Configure->Instrument
ation.
2. Select End User Experience tab.
3. Select Web Page Naming, Error Detection, Thresholds, Percentiles etc. sub-tab.
4. Expand Configure Percentile Metrics
When you complete your changes, remember to click Save.
Configure Percentile Metrics

1. Check the box to enable percentile metric display
2. Add up to four percentile levels to collect. Each value must be a whole number between 1
and 99.
Learn More
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The EUEM Geo Dashboard
The Web EUEM Geo Dashboard View
The Mobile EUEM Geo Dashboard
Customize Your Web EUEM Deployment

Access Customize Your Deployment
Alternate Geo Server Location
Hosting the JavaScript Extension File Yourself
Alternate EUEM Data Collector Location
Learn More
Deployment customizations include:
setting up a custom geo server for private networks or custom location mapping.
hosting your own JavaScript agent extension file instead of using Amazon Cloudfront.
pointing your JavaScript agent to an alternate EUEM data collector location in the Amazon
cloud.
Access Customize Your Deployment

1. Access the EUEM configuration screen if you are not already there. Click Configure->Instr
umentation.
2. Select End User Experience tab.
3. Select Web Page JavaScript Instrumentation sub-tab.
4. Expand Advanced.
5. Expand Customize Your Deployment.
When you complete your changes, remember to click Save.

Alternate Geo Server Location

By default, end-users' locations are resolved using public geographic databases. You can host an
alternate geo server for your countries, regions, and cities instead of using the default geo server
hosted by AppDynamics. Use the Geo Server URL field to point to your custom geo server.
See Use a Custom Geo Server For Web EUEM.
Hosting the JavaScript Extension File Yourself

The JavaScript agent consists of two files, adrum.js and adrum-ext.js. The first file is
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inserted into the page when it is downloaded from your web application. The second is loaded
asynchronously by the first. By default, the extension file is fetched the highly available Amazon
CloudFront CDN infrastructure.
To host the JavaScript agent extension yourself, click Download the JavaScript Agent
Extension. You will get a version that is compatible with your version of the Controller.
Place the file in a Web container and enter the URL of the host in the URL field below. If you
saved the agent file in a directory, for example "js", include the directory name but do not include
the filename of the actual agent extension as this may change with subsequent versions. The
agent will supply the name of the file when it processes the URL.

Alternate EUEM Data Collector Location

The JavaScript agent for EUEM sends browser performance data to the EUEM Cloud for
processing before being transferred and stored on the whichever version of the Controller you are
using. The default EUEM Cloud network has a presence in all AWS regions with centralized data
processing occurring in the Amazon US-WEST Region.
If you have a need for a private EUEM Cloud network, contact your AppDynamics sales
representative and AppDynamics Support. Once approved you will be provided with a URL for an
alternate location from which your AppDynamics controller can collect your data. Supply the URL
in the EUEM Data Collector URL field.
Learn More

Set Up Your Application for Web EUEM
AppDynamics Support
Set Up Your Application for Web EUEM
Injection Overview
Manual Injection
Automatic Injection
Assisted Injection
Assisted Injection using Injection Rules (Java only)
Assisted Injection using Attribute Injection
Choosing an Injection Method
Verifying Injection with Manual Injection
Reversing Injection
Getting Full Timing Data for Associated Business Transactions
Learn More
Injection Overview

Web EUEM works in the following way:
1. An end user requests a first page from your web application.
2. Your web application executes whatever business logic that the particular page requires.
3. Your web application creates the response page to return to the end user. The response
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3.

4.
5.
6.

7.
8.

page includes:
a. application specific information
b. a copy of a small JavaScript script that knows how to collect relevant performance
information about that page. This script is called the JavaScript agent.
The page, with the JavaScript agent included, is returned to the end user.
As the page is being constructed in the browser, the script collects relevant information
about the page's performance.
At approximately the same time as the onload event for the page fires, a copy of a
somewhat larger JavaScript file, the JavaScript agent extension, is downloaded from AWS
asynchronously by the injected agent.
This second script packages the collected performance information and sends it via a web
beacon to the EUEM Cloud collector for processing.
Working together the two scripts continue to collect and send performance information as
the end user navigates through the instrumented pages of your application.

To instrument your application for Web EUEM you must set up your web application to insert the
JavaScript agent file into the page that is returned to the end user as part of the normal process it
follows. The act of inserting the agent is called injection.
There are several ways to inject the JavaScript agent for Web EUEM into your web pages.
Not all types of injection are supported on all frameworks and platforms. See the Script
Injection columns in the Supported Platform Matrix for Web EUEM matrices to find out
what types are supported for your application.
Manual Injection

Manual injection is supported on all platforms and frameworks. To set up a manually injected
page, you:
Download the JavaScript agent to your local environment
Manually configure each page you wish to instrument to find the script where you stored it
so that it can be executed as the page is constructed by the browser.
You can also choose to point your page to an AppDynamics hosted version of the
JavaScript agent instead of hosting it locally. See Options in Using Manual Injection
for the EUEM JavaScript Agent for more information.
For detailed instructions on using manual injection in your application, see Manual Injection.
Automatic Injection

If you are using a Java or .Net app agent on the server-side, and your application is running in an
environment that supports the Apache Jasper JSP compiler (for Java) or ASP.NET or ASPX (for
.NET), you may be able to use automatic injection, where the server-side app agent completely
manages injecting the code at runtime. For detailed instructions on using automatic injection in
your application, see Automatic Injection.
Assisted Injection

Assisted injection is available in two variants. In both cases some of the work is done manually by
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you and some of the work is done by the server-side Java or .Net app agent.
Assisted Injection using Injection Rules (Java only)

In this type of assisted injection you configure rules that define which app server Java classes and
methods write to the output stream of your application and the writer object that is used to do that
writing. AppDynamics intercepts the method and injects the JavaScript agent into the output
stream. You also specify which business transactions you wish to have instrumented in this way.
For detailed information on using this form of assisted injection, see Assisted Injection-Using
Injection Rules - Java Only.
Assisted Injection using Attribute Injection

In this type of assisted injection you copy small code snippets appropriate to your framework into
your page templates or other code that creates your pages. This snippet contains two variables,
JS_HEADER and JS_FOOTER, which the app agent replaces with the appropriate information in
the response object at runtime.
For detailed information on using this form of assisted injection, see Assisted Injection-Using
Attribute Injection.
Choosing an Injection Method

If you are uncertain which procedure to use to inject the agent into your web pages, follow these
guidelines, in this order:
If you want to use Web EUEM and do not have any app agents on the server side, use
manual injection. See Manual Injection.
If automatic injection is available and works for your framework, use automatic injection.
Automatic injection requires the least amount of effort because you do not have to
manually instrument every page. Check the matrices at End User Monitoring (EUEM)
Compatibility to see if automatic injection has been tested in your environment. Also see
Automatic Injection.
If you cannot use automatic injection, and you can edit the source code of your web pages,
use manual injection. See Manual Injection.
If you cannot use automatic injection, and you can edit the source code of your web
application, use one of the kinds of assisted injection. See Assisted Injection-Using
Injection Rules (Java Only) or Assisted Injection-Using Attribute Injection.
Verifying Injection with Manual Injection

Once the agent is injected, it can take the AppDynamic controller a few minutes to discover and
recognize the page, which must happen before data will begin to appear. If, however, you have
configured your page using manual injection and are not seeing EUEM metrics after running load
for a while, check the web page to confirm that the JavaScript Agent for EUEM is present in the
page. If it is not, try injecting the script again.
If after two attempts you still do not see EUEM metrics, try one of the other injection schemes if
they are available for your platform, or call AppDynamics Support.
Reversing Injection
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If you try one way to inject and it does not work, AppDynamics recommends that you undo the
current injection configuration before implementing another one.
To undo automatic injection, just clear the Enable Automatic Injection of JavaScript check
box.
To undo manual and assisted injection using attribute injection, manually delete the
JavaScript Agent for EUEM from your web pages or page templates.
To undo assisted injection using injection rules, clear the Enable check box for each
injection rule in the injection rules list.
If multiple copies of the agent exist on a page, the second copy does not execute.
Getting Full Timing Data for Associated Business Transactions

To get the full real execution time for correlated business transactions your injection method must
write the JS_FOOTER data variable to your page. Manual injection gives the server-side agent the
ability to write data only to the header of the page as it is being constructed by your web
application. It is possible that complete business-transaction timing information is not available at
the moment that the header data is written. Using the footer allows the server-side agent to write
timing data at the footer of the page, by which time a fuller picture of business transaction timing is
available.
You can write the JS_FOOTER data variable into the footer of a web page using the following
techniques:
If you use automatic injection for the injecting into the head section, you automatically get
injection into the footer as well.
If you use manual injection for the head section, for applications built on Java platforms you
can use assisted injection-using injection rules to inject into the footer. Or for applications
built on Java servlet or ASP.NET platforms, you can use assisted injection-using attribute
injection.
If you cannot add the JS_FOOTER variable to your page, the timing shown for correlated business
transactions is the average response time for that transaction rather than the real execution time
for that specific page.
Learn More

Manual Injection
Automatic Injection
Assisted Injection-Using Attribute Injection
Assisted Injection-Using Injection Rules - Java Only

Manual Injection

Download and Include the Agent
To access the manual injection panel
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To inject the JavaScript Agent for Web EUEM
Learn More
For manual injection, you download the JavaScript Agent for Web EUEM and include it in the
header of the web pages for which you want to collect Web EUEM data.
If your installation connects Web EUEM to a server-side application that is also
instrumented, we recommend you also use assisted injection to add a footer to your pages.
Manual injection gives the server-side agent the ability to write data only to the header of
the page as it is being constructed by your web application. Server-side business
transaction information is sometimes not available until after the header has already been
written, so using a footer can ensure that the information is captured. See Getting Full
Timing Data for Associated Business Transactions for more information.
Watch a quick video overview of the manual injection process:
d9mc9t4rm8
Direct link: https://appdynamo.wistia.com/medias/d9mc9t4rm8

Download and Include the Agent
You configure manual injection from the JavaScript Instrumentation tab of the Web EUEM
configuration screen.
To use the same downloaded agent for multiple applications, or to use a cloud-hosted version of
the main agent file, adrum.js, instead of downloading it, see Options in Using Manual Injection for
the EUEM JavaScript Agent.
To access the manual injection panel

1. In the left navigation menu, click Configure -> Instrumentation.
2. Click the End User Experience tab.
3. Click the JavaScript Instrumentation subtab if it is not already selected.
4. Scroll down to the Instrument your HTML pages with the JavaScript Agent panel.
To inject the JavaScript Agent for Web EUEM

1. Click Download the JavaScript Agent.
2. Click Save to File to save it.
The name of the saved file should be "adrum.js".
Save it where you save other assets, such as images, CSS files,for the page into which you are
injecting.
If you have a single code base hosting multiple domains, you need to host adrum.js in each
domain.
3. To include the JavaScript Agent for EUEM in your page, copy the line in the text field in the
second step and paste it into the header, right after the <head> tag and any <meta> tags, of the
pages that you want to monitor. Making sure that the JavaScript Agent loads immediately
improves timing accuracy.
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If your page has <meta> tags, place them right after the <head> tag and then add the agent
line.
You will get EUEM metrics for all pages in which you include this line. If you later decide that you
do not want metrics for the page, remove the line.
4. Click Save in the configuration screen.

This inclusion is highly preferable, for convenience, accuracy, and maintenance, to copying the
entire JavaScript agent into your web pages inline.
The JavaScript for EUEM Agent is named adrum.js. This script asynchronously invokes
another script called adrum-ext, which performs most of the EUEM logic. The adrum-ext
script is hosted on Amazon CDN, but you have the option of hosting it at another location.
See Alternate Location for the JavaScript for EUEM Agent for information about configuring
this option.
Learn More

Set Up and Configure Web EUEM
Set Up Your Application for Web EUEM
Options in Using Manual Injection for the EUEM JavaScript Agent
Automatic Injection
Assisted Injection-Using Injection Rules - Java Only
Assisted Injection-Using Attribute Injection
Options in Using Manual Injection for the EUEM JavaScript Agent

Using a Single JavaScript Agent for Multiple Applications
Using a Hosted Version of the JavaScript Agent
Learn More
Sometimes the standard manual injection scenario is not appropriate for your installation. Use the
following options to customize the process for your needs.
Using a Single JavaScript Agent for Multiple Applications

To use the same copy of the JavaScript agent for EUEM (adrum.js) to cover multiple applications,
you need to specify the app key for each application by setting up a variable in a small script that
precedes the agent script. This is necessary because by default the application key is embedded
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in the agent script.
To set this up:
1. Download the JavaScript agent for EUEM. See Download and Include the Agent for general
instructions on downloading and including the JavaScript agent for EUEM using manual injection.
2. For each of your apps, add a line to the "start-time" script, shown in the red box below, to the
header of each page right after the <head> tag (and any <meta> tags), before the entry that
includes the location of the agent (adrum.js):
window["adrum-app-key"] = "<app-key-for-this-app>";

The app key for each of your apps is displayed in the relevant EUEM configuration screen under A
dvanced->Customize your Deployment.

After you include the variable line, the start-time line and the agent, the <head> section in your
EUEM-monitored web pages should resemble the following example, although your app key will
naturally be different for every app:
<head>
<script>
window["adrum-app-key"] = "AD-AAB-AA-AFB";
window["adrum-start-time"] = new Date().getTime();
</script>
<script src="/adrum.js"></script>
. . .
. . .
</head>

Using a Hosted Version of the JavaScript Agent

AppDynamics maintains a hosted copy of the latest version of the main JavaScript agent file,
adrum.js, on Amazon CDN. The file is located at
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http://de8of677fyt0b.cloudfront.net/adrum/adrum-latest.js

Previous versions of the agent can be found at
http://de8of677fyt0b.cloudfront.net/adrum/adrum-VERSION.js

where VERSION is the version number (for example, 3.7.16.0) you want to access.
To use the hosted version of the JavaScript agent instead of one located on your local system:
1. Open the JavaScript Instrumentation tab.
2. You do not need to download the JavaScript agent.

3. Add a line in the script, shown in the red box above, indicating your app key. The script must be
in the header of the page directly after the <head> tag. This entry must be before the entry that
includes the location of the agent (adrum.js). You must specify the app key if you are using the
hosted script:
window["adrum-app-key"] = "<app-key-for-this-app>";

Your app key is displayed under Advanced->Customize your Deployment.
4. Optional: If you want to use a custom geo-server with the hosted version of the script, you also
need to add a line defining the custom geo URL:
window["adrum-geo-resolver-url"] = "<the URL, including the context
root, of your custom geo-server>";

For more information on using a custom geo-server, see Use a Custom Geo Server For Web
EUEM.
5. Edit the path for adrum.js to point to the hosted location on Amazon:
<script
src="http://de8of677fyt0b.cloudfront.net/adrum/adrum-latest.js">

After you include the app key, the start-time line, the custom geo-server URL (optional), and the
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agent URL, the <head> section in your EUEM-monitored web page should resemble the following
example, although your details will be somewhat different:
<head>
<script>
window["adrum-app-key"] = "AD-AAB-AUM";
window["adrum-start-time"] = new Date().getTime();
window["adrum-geo-resolver-url"]="https://mygeo.acme.com/geo";
</script>
<script
src="http://de8of677fyt0b.cloudfront.net/adrum/adrum-latest.js">
. . .
. . .
</head>

Learn More

Manual Injection
Customizing the JavaScript Agent
Automatic Injection

Access the Automatic Injection Configuration Panel
Enable Automatic Injection
Set Attribute to Enable Automatic Injection for .NET
Configure Automatic Injection
To Specify Business Transactions for Automatic Injection
To Create Match Rules for Automatic Injection
Learn More
Automatic injection uses AppDynamics server-side agents to automatically add the adrum header
and footer to each of your instrumented web pages.
Automatic injection is available only for server-side applications built on Jasper-supported JSP
(Java) , ASP.NET or ASPX (.NET) frameworks.
Access the Automatic Injection Configuration Panel

1.
2.
3.
4.
5.
6.

In the left navigation menu, click Configure -> Instrumentation.
Click the End User Experience tab.
Click the Web JavaScript Instrumentation tab if it is not already selected.
Scroll down to the Advanced panel and expand it if it is closed.
Expand Advanced Instrumentation of your HTML Pages if it is closed.
Click the Automatic JavaScript Injection tab if it is not already selected.
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Enable Automatic Injection

1. In the Automatic JavaScript Injection tab, check or clear Enable Automatic Injection of
JavaScript.
2. If you enabled automatic injection click OK to confirm your action.

Set Attribute to Enable Automatic Injection for .NET

To perform automatic injection for .NET, the AppDynamics app agent detects the <head> element
in the aspx page. This should be part of either the master page or the aspx page.
The <head> element must have the 'runat="server"' attribute set for automatic injection to work.
<head runat="server">

This is not necessary for manual or assisted injection.
Configure Automatic Injection

After you have enabled automatic injection:
You must specify the business transactions for which automatic JavaScript injection is
enabled.
You can limit which pages to inject, by creating custom match and exclude rules for
automatic injection. If you do not configure these rules, by default AppDynamics injects all
pages visited by the enabled business transactions.
Use these rules to fine-tune which business transactions to include or exclude from injection based
on match criteria. For example, you can exclude all business transactions that have a certain
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string in their URLs or set a certain cookie. The configurations for include rules and exclude rules
are similar. It depends on your situation whether it is more convenient to restrict transactions
based on inclusion or exclusion.
To Specify Business Transactions for Automatic Injection

You must select at least one business transaction for automatic injection.
1. From the list on the right, select business transaction. Not all your business transactions
may appear here - the list includes only those transactions that AppDynamics can parse for
automatic injection, those based on Jasper-compiled JSPs or .Net ASP or ASPX pages.
2. Click < Add to move the business transaction to the list on the left.
3. Repeat until all the transactions you wish to enable are on the left and those you do not wish
to enable are on the right.
4. Click Save.
To Create Match Rules for Automatic Injection

You may not wish to instrument every page in your application. For example, if your application
has a very large number of pages, you might want to instrument only the key ones for your
business, to avoid hitting licensing limits. Or when you are in the set up and test phase, you might
only want to instrument a few pages to keep your initial sample manageable.
Use match rules to include or exclude certain pages
1.Expand Only enable Automatic Injection for certain Pages if it is closed.
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2. Click the plus icon to create a match rule or an exclude rule. The create screen appears.

3. Select one or more criteria to match. If you select multiple criteria, all must match for the rule to
come into effect. Use the gear icon to set a NOT condition.
See Fine-Tune Configurations Using Match Conditions for general information about match rules.
c. Click Save.
5. Click Save in the outer configuration screen.
You can later edit or remove a match rule by selecting it in the list and clicking the edit or delete
icon.
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Learn More

Set Up and Configure Web EUEM
Set Up Your Application for Web EUEM
Manual Injection
Assisted Injection-Using Injection Rules - Java Only
Assisted Injection-Using Attribute Injection
Assisted Injection-Using Injection Rules - Java Only

Access the JavaScript Injection Configuration Panel
Create JavaScript Injection Rules
Define Business Transactions to Instrument
Create the Rule
Learn More
To use assisted injection of the JavaScript agent using injection rules, you define rules to
configure:
the Java classes and methods that should be intercepted
the Java writer object and method to use to add the agent to the response object
Assisted injection is available for Java frameworks only.
Access the JavaScript Injection Configuration Panel

1.
2.
3.
4.
5.
6.

In the left navigation menu, click Configure -> Instrumentation.
Click the End User Experience tab.
Click the Web JavaScript Instrumentation tab if it is not already selected.
Scroll down to the Advanced panel and expand it if it is closed.
Expand Advanced Instrumentation of your HTML Pages if it is closed.
Click the Configure JavaScript Injection tab if it is not already selected.

Create JavaScript Injection Rules

1. In the Configure JavaScript Injection tab, expand Create Injection Rules if it is closed.
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2. Click the plus icon.
The Create Injection Rule screen is displayed.

3. Click the Where to Inject JavaScript tab.
4. In the Name field, enter a name for the rule and check Enable to enable it.
6. In the Class and Method to intercept section, define match conditions for the class and method
that write to the output stream in your application. This is the class that server-side
agent intercepts for injection.
7. If the write method is overloaded
a. check the Is this Method Overloaded? check box.
b. click Add Parameter.
c. add the parameters that define the method.
8. In the Pointer to the writer section, select how to obtain a reference to the writer object from the
selected method.
9. In the Injection options section, specify:
the output stream write method server-side agent should use to inject the JavaScript agent
when the injection should occur: when the method begins or when the method ends
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which part of the script should be injected - the header or the footer
optional prefix to output before writing the header or footer, such as <DOCTYPE. . . >
Define Business Transactions to Instrument

Optionally you can limit the business transactions for which the rule is enabled. By default the rule
is enabled for all business transactions. To enable it for specific business transactions only:
1. Click the Inject for these Business Transactions tab.

2. Select These Business Transactions.
3. Specify the business transactions for which the injection rule is enabled by moving them from
the Other Business Transactions list to the Selected Business Transactions list.
4. Specify the business transactions for which the injection rule is disabled by moving them to (or
leaving them in) the Other Business Transactions list.
Create the Rule

1.Click Create Injection rule.
2. Click Save
Learn More
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Set Up and Configure Web EUEM
Set Up Your Application for Web EUEM
Manual Injection
Automatic Injection
Assisted Injection-Using Attribute Injection
Assisted Injection-Using Attribute Injection

Copy Code Snippets into Your Page Template
Learn More
To use assisted injection of the JavaScript agent using attribute injection, you:
Enable attribute injection
Copy code snippets into your page template
Not all frameworks support attribute injection. See the Script Injection columns in the Sup
ported Platform Matrix for Web EUEM matrices to check if you can use this method.

Access the JavaScript Injection Configuration Panel
1.
2.
3.
4.
5.
6.

In the left navigation menu, click Configure -> Instrumentation.
Click the End User Experience tab.
Click the Web JavaScript Instrumentation tab if it is not already selected.
Scroll down to the Advanced panel and expand it if it is closed.
Expand Advanced Instrumentation of your HTML Pages if it is closed.
Click the Configure JavaScript Injection tab if it is not already selected.

7. Check Request Attribute Injection.
8. Click Save.
Copy Code Snippets into Your Page Template

The following examples show code snippets that can be copied directly into your page templates
or other code creating your page. These code snippets tell the app agent where to inject
information. The header value must be injected at the very top of the <head> section and the
footer value must be added at the very end of the code creating the page.
If you have already injected the header portion of the agent using manual injection, you can use
these code snippets to automatically inject the footer data portion only. In this case, add only the
JS_FOOTER values:
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JSF
<h:outputText rendered="#{AppDynamics_JS_HEADER != null}"
value='#{request.getAttribute("AppDynamics_JS_HEADER")}' escape="false"/>
<h:outputText rendered="#{AppDynamics_JS_FOOTER != null}"
value='#{request.getAttribute("AppDynamics_JS_FOOTER")}' escape="false"/>

JSP
<% if (request.getAttribute("AppDynamics_JS_HEADER") !=
<%=request.getAttribute("AppDynamics_JS_HEADER")%> <% }
<% if (request.getAttribute("AppDynamics_JS_FOOTER") !=
<%=request.getAttribute("AppDynamics_JS_FOOTER")%> <% }

null) { %>
%>
null) { %>
%>

Servlet
if (request.getAttribute("AppDynamics_JS_HEADER") != null)
{
out.write(request.getAttribute("AppDynamics_JS_HEADER".toString());
}
if (request.getAttribute("AppDynamics_JS_FOOTER") != null)
{
out.write(request.getAttribute("AppDynamics_JS_FOOTER").toString());
}

Groovy
<g:if test="${AppDynamics_JS_HEADER}">
${AppDynamics_JS_HEADER}
</g:if>
<g:if test="${AppDynamics_JS_FOOTER}">
${AppDynamics_JS_FOOTER}
</g:if>

Velocity Template
#if ($AppDynamics_JS_HEADER)
$AppDynamics_JS_HEADER
#end
#if ($AppDynamics_JS_FOOTER)
$AppDynamics_JS_FOOTER
#end

ASP.NET
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<% if (Context.Items.Contains("AppDynamics_JS_HEADER"))
Response.Write(Context.Items["AppDynamics_JS_HEADER"]); %>
<% if (Context.Items.Contains("AppDynamics_JS_FOOTER"))
Response.Write(Context.Items["AppDynamics_JS_FOOTER"]); %>

MVC Razor
@if(HttpContext.Current.Items.Contains("AppDynamics_JS_HEADER")
{ @Html.Raw((string)HttpContext.Current.Items["AppDynamics_JS_HEADER"]) }
@if(HttpContext.Current.Items.Contains("AppDynamics_JS_FOOTER") )
{ @Html.Raw(HttpContext.Current.Items["AppDynamics_JS_FOOTER"].ToString()) }

Learn More

Set Up and Configure Web EUEM
Set Up Your Application for Web EUEM
Manual Injection
Automatic Injection
Assisted Injection-Using Injection Rules - Java Only
Container Assisted Injection

If you are using Nginx or Apache as your web container, or you are using one of them as a reverse
proxy in front of your web container, you can use the substitution features offered by container
extensions to automatically inject the header portion of the JavaScript agent into your pages.
Injection Using Nginx
Injection Using Apache
If your installation connects Web EUEM to a server-side application that is also
instrumented, we recommend you also use assisted injection to add a footer to your pages,
if possible. Container assisted injection gives the server-side agent the ability to write data
only to the header of the page as it is being constructed by your web application.
Server-side business transaction information is sometimes not available until after the
header has already been written, so using a footer can ensure that the information is
captured. See Getting Full Timing Data for Associated Business Transactions for more
information.
Injection Using Nginx

Download the Agent
Configure Nginx
Sample Nginx Configuration
If you are using Nginx as your web container, or you are currently using, or willing to use, Nginx as
a reverse proxy (see here for more information), you can use a container substitution module to
automatically inject the JavaScript agent into your pages. The module intercepts the response
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object as it is being returned and makes a string substitution.
This module is an extension and is not necessarily built in Nginx by default. The build must be
enabled with the --with-http_sub_module configuration parameter. Check your version to
make sure it is available.
Download the Agent

You must first download the JavaScript agent from the Instrumentation tab of the Web EUEM
configuration screen.
1.
2.
3.
4.
5.
6.
7.

In the left navigation menu, click Configure -> Instrumentation.
Click the End User Experience tab.
Click the JavaScript Instrumentation subtab if it is not already selected.
Scroll down to the Instrument your HTML pages with the JavaScript Agent panel.
Click Download the JavaScript Agent.
Click Save to File to save it.
Place it somewhere accessible to the Nginx instance. The name of the saved file should be
"adrum.js".
You can also use an AppDynamics hosted version of the adrum script instead of
downloading it and placing it on your local system. See Options in Using Manual Injection
for the EUEM JavaScript Agent, in the "Using a Hosted Version of the JavaScript Agent"
section.

Configure Nginx

The ngx_http_sub_module module is a filter that modifies a response by replacing one
specified string by another. You can use this feature to have the server automatically inject the
header portion of the JavaScript agent into a served page. For more information on the process,
see the Nginx documentation, Module ngx_http_sub_module.
For example, modify the location context to replace the <head> tag with the <head> tag and the
JavaScript agent scripts.
Sample Nginx Configuration

location / {
sub_filter
<head>
'<head><script>window['adrum-start-time'] = new
Date().getTime();</script><script src="/adrum.js"></script>';
sub_filter_once on;
}

Where /adrum.js is the path to a copy of the adrum file that is accessible to the server. Note the
timer initialization: <script>window['adrum-start-time'] = new
Date().getTime();</script>. Keeping this as close as possible to the top of the
document, preferably right after the <head> tag, ensures the best possible timings.
If you use <meta> tags, you should place them right after your <head> tag, and then place the
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JavaScript agent directly after the last <meta> tag. This can avoid issues with some versions of
IE.
You may need to escape some characters, depending on your platform. For example, on MacOS:
location / {
sub_filter
<head>
'<head><script>window[\'adrum-start-time\'] = new
Date().getTime();</script><script src="/adrum.js"></script>';
sub_filter_once on;
}

This Nginx module is often used for adding the Google Analytics script. Be careful not to
overwrite any existing GA script when you do this.
Possible variations on the script string can be found in Options in Using Manual Injection for the
EUEM JavaScript Agent and Customizing the JavaScript Agent.
Injection Using Apache

Download the Agent
Configure Apache
Make Sure the Modules are Loaded
Create an Adrum Configuration File
Sample adrum.conf
Add the Location of the Adrum Configuration File to httpd.conf
Restart the Web Server
Alternates
Use the Directory Directive
Use .htaccess
If you are using Apache as your web container, or or you are currently using, or willing to use,
Apache as a reverse proxy, you can use a container substitution module to automatically inject the
JavaScript agent into your pages. The module intercepts the response object as it is being
returned and makes a string substitution.
This method uses two Apache modules: mod_substitute and mod_filter.
Apache documentation here and here.

Read the

Download the Agent

You must first download the JavaScript agent from the Instrumentation tab of the Web EUEM
configuration screen.
1.
2.
3.
4.
5.
6.

In the left navigation menu, click Configure -> Instrumentation.
Click the End User Experience tab.
Click the JavaScript Instrumentation subtab if it is not already selected.
Scroll down to the Instrument your HTML pages with the JavaScript Agent panel.
Click Download the JavaScript Agent.
Click Save to File to save it.

7.
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7. Place it somewhere accessible to the Apache instance. The name of the saved file should
be "adrum.js".
You can also use an AppDynamics hosted version of the adrum script instead of
downloading it and placing it on your local system. See Options in Using Manual Injection
for the EUEM JavaScript Agent, in the "Using a Hosted Version of the JavaScript Agent"
section.
Configure Apache

The basic set-up takes four steps:
1.
2.
3.
4.

Make Sure the Modules are Loaded
Create an Adrum Configuration File
Add the Location of the Adrum Configuration File to httpd.conf
Restart the Web Server

Make Sure the Modules are Loaded

Check your global Apache httpd.conf file and make sure that the following two LoadModule co
mmands are in the file:
LoadModule substitute_module modules/mod_substitute.so
LoadModule filter_module modules/mod_filter.so

Create an Adrum Configuration File

Create a file named adrum.conf with contents similar to the example below. In this case, the
substitution rule covers the location of the entire site (Location /) but you can also recursively
select a specific directory and its subdirectories by using /somedirectory. For more
information, see here:
Sample adrum.conf
<Location />
AllowOverride Options
FilterDeclare AdrumFilter
FilterProvider AdrumFilter SUBSTITUTE resp=Content-Type $text/html
FilterChain AdrumFilter
Substitute "s|<head>|<head><script>window['adrum-start-time'] = new
Date().getTime();</script><script src='/adrum.js'></script>|inq"
</Location>

Where /adrum.js is the path to a copy of the adrum file that is accessible to the server. The in
q after the | are flags:
i - matching is case-insensitive
n - pattern is treated as a fixed string (removing the n means the pattern is treated as a
regular expression)

Copyright © AppDynamics 2012-2014

Page 749

q - module does not flatten the buckets after each substitution - this can speed
performance.
For more information, see the Apache module docs here.
If your <head> tag has an attribute like <head lang="en">, you can use a regex in the
substitution string and omit the n flag. For example:
Substitute "s|(<head[^>]*>)|$1<script>window['adrum-start-time'] =
new Date().getTime();</script><script src='/adrum.js'></script>|iq"

Note the timer initialization: <script>window['adrum-start-time'] = new
Date().getTime();</script>. Injecting these scripts as close as possible to the top of the
document, preferably right after the <head> tag, ensures the best possible timings.
If you use <meta> tags, you should place them right after your <head> tag, and then place the
JavaScript agent directly after the last <meta> tag. This can avoid issues with some versions of
IE.
Add the Location of the Adrum Configuration File to httpd.conf

Add the following line to your global Apache httpd.conf file:
Include [absolutePathTo]/adrum.conf

Alternatively you can add the directives to the httpd.conf file directly instead of creating a
separate adrum file.
Restart the Web Server

To pick up the new configuration, restart:
sudo apchectl -k restart

If you get a warning "Useless use of AllowOverride in line 2 of [absolutePathTo]/adrum.conf", it
can be ignored. It simply means the AllowOverride is redundant. You can remove it if you wish.
Possible variations on the script string can be found in Options in Using Manual Injection for the
EUEM JavaScript Agent and Customizing the JavaScript Agent.
Alternates

If you are setting up your automatic injection using an Apache instance that is configured as a
reverse proxy, you must use the Location directive based method described above, with the Prox
yPass and ProxyPassReverse directives also in the Location directive. If you are using an
Apache instance that is your primary web container you have two additional options for describing
the actual substitution step:
Using the Directory Directive
Using .htaccess
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Use the Directory Directive

You can use the Directory directive instead of the Location directive, replacing your filter name for
<MyFilter>:
<Directory />
AllowOverride Options
FilterDeclare <MyFilter>
FilterProvider <MyFilter> SUBSTITUTE resp=Content-Type $text/html
FilterChain <MyFilter>
Substitute "s|<head>|<head><script>window['adrum-start-time'] = new
Date().getTime();</script><script src='/adrum.js'></script>|inq"
</Directory>

Where /adrum.js is the path to a copy of the adrum file that is accessible to the server.
Use .htaccess

Add lines similar to this to an .htaccess file in the base document directory for your site,
replacing your filter name for <MyFilter>. If you don't have an .htaccess file, create one:
AllowOverride Options
FilterDeclare <MyFilter>
FilterProvider <MyFilter> SUBSTITUTE resp=Content-Type $text/html
FilterChain <MyFilter>
Substitute "s|<head>|<head><script src='/adrum.js'></script>|inq"

Where /adrum.js is the path to a copy of the adrum file that is accessible to the server. Make
sure .htaccess is world-readable.
Customizing the JavaScript Agent

The JavaScript agent works correctly out of the box for most situations. You can, however,
customize adrum.js in specific situations, either by adding on to the manual injection scripts, or,
in the case of automatic or assisted injection, by having your web application insert the appropriate
code.
Add Custom User Data to a Browser Snapshot: Use this option to add application specific
user data in the form of key/value pairs to browser snapshots.
Set Custom Page Names with JavaScript: Use this option to set a page name not based on
the page URL
Handle the window.onerror Event: Use this option if your pages set the JavaScript window.
onerror event
Disable Web EUEM Programmatically: Use this option to temporarily disable data collection
on one or more pages
Set the Exact Current Domain in the JavaScript Agent Cookie: Use this option to have the
agent use the exact current domain when it writes its one cookie.
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Add Custom User Data to a Browser Snapshot

Add User Data
Filter by User Data
Modify User Data Size Limit
You can add user information that is specific to your application to a browser snapshot. The
information is expressed as key value pairs. The information appears in the User Data section of
the snapshot.
You should wrap any code you add with a test, in case the JS agent is turned off for any
reason. For example:
<!--Adding data to the AppDynamics snapshot -->
<script>
if (ADRUM)
{ ADRUM.command ("addUserData", <key>, <value>); }
</script>

Add User Data

To add user data, add the following script to the pages for which you want the additional data to
appear in the browser snapshots.
<script>
ADRUM.command ("addUserData", <key>, <value>);
</script>

The results appear in the browser snapshot in the User Data panel.
For example:
<script>
ADRUM.command ("addUserData", customer_id, getCustomerID());
</script>

might display in the User Data section:
customer_id 6005
<script>
ADRUM.command ("addUserData", movieTitle, getMovie(customerID);
</script>
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might display in the User Data section:
movieTitle The Matrix
Filter by User Data

You can filter browser snapshots based on user data in the Advanced section of the browser
snapshot filter:

Modify User Data Size Limit

The maximum size of all user data in a page is 100 bytes, unless you increase the limit using
setMaxBeaconLength().
<script>
ADRUM.command ("setMaxBeaconLength", nbytes);
</script>

You can set the user data size as high as 2000 bytes. Some browsers will not send packets larger
than this, so increasing this value may cause data to be dropped.
If you modify the user data size, the amount of space allocated to all user data fields scales
uniformly relative to their default sizes.
Set Custom Page Names with JavaScript

In the AppDynamics console, you can configure the names of pages, iframes and Ajax requests
based on various parts of the page URL. See Configure Page Identification and Naming.
To use any arbitrary string, not necessarily a part of the URL, to name a page or an iframe, (but
not an Ajax request) add the setPageName method to the page that you want to name. For
example, for a page named "My Page" use:
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<script>
ADRUM.command ("setPageName", "My Page")
<script>

The default page name is the DOM document title.
Handle the window.onerror Event

If any script on your monitored Web pages, including library code, sets the JavaScript window.on
error event, add the following method to the page immediately after setting window.onerror:
<script>
ADRUM.listenForErrors()
<script>

The JavaScript agent (adrum.js) sets window.onerror to listen for uncaught JavaScript errors.
If this listener is overwritten, errors will not be reported.
The agent will invoke your original onerror handler.
Disable Web EUEM Programmatically

For pages in which the JavaScript agent was injected manually, you can disable the agent
programmatically by adding a script to the header..
To disable Web EUEM add the
window["adrum-disable"] = true

script before adrum.js agent is injected.
For example:
<head>
// before adrum.js
<script>window["adrum-disable"] = true</script>
// adrum.js injection
<script>window["adrum-start-time"] = new
Date().getTime();</script><script src="/adrum.js"></script>

Old EUEM data is preserved but no new EUEM data is collected while the agent is disabled.
You can re-enable Web EUEM by removing the disable script.
Set the Exact Current Domain in the JavaScript Agent Cookie

The JavaScript agent itself writes a single cookie to the page, for timing purposes. This cookie is
set when the user clicks a link and the unload event is fired. By default the cookie is set to the
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broadest possible version of the originating domain (e.g. *.domain.com) to increase the likelihood
that the next page opened in the same domain can access that cookie. For more on how EUEM
uses cookies, see More on Cookies and EUEM Data.
In some cases, however, it may be necessary to limit the cookie to the full exact domain name. To
do this, add a flag in the "adrum-start-time" script to the header of each page right after the
<head> tag and before the entry that includes the location of the agent (adrum.js). The flag should
read: window["adrum-use-strict-domain-cookies"] = true.
After you include the start-time line, the strict domain flag, and the agent, the <head> section in
your EUEM-monitored web pages should look something like this:
<head>
<script>
window["adrum-start-time"] = new Date().getTime();
window["adrum-use-strict-domain-cookies"] = true;
</script>
<script src="/adrum.js"></script>
. . .
. . .
</head>

Check Web EUEM Configuration Issues

License Problems
You do not have a EUEM license key
EUEM works correctly in test environment, but problems arise on moving to
Production
Web EUEM Metrics Not Reported
Connection Problems
To verify connectivity
Unblocking a Firewall
To use a forward proxy
Verifying the Keystore Entries
To verify the keystore
Injection Problems
To verify that the JavaScript Agent for Web EUEM was injected
To change an injection strategy
Some Pages Not Monitored
Errors Not Reported
Browser Snapshot Problems
No Browser Snapshots
No Correlation between Browser Snapshots and Business Transactions
No Transaction Snapshots Associated with Browser Snapshots
Not Getting Full Timing Data for Business Transactions Associated with Browser
Snapshots
This document will guide you through troubleshooting common issues in the setup of your Web
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EUEM product. But first it may be useful to visualize the end to end flow of data:

If you do not see the EUEM data that you expect, use these suggestions to try to correct the
problem.
License Problems
You do not have a EUEM license key

The EUEM license is separate from the Controller license.
Call your AppDynamics sales representative or email salesops@appdynamics.com to obtain an
Web EUEM license key for your AppDynamics account.
The EUEM license key is included as part of the overall license file, but the license itself is still a
separate item that is provisioned separately.
Controllers cannot share an EUEM license key, but applications can.
EUEM works correctly in test environment, but problems arise on moving to Production

If you are running more than one Controller, each instance requires its own license. Make sure
you are not trying to use the same license on more than one Controller.
Web EUEM Metrics Not Reported

These steps provide a high-level overview to checking your Web EUEM setup.
1. Make sure there is load running on your app for the pages that you want to monitor for the
selected time period.
Tip: When Web EUEM discovers a new page, iframe, or Ajax call for the first time
there will be a several minute delay before data for it appears in the product.
After the agent is first injected into a page by any of the injection techniques, it takes up
to two or three minutes for the agent to register with the Controller. No metrics are
captured during this time.
After the page is registered and traffic starts flowing, it can take an additional two or
three minutes for the metrics to appear in the AppDynamics console.
In summary, the very first time the JavaScript agent accesses a page, it can take as
long as 6 minutes for the metrics to appear because of the initial registration.
Subsequently, the delay between an end-user click and the appearance of Web EUEM
data is two to three minutes.
2. Make sure that Web EUEM is enabled for the app. Enable EUEM if it is disabled.
See Enable and Disable Web EUEM.
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3. Examine the source of your web page to ensure that the pages that you want to monitor are
instrumented.
See To verify that the JavaScript Agent for WebEUEM was injected.
4. Make sure there is connectivity from the browser to the EUEM cloud. See Connection Problems
for information about troubleshooting connectivity.
5. Examine your instrumented application to verify that:
the JavaScript agent extension (adrum.ext) is loaded and its status is OK (200).
the EUEM beacon (adrum.gif) is loaded and its status is OK (200).
the ky parameter in the beacon is set to your application key.
You can use the Developer Tools for your web browser to examine your application. The Network
tab shows the agent extension and status.

Tip: Access to the Developer tools is different on different browsers.
On Chrome use View->Developer->Developer Tools.
On Safari use Develop->Show Web Inspector.
On Firefox use Tools->Web Developer.
If the adrum-ext agent extension file or the adrum-gif file from the web beacon are not present
or the status is not valid, verify your EUEM configuration. See Set Up and Configure Web EUEM.
Connection Problems

If your browser cannot connect to the AppDynamics EUEM cloud and you use an on-premise
Controller but not an on-premise EUEM Processor it is possible that:
you have no Internet connectivity
a firewall is blocking the port
the keystore does not trust the cert
To verify connectivity

Run the following command from your browser:
https://agg.eum-appdynamics.com/eumaggregator/ping

If you get a "ping" in the window, you should be able to connect to the EUEM cloud.
If you are using IE on a Windows system, make sure the browser itself does not have a proxy
(with authentication) set up. If it does, the test link may work but not the actual connection.
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Make sure you have also unblocked any firewalls and verified the keystore entries as described
below. If you are still having issues, contact AppDynamics Support.
Unblocking a Firewall

The controller needs to be able to use HTTP over SSL (HTTPS) on port 443 to reach the EUEM
cloud aggregator at agg.eum-appdynamics.com.
If your controller is behind a firewall, you can either open your controller's firewall or use a forward
proxy.
To open the firewall, see the instructions specific to your firewall.
You only need to open the firewall for the specific host and and port
(agg.eum-appdynamics.com on 443), not for the entire *.eum-appdynamics.com domain.
To use a forward proxy

1. Set up an HTTP proxy to https://agg.eum-appdynamics.com.
This is a cleartext/pass-through proxy. Authentication is not supported on the first level. If the
client network itself requires authentication you must set up an intermediate proxy between your
controller and this proxy to pass on the credentials you need to get out of your network.
2. Configure the HTTP proxy host and port in the <Controller-Installation-Directory>/
appserver/glassfish/domains/domain1/config/domain.xml file.
See Configure Controller HTTP Proxy Settings for details about configuring the proxy.
3. Restart the controller's app server.
Verifying the Keystore Entries

You need a valid trusted cert entry for the EUEM aggregator and a private key entry for the
Glassfish server instance underlying the controller.
To verify the keystore

1. Open a command prompt in the controller's glassfish directory, <AppDynamics_install_dir
>/appserver/glassfish
2. Run the keytool command:
keytool -list -keystore keystore.jks

2. Enter the keystore password.
Your keystore entries are displayed.
Your keystore should include a trusted certificate entry for "agg_appdynamics" and private key
entries for "EUEM_client" and "glassfish-instance" that look something like this:
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agg_appdynamics, Mar 18, 2013, trustedCertEntry,
Certificate fingerprint (MD5):
92:A7:19:E0:AF:07:C6:2E:91:6B:D6:47:5C:AD:B3:C7
glassfish-instance, Jul 11, 2012, PrivateKeyEntry,
Certificate fingerprint (MD5):
BE:DE:57:FF:BC:E2:32:AA:85:4C:4C:BD:6F:BC:EC:DE

If you do not have these entries, you need to create the certificate. Contact your System
Administrator or AppDynamics Support for information on how to do this.
Injection Problems

The JavaScript agent for Web EUEM must be injected into every page that you want to monitor for
EUEM data.
To verify that the JavaScript Agent for Web EUEM was injected

View the source of your web page. When automatic or assisted injection is used, you should see
the script for the JavaScript agent for EUEM inline in the web page. The actual version details of
the script may vary, but the first few lines of the agent look like this:

When manual injection is used, you will see:
<script src="/path_to_adrum.js"/>

If the agent is not there:
1. If you used manual injection, use the normal procedures that you use to verify other types of
code changes in your web pages. Keep in mind that various caches, such as the server page,
CDN or browser caches, can prevent the page from actually being reloaded. If you cannot get
manual injection to work, try one of the other injection schemes if they are available for your
platform. See Set Up Your Application for Web EUEM for information about the various injection
strategies.
2. If you used automatic injection, verify that the Enable Automatic injection of JavaScript check
box is checked in the configuration. Click Configure->Instrumentation->End User
Experience->Web JavaScript Instrumentation->Advanced->Advanced Instrumentation of
your HTML Pages->Automatic JavaScript Injection.
Also verify that automatic injection is enabled for all of the business transactions that you want to
monitor. If some of those business transactions are in the Automatic injection possible, but not
enabled list, move them to the Automatic injection enabled list. If the business transaction that
you want to monitor does not appear in either list, automatic injection is not possible for that
business transaction.
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For applications built on .NET, automatic injection is available for ASP.NET and ASPX
frameworks.
3. If you used assisted injection with injection rules for your Java application, verify that injection
rules were created and that the injection rules were enabled. Click Configure->Instrumentation->
End User Experience->Web JavaScript Instrumentation->Advanced->Advanced
Instrumentation of your HTML Pages->Configure JavaScript Injection to see the list of rules
and their enabled status. See Assisted Injection-Using Injection Rules - Java Only for information
about creating and enabling injection rules.

To change an injection strategy

If you try one way to inject the JavaScript agent for Web EUEM and it does not work, it is best to
undo the current injection configuration before implementing another one.
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To undo automatic injection, clear the Enable Automatic Injection of JavaScript check box.
To undo manual and assisted injection using attribute injection, manually delete the
JavaScript agent for Web EUEM code from your web pages.
To undo assisted injection using injection rules, clear the Enable check box for each
injection rule in the injection rules list.
If multiple copies of the agent exist on a page, the second copy does not execute.
Some Pages Not Monitored

If only some web pages are not reporting data, first verify that those pages have been injected with
the JavaScript agent for Web EUEM. See To verify that the JavaScript Agent for Web EUEM was
injected.
It the agent has been injected, the page may have been excluded from monitoring by custom
exclude rules, You can check and modify these rules. To access custom exclude rules for pages:
1. In the left navigation pane click Configure->Instrumentation.
2. Click the End User Experience subtab.
3. Click the Web Page Naming, Error Detection, Thresholds, etc. sub-tab.
4. Expand Configure how Pages, Ajax Requests, and iframes will be named if it is closed.
5. Scroll down to the Custom Exclude Rules list.
If there are any custom exclude rules, they are listed here.

6. To examine and/or modify a custom exclude rule select it in the list and click the Pencil icon.
If you want to remove a custom exclude rule, select it in the list and click the Minus icon.
In addition, certain pages could have been excluded by the injection configuration. This can
happen when automatic injection is used with a limited set of pages enabled for injection. If you
used automatic injection, check your automatic injection configuration to see if the missing pages
are enabled for injection. Examine the Request Match Rules and Request Exclude Rules lists
under Only enable Automatic Injection for certain Pages in the Automatic JavaScript Injection
tab. See Automatic Injection. Pages can be also be bypassed by assisted injection using injection
rules, when an injection rule specifies only classes and methods to be injected. If you used
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assisted injection with injection rules, check your injection rules. See Assisted Injection-Using
Injection Rules - Java Only.
Errors Not Reported

It is possible that reporting is disabled or that certain JavaScript or Ajax errors that you would like
to be reported as errors have been configured to be ignored. See Configure JavaScript and Ajax
Error Detection.
If another script on your monitored pages sets the JavaScript window.onerror event, this setting
can interfere with EUEM error capture. See Handle the window.onerror Event to learn how to
catch those errors.
Browser Snapshot Problems
No Browser Snapshots

If you do not see any browser snapshots, it is possible that browser snapshot collection has been
disabled. If periodic collection and error collection and slow collection are all disabled, the agent
does not collect any browser snapshots. See Configure Browser Snapshot Collection.
Also check the thresholds for that define slow end user experience. AppDynamics collects browser
snapshots only for slow-performing requests, so if the thresholds are set too high, no requests are
flagged as slow. See Configure EUEM Performance Thresholds.
No Correlation between Browser Snapshots and Business Transactions

You get server-side correlation with browser snapshots only if the business transactions
associated with the browser snapshot are running on application servers instrumented with
AppDynamics app agents. This could explain why you do not see any or do not see all of the
business transactions that you expect to see. Check which of your servers are instrumented by
app agents and which are not. You may need to get more AppDynamics app agent licenses to get
correlation.
If the app servers are all instrumented with AppDynamics app agents, it is possible that the
business transactions that you expect to see were not injected with the JavaScript agent for Web
EUEM. This can happen when automatic injection is used with a limited set of business
transactions enabled for injection. If you used automatic injection, check your automatic injection
configuration to see if the missing business transactions are enabled for injection. See To verify
that the JavaScript Agent for WebEUEM was injected and Automatic Injection. Business
transactions can also be excluded with assisted injection using injection rules, when an injection
rule specifies only certain business transactions to be injected. If you used assisted injection with
injection rules, check your injection rules. See Assisted Injection-Using Injection Rules - Java Only.
No Transaction Snapshots Associated with Browser Snapshots

Even if all your app servers are instrumented with AppDynamics app agents, it is possible that no
associated transaction snapshots were captured at the time of the browser snapshot. For
example, if no transactions were slow at the time of the browser snapshot, you probably will not
see any transaction snapshots. See Transaction Snapshots for information about when transaction
snapshots are captured. You can modify transaction snapshot capture. See Configure Transaction
Snapshots.
On the browser side, if a browser snapshot is associated with a transaction snapshot, you will see
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it in the Transaction Snapshots section of the browser snapshots. See Business Transactions in
Browser Snapshots. On the server side, if a transaction snapshot is associated with a browser
snapshot, you will see an EUEM GUID in the ADDITIONAL DATA tab in the transaction snapshot.
See Transaction Snapshots.
Not Getting Full Timing Data for Business Transactions Associated with Browser Snapshots

To ensure full business transaction timing information, you need to inject the JavaScript footer for
EUEM into the footer of your web pages. Manual injection of the agent does not inject into the
footer so you need to use another injection method to get this functionality.
See Getting Full Timing Data for Associated Business Transactions and Choosing Your Injection
Method.

Get More Information about Web EUEM
Use the following topics to learn more about Web EUEM:
Web EUEM Metrics provides a detailed list of all the metrics that EUEM collects
Web EUEM License explains how Web EUEM is licensed
Host a Geo Server describes the conditions under which you might want to host a custom
geo server and how you set one up
Supported Environments and Versions - Web EUEM lists how and to what degree various
browsers and platforms/frameworks are compatible with Web EUEM
Web EUEM Countries and Regions by Geo Dashboard covers the countries and regions
that Web EUEM's default geo server understands
Web EUEM Metrics

Web EUEM Timing Metrics Overview
Web EUEM Metrics Defined
Ajax Metrics Availability
Resource Timing Metrics
Learn More
Key Web EUEM metrics are displayed on the Geo, Page, Iframe, and Ajax dashboards. They can
also be seen on the All Pages and Top Pages lists and in the Metric Browser. In addition, the
Metric Browser gives you the ability to view these metrics in the context of Ajax requests, iframes,
applications, base pages, browsers, devices, and geographic locations.

You can build custom health rules based on Web EUEM Page, Ajax, and iframe metrics in the
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health rule builder. Use these rules to automatically monitor key metrics in your installation. For
more information, see Health Rules.
Web EUEM Timing Metrics Overview

The following provides an overview of the basic Web EUEM page and iframe timing metrics. For
key Ajax metrics, see here. Metrics in black are available from both modern browsers that support
the Navigation Timing API, and older browsers. Metrics in blue are available only from NavTime
browsers. You may see a value of unknown for some metrics taken using older browsers.
When users begin to load the first instrumented page, a timer is started by the JavaScript agent.
The timer, or the NavTime responseStart, begins the first page timing.

For all subsequent pages, a cookie is set by the agent when the Prompt for unload event
happens on the current page. This cookie, or the NavTime navigationStart, initializes a fuller
picture of the entire page loading sequence.
Because a NavTime browser always sets navigationStart, you can get this information
from it even on the first page a user loads from your site.
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Navigation Timing capable browsers also provide highly granular information on connection
details.

Web EUEM Metrics Defined

Time metrics are the average times, in milliseconds, over the time range selected in the Controller
UI or REST API call. The three letter abbreviation is the short name as it is recorded in the web
beacon.
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Name

Short Name

NavTiming
Capable
Browsers +

Browsers
without
NavTiming
Support

Available
For . . .

Definition

Ajax
Callback
Execution
Time
In 3.7 this
metric was
called Docum
ent
Processing
Time

DPT

responseEn
d to
domContent
LoadedEven
tStart in
the context of
the Ajax
object

responseEn
d to
domConten
tLoadedEve
ntStart in
the context of
the Ajax
object

Ajax
Requests

Time for the
browser to
process the
Ajax
response; this
typically
includes the
time to apply
the response
data to the
DOM

Ajax
Response
Download
Time
In 3.7 this
metric was
called Docum
ent Download
Time

DDT

responseSt
art to
responseEn
d in the
context of the
Ajax object

responseSt
art to
responseEn
d in the
context of the
Ajax object

Ajax
Requests

Time for the
browser to
download the
complete
Ajax
response

Ajax
Request
Errors per
Minute

Based on
ARE entries

Ajax
Requests,
App,
Browser,
Device and
Geo

Total number
of Ajax
requests that
generate an
error per
minute

Ajax
Requests
per Minute

Based on
PLC entries

App,
Browser,
Device, and
Geo

Total number
of Ajax
requests per
minute

Ajax
Requests
App, Base
Pages,
Browser,
Device, Geo,
and iframes

Number of
requests that
actually hit
the
application
server, rather
than a cache

Application
Server Calls
per Minute
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Application
Server Time

Ajax
Requests,
App, Base
Pages,
Browser,
Device, Geo,
and iframe

Processing
time for
requests on
the
application
server

DOM
Building
Time
In 3.7 this
metric was
called Docum
ent
Processing
Time

DPT

responseEn
d to
domContent
LoadedEven
tStart

N/A

App, Base
Pages,
Browser,
Device, Geo,
and iframes

Time for the
browser to
build the
Document
Object Model
(DOM) and
make it
available for
JavaScript to
apply
rendering
logic

DOM Ready
Time

DOM

navigation
Start to dom
ContentLoa
dedEventSt
art

Time
between the
writing of the
starttime c
ookie on the
previous
page and an
internal
handler's onr
eady event,
similar to jqu
ery.onread
y()

App, Base
Pages, and
Geo

Interval
between the
time that a
user initiates
a request and
the time that
the
DOMContent
Loaded event
(or the
internal
handler's onr
eady event)
occurs

Domain
Lookup Time

DNS

domainLook
upStart to
domainLook
upEnd

N/A

App, Base
Pages,
Browser,
Device, Geo,
and iframes

Time to
complete the
domain
lookup
portion of the
server
connection
time
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End User
Response
Time

PLT

navigation
Start to
loadEventE
nd

Time
between the
writing of the
starttime c
ookie on the
previous
page and the
onload even
t

Ajax
Requests,
App, Base
Pages,
Browser,
Device, Geo,
and iframes

Average
interval
between the
time that a
user initiates
a request and
the
completion of
the page load
of the
response in
the user's
browser. In
the context of
an Ajax
request, it
ends when
the response
has been
completely
processed.

First Byte
Time

FBT

navigation
Start to res
ponseStart

Time
between the
writing of the
starttime c
ookie on the
previous
page and
when the
page's
JavaScript
agent begins
executing

Ajax
Requests,
App, Base
Pages,
Browser,
Device, Geo,
and iframes

Interval
between the
time that a
user initiates
a request and
the time that
the browser
receives the
first response
byte. In the
context of an
Ajax request,
First Byte
Time is the
interval
between the
Ajax request
dispatch and
the time that
the browser
receives the
first response
byte.
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Front End
Time

FET

responseSt
art to
loadEventE
nd

Time
between
when the
page's
JavaScript
agent begins
executing
and the onl
oad event.

App, Base
Pages,
Browser,
Device, Geo,
and iframes

Interval
between the
arrival of the
first byte of
text response
and the
completion of
the response
page
rendering by
the browser.
Includes
HTML
Download,
DOM Building
Time, and
Resource
Fetch Time.

HTML
Download
and DOM
Building
Time
In 3.7 this
metric was
called Docum
ent Ready
Time

DRT

responseSt
art to
domContent
LoadedEven
tStart

Time
between
when the
page's
JavaScript
agent begins
executing
and an
internal
handler's onr
eady event,
similar to jqu
ery.onread
y().

App, Base
Pages,
Browser,
Device, Geo,
and iframes

Time to make
the complete
HTML
document
(DOM)
available for
JavaScript to
apply
rendering
logic.
Includes the
HTML
Download
and the DOM
Building
Time.

HTML
Download
Time
In 3.7 this
metric was
called Docum
ent Download
Time

DDT

responseSt
art to
responseEn
d

N/A

App, Base
Pages,
Browser,
Device, Geo,
and iframe

Time for the
browser to
download the
complete
HTML
document
content

Iframe
Requests
per Minute

Based on
PLC entries

App,
Browser,
Device, and
Geo

Total number
of iframe
requests per
minute
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Page
Requests
per Minute

Based on
PLC entries

App,
Browser,
Device, and
Geo

Total number
of Page
requests per
minute. This
is the metric
displayed
across most
of the UI.

Page views
with
JavaScript
Errors per
minute

Based on
EPM entries

App, Base
Pages,
Browser,
Device, Geo,
and iframes

Total
number of
page views
that contain
JavaScript
errors per
minute

Resource
Fetch Time
In 3.7 this
metric was
called Page
Render
Time.

PRT

domContent
LoadedEven
tStart to
loadEventE
nd

Time
between an
internal
handler's onr
eady event,
similar to jqu
ery.onread
y(), and onl
oad.

App, Base
Pages,
Browser,
Device, Geo,
and iframes

Time for the
browser to
complete the
download of
remaining
resources,
including
images, and
finish
rendering the
page

Response
Available
Time

RAT

requestSta
rt to
responseSt
art

N/A

App, Base
Pages,
Browser,
Device, Geo,
and iframes

Interval
between the
beginning of
the
processing of
the request
on the
browser to
the time that
the browser
receives the
response.
Includes time
in the network
from the
user's
browser to
the server.
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Requests
per Minute

Based on
PLC entries

Server
Connection
Time

SCT

navigation
Start to
requestSta
rt

SSL
Handshake
Time

SSL

secureConn
ectionStar
t to
connectEnd

Synthetic
Requests
per Minute
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Ajax
Requests,
App, Base
Pages,
Browser,
Device, Geo,
and iframess

Total number
of requests
(Page + Ajax
+ iframe) per
minute

N/A

App, Base
Pages,
Browser,
Device, Geo,
and iframes

Interval
between the
time that a
user initiates
a request and
the start of
fetching the
response
document
from the
server or
application
task. Includes
the time
spent on
redirects,
domain
lookups, TCP
connects and
SSL
handshakes.

N/A

App, Base
Pages,
Browser,
Device, Geo,
and iframes

Time taken to
complete the
SSL
handshake

Ajax
Requests,
App, Base
Pages, Geo,
and iframes

Total number
of requests
from synthetic
monitoring
agents, like
Web Page
Test, per
minute
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TCP
Connect
Time

TCP

connectSta
rt to
connectEnd
.

N/A

App, Base
Pages,
Browser,
Device, Geo,
and iframes

Time to
complete the
TCP connect
portion of the
server
connection
time, the
equivalent of
one network
round trip of
latency

+ NavTiming capable browsers support the W3C Navigation Timing API.

If you are upgrading from controller version 3.7.x to 3.8+, the data that was stored
previously in the database under old names (Document Download Time, Document Ready
Time, Document Processing Time, and Page Render Time) is no longer surfaced to the
user interface. The data is still in the database, however, under the old name, and is visible
in the metric browser.
Ajax Metrics Availability

Because Ajax requests occur in the context of the larger page, these four core metrics are always
available, regardless of the browser type.

For more information on which browsers support the Navigation Timing API, see the Can I Use we
b site.
Resource Timing Metrics

For browsers that support the Resource Timing API, the following additional metrics are available
based on resources that are loaded during Resource Fetch Time:
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Name

Definition

Scripts Loaded per Pageview

Number of JavaScript files (*.js) downloaded
with this pageview

Images Loaded per Pageview

Number of image files (*.bmp, *.gif, *.jpeg,
*.jpg, *.png, *.webp) files downloaded with this
pageview

Resources Loaded per Pageview

Number of all resource files (the above plus
*.css, *.svg, *.htm, *.html, *.ttf, *.woff, *.otf,
*.eot) files downloaded with this pageview

Learn More

Metric Browser
Use the AppDynamics REST API
The Pages and Ajax Requests View
Page, Ajax, and Iframe Dashboards
The Web EUEM Geo Dashboard View
Browser Snapshots
WC3 Navigation Timing API Overview
Web EUEM License
EUEM License Information
To view EUEM License Information
License Type
Usage Period
License Key
Web EUEM Agents Licensed
Page Views Allocated
Page Views Consumed
Overages
Learn More
This topic describes how to interpret the details of your Web EUEM licensing information.
It assumes that you have acquired your Web EUEM license from your AppDynamics sales
representative.
EUEM License Information

Your EUEM license is separate from your Controller license. It covers both Web EUEM and Mobile
EUEM.
To view EUEM License Information

1. In the upper right section of the Controller UI, click Gear Icon -> License.
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2. See the End User Monitoring panel.
License Type

A Web EUEM PRO license allows a specific number of page views per year, per agent.
A page view is an instance of a base page loaded by a Web browser. Repeated views of a single
page are counted as separate page views.
AppDynamics counts a page view each time the JavaScript agent for Web EUEM is executed on a
base page. Only page views of pages that are instrumented by the agent are counted as page
views consumed. For example, pages excluded from monitoring through EUEM configuration are
not counted. Views of Ajax requests and iframes are not counted as page views consumed.
A Web EUEM Lite license includes the following features: Geo Dashboard, Page/Iframe List, and
Usage Stats for the previous 24 hour period for up to 500 million page views. Access via APIs is
supported.
Usage Period

The usage period is per year, even if you have a multi-year license.
The EUEM meter resets every year based on the expiration of your license agreement. For
example, if your license expires on 5/15/2020, your usage period resets every year on 5/15.
License Key

This is the license key associated with your EUEM license.
Web EUEM Agents Licensed

This is the number of EUEM agents you have currently licensed. Each agent provides a certain
number of annual page views.
Page Views Allocated

This is the number of page views allocated for the current usage period by your Web EUEM
license agreement.
Page Views Consumed

This is the number of page views consumed during the current usage period.
If this value is greater than Page Views Allocated and your license allows overages, you are
incurring overage charges.
If you need to stop incurring overage charges, you can disable Web EUEM by clearing the Enable
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End User Monitoring check box in the EUEM configuration window. This will stop end user
monitoring and stop page views from being charged after a delay of approximately one minute.

Overages

How overages are handled is determined by the terms of your Web EUEM license agreement.
When you reach a limit you are notified at the top of the All Pages section of the Pages & Ajax
Requests tab.
If your license does not allow overages, AppDynamics stops reporting EUEM metrics after your
limit has been reached.
If your license does allow overages and your usage exceeds the limit, AppDynamics continues
reporting EUEM metrics and bills you for the overage at the unit rate stipulated by your license
agreement pro-rated over the number of page views that exceed the limit.
Learn More

The Pages and Ajax Requests View
Set Up and Configure Web EUEM
Host a Geo Server
AppDynamics hosts a geo server that resolves the user's geographic location based on the
request's reported IP address. Some customers prefer to host their own geo server because:
they have intranet applications where the public IP address does not provide meaningful
location information but the user's private IP does.
they have a hybrid application where some users access the application from a private
location and some access it from a public one. If a user doesn't come from a specific private
IP range mapped by the custom geo server, the system can be set to default to the public
geo server.
As of version 3.9.2, the custom geo server also supports a new HTTP
header, AD-X-Forwarded-For. You can use this to declare an IP address specifically for the
purpose of geo resolution.
See Use a Custom Geo Server For Web EUEM for more information on setting up your own geo
server and private IP mapping file.
See Alternate Geo Server Location for information on configuring your deployment to use a
custom geo server.
Use a Custom Geo Server For Web EUEM

Download the Geo Server File
Set the Location of the Geo Server
Create the IP Mapping File
Using a Hybrid Custom-Public Geo Server Setup
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Customize File Locations
Deploy a Custom Geo Server on Windows
Precedence in Resolving Locations
Turn on Debugging
By default, end-users' locations are resolved using public geographic databases. You can host an
alternate geo server for your countries, regions, and cities instead of using the default geo server
hosted by AppDynamics.
You may prefer to host your own geo server because:
you have intranet applications where the public IP address does not provide
meaningful location information but the user's private IP does.
you have a hybrid application where some users access the application from a private
location and some access it from a public one. If a user doesn't come from a specific
private IP range mapped by the custom geo server, the system can be set to default
to the public geo server.
To host a custom geo server:
1.
2.
3.
4.

Download the Geo Server File
Set the Location of the Geo Server
Create the IP Mapping File
Customize File Locations

With the release of version 3.9.2 the geo server module has undergone a significant
update. If you already have a custom geo server, you can continue to use it as is, unless
you want to add support for the newly introduced AD-X-Forwarded-For HTTP header,
which is only available in the new version. This header allows you to declare a specific IP
address to use for geo-resolution.
Download the Geo Server File

Download the GeoServer.zip file from AppDynamics at
http://download.appdynamics.com/onpremise/public/latest/GeoServer.zip
This compressed file contains:
geo.war
config-template.xml
schema.xsd
README.txt
Deploy the geo.war in a separate Tomcat/Jetty web container. Do not deploy the geo.war file in
the same container as the controller.
Set the Location of the Geo Server

Enter the URL, including the context root, of your hosted geo server in the Geo Server URL field in
the EUEM configuration screen in the Controller UI. In the following configuration the context root
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is "/geo".

For more information, see Customize Your Web EUEM Deployment.
If you are using manual injection for your JavaScript agent, you must make sure that the copy
of the script that you use is one that you have downloaded after this URL is set.
Create the IP Mapping File

The geo-ip-mappings.xml IP mapping file specifies the locations for which EUEM provides
geographic data. It maps IP addresses to geographic locations.
Edit config-template.xml, which was downloaded with the geo.war file, for your environment.
Once you have filled it in, save it as geo-ip-mappings.xml. Any modifications at runtime are
reloaded without a restart.
This file contains a <mapping> element for every location to be monitored. The file has the
following format.

<mappings>
<mapping>
<subnet from="192.168.1.1" mask="255.255.255.0"/>
<location country="United States" region="California" city="San
Francisco"/>
</mapping>
<default country="United States" region="California" city="San
Francisco"/>
</mappings>

The schema file, schema.xsd, also provides an ip-range element to be used instead of the
subnet element if that is how your system is set up.
This data is visible in browser snapshots and can be used to filter browser snapshots and to filter
browser snapshots for specific locations:The <country>, <region>, and <city> elements are
required. If the values of <country> and <region> do not correspond to an actual geographic
location already defined in the geographic database, map support is not available for the location
in the EUEM map panel, but EUEM metrics are displayed for the location in the grid view of the
geographic distribution, end user response time panel, trend graphs, browser distribution panel,
and in the Metric Browser. The <city> element can be a string that represents the static location of
the end-user. You will notice a <default> element. If there is an IP address that is not covered by
your IP mapping file this is the value that is used. To use a public geo server for non-covered IP
addresses, see Using a Hybrid Custom-Public Geo Server Setup.
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The valid names for country and region are those used in the map in the geo dashboard. You can
hover over a region in the dashboard to see the exact name (including spelling and case) of the
region. See The Web EUEM Geo Dashboard View.
Using a Hybrid Custom-Public Geo Server Setup

If you want EUEM to evaluate any non-mapped IP address using the public geo server, remove
the <default> element. In this case locating any non-mapped IP address is done in the EUEM
cloud, not locally.
Customize File Locations

By default the custom geo server looks for geo-ip-mappings.xml in /opt/geo/geo-ip-map
pings.xml and places logs in /opt/geo/logs/. If you wish them to be elsewhere you can edit
web.xml to set the path. The web.xml file is in the geo.war file, under WEB-INF.
Add the path information as follows:
<context-param>
<param-name>AD_GEO_CONFIG_FILE</param-name>
<param-value>{path-to-file}/geo-ip-mappings.xml</param-value>
</context-param>
<context-param>
<param-name>AD_LOG_HOME</param-name>
<param-value>{path-to-directory}</param-value>
</context-param>

You can also use the -DAD_GEO_CONFIG_FILE startup parameter to set the path for the
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mapping file and -DAD_LOG_HOME for logs.
Deploy a Custom Geo Server on Windows

If you are deploying your custom geo server on Windows, use the following additional instructions.
1. Unzip the GeoServer.zip file you downloaded in Download the Geo Server File to
D:\Appdynamics.
2. Copy D:\Appdynamics\geo\config-template.xml to D:\Appdynamics\geo\geo-ip-mappings.xml.
3. Edit the geo-ip-mappings.xml file as described in Create the IP Mapping File above.
4. Copy D:\Appdynamics\geo\geo.war to D:\apache-tomcat\webapps.
5. Restart the Tomcat server.
6. Stop the Tomcat server.
7. Add the location of the mapping file and the log directory in
D:\apache-tomcat\webapps\geo\WEB-INF\web.xml:
<context-param>
<param-name>AD_GEO_CONFIG_FILE</param-name>
<param-value>D:\Appdynamics\geo\geo-ip-mappings.xml</param-value>
</context-param>
<context-param>
<param-name>AD_LOG_HOME</param-name>
<param-value>D:\Appdynamics\geo\log</param-value>
</context-param>

You can also use the -DAD_GEO_CONFIG_FILE startup parameter to set the path for the
mapping file and -DAD_LOG_HOME to set the path for the log directory.
8. Start the Tomcat server.
9. Test as follows on a Web browser that is not IE:
http://<host>:<port>/geo/resolve.js?ip=192.168.1.1

For example, if you mapped 192.168.1.1 to India/Kernataka/Bangalore, the result would be a
JSON document similar to this:
((window.ADRUM || {}).geo || {}).result = {
"country": "India",
"region": "Karnataka"
"city": "Bangalore"
"localIP": "c0180101"
}

The localIP value is a hex-encoded version of the original IP (in this case, 192.168.1.1),
compressed for space.
Precedence in Resolving Locations
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The custom geo server resolves locations based on the following precedence, from highest to
lowest:
An explicit query parameter: for example, http://mycompany.com/geo/resolve.js?ip=196.166.
2.1
An IP provided using the new header AD-X-Forwarded-For
An IP provided using the X-Forwarded-For header
The remote address of the HTTP request
Turn on Debugging

To turn on debugging:
1. Open WEB-INF/classes/logback.xml with a text editor
2. Change the root element level attribute from INFO to DEBUG.
. . .
<root level="DEBUG">
<appender-ref ref="FILE" />
<appender-ref ref="STDOUT" />
</root>
</configuration>

Learn More
Host a Geo Server
The Web EUEM Geo Dashboard View

Supported Environments and Versions - Web EUEM

Supported Platform Matrix for Web EUEM
Web End User Experience Management Browser Compatibility
Web End User Experience Management (EUEM) Compatibility in Java Environments
Web End User Experience Management (Web EUEM) Compatibility in .NET
Environments
Supported Runtime Environments for .NET Web EUEM
Supported Platform Matrix for Web EUEM
Web End User Experience Management Browser Compatibility

The following Web browsers are certified for the JavaScript agent for Web EUEM.

Copyright © AppDynamics 2012-2014

Page 780

Browser

Windows

Linux

Mac

iOS
(iPhone
and iPad)

Android
(Phone
and
Tablet)

Supports
Resource
Timing
API

Chrome
23.x

x

x

x

x

x

x

Chrome
26.x
Chrome
27.x

x

Chrome
28.x

x

x

x

x

x

x

x

x

Chrome
29.x

x

Firefox 3.0

x

x

x

Firefox 3.5

x

x

x

Firefox 3.6

x

Firefox 4.x

x

x

x

Firefox 5.x

x

x

x

Firefox 6.x

x

x

x

Firefox 7.x

x

x

x

Firefox 8.x

x

x

x

Firefox 9.x

x

x

x

Firefox
10.x

x

x

x

Firefox
11.x

x

x

x

Firefox
12.x

x

x

x

Firefox
13.x

x

x

x

Firefox
14.x

x

x

x

Firefox
15.x

x

x

x
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Firefox
16.x

x

x

x

Firefox
17.x

x

x

x

Firefox
18.x

x

x

x

Firefox
19.x

x

x

x

Firefox
20.x

x

x

x

Firefox
21.x

x

x

x

IE 10

x

IE 9.x

x

IE 8.x

x

IE 7.x

x

IE 6.x

x

x

Mobile
Safari 5.1

x

Mobile
Safari 6

x

Safari 5.x

x

x

Safari 6.x

x

Opera 11

x

Opera 12

x

x

x
x

Web End User Experience Management (EUEM) Compatibility in Java Environments

Manual injection for the JavaScript agent is available for all Java web application environments.
In addition, the following frameworks are certified for the following Web EUEM instrumentation
strategies.
All these frameworks support manual injection of the JavaScript agent for Web EUEM.
Additional supported script injection strategies are listed in the Script Injection column. See
Set Up Your Application for Web EUEM for details.
Web Application/
AJAX Frameworks
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JSP

Servlet 2.3

Tomcat 7x ,
GlassFish v3,
Weblogic (Assisted
only)

Automatic / Assisted

JSF

MyFaces,
ICEFaces,
ADF

Tomcat 7x , Glassfish
v3

Manual

Tapestry

5.0

Struts

2

Manual
Tomcat 7x, GlassFish
v3

Automatic / Assisted

Spring MVC

Tomcat 7x

Automatic / Assisted

Grails

Tomcat 7x, Glassfish
v3, Weblogic 12c

Manual

Wicket

Tomcat 7

Automatic / Assisted

Web Objects

Manual

Liferay

Manual

ZK

Manual

JQuery

Tomcat 7

Automatic / Assisted

MooTools

Tomcat 7

Automatic / Assisted

DWR

Tomcat 7, Glassfish
V3, Weblogic 12c

Automatic / Assisted

YUI

Tomcat 7

Automatic / Assisted

EXT JS

Tomcat 7

Automatic / Assisted

Dojo Web tool kits

Tomcat 7, Glassfish
V3, Weblogic 12c

Automatic / Assisted

GWT

Manual

angular JS

Manual

backbone

Manual

Web End User Experience Management (Web EUEM) Compatibility in .NET Environments

AppDynamics certifies Web EUEM instrumentation for the following .NET frameworks.
All listed frameworks support manual injection of the JavaScript agent for Web EUEM.
Additional supported script injection strategies are listed in the Script Injection column. See
Set Up Your Application for Web EUEM for details.
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Web Application/ AJAX
Frameworks

Versions

Additional Supported Script
Injection Methods

ASP.NET Web Forms (.aspx)

3, 4

Automatic, Assisted
Injection-Using Attribute
Injection

ASP.NET MVC Web Forms
(.aspx)

3, 4

Automatic, Assisted
Injection-Using Attribute
Injection

ASP.NET MVC Razor

3, 4, 5

Assisted Injection-Using
Attribute Injection

Microsoft SharePoint

2007, 2010

Automatic

AppDynamics does not support Web EUEM instrumentation of legacy ASP (.asp) pages.
Supported Runtime Environments for .NET Web EUEM

Microsoft IIS versions 6.0, 7.0, 7.5, 8.0
Web EUEM Countries and Regions by Geo Dashboard
Countries
Regions
The following countries and regions are displayed in the geographic dashboard. Each of these
countries and regions also display their own aggregate EUEM data. Data can be collected from
areas not in the following list, but it will not be displayed in these parts of the interface.
Countries

The following countries are displayed in the geo dashboard.
A-D

Afghanistan
Aland Islands
Albania
Algeria
American
Samoa
Andorra
Angola
Anguilla
Antarctica
Antigua and
Barbuda
Argentina
Armenia
Aruba
Asia/Pacific
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Region
Australia
Austria
Azerbaijan
Bahamas
Bahrain
Bangladesh
Barbados
Belarus
Belgium
Belize
Benin
Bermuda
Bhutan
Bolivia
Bonaire, Saint
Eustatius and
Saba
Bosnia and
Herzegovina
Botswana
Bouvet Island
Brazil
British Indian
Ocean
Territory
Brunei
Darussalam
Bulgaria
Burkina Faso
Burundi
Cambodia
Cameroon
Canada
Cape Verde
Cayman
Islands
Central
African
Republic
Chad
Chile
China
Christmas
Island
Cocos
(Keeling)
Islands
Colombia
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Comoros
Congo
Congo, The
Democratic
Republic of
the
Cook Islands
Costa Rica
Cote d'Ivoire
Croatia
Cuba
Curacao
Cyprus
Czech
Republic
Denmark
Djibouti
Dominica
Dominican
Republic
E-K

Ecuador
Egypt
El Salvador
Equatorial
Guinea
Eritrea
Estonia
Ethiopia
Europe
Falkland
Islands
(Malvinas)
Faroe Islands
Fiji
Finland
France
French
Guiana
French
Polynesia
French
Southern
Territories
Gabon
Gambia
Georgia
Germany
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Ghana
Gibraltar
Greece
Greenland
Grenada
Guadeloupe
Guam
Guatemala
Guernsey
Guinea
Guinea-Bissa
u
Guyana
Haiti
Heard Island
and McDonald
Islands
Holy See
(Vatican City
State)
Honduras
Hong Kong
Hungary
Iceland
India
Indonesia
Iran, Islamic
Republic of
Iraq
Ireland
Isle of Man
Israel
Italy
Jamaica
Japan
Jersey
Jordan
Kazakhstan
Kenya
Kiribati
Korea,
Democratic
People's
Republic of
Korea,
Republic of
Kuwait
Kyrgyzstan
L-Q
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Lao People's
Democratic
Republic
Latvia
Lebanon
Lesotho
Liberia
Libyan Arab
Jamahiriya
Liechtenstein
Lithuania
Luxembourg
Macao
Macedonia
Madagascar
Malawi
Malaysia
Maldives
Mali
Malta
Marshall
Islands
Martinique
Mauritania
Mauritius
Mayotte
Mexico
Micronesia,
Federated
States of
Moldova,
Republic of
Monaco
Mongolia
Montenegro
Montserrat
Morocco
Mozambique
Myanmar
Namibia
Nauru
Nepal
Netherlands
New
Caledonia
New Zealand
Nicaragua
Niger
Nigeria
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Niue
Norfolk Island
Northern
Mariana
Islands
Norway
Oman
Pakistan
Palau
Palestinian
Territory
Panama
Papua New
Guinea
Paraguay
Peru
Philippines
Pitcairn
Poland
Portugal
Puerto Rico
Qatar
R-Z

Reunion
Romania
Russian
Federation
Rwanda
Saint
Bartelemey
Saint Helena
Saint Kitts and
Nevis
Saint Lucia
Saint Martin
Saint Pierre
and Miquelon
Saint Vincent
and the
Grenadines
Samoa
San Marino
Sao Tome
and Principe
Saudi Arabia
Senegal
Serbia
Seychelles
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Sierra Leone
Singapore
Sint Maarten
Slovakia
Slovenia
Solomon
Islands
Somalia
South Africa
South Georgia
and the South
Sandwich
Islands
Spain
Sri Lanka
Sudan
Suriname
Svalbard and
Jan Mayen
Swaziland
Sweden
Switzerland
Syrian Arab
Republic
Taiwan
Tajikistan
Tanzania,
United
Republic of
Thailand
Timor-Leste
Togo
Tokelau
Tonga
Trinidad and
Tobago
Tunisia
Turkey
Turkmenistan
Turks and
Caicos Islands
Tuvalu
Uganda
Ukraine
United Arab
Emirates
United
Kingdom
United States
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United States
Minor Outlying
Islands
Uruguay
Uzbekistan
Vanuatu
Venezuela
Vietnam
Virgin Islands,
British
Virgin Islands,
U.S.
Wallis and
Futuna
Western
Sahara
Yemen
Zambia
Zimbabwe
Regions

The following countries displayed in the geo dashboard also report data by region.
A-G

Afghanistan,
Badakhshan
Afghanistan,
Badghis
Afghanistan,
Baghlan
Afghanistan,
Balkh
Afghanistan,
Bamian
Afghanistan,
Daykondi
Afghanistan,
Farah
Afghanistan,
Faryab
Afghanistan,
Ghazni
Afghanistan,
Ghowr
Afghanistan,
Helmand
Afghanistan,
Herat
Afghanistan,
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Jowzjan
Afghanistan,
Kabol
Afghanistan,
Kandahar
Afghanistan,
Kapisa
Afghanistan,
Khowst
Afghanistan,
Konar
Afghanistan,
Kondoz
Afghanistan,
Laghman
Afghanistan,
Lowgar
Afghanistan,
Nangarhar
Afghanistan,
Nimruz
Afghanistan,
Nurestan
Afghanistan,
Oruzgan
Afghanistan,
Paktia
Afghanistan,
Paktika
Afghanistan,
Panjshir
Afghanistan,
Parvan
Afghanistan,
Samangan
Afghanistan,
Sar-e Pol
Afghanistan,
Takhar
Afghanistan,
Vardak
Afghanistan,
Zabol
Albania, Berat
Albania, Diber
Albania,
Durres
Albania,
Elbasan
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Albania, Fier
Albania,
Gjirokaster
Albania, Korce
Albania,
Kukes
Albania,
Lezhe
Albania,
Shkoder
Albania,
Tirane
Albania, Vlore
Algeria, Adrar
Algeria, Ain
Defla
Algeria, Ain
Temouchent
Algeria, Alger
Algeria,
Annaba
Algeria, Batna
Algeria,
Bechar
Algeria, Bejaia
Algeria, Biskra
Algeria, Blida
Algeria, Bordj
Bou Arreridj
Algeria,
Bouira
Algeria,
Boumerdes
Algeria, Chlef
Algeria,
Constantine
Algeria, Djelfa
Algeria, El
Bayadh
Algeria, El
Oued
Algeria, El
Tarf
Algeria,
Ghardaia
Algeria,
Guelma
Algeria, Illizi
Algeria, Jijel
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Algeria,
Khenchela
Algeria,
Laghouat
Algeria, M'sila
Algeria,
Mascara
Algeria,
Medea
Algeria, Mila
Algeria,
Mostaganem
Algeria,
Naama
Algeria, Oran
Algeria,
Ouargla
Algeria, Oum
el Bouaghi
Algeria,
Relizane
Algeria, Saida
Algeria, Setif
Algeria, Sidi
Bel Abbes
Algeria,
Skikda
Algeria, Souk
Ahras
Algeria,
Tamanghasse
t
Algeria,
Tebessa
Algeria, Tiaret
Algeria,
Tindouf
Algeria,
Tipaza
Algeria,
Tissemsilt
Algeria, Tizi
Ouzou
Algeria,
Tlemcen
Andorra,
Andorra la
Vella
Andorra,
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Canillo
Andorra,
Encamp
Andorra,
Escaldes-Eng
ordany
Andorra, La
Massana
Andorra,
Ordino
Andorra, Sant
Julia de Loria
Angola,
Bengo
Angola,
Benguela
Angola, Bie
Angola,
Cabinda
Angola,
Cuando
Cubango
Angola,
Cuanza Norte
Angola,
Cuanza Sul
Angola,
Cunene
Angola,
Huambo
Angola, Huila
Angola,
Luanda
Angola, Lunda
Norte
Angola, Lunda
Sul
Angola,
Malanje
Angola,
Moxico
Angola,
Namibe
Angola, Uige
Angola, Zaire
Antigua and
Barbuda,
Barbuda
Antigua and
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Barbuda,
Redonda
Antigua and
Barbuda,
Saint George
Antigua and
Barbuda,
Saint John
Antigua and
Barbuda,
Saint Mary
Antigua and
Barbuda,
Saint Paul
Antigua and
Barbuda,
Saint Peter
Antigua and
Barbuda,
Saint Philip
Argentina,
Buenos Aires
Argentina,
Catamarca
Argentina,
Chaco
Argentina,
Chubut
Argentina,
Cordoba
Argentina,
Corrientes
Argentina,
Distrito
Federal
Argentina,
Entre Rios
Argentina,
Formosa
Argentina,
Jujuy
Argentina, La
Pampa
Argentina, La
Rioja
Argentina,
Mendoza
Argentina,
Misiones
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Argentina,
Neuquen
Argentina, Rio
Negro
Argentina,
Salta
Argentina,
San Juan
Argentina,
San Luis
Argentina,
Santa Cruz
Argentina,
Santa Fe
Argentina,
Santiago del
Estero
Argentina,
Tierra del
Fuego
Argentina,
Tucuman
Armenia,
Aragatsotn
Armenia,
Ararat
Armenia,
Armavir
Armenia,
Geghark'unik'
Armenia,
Kotayk'
Armenia, Lorri
Armenia,
Shirak
Armenia,
Syunik'
Armenia,
Tavush
Armenia,
Vayots' Dzor
Armenia,
Yerevan
Australia,
Australian
Capital
Territory
Australia, New
South Wales
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Australia,
Northern
Territory
Australia,
Queensland
Australia,
South
Australia
Australia,
Tasmania
Australia,
Victoria
Australia,
Western
Australia
Austria,
Burgenland
Austria,
Karnten
Austria,
Niederosterrei
ch
Austria,
Oberosterreic
h
Austria,
Salzburg
Austria,
Steiermark
Austria, Tirol
Austria,
Vorarlberg
Austria, Wien
Azerbaijan,
Abseron
Azerbaijan,
Agcabadi
Azerbaijan,
Agdam
Azerbaijan,
Agdas
Azerbaijan,
Agstafa
Azerbaijan,
Agsu
Azerbaijan, Ali
Bayramli
Azerbaijan,
Astara

Copyright © AppDynamics 2012-2014

Page 798

Azerbaijan,
Baki
Azerbaijan,
Balakan
Azerbaijan,
Barda
Azerbaijan,
Beylaqan
Azerbaijan,
Bilasuvar
Azerbaijan,
Cabrayil
Azerbaijan,
Calilabad
Azerbaijan,
Daskasan
Azerbaijan,
Davaci
Azerbaijan,
Fuzuli
Azerbaijan,
Gadabay
Azerbaijan,
Ganca
Azerbaijan,
Goranboy
Azerbaijan,
Goycay
Azerbaijan,
Haciqabul
Azerbaijan,
Imisli
Azerbaijan,
Ismayilli
Azerbaijan,
Kalbacar
Azerbaijan,
Kurdamir
Azerbaijan,
Lacin
Azerbaijan,
Lankaran
Azerbaijan,
Lankaran
Azerbaijan,
Lerik
Azerbaijan,
Masalli
Azerbaijan,
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Mingacevir
Azerbaijan,
Naftalan
Azerbaijan,
Naxcivan
Azerbaijan,
Neftcala
Azerbaijan,
Oguz
Azerbaijan,
Qabala
Azerbaijan,
Qax
Azerbaijan,
Qazax
Azerbaijan,
Qobustan
Azerbaijan,
Quba
Azerbaijan,
Qubadli
Azerbaijan,
Qusar
Azerbaijan,
Saatli
Azerbaijan,
Sabirabad
Azerbaijan,
Saki
Azerbaijan,
Saki
Azerbaijan,
Salyan
Azerbaijan,
Samaxi
Azerbaijan,
Samkir
Azerbaijan,
Samux
Azerbaijan,
Siyazan
Azerbaijan,
Sumqayit
Azerbaijan,
Susa
Azerbaijan,
Susa
Azerbaijan,
Tartar
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Azerbaijan,
Tovuz
Azerbaijan,
Ucar
Azerbaijan,
Xacmaz
Azerbaijan,
Xankandi
Azerbaijan,
Xanlar
Azerbaijan,
Xizi
Azerbaijan,
Xocali
Azerbaijan,
Xocavand
Azerbaijan,
Yardimli
Azerbaijan,
Yevlax
Azerbaijan,
Yevlax
Azerbaijan,
Zangilan
Azerbaijan,
Zaqatala
Azerbaijan,
Zardab
Bahrain, Al
Asimah
Bahrain, Al
Hadd
Bahrain, Al
Janubiyah
Bahrain, Al
Manamah
Bahrain, Al
Mintaqah al
Gharbiyah
Bahrain, Al
Mintaqah al
Wusta
Bahrain, Al
Mintaqah ash
Shamaliyah
Bahrain, Al
Muharraq
Bahrain, Al
Wusta
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Bahrain, Ar
Rifa
Bahrain, Ash
Shamaliyah
Bahrain, Jidd
Hafs
Bahrain,
Madinat
Bahrain,
Madinat
Hamad
Bahrain,
Mintaqat
Juzur Hawar
Bahrain,
Sitrah
Bangladesh,
Barisal
Bangladesh,
Chittagong
Bangladesh,
Dhaka
Bangladesh,
Khulna
Bangladesh,
Rajshahi
Bangladesh,
Sylhet
Barbados,
Christ Church
Barbados,
Saint Andrew
Barbados,
Saint George
Barbados,
Saint James
Barbados,
Saint John
Barbados,
Saint Joseph
Barbados,
Saint Lucy
Barbados,
Saint Michael
Barbados,
Saint Peter
Barbados,
Saint Philip
Barbados,
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Saint Thomas
Belarus,
Brestskaya
Voblasts'
Belarus,
Homyel'skaya
Voblasts'
Belarus,
Hrodzyenskay
a Voblasts'
Belarus,
Mahilyowskay
a Voblasts'
Belarus,
Minsk
Belarus,
Minskaya
Voblasts'
Belarus,
Vitsyebskaya
Voblasts'
Belgium,
Antwerpen
Belgium,
Brabant
Wallon
Belgium,
Brussels
Hoofdstedelijk
Gewest
Belgium,
Hainaut
Belgium,
Liege
Belgium,
Limburg
Belgium,
Luxembourg
Belgium,
Namur
Belgium,
Oost-Vlaander
en
Belgium,
Vlaams-Braba
nt
Belgium,
West-Vlaande
ren
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Belize, Belize
Belize, Cayo
Belize,
Corozal
Belize,
Orange Walk
Belize, Stann
Creek
Belize, Toledo
Benin, Alibori
Benin,
Atakora
Benin,
Atlanyique
Benin, Borgou
Benin,
Collines
Benin, Donga
Benin, Kouffo
Benin, Littoral
Benin, Mono
Benin, Oueme
Benin, Plateau
Benin, Zou
Bermuda,
Devonshire
Bermuda,
Hamilton
Bermuda,
Hamilton
Bermuda,
Paget
Bermuda,
Pembroke
Bermuda,
Saint George
Bermuda,
Saint
George's
Bermuda,
Sandys
Bermuda,
Smiths
Bermuda,
Southampton
Bermuda,
Warwick
Bhutan,
Bumthang
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Bhutan,
Chhukha
Bhutan,
Chirang
Bhutan, Daga
Bhutan,
Geylegphug
Bhutan, Ha
Bhutan,
Lhuntshi
Bhutan,
Mongar
Bhutan, Paro
Bhutan,
Pemagatsel
Bhutan,
Punakha
Bhutan,
Samchi
Bhutan,
Samdrup
Bhutan,
Shemgang
Bhutan,
Tashigang
Bhutan,
Thimphu
Bhutan,
Tongsa
Bhutan,
Wangdi
Phodrang
Bolivia,
Chuquisaca
Bolivia,
Cochabamba
Bolivia, El
Beni
Bolivia, La
Paz
Bolivia, Oruro
Bolivia, Pando
Bolivia, Potosi
Bolivia, Santa
Cruz
Bolivia, Tarija
Bosnia and
Herzegovina,
Federation of
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Bosnia and
Herzegovina
Bosnia and
Herzegovina,
Republika
Srpska
Botswana,
Central
Botswana,
Ghanzi
Botswana,
Kgalagadi
Botswana,
Kgatleng
Botswana,
Kweneng
Botswana,
North-East
Botswana,
North-West
Botswana,
South-East
Botswana,
Southern
Brazil, Acre
Brazil,
Alagoas
Brazil, Amapa
Brazil,
Amazonas
Brazil, Bahia
Brazil, Ceara
Brazil, Distrito
Federal
Brazil, Espirito
Santo
Brazil, Goias
Brazil,
Maranhao
Brazil, Mato
Grosso
Brazil, Mato
Grosso do Sul
Brazil, Minas
Gerais
Brazil, Para
Brazil, Paraiba
Brazil, Parana
Brazil,
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Pernambuco
Brazil, Piaui
Brazil, Rio de
Janeiro
Brazil, Rio
Grande do
Norte
Brazil, Rio
Grande do Sul
Brazil,
Rondonia
Brazil,
Roraima
Brazil, Santa
Catarina
Brazil, Sao
Paulo
Brazil, Sergipe
Brazil,
Tocantins
Brunei
Darussalam,
Alibori
Brunei
Darussalam,
Belait
Brunei
Darussalam,
Brunei and
Muara
Brunei
Darussalam,
Collines
Brunei
Darussalam,
Donga
Brunei
Darussalam,
Kouffo
Brunei
Darussalam,
Littoral
Brunei
Darussalam,
Oueme
Brunei
Darussalam,
Plateau
Brunei
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Darussalam,
Temburong
Brunei
Darussalam,
Tutong
Brunei
Darussalam,
Zou
Bulgaria,
Blagoevgrad
Bulgaria,
Burgas
Bulgaria,
Dobrich
Bulgaria,
Gabrovo
Bulgaria, Grad
Sofiya
Bulgaria,
Khaskovo
Bulgaria,
Kurdzhali
Bulgaria,
Kyustendil
Bulgaria,
Lovech
Bulgaria,
Mikhaylovgrad
Bulgaria,
Montana
Bulgaria,
Pazardzhik
Bulgaria,
Pernik
Bulgaria,
Pleven
Bulgaria,
Plovdiv
Bulgaria,
Razgrad
Bulgaria,
Ruse
Bulgaria,
Shumen
Bulgaria,
Silistra
Bulgaria,
Sliven
Bulgaria,
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Smolyan
Bulgaria,
Sofiya
Bulgaria,
Stara Zagora
Bulgaria,
Turgovishte
Bulgaria,
Varna
Bulgaria,
Veliko
Turnovo
Bulgaria, Vidin
Bulgaria,
Vratsa
Bulgaria,
Yambol
Burkina Faso,
Bale
Burkina Faso,
Bam
Burkina Faso,
Banwa
Burkina Faso,
Bazega
Burkina Faso,
Bougouriba
Burkina Faso,
Boulgou
Burkina Faso,
Boulkiemde
Burkina Faso,
Ganzourgou
Burkina Faso,
Gnagna
Burkina Faso,
Gourma
Burkina Faso,
Houet
Burkina Faso,
Ioba
Burkina Faso,
Kadiogo
Burkina Faso,
Kenedougou
Burkina Faso,
Komoe
Burkina Faso,
Komondjari
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Burkina Faso,
Kompienga
Burkina Faso,
Kossi
Burkina Faso,
Koulpelogo
Burkina Faso,
Kouritenga
Burkina Faso,
Kourweogo
Burkina Faso,
Leraba
Burkina Faso,
Loroum
Burkina Faso,
Mouhoun
Burkina Faso,
Namentenga
Burkina Faso,
Naouri
Burkina Faso,
Nayala
Burkina Faso,
Noumbiel
Burkina Faso,
Oubritenga
Burkina Faso,
Oudalan
Burkina Faso,
Passore
Burkina Faso,
Poni
Burkina Faso,
Sanguie
Burkina Faso,
Sanmatenga
Burkina Faso,
Seno
Burkina Faso,
Sissili
Burkina Faso,
Soum
Burkina Faso,
Sourou
Burkina Faso,
Tapoa
Burkina Faso,
Tuy
Burkina Faso,
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Yagha
Burkina Faso,
Yatenga
Burkina Faso,
Ziro
Burkina Faso,
Zondoma
Burkina Faso,
Zoundweogo
Burundi,
Bubanza
Burundi,
Bujumbura
Burundi,
Bururi
Burundi,
Cankuzo
Burundi,
Cibitoke
Burundi,
Gitega
Burundi,
Karuzi
Burundi,
Kayanza
Burundi,
Kirundo
Burundi,
Makamba
Burundi,
Muramvya
Burundi,
Muyinga
Burundi,
Mwaro
Burundi,
Ngozi
Burundi,
Rutana
Burundi,
Ruyigi
Cambodia,
Banteay
Meanchey
Cambodia,
Batdambang
Cambodia,
Batdambang
Cambodia,
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Kampong
Cham
Cambodia,
Kampong
Chhnang
Cambodia,
Kampong
Speu
Cambodia,
Kampong
Thum
Cambodia,
Kampot
Cambodia,
Kandal
Cambodia,
Koh Kong
Cambodia,
Kracheh
Cambodia,
Mondulkiri
Cambodia,
Pailin
Cambodia,
Phnum Penh
Cambodia,
Preah Vihear
Cambodia,
Prey Veng
Cambodia,
Pursat
Cambodia,
Ratanakiri Kiri
Cambodia,
Siem Reap
Cambodia,
Stung Treng
Cambodia,
Svay Rieng
Cambodia,
Takeo
Cameroon,
Adamaoua
Cameroon,
Centre
Cameroon,
Est
Cameroon,
Extreme-Nord
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Cameroon,
Littoral
Cameroon,
Nord
Cameroon,
Nord-Ouest
Cameroon,
Ouest
Cameroon,
Sud
Cameroon,
Sud-Ouest
Canada,
Alberta
Canada,
British
Columbia
Canada,
Manitoba
Canada, New
Brunswick
Canada,
Newfoundland
Canada,
Northwest
Territories
Canada, Nova
Scotia
Canada,
Nunavut
Canada,
Ontario
Canada,
Prince Edward
Island
Canada,
Quebec
Canada,
Saskatchewan
Canada,
Yukon
Territory
Cape Verde,
Boa Vista
Cape Verde,
Brava
Cape Verde,
Maio
Cape Verde,
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Mosteiros
Cape Verde,
Paul
Cape Verde,
Praia
Cape Verde,
Ribeira
Grande
Cape Verde,
Sal
Cape Verde,
Santa
Catarina
Cape Verde,
Santa Cruz
Cape Verde,
Sao
Domingos
Cape Verde,
Sao Filipe
Cape Verde,
Sao Miguel
Cape Verde,
Sao Nicolau
Cape Verde,
Sao Vicente
Cape Verde,
Tarrafal
Cayman
Islands, Creek
Cayman
Islands,
Eastern
Cayman
Islands,
Midland
Cayman
Islands, South
Town
Cayman
Islands, Spot
Bay
Cayman
Islands, Stake
Bay
Cayman
Islands, West
End
Cayman
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Islands,
Western
Central
African
Republic,
Bamingui-Ban
goran
Central
African
Republic,
Bangui
Central
African
Republic,
Basse-Kotto
Central
African
Republic,
Cuvette-Ouest
Central
African
Republic,
Haut-Mbomou
Central
African
Republic,
Haute-Kotto
Central
African
Republic,
Kemo
Central
African
Republic,
Lobaye
Central
African
Republic,
Mambere-Kad
ei
Central
African
Republic,
Mbomou
Central
African
Republic,
Nana-Grebizi
Central
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African
Republic,
Nana-Mamber
e
Central
African
Republic,
Ombella-Mpok
o
Central
African
Republic,
Ouaka
Central
African
Republic,
Ouham
Central
African
Republic,
Ouham-Pende
Central
African
Republic,
Sangha-Mbae
re
Chad, Batha
Chad, Biltine
Chad,
Borkou-Enned
i-Tibesti
Chad,
Chari-Baguirm
i
Chad, Guera
Chad, Kanem
Chad, Lac
Chad, Logone
Occidental
Chad, Logone
Oriental
Chad,
Mayo-Kebbi
Chad,
Moyen-Chari
Chad,
Ouaddai
Chad,
Salamat
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Chad, Tandjile
Chile, Aisen
del General
Carlos Ibanez
del Campo
Chile,
Antofagasta
Chile,
Araucania
Chile, Arica y
Parinacota
Chile,
Atacama
Chile, Bio-Bio
Chile,
Coquimbo
Chile,
Libertador
General
Bernardo
O'Higgins
Chile, Los
Lagos
Chile, Los
Lagos
Chile, Los
Rios
Chile,
Magallanes y
de la Antartica
Chilena
Chile, Maule
Chile, Region
Metropolitana
Chile,
Tarapaca
Chile,
Tarapaca
Chile,
Valparaiso
China, Anhui
China, Beijing
China,
Chongqing
China, Fujian
China, Gansu
China,
Guangdong
China,
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Guangxi
China,
Guizhou
China, Hainan
China, Hebei
China,
Heilongjiang
China, Henan
China, Hubei
China, Hunan
China,
Jiangsu
China, Jiangxi
China, Jilin
China,
Liaoning
China, Nei
Mongol
China, Ningxia
China,
Qinghai
China,
Shaanxi
China,
Shandong
China,
Shanghai
China, Shanxi
China,
Sichuan
China, Tianjin
China,
Xinjiang
China, Xizang
China,
Yunnan
China,
Zhejiang
Colombia,
Amazonas
Colombia,
Antioquia
Colombia,
Arauca
Colombia,
Atlantico
Colombia,
Bolivar
Colombia,
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Bolivar
Department
Colombia,
Boyaca
Colombia,
Boyaca
Department
Colombia,
Caldas
Colombia,
Caldas
Department
Colombia,
Caqueta
Colombia,
Casanare
Colombia,
Cauca
Colombia,
Cesar
Colombia,
Choco
Colombia,
Cordoba
Colombia,
Cundinamarca
Colombia,
Distrito
Especial
Colombia,
Guainia
Colombia,
Guaviare
Colombia,
Huila
Colombia, La
Guajira
Colombia,
Magdalena
Colombia,
Magdalena
Department
Colombia,
Meta
Colombia,
Narino
Colombia,
Norte de
Santander
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Colombia,
Putumayo
Colombia,
Quindio
Colombia,
Risaralda
Colombia,
San Andres y
Providencia
Colombia,
Santander
Colombia,
Sucre
Colombia,
Tolima
Colombia,
Valle del
Cauca
Colombia,
Vaupes
Colombia,
Vichada
Comoros,
Anjouan
Comoros,
Grande
Comore
Comoros,
Moheli
Congo,
Bouenza
Congo,
Brazzaville
Congo,
Cuvette
Congo,
Cuvette-Ouest
Congo,
Kouilou
Congo,
Lekoumou
Congo,
Likouala
Congo, Niari
Congo,
Plateaux
Congo, Pool
Congo,
Sangha
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Congo, The
Democratic
Republic of
the, Bandundu
Congo, The
Democratic
Republic of
the,
Bas-Congo
Congo, The
Democratic
Republic of
the, Equateur
Congo, The
Democratic
Republic of
the,
Kasai-Oriental
Congo, The
Democratic
Republic of
the, Katanga
Congo, The
Democratic
Republic of
the, Kinshasa
Congo, The
Democratic
Republic of
the, Maniema
Congo, The
Democratic
Republic of
the, Nord-Kivu
Congo, The
Democratic
Republic of
the, Orientale
Congo, The
Democratic
Republic of
the, Sud-Kivu
Costa Rica,
Alajuela
Costa Rica,
Cartago
Costa Rica,
Guanacaste
Costa Rica,
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Heredia
Costa Rica,
Limon
Costa Rica,
Puntarenas
Costa Rica,
San Jose
Cote D'Ivoire,
Agneby
Cote D'Ivoire,
Bafing
Cote D'Ivoire,
Bas-Sassandr
a
Cote D'Ivoire,
Denguele
Cote D'Ivoire,
Dix-Huit
Montagnes
Cote D'Ivoire,
Fromager
Cote D'Ivoire,
Haut-Sassand
ra
Cote D'Ivoire,
Lacs
Cote D'Ivoire,
Lagunes
Cote D'Ivoire,
Marahoue
Cote D'Ivoire,
Moyen-Cavall
y
Cote D'Ivoire,
Moyen-Como
e
Cote D'Ivoire,
N'zi-Comoe
Cote D'Ivoire,
Savanes
Cote D'Ivoire,
Sud-Bandama
Cote D'Ivoire,
Sud-Comoe
Cote D'Ivoire,
Vallee du
Bandama
Cote D'Ivoire,
Worodougou

Copyright © AppDynamics 2012-2014

Page 822

Cote D'Ivoire,
Zanzan
Croatia,
Bjelovarsko-Bi
logorska
Croatia,
Brodsko-Posa
vska
Croatia,
Dubrovacko-N
eretvanska
Croatia, Grad
Zagreb
Croatia,
Istarska
Croatia,
Karlovacka
Croatia,
Koprivnicko-Kr
izevacka
Croatia,
Krapinsko-Zag
orska
Croatia,
Licko-Senjska
Croatia,
Medimurska
Croatia,
Osjecko-Bara
njska
Croatia,
Pozesko-Slav
onska
Croatia,
Primorsko-Gor
anska
Croatia,
Sibensko-Knin
ska
Croatia,
Sisacko-Mosla
vacka
Croatia,
Splitsko-Dalm
atinska
Croatia,
Varazdinska
Croatia,
Viroviticko-Po
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dravska
Croatia,
Vukovarsko-S
rijemska
Croatia,
Zadarska
Croatia,
Zagrebacka
Cuba,
Camaguey
Cuba, Ciego
de Avila
Cuba,
Cienfuegos
Cuba, Ciudad
de la Habana
Cuba,
Granma
Cuba,
Guantanamo
Cuba, Holguin
Cuba, Isla de
la Juventud
Cuba, La
Habana
Cuba, Las
Tunas
Cuba,
Matanzas
Cuba, Pinar
del Rio
Cuba, Sancti
Spiritus
Cuba,
Santiago de
Cuba
Cuba, Villa
Clara
Cyprus,
Famagusta
Cyprus,
Kyrenia
Cyprus,
Larnaca
Cyprus,
Limassol
Cyprus,
Nicosia
Cyprus,
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Paphos
Czech
Republic,
Hlavni mesto
Praha
Czech
Republic,
Jihocesky kraj
Czech
Republic,
Jihomoravsky
kraj
Czech
Republic,
Karlovarsky
kraj
Czech
Republic,
Kralovehradec
ky kraj
Czech
Republic,
Liberecky kraj
Czech
Republic,
Moravskoslez
sky kraj
Czech
Republic,
Olomoucky
kraj
Czech
Republic,
Pardubicky
kraj
Czech
Republic,
Plzensky kraj
Czech
Republic,
Stredocesky
kraj
Czech
Republic,
Ustecky kraj
Czech
Republic,
Vysocina
Czech
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Republic,
Zlinsky kraj
Denmark,
Hovedstaden
Denmark,
Midtjylland
Denmark,
Nordjylland
Denmark,
Sjelland
Denmark,
Syddanmark
Djibouti, Ali
Sabieh
Djibouti, Arta
Djibouti, Dikhil
Djibouti,
Djibouti
Djibouti,
Obock
Djibouti,
Tadjoura
Dominica,
Saint Andrew
Dominica,
Saint David
Dominica,
Saint George
Dominica,
Saint John
Dominica,
Saint Joseph
Dominica,
Saint Luke
Dominica,
Saint Mark
Dominica,
Saint Patrick
Dominica,
Saint Paul
Dominica,
Saint Peter
Dominican
Republic,
Azua
Dominican
Republic,
Baoruco
Dominican
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Republic,
Barahona
Dominican
Republic,
Dajabon
Dominican
Republic,
Distrito
Nacional
Dominican
Republic,
Distrito
Nacional
Dominican
Republic,
Duarte
Dominican
Republic, El
Seibo
Dominican
Republic,
Elias Pina
Dominican
Republic,
Espaillat
Dominican
Republic,
Hato Mayor
Dominican
Republic,
Independenci
a
Dominican
Republic, La
Altagracia
Dominican
Republic, La
Romana
Dominican
Republic, La
Vega
Dominican
Republic,
Maria Trinidad
Sanchez
Dominican
Republic,
Monsenor
Nouel
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Dominican
Republic,
Monte Cristi
Dominican
Republic,
Monte Plata
Dominican
Republic,
Pedernales
Dominican
Republic,
Peravia
Dominican
Republic,
Peravia
Dominican
Republic,
Puerto Plata
Dominican
Republic,
Salcedo
Dominican
Republic,
Samana
Dominican
Republic, San
Cristobal
Dominican
Republic, San
Jose de Ocoa
Dominican
Republic, San
Juan
Dominican
Republic, San
Pedro De
Macoris
Dominican
Republic,
Sanchez
Ramirez
Dominican
Republic,
Santiago
Dominican
Republic,
Santiago
Rodriguez
Dominican
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Republic,
Santo
Domingo
Dominican
Republic,
Valverde
Ecuador,
Azuay
Ecuador,
Bolivar
Ecuador,
Canar
Ecuador,
Carchi
Ecuador,
Chimborazo
Ecuador,
Cotopaxi
Ecuador, El
Oro
Ecuador,
Esmeraldas
Ecuador,
Galapagos
Ecuador,
Guayas
Ecuador,
Imbabura
Ecuador, Loja
Ecuador, Los
Rios
Ecuador,
Manabi
Ecuador,
Morona-Santi
ago
Ecuador,
Napo
Ecuador,
Orellana
Ecuador,
Pastaza
Ecuador,
Pichincha
Ecuador,
Sucumbios
Ecuador,
Tungurahua
Ecuador,
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Zamora-Chinc
hipe
Egypt, Ad
Daqahliyah
Egypt, Al Bahr
al Ahmar
Egypt, Al
Buhayrah
Egypt, Al
Fayyum
Egypt, Al
Gharbiyah
Egypt, Al
Iskandariyah
Egypt, Al
Isma'iliyah
Egypt, Al
Jizah
Egypt, Al
Minufiyah
Egypt, Al
Minya
Egypt, Al
Qahirah
Egypt, Al
Qalyubiyah
Egypt, Al
Wadi al Jadid
Egypt, As
Suways
Egypt, Ash
Sharqiyah
Egypt, Aswan
Egypt, Asyut
Egypt, Bani
Suwayf
Egypt, Bur
Sa'id
Egypt,
Dumyat
Egypt, Janub
Sina'
Egypt, Kafr
ash Shaykh
Egypt, Matruh
Egypt, Qina
Egypt, Shamal
Sina'
Egypt, Suhaj
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El Salvador,
Ahuachapan
El Salvador,
Cabanas
El Salvador,
Chalatenango
El Salvador,
Cuscatlan
El Salvador,
La Libertad
El Salvador,
La Paz
El Salvador,
La Union
El Salvador,
Morazan
El Salvador,
San Miguel
El Salvador,
San Salvador
El Salvador,
San Vicente
El Salvador,
Santa Ana
El Salvador,
Sonsonate
El Salvador,
Usulutan
Equatorial
Guinea,
Annobon
Equatorial
Guinea, Bioko
Norte
Equatorial
Guinea, Bioko
Sur
Equatorial
Guinea,
Centro Sur
Equatorial
Guinea,
Kie-Ntem
Equatorial
Guinea, Litoral
Equatorial
Guinea,
Wele-Nzas
Eritrea,
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Anseba
Eritrea, Debub
Eritrea,
Debubawi
K'eyih Bahri
Eritrea, Gash
Barka
Eritrea,
Ma'akel
Eritrea,
Semenawi
K'eyih Bahri
Estonia,
Harjumaa
Estonia,
Hiiumaa
Estonia,
Ida-Virumaa
Estonia,
Jarvamaa
Estonia,
Jogevamaa
Estonia,
Kohtla-Jarve
Estonia,
Laane-Viruma
a
Estonia,
Laanemaa
Estonia,
Narva
Estonia,
Parnu
Estonia,
Parnumaa
Estonia,
Polvamaa
Estonia,
Raplamaa
Estonia,
Saaremaa
Estonia,
Sillamae
Estonia,
Tallinn
Estonia, Tartu
Estonia,
Tartumaa
Estonia,
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Valgamaa
Estonia,
Viljandimaa
Estonia,
Vorumaa
Ethiopia, Adis
Abeba
Ethiopia, Afar
Ethiopia,
Amara
Ethiopia,
Binshangul
Gumuz
Ethiopia, Dire
Dawa
Ethiopia,
Gambela
Hizboch
Ethiopia,
Hareri Hizb
Ethiopia,
Oromiya
Ethiopia,
Sumale
Ethiopia,
Tigray
Ethiopia,
YeDebub
Biheroch
Bihereseboch
na Hizboch
Fiji, Central
Fiji, Eastern
Fiji, Northern
Fiji, Rotuma
Fiji, Western
Finland, Aland
Finland,
Eastern
Finland
Finland,
Lapland
Finland, Oulu
Finland,
Southern
Finland
Finland,
Western
Finland
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France,
Alsace
France,
Aquitaine
France,
Auvergne
France,
Basse-Norma
ndie
France,
Bourgogne
France,
Bretagne
France,
Centre
France,
Champagne-A
rdenne
France, Corse
France,
Franche-Comt
e
France,
Haute-Norma
ndie
France,
Ile-de-France
France,
Languedoc-R
oussillon
France,
Limousin
France,
Lorraine
France,
Midi-Pyrenees
France,
Nord-Pas-deCalais
France, Pays
de la Loire
France,
Picardie
France,
Poitou-Charen
tes
France,
Provence-Alp
es-Cote
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d'Azur
France,
Rhone-Alpes
Gabon,
Estuaire
Gabon,
Haut-Ogooue
Gabon,
Moyen-Ogoou
e
Gabon,
Ngounie
Gabon,
Nyanga
Gabon,
Ogooue-Ivind
o
Gabon,
Ogooue-Lolo
Gabon,
Ogooue-Mariti
me
Gabon,
Woleu-Ntem
Gambia,
Banjul
Gambia,
Central River
Gambia,
Lower River
Gambia, North
Bank
Gambia,
Upper River
Gambia,
Western
Georgia,
Abashis
Raioni
Georgia,
Abkhazia
Georgia,
Adigenis
Raioni
Georgia,
Ajaria
Georgia,
Akhalgoris
Raioni
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Georgia,
Akhalk'alak'is
Raioni
Georgia,
Akhalts'ikhis
Raioni
Georgia,
Akhmetis
Raioni
Georgia,
Ambrolauris
Raioni
Georgia,
Aspindzis
Raioni
Georgia,
Baghdat'is
Raioni
Georgia,
Bolnisis
Raioni
Georgia,
Borjomis
Raioni
Georgia,
Ch'khorotsqus
Raioni
Georgia,
Ch'okhatauris
Raioni
Georgia,
Chiat'ura
Georgia,
Dedop'listsqar
os Raioni
Georgia,
Dmanisis
Raioni
Georgia,
Dushet'is
Raioni
Georgia,
Gardabanis
Raioni
Georgia, Gori
Georgia, Goris
Raioni
Georgia,
Gurjaanis
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Raioni
Georgia, Javis
Raioni
Georgia,
K'arelis Raioni
Georgia,
K'ut'aisi
Georgia,
Kaspis Raioni
Georgia,
Kharagaulis
Raioni
Georgia,
Khashuris
Raioni
Georgia,
Khobis Raioni
Georgia,
Khonis Raioni
Georgia,
Lagodekhis
Raioni
Georgia,
Lanch'khut'is
Raioni
Georgia,
Lentekhis
Raioni
Georgia,
Marneulis
Raioni
Georgia,
Martvilis
Raioni
Georgia,
Mestiis Raioni
Georgia,
Mts'khet'is
Raioni
Georgia,
Ninotsmindis
Raioni
Georgia, Onis
Raioni
Georgia,
Ozurget'is
Raioni
Georgia, P'ot'i
Georgia,
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Qazbegis
Raioni
Georgia,
Qvarlis Raioni
Georgia,
Rust'avi
Georgia,
Sach'kheris
Raioni
Georgia,
Sagarejos
Raioni
Georgia,
Samtrediis
Raioni
Georgia,
Senakis
Raioni
Georgia,
Sighnaghis
Raioni
Georgia,
T'bilisi
Georgia,
T'elavis Raioni
Georgia,
T'erjolis Raioni
Georgia,
T'et'ritsqaros
Raioni
Georgia,
T'ianet'is
Raioni
Georgia,
Tqibuli
Georgia,
Ts'ageris
Raioni
Georgia,
Tsalenjikhis
Raioni
Georgia,
Tsalkis Raioni
Georgia,
Tsqaltubo
Georgia,
Vanis Raioni
Georgia,
Zestap'onis
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Raioni
Georgia,
Zugdidi
Georgia,
Zugdidis
Raioni
Germany,
Baden-Wurtte
mberg
Germany,
Bayern
Germany,
Berlin
Germany,
Brandenburg
Germany,
Bremen
Germany,
Hamburg
Germany,
Hessen
Germany,
MecklenburgVorpommern
Germany,
Niedersachse
n
Germany,
NordrheinWes
tfalen
Germany,
Rheinland-Pfa
lz
Germany,
Saarland
Germany,
Sachsen
Germany,
Sachsen-Anh
alt
Germany,
Schleswig-Hol
stein
Germany,
Thuringen
Ghana,
Ashanti
Ghana,
Brong-Ahafo
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Ghana,
Central
Ghana,
Eastern
Ghana,
Greater Accra
Ghana,
Northern
Ghana, Upper
East
Ghana, Upper
West
Ghana, Volta
Ghana,
Western
Greece,
Aitolia kai
Akarnania
Greece,
Akhaia
Greece,
Argolis
Greece,
Arkadhia
Greece, Arta
Greece, Attiki
Greece,
Dhodhekaniso
s
Greece,
Drama
Greece,
Evritania
Greece, Evros
Greece,
Evvoia
Greece,
Florina
Greece, Fokis
Greece,
Fthiotis
Greece,
Grevena
Greece, Ilia
Greece,
Imathia
Greece,
Ioannina
Greece,

Copyright © AppDynamics 2012-2014

Page 840

Iraklion
Greece,
Kardhitsa
Greece,
Kastoria
Greece,
Kavala
Greece,
Kefallinia
Greece,
Kerkira
Greece,
Khalkidhiki
Greece,
Khania
Greece, Khios
Greece,
Kikladhes
Greece, Kilkis
Greece,
Korinthia
Greece,
Kozani
Greece,
Lakonia
Greece,
Larisa
Greece,
Lasithi
Greece,
Lesvos
Greece,
Levkas
Greece,
Magnisia
Greece,
Messinia
Greece, Pella
Greece, Pieria
Greece,
Preveza
Greece,
Rethimni
Greece,
Rodhopi
Greece,
Samos
Greece, Serrai
Greece,
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Thesprotia
Greece,
Thessaloniki
Greece,
Trikala
Greece,
Voiotia
Greece,
Xanthi
Greece,
Zakinthos
Greenland,
Nordgronland
Greenland,
Ostgronland
Greenland,
Vestgronland
Grenada,
Saint Andrew
Grenada,
Saint David
Grenada,
Saint George
Grenada,
Saint John
Grenada,
Saint Mark
Grenada,
Saint Patrick
Guatemala,
Alta Verapaz
Guatemala,
Baja Verapaz
Guatemala,
Chimaltenang
o
Guatemala,
Chiquimula
Guatemala, El
Progreso
Guatemala,
Escuintla
Guatemala,
Guatemala
Guatemala,
Huehuetenan
go
Guatemala,
Izabal
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Guatemala,
Jalapa
Guatemala,
Jutiapa
Guatemala,
Peten
Guatemala,
Quetzaltenang
o
Guatemala,
Quiche
Guatemala,
Retalhuleu
Guatemala,
Sacatepequez
Guatemala,
San Marcos
Guatemala,
Santa Rosa
Guatemala,
Solola
Guatemala,
Suchitepeque
z
Guatemala,
Totonicapan
Guatemala,
Zacapa
Guinea-Bissa
u, Bafata
Guinea-Bissa
u, Biombo
Guinea-Bissa
u, Bissau
Guinea-Bissa
u, Bolama
Guinea-Bissa
u, Cacheu
Guinea-Bissa
u, Gabu
Guinea-Bissa
u, Oio
Guinea-Bissa
u, Quinara
Guinea-Bissa
u, Tombali
Guinea, Beyla
Guinea, Boffa
Guinea, Boke
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Guinea,
Conakry
Guinea,
Coyah
Guinea,
Dabola
Guinea,
Dalaba
Guinea,
Dinguiraye
Guinea,
Dubreka
Guinea,
Faranah
Guinea,
Forecariah
Guinea, Fria
Guinea,
Gaoual
Guinea,
Gueckedou
Guinea,
Kankan
Guinea,
Kerouane
Guinea,
Kindia
Guinea,
Kissidougou
Guinea,
Koubia
Guinea,
Koundara
Guinea,
Kouroussa
Guinea, Labe
Guinea,
Lelouma
Guinea, Lola
Guinea,
Macenta
Guinea, Mali
Guinea,
Mamou
Guinea,
Mandiana
Guinea,
Nzerekore
Guinea, Pita
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Guinea,
Siguiri
Guinea,
Telimele
Guinea,
Tougue
Guinea,
Yomou
Guyana,
Barima-Waini
Guyana,
Cuyuni-Mazar
uni
Guyana,
Demerara-Ma
haica
Guyana, East
Berbice-Coren
tyne
Guyana,
Essequibo
Islands-West
Demerara
Guyana,
Mahaica-Berbi
ce
Guyana,
Pomeroon-Su
penaam
Guyana,
Potaro-Siparu
ni
Guyana,
Upper
Demerara-Ber
bice
Guyana,
Upper
Takutu-Upper
Essequibo
H-M

Haiti,
Artibonite
Haiti, Centre
Haiti, Grand'
Anse
Haiti, Nippes
Haiti, Nord
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Haiti, Nord-Est
Haiti,
Nord-Ouest
Haiti, Ouest
Haiti, Sud
Haiti, Sud-Est
Honduras,
Atlantida
Honduras,
Choluteca
Honduras,
Colon
Honduras,
Comayagua
Honduras,
Copan
Honduras,
Cortes
Honduras, El
Paraiso
Honduras,
Francisco
Morazan
Honduras,
Gracias a
Dios
Honduras,
Intibuca
Honduras,
Islas de la
Bahia
Honduras, La
Paz
Honduras,
Lempira
Honduras,
Ocotepeque
Honduras,
Olancho
Honduras,
Santa Barbara
Honduras,
Valle
Honduras,
Yoro
Hungary,
Bacs-Kiskun
Hungary,
Baranya
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Hungary,
Bekes
Hungary,
Bekescsaba
Hungary,
Borsod-AbaujZemplen
Hungary,
Budapest
Hungary,
Csongrad
Hungary,
Debrecen
Hungary,
Dunaujvaros
Hungary, Eger
Hungary, Erd
Hungary,
Fejer
Hungary, Gyor
Hungary,
Gyor-Moson-S
opron
Hungary,
Hajdu-Bihar
Hungary,
Heves
Hungary,
Hodmezovasa
rhely
Hungary,
Jasz-Nagykun
-Szolnok
Hungary,
Kaposvar
Hungary,
Kecskemet
Hungary,
Komarom-Esz
tergom
Hungary,
Miskolc
Hungary,
Nagykanizsa
Hungary,
Nograd
Hungary,
Nyiregyhaza
Hungary,
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Pecs
Hungary, Pest
Hungary,
Salgotarjan
Hungary,
Somogy
Hungary,
Sopron
Hungary,
Szabolcs-Szat
mar-Bereg
Hungary,
Szeged
Hungary,
Szekesfeherv
ar
Hungary,
Szekszard
Hungary,
Szolnok
Hungary,
Szombathely
Hungary,
Tatabanya
Hungary,
Tolna
Hungary, Vas
Hungary,
Veszprem
Hungary,
Veszprem
Hungary, Zala
Hungary,
Zalaegerszeg
Iceland,
Arnessysla
Iceland,
Austur-Hunav
atnssysla
Iceland,
Austur-Skaftaf
ellssysla
Iceland,
Borgarfjardars
ysla
Iceland,
Eyjafjardarsysl
a
Iceland,
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Gullbringusysl
a
Iceland,
Kjosarsysla
Iceland,
Myrasysla
Iceland,
Nordur-Mulas
ysla
Iceland,
Nordur-Tingey
jarsysla
Iceland,
Norourland
Eystra
Iceland,
Norourland
Vestra
Iceland,
Rangarvallasy
sla
Iceland,
Skagafjardars
ysla
Iceland,
Snafellsnesog
Hnappadalssy
sla
Iceland,
Strandasysla
Iceland,
Sudur-Mulasy
sla
Iceland,
Sudur-Tingeyj
arsysla
Iceland,
Suourland
Iceland,
Suournes
Iceland,
Vestfiroir
Iceland,
Vestur-Bardas
trandarsysla
Iceland,
Vestur-Hunav
atnssysla
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Iceland,
Vestur-Isafjard
arsysla
Iceland,
Vestur-Skaftaf
ellssysla
Iceland,
Vesturland
India,
Andaman and
Nicobar
Islands
India, Andhra
Pradesh
India,
Arunachal
Pradesh
India, Assam
India, Bihar
India,
Chandigarh
India,
Chhattisgarh
India, Dadra
and Nagar
Haveli
India, Daman
and Diu
India, Delhi
India, Goa
India, Gujarat
India, Haryana
India,
Himachal
Pradesh
India, Jammu
and Kashmir
India,
Jharkhand
India,
Karnataka
India, Kerala
India,
Lakshadweep
India, Madhya
Pradesh
India,
Maharashtra
India, Manipur
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India,
Meghalaya
India,
Mizoram
India,
Nagaland
India, Orissa
India,
Puducherry
India, Punjab
India,
Rajasthan
India, Sikkim
India, Tamil
Nadu
India, Tripura
India, Uttar
Pradesh
India,
Uttarakhand
India, West
Bengal
Indonesia,
Aceh
Indonesia,
Bali
Indonesia,
Banten
Indonesia,
Bengkulu
Indonesia,
Gorontalo
Indonesia,
Irian Jaya
Barat
Indonesia,
Jakarta Raya
Indonesia,
Jambi
Indonesia,
Jawa Barat
Indonesia,
Jawa Barat
Indonesia,
Jawa Tengah
Indonesia,
Jawa Timur
Indonesia,
Kalimantan
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Barat
Indonesia,
Kalimantan
Selatan
Indonesia,
Kalimantan
Tengah
Indonesia,
Kalimantan
Timur
Indonesia,
Kepulauan
Bangka
Belitung
Indonesia,
Kepulauan
Riau
Indonesia,
Lampung
Indonesia,
Maluku
Indonesia,
Maluku
Indonesia,
Maluku Utara
Indonesia,
Nusa
Tenggara
Barat
Indonesia,
Nusa
Tenggara
Timur
Indonesia,
Papua
Indonesia,
Papua
Indonesia,
Riau
Indonesia,
Riau
Indonesia,
Sulawesi
Barat
Indonesia,
Sulawesi
Selatan
Indonesia,
Sulawesi
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Selatan
Indonesia,
Sulawesi
Tengah
Indonesia,
Sulawesi
Tenggara
Indonesia,
Sulawesi
Utara
Indonesia,
Sulawesi
Utara
Indonesia,
Sumatera
Barat
Indonesia,
Sumatera
Selatan
Indonesia,
Sumatera
Selatan
Indonesia,
Sumatera
Utara
Indonesia,
Yogyakarta
Iran, Islamic
Republic of,
Ardabil
Iran, Islamic
Republic of,
Azarbayjan-e
Bakhtari
Iran, Islamic
Republic of,
Bakhtaran
Iran, Islamic
Republic of,
Bushehr
Iran, Islamic
Republic of,
Chahar Mahall
va Bakhtiari
Iran, Islamic
Republic of,
East
Azarbaijan
Iran, Islamic
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Republic of,
Esfahan
Iran, Islamic
Republic of,
Fars
Iran, Islamic
Republic of,
Gilan
Iran, Islamic
Republic of,
Golestan
Iran, Islamic
Republic of,
Hamadan
Iran, Islamic
Republic of,
Hormozgan
Iran, Islamic
Republic of,
Ilam
Iran, Islamic
Republic of,
Kerman
Iran, Islamic
Republic of,
Kerman
Iran, Islamic
Republic of,
Khorasan
Iran, Islamic
Republic of,
Khorasan-e
Janubi
Iran, Islamic
Republic of,
Khorasan-e
Razavi
Iran, Islamic
Republic of,
Khorasan-e
Shemali
Iran, Islamic
Republic of,
Khuzestan
Iran, Islamic
Republic of,
Kohkiluyeh va
Buyer Ahmadi
Iran, Islamic
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Republic of,
Kordestan
Iran, Islamic
Republic of,
Lorestan
Iran, Islamic
Republic of,
Markazi
Iran, Islamic
Republic of,
Markazi
Iran, Islamic
Republic of,
Markazi
Iran, Islamic
Republic of,
Mazandaran
Iran, Islamic
Republic of,
Mazandaran
Iran, Islamic
Republic of,
Qazvin
Iran, Islamic
Republic of,
Qom
Iran, Islamic
Republic of,
Semnan
Iran, Islamic
Republic of,
Semnan
Province
Iran, Islamic
Republic of,
Sistan va
Baluchestan
Iran, Islamic
Republic of,
Tehran
Iran, Islamic
Republic of,
Yazd
Iran, Islamic
Republic of,
Yazd
Iran, Islamic
Republic of,
Zanjan

Copyright © AppDynamics 2012-2014

Page 855

Iran, Islamic
Republic of,
Zanjan
Iran, Islamic
Republic of,
Zanjan
Iraq, Al Anbar
Iraq, Al
Basrah
Iraq, Al
Muthanna
Iraq, Al
Qadisiyah
Iraq, An Najaf
Iraq, Arbil
Iraq, As
Sulaymaniyah
Iraq, At
Ta'mim
Iraq, Babil
Iraq, Baghdad
Iraq, Dahuk
Iraq, Dhi Qar
Iraq, Diyala
Iraq, Karbala'
Iraq, Maysan
Iraq, Ninawa
Iraq, Salah ad
Din
Iraq, Wasit
Ireland,
Carlow
Ireland, Cavan
Ireland, Clare
Ireland, Cork
Ireland,
Donegal
Ireland, Dublin
Ireland,
Galway
Ireland, Kerry
Ireland,
Kildare
Ireland,
Kilkenny
Ireland, Laois
Ireland,
Leitrim
Ireland,
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Limerick
Ireland,
Longford
Ireland, Louth
Ireland, Mayo
Ireland, Meath
Ireland,
Monaghan
Ireland, Offaly
Ireland,
Roscommon
Ireland, Sligo
Ireland,
Tipperary
Ireland,
Waterford
Ireland,
Westmeath
Ireland,
Wexford
Ireland,
Wicklow
Israel,
HaDarom
Israel,
HaMerkaz
Israel,
HaZafon
Israel, Hefa
Israel, Tel
Aviv
Israel,
Yerushalayim
Italy, Abruzzi
Italy,
Basilicata
Italy, Calabria
Italy,
Campania
Italy,
EmiliaRomagn
a
Italy,
Friuli-Venezia
Giulia
Italy, Lazio
Italy, Liguria
Italy,
Lombardia
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Italy, Marche
Italy, Molise
Italy,
Piemonte
Italy, Puglia
Italy,
Sardegna
Italy, Sicilia
Italy, Toscana
Italy,
Trentino-Alto
Adige
Italy, Umbria
Italy, Valle
d'Aosta
Italy, Veneto
Jamaica,
Clarendon
Jamaica,
Hanover
Jamaica,
Kingston
Jamaica,
Manchester
Jamaica,
Portland
Jamaica,
Saint Andrew
Jamaica,
Saint Ann
Jamaica,
Saint
Catherine
Jamaica,
Saint
Elizabeth
Jamaica,
Saint James
Jamaica,
Saint Mary
Jamaica,
Saint Thomas
Jamaica,
Trelawny
Jamaica,
Westmoreland
Japan, Aichi
Japan, Akita
Japan, Aomori
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Japan, Chiba
Japan, Ehime
Japan, Fukui
Japan,
Fukuoka
Japan,
Fukushima
Japan, Gifu
Japan,
Gumma
Japan,
Hiroshima
Japan,
Hokkaido
Japan, Hyogo
Japan, Ibaraki
Japan,
Ishikawa
Japan, Iwate
Japan,
Kagawa
Japan,
Kagoshima
Japan,
Kanagawa
Japan, Kochi
Japan,
Kumamoto
Japan, Kyoto
Japan, Mie
Japan, Miyagi
Japan,
Miyazaki
Japan,
Nagano
Japan,
Nagasaki
Japan, Nara
Japan, Niigata
Japan, Oita
Japan,
Okayama
Japan,
Okinawa
Japan, Osaka
Japan, Saga
Japan,
Saitama
Japan, Shiga
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Japan,
Shimane
Japan,
Shizuoka
Japan, Tochigi
Japan,
Tokushima
Japan, Tokyo
Japan, Tottori
Japan,
Toyama
Japan,
Wakayama
Japan,
Yamagata
Japan,
Yamaguchi
Japan,
Yamanashi
Jordan, Al
Balqa'
Jordan, Al
Karak
Jordan, Al
Mafraq
Jordan,
Amman
Jordan,
Amman
Governorate
Jordan, At
Tafilah
Jordan, Az
Zarqa
Jordan, Irbid
Jordan, Ma
Kazakhstan,
Almaty
Kazakhstan,
Almaty City
Kazakhstan,
Aqmola
Kazakhstan,
Aqtobe
Kazakhstan,
Astana
Kazakhstan,
Atyrau
Kazakhstan,
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Bayqonyr
Kazakhstan,
East
Kazakhstan
Kazakhstan,
Mangghystau
Kazakhstan,
North
Kazakhstan
Kazakhstan,
Pavlodar
Kazakhstan,
Qaraghandy
Kazakhstan,
Qostanay
Kazakhstan,
Qyzylorda
Kazakhstan,
South
Kazakhstan
Kazakhstan,
West
Kazakhstan
Kazakhstan,
Zhambyl
Kenya,
Central
Kenya, Coast
Kenya,
Eastern
Kenya,
Nairobi Area
Kenya,
North-Eastern
Kenya,
Nyanza
Kenya, Rift
Valley
Kenya,
Western
Kiribati,
Gilbert Islands
Kiribati, Line
Islands
Kiribati,
Phoenix
Islands
Korea,
Democratic
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People's
Republic of,
Chagang-do
Korea,
Democratic
People's
Republic of,
Hamgyong-bu
kto
Korea,
Democratic
People's
Republic of,
Hamgyong-na
mdo
Korea,
Democratic
People's
Republic of,
Hwanghae-bu
kto
Korea,
Democratic
People's
Republic of,
Hwanghae-na
mdo
Korea,
Democratic
People's
Republic of,
Kaesong-si
Korea,
Democratic
People's
Republic of,
Kangwon-do
Korea,
Democratic
People's
Republic of,
Najin
Sonbong-si
Korea,
Democratic
People's
Republic of,
Namp'o-si
Korea,
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Democratic
People's
Republic of,
P'yongan-bukt
o
Korea,
Democratic
People's
Republic of,
P'yongan-nam
do
Korea,
Democratic
People's
Republic of,
P'yongyang-si
Korea,
Democratic
People's
Republic of,
Yanggang-do
Korea,
Republic of,
Ch'ungch'ongbukto
Korea,
Republic of,
Ch'ungch'ongnamdo
Korea,
Republic of,
Cheju-do
Korea,
Republic of,
Cholla-bukto
Korea,
Republic of,
Cholla-namdo
Korea,
Republic of,
Inch'on-jikhalsi
Korea,
Republic of,
Kangwon-do
Korea,
Republic of,
Kwangju-jikhal
si
Korea,
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Republic of,
Kyonggi-do
Korea,
Republic of,
Kyongsang-bu
kto
Korea,
Republic of,
Kyongsang-na
mdo
Korea,
Republic of,
Pusan-jikhalsi
Korea,
Republic of,
Seoul-t'ukpyol
si
Korea,
Republic of,
Taegu-jikhalsi
Korea,
Republic of,
Taejon-jikhalsi
Korea,
Republic of,
Ulsan-gwangy
oksi
Kuwait, Al
Ahmadi
Kuwait, Al
Farwaniyah
Kuwait, Al
Jahra
Kuwait, Al
Kuwayt
Kuwait,
Hawalli
Kuwait,
Mubarak al
Kabir
Kyrgyzstan,
Batken
Kyrgyzstan,
Bishkek
Kyrgyzstan,
Chuy
Kyrgyzstan,
Jalal-Abad
Kyrgyzstan,
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Naryn
Kyrgyzstan,
Osh
Kyrgyzstan,
Osh
Kyrgyzstan,
Talas
Kyrgyzstan,
Ysyk-Kol
Lao People's
Democratic
Republic,
Attapu
Lao People's
Democratic
Republic,
Champasak
Lao People's
Democratic
Republic,
Houaphan
Lao People's
Democratic
Republic,
Khammouan
Lao People's
Democratic
Republic,
Louang
Namtha
Lao People's
Democratic
Republic,
Louangphraba
ng
Lao People's
Democratic
Republic,
Oudomxai
Lao People's
Democratic
Republic,
Phongsali
Lao People's
Democratic
Republic,
Saravan
Lao People's
Democratic
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Republic,
Savannakhet
Lao People's
Democratic
Republic,
Vientiane
Lao People's
Democratic
Republic,
Xaignabouri
Lao People's
Democratic
Republic,
Xiangkhoang
Latvia,
Aizkraukles
Latvia,
Aluksnes
Latvia, Balvu
Latvia,
Bauskas
Latvia, Cesu
Latvia,
Daugavpils
Latvia,
Daugavpils
Latvia,
Dobeles
Latvia,
Gulbenes
Latvia,
Jekabpils
Latvia,
Jelgava
Latvia,
Jelgavas
Latvia,
Jurmala
Latvia,
Kraslavas
Latvia,
Kuldigas
Latvia, Liepaja
Latvia,
Liepajas
Latvia,
Limbazu
Latvia, Ludzas
Latvia,
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Madonas
Latvia, Ogres
Latvia, Preilu
Latvia,
Rezekne
Latvia,
Rezeknes
Latvia, Riga
Latvia, Rigas
Latvia, Saldus
Latvia, Talsu
Latvia,
Tukuma
Latvia, Valkas
Latvia,
Valmieras
Latvia,
Ventspils
Latvia,
Ventspils
Lebanon,
Aakk
Lebanon, Al
Janub
Lebanon,
Baalbek-Herm
el
Lebanon,
Beqaa
Lebanon,
Beqaa
Lebanon,
Beyrouth
Lebanon,
Liban-Nord
Lebanon,
Liban-Nord
Lebanon,
Liban-Sud
Lebanon,
Mont-Liban
Lebanon,
Nabatiye
Lesotho,
Berea
Lesotho,
Butha-Buthe
Lesotho,
Leribe
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Lesotho,
Mafeteng
Lesotho,
Maseru
Lesotho,
Mohales Hoek
Lesotho,
Mokhotlong
Lesotho,
Qachas Nek
Lesotho,
Quthing
Lesotho,
Thaba-Tseka
Liberia, Bong
Liberia,
Gbarpolu
Liberia, Grand
Bassa
Liberia, Grand
Cape Mount
Liberia, Grand
Cape Mount
Liberia, Grand
Gedeh
Liberia, Lofa
Liberia, Lofa
Liberia,
Margibi
Liberia,
Maryland
Liberia,
Maryland
Liberia,
Monrovia
Liberia,
Montserrado
Liberia, Nimba
Liberia, River
Cess
Liberia, River
Gee
Liberia, Sino
Libyan Arab
Jamahiriya,
Ajdabiya
Libyan Arab
Jamahiriya, Al
Aziziyah
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Libyan Arab
Jamahiriya, Al
Fatih
Libyan Arab
Jamahiriya, Al
Jabal al
Akhdar
Libyan Arab
Jamahiriya, Al
Jufrah
Libyan Arab
Jamahiriya, Al
Khums
Libyan Arab
Jamahiriya, Al
Kufrah
Libyan Arab
Jamahiriya,
An Nuqat al
Khams
Libyan Arab
Jamahiriya,
Ash Shati'
Libyan Arab
Jamahiriya,
Awbari
Libyan Arab
Jamahiriya,
Az Zawiyah
Libyan Arab
Jamahiriya,
Banghazi
Libyan Arab
Jamahiriya,
Darnah
Libyan Arab
Jamahiriya,
Ghadamis
Libyan Arab
Jamahiriya,
Gharyan
Libyan Arab
Jamahiriya,
Misratah
Libyan Arab
Jamahiriya,
Murzuq
Libyan Arab
Jamahiriya,
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Sabha
Libyan Arab
Jamahiriya,
Sawfajjin
Libyan Arab
Jamahiriya,
Surt
Libyan Arab
Jamahiriya,
Tarabulus
Libyan Arab
Jamahiriya,
Tarhunah
Libyan Arab
Jamahiriya,
Tubruq
Libyan Arab
Jamahiriya,
Yafran
Libyan Arab
Jamahiriya,
Zlitan
Liechtenstein,
Balzers
Liechtenstein,
Eschen
Liechtenstein,
Gamprin
Liechtenstein,
Gbarpolu
Liechtenstein,
Mauren
Liechtenstein,
Planken
Liechtenstein,
River Gee
Liechtenstein,
Ruggell
Liechtenstein,
Schaan
Liechtenstein,
Schellenberg
Liechtenstein,
Triesen
Liechtenstein,
Triesenberg
Liechtenstein,
Vaduz
Lithuania,
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Alytaus
Apskritis
Lithuania,
Kauno
Apskritis
Lithuania,
Klaipedos
Apskritis
Lithuania,
Marijampoles
Apskritis
Lithuania,
Panevezio
Apskritis
Lithuania,
Siauliu
Apskritis
Lithuania,
Taurages
Apskritis
Lithuania,
Telsiu
Apskritis
Lithuania,
Utenos
Apskritis
Lithuania,
Vilniaus
Apskritis
Luxembourg,
Diekirch
Luxembourg,
Grevenmache
r
Luxembourg,
Luxembourg
Macau, Ilhas
Macau,
Macau
Macedonia,
Aracinovo
Macedonia,
Bac
Macedonia,
Belcista
Macedonia,
Berovo
Macedonia,
Bistrica
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Macedonia,
Bitola
Macedonia,
Blatec
Macedonia,
Bogdanci
Macedonia,
Bogomila
Macedonia,
Bogovinje
Macedonia,
Bosilovo
Macedonia,
Brvenica
Macedonia,
Cair
Macedonia,
Capari
Macedonia,
Caska
Macedonia,
Cegrane
Macedonia,
Centar
Macedonia,
Centar Zupa
Macedonia,
Cesinovo
Macedonia,
Cucer-Sandev
o
Macedonia,
Debar
Macedonia,
Delcevo
Macedonia,
Delogozdi
Macedonia,
Demir Hisar
Macedonia,
Demir Kapija
Macedonia,
Dobrusevo
Macedonia,
Dolna Banjica
Macedonia,
Dolneni
Macedonia,
Dorce Petrov
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Macedonia,
Drugovo
Macedonia,
Dzepciste
Macedonia,
Gazi Baba
Macedonia,
Gevgelija
Macedonia,
Gostivar
Macedonia,
Gradsko
Macedonia,
Ilinden
Macedonia,
Izvor
Macedonia,
Jegunovce
Macedonia,
Kamenjane
Macedonia,
Karbinci
Macedonia,
Karpos
Macedonia,
Kavadarci
Macedonia,
Kicevo
Macedonia,
Kisela Voda
Macedonia,
Klecevce
Macedonia,
Kocani
Macedonia,
Konce
Macedonia,
Kondovo
Macedonia,
Konopiste
Macedonia,
Kosel
Macedonia,
Kratovo
Macedonia,
Kriva Palanka
Macedonia,
Krivogastani
Macedonia,
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Krusevo
Macedonia,
Kuklis
Macedonia,
Kukurecani
Macedonia,
Kumanovo
Macedonia,
Labunista
Macedonia,
Lipkovo
Macedonia,
Lozovo
Macedonia,
Lukovo
Macedonia,
Makedonska
Kamenica
Macedonia,
Makedonski
Brod
Macedonia,
Mavrovi Anovi
Macedonia,
Meseista
Macedonia,
Miravci
Macedonia,
Mogila
Macedonia,
Murtino
Macedonia,
Negotino
Macedonia,
Negotino-Polo
sko
Macedonia,
Novaci
Macedonia,
Novo Selo
Macedonia,
Oblesevo
Macedonia,
Ohrid
Macedonia,
Orasac
Macedonia,
Orizari
Macedonia,
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Oslomej
Macedonia,
Pehcevo
Macedonia,
Petrovec
Macedonia,
Plasnica
Macedonia,
Podares
Macedonia,
Prilep
Macedonia,
Probistip
Macedonia,
Radovis
Macedonia,
Rankovce
Macedonia,
Resen
Macedonia,
Rosoman
Macedonia,
Rostusa
Macedonia,
Samokov
Macedonia,
Saraj
Macedonia,
Sipkovica
Macedonia,
Sopiste
Macedonia,
Sopotnica
Macedonia,
Srbinovo
Macedonia,
Star Dojran
Macedonia,
Staravina
Macedonia,
Staro
Nagoricane
Macedonia,
Stip
Macedonia,
Struga
Macedonia,
Strumica
Macedonia,
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Studenicani
Macedonia,
Suto Orizari
Macedonia,
Sveti Nikole
Macedonia,
Tearce
Macedonia,
Tetovo
Macedonia,
Topolcani
Macedonia,
Valandovo
Macedonia,
Vasilevo
Macedonia,
Veles
Macedonia,
Velesta
Macedonia,
Vevcani
Macedonia,
Vinica
Macedonia,
Vitoliste
Macedonia,
Vranestica
Macedonia,
Vrapciste
Macedonia,
Vratnica
Macedonia,
Vrutok
Macedonia,
Zajas
Macedonia,
Zelenikovo
Macedonia,
Zelino
Macedonia,
Zitose
Macedonia,
Zletovo
Macedonia,
Zrnovci
Madagascar,
Antananarivo
Madagascar,
Antsiranana
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Madagascar,
Fianarantsoa
Madagascar,
Mahajanga
Madagascar,
Toamasina
Madagascar,
Toliara
Malawi,
Balaka
Malawi,
Blantyre
Malawi,
Chikwawa
Malawi,
Chiradzulu
Malawi,
Chitipa
Malawi,
Dedza
Malawi, Dowa
Malawi,
Karonga
Malawi,
Kasungu
Malawi,
Likoma
Malawi,
Lilongwe
Malawi,
Machinga
Malawi,
Mangochi
Malawi,
Mchinji
Malawi,
Mulanje
Malawi,
Mwanza
Malawi,
Mzimba
Malawi,
Nkhata Bay
Malawi,
Nkhotakota
Malawi,
Nsanje
Malawi,
Ntcheu
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Malawi,
Ntchisi
Malawi,
Phalombe
Malawi,
Rumphi
Malawi,
Salima
Malawi,
Thyolo
Malawi,
Zomba
Malaysia,
Johor
Malaysia,
Kedah
Malaysia,
Kelantan
Malaysia,
Kuala Lumpur
Malaysia,
Labuan
Malaysia,
Melaka
Malaysia,
Negeri
Sembilan
Malaysia,
Pahang
Malaysia,
Perak
Malaysia,
Perlis
Malaysia,
Pulau Pinang
Malaysia,
Putrajaya
Malaysia,
Sabah
Malaysia,
Sarawak
Malaysia,
Selangor
Malaysia,
Terengganu
Maldives, Alifu
Maldives, Baa
Maldives,
Dhaalu
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Maldives,
Faafu
Maldives,
Gaafu Alifu
Maldives,
Gaafu Dhaalu
Maldives,
Gnaviyani
Maldives, Haa
Alifu
Maldives, Haa
Dhaalu
Maldives,
Kaafu
Maldives,
Laamu
Maldives,
Lhaviyani
Maldives,
Maale
Maldives,
Meemu
Maldives,
Noonu
Maldives, Raa
Maldives,
Seenu
Maldives,
Shaviyani
Maldives,
Thaa
Maldives,
Vaavu
Mali, Bamako
Mali, Gao
Mali, Kayes
Mali, Kidal
Mali,
Koulikoro
Mali, Mopti
Mali, Segou
Mali, Sikasso
Mali,
Tombouctou
Mauritania,
Adrar
Mauritania,
Assaba
Mauritania,
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Brakna
Mauritania,
Dakhlet
Nouadhibou
Mauritania,
Gorgol
Mauritania,
Guidimaka
Mauritania,
Hodh Ech
Chargui
Mauritania,
Hodh El
Gharbi
Mauritania,
Inchiri
Mauritania,
Tagant
Mauritania,
Tiris Zemmour
Mauritania,
Trarza
Mauritius,
Agalega
Islands
Mauritius,
Black River
Mauritius,
Cargados
Carajos
Mauritius,
Flacq
Mauritius,
Grand Port
Mauritius,
Moka
Mauritius,
Pamplemouss
es
Mauritius,
Plaines
Wilhems
Mauritius, Port
Louis
Mauritius,
Riviere du
Rempart
Mauritius,
Rodrigues
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Mauritius,
Savanne
Mexico,
Aguascaliente
s
Mexico, Baja
California
Mexico, Baja
California Sur
Mexico,
Campeche
Mexico,
Chiapas
Mexico,
Chihuahua
Mexico,
Coahuila de
Zaragoza
Mexico,
Colima
Mexico,
Distrito
Federal
Mexico,
Durango
Mexico,
Guanajuato
Mexico,
Guerrero
Mexico,
Hidalgo
Mexico,
Jalisco
Mexico,
Mexico
Mexico,
Michoacan de
Ocampo
Mexico,
Morelos
Mexico,
Nayarit
Mexico,
Nuevo Leon
Mexico,
Oaxaca
Mexico,
Puebla
Mexico,
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Queretaro de
Arteaga
Mexico,
Quintana Roo
Mexico, San
Luis Potosi
Mexico,
Sinaloa
Mexico,
Sonora
Mexico,
Tabasco
Mexico,
Tamaulipas
Mexico,
Tlaxcala
Mexico,
Veracruz-Llav
e
Mexico,
Yucatan
Mexico,
Zacatecas
Micronesia,
Chuuk
Micronesia,
Kosrae
Micronesia,
Pohnpei
Micronesia,
Yap
Moldova,
Republic of,
Anenii Noi
Moldova,
Republic of,
Balti
Moldova,
Republic of,
Basarabeasca
Moldova,
Republic of,
Bender
Moldova,
Republic of,
Briceni
Moldova,
Republic of,
Cahul
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Moldova,
Republic of,
Calarasi
Moldova,
Republic of,
Cantemir
Moldova,
Republic of,
Causeni
Moldova,
Republic of,
Chisinau
Moldova,
Republic of,
Cimislia
Moldova,
Republic of,
Criuleni
Moldova,
Republic of,
Donduseni
Moldova,
Republic of,
Drochia
Moldova,
Republic of,
Dubasari
Moldova,
Republic of,
Edinet
Moldova,
Republic of,
Falesti
Moldova,
Republic of,
Floresti
Moldova,
Republic of,
Gagauzia
Moldova,
Republic of,
Glodeni
Moldova,
Republic of,
Hincesti
Moldova,
Republic of,
Ialoveni
Moldova,
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Republic of,
Leova
Moldova,
Republic of,
Nisporeni
Moldova,
Republic of,
Ocnita
Moldova,
Republic of,
Rezina
Moldova,
Republic of,
Riscani
Moldova,
Republic of,
Singerei
Moldova,
Republic of,
Soldanesti
Moldova,
Republic of,
Soroca
Moldova,
Republic of,
Stefan-Voda
Moldova,
Republic of,
Stinga
Nistrului
Moldova,
Republic of,
Straseni
Moldova,
Republic of,
Taraclia
Moldova,
Republic of,
Telenesti
Moldova,
Republic of,
Ungheni
Monaco, La
Condamine
Monaco,
Monaco
Monaco,
Monte-Carlo
Mongolia,
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Arhangay
Mongolia,
Bayan-Olgiy
Mongolia,
Bayanhongor
Mongolia,
Bulgan
Mongolia,
Darhan
Mongolia,
Darhan-Uul
Mongolia,
Dornod
Mongolia,
Dornogovi
Mongolia,
Dundgovi
Mongolia,
Dzavhan
Mongolia,
Erdenet
Mongolia,
Govi-Altay
Mongolia,
Govisumber
Mongolia,
Hentiy
Mongolia,
Hovd
Mongolia,
Hovsgol
Mongolia,
Omnogovi
Mongolia,
Orhon
Mongolia,
Ovorhangay
Mongolia,
Selenge
Mongolia,
Suhbaatar
Mongolia, Tov
Mongolia,
Ulaanbaatar
Mongolia, Uvs
Montserrat,
Saint Anthony
Montserrat,
Saint Georges

Copyright © AppDynamics 2012-2014

Page 885

Montserrat,
Saint Peter
Morocco,
Chaouia-Ouar
digha
Morocco,
Doukkala-Abd
a
Morocco,
Fes-Bouleman
e
Morocco,
Gharb-Chrard
a-Beni Hssen
Morocco,
Grand
Casablanca
Morocco,
Guelmim-Es
Smara
Morocco, La
Morocco,
Marrakech-Te
nsift-Al Haouz
Morocco,
Meknes-Tafilal
et
Morocco,
Oriental
Morocco,
Rabat-Sale-Ze
mmour-Zaer
Morocco,
Souss-MassaDr
Morocco,
Tadla-Azilal
Morocco,
Tanger-Tetou
an
Morocco,
Taza-Al
Hoceima-Tao
unate
Mozambique,
Cabo Delgado
Mozambique,
Gaza
Mozambique,
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Inhambane
Mozambique,
Manica
Mozambique,
Maputo
Mozambique,
Maputo
Mozambique,
Nampula
Mozambique,
Niassa
Mozambique,
Sofala
Mozambique,
Tete
Mozambique,
Zambezia
Myanmar,
Chin State
Myanmar,
Irrawaddy
Myanmar,
Kachin State
Myanmar,
Karan State
Myanmar,
Kayah State
Myanmar,
Magwe
Myanmar,
Mandalay
Myanmar,
Mon State
Myanmar,
Pegu
Myanmar,
Rakhine State
Myanmar,
Rangoon
Myanmar,
Sagaing
Myanmar,
Shan State
Myanmar,
Tenasserim
Myanmar,
Yangon
N-S
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Namibia,
Bethanien
Namibia,
Boesmanland
Namibia,
Caprivi
Namibia,
Caprivi Oos
Namibia,
Damaraland
Namibia,
Erongo
Namibia,
Gobabis
Namibia,
Grootfontein
Namibia,
Hardap
Namibia,
Hereroland
Oos
Namibia,
Hereroland
Wes
Namibia,
Kaokoland
Namibia,
Karas
Namibia,
Karasburg
Namibia,
Karibib
Namibia,
Kavango
Namibia,
Keetmanshoo
p
Namibia,
Kunene
Namibia,
Luderitz
Namibia,
Maltahohe
Namibia,
Mariental
Namibia,
Namaland
Namibia,
Ohangwena
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Namibia,
Okahandja
Namibia,
Okavango
Namibia,
Omaheke
Namibia,
Omaruru
Namibia,
Omusati
Namibia,
Oshana
Namibia,
Oshikoto
Namibia,
Otjiwarongo
Namibia,
Otjozondjupa
Namibia,
Outjo
Namibia,
Owambo
Namibia,
Rehoboth
Namibia,
Swakopmund
Namibia,
Tsumeb
Namibia,
Windhoek
Nauru, Aiwo
Nauru, Anabar
Nauru, Anetan
Nauru,
Anibare
Nauru, Baiti
Nauru, Boe
Nauru, Buada
Nauru,
Denigomodu
Nauru, Ewa
Nauru, Ijuw
Nauru,
Meneng
Nauru, Nibok
Nauru, Uaboe
Nauru, Yaren
Nepal,
Bagmati
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Nepal, Bheri
Nepal,
Dhawalagiri
Nepal,
Gandaki
Nepal,
Janakpur
Nepal, Karnali
Nepal, Kosi
Nepal,
Lumbini
Nepal,
Mahakali
Nepal, Mechi
Nepal,
Narayani
Nepal, Rapti
Nepal,
Sagarmatha
Nepal, Seti
Netherlands,
Drenthe
Netherlands,
Flevoland
Netherlands,
Friesland
Netherlands,
Gelderland
Netherlands,
Groningen
Netherlands,
Limburg
Netherlands,
Noord-Braban
t
Netherlands,
Noord-Holland
Netherlands,
Overijssel
Netherlands,
Overijssel
Netherlands,
Utrecht
Netherlands,
Zeeland
Netherlands,
Zuid-Holland
New Zealand,
Auckland
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New Zealand,
Bay of Plenty
New Zealand,
Canterbury
New Zealand,
Chatham
Islands
New Zealand,
Gisborne
New Zealand,
Hawke's Bay
New Zealand,
Manawatu-Wa
nganui
New Zealand,
Marlborough
New Zealand,
Nelson
New Zealand,
Northland
New Zealand,
Otago
New Zealand,
Southland
New Zealand,
Taranaki
New Zealand,
Waikato
New Zealand,
Wellington
New Zealand,
West Coast
Nicaragua,
Autonoma
Atlantico
Norte
Nicaragua,
Boaco
Nicaragua,
Carazo
Nicaragua,
Chinandega
Nicaragua,
Chontales
Nicaragua,
Esteli
Nicaragua,
Granada
Nicaragua,
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Jinotega
Nicaragua,
Leon
Nicaragua,
Madriz
Nicaragua,
Managua
Nicaragua,
Masaya
Nicaragua,
Matagalpa
Nicaragua,
Nueva
Segovia
Nicaragua,
Region
Autonoma
Atlantico Sur
Nicaragua,
Rio San Juan
Nicaragua,
Rivas
Nicaragua,
Zelaya
Niger, Agadez
Niger, Diffa
Niger, Dosso
Niger, Maradi
Niger, Niamey
Niger, Niamey
Niger, Tahoua
Niger, Zinder
Nigeria, Abia
Nigeria,
Adamawa
Nigeria, Akwa
Ibom
Nigeria,
Anambra
Nigeria,
Bauchi
Nigeria,
Bayelsa
Nigeria,
Benue
Nigeria, Borno
Nigeria, Cross
River
Nigeria, Delta
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Nigeria,
Ebonyi
Nigeria, Edo
Nigeria, Ekiti
Nigeria,
Enugu
Nigeria,
Federal
Capital
Territory
Nigeria,
Gombe
Nigeria, Imo
Nigeria,
Jigawa
Nigeria,
Kaduna
Nigeria, Kano
Nigeria,
Katsina
Nigeria, Kebbi
Nigeria, Kogi
Nigeria,
Kwara
Nigeria, Lagos
Nigeria,
Nassarawa
Nigeria, Niger
Nigeria, Ogun
Nigeria, Ondo
Nigeria, Osun
Nigeria, Oyo
Nigeria,
Plateau
Nigeria,
Rivers
Nigeria,
Sokoto
Nigeria,
Taraba
Nigeria, Yobe
Nigeria,
Zamfara
Norway,
Akershus
Norway,
Aust-Agder
Norway,
Buskerud
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Norway,
Finnmark
Norway,
Hedmark
Norway,
Hordaland
Norway, More
og Romsdal
Norway,
Nord-Trondela
g
Norway,
Nordland
Norway,
Oppland
Norway, Oslo
Norway,
Ostfold
Norway,
Rogaland
Norway, Sogn
og Fjordane
Norway,
Sor-Trondelag
Norway,
Telemark
Norway,
Troms
Norway,
Vest-Agder
Norway,
Vestfold
Oman, Ad
Dakhiliyah
Oman, Al
Batinah
Oman, Al
Wusta
Oman, Ash
Sharqiyah
Oman, Az
Zahirah
Oman,
Masqat
Oman,
Musandam
Oman, Zufar
Pakistan,
Azad Kashmir

Copyright © AppDynamics 2012-2014

Page 894

Pakistan,
Balochistan
Pakistan,
Federally
Administered
Tribal Areas
Pakistan,
Islamabad
Pakistan,
North-West
Frontier
Pakistan,
Northern
Areas
Pakistan,
Punjab
Pakistan,
Sindh
Palestinian
Territory,
Occupied,
Gaza
Palestinian
Territory,
Occupied,
West Bank
Panama,
Bocas del
Toro
Panama,
Chiriqui
Panama,
Cocle
Panama,
Colon
Panama,
Darien
Panama,
Herrera
Panama, Los
Santos
Panama,
Panama
Panama, San
Blas
Panama,
Veraguas
Papua New
Guinea,

Copyright © AppDynamics 2012-2014

Page 895

Central
Papua New
Guinea,
Chimbu
Papua New
Guinea, East
New Britain
Papua New
Guinea, East
Sepik
Papua New
Guinea,
Eastern
Highlands
Papua New
Guinea, Enga
Papua New
Guinea, Gulf
Papua New
Guinea,
Madang
Papua New
Guinea,
Manus
Papua New
Guinea, Milne
Bay
Papua New
Guinea,
Morobe
Papua New
Guinea,
National
Capital
Papua New
Guinea, New
Ireland
Papua New
Guinea, North
Solomons
Papua New
Guinea,
Northern
Papua New
Guinea,
Sandaun
Papua New
Guinea,
Southern
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Highlands
Papua New
Guinea, West
New Britain
Papua New
Guinea,
Western
Papua New
Guinea,
Western
Highlands
Paraguay,
Alto Paraguay
Paraguay,
Alto Parana
Paraguay,
Amambay
Paraguay,
Boqueron
Paraguay,
Caaguazu
Paraguay,
Caazapa
Paraguay,
Canindeyu
Paraguay,
Central
Paraguay,
Chaco
Paraguay,
Concepcion
Paraguay,
Cordillera
Paraguay,
Guaira
Paraguay,
Itapua
Paraguay,
Misiones
Paraguay,
Neembucu
Paraguay,
Nueva
Asuncion
Paraguay,
Paraguari
Paraguay,
Presidente
Hayes
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Paraguay,
San Pedro
Peru,
Amazonas
Peru, Ancash
Peru,
Apurimac
Peru,
Arequipa
Peru,
Ayacucho
Peru,
Cajamarca
Peru, Callao
Peru, Cusco
Peru,
Huancavelica
Peru,
Huanuco
Peru, Ica
Peru, Junin
Peru, La
Libertad
Peru,
Lambayeque
Peru, Lima
Peru, Loreto
Peru, Madre
de Dios
Peru,
Moquegua
Peru, Pasco
Peru, Piura
Peru, Puno
Peru, San
Martin
Peru, Tacna
Peru, Tumbes
Peru, Ucayali
Philippines,
Abra
Philippines,
Agusan del
Norte
Philippines,
Agusan del
Sur
Philippines,
Aklan
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Philippines,
Albay
Philippines,
Angeles
Philippines,
Antique
Philippines,
Aurora
Philippines,
Bacolod
Philippines,
Bago
Philippines,
Baguio
Philippines,
Bais
Philippines,
Basilan
Philippines,
Basilan City
Philippines,
Bataan
Philippines,
Batanes
Philippines,
Batangas
Philippines,
Batangas City
Philippines,
Benguet
Philippines,
Bohol
Philippines,
Bukidnon
Philippines,
Bulacan
Philippines,
Butuan
Philippines,
Cabanatuan
Philippines,
Cadiz
Philippines,
Cagayan
Philippines,
Cagayan de
Oro
Philippines,
Calbayog
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Philippines,
Caloocan
Philippines,
Camarines
Norte
Philippines,
Camarines
Sur
Philippines,
Camiguin
Philippines,
Canlaon
Philippines,
Capiz
Philippines,
Catanduanes
Philippines,
Cavite
Philippines,
Cavite City
Philippines,
Cebu
Philippines,
Cebu City
Philippines,
Cotabato
Philippines,
Dagupan
Philippines,
Danao
Philippines,
Dapitan
Philippines,
Davao
Philippines,
Davao City
Philippines,
Davao del Sur
Philippines,
Davao
Oriental
Philippines,
Dipolog
Philippines,
Dumaguete
Philippines,
Eastern
Samar
Philippines,
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General
Santos
Philippines,
Gingoog
Philippines,
Ifugao
Philippines,
Iligan
Philippines,
Ilocos Norte
Philippines,
Ilocos Sur
Philippines,
Iloilo
Philippines,
Iloilo City
Philippines,
Iriga
Philippines,
Isabela
Philippines,
Kalinga-Apaya
o
Philippines, La
Carlota
Philippines, La
Union
Philippines,
Laguna
Philippines,
Lanao del
Norte
Philippines,
Lanao del Sur
Philippines,
Laoag
Philippines,
Lapu-Lapu
Philippines,
Legaspi
Philippines,
Leyte
Philippines,
Lipa
Philippines,
Lucena
Philippines,
Maguindanao
Philippines,
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Mandaue
Philippines,
Manila
Philippines,
Marawi
Philippines,
Marinduque
Philippines,
Masbate
Philippines,
Mindoro
Occidental
Philippines,
Mindoro
Oriental
Philippines,
Misamis
Occidental
Philippines,
Misamis
Oriental
Philippines,
Mountain
Philippines,
Naga
Philippines,
Negros
Occidental
Philippines,
Negros
Occidental
Philippines,
Negros
Oriental
Philippines,
North
Cotabato
Philippines,
Northern
Samar
Philippines,
Nueva Ecija
Philippines,
Nueva
Vizcaya
Philippines,
Olongapo
Philippines,
Ormoc
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Philippines,
Oroquieta
Philippines,
Ozamis
Philippines,
Pagadian
Philippines,
Palawan
Philippines,
Palayan
Philippines,
Pampanga
Philippines,
Pangasinan
Philippines,
Pasay
Philippines,
Puerto
Princesa
Philippines,
Quezon
Philippines,
Quezon City
Philippines,
Quirino
Philippines,
Rizal
Philippines,
Romblon
Philippines,
Roxas
Philippines,
Samar
Philippines,
San Carlos
Philippines,
San Carlos
Philippines,
San Jose
Philippines,
San Pablo
Philippines,
Silay
Philippines,
Siquijor
Philippines,
Sorsogon
Philippines,
South
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Cotabato
Philippines,
Southern
Leyte
Philippines,
Sultan
Kudarat
Philippines,
Sulu
Philippines,
Surigao
Philippines,
Surigao del
Norte
Philippines,
Surigao del
Sur
Philippines,
Tacloban
Philippines,
Tagaytay
Philippines,
Tagbilaran
Philippines,
Tangub
Philippines,
Tarlac
Philippines,
Tawitawi
Philippines,
Toledo
Philippines,
Trece Martires
Philippines,
Zambales
Philippines,
Zamboanga
Philippines,
Zamboanga
del Norte
Philippines,
Zamboanga
del Sur
Poland,
Dolnoslaskie
Poland,
Kujawsko-Po
morskie
Poland,
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Lodzkie
Poland,
Lubelskie
Poland,
Lubuskie
Poland,
Malopolskie
Poland,
Mazowieckie
Poland,
Opolskie
Poland,
Podkarpackie
Poland,
Podlaskie
Poland,
Pomorskie
Poland,
Slaskie
Poland,
Swietokrzyski
e
Poland,
Warminsko-M
azurskie
Poland,
Wielkopolskie
Poland,
Zachodniopo
morskie
Portugal,
Aveiro
Portugal,
Azores
Portugal, Beja
Portugal,
Braga
Portugal,
Braganca
Portugal,
Castelo
Branco
Portugal,
Coimbra
Portugal,
Evora
Portugal, Faro
Portugal,
Guarda
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Portugal,
Leiria
Portugal,
Lisboa
Portugal,
Madeira
Portugal,
Portalegre
Portugal,
Porto
Portugal,
Santarem
Portugal,
Setubal
Portugal,
Viana do
Castelo
Portugal, Vila
Real
Portugal,
Viseu
Qatar, Ad
Dawhah
Qatar, Al
Ghuwariyah
Qatar, Al
Jumaliyah
Qatar, Al
Khawr
Qatar, Al
Wakrah
Qatar, Al
Wakrah
Municipality
Qatar, Ar
Rayyan
Qatar, Jariyan
al Batnah
Qatar,
Madinat ach
Shamal
Qatar, Umm
Sa'id
Qatar, Umm
Salal
Romania,
Alba
Romania,
Arad
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Romania,
Arges
Romania,
Bacau
Romania,
Bihor
Romania,
Bistrita-Nasau
d
Romania,
Botosani
Romania,
Braila
Romania,
Brasov
Romania,
Bucuresti
Romania,
Buzau
Romania,
Calarasi
Romania,
Caras-Severin
Romania, Cluj
Romania,
Constanta
Romania,
Covasna
Romania,
Dambovita
Romania, Dolj
Romania,
Galati
Romania,
Giurgiu
Romania, Gorj
Romania,
Harghita
Romania,
Hunedoara
Romania,
Ialomita
Romania, Iasi
Romania, Ilfov
Romania,
Maramures
Romania,
Mehedinti
Romania,
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Mures
Romania,
Neamt
Romania, Olt
Romania,
Prahova
Romania,
Salaj
Romania,
Satu Mare
Romania,
Sibiu
Romania,
Suceava
Romania,
Teleorman
Romania,
Timis
Romania,
Tulcea
Romania,
Valcea
Romania,
Vaslui
Romania,
Vrancea
Russian
Federation,
Adygeya
Russian
Federation,
Aginsky
Buryatsky AO
Russian
Federation,
Altaisky krai
Russian
Federation,
Amur
Russian
Federation,
Arkhangel'sk
Russian
Federation,
Astrakhan'
Russian
Federation,
Bashkortostan
Russian

Copyright © AppDynamics 2012-2014

Page 908

Federation,
Belgorod
Russian
Federation,
Bryansk
Russian
Federation,
Buryat
Russian
Federation,
Chechnya
Russian
Federation,
Chechnya
Republic
Russian
Federation,
Chelyabinsk
Russian
Federation,
Chita
Russian
Federation,
Chukot
Russian
Federation,
Chuvashia
Russian
Federation,
Dagestan
Russian
Federation,
Evenk
Russian
Federation,
Gorno-Altay
Russian
Federation,
Ingush
Russian
Federation,
Irkutsk
Russian
Federation,
Ivanovo
Russian
Federation,
Kabardin-Balk
ar
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Russian
Federation,
Kaliningrad
Russian
Federation,
Kalmyk
Russian
Federation,
Kaluga
Russian
Federation,
Kamchatka
Russian
Federation,
Karachay-Che
rkess
Russian
Federation,
Karelia
Russian
Federation,
Kemerovo
Russian
Federation,
Khabarovsk
Russian
Federation,
Khakass
Russian
Federation,
Khanty-Mansi
y
Russian
Federation,
Kirov
Russian
Federation,
Komi
Russian
Federation,
Komi-Permya
k
Russian
Federation,
Koryak
Russian
Federation,
Kostroma
Russian
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Federation,
Krasnodar
Russian
Federation,
Krasnoyarsk
Russian
Federation,
Krasnoyarskiy
Kray
Russian
Federation,
Kurgan
Russian
Federation,
Kursk
Russian
Federation,
Leningrad
Russian
Federation,
Lipetsk
Russian
Federation,
Magadan
Russian
Federation,
Mariy-El
Russian
Federation,
Mordovia
Russian
Federation,
Moscow City
Russian
Federation,
Moskva
Russian
Federation,
Murmansk
Russian
Federation,
Nenets
Russian
Federation,
Nizhegorod
Russian
Federation,
North Ossetia
Russian
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Federation,
Novgorod
Russian
Federation,
Novosibirsk
Russian
Federation,
Omsk
Russian
Federation,
Orel
Russian
Federation,
Orenburg
Russian
Federation,
Penza
Russian
Federation,
Perm'
Russian
Federation,
Permskiy Kray
Russian
Federation,
Primor'ye
Russian
Federation,
Pskov
Russian
Federation,
Rostov
Russian
Federation,
Ryazan'
Russian
Federation,
Saint
Petersburg
City
Russian
Federation,
Sakha
Russian
Federation,
Sakhalin
Russian
Federation,
Samara
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Russian
Federation,
Saratov
Russian
Federation,
Smolensk
Russian
Federation,
Stavropol'
Russian
Federation,
Sverdlovsk
Russian
Federation,
Tambovskaya
oblast
Russian
Federation,
Tatarstan
Russian
Federation,
Taymyr
Russian
Federation,
Tomsk
Russian
Federation,
Tula
Russian
Federation,
Tuva
Russian
Federation,
Tver'
Russian
Federation,
Tyumen'
Russian
Federation,
Udmurt
Russian
Federation,
Ul'yanovsk
Russian
Federation,
Ust-Orda
Buryat
Russian
Federation,
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Vladimir
Russian
Federation,
Volgograd
Russian
Federation,
Vologda
Russian
Federation,
Voronezh
Russian
Federation,
Yamal-Nenets
Russian
Federation,
Yaroslavl'
Russian
Federation,
Yevrey
Rwanda,
Butare
Rwanda, Est
Rwanda,
Gitarama
Rwanda,
Kibungo
Rwanda,
Kigali
Rwanda,
Kigali
Rwanda, Nord
Rwanda,
Ouest
Rwanda, Sud
Saint Helena,
Ascension
Saint Helena,
Saint Helena
Saint Helena,
Tristan da
Cunha
Saint Kitts and
Nevis, Christ
Church
Nichola Town
Saint Kitts and
Nevis, Saint
Anne Sandy
Point
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Saint Kitts and
Nevis, Saint
George
Basseterre
Saint Kitts and
Nevis, Saint
George
Gingerland
Saint Kitts and
Nevis, Saint
James
Windward
Saint Kitts and
Nevis, Saint
John
Capisterre
Saint Kitts and
Nevis, Saint
John Figtree
Saint Kitts and
Nevis, Saint
Mary Cayon
Saint Kitts and
Nevis, Saint
Paul
Capisterre
Saint Kitts and
Nevis, Saint
Paul
Charlestown
Saint Kitts and
Nevis, Saint
Peter
Basseterre
Saint Kitts and
Nevis, Saint
Thomas
Lowland
Saint Kitts and
Nevis, Saint
Thomas
Middle Island
Saint Kitts and
Nevis, Trinity
Palmetto Point
Saint Lucia,
Anse-la-Raye
Saint Lucia,
Castries
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Saint Lucia,
Choiseul
Saint Lucia,
Dauphin
Saint Lucia,
Dennery
Saint Lucia,
Gros-Islet
Saint Lucia,
Laborie
Saint Lucia,
Micoud
Saint Lucia,
Praslin
Saint Lucia,
Soufriere
Saint Lucia,
Vieux-Fort
Saint Vincent
and the
Grenadines,
Charlotte
Saint Vincent
and the
Grenadines,
Grenadines
Saint Vincent
and the
Grenadines,
Saint Andrew
Saint Vincent
and the
Grenadines,
Saint David
Saint Vincent
and the
Grenadines,
Saint George
Saint Vincent
and the
Grenadines,
Saint Patrick
Samoa,
Aiga-i-le-Tai
Samoa, Atua
Samoa, Fa
Samoa, Gaga
Samoa,
Gagaifomaug
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a
Samoa,
Palauli
Samoa,
Satupa
Samoa,
Tuamasaga
Samoa, Va
Samoa,
Vaisigano
San Marino,
Acquaviva
San Marino,
Borgo
Maggiore
San Marino,
Chiesanuova
San Marino,
Domagnano
San Marino,
Faetano
San Marino,
Fiorentino
San Marino,
Monte
Giardino
San Marino,
San Marino
San Marino,
Serravalle
Sao Tome
and Principe,
Principe
Sao Tome
and Principe,
Sao Tome
Saudi Arabia,
Al Bahah
Saudi Arabia,
Al Hudud ash
Shamaliyah
Saudi Arabia,
Al Jawf
Saudi Arabia,
Al Jawf
Saudi Arabia,
Al Madinah
Saudi Arabia,
Al Qasim
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Saudi Arabia,
Al Qurayyat
Saudi Arabia,
Ar Riyad
Saudi Arabia,
Ash Sharqiyah
Saudi Arabia,
Ha'il
Saudi Arabia,
Jizan
Saudi Arabia,
Makkah
Saudi Arabia,
Najran
Saudi Arabia,
Tabuk
Senegal,
Dakar
Senegal,
Diourbel
Senegal,
Fatick
Senegal,
Kaolack
Senegal,
Kolda
Senegal,
Louga
Senegal,
Matam
Senegal,
Saint-Louis
Senegal,
Tambacounda
Senegal,
Thies
Senegal,
Ziguinchor
Serbia,
Kosovo
Serbia,
Vojvodina
Seychelles,
Anse aux Pins
Seychelles,
Anse Boileau
Seychelles,
Anse Etoile
Seychelles,
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Anse Louis
Seychelles,
Anse Royale
Seychelles,
Baie Lazare
Seychelles,
Baie Sainte
Anne
Seychelles,
Beau Vallon
Seychelles,
Bel Air
Seychelles,
Bel Ombre
Seychelles,
Cascade
Seychelles,
Glacis
Seychelles,
Grand' Anse
Seychelles,
Grand' Anse
Seychelles, La
Digue
Seychelles, La
Riviere
Anglaise
Seychelles,
Mont Buxton
Seychelles,
Mont Fleuri
Seychelles,
Plaisance
Seychelles,
Pointe La Rue
Seychelles,
Port Glaud
Seychelles,
Saint Louis
Seychelles,
Takamaka
Sierra Leone,
Eastern
Sierra Leone,
Northern
Sierra Leone,
Southern
Sierra Leone,
Western Area
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Slovakia,
Banska
Bystrica
Slovakia,
Bratislava
Slovakia,
Kosice
Slovakia, Nitra
Slovakia,
Presov
Slovakia,
Trencin
Slovakia,
Trnava
Slovakia,
Zilina
Slovenia,
Ajdovscina
Slovenia,
Beltinci
Slovenia, Bled
Slovenia,
Bohinj
Slovenia,
Borovnica
Slovenia,
Bovec
Slovenia, Brda
Slovenia,
Brezice
Slovenia,
Brezovica
Slovenia,
Celje
Slovenia,
Cerklje na
Gorenjskem
Slovenia,
Cerknica
Slovenia,
Cerkno
Slovenia,
Crensovci
Slovenia,
Crna na
Koroskem
Slovenia,
Crnomelj
Slovenia,
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Divaca
Slovenia,
Dobrepolje
Slovenia,
Dobrova-Horju
l-Polhov
Gradec
Slovenia, Dol
pri Ljubljani
Slovenia,
Domzale
Slovenia,
Dornava
Slovenia,
Dravograd
Slovenia,
Duplek
Slovenia,
Gorenja
Vas-Poljane
Slovenia,
Gorisnica
Slovenia,
Gornja
Radgona
Slovenia,
Gornji Grad
Slovenia,
Gornji
Petrovci
Slovenia,
Grosuplje
Slovenia,
Hrastnik
Slovenia,
Hrpelje-Kozin
a
Slovenia,
Idrija
Slovenia, Ig
Slovenia,
Ilirska Bistrica
Slovenia,
Ivancna
Gorica
Slovenia,
Izola-Isola
Slovenia,
Jesenice
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Slovenia,
Jursinci
Slovenia,
Kamnik
Slovenia,
Kanal
Slovenia,
Kidricevo
Slovenia,
Kobarid
Slovenia,
Kobilje
Slovenia,
Kocevje
Slovenia,
Komen
Slovenia,
Koper-Capodi
stria
Slovenia,
Kozje
Slovenia,
Kranj
Slovenia,
Kranjska Gora
Slovenia,
Krsko
Slovenia,
Kungota
Slovenia,
Kuzma
Slovenia,
Lasko
Slovenia,
Lenart
Slovenia, Litija
Slovenia,
Ljubljana
Slovenia,
Ljubno
Slovenia,
Ljutomer
Slovenia,
Logatec
Slovenia,
Loska Dolina
Slovenia,
Loski Potok
Slovenia,
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Luce
Slovenia,
Lukovica
Slovenia,
Majsperk
Slovenia,
Maribor
Slovenia,
Medvode
Slovenia,
Menges
Slovenia,
Metlika
Slovenia,
Mezica
Slovenia,
Miren-Kostanj
evica
Slovenia,
Mislinja
Slovenia,
Moravce
Slovenia,
Moravske
Toplice
Slovenia,
Mozirje
Slovenia,
Murska
Sobota
Slovenia,
Muta
Slovenia,
Naklo
Slovenia,
Nazarje
Slovenia,
Nova Gorica
Slovenia,
Novo Mesto
Slovenia,
Odranci
Slovenia,
Ormoz
Slovenia,
Osilnica
Slovenia,
Pesnica
Slovenia,
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Piran
Slovenia,
Pivka
Slovenia,
Podcetrtek
Slovenia,
Postojna
Slovenia,
Preddvor
Slovenia, Ptuj
Slovenia,
Puconci
Slovenia,
Racam
Slovenia,
Radece
Slovenia,
Radenci
Slovenia,
Radlje ob
Dravi
Slovenia,
Radovljica
Slovenia,
Ribnica
Slovenia,
Rogaska
Slatina
Slovenia,
Rogasovci
Slovenia,
Rogatec
Slovenia,
Ruse
Slovenia,
Semic
Slovenia,
Sencur
Slovenia,
Sentilj
Slovenia,
Sentjernej
Slovenia,
Sentjur pri
Celju
Slovenia,
Sevnica
Slovenia,
Sezana
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Slovenia,
Skocjan
Slovenia,
Skofja Loka
Slovenia,
Skofljica
Slovenia,
Slovenj
Gradec
Slovenia,
Slovenska
Bistrica
Slovenia,
Slovenske
Konjice
Slovenia,
Smarje pri
Jelsah
Slovenia,
Smartno ob
Paki
Slovenia,
Sostanj
Slovenia,
Starse
Slovenia,
Store
Slovenia,
Sveti Jurij
Slovenia,
Tolmin
Slovenia,
Trbovlje
Slovenia,
Trebnje
Slovenia,
Trzic
Slovenia,
Turnisce
Slovenia,
Velenje
Slovenia,
Velike Lasce
Slovenia,
Videm
Slovenia,
Vipava
Slovenia,
Vitanje
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Slovenia,
Vodice
Slovenia,
Vojnik
Slovenia,
Vrhnika
Slovenia,
Vuzenica
Slovenia,
Zagorje ob
Savi
Slovenia,
Zalec
Slovenia,
Zavrc
Slovenia,
Zelezniki
Slovenia, Ziri
Slovenia,
Zrece
Solomon
Islands,
Central
Solomon
Islands,
Choiseul
Solomon
Islands,
Guadalcanal
Solomon
Islands, Isabel
Solomon
Islands,
Makira
Solomon
Islands,
Malaita
Solomon
Islands,
Rennell and
Bellona
Solomon
Islands,
Temotu
Solomon
Islands,
Western
Somalia,
Awdal
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Somalia,
Bakool
Somalia,
Banaadir
Somalia, Bari
Somalia, Bay
Somalia,
Galguduud
Somalia,
Gedo
Somalia,
Hiiraan
Somalia,
Jubbada
Dhexe
Somalia,
Jubbada
Hoose
Somalia,
Mudug
Somalia,
Nugaal
Somalia,
Nugaal
Somalia,
Sanaag
Somalia,
Shabeellaha
Dhexe
Somalia,
Shabeellaha
Hoose
Somalia, Sool
Somalia,
Togdheer
Somalia,
Woqooyi
Galbeed
Somalia,
Woqooyi
Galbeed
South Africa,
Eastern Cape
South Africa,
Free State
South Africa,
Gauteng
South Africa,
KwaZulu-Nata
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l
South Africa,
Limpopo
South Africa,
Mpumalanga
South Africa,
North-West
South Africa,
North-Western
Province
South Africa,
Northern
Cape
South Africa,
Western Cape
Spain,
Andalucia
Spain, Aragon
Spain,
Asturias
Spain,
Canarias
Spain,
Cantabria
Spain, Castilla
y Leon
Spain,
Castilla-La
Mancha
Spain,
Catalonia
Spain,
Comunidad
Valenciana
Spain,
Extremadura
Spain, Galicia
Spain, Islas
Baleares
Spain, La
Rioja
Spain, Madrid
Spain, Murcia
Spain,
Navarra
Spain, Pais
Vasco
Sri Lanka,
Amparai
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Sri Lanka,
Anuradhapura
Sri Lanka,
Badulla
Sri Lanka,
Batticaloa
Sri Lanka,
Central
Sri Lanka,
Colombo
Sri Lanka,
Galle
Sri Lanka,
Gampaha
Sri Lanka,
Hambantota
Sri Lanka,
Jaffna
Sri Lanka,
Kalutara
Sri Lanka,
Kandy
Sri Lanka,
Kegalla
Sri Lanka,
Kurunegala
Sri Lanka,
Mannar
Sri Lanka,
Matale
Sri Lanka,
Matara
Sri Lanka,
Moneragala
Sri Lanka,
Mullaittivu
Sri Lanka,
North Central
Sri Lanka,
North Western
Sri Lanka,
Northern
Sri Lanka,
Nuwara Eliya
Sri Lanka,
Polonnaruwa
Sri Lanka,
Puttalam
Sri Lanka,
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Ratnapura
Sri Lanka,
Sabaragamuw
a
Sri Lanka,
Southern
Sri Lanka,
Trincomalee
Sri Lanka,
Uva
Sri Lanka,
Vavuniya
Sri Lanka,
Western
Sudan, Al
Istiwa'iyah
Sudan, Al
Khartum
Sudan, Al
Wahadah
State
Sudan, Al
Wusta
Sudan, Ash
Shamaliyah
Sudan, Ash
Sharqiyah
Sudan, Bahr
al Ghazal
Sudan,
Central
Equatoria
State
Sudan, Darfur
Sudan,
Kurdufan
Sudan, Upper
Nile
Suriname,
Brokopondo
Suriname,
Commewijne
Suriname,
Coronie
Suriname,
Marowijne
Suriname,
Nickerie
Suriname,
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Para
Suriname,
Paramaribo
Suriname,
Saramacca
Suriname,
Sipaliwini
Suriname,
Wanica
Swaziland,
Hhohho
Swaziland,
Lubombo
Swaziland,
Manzini
Swaziland,
Praslin
Swaziland,
Shiselweni
Sweden,
Blekinge Lan
Sweden,
Dalarnas Lan
Sweden,
Gavleborgs
Lan
Sweden,
Gotlands Lan
Sweden,
Hallands Lan
Sweden,
Jamtlands Lan
Sweden,
Jonkopings
Lan
Sweden,
Kalmar Lan
Sweden,
Kronobergs
Lan
Sweden,
Norrbottens
Lan
Sweden,
Orebro Lan
Sweden,
Ostergotlands
Lan
Sweden,
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Skane Lan
Sweden,
Sodermanland
s Lan
Sweden,
Stockholms
Lan
Sweden,
Uppsala Lan
Sweden,
Varmlands
Lan
Sweden,
Vasterbottens
Lan
Sweden,
Vasternorrlan
ds Lan
Sweden,
Vastmanlands
Lan
Sweden,
Vastra
Gotaland
Switzerland,
Aargau
Switzerland,
Ausser-Rhode
n
Switzerland,
Basel-Landsc
haft
Switzerland,
Basel-Stadt
Switzerland,
Bern
Switzerland,
Fribourg
Switzerland,
Geneve
Switzerland,
Glarus
Switzerland,
Graubunden
Switzerland,
Inner-Rhoden
Switzerland,
Jura
Switzerland,
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Luzern
Switzerland,
Neuchatel
Switzerland,
Nidwalden
Switzerland,
Obwalden
Switzerland,
Sankt Gallen
Switzerland,
Schaffhausen
Switzerland,
Schwyz
Switzerland,
Solothurn
Switzerland,
Thurgau
Switzerland,
Ticino
Switzerland,
Uri
Switzerland,
Valais
Switzerland,
Vaud
Switzerland,
Zug
Switzerland,
Zurich
Syrian Arab
Republic, Al
Hasakah
Syrian Arab
Republic, Al
Ladhiqiyah
Syrian Arab
Republic, Al
Qunaytirah
Syrian Arab
Republic, Ar
Raqqah
Syrian Arab
Republic, As
Suwayda'
Syrian Arab
Republic, Dar
Syrian Arab
Republic,
Dayr az Zawr
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Syrian Arab
Republic,
Dimashq
Syrian Arab
Republic,
Halab
Syrian Arab
Republic,
Hamah
Syrian Arab
Republic,
Hims
Syrian Arab
Republic, Idlib
Syrian Arab
Republic, Rif
Dimashq
Syrian Arab
Republic,
Tartus
T-Z

Taiwan,
Fu-chien
Taiwan,
Kao-hsiung
Taiwan,
T'ai-pei
Taiwan,
T'ai-wan
Tajikistan,
Khatlon
Tajikistan,
Kuhistoni
Badakhshon
Tajikistan,
Sughd
Tanzania,
Arusha
Tanzania, Dar
es Salaam
Tanzania,
Dodoma
Tanzania,
Iringa
Tanzania,
Kagera
Tanzania,
Kigoma

Copyright © AppDynamics 2012-2014

Page 934

Tanzania,
Kilimanjaro
Tanzania,
Lindi
Tanzania,
Manyara
Tanzania,
Mara
Tanzania,
Mbeya
Tanzania,
Morogoro
Tanzania,
Mtwara
Tanzania,
Mwanza
Tanzania,
Pemba North
Tanzania,
Pemba South
Tanzania,
Pwani
Tanzania,
Rukwa
Tanzania,
Ruvuma
Tanzania,
Shinyanga
Tanzania,
Singida
Tanzania,
Tabora
Tanzania,
Tanga
Tanzania,
Zanzibar
Central
Tanzania,
Zanzibar
North
Tanzania,
Zanzibar
Urban
Thailand,
Amnat
Charoen
Thailand, Ang
Thong
Thailand,
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Buriram
Thailand,
Chachoengsa
o
Thailand, Chai
Nat
Thailand,
Chaiyaphum
Thailand,
Chanthaburi
Thailand,
Chiang Mai
Thailand,
Chiang Rai
Thailand,
Chon Buri
Thailand,
Chumphon
Thailand,
Kalasin
Thailand,
Kamphaeng
Phet
Thailand,
Kanchanaburi
Thailand,
Khon Kaen
Thailand,
Krabi
Thailand,
Krung Thep
Thailand,
Lampang
Thailand,
Lamphun
Thailand, Loei
Thailand, Lop
Buri
Thailand, Mae
Hong Son
Thailand,
Maha
Sarakham
Thailand,
Mukdahan
Thailand,
Nakhon
Nayok
Thailand,
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Nakhon
Pathom
Thailand,
Nakhon
Phanom
Thailand,
Nakhon
Phanom
Thailand,
Nakhon
Ratchasima
Thailand,
Nakhon
Sawan
Thailand,
Nakhon Si
Thammarat
Thailand, Nan
Thailand,
Narathiwat
Thailand,
Nong Bua
Lamphu
Thailand,
Nong Khai
Thailand,
Nonthaburi
Thailand,
Pathum Thani
Thailand,
Pattani
Thailand,
Phangnga
Thailand,
Phatthalung
Thailand,
Phayao
Thailand,
Phetchabun
Thailand,
Phetchaburi
Thailand,
Phichit
Thailand,
Phitsanulok
Thailand, Phra
Nakhon Si
Ayutthaya
Thailand,
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Phrae
Thailand,
Phuket
Thailand,
Prachin Buri
Thailand,
Prachuap
Khiri Khan
Thailand,
Ranong
Thailand,
Ratchaburi
Thailand,
Rayong
Thailand, Roi
Et
Thailand, Sa
Kaeo
Thailand,
Sakon
Nakhon
Thailand,
Samut Prakan
Thailand,
Samut
Sakhon
Thailand,
Samut
Songkhram
Thailand,
Saraburi
Thailand,
Satun
Thailand, Sing
Buri
Thailand,
Sisaket
Thailand,
Songkhla
Thailand,
Sukhothai
Thailand,
Suphan Buri
Thailand,
Surat Thani
Thailand,
Surin
Thailand, Tak
Thailand,
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Trang
Thailand, Trat
Thailand,
Ubon
Ratchathani
Thailand,
Ubon
Ratchathani
Thailand,
Udon Thani
Thailand,
Uthai Thani
Thailand,
Uttaradit
Thailand, Yala
Thailand,
Yasothon
The Bahamas,
Acklins and
Crooked
Islands
The Bahamas,
Bimini
The Bahamas,
Cat Island
The Bahamas,
Exuma
The Bahamas,
Freeport
The Bahamas,
Fresh Creek
The Bahamas,
Governor's
Harbour
The Bahamas,
Green Turtle
Cay
The Bahamas,
Harbour
Island
The Bahamas,
High Rock
The Bahamas,
Inagua
The Bahamas,
Kemps Bay
The Bahamas,
Long Island
The Bahamas,
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Marsh
Harbour
The Bahamas,
Mayaguana
The Bahamas,
New
Providence
The Bahamas,
Nichollstown
and Berry
Islands
The Bahamas,
Ragged Island
The Bahamas,
Rock Sound
The Bahamas,
San Salvador
and Rum Cay
The Bahamas,
Sandy Point
Togo,
Centrale
Togo, Kara
Togo,
Maritime
Togo,
Plateaux
Togo,
Savanes
Tonga, Ha
Tonga,
Tongatapu
Tonga, Vava
Trinidad and
Tobago,
Arima
Trinidad and
Tobago,
Caroni
Trinidad and
Tobago,
Mayaro
Trinidad and
Tobago,
Nariva
Trinidad and
Tobago,
Port-of-Spain
Trinidad and
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Tobago, Saint
Andrew
Trinidad and
Tobago, Saint
David
Trinidad and
Tobago, Saint
George
Trinidad and
Tobago, Saint
Patrick
Trinidad and
Tobago, San
Fernando
Trinidad and
Tobago,
Tobago
Trinidad and
Tobago,
Victoria
Tunisia, Aiana
Tunisia, Al
Mahdia
Tunisia, Al
Munastir
Tunisia, Bajah
Tunisia, Ben
Arous
Tunisia,
Bizerte
Tunisia, El Kef
Tunisia,
Gabes
Tunisia,
Jendouba
Tunisia,
Kairouan
Tunisia,
Kasserine
Tunisia, Kebili
Tunisia,
Madanin
Tunisia,
Manouba
Tunisia,
Nabeul
Tunisia,
Qafsah
Tunisia, Sfax
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Tunisia, Sidi
Bou Zid
Tunisia,
Siliana
Tunisia,
Sousse
Tunisia,
Tataouine
Tunisia,
Tozeur
Tunisia, Tunis
Tunisia,
Zaghouan
Turkey, Adana
Turkey,
Adiyaman
Turkey,
Afyonkarahisa
r
Turkey, Agri
Turkey,
Aksaray
Turkey,
Amasya
Turkey,
Ankara
Turkey,
Antalya
Turkey,
Ardahan
Turkey, Artvin
Turkey, Aydin
Turkey,
Balikesir
Turkey, Bartin
Turkey,
Batman
Turkey,
Bayburt
Turkey, Bilecik
Turkey, Bingol
Turkey, Bitlis
Turkey, Bolu
Turkey,
Burdur
Turkey, Bursa
Turkey,
Canakkale
Turkey,
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Cankiri
Turkey,
Corum
Turkey,
Denizli
Turkey,
Diyarbakir
Turkey, Duzce
Turkey, Edirne
Turkey, Elazig
Turkey,
Erzincan
Turkey,
Erzurum
Turkey,
Eskisehir
Turkey,
Gaziantep
Turkey,
Giresun
Turkey,
Gumushane
Turkey,
Hakkari
Turkey, Hatay
Turkey, Igdir
Turkey,
Isparta
Turkey,
Istanbul
Turkey, Izmir
Turkey,
Kahramanmar
as
Turkey,
Karabuk
Turkey,
Karaman
Turkey, Kars
Turkey,
Kastamonu
Turkey,
Kayseri
Turkey, Kilis
Turkey,
Kirikkale
Turkey,
Kirklareli
Turkey,
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Kirsehir
Turkey,
Kocaeli
Turkey, Konya
Turkey,
Kutahya
Turkey,
Malatya
Turkey,
Manisa
Turkey,
Mardin
Turkey,
Mersin
Turkey, Mugla
Turkey, Mus
Turkey,
Nevsehir
Turkey, Nigde
Turkey, Ordu
Turkey,
Osmaniye
Turkey, Rize
Turkey,
Sakarya
Turkey,
Samsun
Turkey,
Sanliurfa
Turkey, Siirt
Turkey, Sinop
Turkey, Sirnak
Turkey, Sivas
Turkey,
Tekirdag
Turkey, Tokat
Turkey,
Trabzon
Turkey,
Tunceli
Turkey, Usak
Turkey, Van
Turkey,
Yalova
Turkey,
Yozgat
Turkey,
Zonguldak
Turkmenistan,
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Ahal
Turkmenistan,
Balkan
Turkmenistan,
Dashoguz
Turkmenistan,
Lebap
Turkmenistan,
Mary
Uganda,
Adjumani
Uganda, Apac
Uganda, Arua
Uganda,
Bugiri
Uganda,
Bundibugyo
Uganda,
Bushenyi
Uganda,
Busia
Uganda, Gulu
Uganda,
Hoima
Uganda,
Iganga
Uganda, Jinja
Uganda,
Kabarole
Uganda,
Kaberamaido
Uganda,
Kalangala
Uganda,
Kampala
Uganda,
Kamuli
Uganda,
Kamwenge
Uganda,
Kanungu
Uganda,
Kapchorwa
Uganda,
Kasese
Uganda,
Katakwi
Uganda,
Kayunga
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Uganda,
Kibale
Uganda,
Kiboga
Uganda,
Kisoro
Uganda,
Kitgum
Uganda,
Kotido
Uganda, Kumi
Uganda,
Kyenjojo
Uganda, Lira
Uganda,
Luwero
Uganda,
Masaka
Uganda,
Masindi
Uganda,
Mayuge
Uganda,
Mbale
Uganda,
Mbarara
Uganda,
Moroto
Uganda, Moyo
Uganda, Mpigi
Uganda,
Mubende
Uganda,
Mukono
Uganda,
Nakapiripirit
Uganda,
Nakasongola
Uganda,
Nebbi
Uganda,
Ntungamo
Uganda,
Pader
Uganda,
Pallisa
Uganda,
Rakai
Uganda,
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Rukungiri
Uganda,
Sembabule
Uganda,
Sironko
Uganda,
Soroti
Uganda,
Tororo
Uganda,
Wakiso
Uganda,
Yumbe
Ukraine,
Cherkas'ka
Oblast'
Ukraine,
Chernihivs'ka
Oblast'
Ukraine,
Chernivets'ka
Oblast'
Ukraine,
Dnipropetrovs'
ka Oblast'
Ukraine,
Donets'ka
Oblast'
Ukraine,
Ivano-Frankiv
s'ka Oblast'
Ukraine,
Kharkivs'ka
Oblast'
Ukraine,
Khersons'ka
Oblast'
Ukraine,
Khmel'nyts'ka
Oblast'
Ukraine,
Kirovohrads'k
a Oblast'
Ukraine, Krym
Ukraine, Kyyiv
Ukraine,
Kyyivs'ka
Oblast'
Ukraine,
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L'vivs'ka
Oblast'
Ukraine,
Luhans'ka
Oblast'
Ukraine,
Mykolayivs'ka
Oblast'
Ukraine,
Odes'ka
Oblast'
Ukraine,
Poltavs'ka
Oblast'
Ukraine,
Rivnens'ka
Oblast'
Ukraine,
Sevastopol'
Ukraine,
Sums'ka
Oblast'
Ukraine,
Ternopil's'ka
Oblast'
Ukraine,
Vinnyts'ka
Oblast'
Ukraine,
Volyns'ka
Oblast'
Ukraine,
Zakarpats'ka
Oblast'
Ukraine,
Zaporiz'ka
Oblast'
Ukraine,
Zhytomyrs'ka
Oblast'
United Arab
Emirates, Abu
Dhabi
United Arab
Emirates,
Ajman
United Arab
Emirates,
Dubai
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United Arab
Emirates,
Fujairah
United Arab
Emirates, Ras
Al Khaimah
United Arab
Emirates,
Sharjah
United Arab
Emirates,
Umm Al
Quwain
United
Kingdom,
Aberdeen City
United
Kingdom,
Aberdeenshire
United
Kingdom,
Angus
United
Kingdom,
Antrim
United
Kingdom,
Ards
United
Kingdom,
Argyll and
Bute
United
Kingdom,
Armagh
United
Kingdom,
Ballymena
United
Kingdom,
Ballymoney
United
Kingdom,
Banbridge
United
Kingdom,
Barking and
Dagenham
United
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Kingdom,
Barnet
United
Kingdom,
Barnsley
United
Kingdom,
Bath and
North East
Somerset
United
Kingdom,
Bedfordshire
United
Kingdom,
Belfast
United
Kingdom,
Bexley
United
Kingdom,
Birmingham
United
Kingdom,
Blackburn with
Darwen
United
Kingdom,
Blackpool
United
Kingdom,
Blaenau
Gwent
United
Kingdom,
Bolton
United
Kingdom,
Bournemouth
United
Kingdom,
Bracknell
Forest
United
Kingdom,
Bradford
United
Kingdom,
Brent
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United
Kingdom,
Bridgend
United
Kingdom,
Brighton and
Hove
United
Kingdom,
Bristol
United
Kingdom,
Bromley
United
Kingdom,
Buckinghams
hire
United
Kingdom,
Bury
United
Kingdom,
Caerphilly
United
Kingdom,
Calderdale
United
Kingdom,
Cambridgeshir
e
United
Kingdom,
Camden
United
Kingdom,
Cardiff
United
Kingdom,
Carmarthensh
ire
United
Kingdom,
Carrickfergus
United
Kingdom,
Castlereagh
United
Kingdom,
Ceredigion
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United
Kingdom,
Cheshire
United
Kingdom,
Clackmannan
shire
United
Kingdom,
Coleraine
United
Kingdom,
Conwy
United
Kingdom,
Cookstown
United
Kingdom,
Cornwall
United
Kingdom,
Coventry
United
Kingdom,
Craigavon
United
Kingdom,
Croydon
United
Kingdom,
Cumbria
United
Kingdom,
Darlington
United
Kingdom,
Denbighshire
United
Kingdom,
Derby
United
Kingdom,
Derbyshire
United
Kingdom,
Derry
United
Kingdom,
Devon
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United
Kingdom,
Doncaster
United
Kingdom,
Dorset
United
Kingdom,
Down
United
Kingdom,
Dudley
United
Kingdom,
Dumfries and
Galloway
United
Kingdom,
Dundee City
United
Kingdom,
Dungannon
United
Kingdom,
Durham
United
Kingdom,
Ealing
United
Kingdom, East
Ayrshire
United
Kingdom, East
Dunbartonshir
e
United
Kingdom, East
Lothian
United
Kingdom, East
Renfrewshire
United
Kingdom, East
Riding of
Yorkshire
United
Kingdom, East
Sussex
United
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Kingdom,
Edinburgh
United
Kingdom,
Eilean Siar
United
Kingdom,
Enfield
United
Kingdom,
Essex
United
Kingdom,
Falkirk
United
Kingdom,
Fermanagh
United
Kingdom, Fife
United
Kingdom,
Flintshire
United
Kingdom,
Gateshead
United
Kingdom,
Glasgow City
United
Kingdom,
Gloucestershir
e
United
Kingdom,
Greenwich
United
Kingdom,
Gwynedd
United
Kingdom,
Hackney
United
Kingdom,
Halton
United
Kingdom,
Hammersmith
and Fulham
United
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Kingdom,
Hampshire
United
Kingdom,
Haringey
United
Kingdom,
Harrow
United
Kingdom,
Hartlepool
United
Kingdom,
Havering
United
Kingdom,
Herefordshire
United
Kingdom,
Hertford
United
Kingdom,
Highland
United
Kingdom,
Hillingdon
United
Kingdom,
Hounslow
United
Kingdom,
Inverclyde
United
Kingdom, Isle
of Anglesey
United
Kingdom, Isle
of Wight
United
Kingdom,
Islington
United
Kingdom,
Kensington
and Chelsea
United
Kingdom,
Kent
United
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Kingdom,
Kingston upon
Hull
United
Kingdom,
Kingston upon
Thames
United
Kingdom,
Kirklees
United
Kingdom,
Knowsley
United
Kingdom,
Lambeth
United
Kingdom,
Lancashire
United
Kingdom,
Larne
United
Kingdom,
Leeds
United
Kingdom,
Leicester
United
Kingdom,
Leicestershire
United
Kingdom,
Lewisham
United
Kingdom,
Limavady
United
Kingdom,
Lincolnshire
United
Kingdom,
Lisburn
United
Kingdom,
Liverpool
United
Kingdom,
London
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United
Kingdom,
Luton
United
Kingdom,
Magherafelt
United
Kingdom,
Manchester
United
Kingdom,
Medway
United
Kingdom,
Merthyr Tydfil
United
Kingdom,
Merton
United
Kingdom,
Middlesbroug
h
United
Kingdom,
Midlothian
United
Kingdom,
Milton Keynes
United
Kingdom,
Monmouthshir
e
United
Kingdom,
Moray
United
Kingdom,
Moyle
United
Kingdom,
Neath Port
Talbot
United
Kingdom,
Newcastle
upon Tyne
United
Kingdom,
Newham
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United
Kingdom,
Newport
United
Kingdom,
Newry and
Mourne
United
Kingdom,
Newtownabbe
y
United
Kingdom,
Norfolk
United
Kingdom,
North Ayrshire
United
Kingdom,
North Down
United
Kingdom,
North East
Lincolnshire
United
Kingdom,
North
Lanarkshire
United
Kingdom,
North
Lincolnshire
United
Kingdom,
North
Somerset
United
Kingdom,
North
Tyneside
United
Kingdom,
North
Yorkshire
United
Kingdom,
Northamptons
hire
United
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Kingdom,
Northumberla
nd
United
Kingdom,
Nottingham
United
Kingdom,
Nottinghamshi
re
United
Kingdom,
Oldham
United
Kingdom,
Omagh
United
Kingdom,
Orkney
United
Kingdom,
Oxfordshire
United
Kingdom,
Pembrokeshir
e
United
Kingdom,
Perth and
Kinross
United
Kingdom,
Peterborough
United
Kingdom,
Plymouth
United
Kingdom,
Poole
United
Kingdom,
Portsmouth
United
Kingdom,
Powys
United
Kingdom,
Reading
United
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Kingdom,
Redbridge
United
Kingdom,
Redcar and
Cleveland
United
Kingdom,
Renfrewshire
United
Kingdom,
Rhondda
Cynon Taff
United
Kingdom,
Richmond
upon Thames
United
Kingdom,
Rochdale
United
Kingdom,
Rotherham
United
Kingdom,
Rutland
United
Kingdom,
Salford
United
Kingdom,
Sandwell
United
Kingdom,
Scottish
Borders
United
Kingdom,
Sefton
United
Kingdom,
Sheffield
United
Kingdom,
Shetland
Islands
United
Kingdom,
Shropshire
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United
Kingdom,
Slough
United
Kingdom,
Solihull
United
Kingdom,
Somerset
United
Kingdom,
South
Ayrshire
United
Kingdom,
South
Gloucestershir
e
United
Kingdom,
South
Lanarkshire
United
Kingdom,
South
Tyneside
United
Kingdom,
Southampton
United
Kingdom,
Southend-onSea
United
Kingdom,
Southwark
United
Kingdom, St.
Helens
United
Kingdom,
Staffordshire
United
Kingdom,
Stirling
United
Kingdom,
Stockport
United
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Kingdom,
Stockton-on-T
ees
United
Kingdom,
Stoke-on-Tren
t
United
Kingdom,
Strabane
United
Kingdom,
Suffolk
United
Kingdom,
Sunderland
United
Kingdom,
Surrey
United
Kingdom,
Sutton
United
Kingdom,
Swansea
United
Kingdom,
Swindon
United
Kingdom,
Tameside
United
Kingdom,
Telford and
Wrekin
United
Kingdom,
Thurrock
United
Kingdom,
Torbay
United
Kingdom,
Torfaen
United
Kingdom,
Tower
Hamlets
United
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Kingdom,
Trafford
United
Kingdom, Vale
of Glamorgan
United
Kingdom,
Wakefield
United
Kingdom,
Walsall
United
Kingdom,
Waltham
Forest
United
Kingdom,
Wandsworth
United
Kingdom,
Warrington
United
Kingdom,
Warwickshire
United
Kingdom,
West
Berkshire
United
Kingdom,
West
Dunbartonshir
e
United
Kingdom,
West Lothian
United
Kingdom,
West Sussex
United
Kingdom,
Westminster
United
Kingdom,
Wigan
United
Kingdom,
Wiltshire
United
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Kingdom,
Windsor and
Maidenhead
United
Kingdom,
Wirral
United
Kingdom,
Wokingham
United
Kingdom,
Wolverhampto
n
United
Kingdom,
Worcestershir
e
United
Kingdom,
Wrexham
United
Kingdom,
York
United States,
Alabama
United States,
Alaska
United States,
American
Samoa
United States,
Arizona
United States,
Arkansas
United States,
Armed Forces
Americas
United States,
Armed Forces
Europe
United States,
Armed Forces
Pacific
United States,
California
United States,
Colorado
United States,
Connecticut
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United States,
Delaware
United States,
District of
Columbia
United States,
Federated
States of
Micronesia
United States,
Florida
United States,
Georgia
United States,
Guam
United States,
Hawaii
United States,
Idaho
United States,
Illinois
United States,
Indiana
United States,
Iowa
United States,
Kansas
United States,
Kentucky
United States,
Louisiana
United States,
Maine
United States,
Marshall
Islands
United States,
Maryland
United States,
Massachusett
s
United States,
Michigan
United States,
Minnesota
United States,
Mississippi
United States,
Missouri
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United States,
Montana
United States,
Nebraska
United States,
Nevada
United States,
New
Hampshire
United States,
New Jersey
United States,
New Mexico
United States,
New York
United States,
North Carolina
United States,
North Dakota
United States,
Northern
Mariana
Islands
United States,
Ohio
United States,
Oklahoma
United States,
Oregon
United States,
Palau
United States,
Pennsylvania
United States,
Puerto Rico
United States,
Rhode Island
United States,
South
Carolina
United States,
South Dakota
United States,
Tennessee
United States,
Texas
United States,
Utah
United States,
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Vermont
United States,
Virgin Islands
United States,
Virginia
United States,
Washington
United States,
West Virginia
United States,
Wisconsin
United States,
Wyoming
Uruguay,
Artigas
Uruguay,
Canelones
Uruguay,
Cerro Largo
Uruguay,
Colonia
Uruguay,
Durazno
Uruguay,
Flores
Uruguay,
Florida
Uruguay,
Lavalleja
Uruguay,
Maldonado
Uruguay,
Montevideo
Uruguay,
Paysandu
Uruguay, Rio
Negro
Uruguay,
Rivera
Uruguay,
Rocha
Uruguay,
Salto
Uruguay, San
Jose
Uruguay,
Soriano
Uruguay,
Tacuarembo
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Uruguay,
Treinta y Tres
Uzbekistan,
Andijon
Uzbekistan,
Bukhoro
Uzbekistan,
Farghona
Uzbekistan,
Jizzakh
Uzbekistan,
Khorazm
Uzbekistan,
Namangan
Uzbekistan,
Nawoiy
Uzbekistan,
Qashqadaryo
Uzbekistan,
Qoraqalpoghis
ton
Uzbekistan,
Samarqand
Uzbekistan,
Sirdaryo
Uzbekistan,
Surkhondaryo
Uzbekistan,
Toshkent
Uzbekistan,
Toshkent
Vanuatu,
Ambrym
Vanuatu,
Aoba
Vanuatu,
Efate
Vanuatu, Epi
Vanuatu,
Malakula
Vanuatu,
Malampa
Vanuatu,
Paama
Vanuatu,
Penama
Vanuatu,
Pentecote
Vanuatu,
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Sanma
Vanuatu,
Shefa
Vanuatu,
Shepherd
Vanuatu,
Tafea
Vanuatu,
Torba
Venezuela,
Amazonas
Venezuela,
Anzoategui
Venezuela,
Apure
Venezuela,
Aragua
Venezuela,
Barinas
Venezuela,
Bolivar
Venezuela,
Carabobo
Venezuela,
Cojedes
Venezuela,
Delta
Amacuro
Venezuela,
Dependencias
Federales
Venezuela,
Distrito
Federal
Venezuela,
Falcon
Venezuela,
Guarico
Venezuela,
Lara
Venezuela,
Merida
Venezuela,
Miranda
Venezuela,
Monagas
Venezuela,
Nueva
Esparta
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Venezuela,
Portuguesa
Venezuela,
Sucre
Venezuela,
Tachira
Venezuela,
Trujillo
Venezuela,
Vargas
Venezuela,
Yaracuy
Venezuela,
Zulia
Vietnam, An
Giang
Vietnam, An
Giang
Vietnam, Ba
Ria-Vung Tau
Vietnam, Ben
Tre
Vietnam, Binh
Dinh
Vietnam, Binh
Thuan
Vietnam, Can
Tho
Vietnam, Cao
Bang
Vietnam, Da
Nang
Vietnam, Dac
Lac
Vietnam, Dak
Lak
Vietnam, Dak
Nong
Vietnam, Dien
Bien
Vietnam,
Dong Nai
Vietnam,
Dong Thap
Vietnam,
Dong Thap
Vietnam, Ha
Giang
Vietnam, Ha
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Nam
Vietnam, Ha
Noi
Vietnam, Ha
Tay
Vietnam, Ha
Tinh
Vietnam, Hai
Duong
Vietnam, Hai
Phong
Vietnam, Hau
Giang
Vietnam, Ho
Chi Minh
Vietnam, Ho
Chi Minh
Vietnam, Hoa
Binh
Vietnam,
Hung Yen
Vietnam,
Khanh Hoa
Vietnam, Kien
Giang
Vietnam, Kien
Giang
Vietnam, Kon
Tum
Vietnam, Lai
Chau
Vietnam, Lam
Dong
Vietnam, Lang
Son
Vietnam, Lao
Cai
Vietnam, Long
An
Vietnam, Nam
Dinh
Vietnam, Nam
Ha
Vietnam,
Nghe An
Vietnam, Ninh
Binh
Vietnam, Ninh
Thuan
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Vietnam, Phu
Tho
Vietnam, Phu
Yen
Vietnam,
Quang Binh
Vietnam,
Quang Nam
Vietnam,
Quang Ngai
Vietnam,
Quang Ninh
Vietnam,
Quang Tri
Vietnam,
Quang Tri
Vietnam, Soc
Trang
Vietnam, Son
La
Vietnam,
Song Be
Vietnam, Tay
Ninh
Vietnam, Thai
Binh
Vietnam, Thai
Nguyen
Vietnam,
Thanh Hoa
Vietnam, Thua
Thien
Vietnam, Tien
Giang
Vietnam, Tra
Vinh
Vietnam,
Tuyen Quang
Vietnam, Vinh
Long
Vietnam, Vinh
Phu
Vietnam, Vinh
Puc Province
Yemen,
Abyan
Yemen, Adan
Yemen, Al
Bayda'
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Yemen, Al
Ghaydah
Yemen, Al
Hudaydah
Yemen, Al
Jawf
Yemen, Al
Mahrah
Yemen, Al
Mahwit
Yemen,
Dhamar
Yemen,
Hadramawt
Yemen,
Hajjah
Yemen, Ibb
Yemen, Lahij
Yemen, Ma'rib
Yemen, Sa
Yemen, San
Yemen,
Shabwah
Yemen, Ta
Zambia,
Central
Zambia,
Copperbelt
Zambia,
Eastern
Zambia,
Luapula
Zambia,
Lusaka
Zambia,
North-Western
Zambia,
Northern
Zambia,
Southern
Zambia,
Western
Zimbabwe,
Bulawayo
Zimbabwe,
Harare
Zimbabwe,
Manicaland
Zimbabwe,
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Mashonaland
Central
Zimbabwe,
Mashonaland
East
Zimbabwe,
Mashonaland
West
Zimbabwe,
Masvingo
Zimbabwe,
Matabeleland
North
Zimbabwe,
Matabeleland
South
Zimbabwe,
Midlands

Mobile EUEM
What is Mobile EUEM?
How Does Mobile EUEM Work?
Licensing and Enabling Mobile EUEM
Learn More

What is Mobile EUEM?
Mobile End User Experience Management (Mobile EUEM) allows you to understand your native
iOS or Android mobile application as your end-users actually use it. It provides you with visibility
into the functioning of the application itself and the application's interactions with the network it
uses and any server-side applications it may talk to. You can:
Understand and improve your mobile application's performance
Know when your application is slow because of networking problems. See Network
Requests List.
Determine whether a request is slow because of your servers or because of the
network connection. See Network Request Dashboard.
Trace an individual request from the initial user action in the mobile application
through the associated business transaction(s) on the application server(s). See Netw
ork Request Snapshots.
Estimate the network performance you can expect for different requests, carriers,
devices, and geographies by viewing current metrics. See Monitor Usage Statistics.
Compare your application's performance across application versions. See Monitor
Network Requests by Mobile Application Version.
Reduce crashes
Observe when your application crashes and what caused each crash. See Crash
Snapshots List, Crash Snapshots.
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Learn which environments experience the most crashes. See Crash Dashboard.
Reduce errors
Observe how many network errors occur and which requests caused them. See Netw
ork Requests List, Network Request Dashboard.
Learn about your users
Learn which devices and technologies most of your users are running. See Monitor
Usage Statistics, Crash Dashboard.
View where your users are located in the world. See The Mobile EUEM Geo
Dashboard.
Customize the data that Mobile EUEM returns
Create new metrics and timers. See Customize Your iOS Instrumentation and Custo
mize Your Android Instrumentation.
Collect diagnostic data from your executing code via information points. See Customi
ze Your iOS Instrumentation and Customize Your Android Instrumentation.

How Does Mobile EUEM Work?
To use mobile EUEM you add a small piece of highly performant code, the mobile agent, to the
source of your application. This process is called instrumenting and is described here. As your
end-users interact with your application, the agent collects metrics and any error information on
the application's performance and sends that information to the AppDynamics controller UI, where
it is displayed in a series of dashboards and charts. If your application crashes, the agent also
creates a crash snapshot with information to help you analyze what happened, including the
crashed function, the source file containing the crashed function, the line number, if available, and
a stack trace of the application at the time of the crash, along with various other identifying data.
And if the server-side application with which your mobile app interacts is also instrumented, you
can get correlated metric information for the entire round-trip request life-cycle.
Data collected by the agent is sent to the Cloud for processing when the agent detects that the
application it is monitoring is already using the network, minimizing the time that the device's radio
is in a high power state. The data is sent in a beacon, a bundled set that is around 200-400 bytes.
If for any reason the Cloud is not available, the agent buffers data locally.
If the Cloud is unavailable for extended periods of time, the agent may delete older data to
prevent unbounded growth in the buffer.

Licensing and Enabling Mobile EUEM
Mobile EUEM requires a separate license from that for your application server and for Web End
User Experience Monitoring, and must be enabled before it is available for use. Until it is enabled it
does not appear in the left navigation bar of the AppDynamics GUI.
For information about licensing, see Mobile EUEM Licenses.
For information on enabling or disabling Mobile EUEM monitoring, see Enable Mobile EUEM on
Your Controller.

Learn More
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Set Up and Configure Mobile EUEM

Monitor Your Applications with Mobile EUEM
Accessing Mobile EUEM
The Mobile EUEM Geo Dashboard
The Network Requests List
The Network Requests Snapshots List
Crashes
Mobile Usage Statistics
Mobile EUEM presents your application information in five ways:
As a map-based dashboard, for overview monitoring
As a detailed list of network requests
As snapshots of problem individual network requests with customizable break-outs of
information
As information on application crashes and detailed snapshots of individual crashes with
stack traces
As overview usage statistics by device, carrier, operating system version, connection type,
and application version, for spotting trends
Accessing Mobile EUEM

You access the mobile EUEM screens from the End User Experience tree in the left navigation
pane.

The Mobile EUEM Geo Dashboard

The Mobile EUEM Geo Dashboard view provides high level insight into how your application is
performing by location across the world. The size of a dot indicates the number of network
requests from that region, and the color indicates the average time per network request in that
region (red is slow). You can click to drill down to areas of specific interest. You can also see the
same information presented in tabular form by clicking the grid icon in the upper left of the panel.
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For more information, see The Mobile EUEM Geo Dashboard.
The Network Requests List

A network request is an HTTP request from an end user's instance of your application to a
server-side application that is designed to accomplish a particular task. Use this list to see how
each request type is behaving in general. You can also use this list to click through to a dashboard
with detailed visualizations of that request's overall performance.
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For more information, see Network Requests Lists.
The Network Requests Snapshots List

When an individual network request experiences slow response times or has a network or HTTP
error associated with it, a detailed snapshot is taken. Use this list to scan problem requests, and,
using filters, begin to see where your issues may lie. You can also use this list to click through to
the details of the snapshot, including, if your application server is instrumented, timings for
business transactions on the server side that were involved in the request and links to any related
transaction snapshots that may exist.

For more information, see Network Request Snapshots List.
Crashes

The Crash Dashboard tab aggregates mobile application crash data over time, using the Analyze
event store. This store contains all the data collected by the mobile agent. The dashboard shows
crash trends, sets of unique crash types, and distribution over usage types.
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There is also a list of individual crash snapshots.

From the list you can click through to detailed information on an individual crash, including a stack
trace.
For more information, see Monitor Crashes.
Mobile Usage Statistics

Graphic representations of overall usage statistics by device, carrier, OS version, connection type,
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and version are found under this tab.

For more information, see Monitor Usage Statistics.
The Mobile EUEM Geo Dashboard
Mobile Geo Dashboard Window
Using Map View
Map Actions
Configuring Map View Options
To Configure the Map
Unknown Locations in Map and Grid Views
Learn More
Understand performance by location using the mobile EUEM geo dashboard tab.
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Mobile Geo Dashboard Window

The window is divided into three panels:
A main panel in the upper left that displays geographic distribution of mobile users on a
map, if you clicked the map view icon, or on a grid if you clicked the grid view icon.
Switch between map view and grid view by clicking these icons.
Expand the map panel or the grid panel to fill the entire dashboard by toggling the
expand icon in the upper right corner of the panel.
A panel on the right displaying:
A dropdown menu
Countries with highest network request times (slowest performance).
Countries with the highest number of network requests (highest load).
Trend graphs in the lower part of the dashboard that dynamically display the number and
rate of network requests (load), network request time, and number and rate of HTTP errors
and network errors. You can click the rates to see them displayed in the Metric Browser.
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You can hover over a point in time in a trend graph to get the precise values at that moment
for that individual metric.

The metrics displayed throughout the geo dashboard are for the country currently selected on the
map or in the grid. For example, if you zoom down from world view to France in the map, the panel
on the right disappears and the trend graphs display data for France.
See Mobile EUEM Metrics for definitions of the metrics.
Using Map View

The main panel in map view displays a map superimposed with circles that represent average
user experience by country.
The size of a circle indicates the relative amount of traffic in a country: the larger the circle the
higher the load. The color of a circle represents the relative request time experienced by users in a
country: green for a fast request time, yellow for a medium request time, red for a slow request
time. Large red circles represent regions of most concern. See Configuring Map View Options for
information on how to adjust circle color and size ranges.
Map Actions

You can perform the following actions directly in the map:
Click any country on the map to drill down into metrics for that country. The country is
colored blue to indicate that it is drilled down. To return to the world view from the country
view, click World in the left corner of the map.
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View summary statistics for a region by hovering over its circle.

Zoom the entire map using the slider on the left. You can also use your mouse wheel to
increase or decrease the map's zoom level.
Reposition the map by clicking and dragging it or by clicking the directional arrows in the
map control widget.
Configuring Map View Options

You can configure the dashboard display in a variety of ways:
The ranges for values that trigger the performance indicator colors on the map
The circle sizes that indicate relative load on the map
Whether to show:
Map Controls
The US States in the global view
The Dark view of the map
All of these configurations are saved for the next time you log into AppDynamics.
To Configure the Map

1. Click the gear icon in the upper right corner of the map or grid panel to get the configuration
window.
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1.

2. Adjust the color thresholds by using one of the following two methods:
Adjust the Network Response Time slider. For example, if you want circles to be red
whenever the network request time is 2000 milliseconds or greater, slide the
maximum value of the yellow slider value to 2000.
or
Double-click the text field that indicates the slider threshold value to make it editable,
enter the value of the threshold in the text field, and press the tab key. You can enter
as large a value as you like in the field (larger than the current maximum displayed
value of the slider) and the displayed range of values for the circle color ranges will
adjust accordingly.
3. Configure circle size representing load (the total number of network requests) by using the
max load circle size slider.
4. Enable map controls for zoom and position by checking Map Controls.
5. Change the map background to dark by checking View Dark Map.
Unknown Locations in Map and Grid Views

If the Mobile EUEM geo-server is not able to determine the source of a request, it is reported as
an unknown location.
This may show up in the map view as a source for highest reqest times and highest loads. It can
also show up in the grid view.
Metrics may also be reported for a location named Anonymous Proxy. This is for metrics
collected for one or more private IP addresses that access the Internet through a proxy.
Learn More

Mobile EUEM Metrics
Monitor Network Requests
Monitor Crashes
Monitor Network Requests

A network request is an HTTP request from your mobile app to a server-side application.
The iOS agent detects network requests when the underlying implementation is handled by the
NSURLConnection class.
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The Android agent detects network requests when the underlying implementation is handled by
the HttpURLConnection, HttpsURLConnection, or HttpClient classes.
You can monitor the aggregate performance of network requests to all your instrumented iOS
applications or all your instrumented Android applications. Or you can monitor the performance of
a single application.
There are different ways of viewing network request data:
The geographic view reports aggregated mobile data by geographic location. Monitor the
geographic view to learn which countries have the highest number of requests, the longest
request times, and the most errors.
The network requests list displays current network requests to your applications. You can
sort the list according to key metrics such as the slowest response time, highest error rate,
highest load, etc. You can view a network request dashboard that summarizes aggregate
performance for a specific network request.
A network request snapshot reports information on an individual instance of a network
request. Snapshots are useful for examining the details of the worst-performing requests.
Access these snapshots from the network request snapshots list.
Usage stats display key network request metrics by various criteria: device, carrier,
operating system version, connection type and application. For example, you can see which
carriers are the slowest or which devices are producing the most errors.
The controller processes a maximum of 500 network requests per account. See Network
Request Limits for suggestions on how to configure network request detection to stay under this
limit.
Network Requests List

How the Network Requests List is Organized
To configure the displayed columns
To filter network requests that are displayed as rows
To view summary details for a network request
More Actions Menu
Learn More
The network requests list shows all the network requests types from your instrumented mobile
applications, along with their key performance indicators.
You access the network requests list from the Network Requests tab.
How the Network Requests List is Organized

The network requests list is a table that displays aggregated metrics for current requests, with one
row for each request type. The columns display the name of the network request, the application
that generated it, and aggregated metrics associated with it. See Mobile EUEM Metrics for
descriptions of these metrics.
Click a column header to sort the the list based on the column's metric. For example, if you want to
sort by the slowest requests, click the Network Request Time (ms) column header. You can toggle
the column to switch between ascending and descending order.
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To configure the displayed columns

1. Click View Options.
2. Clear the check boxes for the columns that you do not want to see in the table.

To filter network requests that are displayed as rows

To see only network requests that currently have load, check the FILTER With Load check box.
To see only network requests with specific names, enter a substring of the network request name
in the Filter field.
In the following example, the user is interested in requests that have load and have "checkout" in
the request name.

To view summary details for a network request

1. Select the network request in the list.
2. Either click View Dashboard or just double-click.
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More Actions Menu

Use the More Actions menu to select one or more requests in the list and perform the following
actions on them.
Exclude Request(s) Use this option to direct AppDynamics to ignore the selected
request(s) and stop reporting metrics for them.
You can use the View Excluded Requests option to see requests that have been excluded
and then you can "unexclude" them.
Rename Request Use this option to rename one selected request in the AppDynamics
console.
Delete Request(s) Use this option to remove the request(s) from the list. If AppDynamics
discovers a deleted request again it will reappear in the list. To prevent it from re-appearing
use Exclude Request(s).
Learn More

Network Request Dashboard
Network Request Limits
Mobile EUEM Metrics

Network Request Dashboard

Accessing a Network Request Dashboard
To view a request dashboard
How the Network Request Dashboard is Organized
Learn More
Each network request type has its own dashboard that graphically displays key performance
indicators for that type over the selected time range. To select the time range, use the general time
range dropdown at the top right of the UI.
Accessing a Network Request Dashboard

To view a request dashboard
1. Click the Network Requests tab.
2. From the network requests list, select the request type you are interested in.
3. Either double-click the request or click View Dashboard.
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How the Network Request Dashboard is Organized

The network request dashboard displays summary key network request metrics for the time
selected. To see any particular metric in the metric browser, click the metric value (in link blue).
The trend graphs for the key performance indicators are:
Network Request Time: Percentile and average times in milliseconds.
Total Server Time: Displayed only If the mobile request is correlated with a server-side
application.
The total server time is the interval between the time that the server-side application
receives the network request to the time that it finishes processing the request.
Use this graph to determine, on average, how much time is spent on the network versus
how much time is spent on the server to process the user's request.
Load: Total Requests and Requests per Minute
Errors: Network Errors and HTTP Errors in total and per minute
Related Business Transactions: If the request is correlated with a server-side application,
the dashboard lists business transactions associated with the request below the
performance metrics.
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You can click the link to a related business transaction to see its business transaction
dashboard. See Business Transaction Dashboard.
If transaction snapshots were taken at the same time as the network request, the dashboard
lists the transaction snapshots below the business transactions. See Transaction Snapshots
.
You can hover over any data point on any of the trend graphs to see the metric for a
precise point.

Learn More

Monitor Network Requests
Network Requests List
Mobile EUEM Metrics
Monitor Business Transactions
Transaction Snapshots
Network Request Snapshots List

How the Network Request Snapshots List is Organized
To configure the columns displayed
To filter the network request snapshots that are displayed as rows
To view a network request snapshot
Learn More
A network request snapshot captures the details of a single instance of a network request.
Examine these details to troubleshoot the causes of slow network request performance.
You access the list using the Network Request Snapshots tab.
How the Network Request Snapshots List is Organized

The network request snapshots list is a table that displays a row for each network request
snapshot. The columns describe properties of each snapshot.
Click a column header to sort the the list based on the column's value. For example, if you want to
sort alphabetically by country, click the Country column header. You can toggle the column to
switch between ascending and descending order.
The Experience column displays an icon that indicates whether the user experience was normal,
slow, very slow or stalled. These values are based on the configured network request thresholds.
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See Configure Mobile Network Request Thresholds.
The Error column displays a red error icon if a network error or an HTTP error occurred.
The Call Graph column is populated only if there is an instrumented server-side application for this
request. This column displays a call graph icon if there is a transaction snapshot with a call graph
on the server side. The call graph lets you drill down to find the causes of poor performance on the
server side. See Transaction Snapshots and Call Graphs.

To configure the columns displayed

1. Click View Options.
2. Clear the check boxes for the options that you do not want to see in the table.
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To filter the network request snapshots that are displayed as rows

1. Click Filters if filters are not showing.
2. Use the dropdown lists to specify the criteria for displaying a row. For example, you can
specify a specific application, a specific network request, user experience, specific carriers,
etc.

To view a network request snapshot

1. Select the network request snapshot in the list.
2. Either click View Network Request Snapshot or just double-click.
Learn More

Network Request Snapshots
Network Request Snapshots

When Network Request Snapshots are Captured
Network Request Snapshot Content
Business Transactions in Network Request Snapshots
Accessing Network Request Snapshots from Transaction Snapshots
Archiving Network Request Snapshots
Learn More
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Network request snapshots capture detailed information about individual network request
instances of your application. They can help you troubleshoot the causes of poorly performing
mobile applications.
When Network Request Snapshots are Captured

Mobile EUEM starts capturing snapshots when user experience becomes slow, based on how you
have configured the thresholds for slow, very slow and stalled. See Configure Mobile Network
Request Thresholds.
Periodic snapshots for normal user experience are also captured at least once per minute.
Network Request Snapshot Content

A network request snapshot contains summary data about the individual request as well as any
business transactions associated with the request if correlation with an instrumented server side
application is available.
The snapshot contains extensive metrics for the request in the Summary Data, including:
User Experience: Normal, Slow, Very Slow, or Stalled.
Time: when the request was received by the EUM Processor collector, in UNIX epoch time.
Mobile Network Request: a link to the network request dashboard for the network request of
which this snapshot is an instance. See Network Request Dashboard.

Business Transactions in Network Request Snapshots

When a network request snapshot is associated with one or more business transactions on an
instrumented server-side application, the business transactions are listed in the Business
Transactions panel in the network request snapshot. You can click the link to see the business
transaction dashboard for the associated business transaction.
If transaction snapshots for an associated business transaction were captured at the same time as
the network request snapshot, they are linked in the Transaction Snapshots panel of the network
request snapshot. If a call graph icon is displayed for a snapshot in the transaction snapshot list, a
full or partial call graph is available for that transaction snapshot. This allows you to examine the
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cause of performance problems on the server side. Click the link to see the associated transaction
snapshot.
Transaction snapshots are triggered on the server when slow or stalled business transactions are
identified, when a diagnostic session is started, or periodically based on a configured interval. In
general, slow, very slow and stalled transactions are more likely to trigger a transaction snapshot
on the server than transactions operating within normal range. For more information about when
server-side transaction snapshots are captured see Transaction Snapshots and Configure
Transaction Snapshots.
Accessing Network Request Snapshots from Transaction Snapshots

If a transaction snapshot seen from the server side has a correlated network request snapshot, a
Mobile Snapshot link appears in the top right of the transaction snapshot flow map. Click the link to
open the network request snapshot.

Archiving Network Request Snapshots

Normally network request snapshots are purged after two weeks. You can archive a snapshot
beyond the normal snapshot lifespan to retain it for future analysis.
To archive a snapshot, click the Archive button in the upper right corner of the snapshot window.
You can view archived snapshots by checking Archived as a view option in the network request
snapshots list.
Customers with on-premise controllers can modify the default two-week period by configuring the
event.retention.period in the Controller Settings section of the Administration console.
Learn More

Network Request Snapshots List
Transaction Snapshots
Monitor Crashes

Use Crashes to give trend and detailed information on mobile application crashes.
A crash snapshot is a detailed report on a particular crash including the code that was executing
when the application crashed. Crash snapshots help you understand the causes of crashes.

Crash Dashboard

Crash Trends
Unique Crashes
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Unique Crash Details
Crash Distribution
The crash dashboard aggregates mobile application crash data over time, using the Analyze event
store. This store contains all the data collected by the mobile agent. You access this view via the
Crash Dashboard tab. The Dashboard is divided into three panels.
Crash Trends

The Crash Trends panel includes a header with a running total of crashes, unique crashes, and
users impacted, and a bar chart showing crashes over time.

Hover over a particular item to see details.
Unique Crashes

Multiple crashes can be caused by the same underlying code issue. The Unique Crashes panel
displays a list of crashes grouped by common characteristics and displays basic information about
the crash group.

Unique Crash Details

To see more detail per crash group, click the the crash that interests you, in blue. The dashboard
for that crash appears, with a header, trend bar graph, crash distribution charts, and a snapshot of
the crucial details common to all the crashes in the group.
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Crash Distribution

The Crash Distribution panel displays multiple metrics on the environment in which the crash
occurred - device, OS version, carrier, and connection type.

Hover over a chart segment for more detail.
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Crash Snapshots List

How the Crash Snapshots List is Organized
To configure the displayed columns
To filter the crashes that are displayed as rows
To view a crash snapshot
To archive a crash snapshot
Learn More
When an instrumented application crashes, a crash snapshot is created. The snapshot provides
information to help you analyze the cause of the crash, including:
crashed function
source file containing the crashed function
line number in the source file, if available
stack trace of the application at the time of the crash
For iOS applications, crash snapshots are based on:
fatal signals (SIGSEGV, etc)
unhandled Objective-C exceptions
For Android applications, crash snapshots are based on:
UI thread hangs (cases where the "Application not responding" error message appears)
unhandled Java exceptions
To see the list of crash snapshots for the selected time range, click Crash Snapshots.
How the Crash Snapshots List is Organized

The crash snapshots list is a table that displays the current crash snapshots, with one row for each
snapshot. The columns represent the crash snapshot properties. See Crash Snapshot Properties f
or descriptions of these properties.
Click a column header to sort the list based on the column's metric. For example, if you want to
sort alphabetically by connection type, click the Connection Type column header. You can toggle
the column to switch between ascending and descending order.
To configure the displayed columns

1. Click View Options.
2. Clear the check boxes for the options that you do not want to see in the table.
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To filter the crashes that are displayed as rows

1. Click Filters
if filters are not showing
2. Use the dropdown lists to specify the criteria for displaying a row. For example, you can
specify a specific application, or specific carriers or specific exceptions.

To view a crash snapshot

1.
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1. Select the crash snapshot in the list.
2. Either click View Crash Details or just double-click.
To archive a crash snapshot

1. Select the crash snapshot in the list.
2. Click Archive.
For more information see Archiving Crash Snapshots.
Learn More

Crash Dashboard
Crash Snapshots
Crash Snapshot Properties
Get Human-Readable Crash Snapshots
Instrument an iOS Application
Instrument an Android Application

Crash Snapshots

Content of Crash Snapshots
Archiving Crash Snapshots
Learn More
Crash snapshots provide detailed information on a single application crash.
Content of Crash Snapshots

The left side of the snapshot displays the key properties of the snapshot, such as the application
that crashed, the time of the crash, the exception thrown when the application crashed, the
function running when the application crashed, the file containing the crashed function, the line
number on which the application crashed. Sometimes not all of this information is available.
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The right side of the snapshot displays the call stack of the crashed application, showing the
thread in which the crash occurred. This is the full stack trace for this specific crash, not the
aggregated stack trace shown in the crash group dashboard.
If the information in the stack trace is cryptic, it is possible that source code for your iOS app was
not symbolicated or the source code for your Android app was obfuscated. See Get
Human-Readable Crash Snapshots for information about why this happens and what you can do
about it.
Click Download to grab the stack trace in a file that you can forward to developers.
Archiving Crash Snapshots

Normally crash snapshots are purged after two weeks. You can archive a snapshot beyond the
normal snapshot lifespan to retain it for future analysis.
To archive a snapshot, click the Archive button in the upper right corner of the snapshot window.
You can also archive crash snapshots from the crash snapshots list.
You can view archived snapshots by checking Archived as a view option in the crash snapshots
list.
Customers with on-premise controllers can modify the default two-week period by configuring the
events.retention.period in the Controller Settings section of the Administration console.
Learn More
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Crash Snapshots List
Crash Snapshot Properties
Get Human-Readable Crash Snapshots

Crash Snapshot Properties

These is the list of crash snapshot properties. They appear in the crash snapshot list and the crash
snapshots themselves.
Mobile App Name: the name of the app that crashed
Mobile App Version: the version string of the crashed application
App Crash Time: timestamp when the crash occurred, based on the mobile device's clock
Device/Manufacturer: model or manufacturer name of the mobile device on which the
crash occurred
OS Version: operating system version of the mobile device on which the crash occurred
Country: the originating country
Carrier: name of the mobile carrier
Connection Type: active connection type at the time of the crash, if known.
Crash id: unique identifier for the crash
Exception Name/Codes: name of the fatal signal (iOS) or uncaught exception (Android)
associated with the crash
Crashed Function: name of the topmost function on the crashed thread's callstack. If this
function is an Objective-C method, this name includes the class name. For Android, this
name is the fully qualified name of the topmost method on the uncaught exception's stack
trace.
Crashed File/Line: name of the source file containing the crashed function, with the line
number, if available
Symbolicated: For iOS. True if this crash report has been matched with a dSym file and
symbolicated; false otherwise.
The application must have been compiled with the Debugging Information Format set to
"DWARF with dSYM File" for a crash report to exist. See Uploading the dSYM File and Get
Human-Readable Crash Snapshots. List only.
Deobfuscated: For Android: True if this crash report has been matched with a ProGuard
mapping file and deobfuscated; false otherwise.
See Uploading the ProGuard Mapping File and Get Human-Readable Crash Snapshots. A
false value for this property does necessarily indicate that the crash report will not be
human-readable since it is possible that the application in question was not obfuscated. List
only.
Archived: whether this snapshot has been archived
Request Timestamp: when the request was initiated. Snapshot only.
Connection Type: active connection type at the time of the crash, if known. Snapshot only.
Get Human-Readable Crash Snapshots

iOS dSYM File
ProGuard Mapping File for Android
Learn More
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The information in most raw crash stack traces is not fully human readable. To make your crash
stack traces more easily understood, you need to provide a platform-specific mapping file that can
translate the raw data into human readable output. Normally you upload the file at the time that
you instrument your mobile application.
For iOS see Uploading the dSYM File. For Android see Uploading the ProGuard Mapping File.
This topic explains the advantages of providing these files.
iOS dSYM File

For iOS applications, the raw data in the stack traces in crash snapshots consists of memory
addresses of stack frames that point to executable application code. It also includes symbols and
memory offsets for the system library code used by the application. Such a partially symbolicated
stack trace looks something like this:

AppDynamics attempts to display stack traces with the names of functions with offsets into those
functions to help you identify the line of code that was executing when the application crashed. To
get the symbols that map to the executable code, it needs the dSYM (desymbolication) file for the
crashed application.
If the dSYM file for the crashed application has been uploaded, the symbolicated stack trace
shows the function name and the offset into the function where the app crashed. It looks
something like this:

The dSYM file is created when the application source code is compiled with the Debugging
Information Format set to "DWARF with dSYM file". AppDynamics recommends that you build all
the iOS apps that you want to monitor using this option and then upload the dSYM file to
AppDynamics. The best time to do this is when you instrument the app.
If a dSYM has been uploaded for a crashed application, in the crash list the Symbolicated column
for the associated crash snapshot is true.
If the symbolicated property is false and you want to see user-friendly stack traces in your crash
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snapshots for this application, you need to locate and upload the dSYM file for the crashed
application.
ProGuard Mapping File for Android

If an Android app was not obfuscated to prevent reverse engineering, you should see
human-readable stack traces in your crash snapshots by default.
However, if the code was obfuscated, AppDynamics needs the ProGuard mapping file to be able
to deobfuscate the app. The best procedure is to upload this file at the time you build the app.
If a ProGuard mapping file has been uploaded for a crashed application, in the crash list the
Deobfuscated column for the crash snapshot is true.
If the deobfuscated property is false and the stack traces you see in the crash snapshots are
obfuscated, you need to locate and upload the mapping file for the application.
Learn More

Crash Snapshots List
Crash Snapshots
Uploading the dSYM File
Uploading the ProGuard Mapping File
Monitor Custom Data
Access the Custom Data tab
Custom Data Types
Info Points
Custom Timers
Custom Metrics
View Custom Data
Out of the box Mobile EUEM provides substantial information on crashes and network and server
related performance. But you may want to customize the mobile agent to collect other metrics and
data of use to you in understanding how your application is performing for your users.
For information on customizing the agent, including sample code, see
Customize Your iOS Instrumentation
Customize Your Android Instrumentation.
To see the results of your data collection, you use the Custom Data tab.
Access the Custom Data tab

1. In the left navigation bar, select the app whose metrics you are interested in.
2. Click the Custom Data tab.
Custom Data Types

There are three kinds of custom data that you can collect:
Info Points
Custom Timers
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Custom Metrics
Info Points

Information points allow you to collect information on how specific methods in your code are
performing. For example, how many times was a particular method executed? How long did it
take, on average, to execute?
Custom Timers

Custom timers allow you to time how long something takes between any arbitrary start point and
end point, even if they span multiple methods. For example, how long did it take to repaint a
frame buffer? How long did the app take to start up?
Custom Metrics

Custom metrics allow you to collect data on any metric you define in your application. Metrics can
be any integer-based data. Over the specified time frame, Mobile EUEM calculates the minimum,
maximum, average, sum, and count of these values.
View Custom Data

Your data is shown in tabular format. Click on any value (in blue) to display the same metric in the
Metric Browser.

You can sort the data by clicking the appropriate column header. You can sort in ascending or
descending order. Use the With Load checkbox to see only items under load.
To change the columns that are displayed, click View Options and make your selection.
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Monitor Usage Statistics

You can get summary statistics about your users from the usage stats tab of the mobile EUEM
dashboard.
Click the appropriate subtab to monitor statistics by the criteria that interest you.
For example, this window displays the distribution of how your users' iOS devices connect to the
Internet.

This window displays the distribution of the versions of Android your application is running on.
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For details of the individual screens see:
Monitor Network Requests by Device or Manufacturer

Accessing Mobile Data by Device
How the Devices Window is Organized
Overall Device Distribution
Performance by Device/Manufacturer
Export as a Report
Learn More
You can monitor mobile applications by the devices that your users use to access your application.
For iOS applications the device is the model of the device. For Android applications the device is
the manufacturer of the device.
The device/manufacturer window helps you discover:
the slowest devices in terms of total network request time
the devices that are generating the most requests
the devices that are experiencing the most errors
Accessing Mobile Data by Device

For iOS, click the Devices subtab of the Usage Stats tab.
For Android, click the Manufacturers subtab.
How the Devices Window is Organized

The window is divided into two panels:
Overall Distribution
Performance by Device
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Overall Device Distribution

The Overall Distribution chart shows the percentages of your end users using different devices.
Performance by Device/Manufacturer

The Performance by Device/Manufacturer list below the chart displays a row for each device.
Click a column to sort the list based on the column's metric. For example, if you want to sort by
Network Request Time with the slowest devices at the top of the list, click the Network Request
Time column. You can toggle the column header to switch between ascending and descending
order.
To filter the list to see only rows for a particular device, enter the device in the filter field.
Export as a Report

To export the data as a report in PDF format:
1. Click the Export as PDF report button in the upper right corner.
2. In the Export Complete field optionally edit the name of the report.
3. Click Save Report
4. Select the location to which to save the report.
5. Click Save.
Learn More

Mobile EUEM Metrics
Monitor Network Requests by Carrier

Accessing Mobile Metrics by Carrier
How the End User Carriers Window is Organized
Overall Distribution
Performance by Carrier
Export as a Report
Learn More
You can monitor mobile applications by the mobile carriers that your users use to access your
application.
The carrier dashboard helps you discover:
The slowest carriers in terms of total network request time.
The carriers that are generating the most requests.
The carriers that are experiencing the most errors.
Accessing Mobile Metrics by Carrier

Click the Carriers subtab of the Usage Stats tab.
How the End User Carriers Window is Organized

The window is divided into two panels:
Overall Distribution
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Performance by Carrier
Overall Distribution

The Overall Distribution chart shows the percentages of your end users using different carriers.
Performance by Carrier

The Performance by Carrier list below the chart displays a row for each carrier.
Click a column to sort the carriers based on the column's metric. For example, if you want to sort
by Network Request Time with the slowest carriers at the top of the list, click the Network Request
Time column. You can toggle the column header to switch between ascending and descending
order.
To filter the list to see only rows for a particular carrier, enter the carrier in the filter field.
Export as a Report

To export the data as a report in PDF format:
1. Click the Export as PDF report button in the upper right corner.
2. In the Export Complete field optionally edit the name of the report.
3. Click Save Report
4. Select the location to which to save the report.
5. Click Save.
Learn More

Mobile EUEM Metrics
Monitor Network Requests by Operating System Version

Accessing Mobile Metrics by Operating System Versions
How the End User OS Versions Window is Organized
Overall Operating System Version Distribution
Performance by Operating System Version
Export as a Report
Learn More
You can monitor mobile applications by the operating system running on the mobile device that
your users use to access your application.
The operating system version dashboard helps you discover:
the slowest operating system versions in terms of total network request time
the operating system versions that are generating the most requests
the operating system versions that are experiencing the most errors
Accessing Mobile Metrics by Operating System Versions

Click the OS Versions subtab of the Usage Stats tab.
How the End User OS Versions Window is Organized

The window is divided into two panels:
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Overall Distribution
Performance by Operating System Version
Overall Operating System Version Distribution

The Overall Distribution chart shows the percentages of your end users using different operating
system versions.
Performance by Operating System Version

The Performance by OS Version list below the chart displays a row for each operating system
version.
Click a column to sort the operating system version based on the column's metric. For example, if
you want to sort by Network Request Time with the slowest operating system version at the top of
the list, click the Network Request Time column. You can toggle the column header to switch
between ascending and descending order.
To filter the list to see only rows for a particular operating system version, enter the operating
system version in the filter field.
Export as a Report

To export the data as a report in PDF format:
1. Click the Export as PDF report button in the upper right corner.
2. In the Export Complete field optionally edit the name of the report.
3. Click Save Report
4. Select the location to which to save the report.
5. Click Save.
Learn More

Mobile EUEM Metrics
Monitor Network Requests by Connection Type

Accessing Mobile Metrics by Connection Types
How the End User Connection Types Window is Organized
Overall Connection Type Distribution
Performance by Connection Types
Export as a Report
Learn More
You can monitor mobile applications by the type of connection that your users use to access your
application.
The connection types dashboard helps you discover:
the slowest connection types in terms of total network request time
the connection types that are generating the most requests
the connection types that are experiencing the most errors
Accessing Mobile Metrics by Connection Types

Click the Connection Types subtab of the Usage Stats tab.
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How the End User Connection Types Window is Organized

The window is divided into two panels:
Overall Distribution
Performance by Connection Type
Overall Connection Type Distribution

The Overall Distribution chart shows the percentages of your end users using different connection
types.
Performance by Connection Types

The Performance by Connection Types list below the chart displays a row for each connection
type. The Unknown connection type is the aggregate of all the network requests for which the
agent wss unable to determine the connection type.
Click a column to sort the connection types based on the column's metric. For example, if you
want to sort by Network Request Time with the slowest connection types at the top of the list, click
the Network Request Time column. You can toggle the column header to switch between
ascending and descending order.
To filter the list to see only rows for a particular connection type, enter the connection type in the
filter field.
Export as a Report

To export the data as a report in PDF format:
1. Click the Export as PDF report button in the upper right corner.
2. In the Export Complete field optionally edit the name of the report.
3. Click Save Report
4. Select the location to which to save the report.
5. Click Save.
Learn More

Mobile EUEM Metrics
Monitor Network Requests by Mobile Application

Accessing Mobile Data by Mobile App
How the Mobile Apps Window is Organized
Overall Mobile Apps Distribution
Performance by Mobile Application
Export as a Report
Learn More
When you access the mobile EUEM dashboard at the platform level, you can compare the key
mobile metrics of different mobile applications of the selected platform.
The mobile applications window helps you discover:
the slowest applications in terms of total network request time
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the applications that are generating the most requests
the applications that are experiencing the most errors
To compare metrics from different versions of a single mobile application, see Monitor Network
Requests by Mobile Application Version.
Accessing Mobile Data by Mobile App

Click the Mobile Apps subtab of the Usage Stats tab.
This tab is available only when you access the dashboard from the platform level.
How the Mobile Apps Window is Organized

The window is divided into two panels:
Overall Distribution
Performance by Mobile Application
Overall Mobile Apps Distribution

The Overall Distribution chart shows the percentages of your end users using different
applications.
Performance by Mobile Application

The Performance by Mobile Application list below the chart displays a row of metrics for each
application.
Click a column to sort the list based on the column's metric. For example, if you want to sort by
Network Request Time with the slowest application at the top of the list, click the Network Request
Time column. You can toggle the column header to switch between ascending and descending
order.
To filter the list to see only rows for a particular application, enter the application string in the filter
field.
Export as a Report

To export the data as a report in PDF format:
1. Click the Export as PDF report button in the upper right corner.
2. In the Export Complete field optionally edit the name of the report.
3. Click Save Report
4. Select the location to which to save the report.
5. Click Save.
Learn More

Mobile EUEM Metrics
Monitor Network Requests by Mobile Application Version

Accessing Mobile Data by Mobile Application Version
How the Versions Window is Organized
Overall Distribution
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Performance by Version
Export as a Report
Learn More
When you access the mobile EUEM dashboard at the application level, you can compare the key
mobile metrics of different versions of the application.
The versions window helps you discover:
the slowest versions in terms of total network request time
the versions that are generating the most requests
the versions that are experiencing the most errors
Accessing Mobile Data by Mobile Application Version

Click the Versions subtab of the Usage Stats tab.
This tab is available only when you access the dashboard from an individual application.
How the Versions Window is Organized

The window is divided into two panels:
Overall Distribution
Performance by Version
Overall Distribution

The Overall Distribution chart shows the percentages of your end users using different versions of
the application.
Performance by Version

The Performance by Version list below the chart displays a row of metrics for each version.
Click a column to sort the list based on the column's metric. For example, if you want to sort the
list in terms of Network Request Time with the slowest version at the top of the list, click the
Network Request Time column. You can toggle the column header to switch between ascending
and descending order.
To filter the list to see only rows for a particular version enter the version substring in the filter
field. For example, is you want to see metrics only for versions 2.x enter "2".
Export as a Report

To export the data as a report in PDF format:
1. Click the Export as PDF report button in the upper right corner.
2. In the Export Complete field optionally edit the name of the report.
3. Click Save Report
4. Select the location to which to save the report.
5. Click Save.
Learn More

Mobile EUEM Metrics
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Set Up and Configure Mobile EUEM
You set up and configure Mobile EUEM in two areas:
Your AppDynamics Controller
Your iOS and/or Android application
To prepare Mobile EUEM you need to make changes in both these areas in a particular order.
You need to do the following:
1.
2.
3.
4.
5.
6.

Check your prerequisites
Review Controller capacity
Evaluate your mobile application
Enable Mobile EUEM on your Controller
Instrument and verify your app
Configure network request naming and thresholds

Check Your Prerequisites

Before you can use AppDynamics to monitor your mobile application you need to make sure you
have the following prerequisites:
An AppDynamics account, with access to an AppDynamics controller
A Mobile EUEM LIcense. See Mobile EUEM Licenses.
Access to your mobile application source code
Review Your Controller Capacity

If you use an on-premise Controller and plan to monitor mobile applications, assess your
Controller's capacity to accommodate the increase in the number of metrics that Mobile EUEM will
generate. The number of individual metric data points generated depends on the level of activity of
your mobile applications. As a rough guide the use of Mobile EUEM can increase the number of
metric data points by as much as 15 to 25K per instrumented application, if your applications are
heavily accessed by mobile users. The actual number depends on how many network requests
your applications receive.
The number of separate EUEM metric names saved in the Controller database can be larger
than the kinds of individual data points saved. For example a metric name for a metric for iOS 5
might still be in the database even if all your users have migrated away from iOS 5. So the metric
name would no longer have an impact on resource utilization, but it would count against the
default limit in the Controller for metric names per application. The default limit for names is
200,000 for Web EUEM and 100,000 for Mobile EUEM.
For more information about Controller sizing see Hardware Requirements per Performance Profile.

Evaluate Your Mobile Application

Out of the box, Mobile EUEM can monitor your application in two ways: network requests and
crash reporting.
If you want to collect information on network requests, your application must make HTTP calls
using specific classes:
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An iOS application must use NSURLConnection to generate network requests.
An Android application must use HttpClient or URLConnection to generate network
requests.
Even if your application does not generate network requests, or if you do not want to monitor that
activity, you can use AppDynamics purely to monitor crashes. You can also extend the mobile
agents using the SDK to collect other data, like how your application is functioning internally. See
Customize Your iOS Instrumentation and Customize Your Android Instrumentation for more
information.
Enable Mobile EUEM on Your Controller

Mobile EUEM is not enabled on your Controller by default and until it is turned on, the Controller UI
does not display Mobile EUEM functionality.
How you enable Mobile EUEM depends on how you are going to use it:
To monitor your mobile application's interaction with an existing server-side application
To monitor your mobile application with no server-side interaction.
Your Controller must have a Mobile EUEM license before you can enable the Mobile EUEM
functionality.
Enable by Connecting to an Existing Server-Side Application

If you want to monitor your mobile application in the context of an existing instrumented
server-side application:
1. In the left navigation panel of the Controller UI, click <your
application>->Configure->Instrumentation.
2. Select the End User Experience tab.
3. Check the Enable Mobile checkbox. If you do not see the checkbox, make sure you have
applied your Mobile EUEM license to your Controller.

Enable without Connection to an Existing Server-Side Application

If your application does not interact with a server-side application or if you do not want to correlate
the activity of your mobile app with any server-side application with which it may interact, you need
to create a new "application" manually in the Controller. The application serves as a container for
the information that the Controller is collecting.
1. Log into the Controller with your normal AppDynamics credentials.
2. In the left navigation bar click Applications.
3. At the top of the central screen, click + Create Application.
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3.

4. Enter a name and description for the application in the popup.

5. Click OK.
6. Select this application and follow the instructions here.
Disable Mobile EUEM on Your Controller

To disable Mobile EUEM, uncheck the Enable Mobile check box.
Instrument and Verify Your App

The method you follow to instrument your app depends on your platform:
Instrument an iOS Application
Instrument an Android Application
Verify Your Instrumentation
Configure Network Request Naming and Thresholds

You can customize how you want the Controller to name your application's requests and what
performance thresholds you want to be in effect. See Configure Mobile Network Request Naming
and Thresholds.

Instrument a Mobile Application

For iOS devices, see Instrument an iOS Application.
For Android devices, see Instrument an Android Application.
Instrument an Android Application

1. Access the instrumentation window
2. Download the Android SDK
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3. Record the Application Key
4. Set Up Your Environment
Setup for Ant
Add the AppDynamics Android agent files
Add a post-compile target
Setup for Maven
Add the AppDynamics Android agent repository to your project
Add the maven runtime dependency
Add the maven plugin
Setup for Gradle
Add the AppDynamics Android agent repository to your project
Modify build.gradle
5. Integrate ProGuard, if Necessary
6. Modify Your Application Source Code
Modify the source
7. Add the Required Permissions
8. Rebuild the Application
Verify your instrumentation - Ant
Verify your instrumentation - Maven
Verify your instrumentation - Gradle
9. Upload the ProGuard Mapping File
Upload the ProGuard Mapping File using the UI
Upload the ProGuard Mapping File using the API
1. Set up your HTTP basic authentication credentials
2. Send the mapping file
Sample Request and Response Using the REST API
Upload Request
Upload Response
10. Customize Your Instrumentation (Optional)
Watch a quick overview of the main steps of the process.
<p> </p>
Direct link: https://appdynamo.wistia.com/medias/gq6toglcej.
1. Access the instrumentation window

1. In the left navigation bar, select the application that you have enabled.
This is either the server-side instrumented application that your mobile application
communicates with or an application that you have created manually.
2. On the left nav bar, click Configure -> Instrumentation.
3. Click the End User Experience tab.
4. Click the Mobile Apps subtab.
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2. Download the Android SDK

Click the Android SDK link in step . This downloads a file named AndroidAgent.zip. This file
unzips to a folder named Android Agent, which contains the files and folders discussed in Set Up
Your Environment.
You must download the SDK separately for each application that you instrument.
3. Record the Application Key

Record the application key generated for this application, displayed in step

.

You will need this key when you modify the source code.
4. Set Up Your Environment

Follow these instructions based on your build environment:
Setup for Ant
Setup for Maven
Setup for Gradle
If you use Eclipse ADT to produce your builds, first build the application with ant and then follow
the instructions for the Android Ant installation.
Setup for Ant

If your build system is ant-based you must:
1. Add agent files to the project
2. Add a post-compile target
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Add the AppDynamics Android agent files

1. Copy ADEumAgent.jar to the libs subdirectory in your project.
2. Copy ADEumInjector.jar to your project's root directory.
Add a post-compile target

Do one of the following:
-- If there is no custom_rules.xml file in your project:
1. Create a file in your project's root directory named custom_rules.xml.
2. Copy and paste the following text into that file.
<project>
<target name="-post-compile">
<taskdef name="injector"
classname="com.appdynamics.android.ant.EUMAgentInjectorTask"
classpath="ADEUMInjector.jar"/>
<injector classfilespath="${out.classes.absolute.dir}"
outputlocation="${out.absolute.dir}/instrumented-jars/"
instrumentationjarlocation="${jar.libs.absolute.dir}/ADEUMAgent.jar"
jarfilesrefid="project.all.jars.path"
androidjarlocation="${project.target.android.jar}"/>
</target>
</project>

-- If there is an existing custom_rules.xml file in your project but it does not contain a
"-post-compile" target:
1. Add the following text to the end of the existing <project> element:
<target name="-post-compile">
<taskdef name="injector"
classname="com.appdynamics.android.ant.EUMAgentInjectorTask"
classpath="ADEUMInjector.jar"/>
<injector classfilespath="${out.classes.absolute.dir}"
outputlocation="${out.absolute.dir}/instrumented-jars/"
instrumentationjarlocation="${jar.libs.absolute.dir}/ADEUMAgent.jar"
jarfilesrefid="project.all.jars.path"
androidjarlocation="${project.target.android.jar}"/>
</target>

Copyright © AppDynamics 2012-2014

Page 1017

-- If there is an existing custom_rules.xml file in your project and it already contains a
"-post-compile" target:
1. Add the following text to the end of the existing "-post-compile" <target> element:
<taskdef name="injector"
classname="com.appdynamics.android.ant.EUMAgentInjectorTask"
classpath="ADEUMInjector.jar"/>
<injector classfilespath="${out.classes.absolute.dir}"
outputlocation="${out.absolute.dir}/instrumented-jars/"
instrumentationjarlocation="${jar.libs.absolute.dir}/ADEUMAgent.jar"
jarfilesrefid="project.all.jars.path"
androidjarlocation="${project.target.android.jar}"/>

Setup for Maven

If your build system is maven you must:
1. Add the agent repository
2. Add the maven runtime dependency
3. Add the maven plugin
These instructions assume you are building your application using the android-maven-plugin with
Maven 3.1.1+.
Add the AppDynamics Android agent repository to your project

1. Copy the adeum-maven-repo directory that you downloaded to your project directory. This
is the directory that contains pom.xml.
2. Add the following code to the <repositories> section of your pom file:
<repositories>
<repository>
<id>adeum</id>
<name>AppDynamics Repo</name>
<url>file://${project.basedir}/adeum-maven-repo</url>
</repository>
</repositories>

Add the maven runtime dependency

Add the following code to the <dependencies> section:
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<dependency>
<groupId>com.appdynamics</groupId>
<artifactId>appdynamics-runtime</artifactId>
<version>1.0</version>
</dependency>

Add the maven plugin

Add the following code to the <plugins> section:
<plugin>
<groupId>com.appdynamics</groupId>
<artifactId>appdynamics-maven-plugin</artifactId>
<version>1.0</version>
<executions>
<execution>
<phase>compile</phase>
<goals>
<goal>adinject</goal>
</goals>
</execution>
</executions>
</plugin>

Setup for Gradle

If your build system is gradle-based you must:
1. Add the AppDynamics Android agent repository to your project
2. Modify your build.gradle
Add the AppDynamics Android agent repository to your project

Copy the adeum-maven-repo directory that you downloaded to your project directory. This is the
directory that contains your build.gradle file.
Modify build.gradle

Make the following changes to build.gradle:
1. Edit or create the "buildscript" section and:
a. Force dependency on the version of the Android plugin used to build your APK files,
for example 'com.android.tools.build:gradle:0.8.3'
b. Add "adeum-maven-repo" as a repository
c. Add the version of the Android plugin you are using as a classpath dependency
d. Add the appropriate version of the AppDynamics plugin as a classpath dependency.
See the table to determine the correct version.
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d.

AppDynamics
version

Gradle version

Android Tools
plugin version

AppDynamics
plugin version

3.8.0 and later

1.8

0.6.3

N/A

1.9

0.7.0,
0.7.1,0.7.3,0.8.3,
0.9.2

These Android
Tools versions do
not support this
version of Gradle

3.8.3 and later

1.10

0.7.3,0.8.3, 0.9.2

com.appdynamics:
appdynamics-gradl
e-plugin:2.0

3.9 and later

1.10

0.7.3,0.8.3, 0.9.2,
0.10x, 0.11x, 0.12x

com.appdynamics:
appdynamics-gradl
e-plugin:2.0

3.9 and later

1.12

0.10x, 0.11x, 0.12x

com.appdynamics:
appdynamics-gradl
e-plugin:2.0

3.9 and later

2.1

0.13.0

com.appdynamics:
appdynamics-gradl
e-plugin:2.0

com.appdynamics:
appdynamics-gradl
e-plugin:1.0

2. In the main section:
a. Apply the "adeum" plugin immediately after the "android" plugin.
b. Add "adeum-maven-repo" as a repository.
c. Add "com.appdynamics:appdynamics-runtime:1.0" as a compile-time dependency.
After you have added all the AppDynamics Android Agent requirements, your build.gradle res
embles this:
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buildscript {
configurations.classpath.resolutionStrategy.force('com.android.tool
s.build:gradle:0.8.3')
repositories {
maven {url uri("adeum-maven-repo") }
//mavenCentral() or whatever repo definitions you are using
}
dependencies {
classpath 'com.android.tools.build:gradle:0.8.3',
'com.appdynamics:appdynamics-gradle-plugin:2.0'
}
}
apply plugin: 'android'
apply plugin: 'adeum'
repositories {
maven {
url uri('adeum-maven-repo')
}
}
dependencies {
compile 'com.appdynamics:appdynamics-runtime:1.0'
}

5. Integrate ProGuard, if Necessary
If you use ProGuard to verify or optimize your code, add the following lines to your Proguard
configuration file, by default proguard.cfg.
Depending on your environment, this file may renamed by your build.
-keep class com.appdynamics.eumagent.runtime.DontObfuscate
-keep @com.appdynamics.eumagent.runtime.DontObfuscate class * { *; }

If you use Proguard to obfuscate your code, note the name and location of the mapping file that
ProGuard produces, because AppDynamics needs this file to create human-readable stack traces
for crash snapshots. For details about why you should do this, see Get Human-Readable Crash
Snapshots. For more information on the process, see Uploading the ProGuard Mapping File.
Every time the application is changed and recompiled the ProGuard mapping file changes, so you
need to upload the new mapping file to AppDynamics every time you modify your app.
6. Modify Your Application Source Code

Modify the source code to initialize the mobile agent as soon as the app launches. A good place to
do this is the onCreate() method of your application's primary Activity. This registers your
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application, and only needs to be done once in your code.
Modify the source

In the source file that defines your application's primary Activity, add the following import:
import com.appdynamics.eumagent.runtime.Instrumentation;

In your primary Activity's onCreate() method, add the following line:
Instrumentation.start("$CURRENT_APP_KEY", getApplicationContext());

Save the file.
Your code should look something like this.
import com.appdynamics.eumagent.runtime.Instrumentation;
...
@Override
public void onCreate(Bundle savedInstanceState)
{
...
Instrumentation.start($CURRENT_APP_KEY",
getApplicationContext());
}

7. Add the Required Permissions

Open your application's AndroidManifest.xml file and verify that it has these permissions:
<uses-permission
android:name="android.permission.INTERNET"></uses-permission>
<uses-permission
android:name="android.permission.ACCESS_NETWORK_STATE"></uses-permis
sion>

If both of these permissions are not present, add them.
8. Rebuild the Application

Rebuild your application.
Verify your instrumentation - Ant

After your build has run, make sure that the post-compile target has completed by checking the
build output. Some of the lines in the post-compile section output should be prefixed with [injec
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tor], for example:
-post-compile:
[injector] Path to class files:
/Users/username/android/networklogger/bin/classes
[injector] Path to instrumentation jar:
/Users/username/android/networklogger/libs/ADEUMAgent.jar
[injector] Path to Android jar:
/Users/username/android-2/platforms/android-18/android.jar
[injector] Copying
/Users/username/android/networklogger/libs/ADEUMAgent.jar to
/Users/username/android/networklogger/bin/instrumented-jars/d5672e56
-062a-479b-ba88-88b367319497.jar

If the target does not run successfully, your app will not be properly instrumented.
Verify your instrumentation - Maven

After your build has run, make sure your application has been instrumented. Check the console
output of your build and make sure there is a line that contains "Injecting:"
Verify your instrumentation - Gradle

After your build has run, make sure your application has been instrumented. Check the console
output of your build and make sure there is a line that contains "Inject:"
9. Upload the ProGuard Mapping File

If you did not obfuscate your application source code, you can skip this step.
This step is optional but highly recommended if you obfuscated your code and plan to monitor
crashes. AppDynamics needs the mapping file for the application to produce human-readable
stack traces for crash snapshots. By default, the mapping file is named mapping.txt, unless you
have renamed it in your build.
If you update your application, you need to upload the new version of the mapping file.
To associate the mapping file with the correct version of the application, you need to provide:
the package name of the Android package for the application
the version code for that application from the AndroidManifest.xml file
You can either upload the mapping file using the instrumentation screen in the Controller UI or use
a special REST API. Perform the upload separately for each ProGuard mapping file that you are
providing.
Upload the ProGuard Mapping File using the UI

1. In the instrumentation window in the controller UI, click the Upload ProGuard mapping file
for Android crashes button.
2. In the ProGuard mapping file upload window, either
select an existing package from the dropdown list
or
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2.

enter a new package name for the mobile application.
If the application is already registered with the controller, you can select its package which is
listed in the dropdown list.
If the application is not yet registered, enter the package name in the New Package field.
1. Enter the version code (a number) for the package. This is the versionCode property in
the AndroidManifest.xml of the application for which this mapping file was generated.
2. Click Select ProGuard mapping file.
The uploader expects a file with .txt extension. The file is named mapping.txt.
3. In the file browser locate and select the mapping file and click Open.
4. Click Upload.
Upload the ProGuard Mapping File using the API

The api uses HTTP basic authentication to send a PUT request to AppDynamics. The username is
your AppDynamics account name and the password is your EUM license key.
1. Set up your HTTP basic authentication credentials

1.
2.
3.
4.

In the upper right section of the Controller UI, click Settings -> License.
Scroll down to the End User Experience Management panel.
Note the Account Name at the top of the panel. This is your username for authentication.
Note the License Key just below the Account Name. This is your password for
authentication.
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5. URL-encode the account name and the license key.
6. Generate an authentication string of the form: "<URL-encoded EUEM account
name>:<URL-encoded EUEM license key>" and base64 encode it. You will use this string
the following step.
7. Add an authentication header to each request, setting its value to "Basic <authentication
string>"
2. Send the mapping file

Send the ProGuard mapping file as as a text file in the body of the PUT request to the following
URI:
https://api.eum-appdynamics.com/eumaggregator/crash-reports/proguard
MappingFile/<androidPackageName>/<versionString>

These parameters are required:
androidPackagename: the name of the Android package for which this mapping file was
generated
versionString: the string representation of the "versionCod"e property in the AndroidMa
nifest.xml of the application for which this mapping file was generated
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The request body contains the mapping file. The content type of the body is either text/plan or gzip
if the body was ended with gzip.
Sample Request and Response Using the REST API

This is a sample request and response using the REST API.
Upload Request
The following example uses curl to send a mapping file. The account name is "Example account"
and the license key/password is "Example-License-Key-4e8ec2ae6cfe". The plus signs replace
spaces in the account name when the account name is URL-encoded. The package name for the
Android application is "com.example.networklogger". The mapping file corresponds to the version
with versionCode 1.
curl -v --upload-file mapping.txt --user
Example+account:Example-License-Key-4e8ec2ae6cfe
https://api.eum-appdynamics.com/eumaggregator/crash-reports/proguard
MappingFile/com.example.networklogger/1

Upload Response
The successful output of the example request looks like this:
* About to connect() to api.eum-appdynamics.com port 443 (#0)
*
Trying ::1...
* connected
* Connected to api.eum-appdynamics.com (::1) port 443 (#0)
* Server auth using Basic with user 'Example+account'
> PUT
/eumaggregator/crash-reports/proguardMappingFile/com.example.network
logger/1 HTTP/1.1
> Authorization: Basic
SW50ZXJuYWwrdGVzdCthY2NvdW50OlRlc3RBY2N0LTFlMzktNDVkMy05MzAzLTRlOGVj
MmFlNmNmZQ==
> User-Agent: curl/7.24.0 (x86_64-apple-darwin12.0) libcurl/7.24.0
OpenSSL/0.9.8y zlib/1.2.5
> Host: app.eum-appdynamics.com
> Accept: */*
> Content-Length: 4
> Expect: 100-continue
>
< HTTP/1.1 100 Continue
* We are completely uploaded and fine
< HTTP/1.1 200 OK
< Content-Length: 0
< Server: Jetty(8.1.4.v20120524)
<
* Connection #0 to host app.eum-appdynamics.com left intact
* Closing connection #0
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10. Customize Your Instrumentation (Optional)

The Instrumentation class has additional methods to allow you to extend the kinds of
application data you can collect and aggregate using Mobile EUEM. There are three basic kinds
of extensions that you can create:
custom timers
custom metrics
information points
In addition, if you are using an environment with an on-premise version of the EUEM Processor,
you need to update your code to indicate the URL to which your agent should send its beacons.
For more information, see Customize Your Android Instrumentation.

Customize Your Android Instrumentation

javadocs.zip
Download the JavaDocs
Extend the Mobile Agent
Info Points
Custom Timers
Custom Metrics
Set Up the Agent for an On-Premise EUEM Processor
Once you have instrumented your Android application with the Mobile Android SDK, you can also
use the APIs exposed by the SDK to customize the data for your app that appears in the Controller
UI, under the Custom Data tab.
Download the JavaDocs

A complete zipped version of the JavaDocs for the SDK can be downloaded from here.
The Instrumentation class contains the methods that are of interest.
Extend the Mobile Agent

You can use methods available in the Instrumentation class to collect three additional types of
data.
Info points
Custom timers
Custom metrics
Info Points

Information points allow you to track how your own code is running. You can see how often a
single method is invoked, and how long it takes to run, using beginCall and endCall. For
example, to collect information on your downloadImage method, you could use code similar to
this:
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private void downloadImage(URL url) {
CallTracker tracker = null;
try {
tracker =
Instrumentation.beginCall("com.example.android.awesomeapp.ImageDownloader",
"downloadImage", url);
//download image.
} finally {
Instrumentation.endCall(tracker);
}
}

Beginning with version 3.9.2, you can use an annotation, @InfoPoint, to create an information
point on any method. For example:
@InfoPoint
public void infoPointMethod(String arg1, int arg2, long value) {
System.out.println("Executing infoPointMethod!");
}

Custom Timers

Custom timers allow you to time any arbitrary sequence of events within your code, even spanning
multiple methods, by using startTimer and stopTimer.
public class MyActivity extends Activity {
@Override
protected void onStart(){
Instrumentation.startTimer("Time Spent on MyActivity");
//your code here.
}
@Override
protected void onStop(){
Instrumentation.stopTimer("Time Spent on MyActivity");
//your code here.
}
}

startTimer(String) and stopTime(String) can be called from different threads.
Custom Metrics

Any integer-based data can be passed to the agent. The first parameter to the report.Metric c
all is the name you want the metric to appear under in the Controller UI. For example, to track the
number of times your users click the checkout button in your UI, you could use code similar to this.
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findViewById(R.id.checkout_button).setOnClickListener(new
View.OnClickListener(){
@Override
public void onClick(View view){
//run your checkout routine.
Instrumentation.reportMetric("Checkout Count", 1);
}
});

Set Up the Agent for an On-Premise EUEM Processor

By default the agent is configured to send its beacons to the EUEM Cloud, which is an instance of
the EUEM Processor running on AWS. If you wish to instrument your app in an environment that
is using an on-prem version of the Processor, you need to modify the URL to which the agent
sends its data. You do this using the second version of the start method listed in the JavaDocs,
using the collectorURL parameter.

Instrument an iOS Application

1. Access the instrumentation window
2. Download the iOS SDK
3. Record Your Application Key
4. Install the Framework
5. Modify the Application Source Code - Objective C
5A. Modify the Application Source Code - SWIFT
6. Add Required Libraries, as Necessary
To add the libraries
7. Rebuild You Application
To rebuild your application
8. Upload the dSYM File
Get the dSYM file from Xcode
Upload the dSYM file to AppDynamics using the UI
Upload the dSYM File to AppDynamics Using the REST API
1. Set up your HTTP basic authentication credentials
2. Send the dSYM file
Sample Request and Response Using the REST API
Upload Request
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Upload Response
9. Customize Your Instrumentation (Optional)
Watch a quick video overview of the main steps of the process.
<p> </p>
Direct link: https://appdynamo.wistia.com/medias/pohgsjj2dd
1. Access the instrumentation window

1. In the left navigation bar, select the application that you have enabled.
This is either the server-side instrumented application that your mobile application
communicates with or an application that you have created manually.
2. On the left nav bar, click Configure -> Instrumentation.
3. Click the End User Experience tab.
4. Click the Mobile Apps subtab.

2. Download the iOS SDK

Click the iOS SDK link in step

. This downloads a file named iOSAgent.zip.

You must download the SDK separately for each application that you instrument.
3. Record Your Application Key

Record the application key generated for this application, displayed in step

.

You will need this key when you modify the source code.
4. Install the Framework

Copyright © AppDynamics 2012-2014

Page 1030

Uncompress the .zip file you downloaded: you have a file named ADEUMInstrumentation.fra
mework. Drag this framework file into your project's Frameworks directory.

5. Modify the Application Source Code - Objective C

Edit your app's main.m file to initialize the mobile agent as soon as the app launches. This
registers your application, and only needs to be done once in your code.
1. In your application's main.m, add this import:
#import <ADEUMInstrumentation/ADEUMInstrumentation.h>

2. Add the call to ADEumInstrumentation initWithKey passing your application key,
recorded in step 3, as a parameter by adding this line of code to the beginning of your
application's main() function:
[ADEumInstrumentation initWithKey:@"$CURRENT_APP_KEY"];

Your main.m should look something like this:
#import <UIKit/UIKit.h>
#import <ADEUMInstrumentation/ADEUMInstrumentation.h>
#import "AppDelegate.h"
int main(int argc, char *argv[])
{
[ADEumInstrumentation initWithKey:@"$CURRENT_APP_KEY"];
@autoreleasepool {
return UIApplicationMain(argc, argv, nil,
NSStringFromClass([AppDelegate class]));
}
}

3. Save the file.
5A. Modify the Application Source Code - SWIFT

The iOS Agent is compatible with applications created using the Swift programming language.
1. Create a bridging header, as described in this Apple documentation, to expose the Agent's

Copyright © AppDynamics 2012-2014

Page 1031

1.
Objective C code to your Swift code.
2. To your bridging header, add this code:
#import <ADEUMInstrumentation/ADEUMInstrumentation.h>

3. In your main.swift or AppDelegate's didFinishLaunchingWithOptions, initialize the
SDK like this:
ADEumInstrumentation.initWithKey($CURRENT_APP_KEY")

4. Save the file.
6. Add Required Libraries, as Necessary

The Appdynamics iOS agent requires the following libraries:
SystemConfiguration.framework
CoreTelephony.framework
libz.dylib
libsqlite3.dylib
To add the libraries

1.
2.
3.
4.

Select the target that builds your app in Xcode.
Select the Build Phases tab.
Expand the Link Binary With Libraries section.
If any of the above libraries are not listed:
Click the + button.
Locate the missing library in the list.
Click Add.

Repeat this step for each missing library.
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7. Rebuild You Application

Rebuild your application with the modified application code.
To enable the agent to provide human-readable information in the crash snapshots that are
produced if the application crashes, compile with the DWARF with dSYM file option to create
a debug symbols file for the application. For more details about why you would want to do this see
Get Human-Readable Crash Snapshots.

To rebuild your application

1.
2.
3.
4.

In Xcode, select your project in the Project Navigator.
In the target list, select the target that builds your application.
Select the Build Settings tab.
In the Build Options section, make sure that the Debugging Information Format is set to
"DWARF with dSYM File".
5. Rebuild the Xcode project.
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8. Upload the dSYM File

This step is optional but highly recommended if you plan to monitor crashes. AppDynamics needs
the dSYM file for the application to produce human-readable stack traces for crash snapshots.
For details about why you should do this, see Get Human-Readable Crash Snapshots.
If you update the application, you need to provide the new dSYM file for the new application
version. The dSYM file contains an UUID that links it to a specific Xcode build, so AppDynamics
can unambiguously match the correct dSYM file with an incoming crash report with no additional
information.
1. Get the dSYM file from Xcode
2. Upload the dSYM file to AppDynamics using the UI
or
Upload the dSYM File to AppDynamics Using the API
Get the dSYM file from Xcode

1.
2.
3.
4.
5.
6.
7.
8.

In Xcode, run the Xcode build: Product > Build.
View the log navigator: View > Navigators > Show Log Navigator.
Click the log entry for the most recent build.
Near the end of the log, find and mouse over the log entry named "Generate
<Your_App_Name>.app.dSYM".
Click the button on the right side of the entry you found in step #4 to expand it.
The end of the displayed command is the path to the dSYM file.
Navigate to this dSYM file in the Finder.
Right click on the dSYM file and choose Compress.
Upload to AppDynamics the .zip file that Finder generates.

Upload the dSYM file to AppDynamics using the UI

1. In the instrumentation window in the controller UI, click the Upload dSym package file for
iOS crashes button.
2. In the Xcode dSym package upload window click Select zipped dSym file.
The uploader expects a file with a .zip extension.
3. In the file browser locate the zipped dSYM file for the application that you are instrumenting
and click Open.
4. Click Upload.
Upload the dSYM File to AppDynamics Using the REST API

The API uses HTTP basic authentication to send a PUT request to AppDynamics. The username
is your AppDynamics account name and the password is your EUM license key.
1. Set up your HTTP basic authentication credentials

1.
2.
3.
4.

In the upper right section of the Controller UI, click Settings -> License.
Scroll down to the End User Experience Management panel.
Note the Account Name at the top of the panel. This is your username for authentication.
Note the License Key just below the Account Name. This is your password for
authentication.
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4.

5. URL-encode the account name and the license key.
6. Generate an authentication string of the form: "<URL-encoded EUEM account
name>:<URL-encoded EUEM license key>" and base64 encode it. You will use this string
the following step.
7. Add an authentication header to each request, setting its value to "Basic <authentication
string>"
2. Send the dSYM file

Send the dSym as a zip archive in the body of a PUT request to the following URI:
https://api.eum-appdynamics.com/eumaggregator/crash-reports/iOSDSym

The content type of the body must be application/zip if the file is a zip file or application/gzip if it is
a gzip file. Only these formats are accepted.
Sample Request and Response Using the REST API

This is a sample request and response using the REST API.
Upload Request
The following example uses curl to send a dSym file named UISampleApp.app.dSYM.zip. The
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account name is "Example account " and the license key/password is Example-License-Key-4e8e
c2ae6cfe. The plus signs replace spaces in the account name when the account name is
URL-encoded.
curl -v --upload-file UISampleApp.app.dSYM.zip --user
Example+account:Example-License-Key-4e8ec2ae6cfe
https://api.eum-appdynamics.com/eumaggregator/crash-reports/iOSDSym

Upload Response
The successful output of the sample request looks like this:
* About to connect() to api.eum-appdynamics.com port 443 (#0)*
Trying ::1...
* connected
* Connected to api.eum-appdynamics.com (::1) port 443 (#0)
* Server auth using Basic with user 'Example+account'
> PUT /eumaggregator/crash-reports/iOSDSym HTTP/1.1
> Authorization: Basic
SW50ZXJuYWwrdGVzdCthY2NvdW50OlRlc3RBY2N0LTFlMzktNDVkMy05MzAzLTRlOGVj
MmFlNmNmZQ==
> User-Agent: curl/7.24.0 (x86_64-apple-darwin12.0) libcurl/7.24.0
OpenSSL/0.9.8y zlib/1.2.5
> Host: localhost:7001
> Accept: */*
> Content-Length: 0
> Expect: 100-continue
>
< HTTP/1.1 100 Continue
< HTTP/1.1 200 OK
< Content-Length: 0
< Server: Jetty(8.1.4.v20120524)
<
* Connection #0 to host api.eum-appdynamics.com left intact
* Closing connection #0

9. Customize Your Instrumentation (Optional)

The ADEUMInstrumentation class has additional methods to allow you to extend the kinds of
data you can collect and aggregate using AppDynamics. There are three basic kinds of
extensions that you can create:
custom timers
custom metrics
information points
In addition, if you are using an environment with an on-premise version of the EUEM Processor,
you need to update your code to indicate the URL to which your agent should send its beacons.
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For more information, see Customize Your iOS Instrumentation.
Customize Your iOS Instrumentation

Download the AppleDocs
Extend the Mobile Agent
Info Points
Custom Timers
Custom Metrics
Set Up the Agent for an On-Premise EUEM Processor
Once you have instrumented your iOS application with the Mobile iOS SDK, you can also use the
APIs exposed by the SDK to customize the data for your app that appears in the Controller UI,
under the Custom Data tab.
Download the AppleDocs

A complete zipped version of the AppleDocs for the SDK can be downloaded from here.
The ADEumInstrumentation class contains the methods that are of interest.
Extend the Mobile Agent

You can use methods available in the ADEUMInstrumentation class to collect three additional
types of data
Info points
Custom timers
Custom metrics
Info Points

Information points allow you to track how your own code is running. You can see how often a
single method is invoked, and how long it takes to run, by using beginCall and endCall,
something like this:
- (void)startTimerWithName
{
id tracker = [ADEumInstrumentation beginCall:self selector:_cmd];
// Implementation of method here ...
[ADEumInstrumentation endCall:tracker];
}

Custom Timers

Custom timers allow you to time any arbitrary sequence of events within your code, even spanning
multiple methods, by using startTimer and stopTimer. For example, to time how long your
application takes to launch, you could do something like this:
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int main(int argc, char * argv[])
{
[ADEumInstrumentation initWithKey:@"<YOUR APP KEY HERE>"];
[ADEumInstrumentation startTimerWithName:@"App Startup"];
// ...
}
- (BOOL)application:(UIApplication *)application
didFinishLaunchingWithOptions:(NSDictionary *)launchOptions
{
// ...
[ADEumInstrumentation stopTimerWithName:@"App Startup"];
return YES;
}

Custom Metrics

Any integer-based data can be passed to the agent. The first parameter to the report.MetricW
ithName call is the name you want the metric to appear under in the Controller UI. Reporting a
metric called "My custom metric", for example, would look something like this:
[ADEumInstrumentation reportMetricWithName:@"My custom metric" value:<VALUE HERE>];
Set Up the Agent for an On-Premise EUEM Processor

By default the agent is configured to send its beacons to the EUEM Cloud, which is an instance of
the EUEM Processor running on AWS. If you wish to instrument your app in an environment that
is using an on-prem version of the Processor, you need to modify the URL to which the agent
sends its data. You do this using the initWithKey:collectorUrl method listed in the
AppleDocs, using the collectorUrl parameter.

Verify Your Instrumentation

After you have instrumented your application:
1. Cause your instrumented mobile application to generate some network traffic.
2. Wait a few minutes.
3. In the controller UI, open Configure->Instrumentation->End User Experience->Mobile
Apps and check the list of registered mobile applications to verify that the application is
registered with the controller. You can also use this interface for some basic management
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tasks, like renaming or deleting your mobile applications.

4. Start monitoring your application! See Monitor Your Applications with Mobile EUEM.
Configure Mobile Network Requests Naming, Thresholds, and Percentiles
Using the Controller UI, you can configure:
how mobile requests are named
the thresholds that cause network request snapshots to be considered, slow, very slow or
stalled
percentile levels you would like to display, if any
To access mobile request configuration
1. In the left navigation pane of the AppDynamics console, click Configure -> Instrumentation
.
2. Click the End User Experience tab.
3. Click the Mobile Network Request Naming, Thresholds & Percentiles subtab.
Configure Mobile Network Request Naming

Using the Default Network Request Naming Configuration
Modifying the Default Naming Configuration Rule
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To modify the default network request naming rule
Creating Custom Naming Rules
To create a custom naming rule
Creating Mobile Exclude Rules
To create a custom exclude rule
Learn More
Using the Default Network Request Naming Configuration

By default AppDynamics names network requests using:
the host name
the first two segments of the URL
For example, if an application makes this HTTP request:
http://myapp.com/friends/profiles/12345

The default name that is displayed in the Controller UI for that request is:
myapp.com/friends/profiles

If this is adequate for your needs, you can leave the default as is.
Modifying the Default Naming Configuration Rule

You may want to configure a different default rule for naming your network requests to help you
visualize the parts of your application more clearly. The task is similar to configuring naming rules
for business transactions on the server side. Try to group logically related requests together while
keeping unrelated requests in separate groups.
If the default host name and first two segments of the URL for all your requests are identical,
you might want to name the requests based on the last segments or a selection of
non-contiguous segments of the URL to distinguish among requests in the network requests
list.
You can also name the requests based on query parameters. For example if the request
passes an order number, you could specify that the value of the order-number query
parameter be used in the network request name.
You can also base the name on a regular expression run on the URL. AppDynamics uses
the Java libraries for regular expressions. For more information see:
Tutorial: http://download.oracle.com/javase/tutorial/essential/regex/index.html
Javadoc: http://download.oracle.com/javase/1.5.0/docs/api/java/util/regex/Pattern.html
To modify the default network request naming rule

The default configuration covers how all your requests are named if you do not customize them
further.
1. Access the Mobile Network Requests Naming and Thresholds window.
2. Expand Configure how Network Requests will be named.
3.
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3. In the Default Naming Convention section, select the elements you want to use for your
default network request naming.
4. Click Save.

Creating Custom Naming Rules

By default, the same request naming rule is applied to every URL that your application requests. If
you want to apply different naming rules to different URLs, create custom naming rules.
For example, if some requests call your own in-house server and others call out to a third-party
API, you may want to see all the third-party API calls as a single network request and use the
default naming rules for the calls to your own server. You would create a custom naming rule that
matches the third party calls and uses only the host in the default rule name or perhaps also
include certain query parameters.
To create a custom naming rule

1. In the Mobile Network Request Naming & Thresholds subtab of the End User Experience
tab, click the + icon under Custom Naming Rules.
2. In the Custom Naming Rule window, enter a name for the custom rule that you are creating.
3. Check the Enabled check box to enable the rule.
4. Select the check boxes and radio buttons and enter the match criteria for AppDynamics to
use to name network requests.
5. Use the Priority parameter on a custom rule to specify which rule to apply to the request
name if it could be detected by more than one custom rule. Custom rules are always
evaluated before the default naming rule, beginning with the custom rule that has the
highest priority.
6. Click OK.
Sample custom naming rule
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The following rule creates a custom match rule for requests to the AcmeMobileShopping
application in which the URL contains "ourpartner.com". This rule uses the protocol, the
subdomain and the third and fourth segments of the URL in the network request name.

You can temporarily cancel the application of a custom naming rule by clearing the Enabled check
box in the custom rule configuration. In this case the default naming rule is applied to requests that
would have been named by the disabled custom rule. To remove the rule permanently, select the
custom rule in the Custom Naming Rules list and click the Delete icon.
Creating Mobile Exclude Rules

If there are certain types of requests that you do not want to monitor, create custom exclude rules
for them based on the URL and/or the application name. Excluded network requests are not
reported or counted toward the network request limit of 500 requests per controller application.
To create a custom exclude rule

1. In the Mobile Network Request Naming & Thresholds subtab of the End User Experience
tab, click the plus icon under Custom Exclude Rules.
2. Enter a name for the exclude rule. that you are creating
3. Check the Enabled check box to enable the rule.
4. Use the dropdown menus to provide the matching criteria for the URL and mobile
application of the requests to be excluded.
5. Click OK.
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.
You can temporarily cancel the application of an exclude rule by clearing the Enabled check box
in the exclude rule configuration. To remove the rule permanently, select the exclude rule in the
Custom Exclude Rules list and click the Delete icon.
Learn More

Network Request Limits
Monitor Network Requests
Configure Mobile Network Request Thresholds

To configure network request thresholds
The mobile agent uses configurable thresholds to determine whether network request time is
normal, slow, very slow or stalled. It uses these thresholds:
to decide whether to create a mobile request snapshot
for labeling network request experience in a network request snapshot
By default the mobile agent uses the following default values to determine whether a request is
slow or stalled:
slow: greater than 3 standard deviations
very slow: greater than 4 standard deviations
stall: greater than 45000 ms
You should configure these defaults to conform to your own criteria for your mobile applications.
An absolute threshold rather than one based on the standard deviation is often more appropriate
for mobile applications.
To configure network request thresholds

1. Access the mobile network request configuration window.
2. In the Mobile Network Request Naming & Thresholds subtab of the End User Experience
tab, expand Thresholds for Slow End User Experience.
3. In the Thresholds for Slow End User Experience section, set the thresholds for slow, very
slow and stalled in milliseconds.
4. Click Save.
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Configure Mobile Percentile Metrics

Access Configure Percentile Metrics
Configure Percentile Metrics
Learn More
In many places across the Controller UI you can choose to display metrics using either averages
or percentiles. A percentile is a measure that indicates a value below which a given percentage of
values in a set falls: for example, the 99th percentile means that 99% of all values are below this
level. Using percentiles can be a good way to reduce the impact of extreme outliers in
performance metrics, which can be useful in the often noisy environments of end user experience
monitoring.
You can:
enable/disable percentile metric display
set up to four different percentile levels to be applied to metrics
Access Configure Percentile Metrics

1. Access the EUEM configuration screen if you are not already there. Configure->Instrument
ation.
2. Select End User Experience tab.
3. Select Mobile Network Request Naming, Thresholds & Percentiles sub-tab.
4. Expand Configure Percentile Metrics
When you complete your changes, remember to click Save.
Configure Percentile Metrics

You can change the percentiles which are used to evaluate data throughout the UI.
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1. Check the box to enable percentile metric display
2. Add up to four percentile levels to collect. Each value must be a whole number between 1
and 99.
If you change the percentiles to collect new values, it takes some time for the recalculation to
take place. If you look in the Metric Browser you see metrics based on the old percentiles up until
the moment that you update the values, when they change to reflect the change.
Learn More

The Web EUEM Geo Dashboard View
The Mobile EUEM Geo Dashboard

Troubleshoot Mobile Applications
You can use Mobile EUEM to investigate two different kinds of problems that can arise with your
mobile applications:
Troubleshoot Slow Network Requests from Mobile Applications

Troubleshoot performance issues by looking at your slowest network requests.
Identifying the Slowest Network Requests
To identify slow network requests
Drilling Down to Slow Network Request Instances
To see details of the slowest individual requests
Learn More
Identifying the Slowest Network Requests

First identify which types of network requests are the slowest.
To identify slow network requests

1. In the left navigation pane click either End User Experience->iOS for iOS
applications or End User Experience->Android for Android applications.
The Mobile EUEM dashboard opens.
2. Click the Network Requests tab.
3. Click the top of the Network Request Time (ms) column, then toggle it to sort the
network requests with the slowest ones at the top.
4.
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4. Skip over network requests that you expect to run for a long time or that have very
little load (low Requests per Minute).
5. Select and double-click one of the slow network requests that you want to investigate.
6. In the network request dashboard, view the Key Performance Indicators at the top of
the Network Request Dashboard. For example:
If the value for Network Request Time is large, the request or response body
may be too large and is taking a while to transmit. Or the data connection might
be slow.
If the backend server is instrumented and the value for Total Server Time
makes up a significant amount of the delay, scroll down to the Related Business
Transactions section to investigate related business transactions on the server
side.
Drilling Down to Slow Network Request Instances

Second, drill down to network request snapshots for individual instances of the slow request
types to get details.
To see details of the slowest individual requests

1. Still in the the Mobile EUEM dashboard, click the Network Request Snapshots tab.
The Network Request Snapshots List opens.
2. Click Filters.
3. In the Network Request Names dropdown list under Network in the Filters panel,
check the check box for the network request that you identified in To identify slow
network requests, then click Search.
This restricts the list to snapshots for that network request only.
4. Click Filters again to close the filters panel.
5. In the list, click the top of the Network Request Time (ms) column, then toggle it to sort
the network request snapshots with the slowest requests at the top.
6. Select and double-click one of the slow network requests.
The network request snapshot displays the details of the slow request.
7. If this request is associated with a server-side application that is also instrumented,
scroll down to see if transaction snapshots for this request are available on the server
side.
If transaction snapshots are available and if most of the time for this network request
is spent on the server, click through to the related transaction snapshots to
understand what is causing the slow performance on the server. See Transaction
Snapshots.

Learn More

Monitor Network Requests
Troubleshoot Mobile Application Crashes
Use crash dashboards and crash snapshots to troubleshoot mobile application crashes.
Identifying the Characteristics of Applications that Crash Most Often
To identify common characteristics of applications that crash
Finding Causes of Crashes
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To find root cause of individual crashes
Learn More
Identifying the Characteristics of Applications that Crash Most Often

Sometimes most of your crashes share one or more characteristics, with your application crashing
more often on certain devices or operating systems or carriers or connections. Identifying these
common characteristics can help you focus in on the problem.
To identify common characteristics of applications that crash

1. In the left navigation pane click either End User Experience->iOS for iOS applications or E
nd User Experience->Android for Android applications.
The Mobile EUEM dashboard opens.
2. Click the Crashes tab.
3. Click the Dashboard subtab if it is not already selected.
4. In the Crashes vs Requests graph, identify values that are significantly above the Average
line. You can use the checkboxes on the left to limit the kinds of information that you are
being shown. This can help make the graph easier to read.

For example, the WiFi version of the app for the iPad 2 and version 2.0 of the application are
both crashing more than average.
5. Scroll down to the detailed section for the characteristic type that defines the problem - for
example, Crashes By Device Name for the iPad 2 WiFi issue.
6. In the line graph, note the times that crashes spike. You can hover over a point on the graph
to see the exact number of crashes at that time.
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Finding Causes of Crashes

After you have identified which applications are causing most of your crashes and approximately
when most crashes occur, you can examine a few of those individual crashes to identify the cause.
To find root cause of individual crashes

1. In the Crashes tab of Mobile EUEM Dashboard, click the Crash Snapshots subtab.
2. Click Filters.
3. Check the check box for the type of apps experiencing the most crashes that you identified
in Identifying the Characteristics of Applications that Crash Most Often.
This filters the crash snapshots list to display only snapshots of crashed applications
meeting those criteria. Below we are searching for iPad 2 WiFi crashes.

4. In the crash snapshots list, select and double-click a snapshot that occurred around the time
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4.
that most crashes occurred. In the stack trace of the crash snapshot, note the thread and
function in which the crash occurred. For some crashes the crashed line number is also
available.
5. Optional: Click Download to get a text version of the stack trace to send to your application
development team.
Learn More

Crash Dashboard
Crash Snapshots List
Crash Snapshots

Get More Information about Mobile EUEM
Use the following to find out more about Mobile EUEM.
Mobile EUEM Metrics
Supported Environments and Versions for Mobile EUEM
Mobile EUEM Licenses
Network Request Limits
Mobile EUEM Metrics

Mobile Metrics Defined
Network Request Metrics
HTTP Errors
Network Errors
Calls to Instrumented Server-Side Applications
Crash Metrics
AppDynamics displays key metrics for Mobile EUEM on the various dashboards in the Mobile UI
and in the Metric Browser.
In the Metric Browser, mobile metrics are aggregated in the Mobile tree by agent (iOS and
Android), application, carrier, connection type, device, geographic location, operating system
version, and application version.
Mobile Metrics Defined

The following describes all the metrics Mobile EUEM collects.
"Average" for time metrics is calculated as an arithmetic mean.
Network Request Metrics

Network request metrics are reported for each platform and for each instrumented mobile
application.
Network Request Time: average interval in milliseconds between the time that a mobile
application initiates a request by calling the system API and the time that the system returns
the response to the application
Network Requests per minute: average number of network requests per minute; for all
requests from the app that are made over HTTP.
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Total Requests: derived by adding all the networks requests per minute over the selected
time range.
HTTP Errors

An HTTP error occurs when an HTTP request is sent and a response is received, but the
response status code indicates that an error occurred. These errors suggest that the network is
working correctly but there is a problem on the client side (4xx status codes) or the server side
(5xx status codes) that prevented normal handling of the request.
HTTP Errors per minute: average errors per minute for errors that return an HTTP
response code between 400 and 599
HTTP Errors (total): total number of errors that return an HTTP response code between
400 and 599 over the selected time range
Network Errors

A network error is any occurrence that prevents the HTTP request from being sent or the HTTP
response from being received successfully. Typical causes of network errors include:
Host cannot be resolved.
Host refused connection.
Connection timed out.
Device is offline.
General connectivity problems.
Network Errors per minute: average network errors per minute
Network Errors (total): total number of network errors over the selected time range
Calls to Instrumented Server-Side Applications

These metrics are only collected when the mobile app interacts with an instrumented server-side
application
Application Server Calls per Minute: average call rate from the mobile application to the
instrumented server-side application
Application Server Time: how long the instrumented server-side application takes to
complete its part of the request, on average
Crash Metrics

Total Number of Crashes
App Crashes per Minute
Supported Environments and Versions for Mobile EUEM
Supported Platform Matrix for Mobile EUEM
Operating Systems
iDevice Architecture
iOS Environments
Android Environments
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Supported Platform Matrix for Mobile EUEM
Operating Systems

Supported Operating System

Version

iOS

5.1.1+

Android

2.3.3+

iDevice Architecture

Apple 32-bit ARM
Apple 64-bit A7
iOS Environments

Supported Framework

Version

XCode

5+

Android Environments

Supported Framework

Version

Ant
Gradle

1.8, 1.10, 1.12

Maven

3.1.1+

Mobile EUEM Licenses

Mobile EUEM License Information
To view Mobile EUEM License Information
License Key
License Type
Usage Period
Total Mobile EUEM Agents Licensed
Monthly Unique Users Allocated
Consumed Monthly Unique Users
Overages
This topic describes how to interpret the details of your Mobile EUEM license information.
Mobile EUEM License Information

Your Mobile EUEM license is separate from your application server and Web EUEM licenses.
To view Mobile EUEM License Information

1. In the upper right section of the AppDynamics console, click Settings -> License.
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or on the Home screen in the AppDynamics under Settings click View License.

2. Scroll down to the Mobile entries under End User Monitoring.

License Key

This is the unique identifier that AppDynamics uses to associate end user data, both Web and
Mobile, to your account. From a practical perspective you only need to know this information for
troubleshooting purposes. The same key applies to Web EUEM and Mobile EUEM services.
However each product has its own types and quantity of agents.
License Type

There are two license types:
Mobile Pro (Paid) license covers the number of Mobile Pro license units you have
purchased. Each Mobile Pro license allows you to monitor a fixed number of active users
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per application per month. This number is specified in your AppDynamics service
agreement.
Mobile Lite (Free) provides one Mobile Lite license unit. Mobile Lite allows you to monitor
the Crash Dashboard and Crash Snapshots (covering the previous 365 days) for 5 million
devices.
By purchasing additional Mobile Pro license units, you can increase the number of unique mobile
users allocated to your account. If you have not purchased a Mobile Pro account, you will receive
a Mobile Lite account.
Usage Period

The usage period for mobile is always the current month, even if you have a multi-year license.
The usage period begins and the meter resets on the first of each month at 12:00pm Pacific time.
Total Mobile EUEM Agents Licensed

For a Mobile Pro license, this is the equivalent of the total number of license units licensed by your
account.
For a Mobile Lite license, this is one Lite license unit. One Lite license unit includes access to the
Crash Dashboard and Crash Snapshots (covering the previous 365 days) for 5 million devices.
Monthly Unique Users Allocated

This is the number of unique mobile users per month allocated by your license.
Each Mobile Pro license unit provides a number of unique mobile users per month per native
mobile app instrumented with AppDynamics iOS or Android SDK. To get your total number of
unique users AppDynamics multiplies the number of licenses you have by the number of unique
mobile users per license.
You cannot carry over unused allocated users from month to month.
Consumed Monthly Unique Users

This is the number of monthly unique users actually monitored during the current month. The
month begins on the 1st at 12:00pm Pacific time, at which time this value is reset to zero.
If this value is greater than Monthly Unique Users Allocated and your license allows overages, you
are incurring overage charges.
When your consumed monthly usage is at 90% of of your month allocation you will see a warning
in the mobile EUEM dashboard.
Overages

How overages are handled is determined by the terms of your license agreement.
If your license does not allow overages, AppDynamics continues reporting mobile metrics
generated by users who started using your application before you consumed all your allocated
users. However, it does not report metrics for additional unique users. For example, if your license
allows 50,000 monthly users, the agent does not report metrics generated by the 50,001st unique
user and beyond but will continue to report on the first 50,000 for the rest of the month. Keep in
mind that if there are patterns in which certain types of users activate the application in the first
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part of the month, you may be missing what other types of users are experiencing. Limiting the
number of active users licensed is not a recommended way to do sampling.
If your license does allow overages and your usage exceeds the limit, AppDynamics continues
reporting mobile metrics for additional users and bills you for the overage at the unit rate stipulated
by your license agreement.
If you need to stop incurring overage charges, you can disable mobile monitoring by clearing the
Enable Mobile check box in the Mobile EUEM configuration window. This will stop mobile
monitoring and stop overage charges after a delay of approximately one minute. See Disable
Mobile EUEM on Your Controller .
Network Request Limits
Remove Network Requests Without Load
To delete network requests with no load
Exclude Requests that Do Not Need to be Monitored
Group Network Requests of Similar Type
Learn More
The EUM cloud can process a maximum of 500 network request types per controller application.
The "controller application" is the application you selected or created when you originally set up
Mobile APM. You used this application to download and instrument your mobile application as
described here (iOS) or here (Android). You should note that a single AppDynamics account may
have more than one controller application associated with it.
After 500 network request types have been registered, AppDynamics continues to monitor those
500 request types but does not register or process any additional request types. If your usage
exceeds the limit, a message pops up in the network request list.

Note that because the limit covers all your mobile applications, if you monitor both iOS and
Android mobile applications, the network request list you are currently looking at may not
show 500 hundred requests. For example, if you have 200 network requests to Android
applications and 301 network requests to iOS applications, you see the warning in both
lists until you take action to delete excess requests.
You can use the following techniques to keep your usage under the 500 network request limit.
Remove Network Requests Without Load

Removing network request types that have been registered but are not receiving any load is a
good place to start to reduce the number of your registered requests.
Deleting network requests does not prevent them from being re-discovered in the future if the
request once again comes under load. To prevent specific network requests from ever being
discovered, you must create exclude rules to keep them from being discovered. See Creating
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Mobile Exclude Rules.
To delete network requests with no load

1.
2.
3.
4.
5.

In the Network Requests list, uncheck the Filter With Load check box.
Refresh the list.
Find the requests that have no load. They are candidates for removal.
Select the requests that you want to delete.
In the More Actions dropdown menu, click Delete Request(s).

Exclude Requests that Do Not Need to be Monitored

The mobile agent may be detecting network requests types that are not interesting for you to
monitor. You can create exclude rules to prevent the agent from ever registering those requests
types. See Creating Mobile Exclude Rules.
After you have created exclude rules to reduce the number of network requests detected, delete
any network requests of the excluded type that have already been registered from the network
request list, following the procedure described in To delete network requests with no load.
Group Network Requests of Similar Type

Review the default network request naming rule described in Configure Mobile Network Request
Naming. It is possible that the default rule is generating many more network requests types than
are desirable.
For example, perhaps your application loads images dynamically and stores them on your server
with URLs like "http://myapp.com/image/image1234.jpg". This would cause a separate network
request to be generated for each image, which is probably not what you want. You could create a
custom naming rule to group all the image URLs as a single network request. See Creating Mobile
Custom Naming Rules.

After you have created custom rules to reduce the number of network requests detected,
unregister the network requests for those are now covered by the custom rule, following the
procedure described in To delete network requests with no load.
Learn More
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Configure Mobile Network Request Naming

Application Performance Management
This topic describes high-level benefits and features of
AppDynamics Application Performance Management.

Continuous Discovery, Visibility, and Problem Detection
Real-Time Business Transaction Monitoring
Service Endpoint Monitoring
Infrastructure Monitoring
Health Rules, Policies, and Actions
Troubleshooting and Diagnostics
Systems Integration
Learn More

Continuous Discovery, Visibility, and Problem Detection
AppDynamics Application Performance Management continuously discovers and monitors all
processing in your application environment using advanced tag, trace, and learn technology
across your distributed transactions. With this information, it provides a simple intuitive view of live
application traffic so you can see where bottlenecks exist.
Dashboards show the health of your entire business application. Health indicators are based on
configurable thresholds and they update based on live traffic. When new services are added to the
system AppDynamics discovers them and adds them to the dashboards and flow maps. See Contr
oller UI Guide.
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AppDynamics observes normal
performance patterns so that it
knows when application
performance becomes
abnormal. It automatically
identifies metrics whose current
values are out of the normal
range, based on dynamic
baselines it has observed for
these metrics. See Detect
Anomalies Using Dynamic Baselines.

Expert Advice
The Intelligent Approach to Production
Monitoring
by Jim Hirschauer

Real-Time Business Transaction Monitoring
An AppDynamics business transaction represents a distinct logical user activity such as logging in,
searching for items, buying an item, etc. Organizing application traffic into business transactions
aligns the traffic with the primary functions of a web business. This approach focuses on how your
users are experiencing the site and provides real-time performance monitoring.
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See Monitor Business Transactions and Monitor Background Tasks.

Service Endpoint Monitoring
Service endpoints are helpful in complex, large-scale applications where an owner is assigned to
one or more logical tiers and the standard representation does not correspond with real-life
ownership of application components. Service endpoints allow you to see a subset of the metrics
for the tier so you can focus on the key performance indicators and snapshots of entry points that
are truly of interest to you. Service endpoints are similar to business transactions except that they
only show metrics for the entry points and do not track metrics for any downstream segments.

See Monitor Service Endpoints.

Infrastructure Monitoring
AppDynamics machine agents gather information about the operating systems and machines,
such as CPU activity, memory usage, disk reads and writes, etc. AppDynamics agents monitor
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JVM and CLR metrics including heap usage and collections.

See Monitor Infrastructure and Server Monitoring.
Expert Advice

Health Rules, Policies,
and Actions

Proactive Monitoring and Alerting with
AppDynamics

Dynamic baselines combined
by Ian Withrow
with policies and health rules
help you proactively detect and
troubleshoot problems before
customers are affected. Health
rules define metric conditions to
monitor, such as when the "average response time is four times slower than the baseline".
AppDynamics supplies default health rules that you can customize, and you can create new ones.
You can configure policies to trigger automatic actions when a health rule is violated or when any
event occurs. Actions include sending email, scaling-up capacity in a cloud or virtualized
environment, taking a thread dump, or running a local script. See Alert and Respond.

Troubleshooting and Diagnostics
You can examine transaction snapshots for slow and error transactions and drill down into the
snapshot with the slowest response time to begin deep diagnostics to discover the root cause of
the problem.
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See Troubleshoot and Resolve.

Systems Integration
AppDynamics is designed to interface with other systems in your organization. You can add data
to AppDynamics, retrieve data from AppDynamics, and integrate AppDynamics actions into your
alerting system. See Extensions and Integrations.

Learn More
End User Experience Management

APM Overview - Java
This information covers using AppDynamics for Java applications and environments. For general
information see Application Intelligence Platform and AppDynamics Features.
Tutorials

Monitor Java Applications

Troubleshoot Application
Problems - Java

Configure AppDynamics for Java

Supported Environments and Versions for Java
Administer App Agents for Java

Supported Environments and Versions for Java
Supported Platform Matrix for the Java Agent
JVM Support

Copyright © AppDynamics 2012-2014

Page 1060

JVM Language Frameworks Support
Application Servers
Application Server Configuration
Message Oriented Middleware Support
Message Oriented Middleware Configuration
JDBC Drivers and Database Servers Support
Business Transaction Error Detection
NoSQL/Data Grids/Cache Servers Support
NoSQL/Data Grids/Cache Servers Configuration
Java Frameworks Support
Java Frameworks Configuration
RPC/Web Services API Support
RPC/Web Services API Framework Configuration
Supported Platform Matrix for the Java Agent

This page documents known environments in which the Java Agent has been used to instrument
applications. The Java Agent can target specific Java bytecode. This provides wide-ranging
flexibility, so if an environment is not listed here, this does not preclude the Java Agent from being
able to extract valuable performance metrics. Contact AppDynamics Support or Sales for
additional details.
Notes:
A dash ("-") in a table cell indicates that this column is not relevant or not supported for that
particular environment.
In cases where no version is provided, assume that all versions are supported. Contact
AppDynamics Support or Sales for confirmation.
For environments that require additional configuration, a separate table describing or linking
to configuration information follows the support matrix.
For environments supported by AppDynamics End User Monitoring, see Supported
Environments and Versions - Web EUM.
JVM Support

These are the known JVM environments in which the Java Agent has been used to instrument
applications.
Vendor

Implem
entation

Version

Operati
ng
System

Object
Instance
Trackin
g

Automat
ic Leak
Detectio
n

Custom Memory Structures

Content
Inspecti
on
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Oracle

Java
HotSpot

7
Update
45+

Solaris
Sparc
64,
Window
s, Linux

-

-

-

-

-

Oracle

Java SE
(Standa
rd
Edition)
New in
3.9

8

Solaris
Sparc
64,
Window
s, Linux

Yes

Yes

Yes

Yes

Yes

BEA

JRockit

1.5

-

-

Yes

Yes

Yes

Yes

BEA

JRockit

1.6, 1.7

-

-

Yes

Yes

-

-

Oracle

JRockit
JVM

28.1+

Linux
Intel 64
Window
s

-

-

-

-

-

IBM

JVM

1.5.x,
1.6.x,
1.7.x

-

-

-

-

-

-

SUN

JVM

1.5, 1.6,
1.7

-

Yes

Yes

Yes

Yes

-

Open
Source

OpenJD
K

1.6

Linux,
window
s,
everywh
ere

-

Yes

-

-

-

HP

OpenV
MS

-

-

-

-

-

-

-

Notes:
Both JDKs and JREs Supported
Object instance tracking, automatic leak detection, and custom memory structure monitoring
are not supported with the IBM Java Agent on an IBM JVM. As a workaround, to get
automatic leak detection and custom memory structure monitoring, you can use the Java
agent for Sun and JRockit JVM on the IBM JVM. However, doing so will likely result in a
negative performance impact. In either case, object instance tracking is not supported on
IBM JVM's.
All JVMs must be restarted after enabling the Automatic Leak Detection feature.
For examples of instrumenting new language constructs in Java SE 8, see Instrumenting
New Constructs Available in Java 8.
JVM Language Frameworks Support
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No additional configuration is required for these frameworks.
Vendor

JVM
Language
Framework

Version

Correlation/
Entry
Points

Exit Points

Transports

Notes

Open
Source /
Typesafe
Reactive Pl
atform

Akka Actor

2.1 - 2.3

Yes

Yes

Netty

Remoting
exit/entry
supported.
Persistenc
e
(experimen
tal module
in v2.3) is
not
currently
supported.

Open
Source

Groovy

-

Yes

Yes

Open
Source /
Typesafe
Reactive
Platform

Play for
Scala

2.1 - 2.3

Yes

-

HTTP over
Netty

Includes
framework
specific
entry points

Open
Source /
Typesafe
Reactive
Platform

Spray.io

-

No

No

No

Currently
not
supported

Pivotal

Grails

-

-

-

-

The Typesafe Reactive Platform is a JVM-based runtime and collection of tools used to build reacti
ve applications. This includes Scala, Play, Akka, and Spray.io.
Application Servers

These are the known application server environments in which the Java Agent has been used to
instrument applications. Some require additional configuration. Click the link on the server or OSGi
Runtime name in the following support matrix for information about additional configuration
required or related configuration topics. Application servers are usually found by the Java Agent as
an entry point.
Vendor

Applicatio
n Server /
OSGi
Runtime

Version

SOA
Protocol

RMI
Supported

JMX

Entry
Points

Apache

Felix

-

-

-

-

Yes
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Apache

Sling

-

-

-

-

Apache

Tomcat

5.x, 6.x,7.x

-

-

Yes

Apache

Resin

1.x - 4.x

-

-

-

-

Adobe

Cold
Fusion

8.x, 9.x

-

No

-

Yes

Equinox

-

-

-

-

Yes

Eclipse

Jetty

6.x, 7.x

-

-

-

-

IBM

InfoSphere

8.x

-

-

-

Yes

IBM

WebSpher
e

6.1

JAX-WS

-

-

Yes

IBM

WebSpher
e

7.x

JAX-WS

Yes, detect
and
correlate

Yes for
WebSpher
e PMI

Yes

IBM

WebSpher
e

8.x

JAX-WS

Yes, detect
and
correlate

-

Yes

Open
Source

Liferay
Portal

-

-

-

-

-

GlassFish
Enterprise
Server

2.x

-

-

Yes

Yes

Oracle

GlassFish
Server and
GlassFish
Server
Open
Source
Edition

3.1+

-

-

Yes for
AMX

Yes

Oracle and
BEA

WebLogic
Server

9.x+

JAX-WS

Yes, detect
and
correlate
for 10.x

Yes

Yes

Application
Server
(OC4J)

-

-

Yes, detect
and
correlate
for 10.x

-

Yes
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-

Grails, with
Tomcat
7.x,
Glassfish
v3,
Weblogic
12.1.1
(12c)

-

-

-

-

-

JBoss
Server

7+

-

-

-

Yes

-

JBoss
Server

4.x, 5.x

-

Yes, detect
and
correlate

-

Yes

JBoss AS

6.x, 7.x
standalone
)

JBoss EAP

6.11, 6.2.0

Application Server Configuration

For application server environments that require additional configuration, this section provides
some information and links to topics that help you configure the environment. Environments in the
Application Server Support table that require additional configuration, link to the configuration table
below.
Application Server

Topics for Required and Optional
Configuration

Apache Felix

To configure Apache Felix for Glassfish
To configure Felix for Jira or Confluence
See also Unable to get metrics from the
Java App Server Agent on GlassFish

Apache Sling

OSGi Infrastructure Configuration#To
configure Apache Sling

Apache Tomcat

Apache Tomcat Startup Settings
Tomcat as a Windows Service
Configuration

Apache Resin

Resin Startup Settings

Apache Cold Fusion

Configuration is required for transaction
discovery, see
Servlet Entry Points

Copyright © AppDynamics 2012-2014

Page 1065

Equinox

To configure Eclipse Equinox

Eclipse Jetty

Jetty Startup Settings

IBM InfoSphere

IBM WebSphere and InfoSphere Startup
Settings

IBM WebSphere

IBM WebSphere and InfoSphere Startup
Settings

Sun GlassFish Enterprise Server

GlassFish JDBC connection pools can be
manually configured using MBean attributes
and custom JMX metrics
GlassFish Startup Settings
Modify GlassFish JVM Options

Oracle GlassFish Server

including GlassFish Server Open Source
Edition
GlassFish Startup Settings
Modify GlassFish JVM Options

Oracle and BEA WebLogic Server

Oracle WebLogic Startup Settings

JBoss Server

JBoss and Wildfly Startup Settings

Message Oriented Middleware Support

These are the known message oriented middleware environments in which the Java Agent has
been used to instrument applications. Some require additional configuration. Click the link on the
messaging server name in the following support matrix for information about additional
configuration required or related configuration topics. Message oriented middleware servers are
usually found by the Java Agent as an entry point.
Vendor

Messaging
Server

Version

Protocol

Correlatio
n/Entry
Points

Exit Points

JMX

Apache

ActiveMQ

5.x+

JMS 1.x

Yes

Yes

Yes

Apache

ActiveMQ

5.x+

STOMP

No

-

Yes

Apache

ActiveMQ

5.8.x+

AMQP 1.0

No

-

Yes

Apache

ActiveMQ

5.x+

SOAP

Yes

-

Yes

Apache

Axis

1.x, 2.x

JAX-WS

Yes

Yes

-

Apache

Apache
CXF

2.1

JAX-WS

Yes

Yes

-

Apache

Synapse

2.1

HTTP

Yes

Yes

-
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Fiorano

Fiorano
MQ

-

-

-

-

IBM

IBM MQ

6.x, 7.x

-

-

-

-

IBM

IBM Web
Application
Server (WA
S)

6.1+, 7.x

Embedded
JMS

-

Yes

-

IBM

IBM
WebSpher
e MQ

-

JMS

Yes

Yes

-

JBoss MQ

4.x

-

-

-

Yes

JBoss

JBoss
Messaging

5.x

-

-

-

Yes

JBoss

HornetQ

-

-

-

-

Yes

Open MQ

-

-

-

-

-

Mulesoft

Mule ESB

3.4

HTTP

Yes

Yes

-

Oracle

Jave
Message
Service
New in 3.9

2.0

JMS

correlation
of the
listener
is disabled
by default

Yes

Oracle

Oracle AQ

-

JMS

-

Yes

-

Oracle /
BEA

WebLogic

9.x+

JMS 1.1

Yes

Yes

Yes

Progress

SonicMQ

-

-

-

-

-

Pivotal

RabbitMQ

-

HTTP

-

Yes

-

Rabbit

RabbitMQ
Spring
Client

-

-

Yes

Yes

-

Spring

Spring
Integration

2.2.0

JMS

Yes

Yes

Yes

Message Oriented Middleware Configuration

For message oriented middleware environments that require additional configuration, this section
provides some information and links to topics that help you configure the environment.
Environments in the Message Oriented Middleware Support table that require additional
configuration, link to the configuration table below.
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Messaging Server

Topics for Required and Optional
Configuration

Apache ActiveMQ

JMS Message Queue Exit Points

Apache Axis

Default exclude rules exist for Apache Axis,
Axis2, and Axis Admin Servlets. See also,
Web Service Entry Points

Apache Synapse

To enable correlation, set node property en
able-soap-header-correlation=true.

IBM MQ

No additional configuration is required.
See also, Default Backends Discovered by the
App Agent for Java

IBM Web Application Server

No additional configuration is required. See
also,
JMS Message Queue Exit Points

IBM WebSphere MQ

IBM Websphere MQ Message Queue Exit
Points

Mule ESB

Mule ESB Startup Settings
Mule ESB Support
See also HTTP Exit Points for Java

BEA WebLogic

Oracle WebLogic Startup Settings

Pivotal RabbitMQ

No additional configuration is required. See
also,
Default Backends Discovered by the App
Agent for Java and
RabbitMQ Message Queue Exit Points

RabbitMQ Spring Client

No addition configuration is required, See also,
Message Queue Exit Points for Java

Spring Integration

Spring Integration Support
See also, JMS Message Queue Exit Points

JDBC Drivers and Database Servers Support

These are the known JDBC driver and database server environments in which the Java Agent has
been used to instrument applications. AppDynamics can follow transactions using these drivers to
the designated database.
JDBC Vendor

Driver Version
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Apache

10.9.1.0

Embedded or
client

Derby

-

Apache

-

-

Cassandra

-

Progress

DataDirect

data connectivity
for ODBC and
JBDC driver
access, data
integration, and
SaaS and cloud
computing
solutions

-

-

IBM

JDBC 3.0
version 3.57.82
or JDBC 4.0
version 4.7.85

DB2 Universal
JDBC driver

DB2

9.x

IBM

JDBC 3.0
version 3.66.46
or JDBC 4.0
version 4.16.53

DB2 Universal
JDBC driver

DB2

10.1

IBM

-

Type IV

Informix

-

Microsoft

4

Type II

MS SQL Server

2012*

Oracle MySQL,
MySQL
Community

5.x

Type II, Type IV

MySQL

5.x

Open Source

Connector/J
5.1.27

Type IV

MySQL

5.x

Open Source

-

Type IV

Postgres

8.x, 9.x

Oracle

9.x

Type II, Type IV

Oracle Database

8i+

Sybase

jConnect

Type IV

Sybase

-

Teradata

-

Teradata
New in 3.9
Notes:

Type II is a C or OCI driver
Type IV is a thin database client and is a pure Java driver
Business Transaction Error Detection

The Java Agent supports the following logging frameworks for business transaction error
detection:
Log4j
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java.util.logging
If you are using a different logger, see Configuring Error Detection Using Custom Loggers.
NoSQL/Data Grids/Cache Servers Support

These are the known NoSQL, data grids and cache server environments in which the Java
Agent has been used to instrument applications. Some require additional configuration. Click the
link on the database, data grid or cache name in the following support matrix for information about
additional configuration required or related configuration topics.
Vendor

Database/Data
Grid/Cache

Version

Correlation/Entry
Points

JMX

Apache

Casandra (Data
Stax, REST) and
Cassandra
CQL3

1.x

Correlation

Yes

Apache

Apache Lucene Apache Solr

1.4.1

Entry Points

Yes

JBoss

JBoss Cache
TreeCache

-

-

-

Terracotta

EhCache

-

-

-

Open Source

Memcached

-

-

-

Open Source

MongoDB

-

-

-

Oracle

Coherence

3.7.1

Custom-Exit

Yes

JBoss

Infinispan

5.3.0+

Correlation

-

NoSQL/Data Grids/Cache Servers Configuration

For NoSQL, data grids, and cache server environments that require additional configuration, this
section provides some information and links to topics that help you configure the environment.
Environments in the NoSQL/Data Grids/Cache Servers Support table that require additional
configuration, link to the configuration table below.
Database/Data Grid/Cache

Topics for Required or Optional
Configuration

Apache Cassandra (DataStax, REST) and
Cassandra CQL3

Cassandra Exit Points for Java
Apache Cassandra Startup Settings
Default Backends Discovered by the App
Agent for Java

Apache Lucene - Apache Solr

Solr Startup Settings

JBoss

JBoss Startup Settings

Terracotta EhCache

EhCache Exit Points
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Open Source Memcached

Memcached Exit Points

Open Source MongoDB

Configurations for Custom Exit Points for
Java

Oracle Coherence

Coherence Startup Settings

Java Frameworks

Support

These are the known Java framework environments in which the Java Agent has been used to
instrument applications. Some require additional configuration. Click the link on the Java
framework name in the following support matrix for information about additional configuration
required or related configuration topics.
Vendor

Framewo
rk

Version

SOA
protocol
(WebSer
vices)

Auto
Naming

Entry
Points

Adobe

BlazeDS

-

HTTP
and JMS
adaptor

-

Yes

Adobe

ColdFusi
on

8.x, 9.x

-

-

Yes

-

Configura
tion
required
for
transactio
n
discovery

Apache

Cassandr
a with
Thrift fra
mework

-

-

-

Yes

Yes

Apache
Thrift
Entry and
Exit
points are
detected

Apache

Struts

1.x, 2.x

-

-

Yes
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Apache

Tapestry

5

-

-

Yes

-

Not by
default

Wicket

-

-

No

Yes

-

Not by
default

WebObje
cts

5.4.3

HTTP

Yes

Yes

-

Yes

CometD

2.6

HTTP

Yes

Yes

-

-

Eclipse

RCP
(Rich
Client
Platform)

-

-

-

-

-

-

Google

Google
Web
Toolkit
(GWT)

2.5.1

HTTP

Yes

Yes

-

-

JBoss

JBossWS
Native
Stack

4.x, 5.x

Native
Stack

-

-

-

-

Open
Source

Direct
Web
Remoting
(DWR)

-

-

-

-

-

-

Open
Source

Enterpris
e Java
Beans (E
JB)

2.x, 3.x

-

-

Yes

-

-

Open
Source

Grails

-

-

-

Yes

-

Not by
default

Open
Source

Hibernate
JMS Liste
ners

1.x

-

-

-

-

-

Open
Source

Java
Abstract
Windowin
g Toolkit
(AWT)

-

-

-

-

-

-

Open
Source

Java
Server
Faces (J
SF)

1.x

-

Yes

Yes

-

Not by
default

Apple
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Open
Source

Java
Server
Pages

2.x

-

Yes

-

-

Yes

Open
Source

Java
Servlet
API

2.x

-

-

-

-

-

Open
Source

Jersey

1.x, 2.x

REST,
JAX-RS

Yes

Yes

No

Not by
default

Open
Source

WebSock
et

1.0 (Java
EE 7,
JSR-356)

-

Yes,
BT
Naming
not
configura
ble

Yes,
correlatio
n
not
supporte
d

Yes

Detection
is
automatic

Open
Source Google

AngularJ
S

-

-

-

Yes

-

-

Oracle

Coherenc
e with
Spring
Beans

2.x, 3.x

-

-

-

-

-

Oracle

Swing
(GUI)

-

-

-

-

-

-

Oracle

WebCent
er

10.0.2,10
.3.0

-

-

-

-

-

Open
Source

JRuby
HTTP

-

-

-

Yes

-

Not by
default

Spring

Spring
MVC

-

-

-

Yes

-

Not by
default

Java Frameworks Configuration

For the Java framework environments that require additional configuration, this section provides
some information and links to topics that help you configure the environment. Environments in the
Java Frameworks Support table that require additional configuration, link to the configuration table
below.
Java Framework
Adobe BlazeDS
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Adobe ColdFusion

Configuration is required for transaction
discovery
Java Web Application Entry Points
Servlet Entry Points

Apache Cassandra with Thrift framework

No additional configuration is required. See
also,
Default Backends Discovered by the App
Agent for Java

Apache Struts

Struts Entry Points

Apache Tapestry

Java Web Application Entry Points
Servlet Entry Points

Wicket

Java Web Application Entry Points
Servlet Entry Points

Apple WebObjects

Business transaction naming can be
configured via getter-chains, see
Getter Chains in Java Configurations
Identify Transactions Based on POJO
Method Invoked by a Servlet

CometD

See also, HTTP Exit Points for Java

Open Source Enterprise Java Beans (EJB)

EJB Entry Points

Open Source Hibernate JMS Listeners

No additional configuration is required. See
also,
Advanced Options in Call Graphs

Open Source Java Server Faces (JSF)

Java Web Application Entry Points and Ser
vlet Entry Points

Open Source Java Server Pages

Servlet Entry Points

Open Source Jersey

JAX-RS Support and node properties:
rest-num-segments
rest-transaction
rest-uri-segment-scheme

Open Source JRuby HTTP

Java Web Application Entry Points
Servlet Entry Points

Open Source WebSocket
Spring MVC
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RPC/Web Services API Support

These are the known Java framework environments in which the Java Agent has been used to
instrument applications. Some require additional configuration. Click the link on the RPC, web
services or API framework name in the following support matrix for information about additional
configuration required or related configuration topics.
Vendor

RPC/W
eb
Service
s API
Framew
ork

Version

SOA
Protocol
WebSer
vices

Auto
Naming

Correlati
on/Entry
Points

Exit
Points

Configur
able BT
Naming
Properti
es

Detectio
n

Apache

Apache
CXF

2.1

JAX-WS

Yes

Yes

Yes

Yes

Yes

Apache

Apache
Commo
ns

-

HTTP
Client

Yes

Yes

Yes

-

Yes

Apache

Apache
Thrift

-

-

Yes

Yes

Yes

Yes

Yes

IBM

WebSp
here

6.x

JAX-RP
C

-

-

-

-

-

IBM

WebSp
here

7.x, 8.x

JAX-RP
C

-

-

-

-

-

IBM

Websph
ere

7.x, 8.x

IIOP

-

-

-

-

-

JBoss

JBoss

4.x, 5.x

RMI

Yes

Yes

Yes

Yes

Yes

Open
Source

java.net.
Http

-

HTTP

Yes

-

Yes

Yes

Yes

Oracle

GlassFi
sh
Metro

-

JAX-WS

-

-

-

-

-

Oracle

GlassFi
sh
Metro
with
Grails

-

JAX-WS

-

Yes

-

-

Not by
Default

Oracle

Oracle
Applicati
on
Server

ORMI

-

no

-

-

-

-
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Oracle

WebLog
ic

10.x

T3, IIOP

Yes

Correlati
on: Yes,
Entry:
No

Yes

-

Yes

Oracle

WebLog
ic

9.x, 10.x

JAX-RP
C

-

-

-

-

-

Sun

Sun
RMI

-

IIOP

-

Not by
Default

-

-

-

Sun

Sun
RMI

-

JRMP

-

By
Default

Yes

host/por
t

Yes

-

Web
Service
s

-

SOAP
over
HTTP

-

Yes

Yes

-

-

RPC/Web Services API Framework Configuration

For the RPC and web service API environment that require additional configuration, this section
provides some information and links to topics that help you configure the environment.
Environments in the RPC/Web Services API Framework Support table that require additional
configuration, link to the configuration table below.
RPC/Web Services API

Topics for Required or Optional
Configuration

Apache Commons

HTTP Exit Points for Java

Apache Thrift

Binary Remoting Entry Points for Apache
Thrift
Default Backends Discovered by the App
Agent for Java

IBM WebSphere

IBM WebSphere and InfoSphere Startup
Settings,
App Agent for Java on z-OS or Mainframe
Environments Configuration See also,
Unable to browse MBeans on
WebSphere Application Server,
Default configuration excludes
WebSphere classes

JBoss

JBoss and Wildfly Startup Settings

Open Source java.net.Http

HTTP Exit Points for Java

Oracle WebLogic

Oracle WebLogic Startup Settings
Default configuration excludes WebLogic
classes
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Web Services

Create Match Rules for Web Services
Web Service Entry Points
Web Services Exit Points for Java

Install the Java Agent
Overview of the Java Agent Installation Process
Planning for Java Agent Installation
Important Files
To Install the Java Agent
1. Download and unzip the Java Agent
2. Add the Java Agent properties as a 'javaagent' argument to your JVM
3. Configure how the Java Agent connects to the Controller
4. (Only for Multi-tenant mode or SaaS Installations) Configure Java
Agent account information
5. Configure how the Java Agent identifies the AppDynamics business
application, tier, and node
Automatic Naming for Application, Tier, and Node
Additional Installation Scenarios
6. Verify Java Agent configuration
7. Verify successful installation and reporting
a. Verify Java Agent installation
b. Verify that the Java Agent is reporting to the Controller
Example Configuration: Java Agent Deployment on a Single JVM
Learn More
The Java Agent identifies and tracks business transactions, captures statistics and diagnostic
data, and analyzes and reports data to the Controller. The Java Agent uses dynamic bytecode
injection to instrument a JVM and it runs as a part of the JVM process.
Caution: The Java Agent may fail if there are other Application Performance Management (APM)
products installed in the same JVM. They can coexist as long as the other APM does not interfere
with the Java Agent class transformations. We discourage the simultaneous use of other Byte
Code Injection (BCI) agents.
Overview of the Java Agent Installation Process

Installing the Java Agent involves adding it as a javaagent (Java Programming Language Agent)
on your JVM and setting up connection and identifying parameters for it to report data to the
Controller.
Install the Java Agent as the same user or administrator of the JVM. Otherwise the Java
Agent may not have the correct write permissions for the system. The Java Agent directories must
have write permission so that AppDynamics can update the logs and other Java Agent files.
Planning for Java Agent Installation

Before installing the Java Agent, be prepared with the following information.
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Planning Item

Description

Where is the startup script for
the JVM?
If using a Java service
wrapper, you need to know
the location of the wrapper
configuration.

This is where you can add
startup arguments
in the script file and system
properties, if needed.

What host and port is the
Controller running on?

For SaaS customers,
AppDynamics provides this
information to you. For
on-premise Controllers, this
information is configured
during Controller installation.
See (Install the Controller on
Linux or Install the Controller
on Windows).

To what AppDynamics
business application does this
JVM belong?

Usually, all JVMs in your
distributed application
infrastructure belong to the
same AppDynamics business
application. You assign a
name to the business
application. For details see Lo
gical Model.

To what AppDynamics tier
does this JVM belong?

You assign a name to the tier.
For details see Logical Model.

Important Files

In addition to the JVM startup script file, two other files are important during installation:
The -javaagent argument uses the fully-qualified path of the javaagent.jar file. No separate
classpath arguments need to be added.
The <agent_home>/conf/controller-info.xml file is where you add the configuration
mentioned in the planning list.
To Install the Java Agent
1. Download and unzip the Java Agent

Download the Java Agent ZIP file from AppDynamics Download Center.
Extract the ZIP file to the destination directory as the same user or administrator of the JVM.
Take note of the following:
Extract the Java Agent to a directory that is outside of your container
All files should be readable by the Java Agent
Runtime directory should be writable by the Java Agent
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Note: Do not unzip/install the Java Agent into to the ..\tomcat\webapps directory. By default
Tomcat tries to undeploy and deploy files under the webapps folder. To avoid the possibility that
Tomcat will occasionally not restart, we recommend installing the Java Agent to a directory outside
of tomcat, such as \usr\local\agentsetup\AppServerAgent.
2. Add the Java Agent properties as a 'javaagent' argument to your JVM

This step adds the Java Agent to the startup script of your application server. Use the
server-specific instructions below to add this argument for different application server JVMs:
3. Configure how the Java Agent connects to the Controller

Configure properties for the Controller host name and its port number.
You can configure these two properties using either the controller-info.xml file or the JVM
startup script:
Configure using
controller-info.xml

Configure using
System Properties

Required

Default

<controller-host>

-Dappdynamics.contr
oller.hostName

Yes

None

<controller-port>

-Dappdynamics.contr
oller.port

Yes

For On-premise
Controller
installations: By
default, port 8090 is
used for HTTP and
8181 is used for
HTTPS
communication.
For SaaS Controller
service: By default,
port 80 is used for
HTTP and 443 is
used for HTTPS
communication.

Optional settings for Java Agent-to-Controller communication
To configure the Java Agent to use SSL, see App Agent for Java Configuration Properties
and Enable SSL (Java).
To configure the Java Agent to use proxy settings see App Agent for Java Configuration
Properties
4. (Only for Multi-tenant mode or SaaS Installations) Configure Java Agent account information

This step is required only when the AppDynamics Controller is configured in Controller
Tenant Mode or when you Use a SaaS Controller.
Skip this step if you are using single-tenant mode, which is the default in an on-premise
installation.
Specify the properties for Account Name and Account Key. This information is provided in
the Welcome email from the AppDynamics Support Team. You can also find this information
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in the <controller-install>/initial_account_access_info.txt file.
Configure using
controller-info.xml

Configure using
System Properties

Required

Default

<account-name>

-Dappdynamics.agent
.accountName

Required only if your
Controller is
configured for multi-te
nant mode or
your controller is
hosted.

None.

<account-access-key
>

-Dappdynamics.agent
.accountAccessKey

Required only if your
Controller is
configured for multi-te
nant mode or
your controller is
hosted.

None.

5. Configure how the Java Agent identifies the AppDynamics business application, tier, and node

When configuring an Java Agent, you identify the business application, tier, and node it belongs to
in the AppDynamics application model. See
Logical Model and Name Business Applications, Tiers, and Nodes for more information on this
model.
You can configure these properties using either the controller-info.xml file or JVM startup script
options. Use these guidelines when configuring agents:
Configure items that are common for all the nodes in the controller-info.xml file.
Configure information that is unique to a node in the startup script.
Configure using
controller-info.xml

Configure using
System Properties

Required

Default

<application-name>

-Dappdynamics.agent
.applicationName

Yes, unless you use
automatic naming

None

<tier-name>

-Dappdynamics.agent
.tierName

Yes, unless you use
automatic naming

None

<node-name>

-Dappdynamics.agent
.nodeName

Yes, unless you use
automatic naming

None

Automatic Naming for Application, Tier, and Node

The Java Agent javaagent command accepts an argument named uniqueID that AppDynamics
uses to automatically name the node and tier for this Java Agent. For example, using this
command argument AppDynamics will name the node and tier "my-app-jvm1":
-javaagent:<agent_home>/javaagent.jar=uniqueID=<my-app-jvm1>
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When uniqueID is used and the application name is not provided either through the system
property or in the controller-info.xml, AppDynamics creates a new business application called
"MyApp".
The naming mechanism is used by the Java Agent Download Wizard process. See Quick Install.
Additional Installation Scenarios

Refer to the links below for typical installation scenarios, especially for cases where there are
multiple JVMs on the same machine:
Configure App Agent for Java on Multiple JVMs on the Same Machine that Serves the Same
Tier
Configure App Agent for Java on Multiple JVMs on the Same Machine that Serve Different
Tiers
Configure App Agent for Java to Use Existing System Properties
App Agent for Java on z-OS or Mainframe Environments Configuration
Configure App Agent for Java for Batch Processes
Add the Agent into an Embedded JVM
6. Verify Java Agent configuration

Ensure that you have added -javaagent argument in your JVM startup script. This is not a -D
system property but a different standard argument for all JVMs v1.5 and higher.
Ensure that you have added all mandatory items either in the Java Agent controller-info.xml
file or in the JVM startup script file.
The user running the JVM process/application server process is the user accessing the Java
Agent installation.
7. Verify successful installation and reporting
a. Verify Java Agent installation

After a successful install, your Java Agent logs, located at <agent_home>/logs, should contain
following message:
Started AppDynamics Java Agent Successfully

If the agent log file is not present, the Java Agent may not be accessing the javaagent
command properties. The application server log file where STDOUT is logged will have the
fallback log messages, for further troubleshooting.
b. Verify that the Java Agent is reporting to the Controller

Use the AppDynamics UI, to verify that the Java Agent is able to connect to the Controller:
Point your browser to: http://<controller-host>:<controller-port>/controller
Provide the admin credentials to log into the AppDynamics UI.
Select the application. In the left navigation pane, click Servers -> App Servers -> <tier> ->
<node>. Click the Agents tab and App Server Agent subtab. An agent successfully reporting
to the Controller will be listed and the Reporting property shows an "up" arrow symbol. For
more details see Verify App Agent-Controller Communication.
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When deploying multiple agents for the same tier, see if you get the exact number of nodes
reporting in the same tier.
Example Configuration: Java Agent Deployment on a Single JVM

The following example shows a sample deployment of the Java Agent for the ACME Bookstore.
Add the javaagent argument to the start-up script of the JVM:
java -javaagent:<install_dir_for_agent>/javaagent.jar

Define the five mandatory items for agent configuration in the Java Agent controller-info.xml
file:
<controller-info>
<controller-host>192.168.1.20</controller-host>
<controller-port>8090</controller-port>
<application-name>ACMEOnline</application-name>
<tier-name>InventoryTier</tier-name>
<node-name>Inventory1</node-name>
</controller-info>

Learn More

App Agent for Java Configuration Properties
Uninstall the Java Agent
Logical Model
Multi-Agent Deployment for Java
Deployment Procedure
To Deploy Java Agents
Sample Deployment Solutions
Learn More
This topic describes the high-level procedures for deploying multiple Java Agent on Java
platforms.
Deployment Procedure
To Deploy Java Agents

1.
2.
3.
4.

Download the latest agent from http://download.appdynamics.com/.
Unzip the downloaded agent file on the destination machine in the desired agent directories.
Modify the app-agent-config.xml file with any custom settings for the node, tier or app.
Set the application name, tier name, node name, Controller host and Controller port
properties for the agent by doing one of the following for each application server:
Configure the settings in the <Agent_Installation_Directory>/conf/controller-info.xml
file.
Pass the settings as startup properties at the command line or in the application
server startup script as -D arguments. See App Agent for Java Configuration
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Properties for more information.
5. Restart the application servers to make the changes take effect.
See Install the Java Agent for detailed instructions on installing the app agent Java Agent.
Sample Deployment Solutions

You can download some sample solutions that our customers have created to perform multi-agent
AppDynamics rollouts.
Use these samples for ideas on how to automate AppDynamics agent deployment for your
environment. All of these samples deploy the agents independently of the application deployment.
ChefExample1 and ChefExample2 use Opscode Chef recipes to automate deployment on
Java platforms. See http://www.opscode.com/chef/ for information about Chef.
JavaExample1 uses a script, configuration file and package repository.
Click below to download the samples.
ChefExample1.tar
ChefExample2.tar
JavaExample1.tar
Learn More

https://github.com/edmunds/cookbook-appdynamics
Deploy the Standalone Machine Agent
Java Server-Specific Installation Settings
If you are a Self-Service Trial user, add the Java Agent javaagent argument to your JVM start
script where <my-app-jvm1> is the name you use for the application running on that JVM.
-javaagent:<agent_home>/javaagent.jar=uniqueID=<my-app-jvm1>

See Name Business Applications, Tiers, and Nodes.
Apache Cassandra Startup Settings

To add the javaagent command in a Windows environment
To add the javaagent command in a Linux environment
The Java Agent bootstraps using the javaagent command line option. Add this option to the
cassandra (Linux) or cassandra.bat (Windows) file.
To add the javaagent command in a Windows environment

1. Open the apache-cassandra-x.x.x\bin\cassandra.bat file.
2. Add the Java Agent javaagent path to the JAVA_OPTS variable. Make sure to include the drive
in the full path to the Java Agent directory.
-javaagent:<agent_home>\javaagent.jar

Copyright © AppDynamics 2012-2014

Page 1083

For example:
set JAVA_OPTS=-ea
-javaagent:C:\appdynamics\agent\javaagent.jar
-javaagent:"%CASSANDRA_HOME%\lib\jamm-0.2.5.jar
. . .
. . .

If you are a Self-Service Trial user, add the Java Agent javaagent argument to your JVM start
script where <my-app-jvm1> is the name you use for the application running on that JVM.
-javaagent:<agent_home>\javaagent.jar=uniqueID=<my-app-jvm1>

3. Restart the Cassandra server. The Cassandra server must be restarted for the changes to take
effect.
To add the javaagent command in a Linux environment

1. Open the apache-cassandra-x.x.x/bin/cassandra.in.sh file.
2. Add the javaagent argument at the top of the file:
JVM_OPTS=-javaagent:<agent_home>/javaagent.jar

For example:
JVM_OPTS=-javaagent:/home/software/appdynamics/agent/javaagent.jar

If you are a Self-Service Trial user, add the Java Agent javaagent argument to your JVM start
script where <my-app-jvm1> is the name you use for the application running on that JVM.
-javaagent:<agent_home>/javaagent.jar=uniqueID=<my-app-jvm1>

3. Restart the Cassandra server for the changes to take effect.
Apache Tomcat Startup Settings

To add the javaagent command in a Windows environment
To add the javaagent command in a Linux environment
The Java Agent bootstraps using the javaagent command line option. Add this option to your
Tomcat catalina.sh or catalina.bat file.
If you are using Tomcat as a Windows service, see Tomcat as a Windows Service Configuration.
To add the javaagent command in a Windows environment

1.
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1. Open the catalina.bat file, located at <apache_version_tomcat_install_dir>\bin.
2. Add the following command to set the environment for Catalina anywhere in the file before the
command execution portion of the script.
set CATALINA_OPTS=%CATALINA_OPTS%
-javaagent:"Drive:<agent_home>\javaagent.jar"

If you are a Self-Service Trial user, add the App Agent for Java javaagent argument to
your JVM start script where <my-app-jvm1> is the name you use for the application running
on that JVM.
-javaagent:"Drive:<agent_home>\javaagent.jar=uniqueID=<my-app-jvm1>"

The javaagent argument references the full path to the Java Agent installation directory,
including the drive.
For details, see the following screen captures.
Sample Tomcat 5.x catalina.bat file

Sample Tomcat 6.x catalina.bat file
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Sample Tomcat 7.x catalina.bat file

3. Restart the application server. The application server must be restarted for the changes to
take effect.
To add the javaagent command in a Linux environment

1. Open the catalina.sh file located at <apache_version_tomcat_install_dir>/bin.
2. Add the following command to set the Catalina environment variables anywhere in the file
before the command execution portion of the script.
export CATALINA_OPTS="$CATALINA_OPTS
-javaagent:agent_install_dir/javaagent.jar"
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The javaagent argument references the full path to the Java Agent installation directory.
If you are a Self-Service Trial user, add the Java Agent javaagent argument to your JVM
start script where <my-app-jvm1> is the name you use for the application running on that
JVM.
-javaagent:<agent_home>/javaagent.jar=uniqueID=<my-app-jvm1>

For details see the screen captures.
Sample Tomcat 5.x catalina.sh file

Sample Tomcat 6.x catalina.sh file
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Sample Tomcat 7.x catalina.sh file

3. Restart the application server. The application server must be restarted for the changes to
take effect.
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Tomcat as a Windows Service Configuration

To install the javaagent as a Tomcat Windows service
The Java Agent bootstraps using the javaagent command line option. Add this option to
your Tomcat properties.
If you are not running Tomcat as a Windows service, see Apache Tomcat Startup Settings.
To install the javaagent as a Tomcat Windows service
These instructions apply to Apache Tomcat 6.x or later versions.
1. Ensure that you are using administrator privileges.
2. Click Programs -> Apache Tomcat.
3. Run Configure Tomcat.
4. Click the Java tab.
5. In the Java Options add:
-javaagent:"<agent_home\javaagent.jar"

If you are a Self-Service Trial user, add the Java Agent javaagent argument to your JVM start
script where <my-app-jvm1> is the name you use for the application running on that JVM.
-javaagent:"<agent_home>\javaagent.jar=uniqueID=<my-app-jvm1>"

For details see the following screenshot.
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6. Restart the Tomcat service. The application server must be restarted for the changes to take
effect.
Coherence Startup Settings
To add the javaagent command in a Coherence environment

1. In the cache-server.sh file update the following:

$JAVAEXEC -server -showversion $JAVA_OPTS
-javaagent:<agent_home>/javaagent.jar -cp
"$COHERENCE_HOME/lib/coherence.jar" com.tangosol.net.DefaultCacheServer $1

2. Restart the application server. You must restart the application server for the changes to
take effect.
GlassFish Startup Settings

To add the javaagent command in a GlassFish 3.0 environment
To add the javaagent command in a GlassFish 3.1 environment
To verify the Agent configuration
About Glassfish AMX Support
The Java Agent bootstraps using the javaagent command line option.
To add the javaagent command in a GlassFish 3.0 environment

1. If you are using GlassFish v3.0, first configure the OSGi containers. For details see OSGi
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Infrastructure Configuration.
2. Log into the GlassFish domain where you want to install the Java Agent.
3. In the left navigation tree Common Tasks section, click Application Server. The Application
Server Settings dialog opens.
4. In the JVM Settings tab, click JVM Options.
5. Click Add JVM Option and add an entry for the javaagent argument. The javaagent argument
contains the full path, including the drive, of the Java Agent installation directory.
-javaagent:<drive>:\<agent_home>\javaagent.jar

If you are a Self-Service Trial user, add the Java Agent javaagent argument to your JVM start
script where <my-app-jvm1> is the name you use for the application running on that JVM.
-javaagent:<drive>:\<agent_home>\javaagent.jar=uniqueID=<my-app-jvm1>

Copyright © AppDynamics 2012-2014

Page 1091

6. Restart the application server. The application server must be restarted for the changes to take
effect.
To add the javaagent command in a GlassFish 3.1 environment

1. If you are using GlassFish v3.0, first configure the OSGi containers. For details see OSGi
Infrastructure Configuration.
2. Log into the GlassFish domain where you want to install the Java Agent.
Note: Remember to turn on remote administration by entering the following command from the
<Controller_home>/appserver/glassfish/bin directory:
asadmin enable-secure-admin

3. In the Configurations section in the left navigation tree, click server-config and then click JVM
Settings.
4. On the JVM Settings tab, click JVM Options.
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5. Click Add JVM Option and add an entry for the javaagent argument as follows:
For Windows:
-javaagent:<Drive Letter>:<agent install location>\javaagent.jar

For Linux:
-javaagent:<agent install location>/javaagent.jar

If you are a Self-Service Trial user, add the Java Agent javaagent argument to your JVM start
script where <my-app-jvm1> is the name you use for the application running on that JVM.
-javaagent:<drive>:\<agent_home>\javaagent.jar=uniqueID=<my-app-jvm1>

6. Restart the application server. The application server must be restarted for the changes to take
effect.
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To verify the Agent configuration

To verify this configuration, look at the domain.xml file located at
<glassfish_install_dir>\domains\<domain_name>. The domain.xml file should have an entry as
shown in the following screenshot.
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About Glassfish AMX Support

AppDynamics supports Glassfish AMX MBeans.
Set the boot-amx node property to enable AMX MBeans. See boot-amx.
You will see the AMX domain in the MBean Browser in the JMX tab of the node dashboard.
IBM WebSphere and InfoSphere Startup Settings

To add the javaagent command in a WebSphere 7.x and InfoSphere 8.x environment
To add the javaagent command in a WebSphere 6.x environment
To add the javaagent command in a WebSphere 5.x environment
To verify the Java Agent configuration
Security Requirements
Running WebSphere with Security Enabled
The Java Agent bootstraps using the javaagent command line option.
To add the javaagent command in a WebSphere 7.x and InfoSphere 8.x environment

1. Log in to the Administrator console of the WebSphere node where you want to install the App
Server Agent.
2. In the Administration Console click Servers.
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3. Expand Server Type and click WebSphere application servers.
4. Click the name of your server.
5. Expand Java and Process Management and click Process Definition.
6. Under the Additional Properties section, click Java Virtual Machine.
7. Enter the javaagent option with the full path to the AppDynamics javaagent.jar file in the Generic
JVM arguments field.
For Windows:
-javaagent:<Drive Letter>:<agent install location>\javaagent.jar

For Linux:
-javaagent:<agent install location>/javaagent.jar

If you are a Self-Service Trial user, add the Java Agent javaagent argument to your JVM start
script where <my-app-jvm1> is the name you use for the application running on that JVM.
-javaagent:<drive>:\<agent_home>\javaagent.jar=uniqueID=<my-app-jvm1>

8. Click OK.

May require OSGI bootdelegation
Websphere uses Equinox as its OSGi container. In some cases you may also need to add
the Java agent packages to the OSGi bootdelegation system property as follows:
-Dorg.osgi.framework.bootdelegation=META-INF.services,com.singularity.*,c
om.ibm.*

To add the javaagent command in a WebSphere 6.x environment

1. Log in to the Administrator console of the WebSphere node where you want to install the Java
Agent.
2. In the left navigation tree, click Servers -> Application servers.
3. Click the name of your server in the list of servers.
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4. In the Configuration tab, click Java and Process Management.
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5. Enter the javaagent option with the full path to the Java Agentjavaagent.jar file in the Generic
JVM arguments field.
For Windows:
-javaagent:<Drive Letter>:<agent install location>\javaagent.jar

For Linux:
-javaagent:<agent install location>/javaagent.jar
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If you are a Self-Service Trial user, add the Java Agent javaagent argument to your JVM start
script where <my-app-jvm1> is the name you use for the application running on that JVM.
-javaagent:<drive>:\<agent_home>\javaagent.jar=uniqueID=<my-app-jvm1>

8. Click OK.

To add the javaagent command in a WebSphere 5.x environment

1. Log in to the Administrator console of the WebSphere node where you want to install the App
Server Agent.
2. In the Administrative Console, click Servers.
3. Click Application Servers.
4. Click the name of your server.
5. Under Additional Properties, click Process Definition.
6. On the next page, under Additional Properties, click Java Virtual Machine.
7. Enter the javaagent option with the full path to the Java Agent javaagent.jar file in the Generic
JVM arguments field.
For Windows:
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-javaagent:<Drive Letter>:<agent install location>\javaagent.jar

For Linux:
-javaagent:<agent install location>/javaagent.jar

If you are a Self-Service Trial user, add the Java Agent javaagent argument to your JVM start
script where <my-app-jvm1> is the name you use for the application running on that JVM.
-javaagent:<drive>:\<agent_home>\javaagent.jar=uniqueID=<my-app-jvm1>

8. Click OK.
To verify the Java Agent configuration

Verify the configuration settings by checking the server.xml file of the WebSphere node where you
installed the Java Agent. The server.xml file should have this entry:
<jvmEntries ...&nbsp;
genericJvmArguments='-javaagent:E:\test1\AppServerAgent\javaagent.jar'
disableJIT="false"/>

Security Requirements

Full permissions are required for the agent to function correctly with WebSphere. Grant all
permissions on both the server level and the profile level.
Running WebSphere with Security Enabled

If you want to run WebSphere while J2EE security or Global security is enabled, you need to make
changes to WebSphere's server.policy file to prevent problems within the interaction between
WebSphere and the Java Agent. Make the change listed below to the server.policy file, which is
located in <websphere_home>/properties or in <websphere_profile_home>/properties.
Add the following block to the WebSphere server.policy file:
grant codeBase "file:\* AGENT_DEPLOYMENT_DIRECTORY \*/-"
{
permission java.security.AllPermission;
};

WebSphere in z-OS or Mainframe Environments
See Configure App Agent for Java in z-OS or Mainframe Environments.
JBoss and Wildfly Startup Settings

To add the javaagent command in a Windows environment
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To add the javaagent command in a Linux environment for JBoss 5.x
To add the javaagent command in a Linux environment for JBoss AS 6.x
To add the javaagent command in a Linux environment for JBoss EAP 6.1.1 and JBoss AS
7.0.x (standalone)
To add the javaagent command in a Linux environment for JBoss 7.1.1
To add the javaagent command in a Linux environment for JBoss EAP 6.0.1, JBoss EAP
6.2.0, JBoss AS 7.x
To add the javaagent command to JBoss EAP 6.1.0
To add the javaagent command in a Windows environment for JBoss EAP 6.0.1, JBoss EAP
6.2.0, JBoss AS 7.x
To add the javaagent command to RHEL JBoss EAP 6.x, JBoss AS 7.0.x, Wildfly 8 (Domain
Mode)
Revise the Domain.xml file
Revise the Host.xml file
To add the Java Agent to JBoss 7.2 (standalone)
Fix Linkage Error
The Java Agent bootstraps using the javaagent command line option. Add this option to your
JBoss server run.sh or run.bat file.
To add the javaagent command in a Windows environment

1. Open the server run.bat file, located at <jboss_version_install_directory>\bin.
2. Add the following javaagent argument at the beginning of your app server start script.
set JAVA_OPTS=%JAVA_OPTS% -javaagent:"<drive>:\<agent_home>\javaagent.jar"

If you are a Self-Service Trial user, add the Java Agent javaagent argument to your JVM
start script where <my-app-jvm1> is the name you use for the application running on that
JVM.
-javaagent:"<drive>:\<agent_home>\javaagent.jar=uniqueID=<my-app-jvm1>"

The javaagent argument references the full path of the App Server Agent installation
directory, including the drive. For details see the screen captures.
3. Sample JBoss 4.x run.bat file
a. Sample JBoss 4.x run.bat file:
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b. Sample JBoss 5.x run.bat file
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4. Restart the application server. The application server must be restarted for the changes to
take effect.
To add the javaagent command in a Linux environment for JBoss 5.x

1. Open the server run.sh file, located at <jboss_version_install_dir>/bin.
2. Add the following javaagent argument to the server start script.
export JAVA_OPTS="$JAVA_OPTS -javaagent:/<agent_home>/javaagent.jar"

a. Sample JBoss 5.x run.sh file
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b.

If you are a Self-Service Trial user, add the Java Agent javaagent argument to your
JVM start script where <my-app-jvm1> is the name you use for the application running
on that JVM.
-javaagent:<agent_home>/javaagent.jar=uniqueID=<my-app-jvm1>

3. Restart the application server. You must restart the application server for the changes to
take effect.
To add the javaagent command in a Linux environment for JBoss AS 6.x

Use the following instructions for JBoss 6.x unless your version matches one for which more
specific instructions exist on this page:
1. Open the server run.sh file, located at <jboss_version_install_dir>/bin.
2. Add the following Java environment variables to the server start script.
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2.

JAVA_OPTS="$JAVA_OPTS
-Djava.util.logging.manager=org.jboss.logmanager.LogManager"
JAVA_ARGS="$JAVA_OPTS
-Dorg.jboss.logging.Logger.pluginClass=org.jboss.logging.logmanager.Logger
PluginImpl"
JBOSS_CLASSPATH=<path>"jboss-logmanager.jar"

3. Add the following javaagent argument to the server start script.
export JAVA_OPTS="$JAVA_OPTS -javaagent:/agent_install_dir/javaagent.jar"

4. Restart the application server. You must restart the application server for the changes to
take effect.
To add the javaagent command in a Linux environment for JBoss EAP 6.1.1 and JBoss AS 7.0.x (standalone)

1. Open the bin/standalone.sh file.
2. Add the following and save the file:
JAVA_OPTS="$JAVA_OPTS
-Djava.util.logging.manager=org.jboss.logmanager.LogManager
-Xbootclasspath/p:/<path/to/jboss-eap-6.1.1>/modules/system/layers/base/or
g/jboss/logmanager/main/jboss-logmanager-1.4.3.Final-redhat-1.jar:/<path/t
o/jboss-eap-6.1.1>/modules/system/layers/base/org/jboss/log4j/logmanager/m
ain/log4j-jboss-logmanager-1.0.2.Final-redhat-1.jar"
JAVA_OPTS="$JAVA_OPTS -javaagent:/<path/to/appdynamics>/javaagent.jar"
JAVA_OPTS="$JAVA_OPTS
-Djboss.modules.system.pkgs=org.jboss.byteman,org.jboss.logmanager,com.app
dynamics,com.appdynamics.,com.singularity,com.singularity."

Note: Substitute <path/to/jboss-eap-6.1.1> and <path/to/appdynamics> with the correct
respective paths for your installation.
3. Restart the application server. You must restart the application server for the changes to
take effect.
4. Integrate error detection with the jboss log manager logging implementation using a custom
logger definition as described in Configuring Error Detection Using Custom Loggers.
To add the javaagent command in a Linux environment for JBoss 7.1.1

1. Open the standalone.sh file
2. Search for the following line in standalone.sh.
# Setup the JVM

3. Add the following above that section and save the file.

Copyright © AppDynamics 2012-2014

Page 1105

3.

export JAVA_OPTS="$JAVA_OPTS -javaagent:<agent-path>/javaagent.jar
-Dorg.jboss.boot.log.file=$JBOSS_HOME/standalone/log/boot.log
-Djava.util.logging.manager=org.jboss.logmanager.LogManager"
export JAVA_OPTS="$JAVA_OPTS
-Xbootclasspath/p:$JBOSS_HOME/modules/org/apache/log4j/main/log4j-1.2.16.j
ar:$JBOSS_HOME/modules/org/jboss/logmanager/log4j/main/jboss-logmanager-lo
g4j-1.0.0.GA.jar:$JBOSS_HOME/modules/org/jboss/logmanager/main/jboss-logma
nager-1.2.2.GA.jar
-Dlogging.configuration=file:$JBOSS_HOME/standalone/configuration/logging.
properties"
#export JAVA_OPTS="$JAVA_OPTS
-Xbootclasspath/p:$JBOSS_HOME/modules/org/jboss/logmanager/main/jboss-logm
anager-1.2.2.GA.jar
-Dlogging.configuration=file:$JBOSS_HOME/standalone/configuration/logging.
properties"

Note: Substitute <agent-path> with the correct path for your installation.
4. Open standalone.conf and search for the following.
# Uncomment the following line to prevent manipulation of JVM options

5. Add the following above that section and save the file.
if [ "x$JBOSS_MODULES_SYSTEM_PKGS" = "x" ]; then
JBOSS_MODULES_SYSTEM_PKGS="org.jboss.byteman,com.appdynamics,com.appdynami
cs.,com.singularity,com.singularity.,org.jboss.logmanager"
# JBOSS_MODULES_SYSTEM_PKGS="org.jboss.byteman"
fi

6. Restart the application server. You must restart the application server for the changes to
take effect.
To add the javaagent command in a Linux environment for JBoss EAP 6.0.1, JBoss EAP 6.2.0, JBoss AS 7.x

1. Open the bin/standalone.conf file.
2. Search for the following line in standalone.conf.
JBOSS_MODULES_SYSTEM_PKGS="org.jboss.byteman"

3. Add the com.singularity and org.jboss.logmanager packages to that line as follows:
JBOSS_MODULES_SYSTEM_PKGS="org.jboss.byteman,com.singularity,org.jboss.log
manager"

4. Add the following to the end of the standalone.conf file in the JAVA_OPTS section.
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4.

-Djava.util.logging.manager=org.jboss.logmanager.LogManager
-Xbootclasspath/p:<JBOSS-DIR>/modules/org/jboss/logmanager/main/jboss-logm
anager-1.2.2.GA.jar
:<JBOSS-DIR>/modules/org/jboss/logmanager/log4j/main/jboss-logmanager-log4
j-1.0.0.GA.jar
:<JBOSS-DIR>/modules/org/jboss/logmanager/log4j/main/log4j-1.2.16.jar

Note: The path for the necessary JAR files may differ for different versions. Provide the
correct path of these JAR files for your version. If any of the packages are not available with
the JBoss ZIP, download the missing package and add it to the path.
5. In the standalone.sh file, add the following javaagent argument.
export JAVA_OPTS="$JAVA_OPTS -javaagent:/agent_install_dir/javaagent.jar"

above the following section of standalone.sh
...
while true;do
if [ "x$LAUNCH_JBOSS_IN_BACKGROUND" = "X" ]; then
# Execute the JVM in the foreground
eval \"$JAVA\" -D\"[Standalone]\"$JAVA_OPTS \
\"-Dorg.jboss.boot.log.file=$JBOSS_LOG_DIR/boot.log\" \
\"-Dlogging.configuration=file:$JBOSS_CONFIG_DIR/logging.properties\"
\
-jar \"$JBOSS_HOME/jboss-modules.jar\" \

The revised section of your startup script file should look similar to the following image:

6. Restart the application server.
To add the javaagent command to JBoss EAP 6.1.0

1. Open the bin/standalone.sh file and find the location where JAVA_OPTS is defined.
2.
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2. Add the following option to the existing JAVA_OPTS arguments:
-javaagent:/path/to/jboss-eap-6.1.0_appagent/javaagent.jar

3. Add the com.singularity and org.jboss.logmanager to the -Djboss.modules.system.pkgs
argument in JAVA_OPTS. The JAVA_OPTS section should look something like this:
JAVA_OPTS="$JAVA_OPTS
-javaagent:/path/to/jboss-eap-6.1.0_appagent/javaagent.jar
-Djboss.modules.system.pkgs=$JBOSS_MODULES_SYSTEM_PKGS,com.singularity,org
.jboss.logmanager -Djava.awt.headless=true"

Note: Substitute <path/to/jboss-eap-6.1.0_appagent> with the path for your installation.
4. Restart the application server to have the changes take effect.
5. Integrate error detection with the JBoss log manager logging implementation using a custom
logger definition as described in Configuring Error Detection Using Custom Loggers.
To add the javaagent command in a Windows environment for JBoss EAP 6.0.1, JBoss EAP 6.2.0, JBoss AS 7.x

1. Open the bin\standalone.conf file.
2. Search for the line JBOSS_MODULES_SYSTEM_PKGS="org.jboss.byteman" and add the
com.singularity and org.jboss.logmanager packages to that line as follows:
JBOSS_MODULES_SYSTEM_PKGS="org.jboss.byteman,com.singularity,org.jboss.log
manager"

3. Save the file.
4. Open the standalone.bat file.
5. Add the following javaagent argument to the standalone.bat file.
:RESTART
"%JAVA%" -javaagent:<AGENT-DIR>javaagent.jar %JAVA_OPTS%
"-Dorg.jboss.boot.log.file=%JBOSS_HOME%\standalone\log\boot.log"
"-Dlogging.configuration=file:%JBOSS_HOME%/standalone/configuration/loggin
g.properties" -jar "%JBOSS_HOME%\jboss-modules.jar"

6. Save the file.
7. Restart the application server. The application server must be restarted for the changes to
take effect.
To add the javaagent command to RHEL JBoss EAP 6.x, JBoss AS 7.0.x, Wildfly 8 (Domain Mode)

You must add a system property to allow the com.singularity classes in the Java Agent to be found
from any class loader.
Add the jvm options specifying the location of the agent jar file, the application name, and the tier
name.
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If all the server instances in the server group are part of the same business application, then
configure -Dappdynamics.agent.applicationName in domain.xml; otherwise, configure the
application name in the host.xml file for each specific server.
If all the server instances in the server group are part of the same tier then configure
-Dappdynamics.agent.tierName in domain.xml, otherwise configure the tier name in host.xml
for each specific server.
-Dappdynamics.agent.applicationName tells the Java Agents the name of the Business
Application to be used to connect to the AppDynamics Controller.
-Dappdynamics.agent.tierName tells the Java Agents the name of the tier to use to connect
to the AppDynamics Controller.
Revise the JBoss domain.xml and host.xml files as indicated in the following sections and then
restart the application server.
Revise the Domain.xml file
1. Locate and edit domain.xml, usually located under $JBOSS_HOME/domain/configuration/.
2. Add the following system property, <property name="jboss.modules.system.pkgs"
value="com.singularity"/> in the <system-properties> element.
<system-properties>
<!-- IPv4 is not required, but setting this helps avoid unintended
use of IPv6 -->
<property name="java.net.preferIPv4Stack" value="true"/>
<property name="jboss.modules.system.pkgs"
value="com.singularity"/>
</system-properties>

This property tells the JBoss modules to allow the com.singularity classes in the Java
Agent to be found from any class loader. This is required for the Java Agentto run.
3. Under the server group name where you want to enable your Java Agents, add the JVM
options using the appropriate values for your agent location, JBoss application name, and
tier name.
<server-group name="main-server-group" profile="full">
<jvm name="default">
<heap size="1303m" max-size="1303m"/>
<permgen max-size="256m"/>
<jvm-options>
<option value="-javaagent:<agent_install_dir>/javaagent.jar"/>
<option value="-Dappdynamics.agent.applicationName=JBOSS-EAP-APP"/>
<option value="-Dappdynamics.agent.tierName=JBOSS-EAP-TIER"/>
</jvm-options>
</jvm>
<socket-binding-group ref="full-sockets"/>
</server-group>

Revise the Host.xml file
Add the -Dappdynamics.agent.nodeName jvm option in the host.xml file (usually located under
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$JBOSS_HOME/domain/configuration/). This option tells theJava Agent the node name to use to
connect to the AppDynamics Controller. Use the appropriate values for your node names.
For example:
<servers>
<server name="server-one" group="main-server-group">
<!-- Remote JPDA debugging for a specific server
<option
value="-agentlib:jdwp=transport=dt_socket,address=8787,server=y,suspend=n"/>
-->
<jvm name="default">
<jvm-options>
<option
value="-agentlib:jdwp=transport=dt_socket,address=8787,server=y,suspend=n"/>
<option value="-Dappdynamics.agent.nodeName=JBOSS-EAP-NODE-1"/>
</jvm-options>
</jvm>
</server>
<server name="server-two" group="main-server-group" auto-start="true">
<!-- server-two avoids port conflicts by incrementing the ports in
the default socket-group declared in the server-group -->
<socket-bindings port-offset="150"/>
<jvm name="default">
<jvm-options>
<option value="-Dappdynamics.agent.nodeName=JBOSS-EAP-NODE-2"/>
</jvm-options>
</jvm>
</server>
<server name="server-three" group="other-server-group" auto-start="false">
<!-- server-three avoids port conflicts by incrementing the ports in
the default socket-group declared in the server-group -->
<socket-bindings port-offset="250"/>
</server>
</servers>

To add the Java Agent to JBoss 7.2 (standalone)

1. Add the following to the standalone.sh file.
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AD_AGENT_HOME="/Users/appd/Downloads/AppServerAgent"
AD_CONT_HOST="localhost"
AD_CONT_POST="8090"
AD_APPL_NAME="JBossAS"
AD_APPL_TIER="standalone"
AD_APPL_NODE="jboss_node"
AD_OPTS=" -javaagent:$AD_AGENT_HOME/javaagent.jar \
-Dappdynamics.controller.hostName=$AD_CONT_HOST \
-Dappdynamics.controller.port=$AD_CONT_POST \
-Dappdynamics.agent.applicationName=$AD_APPL_NAME \
-Dappdynamics.agent.tierName=$AD_APPL_TIER \
-Dappdynamics.agent.nodeName=$AD_APPL_NODE "
# Fix up the Loggers and Bootclasspath
AD_OPTS="$AD_OPTS
-Dorg.jboss.boot.log.file=$JBOSS_HOME/standalone/log/boot.log \
-Djava.util.logging.manager=org.jboss.logmanager.LogManager"
AD_OPTS="$AD_OPTS
-Xbootclasspath/p:$JBOSS_HOME/modules/org/apache/log4j/main/log4j-1.2.16.j
ar:$JBOSS_HOME/modules/org/jboss/log4j/logmanager/main/log4j-jboss-logmana
ger-1.0.1.Final.jar:$JBOSS_HOME/modules/org/jboss/logmanager/main/jboss-lo
gmanager-1.4.0.Final.jar
-Dlogging.configuration=file:$JBOSS_HOME/standalone/configuration/logging.
properties"
JAVA_OPTS="$AD_OPTS $JAVA_OPTS"

Replace the variable values in the first six lines with the values appropriate for your system,
including the path to the Java Agent home, Controller host and port number, and the
application name, tier, and node name for this application in the Controller.
2. Add the following to the standalone.conf file and save it.
# --> Commented out original mod to JBOSS_MODULES_SYSTEM_PKGS
#
#if [ "x$JBOSS_MODULES_SYSTEM_PKGS" = "x" ]; then
# JBOSS_MODULES_SYSTEM_PKGS="org.jboss.byteman"
#fi
#
# --> Replaced with following mod to JBOSS_MODULES_SYSTEM_PKGS
#
if [ "x$JBOSS_MODULES_SYSTEM_PKGS" = "x" ]; then
JBOSS_MODULES_SYSTEM_PKGS="org.jboss.byteman,com.appdynamics,com.appdynami
cs.,com.singularity,com.singularity."
fi

3. Restart the application server. The application server must be restarted for the changes to
take effect.

Fix Linkage Error
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If you see this error:
Caused by: java.lang.LinkageError: loader constraint violation in interface
itable initialization: when resolving method
"com.microsoft.sqlserver.jdbc.SQLServerXAConnection.getXAResource()Ljavax/transa
ction/xa/XAResource;" the class loader (instance of
org/jboss/modules/ModuleClassLoader) of the current class,
com/microsoft/sqlserver/jdbc/SQLServerXAConnection, and the class loader
(instance of <bootloader>) for interface javax/sql/XAConnection have different
Class objects for the type javax/transaction/xa/XAResource used in the signature

Add the following JVM option to the start-up script and restart the server:
-Dappdynamics.bciengine.class.lookahead=!*

The error indicates a race condition while loading classes and this flag controls the class
loading hierarchy thus overcoming the class loading problems.
Jetty Startup Settings

To add the javaagent command in a Jetty environment
The Java Agent bootstraps using the javaagent command line option. Add this option to your
jetty.sh file.
To add the javaagent command in a Jetty environment

1. Open the jetty.sh start script file.
2. Add the following javaagent argument to the beginning of the script.
java -javaagent:/<agent_home>/javaagent.jar

If you are a Self-Service Trial user, add the Java Agent javaagent argument to your JVM start
script where <my-app-jvm1> is the name you use for the application running on that JVM.
-javaagent:<agent_home>/javaagent.jar=uniqueID=<my-app-jvm1>

3. Save the script file.
4. Restart the application server for the changes to take effect.
Mule ESB Startup Settings

To load the Java Agent in Mule ESB, pass the Java Agent JAR location as a JVM argument to
Mule.
Mule ESB 3.X or later uses the Tanuki configuration environment. To specify JVM arguments
in your Mule ESB environment, you need to configure them as additional parameters to the Tanuki
Java Service Wrapper configuration file, wrapper.conf, as described below.
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To configure the Tanuki Service Wrapper

1. Open the Java Service Wrapper configuration file:
<MULE_HOME>/conf/wrapper.conf
2. Find the location indicated for Java Additional Parameters:
# Java Additional Parameters
wrapper.java.additional.1=

3. Add the path to the Java Agent JAR file as a JVM argument using a wrapper.java.additional.
n parameter, as follows.
wrapper.java.additional.n="-javaagent:/path_to_appagent/javaagent.jar"
wrapper.java.additional.n.stripquotes=TRUE

Where "n" is the next available integer among the wrapper.java.additional parameters
already in the wrapper.conf file, if any. The numbers serve to identify each Java Additional
Parameter in the file. Do not skip numbers when adding the property.
Replace path_to_appagent to the path to the javaagent.jar file in your system. The
stripquotes parameter is necessary only if there are spaces in the path or filename, but is
safe to include if not.
For example, on a Linux system and with seven Java parameters already in the file, add the
following properties:
wrapper.java.additional.8="-javaagent:/opt/AppDynamics/Agent/app_agent/jav
aagent.jar"
wrapper.java.additional.8.stripquotes=TRUE

Note: There may be additional wrapper.java.additional properties defined in other Mule files.
These are generated by the system. As indicated by comments preceding these
properties, you should not make changes directly to the properties. Mule automatically
auto-increments the index number for these properties based on the highest integer number
used in wrapper.conf, so you do not need to modify or otherwise account for the index
numbers of auto-generated configuration properties.
Learn More

Mule ESB Support
Oracle WebLogic Startup Settings

To add the javaagent command in a Windows environment
To add the javaagent command in an application running as a Windows service
To add the javaagent command in a Linux environment
The Java Agent bootstraps using the javaagent command line option. Add this option to your
startWebLogic.sh or startWebLogic.cmd file.
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To add the javaagent command in a Windows environment

1. Open the startWebLogic.cmd file, located at
<weblogic_version_install_dir>\user_projects\domains\<domain_name>\bin.
2. Add following javaagent argument to the beginning of your application server start script.
set JAVA_OPTIONS=% JAVA_OPTIONS%
-javaagent:"<drive>:\<agent_home>\javaagent.jar"

If you are a Self-Service Trial user, add the App Agent for Java javaagent argument to your
JVM start script where <my-app-jvm1> is the name you use for the application running on that
JVM.
-javaagent:"<drive>:\<agent_home>\javaagent.jar=uniqueID=<my-app-jvm1>"

The javaagent argument references the full path of the Java Agent installation directory, including
the drive.
2a. Sample WebLogic v9.x startWebLogic.cmd file

2b. Sample WebLogic v10.x startWebLogic.cmd file
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3. Restart the application server. The application server must be restarted for the changes to take
effect.
To add the javaagent command in an application running as a Windows service

Some applications have a pre-compiled startup method that installs WebLogic as a Windows
service. Follow these steps to add the agent to the service.
1. Open the script file that starts the application service, such as
install_XXXX_Server_Start_Win_Service.cmd.
2. Add the javaagent command before the line starting with "set CMDLINE=%JAVA_VM%..." such
as
set
CLASSPATH=%MYSERVER_CLASSPATH%;%PRE_CLASSPATH%;%WEBLOGIC_CLASSPATH%;%POST_CLASSP
ATH%;%WLP_POST_CLASSpATH%
set JAVA_VM=%JAVA_VM% %JAVA_DEBUG% %JAVA_PROFILE%
set WLS_DISPLAY_MODE=Production
@REM AppDynamics Agent Start
set JAVA_OPTIONS=% JAVA_OPTIONS%
-javaagent:"<drive>:\<agent_home>\javaagent.jar"
@REM AppDynamics agent END
set CMDLINE=%JAVA_VM% %MEM_ARGS% -classpath %CLASSPATH% %JAVA_OPTIONS%
weblogic.Server"
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3. Remove the existing Windows Service for your application. From the command line, run this
script.
install_XXXXX_Server_Start_Win_Service.cmd
XXXXX_xxxxx_Production_Server R

4. Install the Windows Service for your application to include the AppDynamics agent
JAVA_OPTIONS argument.
install_XXXXX_Server_Start_Win_Service.cmd
XXXXX_xxxx_Production_Server I

5. From the WebLogic web console, stop your application.
6. Start your application (which also starts WebLogic) from the Windows Services application,
where the Windows service name = XXXXX_xxxx_Production_Server.
7. Ensure that your application is working properly.
For more information, see Creating a Server-Specific Script in the Oracle documentation.
To add the javaagent command in a Linux environment

1. Open the startWebLogic.sh file, located at
<weblogic_<version#>_install_dir>/user_projects/domains/<domain_name>/bin.
2. Add the following lines of code to the beginning of your application server start script.
export JAVA_OPTIONS="$JAVA_OPTIONS -javaagent:/agent_home/javaagent.jar"

If you are a Self-Service Trial user, add the Java Agent javaagent argument to your JVM start
script where <my-app-jvm1> is the name you use for the application running on that JVM.
-javaagent:<agent_home>/javaagent.jar=uniqueID=<my-app-jvm1>

The javaagent argument references the full path of the App Server Agent installation directory. For
details see the screen captures.
2a. Sample WebLogic v9.x startWebLogic.sh file
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2b. Sample WebLogic v10.x startWebLogic.sh file
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3. Restart the application server. The application server must be restarted for the changes to take
effect.
OSGi Infrastructure Configuration

Configuring OSGi Containers
To configure Eclipse Equinox
To configure Apache Sling
To configure Apache Felix for GlassFish
For GlassFish 3.1.2
To configure Felix for Jira or Confluence
To configure other OSGi-based containers
Configuring OSGi Containers

The GlassFish application server versions 3.x and later uses OSGi architecture. By default, OSGi
containers follow a specific model for bootstrap class delegation. Classes that are not specified in
the container's CLASSPATH are not delegated to the bootstrap classloader; therefore you must
configure the OSGi containers for the Java Agentclasses.
For more information see GlassFish OSGi Configuration per Domain.
To ensure that the OSGi container identifies the Java Agent, specify the following package prefix:
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org.osgi.framework.bootdelegation=com.singularity.*

This prefix follows the regular boot delegation model so that the Java Agent classes are visible.
If you already have existing boot delegations, add "com.singularity.*" to the existing path
separated by a comma. For example:
org.osgi.framework.bootdelegation=com.sun.btrace., com.singularity.
To configure Eclipse Equinox

If running Eclipse Equinox under Glassfish:
1. Open the config.ini file located at <glassfish-install>/glassfish/osgi/equinox/configuration.
2. Add the following package prefix to the config.ini file:
org.osgi.framework.bootdelegation=com.singularity.*

If running Eclipse Equinox under the WebSphere Application Server Liberty profile:
1. Open the bootstrap.properties file in the JVM directory <WLP_home>/usr/servers/<server_name
> for editing.
2. Add the following line:
org.osgi.framework.bootdelegation=com.singularity.*

For more information see Getting Started with Equinox.
To configure Apache Sling

1. Open the sling.properties file. The location of the sling.properties varies depending on the Java
platform.
In the Sun/Oracle implementation, the sling.properties file is located at <java.home>/lib.
2. Add following package prefix to the sling.properties file.
org.osgi.framework.bootdelegation=com.singularity.*

To configure Apache Felix for GlassFish

1. Open the config.properties file, located at <glassfish-install>/glassfish/osgi/felix/conf.
2. Add following package prefix to the config.properties file.
org.osgi.framework.bootdelegation=com.singularity.*
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For GlassFish 3.1.2
Add:
com.singularity.*

to the boot delegation list in the <GlassFish_Home_Directory>\glassfish\config\osgi.properties file.
For example:
org.osgi.framework.bootdelgation=${eclipselink.bootdelegation}, com.sun.btrace,
com.singularity.*

To configure Felix for Jira or Confluence

For Jira 5.1.8 and newer, Confluence 5.3 and newer
1. Update the jira startup script (e.g. catalina) with the following java system property:
-Datlassian.org.osgi.framework.bootdelegation=META-INF.services,com.yourkit,com.
singularity.*,com.jprofiler,com.jprofiler.*,org.apache.xerces,org.apache.xerces.
*,org.apache.xalan,org.apache.xalan.*,sun.*,com.sun.jndi,com.icl.saxon,com.icl.s
axon.*,javax.servlet,javax.servlet.*,com.sun.xml.bind.*

2. Update the Java options:
For Linux: JAVA_OPTS=
For Windows: set JAVA_OPTS=%JAVA_OPTS%
-javaagent:/root/AppServerAgent/javaagent.jar"

To configure other OSGi-based containers

For other OSGI-based runtime containers, add the following package prefix to the appropriate
OSGi configuration.
file.org.osgi.framework.bootdelegation=com.singularity.*

Resin Startup Settings

To Configure Resin 1.x - 3.x
To add the javaagent command in a Windows environment
To add the javaagent command in a Linux environment
To Configure Resin 4.x
The Java Agent bootstraps using the javaagent command line option. Add this option to the
resin.sh or resin.bat file.
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To Configure Resin 1.x - 3.x
To add the javaagent command in a Windows environment

1. Open the resin.bat file, located at <Resin_installation_directory>/bin.
2. Add following javaagent argument to the beginning of your application server start script.
exec JAVA_EXE -javaagent:"<drive>:\<agent_home>\javaagent.jar"

If you are a Self-Service Trial user, add the Java Agent javaagent argument to your JVM start
script where <my-app-jvm1> is the name you use for the application running on that JVM.
-javaagent:"<drive>:\<agent_home>\javaagent.jar=uniqueID=<my-app-jvm1>"

The javaagent argument references the full path of the Java Agent installation directory, including
the drive.
3. Restart the application server for changes to take effect.
To add the javaagent command in a Linux environment

1. Open the resin.sh file, located at <Resin_Installation_Directory>/bin.
2. Add the following javaagent argument to the beginning of your application server start script.
exec $JAVA_EXE -javaagent:"<agent_home>/javaagent.jar"

If you are a Self-Service Trial user, add the Java Agent javaagent argument to your JVM start
script where <my-app-jvm1> is the name you use for the application running on that JVM.
-javaagent:<agent_home>/javaagent.jar=uniqueID=<my-app-jvm1>

The javaagent argument references the full path of the Java Agent installation directory. See the
following screenshot.
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3. Restart the application server. The application server must be restarted for the changes to take
effect.
To Configure Resin 4.x

1. To install the Java Agent into Resin 4.X or later, edit the ./conf/resin.xml file and add:
<jvm-arg>-Xmx512m</jvm-arg>
<jvm-arg>-javaagent:<$appagent_location>/javaagent.jar</jvm-arg>
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2. Restart the application server. The application server must be restarted for the changes to take
effect.
Solr Startup Settings

To add the javaagent command in a Windows environment
To add the javaagent command in a Linux environment
The Java Agent bootstraps using the javaagent command line option. Add this option to your Solr
server.
To add the javaagent command in a Windows environment

1. Open the Windows command line utility.
2. Execute the following commands to add the javaagent argument to the Solr server:
>cd $Solr_Installation_Directory
>java -javaagent:"<drive>:\<agent_home>\javaagent.jar" -jar start.jar

If you are a Self-Service Trial user, add the Java Agent javaagent argument to your JVM start
script where <my-app-jvm1> is the name you use for the application running on that JVM.
-javaagent:"<drive>:\<agent_home>\javaagent.jar=uniqueID=<my-app-jvm1>"

The javaagent argument references the full path to the Java Agent installation directory, including
the drive. For details see the screenshots.

To add the javaagent command in a Linux environment

1. Open the terminal.
2. Execute the following commands to add the javaagent argument to the Solr server:
>cd $Solr_Installation_Directory
>java -javaagent:"<agent_home>/javaagent.jar" -jar start.jar

If you are a Self-Service Trial user, add the Java Agent javaagent argument to your JVM start
script where <my-app-jvm1> is the name you use for the application running on that JVM.

Copyright © AppDynamics 2012-2014

Page 1123

-javaagent:<agent_home>/javaagent.jar=uniqueID=<my-app-jvm1>

The javaagent argument references the full path to the Java Agent installation directory. For
details see the screenshot.

Standalone JVM Startup Settings

To add the javaagent command in a Windows environment
To add the javaagent command in a Linux environment
AppDynamics works just as well with JVMs that are not application servers or containers.
TheJava Agent bootstraps using the javaagent command line option, a standard Java option and
can be used with any JVM. Add this option to your standalone JVM.
To add the javaagent command in a Windows environment

1. Open the command line utility for Windows.
2. Add javaagent argument to the standalone JVM:
>java -javaagent:"Drive:\agent_home\javaagent.jar"
<fully_qualified_class_name_with_main_method>

For example:
>java -javaagent:"C:\AppDynamics\agentDir\javaagent.jar"

com.main.HelloWorld

If you are a Self-Service Trial user, add the Java Agent javaagent argument to your JVM start
script, where <my-app-jvm1> is the name you use for the application running on that JVM.
-javaagent:"<drive>:\<agent_home>\javaagent.jar=uniqueID=<my-app-jvm1>"
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The javaagent argument references the full path to the Java Agent installation directory, including
the drive.
To add the javaagent command in a Linux environment

1. Open the terminal.
2. Add the javaagent argument to the standalone JVM:
>java -javaagent:"/agent_install_dir/javaagent.jar"
<fully_qualified_class_name_with_main_method>

For example:
>java -javaagent:"/mnt/AppDynamics/agentDir/javaagent.jar" com.main.HelloWorld

If you are a Self-Service Trial user, add the Java Agent javaagent argument to your JVM start
script where <my-app-jvm1> is the name you use for the application running on that JVM.
-javaagent:<agent_home>/javaagent.jar=uniqueID=<my-app-jvm1>

The javaagent argument references the full path to the Java Agent installation directory.
Tanuki Service Wrapper Configuration

To configure the Tanuki Service Wrapper
The Java Agent bootstraps using the javaagent command line option. Add this option to the Tanuki
Service wrapper.conf file.
To configure the Tanuki Service Wrapper

1. Open the wrapper.conf file.
2. Use the wrapper.java.additional.<n> property to add the javaagent option.
wrapper.java.additional.6=-javaagent:/C:/agent/javaagent.jar

If you are a Self-Service Trial user, add the Java Agent javaagent argument to your JVM start
script where <my-app-jvm1> is the name you use for the application running on that JVM.
-javaagent:<agent_home>/javaagent.jar=uniqueID=<my-app-jvm1>

For more information see:
Tanuki Service Wrapper Properties
Example Configuration
More Help On Tanuki Service Wrapper
Tibco ActiveMatrix BusinessWorks Service Engine Configuration
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To add the javaagent command
The Java Agent bootstraps using the javaagent command line option. Add this option to your Tibco
ActiveMatrix BusinessWorks Services server.
To add the javaagent command

There are typically two scripts associated with the Tibco ActiveMatrix BusinessWorks Services
engine.
my_application.sh
my_application.tra
The JVM that runs the services start with a command line tool called bwengine(.exe).
1. Add the following to the .tra file:

java.extended.properties=-javaagent:/opt/appagent/javaagent.jar

2. Restart the application server for the changes to take effect
See also: https://docs.tibco.com/ and https://tibbr.tibcommunity.com/.

SUN JDK 1.6 on Linux

The Java Agent calls an API to collect CPU times for threads. Because of a Sun JDK 1.6 problem
on Linux the API may take too long, and you may see the following error:
threads blocking on
sun.management.ThreadImpl.getThreadTotalCpuTime0(Native Method).
If this error occurs, the Java Agent by default will disable CPU time collection for threads. You can
force the agent to continue to collect CPU times for threads using the thread-cpu-capture-overhea
d-threshold-in-ms node property, but this may cause unacceptable overhead on your application.
We recommend you use this Java HotSpot VM option instead to speed up the API call itself.
-XX:+UseLinuxPosixThreadCPUClocks
Enable SSL for Java
Before You Begin
SSL Utilities
Keystore Certificate Extractor Utility
Password Encryption Utility
SaaS Controller
Sample SaaS SSL controller.xml configuration
Sample SaaS SSL JVM startup script configuration
On-Premise Controller with a Trusted CA Signed Certificate
Sample on-premise SSL controller.xml configuration for a CA signed certificate
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Sample on-premise SSL JVM startup script configuration for a CA signed certificate
On-Premise Controller with an Internally Signed Certificate
Sample on-premise SSL controller.xml configuration for an internally signed certificate
Sample on-premise SSL JVM startup script configuration for an internally signed
certificate
On-Premise Controller with a Self-Signed Certificate
Sample on-premise SSL controller.xml configuration for a self-signed certificate
Sample on-premise SSL JVM startup script configuration for a self-signed certificate
Learn More
This topic covers how to configure the App Agent for Java (the agent) to connect to the Controller
using SSL. It assumes that you use a SaaS Controller or have configured the on-premise
Controller to use SSL.
The Java Agent supports extending and enforcing the SSL trust chain when in SSL mode.
Before You Begin

Before you configure the Java Agentto enable SSL, gather the following information:
Identify if the Controller is SaaS or on-premise.
Identify the Controller SSL port.
For SaaS Controllers the SSL port is 443.
For on-premise Controllers the default SSL port is 8181, but you may configure the
Controller to listen for SSL on another port.
Identify the signature method for the Controller's SSL certificate:
A publicly known certificate authority (CA) signed the certificate. This applies for
Verisign, Thawte, and other commercial CAs.
A CA internal to your organization signed the certificate. Some companies maintain
internal certificate authorities to manage trust and encryption within their domain.
The Controller uses a self-signed certificate.
Decide how to manage the configurations. See Where to Configure App Agent Properties:
Add the configuration parameters to <agent install directory>/conf/controller-info.xml.
Or
Include system properties in the -javaagent argument in your JVM startup script.
SSL Utilities

We provide two utilities to help you implement SSL.
Keystore Certificate Extractor Utility

The Keystore Certificate Extractor Utility exports certificates from the Controller's Java keystore
and writes them to an agent truststore. It installs to the following location:
<agent install directory>/utils/keystorereader/kr.jar

To avoid copying the Controller keystore to an agent machine, you can run this utility from the
Controller server. Access the agent distribution on the Controller at the following location:
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<controller install directory>/appserver/glassfish/domains/domain1/appagent

To use the Keystore Certificate Extractor, execute kr.jar and pass the following parameters:
The full path to the Controller's keystore:
<controller install
directory>/appserver/glassfish/domains/domain1/config/keystore.jks

The truststore output file name. By default the Java Agent looks for cacerts.jks.
The password for the Controller's certificate, which defaults to "changeit". If you don't include
a password, the extractor applies the password "changeit" to the output truststore.
java -jar kr.jar <controller install
directory>/appserver/glassfish/domains/domain1/config/keystore.jks cacerts.jks
<controller certificate password>

Password Encryption Utility

The Password Encryption Utility encrypts the Controller's certificate password so you can add it to
the controller-info.xml file. It installs to the following location:
<agent install directory>/utils/encryptor/encrypt.jar

To use the Password Encryption Utility, execute encrypt.jar and pass the clear text password as a
parameter. The utility returns the encrypted password:
java -jar <agent install directory>/utils/encryptor/encrypt.jar <controller
certificate password>
Encrypted password is nkV/LwhLMLFjfNTbh0DLow==

SaaS Controller

1. Update the JVM startup script or controller-info.xml to use SSL enabled settings. See App Agent
for Java Configuration Properties.
Set the Controller Port Property to 443. See Controller Port Property.
Set the Controller SSL Enabled Property to true. See Controller SSL Enabled Property.
2. Save your changes.
3. Restart the JVM.
The Java Agentdetects SaaS implementations based upon the controller host URL, which must
contain ".saas.appdynamics.com". It also checks for an account-name and an access-key. If all
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three elements exist, the Java Agentconnects with the SaaS Controller via SSL.
Sample SaaS SSL controller.xml configuration

<?xml version="1.0" encoding="UTF-8"?>
<controller-info>
<controller-host>mycompany.saas.appdynamics.com</controller-host>
<controller-port>443</controller-port>
<controller-ssl-enabled>true</controller-ssl-enabled>
...
<account-name>mycompany</account-name>
<account-access-key>xxxxxxxxxxxxx</account-access-key>
...
</controller-info>

Sample SaaS SSL JVM startup script configuration

java -javaagent:/home/appdynamics/AppServerAgent/
-Dappdynamics.controller.hostName=<controller domain>
-Dappdynamics.controller.port=443 -Dappdynamics.controller.ssl.enabled=true ...
-Dappdynamics.agent.accountName=<account name>
-Dappdynamics.agent.accountAccessKey=<access key>

On-Premise Controller with a Trusted CA Signed Certificate

1. Update your JVM startup script or controller-info.xml to use SSL enabled settings. See App
Agent for Java Configuration Properties.
Set the Controller Port Property to the on-premise SSL port. See Controller Port Property.
Set the Controller SSL Enabled Property to true. See Controller SSL Enabled Property.
To configure the agent to perform full validation of the Controller certificate, set the Force
Default SSL Certificate Validation app agent node property to true. See Force Default SSL
Certificate Validation Property.
2. Save your changes.
3. Restart the JVM.
The Java Agentconnects to the Controller over SSL. Because the Force Default SSL Certificate
Validation app agent node roperty is set to true, the Java Agentenforces the trust chain using the
default Java truststore.
Sample on-premise SSL controller.xml configuration for a CA signed certificate

Copyright © AppDynamics 2012-2014

Page 1129

<?xml version="1.0" encoding="UTF-8"?>
<controller-info>
<controller-host>mycontroller.mycompany.com</controller-host>
<controller-port>8181</controller-port>
<controller-ssl-enabled>true</controller-ssl-enabled>

<force-default-certificate-validation>true</force-default-certificate-validation
>
...
</controller-info>

Sample on-premise SSL JVM startup script configuration for a CA signed certificate

java -javaagent:/home/appdynamics/AppServerAgent/
-Dappdynamics.controller.hostName=<controller domain>
-Dappdynamics.controller.port=443 -Dappdynamics.controller.ssl.enabled=true
-Dappdynamics.force.default.ssl.certificate.validation=true ...

On-Premise Controller with an Internally Signed Certificate

1. Obtain the root CA certificate from your internal resource. By default the agent looks for a Java
truststore named cacerts.jks.
To import a certificate to a truststore, run the following command:
keytool -import -alias rootCA -file <certificate file name> -keystore
cacerts.jks -storepass <truststore password>

This command creates the truststore cacerts.jks if it does not exist and assigns it the password
you specify.
2. Copy the truststore file to the Java Agentconfiguration directory:
cp cacerts.jks <agent install directory>/conf/cacerts.jks

3. Encrypt the truststore password. See Password Encryption Utility.
4. Update your JVM startup script or controller-info.xml to use SSL enabled settings. See App
Agent for Java Configuration Properties.
Set the Controller Port Property to the on-premise SSL port. See Controller Port Property.
Set the Controller SSL Enabled Property to true. See Controller SSL Enabled Property.
Set the Controller Keystore Password Property to the encrypted password. See Controller
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Keystore Password Property.
You must configure this property in the controller-info.xml. It is not available as a system
property in the JVM startup script.
5. Restart the JVM.
The Java Agentdetects the cacerts.jks truststore in its configuration directory and uses it to enforce
the trust chain when connecting to the Controller over SSL.
Sample on-premise SSL controller.xml configuration for an internally signed certificate

<?xml version="1.0" encoding="UTF-8"?>
<controller-info>
<controller-host>mycontroller.mycompany.com</controller-host>
<controller-port>8181</controller-port>
<controller-ssl-enabled>true</controller-ssl-enabled>
<controller-keystore-password>nkV/LwhLMLFjfNTbh0DLow==</controller-keystore-pas
sword>
...
</controller-info>

Sample on-premise SSL JVM startup script configuration for an internally signed certificate

java -javaagent:/home/appdynamics/AppServerAgent/
-Dappdynamics.controller.hostName=<controller domain>
-Dappdynamics.controller.port=443 -Dappdynamics.controller.ssl.enabled=true ...

On-Premise Controller with a Self-Signed Certificate

1. Extract the Controller's self-signed Certificate to a truststore named cacerts.jks. See Keystore
Certificate Extractor Utility.
2. Copy the truststore file to the agent configuration directory:
cp cacerts.jks <agent install directory>/conf/cacerts.jks

3. Encrypt the truststore password. See Password Encryption Utility.
4. Update your JVM startup script or controller-info.xml to use SSL enabled settings. See App
Agent for Java Configuration Properties.
Set the Controller Port Property to the on-premise SSL port. See Controller Port Property.
Set the Controller SSL Enabled Property to true. See Controller SSL Enabled Property.
Set the Controller Keystore Password Property to the encrypted password. See Controller
Keystore Password Property.
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You must configure this property in the controller-info.xml. It is not available as a system
property in the JVM startup script.
5. Restart the JVM.
The Java Agentdetects the cacerts.jks truststore in its configuration directory and uses it to enforce
the trust chain when connecting to the Controller over SSL.
Sample on-premise SSL controller.xml configuration for a self-signed certificate

<?xml version="1.0" encoding="UTF-8"?>
<controller-info>
<controller-host>mycontroller.mycompany.com</controller-host>
<controller-port>8181</controller-port>
<controller-ssl-enabled>true</controller-ssl-enabled>
<controller-keystore-password>nkV/LwhLMLFjfNTbh0DLow==</controller-keystore-pas
sword>
...
</controller-info>

Sample on-premise SSL JVM startup script configuration for a self-signed certificate

java \-javaagent:/home/appdynamics/AppServerAgent/
\-Dappdynamics.controller.hostName=<controller domain>
\-Dappdynamics.controller.port=443 \-Dappdynamics.controller.ssl.enabled=true
...

Learn More

Security
Install the Java Agent
Upgrade the Java Agent
Planning the Upgrade
Upgrading the Java Agent
To upgrade the Java Agent
Planning the Upgrade

If you are upgrading both the Controller and agents, first upgrade the Controller and then upgrade
the Java Agents.
Also, if upgrading multiple agents in your monitored environment, upgrade the agents for the tiers
on which business transactions are originated last. For more information about this requirement,
along with Controller and agent compatibility information, see Agent - Controller Compatibility
Matrix.

Copyright © AppDynamics 2012-2014

Page 1132

Note that upgrading the agent requires a restart of the application server.
Upgrading the Java Agent

Before starting, download the latest version of the Java Agent for your JVM from the AppDynamics
Download Center.
To upgrade the Java Agent

1.
2.
3.
4.
5.

Shut down the application server where the Java Agent is installed.
Create a backup copy of the current agent installation directory.
Extract the Java Agent archive to a new directory
Rename the existing agent directory.
Rename the new directory to the original name of the old agent directory. The new agent
directory and its containing files should have the same directory path as the original one. Using
the same directory path avoids the task of manually changing the agent-related configurations in
your JVM startup script.
6. Copy the controller-info.xml from the old agent directory to the new directory.
7. If you previously made changes to the
<Java_Agent_Installation_Directory>/conf/app-agent-config.xml file, copy those changes to the
new file.
8. Restart the application server.
When done you can archive the original directory and remove it from the application server home.

Uninstall the Java Agent

To uninstall the Java Agent
Learn More
If you delete an app agent from the Controller UI, as described in Manage App Agents, but do not
shut down the JVM that the Java Agent runs on, the Java Agent will reappear in the UI the next
time it connects to the Controller.
To prevent a Java Agent from connecting to the Controller, you need to remove the Java
Agent settings from the JVM configuration. This frees the license associated with the agent in the
Controller and makes it available for use by another app agent. This topic describes how to
uninstall a Java Agent from the JVM configuration.
To uninstall the Java Agent

1. Stop the application server on which the Java Agent is configured.
2. Remove the -javaagent argument in the startup script of the JVM.
3. Remove any system properties configured for the Java Agent from the startup script of your
JVM.
4. Restart the application server.
Learn More
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Manage App Agents
Install the Java Agent
App Agent for Java Configuration Properties

Configure AppDynamics for Java
See also, App Agent for Java Configuration Properties
Business Transaction Configuration Methodology for Java
Modifying the Default Business Transaction Configuration
Suggested Methodology
1. Confirm Business Relevance
2. Review the Architecture
3. Modify Automatic Detection Criteria
Business Transaction Discovery
Disable Entry Point Discovery
Customize Detection Settings
Combine Business Transactions
Use Dynamic Values to Split a Business Transaction
Collect Extra Traffic into a Catch-all Transaction
4. Exclude Business Transactions
Exclude Action in the UI
Configure Exclude Rules
Change the Default Exclude Rule Settings
Create New Exclude Rules
5. Rename Business Transactions
6. Group Business Transactions
7. Delete Old Unwanted Business Transactions
Modifying the Default Business Transaction Configuration

Sometimes you need to fine-tune your business transaction configuration, such as when:
You do not see business transactions that you expect to see based on how your application
should be represented in AppDynamics. See Organizing Traffic as Business Transactions.
You see the All Other Traffic business transaction in the Business Transactions List, for
example:
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AppDynamics creates the All Other Traffic business transaction when a business transaction limit
is reached. You can modify the transaction discovery configuration to reduce the number of
business transactions.
To modify your business transaction configuration follow this suggested methodology.
Suggested Methodology

1. Confirm Business Relevance

The first step in analyzing the business transaction configuration that is right for
your application is to confirm which transactions you want to monitor. Talk with your
application developers and architects about which are the most important
processes to monitor. The discussion will help you identify the correct entry points,
which define the beginnings of your business transactions. Be sure you are
measuring the right things. See Organizing Traffic as Business Transactions.
Once you know what you want to monitor, you can examine the business
transactions being detected and determine your next steps.
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2. Review the Architecture

If you are missing an expected business transaction, review the application
architecture and make sure the expected business transaction is not part of another
transaction initiated by another tier. Also make sure the application/tier/node
configuration is correct. See Mapping Application Services to the AppDynamics
Model.

3. Modify Automatic Detection Criteria

While AppDynamics discovers many business transactions automatically, you may
need to modify these mechanisms to detect additional ones or to disable ones that
are not critical to monitor.
Configuration is hierarchical for a business application and its tiers, and has both a
"global" scope and a more granular "custom" scope. See Hierarchical Configuration
Model and How AppDynamics Identifies Business Transactions Using Entry Points.
To change discovery mechanisms you can:
Disable Entry Point Discovery
Customize Detection Settings
Combine Business Transactions
Use Dynamic Values to Split a Business Transaction
You can change these discovery mechanisms using the Configure->Instrumentati
on->Transaction Detection windows or the Configure->Transaction Discovery t
ool.
Business Transaction Discovery

Using the Business Transaction Discovery tool, you can see the real time effect of
business transaction customizations before applying them. This tool provides an
interactive mode to configure transactions, translating the traffic on your app to
business transactions you need to monitor. For more information, see Fine-tune
Business Transaction Discovery.
Disable Entry Point Discovery

In the Transaction Detection window for the application or tier, you can completely
disable transaction monitoring for a type of entry point. You may want to do this
when:
You know that all the business transactions of a specific entry point type don't
need to be monitored.
You want to use custom transaction discovery configurations instead.
Another example is when Servlets implement Spring Beans and you are interested
in monitoring the transaction starting at the Spring Bean level. In this case you can
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disable Servlet discovery and then only the Spring Beans, which are enabled by
default, are discovered and monitored. See Exclude Spring Beans Of Specific
Packages.

Customize Detection Settings

You can use custom match rules on entry points to establish a set of transactions
that give a good and distinct representation of the business activity while not being
too granular. See Configure Business Transaction Detection and Java Web
Application Entry Points.
For example, by default AppDynamics uses the first two segments of a URI to
identify Servlet-based business transactions. Depending on your application code,
you may need to use either fewer or more segments of a URI to get the correct
granularity to identify the transactions.
For another example, you may have a business transaction initiated by code that
does not use a standard framework, and you need to define a custom POJO entry
point.
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Combine Business Transactions

You can combine multiple business transactions by changing the auto-discovery
rules at the global application or tier level and/or by creating custom match rules at
more granular levels. Both techniques help you configure what business
transactions to monitor.
For example, you may have many Servlet-based business transactions that are
auto-discovered using the first two segments of the URI.
http://www.myapp.com/users/user01
http://www.myapp.com/users/user02
http://www.myapp.com/users/user03
etc...

If it makes more sense to use only the first segment, you can change the
auto-discovery rule to specify only the first segment.
http://www.myapp.com/users

You can also combine multiple transactions using custom match rules on entry
points. See Configure Business Transaction Detection and Java Web Application
Entry Points.
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Use Dynamic Values to Split a Business Transaction

The process of using a dynamic value to customize business transaction discovery
is called transaction splitting. Transaction spitting allows you to fine-tune transaction
detection or exclusion based on a parameter or user data.
For example, you could create a new business transaction configuration that uses
the "color" parameter to separate products/outdoor transactions.

See more Servlet examples:
Automatic Naming Configurations for Servlet-Based Business Transactions
Custom Naming Configurations for Servlet-Based Business Transactions
Advanced Servlet Transaction Detection Scenarios
Collect Extra Traffic into a Catch-all Transaction

After configuring the most important entry points, consider creating a new "catch-all"
rule to collect and name all other website traffic. This will help manage the number
of business transactions you see in lists and flow maps.
Create a custom match "catch-all" rule where:
Entry point type is "Servlet" (the most commonly encountered entry point type
in Java environments)
Priority is "0"
Match value is "URI is not empty"
Make sure the Priority is "0" so that it will be discovered last. Any operations that
don't match your customized detection rules will be discovered by this "catch-all"
rule.
Note: The "catch-all" rule also captures all web service and Struts traffic. This is
because custom rules are evaluated before exclude rules, and there are default
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exclude rules for web service and Struts traffic. The "catch-all" rule will evaluate first
and put what would normally be excluded by default into the "catch-all" business
transaction.

4. Exclude Business Transactions

There are two ways to exclude auto-discovered business transactions that you do
not need to monitor.
The Exclude Action in the UI: Excluding transactions from the UI is helpful if
you think you may want to resume monitoring the transaction in the future, as
the underlying configuration is still present. For example, a transaction may
not have traffic now but you anticipate that it will in the future.
Configure Exclude Rules: One reason to use exclude rules over the Exclude
action in the UI is mainly for efficiency, as you can exclude whole classes of
business transactions using string match rule conditions. See Creating
Exclude Rules.
Exclude Action in the UI

When you exclude a business transaction from the UI, AppDynamics retains
existing metrics for the business transaction, but no longer monitors it. Excluded
transactions do not count against the maximum number of transactions allowed per
application or per agent. Excluding transactions using this method is helpful if you
think you may want to resume monitoring the transaction in the future.
The exclude action in the UI is most useful for web service, POJO, and EJB
business transactions, where a single class or web service detects many
methods/operations, and you want to monitor some but not all of them. In this case
it's onerous to set up custom exclude rules, and much simpler to select the subset
you do not want and exclude them via the UI.
In the Business Transaction List you can select one or more transactions and either
right-click Exclude Transactions or select Actions -> Exclude Transactions.
To resume monitoring the business transaction, you can "un-exclude" it from the
View Excluded Transactions window.
See Excluding Business Transactions from the UI.
Configure Exclude Rules

Exclude rules prevent detection of business transactions that match certain criteria.
You might want to use exclude rules in the following situations:
AppDynamics is detecting business transactions that you are not interested in
monitoring.
A detected business transaction has no traffic and probably will not have
interesting traffic in the future.
You need to trim the total number of business transactions in order to stay
under the Java Agentand Controller limits.
You need to substitute a default entry point with a more appropriate entry
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point using a custom match rule.
To customize exclude rules you can:
Change the Default Exclude Rule Settings
and
Create New Exclude Rules
Change the Default Exclude Rule Settings

Several entry points are excluded by default and you can edit them in the
Transaction Detection panel.

Create New Exclude Rules

You can create new exclude rules using custom match conditions that provides fine
granularity over business transaction detection.
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For example an exclude rule can:
Skip an EJB control class and use the business logic classes
Behave like a filter that allows eligible requests and ignores the rest
Exclude Spring Beans of specific packages.
See Creating Exclude Rules and Exclude Rule Examples for Java.

5. Rename Business Transactions

By default, all business transactions are identified using default naming schemes
for different types of requests. For ease of use you can change the label associated
with the name. Use the Action -> Rename menu in the Business Transaction
Dashboard or the Business Transaction List to give a user-friendly name to the
transaction.
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6. Group Business Transactions

When multiple business transactions are similar and you want to roll up their
metrics, you can put multiple business transactions into a group. You get metrics for
each transaction and for the group as a whole. Grouping in the UI makes your lists
and flowcharts easier to read by reducing visual clutter.
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See Organizing Business Transactions into Groups and Grouping Business
Transactions.

7. Delete Old Unwanted Business Transactions

After you have modified the business transaction discovery configurations, you then
need to delete the old, unwanted business transactions. If you delete a transaction
and you have not changed the configuration, it will be rediscovered. However, when
you have revised the transaction discovery rules properly for what you want to see
and then delete the unwanted business transaction, it won't be rediscovered.
You can delete transactions from the Business Transaction List using More
Actions.

Fine-tune Business Transaction Discovery

To get optimal value from AppDynamics, you need to make sure that your business transactions
are set up to describe the relevant traffic that you need to monitor and that they are not set up to
monitor extraneous traffic that is not important to your success. Although you will derive some
value from AppDynamics auto-discovery, you will significantly increase the utility of the product if
business transaction discovery and monitoring is tuned to reflect your organization's needs.
Transaction Discovery is a business transaction discovery and configuration tool that helps you
choose the right strategy in configuring which business transactions AppDynamics monitors. This
tool provides an interactive mode to configure transaction detection, translating the traffic on your
app to business transactions you need to monitor. Within Business Transaction Discovery, you
can see the effect of the changes you make to the configuration without having to apply it to the
production configuration. When you've finished making your changes, you can then choose which
tiers of the application to apply the tuned configuration to or not to apply the changes at all.
To fine-tune business transaction discovery

1.
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1. From the left navigation menu, click Configure->Transaction Discovery and then click Sta
rt Discovery Session.

2. Select the nodes for which you want to configure business transaction discovery and then
click OK.
You can choose to run the discovery session on more than one node, using Shift-click to
select successive nodes, but all the nodes selectect must be within the same tier. At the end
of the configuration process you can apply your transaction detection configuration changes
to one or more tiers.
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AppDynamics starts discovering transactions and displays them as soon as they are
detected.
During discovery, you can use other features of AppDynamics while the discovery process
continues in the background. You may want to do this in a busy environment where many
transactions are happening. You can give AppDynamics a few minutes to complete the
discovery and then return to the Transaction Discovery page by clicking Configure->Transa
ction Discovery.
Once the discovery session has completed, you will see a window with content similar to the
following.
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From this list you may be able to determine whether there are some transactions that are
not being monitored. You can then create a custom match rule to identify those transaction
types on the Edit Discovery Config tab.
You may also see transactions that you don't want to trace. To prevent detection of those
transactions, create a custom exclude rule on Edit Discovery Config tab.
The following describes the content of the previous screenshot:
Name: The business transaction names that display are named using the naming
conventions for that transaction type. The naming rules can be changed during
instrumentation.
Type: The Java web application entry point type of the business transaction.
Load: The total number of calls for that business since the discovery timestamp.
Discovery Timestamp: The time when the named transaction was first discovered.
Transactions Summary: A summary of the number of of business transactions for each
application type.
From the Transaction Discovery window, there are a number of options you can
choose:
Reset Data
VIew Snapshot
Class/Method Browser
Edit Discovery Config
Apply Config
Stop Session

Clicking Stop Session exits the Business Transaction Discovery tool without saving any of the
changes you made
Reset Data

Clicking Reset Data clears the window and initiates a new business transaction discovery session.
The information displayed in the previous discovery session is not saved.
View Snapshot
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A snapshot of the transaction provides you with details about the transaction that can help you
decide whether or not you want to monitor this transaction type or any of the methods executed by
the transaction.
1. On the Transaction Discovery window, select a transaction for which transaction snapshots
are supported. For example, AppDynamics doesn't take snapshots of Struts Action
transactions but it does for Servlet transactions. Click View Snapshot

The snapshot window appears. It will be empty at first but then will fill up as snapshots are
taken. It will continue to take snapshots until you stop the discovery session.

Click Clear Snapshots to restart the snapshot session and delete details of snapshots
taken in the previous session.
2. Click a snapshot and then click View Snapshot to view the captured details of the
transaction.
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2.

The information displayed on this page can help you create transaction match and exclude
rules.
After viewing the details of that snapshot you can click the breadcrumb to return to the
snapshots page where you can choose to view the details of another snapshot.
Class/Method Browser

The Class/Method Browser allows you to filter the classes of the transactions that have been
discovered for only those classes that meet specific criteria. Knowing which classes and methods
are being traced can help you create custom match or exclude rules. such as by providing you
with information you could use to complete the fields on the Split Transactions Using Payload tab
of the New Business Transaction Match Rule for a Servlet. The information presented here can
also help you identify transactions that are not being traced, in which case you would create a
custom match rule to include transactions of that type.
To filter the classes shown in the browser, click one of the following choices in the list:
Search for classes implementing interface name
Search for classes extending super class
Search for classes having annotation
Search by class name
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Searching for classes implementing interface name java.lang.runnable provides results similar to
the following.

Edit Discovery Config

When you click Edit Discovery Config, the configuration AppDynamics used for auto-discovery
for your environment appears. Edit Discovery Config lets you tweak the settings for business
discovery configuration rules much as you would on the Instrumentation->Transaction
Detection window. All the same options are available for discovering and naming business
transactions for specific entry points and for creating custom match and exclude rules are
available here.
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If you want to start your tweaking using an existing customized configuration, click Copy from
App / Tier and choose the application or tier from which to copy the configuration.
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After making a change in the configuration, you can see the effect on the transactions discovered
by clicking View Results.
If you don't like the changes you made or need to make more, you can go back and do some more
tweaking, clicking View Results whenever you like to see your changes.
If you like the changes,on the window that appears when you click View Results, click Apply
Config.
Apply Config

Clicking Apply Config presents you with a window where you can apply the business transaction
discovery rules that you have configured in the Transaction Discovery tool. You can choose to
apply your new configuration to all tiers of the application or to one or more tiers in the
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application. You will soon see your changes reflected in the list of business transactions displayed
when you click Business Transactions on the left navigation menu.

Learn More

Configure Business Transaction Detection
Java Web Application Entry Points
Exclude Rule Examples for Java
Business Transaction Configuration Methodology for Java
Java Web Application Entry Points

Tiers and Web Application Entry Points
Other Web Application Frameworks Based on Servlets or Servlets Filter
Learn More
This section discusses web application entry points for different types of business transactions.
Tiers and Web Application Entry Points
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A tier can have multiple entry points.

For example, for Java frameworks a combination of pure Servlets or JSPs, Struts, Web services,
Servlet filters, etc. may all co-exist on the same JVM.
The middle-tier components like EJBs and Spring beans are usually not considered entry points
because they are normally accessed using either the front-end layers such as Servlets or from
classes that invoke background processes.
For details about Java entry points see:
Other Web Application Frameworks Based on Servlets or Servlets Filter

AppDynamics provides out-of-the-box support for most of the common web frameworks that are
based on Servlets or Servlet Filters. When using any of the frameworks listed below, refer to the S
ervlet discovery rules to configure transaction discovery.
Spring MVC
Wicket
Java Server Faces (JSF)
JRuby
Grails
Groovy
Tapestry
ColdFusion
Learn More
Servlet Entry Points

Servlet-Based Business Transactions
Identify Business Transactions Based on REST-Style URLs
Additional Servlet-Based Business Transaction Detection Scenarios
Learn More
You can configure transaction entry points for Servlet-based methods that may or may not be used
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as part of an application framework.
Servlet-Based Business Transactions

AppDynamics allows you to configure a transaction entry point on the invocation of the service
method of a Servlet. The response time for the Servlet transaction is measured when the Servlet
entry point is invoked.

As discussed in Configure Business Transaction Detection and Business Transaction
Configuration Methodology for Java, AppDynamics automatically identifies business transactions,
and if the defaults are not ideal for monitoring your application, you can change them. For
Servlet-based transactions you can:
Identify a Servlet request based on a particular segment of its URI.
Identify a Servlet request based on part of its HTTP request, such as header values,
parameters, etc.
There are two scopes to identifying business transactions:
Automatic transaction naming configurations (sometimes called "global discovery rules"
and "auto-detection scheme") by default apply across the entire business application and
can be overridden at the tier level. AppDynamics provides default, out-of-the-box automatic
configurations. You can modify the automatic global transaction naming configuration across
the entire business application or tier in the Transaction Detection Entry Points and
Transaction Naming Configuration windows. See Automatic Naming Configurations for
Servlet-Based Business Transactions.
Custom transaction naming configurations (sometimes called "custom match rules") by
default apply across the entire business application and can be overridden at the tier level.
AppDynamics provides some POJO custom match rules that are disabled by default. When
you need different configurations for different parts of the application or different web
contexts, add custom match rules in the Transaction Detection and New Business Transaction
Match Rule window. See Custom Naming Configurations for Servlet-Based Business
Transactions.
As you might expect, you can use a combination of the global and specific configurations to effectively
identify and represent the most important business transactions in your application. See When to Use
Custom Naming Configurations Instead of Automatic Global Configurations.
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Identify Business Transactions Based on REST-Style URLs

REST applications typically have dynamic URLs where the application semantics are a part of the
URL. Sometimes you need to "skip over" a dynamic part of a URL when identifying business
transactions.
To configure business transactions based on dynamic URLs, see:
For global configurations:
Skip a Segment of the URI
Use Multiple Segments in a URI
For custom configurations:
Custom Naming Configurations for Servlet-Based Business Transactions
Additional Servlet-Based Business Transaction Detection Scenarios

For other detection scenarios see:
Learn More

For more information see:
Automatic Naming Configurations for Servlet-Based Business Transactions
Custom Naming Configurations for Servlet-Based Business Transactions
Use Parts of HTTP Requests to Name Global Servlet Entry Points
Configure Business Transaction Detection
Automatic Naming Configurations for Servlet-Based Business Transactions

Default Automatic Naming Identification for Servlet-Based Transactions
Modify the Automatic Global Naming
To modify the automatic global naming for Servlet-based transactions
Use Different Segments of the URI to Globally Identify Business Transactions
Use the Full, First or Last Segments of the URI
Skip a Segment of the URI
Use Multiple Segments in a URI
Use Parts of HTTP Requests to Automatically Identify Business Transactions
To modify the automatic global naming for Servlet-based transactions
Use URI Segment Numbers
Use HTTP Parameter Values
Use Header Values
Use a Referer Header
Use Cookie Values
Use Session Attribute Values
Use Methods
Use Request Host
Use Request Originating Address
Use Custom Expressions
Use Part of an HTTP Parameter Value to Split a Business Transaction
Learn More
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You can configure the automatic global business transaction naming criteria for Servlet-based
applications. Automatic transaction naming configurations (sometimes called "global discovery
rules" and "auto-detection scheme") by default apply across the entire business application and
can be overridden at the tier level. You can modify the automatic global transaction naming
configuration across the entire business application or tier in the Transaction Detection Entry
Points and Transaction Naming Configuration windows.
You can both modify the global automatic discovery rules and/or create custom match rules. See
When to Use Custom Naming Configurations Instead of Automatic Global Configurations.
Default Automatic Naming Identification for Servlet-Based Transactions

By default AppDynamics automatically discovers and identifies all Servlet-based business
transactions using the first two segments of the URI.
For example, if the URI for a checkout operation in an online store is
http://acmeonline.com/store/checkout
AppDynamics automatically names the business transaction "store/checkout" and all checkout
requests are handled in one business transaction.
By default AppDynamics does not use parts of the HTTP request to identify business
transactions.
Modify the Automatic Global Naming

You can modify the URI and/or specify parts of the HTTP request.
Change which segments of the URI are used to automatically identify business transactions.
See the section Use Different Segments of the URI to Identify Business Transactions.
When the URI does not contain enough information to effectively identify the business
transaction, you can use headers, parameters, cookies, and other parts of HTTP
requests. See the section Use Parts of HTTP Requests to Identify Transactions.
To modify the automatic global naming for Servlet-based transactions
1. In the left navigation pane click Configure -> Instrumentation.
2. In the Transaction Detection tab select the application or a tier.
3. Click the Java - Transaction Detection sub-tab.
4. Expand the Entry Points panel.
5. In the Servlet section, confirm that Transaction Monitoring and Discover Transactions
automatically for all Servlet requests are both enabled.
6. In the Servlet section, click Configure Naming.
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Use Different Segments of the URI to Globally Identify Business Transactions

You can change the automatic global naming configuration to fine-tune how AppDynamics
identifies Servlet-based business transactions. You can:
Use the Full, First or Last Segments
Skip a Segment
Use Multiple Segments
Use the Full, First or Last Segments of the URI

For example the following URI represents the checkout operation in ACME Online:
http://acmeonline.com/web/store/checkout
By default a business transaction is identified by the first two segments of the URI:
"/web/store". However this does not indicate the business functionality of the operation, such as
checkout, add to cart, etc. Another approach is to identify the business transaction using the last
two segments of the URI: "store/checkout".

At the global scope you modify URI detection to:
Use the full URI
Use either the first or last segments of the URI, and specify how many segments
If you need more granularity on the URI, such as to use non-contiguous segments, you can click N
ame Transactions dynamically using part of the request and specify the segments with the Us
e URI segments in Transaction names option as described in the following sections.
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Skip a Segment of the URI

Suppose a customer ID or the order ID is part of the URI, and you don't need that information to
identify a business transaction. For example the following URL represents the checkout
transaction invoked by a customer with ID 1234:
http://acmeonline.com/store/cust1234/checkout
The default discovery mechanism names this business transaction "/store/cust1234". Ideally, all
the customers performing a checkout operation should also be part of the checkout business
transaction. Therefore, a better approach is to name this transaction "/store/checkout".
To configure the transaction to be named "/store/checkout", use the first segment of the URI and
split that URI using the third segment, thus avoiding the second (dynamic) segment:

Use Multiple Segments in a URI

Sometimes you need to use multiple or non-contiguous segments to globally identify a business
transaction. For example for the following URL it is best to use segments 1,3, and 5:
http://acmeonline.com/user/foo@bar.com/profile/profile2345/edit
You would specify the first segment in the What part of the URI.. section and specify the others in
the Name Transactions dynamically.. section:
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Use Parts of HTTP Requests to Automatically Identify Business Transactions

You can configure the global naming for your Servlet based business transactions using headers,
parameters, cookies, and other parts of HTTP requests.
To identify Servlet based business transactions using particular parts of the HTTP request, use
the Name Transactions dynamically using part of the request option:
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You can "split" the transactions using different parts of your request data like header, URI,
sessions, etc. For more information see Transaction Splitting for Dynamic Discovery.
To modify the automatic global naming for Servlet-based transactions
1. In the left navigation pane click Configure -> Instrumentation.
2. In the Transaction Detection tab select the application or a tier.
3. Click the Java - Transaction Detection sub tab.
4. Expand the Entry Points panel.
5. In the Servlet section, confirm that Transaction Monitoring and Discover Transactions
automatically for all Servlet requests are both enabled.
6. In the Servlet section, click Configure Naming.
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7. In the Servlet Transaction Naming Configuration window, click Name Transactions
dynamically using part of the request.

The following sections describe the various options for using parts of the HTTP requests.
Use URI Segment Numbers

You can name your transaction dynamically using URL segments. See Use Different Segments of
the URI to Automatically Identify Business Transactions.
Use HTTP Parameter Values

You can name a business transaction based on the value of a particular parameter in your request
data.
For another example, consider the following URL:
http://acmeonline.com/orders/process?type=creditcard
The ideal naming configuration uses the combination of the parameter value for the parameter
"type" and the last two segments to name the business transaction
"/orders/process.creditcard". This configuration ensures that the credit card orders are
differentiated from other orders.
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For another example, in dispatcher-style Servlet patterns where the Servlet dispatches requests
based on a query parameter, configure both the URI segments and the dynamic parameter. For
the following URL:
http://acmeonline.com/dispatcher?action=checkout
You can identify the transaction based on the segments and the value of the "action" parameter.
For example:

AppDynamics automatically identifies the business transaction based on the value of the "action"
parameter, "<Segments_of_URI>.checkout".
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You can also identify a business transaction based on multiple parameters by providing the
comma-separated names of those parameters.
Use Header Values

You can also name your transaction based on the value of header(s) of your request data.
For example, to identify the requests based on "header1" for ACME Online:
1. Set the URI identification option.
2. Enable the Use header value in transaction names option and enter the header name
"header1" .
The business transaction named "<Segments_of_URI>.<header1>".
You can name a business transaction based on multiple headers by providing the
comma-separated names of those headers.
Use a Referer Header

If you are working on any of the following web technologies like Java Servlets, JSP, Struts,
Springs or .NET, and if you would like to know which page has the current requested URL
reference, you can get it by configuring the transactions on the REFERER header.
1. Set URI identification option.
2. Enable the Use header value in transaction names option and enter the header name
"referer" .
This configures names of all transactions using the referring URL.
Use Cookie Values

You can also name your transaction based on the value of a particular cookie in your request data.
For example: For ACME Online, you can identify only those transactions when the "Gold"
customers invoke the checkout operation.
1. Set the URI identification option.
2. Enable the Use cookie value in transaction names option and provide the cookie name.
You can name a business transaction based on multiple cookies by providing the
comma-separated names of the cookies.
Use Session Attribute Values

You can name a business transaction based on the value of a particular session attribute key in
your request data.
Set the URI identification option.
Enable the Use session attribute values in transaction names option and provide the
session attribute key.
Use Methods

You can name a business transaction based on the GET/POST/PUT methods.
1. Set the URI identification option.
2.
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2. Enable the Specify request method in transaction names option.
Use Request Host

You can name a business transaction based on the request host.
1. Set the URI identification option.
2. Enable the Use request host in transaction names option.
Use Request Originating Address

You can name a business transaction based on the request's originating address.
1. Set the URI identification option.
2. Enable the Use request originating address in transaction names option.
Use Custom Expressions

You can use a custom expression to specify the name of business transaction.
1. Set the URI identification option.
2. Enter the expression. See Custom Expressions for Naming Business Transactions.
Use Part of an HTTP Parameter Value to Split a Business Transaction
For example, given an HTTP parameter, eventSource, that has values like:
TabBar:AccountTab:AccountTab_AccountNumberSearchItem_Button_act
Assuming getParameter returns a java.lang.string(), you can use the following expression in the A
pply a custom expression on HTTPServletRequest and use the result in Transaction Names
field:
{getParameter(eventSource).split(":").[0]}
AppDynamics uses everything up the first colon ':' to name the business transaction, in this
example "TabBar".

Additional Servlet-Based Business Transaction Detection Scenarios
For other detection scenarios see:
Learn More

For more information see:
Custom Naming Configurations for Servlet-Based Business Transactions
Use Parts of HTTP Requests to Name Global Servlet Entry Points
Configure Business Transaction Detection
Group URI Patterns for All Servlet Entry Points
Group URI Patterns for a Custom Servlet
Custom Naming Configurations for Servlet-Based Business Transactions

Custom Match Rules for Specific Contexts
To access business transaction detection custom configuration
Match on HTTP Methods
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Match on URIs
Split a URI Using Request Data
Split Based on the First Segments of the URI
Split Based on the Last Segments of the URI
Split Based on URI Segment Numbers
Split Based on Parameter Values
Split Based on Header Values
Split Based on Cookie Values
Split Based on an HTTP Method
Split Based on the Request Host
Split Based on the Request Originating Address
Split Based on a Custom Expression
Match on an HTTP GET or POST Parameter
To identify transactions based on the POST parameter
Match on a Header Parameter Name or Value
Match on a Hostname or Port
Match on a Class or Servlet Name
Match on a Cookie Name or Value
Match on Information in the Body of the Servlet Request
Learn More
This topic describes how to configure entry point detection for a particular Servlet-based
transaction using a custom match rule.
To configure at the global application or tier level see Automatic Naming Configurations for
Servlet-Based Business Transactions.
For context see Configure Business Transaction Detection and Servlet Entry Points.
Custom Match Rules for Specific Contexts

To handle situations when web contexts represent different parts of the same business application
and therefore require different naming configurations, use custom match rules for each of the web
contexts or URIs. Custom match rules let you create mutually exclusive business transactions for
specific contexts.
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See Custom Match Rules for general information.

You can use the transaction splitting option to separate business transactions based on URI
patterns, request data, or payload.
To access business transaction detection custom configuration
1. From the left navigation pane select Configure -> Instrumentation.
2. Click the Transaction Detection tab if it is not already selected.
3. Select the tier for which you want to configure the transactions or select the application if you
want to configure at the application level. For information about inheritance for transaction
detection, see Hierarchical Configuration Model.
4. Click the Java - Transaction Detection subtab.
5. In the Custom Match Rules panel click Add (the + sign).
6. To configure a rule for Servlets, select Servlet the drop-down list and click Next.
The New Business Transaction Match Rule - Servlet window opens.
7. Give the rule a name.
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8. If you have multiple custom match rules, change the priority based on the evaluation order of
the rule. Higher numbers will evaluate first, with 0 being the last custom rule to be evaluated. For
details see Sequence and Precedence for Auto-Naming and Custom Match Rules.
Match on HTTP Methods

You can use GET, POST, PUT, and DELETE methods to identify a business transaction.

Match on URIs

By default AppDynamics automatically discovers and identifies all Servlet-based business
transactions using the first two segments of the URI. You can change the global default or use a
different pattern for a custom match rule.
A custom rule can match a URI based on one of the following expressions:
Equals
Starts With
Ends With
Contains
Matches Reg Ex
Is in List
Is Not Empty
In addition you can configure a NOT condition:

Split a URI Using Request Data

You can split business transactions by adding attributes to either full or partial URI's for a Servlet
request. You can also append a key-value pair to a URI discovered name. This splits the URI into
a separate transaction.
1. First you configure the URI match. See the previous section.
2. Select the Split Transactions using Request Data tab and click the Split Transactions using
request data option.
3. Provide the details for dynamically splitting based on the following:
First Segments of the URI
Last Segments of the URI
Segment Numbers
Parameter Values
Header Values
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Cookie Values
HTTP Methods
Request Host
Request Originating Address
Use a Custom Expression
Split Based on the First Segments of the URI
Consider the following request URI:
http://acmeonline.com/store/checkout
Note that the "first two segments" is the same as the default global configuration. You may want to
use a similar custom match rule when you have a few different rules and you want to control the
order (Priority) by which the rules execute.

Split Based on the Last Segments of the URI
Consider the following request URI:
http://acmeonline.com/web/store/checkout
Using the default global discovery rules, AppDynamics automatically identifies this business
transaction as: /web/store. However the default does not accurately identify the functionality used
by the store, such as checkout or add to cart etc.
You can reset it to Use the last 2 segments so that the business transaction is named
"<Name_Of_The_Custom_Rule>.store.checkout".
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Split Based on URI Segment Numbers
You can name your transaction dynamically using a particular segment number.
For example: For ACME Online, the checkout operation has following URL:
http://www.acmeonline.com/shopping/customer1234/checkout
To correctly identify the user requests for "checkout" functionality, provide the segment numbers
("1,3"). This custom match rule groups all the qualifying requests into a "<Name_Of_The_Custom_R
ule>.shopping.checkout" transaction.
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For another example:

Split Based on Parameter Values
You can name a business transaction based on the value of a particular parameter in the request
data.
For example, ACME Online's checkout action results in following URL:
http://acmeonline.com/orders/process?type=creditcard
You want to use the combination of the parameter value for the parameter "type" and the last two
segments to identify a business transaction called "/orders/process.creditcard". This ensures that
the credit card orders are differentiated from other orders.On the "Transaction Match Criteria"
section, select the matching option for URI (in this case, "orders").
1. Define the URI.
2.
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2. For the Split Transactions using Request Data option, enter the parameter name ("type").
This custom rule will group all those requests for which the value of parameter "type" is
"creditcard" into a "<Name_Of_Custom_Rule>.creditcard" business transaction.
A custom rule may also identify other requests that use the same parameter. You can later choose
to exclude these transactions.
You can split based on multiple parameters by entering the comma-separated names of those
parameters.

Split Based on Header Values
You can also name your transaction based on the value of header(s) of your request data,
including the host name.
For example, to identify the requests based on the host name for ACME Online:
1. Define the URI.
2. For the Split Transactions using Request Data option, enter the header name
("Host").
This custom rule will put qualifying requests into a business transaction named
"<Name_Of_Custom_Rule>.<Host_Name>".
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You can also name your transaction based on multiple headers by entering the comma-separated
names of those headers.
Split Based on Cookie Values
You can also name your transaction based on the value of a particular cookie in your request data.
For example, you can identify only those business transactions where the "Gold" customers invoke
the checkout operation.
To do this, specify a custom rule as follows:
1. Define the URI.
2. For the Split Transactions using Request Data option, enter the name of the
cookie.
This configuration will also return those transactions for which the customer priority is not "Gold".
You can choose to exclude such transactions.
You can also name your transaction based on multiple cookies by providing the comma-separated
names of those cookies.
Split Based on an HTTP Method
You can name a business transaction based on GET/POST/PUT methods.
To do this, specify a custom rule as follows:
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1. Define the URI.
2. For the Split Transactions using Request Data option, select Use request
methods (GET/PUT/POST) in the transaction names.

Split Based on the Request Host
You canname a business transaction based on the request host.
1. Define the URI.
2. For the Split Transactions using Request Data option, select Use request host in
transaction names.
Split Based on the Request Originating Address
You can name a business transaction based on the request's originating address.
1. Define the URI.
2. For the Split Transactions using Request Data option, select Use the request
originating address in transaction names.
Split Based on a Custom Expression
You can use a custom expression to name a business transaction.
1. Define the URI.
2. For the Split Transactions using Request Data option, select Apply a custom
expression on HTTPServletRequest and use the result in Transaction Names.
3.
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3. Enter the custom expression. See Custom Expressions for Naming Business Transactions.
Match on an HTTP GET or POST Parameter

To identify transactions based on the POST parameter
For example, ACME Online's checkout operation for any item in the "Book" category results in a
POST parameter ("itemid") whose value is "Book".
To identify only those requests that belong to a "BuyBook" business transaction, configure the
custom match rule:
1.
2.
3.
4.
5.

In the Transaction Match Criteria tab, define the URI as "/shopping".
In the same tab, check the HTTP Parameter option.
Select Check for parameter value.
Enter the Parameter Name; in this example it is "itemid".
Set Value Equals to "Book".

With this custom match rule, every time a request matches the custom parameter rule it is
identified as part of the BuyBook business transaction.
Match on a Header Parameter Name or Value

A custom rule can match on a header parameter name.
1. In the Transaction Match Criteria tab, check Header.
2. Select Check for parameter existence and enter the parameter name.
A custom rule can match on a header parameter name and value.
1. In the Transaction Match Criteria tab, check Header.
2. Select Check for parameter value and enter the parameter name.
3. Enter a Value based on one of the following expressions:
Equals
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Starts With
Ends With
Contains
Matches Reg Ex
Is in List
Is Not Empty
Match on a Hostname or Port

A custom rule can match a hostname or port based on one of the following expressions:
Equals
Starts With
Ends With
Contains
Matches Reg Ex
Is in List
Is Not Empty
In addition you can configure a NOT condition.
Match on a Class or Servlet Name

A custom rule can match a class name or Servlet name on one of the following expressions:
Equals
Starts With
Ends With
Contains
Matches Reg Ex
Is in List
Is Not Empty
In addition you can configure a NOT condition.
Match on a Cookie Name or Value

A custom rule can match on a cookie name.
1. In the Transaction Match Criteria tab, check Cookie.
2. Select Check for cookie existence and enter the cookie name.
A custom rule can match on the value of a cookie.
1. In the Transaction Match Criteria tab, check Cookie.
2. Select Check for cookie value and enter the cookie name.
3. Enter a Value based on one of the following expressions:
Equals
Starts With
Ends With
Contains
Matches Reg Ex
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Is in List
Is Not Empty
Match on Information in the Body of the Servlet Request

In certain situations, you might have an application that receives an XML/JSON payload as part of
the POST request.
If the category of processing is a part of the XML/JSON, neither the URI nor the
parameters/headers have enough information to name the transaction. Only the XML contents that
can provide correct naming configuration.
See Identify Transactions Based on DOM Parsing Incoming XML Payload and Identify
Transactions for Java XML Binding Frameworks.
Learn More

Configure Business Transaction Detection
Business Transaction Configuration Methodology for Java
Servlet Entry Points
Automatic Naming Configurations for Servlet-Based Business Transactions

Custom Expressions for Naming Business Transactions

You can create custom expressions to name transactions based on the evaluation of a custom
expression on the HTTPServletRequestObject.
Suppose you want to monitor the HttpServletRequest request variable to identify the names and
values of all the request parameters passed with the request.
The following example shows a custom rule configuration based on the expression:
${getParameter(myParam)}-${getUserPrincipal().getName()}
which evaluates to:
request.getParameter("myParam")+"-"+request.getUserPrincipal()
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You can create a custom expression on the HTTPServletRequest to identify all Servlet based
requests (modify global discovery at the transaction naming level) or for a specific set of requests
(custom rule).
Request Attributes in the Custom Expression
A custom expression can have a combination of any of the following getter chains on the request
attributes:
Getters on Request Attributes

Transaction Identification

getAuthType()

Use this option to monitor secure (or insecure)
communications.

getContextPath()

Identify the user requests based on the portion
of the URI.

getHeader()

Identify the requests based on request
headers.

getMethod()

Identify user requests invoked by a particular
method.

getPathInfo()

Identify user requests based on the extra path
information associated with the URL (sent by
the client when the request was made).

getQueryString()

Identify the requests based on the query string
contained in the request URL after the path.

getRemoteUser()

Identify the user requests based on the login of
the user making this request.
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getRequestedSessionId()

Identify user requests based on the session id
specified by the client.

getUserPrincipal()

Identify user requests based on the current
authenticated user.

For example, the following custom expression can be used to name the business transactions
using the combination of header and a particular parameter:
${getHeader(header1)-${getParameter(myParam)}
The identified transaction will be named based on the result of following expression in your
application code:
request.getHeader("header1")\+ "-"\+ request.getParameter("myParam")

Advanced Servlet Transaction Detection Scenarios

See also:
Custom Naming Configurations for Servlet-Based Business Transactions
Servlet Entry Points
Identify Transactions Based on DOM Parsing Incoming XML Payload

Business Transactions and XML Payload
Identifying the Business Transaction Using the XPath Expression
To configure a custom match rule
Learn More
This topic describes how to identify transactions when an XML is posted to a Servlet.
Business Transactions and XML Payload

The XML contains the naming information for the Business Transaction. The Servlet uses a DOM
parser to parse the posted XML into a DOM object.

Identifying the Business Transaction Using the XPath Expression
For example, the following XML posts an order for three items. The order uses credit card
processing.
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<acme>
<order>
<type>creditcard</type>
<item>Item1</item>
<item>Item2</item>
<item>Item3</item>
</order>
<acme>

The URL is:
http://acmeonline.com/store

The doPost method of the Servlet is:

public void doPost(HttpServletRequest req, HttpServletResponse resp)
{
DocumentBuilderFactory docFactory =
DocumentBuilderFactory.newInstance();
DocumentBuilder docBuilder = docFactory.newDocumentBuilder();
Document doc = docBuilder.parse(req.getInputStream());
Element

element = doc.getDocumentElement();

//read the type of order
//read all the items
processOrder(orderType,items)
.....
}

The XPath expression "//order/type" on this XML payload evaluates to "creditcard".
This value correctly identifies the type of the order and therefore should be used to name the
"Order" transaction.
To identify the Business Transactions in this manner, first configure a custom match rule that
automatically intercepts the method that parses the XML and gets the DOM object.
You use the XPath expression in the custom rule so that it names the transaction, for example
"Store.order.creditcard". Though the name is not obtained until the XML is parsed, AppDynamics
measures the duration of the business transaction to include the execution of the doPost() method.
To configure a custom match rule
1. Navigate to the custom rule section for Servlets.
2. In the Transaction Match Criteria tab, specify the URI.
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3. In the Split Transactions Using Payloads tab, enable Split transactions using XML/JSON
Payload or a Java method invocation.
4. Set the split mechanism to XPath Expressions.
5. Enter the XPath expression that you want to set as the Entry Point. The result of the XPath
expression will be appended to the name of the Business Transaction.

You can use one or more XPath expressions to chain the names generated for the Business
Transaction.
If the expression does not evaluate to a value, the transaction will not be identified.
Learn More

Servlet Entry Points
Identify Transactions Based on POJO Method Invoked by a Servlet

Using a Java Method to Name a Transaction
To configure the custom match rule
Learn More
Using a Java Method to Name a Transaction

You can use a Java method to name the transaction where:
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You might not have a clear URI pattern or
You are using XML/JSON frameworks that are currently not supported by AppDynamics.
The following illustration shows how the Servlet that invokes the POJO method holds the
transaction name.

For example, consider the processOrder() method. The order is parsed using any type of method
and eventually when the processOrder() method is invoked, a correct approach to name
transaction is to capture the first parameter to the processOrder() method.
The following URL is used by these requests: http://acmeonline.com/store. Following code snippet
shows the doPost() method of the Servlet:

public void doPost(HttpServletRequest req, HttpServletResponse resp)
{
//process the data from the sevlet request and get the orderType and the items
processOrder(orderType,item)
.....
}
public void processOrder(String orderType,String item)
{
//process order
}

The processOrder() method has the information which can correctly derive the type of the order
and also the name of the transaction. To identify these requests as a single transaction, configure
a custom match rule.
To configure the custom match rule
1. Go to the custom rule section for Servlet Entry Points
2. In the Transaction Match Criteria tab, specify the URI.
3. In the Split Transactions Using Payload tab, enable Split transactions using XML/JSON
Payload or a Java method invocation.
4. Select POJO Method Call as the split mechanism .
5. Enter the class and the method name.
6. If the method is overloaded, also specify the details for the arguments.
7. Optionally, you can name your transactions by defining multiple methods in a getter chain in the
Method Call Chain field.
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The following screenshot displays the configuration of a custom match rule which will name all the
qualifying requests into a "Store.order.creditcard" transaction:

This custom rule ensures that the processOrder method is automatically intercepted.
Although the name is not obtained till the processOrder() method is called, the time for the
transaction will include all of the doGet() method.
In addition to the parameter, you can also specify either the return type or a recursive getter chain
on the object to name the transaction. For example, if the method parameter points to a complex
object like PurchaseOrder, you can use something like getOrderDetails().getType() to correctly
name the transaction.
Learn More

Servlet Entry Points
Identify Transactions for Java XML Binding Frameworks

To Configure the Custom Match Rule
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Supported Java XML data binding frameworks
Learn More
The following illustration shows the situation in which an XML is posted to a Servlet. The Servlet
uses an XML-to-Java binding framework, such as XMLBeans or Castor, to unmarshal and read
the posted XML payload.

The XML payload contains the naming information for the transactions.
In the following example, an XML payload posts an order for three items. It uses a credit card to
process the order.
The URL is: http://acmeonline.com/store

<acme>
<order>
<type>creditcard</type>
<item>Item1</item>
<item>Item2</item>
<item>Item3</item>
</order>
<acme>

The following code snippet shows the doPost() method of the Servlet:

public void doPost(HttpServletRequest req, HttpServletResponse resp)
{
PurchaseOrderDocument poDoc = PurchaseOrderDocument.Factory.parse(po);
PurchaseOrder po = poDoc.getPurchaseOrder();
\\
String orderType = po.getOrderType();
//read all the items
processOrder(orderType,items)
...
}

Copyright © AppDynamics 2012-2014

Page 1184

After the posted XML is unmarshalled to the PurchaseOrder data object, the getOrderType()
method should be used to identify the type of the order.
To Configure the Custom Match Rule
1. Navigate to the custom rule section for Servlet Entry Points.
2. In the Transaction Match Criteria tab, specify the URI.
3. In the Split Transactions Using Payload tab, check Split transactions using XML/JSON
Payload or a Java method invocation.
4. Select Java XML Binding as the split mechanism.
5. Enter the class name and the method name.
The screenshot below shows a custom match rule which identifies the business transaction for this
example as "Store.order.creditcard":

This custom rule ensures that the method in XMLBeans (which unmarshals XML to Java objects)
is automatically intercepted. It also ensures that the getOrderType() method is applied on the Java
data object only if it is the PurchaseOrder data object.
If the name of the transaction is not on a first level getter on the unmarshalled object, you can also
use a recursive getter chain such as getOrderType().getOrder() to get the name.
Although the transaction name is not obtained until the XML is unmarshalled, the response time
for the transaction is calculated from the doGet() method.
Supported Java XML data binding frameworks
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The following Java XML data binding frameworks are supported:
Castor
JAXB
JibX
XMLBeans
XStream
Learn More

Servlet Entry Points
Identify Transactions Based on JSON Payload

Example Configuration for a JSON Payload
Learn More
Example Configuration for a JSON Payload

The following illustration shows a JSON payload posted to a Servlet and the Servlet unmarshalls
the payload.

The JSON contains the naming information for the transactions.
For example, the following JSON payload posts an "order" for an item "car" and uses creditcard for
processing the order.
The URL is:
*http://acmeonline.com/store*

order
:{
type:creditcard,
id:123,
name:Car,
price:23
}}

The following code snippet shows the doPost method of the Servlet:
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public void doPost(HttpServletRequest req, HttpServletResponse resp)
{
//create JSONObject from servlet input stream
String orderType = jsonObject.get("type");\\
//read the item for the order\\
processOrder(orderType,item)\\
.....\\
}

After the posted JSON payload is unmarshalled to the JSON object, the "type" key is required to
identify the type of the order. In this case, this key uniquely identifies the business transaction.
To configure this rule:
1. Go to the custom rule section for Servlet Entry Points.
2. Under "Transaction Match Criteria" specify the URI.
3. Under "Split Transactions Using Payloads", enable "Split transactions using XML/JSON Payload
or a Java method invocation".
4. Select the split mechanism as "JSON".
5. Enter the JSON object key.
The following screenshot displays the configuration for a custom match rule that will name all the
qualifying requests into a single transaction called "Store.Order.creditcard".
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6. Set the property "enable-json-bci-rules" to "true" for each node to enable this custom rule. See
App Agent Node Properties.
This configuration ensures that the JSONObject and the get("$JSON_Object_Key") method on this
object are intercepted automatically to get the name of the transaction. Although the transaction
name is not obtained until the JSON object is unmarshalled, the response time for the transaction
will be calculated from the doGet method.
Learn More

Servlet Entry Points
App Agent Node Properties
Identify Transactions Based on URL Segment and HTTP Parameter

This topic describes a method you can use to identify transactions using both a URL Segment and
HTTP Parameter split to get split transactions based on page context or action.
Use Custom Expressions

Use the "Apply a custom expression on HTTPServletRequest and use the result in Transaction
Names" option for Servlet naming with the following expression. Using this method, the transaction
is named immediately.
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${getParameter(myparam)}-${getRequestURI().split(\/).[1,2]}

The above expression generates paramvalue-secondsegment-thirdsegment.

Identify Transactions for Grails Applications

Configure transaction identification for Grails applications by changing the default naming scheme
to use the full URI.
To configure business transactions for a Grails application
1. On the left hand side navigation of the AppDynamics User Interface, go to Configure ->
Instrumentation.
2. Select the Transaction Detection section.
3. Select the tier for which you want to enable identification.
4. Go to the Entry Points section.
5. Under the Servlet section, click Configure Naming.
This opens the configuration screen for modifying all the Servlets based transactions.
6. Select the Use the Full URI option.
7.
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7. Save this configuration.

Identify Transactions Based on Web Services

In certain situations Web Services may not correlate. This may occur when your Web Services
have identical names and timestamps.
Additionally, most stacks use their own dispatcher for the JAX WS RI Webservices stack and
because of the "com.sun package" this Servlet does not get instrumented.
To configure web service transactions with identical names and timestamps
1. Open the <Java App Server Agent_Installation_Directory>/conf/app-agent-config.xml file.
2. Modify the "override exclude" section in this file to include the filter value
"com.sun.xml.ws.transport.http.servlet.WSServlet".
<bci-processing-excludes>
&nbsp;&nbsp;&nbsp; <override-system-exclude filter-type="equals"
filter-value="com.sun.xml.ws.transport.http.servlet.WSServlet"/>
</bci-processing-excludes>

3. Save the file and restart the JVM where these changes were made.
Identify Transactions Based on the JSP Name

To identify transactions based on the name of the JSP being rendered
1. Create a custom match rule for the Servlets.
2. On the Transaction Match Criteria section, enable the URI option and specify the value as
'faces'.
This filter will capture all the qualifying requests.
3. Go to the Split Transactions Using Payload section.
4. Enable the Split Transactions using the XML/JSON payload or Java method invocation
option.
5. Select the option for POJO Method Call.
6. Specify the name of the class as 'com.sun.faces.application.ViewHandlerImpl'.
7. Specify the name of the method as 'renderView()'.
8. Specify the argument index as '1'.
9. Also, define the Method Call Chain or getter as 'getViewId()'. This name will be appended to
the name of the transaction.
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This custom rule generates business transactions that are named in the following pattern:
"<Name of the Custom Rule>.<path to jsp>".
You can later rename these business transactions to a more user-friendly name if you like.
Struts Entry Points

Struts-based Transactions
Struts Request Names
Custom Match Rules for Struts Transactions
Exclude Rules for Struts Actions or Methods
Problem When Custom-built Dispatch Servlet is Not Excluded
Struts-based Transactions

When your application uses Struts to service user requests, AppDynamics intercepts individual
Struts Action invocations and names the user requests based on the Struts action names. A Struts
entry point is a Struts Action that is being invoked.
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AppDynamics supports following versions of Struts:
Struts 1.x
Struts 2.x
Struts Action invocations are typically preceded by a dispatcher Servlet, but identification is
deferred to the Struts Action. This ensures that the user requests are identified based on the Struts
Action and not from the generic URL for Dispatcher Servlet.
The response time for the Struts-based transaction is measured when the Struts entry point is
invoked.
The following figure shows the identification process for Struts Action entry points.

Struts Request Names

When a Struts Action is invoked, by default AppDynamics identifies the request using the name of
Struts Action and the name of the method. All automatically discovered Struts-based transactions
are thus named using the convention <Action Name>.<Method Name>.
For example, if an action called ViewCart is invoked with the SendItems(), the transaction is
named "ViewCart.SendItems".
For Struts 1.x the method name is always "execute".
You can rename or exclude auto-discovered transactions. See Business Transaction List
Operations.
Custom Match Rules for Struts Transactions

For finer control over the naming of Struts-based transactions, use custom match rules.
A custom match rule lets you specify customized names for your Struts-based requests. You can
also group multiple Struts invocations into a single business transaction using custom match rules.
See Custom Match Rules for information about accessing the configuration screens.
The matching criteria for creating the rule are: Struts Action class names, Struts Action names,
and Struts Action method names.
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Exclude Rules for Struts Actions or Methods

To prevent specific Struts Actions and methods from being monitored add an exclude rule. See Ex
clude Rules. The criteria for Struts exclude rules are the same as those for custom match rules.
Problem When Custom-built Dispatch Servlet is Not Excluded

When a Struts action is called, it can demarcate a transaction as an entry point. AppDynamics
instruments the Struts invocation handler to get the action name because the Struts action is not
an interface. The invocation handler provides the App Agent for Java with the name of the action
being invoked. If the dispatcher Servlet is custom-built and has not been excluded from
instrumentation, the wrong entry point could be instrumented and the business transaction could
be misidentified.
To address this issue, add a custom exclude rule for the dispatcher servlet or add a BCI exclude
for it.
Web Service Entry Points

Web Services-based Transactions
Default Naming
Custom Match Rules for Web Services
Exclude Rules
Transaction Splitting for Web Services Based on Payload
This topic discusses Web Service Entry Points.
Web Services-based Transactions

When your application uses Web Services to service user requests, AppDynamics intercepts the
Web Service invocations and names requests based on the Web Service action names and
operation name. A Web Service entry point is a Web Service end point that is being invoked.
This is relevant only when the Web Service invocation is part of the entry point tier and not in a
downstream tier.
Web Service invocations are usually preceded by a dispatcher Servlet, but identification is
deferred to the Web Service endpoints. This configuration ensures that the requests are identified
based on the Web Service and not based on the generic URL for the dispatcher Servlet.
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Default Naming

When the Web Service end point is invoked, the request is named after the Web Service name
and the operation name.
For example, if a service called CartService is invoked with the Checkout operation, the is named
"CartService.Checkout".
You can rename or exclude these automatically discovered transactions. See Business
Transaction List Operations.
Custom Match Rules for Web Services

You can aggregate different Web Service requests into a single business transaction using the
web service name or the operation name. You do this by creating custom match rules for Web
Services. See Custom Match Rules for information about accessing the configuration screens.
The following example names all operations for the Web Service named "CartService":

Exclude Rules

To exclude specific Web Services or operation names from detection, add an exclude rule. See Ex
clude Rules. The criteria for Web Service exclude rules are the same as those for custom match
rules.
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Transaction Splitting for Web Services Based on Payload

1. Disable the Web Service automatic transaction discovery.
2. Disable the following default exclude rules:
Apache Axis Servlet
Apache Axis2 Servlet
Apache Axis2 Admin Servlet
3. Add the custom match rule for Axis or Axis2 Servlet (based on the version being used) and split
the transaction using payload or request depending on the pattern in your scenario.
POJO Entry Points

Considerations for Defining a POJO Entry Point
Defining a POJO Entry Point
To define a POJO Entry Point
Defining an Entry Point for a Method Using the Fully-Qualified Class Name
Defining an Entry Point for Classes that have Methods with Multiple Parameters
Defining an Entry Point for a Method that Extends a Super Class
Defining an Entry Point for a Method Using an Interface
Defining an Entry Point for a Method Using Annotations
Dynamically Identifying POJO Transactions Using Transaction Splitting
Defining an Entry Point based on a Parameter Value
To configure transaction splitting
Using a Method parameter for dynamically naming the transactions
Exclude Rules for POJO Transactions
Identifying a POJO Transaction as a Background Task
Learn More
Not all business processing can be implemented using Web entry points for popular frameworks.
Your application may perform batch processing in all types of containers. You may be using a
framework that AppDynamics does not automatically detect. Or maybe you are using pure Java.
In these situations, to enable detection of your business transaction, configure a custom match
rule for a POJO (Plan Old Java Object) entry point. The rule should be defined on the
class/method that is the most appropriate entry point. Someone who is familiar with your
application code should help make this determination. See Considerations for Defining a POJO
Entry Point.
AppDynamics measures performance data for POJO transactions as for any other transactions.
The response time for the transaction is measured from the POJO entry point, and the remote
calls are tracked the same way as remote calls for a Servlet's Service method.
Considerations for Defining a POJO Entry Point

The POJO entry point is the Java method that starts the transaction.
The most important consideration in defining a POJO entry point is to choose a method that
begins and ends every time the specific business transaction is invoked.
For example, consider the method execution sequence:
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com.foo.threadpool.WorkerThread.run()
calls com.foo.threadpool.WorkerThread.runInternal()
calls com.foo.Job.run()

The first two calls to run() method are the blocking methods that accept a job and invoke it.
The Job.run() method is the actual unit of work, because Job is executed every time the business
transaction is invoked and finishes when the business transaction finishes.
Methods like these are the best candidates for POJO entry points.
Defining a POJO Entry Point
To define a POJO Entry Point

1. Click Configure -> Instrumentation.
2. In the Transaction Detection tab select the tier.
3. Click Use Custom Configuration for this Tier.
4. Scroll down to the Custom Rules panel and click Add (the plus sign).
5. From the Entry Point Type dropdown menu select POJO and click Next.
6. In the New Business Transaction Match Rule - POJO window set the criteria for identifying
the entry point.
7. Save the configuration.
If you are running on IBM JVM v1.5 or v1.6, you must restart the JVM after defining the custom
match rules.
You may optionally refine the naming of a POJO-based transaction by transaction splitting.
See the following sections for examples:
Defining an Entry Point for a Method Using the Fully-Qualified Class Name
Defining an Entry Point for a Method Using a Superclass
Defining an Entry Point for a Method Using an Interface
Defining an Entry Point for a Method Using Annotations
Identify a POJO Transaction as a Background Task
See also Custom Match Rules.
Defining an Entry Point for a Method Using the Fully-Qualified Class Name

For the class named "Foo" and method doWork(), match on the fully-qualified class name and
method name:
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After you define and save the custom match rule for the POJO transaction, performance data for it
displays in the Business Transactions List.

The name of the POJO-based business transaction is the name of the custom match rule or entry
point definition.
In the example above. AppDynamics shows that the "doWork" method of class "Foo" was invoked
260 times and had an average response time of 678 ms (for the selected time range). Out of the
total invocations, 62 invocations were slow and 22 invocations were very slow (these slow or very
slow identification is based on the thresholds set for the business transaction).
Defining an Entry Point for Classes that have Methods with Multiple Parameters

For example, we want to instrument one of more methods in the following class:
class A
{
public void m1();
public void m1(String a);
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public void m1(String a, com.mycompany.MyObject b);
}
To instrument all the methods in the class, create a POJO-based business transaction
match rule as follows:
Match Classes with a Class Name that Equals A
Method Name Equals m1(java.lang.String)
To instrument only the method with one parameter, create a POJO-based business
transaction match rule as follows:
Match Classes with a Class Name that Equals A
Method Name Equals m1(java.lang.String)
To instrument only the method with two parameters, create a POJO-based business
transaction match rule as follows:
Match Classes with a Class Name that Equals A
Method Name Equals m1(java.lang.String, com.mycompany.MyObject)
Defining an Entry Point for a Method that Extends a Super Class

For example, the entry point is based on the com.acme.AbstractProcessor super class, which
defines a process() method, which is extended by its child classes: SalesProcessor,
InventoryProcessor, BacklogProcessor.
Define the custom rule on the method defined in the super class:

Defining an Entry Point for a Method Using an Interface

Define a custom rule matching on an interface named com.acme.IProcessor, which defines a
process() method that is implemented by the SalesProcessor, InventoryProcessor,
BacklogProcessor classes.

Copyright © AppDynamics 2012-2014

Page 1198

Defining an Entry Point for a Method Using Annotations

For example, if all processor classes are annotated with "@com.acme.Processor", a custom rule
should be defined using annotation.

By default, in these cases the business transaction started when any process() is invoked is
named Process, based on the name of the custom rule. To refine the transaction name to reflect
the specific method called (Process.SalesProcessor, Process.InventoryProcessor,
Process.BacklogProcessor) use transaction splitting.
Dynamically Identifying POJO Transactions Using Transaction Splitting

By default, when you create a custom match rule for POJO transactions, all the qualifying requests
are identified by the name of the custom match rule.
However, in many situations it is preferable to split POJO-based transactions, especially for nodes
that execute scheduled jobs.
For example, if multiple classes have the same method and are instrumented using the same rule,
when the method is invoked the class name of the instance being invoked can be used to classify
the request.
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If you split the transaction based on the simple class name, instead of one business transaction
named Process, the transaction that is started when the process() method is invoked is named
based on the rule name combined with the class name: either Process.SalesProcessor,
Process.InventoryProcessor, or Process.BacklogProcessor.
Defining an Entry Point based on a Parameter Value

In some cases you want to split the transaction based on the value of a parameter in the entry
point method. For example, you could configure the split on the following process() method:
public void process(String jobType,String otherParameters...)

where the jobType parameter could be Sales, Inventory or Backlog.

You can name POJO transactions dynamically using the following mechanisms:
method parameter
POJO object instance
fully qualified class name
simple class name
thread ID
thread name
method name
simple class name and method name
full class name and method name
In all cases, the name of the rule is prepended to the dynamically-generated name to form the
business transaction name.
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To configure transaction splitting

1. In the Transaction Splitting tab of the New Business Transaction Match Rule - POJO window,
click Split POJO Transactions using one of the following mechanisms...
2. Click the mechanism to use to split the transaction.
If you are specifying a method parameter, enter the zero-based parameter index of the
parameter.
If the parameter is a complex type, specify the getter chain to use used to derive the
transaction name.
If you are specifying a POJO object instance, specify the getter chain. See Getter Chains in
Java Configurations.
3. Click Save.

Using a Method parameter for dynamically naming the transactions

Suppose in the ACME Online example, instead of the super-class or interface, the type of the
processing is passed in as a parameter.
For example:
public void process(String jobType,String otherParameters...)

In this case, it would be appropriate to name the transaction based on the value of Job type. This
Job type is passed as the parameter.
To specify a custom rule for method parameter:
1. Specify the details for the custom rule in the Transaction Match Criteria tab.
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2. Click the Transaction Splitting tab.
3. Click Split POJO Transactions using one of the following mechanisms...
4. Select the option for the method parameter.
5. Specify the details for the parameters.
You can use a getter chain if the parameter is of complex type in order to derive a string value,
which can then be used for the transaction name. See Getter Chains in Java Configurations.

Exclude Rules for POJO Transactions

To prevent configured transaction splitting from being applied in certain situations, create an
exclude rule defined on the output of the transaction splitting.
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Identifying a POJO Transaction as a Background Task

When you want to specify that a POJO transaction is a background task, check Background Task
.

When a request runs as a background task, AppDynamics reports only Business Transaction
metrics for the request. It does not aggregate response time and calls metrics at the tier and
application levels for background tasks. This is ensures that background tasks do not distort the
baselines for the business application. Also, you can set a separate set of thresholds for
background tasks. See Monitor Background Tasks.
Learn More

Identify Transactions Based on POJO Method Invoked by a Servlet
Spring Bean Entry Points

Spring Bean-based Transactions
Default Naming for Spring Bean Requests
To Enable Auto-discovery for Spring Bean entry points
Custom Match Rules for Spring Bean Requests
Exclude Rules Spring Bean Transactions
This topic describes how to configure transaction entry points for Spring Bean requests.
Spring Bean-based Transactions

AppDynamics allows you to configure a transaction entry point for a particular method for a
particular bean in your environment. The response time is measured from when the Spring Bean
entry point is invoked.
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Default Naming for Spring Bean Requests

When the automatic discovery for a Spring Bean based request is turned on, AppDynamics
automatically identifies all the Spring Beans based transactions and names these transactions
using the following format:
BeanName.MethodName

By default, the transaction discovery for Spring Bean-based requests is turned off.
To Enable Auto-discovery for Spring Bean entry points

1. Access the transaction detection configurations screen and select the tier to configure. See To
Access Business Transaction Detection Configuration
2. In the Spring Bean entry in the Entry Points section check the Automatic Transaction Detection
check box.
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Custom Match Rules for Spring Bean Requests

If you are not getting the required visibility with the auto-discovered transactions, you can create a
custom match rule for a Spring Bean based transaction. See Custom Match Rules.
The following example creates a custom match rule for the placeOrder method in the
orderManager bean.

Exclude Rules Spring Bean Transactions

To exclude specific Spring Bean transactions from detection add an exclude rule. See Exclude
Rules. The criteria for Spring Bean exclude rules are the same as those for custom match rules.
EJB Entry Points

EJB-Based Business Transactions
Default Naming for EJB Entry Points
To Enable the Auto-discovery for EJB Transactions
Custom Match Rules for EJB based Transactions
Exclude Rules for EJB Transactions
This topic describes how to configure transaction entry points for the EJB based requests.
EJB-Based Business Transactions

AppDynamics allows you to configure an EJB-based transaction entry point on either the bean
name or method name. The response time for the EJB transaction is measured when the EJB
entry point is invoked.
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Default Naming for EJB Entry Points

AppDynamics automatically names all the EJB transactions <EJBName>.<MethodName>. By
default, automatic transaction discovery for EJB transactions is turned off. To get visibility into
these transactions, enable the auto-discovery for EJB based transactions explicitly.
Keep in mind the following before you enable auto-discovery for EJB based transactions:
If the EJBs use Spring Beans on the front-end, the transaction is discovered at the Spring
layer and the response time is measured from the Spring Bean entry point. This is because
AppDynamics supports distributed transaction correlation.
AppDynamics groups all the participating EJB-based transactions (with remote calls) in the
same business transaction. However, if your EJBs are invoked from a remote client where
the App Server Agent is not deployed, these EJBs are discovered as new business
transactions.
To Enable the Auto-discovery for EJB Transactions

1. Access the transaction detection configurations screen and select the tier to configure. See To
Access Business Transaction Detection Configuration.
2. In the EJB entry in the Entry Points section check the Automatic Transaction Detection check
box.
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Custom Match Rules for EJB based Transactions

If you are not getting the required visibility with auto-discovered transactions, create a custom
match rule for a EJB based transaction. See Custom Match Rules.
The following example creates a custom match rule for the receiveOrder method in the TrackOrder
bean. The transactions are named " ACME_EJB.TrackOrder.receiveOrder".
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In addition to the bean and method names, other match criteria that could be used to define the
transaction are the EJB type, class name, superclass name and interface name.
Exclude Rules for EJB Transactions

To exclude specific EJB transactions from detection add an exclude rule. See Exclude Rules. The
criteria for EJB exclude rules are the same as those for custom match rules.
JMS Entry Points

Messaging Entry Points
Default Naming Conventions
To Access the Default Configuration for Messaging Entry Points
Custom Match Rules for Messaging Entry Points
Grouping Example
Message Payload Example
Learn More
This topic discusses messaging entry points configuration.
Messaging Entry Points

When an application uses asynchronous message listeners or message driven beans, such as
JMS or equivalent MQ providers as the primary trigger for business processing on the entry point
tier AppDynamics can intercept the message listener invocations and track them as business
transactions. This is relevant only for the entry point tier.

You can define messaging entry points for queue listeners to monitor Service Level Agreements
(SLAs). An SLA is often reflected in the rate of processing by a queue listener. When you monitor
a messaging entry point, you can track the rate of processing by a particular queue listener.
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Default Naming Conventions

AppDynamics automatically detects and names the messaging entry points. When a message
listener is invoked, the transaction is named after the destination name (the queue name) or the
listener class name if the destination name is not available.
To Access the Default Configuration for Messaging Entry Points

1. Access the business transaction configuration page.
See To Access Business Transaction Detection Configuration.
2. Scroll down to message entry point entry for your framework.
Custom Match Rules for Messaging Entry Points

If you want finer control over naming messaging requests, you can use custom match rules either
to specify names for your messaging entry points or to group multiple queue invocations into a
single business transaction.
See To Create Custom Match Rules for general information about configuring custom match rules.
Grouping Example

The following custom match rule groups all transactions to queues starting with the word "Event"

Message Payload Example

The following custom rule uses message properties (headers) to define the custom match rule.
You can also use the message content. You can also use message properties or message content
to define custom exclude rules to exclude certain messaging entry points from detection.
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Learn More

Configure Business Transaction Detection
Binary Remoting Entry Points for Apache Thrift

Default Naming for Binary Remoting (Thrift) Entry Points
Enabling Auto-discovery for Binary Remoting (Thrift) Entry Points
Creating Custom Match Rules for Binary Remoting (Thrift) Requests
Apache Thrift is a binary remoting protocol. Cassandra uses the Thrift protocol to achieve
portability across programming languages. Applications written in many different languages can
make calls to the Cassandra database using the Thrift protocol.
AppDynamics is preconfigured to detect transaction entry points for Cassandra with Thrift
framework applications.
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AppDynamics measures performance data for Thrift transactions as for any other transaction.
Thrift entry points are POJO-based. The response time for the transaction is measured from the
POJO entry point, and the remote calls are tracked the same way as remote calls for a Servlet's
Service method.
Default Naming for Binary Remoting (Thrift) Entry Points

When the automatic discovery for a request using Binary Remoting (Thrift) protocol is enabled,
AppDynamics automatically identifies all the transactions and names them using the following
format:
RemoteInterfaceClassName:MethodName

By default, transaction discovery for Binary Remoting (Thrift)-based request is enabled.
Enabling Auto-discovery for Binary Remoting (Thrift) Entry Points

Binary Remoting (Thrift) entry points are enabled by default, but if you are not seeing them in the T
ier Flow Map, you should ensure they have been enabled as follows.
1. Access the transaction detection configuration window and select the tier to configure. See To
Access Business Transaction Detection Configuration.
2. In the Binary Remoting entry of the Entry Points section, click Automatic Transaction
Detection.
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When enabled, you can see Thrift calls from calling tiers to the Cassandra database in the List
View of the Tier Dashboard. Since the transactions using the Thrift protocol are POJO-based,
they appear as POJO in the Type column.

Creating Custom Match Rules for Binary Remoting (Thrift) Requests

If you are not getting the required visibility with the auto-discovered transactions, you can
configure custom match rules and transaction splitting for specific classes and methods.
To enable detection of your binary remoting business transactions, configure a custom match rule.
The rule should be defined on the class/method that is the most appropriate entry point. Someone
who is familiar with your application code should help make this determination.
A custom match rule lets you specify customized names for your Binary Remoting (Thrift) based
requests. You can also group multiple Thrift invocations into a single business transaction using
custom match rules. See Custom Match Rules for information about accessing the configuration
windows.
The matching criteria for creating the custom entry point rule for a Thrift request are the POJO
class name and method name of the business transaction initiating the binary remote call.
Transaction splitting and exclude rules are also supported. For information about and examples of

Copyright © AppDynamics 2012-2014

Page 1212

the various POJO-based business transaction match rules you can create for Binary Remoting
(Thrift), see POJO Entry Points. The rules for Binary Remoting (Thrift) entry points are consistent
with those for POJO entry points.

CometD Support

CometD is a scalable HTTP-based event routing bus for transporting asynchronous messages
over HTTP. CometD provides both a JavaScript API and Java API and is used for applications
such as multi-player games and chat rooms. AppDynamics supports both the
WebSocket and HTTP long-polling client transports. CometD sends messages to channels and we
can now track messages through the channels.
New rules defined in the agent:
New POJO rules to gather message activity
Business transaction split configuration on the POJO rules to determine which channel the
message was published to, tracks business transaction per channel
New servlet exclude rules - since the CometD Servlet implements the different transports
activity, you need to exclude the Servlets implementing the CometD transports. CometD is
generally contained within a Jetty container, you need to exclude the Jetty container tracking
in order to see the CometD messages contained within the transaction. CometD servlets are
excluded by default. The following are the Jetty Servlet exclude rules:
EQUALS, org.eclipse.jetty.server.handler.ContextHandler
EQUALS, org.eclipse.jetty.servlet.ServletContextHandler
ENDSWITH, jetty.plugin.JettyWebAppContext
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Mule ESB Support

Mule ESB 3.4 and previous releases are supported.
Mule ESB (Enterprise Service Bus) is an integration platform with many different connectors for
integrating applications and supporting service oriented architectures. By default, AppDynamics
detects the Mule ESB endpoint. However, in some situations, you may need to create a servlet
exclude rule.
The App Agent for Java supports Mule ESB as follows:
Tracks Business Transactions to Remote Services and Tiers
No configuration required: The App Agent for Java detects business application calls through
Mule ESB service connections to remote services and tiers. Mule ESB is automatically detected
and continuing tiers are recognized. Asynchronous correlation is enabled by default. Business
transaction naming is dependent on business transaction discovery.
Detects incoming HTTP to the Mule ESB HTTP endpoint when it performs as a servlet
No configuration required: If your application takes the output of the Mule ESB HTTP endpoint
and makes it perform like a servlet, the App Agent for Java detects incoming HTTP to the Mule
HTTP Endpoint as a servlet.
Detects SOAP or RESTful operations beyond the Mule ESB HTTP Endpoint
Servlet Exclude Rule Required: Mule ESB can function as a transport connector.In some cases
the Mule ESB HTTP endpoint is an entry point to another application component. For example, the
Mule ESB HTTP endpoint can be an entry point to an application that ends with a CXF SOAP
service or a JAX-RS RESTful endpoint further in the tier. By default, the App Agent for Java treats
the Mule ESB HTTP output as a servlet, an endpoint in the application and doesn't see the the
CXF SOAP or JAX-RS RESTful operation further in the flow. In order to see the SOAP or RESTful
operation, we need to exclude the Mule ESB HTTP servlet.
For example, we have an application using Mule ESB services at this URI: http://muleapp1:8080/
There are some HTTP response servlets on: http://muleapp1:8080/httpResponseService/
and there is a CXF SOAP endpoint
on: http://muleapp1:8080/webservicenedpoint/
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To see the CXF SOAP endpoint, we need to create a servlet exclude rule on
uri:http://muleapp1:8080/webservicenedpoint/
We do not need to create a servlet exclude rule when the Mule ESB HTTP endpoint continues to
another tier or for exit points within Mule ESB.
See also, Mule ESB Startup Settings.
JAX-RS Support

AppDynamics Agent for Java supports Jersey 1.x and 2.x by default. Business transaction entry
points are named using the following app agent node properties:
rest-num-segments
rest-transaction-naming
rest-uri-segment-scheme
Examples
Using Default Settings

By default the business transaction is named using the first two segments of the REST URI and
the name of the HTTP method, separated by a period. The application name part of the URI is not
used.
rest-transaction-naming={rest-uri}.{http-method}

For example, using default settings, when the App Agent for Java detects this REST resource as
an entry point,
/REST/MyApplication/MyResource/resource
The agent uses the URI of the REST resource to name the business transaction.
The REST resource is accessible using the HTTP method GET.
So, the business transaction name would be,
MyResource/resource.GET
where MyResource/resource is the first two segments of the REST URI
and GET is the HTTP method.

Using rest-transaction-naming Properties

Using the rest-transaction-naming property, you can name the business transaction using a
number of properties. For this example, we'll use the following agent node property:
rest-transaction-naming={class-name}/{method-name}
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So, when the App Agent for Java sees a REST resource with a class name of com.company.rest.r
esources.Employees with a CreateNewEmployee method, it names the business transaction com.
company.rest.resources.Employees/CreateNewEmployee.

Learn More

App Agent Node Properties Reference
Spring Integration Support

In Spring-based applications, Spring Integration enables lightweight messaging and supports
integration with external systems via declarative adapters.
The App Agent for Java by default automatically discovers exits for all Spring Integration Release
2.2.0 channels except 'DirectChannel.'
See the Sample Application Flow XML below.
AppDynamics Pro Agent for Java supports tracking application flow through Spring Integration me
ssaging channels. The App Agent for Java Spring Integration support is based on the
MessageHandler interface.
For pollable channels:
A continuing transaction is tracked if the Spring Integration framework is polling for
messages.
If the application code polls for messages in a loop, the span of each loop iteration is tracked
as a transaction. Tracking begins when the loop begins and end it when the iteration ends.
Entry points
Originating transactions begin with MessageHandler.handleMessage() implementations. If the
incoming message is already recognized by the App Agent for Java then a continuing transaction
is started.
Exit points
Exit points are based on MessageChannel.send(). Most of these message channels are typically
inside the JVM so the Application Flow Maps shows a link from the tier to the message channel
component name (bean name) and back.
Spring Integration Support Customizations
Track Application Flow Before Message Handler is Executed

In cases where a lot of application flow happens before the first MessageHandler gets executed,
you should enable tracking the application flow as follows:
Find a suitable POJO entry point and configure it.
Set the enable-spring-integration-entry-points node property to 'false'. This property is set to
'true' by default.
Restart the application server
Limit Tracking of Looping Pollable Channels
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To safeguard against cases where pollableChannel.receive() is not called inside a loop, you
can ensure that the App Agent for Java tracks a pollable channel loop only if it happens inside a
class/method combination similar to that defined in the following example. Configure the spring-int
egration-receive-marker-classes node property for each class/method combination that polls
messages in a loop, then only those class/methods identified in this node property are tracked.
class MessageProcessor
{
void process()
{
while(true)
{
Message message = pollableChannel.receive()
}
}
}

For example, for the loop above, set the spring-integration-receive-marker-classes node property
as follows and restart the application server:
spring-integration-receive-marker-classes=MessageProcessor/process

Note: The spring-integration-receive-marker-classes node property must be configured before the
method process() gets executed for any changes to take effect. Restart the application server after
setting this property.
Sample Application Flow XML

The following XML specifies the integration flow configuration of the application tracked in the
image above.
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<?xml version="1.0" encoding="UTF-8"?>
<beans:beans xmlns="http://www.springframework.org/schema/integration"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:beans="http://www.springframework.org/schema/beans"
xsi:schemaLocation="http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans.xsd
http://www.springframework.org/schema/integration
http://www.springframework.org/schema/integration/spring-integration.xsd">

<channel id="inputChannel">
<queue capacity="100"/>
</channel>
<channel id="out"/>
<bridge input-channel="inputChannel" output-channel="out">
<poller max-messages-per-poll="10" fixed-rate="5000"/>
</bridge>

<channel id="outputChannel">
<queue capacity="100"/>
</channel>

<service-activator input-channel="out"
output-channel="outputChannel"
ref="helloService"
method="sayHello"/>
<channel id="out2">
<queue capacity="100"/>
</channel>

<bridge input-channel="outputChannel" output-channel="out2">
<poller max-messages-per-poll="10" fixed-rate="5000"/>
</bridge>

<beans:bean id="helloService"
class="org.springframework.integration.samples.helloworld.HelloService"/>
</beans:beans>

In the following statements, you can see Spring Integration channels that are recognized and
identified in the Application Flow Map visualized above:
<channel id="out">
<channel id="outputChannel">
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Instrumenting Apple WebObjects Applications

This document helps you instrument applications written with WebObjects 5.4.3 on OSX 10.9
systems.
After installing WebObjects, you can find most of the artifacts in the following directories:
/Developer/Examples/JavaWebObjects
/Developer/Applications/WebObjects

We will use one of the developer examples in the following section to illustrate how to instrument
an application created with Apple WebObjects.
Instrumenting a Sample App

When you run the HelloWorld application,
/Developer/Examples/JavaWebObjects/HelloWorld,
a script file is generated
/Developer/Examples/JavaWebObjects/HelloWorld/dist/legacy/HelloWorld.woa/HelloWorld.
Open up the generated script
file, /Developer/Examples/JavaWebObjects/HelloWorld/dist/legacy/HelloWorld.woa/HelloWorld, an
d towards the end of the file, line 310 in the following example, you'll see the Java execute line:

Add the standard App Agent for Java arguments to the Java execution script for the HellowWord
applicaiton:

You can configure business transaction name using getter-chains. For more information, see
Getter Chains in Java Configurations
Identify Transactions Based on POJO Method Invoked by a Servlet
Exclude Rule Examples for Java

Exclude Business Transactions Using Exclude Rules
Change the Default Exclude Rule Settings
Use the Next Layer of Application Logic
Use an Exclude Rule as a Filter
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Exclude Spring Beans of Specific Packages
Learn More
Exclude Business Transactions Using Exclude Rules

Exclude rules prevent detection of business transactions that match certain criteria. You might
want to use exclude rules in the following situations:
AppDynamics is detecting business transactions that you are not interested in monitoring.
You need to trim the total number of business transactions in order to stay under the agent
and controller limits.
You need to substitute a default entry point with a more appropriate entry using a custom
match rule.
You can customize existing rules:
Change the Default Exclude Rule Settings
and/or setting up new rules:
Use the Next Layer of Application Logic
Use an Exclude Rule as a Filter
Exclude Spring Beans of Specific Packages
Change the Default Exclude Rule Settings

AppDynamics has a default set of exclude rules for Servlets. Sometimes you need to adjust the
default exclude rules by disabling a default rule or adding your own exclude rules.
Several entry points are excluded by default as shown here. You can change their default settings

Use the Next Layer of Application Logic

When the incoming request starts at some control logic in your code that triggers different
business logic based on payload data, you may prefer the business logic class and method as
your business transaction names. You can exclude the control logic from being identified as the
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business transaction, and have the business logic be identified instead.
For example, when the control logic and business logic are built as EJBs, enabling EJB discovery
will result in business transactions based on the control class and method. Instead, you can create
an EJB exclude rule using the match criteria Class Name Equals the control class name and then
the business logic APIs can be discovered as business transactions. This type of exclude rule
looks similar to this:

Use an Exclude Rule as a Filter

Another reason to use an exclude rule is to use it like a filter, where you allow the eligible requests
and ignore everything else.
For example, you want to use default discovery rules. Your application is receiving URI ranges that
start with : /a, /b ... /z, however you want to monitor URIs only when they start with /a and /b. The
easiest way to achieve this is to create a Servlet exclude rule that does a Match : Doesn't Start
With /a or /b as shown here:
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Exclude Spring Beans of Specific Packages

In this scenario, an application has a couple of Spring Beans of the class java.lang.String and
java.util.ArrayList. Because of this, all instances of these classes are being mismarked as Spring
Beans with the same IDs. To fix this behavior and exclude specific Spring Bean IDs, you can
define an exclude rule as follows:
1. In the left navigation panel, click Configure -> Instrumentation.
2. Select the Transaction Detection tab.
3. Select your tier.
4. Navigate to the Exclude Rules section.
5. Click on "+" to create a new rule and select Spring Bean from the Entry Point Type menu.
6. Provide a name for the exclude rule.
7. In the popup, enable the Bean ID match criteria, use the Equals option and type the Spring
Bean ID that you want to exclude from discovery as a business transaction.
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Learn More

Business Transaction Configuration Methodology for Java
Configure Business Transaction Detection
Fine-Tune Configurations Using Match Conditions
Regular Expressions In Match Conditions
Configure Multi-Threaded Transactions for Java
Default Configuration
Custom Configuration
Managing Thread Correlation Using a Node Property
Enabling and Disabling Asynchronous Monitoring
To Disable the New Method of Asynchronous Monitoring
To Disable all Asynchronous Monitoring
To Enable Asynchronous Monitoring
Learn More
AppDynamics collects and reports key performance metrics for individual threads in multi-threaded
Java applications. See Trace MultiThreaded Transactions for Java for details on where these
metrics are reported.
In addition to support for applications written in Java, applications running in the JVM that are
written with Groovy are also supported. Groovy classes can be intercepted, servlets are detected
by default, and exit calls and thread correlation are supported without any additional configuration.
Default Configuration

Classes for multi-threaded correlation are configured in the <excludes> child elements of the
<fork-config> element in the
<App_Server_Agent_Installation_Directory>/conf/app-agent-config.xml file.
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The default configuration excludes the java, org, weblogic and websphere classes:
<fork-config>
<!-- exclude java and org -->
<excludes filter-type="STARTSWITH" filter-value="com.singularity/"/>
<excludes filter-type="STARTSWITH"
filter-value="java/,javax/,com.sun/,sun/,org/"/>
<!-- exclude weblogic and websphere -->
<excludes filter-type="STARTSWITH"
filter-value="com.bea/,com.weblogic/,weblogic/,com.ibm/,net/sf/,com/mchange/""/>
. . .

Note: The agent supports package names where the levels in the hierarchy are either separated
by dots (.) or slashes
. The agent converts the dots to slashes internally.
Custom Configuration

You can edit the app-agent-config.xml file to exclude additional classes from thread correlation. All
classes not excluded are by default included.
You can also explicitly include sub-packages and subclasses of excluded packages and classes.
Use the <includes> or <include> child element to specify the included packages and classes.
Use the <excludes> and <includes> elements to specify a comma-separated list of classes or
packages. Use the <exclude> and <include> elements to specify a single class or package
Managing Thread Correlation Using a Node Property

You can also configure which classes or packages to include or exclude using a node property.
See thread-correlation-classes and thread-correlation-classes-exclude.
Enabling and Disabling Asynchronous Monitoring

You should disable monitoring of multi-threaded transactions on all agents if all of your agents
and your controller are not at AppDynamics version 3.6 or higher. The previous methodology for
monitoring asynchronous communications was problematic. You can enable the feature after all of
your agents have been upgraded.
You must restart the agent after you enable or disable this feature.
To Disable the New Method of Asynchronous Monitoring

1. In the left navigation pane click Configure->Instrumentation->Transaction Detection.
2. From the Actions menu in the upper left corner click Disable Async Monitoring.

To Disable all Asynchronous Monitoring

Set the App Agent Node property, thread-correlation-classes-exclude to disable asynchronous
monitoring for all the relevant classes.
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thread-correlation-classes-exclude=a,b,c,d,e,f,...z

or
Add the following line under the fork-config section of the app-agent-config.xml file.
<exclude filter-type="REGEX" filter-value=".*"/>

To Enable Asynchronous Monitoring

1. In the left navigation pane click Configure->Instrumentation->Transaction Detection.
2. From the Actions menu in the upper-left corner click Enable Async Monitoring.

Learn More

Configure Business Transaction Detection
App Agent Node Properties
Configure End-to-End Message Transactions for Java

About End-to-End Message Monitoring
Configure End-to-End Performance Monitoring
To enable end-to-end message transaction monitoring
End-to-End Performance Metrics
Learn More
About End-to-End Message Monitoring

As described in Configure Multi-Threaded Transactions for Java, AppDynamics can automatically
detect and monitor asynchronous threads spawned in Java and .NET applications as part of a
business transaction. The request response times for such business transactions reflect the length
of time from when the entry point thread receives the request until it responds to the client. In a
highly distributed, asynchronous application, however, this response time doesn't always reflect
the actual amount time it takes to fully process a request.
For example, consider an asynchronous application with an entry point method in a request
handler that spawns multiple threads, including one to serve as the final response handler. The
request handler thread then returns a preliminary response to the client, stopping the clock for
purposes of measuring the response time of the business transaction.
Meanwhile the spawned threads continue to execute until completion, at which point the response
handler generates the final response to the client. In this case, the time it takes for the complete,
logical transaction that the AppDynamics user wants to monitor does not match the reported
response time metric for the business transaction.
End-to-end metrics give you a way to measure the processing time for business transactions for
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which response time alone does not reflect the entire request processing workflow. The
end-to-end message metrics show how long it takes to process the end-to-end transactions, the
number of end-to-end transactions per minute, and the number of slow end-to-end message
processing events.
Configure End-to-End Performance Monitoring

To use end-to-end message monitoring, you need to identify a method in your application that acts
as the logical end point in the transaction processing sequence. For our sample response handler,
this could be the method in the response handler that waits for threads to complete, assembles the
response and sends it to the client.
To enable end-to-end message monitoring in AppDynamics:
Make sure that the threads in the logical transaction processing flow are traced by
AppDynamics, including the thread that contains the end-point method. If needed, configure
custom correlation to ensure that all threads are properly traced. For more information, see
in Configure Multi-Threaded Transactions for Java.
Configure the end-to-end message settings in the App Agent for the node that contains the
business transaction entry point, as described here
To enable end-to-end message transaction monitoring

1. In the application navigation tree, navigate to the node that contains the entry point for the
messages for which you want to measure end-to-end performance.
2. Click the Agents tab.
If the Agents item is not visible in the tab bar, expand the tab bar, as shown:

3. Click the Configure button.
4. Click Use Custom Configuration.
5. Set values for the following agent properties by double-clicking the property and entering
new values for each:
a. async-transaction-demarcator: Specifies the class name and name for the method
that serves as the termination point for the end-to-end transaction. It should be in the
format: class_name/method_name
b. end-to-end-message-latency-threshold-millis: Optionally, set a value in milliseconds
that, if exceeded by the time it takes to process an end-to-end message, causes the
transaction to be considered a slow end-to-end message and sends an event to the
Controller.
You can navigate to the settings quickly by filtering the view with "async". For example:
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6. Click Save to apply your changes.
End-to-end latency metrics should now appear for any business transactions that has an entry
point on the configured node and invokes the transaction demarcator method. Values for
end-to-end message transaction performance should also appear in the metric browser view for
the node and for the overall application.
End-to-End Performance Metrics

The overall application performance metrics for end-to-end message transactions are:
Average End to End Latency: The average time in milliseconds spent processing
end-to-end message transactions over the selected time frame.
End to End Messages per Minute: The average number of transactions that are measured
as end-to-end message transactions per minute over the selected time frame.
Number of Slow End to End Messages: The number of end-to-end message transactions
that exceeded the configured end-to-end latency threshold over the selected time frame.
For information on how to accessing the overall application performance metrics, see Metric
Browser.
Learn More

Measure Distributed Transaction Performance
Configure Multi-Threaded Transactions for Java
Configure Backend Detection for Java

Types of Exit Points
View the Discovery Rules
Revise Backend Discovery Rules
Change the Default Discovery Rules
Add Backend Discovery Rules
Add Custom Exit Points
Propagate Changes to Other Tiers or Applications
Learn More
To review general information about monitoring databases and remote services (collectively
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known as backends) and for an overview of backend configuration see Backend Monitoring.
Types of Exit Points

Each automatically discovered backend type has a default discovery rule and a set of configurable
properties. See the following:
Configure Custom Exit Points for Java
Configurations for Custom Exit Points for Java
HTTP Exit Points for Java
JDBC Exit Points for Java
Message Queue Exit Points for Java
Web Services Exit Points for Java
Cassandra Exit Points for Java
RMI Exit Points for Java
Thrift Exit Points for Java
View the Discovery Rules

To view the discovery rules for an automatically discovered backend, access the backend
configuration window using these steps:
1. Select the application.
2. In the left navigation pane, click Configure -> Instrumentation.
3. Select the Backend Detection tab.
4. Select the application and the tab corresponding to your agent platform (Java, .NET, PHP).

The Automatic Backend Discovery default configurations for that agent are listed.
5. In the Automatic Backend Discovery list, click the backend type to view.
A summary of the configuration appears on the right. For example, the following figure shows that
JMS backends are auto-discovered using the Destination, Destination Type, and Vendor.
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Revise Backend Discovery Rules

If the default settings don't give you exactly what you need, you can refine the configuration in the
following ways:
Change the default discovery rules:
Enable or disable one or more of the properties
Use one or more specified segments of a property
Run a regular expression on a property
Execute a method on a property
Add new discovery rules
Add custom exit points
The precise configurations vary according to the backend type. These general features are
configurable:
Discovery Enabled - You can enable and disable automatic discovery for the backend type.
Undiscovered backends are not monitored.
Correlation Enabled - You can enable and disable correlation. Correlation enables
AppDynamics to tag, trace, and learn about application calls to and through the backend to
other remote services or tiers. For example, if a call is made from Tier1 -> Backend1 ->
Tier2, Tier2 knows about the transaction flow because the agent "tags" the outbound call
from Backend1 to identify it as related to the same transaction that called Backend1 from
Tier1. If you do not care about activity downstream from the backend, you may want to
disable correlation.
Backend Naming - You can configure how backends are named.
Change the Default Discovery Rules

When you need to revise the default set of discovery rules, in many cases, you can achieve the
visibility you need by making adjustments to the default automatic discovery rules. For some
scenarios, you might want to disable some or all of the default rules and create custom rules for
detecting all your backends. AppDynamics provides flexibility for configuring backend detection.
For example, detection of HTTP backends is enabled by default. In Java environments, HTTP
backends are identified by the host and port and correlation with the application is enabled. To
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change the discovery rule for HTTP backends in some way, such as disabling correlation, omitting
a property from the detected name, or using only certain segments of a property in the name, you
edit the HTTP automatic discovery rule.
Review the rules for each exit point to determine the best course of action for your application if
the default discovery rules do not give the results you need for your monitoring strategy.
To change default backend automatic discovery rules

1. From the left-hand navigation panel, select Configure -> Instrumentation. Then select the Bac
kend Detection tab and the application or tier you want to configure.
2. In the Automatic Backend Discovery list, select the backend type to modify.
The rule summary appears in the Automatic Discovery panel on the right.
3. Click Edit Automatic Discovery.
The Edit Automatic Backend Discovery Rule window appears.
4. For each property that you want to configure:
Select the property in the property list.
Check the property check box to use the property for detection; clear the check box to omit
it.
If you are using the property, choose how the property is used from the drop-down list.

If you have a complex property, such as the URL, destination, or a query string, and you
want to eliminate some parts of it or need some additional manipulation you can use an
option from the second drop-down list such as Run a Regular Expression on it or Execute
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methods on it (getter chain). Each option has associated configuration parameters. For
example, you have options for manipulating the segments of the URL.

5. Check Enabled to enable the rule; clear the check box to disable it.
6. Check Correlation Enabled to enable correlation.
7. Click OK.
Add Backend Discovery Rules

AppDynamics provides the additional flexibility to create new custom discovery rules for the
automatically discovered backend types. Custom rules include the following settings:
Name for the custom rule.
Priority used to set precedence for custom rules.
Match Conditions used to identify which backends are subject to the custom naming rules.
Backend Naming Configuration used to name the backends matching the match
conditions.
The window for adding custom discovery rules looks like this:

Copyright © AppDynamics 2012-2014

Page 1231

To create a custom discovery rule for an automatically discovered backend type, use these steps:

1. In the Automatic Backend Discovery list, select the backend type.
The Custom Discovery Rules editor appears in the right panel below the Automatic Discovery
panel.
2. Click Add (the + icon) to create a new rule or select an existing rule from the list and click the
edit icon to modify one.
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3. Enter a name for the custom rule.
4. Confirm the settings for Enabled and Correlation Enabled (if applicable).
4. Enter the priority for the custom rule compared to other custom rules for this backend type. The
higher the number, the higher the priority. A value of 0 (zero) indicates that the default rule should
be used.
5. In the next section, configure the match conditions.
Match conditions are used to identify which backends should use the custom rule. Backends that
do not meet all the defined match conditions are discovered according to the default rule.
7. In the next section, configure the naming for the backends matching the rule. The naming
configuration must include the property used by the match condition.
8. Save the configuration.
See specific exit points for examples.
Add Custom Exit Points

When your application has backends that are not automatically discovered, you can enable
discovery using custom exit points. To do this, you need to know the class and method used to
identify the backend. See Configure Custom Exit Points for Java.
Propagate Changes to Other Tiers or Applications

When you have made changes to the backend detection rules, you may want to propagate your
changes to other tiers or applications.
To copy an entire backend detection configuration to all tiers

1. Access the backend detection window. See View the Discovery Rules.
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2. In the left panel select the application or tier whose configuration you want to copy.
3. Click Configure all Tiers to use this Configuration.
To copy an entire backend detection configuration to another tier or application

1. Access the backend detection window. See View the Discovery Rules.
2. In the left panel select the application or tier whose configuration you want to copy.
3. Click Copy.
4. In the Application/Tier browser, choose the application or tier to copy the configuration to.
5. Click OK.
Learn More

Backend Monitoring
Monitor Databases
Monitor Remote Services
Hierarchical Configuration Model
Configure Custom Exit Points
Configurations for Custom Exit Points for Java
Configure Custom Exit Points for Java

Default Backends Discovered by the App Agent for Java
Configure Custom Exit Points for Java Backends
To create a custom exit point
To split an exit point
To group an exit point
To define custom metrics for a custom exit point
To define transaction snapshot data collected
Learn More
AppDynamics provides default automatic discovery for commonly-used backends. If a backend
used in your environment is not discovered, first compare the list of default backends to determine
whether you need to modify the default configuration. If it is not on the list then configure a custom
exit point according to these instructions.
Default Backends Discovered by the App Agent for Java

The default backends for Java are:
HTTP
JDBC
JMS
Cassandra
IBM MQ
RABBITMQ
RMI
Thrift
Web Service
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To configure a default backend see Configure Backend Detection for Java.
Configure Custom Exit Points for Java Backends

Configure Custom Exit Points
Use custom exit points to identify backend types that are not automatically detected, such as file
systems, mainframes, and so on. For example, you can define a custom exit point to monitor the
file system read method. After you have defined a custom exit point, the backend appears on the
flow map with the type-associated icon you selected when you configured the custom exit point.

You define a custom exit point by specifying the class and method used to identify the
backend. If the method is overloaded, you need to add the parameters to identify the
method uniquely.
You can restrict the method invocations for which you want AppDynamics to collect
metrics by specifying match conditions for the method. The match conditions can be
based on a parameter or the invoked object.
You can also optionally split the exit point based on a method parameter, the return
value, or the invoked object.
You can also configure custom metrics and transaction snapshot data to collect for the
backend.
To create a custom exit point

1. From the left navigation pane, click Configure -> Instrumentation and select the Ba
ckend Detection tab.
2. Select the application or tier for which you are configuring the custom exit point.
3. Ensure Use Custom Configuration for this Tier is selected.
Backend detection configuration is applied on a hierarchical inheritance model. See Hier
archical Configuration Model.
4. Scroll down to Custom Exit Points and click Add (the + icon).
5. In the Create Custom Exit Point window, click the Identification tab if it is not
selected.
6. Enter a name for the exit point. This is the name that identifies the backend.
7. Select the type of backend from the Type drop-down menu.
This field controls the icon and name that appears on the flow maps and dashboards.
Some of the values are shown in this screen shot:
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If the type is not listed, you can check Use Custom and enter a string to be used as the
name on the dashboards.
8. Configure the class and method name that identify the custom exit point.
If the method is overloaded, check the Overloaded check box and add the parameters.
9. If you want to restrict metric collection based on a set of criteria that are evaluated at
runtime, click Add Match Condition and define the match condition(s).
For example, you may want to collect data only if the value of a specific method
parameter contains a certain value.
10. Click Save.
The following screenshot shows a custom exit point for a Cache type backend. This exit
point is defined on the getAll() method of the specified class. The exit point appears in
flow maps as an unresolved backend named CoherenceGetAll.
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To split an exit point

1. In the Backend Detection configuration window, click Add.
2. Enter a display name for the split exit point.
3. Specify the source of the data (parameter, return value, or invoked object).
4. Specify the operation to invoke on the source of the data: Use toString() or Use
Getter Chain (for complex objects).
5. Click Save.
The following example shows a split configuration of the previously created
CoherenceGetAll exit point based on the getCacheName() method of the invoked
object.
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To group an exit point

You can group methods as a single exit point if the methods point to the same key.
For example, ACME Online has an exit point for NamedCache.getAll. This exit point has
a split configuration of getCacheName() on the invoked object as illustrated in the
previous screen shot.
Suppose we also define an exit point for NamedCache.entrySet. This is another exit
point, but it has the split configuration that has getCacheName() method of the invoked
object.
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If the getAll() and the entrySet() methods point to the same cache name, they will point
to the same backend.
Matching name-value pairs identify the back-end. In this case, only one key, the cache
name, has to match. So, here both exit points have the same name for the cache and
they resolve to the same backend.
To define custom metrics for a custom exit point

Custom metrics are collected in addition to the standard metrics.
The result of the data collected from the method invocation must be an integer value,
which is either averaged or added per minute, depending on your data roll-up selection.
To configure custom business metrics that can be generated from the Java method
invocation:
1. Click the Custom Metrics tab.
2. Click Add.
3. In the Add Custom Metric window type a name for the metric.
4. Select Collect Data From to specify the source of the metric data.
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5. Select Operation on Method Parameter to specify how the metric data is processed.
6. Select how the data should be rolled up (average or sum) from the Data Rollup
drop-down menu.
7. Click Create Custom Metric.
To define transaction snapshot data collected

1. Click the Snapshot Data tab.
2. Click Add.
3. In the Add Snapshot Data window, enter a display name for the snapshot data.
4. Select the Collect Data From radio button to specify the source of the snapshot data.
5. Select the Operation on Method Parameter to specify how the snapshot data is
processed.
5. Click Save.
Learn More

Configurations for Custom Exit Points for Java
Configurations for Custom Exit Points for Java

Caching System Backends
Coherence Exit Points
Sample Coherence Exit Point Configuration
Memcached Exit Points
Sample Memcached Exit Point Configuration
EhCache Exit Points
Sample EhCache Exit Point Configuration
SAP Exit Points
Sample SAP Exit Point Configuration
Mail Exit Points
Sample Mail Exit Point Configuration
LDAP Exit Points
Sample LDAP Exit Point Configuration
MongoDB Exit Points
Sample MongoDB Exit Point Configuration
Learn More
This topic describes custom exit point configurations for specific backends in Java environments.
To implement these exit points, create custom exit points using the configuration described. To
learn how to create custom exit points, see To create a custom exit point.
Caching System Backends
Coherence Exit Points
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Name of the
Exit Point

Type

Method
Name

Match
Criteria for
the Class

Class/Interfa
ce/Superclas
s/Annotation
Name

Splitting
Configuratio
n

Coherence.P
ut

Cache

put

that
implements
an
interface
which

com.tangosol.
net.NamedCa
che

getCacheNa
me()

Coherence.P
utAll

Cache

putAll

that
implements
an
interface
which

com.tangosol.
net.NamedCa
che

getCacheNa
me()

Coherence.E
ntrySet

Cache

entrySet

that
implements
an
interface
which

com.tangosol.
net.NamedCa
che

getCacheNa
me()

Coherence.K
eySet

Cache

keySet

that
implements
an
interface
which

com.tangosol.
net.NamedCa
che

getCacheNa
me()

Coherence.G
et

Cache

get

that
implements
an
interface
which

com.tangosol.
net.NamedCa
che

getCacheNa
me()

Coherence.R
emove

Cache

remove

that
implements
an
interface
which

com.tangosol.
net.NamedCa
che

getCacheNa
me()

Sample Coherence Exit Point Configuration
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Memcached Exit Points

Name of the
Exit Point

Type

Method Name

Match Criteria
value
for the Class

Class/Interface/
Superclass/Ann
otation Name

Memcached.Add

Cache

add

With a class
name that

net.spy.memcac
hed.Memcached
Client

Memcached.Set

Cache

set

With a class
name that

net.spy.memcac
hed.Memcached
Client

Memcached.Rep
lace

Cache

replace

With a class
name that

net.spy.memcac
hed.Memcached
Client

Memcached.Co
mpareAndSwap

Cache

cas

With a class
name that

net.spy.memcac
hed.Memcached
Client

Memcached.Get

Cache

get

With a class
name that

net.spy.memcac
hed.Memcached
Client
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Memcached.Re
move

Cache

remove

With a class
name that

net.spy.memcac
hed.Memcached
Client

Sample Memcached Exit Point Configuration

EhCache Exit Points

Name of the
Exit Point

Type

Method
Name

Match
Criteria
value
for the Class

Class/Interfa
ce/
Superclass/
Annotation
Name

Splitting
Configuratio
n

EhCache.Ge

Cache

get

With a class
name that

net.sf.ehcach
e.Cache

getName()

EhCache.Put

Cache

put

With a class
name that

net.sf.ehcach
e.Cache

getName()

EhCache.Put
IfAbsent

Cache

putIfAbsent

With a class
name that

net.sf.ehcach
e.Cache

getName()

EhCache.Put
Quiet

Cache

putQuiet

With a class
name that

net.sf.ehcach
e.Cache

getName()

t
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EhCache.Re
move

Cache

remove

With a class
name that

net.sf.ehcach
e.Cache

getName()

EhCache.Re
moveAll

Cache

removeAll

With a class
name that

net.sf.ehcach
e.Cache

getName()

EhCache.Re
moveQuiet

Cache

removeQuiet

With a class
name that

net.sf.ehcach
e.Cache

getName()

EhCache.Re
place

Cache

replace

With a class
name that

net.sf.ehcach
e.Cache

getName()

Sample EhCache Exit Point Configuration

SAP Exit Points

Name of the
Exit Point

Type

Method Name

Match Criteria
value
for the Class

Class/Interface/
Superclass/Ann
otation Name

SAP.Execute

SAP

execute

With a class
name that

com.sap.mw.jco
.rfc.MiddlewareR
FC$Client
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SAP.Connect

SAP

connect

With a class
name that

com.sap.mw.jco
.rfc.MiddlewareR
FC$Client

SAP.Disconnect

SAP

disconnect

With a class
name that

com.sap.mw.jco
.rfc.MiddlewareR
FC$Client

SAP.Reset

SAP

reset

With a class
name that

com.sap.mw.jco
.rfc.MiddlewareR
FC$Client

SAP.CreateTID

SAP

createTID

With a class
name that

com.sap.mw.jco
.rfc.MiddlewareR
FC$Client

SAP.ConfirmTID

SAP

confirmTID

With a class
name that

com.sap.mw.jco
.rfc.MiddlewareR
FC$Client

Sample SAP Exit Point Configuration

Mail Exit Points
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Name of the
Exit Point

Type

Method Name

Match Criteria
value
for the Class

Class/Interface/
Superclass/Ann
otation Name

MailExitPoint.Se
nd

Mail Server

send

With a class
name that

javax.mail.Trans
port

MailExitPoint.Se
ndMessage

Mail Server

sendMessage

With a class
name that

javax.mail.Trans
port

Sample Mail Exit Point Configuration

LDAP Exit Points

Name of the
Exit Point

Type

Method Name

Match Criteria
value
for the Class

Class/Interface/
Superclass/Ann
otation Name

LDAPExitPoint.
Bind

LDAP

bind

With a class
name that

javax.naming.dir
ectory.InitialDirC
ontext

LDAPExitPoint.
Rebind

LDAP

rebind

With a class
name that

javax.naming.dir
ectory.InitialDirC
ontext
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LDAPExitPoint.
Search

LDAP

search

With a class
name that

javax.naming.dir
ectory.InitialDirC
ontext

LDAPExitPoint.
ModifyAttributes

LDAP

modifyAttributes

With a class
name that

javax.naming.dir
ectory.InitialDirC
ontext

LDAPExitPoint.
GetNextBatch

LDAP

getNextBatch

With a class
name that

com.sun.jndi.lda
p.LdapNamingE
numeration

LDAPExitPoint.
NextAux

LDAP

nextAux

With a class
name that

com.sun.jndi.lda
p.LdapNamingE
numeration

LDAPExitPoint.
CreatePooledCo
nnection

LDAP

createPooledCo
nnection

With a class
name that

com.sun.jndi.lda
p.LdapClientFact
ory

LDAPExitPoint.
Search

LDAP

search

With a class
name that

com.sun.jndi.lda
p.LdapClientFact
ory

LDAPExitPoint.
Modify

LDAP

modify

With a class
name that

com.sun.jndi.lda
p.LdapClientFact
ory

Sample LDAP Exit Point Configuration
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MongoDB Exit Points

Name of
the
Exit
Point

MongoD
B.Insert

Type

JDBC

Copyright © AppDynamics 2012-2014

Method
Name

insert

Match
Criteria
value
for the
Class

With a
class
name
that

Class/Int
erface/
Supercla
ss/Annot
ation
Name

com.mon
godb.DB
Collection

Splitting
configuration/
Custom Exit Point
Identifier

Collect
Data
From
value for
the
Class

Operatio
n on
Invoked
Object
value for
the
Class

Invoked_
Object.

getDB().g
etName()

Snapsho
t Data

Paramete
r_0.toStri
ng()

Page 1248

MongoD
B.Find

JDBC

find

With a
class
name
that

com.mon
godb.DB
Collection

Invoked_
Object.

getDB().g
etName()

Paramete
r_0.toStri
ng()

MongoD
B.Update

JDBC

update

With a
class
name
that

com.mon
godb.DB
Collection

Invoked_
Object.

getDB().g
etName()

Paramete
r_0.toStri
ng()

MongoD
B.Remov
e

JDBC

remove

With a
class
name
that

com.mon
godb.DB
Collection

Invoked_
Object.

getDB().g
etName()

Paramete
r_0.toStri
ng()

MongoD
B.Apply

JDBC

apply

With a
class
name
that

com.mon
godb.DB
Collection

Invoked_
Object.

getDB().g
etName()

Paramete
r_0.toStri
ng()

Avoiding high overhead
AppDynamics recommends that you avoid instrumenting highly-used methods, such as the
find() method, because the activity around these methods can cause an undesired amount
of overhead on the system.
Sample MongoDB Exit Point Configuration

Copyright © AppDynamics 2012-2014

Page 1249

Learn More

Configure Backend Detection (Java)
Configure Custom Exit Points
HTTP Exit Points for Java

Automatic Discovery and Default Naming
HTTP Configurable Properties
Changing the Default HTTP Automatic Discovery and Naming
Examples
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HTTP Service
HTTP Backends With Different Formats
Learn More
This topic explains HTTP exit point configuration. To review general information about monitoring
databases and remote services (collectively known as backends) and for an overview of backend
configuration see Backend Monitoring. For configuration procedures, see Configure Backend
Detection for Java.
Automatic Discovery and Default Naming

By default, AppDynamics automatically detects and identifies HTTP exit points (backends). HTTP
exit point activity includes all HTTP calls done outside of a web service call. Web service calls are
not considered an HTTP exit point. The Host and Port properties are enabled in the default HTTP
automatic discovery rule. From the enabled properties AppDynamics derives a display name, for
example: "myHTTPHost:5000". By default, AppDynamics groups HTTP backends together on the
application flow map as shown:

Click the HTTP Backends label to see the individual backends listed.
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If you edit the flow map to ungroup the HTTP backends, you can see each separate HTTP
backend and how it uses the default discovery rule for naming.
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HTTP Configurable Properties

You can enable or disable the use of the following properties for HTTP exit points.
Configurable Properties

Used by Default
in Detection and Naming

Host

Yes

Port

Yes

URL

No

Query String

No

For procedures, see Configure Backend Detection (Java)
Changing the Default HTTP Automatic Discovery and Naming

Depending on exactly what you need to monitor, there may be times when you want to change the
default HTTP configuration. When you see things such as EC2 host names, file paths, and ports in
the backend name, changing the default discovery rule may help. For example, when all the HTTP
backends for a tier or application have a similar format, such as a prefix like "ec2storage", you can
generate the right name and the correct number of backends to monitor by editing the automatic
discovery rule. Doing this enables you to monitor the key performance indicators (KPIs) that are of
most interest to you.
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Examples
HTTP Service

Consider a scenario with the following HTTP URLs:
http://ec2-17:5400/service1
http://ec2-17:5450/service2
http://ec2-18:5400/service1
http://ec2-18:5450/service2

In this case, measuring performance based on host name would be of no use since the IP
addresses are transient and all performance numbers would be irrelevant after the IP addresses
recycle. Therefore, you want to monitor by service name. To do this you need to avoid using the
Host and Port properties in your configuration and use only the URL property.
1. Edit the Automatic Backend Discovery rule for HTTP. See Configure Backend Detection
(Java) for details on accessing this screen.

2. First select and disable the use of Host and Port.
3. Then select and enable the property you want to use to uniquely identify the backend. In this
case, select URL and check Use URL in the Backend Name.
4. For the field How will URL be used in the Backend name?, select Use a segment of it.
5. From the segment options drop-down list, select Use the first N Segments, then specify that
the first segment should be used. In this case the split delimiter is a / (slash). The backend naming
configuration looks similar to the following:
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A similar technique can be used to strip out some segment of the URL, such as a user name as in
the following URLs:
[http://host:34/create/username1]
[http://host:34/create/username2]

What you care about in this case is the "create" service, so your configuration is the same as in
the previous screen shot.
6. Once you change the configuration, you should delete all HTTP backends. Then, as the agent
rediscovers the backends according to the changed configuration, you see only the service
backends in the flow map.
HTTP Backends With Different Formats

Consider a set of HTTP backends that have different formats, for example, some are prefixed with
ec2storage, some are salesforce.com or localhost and so on,. In this case, you don't change the
automatic discovery rule. Instead you create a custom rule. This is because you need different
rules for the different URL formats as follows:
For format "ec2storage/servicename", you need to use the URL
For format "salesforce.com", you want to use the host name
For the other backends, you might want to use the query string
In some cases, your HTTP backend discovery configuration might consist of a combination of the
default rule and custom rules. A custom rule to handle the "ec2storage" URLs might look similar to
the following:
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Learn More

Configure Backend Detection (Java)
Backend Monitoring
Monitor Remote Services
Configure Backend Detection
Flow Maps
JDBC Exit Points for Java

Auto-Discovery and Default Naming
JDBC Configurable Properties
Changing the Default JDBC Automatic Discovery and Naming
Examples
Multiple Databases from Same Vendor
JDBC with Complex URLs
EC2 Hosted Databases
Learn More
This topic covers JDBC exit point configuration. To review general information about monitoring
databases and remote services (collectively known as backends) and for an overview of backend
configuration see Backend Monitoring. For configuration procedures, see Configure Backend
Detection (Java).
Auto-Discovery and Default Naming

JDBC backend activity consists of all JDBC calls including inserts, queries, updates, getting

Copyright © AppDynamics 2012-2014

Page 1256

connections from connection pools, and so on. By default, JDBC backends are identified using the
logical properties of the database:
URL
Host name
Port number
Database schema
Version
Vendor
From these properties AppDynamics derives a display name, for example "XE-Oracle DB". You
can see an Oracle JDBC database on the following flow map.

You can see the values of the database properties on the database dashboard.

JDBC Configurable Properties
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You can enable or disable the use of the following properties for JDBC exit points.
Configurable Properties

Property Used by Default
in Detection and Naming

Description

URL

Yes

JDBC URL provided to the
driver

Host

Yes

Database host

Port

Yes

Database port

Database

Yes

Database schema

Version

Yes

Database version as reported
by JDBC driver

Vendor

Yes

Database vendor as reported
by JDBC driver

Changing the Default JDBC Automatic Discovery and Naming

Depending on exactly what you need to monitor, you may want to change the default JDBC
configuration. When you see the same physical database represented as multiple JDBC
databases, you may need to revise the automatic discovery rule. Doing this enables you to more
effectively monitor the key performance indicators (KPIs) that are of most value to you.
Examples
Multiple Databases from Same Vendor

JDBC connections to the same physical Oracle database (with the same URI) may appear as
multiple backends. In some circumstances, the Vendor property captured for the database is
different. This can happen when different drivers are used to access the database. For example,
you might see JDBC backends with the following vendor names:
Oracle DB
Oracle
If the database driver package name matches the standard Oracle database driver, then the
vendor name used is "Oracle DB". If it doesn't match, then the product name from the database
metadata (using the java.sql.DatabaseMetaData class) is used as a vendor name. So database
calls that use different drivers to reach the same physical database may be detected as separate
databases. You can fix this by disabling the use of the Vendor property in the discovery rule.
JDBC with Complex URLs

In this example, the database URL is configured for high availability, so it is quite long and
complex. Choosing the Run a regular expression on it URL option is the way to go. Disable the
use of the Host and Port properties for JDBC automatic discovery. Instead enable the use of the
URL that appears in the JDBC call, along with a regular expression to get the correct database
naming and discovery.
For example, to extract all the hosts and all the ports from the following URL:
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jdbc:oracle:thin:@(DESCRIPTION_LIST=(LOAD_BALANCE=OFF)(FAILOVER=ON)(DESCRIPTION=
(ADDRESS_LIST=(LOAD_BALANCE=ON)(ADDRESS=(PROTOCOL=TCP)(HOST=titanpfmcl01)(PORT=1
521)))(CONNECT_DATA=(SERVICE_NAME=trafrefpfm01.global.trafigura.com)))(DESCRIPTI
ON=(ADDRESS_LIST=(LOAD_BALANCE=ON)(ADDRESS=(PROTOCOL=TCP)(HOST=titanpfmcl02)(POR
T = 1521)))(CONNECT_DATA=(SERVICE_NAME=trafrefpfm01.global.trafigura.com))))

This sample is for a string that contains the host and service name twice. You can also use port in
your regular expression if needed by your requirements.
The following regular expression applied to the previous high availability URL results in a backend
name similar to this:
titanpfmcl01-trafrefpfm01.global.trafigura.com-titanpfmcl02-trafrefpfm01.global.trafigura.com.
.*HOST=([^\)]*).*SERVICE_NAME=([^\)]*).*HOST=([^\)]*).*SERVICE_NAME=([^\)]*).*

Note: the expression starts and end with ".". Set *Regular expression groups to "1,2,3,4".
Set the Merge Delimiter to "-".
This configuration looks like this in the UI:

Also see Regular Expressions In Match Conditions.
EC2 Hosted Databases

AppDynamics automatically discovers JDBC backends based on host, port, URL, database,
version and vendor values. To monitor all JDBC databases that contain "EC2" in their host names
as a single database, create a JDBC custom discovery rule and use the following match condition:
Host Contains "EC2" as shown in the following screen shot.
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Assuming host names of the format "EC2-segment2-segment3", use the following naming
configuration:

This configuration results in a single database icon on the flow map named "EC2".
Learn More

Configure Backend Detection (Java)
Backend Monitoring
Monitor Databases
Message Queue Exit Points for Java

JMS Message Queue Exit Points
JMS Auto-Discovery and Default Naming
JMS Configurable Properties
Changing the Default JMS Automatic Discovery and Naming
Examples
Monitor the Server by Ignoring the JMS Queue Name
Temporary Queues
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Session ID in the Queue Name
IBM Websphere MQ Message Queue Exit Points
IBM Websphere MQ Auto-Discovery and Default Naming
IBM MQ Configurable Properties
Example: Monitor the Server by Ignoring the MQ Queue Name
RabbitMQ Message Queue Exit Points
RabbitMQ Auto-Discovery and Default Naming
RabbitMQ Configurable Properties
Changing the Default RabbitMQ Automatic Discovery and Naming
Example: Monitor the Server by Ignoring the RabbitMQ Queue Name
Learn More
This topic covers message queue exit point configuration, including JMS, IBM MQ, and RabbitMQ.
To review general information about monitoring databases and remote services (collectively
known as backends) and for an overview of backend configuration see Backend Monitoring. For
configuration procedures, see Configure Backend Detection (Java).
For a list of supported message-oriented middleware products, see Supported Application Servers
and Portals for the App Agent for Java
JMS Message Queue Exit Points
JMS Auto-Discovery and Default Naming

JMS backend activity includes all JMS message send and publish activity. By default, JMS back
ends are identified using the logical properties of the JMS server, such as: vendor, destination
name, and destination type.
The default configuration uses all three properties of the JMS queue.
From the enabled properties AppDynamics derives a display name, for example,
ActiveMQ-OrderQueue.

The Backend Properties are visible on the Remote Services dashboard.
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JMS Configurable Properties

The following properties can be configured to refine the identification of JMS backends.
Configurable Properties

Property Used by Default
in Detection and Naming

Destination

Yes

Destination Type

Yes

Vendor

Yes

Changing the Default JMS Automatic Discovery and Naming

Depending on exactly what you need to monitor, there may be times when you want to change the
default JMS configuration. In most cases, you can generate the right name and the correct number
of backends to monitor by editing the automatic discovery rule. For example, you can disable use
of the Vendor property. If you do, then JMS backends with the same destination and destination
type are identified as the same backend and the metrics for calls with the same destination and
destination type are aggregated into one backend. Changing the default discovery rule can enable
you to monitor the key performance indicators (KPIs) that are of most interest to you.
Examples

Monitor the Server by Ignoring the JMS Queue Name
In this example, the application is making calls to a message server that handles several queues.
The sample destination names look like this:
AccountQ
AccountReplyQ
AccountRecQ
AccountDebitQ
The default automatic discovery rule detects one backend for each unique destination and so the
flow map shows one queue backend for each different queue name. In this example, each of the
above would show as a separate backend on the application flow map. If you are interested in
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monitoring the performance of the server and not each queue name, you can modify the
configuration to ignore the Destination property and use just the Type and Vendor. This
configuration looks similar to the following:

Temporary Queues
In this example an application creates many temporary JMS response queues that are deleted
after the message is received. By default, Appdynamics discovers these queues separately and
lists each one as a unique remote service. This default behavior probably does not enable
effective monitoring. Instead, you can create a custom JMS discovery rule stating that if the
destination name contains "TemporaryQueue", list it as "WeblogicTempQueue", or whatever name
makes sense in your monitoring environment. In this way, you can monitor the performance that
matters. The configuration to accomplish this is shown in the following screen shot:
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Session ID in the Queue Name
If your JMS queues use the session ID in the destination, this causes each session to be identified
as a separate backend. In this case, you might not be interested in seeing each queue separately,
and instead want to aggregate everything for the same host and port to the same backend. You
can generate the right name and the correct number of backends to monitor by editing the
automatic discovery rule. Doing this enables you to monitor the key performance indicators (KPIs)
that are of most interest to you.
IBM Websphere MQ Message Queue Exit Points
IBM Websphere MQ Auto-Discovery and Default Naming

IBM MQ, also known as IBM WebSphere MQ and IBM MQSeries, is IBM's message-oriented
middleware similar to JMS. Several additional properties are configurable, such as host and port.
This is useful where you have lots of queues and you want to monitor them based on a subset of
the properties.
IBM MQ Configurable Properties

You can enable or disable the use of the following properties for IBM MQ exit points.
Configurable Properties

Property Used by Default
in Detection and Naming

Destination

Yes

Destination Type

Yes
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Host

Yes

Port

Yes

Major Version

Yes

Vendor

Yes

Example: Monitor the Server by Ignoring the MQ Queue Name
In this example, the application is making calls to a message server that handles several queues.
The sample destination names look like this:
MQhostwest-US:1521
MQhosteast-US:1521
MQhostsouth-US:1521
The default automatic discovery rule detects one backend for each unique destination and so the
flow map shows one queue backend for each different queue name. In this example, each of the
above would show as a separate backend on the application flow map. If you are interested in
monitoring the performance of the server and not each queue name, you can create a discovery
rule that just uses the Host and Port, as follows:

RabbitMQ Message Queue Exit Points
RabbitMQ Auto-Discovery and Default Naming

RabbitMQ is an open source, commercially supported, messaging middleware that runs on many
different operating systems. By default, the App Agent for Java discovers exit points utilizing the
RabbitMQ Java API, which is usually shipped as an amqp-client.jar. By default, RabbitMQ
backends are identified by Host, Port, Routing Key, and Exchange. By default, the name would
resemble this:

Copyright © AppDynamics 2012-2014

Page 1265

amqp://guest@127.0.0.1:5672/exchange/task_queue
RabbitMQ Configurable Properties

You can enable or disable the use of the following properties for RabbitMQ exit points.
Configurable Properties

Property Used by Default
in Detection and Naming

Host

Yes

Port

Yes

Routing Key

Yes

Exchange

Yes

Changing the Default RabbitMQ Automatic Discovery and Naming

You can change the default RabbitMQ automatic discovery attributes by clicking Edit Automatic
Discovery.

A window appears where you can edit the automatic RabbitMQ backend discovery rules.
Example: Monitor the Server by Ignoring the RabbitMQ Queue Name

Configuring properties, such as host and port, is useful where you have lots of queues and want to
monitor the health of the server and not the message queue. In this situation, a discovery rule
using only host and port might be the most useful strategy as follows:
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Learn More

Configure Backend Detection (Java)
Backend Monitoring
Monitor Remote Services
Configure Backend Detection
Flow Maps
AppDynamics eXchange RabbitMQ Monitoring Extension for visibility into the queue.
Web Services Exit Points for Java

Auto-Discovery and Default Naming
Web Services Configurable Properties
Changing the Default Web Service Automatic Discovery and Naming
Examples
Web Services Using HTTP for Transport
Learn More
This topic covers web services exit point configuration. To review general information about
monitoring databases and remote services (collectively known as backends) and for an overview
of backend configuration see Backend Monitoring. For configuration procedures, see Configure
Backend Detection (Java).
Auto-Discovery and Default Naming

Web service backend activity includes all web service invocations. Web service backends are
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identified using the web service name.
Web Services Configurable Properties

Configurable Properties

Property Used by Default
in Detection and Naming

Service

Yes

URL

No

Operation

No

Soap Action

No

Vendor

No

Changing the Default Web Service Automatic Discovery and Naming

Depending on exactly what you need to monitor, there may be times when you want to change the
default configuration. In most cases, you can generate the right name and the correct number of
backends to monitor by editing the automatic discovery rule.
Examples
Web Services Using HTTP for Transport

You can disable automatic discovery of a backend type entirely if this better suits your monitoring
needs. For example, if your web services use HTTP for transport and you are fine with them being
discovered as HTTP backends, you can disable discovery of the Web Service type backends.

Learn More

Configure Backend Detection (Java)
Backend Monitoring
Monitor Remote Services
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Cassandra Exit Points for Java

Auto-Discovery and Default Naming
Cassandra Configurable Properties
Changing the Default Cassandra Automatic Discovery and Naming
Learn More
This topic covers Cassandra exit point configuration. To review general information about
monitoring databases and remote services (collectively known as backends) and for an overview
of backend configuration see Backend Monitoring. For configuration procedures, see Configure
Backend Detection (Java).
Auto-Discovery and Default Naming

By default, AppDynamics automatically detects and identifies Cassandra databases and
Cassandra CQL3.
Cassandra Configurable Properties

Configurable Properties for
Database

Configurable Properties
for CQL3

Property Used by Default
in Detection and Naming

Host

Host

Yes

Port

Port

Yes

transport

Yes

keyspace

Yes

Changing the Default Cassandra Automatic Discovery and Naming

Depending on what you need to monitor, you can change the default configuration by disabling
one or more properties.
Learn More

Configure Backend Detection (Java)
Backend Monitoring
Configure Backend Detection
RMI Exit Points for Java

Auto-Discovery and Default Naming
RMI Properties
Changing the Default RMI Automatic Discovery and Naming
Learn More
This topic covers Java Remote Method Invocation (RMI) exit point configuration. To review
general information about monitoring databases and remote services (collectively known as
backends) see Backend Monitoring.
Auto-Discovery and Default Naming

The App Agent for Java automatically discovers backends called using the standard Java RMI
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API. For a list of supported RMI frameworks, see Supported Application Servers and Portals for
the App Agent for Java
RMI Properties

Configurable Properties

Property Used by Default
in Detection and Naming

URL

Yes

Changing the Default RMI Automatic Discovery and Naming

Depending on what you need to monitor, you can change the default configuration to use a portion
of the URL.
Learn More

Configure Backend Detection (Java)
Backend Monitoring
Monitor Remote Services
Thrift Exit Points for Java

Automatic Discovery and Default Naming
Thrift Configurable Properties
Changing the Default Thrift Automatic Discovery and Naming
Learn More
This topic explains Thrift exit point configuration. To review general information about monitoring
databases and remote services (collectively known as backends) and for an overview of backend
configuration see Backend Monitoring. For configuration procedures, see Configure Backend
Detection (Java).
Automatic Discovery and Default Naming

By default, AppDynamics automatically detects and identifies Apache Thrift exit points (backends).
See Apache Thrift for details.
Thrift Configurable Properties

You can enable or disable the use of the following properties for Thrift exit points.
Configurable Properties

Used by Default
in Detection and Naming

Host

Yes

Port

Yes

transport

Yes

Changing the Default Thrift Automatic Discovery and Naming

Depending on what you need to monitor, you can change the default configuration by disabling
one or more properties.
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Learn More

Configure Backend Detection (Java)
Backend Monitoring
Monitor Remote Services
Configure Memory Monitoring for Java
See:
Configure and Use Custom Memory Structures for Java
Configure and Use Object Instance Tracking for Java
Configure Automatic Leak Detection for Java

Prerequisites for Automatic Leak Detection
Memory Leaks in a Java Environment
AppDynamics Java Automatic Leak Detection
Automatic Leak Detection Support
Conditions for Troubleshooting Java Memory Leaks
Starting Automatic Leak Detection
To start automatic leak detection on a node
Learn More
This topic helps you understand how to configure automatic leak detection.
Prerequisites for Automatic Leak Detection

Automatic leak detection can only be used with specific JVMs. See JVM Support.
Memory Leaks in a Java Environment

While the JVM's garbage collection greatly reduces the opportunities for memory leaks to be
introduced into a codebase, it does not eliminate them completely. For example, consider a web
page whose code adds the current user object to a static set. In this case, the size of the set grows
over time and could eventually use up significant amounts of memory. In general, leaks occur
when an application code puts objects in a static collection and does not remove them even when
they are no longer needed.
In high workload production environments if the collection is frequently updated, it may cause the
applications to crash due to insufficient memory. It could also result in system performance
degradation as the operating system starts paging memory to disk.
AppDynamics Java Automatic Leak Detection

AppDynamics automatically tracks every Java collection (for example, HashMap and ArrayList)
that meets a set of criteria defined below. The collection size is tracked and a linear regression
model identifies whether the collection is potentially leaking. You can then identify the root cause
of the leak by tracking frequent accesses of the collection over a period of time.
Once a collection is qualified, its size, or number of elements, is monitored for long term growth
trend. A positive growth indicates that the collection as potentially leaking!
Once a leaking collection is identified, the agent automatically triggers diagnostics every 30
minutes to capture a shallow content dump and activity traces of the code path and business
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transactions that are accessing the collection. By drilling down into any leaking collection
monitored by the agent, you can manually trigger Content Summary Capture and Access Tracking
sessions. See Configure Automatic Leak Detection for Java
You can also monitor memory leaks for custom memory structures. Typically custom memory
structures are used as caching solutions. In a distributed environment, caching can easily become
a prime source of memory leaks. It is therefore important to manage and track memory statistics
for these memory structures. To do this, you must first configure custom memory structures. See
Configure and Use Custom Memory Structures for Java.
Automatic Leak Detection Support

Ensure AppDynamics supports Automatic Leak Detection on your JVM. See JVM Support.
Conditions for Troubleshooting Java Memory Leaks

Automatic Leak Detection uses On Demand Capture Sessions to capture any actively used
collections (i.e. any class that implements JDK Map or Collection interface) during the Capture
period (default is 10 minutes) and then qualifies them based on the following criteria:
For a collection object to be identified and monitored, it must meet the following conditions:
The collection has been alive for at least N minutes. Default is 30 minutes, configurable with
the minimum-age-for-evaluation-in-minutes node property.
The collection has at least N elements. Default is 1000 elements, configurable with the mini
mum-number-of-elements-in-collection-to-deep-size node property.
The collection Deep Size is at least N MB. Default is 5 MB, configurable with the minimum-si
ze-for-evaluation-in-mb property.
The Deep Size is calculated by traversing recursive object graphs of all the objects in
the collection.
See App Agent Node Properties and App Agent Node Properties Reference by Type.

Starting Automatic Leak Detection
To start automatic leak detection on a node

1. In the left navigation pane, click Servers -> App Servers -> <tier> -> <node>. The Node
Dashboard opens.
2. Click the Memory tab.
3. Click the Automatic Leak Detection subtab.
4. Click ON.
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AppDynamics begins to automatically track the top 20 application classes and the top 20 system
(core Java) classes in the heap.

The Automatic Memory Leak dashboard shows:
Collection Size: The number of elements in a collection.
Potentially Leaking: Potentially leaking collections are marked as red. You should start
diagnostic sessions on potentially leaking objects.
Status: Indicates if a diagnostic session has been started on an object.
Collection Size Trend: A positive and steep growth slope indicates potential memory leak.

Tip: To identify long-lived collections compare the JVM start time and Object Creation Time.
If you cannot see any captured collections, ensure that you have correct configuration for detecting
potential memory leaks.
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Learn More

Troubleshoot Java Memory Leaks
Configure and Use Object Instance Tracking for Java

Prerequisites for Object Instance Tracking
Specifying the Classpath
Classpath for application only
Classpath for entire environment
Starting Object Instance Tracking
To start object instance tracking on a node
Tracking Specific Classes
To track instances of custom classes
Learn More
This topic helps you understand how to configure and use object instance tracking. For more
information about why you may need to configure this, see Troubleshoot Java Memory Thrash.
Prerequisites for Object Instance Tracking

Object Instance Tracking can be used only for Sun JVM v1.6.x and later.
If you are running with the JDK then tools.jar will probably be setup correctly, but if you are
running with the JRE you must add tools.jar to JRE_HOME/lib/ext and restart the JVM for
this feature to start working. You can find the tools.jar file in JAVA_HOME/lib/tools.jar.
In some cases In some cases you might also need to copy libattach.so (Linux) or attach.dll
(Windows) from your JDK to your JRE.
Depending on the JDK version, you may also need to specify the classpath as shown below
(along with other -jar options).
Specifying the Classpath

When using a JDK tool, set the classpath using the -classpath option.
Classpath for application only

This sets the classpath for the application only. For example:
On Windows
java -classpath <complete-path-to-tools.jar>;%CLASSPATH% -jar myApp.jar
OR
On Unix
java -Xclasspath/a:<complete-path-to-tools.jar> -jar myApp.jar
Classpath for entire environment

Alternatively, you can set the CLASSPATH variable for your entire environment. For example:
On Windows
SET CLASSPATH=%CLASSPATH%;%JAVA_HOME%\lib\tools.jar
On Unix
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CLASSPATH=$CLASSPATH:$JAVA_HOME/lib/tools.jar

Starting Object Instance Tracking
To start object instance tracking on a node

1. In the left navigation pane, click Servers -> App Servers -> <tier> -> <node>. The Node
Dashboard opens.
2. Click the Memory tab.
3. Click the Object Instance Tracking subtab.
4. Click ON.

AppDynamics begins to automatically track the top 20 application classes and the top 20 system
(core Java) classes in the heap.
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Tracking Specific Classes

Check against the required set of classes to enable instance tracking for each set. For improved
performance, only the top 20 application classes and the top 20 system (core Java) classes in the
heap are tracked automatically.
Use the Configure Custom Classes to Track option to specify instances of specific classes.
Classes configured here are only tracked if their instance count is among the top 1000 instance
counts in the JVM.
To track instances of custom classes

1. In the left navigation pane, click Servers -> App Servers -> <tier> -> <node>. The Node
Dashboard opens.
2. From the Object Instance Tracking subtab, click Configure Custom Classes To Track on the
rightmost corner of the window.
3. In the Object Instance Tracking - Define Custom Classes to Track section for the tier, click Add.

4. In the Create New Instance Tracker window, check Enabled.
5. Enter the fully-qualified class name of the class to track.
6. Click Save.
You can also access this configuration page by selecting Configuration -> Instrumentation ->
Memory Monitoring.
You can edit or delete the object tracing configuration after it has been created.
Learn More

Troubleshoot Java Memory Thrash
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Configure and Use Custom Memory Structures for Java

Custom Memory Structures and Memory Leaks
Using Automatic Leak Detection vs Monitoring Custom Memory Structures
To identify custom memory structures
To Add a Custom Memory Structure
Identifying Potential Memory Leaks
Diagnosing memory leaks
Isolating a leaking collection
Access Tracking
Learn More
This topic describes how to configure custom memory structures and monitor large coarse grained
custom cache objects.
AppDynamics provides different levels of memory monitoring for multiple JVMs. Ensure custom
memory structures are supported in your JVM environment. See JVM Support.
CPU Overhead Caution
Due to high CPU usage, Custom Memory Structures monitoring should only be enabled
while debugging a problem.
Custom Memory Structures and Memory Leaks

Typically custom memory structures are used as caching solutions. In a distributed environment,
caching can easily become a source of memory leaks. AppDynamics helps you to manage and
track memory statistics for these memory structures.
AppDynamics provide visibility into:
Cache access for slow, very slow, and stalled business transactions
Usage statistics, rolled up to the Business Transaction level
Keys being accessed
Deep size of internal cache structures
Using Automatic Leak Detection vs Monitoring Custom Memory Structures

The automatic leak detection feature captures memory usage data for all map and collection
libraries in a JVM session. However, custom memory structures might or might not contain
collections objects. For example, you may have a custom cache or a third party cache like
Ehcache for which you want to collect memory usage statistics. Using custom memory structures,
you can monitor any custom object created by the app and the size data can be traced across
JVM restarts. Automatic leak detection is typically used to identify leaks and custom memory
structures is used to monitor large coarse grained custom cache objects.
The following provides the workflow for configuring, monitoring, and troubleshooting custom
memory structures. You must configure custom memory structures manually.
1. On the Node Dashboard, use the Automatic Leak Detection, On Demand Capture Session
feature to determine which classes aren't being monitored, for example, custom or third
party caches such as EhCache.
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1.

2. Configure Custom Memory Structures and then restart the JVM if necessary.

3. Turn on Custom Memory Structures monitoring to detect potential memory leaks in the
custom memory structures you have configured.

4. Drill down into leaking memory structures for details that will help you determine where the
leak is.
To identify custom memory structures

1.
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1. On the Automatic Leak Detection subtab of the Memory tab, click On.
2. Click Start On Demand Capture Session to capture information on which classes are
accessing which collections objects. Use this information to identify custom memory
structures.
AppDynamics captures the top 1000 classes, by instance count.
To Add a Custom Memory Structure

These instructions provide an alternate method to accessing the Custom Memory Structures pane
than the workflow above shows. Use the method that is most convenient to you.
1. From the left navigation pane select Configure -> Instrumentation.
2. In the Tier panel, click the tier for which you want to configure a custom memory structure
and then click Use Custom Configuration for this Tier.
3. On the top menu, click the Memory Monitoring tab.
4. In the Custom Memory Structures panel, click Add to add a new memory structure.

a. In the Create Memory Structure window
Specify the configuration name.
Click Enabled.
Specify the discovery method.
The discovery method provides three options to monitor the custom memory
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structure. The discovery method determines how the agent gets a reference to
the custom memory structure. AppDynamics needs this reference to monitor the
size of the structure. Select one of the three options for the discovery method:
Discover using Static Field.
Discover using Constructor.
Discover using Method.
In many cases, especially with caches, the object for which a reference is needed is
created early in the life cycle of the application.
Example for using static
field
public
class
CacheManag
er
{ private
static Map
userCache<
String>
User>; }

Notes: Monitors deep size
of this Map.

Example for using
Constructor

Example for using
method

public
class
CustomerCa
che
{ public
CustomerCa
che(); }

public
Class
CacheManag
er{
public
List<Order
>;
getOrderCa
che();
{}
}

Notes: Monitors deep size
of CustomerCache
object(s).

Notes: Monitors deep size
of this list.

Restart the JVM after the discovery methods are configured to get the references for
the object.
b. (Optional) Define accessors.
Click Define Accessors to define the methods used to access the custom memory
structure. This information is used to capture the code paths accessing the custom
memory structure.
c. (Optional) Define the naming convention.
Click Define Naming Convention. These configurations differentiate between custom
memory structures.
There are situations where more than one custom Caches are used, but only few of
them need monitoring. In such a case, use the Getter Chain option to distinguish
amongst such caches. For all other cases, use either value of the field on the object or
a specific string as the object name.
d. Click Save to save the configuration.
Identifying Potential Memory Leaks

Start monitoring memory usage patterns for custom memory structures. An object is automatically
marked as a potentially leaking object when it shows a positive and steep growth slope. The
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Memory Leak Dashboard provides the following information:

The Custom Memory Structures dashboard provides the following information:
Class: The name of the class or collection being monitored.
Deep Size (bytes): The upper boundary of memory available to the structure. The
deep size is traced across JVM restarts
% of Current Used Heap: The percentage of memory available for dynamic allocation.
Potentially Leaking: Potentially leaking collections are marked as red. We recommend
that you start a diagnostic session on potentially leaking objects.
JVM Start Time: Custom Memory Structures are tracked across JVM restarts.
Status: Indicates if a diagnostic session has been started on an object.
Deep Size: A positive and steep growth slope indicates potential memory leak.
After the potentially leaking collections are identified, start the diagnostic session.
Diagnosing memory leaks

On the Custom Memory Structures Dashboard, select the class name to monitor and click Drill
Down or right-click the class name and select Drill Down.
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Isolating a leaking collection

Use Content Inspection to identify to which part of the application the collection belongs. It allows
monitoring histograms of all the elements in a particular memory structure. Start a diagnostic
session on the object and then follow these steps:
1. Select the Content Inspection tab.
2. Click Start Content Summary Capture Session.
3. Enter the session duration. Allow at least 1-2 minutes for the data to generate.
4. Click Refresh to retrieve the session data.
5. Click a snapshot to view the details about that specific content summary capture session.
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Access Tracking

Use Access Tracking to view the actual code paths and business transactions accessing the
memory structure. Start a diagnostic session on the object and follow these steps:
1. Select the Access Tracking tab.
2. Select Start Access Tracking Session.
3. Enter the session duration. Allow at least 1-2 minutes for data generation.
4. Click Refresh to retrieve the session data.
5. Click a snapshot to view the details about that specific content summary capture session.
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Learn More

Troubleshoot Java Memory Leaks
Configure Background Tasks - Java
Pre-Configured Frameworks for Java Background Tasks
Configuring POJO Transactions as Background Tasks
Configuring Background Batch or Shell Files using a Main Method
To instrument the main method of a background task
Learn More
Pre-Configured Frameworks for Java Background Tasks

When enabled, AppDynamics provides discovery for the following Java background-processing
task frameworks:
Quartz
Cron4J
JCronTab
JavaTimer
The instructions for enabling discovery are the same as for any background task. See Configure
Background Tasks.
Configuring POJO Transactions as Background Tasks
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In a Java environment background tasks are detected using POJO entry points. You use the same
basic procedure as defining entry points for business transactions, except that you check the
Background Task check box, and you need to configure the thresholds. The instructions are the
same as for any background task. See Configure Background Tasks.
Configuring Background Batch or Shell Files using a Main Method

Sometimes background tasks are defined in batch or shell files in which the main method triggers
the background processing. In this situation, the response time of the batch process is the duration
of the execution of the main method.
IMPORTANT: Instrument the main method only when the duration of the batch process is
equal to the duration of the main method. Otherwise choose another method that accurately
represents the unit of work for the background process.
To instrument the main method of a background task

1. In the left navigation pane, click Configure -> Instrumentation.
2. In the Transaction Detection section select the tier for which you want to instrument the main
method.
3. In the Custom Rules section click Add (the "+" icon).
4. From the Entry Point type drop down list, click POJO.
5. Enter a name for the custom rule.
6. Check Background Task.
7. Check Enabled.
8. Enter "main" as the match value for Method Name.

9. Save the changes.
10. To ensure that the name of the script file is automatically picked up as a background task,
configure your Java Agent for that node. See Configure App Agent for Java for Batch Processes.
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Learn More

Configure Background Tasks
Configure App Agent for Java for Batch Processes
POJO Entry Points
Import and Export Transaction Detection Configuration for Java
Import and Export Auto-Detected Entry Point Configurations
To import or export the configurations for all the auto-detected entry-points to or from
an application
To import or export the configuration for a single auto-detected entry point type to or
from an application
To import or export the configurations for all the auto-detected entry-points to or from
a tier
To import or export the configuration for a single auto-detected entry point type to or
from a tier
Import and Export Custom Match and Exclude Rules
To import or export a single custom match rule to or from an application
To import or export a single custom match rule to or from a tier
Import and Export Exclude Rules
To import or export a single exclude rule to or from an application
To import or export a single exclude rule to or from a tier
Overwrite Parameter
Learn More
You can export your transaction detection configurations from one application to another using the
AppDynamics REST API. This capability allows you to re-use transaction detection configurations
in different applications instead of re-configuring each application manually using the
AppDynamics console.
You can export from an application or tier configuration and import to an application or tier
configuration.
This feature is available for Java platforms only.
You can import and export:
auto-detected entry point configurations
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custom match rules

exclude rules
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To export use the HTTP GET method. Encode the URI using UTF-8 URL encoding.
The URI is the application (and optionally the tier) from which you are exporting the configuration.
The configuration is exported to an xml file. If necessary, you can edit the xml file before you
import it. For example, if you have exported the configuration of all the auto-detected entry-points
and you do not want to import all of them, you can delete the ones you do not want from the file
before you import it.
To import use the HTTP POST method. Encode the URI using UTF-8 URL encoding. The URI is
the application (and optionally the tier) to which you are importing the configuration. Use UTF-8
URL encoding of the URI before posting; for example, do not replace a space (" ") with "%20" in
the URI.
For information about overwriting a configuration with the same name see Overwrite Parameter.
Import and Export Auto-Detected Entry Point Configurations

You can import and export all your entry point configurations or one entry point configuration in a
single request. Lists of multiple entry point names are not supported.
For requests that specify a single entry point configuration, the entry-point-type-name is the name
displayed in the Type column of the Entry Points List in the Instrumentation->Transaction
Detection tab in the AppDynamics console.
To import or export the configurations for all the auto-detected entry-points to or from an application

http://<controller-host>:<controller-port>/controller/transactiondetection/<application-name>/auto
For example:
http://op2.appdynamics.com:80/controller/transactiondetection/ACME
Book Store Application/auto

produces the output in auto_app_all.xml.
To import or export the configuration for a single auto-detected entry point type to or from an application

http://<controller-host>:<controller-port>/controller/transactiondetection/<application-name>/auto/<
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entry-point-type-name>
For example:
http://op2.appdynamics.com:80/controller/transactiondetection/ACME
Book Store Application/auto/Servlet

produces the output in auto_app_servlet.xml.
To import or export the configurations for all the auto-detected entry-points to or from a tier

http://<controller-host>:<controller-port>/controller/transactiondetection/<application-name>/<tier-n
ame>/auto
For example:
http://op2.appdynamics.com:80/controller/transactiondetection/ACME
Book Store Application/ECommerce Server/auto/

produces the output in auto_tier_all.xml.
To import or export the configuration for a single auto-detected entry point type to or from a tier

http://<controller-host>:<controller-port>/controller/transactiondetection/<application-name>/<tier-n
ame>/auto/<entry-point-type-name>
For example:
http://op2.appdynamics.com:80/controller/transactiondetection/ACME
Book Store Application/ECommerce Server/auto/Servlet

produces the output in auto_tier_servlet.xml.
Import and Export Custom Match and Exclude Rules

The URLs for both the import and export operations are identical.
To create the XML file do one of the following:
EASY: Create the rule on a local controller and export it.
or
DIFFICULT: Write the XML for the rule from scratch using a text editor.
To import the rule to the destination controller, use an HTTP POST operation attaching the XML
file that describes the rule as attachment.
To import or export a single custom match rule to or from an application

http://<controller-host>:<controller-port>/controller/transactiondetection/<application-name>/custo
m/<entry-point-type-name><custom-rule-name>
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For example:
http://op2.appdynamics.com/controller/transactiondetection/ACME Book
Store Application/custom/pojo/JavaTimer

produces the output in custom_app_single.xml.
The older syntax http://<controller-host>:<controller-port>/controller/transactiondetection/<application-name
>/<entry-point-type-name>/custom/<custom-rule-name>
has been deprecated but it still works for backward compatibility with existing queries.
To import or export a single custom match rule to or from a tier

http://<controller-host>:<controller-port>/controller/transactiondetection/<application-name>/<tier-n
ame>/custom/<entry-point-type-name>/<custom-rule-name>
For example:
http://op2.appdynamics.com:80/controller/transactiondetection/ACME
Book Store Application/ECommerce Server/custom/pojo/Quartz

produces the output in custom_tier_single.xml.
The older syntax http://<controller-host>:<controller-port>/controller/transactiondetection/<application-name
>/<tier-name>/<entry-point-type-name>/custom/<custom-rule-name>
has been deprecated but it still works for backward compatibility with existing queries.
Import and Export Exclude Rules

You can import and export exclude rules for servlet and POJO type entry points.
The exclude-rule-name is the name displayed in the exclude rule list in the
Instrumentation->Transaction Detection tab in the AppDynamics console.
To import or export a single exclude rule to or from an application

http://<controller-host>:<controller-port>/controller/transactiondetection/<application-name>/<entry
-point-type-name>/<exclude-rule-name>
For example:
http://op2.appdynamics.com:80/controller/transactiondetection/ACME
Book Store Application/exclude/servlet/Apache Axis Servlet

produces the output in exclude_app_single.
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To import or export a single exclude rule to or from a tier

http://<controller-host>:<controller-port>/controller/transactiondetection/<application-name>/<tier-n
ame>/servlet/<exclude-rule-name>
For example:
http://op2.appdynamics.com:80/controller/transactiondetection/ACME
Book Store Application/ECommerce Server/exclude/servlet/Struts Action
Servlet

produces the output in exclude_tier_single.
Overwrite Parameter

Use the overwrite parameter to overwrite a configuration of the same name. Without this
parameter, if the import encounters a configuration for a component of the same name, the
request will fail.
For example, to import a configuration for a POJO custom match rule named "JavaTimer" to an
application that has an existing "JavaTimer" custom match rule use:
http://op2.appdynamics.com:80/controller/transactiondetection/ACME
Book Store Application/pojo/custom/JavaTimer?overwrite=true

The default is overwrite=false.
Learn More

Configure Business Transaction Detection
Use the AppDynamics REST API
Import and Export Health Rule Configurations
Getter Chains in Java Configurations
Using Getter Chains
Separators in Getter Chains
Escaping Special Characters
Values Passed in a Getter Chain
Getter Chain Examples
Braces Enclosing Getter Chains
Learn More
This topic provides some guidance and examples of the correct syntax for using getter chains in
AppDynamics configurations.
Using Getter Chains

You can use getter chains to:
Create a new JMX Metric Rule and define metrics from MBean attributes. See MBean
Getter Chains and Support for Boolean and String Attributes.
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Configure method invocation data collectors. See Configure Data Collectors#To use a getter
chain to specify the data collection on method invocation.
Define a new business transaction custom match rule that uses a POJO object instance as
the mechanism to name the transaction. See POJO Entry Points.
Configure a custom match rule for servlet entry points and name the transaction by defining
methods in a getter chain. See Identify Transactions Based on POJO Method Invoked by a
Servlet.
Note: If a getter chain calls on a method that does a lot of processing, such as making numerous
SQL calls, it can degrade the performance of the application and the App Agent for Java. Ideally,
use getter chains only with simple MBean gets.
An example of a simple getter would be just getting a property from a bean, such as getName().
public class MyBean
{
private String name;
public void setName(String name)
{ this.name = name; }
public String getName()
{ return this.name; }
public String getValue()
{ // Open up a database connection and run a big query // Process the
result set performing some complex maths on the data // etc. return
calculatedValue; }
}

Separators in Getter Chains

The following special characters are used as separators:
comma (,) for separating parameters
forward slash (/) for separating a type declaration from a value in a parameter
Dot (.) for separating the methods and properties in the getter chain
Dot (.) when representing "anything" must be escaped.
Escaping Special Characters

If a slash or a comma character is used in a string parameter, use the backslash (\) escape
character.
If a literal dot (.) is used in a string parameter, use the backslash escape character before
the dot. For example, a dot (.) when representing any character must be escaped using the
backslash (\) escape character.
For example, in the following getter chain, both the backslash (\) and the dot (.) are escaped.
getHeader(hostid).split(\\\.).[1]

Values Passed in a Getter Chain
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The value passed in a getter chain is always a string unless cast to another type. The following
supported types default to java.lang.String.
int
float
boolean
long
object
Getter Chain Examples

Getter chain with integer parameters in the substring method using the forward slash as the
type separator:
getAddress(appdynamics, sf).substring(int/0, int/10)

Getter chain with various non-string parameter types:
getAddress(appdynamics, sf).myMethod(float/0.2, boolean/true,
boolean/false, int/5)

Getter chain with forward slash escaped; escape character needed here for the string
parameter:
getUrl().split(\/) # node slash is escaped by a backward slash

Getter chain with an array element:
getUrl().split(\/).[4]

Getter chains that return Hashmap values:
get(object/myvalue).substring(int/0,int/10)
get(object/ACTION)

Getter chain with multiple array elements separated by commas:
getUrl().split(\/).[1,3]

Getter chain retrieves property values, such as the length of an array:
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getUrl().split(\.).length

Getter chain using backslash to escape the dot in the string parameter;
the call is getParam (a.b.c).
getAddress.getParam(a\.b\.c\.)

In the following getter chain, the first dot requires an escape character because it is in a
string method parameter (inside the parentheses). The second dot does not require an
escape character because it is not in a method parameter (it is outside the parentheses).
getName(suze\.smith)getClass().getSimpleName()

The following getter chain is from a transaction splitting rule on URIs that use a semicolon
as a delimiter; for example:
/my-webapp/xyz;jsessionid=BE7F31CC0235C796BF8C6DF3766A1D00?act=Add&uid=c42ab
7ad-48a7-4353-bb11-0dfeabb798b5
The getter chain splits on the API name, so the resulting split transactions are "API.abc",
API."xyz" and so on.
The call gets the URI using getRequestURI() and then splits it using the escaped forward
slash. From the resulting array it takes the third entry (as the split treats the first slash as a
separator) and inserts what before the slash (in this case, nothing) into the first entry. Then it
splits this result using the semicolon, getting the first entry of the resulting array, which in this
case contains the API name.
getRequestURI().split(\/).[2].split(;).[0]

Tip: When using string.split(), remember that it takes a regex and you have to escape any
special regex characters.
For example, if you want to split on left square bracket ([):
Java syntax: split("
[")
Getter chain syntax: split([)

Braces Enclosing Getter Chains

In most cases braces

Copyright © AppDynamics 2012-2014

are not used to enclose getter chains in AppDynamics configurations.

Page 1294

An exception is the use of a getter chain in a custom expression on the HTTPRequest object.
Custom expressions on the HTTP request are configurable in the Java Servlet Transaction
Naming Configuration window and in the Split Transactions Using Request Data tab of the servlet
custom match and exclude rules. In these cases, braces are required to delineate the boundaries
of the getter chains.

Getter chains in custom expressions on the HTTP request in diagnostic data collector should also
be enclosed in braces:
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Learn More

Configure Business Transaction Detection
Configure Data Collectors
Code Metric Information Points for Java
Code Metric Information Points for Java System Classes
To instrument a Java system class
Learn More
Code Metric Information Points for Java System Classes

System classes like java.lang.* are by default excluded by AppDynamics. To enable
instrumentation for a system class, use code metric information points.
The overhead of instrumenting Java system classes is based on the number of calls.
AppDynamics recommends that you instrument only a small number of nodes and monitor the
performance for these nodes before adding configuring all the nodes in your system.
To instrument a Java system class

1. Open the <agent_home>/conf/app-agent-config.xml file for the node where you want to enable
the metric.
2. Add the fully-qualified system class name to the override exclude section in the XML file. For
example, to configure the java.lang.Socket class connect method, modify following element:

Copyright © AppDynamics 2012-2014

Page 1296

<override-system-exclude filter-type="equals" filter-value="java.lang.Socket"/>

3. Restart those JVMs for which you have modified the XML file.
Learn More

Code Metrics
Configure Code Metric Information Points
Configure JMX Metrics from MBeans
JMX Metric Rules and Metrics
Using the JMX Metric Rules Configuration
Panel
Using the MBean Browser to Add an MBean
Attribute
To create a metric from an MBean
attribute in the MBean Browser
Learn More

Utilizing JMX Metrics in
Troubleshooting
This topic describes how to create persistent JMX metrics from MBean attributes.
There are two ways to add MBean metrics:
Using the JMX Metric Rules Configuration Panel for multiple attributes
Using the MBean Browser to Add an MBean Attribute for specific attributes
For background information about creating JMX metrics see Monitor JVMs and Monitor JMX
MBeans.
JMX Metric Rules and Metrics

A JMX Metric Rule maps a set of MBean attributes from one or more MBeans into AppDynamics
persistent metrics. You configure a metric rule that creates one or more metrics in the
AppDynamics system. You may want to create new metrics if the preconfigured metrics do not
provide sufficient visibility into the health of your system.
After the MBean attribute is configured to provide a persistent metric in AppDynamics, you can use
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it to configure health rules. For details see Health Rules.
To view the MBeans that are reporting currently in your managed environment use the Metric
Browser.
You can use the JMX Metrics Rules Panel or the MBean Browser to create new metrics. MBean
query expressions are supported.
Required User Permissions
To configure new JMX Metrics your user account must have "Configure JMX" permissions
for the application.
For information about configuring user permissions for applications, see To Configure the
Default Application Permissions.
Using the JMX Metric Rules Configuration Panel

The JMX Metric Rules Panel is the best way to create metrics for multiple attributes based on the
same MBean or for complex matching patterns.
1. In the left navigation pane, click Configure -> Instrumentation.
2. Click the JMX tab.
3. In the JMX Metric Configurations panel, click the Java platform for which you are configuring
metrics.

4. In the JMX Metric Rules panel, click the Add (the + icon). The New Rule # panel opens. The
rule is given the next incremented number.
5. Provide the name and settings for this rule:
The Name is the identifier you want to display in the UI.
An Exclude Rule is used for excluding existing rules, so leave the default No option.
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5.

Enabled means that you want this rule to run, so leave it selected.
The Metric Path is the category as shown in the Metric Browser where the metrics will
be displayed. A metric path groups the metrics and is relative to the Metric Browser
node. For example, the following screenshot displays how the JMX Metric Rule
"Tomcat_HttpThreadPools" is defined for the ACME Online demo. The metric path is
"Web Container Runtime", the category on Metric Browser where all metrics
configured under the "Tomcat_HttpThreadPools" Metric Rule will be available.

6. In the MBeans subpanel, add matching criteria to identify the MBeans that you want to
monitor.
The Domain name is the Java domain. This property must be the exact name; no
wildcard characters are supported.
The Object Name Match Pattern is the full object name pattern. The property may
contain wildcard characters, such as the asterisk for matching all the name/value
pairs. For example, specifying "jmx:type=Hello,*" matches a JMX MBean
ObjectName, "jmx:type=Hello,name=hello1,key1=value1".
The Instance Identifier is the MBean ID.
The Advanced MBean Matching Criteria is optional for more complex matching.
Use one of the following:
any-substring
final-substring
equals
initial-substring
7. Click Add Condition.
For example, the following screenshot displays the MBean matching criteria for the
"Tomcat_HTTPThreadPools" rule.
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8. For all MBeans that match the preceding criteria, you can define one or more metrics for the
attributes of those MBeans.
In the Attributes panel click Add Attribute to specify the MBean attributes.
9. Provide the name of the attribute and the metric name. The metric name is used to
represent the metric in the Metric Browser.
10. If needed, specify Advanced properties for the attribute.
Metric Getter Chain Expressions can be executed against any value. In addition,
getter chains for Strings and Booleans are supported using implicit conversion. See M
Bean Getter Chains and Support for Boolean and String Attributes.
Metric Time Rollup determines how the metric will be aggregated over a period of
time. You can choose to either average or sum the data points, or use the latest data
point in the time interval.
Metric Cluster Rollup defines how the metric will be aggregated for a tier, using the
performance data for all the nodes in that tier. You can either average or sum the
data.
Metric Aggregator Rollup defines how the Agent rolls up multiple individual
measurements (observations) into the observation that it reports once a one minute.
For performance reasons, Agents report data to the Controller at one minute intervals.
Some metrics, such as Average Response Time, are measured (observed) many
times in a minute. The Metric Aggregator Rollup setting determines how the Agent
aggregates these metrics. You can average or sum observations on the data points or
use the current observation. Alternatively you can use the delta between the current
and previous observation.
11. Click Add Attribute to define another metric from the same MBean.
12. Click Create JMX Rule.
The following screenshot shows how the MBean attributes configured for the
Tomcat_HttpThreadPools rule are displayed in the Metric Browser.
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Using the MBean Browser to Add an MBean Attribute

You may know exactly which particular MBean attribute you want to monitor. You can select the
attribute in the MBean Browser and create a JMX Metric Rule for it.
To create a metric from an MBean attribute in the MBean Browser

1. Navigate to the attribute and select it in the MBean Browser.
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2. Click Create Metric.
3. In the Select JMX Configuration for the Metric Rule window, select the group in which to
create the rule from the Select JMX Configuration pulldown. The categories that already
exist on your system are listed. This example uses the Tomcat JMX configuration. Click OK.

4. Alternatively, you can create a new group with an name of your choosing. Click Create New
JMX Configuration to make a new category. This is useful if you want to separate out the
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custom metrics from the out-of-the-box metrics. The Create JMX Metric Rule from an
MBean window opens.

5. Supply the Metric Path, the category as shown in the Metric Browser where the metrics will
be displayed. For more discussion of the Metric Path see Step 5 of the previous section.
6. Review the MBean Matching Criteria and modify it as needed. Since this is the MBean you
selected, you probably do not need to change it.
7. Review the MBean Attribute and Metric Name. This is the MBean attribute you originally
selected. By default the name is the same as the attribute. You can change it if you want to
be more specific about its use.
8. Review the Advanced panel rollup criteria and update as needed. For more information
about these options see Step 10 of the previous section.
9. Click Add Attribute to define another metric from the same MBean.
10. Click Create JMX Rule. The new metric displays in the JMX Metric Browser.
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10.

Learn More

Monitor JVMs
Monitor JMX MBeans
Exclude JMX Metrics
Create, Import or Export JMX Metric Configurations

To create a New JMX Configuration
To import a JMX metrics configuration
To export a JMX metrics configuration
To use a pre-3.3 configuration file for JMX metrics
This topic describes how to import or export your existing JMX configurations or create new JMX
configurations.
Prerequisite for Configuring JMX Metric Rules
In order to configure JMX metric rules, your user account must have "Configure
JMX" permissions for the application. For information about configuring user
permissions for applications, see To Configure the Default Application Permissions.
To create a New JMX Configuration

This is useful if you want to separate out the custom metrics from the out-of-the-box metrics.
1. In the left navigation menu, click Servers -> JMX.
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2. Click Select Node, in the Node Browser click the node, and then click Select. All the
Domains for the node appear.
3. In the Domain tree, expand the domains to locate the MBean you want to use as the basis
for a JMX metric.

4. Click the MBean attribute you want to work with, and then click Create New JMX
Configuration.
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The Create JMX Configuration dialog appears.

5. Enter the Name and Description for the JMX configuration, and click Enabled if you want
the new configuration to be immediately accessible and usable.
To import a JMX metrics configuration

1. Click Configure -> Instrumentation.
2. Click the JMX tab.
3. Click the Import JMX Configuration icon.

4. In the JMX Configuration Import screen, click Select JMX Config. File and select the XML
configuration file for your JMX metrics.
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5. Click Import.
To export a JMX metrics configuration

1. Click Configure -> Instrumentation.
2. Click the JMX tab.
3. Click the Export JMX Configuration icon.
The configuration is downloaded as an XML file.
To use a pre-3.3 configuration file for JMX metrics

In AppDynamics Pro Version 3.3 the structure of the XML-based configuration file for JMX metrics
changed. As a result, if you use a pre-3.3 version, you must provide additional attributes in the
configuration file.
The following screenshot shows a sample XML configuration file for the JMX metrics for pre-3.3
versions of AppDynamics:
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Beginning with AppDynamics version 3.3, the structure for this XML file is the following:

To be able to import your existing configurations for JMX metrics, add the following attributes for
<server> element and each of the <metric> elements in your XML file.
The attributes for each element are listed below:
Attributes for the <server> element
Attribute Name

Attribute Type

description

String

enabled

Boolean

name

String

Allowed Values

Mandatory/Optional
Mandatory

true/false

Mandatory
Mandatory

Attributes for each <metric> element
For each <metric> element, add the mandatory attributes from the following list to your existing
configuration file:
Attribute Name

Attribute Type

name

String

domain-name

String

mbean-name-pattern

String
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Mandatory/Optional
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true/false

Mandatory
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category

String

enabled

Boolean

true/false

Mandatory

exclude

Boolean

true/false

Mandatory

bean-name

String

Optional

query-attribute

String

Optional

query-expression-type

Mandatory
All those <metric>
elements that
have same value for
this attribute will
be grouped together
on the metric browser.

Use any one from the
following values:

Optional

any-substring
final-substring
equals
initial-substring
query-value

String

Optional

instance-identifier

String

Optional

instance-name

String

Optional

Exclude JMX Metrics

Tuning What Metrics are Gathered
To exclude a metric
Learn More
This topic describes how to exclude MBean attributes from being monitored as JMX metrics.
For background information about JMX metrics see Monitor JVMs and Monitor JMX MBeans.
Tuning What Metrics are Gathered

AppDynamics provides a default configuration for certain JMX metrics. However, in situations
where an environment has many resources, there may be too many metrics gathered.
AppDynamics lets you exclude resources and particular operations on resources.
To exclude a metric

For example, suppose you want to exclude monitoring for HTTP Thread Pools. Follow the
procedure described in Create a new JMX Metrics Rule, using the following criteria:
1. Set the Exclude Rule option to Yes.
2. Provide the Object Name Match Pattern:
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Catalina:type=ThreadPool,*

3. Provide the Advanced MBean Matching value:
http

This configuration causes AppDynamics to stop monitoring metrics for HTTP Thread Pools.
Later, if you want to see all HTTP Thread Pool metrics, clear the Enabled checkbox to disable the
rule.
Learn More

Monitor JVMs
Monitor JMX MBeans
Configure JMX Metrics from MBeans
Exclude MBean Attributes

Excluding MBean Attributes from the MBean Browser
To exclude an MBean attribute
Learn More
Excluding MBean Attributes from the MBean Browser

Some MBean attributes contain sensitive information that you do not want the Java Agent to
report. You can configure the Java Agent to exclude these attributes using the <exclude
object-name> setting in the app-agent-config.xml file.
To exclude an MBean attribute

1. Open the AppServerAgent/conf/app-agent-config.xml file.
2. The new configuration takes effect immediately if the agent-overwrite property is set to true in
the app-agent-config.xml. If agent-overwrite is false, which is the default, then the new
configuration will be ignored and you have to restart the agent. Set the property to true.
<property name="agent-overwrite" value="true"/>

3. Locate the JMXService section. It looks like this:
<agent-service name="JMXService" enabled="true">

4. In the JMXService <configuration> section add the <jmx-mbean-browser-excludes> section and
the <exclude object-name> property as per the instructions in the comment.
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<configuration>
<!-Use the below configuration sample to create rules to
exclude MBean attributes from MBean Browser.
<exclude object-name=<MBean name pattern>
attributes=< * |comma separated list of attribute names> >
The example below will exclude all attributes of
MBeans that match "Catalina:*".
<jmx-mbean-browser-excludes>
<exclude object-name="Catalina:*"
attributes="*"/>
</jmx-mbean-browser-excludes>
-->
</configuration>

4. Save the file.
Learn More

App Agent for Java Directory Structure
Configure JMX Without Transaction Monitoring

Collect Metrics without Transaction Monitoring
To turn off transaction detection
Learn More
Collect Metrics without Transaction Monitoring

In some circumstances, such as for monitoring caches and message buses, you want to collect
JMX metrics without the overhead of transaction monitoring.
You can do this by turning off transaction detection at the entry point.
To turn off transaction detection

1.
2.
3.
4.
5.

In the left navigation panel, click Configure -> Instrumentation.
In the Select Application or Tier panel, select the application.
In the right panel, click Use Custom Configuration for this Tier.
Expand the Entry Points list if it is not already expanded.
Clear all the relevant Enabled checkboxes in the Transaction Monitoring column.

Transaction monitoring on all selected entry points in the application is disabled. Exit point
detection remains enabled.
Learn More

Configure Business Transaction Detection
Resolve JMX Configuration Issues

Unable to browse MBeans on WebSphere Application Server (WAS).
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Unable to get metrics from the App Agent for Java App on a GlassFish server
Unable to get JMX metrics for database connections on GlassFish
Learn More
This topic describes how to resolve issues that may prevent AppDynamics from properly reporting
JMX MBean metrics.
Unable to browse MBeans on WebSphere Application Server (WAS).

In certain situations, you may encounter the following exception in the agent.log file for App Agent
for Java App deployed on the WebSphere Application Server (WAS).
[AD Thread-Transient Event Channel Poller0] 17 Aug 2011 08:14:08,031
ERROR JMXTransientOperationsHandler - Error trying to lookup clz java.lang.ClassNotFoundException: com.ibm.ws.security.core.SecurityContext

To resolve this issue:
1. From the WAS administration console, navigate to the JVM settings for the server of interest: A
pplication servers -> <server> -> Process Definition -> Java Virtual Machine.
2. Remove the following setting from the generic JVM settings:
-Djavax.management.builder.initial = -Dcom.sun.management.jmxremote

Unable to get metrics from the App Agent for Java App on a GlassFish server

Under some situations JMX metrics from GlassFish are not reported. Also some metrics may not
be enabled by default. Try these solutions:
1) Confirm that JMX monitoring is enabled in the GlassFish server. Refer to the following
screenshot:
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2) Copy the text below into an mbean-servers.xml file in the following directory:
<App_Agent_Dir>/conf/jmx/

<?xml version="1.0" encoding="UTF-8" ?>
<!--<!DOCTYPE servers SYSTEM "mbean-servers.dtd"> -->
<servers xmlns="http://www.appdynamics.com"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:schemaLocation="http://www.appdynamics.com
mbean-servers.xsd">
<!-<server mbean-server-name="WebSphere"
mbean-name-pattern="WebSphere:*,type=Server,j2eeType=J2EEServer"
version-attribute="platformVersion" version-startsWith="7"
config-file="servers/websphere-7-jmx-config.xml" />
<server mbean-server-name="WebSphere"
mbean-name-pattern="WebSphere:*,type=Server,j2eeType=J2EEServer"
version-attribute="platformVersion" version-startsWith="6"
config-file="servers/websphere-7-jmx-config.xml" />
-->
<server mbean-server-name="WebSphere"
mbean-name-pattern="WebSphere:*,type=Server"
config-file="servers/websphere-7-jmx-config.xml" />
<server mbean-server-name="JBoss_4"
mbean-name-pattern="jboss.management.local:j2eeType=J2EEServer,name=Local"
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version-attribute="serverVersion" version-startsWith="4"
config-file="servers/jboss-4-jmx-config.xml" />
<server mbean-server-name="JBoss_5"
mbean-name-pattern="jboss.management.local:j2eeType=J2EEServer,name=Local"
version-attribute="serverVersion" version-startsWith="5"
config-file="servers/jboss-5-jmx-config.xml" />
<server mbean-server-name="JBoss_6"
mbean-name-pattern="jboss.management.local:j2eeType=J2EEServer,name=Local"
version-attribute="serverVersion" version-startsWith="6"
config-file="servers/jboss-5-jmx-config.xml" />
<server mbean-server-name="Tomcat_5.5"
mbean-name-pattern="Catalina:type=Server" version-attribute="serverInfo"
version-startsWith="Apache Tomcat/5.5"
config-file="servers/tomcat-5-jmx-config.xml" />
<server mbean-server-name="Tomcat_6.0"
mbean-name-pattern="Catalina:type=Server" version-attribute="serverInfo"
version-startsWith="Apache Tomcat/6.0"
config-file="servers/tomcat-6-jmx-config.xml" />
<server mbean-server-name="Tomcat_7"
mbean-name-pattern="Catalina:type=Server" version-attribute="serverInfo"
version-startsWith="Apache Tomcat/7"
config-file="servers/tomcat-7-jmx-config.xml" />
<server mbean-server-name="Sun GlassFish_2.1"
mbean-name-pattern="com.sun.appserv:j2eeType=J2EEServer,name=server,category=run
time" config-file="servers/glassfish-v2-jmx-config.xml" />
<server mbean-server-name="WebLogic_10"
mbean-server-lookup-string="java:comp/jmx/runtime"
mbean-name-pattern="com.bea:*,Type=ServerRuntime"
version-attribute="WeblogicVersion" version-startsWith="WebLogic Server 10"
config-file="servers/weblogic-10-jmx-config.xml" />
<server mbean-server-name="WebLogic_9"
mbean-server-lookup-string="java:comp/jmx/runtime"
mbean-name-pattern="com.bea:*,Type=ServerRuntime"
version-attribute="WeblogicVersion" version-startsWith="WebLogic Server 9"
config-file="servers/weblogic-9-jmx-config.xml" />
<server mbean-server-name="ActiveMQ_5.3.2"
mbean-name-pattern="org.apache.activemq:*"
config-file="servers/activemq-5.3.2-jmx-config.xml" />
<server mbean-server-name="Apache Solr 1.4.1" mbean-name-pattern="solr:*"
config-file="servers\solr-1.4.1-jmx-config.xml" />
<server mbean-server-name="Apache Cassandra 0.7.0"
mbean-name-pattern="org.apache.cassandra.net:*"
config-file="servers\cassandra-0.7.0-jmx-config.xml" />
<server mbean-server-name="Apache Cassandra 0.7.0"
mbean-name-pattern="org.apache.cassandra.db:*"
config-file="servers\cassandra-0.7.0-jmx-config.xml" />
<server mbean-server-name="Apache Cassandra 0.7.0"
mbean-name-pattern="org.apache.cassandra.request:*"
config-file="servers\cassandra-0.7.0-jmx-config.xml" />
<server mbean-server-name="Apache Cassandra 0.7.0"
mbean-name-pattern="org.apache.cassandra.internal:*"
config-file="servers\cassandra-0.7.0-jmx-config.xml" />
<!-- If you are using Platform MBean server to report activemq metrics then
you may uncomment the following line.
-->
<!--
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<server mbean-server-name="Platform"
mbean-name-pattern="org.apache.activemq:*"
config-file="servers\activemq-5.3.2-jmx-config.xml" />
-->
<!-- If your app publishes custom jmx metrics to platform jmx server then
you may modify the platform-jmx-config.xml
and update the mbean-name-pattern in the following line to start recording
your metrics by appdynamics agent
-->
<!-<server mbean-server-name="Platform" mbean-name-pattern="com.foo.myjmx:*"
config-file="servers\platform-jmx-config.xml" />
-->
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</servers>

You should see a new JMX node in the metrics tree.
Unable to get JMX metrics for database connections on GlassFish
JDBC connection pool metrics are not configured out-of-the-box for GlassFish. To configure them,
uncomment the JDBC connection pool section and provide the relevant information in the following
file:
<app_agent_install>/conf/jmx/servers/glassfish-v2-jmx-config.xml

Uncomment the following section and follow the instructions provided in the file.
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<!-- The following config can be uncommented to monitor glassfish JDBC
connection pool. Please set the name of the connection
pool (not the datasource name) and enable monitoring for the JDBC Pools on
glassfish admin console. -->
<!-<metric
mbean-name-pattern="com.sun.appserv:type=jdbc-connection-pool,category=monitor,n
ame=<set the name of pool>,*"
category="JDBC Connection Pools">
<attribute-counter-mappings>
<attribute-counter-mapping>
<attribute-name>numconnused-current</attribute-name>
<counter-name>Connections In Use</counter-name>
<counter-type>average</counter-type>
<time-rollup-type>average</time-rollup-type>
<cluster-rollup-type>individual</cluster-rollup-type>
</attribute-counter-mapping>
<attribute-counter-mapping>
<attribute-name>numconnused-highwatermark</attribute-name>
<counter-name>Max Connections Used</counter-name>
<counter-type>observation</counter-type>
<time-rollup-type>average</time-rollup-type>
<cluster-rollup-type>individual</cluster-rollup-type>
</attribute-counter-mapping>
<attribute-counter-mapping>
<attribute-name>numpotentialconnleak-count</attribute-name>
<counter-name>Potential Leaks</counter-name>
<counter-type>observation</counter-type>
<time-rollup-type>average</time-rollup-type>
<cluster-rollup-type>individual</cluster-rollup-type>
</attribute-counter-mapping>
<attribute-counter-mapping>
<attribute-name>averageconnwaittime-count</attribute-name>
<counter-name>Avg Wait Time Millis</counter-name>
<counter-type>observation</counter-type>
<time-rollup-type>average</time-rollup-type>
<cluster-rollup-type>individual</cluster-rollup-type>
</attribute-counter-mapping>
<attribute-counter-mapping>
<attribute-name>waitqueuelength-count</attribute-name>
<counter-name>Current Wait Queue Length</counter-name>
<counter-type>observation</counter-type>
<time-rollup-type>average</time-rollup-type>
<cluster-rollup-type>individual</cluster-rollup-type>
</attribute-counter-mapping>
</attribute-counter-mappings>
</metric>

Learn More

IBM WebSphere and InfoSphere Startup Settings
GlassFish Startup Settings
MBean Getter Chains and Support for Boolean and String Attributes
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In addition to getter chain support for numeric boxed primitives (Short, Integer, Long, etc.),
Strings and Booleans are supported using implicit conversion. Expressions can be
executed against any value.
Prior to 3.7.7, AppDynamics supported Integer MBean attributes. In 3.7.7 support was
added for Boolean and String attributes using the new getter chain field that implicitly
converts the Boolean or String to an Integer. Booleans are automatically converted to 0
(false) and 1 (true). Strings are converted to numeric values.
Example Metric Getter Chain

1. Given the following MBean code:

2. Locate the MBean in the MBean Browser:
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3. Create a new JMX Metric Rule and add the getter chain information in new Metric Getter Chain
field:
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4. The new metric shows up in the Metric Tree:
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Learn More

Getter Chains in Java Configurations
Configure Percentile Metrics for Java
In many places across the Controller UI you can choose to display metrics using either averages
or percentiles. A percentile is a measure that indicates a value below which a given percentage of
values in a set falls: for example, the 99th percentile means that 99% of all values are below this
level. Using percentiles can be a good way to reduce the impact of extreme outliers in
performance metrics, which can be useful in the often noisy environments of end user experience
monitoring.
You can:
enable/disable percentile metric display
set up to five different percentile levels to be applied to metrics

New in 3.9 - Configuring Percentile Metrics for Java
<p> Configuring Percentile Metrics for Java</p>

Access Configure Percentile Metrics Configuration
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New in 3.9
1. Access the application Configuration page if you are not already there.

2. From the left navigation menu, select Slow Transaction Thresholds.
3. To apply your settings to all business transaction thresholds, click Default Thresholds.
To apply your settings to the thresholds for a specific transaction, click Invdividual
Transaction Thresholds and then select the transaction you want to configure.
4. Expand Percentile Metrics Settings.
When you complete your changes, remember to click Save.
Configure Percentile Metrics

New in 3.9

1. Check Enable Percentile Metrics.
2. Add up to five percentile levels to collect. Each value must be a whole number between 1
and 99.
3. To apply this configuration to all existing business transactions, click Apply to all Existing
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3.
Business Transactions.
To apply this configuration to only new transacations discovered, ensure Apply to all
Existing Business Transactions is not selected.
4. Click Save Percentile Metric Configuration.
Configuring Percentile Metrics using App Agent Node Properties

New in 3.9 Percentile Metrics are captured and reported by the App Agent for Java by default.
There are three agent node properties that you can use to enable or disable collections and
presentation of percentile metrics and configure how percentile metrics are collected. You do not
need to restart the agent after making changes to these properties.
disable-percentile-metrics: Set this property to 'false' to view the percentile metrics. New in
3.9 The default value for this property is 'false'.
percentile-method-option You can choose one of two different algorithms to calculate
percentiles in AppDynamics:
P Square algorithm (default): This option consumes the least amount of storage and
incurs the least amount of CPU overhead. The accuracy of the percentile calculated
varies depending on the nature of the distribution of the response times. You should
use this option unless you doubt the accuracy of the percentiles presented.
Quantile Digest algorithm: This option consumes slightly more storage and CPU
overhead for the machine where the agent is running, but may offer better percentiles
depending on how the response times are distributed.
percentiles-to-report: By default, the system will capture the 95th percentile metrics. You can
change the percentile captured here.
Learn More

Percentile Metrics for Business Transactions
Metric Browser
Business Metrics
App Agent Node Properties Reference
App Agent Node Properties
Instrumenting New Constructs Available in Java 8
Language Constructs
Lambdas
Interface Static Methods
Interface Default Methods
Instrumenting an Interface Default Method Directly
Java 8 includes a many new features, most notably there are several new language constructs:
lambdas, static interface methods, and default interface methods. This document helps you
instrument these constructs.
Language Constructs
Lambdas

Lambdas are a new addition to Java 8, enabling a functional style of programming in Java. Here's

Copyright © AppDynamics 2012-2014

Page 1323

a short example:
LambdaMethodInterface i = (acc, x) -> acc + x;

In the JVM, this essentially creates an anonymous instance of the associated FunctionalInter
face, shown below:
package jdk8;
@java.lang.FunctionalInterface
interface LambdaMethodInterface
{
int sum(int acc, int x);
}

To instrument lambda instances, create a POJO business transaction match rule for the LambdaM
ethodInterface such as:
Match Classes

that implements an interface which

Equals

jdk8.LambdaMethodInterface

Interface Static Methods

Interfaces now can have static methods, such as can be found in the example below:
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package jdk8;
interface InterfaceForStaticMethod
{
static int sum(int acc, int x)
{
return acc + x;
}
}

The bytecode for this construct resides in the compiled class file so a class match against the
interface class will instrument that class for a business transaction.
Create a POJO business transaction match rule for the interfaceForStaticMethod such as:
Match Classes

with a Class Name that

Equals

jdk8.InterfaceForStaticMethod

Interface Default Methods

Interfaces can now have default methods. As with interface static methods, the bytecode resides
in the interface for default methods.
There are two important points to keep in mind when defining instrumentation against an interface
default method:
1. If the target are classes that do not override the default method, target the interface via a
class match
2.
Copyright © AppDynamics 2012-2014

Page 1325

2. If the target are classes that do override the default method, target the interface via an
interface match
Instrumenting an Interface Default Method Directly

Given:
package jdk8;
interface InterfaceForConcreteClassDefaultMethod
{
default int sum(int acc, int x)
{
return acc + x;
}
}

And:
package jdk8;
class ClassForDefaultMethod implements InterfaceForConcreteClassDefaultMethod
{
}

In this example, the ClassForDefaultMethod does not override the default method. Therefore,
you can use a class match against the interface such as:
Match Classes
thod

with a Class Name that
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Instrumenting an Overridden Default Method
Given:
package jdk8;
interface InterfaceForAnonymousClassDefaultMethod
{
default int sum(int acc, int x)
{
return acc + x;
}
}

And:
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InterfaceForAnonymousClassDefaultMethod i = new
InterfaceForAnonymousClassDefaultMethod()
{
@Override
public int sum(int acc, int x)
{
return acc + x;
}
};

Because the method is overridden, the target bytecode resides in the anonymous class, Interfa
ceForAnonymousClassDefaultMethod. So you need to create an interface match POJO
business transaction match rule such as:
Match Classes
Method

with a Class Name that

Equals

jdk8.InterfaceForAnonymousClassDefault

Monitor Java Applications
Monitor JVMs

Infrastructure Monitoring in a Java Environment
JVM Key Performance Indicators

Copyright © AppDynamics 2012-2014

Page 1328

Memory Usage and Garbage Collection
To view heap usage, garbage collection, and memory pools
Heap Usage
Garbage Collection
Memory Pools
Classes, Garbage Collection, Memory, Threads, and Process CPU Usage Metrics
To view classes, garbage collection, memory, threads, and process CPU usage
metrics
Alert for JVM Health
Monitor JVM Configuration Changes
Detect Memory Leaks
Automatic Leak Detection
To enable automatic leak detection
Detect Memory Thrash
Object Instance Tracking
To monitor Java object instances
Monitor Long-lived Collections
To view or configure custom memory structures
Learn More

JVM/container configuration can often be a root cause for slow performance because not
enough resources are available to the application.
Infrastructure Monitoring in a Java Environment

A Java application environment has multiple functional subsystems. These are usually
instrumented using JMX (Java Management Extensions) or IBM Performance Monitoring
Infrastructure (PMI). AppDynamics automatically discovers JMX and PMI attributes.
JMX uses objects called MBeans (Managed Beans) to expose data and resources from your
application. In a typical application environment, there are three main layers that use JMX:
JVMs provide built-in JMX instrumentation, or platform-level MBeans that supply important
metrics about the JVM.
Application servers provide server or container-level MBeans that reveal metrics about the
server.
Applications often define custom MBeans that monitor application-level activity.
MBeans are typically grouped into domains to indicate where resources belong. Usually in a JVM
there are multiple domains. For example, for an application running on Apache Tomcat there are
“Catalina” and “Java.lang” domains. “Catalina” represents resources and MBeans relating to the
Tomcat container, and “Java.lang” represents the same for the JVM Hotspot runtime. The
application may have its own custom domains.
For more information about JMX, see the JMX overview and tutorial. To learn about PMI see Writi
ng PMI Applications Using the JMX Interface.
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JVM Key Performance Indicators

There are often thousands of attributes, however, you may not need to know about all of them. By
default, AppDynamics monitors the attributes that most clearly represent key performance
indicators and provide useful information about short and long term trends. The preconfigured JVM
metrics include:
Total classes loaded and how many are currently loaded
Thread usage
Percent CPU process usage
On a per-node basis:
Heap usage
Garbage collection
Memory pools and caching
Java object instances
You can configure additional monitoring for:
Automatic leak detection
Custom memory structures
Memory Usage and Garbage Collection

Monitoring garbage collection and memory usage can help you identify memory leaks or memory
thrash that can have a negative impact application performance.

Important Information
The agent cannot capture memory statistics if the application is configured to use G1GC
(-XX:+UseG1GC) and using JDK version = 1.6.0_26-b03. You should either remove
-XX:+UseG1GC from the application startup options or upgrade the JDK to version 1.6.0_3
2 or higher.

To view heap usage, garbage collection, and memory pools

1. In the left navigation pane, click Servers - > App Servers -> <tier> -> <node>. The Node
Dashboard opens.
2. On the Node Dashboard, click the Memory tab.
3. On the Memory tab, click the Heap & Garbage Collection subtab. The panels show data
about the current usage.
See Node Dashboard for a complete description of the this dashboard.
Heap Usage

The Heap panel shows data about the current usage.
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Garbage Collection

Java garbage collection refers to how the JVM monitors the objects in memory to find any objects
which are no longer being referenced by the running application. Unused objects are deleted from
memory to make room for new objects. For details see the Java documentation for Tuning
Garbage Collection.
Garbage collection is a well-known mechanism provided by Java Virtual Machine to reclaim heap
space from objects that are eligible for garbage collection. The process of scanning and deleting
objects can cause pauses in the application. Because this can be an issue for applications with
large amounts of data, multiple threads, and high transaction rates, AppDynamics captures
performance data about the duration of the pauses for garbage collection.
Below the Heap panel, the Garbage Collection - Time Spent panel shows how much time, in
milliseconds, it takes to complete both minor and major collections.

The Garbage Collection - Minor Collections panel shows the number of minor collections per
minute. The effectiveness of minor collections indicates better performance for your application.
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The Garbage Collection - Major Collections panel shows the number of major collections per
minute.

Memory Pools

The Memory Pools panel shows usage and trends about the Java memory pools.

Classes, Garbage Collection, Memory, Threads, and Process CPU Usage Metrics

Information on JVM classes, garbage, threads and process CPU usage is available on the JMX
Metrics subtab of the Node Dashboard JMX tab.
To view classes, garbage collection, memory, threads, and process CPU usage metrics

1. In the left navigation pane, click Servers - > App Servers -> <tier> -> <node>. The Node
Dashboard opens.
2. In the Node Dashboard, click the JMX tab.
3. In the JMX Metrics subtab metric tree, click an item and drag it to the line graph to plot current
metric data.
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Alert for JVM Health

You can set up health rules based on JVM or JMX metrics. Once you have a health rule, you can
create specific policies based on health rule violations. One type of response to a health rule
violation is an alert. See Alert and Respond for a discussion of how health rules, alerts, and
policies can be used.
You can also create additional persistent JMX metrics from MBean attributes. See Configure JMX
Metrics from MBeans.
Monitor JVM Configuration Changes

The JVM tab of the Node Dashboard displays the JVM version, startup options, system options
and environment properties for the node.
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Changes to the application configuration generate events that can be viewed in the Events list.
For more information, see Monitor Application Change Events.
Detect Memory Leaks

By monitoring JVM heap utilization and memory pool usage you can identify potential memory
leaks. Consistently increasing heap valleys may indicate either an improper heap configuration or
a memory leak. You might identify potential memory leaks by analyzing the usage pattern of either
the survivor space or the old generation. To troubleshoot memory leaks see Troubleshoot Java
Memory Leaks.
Automatic Leak Detection

AppDynamics supports automatic leak detection for some JVMs as listed in JVM Support. By
default this functionality is not enabled, because using this mode results in higher overhead on the
JVM. AppDynamics recommends that you enable leak detection mode only when you suspect a
memory leak problem and that you turn it off once the leak is identified and remedied.
Memory leaks occur when an unused object’s references are never freed. These are the most
common occurrences in collections classes, such as HashMap. This is caused when an
application code puts objects in collections but does not remove them even when they are not
being actively used. In production environments with high workloads, a frequently
accessed collection with a memory leak can cause the application to crash.
AppDynamics automatically tracks every Java collection (HashMap, ArrayList, and so on) that has
been alive in the heap for more than 30 minutes. The collection size is tracked and a linear
regression model identifies if the collection is potentially leaking. You can then identify the root
cause of the leak by tracking frequent accesses of the collection over a period of time.
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View this data on the Node Dashboard on the Automatic Leak Detection subtab of the Memory
tab. See Node Dashboard for a complete description of this dashboard and its tabs.
To enable automatic leak detection

To enable automatic leak detection follow the instructions at Troubleshoot Java Memory Leaks.
Detect Memory Thrash

Memory thrash is caused when a large number of temporary objects are created in very short
intervals. Although these objects are temporary and are eventually cleaned up, the
garbage collection mechanism may struggle to keep up with the rate of object creation. This may
cause application performance problems. Monitoring the time spent in garbage collection can
provide insight into performance issues, including memory thrash. For example, an increase in the
number of spikes for major collections either slows down a JVM or indicates potential memory
thrash. To troubleshoot memory thrash, see Troubleshoot Java Memory Thrash.
Object Instance Tracking

The Object Instance Tracking subtab helps you isolate the root cause of possible memory thrash.
By default,AppDynamics tracks the object instances for the top 20 core Java classes and the top
20 application classes. For the list of the supported JVMs see the Compatibility Matrix for Memory
Monitoring.
The Object Instance Tracking subtab provides the number of instances for a particular class and
graphs the count trend of those object in the JVM. It provides the shallow memory size (the
memory footprint of the object and the primitives it contains) used by all the instances.

To monitor Java object instances

1. Ensure the tools.jar file is in the jre/lib/ext directory.
2. On the Node Dashboard, click the Memory tab.
3. On the Memory tab, click the Object Instance Tracking subtab.
4.
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4. Click On and then OK.
See Configure Object Instance Tracking (Java).
Monitor Long-lived Collections

AppDynamics automatically tracks long lived Java collections (HashMap, ArrayList, and so on)
with Automatic Leak Detection. You can also configure tracking of specific classes using the
Custom Memory Structures capability. You can use this capability to monitor a custom cache or
other structure that is not a Java collection. Custom memory structures are used as caching
solutions. For example, you may have a custom cache or a third party cache such as Ehcache. In
a distributed environment, caching can easily become a prime source of memory leaks. In
addition, custom memory structures may or may not contain collections objects that would be
tracked using automatic leak detection. It is therefore important to manage and track these
memory structures.
AppDynamics provides visibility into:
Cache access for slow, very slow, and stalled business transactions
Usage statistics (rolled up to Business Transaction level)
Keys being accessed
Deep size of internal cache structures
Ensure your custom memory structures are supported on your JVM, see JVM Support.
To view or configure custom memory structures

1. In the Node Dashboard, click the Memory tab.
3. On the Memory tab, click the Custom Memory Structures subtab.
For details see Configure and Use Custom Memory Structures for Java.
Learn More

Configure Policies
Supported Environments and Versions
Infrastructure Metrics
Monitor Events
JVM Crash Guard

To start monitoring for JVM Crashes
When a JVM crash occurs,you need to be notified as soon as possible. Learning of a JVM crash
is very critical because it maybe a sign of a severe runtime problem in an application.
Furthermore, you may want to to take remediation steps once you are aware that a crash event
has occurred. JVM Crash is a new event type, implemented as part of JVM Crash Guard, that you
can activate to provide you with the critical information you need to expeditiously handle JVM
crashes.
The following image shows the Events window where notification of two JVM Crash events
detected is displayed.
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Double-clicking the JVM Crash event on the Events window displays more information to assist
you in troubleshooting the underlying reason for the JVM crash.
On the Summary page you can download any logs associated with the JVM Crash event.

The JVM Crash window also displays information about actions executed as a result of the crash.
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These are actions that you specify when creating the policy that is triggered by a JVM crash event.

The JVM Crash event captures the following information: timestamp, crash reason, host name, IP
address, process ID, application name, node name, and tier name and displays them on the
details page.
In the Crash Reason details field of the JVM Crash Details tab, the JVM Crash details indicate the
root cause of the crash if available; for example, a java.lang.OutOfMemoryError, Segmentation
Fault, etc... To facilitate the discovery and display of the reason for the JVM crash, JVM Crash
Guard provides full support for:
Hotspot JVM error log analysis
IBM JVM System Dump log analysis
Jrockit JVM error log analysis

To start monitoring for JVM Crashes

Prerequisite
JVM Crash Guard is a policy trigger that works with the Standalone Machine Agent to fire
an AppDynamics policy when a JVM Crash event occurs. You must therefore have a
Standalone Machine Agent installed on the system which you want to monitor for JVM
crashes. On Windows, the Standalone Machine Agent must run in Administrator root
mode. On Linux, JVM Crash Guard requires that the Standalone Machine Agent user be
able to read all the processes in /proc/*. This may be the ‘root’ user or another user with
this privilege.
1. From the left-hand navigation menu, click Alert & Respond ->Policies and then click Creat
e a Policy.
OR
Navigate to the Policies tab and then click Create a Policy.
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1.

The Create Policy dialog appears.

2. In the Other Events section, expand the Server Crashes option and click JVM Crash.
The JVM Crash event then becomes a trigger to fire a policy.
3. Proceed as usual to create the Policy. For more information on creating Policies, see Policie
s.
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Monitor Java App Servers

Infrastructure Monitoring in a Java Environment
App Server Key Performance Indicators
Alerting for App Server Health
Learn More

Utilizing JMX Metrics in
Troubleshooting

Infrastructure Monitoring in a Java Environment

A Java application environment has multiple functional subsystems. These are usually
instrumented using JMX (Java Management Extensions) or IBM Performance Monitoring
Infrastructure (PMI). AppDynamics automatically discovers JMX and PMI attributes.
JMX uses objects called MBeans (Managed Beans) to expose data and resources from your
application. In a typical application environment, there are three main layers that use JMX:
JVMs provide built-in JMX instrumentation, or platform-level MBeans that supply important
metrics about the JVM.
Application servers provide server or container-level MBeans that reveal metrics about the
server.
Applications often define custom MBeans that monitor application-level activity.
MBeans are typically grouped into domains to indicate where resources belong. Usually in a JVM
there are multiple domains. For example, for an application running on Apache Tomcat there are
“Catalina” and “Java.lang” domains. “Catalina” represents resources and MBeans relating to the
Tomcat container, and “Java.lang” represents the same for the JVM Hotspot runtime. The
application may have its own custom domains.
For more information about JMX, see the JMX overview and tutorial. To learn about PMI see Writi
ng PMI Applications Using the JMX Interface.
App Server Key Performance Indicators

AppDynamics creates long-term metrics of the key MBean attributes that represent the health of
the Java container. Depending on your application configuration, metrics may include:
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Session information such as the number of active and expired sessions, maximum active
sessions, processing time, average and maximum alive times, and a session counter.
Web container runtime metrics that represent the thread pool that services user requests.
The metrics include pending requests and number of current threads servicing requests.
These metrics are related to Business Transaction metrics such as response time.
Messaging metrics related to JMS destinations, including the number of current consumers
and the number of current messages.
JDBC connection pool metrics including current pool size and maximum pool size.
To see the JMX metrics discovered in a node, see the JMX tab on the Node Dashboard.
To learn how to customize additional MBean attributes for long-term monitoring, see Configure
JMX Metrics from MBeans.
Alerting for App Server Health

AppDynamics discovers metrics for most Java platforms and applications. Some environments
however are not instrumented by default, yet they have MBeans. For those situations you can
enable monitoring using the MBean Browser. For details see Monitor JMX MBeans.
In addition to the preconfigured metrics, you may be interested in additional JVM or Java container
metrics. You can add custom metrics using JMX MBean attributes in the Metric Browser. To
customize which MBean attributes are monitored, see Configure JMX Metrics from MBeans.
Once you add a custom metric you can create a custom health rule for it and receive alerts if
conditions indicate problems. For details see Alert and Respond.
AppDynamics also provides the Application Server Agent API (Agent API) for access to metrics
that are not supported by default or by MBeans. You can use the Agent API to:
Inject custom events and report on them
Create and report on new metrics
Correlate distributed transactions when using protocols that AppDynamics does not support
Learn More

Configure JMX Metrics from MBeans
Monitor JMX MBeans
Configure Health Rules
Supported Environments and Versions
Monitor JMX MBeans

JMX and MBeans Monitoring Application
Infrastructure
Prerequisites for JMX Monitoring
Preconfigured JMX Metrics
To view the configuration of the
preconfigured JMX metrics
Using AppDynamics for JMX Monitoring
To view JMX metrics in the Metrics
Browser
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Trending MBeans Using Live Graphs
To monitor the real-time trend of an
MBean
Working with MBean Values
To View and Edit the MBean Attribute
Values
To invoke MBean Operations
To view Complex MBean Attributes
Configuring New JMX Metrics
Reusing JMX Metric Configurations
Understanding JMX Metrics
Learn More

Utilizing JMX Metrics in
Troubleshooting
This topic discusses how to provide visibility into the JMX metrics for your JVM and application
server.
JMX and MBeans Monitoring Application Infrastructure

As discussed at Monitor JVMs and Monitor Java App Servers, AppDynamics uses JMX (Java
Management Extensions) to monitor Java applications.
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JMX uses objects called MBeans (Managed Beans) to expose data and resources from your
application. You can use one or more MBean attributes to create persistent JMX metrics in
AppDynamics. In addition, you can import and export JMX metric configurations from one version
or instance of AppDynamics to another.
Prerequisites for JMX Monitoring

AppDynamics can capture MBean data, when these conditions are met:
The monitored system must be running on Java 1.5 or later.
Each monitored Java process must enable JMX. See the JMX documentation.
Additional MBean data may be available when a monitored business application exposes
Managed Beans (MBeans) using standard JMX. See the MBean documentation.
Preconfigured JMX Metrics

AppDynamics provides preconfigured JMX metrics for several common app server environments:
Apache ActiveMQ
Cassandra
Coherence
GlassFish
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HornetQ
JBoss
Apache Solr
Apache Tomcat
Oracle WebLogic Server
WebSphere PMI
For application server environments that are not instrumented by default, you can configure new
JMX metrics configurations. You can also add new JMX metric rules. See Configure JMX Metrics
from MBeans. You can also add new metric rules to the existing set of configurations. For
example, Glassfish JDBC connection pools can be manually configured using MBean attributes
and custom JMX metrics.
To view the configuration of the preconfigured JMX metrics

1. In the left navigation pane, click Configure -> Instrumentation and select the JMX tab.
2. The list of JMX Metric Configurations appears.
Click a metric configuration to view the preconfigured JMX metrics for that app server.
3. For example, selecting Cassandra shows the preconfigured JMX Metric Rules for Apache
Cassandra.
Double-click a metric rule to see configuration details such as the MBeans matching criteria
and the MBean attributes being used to define the metric.

You can view, delete, and edit the existing JMX metric rules.
Using AppDynamics for JMX Monitoring

You can view MBean-based metrics using the Node Dashboard and the Metric Browser. In
addition, the MBean Browser enables you to view all the MBeans defined in the system.
To view JMX metrics in the Metrics Browser

1. In the left navigation pane, click Servers -> App Servers -> <Tier> -> <Node>. The Node
Dashboard opens.
2.
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2. Click the JMX tab. The JMX Metrics browser opens and displays the MBeans in a Metric
Tree.
3. To monitor a particular metric, double-click or drag and drop the metric onto the graph panel.
4. Browse the default JMX metrics.

5. You can perform all the operations that are provided by the Metric Browser such as:
Drill-down
Analyze the transaction snapshot for a selected time duration
Set the selected time range as a global time range
Trending MBeans Using Live Graphs

You can monitor the trend of a particular MBean attribute over time using the Live Graph.
To monitor the real-time trend of an MBean

1. In the left navigation pane, click Servers -> App Servers -> <Tier> -> <Node>. The Node
Dashboard opens.
2. Click the JMX tab.
3. Click the MBean Browser sub-tab.
Alternate Path to JMX Metrics
Alternatively, in the left navigation pane, click Servers -> App Servers -> JMX. The
JMX window appears
If you haven't already selected a node, you are prompted to select a node and then a
tier and then the JMX window appears
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4. Select the domain for which you want to monitor MBeans. For a description of domains see
Monitor JVMs.
5. In the domain tree, expand the domains to find and then select the MBean that is of interest
to you.
6. Expand the Attributes section and then choose an attribute of the MBean.
7. Click Start Live Graph for Attribute and then click Start Live Graph. You can see the
runtime values.
8. Select an attribute and click Live Graph for Attribute to see a larger view of a particular
graph.
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Working with MBean Values

When troubleshooting or monitoring a Java-based system, you may want to change the values of
composite mBeans and execute mBean methods. Using the JMX window, you can accomplish
these tasks.
Prerequisite for Setting MBean Attributes and Invoking Operations
To change the value of an MBean attribute or invoke operation, your user account
must have "Set JMX MBean Attributes and Invoke Operations" permissions for the
application. For information about configuring user permissions for applications, see
To Configure the Default Application Permissions.
To View and Edit the MBean Attribute Values

1. From the JMX window, select MBean Browser.
2. In the Domain tree, search and find the MBean that interests you.
3. Select an editable attribute, one that has Yes in the Editable column, and then click View/E
dit Attribute.
4. In the MBean Attribute window that displays, you see the current value of the MBean
Attribute.
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4.

5. You can change the value of an editable MBean Attribute by entering a new value in the Val
ue field.
To invoke MBean Operations

Using the JMX viewer, you can invoke an mBean operation, specify standard java language
strings for the parameters, and view the return values from the mBean invocation.
1. From the JMX window, select MBean Browser.
2. In the Domain tree, search and find the MBean that interests you.
3. Open the Operations pane, scroll to find the operation that interests you, and double-click
the Invoke Action activator.

4.
Copyright © AppDynamics 2012-2014

Page 1348

4. Enter the parameter values for the operation and then click Invoke. Click OK to invoke the
operation.
Scalar values for constructors of complex types, such as getMBeanInfo(java.util.Locale)
allow you to enter "en-us".
A message appears indicating that the operation is in progress and the number of seconds
elapsed. When the operation completes, the results display.
The method return result from an invocation can also be a complex attribute. In this case
the name, description, type, and editable attributes of the method are also displace in the
MBean Operation Result area.

To view Complex MBean Attributes

When the MBean is a complex type, you can view its details by double-clicking it as shown below.
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Configuring New JMX Metrics

Required User Permissions
To configure new JMX Metrics your user account must have "Configure JMX" permis
sions for the application.
For information about configuring user permissions for applications, see To
Configure the Default Application Permissions.
In addition to the preconfigured metrics, you can define a new persistent metric using a JMX
Metric Rule that maps a set of attributes from one or more MBeans.
You can create a JMX metric from any MBean attribute or set of attributes. Once you create a
persistent JMX metric, you can:
View it in the Metric Browser
Add it to a Custom Dashboard
Create a health rule for it so that you can receive alerts
The JMX Metrics Configuration panel is the central configuration interface for all of the JMX
metrics that AppDynamics reports. You can use the MBean Browser to view MBeans exposed in
your environment. From there, you can access the JMX Metrics Configuration panel by selecting
an MBean attribute and clicking Create Metric.
For details, see Configure JMX Metrics from MBeans.
Reusing JMX Metric Configurations

Once you create a custom JMX metric configuration, you can keep the configuration for upgrade
or other purposes. The JMX metric information is stored in an XML file that you can export and
then import to another AppDynamics system. For instructions see Create, Import or Export JMX
Metric Configurations.
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Understanding JMX Metrics

Java Management Extensions (JMX) is a public specification for monitoring and managing Java
applications. Through JMX, Appdynamics can access Java class properties that collect
management data, such as the resources your application is consuming.
For information on the specific metrics available for you environment, see the documentation
provided by your vendor.
Apache ActiveMQ, see ActiveMQ MBeans Reference, in the ActiveMQ Features
documentation
Cassandra, see Cassandra Metrics
Coherence, see the Coherence MBeans Reference in Appendix A of the Coherence
Management Guide
GlassFish, see the Oracle Sun Glassfish Administration Guide where you can find a Metrics
Information Reference
HornetQ, see Using Management Via JMX
JBoss, see An Introduction to JMX
Apache Solr, see Quick Demo in the Solr JMX documentation
Apache Tomcat, see the descriptions of JMX MBeans for Catalina in the
mbeans-descriptor.xml file for each package
Oracle WebLogic Server, see Understanding JMX
WebSphere PMI, see PMI data organization in the IBM Websphere Application
documentation
Learn More

Configure JMX Metrics from MBeans
Monitor JVMs
Create, Import or Export JMX Metric Configurations
Configure JMX Without Transaction Monitoring
Trace MultiThreaded Transactions for Java
Thread Visibility and Metrics
Thread Metrics
Asynchronous Activity in Dashboards
Application Dashboard
Business Transaction Dashboard
Threads and Thread Tasks in the Metric Browser
Threads in Call Graphs
To Drill Down into Downstream Calls on a Thread
Thread Metrics in Health Rules
Learn More
Multithreaded programming techniques are common in applications that require asynchronous
processing. Although each thread has its own call stack, multiple threads can access shared data.
This creates two potential problems: visibility and access.
A visibility problem occurs if thread A reads shared data which is later changed by thread B,
and thread A is not aware of the change.

Copyright © AppDynamics 2012-2014

Page 1351

An access problem occurs if several threads are trying to access and change the same
shared data at the same time.
Visibility and access problems can lead to:
Liveness failure: Application performance becomes sluggish or stops processing also known
as a deadlock.
Safety failure: Race condition that results in difficult to discover programming errors.
Thread contention can occur when multiple threads attempt to access a synchronized method or
block at the same time. If a thread remains in the synchronized method or blocks for a long time,
the other threads must wait for access to shared resources. This situation has an adverse effect
on application performance. Call graphs for multi-threaded transactions enable you to trace thread
creation in a business transaction and provide an aggregated view of the overall processing for
transactions that spawn threads for concurrent processing.
AppDynamics monitors asysnchronous activities as first class entities with their own metrics to
give you the information you need to see and act to correct these performance issues.
Thread Visibility and Metrics

When applications spawn threads to perform concurrent tasks, you can monitor each thread as a
separate entity, including exit calls and policies associated with a specific thread. By default,
all Runnables, Callables and Threads are instrumented, except those that are explicitly excluded.
AppDynamics provides the flexibility to adjust the default monitoring to match the needs of your
specific applications. In some environments, if the default settings lead to too many classes being
instrumented, you can create custom rules to exclude unnecessary classes. If you do not want to
monitor any threads, you can completely disable asynchronous monitoring. This requires an agent
restart. See Configure Multi-Threaded Transactions for Java.
AppDynamics provides thread visibility in dashboards, the metric browser and snapshots.
Thread Metrics

For each asynchronous thread spawned in the course of executing a business transaction,
AppDynamics collects and reports metrics such as the following:
Average response time
Calls per minute
Errors per minute
Asynchronous Activity in Dashboards

AppDynamics detects asynchronous calls in an application and labels them as "async" in the
dashboards that display the asynchronous activity.
Application Dashboard

In the following Application Flow Map, you can see the calls per minute and average response
time displayed on each flow line where asynchronous activities are detected. These metrics
aggregate the metrics for asynchronous activities across all business transactions.
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For improved visibility, you can set the flow map lines to display as dotted lines. See To enable
dotted flow line.
Business Transaction Dashboard

Asynchronous activity can be viewed in a hierarchical format with the originating activities
encapsulating their respective spawned asynchronous activities. The tree view of a multi-threaded
business transaction flow shows the hierarchical view as well as the errors and time spent in
asynchronous calls for separate business transactions. To expand the tree to see all the calls,
right-click a tier name and select Expand All.

The following metrics are visualized in the Transaction Flow Tree View:
Metric Name
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Time Spent (ms)

Average time spent by the specific activity and
any spawned asynchronous activities.
Percentage metrics are used to represent the
fraction of time spent in a specific activity.
Asynchronous activities do not have a
percentage breakdown because each
asynchronous activity is linked to the
originating business transaction, but
represents a separate logical entity throughout
the execution of the business transaction.

Calls

Number of calls made by a particular activity
such as an asynchronous activity.

Calls/min

Number of calls made per minute for a
particular activity such as an asynchronous
thread.

Errors

Number of calls for a particular activity which
resulted in errors.

Errors/min

Number of calls made per minute for a
particular activity which resulted in errors.

Trends for baselines are visualized using the data for the originating business transaction. Metrics
for the asynchronous activities are not used in calculation of these trends.
The Transaction Scorecard reflects only the data for the originating business transaction. The
scorecard metrics are not inclusive of the metrics for any asynchronous threads being spawned by
the originating business transaction.
The Transaction Snapshot Flow Map for a transaction with asynchronous activity displays both
synchronous time and time spent in asynchronous activity. The following are example screen
shots of transactions with asynchronous activities:
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On the transaction flow map, AppDynamics displays the following metrics:
Metric Name

Explanation

1. Tier Response Time (ms)

Time spent processing at a particular tier for
this business transaction. Only present for
originating tier snapshots. (first in chain)

2. Percentage of Time Spent (%)

Percentage metric represents the fraction of
time spent processing at a particular tier or in
communication with other tiers/backends from
the entire execution lifespan of a business
transaction. Only present for "first in chain"
snapshots. This metric does not include the
processing time of the asynchronous activities
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3. Asynchronous Activity Processing Time
(ms)

Processing time of all asynchronous activities
at this tier. This metric does not contribute to
the overall tier response time because the
activity is asynchronous by nature. This metric
is calculated by adding the execution times of
all asynchronous activities at a tier and the
time spent in communication between other
tiers and backends as follows:
Asynchronous Activity Processing Time =
Asynchronous-activity-1-processing-time +
Asynchronous-activity-2-processing-time + so
on.

4. Execution Time (ms)

Time spent processing by the business
transaction in all affected tiers and
communication with other tiers and backends.
This metric does not include processing time
of the asynchronous activities. However, in
the case of Wait-for-Completion, the
originating business transaction will take a
longer time processing the request due to
blocking and waiting for all the activities to
complete before proceeding.
The formula for this metric is calculated by
summing up the processing times of a
Business Transaction at a particular
Tier/communication between Tiers/Backends
as follows:
Execution Time =
Time-spent-processing-in-Tier-1 +
Time-spent-processing-in-Tier-2 +
Time-spent-communicating-with-Tier-2 + so
on.

5. Call back to same tier (ms)

This label and corresponding value are not
always present. When a tier makes an exit call
and the call is received back by the same tier
then this is displayed. The metric value
corresponds to the time spent in the call from
the moment the call went out of the tier until
the point the call returned back to the caller.
If the label contains "async" then the exit call
was made asynchronously.

Threads and Thread Tasks in the Metric Browser

In a multi-threaded transaction, AppDynamics reports key business transaction performance
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metrics for individual threads in a Thread Tasks branch of the tier in the Metric Browser. The
Thread Tasks branch is created only for multi-threaded transactions.
The Metric Browser path is Business Transaction Performance -> Business Transactions ->
tier-name -> business-transaction-name -> Thread Tasks as shown here:

Thread Tasks are also reported in tiers under Overall Application Performance, where you can see
metrics on specific calls made by each thread in a node or in a tier.
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Threads in Call Graphs

When you drill down in a transaction snapshot for a tier with multiple calls, AppDynamics displays
the list of calls that you can drill down into.

Select a call from the list and double-click or click Drill Down into Call to access the call graph.
Diagnostic sessions are automatically triggered based on the average response time of the
originating thread of a business transaction. See See Detailed Data Using Diagnostic Sessions.
To configure snapshots based on KPIs of an asynchronous thread, use a custom health rule
based on the thread KPI of interest and set up a policy to trigger a diagnostic session on the
business transaction. See See Detailed Data Using Diagnostic Sessions.
To Drill Down into Downstream Calls on a Thread

If the call graph indicates Async Activity in the Exit Call/Threads column, you can drill down further
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into the downstream call on the thread:

1. Click Async Activity in the Exit Calls/Threads Column for the call that you want to drill down
from.
2. In the Exit Calls and Async Activities window, click Drill Down into Downstream Call.

A call graph for the downstream call opens.
Thread Metrics in Health Rules

You can create a custom health rule based on the performance metrics for a thread task.
When you click the metric icon in the Health Rule Wizard, the embedded metric browser includes
the Thread Tasks if the entity for which you are configuring the health rule spawns multiple
threads.
See Configure Health Rules.
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Learn More

Configure Multi-Threaded Transactions for Java
Metric Browser
Call Graphs
Health Rules
Configure Health Rules
Configure Diagnostic Sessions For Asynchronous Activity - Java
Monitoring in a Development Environment
Using AppDynamics in a non-production environment is useful for capturing and troubleshooting
issues while your applications are under development before you move them into production. To
facilitate greater flexibility into the amount of visibility into your environment, AppDynamics
provides the following monitoring levels when using the App Agent for Java.
Production is the normal operational mode that optimizes agent performance for your
environment, where you have set the balance between transaction visibility and overhead.
Development can be used in non-production environments where overhead is less of a
concern. When development mode is enabled, the system relaxes the various limits
associated with data capture. AppDynamics disables all limits that are intended to reduce
overhead in order to increase the amount of data captured, such as disabling limits to the
number of call graphs and SQL statements to capture. As a safeguard, when the load
reaches the maximum number of calls per minute you pre-defined or heap utilization
reaches the maximum value you defined for development, AppDynamics re-enables all of
the limits.
To Change the Monitoring Level

Prerequisite for Changing the Development Level
To change the Monitoring Level, your user account must have "Configure Monitoring
Level (Production/Development)" permissions for the application. For information
about configuring user permissions for applications, see To Configure the Default
Application Permissions.
Define the maximum number-of-calls-per-minute safeguard using the dev-mode-sus
pend-cpm app agent node property.
Optionally, define the maximum Java heap utilization percentage for development
mode using the heap-storage-monitor-devmode-disable-trigger-pct app agent node
property.
1. In the left-hand navigation menu of the Application Dashboard, click Configure.
2. Click the monitoring level and choose either Production or Development.

Copyright © AppDynamics 2012-2014

Page 1360

You can confirm that app agents have switched into or out of development mode from the Events
viewer. As each app agent switches into or out of development mode, it triggers an Agent
Diagnostics Event with a summary of "Dev Mode enabled" or "Dev Mode disabled". Similarly, the
app agents generate events that indicate when development mode is disabled due to a safeguard
limit being exceeded.
Effects of Using Development Mode

The development monitoring level controls a set of agent property values that affect the agent
behavior to increase visibility, resolution, and decrease data latency at the expense of
overhead. The following describes the effects of using Development mode:
SQL and JDBC Captures: When in development mode any constraints on SQL captures
and all other exit calls are relaxed. All SQL statements are collected, without a per
transaction limit, as well as all JDBC calls attached to the method, even if the duration of the
call is less than 10 ms, which is the normal cut off point for JDBC call collection.
Call Graphs: All call graphs are captured during development mode.
Snapshots: A snapshot is taken for every transaction, including slow and error
transactions.
App Agent Node Properties Ignored During Development Mode

In development mode, the values for the following app agent node properties are ignored:
max-concurrent-snapshots
on-demand-snapshots

Tutorials for Java
This section provides tutorials for tasks in AppDynamics.
Quick Tour of the User Interface
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Troubleshooting Application Errors

Identifying and troubleshooting errors in your Java application.
Overview Tutorials for Java
Quick Tour of the User Interface

Use AppDynamics for the First Time with Java

All Applications Dashboard
Application Dashboard
Time Range
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Flow Map and KPIs
Events
Transaction Scorecard
Exceptions and Errors
More Tutorials
This topic assumes that an application is already configured in AppDynamics, and uses the Acme
Online application as the example. It also assumes that you have already logged in to
AppDynamics.
This topic gives you an overview of how AppDynamics detects actual and potential problems that
users may experience in your application - transactions that are slow, stalled or have errors - and
helps you easily identify the root causes.
All Applications Dashboard

When you log into the Controller UI you see the All Applications dashboard.

The All Applications dashboard shows high-level performance information about one or more
business applications. Load, response time, and errors are standard metrics that AppDynamics
calls "key performance indicators" or "KPIs". The others are:
Health Rule Violations and Policies: AppDynamics lets you define a health rule, which consists
of a condition or a set of conditions based on metrics exceeding predefined thresholds or dynamic
baselines. You can then use health rules in policies to automate optional remedial actions to take if
the conditions trigger. AppDynamics also provides default health rules to help you get started.
Business Transaction Health: The health indicators are a visual summary of the extent to which
a business transaction is experiencing critical and warning health rule violations. See the slow
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transactions tutorial.
Server Health: Additional visual indicators that track how well the server infrastructure is
performing. See the server health tutorial.
Application Dashboard

Click an application to monitor, one that has some traffic running through it. The Application
dashboard gives you a view of how well the application is performing.

You see the dashboard for your application. The flow map on the left gives you an overview of
your servers (application servers, databases, remote servers such as message queues, etc.) and
metrics for the calls between them. Click, hold and move the icons around to arrange the flow
map. Use the scale slider and mini-map to change the view.
Time Range

From the time range drop-down in the upper-right corner select the time range over which to
monitor - the last 15 minutes, the last couple of hours, the last couple of days or weeks. Try a few
different time ranges and see how the dashboard data changes.
Flow Map and KPIs

In the flow map, click any of the blue lines to see more detail on the aggregated key performance
metrics (load, average response time and errors) between the two servers. See the flow maps
tutorial.
The graphs at the bottom of the dashboard show the key performance indicators over the selected
time range for the entire application.
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Events

An event represents a change in application state. The Events pane lists the important events
occurring in the application environment. See the events tutorial.
Transaction Scorecard

The Transaction Scorecard panel shows metrics about business transactions within the specified
time range, covering the percentage of instances that are normal slow, very slow, stalled or have
errors. Slow and very slow transactions have completed. Stalled transactions never completed or
timed out. Configurable thresholds define the level of performance for the slow, very slow and
stalled categories. See the Transaction Scorecard tutorial.
Exceptions and Errors

An exception is a code-logged message outside the context of a business transaction. An error is
a departure from the expected behavior of a business transaction, which prevents the transaction
from working properly. See the exceptions tutorial.
More Tutorials

Monitoring Tutorials for Java
Tutorial for Java - Events

Monitoring Events
Filtering Events
Monitoring Events

1. From an application, tier or node dashboard, look at the Events panel.

The Events panel shows all the events that are monitored by AppDynamics. There are several
types of events:
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Health Rule Violation Events include business transaction health rule events such as
average response time, and server health events such as Java VM Heap Utilization
Thresholds. To change what generates a health rule event, see Health Rules.
Slow Transaction Events occur when slow, very slow or stalled transactions are detected.
See Configure Thresholds.
Error Events occur when application exceptions are thrown or HTTP Errors are returned.
See Configure Error Detection.
Code Problem Events occur when a code deadlock is detected or a resource pool is
utilized beyond the specified threshold. For example this event occurs when a JDBC
connection pool is above 80% utilized or when a java.lang.Thread is deadlocked.
Application Change Events occur when administrative changes are made to an application
tier. For example, this event occurs when an application server instance is restarted or when
a Java VM option is modified on an application server. See Monitor Application Change
Events.
AppDynamics Config Warnings occur when the AppDynamics infrastructure needs
attention. For example, when the Controller detects low disk space conditions on its host the
policy associated with this event type occurs. See Administration Guide.
Custom events are user-defined events. See Events.
2. To get details click an event in the list. For example, click a slow request event to see the details
of the request in the transaction flow map so you can start troubleshooting the slow request.

For more information on resolving issues related to slow transactions, see Troubleshoot Slow
Response Time for Java.
Filtering Events

You can filter events by type in the Events panel. Click the type of event you want to see and click
Search. For example, to see only Deadlocks and Resource Pool Exhaustion events select the
Code Problem Event and click Search.
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Tutorial for Java - Flow Maps

Flow maps show the health of your application, all tiers, and the communication between the tiers.
It includes summary indicators such as call rates and error rates:

Visual indicators quickly show you problem tiers and healthy tiers. Below you can see tier 1 is
experiencing very slow response times, while tier 2 and tier 3 are healthy:
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By default, the flow map computes tier health by comparing the state of the tier averaged over the
last 15 minutes against the daily trend (the 30 day rolling average). You can change the time
window for baseline comparison using the time window pull down menu. You can also disable
baseline comparisons:

You can change the time range displayed in the flow map by changing the time window using the
time window pull down menu. Changing the time range effects the entire dashboard:
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You can troubleshoot a problem system call by clicking on a the tier's name to drill down into a
subset of the system involving the tier:

To view the slow response times in detail click on the slow response time menu:
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From the slow response time pick a transaction to see a snapshot of the slow transaction:

From the transaction snapshot you can troubleshoot the slow transaction:
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For more information on resolving issues related to slow transactions, see Troubleshoot Slow
Response Time for Java.
Tutorial for Java - Server Health

About Java Server Health
Learn More
About Java Server Health

By default, AppDynamics provides predefined rules for CPU utilization, physical memory
utilization, JVM heap utilization, and CLR heap utilization. For example the default health rule for
CPU utilization triggers a warning when a node exceeds 75% CPU utilization and triggers a critical
event when CPU utilization is 90% or above.
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Node health is driven by node health rules. The following example shows that Node_8003 is
experiencing a JVM heap health rule violation; all of the heap is consumed.

You can view the health rule violation details and the status of the violation:

There are many types of health rules and each defines a condition or set of conditions in terms of
a certain set of metrics that serve as health indicators of your application component. For example,
the Business Transaction Performance health rule defines a set of conditions in terms of business
transaction metrics, while the Node Health-Hardware,JVM,CLR health rule defines a set of
conditions in terms of hardware metrics.
To change or add a new health rule, see Configure Health Rules.
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You can control the scope of a health rule to a specific application component. For example, for
Node Health, you can choose between scoping to tiers or nodes. For tiers, you can apply the
health rul to all tiers or to specific tiers only. For nodes, you can apply the health rule to all nodes.
If you have a large cluster, you can choose specific nodes as well.

Once you scope the health rule, you can define the triggering conditions of the health rule. There
are two status condition sets, warning and critical, which can be defined independently of each
other. Each status condition set consists of atomic conditions that must either be ALL met or have
ANY that are met in order to trigger the status condition. Atomic conditions are based on
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predefined metrics that serve as health indicators of your application component. If you cannot find
a Health Rule type that has a predefined metric that meets your needs, you can add a metric using
custom monitors or create a JMX metric from MBeans and use a Custom Health Rule.

After defining Health Rules, you can use the Health Rule Violation Events in policies to trigger acti
ons that can notify Administrators via email or SMS systems or perform some other action.
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Learn More

Troubleshooting Server Health, AppDynamics in Action video
Tutorial for Java - Transaction Scorecards
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Transactions are categorized as Normal, Slow, Very Slow, Stalled, or Errors, which are
determined by thresholds and the AppDynamics error detection subsystem. Thresholds can be
static or dynamic; dynamic thresholds are based on historical data. The Transaction Analysis
Histogram shows the distribution over time.
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Default Transaction Thresholds can be viewed here:

If you want to change the thresholds for all or individual transactions see the transaction threshold
policy configurations (see below). See Set Performance Boundaries Using Thresholds.
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To troubleshoot slow transactions, see Troubleshoot Slow Response Times for Java.
By Default, errors are determined when HTTP Error Codes are returned and by default
AppDynamics instruments Java error and warning methods such as logger.warn and logger.error.
AppDynamics captures the exception stack trace and automatically correlates it with the request.
To learn how to change this, such as to reduce the number of errors reported by AppDynamics by
default or to add redirect error pages, see Configure Error Detection.
Troubleshooting Tutorials for Java
Tutorial for Java - Business Transaction Health Drilldown

Business Transaction Drilldown

Download MP4 version: BTHealthDrilldown.mp4
Download QuickTime version: BTHealthDrilldown.mov
Tutorial for Java - Exceptions

The Exceptions
Drill Down into the HTTP Error Code Exception
Drill Down into the AxisFault Exception
Drill Down into the Logger Exception
See How Exceptions are Configured
Learn More
The Exceptions

An exception is a code-logged message outside the context of a business transaction. Common
exceptions include code exceptions or logged errors, HTTP error codes, and error page redirects.
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Exceptions display in the Exceptions pane of many dashboards.

Click Exceptions to quickly see a list, ordered by frequency.

Drill Down into the HTTP Error Code Exception

Notice the spike in the HTTP Error Codes graph, and that the "Page Not Found: 404 error" is the
most frequent.
To find out more about the 404 error, click the row.
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The list of URLs shows pages that have 404 errors. The memberLogOut and getAllItems URLs
have the most 404 errors. You can provide this information to the web team to determine why
those pages have so many 404 errors.
Drill Down into the AxisFault Exception

In the Exceptions tab, click the AxisFault row. A list of error snapshots shows the affected URL,
tier, and node.

Click a row and then click the Stack Traces for This Exception tab to drill down further. Then click
on one of the exceptions to see the stack trace.
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Share the stack trace with the development team to solve the problem.
Drill Down into the Logger Exception

In the Exceptions tab, click the Log4J Error Messages row. A list of error transaction snapshots
shows the affected URL, business transaction, tier, and node. You can see a graph of the
errors-per-minute data.

Click on a row to see the flow map for the error transaction snapshot.
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The icons for both tiers have a Drill Down button. Click the Drill Down button on Ecommerce tier; it
also says "Start", indicating that the transaction started on this tier.
The Call Drill Down shows the summary of the error message.
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You can use the Export to PDF button at the lower left to send this information to your colleagues.
Go back to the flow map and click the Inventory tier Drill Down button. You see the Call Drill
Down of the Inventory tier error message.

Compare the two error messages.
See How Exceptions are Configured

AppDynamics provides application-level default configurations for detecting exceptions. In the left
navigation pane click Configure -> Instrumentation -> Error Detection.
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Learn More

Troubleshoot Errors
Configure Error Detection
Tutorial for Java - Slow Transactions

To begin troubleshooting, click Troubleshoot -> Slow Response Times:
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To troubleshoot slow business transaction URLs, select the Slow Transactions tab and use the
Transaction Snapshots pane:

Once you select the URL you will see a visualization of the transaction. You can drill into a call
graph by clicking the drill-down icon.
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Once you are in the call graph you can look for methods that have a significant response time. For
example, the executeQuery method is responsible for 99% of response time:

From the Troubleshoot -> Slow Response Times page, you can also select the Slowest DB &
Remote Service Calls tab:
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You can drill into the transaction snapshots from this tab to see the snapshot view:

For more information on resolving issues related to slow transactions, see Troubleshoot Slow
Response Times for Java.
Tutorial for Java - Troubleshooting using Events

Troubleshooting with Events
How to Set up the Events List
How to Know Something is Not Quite Right
How to Investigate
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Investigating Errors
Investigating Stalled Business Transactions
Investigating Slow Business Transactions
Investigating Application Server Exceptions
Investigating Code Deadlocks
Investigating Application Change Events
Troubleshooting with Events
How to Set up the Events List

1. From the left navigation pane, click an application and then click Events.
You can also access the Events window by clicking Events on the right side of the
application dashboard.
2. In the Events window, use the filter criteria to pick which events you want to monitor. Click Sear
ch.
3. Set the time range.
4. Look for issues and anomalies.
How to Know Something is Not Quite Right

You see:
Red (critical, policy violation)
Purple (warning, stall)
Orange (warning, very slow)
Yellow (warning, slow)
How to Investigate

You drill down to the root cause of the problem in different ways depending on the type of event.
Investigating Errors

You can troubleshoot application issues by drilling down into errors.
1. In the Events window click an Error.

2. In the Transaction Flow Map click the Drill Down icon. If there are multiple drill down icons,
select the one with the transaction that takes the most time.
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3. In the Call Drill Down window click the Summary tab.

4. Use the Summary information to troubleshoot issues. This information can also be exported to
PDF.
Investigating Stalled Business Transactions

You can troubleshoot business transactions by drilling down into stalled business transactions.
1. In the Events window click a Slow Requests - Stalled row.
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2. In the Transaction Flow Map click the Drill Down icon.

3. In the Call Drill Down window click the Summary tab.

4. Use the Summary information to troubleshoot business transaction issues. This information can
also be exported to PDF.
Investigating Slow Business Transactions

You can troubleshoot business transactions by drilling down into slow or very slow business
transactions.
1. In the Events window click a Slow Requests - Very Slow or Slow row.
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2. In the Transaction Flow Map click the Drill Down icon. If there are multiple drill down icons,
select the one with the transaction that takes the most time.

If there is more than one call from the originating Tier, you will see the Select a Call window. In
this case, proceed to step 3. Otherwise, skip to step 4.
3. In the Select a Call window click the slowest call.

4. In the Call Drill Down window click the Hot Spots tab to see the slowest methods.
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5. In this example, since the slow call is a database call you know you can click the SQL Calls tab
to see the slowest SQL statement.

6. Use this information to diagnose transaction issues. This information can also be exported to
PDF.
Investigating Application Server Exceptions

You can troubleshoot application server issues by drilling down into application server exceptions.
1. In the Events window click an Application Server Exception.

2. In the Application Server Exception window, click the Details tab.
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3. Use this information to troubleshoot application server issues. Use the Copy to Clipboard butto
n to save the exception details.
Investigating Code Deadlocks

You can troubleshoot code deadlocks by drilling down into a code deadlocks.
1. In the Events window click a Code Deadlock.

2. In the Code Deadlock window click the Details tab.
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3. Use this information to troubleshoot code deadlock issues. Use the Copy to Clipboard button
to save the deadlock details.
Investigating Application Change Events

You can view application changes by drilling down into application change events.
By default AppDynamics reports events when applications are deployed, app servers are
restarted, and configuration parameters are changed. Since these are not problems, they
are indicated by a blue icon.
1. Click a change event to see a summary and details, for example:

2. Use this information to view application changes. Use the Copy to Clipboard button to save the
change details.

Administer App Agents for Java
Resolving Configuration Issues App Agent for Java

Resolving App Agent for Java Startup Issues
Locating the App Agent for Java Log Files
Resolving Incomplete Agent Configuration Issues
Unblocking the Controller Port
Correcting File Permission Issues
Learn More
This topic discusses techniques for finding and interpreting the information in the App Agent for
Java log files.
Resolving App Agent for Java Startup Issues

After sending a request to your web application, data should appear in the UI. If no data appears,
check the following:
1. You have re-started the application server.
2. Verify that the javaagent argument has been added to the startup script of your JVM.
3. Verify that you configured the agent-controller communication properties and agent identification
properties in the controller-info.xml file or as system properties in the startup script of your JVM.
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See App Agent for Java Configuration Properties.
4. Check the Agent logs directory located at <Agent_Installation_Directory>/logs/<Node_Name>
for the agent.log file.
5. Verify that the Agent is compatible with the Controller. For details see Agent - Controller
Compatibility Matrix.
Locating the App Agent for Java Log Files

Agent log files are located in the <Agent_Installation_Directory>/logs/<Node_Name> folder.
The agent.log file is the recommended file to help you with troubleshooting. This log can indicate
the following:
Incomplete information in your Agent configuration.
The Controller port is blocked.
Incorrect file permissions.
Error messages related to starting the App Agent for Java use this format:

ERROR com.singularity.JavaAgent - Could Not Start Java Agent

Resolving Incomplete Agent Configuration Issues

The following table lists the typical error messages for incomplete Agent configuration:
Error Message

Solution

Cannot connect to the Agent - ERROR
com.singularity.XMLConfigManager Incomplete Agent Identity data, Invalid
Controller Port Value []

This indicates that the value for the controller
port in controller-info.xml is missing.
Add the port value, along with the host value
(<your-host-name>), to fix this error.
For on-premise Controller installations:
Default port value is 8090 for HTTP and
8181 for HTTPS.
For Controller SaaS service: Default port
value is 80 for HTTP and 443 for HTTPS.

Caused by:
com.singularity.ee.agent.configuration.a:
Could not resolve agent-controller basic
configuration

This is usually caused because of incorrect
configuration in the Controller-info.xml file.
Ensure that the information for agent
communication (Controller host and port) and
agent identification (application, tier and node
names) is correctly configured.
Alternatively, you can also use the system
properties (-D options) or environment
variables to configure these settings.

For more information about agent properties see App Agent for Java Configuration Properties.
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Unblocking the Controller Port

The following table lists the typical error message when the Controller port is blocked in your
network:
Error Message

Solution

ERROR
com.singularity.CONFIG.ConfigurationChannel
- Fatal transport error: Connection refused
WARN
com.singularity.CONFIG.ConfigurationChannel
- Could not connect to the controller/invalid
response from controller,
cannot get initialization information, controller
host \x.x.x.x\, port 8090, exception Fatal
transport error: Connection refused

Try to ping <your-host-name> from the
machine where you have configured the
Application Server Agent.
If it works, then confirm if the Controller port is
not blocked in your network.
To check if a port was blocked in the
network; use command: netstat -an for
Windows and nmap for Linux.
* For on-premise Controller
installations: Default port value is 8090 for
HTTP and 8181 for HTTPS.
For Controller SaaS service: Default port
value is 80 for HTTP and 443 for HTTPS.

Correcting File Permission Issues

Following table lists the typical error message when the file permissions are not correct:
Error Message

Solution

ERROR com.singularity.JavaAgent - Could
Not Start Java Agent
com.singularity.ee.agent.appagent.kernel.spi.c
: Could not start services"

This is usually caused because of incorrect
permissions for log files.
Confirm if the user who is running the server,
has read and write permission on the agent
directories.
If the user has chmod a-r equivalent
permission, change the permission to chmod
a+r "<agent_directory>"

Learn More

Install the Java Agent
App Agent for Java Configuration Properties
App Agent for Java Configuration Properties
Where to Configure App Agent Properties
Creating and Registering Tiers
Example Java App Agent controller-info.xml File
Example Startup-up Using System Properties
Java App Server Agent Properties
Agent-Controller Communication Properties
Controller Host Property
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Controller Port Property
SSL Configuration Properties
Controller SSL Enabled Property
Controller Keystore Password Property
Controller Keystore Filename Property
Force Default SSL Certificate Validation Property
Agent Identification Properties
Application Name Property
Tier Name Property
Node Name Property
Reuse Node Name Property
Reuse Node Name Prefix Property
Multi-Tenant Mode Properties
Account Name Property
Account Access Key Property
Proxy Properties for the Controller
Proxy Host Property
Proxy Port Property
Proxy User Name Property
Proxy Password Property
Other Properties
Enable Orchestration Property
Agent Runtime Directory Property
Redirect Logfiles Property
Force Agent Registration Property
Reuse Node Name Property
Auto Node Name Prefix Property
Cron/Batch JVM Property
Unique Host ID Property
Hot Spot Learning on Controller
Learn More
Where to Configure App Agent Properties

You can configure the App Server Agent properties:
in the controller-info.xml file in the <Agent_Installation_Directory>/conf directory
in the system properties (-D options) in the JVM startup script
The system properties override the settings in the controller-info.xml file.
For shared binaries among multiple JVM instances, AppDynamics recommends using a
combination of the xml file and the start-up properties to configure the app agent. Configure all the
properties common to all the JVMs in the controller-info.xml file. Configure the properties unique to
a JVM using the system properties in the start-up script.
For example:
For multiple JVMs belonging to the same application serving different tiers, configure the
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application name in the controller-info.xml file and the tier name and node name using the
system properties.
For multiple JVMs belonging to the same application and the same tier, configure the
application name and the tier name in the controller-info.xml file and the node name using
the system properties.
After you configure agent properties, confirm that the javaagent argument has been added to the
JVM startup script. For more information, see Java Server-Specific Installation Settings.
For some properties, you can use system properties already defined in the start-up script as the
App Server Agent property values. For more information, see Configure App Agent for Java to Use
Existing System Properties.
Creating and Registering Tiers

You can create a tier in the Controller prior to setting up any agents. Alternatively, an agent can
register its tier with the Controller the first time, and only the first time, that it connects with the
Controller. If a tier with the name used to connect already exists, the agent is associated with the
existing tier.
Example Java App Agent controller-info.xml File

<?xml version="1.0" encoding="UTF-8"?>
<controller-info>
<controller-host>192.168.1.20</controller-host>
<controller-port>8090</controller-port>
<controller-ssl-enabled>false</controller-ssl-enabled>
<application-name>ACMEOnline</application-name>
<tier-name>InventoryTier</tier-name>
<node-name>Inventory1</node-name>
<agent-runtime-dir></agent-runtime-dir>
<enable-orchestration>false</enable-orchestration>
<account-name></account-name>
<account-access-key></account-access-key>
<force-agent-registration>false</force-agent-registration>
</controller-info>

Example Startup-up Using System Properties
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The following command uses the system properties to start the agent that monitors the ACME
Online sample application's Inventory tier. Note that the system properties are case-sensitive.
java -javaagent:/home/appdynamics/AppServerAgent/javaagent.jar
-Dappdynamics.controller.hostName=192.168.1.20
-Dappdynamics.controller.port=8090
-Dappdynamics.agent.applicationName=ACMEOnline
-Dappdynamics.agent.tierName=Inventory
-Dappdynamics.agent.nodeName=Inventory1 SampleApplication

Java App Server Agent Properties

This section describes the Java App Agent configuration properties, including their
controller-info.xml elements and their system property options.
Agent-Controller Communication Properties
Controller Host Property

Description: This is the host name or the IP address of the AppDynamics Controller. Example
values are 192.168.1.22 or myhost or myhost.abc.com. This is the same host that you use to
access the AppDynamics browser-based user interface. For an on-premise Controller, use the
value for Application Server Host Name that was configured when the Controller was installed. If
you are using the AppDynamics SaaS Controller service, see the Welcome email from
AppDynamics.
Element in controller-info.xml: <controller-host>
System Property: -Dappdynamics.controller.hostName
Type: String
Default: None
Required: Yes, if the Enable Orchestration property is false.
If Enable Orchestration is true, and if the app agent is deployed in a compute cloud instance
created by an AppDynamics workflow, do not set the Controller host unless you want to override
the auto-detected value. See Enable Orchestration Property.
Controller Port Property

Description: This is the HTTP(S) port of the AppDynamics Controller. This is the same port that
you use to access the AppDynamics browser-based user interface.
If the Controller SSL Enabled property is set to true, specify the HTTPS port of the Controller;
otherwise specify the HTTP port. See Controller SSL Enabled Property.
Element in controller-info.xml: <controller-port>
System Property: -Dappdynamics.controller.port
Type: Positive Integer
Default: For On-premise installations, port 8090 for HTTP and port 8181 for HTTPS are the
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defaults.
For the SaaS Controller Service, port 80 for HTTP and port 443 for HTTPS are the defaults.
Required: Yes, if the Enable Orchestration property is false.
If Enable Orchestration is true, and if the app agent is deployed in a compute cloud instance
created by an AppDynamics workflow, do not set the Controller port unless you want to override
the auto-detected value. See Enable Orchestration Property.
SSL Configuration Properties
Controller SSL Enabled Property

Description: When set to true, this property specifies that the agent should use SSL (HTTPS) to
connect to the Controller. If SSL Enabled is true, set the Controller Port property to the HTTPS
port of the Controller. See Controller Port Property.
Element in controller-info.xml: <controller-ssl-enabled>
System Property: -Dappdynamics.controller.ssl.enabled
Type: Boolean
Default: False
Required: No
Controller Keystore Password Property

Description: This is an encrypted value of the Controller certificate password. See Password
Encryption Utility.
Element in controller-info.xml: <controller-keystore-password>
System Property: Not applicable
Type: Boolean
Default: None
Required: No
Controller Keystore Filename Property

Description: By default the agent looks for a Java truststore file named cacerts.jks in the
configuration directory: <agent install directory>/conf. Use this property to enable full validation of
Controller SSL certificates with a different Java truststore file. See Enable SSL for Java.
Element in controller-info.xml: <controller-keystore-filename>
System Property: Not applicable
Type: String
Default: None
Required: No
Force Default SSL Certificate Validation Property
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Description: This property allows you to override the default behavior for SSL validation. The
property can have three states:
true: Forces the agent to perform full validation of the certificate sent by the controller,
enabling the agent to enforce the SSL trust chain. Use this setting when a public certificate
authority(CA) signs your Controller SSL certificate. See Enable SSL On-Premise with a
Trusted CA Signed Certificate.
false: Forces the agent to perform minimal validation of the certificate. This property
disables full validation of the Controller's SSL certificate. Use this setting when full validation
of a SaaS certificate fails.
unspecified: The validation performed by the agent depends on the context:
If the agent is connecting to a SaaS controller, full validation is performed.
If the agent is connecting to an on-premise controller, and the cacerts.jks file is
present, then full validation is performed using the cacerts.jks file.
If the agent is connecting to an on-premise controller, and there is no cacerts.jks file,
then minimal validation is performed
Element in controller-info.xml: Not applicable
System Property: -Dappdynamics.force.default.ssl.certificate.validation
Type: Boolean
Default: None
Required: No
Agent Identification Properties
Application Name Property

Description: This is the name of the logical business application that this JVM node belongs to.
Note that this is not the deployment name(ear/war/jar) on the application server.
If a business application of the configured name does not exist, it is created automatically.
Element in controller-info.xml: <application-name>
System Property: -Dappdynamics.agent.applicationName
Type: String
Default: None
Required: Yes
Tier Name Property

Description: This is the name of the logical tier that this JVM node belongs to. Note that this is
not the deployment name (ear/war/jar) on the application server.
If the JVM / AppServer start-up script already has a system property that references the tier, such
as -Dserver.tier, you could use ${server.tier} as the tier name. For more information, see Configure
App Agent for Java to Use Existing System Properties.
See Name Business Applications, Tiers, and Nodes.
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Element in controller-info.xml: <tier-name>
System Property: -Dappdynamics.agent.tierName
Type: String
Default: None
Required: Yes
Node Name Property

Description: This is the name of the JVM node.
Where JVMs are dynamically created, use the system property to set the node name.
If your JVM / AppServer start-up script already has a system property that can be used as a node
name, such as -Dserver.name, you could use ${server.name} as the node name. You could also
use expressions such as ${server.name}_${host.name}.MyNode to define the node name. See Co
nfigure App Agent for Java to Use Existing System Properties for more information.
In general, the node name must be unique within the business application and physical host. If you
want to use the same node name for multiple nodes on the same physical machine, create
multiple virtual hosts using the Unique Host ID property. See Unique Host ID Property.
See Name Business Applications, Tiers, and Nodes.
Element in controller-info.xml: <node-name>
System Property: -Dappdynamics.agent.nodeName
Type: String
Default: None
Required: Yes
New
Reuse Node Name Property

Description: This system property enables the reuse of node names.
This property is useful in zOS Dynamic Workload Manager based-environments where new JVMs
are launched and shutdown based on actual work load. Appdynamics generates a node name with
App, Tier and Sequence number. The node names are pooled. For example, the sequence
numbers are reused when the nodes are purged (based on the node lifetime).
Use this option in environments where the node name can't be specified in the server startup
script, and therefore needs to be auto-generated. Every node creates its own metrics and the
names are pooled to make sure the Controller isn't overloaded with too many metric names. The
node name is generated by the Controller and sent back to the agent. The Controller recycles
node names based on the node retention period property.
Element in controller-info.xml: <node-name>
System Property: -Dappdynamics.agent.reuse.nodeName
Type: Boolean - valid values are "true" or "false"
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Default: String.
Required: No
Example: Using the following property specifications, the agent directs the Controller to generate
a node name with the prefix "reportGen". Node names will have suffixes --1, --2 etc. depending on
how many nodes are running in parallel. Later, the node names are reused by the controller.
-Dappdynamics.agent.reuse.nodeName=true
-Dappdynamics.agent.reuse.nodeName.prefix=reportGen
Reuse Node Name Prefix Property

Description: This property directs the Controller to generate node names dynamically with the
prefix specified.
System Property: -Dappdynamics.agent.reuse.nodeName.prefix
Element in controller-info.xml: <node-name>
Type: Boolean - valid values are "true" or "false"
Default: false, when set so "true", you do not need to specify a node name.
Required: No
Example: Using the following property specifications, the agent directs the Controller to generate
a node name with the prefix "reportGen". Node names will have suffixes --1, --2 etc. depending on
how many nodes are running in parallel. Later, the node names are reused by the controller.
-Dappdynamics.agent.reuse.nodeName=true
-Dappdynamics.agent.reuse.nodeName.prefix=reportGen
Multi-Tenant Mode Properties

Description: If the AppDynamics Controller is running in multi-tenant mode or if you are using the
AppDynamics SaaS Controller, specify the account name and account access key for this agent to
authenticate with the Controller. If you are using the AppDynamics SaaS Controller, the account
name is provided in the Welcome email sent by AppDynamics. You can also find this information
in the <controller-install>/initial_account_access_info.txt file.
If the Controller is running in single-tenant mode (the default) there is no need to configure these
values.
Account Name Property

Description: This is the account name used to authenticate with the Controller.
Element in controller-info.xml: <account-name>
System Properties: -Dappdynamics.agent.accountName
Type: String
Default: None
Required: Yes for AppDynamics SaaS Controller and other multi-tenant users; no for
single-tenant users.
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Account Access Key Property

Description: This is the account access key used to authenticate with the Controller.
Element in controller-info.xml: <account-access-key>
System Properties: -Dappdynamics.agent.accountAccessKey
Type: String
Default: None
Required: Yes for AppDynamics SaaS Controller and other multi-tenant users; no for
single-tenant users.
Proxy Properties for the Controller

These properties route data to the Controller through a proxy.
Proxy authentication cannot be used in conjunction with SSL.
Proxy Host Property

Description: This is the proxy host name or IP address.
Element in controller-info.xml: Not applicable
System Property: -Dappdynamics.http.proxyHost
Type: String
Default: None
Required: No
Proxy Port Property

Description: This is the proxy HTTP(S) port.
Element in controller-info.xml: Not applicable
System Property: -Dappdynamics.http.proxyPort
Type: Positive Integer
Default: None
Required: No
Proxy User Name Property

Description: This is the name of the user that is authenticated by the proxy host.
Element in controller-info.xml: Not applicable
System Property: -Dappdynamics.http.proxyUser
Type: String
Default: None
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Required: No
Proxy Password Property

Description: This is the absolute path to the file containing the password of the user that is
authenticated by the proxy host. The password must be the first line of the file and must be in
clear, unencrypted text.
Element in controller-info.xml: Not applicable
System Property: -Dappdynamics.http.proxyPasswordFile
Type: String
Default: None
Required: No
Example: -Dappdynamics.http.proxyPasswordFile=/path/to/file-with-first-line-containing-passwordin-clear-text
Other Properties
Enable Orchestration Property

Description: When set to true, enables auto-detection of the controller host and port when the
app server is a compute cloud instance created by an AppDynamics orchestration workflow. See
Controller Host Property and Controller Port Property.
In a cloud compute environment, auto-detection is necessary for the Create Machine tasks in the
workflow to run correctly.
If the host machine on which this agent resides is not created through AppDynamics workflow
orchestration, this property should be set to false.
Element in controller-info.xml: <enable-orchestration>
System Property: Not applicable
Type: Boolean
Default: False
Required: No
Agent Runtime Directory Property

Description: This property sets the runtime directory for all runtime files (logs, transaction
configuration) for nodes that use this agent installation. If this property is specified, all agent logs
are written to <Agent-Runtime-Directory>/logs/node-name and transaction configuration is written
to the <Agent-Runtime-Directory>/conf/node-name directory.
Element in controller-info.xml: <agent-runtime-dir>
System Property: -Dappdynamics.agent.runtime.dir
Type: String
Default: <Agent_Installation_Directory>/nodes
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Required: No
Redirect Logfiles Property

Description: This property sets the destination directory to which to redirect log files for a node.
Element in controller-info.xml: Not applicable
System Property: -Dappdynamics.agent.logs.dir
Type: String
Default: <Agent_Installation_Directory>/logs/<Node_Name>
Required: No
Force Agent Registration Property

Description: Set to true only under the following conditions:
The Agent has been moved to a new application and/or tier from the UI
and
You want to override that move by specifying a new application name and/or tier name in
the agent configuration.
Element in controller-info.xml: <force-agent-registration>
System Property: Not applicable
Type: Boolean
Default: False
Required: No
Reuse Node Name Property

Description: Set this property if you want the Controller to generate unique node names
automatically using a prefix.
You can specify the prefix in the Auto Node Name Prefix Property. If you do not provide a prefix
but set the reuse.nodeName property to true, the Controller uses the tier name as a prefix.
This property is useful for dynamic multi-tier clustered applications with many JVMs that have
short life spans. It allows AppDynamics to reuse node names and to capture historical data for
these short-lived nodes after they become historical or are deleted.
Element in controller-info.xml: Not applicable
System Property: -Dappdynamics.agent.reuse.nodeName
Type: Boolean
Default: None
Required: No
Auto Node Name Prefix Property
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Description: Set this property if you want the Controller to generate node names automatically
using a prefix that you provide.
The Controller generates node names based on the prefix concatenated with a number, which is
incremented sequentially. For example, if you assign a value of "mynode" to this property, the
Controller generates node names "mynode-1", "mynode-2" and so on.
If one of the nodes is deleted and the Reuse Node Name Property is true, the Controller will re-use
the deleted node name.
Element in controller-info.xml: Not applicable
System Property: -Dappdynamics.agent.auto.node.prefix=<your_prefix>
Type: String
Default: Serial number maintained by the Controller appended to the tier name
Required: No
Cron/Batch JVM Property

Description: Set this property to true if the JVM is a batch/cron process or if you are
instrumenting the main() method. This property can be used to stall the shutdown to allow the
agent to send metrics before shutdown.
Element in controller-info.xml: Not applicable
System Property: -Dappdynamics.cron.vm
Type: Boolean
Default: False
Required: No
Unique Host ID Property

Description: UniqueHostId logically partitions a single physical host or virtual machine such that
it appears to the Controller that the application is running on different machines. Set the value to a
string that is unique across the entire managed infrastructure. The string may not contain any
spaces. If this property is set on the app agent, it must be set on the machine agent as well.
See Configure Multiple Standalone Machine Agents for One Machine for Java.
System Property: -Dappdynamics.agent.uniqueHostId
Type: String
Default: None
Required: No
Hot Spot Learning on Controller

Description: New in 3.9 The HotspotLearning property enables or disables hotspot learning on
the Controller. Prior to 3.9, hot spot learning was performed by the App Agent for Java. To improve
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performance and more accurately collect snapshot information, this functionality was moved to the
Controller in 3.9. Setting this option to false will disable everything related to this new feature. For
more information on hotspots, see Transaction Snapshots and Call Graphs.
System Property: -Dappdynamics.hotspot.learn.enabled
Type: String
Default: true
Required: No

Learn More

Name Business Applications, Tiers, and Nodes
Configure App Agent for Java for JVMs that are Dynamically Identified
Configure App Agent for Java to Use Existing System Properties
Java Agent on z-OS or Mainframe Environments Configuration
Configure and Start an Agent Logging Session
1. In the Agents tab of the node dashboard, scroll down to the Agent Logs panel.
2. Click Start Agent Logging Session.
The Agent Logging Session window opens.
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3. From the drop-down menu select the duration for which you want to log.
4. Check the check boxes for the types of requests that you want to log.
5. Click Start Agent Logging Session.
The selected logging sessions appear in the logging list.
The logged request and response output appears in the Controller and the agent log.
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For more information, see Request Agent Log Files.
Configure App Agent for Java in z-OS or Mainframe Environments
To name nodes automatically
Learn More
In some environments JVMs have transient identity, such as when a single script spawns multiple
JVMs.

For example, an environment may consist of WebSphere on IBM Mainframes, using a dynamic
workload management feature that spawns new JVMs for an existing application server (called a
servant). These JVMs are exact clones of an existing JVM, but each of them has a different
process ID. Based on load, any number of additional JVMs may be created.
To name nodes automatically

The App Server Agent can automatically name the dynamically generated JVMs using the
appdynamics.agent.reuse.nodeName property. See Reuse Node Name Property to enable re-use
of node names and Auto Node Name Prefix Property to set the prefix used for
automatically-named nodes. You specify these properties in your startup script, using the following
format:

-Dappdynamics.agent.reuse.nodeName=true
-Dappdynamics.agent.reuse.nodeName.prefix=<node name prefix>

If you are using these properties, ensure that you have not specified the node name anywhere
(controller-info.xml file or as a system property) in your JVMs start-up script.
The following illustration shows the sample configuration for ACME Bookstore. This configuration
will create unique node names for every instance of the virtual machine starting up in the ACME
Bookstore environment.
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The name of a node is available for reuse if the node has been out of contact with the Controller
for a period of time that exceeds the node retention setting. For more about historical nodes, node
retention and deletion, see Remove Unused Nodes.
Learn More

App Agent for Java Configuration Properties
Remove Unused Nodes
App Agent for Java Performance Tuning
Business Transaction Thresholds
Snapshot Collection Thresholds
Disable Scheduled Snapshots
Suggested Scheduling Settings
Suggested Diagnostic Session Settings
Tuning Call Graph Settings
Suggested SQL Query Time and Parameters
Memory Monitoring
Learn More
This topic discusses how to get the best performance from App Agents for Java.
Business Transaction Thresholds

AppDynamics determines whether transactions are slow, very slow, or stalled based on the
thresholds for Business Transactions. AppDynamics recommends using standard deviation based
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dynamic thresholds. See Configure Thresholds.
Snapshot Collection Thresholds

Snapshot collection thresholds determine when snapshots are collected for a Business
Transaction. Too many snapshots can affect performance and therefore snapshot collection
thresholds should be considered carefully in production or load testing scenarios. See Configure
Thresholds.
Disable Scheduled Snapshots

For more information see Transaction Snapshots.
Suggested Scheduling Settings

10 minutes for small deployments < 10 BTs
20 minutes for medium deployments < 10 - 50 BTs
30 minutes for > 50 - 100 BTs
60 minutes > 100 BTs
Suggested Diagnostic Session Settings

Settings for Slow requests (%value): 20 - 30
Settings for Error requests (%value): 10 - 20
Click Apply to all Business Transactions.
Tuning Call Graph Settings

To configure call graph settings, click Configure -> Instrumentation and the Call Graph Settings
tab. See Configure Call Graphs.
Suggested SQL Query Time and Parameters

Minimum SQL Query Time : 100 ms (Default is 10)
Enable Filter SQL Parameter Values.
Memory Monitoring

Memory monitoring features such as leak detection, object instance tracking, and custom memory
should be enabled only for a specific node or nodes when debugging a memory problem.
Automatic leak detection is on-demand, and therefore, the leak detection will execute only for the
specified duration.
When you observe periods of growth in the heap utilization (%), you should enable on-demand
memory leak capture. See Troubleshoot Java Memory Leaks.
Learn More

Configure Thresholds
Configure Call Graphs
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Troubleshoot Java Memory Leaks
Move an App Agent for Java Node to a New Application or Tier
Moving a Node to a New Application or Tier
To change the Java Agent associations from the UI
Optionally update the controller-info.xml file
Forcing node re-registration using the controller-info.xml file
Learn More
If your JVM machine has both an App Agent for Java and a Machine Agent, you cannot change
the associations in the Machine Agent controller-info.xml file. You can only change these
associations either through the UI or by modifying the App Agent for Java controller-info.xml file.
Moving a Node to a New Application or Tier

You can assign an App Agent for Java node to a new application or tier using the AppDynamics UI
without restarting the JVM.
You can optionally update the controller-info.xml file and restart the JVM. You must restart the
JVM when you change the associations in the controller-info.xml file.
Moving the node using the AppDynamics UI cannot be overridden by an agent configuration
unless you set the force-agent-registration flag to true in the controller-info.xml file.
To change the Java Agent associations from the UI

1. Select the node that you want to move by clicking Servers -> App Servers -> <Tier>
-><Node>.
2. Click Actions -> Move Node.
4. In the Move Node window select the new application and/or tier from the drop-down menus.
5. Click OK to confirm the reassignment. It may take several minutes to complete.

When you change the associations for an App Agent for Java, AppDynamics registers an
Application Changes event. You can review the details of the event in the Events view.
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Optionally update the controller-info.xml file

The UI does not update the controller-info.xml file. However if you restart the JVM the Controller
will remember and keep the change you made from the UI.
You may want to maintain consistency with the controller-info.xml file, just for neatness' sake.
Perform these two additional steps:
6. Update these configuration changes in the App Agent for Java controller-info.xml file.
7. Restart the JVM.
If it is not feasible to restart the JVM at this time, remember the change and update the file the
next time you restart the JVM.
Forcing node re-registration using the controller-info.xml file

If you've moved a node in the UI and you want to move it again elsewhere using
controller-info.xml, then when you restart the JVM you set the force-agent-registration property to
'true'. See Force Agent Registration Property.
Learn More

Logical Model
App Agent for Java Diagnostic Data
To view agent diagnostic data
To view agent diagnostic stats
Learn More
To view agent diagnostic data

1. From an Application Dashboard, click Actions -> View Agent Diagnostics.
The Agent Diagnostic Data window opens and displays various metrics related to the application,
tiers, and nodes.

2. Select a node and click View Agent Diagnostic Events for selected Node.
The Agent Diagnostics Event window opens.
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To view agent diagnostic stats

1. From the left navigation pane, click *Servers -> App Servers -> <Tier> -> <Node>.
2. In the Node Dashboard, click the Agents tab.
3. Click the Agent Diagnostic Stats subtab.

Learn More

Troubleshoot Node Problems
App Agent for Java Directory Structure
App Agent for Java Directory Structure
The conf Directory
App Agent for Java Directory Structure

The AppServerAgent.zip folder contains files for installing the App Agent for Java.
The directory structure for the agent is illustrated in the following screen shot.
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lib: The lib folder has the core agent libraries and the third-party libraries.
conf: The conf folder is the configuration directory that has local configuration backup.
sdk: This folder contains the Javadocs and APIs to extend AppDynamics' monitoring
capabilities.
javaagent.jar: This JAR file has the argument to bootstrap the App Agent for Java. To
enable the agent, the --javaagent argument for JVM startup is required. See Install the Java
Agent.
logs: All logs written by the agent in this directory.
The conf Directory

The files located in this directory are commonly used for agent configuration and deployment.

transactions.xml: This XML file has configurations for business transaction identified by the
agent.
controller-info.xml: This XML file has controller connectivity and identification.
The following agent settings are configured using this XML file:
Agent communication settings (specified using <controller-host> and <controller-port>
properties).
Agent identification settings (specified using <application-name>, <tier-name>, and
<node-name> properties).
app-agent-config.xml: This XML file contains agent configuration. Any changes to the
agent's local settings are specified in this file, and these changes override the global
configuration. This file is typically used for short-term properties settings or for debugging
agent issues.
jmx: The jmx folder contains files for configuring the JMX and Websphere PMI metrics.
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logging/log4j.xml: This file contains flags to control logging levels for the agent. It is highly
recommended not to change the default logging levels.
To specify a different log directory, use the following system property:
-Dappdynamics.agent.logs.dir

IBM App Agent for Java

Supported JVMs
Instrumenting the IBM App Agent for Java
Running the App Agent for Java in a WebSphere/InfoSphere Environment with WebLogic
Security Enabled
Under most circumstances, the IBM App Agent for Java works the same as the App Agent for
Java.
This topic gathers information specific to the IBM App Agent for Java.
Supported JVMs

IBM JVM 1.5.x, 1.6.x
Instrumenting the IBM App Agent for Java

To change instrumentation for the IBM App Agent for Java, the IBM JVM must be restarted. By
default the IBM App Agent for Java does not apply BCI changes without restarting the JVM. This is
because in the IBM VM (J9 1.6.0) the implementation of re-transformation affects performance
(changes the JIT behavior such that less optimization occurs).
The following changes require that you restart the IBM JVM.
Automatic leak detection
Custom memory structures
Information points
Aggressive snapshot policy (also called hotspot instrumentation)
Custom POJO rules for transaction detection
Custom exit point rules
End user experience monitor (EUM), when you enable it and/or disable it after first enabling
it
Running the App Agent for Java in a WebSphere/InfoSphere Environment with WebLogic Security Enabled

If your WebSphere/InfoSphere environment includes a security-enabled WebLogic Application
Server, several InfoSphere Master Data Management (MDM) Server clients require security
configuration.
For more information, see Configuring Java clients to work with WebLogic security in the IBM
documentation.
Configure App Agent for Java for Batch Processes
To configure the App Agent for Java
To use the script name as the node name
Learn More
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You can configure the App Agent for Java for those JVMs that run as cron or batch jobs where the
JVM runs only for the duration of the job. AppDynamics monitors the main method of the Java
program.
To configure the App Agent for Java

1. Add the application and tier name to the controller-info.xml file.
2. Add the appdynamics.cron.vm property to the AppDynamics javaagent command in the startup
script of your JVM process:

-javaagent:<agent_install_dir>/javaagent.jar
-Dappdynamics.agent.nodeName=${NODE_NAME} -Dappdynamics.cron.vm=true

The agent_install_dir is the full path of the App Agent for Java installation directory.
The appdynamics.cron.vm property creates a delay between the end of the main method and the
JMV exit so that the Agent has time to upload metrics to the Controller.
To use the script name as the node name

You can use the script name that executes the cron or batch job as the node name.
The following commands set the value of variable NODE_NAME using the combination of the
script and host name. Add these commands to the startup script of the JVM.

# Use the name of the script (no path, no extension) as the name of the node.
NODE_NAME=sample
NODE_NAME="${NODE_NAME%%.}"
echo $NODE_NAME
# Localize the script to the host.
NODE_NAME="$NODE_NAME@$HOSTNAME"

The following illustration shows the sample configuration for controller-info.xml and the startup
script of the JVM.
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Learn More

Configure Background Tasks - Java
Configure App Agent for Java in Restricted Environments
To write the "startup hook" agent program
Some restricted environments do not allow any changes to the JVM startup script. For these
environments AppDynamics provides the appdynamics.agent.startup.hook property. This "startup
hook" allows a single point of deployment for the agent. You create a Java main method that is
invoked programmatically, before your startup script is executed.
To write the "startup hook" agent program

1. Implement a class with Java main method.
2. Create a JAR file for this class.
3. In the manifest of the JAR file, specify the class created in step 1.
4. Add the following javaagent argument and system properties (-D options) to your startup script:

-javaagent:<agent_install_dir>/javaagent.jar
-Dappdynamics.agent.startup.hook=<JAR-file>

Copyright © AppDynamics 2012-2014

Page 1419

Configure App Agent for Java on Multiple JVMs on the Same Machine that Serve Different Tiers

To configure the App Agent for Java
This section describes how you can configure the App Agent for Java for multiple JVMs that are
located on a single machine and are serving two tiers.
For example, the ACME Bookstore has two JVMs on the same physical server. These two JVMs
are bound to two different virtual IP (one JVM is used for Order Processing Services and the other
JVM is used for Inventory Services).

For such cases, follow these rules:
All of the common information should be configured using controller-info.xml file.
All of the information unique to a JVM should be configured using the system properties in
the JVM startup script.
Information in the startup scripts always overrides the information in the controller-info.xml
file.
To configure the App Agent for Java

1. Add application name to controller-info.xml file.
2. Add javaagent argument and following system properties (-D options) to the start-up script to
each of your JVM:
java -javaagent:<Agent-Installation-Directory>/javaagent.jar
-Dappdynamics.agent.tierName=$tierName -Dappdynamics.agent.nodeName=$nodeName

Separate the system properties with a white space character.
All agents in shared mode need a unique node name so that they can be differentiated from one
another. See Configure App Agent for Java to Use Existing System Properties.
The following illustration displays how this configuration is applied to ACME Bookstore:
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Tips:
The application and tier names can also be configured using the system properties. For
more details see App Agent for Java Configuration Properties.
Some application server management consoles allow you to specify startup arguments
using a web interface. See Java Server-Specific Installation Settings.
Configure App Agent for Java on Multiple JVMs on the Same Machine that Serves the Same
Tier
To configure the App Agent for Java properties
This topic describes how to configure the App Agent for Java for multiple JVMs that are located on
a single machine and are serving the same tier.
For example, ACME Bookstore has a physical server with five JVMs installed on it. All of these
JVMs are used for the Inventory Services.
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For such cases, follow these rules:
All of the common information should be configured using controller-info.xml.
All of the information unique to a JVM should be configured using the system properties in
the start-up script.
Information in the startup scripts always overrides the information in the controller-info.xml
file.
To configure the App Agent for Java properties

1. Provide the application and tier name in the controller-info.xml file.
2. Add the javaagent argument and system property (-D option) for the node name to the batch file
or startup script of each JVM.

java -javaagent:<Agent-Installation-Directory>/javaagent.jar
-Dappdynamics.agent.nodeName=$nodeName

Separate the system properties with a white space character.
The following illustration displays how this configuration is applied to the ACME Bookstore.
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The application and tier names can also be configured using the system properties. See App
Agent for Java Configuration Properties.
Some application server management consoles allow you to specify start-up arguments using a
web interface. See Java Server-Specific Installation Settings.
Configure App Agent for Java to Use Existing System Properties
System Properties
Using System Properties
To identify nodes
To identify tiers
Sample Agent Configuration Using System Properties
Learn More
This topic explains how to configure the App Agent for Java using the existing system property
values.
System Properties

AppDynamics recommends that you use the existing system properties to configure the Agent
when your environment consists of multiple JVMs on the same machine. Once you have these
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variables configured, you can complete Agent installation for all JVMs by simply adding the
javaagent argument to each JVM startup script. Then add the rest of the information to the
controller-info.xml file.
AppDynamics recommends that you use the system properties if the same startup script is starting
all the JVMs in your environment.
You can identify the node name based on the value of -Dserver.name and the tier name based on
the value of -Dcluster.name.
Also, you can combine two or more system properties to identify the node or tier name. You can
use -Dhost.name and -Dserver.name to identify similarly named nodes on different machines even
when they belong to the same tier.
You can use existing system properties for the controller host and port, however combining is not
supported in this case.
Using System Properties

Use the following syntax to represent the value of the system property in the controller-info.xml file.
${system property name}

You can combine multiple system properties.
${host.name}${server.name}

You can combine system properties with literals. In the following example '_' and 'inventory' are
literals.
${host.name}_${server.name}.inventory

To identify nodes

${host.name}

or
${server.name}

or
${host.name}${server.name}

To identify tiers
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${cluster.name}

Sample Agent Configuration Using System Properties

Consider a JVM with a script file named startserver.sh. This script file has following system
property:
-Dserver.name=$1

If you execute:
startserver.sh ecommerce01

The script creates a new server named ecommerce01.
To use this system property for Agent configuration, add the appdynamics.agent.nodeName
property to startserver.sh file.
-Dappdynamics.agent.nodeName=$server.name

When the script creates the new server named ecommerce01, it will be identified by AppDynamics
as both a server and as a node.
The following screenshot shows a sample configuration for the controller-info.xml file and the
startup script.
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Learn More

Logical Model
Install the Java Agent
Administer App Agent for Java FAQ
App Agent for Java Administration FAQ
Q. Why am I seeing "WARN AsyncHandOffIdentificationInterceptor - Reached
maximum limit 500 of async handoff call graph samples. No more samples will be
taken" message in the agent log files?
App Agent for Java Administration FAQ
Q. Why am I seeing "WARN AsyncHandOffIdentificationInterceptor - Reached maximum limit 500 of async handoff call graph
samples. No more samples will be taken" message in the agent log files?

In AppDynamics 3.6 and 3.7, all Runnables, Callables and Threads are instrumented by default
except for the ones that are excluded by the agent configuration in app-agent-config.xml. In some
environments, this could result in too many classes being instrumented, or cause common classes
in a framework that implements the Runnable interface to be mistaken for asynchronous activity
when it is not, for example Groovy application using Closures.
To debug the cause of the message, check the call graph to see if so many asynchronous
activities are legitimate. If they are not, then exclude the packages that are not really
asynchronous activities. See Configure Multi-Threaded Transactions for Java.
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Configure App Agent for Java for JVMs that are Dynamically Identified

To configure the node name of the App Agent for Java
Configuration notes
This topic describes how to configure the App Agent for Java in environments where the JVMs are
dynamic.
To configure the node name of the App Agent for Java

1. Add the application and tier name to the controller-info.xml file.
2. Add the javaagent argument and the following system properties (-D options) to the startup
script of the JVMs:
java -javaagent:<agent-install-dir>/javaagent.jar
-Dappdynamics.agent.nodeName=${NODE_NAME}

Configuration notes

The system properties are separated by a white space character.
The <agent-install-dir> references the full path of the App Agent for Java installation directory.
The token ${NODE_NAME} identifies the JVMs dynamically and names these JVMs based on the
parameter value passed during the execution of the startup script for your JVM process.
The application and tier names can also be configured using the system properties. For example,
you can configure the agent to direct the Controller to create node names using a prefix and to
reuse node names so the Controller is not overloaded, using the -Dappdynamics.agent.reus
e.nodeName.prefix and =Dappdynamics.agent.reuse.nodeName options respectively.
For more details see App Agent for Java Configuration Properties.
Some application server management consoles allow you to specify startup arguments using a
web interface.
For details see Java Server-Specific Installation Settings.
Add the Agent into an Embedded JVM
In order to add the agent into an embedded JVM you must first identify the java process in which
you want to embed the agent and then apply the agent to that java process.
1. From the command line, use the JPS tool to list the process id and the fully-qualified java main
class, as follows:

C:\>jps -l

The system returns information such as,
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2160 sun.tools.jps.Jps
2020 org.apache.catalina.startup.Bootstrap

2. Apply the agent to the relevant process id as follows:

C:\>java -jar javaagent.jar <java>process_id>

Note: Ensure the AppDynamics Pro Controller has all the required information for the JVM,
including controller-host, port, tier, and node name.

APM Overview - .NET
This information covers using AppDynamics for .NET applications and environments. For general
information see Application Intelligence Platform and AppDynamics Features.
.NET Agent 3.9 Feature Updates

Machine Snapshots for
.NET
Monitor CLR Crashes
Monitor Service Endpoints
for .NET
Monitor Memory Usage
with Object Instance
Tracking for .NET

Monitor .NET Applications

Supported Environments and
Versions - .NET

Supported Environments
and Versions for .NET
Web End User
Experience Management
for .NET
All Supported
Environments and
Versions
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Configure AppDynamics for .NET

Administer the .NET Agent

Tutorials

Supported Environments and Versions for .NET
Supported Platform Matrix for the .NET Agent
Supported Runtime Environments
OS Versions
Microsoft .NET Frameworks
Runtime Environments
Microsoft Windows Azure
Unsupported Frameworks
Automatically Discovered Business Transactions
Supported Loggers for the .NET Agent
Remote Service Detection
Supported Windows Azure Remote Services
Data Storage Detection
Supported ADO.NET Clients
Supported Platform Matrix for the .NET Agent
Supported Runtime Environments

This section lists the environments where the .NET Agent does some automatic discovery after
little or no configuration.
OS Versions

Microsoft* Windows* Server 2003 (32-bit and 64-bit)
Microsoft Windows Server 2008 (32-bit and 64-bit)
Microsoft Windows Server 2008 R2
Microsoft Windows Server 2012
Microsoft .NET Frameworks

Microsoft .NET Framework versions 2.0, 3.0, 3.5, 4.0, 4.5
Runtime Environments
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Microsoft IIS versions 6.0, 7.0, 7.5, 8.0, 8.5
Microsoft SharePoint 2010, 2013 as services running inside IIS
Managed Windows Services
Managed Standalone Applications
Microsoft Windows Azure

Windows Azure Cloud Services (Web Roles and Worker Roles)
Unsupported Frameworks

Microsoft .NET versions 1.0, 1.1
Unmanaged native code
Windows Azure Web Sites
Automatically Discovered Business Transactions

The .NET Agent discovers BTs for the following frameworks by default. The agent enables
detection without additional configuration.
Type

Custom Configuration
Options

Downstream Correlation

ASP.NET

Yes

Yes

ASP.NET MVC 2
ASP.NET MVC 3
ASP.NET MVC 4
ASP.NET MVC 5

Yes

Yes

.NET Remoting

No

Requires configuration.
See Enable Correlation for
.NET Remoting.

Windows Communication
Foundation (WCF)

No

Yes

Web Services including SOAP

No

Yes

No

Yes

IBM WebSphere MQ

No

Yes

RabbitMQ

Yes

Yes

No

Yes

No

Yes

Message Queues
Apache ActiveMQ NMS
framework and related MQs

TIBCO Enterprise Message
Service
TIBCO Rendezvous

The App Agent for .NET automatically discovers entry points for ASP.NET web forms with
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the Async property set to "true" in the Page directive.
Supported Loggers for the .NET Agent

Log4Net
NLog
System Trace
Windows Event Log
If you are using a different logger, see Custom Logger Definitions.
Remote Service Detection

The .NET Agent automatically detects the following remote service types. The agent enables
detection by default. You don't need to perform extra configuration.
Type

Custom
Configuration
Options

Async Detection †

Downstream
Correlation

Directory Services,
including LDAP

No

No

N/A

HTTP

Yes

Requires
configuration.
See Monitor Async
Transactions for .NET
.

Yes

.NET Remoting

Yes

No

Requires
configuration.
See Enable
Correlation for .NET
Remoting.

WCF

Yes

Requires
configuration.
See Monitor Async
Transactions for .NET
.

Yes

WCF Data Services

Yes

No

No

Web Services,
inlcuding SOAP

Yes

Requires
configuration.
See Monitor Async
Transactions for .NET
.

Yes

Message Queues
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Apache ActiveMQ
NMS framework and
related MQs

Yes

No

Yes

IBM WebSphere
MQ (IBM XMS)

Yes

No

Yes

Microsoft Message
Queuing (MSMQ)

Yes

No

N/A

Microsoft Service
Bus / Windows Azure
Service Bus

No

No

Yes

TIBCO Enterprise
Message Service

Yes

No

Yes

Yes

No

Yes

No

No

No

TIBCO Rendezvous
Windows Azure
Queue

† The agent discovers asynchronous transactions for the Microsoft .NET 4.5 framework. See
Monitor Async Transactions for .NET for details.

Supported Windows Azure Remote Services

Type

Configuration
can be customized

Downstream
Correlation

Azure Blob

No

No

Azure Queue

No

No

Microsoft Service Bus

No

Yes

Data Storage Detection

The .NET Agent automatically detects the following data storage types. The agent enables
detection by default. You don't need to perform extra configuration.
Type

Configuration Can
Be Customized

AppD for Databases?

ADO.NET (see supported
clients below)

Yes

No

Windows Azure Blob Storage

No

No

Supported ADO.NET Clients

AppDynamics can monitor any ADO.NET client version and type. Clients we've tested include the
following:
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Database Name

Database Version

Client Type

Oracle

10, 11, 12

ODP.NET

Oracle

10, 11, 12

Microsoft Provider for Oracle

MySQL

5.x

Connector/Net and ADO.NET

Microsoft SQL Server *

2005, 2008, 2012

ADO.NET

* Microsoft, SQL Server, and Windows are registered trademarks of Microsoft Corporation in
the United States and other countries.

Install the .NET Agent
Installing the .NET Agent
Installation Prerequisites
Installation Procedure
To install the .NET Agent
Agent Configuration
Silent Install Options
Learn More
This topic describes a new installation for the .NET Agent.
If you want to install the .NET Agent from the command line, see Unattended Installation for
.NET.
For .NET Agent upgrades, see Upgrade the .NET Agent.
Install the .NET Agent once on each system that hosts managed .NET applications: IIS
applications, Windows services, or standalone applications. At start up, the agent initializes an
individual instance of itself for each application running in the CLR.
Installing the .NET Agent

Installing the .NET Agent (agent), involves the following process:
1. Install the the agent according to the installation procedure.
2. Configure the agent.
AppDynamics provides a configuration utility to configure IIS applications. Monitoring Windo
ws services and standalone applications requires additional manual configuration.
3. Restart instrumented applications.
The configuration utility gives you the option to restart IIS or not.
If you don't restart IIS, monitoring doesn't begin until the next time IIS restarts.
You must restart Windows services and standalone applications manually.
Installation Prerequisites

Microsoft Distributed Transaction Coordinator (MSDTC)
COM+
See Verify COM+ Services are enabled.
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Installation Procedure
To install the .NET Agent

1.
2.
3.
4.

Download the .NET Agent MSI installer package from the AppDynamics Download Zone.
Run the MSI installer package.
Read the End User Agreement and click to accept. Click Next.
Optionally change the destination directory for the App Agent for .NET and click Install.
By default, the agent installs to the following directory:

%ProgramFiles%\AppDynamics\AppDynamics .NET Agent
5. Click Yes on the User Account Control window to allow the installer to make changes to the
computer.
If the current account does not have administrator privileges, the installer prompts you to
supply the password for an administrator account.
6. Wait for the installation to complete.
7. For new installs, AppDynamics recommends you launch the AppDynamics Agent
Configuration utility.
If you encounter problems installing, see Resolve .NET Agent Installation and Configuration Issues
.
Agent Configuration

Launch the AppDyanmics Agent Configuration utility to configure the .NET Agent.
If you are instrumenting IIS applications, see Configure the .NET Agent.
If you are instrumenting Windows services:
1. See Configure the .NET Agent.
2. See Enable the .NET Agent for Windows Services.
If you are instrumenting standalone applications:
1. See Configure the .NET Agent.
2. See Enable the .NET Agent for Standalone Applications.
Silent Install Options

See Unattended Installation for .NET.
Learn More

Configure the .NET Agent
Unattended Installation for .NET
Logical Model
.NET Agent Configuration Properties
Resolve .NET Agent Installation and Configuration Issues
Disable Instrumentation for an IIS Application Pool
Upgrade the .NET Agent
.NET Agent Directory Structure
Configure the .NET Agent
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Configuration Considerations
File System Security Settings
Configuring the .NET Agent
To access the .NET Agent Configuration Utility
To set up the logs and account permissions
To provide Controller configuration information
To map business applications, tiers, and nodes to your application environment
To let AppDynamics automatically name the tiers
To manually name the tiers
Using a Configuration File from the Command Line
To create a configuration file
To run the configuration utility from the command line
Learn More
The .NET Agent requires information about your .NET applications: IIS applications, Windows
services, or standalone applications. Configure the .NET Agent according to the types of
applications you want to monitor:
For IIS applications, use the configuration utility with either automatic or manual tier naming.
See the instructions in this topic.
For Windows services, use the configuration utility, then manually update the config.xml.
See Enable the .NET Agent for Windows Services.
For standalone applications, use the configuration utility, then manually update the
config.xml See Enable the .NET Agent for Standalone Applications.
It is possible to instrument any combination of IIS Applications, Windows services, and
standalone applications on a single server. Run the configuration utility to configure IIS, then follow
the instructions for Windows services and Standalone applications.
Use the .NET Agent Configuration Utility to configure the agent just after installation, or to make
changes to existing agent configurations.
Configuration Considerations

AppDynamics recommends that you install the Controller, or have access credentials to a SaaS
Controller, before installing an agent.
Prior to configuration, run the .NET Agent Installer. See Install the .NET Agent.
The utility configures one agent at a time.
AppDynamics implements the profile API of the .NET CLR. Since a Windows machine only allows
use of one profiler at a time, you must uninstall any pre-existing profiler, such as Ant, VS 2010
Performance Tools, or others. The utility alerts you if it finds a pre-existing profiler.
To apply configurations, the .NET Agent Configuration Utility must restart IIS. The utility offers
you the option to restart IIS or not. If you choose not to restart, configurations apply the next time
IIS restarts.
File System Security Settings

For the .NET Agent to instrument your application correctly, ensure the following Windows
accounts have the required file system access permissions:
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The account you use to run your web application as defined by its application pool or the
Windows service account.
The account you use to run the AppDynamics Agent Coordinator, by default the Local
System account.
The required permissions are as follows:
Write permission to the .NET App Agent logs directory:
For agent version 3.7.8 or later, the default is as follows:
Windows Server 2008 and later: %ProgramData%\AppDynamics\DotNetAgent\
Logs
Windows Server 2003: %AllUsersProfile%\Application
Data\AppDynamics\DotNetAgent\Logs
For agent version 3.7.7 or earlier, the default is C:\Appdynamics\Logs.
Read and Execute permissions to to the .NET App Agent install directory, by default C:\Pr
ogram Files\AppDynamics\AppDynamics .NET Agent
Read and Execute permissions the web application installation directory, for example C:\i
netpub\wwwroot\myapp
Configuring the .NET Agent
To access the .NET Agent Configuration Utility

1. In the Windows menu, click AppDynamics -> .NET Agent -> AppDynamics Agent
Configuration.
2. If the "Warning: 3rd Party Profiler installed" message displays, it means that the
configuration utility has discovered another profiler. Windows only allows one profiler per
machine. Because AppDynamics uses a profiler you must uninstall any other profilers.

Click Yes to exit and uninstall any pre-existing profiler. Check the registry to make sure that
the uninstall process cleaned up the registry entries. Use the warning message to identify
any undeleted profiler environment variables.
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Video Tutorial: Manual Installation And Configuration

3. When the configuration utility detects legacy agent configurations from version 3.7.7 or earlier, it
displays the Upgrade Configuration window.
Answer Yes to remove legacy configurations. For a list of affected configurations, See To
clean up legacy configurations.
Removing legacy configurations modifies web.config files causing IIS to restart affected
applications.
Answer No to leave legacy configurations in place. You can remove them at a later time.
4. When the utility discovers no further profiler conflicts or after any configuration clean up, the
welcome window displays.
Click Next to advance to Log directory permissions.
To set up the logs and account permissions

The first window helps you set up the location of the agent logs and provide the correct account
access to the logs.
1. If you want to change the default location of the log directory, click Change and select a new
location.
The default logs directories are as follows:
Windows Server 2008 and later: %ProgramData%\AppDynamics\DotNetAgent\Logs
Windows Server 2003: %AllUsersProfile%\Application
Data\AppDynamics\DotNetAgent\Logs
2. If needed, add accounts for log directory permissions.
Commonly-used accounts are provided. If your application uses another account, enter the
Windows account you use to run your web application as defined by its application pool or the
Windows service account. The account name must be valid on the operating system and have
permission to write to the log files directory.
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3. Click Add. If you get a warning message, make sure that the account is valid on the system.
4. Click Next and the wizard confirms the list of accounts.
5. Click Next to advance to Controller Configuration.
To provide Controller configuration information

1. Enter the Controller access information and credentials.
The .NET Agent configuration utility only supports configuration of one Controller and
business application per server.
Use tiers to organize different applications you instrument on a single server.
Or manually configure support for multiple business applications, see Configure
Multiple Business Application Support for .NET.
For a SaaS Controller, enter the server name or IP, port number, account name, and access
key as provided to you by AppDynamics.
For an on-premise Controller, if you haven't already installed it, cancel this installation and
see Install the Controller. Otherwise enter the server name and port number of an existing
Controller.
For a secure connection, click Enable SSL.
The Controller must use a trusted certificate.
If needed, fill in the proxy information. Proxies that use authentication require additional
configuration.
2. Click Test Controller Connection to verify the connection.
3. Click Next to advance to the Application Configuration
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AppDynamics retrieves existing business application information from the Controller and displays it
in the left column. Controller connection status displays on the right.
4. Click Existing Applications from the Controller to select business applications from the
Controller.
If you haven't defined business applications in the Controller, the utility displays an empty list.
Click New Application to define a new business application. Be careful about spellings and
capitalization and note down the exact name.
Do not use ampersands in the business application name; they are not supported at this
time.
5. Click Next to advance to Assign IIS applications to tiers.
To map business applications, tiers, and nodes to your application environment

1. Read about how AppDynamics uses business applications, tiers, and nodes to organize
application performance monitoring. In summary:
A business application is a set of modules and distributed services that together provide
business functionality.
A node is the basic unit of processing that AppDynamics monitors.
A tier represents a module in an application environment, such as an eCommerce website
or Inventory application.
See Logical Model.
2. Decide how to identify and name the tiers. Either AppDynamics will automatically configure tier
names, or you can manually configure them.
Use these guidelines for deciding whether to use automatic or manual naming:
To have AppDynamics instrument all IIS applications on a machine, choose automatic.
AppDynamics names tiers using this pattern:
IIS_site_name-IIS_application_name

To select the IIS applications on a machine to instrument with AppDynamics, choose manua
l.
Using manual naming, you supply the tier names and AppDynamics updates the
configuration file.
To let AppDynamics automatically name the tiers

1. In the Assign IIS applications to tiers window click Automatic.
2. If prompted, click OK to confirm Automatic configuration.
The configuration utility summarizes the configuration settings.
3. By default when you click Next the configuration utility restarts IIS.
If you do not want to apply the configuration right away, uncheck the box. The Configuration
Utility saves the information and applies it the next time you restart IIS.
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4. If you proceed and click Next, the configuration utility logs its activities, including stopping and
restarting IIS, and reports any problems. Review the summary for any issues in red font. Green
font indicates the more interesting logged events. The summary shows any Warnings (W) or
Errors (E). If you have errors, contact AppDynamics Support.

5. When there are no errors, click Next.
6. Click Done to close the Configuration Utility.
To manually name the tiers

1. In the Assign IIS applications to tiers window click Manual, then click Next.
2. Assign IIS Applications to AppDynamics tiers.
Select a tier on the right and click a business application on the left. The assigned tier will be
highlighted in boldface.
For large IIS installations, use the Max IIS tree depth pulldown to display all the projects. A
large tree depth may take some time to view.
To create new tiers, enter a name and click Add Tier.
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5. When you are done click Next. AppDynamics displays a configuration summary.
6. Review the configuration. If you need to make changes click Back.
7. On the Configuration Summary window, uncheck Restart IIS if you don't want to immediately
restart IIS.
You may restart later to apply your changes, or they will take effect after a reboot.

7. If you proceed and click Next, the Configuration Utility logs its activities, including stopping and
restarting IIS, and reports any problems.
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8. Review the configuration log summary.
As it applies the configuration, AppDynamics generates a log of the configuration activities and
displays a summary. Review the summary for any issues in red font. Green font indicates the more
interesting logged events. The summary shows any Warnings (W) or Errors (E). If you have
errors, contact AppDynamics Support.
9. Click Next. The wizard completes.
For troubleshooting information see Resolve .NET Agent Installation and Configuration Issues.
Using a Configuration File from the Command Line

You can set up a .NET Agent configuration file and run it from the command line. This is useful
when you have multiple agents to configure.
To create a configuration file

1. From a command line, start the configuration utility:
AppDynamics.Agent.Winston.exe -s <SetupConfigurationFilePath>

For example:
c:\Program Files\AppDynamics\AppDynamics .NET
Agent\AppDynamics.Agent.Winston.exe -s
"c:\temp\configurationSavedSetupConfiguration.xml"

The utility starts.
2. Configure the agent as described in the previous sections. The configuration is applied.
In addition, when the configuration completes, AppDynamics creates a setup file.
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Use this setup file as an argument to the command line utility.
To perform an unattended installation, pass the configuration file directly to the MSI installer
package. See Unattended Installation for .NET.
To run the configuration utility from the command line

1. Start the .NET Configuration Utility from the command line. Change the file path and setup file
path as needed.
AppDynamics.Agent.Winston.exe -c <SetupConfigurationFilePath>

For example:
c:\Program Files\AppDynamics\AppDynamics .NET
Agent\AppDynamics.Agent.Winston.exe -c
"c:\temp\configurationSavedSetupConfiguration.xml"

The utility runs in command line mode; the user interface does not launch.
When it finishes, the utility exits the process with status 0 for success or any other number for
failure.
2. Review the Winston.txt log file in the default logs directory for details.
Learn More

Video Tutorial: App Agent for .NET Manual Installation and Configuration
Install the .NET Agent
Naming Conventions for .NET Nodes
.NET Agent Directory Structure
.NET Agent Directory Structure
Executables
Log files
Agent configuration files
Coordinator Service configuration files
About Windows Server system directory variables
This topic details the default installation directories for the .NET Agent.
.NET Agent Directory Structure

The .NET Agent installs to the following directories. To navigate to a directory, copy the path and
paste it into the Windows Explorer address bar.
Executables

The agent executables and supporting files install to the AppDynamics .NET Agent directory, the
same as previous versions:
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Windows Server 2003 and later
%ProgramFiles%\AppDynamics\AppDynamics .NET Agent

Log files

The Logs directory defaults to the following location:
Windows Server 2008 and later
%ProgramData%\AppDynamics\DotNetAgent\Logs

Windows Server 2003
%AllUsersProfile%\Application Data\AppDynamics\DotNetAgent\Logs

Agent configuration files

The unified configuration file config.xml installs to the Config directory:
Windows Server 2008 and later
%ProgramData%\AppDynamics\DotNetAgent\Config

Windows Server 2003
%AllUsersProfile%\Application Data\AppDynamics\DotNetAgent\Config

Coordinator Service configuration files

The AppDynamics Agent Coordinator service writes configuration files from the Controller to the D
ata directory:
Windows Server 2008 and later
%ProgramData%\AppDynamics\DotNetAgent\Data

Windows Server 2003
%AllUsersProfile%\Application Data\AppDynamics\DotNetAgent\Data

About Windows Server system directory variables

%ProgramFiles% is located at <system drive>\Program Files for Windows Server 2003 and
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later.
%ProgramData% is located at <system drive>\Program Data for Windows Server 2008 and
later.
%AllUsersProfile% is located at <system drive>\Documents and Settings\All Users for
Windows 2003.
Unattended Installation for .NET
Prepare for Unattended Installation
To create a setup configuration file
Sample setup configuration file
Perform Unattended Installation
Installation prerequisites
To perform an unattended installation
Setup Configuration File Properties
Winston element
Log File Directory element
Log File Folder Access Permissions element
Account element
AppDynamics Agent element
Learn More
This topic describes the process to run an unattended installation for the .NET Agent. For more
detail about how to install and configure the agent manually see Install the .NET Agent.
Prepare for Unattended Installation

The .NET Agent MSI installer package allows you to specify the path to a setup configuration file
to perform an unattended installation. The setup configuration file contains all the properties you
need to enable instrumentation for your .NET applications.
To create a setup configuration file

You must run the .NET MSI installer package on one computer before you can use the
AppDynamics Agent Configuration utility to create a setup configuration file. See Install the .NET
Agent.
Setup configuration files created in previous versions of the AppDynamics Agent Configuration
utility work with the 3.8 installer.
1. Launch the AppDynamics Agent Configuration utility from the command line. Use the -s parame
ter to specify the setup configuration file destination. See To create a configuration file.
AppDynamics.Agent.Winston.exe -s <path to setup configuration file>

2. Go through the configuration wizard normally.
The configuration utility saves the setup configuration file to the path you specified.
The configuration utility only configures instrumentation for IIS applications.
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3. Optional: To perform unattended installation for Windows services or for standalone
applications, you must edit the setup configuration file manually.
For Windows services, add a Windows Services block as a child of the App Agents element.
See Configuring the App Agent for .NET for Windows Services.
For standalone applications, add a Standalone Applications block as a child of the App
Agents element. See Configuring the App Agent for .NET for Standalone Applications.
Sample setup configuration file

The following example shows a setup configuration file that instruments two IIS Applications
(MainBC and SampleHTTPService), a Windows service (BasicWindowsService), and a
standalone application (MyStandaloneApp.exe).
The configuration file sets the log directory as C:\ProgramData\AppDynamics\DotNetAgent\Logs
and grants write permission to four accounts.
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<winston>
<logFileDirectory
directory="C:\ProgramData\AppDynamics\DotNetAgent\Logs" />
<logFileFolderAccessPermissions defaultAccountsEnabled="false">
<account name="NT AUTHORITY\LOCAL SERVICE" displayName="LOCAL
SERVICE" />
<account name="NT AUTHORITY\SYSTEM" displayName="SYSTEM" />
<account name="NT AUTHORITY\NETWORK SERVICE" displayName="NETWORK
SERVICE" />
<account name="IIS_IUSRS" displayName="ApplicationPool Identity"
/>
</logFileFolderAccessPermissions>
<appdynamics-agent
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
<controller host="mycontroller.mycompany.com" port="8090"
ssl="false">
<application name="My Business Application" />
</controller>
<machine-agent />
<app-agents>
<IIS>
<applications>
<application path="/" site="MainBC">
<tier name="Main Site" />
</application>
<application path="/" site="SampleHTTPService">
<tier name="HTTP Services" />
</application>
</applications>
</IIS>
<windows-services>
<windows-service name="BasicWindowsService">
<tier name="Service Tier"/>
</windows-service>
</windows-services>
<standalone-applications>
<standalone-application executable="MyStandaloneApp.exe">
<tier name="Standalone App" />
</standalone-application>
</standalone-applications>
</app-agents>
</appdynamics-agent>
</winston>

Perform Unattended Installation

After you have created a setup configuration file, use it to run an unattended installation.
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Installation prerequisites

You must enable COM+ for the agent to function. See Verify COM+ Services are enabled.
To perform an unattended installation

1. Uninstall any existing agent.
2. Launch an elevated command prompt with full administrator privileges. See Start a Command
Prompt as an Administrator.
Logging on to Windows as a member of the Administrators group does not grant sufficient
permissions to run the installer.
3. Run the agent MSI installer package from the elevated command prompt. Use the AD_SetupFil
e parameter to pass the absolute file path to the setup configuration file.
msiexec /i dotNetAgentSetup64.msi /q /norestart /lv %TEMP%\AgentInstaller.log
AD_SetupFile=<absolute path to setup config.xml>

Optionally use the INSTALLDIR parameter to customize the agent installation directory.
INSTALLDIR=<custom agent install directory>

For example:
msiexec /i dotNetAgentSetup64.msi /q /norestart /lv %TEMP%\AgentInstaller.log
AD_SetupFile=C:\temp\SetupConfig.xml INSTALLDIR=D:\AppDynamics

4. Restart the AppDynamics.Agent.Coordinator.
net stop AppDynamics.Agent.Coordinator
net start AppDynamics.Agent.Coordinator

5. Restart applications you have instrumented: IIS, Windows services, or standalone applications.
For example, to restart IIS:
iisreset

Setup Configuration File Properties
Winston element
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The Winston element is the root element for the configuration file.
Required element: <winston>
Log File Directory element

The Log File Directory element is a child element of the Winston element. Use the directory attrib
ute to specify the log directory. If you omit the Log File Directory element, we use the default
directory:
Windows Server 2008 and later: %ProgramData%\AppDynamics\DotNetAgent\Logs
Windows Server 2003: %AllUsersProfile%\Application
Data\AppDynamics\DotNetAgent\Logs
Optional element: <logFileDirectory
directory="C:\ProgramData\AppDynamics\DotNetAgent\Logs" />
Log File Folder Access Permissions element

The Log File Folder Access Permissions is a child element of the Winston element. Unless you set
the default accounts enabled attribute to false, we grant write access to the logs folder for the
default accounts:
LOCAL SERVICE
SYSTEM
NETWORK SERVICE
ApplicationPool Identity
Optional element: <logFileFolderAccessPermissions
defaultAccountsEnabled="false">
Account element

The Account element is a child element of the Log File Folder Access Permissions element.
Create an Account element for the Windows account you use to run your application.
Set the name attribute to the name of account you use to run your application: the account for the
application pool for IIS or the Windows service account.
The display name attribute is a user-friendly name you choose for the account. The display name
shows up in log entries about assigning permissions for the account.
Optional element: <account name="MyAppPoolIdentity" displayName="Custom
ApplicationPool Identity" />
For example, if you run a Windows service under a domain account:
<account name="MYDOMAIN\service_acct" displayName="Domain Service
Account" />
AppDynamics Agent element

The AppDynamics Agent element is a child of the Winston element. It follows the same format as
the config.xml to define the agent configuration for all your .NET applications. See .NET Agent
Configuration Properties.
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Required element: <appdynamics-agent
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
Learn More

Configure the .NET Agent
.NET Agent Configuration Properties
Enable the .NET Agent for Windows Services
Enable the .NET Agent for Standalone Applications
Upgrade the .NET Agent

Upgrade the .NET Agent from Version 3.7.8 or Later
To uninstall the old version of the agent
To install the new version of the agent
To resume monitoring
Upgrade the .NET Agent from Version 3.7.7 or Earlier
To uninstall the old version of the .NET Agent
To install the new version of the .NET Agent
Configure the .NET Agent
To configure the agent using automatic tier generation and assignment
To configure the agent using manual tier generation and assignment
To clean up legacy configurations
To resume monitoring
Updated .NET Agent Directory Structure
Learn More
This topic describes how to upgrade to the .NET Agent version 3.8. The instructions vary based
upon your current version of the .NET Agent.
Upgrade the .NET Agent from Version 3.7.8 or Later

The MSI installer package for the new version of the .NET Agent (the agent) installs the updated
agent files and maintains all legacy configurations. After you complete the installation, start the
AppDynamics.Agent.Coordinator service and instrumented applications to finish the upgrade.
To uninstall the old version of the agent

1. Stop IIS, instrumented Windows services, and instrumented standalone applications.
If you shut down IIS but continue to see active IIS Worker Processes, check the Application
Pools pane in the IIS Manager and stop any started application pools.
Failing to stop instrumented applications before uninstalling the .NET Agent may require you to
reboot the machine.
2. Stop the AppDynamics.Agent.Coordinator service.
3. In the Control Panel, select Add/Remove Programs. Remove the AppDynamics .NET Agent.
To install the new version of the agent
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See To install the .NET Agent.
Don't launch AppDynamics Agent Configuration when the installer completes unless you want
to make changes to the existing configuration. The installer maintains existing agent
configurations.

To resume monitoring

1. Start the AppDynamics.Agent.Coordinator service.
net start AppDynamics.Agent.Coordinator

2. Start IIS, instrumented Windows services, and instrumented standalone applications.
Upgrade the .NET Agent from Version 3.7.7 or Earlier

Identify the right upgrade path based upon the method of tier naming and assignment (manual or
automatic) and the type of application you instrument:
If you use manual tier naming and assignment, the installer package upgrades
configurations for IIS applications and Windows services.
If you used automatic tier naming and assignment, run the configuration utility to update
configurations.
If you used standalone applications with 3.7.7 or earlier, follow the steps to Enable the .NET
Agent for Standalone Applications.
The MSI installer package for the new version installs the updated agent files. After installing, you
may need to run the configuration utility to update your configuration and optionally remove legacy
configurations. Finally, restart the AppDynamics.Agent.Coordinator service and instrumented
applications.
To uninstall the old version of the .NET Agent

1. Stop IIS and instrumented Windows services.
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If you shut down IIS but continue to see active IIS Worker Processes, check the Application
Pools pane in the IIS Manager and stop any started application pools.
Failing to stop instrumented applications before uninstalling the App Agent for .NET may
require you to reboot the machine.
2. Stop the AppDynamics.Agent.Coordinator service.
3. In the Control Panel, select Add/Remove Programs. Remove the AppDynamics .NET Agent.
To install the new version of the .NET Agent

See To install the App Agent for .NET.
If you used the following environment variables with the earlier version, the MSI installer migrates
the configurations to the new configuration file:
AppDynamicsAgent_CallGraphOptions
AppDynamicsAgent_DisableAppPools
AppDynamicsAgent_EnableInProcesses
AppDynamicsAgent_IgnoreCLREnv
AppDynamicsAgent_Profiler_Classes
Configure the .NET Agent

Configure the agent based on your method of tier generation and assignment: automatic or manua
l.
The .NET Agent configuration utility only supports configuration of one Controller per server. If
you previously used unsupported methods to configure different applications on the same server
to connect to different Controllers, you must reconfigure your logical model.
To configure the agent using automatic tier generation and assignment

If you used automatic configuration with the earlier version of the .NET Agent, run the
configuration utility to configure the agent:
1. Use the .NET Agent Configuration utility to reconfigure instrumentation for IIS applications.
Choose Automatic for the method of tier generation and assignment. See Configure the .NET
Agent.
2. Configure instrumentation for Windows services manually. See Enable the .NET Agent for
Windows Services.
To configure the agent using manual tier generation and assignment

For manual systems using manual tier generation and assignment, the installer package migrates
the configurations for IIS applications and for Windows services to the config.xml. At this stage, the
configuration for IIS applications and Windows services is complete.
If you choose not to launch the configuration utility and clean up legacy configurations, restart
the AppDynamics.Agent.Coordinator service.
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net stop AppDynamics.Agent.Coordinator
net start AppDynamics.Agent.Coordinator

To clean up legacy configurations

You can clean up legacy configurations by launching the AppDynamics Agent Configuration utility.
When the utility detects agent settings from a previous version, it offers you the option to clean up.
The clean up procedures modifies the web.config files causing an IIS restart.
1. Launch the AppDynamics Agent Configuration utility.
The Upgrade Configuration window opens.
2. Answer Yes to clean up old AppDynamics configurations.

The utility removes the following configurations:
AppDynamics configSections from web.config files for IIS applications and from
application.config files for Windows services.
Environment variables:
AppDynamicsAgent_IgnoreCLREnv
AppDynamicsAgent_CallGraphOptions
AppDynamicsAgent_EnableInProcesses
AppDynamicsAgent_DisableAppPools
AppDynamicsAgent_Profiler_Classes
3. Proceed through the wizard normally:
Verify or update the log directory and grant write permissions to it.
Verify the controller connection information.
Verify or update manual tier assignment.
To resume monitoring

Start IIS and instrumented Windows services.
Updated .NET Agent Directory Structure

To learn more about the updated App Agent for .NET Directory Structure, See .NET Agent
Directory Structure.
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Learn More

Install the .NET Agent
Configure the .NET Agent
Uninstall the .NET Agent
Agent - Controller Compatibility Matrix
Platform Release Notes
Resolve .NET Agent Installation and Configuration Issues
Enable SSL for .NET
Before You Begin
Enable SSL for the .NET Agent
To configure SSL using the AppDynamics Agent Configuration utility
To configure SSL in the config.xml
Sample SaaS SSL config.xml configuration
Sample on-premise SSL config.xml configuration
Establish Trust for the Controller's SSL Certificate
Certificates signed by a publicly known Certificate Authority
Certificates signed by an Internal Certificate Authority
Self-Signed Certificates
Troubleshooting Tips
Learn More
This topic covers how to configure the .NET Agent (the agent) to connect to the Controller using
SSL. It assumes that you use a SaaS Controller or have configured the on-premise Controller to
use SSL.
Before You Begin

Before you configure the agent to enable SSL, gather the following information:
Identify if the Controller is SaaS or on-premise.
Identify the Controller SSL port.
For SaaS Controllers the SSL port is 443.
For on-premise Controllers the default SSL port is 8181, but you may configure the
Controller to listen for SSL on another port.
Identify the signature method for the Controller's SSL certificate:
A publicly known certificate authority (CA) signed the certificate. This applies for
Verisign, Thawte, and other commercial CAs.
A CA internal to your organization signed the certificate. Some companies maintain
internal certificate authorities to manage trust and encryption within their domain.
The Controller uses a self-signed certificate.
Enable SSL for the .NET Agent

There are two ways to update the SSL settings for the agent. You can use the AppDynamics
Agent Configuration Utility. Otherwise, edit the settings directly in the config.xml, see Where to
Configure .NET Agent Properties.
When you enable SSL for the .NET Agent, you automatically enable SSL for the .NET Machine
Agent.
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To configure SSL using the AppDynamics Agent Configuration utility

1. Launch the AppDynamics Agent Configuration utility.
2. In the Controller Configuration window, set the Port Number to the SSL port for the
Controller.
For a SAAS Controller, set the Port Number to 443.
For an on-premise Controller, set the Port Number to the on-premise SSL port. The
default is 8181.
3. Click Enable SSL.
This example demonstrates connection to an on-premise Controller listening for SSL on port 8181:

4. Click Next and proceed with the rest of the windows to complete the configuration.
5. Restart instrumented applications: IIS applications or application pools, Windows services, or
standalone applications.
If you use automatic tier configuration, restart IIS. For example, open a command prompt and run:
iisreset

Upon restart the agent connects with the Controller via SSL.
To configure SSL in the config.xml
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1. Open the config.xml file as administrator. See Where to Configure .NET Agent Properties.
2. Update the SSL settings. See Controller Element.
Set the Controller port attribute to the on-premise SSL port. The default is 8181. See Cont
roller port attribute.
Set the Controller SSL attribute to "true". See Controller ssl attribute.
3. Save your changes.
4. Restart the AppDynamics.Agent.Coordinator service.
5. Restart instrumented applications: IIS applications or application pools, Windows services, or
standalone applications.
If you use Automatic configuration, restart IIS. For example, open a command prompt and run:
iisreset

Upon restart the agent connects with the Controller via SSL.
Sample SaaS SSL config.xml configuration

<?xml version="1.0" encoding="utf-8"?>
<appdynamics-agent xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
<controller host="mycompany.saas.appdynamics.com" port="443" ssl="true">
<application name="MyDotNetApplication" />
</controller>
...
</appdynamics-agent>

Sample on-premise SSL config.xml configuration

<?xml version="1.0" encoding="utf-8"?>
<appdynamics-agent xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
<controller host="mycontroller.mycompany.com" port="8181" ssl="true">
<application name="MyDotNetApplication" />
</controller>
...
</appdynamics-agent>

Establish Trust for the Controller's SSL Certificate

The .NET Agent requires that the Common Name (CN) on the Controller certificate match the DNS
name of the Controller. Additionally, certificates for the root CA that signed the Controller's SSL
certificate must reside in the Windows Trusted Root Certification Authorities store for the Loca
l Computer.
Certificates signed by a publicly known Certificate Authority
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The root certificates for most publicly trusted CA signing authorities, such as Verisign, Thawte, and
other commercial CAs, are in the Trusted Root Certification Authorities store by default.
Certificates signed by an Internal Certificate Authority

If your organization uses internal CA to sign certificates, you may need to obtain the root CA
certificate from your internal security management resource. To import the root certificate, see Add
ing certificates to the Trusted Root Certification Authorities store for a local computer.
This example shows how to use the Certificate snap-in for the Microsoft Management Console to
import a certificate for a Trusted Root Certification Authority:

If an intermediate CA signed the Controller's certificate, you must import the certificate for the
intermediate CA in addition to the one for the root CA that signed the intermediate CA's certificate.
If your controller is publicly accessible, you can use a certificate checker to identify the certificates
required to complete the trust chain. See the certificate checker from Thawte.
This examples shows the Intermediate Certification Authorities store:
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Self-Signed Certificates

The App Agent for .NET does not support self-signed certificates. In order to implement SSL, the
Controller must use a certificate signed by a trusted CA signing authority or an internal trusted root
CA. See Security.
Troubleshooting Tips

If you imported certificates for a root or intermediate CA, verify the certificate store where
you imported them. Import them to Certificates (Local Computer).
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The AppDynamics SaaS Controller uses certificates signed by Thawte. In some cases,
SaaS customers must import the Thawte root certificates into the Windows Trusted Root
Certification Authorities store.
In some cases system administrators set up group policies that require external certificates
be imported to the Third-Party Root Certification Authorities store. If importing the
certificate for the root CA to the Windows Trusted Certification Authorities store doesn't
work, try the Third-Party Root Certification Authorities store.
Learn More

Security
.NET Agent Configuration Properties
Enable the .NET Agent for Windows Services
Preparing to Configure the .NET Agent for Windows Services
Configuring the .NET Agent for Windows Services
Learn More
By default, AppDynamics enables the .NET Agent only for IIS worker processes. This topic
describes how to edit the config.xml file to enable the agent for Windows services.
It is possible to instrument any combination of IIS Applications, Windows services, and
standalone applications on a single server. Run the configuration utility to configure IIS, then follow
the instructions for Windows services and Standalone applications.
Preparing to Configure the .NET Agent for Windows Services

Before you enable the .NET Agent for Windows services, you must install the agent. We
recommend using the AppDynamics Agent Configuration utility to perform basic configuration
tasks.
1. If you have not already done so, install the .NET Agent. See Install the .NET Agent
2. Run the AppDynamics Agent Configuration utility to generate a config.xml. See Configure
the .NET Agent.
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2.
Even though the Configuration Utility only instruments IIS Applications, it is useful to create
the config.xml and specify Controller connection properties.
If you have previously instrumented app agents for IIS applications, don't run the
configuration utility. You already have a config.xml.
Use the configuration utility to do the following:
Change the location of the Logs directory and assign permissions.
Configure and test connectivity to the Controller.
Set the Business Application for the agent.
Choose Manual for the method of tier generation and assignment. Don't assign assign any
tiers for any IIS Applications. This disables instrumentation for all IIS applications.
Configuring the .NET Agent for Windows Services

Once you have configured the Controller properties for the .NET Agent, instrument your Windows
service by adding an XML element for it to the config.xml.
1. Edit the config.xml file as an administrator. See Where to Configure .NET Agent Properties.
If you haven't instrumented IIS applications, the file contains minimal configurations for
Controller connectivity and the machine agent. Verify the Controller properties and the
Business Application name:
<?xml version="1.0" encoding="utf-8"?>
<appdynamics-agent
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
<controller host="mycontroller.mycompany.com" port="8090"
ssl="false">
<application name="My Business Application" />
</controller>
<machine-agent />
<app-agents>
<IIS>
<applications />
</IIS>
</app-agents>
</appdynamics-agent>

If you have already instrumented IIS applications, you see their configurations under the IIS
element.
2. Add the Windows Services block as a child of the App Agents element. Create a Windows
Service element for each Windows service you want to instrument. Use the Tier element to
assign the instrumented service to a tier in the Controller. See .NET Agent Configuration
Properties
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<windows-services>
<windows-service name="BasicWindowsService">
<tier name="Service Tier"/>
</windows-service>
<windows-service name="SecondWindowsService">
<tier name="Service Tier"/>
</windows-service>
</windows-services>

3. Set the Windows Service element name attribute to the service name. The service name
may not be the same as the display name in the Services panel of the Server manager.

This sample config.xml demonstrates instrumentation for a Windows service:
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<?xml version="1.0" encoding="utf-8"?>
<appdynamics-agent
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
<controller host="mycontroller.mycompany.com" port="8090"
ssl="false">
<application name="My Business Application" />
</controller>
<machine-agent />
<app-agents>
<IIS>
<applications />
</IIS>
<windows-services>
<windows-service name="BasicWindowsService">
<tier name="Service Tier"/>
</windows-service>
</windows-services>
</app-agents>
</appdynamics-agent>

4. Restart the AppDynamics.Agent.Coordinator
5. Restart the Windows service.
If your Windows service does not implement any of the frameworks we instrument by
default, you must configure a POCO entry point for a class/method in your service for
the agent to begin instrumentation. See Supported Environments and Versions for
.NET and POCO Entry Points.
Learn More

Mapping Application Services to the AppDynamics Model
Configure the .NET Agent
Install the .NET Agent
.NET Agent Configuration Properties
Enable the .NET Agent for Standalone Applications
Preparing to Configure the .NET Agent for Standalone Applications
Configuring the .NET Agent for Standalone Applications
Learn More
By default, AppDynamics enables the .NET Agent only for IIS worker processes. This topic
describes how to edit the config.xml file to enable the agent for standalone applications.
It is possible to instrument any combination of IIS Applications, Windows services, and
standalone applications on a single server. Run the configuration utility to configure IIS, then follow
the instructions for Windows services and Standalone applications.
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Preparing to Configure the .NET Agent for Standalone Applications

Before you enable the .NET Agent for standalone applications, you must install the agent. We
recommend using the AppDynamics Agent Configuration utility to perform basic configuration
tasks.
1. If you have not already done so, install the .NET Agent. See Install the .NET Agent
2. Run the AppDynamics Agent Configuration utility to generate a config.xml. See Configure
the .NET Agent.
Even though the Configuration Utility only instruments IIS Applications, it is useful to create
the config.xml and specify Controller connection properties.
If you have previously instrumented app agents for IIS applications, don't run the
configuration utility. You already have a config.xml.
Use the configuration utility to do the following:
Change the location of the Logs directory and assign permissions.
Configure and test connectivity to the Controller.
Set the Business Application for the agent.
Choose Manual for the method of tier generation and assignment. Don't assign assign any
tiers for any IIS Applications. This disables instrumentation for all IIS applications.
Configuring the .NET Agent for Standalone Applications

Once you have configured the Controller properties for the .NET Agent, instrument your
standalone application by adding an xml element for it to the config.xml.
1. Edit the config.xml file as an administrator. See Where to configure .NET agent properties.
If you haven't instrumented IIS applications, the file contains minimal configurations for
Controlller connectivity and the machine agent. Verify the Controller properties and the
Business Application name

<?xml version="1.0" encoding="utf-8"?>
<appdynamics-agent
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
<controller host="mycontroller.mycompany.com" port="8090"
ssl="false">
<application name="My Business Application" />
</controller>
<machine-agent />
<app-agents>
<IIS>
<applications />
</IIS>
</app-agents>
</appdynamics-agent>

If you have already instrumented IIS applications, you will see their configurations under the
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IIS element.
2. Add the Standalone Applications block as a child of the App Agents element. Create a
Standalone Application element for each standalone application you want to instrument. Use
the Tier element to assign the instrumented application to a tier in the Controller. See .NET
Agent Configuration Properties
<standalone-applications>
<standalone-application executable="MyStandaloneApp.exe">
<tier name="Standalone Tier" />
</standalone-application>
<standalone-application
executable="MyOtherStandaloneApp.exe">
<tier name="Standalone Tier" />
</standalone-application>
</standalone-applications>

Set the Standalone Application element executable attribute to the executable file name. Do
not include the full path to the executable.

For example, if the full path to the standalone application is C:\Program
Files\MyApplication\MyStandaloneApp.exe, set the executable element to
"MyStandaloneApp.exe". The file extension is optional, so "MyStandaloneApp" also works.
This sample config.xml demonstrates instrumentation for a standalone application:
<?xml version="1.0" encoding="utf-8"?>
<appdynamics-agent
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
<controller host="mycontroller.mycompany.com" port="8090"
ssl="false">
<application name="My Business Application" />
</controller>
<machine-agent />
<app-agents>
<IIS>
<applications />
</IIS>
<standalone-applications>
<standalone-application executable="MyStandaloneApp.exe">
<tier name="Standalone Tier" />
</standalone-application>
</standalone-applications>
</app-agents>
</appdynamics-agent>

3. Restart the AppDynamics.Agent.Coordinator.
4.
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4. Restart the standalone application.
If your standalone application does not implement any of the frameworks we
instrument by default, you must configure a POCO entry point for a class/method in
your application for the agent to begin instrumentation. See Supported Environments
and Versions for .NET and POCO Entry Points.
Learn More

Mapping Application Services to the AppDynamics Model
Configure the .NET Agent
Install the .NET Agent
AppDynamics for Windows Azure with NuGet
Prerequisites
Register for an AppDynamics for Windows Azure Account
Add the .NET Agent to Your Azure Solution
Learn More
Monitor your Azure cloud solutions with the AppDynamics for Windows Azure NuGet package.
Sign up for the AppDynamics add-on in the Windows Azure portal, then enable the AppDynamics
agent in your Visual Studio solution. If you can't use NuGet to install the .NET Agent, see Manually
Install the .NET Agent on Windows Azure.
Prerequisites

Visual Studio 2010 or later
A Visual Studio solution to monitor
Visual Studio must have the following permissions to the solution:
Read and Write permissions to each project directory
Read and Write permissions to each Visual Studio .NET C# Project (*.csproj) file
Read and Write permissions to the Service Definition (ServiceDefinition.csdef) file
Windows Azure SDK
Windows Azure account
If the Visual Studio Standalone Profiler is installed, you must uninstall it and remove related
registry entries.
Register for an AppDynamics for Windows Azure Account

If you haven't registered for an AppDynamics account, see Register for AppDynamics for Windows
Azure.
Once you've registered, we will send you a Welcome email with your URL and credentials to
connect to the AppDynamics Controller. If you already have AppDynamics credentials from
another product, you can sign in using them.
Add the .NET Agent to Your Azure Solution

Use the NuGet package manager to add the .NET Agent to your Azure solution in Visual Studio.
1. In Visual Studio, right-click your solution name and chose Manage NuGet Packages for
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Solution.

2. Click the NuGet official package source in the left menu and type "AppDynamics" in the
search bar in the upper right.
3. Select AppDynamics .NET Agent for Azure and click Install.

4. Click the projects you want to monitor, then click OK.
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5. Click I Accept to agree to the license terms.

Copyright © AppDynamics 2012-2014

Page 1467

6. Enter the connection information from your Welcome email:
Controller Host
Controller Port
Account Name
Account Key
We automatically populate Application Name with the name of your Windows Azure solution.

7. Close the Manage NuGet Packages window.
8. Verify the following:
Instrumented projects have an AppDynamics folder
The AppDynamics folder(s) contain an MSI installer package and a setup.cmd file
The ServiceDefinition.csdef has an AppDynamics startup task
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9. Right-click the Windows Azure cloud solution and click Publish.

Once you've successfully published your project, you're ready to log on to the Controller and begin
monitoring your solution!
Learn More

Application Intelligence Platform
APM Overview - .NET
Quick Tour of the User Interface Video Tutorial
Manually Install the .NET Agent on Windows Azure

Prerequisites
Register for an AppDynamics Account
AppDynamics Account Home Page
Download the .NET Agent
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Add the .NET Agent to Windows Azure Roles
Publish the AppDynamics-Instrumented Application to Windows Azure
Monitor Your Application
Learn More
This topic describes how to manually install the .NET Agent on Windows Azure. To install the
.NET Agent on Windows Azure using NuGet, see AppDynamics for Windows Azure with NuGet.
Prerequisites

Visual Studio 2010 or later
A Visual Studio solution to monitor
Windows Azure SDK
Windows Azure account
If the Visual Studio Standalone Profile is installed, you must uninstall it and clean up the
registry.
Register for an AppDynamics Account

If you haven't registered for an AppDynamics account, see Register for AppDynamics for Windows
Azure.
Once you've registered, we will send you a Welcome email with your URL and credentials to
connect to the AppDynamics Controller. If you already have AppDynamics credentials from
another product, you can sign in using them.
AppDynamics Account Home Page

Your AppDynamics account home page includes:
A link to the AppDynamics download site where you can download the .NET Agent
Controller URL where you log into your account on the AppDynamics controller hosted
service
AppDynamics credentials: Account, Username, and Access Key
Number of days left in your Pro trial
Links to the AppDynamics on-boarding videos and documentation
You can access your AppDynamics account home page at any time by entering its URL in a web
browser and signing in with your AppDynamics credentials.
Download the .NET Agent

To download the .NET Agent from AppDynamics:
1. Navigate to the AppDynamics download site. The URL is in your welcome email and on your
AppDynamics account home page.
2. Log in with your AppDynamics account name and access key.
3. Download the file named dotNetAgentSetup64.msi. Do not run the file.
4. Download the file named startup.cmd.
For convenience we've attached the same file to this document (startup.cmd) and included the
contents in step 5 below.
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Add the .NET Agent to Windows Azure Roles

This step instruments the roles in your Visual Studio solution for monitoring by AppDynamics.
There is no traditional Windows wizard-style installation procedure required to use AppDynamics
for Windows Azure.
These instructions apply to the AppDynamics .NET Agent version 3.7.8 or later. If you
downloaded an earlier version, please download the latest version of the agent.
1. Either create a new Windows Azure cloud project in Visual Studio or open an existing Windows
Azure cloud project.
2. If you created a new project, add the Web role and/or Worker role projects to the solution.
3. To each Web and Worker role project that you want to monitor, add a new folder named AppDy
namics.
The scripts look for the AppDynamics folder. Using a different name may cause the script to
fail.
4. Copy the dotNetAgentSetup64.msi you downloaded to the AppDynamics folder for each Web
and Worker role project.
Note that while each role project has a single attached agent MSI installer package, each role
instance in the project requires a separate agent license.
5. Download the startup.cmd and add it to each Web and Worker role project that you want to
monitor.
Alternatively, add a text file named startup.cmd and paste the following lines in it:
REM Install the AppDynamics agent on Windows Azure
SETLOCAL EnableExtensions
IF {%INTERNAL_APPDYNAMICS_AGENT_INSTALL_REBOOT%}=={true} (
SETX INTERNAL_APPDYNAMICS_AGENT_INSTALL_REBOOT ""
GOTO :END
)
REM Bypass the installation if this is emulated environment
IF {%EMULATED%}=={true} GOTO :END
REM Uninstall if .NET Agent already installed
IF {%COR_PROFILER%}=={AppDynamics.AgentProfiler} (
start /wait msiexec /x {0C633F51-09FE-4AE4-A25F-F6CD167CC46E} /quiet /log
d:\aduninstall.log
IF NOT %ERRORLEVEL%==0 SHUTDOWN /r /f /c "Reboot after uninstalling the
AppDynamics .NET Agent"
)
ELSE IF DEFINED COR_PROFILER GOTO :END
IF NOT EXIST AppDynamics\dotNetAgentSetup64.msi GOTO :END
SET
SET
SET
SET

ControllerHost=%1
ControllerPort=%2
AccountName=%3
AccountAccessKey=%4
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SET ControllerApplication=%5
SET ControllerSSLEnabled=%6
IF {%1}=={} (ECHO Syntax error: Missing AD_Agent_ControllerHost parameter
>>d:\adInstall.log) & (GOTO :END)
IF {%2}=={} (ECHO Syntax error: Missing AD_Agent_ControllerPort parameter
>>d:\adInstall.log) & (GOTO :END)
IF {%3}=={} (ECHO Syntax error: Missing AD_Agent_AccountName parameter
>>d:\adInstall.log) & (GOTO :END)
IF {%4}=={} (ECHO Syntax error: Missing AD_Agent_AccountAccessKey parameter
>>d:\adInstall.log) & (GOTO :END)
IF {%5}=={} (SET ControllerApplication=Default)
IF {%6}=={} (SET ControllerSSLEnabled=false)
REM Install the agent
start /wait msiexec /i AppDynamics\dotNetAgentSetup64.msi
AD_Agent_Environment=Azure AD_AzureRoleName=%RoleName%
AD_AzureRoleInstanceID=%RoleInstanceID% AD_Agent_ControllerHost=%ControllerHost%
AD_Agent_ControllerPort=%ControllerPort% AD_Agent_AccountName=%AccountName%
AD_Agent_AccountAccessKey=%AccountAccessKey%
AD_Agent_ControllerApplication=%ControllerApplication%
AD_Agent_ControllerSSLEnabled=%ControllerSSLEnabled% /quiet /log
d:\adInstall.log
IF %ERRORLEVEL%==0 (
SETX INTERNAL_APPDYNAMICS_AGENT_INSTALL_REBOOT "true"
REM Reboot the machine after installation in order to restart role CLR and
attach AppDynamics Agent to it
SHUTDOWN /r /f /c "Reboot after installing the AppDynamics .NET Agent"
)
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:END
EXIT /B %ERRORLEVEL%

5. IMPORTANT: For each Web and Worker role to that you want to monitor, set the Copy to
Output Directory property for the dotNetAgentSetup64.msi file and for the startup.cmd file to Cop
y Always.

6. In the ServiceDefinition.csdef file for the Windows Azure cloud project, add a Startup Task
element that invokes startup.cmd with parameters for each WorkerRole and WebRole element.
Add the following lines:
<Startup>
<Task commandLine="AppDynamics\startup.cmd [your_controller_host]
[your_controller_port] [your_account_name] [your_access_key]
[your_application_name] [SSLEnabled]" executionContext="elevated"
taskType="simple">
<Environment>
<Variable name="EMULATED">
<RoleInstanceValue xpath="/RoleEnvironment/Deployment/@emulated" />
</Variable>
</Environment>
</Task>
</Startup>

where:
your_controller_host and your_controller_port are the Controller host and port for your
AppDynamics account, and your_account_name and your_access_key are your
credentials. The Welcome email we sent when you registered with AppDynamics includes
this information. You can also find it on your AppDynamics account home page. See Registe
r for AppDynamics for Windows Azure.
your_application_name is the name you choose for your business application. This name
identifies the application in the AppDynamics Controller interface.
SSLEnabled is an optional property that defaults to "false". To enable SSL set your_contro
ller_port to 443 and SSLEnabled to "true".
7. Verify the following:
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Instrumented projects have an AppDynamics folder
The AppDynamics folder(s) contain a dotNetAgentSetup64.msi and a startup.cmd file
For instrumented projects, you set the Copy to Output Directory property for the .msi and
.cmd files to Copy Always
The ServiceDefinition.csdef includes an AppDynamics startup task

Publish the AppDynamics-Instrumented Application to Windows Azure

1. In Visual Studio, click the Windows Azure cloud project.
2. Right-click. Click Publish...
Monitor Your Application

Once you've published your application and there is load on it, you can login to the Controller and
begin monitoring.
1. Log into the AppDynamics Controller at the URL given in your welcome email and on your
AppDynamics account home page.
2. Send some requests to your application so there is some traffic to monitor and wait a few
minutes.
3. In the AppDynamics Controller, click your application.
4. Monitor your application.
Learn More

Features Overview
Quick Tour of the User Interface Video Tutorial
Register for AppDynamics for Windows Azure

What is AppDynamics?
Register for an AppDynamics for Windows Azure Account
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Register for an AppDynamics for Windows Azure Account From Windows Azure
Marketplace
Next Steps
Learn More
Monitor your Azure cloud solutions with the AppDynamics for Windows Azure NuGet package.
Sign up for the AppDyanmics add-on in the Windows Azure portal, then enable the AppDynamics
agent in your Visual Studio solution.
What is AppDynamics?

AppDynamics is an application performance monitoring solution that helps you:
Identify problems, such as slow and stalled user requests and errors, in a production
environment
Troubleshoot and isolate the root cause of such problems
There are two components in AppDynamics:
App Agent: The .NET Agent collects data from your servers. You run a separate agent on every
role instance that you want to monitor. You install the agent as part of the NuGet package.
AppDynamics Controller: The agent sends information to an AppDynamics Controller hosted
service. Using a browser-based console, you log on to the Controller to monitor, analyze and
troubleshoot your application.
Register for an AppDynamics for Windows Azure Account

Use the Windows Azure portal to sign up for AppDynamics for Windows Azure.
1. Log on to the Windows Azure portal at https://manage.windowsazure.com.

2. Click +NEW at the bottom left corner of the portal.
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3. In the left menu, click STORE.

4. Click AppDynamics in the list of services and click the NEXT arrow.
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5. Click the plan corresponding to the size (Extra Small, Small, Medium, etc.) and number of virtual
machines where you will install AppDynamics monitoring agents.
6. Select your REGION and click the NEXT arrow.
7. After the form validates the NAME field and displays a green check, click the NEXT arrow.

8. Review your purchase and click the CHECK to purchase.
You've successfully signed up for AppDynamics for Windows Azure!
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Register for an AppDynamics for Windows Azure Account From Windows Azure Marketplace

1. Click Try Free or Sign Up for AppDynamics on the Windows Azure Marketplace at https://data
market.azure.com/application/f9949031-b8b9-4da5-b500-c615f3f2a7cd.
If you choose Sign Up, you receive a free version of AppDynamics Pro for Windows Azure with
full functionality, which downgrades after 30 days to a free version of AppDynamics Lite for
Windows Azure with limited functionality. You do not need to provide a credit card for this option.
You can upgrade to AppDynamics Pro for Windows Azure at any time.
If you choose Try Free, you receive a free version of AppDynamics Pro for Windows Azure with
full functionality. You need to provide a credit card for this option. After 30 days your credit account
will be charged for continued use of AppDynamics Pro for Windows Azure, unless you cancel your
subscription.
You need one agent license for each role instance that you wish to monitor. For example, a site
running 2 Web role instances and 2 Worker role instances requires 4 agent licenses.
2. On the registration page, provide your user information, a password, email address, company
name, and the name of the application you are monitoring as you will publish it with Windows
Azure.
3. Click Register Now.
Next Steps

We'll send you a Welcome email with your URL and credentials to connect to the AppDynamics
Controller. Then you can use NuGet to add the .NET Agent to your Windows Azure solution or
install it manually.
To install the agent using NuGet, see AppDynamics for Windows Azure with NuGet.
To install the agent manually, see Manually Install the .NET Agent on Windows Azure.
Learn More

AppDynamics for Windows Azure with NuGet
Manually Install the .NET Agent on Windows Azure
Application Intelligence Platform
APM Overview - .NET
Uninstall the .NET Agent
This topic describes how to do a complete uninstall of the .NET Agent.
Do not follow these instructions if you are doing an upgrade. If you want to upgrade to a new
version see Upgrade the .NET Agent.
To completely uninstall the .NET Agent

1. Stop IIS, instrumented Windows services, and instrumented standalone applications.
Failing to stop instrumented applications before uninstalling the agent requires you to reboot
the machine to complete the uninstall.
2. Stop the AppDynamics.Agent.Coordinator service.
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2.

3. In the Control Panel, select Add/Remove Programs. Remove the AppDynamics .NET
Agent.
4. The uninstall procedure does not remove configuration files. Delete the configuration
directory:
Windows Server 2008 and later: %ProgramData%\AppDynamics
Windows Server 2003: %AllUsersProfile%\Application Data\AppDynamics
5. Verify the uninstall deleted the AppDynamics executables directory. If not, delete it
manually:
Windows Server 2003 and later: %ProgramFiles%\AppDynamics
6. Restart IIS, Windows services, and standalone applications.

Learn More

Upgrade the .NET Agent
Install the .NET Agent
Agent - Controller Compatibility Matrix
Platform Release Notes
Resolve .NET Agent Installation and Configuration Issues
Resolve Agent-Controller Configuration Issues
To verify that the .NET Agent is reporting to the Controller
To check Internet Explorer proxy settings
Checklist for Resolving .NET Agent Installation Issues
Resolve .NET Agent Issues
Resolving Agent Installation Issues
Verify Administrative privileges
To verify COM+ Services are enabled
To generate a log for agent installation failures
To correct failed installation caused by other APM products
To remove associated "Environment" subkey for W2SVC and WAS
services in the registry:
Resolve Configuration Errors
Verify the configuration in the config.xml file
Resolve Log Issues
To verify that the .NET Agent directory has the correct permissions
Allowed groups for different IIS versions
Learn More
This topic covers how to solve installation and configuration problems for the .NET Agent.
Resolve Agent-Controller Configuration Issues
To verify that the .NET Agent is reporting to the Controller
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Use the AppDynamics UI to verify that the agent is able to connect to the Controller.
1. In a browser open:
http://<controller-host>:<controller-port>/controller

If you can't connect to the controller in Internet Explorer, see To check for misconfigured IE proxy
settings.
2. Log in to the AppDynamics UI.
3. Select the application to open the Application Dashboard.
4. In the left navigation panel click Servers -> App Servers and open the Health tab.
The Health tab lists the tiers, their nodes, and App Agent Status. When an agent successfully
reports to the Controller, you see an "up" arrow symbol. For details see Verify App
Agent-Controller Communication.
When deploying multiple agents for the same tier, determine whether you get the correct
number of nodes reporting into the same tier.
After sending a request to your web application, data should appear on the AppDynamics
UI. The agents should be displayed in the Application Flow Map of the Application
Dashboard.

If no data appears after a few minutes:
Verify that the Agent is writing its log files:
Windows Server 2008 and later: %ProgramData%\AppDynamics\DotNetAgent\Logs
\AgentLog.txt
Windows Server 2003: %AllUsersProfile%\Application
Data\AppDynamics\DotNetAgent\Logs\AgentLog.txt
If the log file exists, open it and review it for errors.
If the log file doesn't exist, run the Windows Event Viewer and see the application
messages.
If there are no AppDynamics event messages, look for messages from the .NET Runtime.
To check Internet Explorer proxy settings
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Misconfigured proxy settings in Internet Explorer may cause the App Agent for .NET to fail to
connect to the controller. If Test Controller connection fails on the Controller Configuration
window in the AppDynamics Agent Configuration utility, do the following:
1. Verify the Controller host and port settings are correct.
2. In Internet Explorer, open:
http://<controller-host>:<controller-port>/controller

3. If the connection also fails in Internet Explorer, check the proxy settings. See Change IE Proxy
Settings.
4. Correct or remove any incorrect proxy settings.
Checklist for Resolving .NET Agent Installation Issues

Item

Notes

Run the installer as
Administrator.

Verify Administrative
privileges

Verify that COM+ is enabled.

To verify COM+ Services are
enabled

Verify permissions for Agent
directory.

To verify that the .NET Agent
directory has the correct
permissions based on the
site’s application pool identity.

Verify that the Agent is
compatible with the Controller.

Agent - Controller
Compatibility Matrix

Verify the correct settings in
the config.xml:

Update the config.xml file to
include the .NET Agent
Configuration Properties.

Windows Server 2008 and
later:
%ProgramData%\AppDynam
ics\DotNetAgent\Config
\config.xml
Windows Server 2003:
%AllUsersProfile%\Appl
ication
Data\AppDynamics\DotNe
tAgent\Config\config.x
ml

Resolve .NET Agent Issues
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Resolving Agent Installation Issues

If the Agent installation is failing, check the following configurations in your environment:
Verify Administrative privileges

Ensure that you have the administrative privileges when you launch the installer. If the currently
user doesn't have sufficient privileges, the installer prompts you for an administrator password.
To verify COM+ Services are enabled

If you receive an error about the Appdynamics.Agent.Coordinator_service, ensure that the COM+
applications in your system are enabled.
1. From the Windows Start Menu, click Run.
2. Enter "services.msc" and click on the "OK" button. Windows opens the Services Console.

3. Enable the COM+ services (if not enabled).
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To generate a log for agent installation failures

If installer fails, use the command line utility to launch the installer.
msiexec /i $Path_to_the_MSI_File /l*v verbose.log

A verbose log for the .NET Agent is created at the same location where you saved the installer file.
Send this log to the AppDynamics Support Team.
To correct failed installation caused by other APM products

The .NET Agent installation may fail if there are other Application Performance Management
(APM) products installed in the same managed environment. Remove the associated
"Environment" subkey for certain services for the installed APM products.
To remove associated "Environment" subkey for W2SVC and WAS services in the registry:

1. Run Regedit or regedt32.
2. In regedit.exe, locate the following registry keys:
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\services\W3SVC
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\services\WAS
3. Expand the keys.
4. Modify the Environment subkey to delete the following values:
COMPLUS_ProfAPI_ProfilerCompatibilitySetting=EnableV2Profiler
COR_ENABLE_PROFILING=1
COR_PROFILER= {a GUID}

5. Restart the services. For more details see How to restart the W2SVC and WAS services?.
Resolve Configuration Errors
Verify the configuration in the config.xml file

Ensure that you have correctly configured the config.xml file for the App Agent for .NET. For
more detail, see .NET Agent Configuration Properties.
If you made manual edits to the config.xml, check the AgentLog.txt and WarnLog.txt for
errors. Invalid XML shows in the log as follows:
2014-03-13 10:49:18.7199 1232 dllhost 1 1 Error ConfigurationManager Error
reading the configuration file

Resolve Log Issues

The .NET Agent writes logs to the following directories:
Windows Server 2008 and later: %ProgramData%\AppDynamics\DotNetAgent\Logs
Windows Server 2003: %AllUsersProfile%\Application
Data\AppDynamics\DotNetAgent\Logs

Copyright © AppDynamics 2012-2014

Page 1483

The agent will not generate logs if the agent directory does not have sufficient permissions
permissions.
IMPORTANT: If the installation doesn't create the AppDynamics directory, contact AppDynamic
s Support Team.
To verify that the .NET Agent directory has the correct permissions

1. Click IIS -> Application pools.
IIS displays the list of application pools for your machine.

2. Right-click on a particular application pool.
3. Click Advanced Settings.
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IIS displays the Application Pool Identity for that application.
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4. Ensure that your Agent Directory also has the same permissions as your site's application
pools.
Navigate to AppDynamics .NET App Server Agent directory location.
Right-click on the "logs" directory for the App Server Agent and select Properties.
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Click the Security tab and verify that the same Application Pool Identity is specified for the
.NET Agent directory.
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If the Agent's logs directory does not have the required permissions:
1. In the Security tab, click Edit.
2. Click Add to add new permissions to the Agent directory.
3. Click Advanced.
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4. Click Find Now to find all the users, groups, or built-in security principals on your machine.
5. Select the required group (see the information given below for "Allowed groups") from the list
and click OK.
6. Provide the read and write permissions for the selected user/group/security principal to the
Agent directory and click OK.
7. Click Apply.
Allowed groups for different IIS versions

For IIS v6.x, following settings are applicable for Application Pool Identities:
Application Pool Identity

Permission Level

LocalService

LOCAL SERVICE

LocalSystem

SYSTEM

NetworkService

NETWORK SERVICE
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Custom Account

Provide the exact name of the account.

For IIS v7.0 and later, following settings are applicable for Application Pool Identities:
Application Pool Identity

Permission Level

LocalService

LOCAL SERVICE

LocalSystem

SYSTEM

NetworkService

NETWORK SERVICE

ApplicationPoolIdentity

Provide the group level permissions for
IIS_IUSRS Group
(see the screenshot given below).

Custom Account

Provide the exact name of the account.

For example, if your application has the identity "ApplicationPoolIdentity", you must provide the
permissions for "IIS_IUSRS" group to your Agent's directory.
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Learn More

Install the .NET Agent

Configure AppDynamics for .NET
Enable Thread Correlation for .NET
Enable Correlation for .NET Remoting
Configure Backend Detection for .NET
Configure Business Transaction Detection for .NET
Configure Application Domain Monitoring
Instrument the DefaultDomain for Standalone Applications
Identify MVC Transactions by Controller and Action
Getter Chains in .NET Configurations
Enable Monitoring for Windows Performance Counters
Configure the .NET Machine Agent
Enable Instrumentation for WCF Data Services
Configure Machine Snapshots for .NET
Configure Multiple Business Application Support for .NET
Enable Thread Correlation for .NET
To enable thread correlation for .NET applications
To enable thread correlation in prior versions of the .NET Agent
Learn More
The AppDynamics .NET Agent supports multi-threaded correlation for the following patterns:
Thread.Start on the Common Language Runtime (CLR) 2.x and CLR 4.x
ThreadPool.QueueUserWorkItem on the Common Language Runtime (CLR) 2.x and CLR
4.x
TaskFactory.FromAsync
These instructions apply to the .NET Agent 3.9.2 and later. For version 3.9.0 and 3.9.1, see below.
To enable thread correlation for .NET applications

Configure all instrumentation settings for the .NET Agent in the config.xml file. See Where to
Configure App Agent Properties.
1. Launch a text editor as administrator.
2. Edit the config.xml file as an administrator. See Where to Configure App Agent Properties.
3. Copy the code block below to a child element of the Machine Agent element. (See Machine
Agent Element):
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<instrumentation>
<instrumentor name="ThreadCorrelationThreadPoolCLR2Instrumentor"
enabled="true"/>
<instrumentor name="ThreadStartCLR2Instrumentor" enabled="true"/>
<instrumentor name="ThreadStartCLR4Instrumentor" enabled="true"/>
<instrumentor name="TaskFactoryFromAsyncInstrumentor" enabled="true"/>
</instrumentation>

For example:
<?xml version="1.0" encoding="utf-8"?>
<appdynamics-agent xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
...
<machine-agent>
<!--Enable thread correlation-->
<instrumentation>
<instrumentor name="ThreadCorrelationThreadPoolCLR2Instrumentor"
enabled="true"/>
<instrumentor name="ThreadStartCLR2Instrumentor" enabled="true"/>
<instrumentor name="ThreadStartCLR4Instrumentor" enabled="true"/>
<instrumentor name="TaskFactoryFromAsyncInstrumentor" enabled="true"/>
</instrumentation>
</machine-agent>
...
</appdynamics-agent>

4.
5.
6.
7.

The configuration syntax is enabled="true".
The agent enables the instrumentor for ThreadPool.QueueUserWorkItem on the CLR 4
by default without changes to the XML.
Save the config.xml file.
Enable the thread-correlation node property.
Restart the AppDyanmics.Agent.Coordinator Service.
Restart instrumented applications for your changes to take effect.

To enable thread correlation in prior versions of the .NET Agent

Click to expand for instructions exclusive to 3.9.0 and 3.9.1.
AppDynamics supports instrumentation for Thread.Start and ThreadPool.QueueUserWorkItem
on the Common Language Runtime (CLR) 2.x and CLR 4.x.
Configure all instrumentation settings for the .NET Agent in the config.xml file. See Where to
Configure App Agent Properties.
1. Launch a text editor as administrator.
2. Edit the config.xml file as an administrator. See Where to Configure App Agent
Properties.
3. Copy the code block below to a child element of the Machine Agent element. (See Machi
ne Agent Element):
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3.

<instrumentation>
<instrumentor
name="ThreadCorrelationThreadPoolCLR2Instrumentor" enabled="true"/>
<instrumentor name="ThreadStartCLR2Instrumentor"
enabled="true"/>
<instrumentor name="ThreadStartCLR4Instrumentor"
enabled="true"/>
</instrumentation>

For example:
<?xml version="1.0" encoding="utf-8"?>
<appdynamics-agent
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
...
<machine-agent>
<!--Enable thread correlation-->
<instrumentation>
<instrumentor
name="ThreadCorrelationThreadPoolCLR2Instrumentor" enabled="true"/>
<instrumentor name="ThreadStartCLR2Instrumentor"
enabled="true"/>
<instrumentor name="ThreadStartCLR4Instrumentor"
enabled="true"/>
</instrumentation>
</machine-agent>
...
</appdynamics-agent>

4.
5.
6.
7.

The configuration syntax is enabled="true".
Save the config.xml file.
Enable the async-tracking node property.
Restart the AppDyanmics.Agent.Coordinator Service.
Restart instrumented applications for your changes to take effect.

Learn More

Configure Backend Detection for .NET
Monitor Remote Services
Enable Correlation for .NET Remoting
Instrumenting Applications That Use .NET Remoting
To enable correlation for .NET remoting
To specify an agent trigger
Learn More
Developers use .NET remoting to build distributed applications that share objects across
processes or across application domains running in the same process. AppDynamics
doesn't enable correlation for .NET remoting functions by default.
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Instrumenting Applications That Use .NET Remoting

You can configure the .NET Agent to discover .NET remoting entry and exit points.
To enable correlation for .NET remoting

1. Launch a text editor as administrator.
2. Edit the config.xml file as an administrator. See Where to Configure App Agent
Properties.
3. Copy the code block below to a child element of the Machine Agent element. (See Ma
chine Agent Element):
<instrumentation>
<instrumentor name="RemotingMscorlibEntryInstrumentor"
enabled="true"/>
<instrumentor name="RemotingExitInstrumentor"
enabled="true"/>
</instrumentation>

For example:
<?xml version="1.0" encoding="utf-8"?>
<appdynamics-agent
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
...
<machine-agent>
<!--Enable correlation for .NET remoting-->
<instrumentation>
<instrumentor name="RemotingMscorlibEntryInstrumentor"
enabled="true"/>
<instrumentor name="RemotingExitInstrumentor"
enabled="true"/>
</instrumentation>
</machine-agent>
...
</appdynamics-agent>

4. Save the config.xml file.
5. Restart the AppDyanmics.Agent.Coordinator Service.
6. Restart instrumented applications for your changes to take effect.
If the agent doesn't discover the entry points after configuration, specify an agent trigger.
To specify an agent trigger

.NET remoting entry point functions execute in low-level .NET libraries that may not trigger
automatic agent instrumentation. If the agent doesn't discover the .NET remoting entry
points after configuration you can specify a function that triggers the agent to begin
instrumentation.
1. Identify a function to trigger the agent to begin instrumentation. The function can be
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1.
any function that executes as part of the application process.
For example, consider the following code for a MovieTicket remoting object. In this
case, use the function GetTicketStatus to trigger the agent.
using System;
namespace MovieGoer
{
public class MovieTicket : MarshalByRefObject
{
public MovieTicket()
{
}
public string GetTicketStatus(string stringToPrint)
{
return String.Format("Enquiry for {0} -- Sending back
status: {1}", stringToPrint, "Ticket Confirmed");
}
}
}

2. Edit the config.xml file as an administrator. See Where to Configure App Agent
Properties.
3. Update the Instrumentation element to include the AgentTriggerInstrumentor. (See Ma
chine Agent Element):
<instrumentation>
<instrumentor name="AgentTriggerInstrumentor" enabled="true"
args="" />
<instrumentor name="RemotingMscorlibEntryInstrumentor"
enabled="true"/>
<instrumentor name="RemotingExitInstrumentor"
enabled="true"/>
</instrumentation>

4. Set the AgentTriggerInstrumentor args value to the name of the trigger function from
step 1.
For example:
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<?xml version="1.0" encoding="utf-8"?>
<appdynamics-agent
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
...
<machine-agent>
<!--Enable correlation for .NET remoting-->
<instrumentation>
<instrumentor name="AgentTriggerInstrumentor" enabled="true"
args="MovieGoer.MovieTicket.GetTicketStatus" />
<instrumentor name="RemotingMscorlibEntryInstrumentor"
enabled="true"/>
<instrumentor name="RemotingExitInstrumentor"
enabled="true"/>
</instrumentation>
</machine-agent>
...
</appdynamics-agent>

5. Save the config.xml file.
6. Restart instrumented applications for your changes to take effect.

Learn More

Configure Backend Detection for .NET
Monitor Remote Services
Configure Backend Detection for .NET
Types of Exit Points
View the Discovery Rules
Revise Backend Discovery Rules
Change the Default Discovery Rules
Add Backend Discovery Rules
Add Custom Exit Points
Propagate Changes to Other Tiers or Applications
Learn More
To review general information about monitoring databases and remote services (collectively
known as backends) and for an overview of backend configuration see Backend Monitoring.
Types of Exit Points

Each automatically discovered backend type has a default discovery rule and a set of configurable
properties. See the following:
WCF Exit Points for .NET
Message Queue Exit Points for .NET
ADO.NET Exit Points
HTTP Exit Points for .NET
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Web Services Exit Points for .NET
Configure Custom Exit Points for .NET
For information on All Other Traffic transactions, see Backend Monitoring.

View the Discovery Rules

To view the discovery rules for an automatically discovered backend, access the backend
configuration screen using these steps:
1.
2.
3.
4.

Click the application or tier.
In the left navigation pane, click Configure -> Instrumentation.
Click the Backend Detection tab.
Click the .NET - Backend Detection tab.

The .NET - Backend Detection tab lists the default configurations for Automatic Backend
Discovery
5. In the Automatic Backend Discovery list, click the backend type to view.
A configuration summary appears on the right.
For example, AppDynamics enables automatic discovery for HTTP backends by default and
names them for the host and port.

Revise Backend Discovery Rules

If the default settings don't give you exactly what you need, you can refine the configuration in the
following ways:
Change the default discovery rules:
Enable or disable one or more of the properties
Use one or more specified segments of a property
Run a regular expression on a property
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Execute a method on a property
Add new discovery rules
Add custom exit points
The precise configurations vary according to the backend type. These general features are
configurable:
Discovery Enabled - You can enable and disable automatic discovery for the backend type.
Undiscovered backends are not monitored.
Correlation Enabled - You can enable and disable correlation. Correlation enables
AppDynamics to tag, trace, and learn about application calls to and through the backend to
other remote services or tiers. For example, if a call is made from Tier1 -> Backend1 ->
Tier2, Tier2 knows about the transaction flow because the agent "tags" the outbound call
from Backend1 to identify it as related to the same transaction that called Backend1 from
Tier1. If you do not care about activity downstream from the backend, you may want to
disable correlation.
Backend Naming - You can configure how backends are named.
Change the Default Discovery Rules

When you need to revise the default set of discovery rules, in many cases, you can achieve the
visibility you need by making adjustments to the default automatic discovery rules. For some
scenarios, you might want to disable some or all of the default rules and create custom rules for
detecting all your backends. AppDynamics provides flexibility for configuring backend detection.
For example, detection of HTTP backends is enabled by default. In Java environments, HTTP
backends are identified by the host and port and correlation with the application is enabled. To
change the discovery rule for HTTP backends in some way, such as disabling correlation, omitting
a property from the detected name, or using only certain segments of a property in the name, you
edit the HTTP automatic discovery rule.
Review the rules for each exit point to determine the best course of action for your application if
the default discovery rules do not give the results you need for your monitoring strategy.
To change default backend automatic discovery rules

1. From the left-hand navigation panel, select Configure -> Instrumentation. Then select the Bac
kend Detection tab and the application or tier you want to configure.
2. In the Automatic Backend Discovery list, select the backend type to modify.
The rule summary appears in the Automatic Discovery panel on the right.
3. Click Edit Automatic Discovery.
The Edit Automatic Backend Discovery Rule window appears.
4. For each property that you want to configure:
Select the property in the property list.
Check the property check box to use the property for detection; clear the check box to omit
it.
If you are using the property, choose how the property is used from the drop-down list.
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If you have a complex property, such as the URL, destination, or a query string, and you
want to eliminate some parts of it or need some additional manipulation you can use an
option from the second drop-down list such as Run a Regular Expression on it or Execute
methods on it (getter chain). Each option has associated configuration parameters. For
example, you have options for manipulating the segments of the URL.

5. Check Enabled to enable the rule; clear the check box to disable it.
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6. Check Correlation Enabled to enable correlation.
7. Click OK.
Add Backend Discovery Rules

AppDynamics provides the additional flexibility to create new custom discovery rules for the
automatically discovered backend types. Custom rules include the following settings:
Name for the custom rule.
Priority used to set precedence for custom rules.
Match Conditions used to identify which backends are subject to the custom naming rules.
Backend Naming Configuration used to name the backends matching the match
conditions.
The window for adding custom discovery rules looks like this:

To create a custom discovery rule for an automatically discovered backend type, use these steps:

1. In the Automatic Backend Discovery list, select the backend type.
The Custom Discovery Rules editor appears in the right panel below the Automatic Discovery
panel.
2. Click Add (the + icon) to create a new rule or select an existing rule from the list and click the
edit icon to modify one.
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3. Enter a name for the custom rule.
4. Confirm the settings for Enabled and Correlation Enabled (if applicable).
4. Enter the priority for the custom rule compared to other custom rules for this backend type. The
higher the number, the higher the priority. A value of 0 (zero) indicates that the default rule should
be used.
5. In the next section, configure the match conditions.
Match conditions are used to identify which backends should use the custom rule. Backends that
do not meet all the defined match conditions are discovered according to the default rule.
7. In the next section, configure the naming for the backends matching the rule. The naming
configuration must include the property used by the match condition.
8. Save the configuration.
See specific exit points for examples.
Add Custom Exit Points

When your application has backends that are not automatically discovered, you can enable
discovery using custom exit points. To do this, you need to know the class and method used to
identify the backend. See Configure Custom Exit Points for Java.
Propagate Changes to Other Tiers or Applications

When you have made changes to the backend detection rules, you may want to propagate your
changes to other tiers or applications.
To copy an entire backend detection configuration to all tiers

1. Access the backend detection window. See View the Discovery Rules.

Copyright © AppDynamics 2012-2014

Page 1501

2. In the left panel select the application or tier whose configuration you want to copy.
3. Click Configure all Tiers to use this Configuration.
To copy an entire backend detection configuration to another tier or application

1. Access the backend detection window. See View the Discovery Rules.
2. In the left panel select the application or tier whose configuration you want to copy.
3. Click Copy.
4. In the Application/Tier browser, choose the application or tier to copy the configuration to.
5. Click OK.
Learn More

Backend Monitoring
Monitor Databases
Monitor Remote Services
WCF Exit Points for .NET

Auto-Discovery and Default Naming
Configurable Properties
Changing the Default WCF Automatic Discovery and Naming
Learn More
This topic explains WCF exit point configuration. To review general information about monitoring
databases and remote services (collectively known as backends) and for an overview of backend
configuration see Backend Monitoring.
Auto-Discovery and Default Naming

By default, AppDynamics automatically detects and identifies WCF exit points (backends) when an
application uses the WCF client libary.
The default WCF automatic discovery rule uses the remote address property. From the enabled
properties AppDynamics derives a display name using the remote address, for example:

By default, AppDynamics groups multiple backends of the same type together on the application

Copyright © AppDynamics 2012-2014

Page 1502

flow map.
The backend properties for the WCF backend can be viewed on the Remote Services dashboard.

Configurable Properties

Configurable Properties

Property Used by Default
in Detection and Naming

Description

Remote Address

Yes

URL minus the query,
fragment and user information
(name and password)

Operation Contract

No

WCF operation name

URL

No

full URL

Host

No

host portion of URL

Port

No

port number if present in the
URL, otherwise protocol
default

SOAP Action

No

In the case that a web service
is called, the SOAP action

Changing the Default WCF Automatic Discovery and Naming

Depending on what you need to monitor, you can change the default configuration to use other
properties.
For procedures, see Configure Backend Detection for .NET.
Learn More

Backend Monitoring
Monitor Remote Services
Configure Custom Exit Points
Message Queue Exit Points for .NET

Auto-Discovery and Default Naming
Queues Configurable Properties
Changing the Default Queues Automatic Discovery and Naming
Learn More
This topic explains exit point configuration for message queue exit points. To review general
information about monitoring databases and remote services (collectively known as backends) and
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for an overview of backend configuration see Backend Monitoring.
Auto-Discovery and Default Naming

By default, AppDynamics automatically detects and identifies many message queue exit points.
For a list of the supported message-oriented middleware products, see Supported Remote Service
Detection for .NET.
The default queue automatic discovery rule uses the destination property. From the enabled
properties AppDynamics derives a display name as shown here:

By default, AppDynamics groups multiple backends of the same type together on the application
flow map.
The backend properties for the queue can be viewed on the Remote Server dashboard.

Queues Configurable Properties

In general, the properties listed below are used for queue exit points. However, each
message-oriented product is different and there may be variations in the properties or their names.
Configurable Properties

Property Used by Default
in Detection and Naming

Description

Host

No

Queue server name

Destination

Yes

Name of topic or queue

Destination Type

No

queue or topic

Vendor

No

Vendor from the client library
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Note
For MSMQ, correlation for downstream calls is not supported.
For .NET remoting, additional configuration is needed to get downstream correlation. See
Enable Correlation for .NET Remoting.
Changing the Default Queues Automatic Discovery and Naming

Depending on what you need to monitor, you can change the default configuration by disabling
one or more properties.
For configuration procedures, see Configure Backend Detection for .NET.
Learn More

Backend Monitoring
Monitor Remote Services
Enable Correlation for .NET Remoting
Configure Custom Exit Points
Monitor RabbitMQ Backends for .NET

Remote Service Detection
Exit Points
Backend Naming
To refine backend naming
Entry Points
BasicGet Method
HandleBasicDeliver Method
Learn More
The .NET Agent (agent) automatically discovers RabbitMQ remote services. This topic covers the
methods we instrument for RabbitMQ backends and the backend naming convention.
Remote Service Detection

AppDynamics auto-detects RabbitMQ backends based upon calls from instrumented tiers.
RabbitMQ exit points are methods that publish or push messages to a queue. RabbitMQ entry
points are methods that listen or poll for new messages in the queue.
To see RabbitMQ in the list of backends, in the left navigation pane click Servers->Remote
Services.
Exit Points

The agent discovers a RabbitMQ backend exit point when your application sends a message to
the queue using the BasicPublish() method.
Backend Naming

By default, the agent names the RabbitMQ backend for the exchange parameter of the BasicPub
lish() method.
For example:
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model.BasicPublish("MyExchange", "", false, false,
basicProperties, Encoding.UTF8.GetBytes(message));

In this case the agent names the queue MyExchange.

You can refine the backend name to include some or all segments of the routing key. To configure
RabbitMQ naming you must be familiar with your implementation RabbitMQ exchanges and
routing keys. See RabbitMQ Exchanges and Exchange Types.
To refine backend naming
Register the rmqsegments node property. For instructions on how to set a node property, see Ap
p Agent Node Properties.
Name: rmqsegments
Description: "Configure RabbitMQ naming to include routing key segments."
Type: Integer
Value: <integer>
The routing key is a string. The agent treats dot-separated (".") substrings of the routing key as
segments. Set the value to an integer that represents the number of routing key segments to
include in the name.
In the following example the routing key is abc.def.ghi. Set the rmqsegments value to "2" to name
the queue MyExchange.abc.def.
model.BasicPublish("MyExchange", "abc.def.ghi", false, false,
basicProperties, Encoding.UTF8.GetBytes(message));

After you save the node property, the Controller sends the configuration to the agent. After some
time the RabbitMQ backend shows up with the new name.
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Entry Points

The agent discovers RabbitMQ backend entry point when your application polls the the queue.
AppDynamics auto-detects RabbitMQ based upon the following patterns:
BasicGet
HandleBasicDeliver
BasicGet Method

The agent detects the pattern below where the application periodically polls the message queue
using the BasicGet() method. The call timing is limited to time spent inside the while loop. The
timer only starts when the BasicGet result returns a value at line 4. The timer ends when the next
BasicGet executes. In this example, the application polls every five seconds, so the execution time
equals the time in the if loop plus five seconds.
while (true)
{
var result = channel.BasicGet("MyExchange", true);
if (result != null)
{
var body = result.Body;
var message = Encoding.UTF8.GetString(body);
Console.WriteLine("Received: {0}.", message);
}
Thread.Sleep(5000);
}

HandleBasicDeliver Method

The agent detects the HandleBasicDeliver() method for custom implementations of the IBas
icConsumer interface. In this case the call timing reflects the execution time for the
HandleBasicDeliver method.
Learn More

RabbitMQ Exchanges and Exchange Types
RabbitMQ Monitoring Extension
App Agent Node Properties
App Agent Node Properties Reference by Type
ADO.NET Exit Points

Auto-Discovery and Default Naming
Configurable Properties
Changing the Default ADO.NET Automatic Discovery and Naming
Examples
Different ADO.NET Providers
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Learn More
This topic explains ADO.NET exit point configuration. To review general information about
monitoring databases and remote services (collectively known as backends) and for an overview
of backend configuration see Backend Monitoring.
Auto-Discovery and Default Naming

ADO.NET data providers implementing standard Microsoft interfaces are automatically discovered
as backends. For a complete list, see Supported ADO.NET Clients for the .NET Agent.
Because the ADO.NET API is interface-based, by default AppDynamics instruments all ADO.NET
database providers that implement these interfaces.
For database identification, AppDynamics uses information from the ADO.NET connection string.
The connection string specifies the server address and schema or the local file name. Most
connection strings are formatted according to well-known rules that can be parsed and distilled to
a database name. However, because there is no standard on the connection string, it is up to the
ADO.NET provider implementer to choose the format.
For some providers, AppDynamics may fail to parse the connection string. In these cases, the
.NET agent uses the complete connection string minus any user password. The property is labeled
ADO.NET connection string and the value shows the connection string minus any user
password.

The backend properties can be viewed on the Database Dashboard.

Copyright © AppDynamics 2012-2014

Page 1508

Configurable Properties

You can enable or disable the use of the following properties for ADO.NET exit points.
Configurable Properties

Property Used by Default
in Detection and Naming

Description

Host

Yes

Data source or database
server. Labeled Data Source
on the Backend Dashboard.

Database

Yes

Database

Vendor

No

Type of the client-side
ADO.NET library. Labeled Pro
vider type on the Backend
Dashboard

Connection String

No

Full connection string with
password filtered out

Port

No

Port number. This is seldom
used to identify ADO.NET
databases.

Changing the Default ADO.NET Automatic Discovery and Naming

There may be times when you want to change the default configuration depending on exactly what
you need to monitor. For example, when you have multiple databases on the same server, you
may need to revise the automatic discovery rule. Doing this enables you to more effectively
monitor the key performance indicators (KPIs) that are of most interest to you.
For configuration procedures, see Configure Backend Detection for .NET.
Examples
Different ADO.NET Providers

If you have different ADO.NET providers connecting to a single Oracle database, you might be
using both the Microsoft implementation of ADO.NET and the Oracle client, ODP.NET. In this
case, you could enable the Vendor property to split the single Oracle backend into two separate
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backends.
Learn More

Backend Monitoring
Monitor Remote Services
Configure Custom Exit Points
HTTP Exit Points for .NET

Automatic Discovery and Default Naming
HTTP Configurable Properties
Changing the Default HTTP Automatic Discovery and Naming
Learn More
This topic explains HTTP exit point configuration for .NET. To review general information about
monitoring databases and remote services (collectively known as backends) and for an overview
of backend configuration see Backend Monitoring.
Automatic Discovery and Default Naming

By default, AppDynamics automatically detects and identifies HTTP exit points (backends) that
use the Microsoft HTTP client.
The default HTTP automatic discovery rule uses the URL property. From the enabled properties
AppDynamics derives a display name using the URL, for example:

By default, AppDynamics groups backends of the same type together on the application flow map.
HTTP Configurable Properties

You can enable or disable the use of the following properties for HTTP exit points.
Type

Configurable Properties

Property Used by Default
in Detection and Naming

HTTP

Host

No

Port

No
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URL

Yes

Query String

No

Changing the Default HTTP Automatic Discovery and Naming

Depending on exactly what you need to monitor, there may be times when you want to change the
default HTTP configuration. Review HTTP Exit Points (Java) for examples.
For configuration procedures, see Configure Backend Detection for .NET.
Learn More

Backend Monitoring
Monitor Remote Services
Configure Custom Exit Points
Web Services Exit Points for .NET

Auto-Discovery and Default Naming
Configurable Properties
Changing the Default WCF Automatic Discovery and Naming
Learn More
This topic explains Web Services exit point configuration for .NET. To review general information
about monitoring databases and remote services (collectively known as backends) and for an
overview of backend configuration see Backend Monitoring.
Auto-Discovery and Default Naming

By default, AppDynamics automatically detects and identifies web services exit points (backends)
when an application uses the Microsoft Web Services client library.
The default web services automatic discovery rule uses the URL property. From the enabled
properties AppDynamics derives a display name using the URL, for example:

By default, AppDynamics groups multiple backends of the same type together on the application
flow map.
The backend properties for the web services backend can be viewed on the Remote Services
dashboard.
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Configurable Properties

Configurable Properties

Property Used by Default
in Detection and Naming

Service

No

URL

Yes

Operation

No

Soap Action

No

Changing the Default WCF Automatic Discovery and Naming

Depending on exactly what you need to monitor, there may be times when you want to change the
default configuration. In most cases, you can generate the right name and the correct number of
backends to monitor by editing the automatic discovery rule.
For configuration procedures, see Configure Backend Detection for .NET.
Learn More

Backend Monitoring
Monitor Remote Services
Configure Custom Exit Points
Configure Custom Exit Points for .NET

Default Backends Discovered by the .NET Agent
Configure Custom Exit Points for .NET Backends
To create a custom exit point
To split an exit point
To group an exit point
To define custom metrics for a custom exit point
To define transaction snapshot data collected
Learn More
AppDynamics provides default automatic discovery for commonly-used backends. If a backend
used in your environment is not discovered:
Compare the list of default backends.
If the backend is listed, but the agent doesn't discover it, modify the default configuration
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OR
If the backend isn't listed, then configure a custom exit point according to these instructions.
Default Backends Discovered by the .NET Agent

For a list of supported backends see Remote Service Detection.
For instructions on modifying default backend discovery see Configure Backend Detection for
.NET.
Configure Custom Exit Points for .NET Backends

Use custom exit points to identify backend types that are not automatically detected, such as file
systems, mainframes, and so on. For example, you can define a custom exit point to monitor the
file system read method. After you have defined a custom exit point, the backend appears on the
flow map with the type-associated icon you selected when you configured the custom exit point.
You define a custom exit point by specifying the class and method used to identify the backend. If
the method is overloaded, you need to add the parameters to identify the method uniquely.
You can restrict the method invocations for which you want AppDynamics to collect metrics by
specifying match conditions for the method. The match conditions can be based on a parameter or
the invoked object.
You can also optionally split the exit point based on a method parameter, the return value, or the
invoked object.
You can also configure custom metrics and transaction snapshot data to collect for the backend.
To create a custom exit point

1. From the left navigation pane, click Configure -> Instrumentation and select the Backend
Detection tab.
2. Select the application or tier for which you are configuring the custom exit point.
3. Ensure Use Custom Configuration for this Tier is selected.
Backend detection configuration is applied on a hierarchical inheritance model. See Hierarchical
Configuration Model.
4. Scroll down to Custom Exit Points and click Add (the + icon).
5. In the Create Custom Exit Point window, click the Identification tab if it is not selected.
6. Enter a name for the exit point. This is the name that identifies the backend.
7. Select the type of backend from the Type drop-down menu.
This field controls the icon and name that appears on the flow maps and dashboards. Some of the
values are shown in this screen shot:

Copyright © AppDynamics 2012-2014

Page 1513

If the type is not listed, you can check Use Custom and enter a string to be used as the name on
the dashboards.
8. Configure the class and method name that identify the custom exit point.
If the method is overloaded, check the Overloaded check box and add the parameters.
9. If you want to restrict metric collection based on a set of criteria that are evaluated at runtime,
click Add Match Condition and define the match condition(s).
For example, you may want to collect data only if the value of a specific method parameter
contains a certain value.
10. Click Save.
The following screenshot shows a custom exit point for a Cache type backend. This exit point is
defined on the getAll() method of the specified class. The exit point appears in flow maps as an
unresolved backend named CoherenceGetAll.
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To split an exit point

1. In the Backend Detection configuration window, click Add.
2. Enter a display name for the split exit point.
3. Specify the source of the data (parameter, return value, or invoked object).
4. Specify the operation to invoke on the source of the data: Use toString() or Use Getter Chain (
for complex objects).
5. Click Save.
The following example shows a split configuration of the previously created CoherenceGetAll exit
point based on the getCacheName() method of the invoked object.
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To group an exit point

You can group methods as a single exit point if the methods point to the same key.
For example, ACME Online has an exit point for NamedCache.getAll. This exit point has a split
configuration of getCacheName() on the invoked object as illustrated in the previous screen shot.
Suppose we also define an exit point for NamedCache.entrySet. This is another exit point, but it
has the split configuration that has getCacheName() method of the invoked object.
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If the getAll() and the entrySet() methods point to the same cache name, they will point to the
same backend.
Matching name-value pairs identify the back-end. In this case, only one key, the cache name, has
to match. So, here both exit points have the same name for the cache and they resolve to the
same backend.
To define custom metrics for a custom exit point

Custom metrics are collected in addition to the standard metrics.
The result of the data collected from the method invocation must be an integer value, which is
either averaged or added per minute, depending on your data roll-up selection.
To configure custom business metrics that can be generated from the Java method invocation:
1. Click the Custom Metrics tab.
2. Click Add.
3. In the Add Custom Metric window type a name for the metric.
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4. Select Collect Data From to specify the source of the metric data.
5. Select Operation on Method Parameter to specify how the metric data is processed.
6. Select how the data should be rolled up (average or sum) from the Data Rollup drop-down
menu.
7. Click Create Custom Metric.
To define transaction snapshot data collected

1. Click the Snapshot Data tab.
2. Click Add.
3. In the Add Snapshot Data window, enter a display name for the snapshot data.
4. Select the Collect Data From radio button to specify the source of the snapshot data.
5. Select the Operation on Method Parameter to specify how the snapshot data is processed.
5. Click Save.
Learn More

Backend Monitoring
Monitor Remote Services
Monitor Databases
Configure Business Transaction Detection for .NET
.NET Entry Points
To create custom match rules for .NET entry points
Learn More
This topic introduces .NET entry points and the way that they are used in business transaction
detection. If the auto-discovered entry points don't include all your critical business transactions,
use custom match rules to customize entry point discovery.
.NET Entry Points

AppDynamics detects entry points in the following places:
On originating tiers, the method or operation that marks the beginning of a business
transaction is an entry point. In most cases, this type of entry point maps to a user request
or action such as "View/Cart". Entry points on originating tiers define the business
transaction name.
On downstream tiers, entry points correlate to incoming http calls, web service requests,
and other communications from instrumented tiers.
The .NET Agent (agent) automatically detects entry points for the frameworks listed as automatical
ly discovered business transactions. See Supported Environments and Versions (.NET).
If the agent detects an entry point on the originating tier, it registers a business transaction with the
Controller. The Controller displays the business transaction in the Business Transactions List. If an
entry point correlates to an upstream exit point, such as an exiting service call, the agent includes
it as part of the existing business transaction.
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If you need to monitor transactions not automatically discovered by the App Agent for .NET, you
can customize entry point detection. See Organizing Traffic as Business Transactions to learn how
to plan your business transactions. After you have identified the critical business transactions for
your application, create custom match rules for them to enable transaction detection.
To create custom match rules for .NET entry points

1. Click Configure > Instrumentation > Transaction Detection.
2. Click the .NET - Transaction Detection tab.
3. From the Select Application or Tier list at the left, click either:
an application, to configure transaction detection for all tiers in a business application.
a tier, to configure transaction detection at the tier level. At the tier level click Use Custom
Configuration for this Tier. AppDynamics copies the application configuration to the tier
level so that you can modify it for the tier.
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4. Use the Custom Match Rules pane to add and remove business transaction match rules.
For details on types of .NET entry points and how to setup
custom match rules, see:
ASP.NET Entry Points
Message Queue Exit Points
POCO (.NET Class/Method) Entry Points
WCF Entry Points
Web Service Entry Points

Learn More

Web Entry Points
Configure Business Transaction Detection
Organizing Traffic as Business Transactions
POCO Entry Points

Defining a POCO Entry Point
Discovery of POCO Transactions
To specify a POCO custom match rule
POCO Transaction as a Background Task
Learn More
Some applications use frameworks other than ones the .NET Agent auto-detects. This is
frequently the case with Windows services and standalone applications. AppDynamics lets you
specify entry points using custom match rules for Plain Old CLR Objects (POCOs). Once you've
defined POCOs, we measure performance data for POCO transactions the same as for other
transactions.
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Define the custom match rule on the .NET class/method that is the most appropriate entry point for
the business transaction (BT). Someone who is familiar with your application code should help
make this determination.
Defining a POCO Entry Point

On an originating tier, a POCO entry point is the method that starts the BT. If the POCO entry
point is on a downstream tier, it may correlate to an upstream exit point. When defining a POCO
entry point, it is important to choose a method that begins and ends every time the BT executes.
For more on entry points, see Monitor Business Transactions.
Good candidates for POCO entry points include the following:
A timer in a Windows service that executes a database call to check for new records to
process. For example, an order processing system that periodically checks for new orders in
the system.
A loop in a standalone application that batch processes records via a web service call. For
example, an expense reporting system that loops through approved expenses to submit
them for reimbursement.
A method in a web application that executes every time a client connects. For example,
consider the method execution sequence:
using System.Net;
using System.Net.Sockets;
using System.Threading.Tasks;
namespace MyService
{
class MyProgram
{
static void Main(string[] args)
{
TcpListener myList = new TcpListener(IPAddress.Parse("127.0.0.1"),
8000);
using (Socket s = myList.AcceptSocket())
Task.Factory.StartNew(DoWork, s);
}
static void DoWork<Socket>(Socket s)
{
// ...
}
}
}

The AcceptSocket() method is the blocking method that accepts a job and invokes it. The MyP
rogram.DoWork() method is the unit of work because it executes every time a client calls the
business transaction and it finishes at the same time as the business transaction. This makes DoW
ork() a good POCO entry point.
Discovery of POCO Transactions
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By default, once you configure a custom match rule for a POCO entry point, the .NET
Agent detects and displays it in the Business Transactions List. AppDynamics names the BT for
the name of the custom match rule. For more information, see Configure Business Transaction
Detection.
To specify a POCO custom match rule

To set up a POCO entry point, define a custom match rule for a .NET Class/Method.
For steps to access the Custom Match Rules pane, see To create custom match rules for .NET
entry points.
1. In the Custom Match Rules pane, click the plus symbol (+) to add an entry point.
2. Click .NET Class/Method in the dropdown list, then click Next.
3. Name the New Business Transaction Match Rule.
AppDynamics uses the rule Name to name the BT.
The Controller enables the rule by default. Disable it later if needed.
The POCO is a foreground task, to configure it as a background task, see POCO
Transaction as a Background Task.
4. In the Transaction Match Criteria tab, specify the Match Classes criteria.
5. Specify the Method Name match criteria.

6.
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6. Click Create Custom Match Rule. If you are configuring at the application level, click Config
ure all Tiers to use this Configuration.
7. Click OK to the notification message Instrumentation changes require restart.
After you save the rule, it appears in the Custom Match Rule list. The business application
or tier you customized displays a green check in the Select Application or Tier pane.

8. Wait one minute and restart the CLR/application.
The next time the POCO method executes, the agent detects it and registers the entry point.
If the entry point is on an originating tier, the Controller displays it as a business transaction in
the Business Transactions List.

The agent identifies all the qualifying transactions using the custom match rule. In some
situations you may need to further refine the discovery rules. Use the splitting options on the T
ransaction Splitting tab.
If you create an application-level POCO that applies to a tier that has not yet registered with the
Controller, you may need to restart the application after the tier registers in order to see the
business transaction.
POCO Transaction as a Background Task

Click the Background Task check box in the Business Transaction Match Rule window to
indicate that a POCO transaction runs in the background.
When a request runs as a background task, AppDynamics reports only Business Transaction
metrics for the request. It does not aggregate response time and call metrics at the tier and
application levels for background tasks. This prevents background tasks from distorting baselines
for the business application. Also, you can set a separate set of thresholds for background tasks.
See Monitor Background Tasks.
Learn More
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Monitor Background Tasks
Configure Business Transaction Detection
Business Transactions List
ASP.NET Entry Points

Default Automatic Naming for ASP.NET Transactions
Customize the Automatic Naming Scheme
To modify automatic naming
Identify Transactions Using URI Segments
To name transactions using all, first, or last URI segments
To use specific URI segments in transaction names
Identify Transactions Using Headers, Cookies, and Other Parts of HTTP Requests
To use HTTP parameter values in transaction names
To use a header value in transaction names
To use a cookie value in transaction names
To use a session attribute value in transaction names
To use the request method in Transaction names
To use the request host in Transaction names
To use the request originating address in Transaction names
To use a custom expression on the HttpRequest
Custom Match Rules for ASP.NET Transactions
To create an ASP.NET custom match rule
To split custom ASP.NET transactions
Learn More

AppDynamics automatically detects entry points for client requests to ASP.NET applications. If the
request occurs on an originating tier, the method or operation marks the beginning of a business
transaction and defines the transaction name. In most cases, this type of entry point maps to a
user request or action such as "Cart/Checkout". AppDynamics allows you to configure transaction
naming based upon the ASP.NET request.
Default Automatic Naming for ASP.NET Transactions

By default, the AppDynamics auto-detection naming scheme identifies all ASP.NET transactions
using the first two segments of the URI.
For example, the following URI represents the checkout operation in an online store:
http://example.com/Cart/Checkout
AppDynamics automatically names the transaction:
/Cart/Checkout
For another example, the following URI represents a funds transfer operation in an online bank:
http://webbank.mybank.com/Account/Transferfunds/NorthernCalifornia
AppDynamics automatically names the transaction:
/Account/Transferfunds
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Customize the Automatic Naming Scheme

AppDynamics lets you customize the auto-detected naming scheme to best fit your environment:
Identify transactions using URI segments
Identify transactions using headers, cookies, and other parts of HTTP requests
To modify automatic naming

1. Click Configure > Instrumentation > Transaction Detection.
2. Click the .NET - Transaction Detection tab.
3. From the Select Application or Tier list at the left, click either:
an application to configure transaction detection for all tiers in a business application.
a tier. At the tier level click Use Custom Configuration for this Tier. AppDynamics
copies the application configuration to the tier level so that you can modify it for the
tier.
4. If necessary, click Enabled under Transaction Monitoring and Discover Transactions
automatically for ASP.NET requests.
You can configure naming with Discover Transactions automatically for ASP.NET
requests disabled, but the agent doesn't discover ASP.NET transactions.
5. Click Configure Naming for the ASP.NET type in the in the Entry Points panel.
6. Change the naming scheme in the ASP.NET Transaction Naming Configuration window and
click Save.
The following sections provide examples to help you decide how to configure the naming scheme.
Identify Transactions Using URI Segments

AppDynamics offers the following options to automatically name ASP.NET transactions based
upon the URI:
Use all, first, or last URI segments
Use specific URI segments
To name transactions using all, first, or last URI segments

Consider the following URL that represents the checkout operation in an online store:
http://example.com/Web/Store/Checkout
The first two segments of the URI don't provide a significant name for the business transaction:
/Web/Store
Identify a more meaningful name using one of the following options:
Click Use the full URI to identify the transaction by all URI segments. For example:
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/Web/Store/Checkout
Click Use the first or Use the last n segments to use two contiguous segments at the
beginning or end of the URI, where n is the number of segments.
For example, to identify the checkout transaction using the last two segments of the URI:
/Store/Checkout

If you need more flexibility, such as using non-contiguous segments in the name, click Nam
e Transactions dynamically using part of the requests and specify the segments with
the Use URI segments in Transaction names option.
To use specific URI segments in transaction names

You can choose specific URI segments to use in the transaction name. This enables you to skip
URI segments or use non-contiguous segments in the naming scheme.
1. Click Use a part of the URI.
2. Enter the number of first or last segments to use.
3. Click Name Transactions dynamically using part of the request.
4. Click Use URI segment(s) in Transaction names.
5. Enter the segment numbers separated by commas.
For example the following URL represents the checkout transaction requested by a
customer with ID 1234:
http://example.com/Store/cust1234/Checkout
The checkout transaction is the same regardless of the customer, so it makes sense to
name the transaction based upon the first and third segments of the URI.
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AppDynamics names the transaction:
/Store/Checkout
Identify Transactions Using Headers, Cookies, and Other Parts of HTTP Requests

You can also name ASP.NET transactions using parameters, headers, cookies, and other parts of
HTTP requests.
To identify all your ASP.NET transactions using particular parts of the HTTP request, use the
Name Transactions dynamically using part of the request option.
Carefully consider your naming configuration choices. If you use a value such as the request
originating address and you have many clients accessing your application, you may see the All
Other Traffic Business Transaction.
To use HTTP parameter values in transaction names

1. Set the URI identification option.
2. Click Use a parameter value in Transaction names and enter the Parameter Name.
For example, consider the following URL:
http://example.com/Store/Inventory?category=electronics

AppDynamics names the transaction to include the category parameter value:
/Store/Inventory.electronics
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To use a header value in transaction names

1. Set the URI identification option.
2. Click Use header value in transaction names and enter a Header Name.
For example, consider a site that uses the custom header "Version", AppDynamics names
transactions with the header value as follows:
/Store/Inventory.v2.5
To use a cookie value in transaction names

1. Set the URI identification option.
2. Click Use a cookie value in Transaction names and enter the Cookie Name.
For example, a website tracks a user's loyalty status in a cookie. Set the Cookie Name to
"loyalty". AppDynamics names transactions for the loyalty cookie value:
/Store/Inventory.Status=Gold
To use a session attribute value in transaction names

1. Set the URI identification option.
2. Click Use a session attribute in Transaction names and enter the Session Attribute Key
.
For example, a website stores a customer's region in the session property. Set the Session
Attribute name to "region". AppDynamics names transactions for the region session attribute
value:
/Store/Inventory.NorthAmerica
To use the request method in Transaction names

1. Set the URI identification option.
2. Click Use the request method (GET/POST/PUT) in Transaction names.
AppDynamics names transactions for the request method. For example:
/Store/Inventory.GET
To use the request host in Transaction names

1. Set the URI identification option.
2. Click Use the request host in Transaction names.
AppDynamics names transactions for the ip address of the request host. For example:
/Store/Inventory.192.0.2.0
To use the request originating address in Transaction names

1. Set the URI identification option.

Copyright © AppDynamics 2012-2014

Page 1528

1.
2. Click Use the request originating address in Transaction names.
AppDynamics names transactions for the ip address of the request client. For example:
/Store/Inventory.192.0.2.10
To use a custom expression on the HttpRequest

Custom expressions enable you to name transactions using getter chain(s) for HttpRequest proper
ties and methods.
1. Set the URI identification option.
2. Click Apply a custom expression on HttpRequest and use the result in Transaction
Names.
3. Enter your custom expression getter chain as follows:
Enclose getter chain(s) inside braces: ${} .
Use getter chain syntax.
Use any HttpRequest request attributes or methods.
For example, consider this URL:
http://mystore.example.com/Store/Inventory-Furniture
The following custom expression uses two getter chains:
The first getter chain fetches the URL, splits it on the dash character ("-"), and uses
the second string in the array.
The second getter chain fetches the HttpRequest.UserAgent property.
The literal dash character "-" separates the two getter chains.

${Url.ToString().Split(Char[]/-).[2]}-${UserAgent}

The result is the following business transaction name:
Furniture-Mozilla/5.0 (Windows NT 6.3; Trident/7.0; rv:11.0) like
Gecko

Custom Match Rules for ASP.NET Transactions

Custom match rules provide greater flexibility for transaction naming. When you define a match
rule, AppDynamics uses the rule name for the business transaction name.
For steps to access the Custom Match Rules pane, see To create custom match rules for. NET
entry points .
To create an ASP.NET custom match rule

1. In the Custom Match Rules pane, click the plus symbol (+) to add an entry point.
2.
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1.
2. Click ASP.NET in the dropdown list. Click Next.
3. Name the New Business Transaction Match Rule.
AppDynamics uses the rule Name to name the BT.
The Controller enables the rule by default. Disable it later if needed.
Set the Priority for the match rule. AppDynamics applies higher priority rules first.
4. Set one or more of the following match criteria. When AppDynamics detects a requests
matching your specified criteria, it identifies the request using your custom name.
Method: Match on the HTTP request method, GET, POST, PUT or DELETE.
WIth automatic discovery for ASP.NET transactions enabled, configuring the match
on GET or POST causes the the agent to discover both GET and POST requests. If
you only want either GET or POST requests for the transaction, consider the
following options:
Disable automatic discovery for ASP.NET transactions.
Create an exclude rule for the method you don’t want: GET or POST.

URI: Set the conditions to match for the URI.
For rules on regular expressions for .NET, see .NET Framework Regular Expressions.
Optionally click the gear icon to set a NOT condition.
You must set an URI match condition in order to use transaction splitting.
HTTP Parameter: Match on HTTP parameter existence or a specific HTTP parameter
value.
Header: Match on a specific HTTP header's (parameter's) existence or a specific HTTP
header value.
Hostname: Match on the server host name. Optionally click the gear icon to set a NOT
condition.
Port: Match on the server port number. Optionally click the gear icon to set a NOT condition.
Class Name: Match on the ASP.NET class name. Optionally click the gear icon to set a
NOT condition.
Cookie: Match on cookie existence or a specific a specific cookie value.
5. Click Create Custom Match Rule.
The rule appears in the Custom Match Rule list. The business application or tier you
customized displays a green check in the Select Application or Tier pane.
After the agent receives the updated configuration, it discovers the new business transaction
and displays it in the Business Transactions List.
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To split custom ASP.NET transactions

AppDynamics lets you further refine ASP.NET custom transaction names using transaction
splitting. See Transaction Splitting for Dynamic Discovery.
1. Create a custom match rule. To use transaction splitting, you must specify URI match
criteria.
2. Click Split Transactions Using Request Data.
3. Click the splitting option to use.
The transaction splitting options work the same as the methods described in the previous
sections:
Identify transactions using URI segments
Identify Transactions Using Headers, Cookies, and Other Parts of HTTP Requests
For example, consider the following URL:
http://example.com/Store/Inventory?category=electronics
Configure the custom match rule to match on the "URI contains Inventory".
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Split the transaction on the category parameter.

4. Click Save.
After the agent receives the updated configuration, it discovers the new business transaction
and displays it in the Business Transactions List.

Learn More

Configure Business Transaction Detection for .NET
Web Entry Points
Configure Business Transaction Detection
Import and Export Transaction Detection Configuration for .NET

Import and Export Auto-Detected Entry Point Configurations
Export guidelines
Import guidelines
To import or export the configurations for all the auto-detected entry-points to or from
an application
To import or export the configuration for a single auto-detected entry point type to or
from an application
Entry point type names
To import or export the configurations for all the auto-detected entry-points to or from
a tier
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To import or export the configuration for a single auto-detected entry point type to or
from a tier
Import and Export Custom Match Rules
To import or export a single custom match rule to or from an application
To import or export a single custom match rule to or from a tier
Import and Export Exclude Rules
To import or export a single exclude rule to or from an application
To import or export a single exclude rule to or from a tier
Overwrite Parameter
Learn More
AppDynamics lets you migrate transaction detection configurations for .NET entry points from one
application to another using a REST API. Use the API to copy transaction detection configurations
rather than manually re-configuring multiple applications in the Controller.
Import and Export Auto-Detected Entry Point Configurations

You can import and export all your entry point configurations or one entry point configuration in a
single request. Lists of multiple entry point names are not supported. Import to or export from
application-level configuration and tier-level configuration as follows:
auto-detected entry point configurations
custom match rules
exclude rules
Export guidelines

Follow these rules when exporting entry point configurations:
Use the HTTP GET method.
Encode the URI using UTF-8 URL encoding.
The base URI is the source application and, optionally, the source tier for your configuration
export.
http://<controller host>:<controller
port>/controller/transactiondetection/<application
name>/<optional tier name>

The Controller exports the configurations to an XML file. If necessary, you can edit the XML
file before you import it.
For example, if you export the all the auto-detected entry points but don't want to import
them all, delete the ones you do not want from the file before import.
Import guidelines

Follow these rules when importing entry point configurations:
Export the auto-detected entry point configuration, custom match rule, or exclude rule from
the Controller.
You may manually create the XML, but that option is more difficult.
Use the HTTP POST method.
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Encode the URI using UTF-8 URL encoding.
The base URI is the destination application and, optionally, the destination tier for your
configuration import.
http://<controller host>:<controller
port>/controller/transactiondetection/<application
name>/<optional tier name>

Include the XML configuration as a file attachment to the request.
To overwrite an existing configuration with the same name see Overwrite Parameter.
A successful import request returns HTTP status code 200.
To import or export the configurations for all the auto-detected entry-points to or from an application

http://<controller host>:<controller
port>/controller/transactiondetection/<application name>/auto
exports all the auto-detected entry point types for all agents: ASP.NET, Java, PHP, NodeJS, etc.
For example:
http://appdcontroller.example.com/controller/transactiondetection/Ho
wdy+World+Travel/auto

produces the output in auto_all.xml.
To import or export the configuration for a single auto-detected entry point type to or from an application

http://<controller-host>:<controller-port>/controller/transactiondetecti
on/<application name>/auto/<entry point type name>
Entry point types names are case insensitive.
In this example the customized ASP.NET naming configuration uses one segment of the URI and
the "destination" parameter, the API
http://appdcontroller.example.com/controller/transactiondetection/Ho
wdy+World+Travel/auto/aspdotnet

produces the output in auto_aspdotnet.xml.
Entry point type names
When you import or export a specific entry point type, the REST API requires the following entry
point type names:
ASP.NET: AspDotNet
Web Service: DotNetWebService
WCF: WCF
.NET Class / Method: POCO
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Message Queue: DotNetJms
.NET Remoting: DotNetRemoting
To import or export the configurations for all the auto-detected entry-points to or from a tier

http://<controller-host>:<controller-port>/controller/transactiondetecti
on/<application name>/<tier name>/auto
For example:
http://appdcontroller.example.com/controller/transactiondetection/Ho
wdy+World+Travel/TravelSearch+Server/auto/

The tier output is the same as for an application. See auto_all.xml.
To import or export the configuration for a single auto-detected entry point type to or from a tier

http://<controller host>:<controller
port>/controller/transactiondetection/<application name>/<tier
name>/auto/<entry point type name>
For example if you disabled Web Services for the TravelSearch Server tier, the API
http://appdcontroller.example.com/controller/transactiondetection/Ho
wdy+World+Travel/TravelSearch+Server/auto/DotNetWebService

produces the output in auto_webservice.xml.
Import and Export Custom Match Rules
To import or export a single custom match rule to or from an application

http://<controller host>:<controller
port>/controller/transactiondetection/<application name>/custom/<entry
point type name>/<custom rule name>
For example to export a POCO, the API
http://appdcontroller.example.com/controller/transactiondetection/Ho
wdy+World+Travel/custom/POCO/My+POCO

produces the output in custom_poco.xml.
To import or export a single custom match rule to or from a tier

http://<controller host>:<controller
port>/controller/transactiondetection/<application name>/<tier name>/cus
tom/<entry point type name>/<custom rule name>
For example:
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http://appdcontroller.example.com/controller/transactiondetection/Ho
wdy+World+Travel/TravelSearch+Server/custom/AspDotNet/My+ASP.NET+Tra
nsaction

produces the output in custom_aspdotnet.xml.
Import and Export Exclude Rules
To import or export a single exclude rule to or from an application

http://<controller host>:<controller
port>/controller/transactiondetection/<application name>/exclude/<entry
point type name>/<exclude rule name>
For example, to export an exclude rule for a specific service, the API
http://appdcontroller.example.com/controller/transactiondetection/Ho
wdy+World+Travel/exclude/DotNetWebService/My+Web+Service+Exclude+Rule

produces the output in exclude_webservice.xml.
To import or export a single exclude rule to or from a tier

http://<controller host>:<controller
port>/controller/transactiondetection/<application name>/<tier
name>/exclude/<entry point type name>/<exclude rule name>
For example:
http://appdcontroller.example.com/controller/transactiondetection/Ho
wdy+World+Travel/TravelSearch+Server/exclude/DotNetWebService/My+Web
+Service+Exclude+Rule

The tier output is the same as for an application. See exclude_webservice.xml.
Overwrite Parameter

Use the overwrite parameter to overwrite a configuration of the same name. Without this
parameter, if the import encounters a configuration for a component of the same name, the
request will fail.
For example, to import a configuration for a POCO custom match rule named "My POCO" to an
application that has an existing "My POCO" custom match rule use:
http://appdcontroller.example.com/controller/transactiondetection/Ho
wdy+World+Travel/custom/POCO/My+POCO?overwrite=true
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The default is overwrite=false.
Learn More

Configure Business Transaction Detection
Use the AppDynamics REST API
WCF Entry Points

Automatic Naming for WCF Transactions
Custom Match Rules for WCF Transactions
To create a WCF custom match rule
Learn More
AppDynamics automatically detects entry points for client requests to Windows Communication
Foundation (WCF) services. If the request occurs on an originating tier , the method or operation
marks the beginning of a business transaction and defines the transaction name. For information
on originating tiers, see Configure Business Transaction Detection.
When WCF calls execute on a downstream tier, AppDynamics includes them as part of the
business transaction from the originating tier.

Automatic Naming for WCF Transactions
By default, the AppDynamics auto-detection naming scheme identifies all WCF transactions using
the service name and operation name:
ServiceName.OperationName

For example, a web service for a travel website books reservations from client front ends.

You can rename or exclude automatically discovered transactions. See Business Transaction List
Operations.
Custom Match Rules for WCF Transactions

Custom match rules provide flexibility for WCF transaction naming. When you define a match rule,
AppDynamics uses the rule name for the business transaction name.
For steps to access the Custom Match Rules pane, see "To create custom match rules for .Net
entry points" on Configure Business Transaction Detection for .NET.
To create a WCF custom match rule

1.
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1. In the Custom Match Rules pane, click the plus symbol (+) to add an entry point.
2. Click WCF in the dropdown list. Click Next.
3. Name the New Business Transaction Match Rule.
AppDynamics uses the rule Name to name the BT.
The Controller enables the rule by default. Disable it later if needed.
Set the Priority for the match rule. AppDynamics applies higher priority rules first.
4. Set one or more of the following match criteria. When AppDynamics detects a requests
matching your specified criteria, it identifies the request using your custom name.
Web Service Name
For rules on regular expressions for .NET, see .NET Framework Regular Expressions.
Optionally use the gear dropdown to set a NOT condition.
Operation Name
For rules on regular expressions for .NET, see .NET Framework Regular Expressions.
Optionally use the gear dropdown to set a NOT condition.

For example, to report all operations for a TravelService, such as SearchTravel and
BookTravel, as one business transaction:

5. Click Create Custom Match Rule.
The rule appears in the Custom Match Rule list. The business application or tier you
customized displays a green check in the Select Application or Tier pane.
After the agent receives the updated configuration, it discovers the new business transaction and d
isplays it in the Business Transactions List.

Learn More

Windows Communication Foundation
Configure Business Transaction Detection for .NET
ASP.NET Web Service Entry Points

Automatic Naming for Web Service Transactions
Custom Match Rules for ASP.NET Web Service Transactions
To create an ASP.NET web service custom match rule
Learn More
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AppDynamics automatically detects entry points for client requests to ASP.NET web services. If
the request occurs on an originating tier, the method or operation marks the beginning of a
business transaction and defines the transaction name. For more information on originating tiers,
see Configure Business Transaction Detection for .NET.
When web service calls execute on a downstream tier, AppDynamics includes them as part of the
business transaction from the originating tier.

Automatic Naming for Web Service Transactions
By default, the AppDynamics auto-detection naming scheme identifies all web service transactions
using the service name and operation name:
ServiceName.OperationName

For example, a web service for a travel website books reservations from client front ends.

You can rename or exclude automatically discovered transactions. For more information, see
"Business Transaction List Actions" on Business Transactions List.
Custom Match Rules for ASP.NET Web Service Transactions

Custom match rules provide flexibility for ASP.NET web service transaction naming. When you
define a match rule, AppDynamics uses the rule name for the business transaction name.
For steps to access the Custom Match Rules pane, see "To create custom match rules for. NET
entry points," on Configure Business Transaction Detection for .NET.
To create an ASP.NET web service custom match rule

1. In the Custom Match Rules pane, click the plus symbol (+) to add an entry point.
2. Click Web Service in the dropdown list. Click Next.
3. Name the New Business Transaction Match Rule.
AppDynamics uses the rule Name to name the BT.
The Controller enables the rule by default. Disable it later if needed.
Set the Priority for the match rule. AppDynamics applies higher priority rules first.
4. Set one or more of the following match criteria. When AppDynamics detects a requests
matching your specified criteria, it identifies the request using your custom name.
Web Service Name
For rules on regular expressions for .NET, see .NET Framework Regular Expressions.
Optionally use the gear dropdown to set a NOT condition.
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Operation Name
For rules on regular expressions for .NET, see .NET Framework Regular Expressions.
Optionally use the gear dropdown to set a NOT condition.

For example, to report all operations for a TravelService, such as SearchTravel and
BookTravel, as one business transaction:

5. Click Create Custom Match Rule.
The rule appears in the Custom Match Rule list. The business application or tier you
customized displays a green check in the Select Application or Tier pane.
After the agent receives the updated configuration, it discovers the new business transaction and d
isplays it in the Business Transactions List.

Learn More

Configure Business Transaction Detection for .NET
Message Queue Entry Points

Automatic Naming for WCF Transactions
Custom Match Rules for Message Queue Transactions
To create a message queue custom match rule
Learn More
AppDynamics automatically detects entry points for client requests to message queues. If the
request occurs on an originating tier, the method or operation marks the beginning of a business
transaction and defines the transaction name. For information on originating tiers, see Configure
Business Transaction Detection for .NET
When message queue calls execute on a downstream tier, AppDynamics includes them as part of
the business transaction from the originating tier.

Automatic Naming for WCF Transactions
By default, the AppDynamics auto-detection naming scheme identifies all message queue
transactions using the destination name. Otherwise, if the destination name is not available,
AppDynamics uses the listener class name.
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Destination Name

You can rename or exclude automatically discovered transactions. See information on Business
Transaction List Actions in Business Transactions List.
Custom Match Rules for Message Queue Transactions

Custom match rules provide flexibility for message queue transaction naming. When you define a
match rule, AppDynamics uses the rule name for the business transaction name.
For steps to access the Custom Match Rules pane, see "To create custom match rules for .Net
entry points," in Configure Business Transaction Detection for .NET.
To create a message queue custom match rule

1. In the Custom Match Rules pane, click the plus symbol (+) to add an entry point.
2. Click Message Queues in the dropdown list. Click Next.
3. Name the New Business Transaction Match Rule.
AppDynamics uses the rule Name to name the BT.
The Controller enables the rule by default. Disable it later if needed.
Set the Priority for the match rule. AppDynamics applies higher priority rules first.
4. Set one or more of the following match criteria. When AppDynamics detects a requests
matching your specified criteria, it identifies the request using your custom name.
Message Destination
Match on one of the following:
Queue
Topic
Unknown
Click a match criteria.
Enter a string to match.
Message Property
Match on property name existence.
Click the Property Type.
Enter the Property Name.
Check for property value.
Click the Property Type.
Enter the Property Name.
Enter the Property Value.
Message Content
Click a match criteria.
Enter a string to match.
For rules on regular expressions for .NET, see .NET Framework Regular Expressions.
Optionally use the gear dropdown to set a NOT condition
5. Click Create Custom Match Rule.

Copyright © AppDynamics 2012-2014

Page 1541

5.
The rule appears in the Custom Match Rule list. The business application or tier you
customized displays a green check in the Select Application or Tier pane.

After the agent receives the updated configuration, it discovers the new business transaction and d
isplays it in the Business Transactions List.

Learn More

Configure Business Transaction Detection for .NET
Configure Application Domain Monitoring
Overview
Single Application Domain
Multiple Application Domains
Configure Monitoring for Multiple Application Domains
To configure Application Domain instrumentation.
Sample Standalone Application configuration with multiple AppDomains
Learn More
You can configure monitoring for ASP.NET applications with multiple Application Domains
(AppDomains). This topic assumes you have a working knowledge of AppDomains and that you
are familiar with the AppDomain implementation in your application.
This topic does not cover the System Domain, Shared Domain, or DefaultDomain AppDomains the
CLR instantiates before it executes the managed code. If your standalone application runs in the
DefaultDomain, see Instrument the DefaultDomain for Standalone Applications.
Overview

Windows uses processes to manage security and performance isolation between running
applications. Process isolation ensures one application's running code doesn't interfere with
another application. However, for applications that share data, making calls between Windows
processes can introduce complications and performance issues. AppDomains enable developers
to create several applications that run inside a single process but maintain application isolation.
Single Application Domain

In the case of a single application running inside its own process, the runtime host typically
manages the AppDomain. The application executable and the AppDomain have the same name.
The .NET Agent (agent) installs itself inside the single AppDomain and creates a node for the
application.
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Multiple Application Domains

When developers include multiple AppDomains in an application, all the AppDomains run inside a
single process. The application executable may have the same name as one AppDomain, but
there are other, uniquely named AppDomains. By default, the agent installs itself inside all the
AppDomains and creates nodes for them.

Configure Monitoring for Multiple Application Domains
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If the application you monitor contains multiple AppDomains, the App Agent for .NET automatically
instruments each AppDomain and creates a node. You can configure the .NET Agent to
instrument only the AppDomains you specify. This is useful to exclude AppDomains you don't want
to monitor and to limit the number of nodes in a tier.
You can configure application domain monitoring for:
Windows Services
Standalone Applications
To configure Application Domain instrumentation.

Configure all instrumentation settings for the .NET Agent in the config.xml file. See Where to
Configure App Agent Properties.
1. Identify the name of the AppDomains you want to instrument.
If you have already instrumented your application, you can see the AppDomain names in
the Node Dashboard.
Click the node in the left navigation pane, then click CLR. See Node Dashboard.

2. Launch a text editor as administrator.
3. Edit the config.xml file as an administrator. See Where to Configure App Agent Properties.
4. Find the element that corresponds to your application with multiple AppDomains:

Windows Service element: <windows-service name="MyWindowsService">
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Standalone Application element: <standalone-application
executable="MyWindowsApplication.exe">
5. Add the app-domain-name attribute to the element.
For example, to instrument the MyApp.exe AppDomain for the MyApp.exe standalone application:
<standalone-application executable="MyApp.exe" app-domain-name="MyApp.exe">
<tier name="StandaloneApplication Tier"/>
</standalone-application>

As soon as you instrument one AppDomain in the config.xml, the agent instruments only
the AppDomains you specify. Other AppDomains are not instrumented.
6. To instrument additional AppDomains, add an element for each AppDomain as if they were
separate applications.
For example, to instrument MyAppDomain1 in MyApp.exe:
<standalone-application executable="MyApp.exe" app-domain-name="MyAppDomain1">
<tier name="StandaloneApplication Tier"/>
</standalone-application>

7. Save the config.xml file.
8. Restart the AppDynamics.Agent.Coordinator service.
9. Restart instrumented applications: Windows services or standalone applications.
Sample Standalone Application configuration with multiple AppDomains

This sample config.xml shows the configuration for the application MyApp.exe. Instrumentation
only applies to the AppDomains specified in the config.xml: MyApp.exe and MyAppDomain2.
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<?xml version="1.0" encoding="utf-8"?>
<appdynamics-agent xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
<controller host="mycontroller.mycompany.com" port="8090" ssl=false">
<application name="MyDotNetApplication" />
</controller>
<machine-agent />
<app-agents>
<standalone-applications>
<standalone-application executable="MyApp.exe"
app-domain-name=""MyApp.exe">
<tier name="StandaloneApplication Tier"/>
</standalone-application>
<standalone-application executable="MyApp.exe"
app-domain-name=""MyAppDomain2">
<tier name="StandaloneApplication Tier"/>
</standalone-application>
</standalone-applications>
</app-agents>
</appdynamics-agent>

Learn More

Instrument DefaultDomain for Standalone Applications
Application Domains
.NET Agent Configuration Properties
Enable the .NET Agent for Windows Services
Enable the .NET Agent for Standalone Applications
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Instrument the DefaultDomain for Standalone Applications

Instrument the DefaultDomain for Standalone Applications
To check if your application runs in the DefaultDomain
To instrument the DefaultDomain
Learn More
This topic provides instructions to identify if your application runs in the .NET DefaultDomain, and,
if so, how to instrument it.
Instrument the DefaultDomain for Standalone Applications

By default, the .NET Agent does not instrument the DefaultDomain AppDomain. Before you
instrument the DefaultDomain:
Follow the instructions to instrument a standalone application.
Create a POCO entry point for a class/method in the application.
If you complete those steps and still don't see business transactions in the Controller, check if your
managed code runs in the DefaultDomain. If so, you must configure the agent to instrument the
DefaultDomain.
To check if your application runs in the DefaultDomain

If you are unfamiliar with your application's managed code, you can use the agent logs to identify
the AppDomain.
1. Open the agent log:
Windows Server 2008 and later: %ProgramData%\AppDynamics\DotNetAgent\Logs\Ag
entLog.txt
Windows Server 2003: %AllUsersProfile%\Application
Data\AppDynamics\DotNetAgent\Logs\AgentLog.txt
2. Search the agent log for "AppDomain".
Few log entries contain "AppDomain" when the agent starts up. Look for an entry by "dllhost" or
your instrumented application similar to the following:
2013-12-16 08:23:02.3120 3068 MYPROGRAM 1 1 Info Configuration
appDomainName=DefaultDomain appDomainId=1 iis-app=null site=null port=null
appPoolId=
2013-12-16 08:23:02.6240 3192 dllhost 1 17 Info ConfigurationManager Not
instrumenting DefaultDomain for pid 3068

In this example MYPROGRAM is the name of the instrumented standalone application. You can
see the name of the AppDomain in the log entry: appDomainName=DefaultDomain.
To instrument the DefaultDomain

Configure all instrumentation settings for the .NET Agent in the config.xml file. See Where to
Configure App Agent Properties.
1. Launch a text editor as administrator.

Copyright © AppDynamics 2012-2014

Page 1547

2. Edit the config.xml file as an administrator. See Where to Configure App Agent Properties.
3. Copy the code block below to a child element of the Standalone Application element. See Sta
ndalone Application Element:
<profiler>
<instrument-defaultdomain enabled="true"/>
</profiler>

The Profiler element must follow the Standalone Application Tier element.
For example:
<?xml version="1.0" encoding="utf-8"?>
<appdynamics-agent xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
<controller host="mycontroller.mycompany.com" port="8090" ssl="false">
<application name="My Business Application" />
</controller>
<machine-agent />
<app-agents>
<IIS>
<applications />
</IIS>
<standalone-applications>
<standalone-application executable="MyStandaloneApp.exe">
<tier name="Standalone Tier" />
<profiler>
<instrument-defaultdomain enabled="true"/>
</profiler>
</standalone-application>
</standalone-applications>
</app-agents>
</appdynamics-agent>

4. Save the config.xml file.
5. Restart the AppDynamics.Agent.Coordinator service.
6. Restart the standalone application for your changes to take effect.
Learn More

Enable the .NET Agent for Standalone Applications
POCO Entry Points
.NET Agent Configuration Properties
Identify MVC Transactions by Controller and Action
Identifying MVC Transactions by Controller and Action
To identify ASP.NET MVC transactions by Controller/Action
Business Transaction Naming Convention
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Learn More
You can configure the agent to identify transactions by MVC Controller/Action instead of the
default naming by URI. For general information on organizing and naming business transactions,
see Organizing Traffic as Business Transactions.
Identifying MVC Transactions by Controller and Action

By default the .NET Agent (agent) identifies ASP.NET MVC business transactions by the request
URL or server URI.
In cases where an application accepts numerous client URLs for a single MVC controller and
action, naming business transactions with the client URL can cause several issues including the
following:
The number of business transactions exceeds the limits. See Business Transaction Limits.
Most requests wind up in "All other traffic". See All Other Traffic Business Transaction.
Requests per minute per business transaction is inconsistent.
For example, consider a MVC application that lists store locations. City-specific URLs list the
locations for a city:
http://myapp.mycompany.com/Bellevue
The business transaction name for this URL defaults to /Bellevue. Each request for a unique city
generates a business transactions. None of the URIs contain common elements that you can use
to configure business transaction names.

In the web application, all city location searches, such as /Bellevue, map to the Results action of
the Search controller. After you configure the agent to name transactions by controller and action,
the agent identifies the business transaction as Search/Results.
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The Search/Results business transaction combines search requests for all cities into one
transaction.
To identify ASP.NET MVC transactions by Controller/Action

To configure the agent to identify MVC transactions as Controller/Action, register the aspdotnet-m
vc-naming-controlleraction node property. The node property works for MVC 3, MVC 4 and
WebAPI transactions.
For instructions on how to register a new node property, see App Agent Node Properties.
Name: aspdotnet-mvc-naming-controlleraction
Description: Identfy ASP.NET MVC Business Transactions as Controller/Action.
Type: Boolean
Value: True
The default value is False.
After the agent registers traffic with a business transaction named for the Controller/Action and
after traffic to the old business transactions named for the client URL diminishes, delete the old
business transactions.
Business Transaction Naming Convention

If you use Areas to organize your MVC application, the agent includes the Area name in the
business transaction name:
/Area name/Controller name/Action name
For example, if your travel application has separate Areas for hotel, airfare, and car rentals:
/Hotel/Search/Results
Otherwise the agent names the transaction as follows:
/Controller name/Action name
Learn More

Business Transaction Limit
All Other Traffic Business Transaction
App Agent Node Properties
Configure Business Transaction Detection
ASP.NET Routing
Getter Chains in .NET Configurations
Using Getter Chains
Separators in Getter Chains
Getter Chain Examples
Learn More
This topic provides some guidance and examples of the correct syntax for using getter chains in
AppDynamics configurations.
Using Getter Chains

Copyright © AppDynamics 2012-2014

Page 1550

You can use getter chains to:
Configure method invocation data collectors. See Configure Data Collectors.
Define a new business transaction custom match rule that uses a POCO object instance as
the mechanism to name the transaction. See POCO Entry Points.
Note: If a getter chain calls on a method that does a lot of processing, such as making numerous
SQL calls, it can degrade the performance of the application and the App Agent for .NET. Ideally,
use getter chains only with simple gets.
An example of a simple getter would be a method to return a property from a class, such as
GetName().
public class MyUser
{
private String Name {get; set;}
private String Url;
public GetUrl(){
return this.Url;
}
}

Separators in Getter Chains

The following special characters are used as separators:
comma (,) for separating parameters
forward slash (/) for separating a type declaration from a value in a parameter
dot (.) for separating the methods and properties in the getter chain
If a slash or a comma character is used in a string parameter, use the backslash (\) escape
character. Except in the case of type / value.
If a literal dot is used in a string parameter, use the backslash escape character before the dot.
Getter Chain Examples

These examples are intended to get you started with the getter chain syntax for
AppDynamics.
Getter chain with integer parameters in the substring method using the forward slash as the
type separator:
GetAddress(appdynamics, sf).Substring(int/0, int/10)

This example returns the first 10 characters of a string. The int parameter types resolve
which overloaded method to call.

Copyright © AppDynamics 2012-2014

Page 1551

Getter chain with various non-string parameter types:
GetAddress(appdynamics, sf).MyMethod(float/0.2, boolean/true,
boolean/false, int/5)

For cases when you specify type / char, you don't need to escape anything after the
type.
Getter chain with forward slash escaped; escape character needed here for the string
parameter:
GetUrl().Split(char[]//)

This example splits a URL on the forward slash character and returns a string array. The
following examples are more likely.
Getter chain with an array element:
GetUrl().Split(char[]//).[4]

Getter chain with multiple array elements separated by commas:
GetUrl().Split(char[]//).[1,3]

Getter chain retrieves property values, such as the length of an array:
GetUrl().Split(char[]//).Length

Getter chain using backslash to escape the dot in the string parameter;
the call is getParam (a.b.c).
GetAddress.GetParam(a\.b\.c\.)

In the following getter chain, the first dot requires an escape character because it is in a
string method parameter (inside the parentheses). The second dot does not require an
escape character because it is not in a method parameter (it is outside the parentheses).
GetUser(suze\.smith).GetGroup().GetId()

The following getter chain is from a transaction splitting rule on URIs that use a semicolon
as a delimiter; for example:
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/my-webapp/xyz;sessionid=BE7F31CC0235C796BF8C6DF3766A1D00?act=Add&uid=c42ab
7ad-48a7-4353-bb11-0dfeabb798b5
The getter chain splits on the API name, so the resulting split transactions are "API.abc",
API."xyz" and so on.
The call gets the URI using GetUri() and then splits it using the escaped forward slash.
From the resulting array it takes the third entry (as the split treats the first slash as a
separator) and inserts what before the slash (in this case, nothing) into the first entry.
Then it splits this result using the semicolon, getting the first entry of the resulting array,
which in this case contains the API name.
GetUri().Split(char[]//).[2].Split(char[];).[0]

Learn More

Configure Business Transaction Detection
Configure Data Collectors
Enable Monitoring for Windows Performance Counters
Performance Counters and the .NET Machine Agent
To configure additional performance counters for .Net
Sample .NET Machine Agent configuration with additional performance counters
Performance Counters and the .NET Machine Agent

By default, the .NET Machine Agent uses Microsoft Performance Counters to gather and report
.NET metrics. For details on the preconfigured .NET metrics see Monitor CLRs and Monitor IIS.
You can specify additional performance counters to be reported by the .NET Machine Agent.
To configure additional performance counters for .Net

1. Shut down the AppDynamics.Agent.Coordinator service.
2. Edit the config.xml file as an administrator. See Where to Configure App Agent Properties.
3. Add the Performance Counters block as a child of the Machine Agent element.
<perf-counters>
<perf-counter cat="" name="" instance=""/>
</perf-counters>

4. Create a Performance Counter element for each performance counter you want to add.
Use any of the performance counters as specified in Performance Counters in .NET
Framework.
Set the cat attribute to the category of the performance counter.
Set the name attribute to the performance counter name.
Set the instance attribute to the of the performance counter.
If a particular performance counter has many instances you can specify the following
options:
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instance ="*" OR
instance ="all" (This will report the sum of all instances)
For example, to add the performance counter for measuring CPU Idle time(%), add the
following element in the <perf-counters> block:
<perf-counter cat="Processor" name="% Idle Time"
instance="_Total"/>

5. Save the config.xml.
6. Start the AppDynamics.Agent.Coordinator service.
Sample .NET Machine Agent configuration with additional performance counters

<machine-agent>
<!-- Additional machine level Performance Counters -->
<perf-counters>
<perf-counter cat="Processor" name="% Idle Time" instance="_Total"/>
</perf-counters>
</machine-agent>

Configure the .NET Machine Agent

The .NET Machine Agent
Machine Agent Configuration
To configure the .NET Machine Agent
To Configure the .NET Machine Agent without app agents
Machine Agent Tier
Learn More
This topic provides instructions to configure the .NET Machine Agent that installs automatically
with the .NET Agent.
The .NET Machine Agent

The .NET Agent includes an embedded .NET Machine Agent that runs as part of the
AppDynamics.Agent.Coordinator service. Among other things, the Machine Agent regularly
gathers system performance data and reports it back to the Controller as metrics.
Do not confuse the .NET Machine Agent with the Standalone Machine Agent, a Java
application. The Standalone Machine Agent provides the capability to use extensions (plugins,
metric listener, orchestration). See Standalone Machine Agent.

Machine Agent Configuration
The app agent MSI Installer package and .NET Agent Configuration Utility automatically install and
configure the .NET Machine Agent to connect to the Controller. The connection information is the
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same for the app agent and the .NET Machine agent. See Configure the .NET Agent.
You can customize the .NET Machine Agent to enable additional functionality.

To configure the .NET Machine Agent
1. If you haven't already, Install the .NET Agent.
2. Customize instrumentation settings for the Machine Agent element in the config.xml file.
See Where to Configure Agent Properties.
See the following topics for .NET Machine Agent configuration options:
Enable Monitoring for Windows Performance Counters
Enable Thread Correlation for .NET
Enable Correlation for .NET Remoting
Enable Instrumentation for WCF Data Services
Configure Machine Snapshots for .NET
To Configure the .NET Machine Agent without app agents

1. If you haven't already, Install the .NET Agent.
2. Launch the AppDynamics Agent Configuration utility and follow the steps until you reach the
Assign IIS applications to tiers window.
3. Click Manual for the method of tier generation and assignment and click Next.

4. Don't assign any IIS applications to tiers, click Next.
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If you configured any Windows services or standalone applications, manually disable
those agents in the config.xml.
5. Continue with the remaining steps and click Done.
Monitoring resumes for the .NET Machine Agent only.
Machine Agent Tier

Immediately after you install and configure the .NET Agent, the .NET Machine Agent registers with
the Controller and starts reporting performance data.
Frequently the machine agent metrics reach the controller before the app agent has had time to
instrument and register IIS applications, Windows services, or standalone applications. If there are
no application tiers, the machine agent registers as the Machine Agent tier.

Once the app agent begins reporting metrics for configured application tiers, the .NET Machine
Agent reports to the application tiers and stops sending data to the Machine Agent tier.
Learn More

Install the .NET Agent
Monitor CLRs
Enable Instrumentation for WCF Data Services
To enable instrumentation for WCF Data Services
Learn More
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AppDynamics supports instrumentation for WCF Data Services including the WCF RIA Services
for Microsoft LightSwitch.
To enable instrumentation for WCF Data Services

Configure all instrumentation settings for the .NET Agent in the config.xml file. See Where to
Configure App Agent Properties.
1. Launch a text editor as administrator.
2. Edit the config.xml file as an administrator. See Where to Configure App Agent Properties.
3. Copy the code block below to a child element of the Machine Agent element. (See Machine
Agent Element):
<instrumentation>
<instrumentor name="WCFDSEntryInstrumentor" enabled="true" />
</instrumentation>

For example:
<?xml version="1.0" encoding="utf-8"?>
<appdynamics-agent xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
...
<machine-agent>
<!--Enable thread correlation-->
<instrumentation>
<instrumentor name="WCFDSEntryInstrumentor" enabled="true" />
</instrumentation>
</machine-agent>
...
</appdynamics-agent>

The configuration syntax is enabled="true".
4. Save the config.xml file.
5. Restart the AppDyanmics.Agent.Coordinator Service.
6. Restart instrumented applications for your changes to take effect.
Learn More

Configure Business Transaction Detection for .NET
.NET Agent Configuration Properties
Configure Machine Snapshots for .NET
Default Settings and Configuration Considerations
To configure machine snapshots for the .NET Machine Agent
Learn More
The .NET Machine Agent takes machine snapshots to capture vital system data for Windows and
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IIS. Use these guidelines to tune the frequency the .NET Machine Agent takes machine snapshots
in your environment.
To learn how to analyze machine snapshots in the Controller, see Machine Snapshots for .NET.
Default Settings and Configuration Considerations

By default the .NET Machine Agent takes machine snapshots under the following conditions:
Periodic collection: The agent takes one snapshot every 10 minutes.
Breached thresholds: The .NET Machine agent takes samples of machine statistics every 10
seconds within a 10 minute window. For each sample, the agent checks the CPU percent
usage, the memory percent usage, and oldest item in the IIS application pool queue. The
agent flags a sample as a violation when the current usage meets or exceeds one of the
following thresholds:
CPU at 80% or higher
Memory at 80% or higher
IIS application pool queue item older than 100 milliseconds
The agent takes a snapshot when it identifies 6 violations of a single type, such as CPU
usage, within the window. The agent only takes one snapshot per window for breached
thresholds.
With the default window size of 10 minutes and the violations per window of six, the sixth violation of
a single type triggers a machine snapshot:
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Before you change the machine snapshot settings, decide which configuration options work best
for your environment. The following questions and considerations should help you decide how to
set your thresholds:
What percentage CPU or memory usage might flag the beginnings of an issue in your
environment?
How long is too long for items to wait in the IIS queue?
Do you expect occasional CPU or memory spikes?
Are periodic collections every ten minutes frequent enough?
Make sure the value for violations is larger than the number of samples per window.
For example: If you decrease the window size to 60 seconds and take 10 samples per window, the
agent takes samples at the same frequency as the default settings, once every 10 seconds.
However you are likely to get more snapshots because the agent only takes one snapshot per
window. If you set the violations per window to 5, the agent takes a snapshot any time half the
samples in the window violate a specific threshold.
To configure machine snapshots for the .NET Machine Agent

Configure all instrumentation settings for the .NET Machine Agent in the config.xml file. See Wher
e to Configure App Agent Properties.
1. Launch a text editor as administrator.
2. Edit the config.xml file as an administrator. See Where to Configure App Agent Properties.
3. Copy the code block below to a child element of the AppDynamics Agent element. See App
Dynamics Agent Element.
<machine-agent>
<machine-snapshot enabled="true" window-size="600"
samples-per-window="60" violations-per-window="6" max-percent-cpu="80"
max-percent-memory="80" max-queue-item-age="100" periodic-collection="600"
/>
</machine-agent>

If you have already customized the .NET Machine Agent, only copy the Machine
Snapshot element and paste it as a child of the Machine Agent element.
4. Edit the values for the Machine Snapshot element attributes:
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4.

<?xml version="1.0" encoding="utf-8"?>
<appdynamics-agent xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
...
<machine-agent>
<!--Configure machine snapshots-->
<machine-snapshot enabled="true" window-size="60" samples-per-window="10"
violations-per-window="5" max-percent-cpu="80" max-percent-memory="80"
max-queue-item-age="100" periodic-collection="600"/>
</machine-agent>
...
</appdynamics-agent>

5. Save the config.xml file.
6. Restart the AppDyanmics.Agent.Coordinator Service.

Learn More
Machine Snapshots for .NET
.NET Agent Configuration Properties
Configure Multiple Business Application Support for .NET
Preparing to Configure Multiple Business Applications
Configuring the App Agent for .NET for Multiple Business Applications
Sample Configuration
Agent Configuration Properties for Multiple Application Support
Controller Applications Element
Controller Application Element
Application name attribute
Application default attribute
Controller-Application Attribute
Multiple business application support in the .NET Agent requires manually editing the
config.xml to use a schema that the .NET Agent configuration utility doesn't currently
support.
If you follow these instructions to configure multiple application support, you can't use the
configuration utility to make configuration changes afterward. If you launch the
configuration utility on a server where you've configured multiple application support, the
utility will prompt you to delete the configurations.
Take me directly to the Sample Configuration.
Previous versions of the .NET Agent required that monitoring data for all .NET applications running
on a Windows host report to one business application in the Controller. This topic describes how to
configure the .NET Agent to register different applications on the same Windows host with multiple
business applications in the Controller.
To learn more about AppDynamics business applications, see Logical Model.
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Preparing to Configure Multiple Business Applications
Before you configure the .NET Agent, you must install the agent. Use the AppDynamics .NET
Agent Configuration utility to perform basic configuration tasks.
1. Identify how you want to organize your business applications and identify the business
application names.
For example, consider a Windows host running IIS. The IIS instance serves two applications
for two separate customers: Ticket Search and Travel Search. The applications perform
similar functions, but it makes sense to monitor them separately because they function
independently. In this case, create two business applications based upon the application
name: Ticket Search Engine and Travel Search Engine.
AppDynamics doesn't correlate business transaction activity across business
applications. If a tier in the first business application makes an exit call to a second tier in
another business application, the second tier displays as an un-instrumented backend in the
first business application.
2. Map your IIS applications or application pools, Windows services, and standalone
applications to tiers in the different business applications.
For example, map the TicketSearch site to the Ticket Search Web tier in the Ticket Search
Engine business application. Map the TravelSearch site to the Travel Search Web tier in the
Travel Search Engine business application.

3. If you have not already done so, install the .NET Agent. See Install the .NET Agent.
4. Run the AppDynamics Agent Configuration utility to generate a config.xml and configure the
Controller connection. See Configure the .NET Agent
5. When prompted, choose Manual for the method of tier generation and assignment.
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5.

Currently the configuration utility only supports mapping one business
application per server.
Configuring the App Agent for .NET for Multiple Business Applications

Once you have configured the Controller properties for the .NET Agent, instrument your .NET
Applications in the config.xml.
1. Open the config.xml file as administrator and edit the file.
2. Copy the Controller Applications block and paste it as a child element of the Controller el
ement. Replace any existing <applications> or <application> elements:
<!--Configure multiple business applications-->
<applications>
<application name="ApplicationName1" default ="true"/>
<application name="ApplicationName2"/>
</applications>

3. Add an Application element for each of the business applications in the Controller.
Edit the name attribute for the Application elements to match the business
application name in the Controller. If the application doesn't exist yet, the Controller
creates it.
Set the default attribute to "true" for one Application element. If the agent can't find a
match for the business application name in the IIS application, Windows service, or
standalone application configuration, the tier reports to the default business
application.
In this example, Ticket Search is the default business application:
<?xml version="1.0" encoding="utf-8"?>
<appdynamics-agent xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
<controller host="mycontroller.mycompany.com" port="8090" ssl="false">
<!--Configure multiple business applications-->
<applications>
<application name="Ticket Search" default ="true"/>
<application name="Travel Search"/>
</applications>
</controller>
...

4. Add configuration elements for the IIS applications or application pools, Windows services,
or standalone applications to instrument.
For IIS applications, add the IIS Applications block as a child of the IIS element. Replace
any existing <applications> element. For more information, see IIS Applications Element
.
Show IIS Application configuration.
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<applications>
<application path="/" site="FirstSite"
controller-application="Application1">
<tier name="FirstSite Tier"/>
</application>
<application path="/" site="SecondSite"
controller-application="Application2">
<tier name="SecondSite Tier"/>
</application>
</applications>

For IIS application pools, add the IIS Application Pools block as a child of the IIS element.
Replace any existing <application-pools> element. For more information, see IIS
Application Pools Element.
Show IIS Application Pool configuration.
<application-pools>
<application-pool name="MyAppPool1"
controller-application="Application1">
<tier name="App1 AppPool Tier"/>
</application-pool>
<application-pool name="MyAppPool2"
controller-application="Application2">
<tier name="App2 AppPool Tier"/>
</application-pool>
</application-pools>

For Windows services, add the Windows Services block as a child of the App Agents ele
ment. For more information, see Windows Services Element.
Show Windows service configuration.
<windows-services>
<windows-service name="Service1"
controller-application="Application1">
<tier name="App1 Service Tier"/>
</windows-service>
<windows-service name="Service2"
controller-application="Application2">
<tier name="App2 Service Tier"/>
</windows-service>
</windows-services>

For standalone applications, add the Standalone Applications block as a child of the App
Agents element. For more information, see Standalone Applications Element.
Show standalone application configuration.
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<standalone-applications>
<standalone-application executable="App1.exe"
controller-application="ApplicationName1">
<tier name="App1 Standalone Tier"/>
</standalone-application>
<standalone-application executable="App2.exe"
controller-application="ApplicationName2">
<tier name="App2 Standalone Tier"/>
</standalone-application>
</standalone-applications>

5. Configure your application elements as follows:
Add the corresponding element for each IIS application or application pool, Windows
service, or standalone application to instrument. For information on specific elements
see .NET Agent Configuration Properties.
For each application element set the controller-application attribute to the name of
the corresponding business application. If you omit the controller-application attribute,
the agent adds the application to a tier in the configured default business application.
Set the Tier element name attribute to the business application tier name.
6. After you complete configuration, save the changes to config.xml.
7. Restart the AppDynamics.Agent.Coordinator service.
8. Restart IIS applications or application pools, Windows services, or standalone applications.
9. As your applications begin processing traffic, the agent registers them with the Controller.
Log on to the Controller to see that your applications have registered with the corresponding
business application.
Sample Configuration

This sample config.xml demonstrates configuration for multiple business applications in the
Controller. Because the Windows service TicketService doesn't specify a controller-application
attribute, it reports to the default business application Ticket Search Engine. All applications in the
TravelAPIPool report to the Travel Search Engine.
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<?xml version="1.0" encoding="utf-8"?>
<appdynamics-agent
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
<controller host="mycontroller.mycompany.com" port="8090"
ssl="false">
<!--Configure multiple business applications-->
<applications>
<application name="Ticket Search Engine" default ="true"/>
<application name="Travel Search Engine"/>
</applications>
</controller>
<machine-agent />
<app-agents>
<IIS>
<automatic enabled="false" />
<application-pools>
<application-pool name="TravelAPIPool"
controller-application="Travel Search Engine">
<tier name="Travel APIs"/>
</application-pool>
</application-pools>
<applications>
<application path="/" site="TicketSearch"
controller-application="Ticket Search Engine">
<tier name="Ticket Search Web"/>
</application>
<application path="/" site="TravelSearch"
controller-application="Travel Search Engine">
<tier name="Travel Search Web"/>
</application>
</applications>
</IIS>
<windows-services>
<windows-service name="TicketService">
<tier name="Ticket Service"/>
</windows-service>
</windows-services>
</app-agents>
</appdynamics-agent>

Agent Configuration Properties for Multiple Application Support

This section describes the configuration properties that apply to multiple business application
support. These configuration properties are in addition to and supersede the ones documented in .
NET Agent Configuration Properties.
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Controller Applications Element

The Controller Applications element is a child of the Controller element. It is a container
element for all controller applications elements that map to business applications in the Controller.
Required Element: <applications>
Controller Application Element

The Controller Application element is a child of the Controller Applications element. It
indicates the name of the logical business application you see in the Controller. When you have
more than one Controller Application element, you must set the default attribute to "true" for one of
them.
Required Element: <application name="MyDotNetApplication" default="true"/>
Application name attribute

Set the application name attribute to the business application name in the Controller. If the
application name does not exist, the Controller creates it when the agent registers.
Type: String
Default: None
Required: Yes
Application default attribute

Set the application default attribute to "true" for one Controller Application element.
Instrumented applications without the controller-application attribute register with the default
business application in the Controller.
Type: Boolean
Default: false
Required: For one application in multiple application configurations
Controller-Application Attribute

The IIS Application, IIS Application Pool, Windows Service, and Standalone Application ele
ments accept the controller-application attribute. Set the value to the Controller Application ele
ment name. If you don't include a controller-application attribute, the application registers with the
default business application.
For example, an IIS application:
<application path="/" site="MySite" controller-application="My Business
Application">
Type: String
Default: None
Required: No

Monitor .NET Applications
Monitor CLRs
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Monitor IIS
Monitor Oracle Backends for .NET with AppDynamics for Databases
Monitor Service Endpoints for .NET
Machine Snapshots for .NET
Monitor Memory Usage with Object Instance Tracking for .NET
Monitor Async Backends for .NET
The .NET embedded machine agent reports hardware metrics such as:
CPU activity
Memory usage
Disk reads and writes
Network traffic
When IIS is installed on the machine, the .NET machine agent also reports IIS, ASP.NET and
ASP.NET Application metrics. See Monitor IIS.
The .NET Agent reports CLR metrics, which are also based on MS Performance Counters. See M
onitor CLRs.
If you install the Standalone Machine Agent, a Java application, in a .NET environment, then you
can add custom monitors and extensions such as the HTTP listener. See Standalone Machine
Agent for details.
Learn More

Monitor Databases
Monitor Remote Services
Monitor CLRs
CLR Metrics
To access the Node Dashboard
To access the Metric Browser
Alerting for CLR Health
Learn More
AppDynamics uses Microsoft Windows Performance Counters to gather .NET metrics. These
preconfigured CLR metrics can be viewed from the Node Dashboard and in the Metric Browser.
Refer to the Microsoft documentation for more information:
General overview: Performance Counters
ASP.NET Counters: Performance Counters for ASP.NET
CLR Metrics

CLR metrics give insight into how the .NET runtime is performing. The AppDynamics
preconfigured CLR metrics include:
.NET CLR memory usage
Total classes loaded and how many are currently loaded
Garbage collection time spent, and detailed metrics about GC memory pools and caching
Locks and thread usage
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Memory heap and non-heap usage, including the large object heap
Percent CPU process usage
To access the Node Dashboard

1. Select the business application.
2. In the left navigation pane, click Servers -> App Servers -> <Tier> -> <Node>.
AppDynamics displays the Node Dashboard for the selected node.
3. Click the tab for the metrics you want to view.

See Node Dashboard for more details.
To access the Metric Browser

1.
2.
3.
4.
5.

In the left navigation pane of the Controller, click Analyze -> Metric Browser.
Expand the Application Infrastructure Performance branch of the Metric Tree.
Expand the tier that you want to view.
Expand the tree for each category of metrics.
To view the CLR metrics in the Metric Browser, expand Application Infrastructure
Performance -> <Node> -> CLR.
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See Metric Browser for more details.
Alerting for CLR Health

You can set up health rules based on the infrastructure metrics. Once you have a health rule, you
can create specific policies based on health rule violations. One type of response to a health rule
violation is an alert.
In addition to the default metrics, you may be interested in additional metrics. You can specify
additional performance counters to be reported by the .NET Machine Agent. See Enable
Monitoring for Windows Performance Counters for details.
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Once you add a custom metric you can create a health rule for it and receive alerts when
conditions indicate problems.
See Alert and Respond for details on health rules and policies.
Learn More

Monitor Infrastructure
Performance Counters for ASP.NET (external website)
Install the .NET Agent
Enable Monitoring for Windows Performance Counters
Monitor CLR Crashes

To monitor for CLR crash events
To analyze and respond to CLR crash events
To disable CLR crash event reporting
About crash events the .NET Machine Agent monitors
The .NET Machine Agent monitors Windows for non-graceful CLR shutdowns on IIS and raises
CLR crash events in the Controller when such crashes occur. Use a policy to alert responsible
parties when the agent reports a CLR crash.
To monitor for CLR crash events

Create a policy that sends notifications when a CLR crash event occurs.
1. Verify your Email / SMS Configuration. See Configure the SMTP Server.
2. Create a notification action configured to alert the parties who respond to CLR crashes. See
Notification Actions.
3. Create a policy to trigger on CLR Crash under Other Events on the Create Policy window.
For the action, choose the notification action you created in step 2. See Configure Policies.
After you create the policy, the Controller sends a notification when the .NET Machine Agent
raises CLR crash events.
To analyze and respond to CLR crash events

When an IIS CLR crashes, the .NET Machine Agent raises an event in the Controller. The events
pane on the application dashboard displays the number of server crash events, including CLR
crashes, during the selected time range.
1. Click the Server Crashes link in the application dashboard to display a list of all server
crash events during the selected time range.
2. Optionally filter on the CLR Crash event type.
Entries for individual CLR crashes display information about the crash event, including the
process id and the Windows event log id.
After a CLR crash, IIS automatically tries to restart the CLR, so one issue frequently
causes multiple CLR crash events.
3. Double-click a CLR Crash type event to display more information in the CLR Crash window:
The Summary tab shows the Windows process id of the w3wp process that crashed
and the Windows event log id for the crash. The summary also includes the affected
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3.

tier and node names.
If multiple tiers have nodes on the same machine, you may see more than one tier
in the CLR Crash window.
The Details tab displays essential information about the crash including the following:
the Computer where the crash occurred
the Windows event log Event Level
the Windows Event Log Name
the time Windows logged the event
Event Messages from the Windows event log entry
the Windows Event Source
The Actions Executed tab shows any actions the event triggers. See To monitor for
CLR crash events.
Read and add new comments on the Comments tab. For example, add a comment to the
CLR crash event to notify colleagues that you're triaging the issue.
To disable CLR crash event reporting

The .NET Machine Agent enables CLR crash event reporting by default. Disable it as follows:
1. Edit the agent config.xml as an administrator. See Where to Configure App Agent Properties
.
2. Set enabled="false" for the CLR Crash Reporting element. See CLR Crash Reporting
Element.
3. Restart the AppDynamics.Agent.Coordinator service.
About crash events the .NET Machine Agent monitors

The .NET Machine Agent listens on the following Windows event logs for crash events:
Application Log
System Log
The agent listens for events logged at event level "Warning" and higher on the following sources:
Application Error
.NET Runtime
WAS (Windows Process Activation Service)
The agent listens for events logged at event level "Information" and higher on the following source:
Windows Error Reporting
The agent reports events related to CLR crashes for all w3wp processes to the Controller, even if
you aren't monitoring the process. The Controller treats all events as "Warning" severity, which is
not directly related to the Windows event level.

Monitor IIS

Default Metrics Available in the .NET Environment
ASP.NET Metrics
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ASP.NET Application Metrics
IIS Metrics
Monitoring IIS Application Pools
To view the IIS application pools:
The AppDynamics .NET Agent includes the .NET Machine Agent that runs as part of the
AppDynamics.Agent.Coordinator service. Among other things, the Machine Agent regularly
gathers system performance data and reports it back to the Controller as metrics.
The .NET Machine Agent uses Microsoft Windows Performance Counters to gather .NET metrics.
In the Controller, you can view preconfigured metrics for IIS in the Metric Browser.
For more information on Windows Performance Counters, refer to the Microsoft documentation Pe
rformance Counters for ASP.NET.
Default Metrics Available in the .NET Environment

Internet Information Services (IIS) must be installed on the machine for you to view the metrics
for the following:
IIS
ASP.NET
ASP.NET Application
ASP.NET Metrics

To view the ASP.NET metrics in the Metric Browser, expand Application Infrastructure
Performance -> <Node> -> ASP.NET.
AppDynamics reports the following ASP.NET metrics:
Application Restarts
Applications Running
Requests Disconnected
Requests Queued
Requests Rejected
Request Wait Time
Worker Process Restarts
ASP.NET Application Metrics

To view the ASP.NET Application metrics in the Metric Browser, expand Application
Infrastructure Performance -> <Node> -> ASP.NET Applications.
AppDynamics reports the following ASP.NET Application metrics:
Anonymous Requests
Anonymous Requests/sec
Cache Total Entries
Cache Total Hit Ratio
Cache Total Turnover Rate
Cache API Entries
Cache API Hit Ratio
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Cache API Turnover Rate
Errors Unhandled During Execution/sec
Errors Total/sec
Errors During Preprocessing
Errors During Compilation
Errors During Execution
Errors Unhandled During Execution
Errors Unhandled During Execution/sec
Errors Total
Errors Total/sec
Output Cache Entries
Output Cache Hit Ratio
Output Cache Turnover Rate
Pipeline Instance Count
Requests Executing
Requests Failed
Requests In Application Queue
Requests Not Found
Requests Not Authorized
Requests Succeeded
Requests Timed Out
Requests Total
Requests/sec
Session State Server Connections Total
Session SQL Server Connections Total
Sessions Active
Sessions Abandoned
Sessions Timed Out
Sessions Total
Transactions Aborted
Transactions Committed
Transactions Pending
Transactions Total
Transactions/sec
IIS Metrics

From the Metric Browser:
To view the IIS metrics for a tier, expand Application Infrastructure Performance ->
<Tier> -> IIS.
To View the IIS metrics for a node, expand Application Infrastructure Performance ->
<Tier> -> Individual Nodes -> <Node> -> IIS.
AppDynamics reports each metric for the entire tier, each individual application pool, and each
individual node as follows:
Application Infrastructure Performance -> <Tier> -> IIS = combined for all IIS processes
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in all Application Pools for this tier
Application Infrastructure Performance -> <Tier> -> Application Pools -> <application
pool name> = combined for all processes in this specific Application Pool
Application Infrastructure Performance -> <Tier> -> Individual Nodes -> <Node> =
metrics for the specific node
Monitoring IIS Application Pools

You can monitor the health of IIS application pools for the instrumented .NET nodes in a tier. You
can view the information by application pool, machine, and process IDs in varying hierarchies.
These groupings enable you to visualize key performance indicators for your infrastructure:
Health of the node in the specified time-range for a particular group.
App Server Agent's status in the specified time-range.
Last CLR restart.
A link to the parent tier.
To view the IIS application pools:

1. In the left navigation pane, select the tier that you want to monitor: Servers -> AppServers ->
<Tier>.
2. Click the IIS App Pools tab.
The IIS App Pools list displays.
3. (Optional) From the Group Nodes By dropdown menu, select how you want to view the
application pools and machines for this tier.

4. To view a node's dashboard, double-click the node in the list. From there you can select the
various tabs for details about performance of the node. See Node Dashboard.
If a machine or application pool name is not available for a .NET node, an "Unknown App
Pool" / "Unknown Machine" grouping is created.
Monitor Oracle Backends for .NET with AppDynamics for Databases
Configure Prerequisites
Monitor Oracle Database Backends
To monitor Oracle databases from the Controller
Learn More
Oracle ODP.NET database backends integrate with AppDynamics for Databases. This topic
covers how to configure integration and an introduction to the enhanced features.
Configure Prerequisites
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Before you can take advantage of the integration for Oracle backends with AppDynamics for
Databases, you must perform the following setup:
1. Install AppDynamics for Databases and add a collector for your Oracle database. See Install
AppDynamics for Databases and Add an AppDynamics for Databases Collector.
2. Enable integration with AppDynamics for Databases in the Controller. See Integrate with
AppDynamics for Databases.
3. Log off from the Controller, then log on again.
4. Enable the Vendor property for ADO.NET backend naming. For more information see Changing
the Default ADO.NET Automatic Discovery and Naming.

AppDynamics for Databases requires the Vendor property to identify the Oracle
database.

Monitor Oracle Database Backends

After you configure integration, AppDynamics enables links from the Controller to AppDynamics
for Databases.
To monitor Oracle databases from the Controller

1. Right-click the Oracle database and click Link to AppDynamics for Databases.
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In addition to the flow map, you can right-click the Oracle database in Servers >
Databases to display the Link to AppDynamics for Databases.
AppDynamics for Databases looks for a database match in its repository and displays the
database platform window.

2. If it doesn't find a match, you can select your database from a list and manually map it. You
only need to map the database once. The next time you link, the database platform window
displays automatically.

For information on manually mapping your database, see Manually Map a Database.
3. See Monitor Databases for more information on monitoring with AppDynamics for
Databases.

Learn More

Introduction to AppDynamics for Databases
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Monitor Databases

Monitor Service Endpoints for .NET

Overview of Service Endpoints
Working With Service Endpoints
To configure service endpoints
To view service endpoints from the tier dashboard
To analyze service endpoints in the metric browser
Node Properties
Learn More
Overview of Service Endpoints

Business transactions represent performance metrics and KPIs for the end-to-end lifetime of a
customer request. Business transactions for service-oriented applications frequently span multiple
tiers with diverse entry points. Sometimes you need to focus on the performance of a specific entry
point on a single tier. Service endpoints enable you to collect metrics and view the performance of
individual web applications and services on a specific tier. Service endpoints don't include any
data for upstream or downstream tiers.
For example, consider a Travel site that has an ASP.NET MVC front end. When a customer
searches, the /Travel/Search business transaction originates on the MVC tier that calls a WCF
service. The WCF service in turn calls external travel sites, aggregates the results, and returns the
search results to the MVC front end.

If you are solely responsible for the HWT Core Services tier or the WCF service, a service
endpoint lets you focus on the performance metrics that apply to your tier.
Working With Service Endpoints

Because you decide which
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endpoints are important,
the .NET Agent doesn't
automatically discover service
endpoints; you must configure
them. After you configure
service endpoints, you can
monitor service endpoint
performance on the tier
dashboard. Drill into a service
endpoint to see metric graphs
and transaction snapshots
where the service endpoint
executed. Use the metric
browser to analyze service
endpoint performance.
To configure service endpoints

1. Click Configure > Instru
mentation.
2. Click Service Endpoints.
3. Click a tier in the Tier list.
4. Click + to add.
5. Click to select the service
endpoint type:
ASP.NET
Web Service
WCF
Message Queues
The .NET
Agent doesn't
support service
endpoints for
MSMQ.
6. Click Next.
7. Enter the Service
Endpoint Definition.
Configure service
endpoints the same way
you configure custom
match rules. See the
following topics:
Custom Match
Rules for ASP.NET
Transactions
Custom Match
Rules for ASP.NET
Web Service
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Transactions
Custom Match
Rules for WCF
Transactions
Custom Match
Rules for Message
Queue
Transactions
AppDynamics names
the service endpoint for
the Name you enter in the
service endpoint
configuration.
8. Click Create Service
Endpoint Definition.
To view service endpoints from the tier
dashboard

1. Click Servers > App
Servers > <tier> for the
tier with the service
endpoint.
2. Click Service Endpoints
to the right of the tier flow
map. Alternatively, click
the Service Endpoints tab.
The Service Endpoints
tab displays the following
information about each
service endpoint during
the selected time frame:
Service endpoint
name
Average response
time for the
endpoint
Total calls
Calls per minute
Number of errors
Percent of all calls
resulting in errors
Service endpoint
type
3. Double-click a service
endpoint to view KPI
graphs and transaction
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3.

snapshots.

The .NET Agent
doesn't take
snapshots for
service endpoints.
This view filters
on transaction
snapshots where
the service
endpoint
executed.
Tip: Although
the .NET
Agent doesn't
automatically
discover service
endpoints,
frequently you
want to monitor
service endpoints
that match
automatically
discovered entry
points in a
business
transaction:
You can
create
service
endpoints on
the entry
point for a
business
transaction.
For
ASP.NET
service
endpoints,
you can use
the URL.
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For example,
in the Travel
Site tier: URL
matches
"/Travel/Searc
h"
For WCF
and
ASP.NET
web service
entry points,
you can use
an existing
transaction
snapshot to
find the URL
for the
service.
1. Open
a full
transa
ction
snaps
hot for
the
busine
ss
transa
ction.
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2. From
the
upstre
am
tier,
click
the
exit
call
link,
either
WCF
or We
b
Servi
ce.
The
exit
call
windo
w
shows
the
URL
for the
web
servic
e.

3. Open
the
servic
e URL
in a
brows
er.
4. On the
servic
e
page,
the url
to
acces
s the
wsdl
file.
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5. The s
ervic
e
name
eleme
nt
shows
the
servi
ce
name.
<wsdl:service name="Service1">

To analyze service endpoints in the metric browser

1. Click Analyze > Metric Browser.
2. In the Metric Browser window, click Service End Points > <tier> for the tier with the service
endpoint.
3. Click to expand the service endpoint to see metrics for all nodes. Optionally click Individual
Nodes to drill into node-specific metrics.
4. Drag metrics onto the chart. See Metric Browser.

Node Properties

The agent has a default limit of 100 service endpoints. This limit is configurable using the max-serv
ice-end-points-per-node node property.
Learn More
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Monitor Service Endpoints
Tier Dashboard
Transaction Snapshots

Machine Snapshots for .NET

Overview of Machine Snapshots
Prerequisites
Working With Machine Snapshots
Learn More
Sometimes environmental conditions cause trouble on the machines where your application runs.
Issues that occur outside monitored application code don't show up on transaction snapshots.
Machine snapshots provide critical details about CPU usage, memory usage, and the IIS queue on
a server at a specific moment in time. Use the data in machine snapshots to uncover and resolve
environmental problems.
Overview of Machine Snapshots

AppDynamics generates machine snapshots to capture the state of a server at a specific moment
in time. The machine snapshots show the processes running on the machine, the IIS application
pool activity, and any related transaction snapshots. By default the .NET Machine Agent takes
machine snapshots under the following conditions:
Periodic collection: The agent takes one snapshot every 10 minutes.
Breached thresholds: The .NET Machine agent takes samples of machine statistics every 10
seconds within a 10 minute window. For each sample, the agent checks the CPU percent
usage, the memory percent usage, and oldest item in the IIS application pool queue. The
agent flags a sample as a violation when the current usage meets or exceeds one of the
following thresholds:
CPU at 80% or higher
Memory at 80% or higher
IIS application pool queue item older than 100 milliseconds
The agent takes a snapshot when it identifies 6 violations of a single type, such as CPU
usage, within the window. The agent only takes one snapshot per window for breached
thresholds.
To customize the periodic collection or threshold settings, see Configure Machine Snapshots for
.NET.
Prerequisites

The .NET Machine Agent requires the following conditions to return machine snapshot data for IIS
application pools:
IIS 7 or later
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Enable the Request Monitor for the IIS Health Monitoring feature.

To enable Request Monitor from the Windows PowerShell command line, launch
PowerShell as an administrator and run the following command:
Install-WindowsFeature Web-Request-Monitor

Working With Machine Snapshots

The Machine Snapshot tab on the application dashboard lists all the snapshots for the selected
time range. Entries for individual snapshots show the following:
Time the .NET Machine Agent took the snapshot
Machine name for the snapshot
Snapshot trigger, either periodic snapshot collection or threshold exceeded
Percent CPU usage
Percent memory usage
Use Filters to limit the snapshot list to a specific snapshot trigger:
Periodic collection
Memory events
CPU events
IIS events
Machines where the agent took snapshots
Archived snapshots
Double-click a snapshot to open the Machine Snapshot window:
The Processes tab shows information similar to that from the Windows Task Manager,
including the following:
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Process id
Process name
Process description
Percent CPU used by the process
Percent memory used by the process
Click a column heading to sort by the column. For example, click CPU % and sort descending
to identify processes using the most CPU.

The IIS App Pools tab shows information on the active IIS application pools:
Application pool name
Arrivals to the queue per second
Queue requests processed per second
Age of the oldest item in the queue
The Transaction Snapshots tab displays all transaction snapshots involving the current
machine for five minutes prior to and five minutes after the machine snapshot. This
demonstrates how current environmental factors are affecting your business transaction
performance. For example, when CPU usage is high, you may discover slow and stalled
transactions.
Double-click a transaction snapshot to open it.
Learn More

Configure Machine Snapshots for .NET
Monitor Infrastructure
Application Dashboard
Transaction Snapshots
Monitor Memory Usage with Object Instance Tracking for .NET

Prerequisites for Object Instance Tracking
To install the Microsoft.Diagnostic.Runtime.dll
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Working With Object Instance Tracking
To enable object instance tracking on a node
To identify memory usage problems with object instance tracking
To track object instances for custom classes
Learn More
When you enable object instance tracking for a node, AppDynamics analyzes the heap to identify
classes with the most instances on the heap. AppDynamics tracks the top 20 .NET framework
classes and the top 20 application classes based upon the number of instances. Use object
instance tracking to identify memory usage trends in classes with large numbers of instances.
Prerequisites for Object Instance Tracking

The .NET Agent only supports object instance tracking for .NET 4 and later.
The .NET Agent Coordinator Service must be the same architecture as the monitored
application. For example, a 64-bit coordinator with a 64-bit IIS application.
3.9.0 and 3.9.1 only: Install the Microsoft.Diagnostics.Runtime.dll to the AppDynamics .NET
Agent application directory.
Click to expand instructions to install CLR Memory Diagnostics
To install the Microsoft.Diagnostic.Runtime.dll

1. If it is not installed, install NuGet on the machine where you plan to run object
instance tracking.
2. Download CLR Memory Diagnostics from Microsoft using the NuGet command
line.
For example, download the CLR Memory Diagnostics to a temp directory:
nuget install Microsoft.Diagnostics.Runtime -OutputDirectory
"C:\temp" -Pre

3. Copy Microsoft.Diagnostics.Runtime.dll to the AppDynamics .NET Agent
application directory.
For example:
copy "C:\temp\Microsoft.Diagnostics.Runtime.0.8.25-beta\lib\
net40\Microsoft.Diagnostics.Runtime.dll"
"%ProgramFiles%\AppDynamics\AppDynamics
.NET Agent"

See CLR Memory Diagnostics and NuGet command line reference.
Working With Object Instance Tracking
To enable object instance tracking on a node

1. In the left navigation pane, click Servers > App Servers > <tier> > <node>.
2. On the node dashboard, click the Memory tab.
3.
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3. Click the Object Instance Tracking subtab.
4. Click ON.
Once the agent completes the heap analysis, AppDynamics begins to track the top 20
application classes and the top 20 system (core .NET) classes in the heap.
When you enable object instance tracking, the application pauses during heap
analysis and cannot process requests. Enable object instance tracking while you're
diagnosing memory issues. Turn it off when you finish troubleshooting.
To identify memory usage problems with object instance tracking

Use the following guidelines to identify memory usage problems:
The controller resolution for object instances is one minute, but the .NET Agent agent only
sends data every 10 minutes, so .NET memory appears as a series of peaks over time.
It is normal for the controller to display 0 for the Current Instance Count and Shallow Size in
between instance count collection times.
Hover over a peak to display information about the instance count.
Look for trends where the peaks increase in size from left to right. This may be an indication
of a memory leak.

To track object instances for custom classes

If you want to track a class that doesn't appear in the top 20 on the Object Instance Tracking tab,
you can configure a specific class to track.
1. On the Object Instance Tracking tab, click Configure Custom Classes to Track to navigate
to the Configure Instrumentation > Memory Monitoring tab.
2. Click Add.
The Create New Instance Tracker window opens.
3. Leave Enabled checked.
4. Enter the fully qualified class name for the instance to track.
5. Click Save.
Learn More
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CLR Memory Diagnostics
NuGet command line reference
Monitor Async Backends for .NET
Asynchronous Backend Calls in .NET
Supported asynchronous exit point patterns
To enable asynchronous exit point detection
Identify Asynchronous Backend Calls in Dashboards
Troubleshoot Asynchronous Calls in Transaction Snapshots
Transaction Snapshot Flow Map
Snapshot Execution Waterfall View
Call Graph
Analyze Asynchronous Activity in the Metric Browser
Learn More
This topic describes how to enable asynchronous exit point detection in the .NET Agent. It covers
the .NET asynchronous programming patterns the agent detects and provides instruction on how
to use AppDynamics Controller features that represent asynchronous transactions.
For more information about remote services and exit points, see Monitor Remote Services and Co
nfigure Backend Detection for .NET.
Asynchronous Backend Calls in .NET

Developers use asynchronous programming patterns to create scalable, more performant
applications. Microsoft .NET lets you designate methods as asynchronous tasks. The .NET
runtime releases resources for asynchronous methods while tasks complete. When task
processing finishes, the runtime calls back to the originating asynchronous method so the method
may continue processing.
Because tasks may execute in parallel, AppDynamics sometimes represents asynchronous
activity differently from synchronous activity in the Controller.
Supported asynchronous exit point patterns

The agent discovers the following asynchronous programming patterns for HTTP, Web Service,
and WCF exit points:
Microsoft .NET 4.5 async and await keywords. See Asynchronous Programming with Async
and Await.
If the entry point on a downstream WCF tier is asynchronous, the agent doesn't detect the
transaction on the downstream tier.
New in 3.9.2, AppDynamics separates async backend tracking from thread correlation. To
configure thread correlation, see Enable Thread Correlation for .NET.
Click to expand for information exclusive to 3.9.0. and 3.9.1.
In .NET Agent versions 3.9.0 and 3.9.1, when you enable backend detection, the agent also
enables thread correlation for the following patterns:
Microsoft .NET 4.5 TaskFactory.FromAsync wrapper. See TPL and Traditional .NET
Framework Asynchronous Programming.
Asynchronous activities scheduled on the thread pool
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using ThreadPoolQueueUserWorkItem for CLR4. For more thread correlation options,
see Enable Thread Correlation for .NET.
To enable asynchronous exit point detection

To enable asynchronous exit point detection, register the async-tracking node property.
For instructions on how to set a node property, see App Agent Node Properties.
Name: async-tracking
Description: Enable detection of asynchronous exit points.
Type: Boolean
Value: True
The default value is False.
Identify Asynchronous Backend Calls in Dashboards

When AppDynamics detects asynchronous exit points in an application it labels the calls as async
in the dashboards. Because they may execute simultaneously the Controller doesn't display
percentage value of the end-to-end transaction time for asynchronous calls.
For example, consider a travel site application that asynchronously searches fares on multiple
provider sites and displays them back to the customer. In this case, the agent discovers the
asynchronous HTTP calls and displays them on the transaction flow map.

For further visibility of asynchronous calls, edit the current flow map and click Use dotted line u
nder Asynchronous Activity.
Use the transaction flow tree view of the asynchronous transaction to display errors and time spent
in asynchronous tasks.
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Troubleshoot Asynchronous Calls in Transaction Snapshots

Transaction snapshots include several features to help you discover problem areas in business
transactions that use asynchronous methods. For an overview of transaction snapshots, see Trans
action Snapshots.
Transaction Snapshot Flow Map

The Transaction Snapshot Flow Map graphically represents the business transaction. It displays
the user experience, execution time, and timestamp of the transaction. The flow map also provides
details of the overall time that is spent in a particular tier and in database and remote service calls.
The async label indicates asynchronous calls.
Snapshot Execution Waterfall View

The transaction Snapshot Execution Waterfall View shows a timeline representation of the
end-to-end execution of the business transaction. Synchronous and asynchronous processes
appear on a bar diagram illustrating their relative execution time arranged in chronological order.
The waterfall view enables you to visually identify which processes are running the longest.
Double-click a bar to drill down to a call graph and investigate problematic code.
Call Graph

When the agent detects asynchronous exit points, it displays an await link in the Exit
Calls/Threads column of the call graph in the Call Drill Down. Click the link to display a list of the
asynchronous calls. The format of the await link is as follows:
await@<tier name>

For example, the Travel Search Web tier makes asynchronous calls to the internal customer
management system and to provider backends. The link shows as "await@Travel Search Web".
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The Exit Calls and Async Activities window shows a list of the exit calls and the corresponding aw
ait continuation calls.
Exit calls display by type: HTTP, web service, or WCF.
Continuations/call backs display as await@tier name.
For example:
HTTP call to the Customer
Management tier

Continuation call back to the
Travel Search tier

Analyze Asynchronous Activity in the Metric Browser

The Metric Browser displays asynchronous activity in the following places:
Business Transaction Performance -> Business Transactions -> tier > business
transaction -> Thread Tasks -> Asynchronous Operation -> External Calls
Overall Application Performance -> tier -> Thread Tasks -> Asynchronous Operation
-> External Calls

Copyright © AppDynamics 2012-2014

Page 1592

Overall Application Performance -> tier -> Individual Nodes -> node name -> Thread
Tasks -> Asynchronous Operation -> External Calls
For example:

For more information on how to use the Metric Browser, see Metric Browser.
Learn More

Using Asynchronous Methods in ASP.NET 4.5

Tutorials for .NET
Quick Tour of the User Interface
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Overview Tutorials for .NET
Quick Tour of the User Interface

Manual Installation and Configuration
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Administer the .NET Agent
AppDynamics Applications and IIS Applications
Log Files
Additional .NET Agent Administration Topics
AppDynamics Applications and IIS Applications

Usually there is not a 1-to-1 correspondence between an AppDynamics business application and
an IIS application. A typical AppDynamics configuration assigns one IIS application per tier, and
multiple tiers to a single AppDynamics business application. For example, a front end is a single
tier, various services are represented as another tier or tiers, and they all belong to a single
business application. See Name Business Applications, Tiers, and Nodes.
Log Files

The configuration file that controls log files for the .NET Agent is located at:
%ProgramFiles%\AppDynamics\AppDynamics .NET Agent\AppDynamicsAgentLog.config

The configuration file uses NLog rules. See http://nlog-project.org/.
Additional .NET Agent Administration Topics

Disable Instrumentation for an IIS Application Pool

When to Consider Disabling Instrumentation
To disable monitoring for an IIS application pool or pools
When to Consider Disabling Instrumentation

By default when you install the .NET Agent on a machine and use automatic tier naming, the agent
instruments every IIS application. You may not need to monitor all application pools.
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To disable monitoring for an IIS application pool or pools

1. Open the config.xml file as administrator and edit the file as follows:
Windows Server 2008 and later
%ProgramData%\AppDynamics\DotNetAgent\Config\config.xml
Windows Server 2003
%AllUsersProfile%\Application Data\AppDynamics\DotNetAgent\Config\config.xml
2. Add the Application Pools block as a child of the IIS element. See .NET Agent Configuration
Properties.
<!-- Disable instrumentation for an application pool -->
<application-pools>
<!-- Do not instrument applications in DefaultAppPool when "enabled"
attribute is set to false -->
<application-pool name="DefaultAppPool" enabled="false" />
</application-pools>

3. Set the Application Pool element name attribute to the application pool name. This example
disables instrumentation for the DefaultAppPool. You may add multiple Application Pool
elements.
4. Restart the AppDynamics.Agent.Coordinator.
5. Restart IIS.
Naming Conventions for .NET Nodes
Syntax for IIS Node Names
Syntax for IIS Web Garden Node Names
Syntax for Windows Service Node Names
Syntax for Standalone Application Nodes
Maximum Number of Automatically Generated Nodes
By default the AppDynamics .NET Agent (agent) automatically names nodes. Automatic node
naming for .NET uses the application name to directly link nodes to an application process. This
node naming convention is especially useful in cases of application pools that host multiple
applications and in the case of applications in a recycle process.
If you are upgrading from the .NET Agent version 3.7.7 or earlier, the new node naming
convention takes effect upon restart. Nodes named under the old scheme become historical nodes
with no correlation to the new nodes.
Syntax for IIS Node Names

The naming pattern for IIS nodes is as follows:
<machine-name>-<tier>-<site>/<app>
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Machine Name: NetBIOS name of the local computer where the application runs
Tier: Name of the logical tier for the application. See Logical Model.
Site: IIS Site name.
App: Virtual path within the site.

The agent omits <app> when the application is the default site root application.
The agent omits <tier> when the tier name is the same as the site name.
For example:
WIN-86M7CEJO6P5-Order Server-OrderSvc
WIN-86M7CEJO6P5 is the machine name.

Order Server is the tier name.
OrderSvc is the site name. The application is the default app in the site root, so the agent
omits it.
For another example:
WIN-86M7CEJO6P5-Order Server-Store/ProcessOrder

Store is the IIS Site name.
ProcessOrder is the application name within the site.
Different .NET versions of the same application have their own versions of the CLR and run on
independent processes. Therefore the agent identifies the two processes as different nodes.
Syntax for IIS Web Garden Node Names

The syntax for web gardens is the same as IIS Nodes, except that the agent appends a process
index to differentiate between the worker processes in the web garden.
<machine-name>-<tier>-<site>/<app>-<process-index>

Process Index: Zero-based index of the process. For a web garden-IIS-hosted application with
five worker processes, the index could be 0, 1, 2, 3 or 4.
Don't confuse the process index with the Windows process id.

When IIS first launches web garden processes, the agent assigns a sequential index to each
process. However, as IIS recycles processes, the agent reuses the available indexes freed by
terminated processes. This means there will likely be no correlation between the index sequence
and the chronological start of the process.
There are edge cases where you may see more nodes than the maximum number of worker
processes. This can happen when a long-running request prevents a process from shutting down
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before its replacement launches.
Syntax for Windows Service Node Names

The naming pattern for Windows service nodes is as follows:
<machine-name>-<tier>-<service-name>

Machine Name: NetBIOS name of the local computer where the Windows service runs.
Service Name: Windows Service name as defined in the service properties window.
The agent omits <tier> when the tier name is the same as the service name.
For Example:
WIN-86M7CEJO6P5-MyWindowsService

WIN-86M7CEJO6P5 is the machine name.
MyWindowsService is the the windows Service name.
Syntax for Standalone Application Nodes

The naming pattern for standalone applications is as follows:
<machine-name>-<tier>-<executable-name>

Machine Name: NetBIOS name of the local computer where the standalone application runs.
Executable Name: Standalone application executable file name.
The agent omits <tier> when the tier name is the same as the executable name.
For Example:
WIN-86M7CEJO6P5-MyStandaloneApp.exe

WIN-86M7CEJO6P5 is the machine name.
MyStandaloneApp.exe is the executable file name.
Maximum Number of Automatically Generated Nodes

The algorithm below calculates the number of nodes the agent automatically generates. It refers to
all nodes that are alive, as historical node counts can change via retention and deletion time
frames as well as manual deletion, etc.
IISApp1_AppPool_MaxWorkerProcesses
+
IISApp2_AppPool_MaxWorkerProcesses
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+...
IISAppN_AppPool_MaxWorkerProcesses
+...
Self-Hosted Process (Windows Service, Console Application, etc)
=
Number of Nodes
In the case of a webgarden, by default AppDynamics flags a node as historical within five
minutes after it recycles. Wait 5 minutes for a recycled node to disappear from the application flow
map.
.NET Agent Configuration Properties
Overview
Where to Configure App Agent Properties
AppDynamics Agent Element
Controller Element
Controller Application Element
Account Element
Proxy Element
Machine Agent Element
Machine Snapshot Element
CLR Crash Reporting Element
Performance Counters Element
Sample Machine Agent Configuration with Performance Counters
Instrumentation Element
Sample Machine Agent Configuration with Thread Correlation Instrumentors
App Agents Element
Default Profiler Element
Profiler - Disabled Features Element
Sample Default Profiler Configuration with Disabled Features
App Agents - IIS Element
IIS Automatic Instrumentation Element
IIS Application Pools Element
IIS Application Pool Element
IIS Applications Element
Sample IIS Application Configuration
App Agents - Windows Services Element
Windows Service Element
Sample Windows Service Configuration
App Agents - Standalone Applications Element
Standalone Application Element
Sample Standalone Application Configuration
Learn More
Configure the .NET Agent properties using a single configuration file. This topic describes the
structure and content of the config.xml file to help you customize agent behavior. To use the .NET
Agent Configuration Utility, see Configure the .NET Agent.
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Overview

The .NET Agent uses a single configuration file to control agent behavior: Controller connectivity,
machine agent operations, and app agent functionality for IIS applications, Windows services, and
standalone applications such as console applications, WinForms, or WPF. Benefits of the unified
configuration file include:
Maintain agent configurations separately from web.config files.
Enable instrumentation of Windows services and standalone applications without
environment variables.
Control agent behavior for specific applications with hierarchical configuration.
To configure connection to the Controller, See Controller Element.
To configure the .NET machine agent, See Machine Agent Element.
To configure app agents for IIS applications, see App Agents - IIS Element.
To configure an app agent for a Windows service, see App Agents - Windows Services Element.
To configure an app agent for a standalone application, see App Agents - Standalone Applications
Element.
Where to Configure App Agent Properties

Configure the agent properties in the config.xml file in the agent Config directory. If you run the
.NET Agent Configuration Utility, it writes the conifg.xml to the following locations:
Windows Server 2008 and later
%ProgramData%\AppDynamics\DotNetAgent\Config\config.xml

Windows Server 2003
%AllUsersProfile%\Application Data\AppDynamics\DotNetAgent\Config\config.xml

Sample config.xml files install to the following location:
%ProgramFiles%\AppDynamics\AppDynamics .NET Agent\SampleConfigurations

After you edit the config.xml, you must restart the AppDynamics.Agent.Coordinator service.
Then restart IIS, your Windows service, or standalone application for your instrumentation
changes to take effect.

Minimal .NET App Agent controller-info.xml File
The most basic configuration demonstrates the required sections for agent configuration. This
sample instruments all IIS applications using the automatic element (<automatic />). No
Windows services or standalone applications are instrumented.
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<?xml version="1.0" encoding="utf-8"?>
<appdynamics-agent xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
<controller host="mycontroller.mycompany.com" port="8090" ssl=false">
<application name="MyDotNetApplication" />
</controller>
<machine-agent />
<app-agents>
<IIS>
<automatic />
</IIS>
</app-agents>
</appdynamics-agent>

AppDynamics Agent Element

The Appdyanmics Agent element is the root container element for configurations in the config.xml.
Required Element: <appdynamics-agent
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
Controller Element

The Controller element is a child of the AppDynamics Agent element. It specifies the connection
information for the AppDyanmics Pro Controller.
The .NET Agent configuration utility only supports configuration of one Controller per server.
Required Element: <controller host="mycontroller.mycompany.com" port="8090"
ssl="false" high_availability="false">
Controller host attribute

The Controller host attribute indicates the host name or the IP address of the AppDynamics
Controller. For an on-premise Controller, use the value for Application Server Host Name you
provided when you installed the Controller. If you use the AppDynamics SaaS Controller, see the
Welcome email from AppDynamics.
Type: String
Default: None
Required: Yes
Controller port attribute

The Controller port attribute specifies the HTTP(S) port of the AppDynamics Controller. If the
Controller ssl attribute is set to true, specify the HTTPS port of the Controller; otherwise specify the
HTTP port.
Type: Positive Integer
Default: 8090
For On-premise installations, the defaults are port 8090 for HTTP and port 8181 for HTTPS.
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For the SaaS Controller, use port 80 for HTTP or port 443 for HTTPS.
Required: Yes
Controller ssl attribute

To enable encryption over SSL between the agent and the Controller, set the Controller ssl
attribute to "true".
Type: Boolean
Default: false
Required: No
Controller high availability attribute

If you have your controller set up for high availability, set the Controller high availability attribute to
"true".
Type: Boolean
Default: false
Required: No
Controller Application Element

The Controller Application element is a child of the Controller element. It indicates the name of the
logical business application you see in the Controller interface.
The .NET Agent configuration utility only supports one business application per server.
Use tiers to organize different applications you instrument on a single server.
Or manually configure support for multiple business applications, see Configure Multiple
Business Application Support for .NET.
Required Element: <application name="MyDotNetApplication"/>
Application name attribute

Set the application name attribute to the business application you use in the controller. If the
application name does not exist, the Controller will create it when the agent registers. All
instrumented applications in the config.xml register with the same business application in the
Controller. See Logical Model.
Type: String
Default: None
Required: Yes
You specify a Tier for individual applications in the App Agents Element.
Account Element

The Account element is a child of the Controller element. If the AppDynamics Controller runs in
multi-tenant mode or if you use the AppDynamics SaaS Controller, specify the account name and
account access key for the agent to authenticate with the Controller. If you are using the
AppDynamics SaaS Controller, the account name is provided in the Welcome email from
AppDynamics.
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Optional Element: <account name="mycontroller.saas.appdynamics.com"
password="myaccesskey"/>
Account name attribute

The account name attribute indicates to the account name for the SaaS or multi-tenant Controller.
Type: String
Default: None
Required: Only for SaaS or multi-tenant Controllers
Account password attribute

The account password attribute indicates the access key for the SaaS or multi-tenant Controller.
Type: String
Default: None
Required: Only for SaaS or multi-tenant Controllers
Proxy Element

The Proxy element is a child of the Controller element. Use it to configure connection to the
Controller through a proxy server with no authentication.
Optional Element: <proxy host="proxy-name" port="3128" enabled="true"/>
Proxy host attribute

The proxy host attribute indicates the proxy server host name or IP address.
Type: String
Default: None
Required: host is required for the proxy element
Proxy port attribute

The proxy port attribute indicates the proxy server port.
Type: Positive Integer
Default: None
Required: port is required for the proxy element
Proxy enabled attribute

To enable Controller access through a proxy server, set the proxy enabled attribute to "true".
Type: Boolean
Default: false
Required: No
Machine Agent Element

The Machine Agent element is a child of the AppDynamics Agent element. An empty Machine
Agent element enables the default instrumentation for the .NET machine agent (See Monitor CLRs
and Monitor IIS). Enable optional additional Microsoft Performance Counters or .NET
Agent instrumentors as children of the Machine Agent element.
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Required Element: <machine-agent/>
Machine Snapshot Element

The Machine Snapshot element is a child of the Machine Agent element. Use it to tune the
settings for machine snapshots in your environment. If you don't specify an attribute, the agent
uses the default values for that attribute. See Machine Snapshots for .NET and Configure Machine
Snapshots for .NET.
Optional Element: <machine-snapshot enabled="true" window-size="600" samples-per
-window="60" violations-per-window="6" max-percent-cpu="80" max-percent-memor
y="80" max-queue-item-age="100" periodic-collection="600" />
Machine Snapshot enabled attribute

Set the Machine Snapshot enabled attribute to "false" to disable machine snapshots.
Type: Boolean
Default: true
Required: No

Machine Snapshot window size attribute

Specify the window size time range in seconds for the .NET Machine Agent to take samples.
During a window, the agent takes samples and checks them for breached thresholds: max percent
CPU, the max percent memory, and max queue item age.
Type: Integer
Default: 600
Required: No
Machine Snapshot samples per window attribute

Specify the number of samples the .NET Machine Agent takes during the specified window. For
example, if the window size is 600 and the samples per window is 60, the agent takes a sample
once every 10 seconds.
Type: Integer
Default: 60
Required: No
Machine Snapshot violations per window attribute

When the .NET Machine Agent detects the number of violations per window for one threshold, it
takes a snapshot. The agent only takes one snapshot per window for thresholds exceeded. For
example, if the violations per window is set to 6, and six samples show memory usage at 80% or
greater, the agent takes a snapshot. The counters for each threshold are separate.
Type: Integer
Default: 6
Required: No
Machine Snapshot max percent memory attribute
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When the .NET Machine agent detects CPU usage on the machine equals or exceeds the max
percent cpu value, it flags the sample as a violation. The minimum value is 20; the maximum value
is 100.
Type: Integer
Default: 80
Required: No
Machine Snapshot max percent cpu attribute

When the .NET Machine agent detects memory usage on the machine equals or exceeds the max
percent memory value, it flags the sample as a violation. The minimum value is 20; the maximum
value is 100.
Type: Integer
Default: 80
Required: No
Machine Snapshot max queue item age attribute

When the .NET Machine agent detects the oldest item in the IIS queue equals or exceeds the max
queue item age value in milliseconds, it flags the sample as a violation.
Type: Integer
Default: 100
Required: No
Machine Snapshot periodic collection attribute

The .NET Machine agent takes one snapshot per periodic collection time range. Specify the value
in seconds. The minimum is 60 seconds.
Type: Integer
Default: 600
Required: No
CLR Crash Reporting Element

The CLR Crash Reporting element is a child element of the Machine Agent element. Use the CLR
Crash Reporting element to control whether or not the .NET Machine Agent reports CLR crash
events to the Controller. See Monitor CLR Crashes.
Optional Element: <clrcrash-reporting enabled="true"/>
CLR Crash Reporting enabled attribute

Set the enabled attribute to "false" to stop reporting CLR Crash events to the controller.
Type: Boolean
Default: true
Required: No
Performance Counters Element

The Performance Counters element is a child of the Machine Agent element. It is a container for
all performance counters.
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Optional Element: <perf-counters>
Performance Counter element

The Performance Counter element is a child of the Performance Counters element. For a list of
performance counters to enable, see Performance Counters in the .NET Framework.
Optional Element: <perf-counter cat="category" name="name"
instance="instance"/>
Performance Counter cat attribute

The performance counter cat attribute indicates the performance counter category.
Type: String
Default: None
Required: Category is required for the Performance Counter element.
Performance Counter name attribute

The performance counter name attribute indicates the performance counter name.
Type: String
Default: None
Required: Name is required for the Performance Counter element.
Performance Counter instance attribute

The performance counter instance attribute is the performance counter instance value.
Type: String
Default: None
Required: Instance is required for the Performance Counter element.
Sample Machine Agent Configuration with Performance Counters
<machine-agent>
<!-- Additional machine level Performance Counters -->
<perf-counters>
<perf-counter cat="Network Interface" name="Bytes Sent" instance="Local
Area Connection"/>
</perf-counters>
</machine-agent>

Instrumentation Element

The Instrumentation element is a child of the Machine Agent element. It allows you to enable
additional .NET Agent instrumetors such as thread correlation or correlation for .NET remoting.
Optional Element: <instrumentation>
Instrumentor element

The Instrumentor element is a child of the Instrumentation element. The instrumentor element
specifies the .NET Agent instrumentor to implement.
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Optional Element: <instrumentor name="instrumentor name" enabled="true"/>/>
Instrumentor name attribute

The instrumentor name attribute indicates the instrumentor name.
Type: String
Default: None
Required: Name is required for the Instrumentor element.
Instrumentor enabled attribute

Set the instrumentor enabled attribute to "true" to enable instrumentation.
Type: Boolean
Default: false
Required: No.
The current configuration syntax is enabled="true". Versions prior to 3.7.8 used
disabled="false".
Sample Machine Agent Configuration with Thread Correlation Instrumentors
<machine-agent>
<!--Enable thread correlation-->
<instrumentation>
<instrumentor name="ThreadCorrelationThreadPoolCLR2Instrumentor"
enabled="true"/>
<instrumentor name="ThreadCorrelationThreadPoolCLR4Instrumentor"
enabled="true"/>
<instrumentor name="ThreadStartCLR2Instrumentor" enabled="true"/>
<instrumentor name="ThreadStartCLR4Instrumentor" enabled="true"/>
</instrumentation>
</machine-agent>

Additional .NET Agent Instrumetors

See Enable Thread Correlation for .NET.
See Enable Correlation for .NET Remoting.
See Enable Instrumentation for WCF Data Services.
App Agents Element

The App Agents element is a child of the AppDynamics Agent element. It is a container for app
agent configurations for IIS applications, Windows services, and standalone applications.
Required Element: <app-agents enabled="true">
App agents enabled attribute

To disable application monitoring on the server, set the app agents enabled attribute to "false".
Type: Boolean
Default: true
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Required: No
Default Profiler Element

The default Profiler element is a child of the App Agents element. It defines customizations to the
default profiler behavior for all instrumented .NET applications on the machine: IIS applications,
application pools, Windows services, and standalone applications.
Optional Element: <profiler>
Profiler - Disabled Features Element

New in 3.9.4, The Disabled Features element is a child of the Profiler element. Use this property
to disable data collection mechanisms at the agent level for security or privacy reasons. This
configuration overrides any configuration set by the Controller.
Optional Element: <disabled-features value="NONE"/>
Disabled features value attribute

The disabled features value is a comma separated list of features to disable. The available values
are as follows:
LOG_PAYLOAD: Override the log-request-payload node property to suppress logging http
request payloads
RAW_SQL: Override the capture-raw-sql node property to suppress logging raw sql output
CUSTOM_EXIT_SNAP_DATA: Suppress snapshot data from custom exits points
METHOD_INV_DATA_COLLECTOR: Suppress method invocation data collector user data
HTTP_DATA_COLLECTOR: Suppress HTTP request data collector user data
INFO_POINT: Suppress information point metrics
ALL: Disable all the available features
NONE: Don't disable features
Type: String
Default: NONE
Required: No
Sample Default Profiler Configuration with Disabled Features
<app-agents>
<profiler>
<disabled-features value="LOG_PAYLOAD,RAW_SQL,CUSTOM_EXIT_SNAP_DATA"/>
</profiler>
...
</app-agents>

App Agents - IIS Element

The IIS element is a child of the App Agents element. There are three options to configure IIS
applications:
Automatic configuration
Application pool configuration
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Application configuration
The settings for any application pool apply to all applications within the app pool unless the
individual application has a specific configuration.
Explicit child-level configurations override parent-level configurations. Otherwise, children inherit
parent configurations.
Optional Element: <IIS>
IIS Automatic Instrumentation Element

The Automatic element is a child of the IIS element. Use the Automatic element to enable or
disable automatic instrumentation for all IIS apps. You can configure automatic instrumentation
and manual instrumentation both. Manual configurations override automatic ones.
Optional Element: <automatic enabled="false" />
Automatic enabled attribute

Set the automatic enabled attribute to "true" to enable instrumentation for all IIS applications. This
is the default setting if you use the .NET Agent Configuration Utility automatic configuration option.
To disable automatic instrumentation for all IIS applications, set the value to "false".
Type: Boolean
Default: true
Required: No
IIS Application Pools Element

The IIS Application Pools element is a child of the IIS element. It is a container element for all the
IIS application pools you configure for instrumentation.
Optional Element: <application-pools>
IIS Application Pool Element

The Application Pool element is a child of the Application Pools element.. You may have multiple
application pool elements distinguished by the name attribute. Use the application pool element to
configure the app agent for all applications within an application pool. For more information on IIS
application pools, see Managing Application Pools in IIS.
Application-specific configurations in the IIS Applications element override application pool
configurations.
Optional Element: <application-pool name="DefaultAppPool" enabled="false">
Application pool name attribute

The application pool name attribute indicates the name of the IIS Application Pool.
Type: String
Default: None
Required: Name is required for the Application Pool element.
Application pool enabled attribute
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Set the application pool enabled attribute to "false" to disable instrumentation for all applications in
the application pool. Set the value to "true" to instrument all applications in the application pool.
Type: Boolean
Default: None. Defaults to true if not specified.
Required: No
Application Pool Tier Element

The Tier element is a child of the Application Pool element. If you enable instrumentation for an
Application pool, you must use a Tier element to assign the pool's applications to a tier in the
Controller. See Logical Model.
Required Element: <tier name="Inventory" />
Tier name attribute

Use the tier name attribute to specify the tier.
Type: String
Default: None
Required: Yes
IIS Applications Element

The IIS Applications element is a child of the IIS element. It is a container element for all the IIS
applications you configure for instrumentation.
Optional Element: <applications>
Application Element

The Application element is a child of the Applications element. Use multiple application elements
to instrument different sites and applications. To learn more about IIS sites and applications, see U
nderstanding Sites, Applications, and Virtual Directories on IIS 7 and Above.
Optional Element: <application path="/" site="FirstSite" port="8008">
Application site attribute

The application site attribute indicates the root site in IIS for the application.
Type: String
Default: None
Required: Site is required for the Application element.
Application path attribute

The application path attribute indicates the application's path relative to the root site. Use the
forward slash to indicate the root site and instrument all children applications. Use the path to an
application to instrument the specific application and any children.
For example: Site1 hosts two applications AppX and AppY. To instrument Site 1, AppY and AppZ,
set the path to "/". To instrument AppY, but not AppZ, set the path to "/AppY".
Type: String
Default: /
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Required: Path is required for the Application element.
Application port attribute

For cases where two or more sites in IIS 6 have the same site name, set the site port attribute to
differentiate between the sites.
Type: Positive Integer
Default: None
Required: No
Application enabled attribute

In certain cases you may want to enable instrumentation for a parent application, but disable it for
a child application. In this case create an Application element for the child application to disable
and set the application enabled attribute to to "false".
Type: Boolean
Default: true
Required: No
Application Tier Element

The Tier element is a child of the Application element. If you enable instrumentation for an
application, your must use a Tier element to assign the application to a tier in the Controller. See L
ogical Model.
Required Element: <tier name="Consumer" />
Tier name attribute

The tier name attribute indicates the business application tier.
Type: String
Default: None
Required: Yes
Sample IIS Application Configuration
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<IIS>
<!-- Automatic instruments all IIS applications when enabled -->
<automatic enabled="false" />
<!-- Application Pool agent configurations -->
<application-pools>
<!-- Do not instrument applications in DefaultAppPool when "enabled"
attribute is set to false -->
<application-pool name="DefaultAppPool" enabled="false">
<tier name="Tier Name"/>
</application-pool>
<!-- Instrument applications in the OtherAppPpool and assign them to the
Inventory tier -->
<application-pool name="OtherAppPool">
<tier name="Inventory"/>
</application-pool>
</application-pools>
<applications>
<!-- Instrument all applications in the First Site -->
<application path="/" site="FirstSite">
<tier name="Order"/>
</application>
<!-- Instrument the /app application and child apps in the Second Site
-->
<!-- but not the root Second Site application -->
<application path="/app" site="SecondSite">
<tier name="Consumer"/>
</application>
</applications>
</IIS>

App Agents - Windows Services Element

The Windows Services element is a child of the App Agents element. It is a container element for
all the Windows Services you configure for instrumentation.
For instructions to instrument Windows services, see Enable the .NET Agent for Windows
Services.
Optional Element: <windows-services>
Windows Service Element

The Windows Service element is a child of the Windows Services element. It specifies a Windows
service to instrument.
Optional Element: <windows-service name="MyWindowsService">
Service name attribute

The service name attribute indicates the service name for the Windows service to instrument.
Use the value of the Service name from the service properties window. Do not use the Display
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name.
Type: String
Default: None
Required: Yes
Service app-domain-name attribute

For applications with multiple application domains, the app-domain-name attribute enables you to
limit instrumentation to specific application domains. See Configure Application Domain Monitoring
.
Type: String
Default: None
Required: No
Windows Service Tier Element

The Tier element is a child of the Windows Service element. If you enable instrumentation for an
application, your must use a Tier element to assign the application to a tier in the Controller. See L
ogical Model.
Required Element: <tier name="Consumer" />
Tier name attribute

The tier name attribute indicates the business application tier.
Type: String
Default: None
Required: Yes
Sample Windows Service Configuration
<windows-services>
<windows-service name="MyWindowsService">
<tier name="Service Tier"/>
</windows-service>
</windows-services>

App Agents - Standalone Applications Element

The Standalone Applications element is a child of the App Agents element. It is a container
element for all the standalone applications you configure for instrumentation.
For instructions to instrument standalone applications, see Enable the .NET Agent for
Standalone Applications.
Optional Element: <standalone-applications>
Standalone Application Element

The Standalone Application element is a child of the Standalone Applications element. It specifies
a standalone application to instrument.
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Optional Element: <standalone-application
executable="MyWindowsApplication.exe">
Standalone Application executable attribute

The standalone application executable attribute specifies the file name of the Windows application
to instrument.
Only use the application file name. Do not include the full path to the file. For example, if you
want to instrument, C:\Program Files\My Application\MyApp.exe, the executable value is
"MyApp.exe". The file extension is optional, so "MyApp" also works.
Type: String
Default: None
Required: Yes
Standalone application app-domain-name attribute

For applications with multiple application domains, the app-domain-name attribute enables you to
limit instrumentation to specific application domains. See Configure Application Domain Monitoring
.
Type: String
Default: None
Required: No
Standalone Application Tier Element

The Tier element is a child of the Standalone Application element. If you enable instrumentation
for an application, your must use a Tier element to assign the application to a tier in the Controller.
See Logical Model.
Required Element: <tier name="Consumer" />
Tier name attribute

The tier name attribute indicates the business application tier.
Type: String
Default: None
Required: Yes
Sample Standalone Application Configuration
<standalone-applications>
<standalone-application executable="MyWindowsApplication.exe">
<tier name="StandaloneApplication Tier"/>
</standalone-application>
</standalone-applications>

Learn More

Logical Model
Name Business Applications, Tiers, and Nodes
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Configure the .NET Agent
Enable the .NET Agent for Windows Services
Enable the .NET Agent for Standalone Applications

APM Overview - PHP
This information covers using AppDynamics for PHP applications and environments. For general
information see Application Intelligence Platform and AppDynamics Features. For information
about supported platforms see Supported Platform Matrix for the PHP Agent.
Monitor PHP Application
Problems

Troubleshoot Application
Problems - PHP

Supported Environments and
Versions for PHP
AppDynamics for PHP
Architecture

Install AppDynamics for PHP

Configure AppDynamics for PHP

Supported Environments and Versions for PHP
Supported Platform Matrix for the PHP Agent
PHP Versions
PHP 5.2 Note
PHP ZTS Note
PHP Web Servers
Operating Systems
Architecture
PHP Frameworks and Protocols
Transaction Naming
HTTP Exit Points
Database Exit Points
Cache Exit Points
Web Service Exit Points
Message Queue Exit Points
Opcode Cache Compatibility
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Correlation with AppDynamics for Databases
Supported Platform Matrix for the PHP Agent
PHP Versions

Supported PHP Versions

Comment

5.2

Does not detect mysqli backends instantiated
with the new keyword. See note below.

5.3
5.4
5.5
PHP 5.2 Note

The PHP Agent is incompatible with PHP 5.2 applications that use the new keyword to instantiate
a mysqli backend.
For example, AppDynamics will not detect the mysqli backend created by a PHP 5.2 application
that uses an expression like this:
// Does not get detected.
$db = new mysqli("localhost", "user", "password", "database");

The workaround is to change such expressions to use mysqli_connect():
$db = mysqli_connect("localhost", "user", "password", "database");

PHP ZTS Note

The PHP Agent is incompatible with the mode of PHP called Zend Thread Safety (ZTS).
If you are using ZTS, AppDynamics suggests that you review your dependencies on ZTS to
confirm that you actually need it, and if you do not, to switch to non-ZTS mode.
If you have a legacy infrastructure which requires ZTS or an app library that needs it, such as
pthreads, contact AppDynamics Support.
PHP Web Servers

Supported Web Server

Version

Comment

Apache

2.2

in prefork mode using
mod_php

Apache

2.4

in prefork mode using
mod_php
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Apache

2.2

in worker MPM mode using
mod_fastcgi with php-fpm or
mod_fcgid with php-cgi

Apache 2.4

2.4

in worker MPM mode using
mod_fastcgi with php-fpm or
mod_fcgid with php-cgi

Supported Operating
System

Version

Comment

RHEL/CentOS

5.8+

SELinux is disabled.

Ubuntu/Debian

10+

SELinux is disabled.

Framework/Protocol

Version

Entry Point Type

Drupal

7

Drupal entry

WordPress

3.4 & 3.5

Wordpress

Zend

1&2

PHP MVC

Any Web Server compatible
with php-fpm

Operating Systems

Architecture

Supported Architecture
32-bit
64-bit
PHP Frameworks and Protocols
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CodeIgniter

2.x

PHP MVC

FuelPHP

1.5x & 1.6x

PHP MVC

Magento

1.5, 1.6 & 1.7

PHP MVC

Symfony

1&2

PHP MVC

CakePHP

2.x

PHP MVC

HTTP

PHP Web

CLI

PHP CLI

If your PHP framework is not listed here, the agent detects your entry points as PHP Web and
names the business transactions based on the first two segments of the URI (the default naming
convention for PHP Web transactions). So it is still possible to monitor applications on
"unsupported" frameworks. You can modify the naming convention used for PHP Web Entry
points. See PHP Web Transaction Naming.
Transaction Naming

Framework/Environment

Default Transaction Naming

Drupal

page callback name

Wordpress

template name

PHP MVC Frameworks

controller:action

PHP Modular MVC Frameworks

module:controller:action

PHP Web

URI

PHP Web Service

service name.operation name

PHP CLI

last two segments of the script's directory path
plus the name of the script

Virtual host prefixing is available for all supported entry point types except PHP CLI.
HTTP Exit Points

Supported HTTP Exit Points
curl/curl-multi
drupal_http_request()
fopen(), file_get_contents()
NuSOAP 0.9.5
Zend_HTTP_Client::request()
Database Exit Points
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Supported Database Exit Points
MySQL old native driver
MySQLi Extension
OCI8
PDO
Cache Exit Points

Supported Cache Exit Points

Version

Memcache
Memcached
Predis

0.8.5

Predis is supported on PHP versions 5.3 and higher.
Although Predis is a full PHP client library, the PHP Agent supports Predis as an exit point only,
not as an entry point.
Web Service Exit Points

Supported Web Service Exit Points
NuSOAP 0.9.5
Message Queue Exit Points

Supported Message Queue Exit Points
RabbitMQ
RabbitMQ support requires the amqp extension.
See also Monitor RabbitMQ Backends for PHP.
Opcode Cache Compatibility

Alternative PHP Cache (APC)
Correlation with AppDynamics for Databases

AppDynamics for Databases version 2.7.4 or higher is required if you want to correlate
AppDynamics for Databases with the PHP Agent.

AppDynamics for PHP Architecture
The PHP Agent consists of:
a PHP extension component
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a proxy component
The PHP extension component discovers, maps and tracks metrics for business transactions, app
services, and backends in your web application by injecting instrumentation into the PHP
application at runtime.
The proxy component is a Java daemon process that handles the communication between the
PHP extension component and the Controller. The proxy reports the performance metrics to the
Controller, where the data is stored, baselined, and analyzed. You can access this performance
data interactively using the Controller console or programmatically using the AppDynamics REST
API.
By default, the proxy component is automatically started when you start the PHP Agent. Certain
deployments require starting the proxy manually.
Architecture with Each Agent With Its Own Proxy

Architecture with Multi-Tenant Proxy

Install the PHP Agent
Prerequisites for Agent Installation
Install the PHP Agent
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Files Added to Your Installation
PHP configuration files
.so files
Logs
Installing the Machine Agent on a PHP Node
Learn More
You can install the PHP Agent using either a Linux shell script (install.sh) or the RPM Package
Manager (RPM).
These instructions assume that you are installing the AppDynamics PHP Agent in a standard PHP
environment, specifically:
a single PHP installation running on the Linux machine
PHP running in a single Apache or FPM pool
standard packages have been used to install PHP, Apache and/or PHP-FPM
no customizations have been made to your PHP configuration
It is possible that the installer will work if one or more of these assumptions is violated.
This installation results in an AppDynamics model of your application consisting of one application,
one tier, and one node.
Prerequisites for Agent Installation

1. Confirm that you have a supported environment installed on the server and that the server is
configured correctly to run PHP scripts.
How you do this depends on your PHP environment. For example, in our Ubuntu 12+ web server
running Apache we use:
sudo apt-get install apache2 php5 php5-cli
php -i

In our CentOS 5+ web server running Apache mod_ssl we use:
sudo yum install httpd mod_ssl php53 php53-cli
php -i

2. Confirm that your PHP was not built with the enable-debug configure option.
The PHP Agent is incompatible with PHP builds that were compiled with debugging symbols.
To determine whether your PHP was built with debugging symbols you can use the following
command:
php -i | grep -e "Debug Build"

The response should be:
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Debug Build => no

3. Install the PHP application that you want to monitor, if it is not already installed.
4. Download the the appropriate PHP agent installer for your platform.
On RedHat and CentOS:
To use the RPM installer for the 32-bit agent, download appdynamics-php-agent-agent-ver
sion-number-i686.rpm.
To use the RPM installer for the 64-bit agent, download appdynamics-php-agent-agent-ver
sion-number-x86_64.rpm.
On all other platforms:
To use install.sh for the 32-bit agent, download appdynamics-php-agent-x86-linux.tar.bz2
.
To use install.sh for the 64-bit agent, download appdynamics-php-agent-x64-linux.tar.bz2
.
If you use an on-premise Controller, download the latest version of the AppDynamics Controller.
The download site is http://download.appdynamics.com.
5. Be prepared to provide the following information to the installation script:
controller host and controller port: These are the host name or IP address and the port
number of the AppDynamics controller that the agent connects to. SaaS customers receive
this information from AppDynamics. On-premise customers establish these settings when
they install the controller.
AppDynamics application name: This is the name that you assign to the business
application you will monitor with AppDynamics.
AppDynamics tier name: This is the name that you assign to the tier you will monitor with
AppDynamics.
AppDynamics node name: This is the name of the basic unit of processing that the agent
monitors.
If you have an on-premise AppDynamics controller running in multi-tenant mode or if you are using
the AppDynamics SaaS Controller, you will also need to provide the following, which were
included in your Welcome email from AppDynamics:
AppDynamics account name
AppDynamics account key
6. Stop the Apache server.
Tip: Do not install the PHP Agent along with other non-AppDynamics Application
Performance Management (APM) tools, especially in a production environment. The
PHP agent installation may fail if there are other APM products installed in the same
managed environment.
Install the PHP Agent
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To use install.sh, see Install the PHP Agent using a Shell Script.
To use RPM, see Install the PHP Agent using RPM.
To instrument PHP CLI, see also Special Procedures for PHP CLI.
Files Added to Your Installation
PHP configuration files

For AppDynamics, the PHP configuration files of interest are the php.ini and
appdynamics_agent.ini fragment. AppDynamics settings can be found in either .ini file, depending
on the operating system under which your PHP is installed.
The PHP agent installer adds the appdynamics_agent.ini file to the directory that contains your
php.ini file. You can find this directory using the following command:
php -i | grep -e "Additional .ini files parsed"

If the installer is not able to determine the directory where the ini fragments for your PHP
deployment live, it displays the required AppDynamics ini fragment and prompts you to copy and
paste it into your main php.ini file.
Also see http://php.net/manual/en/configuration.file.php for information about possible locations.
.so files

The installer also installs the appdynamics_agent.so file in your PHP extensions directory. You
can find this directory using the following command:
php -i | grep

extension_dir

Logs

There is an agent log and a proxy log for each application.
The agent log is located at $<php_agent_install>/logs/agent.log. The log contains the transactions
that the agent processes and then sends to the proxy. The default pattern for agent log naming is:
agent.log: the current log
agent.log.1: most recent log
agent.log.2: second most recent log
agent.log.3: third most recent log
agent.log.4: fourth most recent log
agent.log.5: fifth recent log
The proxy log is located $<php_agent_install>/logs/proxy_$date.log. This log contains the
transactions that the proxy accepts from the agent and then sends to the Controller.
Installing the Machine Agent on a PHP Node

If you install the machine agent on the machine hosting the instrumented PHP node and you
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specify the tier and node name in the machine agent's controller-info.xml file, the PHP Agent will
fail to register.
To avoid this problem:
Install the PHP Agent before you install the machine agent
Do not specify the tier and node in the machine agent controller-info.xml, where it is
optional. The machine agent will pick up the tier and node from the app agent configuration.
Learn More

Install the PHP Agent using a Shell Script
Install the PHP Agent using RPM
Special Procedures for PHP CLI
Upgrade the PHP Agent
Run the Proxy Daemon Manually for PHP Agents
Resolve Installation Issues for PHP
Standalone Machine Agent Configuration Properties
Install the Standalone Machine Agent
AppDynamics for PHP Architecture
Install the Controller
Install the PHP Agent using a Shell Script
Installing the PHP Agent
To install the PHP Agent
Installation Samples
Uninstall the PHP Agent using install.sh
Learn More
Watch an AppDynamics engineer install the PHP
Agent in this AppDynamics in Action video:

Installing the PHP Agent
To install the PHP Agent

1. Untar the tarball containing the agent into a directory. The directory should be owned by the
same user that runs Apache or php-fpm. AppDynamics recommends /opt/appdynamics/php-agent.
This documentation refers to this directory as the php_agent_install directory or
$<php_agent_install>.
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cd $<php_agent_install>
tar -xvjf appdynamics-php-agent-x64-linux.tar.bz2

2. Set the following permissions on these subdirectories of your php_agent_install directory.
logs - Make the logs directory readable/writable/executable by all.
chmod 777 <php_agent_install>/logs

php - Make this directory readable and executable by all and writable by the directory owner.
chmod -R 755 <php_agent_install>

3. Run the installation script using the following syntax. Each PHP instance is a single node.
$<php_agent_install>/install.sh [-s]
[-a=<account_name>@<account_key>]
[--http-proxy-host=<proxy_host>] [--http-proxy-port=<proxy_port>] [-e
<php_ext_dir>] [-i <php_ini_dir>]
[-p <php_binary_dir>] [-v <php_version>]
<controller-host> <controller-port> <app_name> <tier_name>
<node_name>

-s option: You can optionally specify the -s option if you want the agent to use SSL
(HTTPS) to connect to the controller. In this case, set the Controller port to the HTTPS port
of the controller.
account_key and_account name: The AppDynamics account_key and account_name are
required for a controller running in multi-tenant mode. These values are provided in your
welcome email from AppDynamics.
http-proxy-host:
http-proxy-port:
http-proxy-user:
http-proxy-password-file:
Set the http-proxy-host and http-proxy-port to route data to the controller through a proxy
server. The http-proxy-host is the host name or IP address of the proxy server. The
http-proxy-port is the proxy server's HTTP or HTTPS port, whichever you are using. If you set
the http-proxy-host you must set the http-proxy-port as well.
Use the http-proxy-user and http-proxy-port if the proxy server requires credentials.
-e option: extensions directory for the appdynamics_agent.so file; needed only when the
default PHP CLI binary cannot be determined.
-i option: ini directory for the appdynamics_agent.ini file; needed only when the default PHP
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CLI binary cannot be determined.
-v option: version of PHP that you are instrumenting. Valid formats are version numbers to
one or two decimal positions; e.g. "5.4" and "5.4.21" are both valid. Needed only when the
default PHP CLI binary cannot be determined or there is no PHP CLI binary.
-p option: path to the PHP binary

By default the installer uses the PHP CLI binary to determine where to install the PHP
Agent. This works for most PHP environments.
If you are instrumenting a different PHP, use the -e option to indicate the correct
extensions directory for the appdynamics_agent.so file and the -i option for the correct ini
directory for the appdynamics_agent.ini file. If you are installing in an environment where
there is no PHP CLI binary available, you must use the -v option as well as the -e, and -i o
ptions.
If all options are used, the -e, -i and -v options have precedence over the -p option.
Installing as root
On some systems, such as Ubuntu, it is necessary to perform the installation as root. Verify
whether you need to install as root in your environment.
You can use sudo to do this. See http://linux.about.com/od/commands/l/blcmdl8_sudo.htm.

4. Restart the web server, unless you are installing an agent to monitor PHP-CLI only.
If you are running multiple installations of Apache on the same machine, run install.sh once for
each Apache, each time with the appropriate node, php_ini dir and php_ext dir options. In this
case see also Run the PHP Proxy Daemon Manually.
See Files Added to Your Installation for information about the default installation directories.
If your installation failed, see Resolve Installation Issues for PHP.
Installation Samples

Here is a sample command to install the agent on a single-tenant controller:
install.sh controller 8090 myApp myTier myNode

Here is a sample command to install the agent using SSL on a multi-tenant on-premise controller:
install.sh -s -a=PHPCust1000@9456d222-66e2-54d2-f8aabbc66c4e
controller1.appdynamics.com 8818 myApp myTier myNode

Here is a sample command to route traffic to the controller through a proxy server.
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install.sh --http-proxy-host=myproxyhost --http-proxy-port=8099
controller 8090 myApp myTier myNode

Tip: The installer overwrites your existing settings in the AppDynamics PHP Agent ini
fragment, found in appdynamics-php-agent/php/conf/appdyanmics_agent.ini. If you
configured properties in that file, you need to update them every time you run the
installer. It does not overwrite the php.ini file.
If the startup does not succeed, file a support ticket.
Uninstall the PHP Agent using install.sh

If you installed the agent using install.sh, use install.sh to uninstall it.
To uninstall:
1. Shut down the web server.
2. From the PHP agent install directory, run the PHP installer with the -u option:
install.sh -u

3. Delete the <php_agent_install> directory.
Learn More

Install the PHP Agent
Install the PHP Agent using RPM
Upgrade the PHP Agent
Resolve Installation Issues for PHP
Run the PHP Proxy Daemon Manually
AppDynamics for PHP Architecture
Install the Controller
Install the PHP Agent using RPM
Procedure for Installing PHP Agent Using RPM
RPM Environment Variables
Run the RPM Package
Using sudo to install
Updating the Installation
RPM Log File
Uninstall the Agent for PHP using RPM
Learn More
The RPM package lets you automate the installation of the PHP Agent.
RPM is supported on RHEL and CentOS. You must run the package as root.
RPM installs one agent at a time. Installation of multiple agents is not supported.
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Procedure for Installing PHP Agent Using RPM

1. Download the RPM package from the AppDynamics download site.
2. Set the environment variables. RPM gets its installation information from the environment, not
from the command-line. See RPM Environment Variables.
3. Run the RPM package. See Run the RPM Package.
4. If there are errors, examine the log file. See RPM Log File.
See also Resolve Installation Issues for PHP
5. Restart Apache, unless you are installing an agent to monitor PHP CLI only.
RPM Environment Variables

The RPM installer attempts to determine the location of your PHP installation based on the PATH
environment variable. It uses the first PHP installation that it encounters in the PATH to configure
the installer. If you have installed PHP in a non-standard location, you must provide the directory
of your PHP binary in APPD_PHP_PATH.
You can route data to the controller through a proxy server, but proxy servers that require a
username and password are not supported.
The installer uses the default values for the other variables if you do not set them.
Set the APPD environment variables at the operating system level. You may want to use a script
to set the environment variables.
Environment
Variable

Description

Default

Required?

APPD_PHP_PATH

Directory containing
the PHP binary

None

if your PHP binary is
not in a standard
location. By default
the installer uses the
PHP CLI binary to
determine where to
install the app agent.

APPD_PHP_CONFIG
URATION_DIR

INI directory in which
to install the
appdynamics_agent.i
ni file. Takes
precedence over the
APPD_PHP_PATH
setting.

Directory containing
your php.ini file. See
Files Added to Your
Installation.

if your PHP binary is
not in the standard
location or if no PHP
CLI binary is
available.

APPD_PHP_EXTEN
SION_DIR

Extensions directory
in which to install the
appdynamics_agent.s
o file. Takes
precedence over the
APPD_PHP_PATH
setting.

Your PHP extensions
directory. See Files
Added to Your
Installation.

if your PHP binary is
not in the standard
location or if no PHP
CLI binary is
available.
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APPD_PHP_VERSIO
N

Version of PHP that
you are instrumenting.
Valid formats are
version numbers to
one or two decimal
positions; e.g. "5.4"
and "5.4.21" are both
valid. Takes
precedence over the
APPD_PHP_PATH
setting.

Version used by your
PHP CLI binary

APPD_CONF_CONT
ROLLER_HOST

Controller host name

"localhost"

APPD_CONF_CONT
ROLLER_PORT

Controller port

8080

APPD_CONF_APP

Application name

"MyApp"

APPD_CONF_TIER

Tier name

Hostname of the
machine running the
script (same as the
node name)

APPD_CONF_NODE

Node name

Hostname of the
machine running the
script

APPD_CONF_ACCO
UNT_NAME

Account name

None

if you have an
on-premise
AppDynamics
controller running in
multi-tenant mode or
if you are using the
AppDynamics SaaS
Controller.

APPD_CONF_ACCE
SS_KEY

Account key

None

if you have an
on-premise
AppDynamics
controller running in
multi-tenant mode or
if you are using the
AppDynamics SaaS
Controller.

APPD_CONF_SSL_E
NABLED

true to enable SSL
communication with
the controller, false
otherwise

false
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APPD_CONF_HTTP_
PROXY_HOST

Hostname or IP
address of the http
proxy server

None

if you want to route
data to the controller
through a proxy
server.

APPD_CONF_HTTP_
PROXY_PORT

HTTP or HTTPS port
of the http proxy
server; must be set if
APPD_CONF_HTTP_
PROXY_HOST is set

None

if you want to route
data to the controller
through a proxy
server.

APPD_CONF_HTTP_
PROXY_USER

username on the http
proxy server

None

if you want to route
data to the controller
through a proxy
server that requires a
username.

APPD_CONF_HTTP_
PROXY_PASSWOR
D_FILE

password on the http
proxy server

None

you want to route
data to the controller
through a proxy
server that requires a
password.

APPD_PROXY_CTR
L_DIR

initial control
communication
directory between the
agent and the Java
proxy

None

if you need to start
the proxy manually.

Run the RPM Package

To run the installer package:
rpm -i <package-name>

If you have multiple installations of PHP on one machine, run the package once for each PHP
installation, each time with the appropriate APPD_PHP_PATH and APPD_CONF_NODE settings.
Using sudo to install

If you are using sudo to pass the environment variables to the installation script you can use:
sudo APPD_PHP_PATH=/opt/php rpm -i <package-name>

or
APPD_PHP_PATH=/opt/php sudo -E rpm -i <package-name>
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Updating the Installation

Any changes that you made to the configuration files are preserved when you re-run the installer.
RPM saves your original settings and appdynamics_agent_log4cxx.xml files with the settings from
the previous installation.
RPM Log File

If the installation succeeds, no log file is generated.
If there were errors, a message displays the location of the log file generated in the /tmp directory.
Examine this log file to identify the cause of the problem.
Uninstall the Agent for PHP using RPM

If you installed the agent using RPM, use RPM to uninstall it.
To uninstall:
rpm -e appdynamics-php-agent-<version>

To find the version of the package that you installed you can use:
rpm -qa | grep appdynamics-php-agent

The existing configurations are saved in a tarball in /tmp, the location of which will be displayed
after the uninstall completes.
Learn More

Install the PHP Agent
Install the PHP Agent using a Shell Script
Run the Proxy Daemon Manually for PHP Agents
Resolve Installation Issues for PHP
AppDynamics for PHP Architecture
Install the Controller
Upgrade the PHP Agent
If you are upgrading both the Controller and agents, first upgrade the Controller and then upgrade
the agents.
Also, if you are upgrading multiple agents in your monitored environment, upgrade the agents for
the tiers on which business transactions originate last. For more information about this
requirement, along with Controller and agent compatibility information, see Agent - Controller
Compatibility Matrix.
To upgrade the app agent

1. Shut down the web server or php-fpm.
2. Copy the controller host, controller port, application name, tier name and node name property
values from your ini file.
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If you are running in multi-tenant mode, also copy the account name and account access key
property values.
3. Recursively remove or rename the old AppDynamics PHP installation directory.
4. Download and extract the most recent agent tarball.
5. Run the installation script, using the values that you copied from controller-info.xml for the
parameters.
6. Restart Apache or php-fpm.
If you are using the agent to monitor PHP CLI without running a web server, you can omit
steps 1 and 6.
Learn More

Install the PHP Agent
Uninstall the PHP Agent
Resolve Installation Issues for PHP
Agent - Controller Compatibility Matrix
Uninstall the PHP Agent
Uninstalling the PHP Agent
To uninstall the app agent:

1. Shut down Apache.
If you are using the agent to monitor PHP CLI without running a web server, you can omit step 1.
2. Do one of the following:
If the agent was installed with the shell script installer, enter:
install.sh -u

Then delete the <php_agent_install> directory.
If the agent was installed with the RPM installer, enter:
rpm -e appdynamics-php-agent-<version>

where <version> is the package you installed. You can find the version using:
rpm -qa | grep appdynamics-php-agent

Agents Installed with the Agent Download Wizard

If your agent was downloaded and installed using the Agent Download Wizard, it might not be
obvious which installer was used. The name of the actual installer called by the runme.sh
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command in the wizard is hidden from the user.
Normally, if RHEL and CentOS was selected in the wizard, the RPM installer was used. If All
Other LInux OS was selected in the wizard, the shell script installer was used. So use the
appropriate uninstall command based on the command that was used to install the agent..
If you do not know which selection was checked in the wizard, run
rpm -qa | grep appdynamics-php-agent

If this does not list any results, assume that the shell script installer was used to install the agent.
Learn More

Install the PHP Agent using a Shell Script
Install the PHP Agent using RPM
Quick Install for the PHP Agent
Resolve Installation Issues for PHP
Determine whether the installer installed in the correct directory.
To reinstall the agent
Check error messages in the installation output
Verify that the AppDynamics settings block exists in the configuration file.
Confirm that the correct permissions are set for the installation directory.
Confirm that the proxy is running.
To confirm whether the proxy is running
Check the Configuration Properties.
If you installed the PHP Agent, started up your instrumented server, and your application is
receiving traffic but no metrics are being reported, try these suggestions for investigating
installation issues.
Determine whether the installer installed in the correct directory.

It is possible that the agent was installed in the wrong directory. Verify the location of your PHP
installation.
Verify the location of your PHP by running phpinfo. See http://us1.php.net/phpinfo.
Then check where the installer actually installed the agent files.
The appdynamics_agent.ini file should be in the same directory that contains the php.ini file
for your PHP installation.
The appdynamics_agent.so file should be in the extensions directory for your PHP
installation.
See Files Added to Your Installation for information about how to locate these directories.
In addition, on Linux you can use pstree to locate the agent. Pstree displays the AppDynamics
agent running under Apache if the agent is installed properly. See http://freecode.com/projects/pstr
ee.
If the agent files are not in the correct directories, re-install the agent with the -i and -e options.
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To reinstall the agent

If the app agent is not installed in the right directory, re-install the agent using the install.sh installer
with the -i and -e options. Use the -i to install the appdynamics_agent.ini file in the same directory
as your php.ini file and the -e to install the appdynamics_agent.so file in the same directory as
your PHP extensions directory. See Install the PHP Agent using a Shell Script.
If you initially installed the agent using the RPM installer, you can find the shell script installer at /u
sr/lib/appdynamics-php5/install.sh.
Check error messages in the installation output

When you reinstall, examine carefully any error messages in the output of the install script,
especially those that direct you to copy some settings into php.ini.
If necessary copy those settings into the php.ini file. See Controller Information in the PHP
Configuration Files for information on common settings that may be missing.
Verify that the AppDynamics settings block exists in the configuration file.

Run this command:
php -i | less

and examine the output. You should see should be an appdynamics_agent.ini and a configuration
block listing appdynamics ini values.
Confirm that the correct permissions are set for the installation directory.

Check that the following permissions are set for the PHP agent install directory:
chown -R <apacheuser>:<apacheuser> <php_agent_install>
chmod -R 755 <php_agent_install>
chmod 777 <php_agent_install>/logs

Confirm that the proxy is running.

The Java proxy is the part of the agent that communicates with the Controller. If the agent is
installed in the right place, confirm that the Java proxy is running.
To confirm whether the proxy is running

1. From the command line enter 'ps aux | grep java'.
2. Inspect the list. You should see output similar to the following if the proxy is running:
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/usr/lib/appdynamics-php5/proxy/jre/bin/java -server -Xmx120m
-classpath
/usr/lib/appdynamics-php5/proxy/conf/logging/*:/usr/lib/appdynamicsphp5/proxy/lib/*:/usr/lib/appdynamics-php5/proxy/lib/tp/*:/usr/lib/a
ppdynamics-php5/proxy/*
-Djava.library.path=/usr/lib/appdynamics-php5/proxy/lib/tp
-Dappdynamics.agent.logs.dir=/usr/lib/appdynamics-php5/logs
-Dcomm=/tmp/ad-siJ4rp -DagentType=PHP_APP_AGENT
-Dappdynamics.agent.runtime.dir=/usr/lib/appdynamics-php5/proxy
com.appdynamics.ee.agent.proxy.kernel.Proxy

If you are instrumenting a PHP CLI script, you need to start the proxy manually. You may also
need to start the proxy manually if you have special requirements for running Java processes.
See Run the Proxy Daemon Manually for PHP Agents .
Check the Configuration Properties.

It is possible that the properties that the proxy uses to communicate with the Controller were not
set properly.
You can modify these properties in the php.ini or appdynamics_agent.ini file, wherever they are
set in your environment. See Controller Information in the PHP Configuration Files.

Controller Information in the PHP Configuration Files

agent.controller.hostName
agent.controller.port
agent.applicationName
agent.tierName
agent.nodeName
agent.accountName
agent.accountAccessKey
agent.controller.ssl.enabled
agent.proxy_ctrl_dir
The PHP installers write information that the agent uses to communicate with the controller to the
AppDynamics Agent section of the PHP configuration files.
This is different from some of the other AppDynamics application agents, which writes this
information to an XML file called controller-info.xml.
If you re-install the agent, the installer overwrites your settings only if you are using a fragments
directory. It never overwrites the php.ini. You can edit the PHP configuration files after installation
to add, delete, or modify these settings.
If a setting documented as "required" is not provided, the agent will not start. In this case the agent
logs the error to the web server error log. For example, if the controller.Hostname is not set you
would see the following message in the the apache error log:
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[AD agent] agent.controller.hostName is not set.

Agent is disabled.

If after successful startup you remove a required setting or set it to an empty value, the change is
ignored as long as the application is running, using the original value of the setting as it was at
startup. If, you change a required setting to a different valid value, restart the web server to apply
the change.
The controller information settings are described below.
agent.controller.hostName

This is the host name or the IP address of the AppDynamics Controller. Example values are
192.168.1.22 or myhost or myhost.abc.com. This is the same host that you use to access the
AppDynamics browser-based user interface. For an on-premise Controller, use the value for
application server host name that was configured when the Controller was installed.
This setting is required.
agent.controller.port

This is the HTTP(S) port of the AppDynamics Controller. This is the same port that you use to
access the AppDynamics browser-based user interface.
If agent.controller.ssl.enabled is true, specify the HTTPS port of the Controller; otherwise specify
the HTTP port. See agent.controller.ssl.enabled.
For on-premise installations, port 8090 for HTTP and port 8181 for HTTPS are the defaults.
This setting is required.
agent.applicationName

This is the name of the logical business application that the instrumented node belongs to.
If a business application of the configured name does not exist, it is created automatically.
This setting is required.
agent.tierName

This is the name of the logical tier that this node belongs to.
This setting is required.
agent.nodeName

This is the name of the instrumented node.
This setting is required.
agent.accountName

This is the account name used to authenticate with the Controller.
This setting is required if the AppDynamics Controller is running in multi-tenant mode or if you are
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using the AppDynamics SaaS Controller. It specifies the account name for the agent to use to
authenticate with the Controller. If you are using the AppDynamics SaaS Controller, the Welcome
email sent by AppDynamics provides the account name.
This setting is not required if the Controller is running in single-tenant mode.
agent.accountAccessKey

This is the account access key used to authenticate with the Controller.
This setting is required if the AppDynamics Controller is running in multi-tenant mode or if you are
using the AppDynamics SaaS Controller. It specifies the account access key for the agent to use
to authenticate with the Controller. If you are using the AppDynamics SaaS Controller, the
Welcome email sent by AppDynamics provides this information.
This setting is not required if the Controller is running in single-tenant mode.
agent.controller.ssl.enabled

When set to true, this setting specifies that the agent should use SSL (HTTPS) to connect to the
Controller. If agent.controller.ssl.enabled is true, set the agent.controller.port to the HTTPs port of
the Controller.
agent.proxy_ctrl_dir

This specifies the initial control communication directory between the agent and the proxy. Needed
only for manual proxy start. See Run the Proxy Daemon Manually for PHP Agents.

Special Procedures for PHP CLI

Special Procedures for PHP CLI
To instrument PHP CLI
Considerations for Various Scenarios
Learn More
Special Procedures for PHP CLI

The main consideration for instrumenting a PHP CLI application is that you must arrange to run
the proxy dameon manually.
The default is to launch automatically when the agent starts up, which works better in most cases
for the non-CLI platforms
To instrument PHP CLI

1. Create ts proxy control directory from which to run the proxy.
2. In your PHP configuration file (php.ini or appdynamics_agent.ini depending on your
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environment) include the following settings:
agent.cli_enabled = 1
agent.auto_launch_proxy = 0
agent.proxy_ctrl_dir = <proxy control directory>
If you are using the RPM installer to install the agent you may have configured the proxy
control directory using the APPD_PROXY_CTRL_DIR environment variable. See Install the
PHP Agent using RPM. This environment variable takes precedence over the setting in the
ini file.
3. Before running any traffic through the CLI, run the proxy from the directory into which you
installed the PHP agent, passing the proxy control directory and proxy log directory as an
arguments.
runProxy -- <proxy_dir> <log_dir>

For example:
runProxy -r /tmp/appd/app1/tier1/node1 -- /tmp/proxy.communication
/tmp/agentLogs

For the full set of options to runProxy see Run the Proxy Daemon Manually for PHP Agents.
Considerations for Various Scenarios

If you have PHPs running CLI and apache on the same machine, your AppDynamics setup
depends on whether you want all the traffic reported against a single AppDynamics node or
separate nodes. A separate proxy is required for each AppDynamics node that you want to
monitor in the controller.
If you want all the CLI traffic to be reported against one node and all the web traffic to be reported
against a different node, configure apache to auto-launch the proxy (the default) and configure CLI
to use a manually-launched proxy. This requires separate .ini files - one for the web PHP with
agent.auto_launch_proxy set to 1 and another for PHP CLI with agent.auto_launch_proxy set to 0.
If you want the web traffic and the CLI traffic to be reported against the same node, configure both
apache and CLI to use the same manually launched proxy.
Learn More

Run the Proxy Daemon Manually for PHP Agents
Controller Information in the PHP Configuration Files

Run the Proxy Daemon Manually for PHP Agents

By default, when the PHP agent starts up, it automatically executes the runproxy shell script. This
script runs the Java proxy daemon that handles communication between the PHP agents and the
controller. See AppDynamics for PHP Architecture for information about how the Java proxy
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daemon fits into the PHP agent architecture.
Automatic startup of the proxy works for the great majority of situations. However, you can
suppress the automatic startup of this script and run it manually. You would do this if:
You plan to instrument a PHP CLI entry point. The PHP CLI entry point requires manual
startup of the proxy and immediate creation of the node on startup.
You have multiple apache pools on the same machine reporting to the same proxy.
To do this, you first need to configure the agent for manual proxy launch. Then you need to launch
the proxy manually. See:
Learn More

Set Up a Multi-Tenant Proxy for PHP Agents
Special Procedures for PHP CLI
Configure Manual Startup of the runProxy Script for PHP Agents

You need to configure the agent for manual startup if you plan to start the runproxy script
manually.
To configure manual starting of runproxy

1. By default the agent.auto_launch_proxy setting in php.ini or appdynamics_agent.ini is set to 1 to
enable automatic startup of the proxy.
Change it to 0 to suppress automatic startup if you want to execute runProxy manually.
2. In the PHP configuration file (php.ini or appdynamics_agent.ini depending on your setup), set
the agent.proxy_script to the path of the runproxy that you want to use. The file in the script is
relative to the root of the PHP agent. You can specify the absolute path if you prefer.
3. In the PHP configuration file, set the agent.proxy_ctrl_dir to the directory to use for initial control
communication between the agent and the proxy. This directory contains the domain control
socket, which the agent uses to start an AppDynamics node. This directory is where the agent
gets the configuration for the node. The application user must have read permission on the
proxy_ctrl_dir.
Whenever you install the PHP agent, the installer overwrites the runproxy script and the
appdynamics_agent.ini file, but not the php.ini. If you re-install, you need to reset the
agent.auto_launch_proxy setting in the appdynamics_agent.ini file before you restart the server.
Learn More

Controller Information in the PHP Configuration Files
Install the PHP Agent
Execute the runProxy Script Manually
Run the Proxy Daemon Manually for PHP Agents
Execute the runProxy Script Manually

By default, the proxy component is automatically started when you start the agent. Use the
command described here only if you have configured the agent for manual proxy launch.
Before any traffic is run on the instrumented server, execute the appropriate version of the
runproxy script to start the proxy.
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Here is the full set of options for the runProxy script. The proxy control directory is required.
Usage: runProxy options -- proxyCommunicationDir logDirectory
[jvmOption [ jvmOption [...] ]
Options:
-r <dir>, --proxy-runtime-dir=<dir>
Specifies proxy runtime
directory
-d <dir>, --proxy-dir=<dir>
Specifies root proxy
directory
-j <dir>, --jre-dir=<dir>
Specifies root JRE directory
-v, --verbose
Enable verbose output
-h,--help
Show this message

Example:

./proxy/runProxy -d ./proxy -r <agent.proxy_ctrl_dir>
/tmp/proxy.communication /tmp/agentLogs

When the proxy starts, nodes are not created immediately. A node is created when the agent first
detects traffic on it.
Every time you reboot the server, you need to execute the runproxy script if you have opted to
start the proxy manually.
Learn More

Configure Manual Startup of the runProxy Script for PHP Agents
Run the Proxy Daemon Manually for PHP Agents
Set Up a Multi-Tenant Proxy for PHP Agents

Setting up a Multi-Tenant Proxy
To set up a multi-tenant proxy
Learn More
By default, if you are running multiple agents, each agent automatically launches its own Java
proxy to communicate with the controller.
However, if you are running multiple PHP Agents on the same machine, you can reduce your
overhead by setting up the agents to report to a single multi-tenant Java proxy. In this case you
would need to start that proxy manually.
Setting up a Multi-Tenant Proxy
To set up a multi-tenant proxy

1. Configure each agent for manual launch of the proxy. To do this, in the PHP configuration

Copyright © AppDynamics 2012-2014

Page 1640

1.
file (php.ini or appdynamics_agent.ini depending on your setup) for each agent, set the
agent.auto_launch_proxy value to 0.
2. Configure a single proxy control directory for all the agents that will share the proxy. They
must all be on the same machine. To do this, in the PHP configuration file for each agent,
set agent.proxy_ctrl_dir to the same proxy control directory.
The permissions on this directory should be readable and executable by the process that
runs apache and writable by the process that runs the proxy.
3. Before you start the agents, arrange to launch the proxy manually, passing the proxy control
directory configured in step 2 as the proxyCommunicationDir argument to the runProxy
script. See Execute the runProxy Script Manually. AppDynamics recommends launching the
proxy on system startup.
4. Verify that each agent reporting to the multi-tenant proxy is configured with a unique
app_name/node_name combination. The app_name and node_name are arguments to the
agent install script.
Learn More

AppDynamics for PHP Architecture
Execute the runProxy Script Manually
Run the Proxy Daemon Manually for PHP Agents
Install the PHP Agent

Configure AppDynamics for PHP
Configure Transaction Detection for PHP

Accessing Transaction Detection
To Access Business Transaction Detection Configuration
PHP Entry Points
Business Transaction Naming and Identification
Virtual Host Naming Prefix
Learn More
Accessing Transaction Detection
To Access Business Transaction Detection Configuration

1. From the left navigation pane select Configure -> Instrumentation.
2. Click the Transaction Detection tab if it is not already selected.
3. Click the PHP - Transaction Detection tab.
4. Do one of the following:
To configure transaction detection at the application level, in the left panel select the
application.
If you select the application, you can optionally click the button to configure all tiers to use
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the application-level configuration.
To configure transaction detection at the tier level, in the left panel select the tier for which
you want to configure transaction detection.
You can choose the button to apply the application configuration to the selected tier or the
button to create a custom configuration for this tier.
5. To configure a custom configuration for the tier, select Use Custom Configuration for this
Tier.
PHP Entry Points

The entry point is where the business transaction begins. Typically an entry point is a method or
operation.
The following screenshot shows PHP entry point types for the transaction types that AppDynamics
automatically detects and monitors. The entry point types are based on the PHP framework.
For each type, you can enable and disable transaction monitoring. When monitoring is disabled,
the agent stops counting, measuring, recording, etc. all activity on servers of that type.
If the agent cannot detect the framework, the entry point type defaults to PHP Web. This entry
point automatically detects all HTTP requests to the application.
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Business Transaction Naming and Identification

AppDynamics identifies and names business transactions using the following conventions:
PHP Web: the first two segments of the URI
PHP MVC:
<module> : <controller> : <action> for modular frameworks
<controller> : <action> for non-modular frameworks
PHP CLI: last two segments of the script's directory path plus the name of the script
PHP Web Service: <ServiceName>.<OperationName>
Drupal: <page callback name>
Wordpress: <page template>
Virtual Host Naming Prefix

If you have multiple virtual hosts configured on a single web server, you can differentiate among
the business transactions by checking the Use Virtual Host in Business Transaction names check
box. This adds the virtual host name as a prefix to the default business transaction name for all
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transactions subsequent to this configuration.
For example, an application has two exit.php actions running on the same physical host. If the
virtual host name is not used to name the transaction, the AppDynamics agent identifies all
requests to exit.php as a single business transaction named "exit.php". However, if one of those
actions runs on a virtual host named "phpagent1" and the other runs on a virtual host named
"phpagent2" and the virtual host name is used to name the transaction, the agent identifies two
different business transactions named "phpagent1 : exit.php" and "phpagent2 : exit.php".
Learn More

Monitor Business Transactions
PHP Entry Points
PHP Entry Points

The entry point is where the business transaction begins, typically a URI or a page callback name,
MVC controller action, page template name, or page template.
Configure Web PHP Entry Points

PHP Web Transaction Naming
Transaction Naming Based on Web Context
Web Context is http://example.com/store/checkout
Web Context is http://example.com/secure/internal/updateinventory
Web Context is http://example.com/secure/orders/process.creditcard
To configure PHP Web Transaction Naming
Default Detection for PHP Web Entry Points
Configure Custom Match Rules for PHP Web Entry Points
To configure a custom match rule for a PHP Web entry point
To modify a custom match rule for a PHP Web entry point
To remove a custom match rule for a PHP Web entry point
Configure Exclude Rules for PHP Web Entry Points
To configure an exclude rule for a PHP Web entry point
To modify an exclude rule for a PHP Web entry point
To remove an exclude rule for a PHP Web entry point
Split PHP Web Transactions
To split transactions for a PHP Web entry point using a custom match rule
Learn More
If the PHP Agent cannot detect the application's framework, the entry point type defaults to PHP
Web. This entry point automatically detects all HTTP requests to the application and names the
business transaction after the URI.
PHP Web Transaction Naming

The default convention for PHP Web transactions is to use first two segments of the URI to name
the transaction. You can change the naming convention to use the full URI or to use different
segments of the URI.
By default, AppDynamics automatically names PHP Web transactions based on the URI of the
application.
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You can also configure dynamic transaction naming based on the details of the user request.
Transaction Naming Based on Web Context

In certain situations, it is appropriate to modify the existing naming and name business
transactions based on different web contexts.
For example, MyOnlineBiz's entry point tier has multiple contexts deployed in a single PHP web
server instance. These web contexts represent different parts of the same business application
and therefore require following different naming strategies. Some examples:
Web Context is http://example.com/store/checkout
The naming strategy should use first two segments to name these transactions as: /store/checko
ut.

Web Context is http://example.com/secure/internal/updateinventory
The naming strategy should use last two segments to name these requests as: /internal/updatein
ventory.

Web Context is http://example.com/secure/orders/process.creditcard
The naming strategy should use the combination of parameter value for "type" and the last two
segments to name such requests as: /orders/process.creditcard.
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To configure PHP Web Transaction Naming
1. Click Configure Naming in the row for the PHP Entry point in the Entry Points table.

2. In the naming configuration screen do one of the following:
To use the full URI as the transaction name select Use the full URI.
or
To use specify segments to use as the transaction name, select Use the first or Use the
last from the dropdown menu and then enter the number of segments to use in the text field.
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3. To configure dynamic naming:
a. Check the Name Transactions dynamically using part of the request check box.
b. Select the radio button that corresponds to the part of the request that you want to use in the
transaction name.
c. Enter the request value in the text field where appropriate.
4. Click Save.
Default Detection for PHP Web Entry Points

By default, AppDynamics automatically names PHP Web transactions based on the url of the
application.
You may be seeing too many or too few PHP Web transactions. If you are not getting the visibility
that you need with the default configuration, create one or more custom match rules for PHP Web
entry points.
If you are seeing too many transactions, create exclude rules to prevent the agent from
discovering the entry points that you do not need to monitor. Or create custom match rules that
group several entry points into a single entry point.
If you are seeing too few transactions, review your custom match rules rules to make sure that
they detect all the entry points that you want the agent to discover.
Configure Custom Match Rules for PHP Web Entry Points

You can configure multiple match criteria for the agent to use to detect the transaction.
The agent determines the match using only the configured criteria.
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To configure a custom match rule for a PHP Web entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Custom Match Rules section.
3. Click the add icon to add a new custom match rule.
4. Select PHP Web from the Entry Point Type dropdown list.
5. Click Next.
6. In the New Business Transaction Match Rule-PHP Web window, enter a name for the rule.
7. Check the Enabled check box to enable the rule.
8. Optionally enter the priority of this rule for the app agent to use when multiple rules could apply
to the same entry point. See The Priority Parameter when Multiple Rules Apply.
9. In the Transaction Match Criteria tab, for each match conditions that you want to specify, check
the check box for the condition for which you are configuring a match. Then do one or more of the
following:
HTTP method: To configure a match on the HTTP method, select the method (GET, POST,
PUT, DELETE) from the dropdown list.
URI: To configure a match on the URI, enter the value against which to match the in the text
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field and the the condition to use to determine the match from the dropdown list.
To reverse the condition, click the gear icon and check the NOT condition check box.
HTTP parameter: To configure a match on an HTTP parameter, from the dropdown list
select Check for parameter existence or Check for parameter value and enter the
parameter name or the parameter value match condition as appropriate.
To configure more than one parameter, click the + icon to get a new HTTP parameter panel.
Header: To configure a match on the header, from the dropdown list select Check for
parameter existence or Check for parameter value and enter the parameter name or the
parameter value match condition as appropriate.
To configure more than one parameter, click the + icon to get a new header panel.
Port: To configure a match on the port, enter the value against which to match the in the
text field and the the condition to use to determine the match from the dropdown list.
To reverse the condition, click the gear icon and check the NOT condition check box.
Cookie: To configure a match on a cookie, from the dropdown list select Check for cookie
existence or Check for cookie value and enter the cookie name or the cookie value match
condition as appropriate.
To configure more than one cookie, click the + icon to get a new cookie panel.
9. Click Create Custom Match Rule.
To modify a custom match rule for a PHP Web entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Custom Match Rules section.
3. From the Custom Match Rules list, select the rule that you want to modify.
4. Double-click the rule or click the edit icon.
5. Modify the rule as needed. See steps 6 through 9 in To configure a custom match rule for a
PHP Web entry point. If you want to disable the rule, clear the Enabled check box.
6. Click Save.
To remove a custom match rule for a PHP Web entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Custom Match Rules section.
3. From the Custom Match Rules list, select the rule that you want to remove.
4. Click the delete icon.
5. In the Confirm Delete window click OK.
Configure Exclude Rules for PHP Web Entry Points

You can configure an exclude rule to exclude from detection any entry point that matches the
configured match conditions. The match conditions are the same as those available for configuring
custom match rules.
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Transactions excluded through exclude rules are not counted towards the business transaction
limit of 50 transactions per agent or 200 transactions per application.
To configure an exclude rule for a PHP Web entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Exclude Rules section.
3. Click the add icon to add a new exclude rule.
4. Select PHP Web from the Entry Point Type dropdown list.
5. Click Next.
6. In the New Exclude Business Transaction Match Rule-PHP Web window, enter a name for the
rule.
7. Check the Enabled check box to enable the rule.
8. In the Transaction Match Criteria tab, for each match conditions that you want to specify, check
the check box for the condition for which you are configuring a match. Then configure one or more
of the following:
HTTP method: To configure a match on the HTTP method, select the method (GET, POST,
PUT, DELETE) from the dropdown list.
URI: To configure a match on the URI, enter the value against which to match the in the text
field and the the condition to use to determine the match from the dropdown list.
To reverse the condition, click the gear icon and check the NOT condition check box.
HTTP parameter: To configure a match on an HTTP parameter, from the dropdown list
select Check for parameter existence or Check for parameter value and enter the
parameter name or the parameter value match condition as appropriate.
To configure more than one parameter, click the + icon to get a new HTTP parameter panel.
Header: To configure a match on the header, from the dropdown list select Check for
parameter existence or Check for parameter value and enter the parameter name or the
parameter value match condition as appropriate.
To configure more than one parameter, click the + icon to get a new header panel.
Port: To configure a match on the port, enter the value against which to match the in the
text field and the the condition to use to determine the match from the dropdown list.
To reverse the condition, click the gear icon and check the NOT condition check box.
Cookie: To configure a match on a cookie, from the dropdown list select Check for cookie
existence or Check for cookie value and enter the cookie name or the cookie value match
condition as appropriate.
To configure more than one cookie, click the + icon to get a new cookie panel.
9. Click Create Exclude Rule.
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To modify an exclude rule for a PHP Web entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Exclude Rules section.
3. From the Exclude Rules list, select the rule that you want to modify.
4. Double-click the rule or click the edit icon.
5. Modify the rule as needed. See steps 7 and 8 in To configure an exclude rule for a PHP Web
entry point. If you want to disable the rule, clear the Enabled check box.
6. Click Save.
To remove an exclude rule for a PHP Web entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Exclude Rules section.
3. From the Exclude Rules list, select the rule that you want to remove.
4. Click the delete icon.
5. In the Confirm Delete window click OK.
Split PHP Web Transactions

If a transaction is configured to identify the entry point based on the the URI, you can optionally
split the transaction into multiple transactions. For example, a login request may be automatically
detected as a single transaction, but you want to split it into two transactions based on whether the
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request branches to a new-user or existing-user operation. For general information about
transaction splitting see Transaction Splitting for Dynamic Discovery.
To split transactions for a PHP Web entry point using a custom match rule
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Custom Match Rules section.
3. From the Custom Match Rules list, select the rule for which you want to split the transaction.
4. Double-click the rule or click the edit icon.
5. Verify in the Transaction Match Criteria tab that the rule is configured to identify the entry point
based on the URI.

6. Click the Split Transaction Using Request Data tab.
7. Check the Split Transactions using request data check box.
8. Select the part of the URI that you want to use to split the transaction.
In the example below the transaction is split by the carrier parameter. As a result, separate
transactions will be detected for
products/mobile/checkout?carrier=verizon
products/mobile/checkout?carrier=sprint
products/mobile/checkout?carrier=att
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9. Click Save.
Learn More
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To configure a custom match rule for a PHP MVC entry point
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To remove an exclude rule for a PHP MVC entry point
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By default, automatic transaction detection for PHP MVC transactions is turned off. See Configure
Transaction Detection for PHP for general information about turning on automatic detection in the
PHP entry point window.
Default Detection and Naming for PHP MVC Entry Points

By default, for most MVC frameworks, the business transaction is named using the
controller:action. For modular MVC frameworks, the business transaction is named using the
module:controller:action.
You may be seeing too many or too few PHP MVC transactions. If you are not getting the visibility
that you need with the default configuration, create one or more custom match rules for PHP MVC
entry points.
If you are seeing too many transactions, create exclude rules to prevent the agent from
discovering the entry points that you do not need to monitor. Or create custom match rules that
group several entry points into a single entry point.
If you are seeing too few transactions, review your custom match rules rules to make sure that
they detect all the entry points that you want the agent to discover.
Configure Custom Match Rules for PHP MVC Entry Points

You can configure a custom match rule that matches a portion of the module, controller or view
name (such as "Begins with" or "Contains") rather than the default which matches the entire name
("Equals").
You cannot configure a single match rule that matches on both the controller and the action.
The agent determines the match using only the configured criteria. So if you configure a rule
based on matching a specific controller pattern but do not configure the action or the module, the
agent does not consider the action or the module in evaluating the match.

To configure a custom match rule for a PHP MVC entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Custom Match Rules section.
3. Click the add icon to add a new custom match rule.
4. Select PHP MVC from the Entry Point Type dropdown list.
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5. Click Next.
6. In the New Business Transaction Match Rule-PHP MVC window, enter a name for the rule.
7. Check the Enabled check box to enable the rule.
8. In the Business Transaction Match Criteria section, for each match condition that you want to
specify, do the following:
a. Check the check box for the segment for which you are configuring a match.
b. In the text field, enter the value against which to match.
c. Select the condition to use to determine the match from the dropdown list.
To reverse the condition, click the gear icon and check the NOT condition check box.
9. Click Create Custom Match Rule.
To modify a custom match rule for a PHP MVC entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Custom Match Rules section.
3. From the Custom Match Rules list, select the rule that you want to modify.
4. Double-click the rule or click the edit icon.
5. Modify the rule as needed. See steps 7 through 10 in To configure a custom match rule for a
PHP MVC entry point. If you want to disable the rule, clear the Enabled check box.
6. Click Save.
To remove a custom match rule for a PHP MVC entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Custom Match Rules section.
3. From the Custom Match Rules list, select the rule that you want to remove.
4. Click the delete icon.
5. In the Confirm Delete window click OK.
Configure Exclude Rules for PHP MVC Entry Points

You can configure an exclude rule to exclude from detection any entry point that matches the
configured match conditions. The match conditions are the same as those available for configuring
a custom match rule.
Transactions excluded through exclude rules are not counted towards the business transaction
limit of 50 transactions per agent or 200 transactions per application.
To configure an exclude rule for a PHP MVC entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Exclude Rules section.
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3. Click the add icon to add a new exclude rule.
4. Select PHP MVC from the Entry Point Type dropdown list.
5. Click Next.
6. In the Exclude Business Transaction Match Rule-PHP MVC window, enter a name for the rule.
7. Check the Enabled check box to enable the rule.
8. In the Business Transaction Match Criteria section, for each match condition that you want to
specify, do the following:
a. Check the check box for the segment for which you are configuring a match.
b. In the text field enter the value against which to match.
c. Select the condition to use to determine the match from the dropdown list.
To reverse the condition, click the gear icon and check the NOT condition check box.
9. Click Create Exclude Rule.

To modify an exclude rule for a PHP MVC entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Exclude Rules section.
3. From the Exclude Rules list, select the rule that you want to modify.
4. Double-click the rule or click the edit icon.
5. Modify the rule as needed. See steps 7 and 8 in To configure an exclude rule for a PHP MVC
entry point. If you want to disable the rule, clear the Enabled check box.
6. Click Save.
To remove an exclude rule for a PHP MVC entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Exclude Rules section.
3. From the Exclude Rules list, select the rule that you want to remove.
4. Click the delete icon.

Copyright © AppDynamics 2012-2014

Page 1656

5. In the Confirm Delete window click OK.
Learn More

Configure Transaction Detection for PHP
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To remove a custom match rule for a Drupal entry point
Configure Exclude Rules for Drupal Entry Points
To configure an exclude rule for a Drupal entry point
To modify an exclude rule for a Drupal entry point
To remove an exclude rule for a Drupal entry point
Learn More
By default, automatic transaction detection for Drupal transactions is turned off. See Configure
Transaction Detection for PHP for general information about turning on automatic detection in the
PHP entry point window.
Default Detection and Naming for Drupal Entry Points

By default, AppDynamics automatically names Drupal transactions based on the page callback
name of the Drupal module.
You may be seeing too many or too few Drupal transactions. If you are not getting the visibility that
you need with the default configuration, create one or more custom match rules for Drupal entry
points.
If you are seeing too many transactions, create exclude rules to prevent the agent from
discovering the entry points that you do not need to monitor. Or create custom match rules that
group several entry points into a single entry point.
If you are seeing too few transactions, review your custom match rules rules to make sure that
they detect all the entry points that you want the agent to discover.
Configure Custom Match Rules for Drupal Entry Points

You can configure a custom match rule that matches a portion of the page callback name (such as
"Begins with" or "Contains") rather than the default which matches the entire page callback name
("Equals").
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To configure a custom match rule for a Drupal entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Custom Match Rules section.
3. Click the add icon to add a new custom match rule.
4. Select Drupal from the Entry Point Type dropdown list.
5. Click Next.
6. In the New Business Transaction Match Rule-Drupal window, enter a name for the rule.
7. Check the Enabled check box to enable the rule.
8. Check the check box in the Business Transaction Match Criteria section.
9. In the text field, enter the value against which to match the page callback name.
10. Select the condition to use to determine the match from the dropdown list.
To reverse the condition, click the gear icon and check the NOT condition check box.
11. Click Create Custom Match Rule.
To modify a custom match rule for a Drupal entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Custom Match Rules section.
3. From the Custom Match Rules list, select the rule that you want to modify.
4. Double-click the rule or click the edit icon.
5. Modify the rule as needed. See steps 7 through 10 in To configure a custom match rule for a
Drupal entry point. If you want to disable the rule, clear the Enabled check box.
6. Click Save.
To remove a custom match rule for a Drupal entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Custom Match Rules section.
3. From the Custom Match Rules list, select the rule that you want to remove.

Copyright © AppDynamics 2012-2014

Page 1658

4. Click the delete icon.
5. In the Confirm Delete window click OK.
Configure Exclude Rules for Drupal Entry Points

You can configure an exclude rule to exclude from detection any entry point that matches the
configured match conditions. The match conditions are the same as those available for configuring
custom match rules.
Transactions excluded through exclude rules are not counted towards the business transaction
limits.
To configure an exclude rule for a Drupal entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Exclude Rules section.
3. Click the add icon to add a new exclude rule.
4. Select Drupal from the Entry Point Type dropdown list.
5. Click Next.
6. In the Exclude Business Transaction Match Rule-Drupal window, enter a name for the rule.
7. Check the Enabled check box to enable the rule.
8. Check the check box in the Business Transaction Match Criteria section.
9. In the text field, enter the value against which to match the page callback name.
10. Select the condition to use to to determine the match from the dropdown list.
To reverse the condition, click the gear icon and check the NOT condition check box.
11. Click Create Exclude Rule.

To modify an exclude rule for a Drupal entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Exclude Rules section.
3. From the Exclude Rules list, select the rule that you want to modify.
4. Double-click the rule or click the edit icon.
5. Modify the rule as needed. See steps 7 through 10 in To configure an exclude rule for a Drupal

Copyright © AppDynamics 2012-2014

Page 1659

entry point. If you want to disable the rule, clear the Enabled check box.
6. Click Save.
To remove an exclude rule for a Drupal entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Exclude Rules section.
3. From the Exclude Rules list, select the rule that you want to remove.
4. Click the delete icon.
5. In the Confirm Delete window click OK.
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By default, automatic transaction detection for Wordpress transactions is turned off. See Configure
Transaction Detection for PHP for general information about turning on automatic detection in the
PHP entry point window.
Default Detection and Naming for Wordpress Entry Points

By default, AppDynamics automatically names Wordpress transactions based on the Wordpress
template name.
You may be seeing too many or too few Wordpress transactions. If you are not getting the visibility
that you need with the default configuration, create one or more custom match rules for Wordpress
entry points.
If you are seeing too many transactions, create exclude rules to prevent the agent from
discovering the entry points that you do not need to monitor. Or create custom match rules that
group several entry points into a single entry point.
If you are seeing too few transactions, review your custom match rules rules to make sure that
they detect all the entry points that you want the agent to discover.
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Configure Custom Match Rules for Wordpress Entry Points

You can configure a custom match rule that matches a portion of the page template name (such
as "Begins with" or "Contains") rather than the default which matches the entire page template
name ("Equals").

To configure a custom match rule for a Wordpress entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Custom Match Rules section.
3. Click the add icon to add a new custom match rule.
4. Select Wordpress from the Entry Point Type dropdown list.
5. Click Next.
6. In the New Business Transaction Match Rule-Wordpress window, enter a name for the rule.
7. Check the Enabled check box to enable the rule.
8. Check the check box in the Business Transaction Match Criteria section.
9. In the text field, enter the value against which to match the page template name.
10. Select the condition to use to determine the match from the dropdown list.
To reverse the condition, click the gear icon and check the NOT condition check box.
11. Click Create Custom Match Rule.
To modify a custom match rule for a Wordpress entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Custom Match Rules section.
3. From the Custom Match Rules list, select the rule that you want to modify.
4. Double-click the rule or click the edit icon.
5. Modify the rule as needed. See steps 7 through 10 in To configure a custom match rule for a
Wordpress entry point. If you want to disable the rule, clear the Enabled check box.
6. Click Save.
To remove a custom match rule for a Wordpress entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
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Detection.
2. Scroll down to the Custom Match Rules section.
3. From the Custom Match Rules list, select the rule that you want to remove.
4. Click the delete icon.
5. In the Confirm Delete window click OK.
Configure Exclude Rules for Wordpress Entry Points

You can configure an exclude rule to exclude from detection any entry point that matches the
configured match conditions. The match conditions are the same as those available for configuring
custom match rules.
Transactions excluded through exclude rules are not counted towards the business transaction
limits.
To configure an exclude rule for a Wordpress entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Exclude Rules section.
3. Click the add icon to add a new exclude rule.
4. Select Wordpress from the Entry Point Type dropdown list.
5. Click Next.
6. In the Exclude Business Transaction Match Rule-Wordpress window, enter a name for the rule.
7. Check the Enabled check box to enable the rule.
8. Check the check box in the Business Transaction Match Criteria section.
9. In the text field enter the value against which to match the page template name.
10. Select the condition to use to to determine the match from the dropdown list.
To reverse the condition, click the gear icon and check the NOT condition check box.
11. Click Create Exclude Rule.

To modify an exclude rule for a Wordpress entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Exclude Rules section.
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3. From the Exclude Rules list, select the rule that you want to modify.
4. Double-click the rule or click the edit icon.
5. Modify the rule as needed. See steps 7 through 10 in To configure an exclude rule for a
Wordpress entry point. If you want to disable the rule, clear the Enabled check box.
6. Click Save.
To remove an exclude rule for a Wordpress entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Exclude Rules section.
3. From the Exclude Rules list, select the rule that you want to remove.
4. Click the delete icon.
5. In the Confirm Delete window click OK.
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Learn More
Before configuring a PHP CLI entry poiint, make sure you have arranged to run the proxy daemon
manually. This is required for monitoring PHP CLI. See Special Procedures for PHP CLI and Run
the Proxy Daemon Manually for PHP Agents.
Detection for PHP CLI Entry Points

The PHP Agent automatically detects PHP CLI entry points if the PHP CLI entry point type is
enabled.
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PHP CLI Business Transactions

By default, AppDynamics automatically names PHP CLI transactions based on the last two
segments of the script's directory path plus the name of the script.
The agent creates a business transaction instance every time the script is run.
If you are seeing too many transactions, create exclude rules to prevent the agent from
discovering the transactions that you do not need to monitor. Or create custom match rules that
group several entry points into a single entry point.
If you are seeing too few transactions, review your custom match rules rules to make sure that
they detect all the PHP CLI entry points that you want the agent to discover.
Configure Custom Match Rules for PHP CLI Entry Points

You can configure a custom match rule that matches a portion of the script name (such as "Begins
with" or "Contains" or "Reg Ex") rather than the default which matches the entire script name
("Equals"). The following rule matches a regular expression for scripts that start with "mysql." and
end with "php".
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To configure a custom match rule for a PHP CLI entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Custom Match Rules section.
3. Click the add icon to add a new custom match rule.
4. Select PHP CLI from the Entry Point Type dropdown list.
5. Click Next.
6. In the New Business Transaction Match Rule-PHP CLI window, enter a name for the rule.
7. Check the Enabled check box to enable the rule.
8. Check the check box in the Business Transaction Match Criteria section.
9. In the text field, enter the value against which to match the page callback name.
10. Select the condition to use to determine the match from the dropdown list.
To reverse the condition, click the gear icon and check the NOT condition check box.
11. Click Create Custom Match Rule.
To modify a custom match rule for a PHP entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Custom Match Rules section.
3. From the Custom Match Rules list, select the rule that you want to modify.
4. Double-click the rule or click the edit icon.
5. Modify the rule as needed. See steps 7 through 10 in To configure a custom match rule for a
PHP CLI entry point. If you want to disable the rule, clear the Enabled check box.
6. Click Save.
To remove a custom match rule for a PHP CLI entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Custom Match Rules section.
3. From the Custom Match Rules list, select the rule that you want to remove.
4. Click the delete icon.
5. In the Confirm Delete window click OK.
Configure Exclude Rules for PHP CLI Entry Points

You can configure an exclude rule to exclude from detection any entry point that matches the
configured match conditions. The match conditions are the same as those available for configuring
custom match rules.
Transactions excluded through exclude rules are not counted towards the business transaction
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limit of 50 transactions per agent or 200 transactions per application.
To configure an exclude rule for a PHP CLI entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Exclude Rules section.
3. Click the add icon to add a new exclude rule.
4. Select PHP CLI from the Entry Point Type dropdown list.
5. Click Next.
6. In the Exclude Business Transaction Match Rule-PHP CLI window, enter a name for the rule.
7. Check the Enabled check box to enable the rule.
8. Check the check box in the Business Transaction Match Criteria section.
9. In the text field, enter the value against which to match the page callback name.
10. Select the condition to use to to determine the match from the dropdown list.
To reverse the condition, click the gear icon and check the NOT condition check box.
11. Click Create Exclude Rule.
For example, you may have a custom match rule that detects all the scripts in the /xyz directory
but you want to exclude from detection the /xyz/a.php script.

To modify an exclude rule for a PHP CLI entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Exclude Rules section.
3. From the Exclude Rules list, select the rule that you want to modify.
4. Double-click the rule or click the edit icon.
5. Modify the rule as needed. See steps 7 through 10 in To configure an exclude rule for a PHP
CLI entry point. If you want to disable the rule, clear the Enabled check box.
6. Click Save.
To remove an exclude rule for a PHP CLI entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2.
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2.
3.
4.
5.

Scroll down to the Exclude Rules section.
From the Exclude Rules list, select the rule that you want to remove.
Click the delete icon.
In the Confirm Delete window click OK.
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By default, automatic transaction detection for PHP Web Services transactions is turned off. See C
onfigure Transaction Detection for PHP for general information about turning on automatic
detection in the PHP entry point window.
Default Detection and Naming for PHP Web Service Entry Points

By default, for Web Services frameworks the business transaction is named for the web service
name and the operation name.
You may be seeing too many or too few PHP Web Service transactions. If you are not getting the
visibility that you need with the default configuration, create one or more custom match rules for
PHP Web Service entry points.
If you are seeing too many transactions, create exclude rules to prevent the agent from
discovering the entry points that you do not need to monitor. Or create custom match rules that
group several entry points into a single entry point.
If you are seeing too few transactions, review your custom match rules rules to make sure that
they detect all the entry points that you want the agent to discover.
Configure Custom Match Rules for PHP Web Service Entry Points

You can configure a custom match rule that matches a portion of the web service name and/or
operation name (such as "Begins with" or "Contains") rather than the default which matches the
entire name ("Equals").
The agent determines the match using only the configured criteria. So if you configure a rule
based on matching a specific web service name but do not configure the operation name, the
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agent does not consider the operation name in evaluating the match.

To configure a custom match rule for a PHP Web Service entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Custom Match Rules section.
3. Click the add icon to add a new custom match rule.
4. Select PHP Web Service from the Entry Point Type dropdown list.
5. Click Next.
6. In the New Business Transaction Match Rule - PHP Web Services window, enter a name for the
rule.
7. Check the Enabled check box to enable the rule.
8. In the Business Transaction Match Criteria section, for each match condition that you want to
specify, do the following:
a. Check the check box for the segment for which you are configuring a match.
b. In the text field, enter the value against which to match.
c. Select the condition to use to determine the match from the dropdown list.
To reverse the condition, click the gear icon and check the NOT condition check box.
9. Click Create Custom Match Rule.
To modify a custom match rule for a PHP Web Service entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Custom Match Rules section.
3. From the Custom Match Rules list, select the rule that you want to modify.
4. Double-click the rule or click the edit icon.
5. Modify the rule as needed. See step 8 in To configure a custom match rule for a PHP Web
Service entry point. If you want to disable the rule, clear the Enabled check box.
6. Click Save.
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To remove a custom match rule for a PHP Web Service entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Custom Match Rules section.
3. From the Custom Match Rules list, select the rule that you want to remove.
4. Click the delete icon.
5. In the Confirm Delete window click OK.
Configure Exclude Rules for PHP Web Services Entry Points

You can configure an exclude rule to exclude from detection any entry point that matches the
configured match conditions. The match conditions are the same as those available for configuring
a custom match rule.
Transactions excluded through exclude rules are not counted towards the business transaction
limit.
To configure an exclude rule for a PHP Web Services entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Exclude Rules section.
3. Click the add icon to add a new exclude rule.
4. Select PHP Web Services from the Entry Point Type dropdown list.
5. Click Next.
6. In the New Exclude Business Transaction Match Rule - PHP Web Service window, enter a
name for the rule.
7. Check the Enabled check box to enable the rule.
8. In the Business Transaction Match Criteria section, for each match condition that you want to
specify, do the following:
a. Check the check box for the segment for which you are configuring a match.
b. In the text field enter the value against which to match.
c. Select the condition to use to determine the match from the dropdown list.
To reverse the condition, click the gear icon and check the NOT condition check box.
9. Click Create Exclude Rule.
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To modify an exclude rule for a PHP Web Service entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Exclude Rules section.
3. From the Exclude Rules list, select the rule that you want to modify.
4. Double-click the rule or click the edit icon.
5. Modify the rule as needed. See step 8 in To configure an exclude rule for a PHP Web Service
entry point. If you want to disable the rule, clear the Enabled check box.
6. Click Save.
To remove an exclude rule for a PHP Web Service entry point
1. Access the PHP transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Exclude Rules section.
3. From the Exclude Rules list, select the rule that you want to remove.
4. Click the delete icon.
5. In the Confirm Delete window click OK.
Calibrate PHP Entry Point Detection

Process
1 Confirm Business Relevance
2 Exclude Business Transactions
3 Combine Business Transactions
4 Split PHP Web Business Transactions
5 Delete Unnecessary Business Transactions
Learn more
Sometimes you need to fine-tune your entry point detection configuration, for example:
When you are not seeing expected business transactions
When you see All Other Traffic business transactions in your business transaction list, as
shown here:
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To analyze your current configuration try one or more of the following tactics:
Confirm that you have the right entry point for the start of your business transaction, see Org
anizing Traffic as Business Transactions.
Review the application architecture and make sure the expected business transactions are
not part of another transaction in an upstream tier.
Review the existing rules and if necessary, modify them using one or more of the following
techniques:
Combine business transactions using custom match rules.
Exclude some entry points.
Create and fine-tune custom match rules to define entry points precisely.
There is a default limit of 50 business transactions per agent and 200 business transactions per
business application. If you need to increase the limits, set it in the max-business-transactions
property in <php-agent-root>/proxy/conf/app-agent-config.xml. There is a hard limit of 100
business transactions per agent.
Process

The following flow chart suggests a process for analyzing your entry point detection scheme.
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1 Confirm Business Relevance

The first step in determining the entry point configuration that is right for
your application is to decide which transactions you want to monitor.
Because business transactions begin with specific entry points, this may
require talking to application developers and architects to confirm the
correct set of entry points. Be sure you are measuring the right things.
Once you know what you want to monitor, you can examine the business
transactions currently being detected and determine your next steps.
This topic describes several techniques for modifying your entry point
configuration.
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2 Exclude Business Transactions

Use exclude rules to prevent the agent from detecting entry points for
business transactions that you do not need to monitor.
Here are some scenarios where exclude rules might be useful.
Business Transaction Discovery at the Next Layer of Application Component Logic

By default, the agent detects PHP MVC requests based on the module*:c
ontroller:*action. When an incoming PHP MVC request starts at some
control logic in your code that triggers different business logic based on
the action, you may prefer to use just the action as the business
transaction name. You can create an PHP MVC exclude rule using the
match criteria on the action name to prevent certain business
transactions from being discovered.
The following rule excludes entry points in which the action starts with ind
exAction.

Use an Exclude Rule as a Filter

You can use an exclude rule as a filter to allow the eligible requests and
ignore everything else.
For example, you want to use default discovery rules to identify the
correct entry poiunts. Your application receives URI ranges that start with
: /a, /b ... /z, but you want to monitor only URIs only that start with /a and /
b. Create an exclude rule that matches on Doesn't Start With /a or /b as
shown here:
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3 Combine Business Transactions

When you need to reduce the number of entry points that are
automatically discovered, you can use a custom match rule to combine
multiple potential entry points into a single entry point.
For example, if you have PHP MVC entry points that are automatically
detected as
catalog1:productA:view
catalog2:productB:view
catalog2:productA:view
catalog3:productD:view
and you want just a single transaction for catalog, create a custom match
rule matching only on "catalog".

Or if you have PHP Web entry points that are detected as
/clothing/girls
/clothing/boys
/clothing/women
/clothing/men
and you want just a single transaction for all clothing, create a custom
match rule matching only on "clothing".

Or you want the agent to ignore case in the URI, so that /appdynamics.c
om and /APPDYNAMICS.com are detected as a single transaction, not
two transactions.
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After you have created a custom match rule, delete the old business
transactions that were originally discovered. Deleting a business
transaction deletes all historical data regarding that transaction. When
the agent detects the transaction again, it uses the new custom match
rule rather than the default discovery rule. See 5 Delete Unnecessary
Business Transactions.
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4 Split PHP Web Business Transactions

Using a dynamic value to customize business transaction discovery is
called transaction splitting. Transaction spitting allows you to fine-tune
detection or exclusion based on a parameter or user data. For the PHP
agent, this feature is available for PHP Web type entry points only.
For example, the agent detects the URI /company/careers but you want
to track separate business transactions for /careers/engineering, /caree
rs/marketing, /careers/sales, and so on. Create a custom match rule
with transaction splitting.

Or you want to split a URI that contains a parameter as in /myonline/stor
e/shop?productid=dvd, /myonline/store/shop?productid=cd, /myonli
ne/store./shop?productid=book.
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5 Delete Unnecessary Business Transactions

After you have modified the business transaction discovery configuration,
you should delete the old transactions that were discovered using the old
discovey rules.
If you delete a business transaction and you have not changed the entry
point configuration, the agent will rediscover it. However, if you have
modified the transaction detection rules then delete the old business
transaction, it will not be rediscovered.
You delete business transactions from the business transaction list in the
AppDynamics console. See the information about the Delete operation at
Business Transactions List Operations.

Learn more

Configure Business Transaction Detection
All Other Traffic Business Transaction
Fine-Tune Configurations Using Match Conditions
Regular Expressions In Match Conditions
PHP Entry Points
Import and Export Transaction Detection Configuration for PHP

Import and Export Auto-Detected Entry Point Configurations
To import or export the configurations for all the auto-detected entry-points to or from
an application
To import or export the configuration for a single auto-detected entry point type to or
from an application
To import or export the configurations for all the auto-detected entry-points to or from
a tier
To import or export the configuration for a single auto-detected entry point type to or
from a tier
Import and Export Custom Match Rules
To import or export a single custom match rule to or from an application
To import or export a single custom match rule to or from a tier
Import and Export Exclude Rules
To import or export a single exclude rule to or from an application
To import or export a single exclude rule to or from a tier
Overwrite Parameter
AppDynamics lets you migrate transaction detection configurations for PHP entry points from one
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application to another using a REST API. Use the API to copy transaction detection configurations
rather than manually re-configuring multiple applications in the Controller.
Import and Export Auto-Detected Entry Point Configurations

You can import and export all your entry point configurations or one entry point configuration in a
single request. Lists of multiple entry point names are not supported.
You can import to or export from the following application-level and tier-level configurations:
auto-detected entry point configurations
custom match rules
exclude rules
Guidelines for exporting entry point configurations:
Use the HTTP GET method.
Encode the URI using UTF-8 URL encoding.
The base URI is the source application and, optionally, the source tier for your configuration
export.
http://<controller host>:<controller
port>/controller/transactiondetection/<application
name>/<optional tier name>

The Controller exports the configurations to an XML file. If necessary, you can edit the XML
file before you import it.
For example, if you export all the auto-detected entry points but don't want to import them
all, delete the ones you do not want from the file before import.
Guidelines for importing entry point configurations:
Export the auto-detected entry point configuration, custom match rule, or exclude rule from
the Controller.
Alternately, you can manually create the XML, but that option is more work for you.
Use the HTTP POST method.
Encode the URI using UTF-8 URL encoding.
The base URI is the destination application and, optionally, the destination tier for your
configuration import.
http://<controller host>:<controller
port>/controller/transactiondetection/<application
name>/<optional tier name>

Include the XML configuration as a file attachment to the request.
Use UTF-8 URL encoding of the URI before posting. For example, use the plus symbol "+"
to replace the space character in the URI.
To overwrite an existing configuration with the same name see Overwrite Parameter.
A successful import request returns HTTP status code 200.
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To import or export the configurations for all the auto-detected entry-points to or from an application

http://<controller host>:<controller
port>/controller/transactiondetection/<application name>/auto

exports all the auto-detected entry point types for all agents: ASP.NET, Java, PHP, NodeJS, etc.
For example:
http://appdcontroller.example.com/controller/transactiondetection/Ho
wdy+World+Travel/auto

produces the output in auto_all.xml.
To import or export the configuration for a single auto-detected entry point type to or from an application

http://<controller-host>:<controller-port>/controller/transactiondet
ection/<application name>/auto/<entry point type name>

Entry point types names are case insensitive. The following entry point type names are valid:
phpWeb
phpMvc
phpDrupal
phpWordpress
phpCli
phpWebService
For example:
http://appdcontroller.example.com/controller/transactiondetection/Bu
ndy+Online+Shoes/auto/phpWeb

To import or export the configurations for all the auto-detected entry-points to or from a tier

http://<controller-host>:<controller-port>/controller/transactiondet
ection/<application name>/<tier name>/auto

For example:
http://appdcontroller.example.com/controller/transactiondetection/Bu
ndy+Online+Shoes/Fullfillment/auto/

To import or export the configuration for a single auto-detected entry point type to or from a tier
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http://<controller host>:<controller
port>/controller/transactiondetection/<application name>/<tier
name>/auto/<entry point type name>

For example :
http://appdcontroller.example.com/controller/transactiondetection/Bu
ndy+Online+Shoes/Fullfillment/auto/phpWeb

Import and Export Custom Match Rules
To import or export a single custom match rule to or from an application

http://<controller host>:<controller
port>/controller/transactiondetection/<application
name>/custom/<entry point type name>/<custom rule name>

This example exports/imports a PHP MVC custom match rule named Sample MVC Rule.
http://appdcontroller.example.com/controller/transactiondetection/Bu
ndy+Online+Shoes/custom/phpMvc/Sample+MVC+Rule

To import or export a single custom match rule to or from a tier

http://<controller host>:<controller
port>/controller/transactiondetection/<application name>/<tier
name>/custom/<entry point type name>/<custom rule name>

This example exports/imports a PHP MVC custom match rule named Sample MVC Rule from/to
the Fullfillment tier.
http://appdcontroller.example.com/controller/transactiondetection/Bu
ndy+Online+Shoes/FullFillment/custom/phpMvc/Sample+MVC+Rule

Import and Export Exclude Rules
To import or export a single exclude rule to or from an application
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http://<controller host>:<controller
port>/controller/transactiondetection/<application
name>/exclude/<entry point type name>/<exclude rule name>

This example exports/imports a PHP Web Service exclude rule named My Web Service Exclude
Rule.
http://appdcontroller.example.com/controller/transactiondetection/Bu
ndy+Online+Shoes/exclude/phpWebService/My+Web+Service+Exclude+Rule

To import or export a single exclude rule to or from a tier

http://<controller host>:<controller
port>/controller/transactiondetection/<application name>/<tier
name>/exclude/<entry point type name>/<exclude rule name>

This example exports/imports a PHP Web Service exclude rule named My Web Service Exclude
Rule from/to the Fullfillment tier.
http://appdcontroller.example.com/controller/transactiondetection/Bu
ndy+Online+Shoes/Fullfillment/exclude/phpWebService/My+Web+Service+E
xclude+Rule

Overwrite Parameter

Use the overwrite parameter to overwrite a configuration of the same name. Without this
parameter, if the import encounters a configuration for a component of the same name, the
request will fail.
For example, to import a configuration for a PHP Web custom match rule named "My Rule" to an
application that has an existing "My Rule" custom match rule that you want to overwrite use:
http://appdcontroller.example.com/controller/transactiondetection/Bu
ndy+Online+Shoes/custom/phpWeb/My+Rule?overwrite=true

The default is overwrite=false.
Configure Error Detection for PHP
Accessing Error Detection Configuration for the PHP Agent
To Access Error Detection Configuration
Error Detection Threshold for the PHP Agent
Reporting Errors in Business Transactions for the PHP Agent
To configure basic error detection for the PHP agent
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Configuring the PHP Agent to Ignore Exceptions and Log Messages
Configuring Exceptions to Ignore
To configure the PHP agent to ignore an exception
Configuring Logged Messages to Ignore
To configure the PHP agent to ignore a log message
The PHP Agent instruments the PHP reporting facility. PHP applications can use trigger_error to
report errors through that facility. PHP extensions and PHP itself can also use the PHP facility for
reporting errors.
However, the PHP Agent does not report errors that occur during an exit call but instead creates a
synthetic exception for such errors.
You can configure the threshold for log messages and exceptions that the PHP agent reports as
errors. You can also define exceptions that should not be included in the business transaction
error count and log messages that should not be reported to the controller.
These configurations help you reduce the number of errors that the agent reports so you see just
those that are most useful for monitoring and troubleshooting.
Accessing Error Detection Configuration for the PHP Agent
To Access Error Detection Configuration

1. From the left navigation pane select Configure -> Instrumentation.
2. Click the Error Detection tab.
3. Click the PHP - Error Detection tab.
Error Detection Threshold for the PHP Agent

To control the number of detected errors, you can choose the minimum threshold of errors that the
agent should report from Error, Warning, and Notice.
If you select Error, the agent reports only messages and exceptions marked Error.
If you select Warning, the agent reports only messages and exceptions marked Error and
Warning.
If you select Notice, the agent reports messages and exceptions marked Error, Warning and
Notice.
Reporting Errors in Business Transactions for the PHP Agent

Errors in business transactions are displayed in a variety of places in the AppDynamics console:
In the transaction scorecards in various dashboards
In the Errors trend graph on the business transaction dashboard
In the business transaction lists
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In error transaction snapshots

In the Error Transactions tab accessed from the Troubleshoot->Errors item

You can configure whether you want log messages and exceptions within the error threshold to be
marked as transaction errors and counted by checking or clearing the Mark Business Transaction
as error check box.

Copyright © AppDynamics 2012-2014

Page 1683

When error detection is enabled, if the Mark Business Transaction as error check box is clear, the
agent reports exceptions and log messages to the controller for all errors within the configured
threshold, but it does not increment the error counts and the errors per minute counts reported for
the affected business transactions.
If the Mark Business Transaction as error check box is checked, detected log messages and
exceptions cause the error counts to be incremented. Transaction snapshots generated for these
errors are error transaction snapshots.
You can further refine which errors cause business transaction error counts to be incremented
through ignore rules. See Configuring Exceptions to Ignore.
To configure basic error detection for the PHP agent

1. Check the Detect Error check box to enable error detection. Clear the check box to disable error
detection.
2. If error detection is enabled, select the minimum threshold from the dropdown list.
Errors below the threshold are not reported.
3. If you want the agent to count the business transaction that caused the error as an error
transaction, check the Mark Business Transaction as error check box. If you do not want the
business transactions with errors to be counted as error transactions, clear this check box.
4. Click Save Error Configuration in the top left corner of the window.
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Configuring the PHP Agent to Ignore Exceptions and Log Messages

Configuring exceptions and log messages to ignore is useful for excluding a temporary known
issue from the error count to avoid skewing error metrics and triggering unnecessary alerts from
health rules that are based on the error count. You can configure AppDynamics to ignore specified
exceptions and logged messages.
Configuring Exceptions to Ignore

You can direct the agent to ignore an exception only when the exception message contains a
certain string or does not contain the string.
The ignored exception is not really "ignored". This configuration just prevents the agent from
incrementing business transaction error metrics caused by exceptions that have been configured
to be ignored. When an ignored exception occurs, AppDynamics does not count the business
transaction in which the exception occurred as an error error transaction. But it still detects the
exception, logs the exception, and increments the exception count. The exception is still displayed
in the Exceptions subtab of the Errors tab of the tier and node dashboards and in the Summary
and Error Details sections of any transaction snapshot that was in progress when the exception
occurred.
Ignoring an exception simply means that AppDynamics does not increment the business
transaction error count for those exceptions.
To configure the PHP agent to ignore an exception

1. Click Add New Exceptions to Ignore under the Ignored Exceptions list.
2. Enter the fully-qualified class names of exceptions to ignore, separated by colons.
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Exception chains are supported. If you specify "A:B" as the exception chain, the agent matches
any chain where B is in the chain of A, even if B is not an immediate cause of the exception.
3. Optionally, further qualify the exceptions to ignore by configuring a match condition for the
exception message. Enter the string to match and the qualifier from the dropdown list (Equals,
Contains, Starts with, Ends with, Matches Reg Ex).
The RegEx operation uses PHP's built-in PCRE regular expression engine and requires the same
syntax, including delimiters (for example: /^Foo/). See the PCRE Manual for help matching a
regular expression.
Click the gear icon to configure the NOT condition for the match.

4. Click Save.
5. Click Save Error Configuration in the top left corner of the window.
You can later edit or remove the ignore rule by clicking it in the Ignored Exceptions list.
Configuring Logged Messages to Ignore

When a log message that has been configured to be ignored is logged, the PHP agent does not
report the message to the controller.
To configure the PHP agent to ignore a log message

1. Click Add under the Ignored Messages list.
2. Enter the string to be matched in the message and the qualifier from the dropdown list (Equals,
Contains, Starts with, Ends with, Matches Reg Ex).
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The RegEx operation uses PHP's built-in PCRE regular expression engine and requires the same
syntax, including delimiters (for example: /^Foo/). See the PCRE Manual for help matching a
regular expression.
Click the gear icon to configure the NOT condition for the match.
3. Click Save.
4. Click Save Error Configuration in the top left corner of the window
Configure Call Graphs for PHP
Call Graph Settings
To access call graph configuration screens
Call Graph Granularity
SQL Capture Settings
To configure SQL capture
Learn More
This topic describes how to configure call graphs in the PHP agent.
Call Graph Settings

The Call Graph Settings window lets you configure thresholds that affect performance and how
much detail about SQL statements to capture.
To access call graph configuration screens

1. In the left navigation pane, click Configure -> Instrumentation.
2. Click the Call Graph Settings tab.
3. Click the PHP Call Graph Settings subtab.
Whenever you create or modify a call graph setting in these screens, click the Save Call Graph
Settings button to save your configuration.
Call Graph Granularity

You can control the granularity for call graphs using following settings:
For methods: To ensure low performance overhead, choose a threshold in milliseconds for
method execution time. Methods taking less than the time specified here are filtered out of
the call graphs.
For SQL calls: You can also specify a threshold for SQL queries. SQL queries taking more t
han the specified time in milliseconds are captured in the call-graphs.
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To exclude internal functions from the call graphs, check the Exclude internal functions check box.
SQL Capture Settings

Often the SQL Calls section does not display the raw values in a SQL query, as shown in the
following query:
INSERT INTO ORDERREQUEST ( ITEM_ID, NOTES ) VALUES ( ?, ? )
Replacing the literals in a query with parameter markers in this way is called normalizing the
query.
Normalizing a query prevents display of sensitive data, such as social security numbers or credit
card numbers, which are potential query parameters. Normalizing queries also helps to organize
SQL data by flattening the parameter values for the query so that the statistics from different
executions of the query can be aggregated and compared against one another.
However, during troubleshooting, you may want to display the values of the bind variables.
To configure SQL capture

1. In the Call Graph Settings tab, scroll down to the SQL Capture Settings section.
2. Select one of the following:
Capture Raw SQL: Select this option to see raw SQL data (this captures raw SQL data
along with the parameter values). Raw SQL data includes prepared statement bind variables
or raw statements. By default, the private SQL data and queries that take less than 10 ms
are not captured.
Filter Parameter values: Select this option to filter all literal values (constants) out of the
captured query.

3. Click Save Call Graph Settings.
Learn More

Call Graphs
Transaction Snapshots
Configure Information Points for PHP
Configuring an Information Point
Creating an Information Point Definition
classMatch
methodMatch
matchConditions
metricDefinitions
Sample JSON Information Point Configuration
Learn More
Information points (aka "business metrics", "code metrics") are available in version 3.9 of the PHP

Copyright © AppDynamics 2012-2014

Page 1688

Agent. The PHP Agent uses a different UI from the Java and .NET agents to configure information
points. This UI provides a text field in which you paste the information point definition in JSON
notation.
Configuring an Information Point

1.
2.
3.
4.
5.
6.

Select your application.
Click Analyze -> Information Points.
Click Add (the + symbol).
Enter a name for the information point.
Select PHP as the agent type.
In an editor, create the information point definition in JSON format. See Creating an
Information Point Definition for the details on how to construct this definition.
7. Copy and paste the JSON into the text field in the UI.
8. Click Create Information Point at the bottom of the screen.

Creating an Information Point Definition

An information point definition contains the following objects:
classMatch
methodMatch
matchConditions
metricDefinitions
An information point used for a business metric (to track some aspect of the performance of a
business) requires that you create the metricDefinitions object described below.
An information point used for a code metric (to track how a method in your application code is
performing)
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classMatch

The "classMatch" defines the class on which the information point is based. It contains a
className, which you provide, and a type, which specifies how to match the className.
The class must be defined is a separate file from the file in which it is instantiated and invoked.
The only supported type for the PHP agent is MATCHES_CLASS.
This object is optional.
If you are accustomed to configuring information points in the AppDynamics UI for other agents,
this is where the className and MATCHES_CLASS type appear in the UI:

JSON Example:
Creates an information point on a class for which the class name equals "CheckoutManager".
"classMatch": {
"type": "MATCHES_CLASS",
"className": "CheckoutManager"
},

If your class names are defined in a namespace, you need to escape the backslashes in the
namespace with an escape backslash. For example, if the full class name is:
"Bundy\ShoesBundle\Entity\CheckoutManager"
configure the class name as
"classMatch": {
"type": "MATCHES_CLASS",
"className": "Bundy\\ShoesBundle\\Entity\\CheckoutManager"
},"

methodMatch

The methodMatch defines the method on which the information point is based.
It contains a required methodName and an optional matchCondition expression.
This object is required.
If you are accustomed to configuring information points in the AppDynamics UI for other agents,
this is where the methodName and matchConditions objects appear in the UI:
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JSON Examples:
Creates an information point on a method named "process".
"methodMatch": {
"methodName": "process",
. . .

If you are creating an information point to implement a simple code metric, for example to track
how many times a method is called, the methodName object may be the only configuration you
need. For example, the following code metric information point counts the number of calls to the
method named "deleteCartItems".
"methodMatch": {
"methodName": "deleteCartItems"
}

matchConditions

The matchConditions object is the part of the methodMatch that restricts the information point to
invocations that match the configured matches conditions.
There can be multiple conditions inside the matchConditions object.
This object is optional. If it is not provided, the information point includes all invocations of the
specified method.
A condition consists of:
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an operation type used to compare the left and right sides of the match condition. Valid
types are:
EQUALS
NOT_EQUALS
LT
GT
LE
GE
NOT
AND
OR
a comparisonOp with expression nodes on the left side (lhs) and right side (rhs) of the
operation
An expression node contains
a type, which is ENTITY, STRING, or INTEGER
a value, which is an entityValue, stringValue, or integerValue
If the type is ENTITY, the entityValue has a type, which is INVOKED_OBJECT,
RETURN_VALUE, or PARAMETER.
If the type of the entityValue is PARAMETER, the zero-based parameterIndex indicates
the parameter on which to base the match.
JSON Example:
The information point matches only invocations of the process method in which parameter 1
equals "VISA".
"methodMatch": {
"methodName": "process",
"matchCondition": {
"type": "EQUALS",
"comparisonOp": {
"lhs": {
"type": "ENTITY",
"entityValue": {
"type": "PARAMETER",
"parameterIndex": 1
}
},
"rhs": {
"type": "STRING",
"stringValue": "VISA"
}
}
}

metricDefinitions

The metricDefinitions object contains one or more definitions of custom metrics.
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A custom metric defines a special metric for the data captured by the information point. This
metric appears in the Metric Browser and in the information point's dashboard. You can create
health rules based on a custom metric and retrieve its value using the AppDynamics REST
API, just like any other metric.
There can be multiple custom metrics for a single information point. For example, one metric
might be based on the average and one on the accumulated (sum) of the information point's
values.
Metric definitions are optional. If you do not configure a custom metric for an information point,
the information point captures only the generic KPIs (response time, calls and calls per
minute, errors an errors per minute) for the method. Custom metrics are typically configured
for information points that are used as Business Metrics.
A metricDefinitions objects consists of one or more definitions, each having the following
structure:
a name
a rollup type (AVERAGE or SUM)
data, which consists of a type, (ENTITY, STRING, or INTEGER) and a value
(entityValue, stringValue, or integerValue)
If the type is ENTITY, the entityValue has a type, which is INVOKED_OBJECT,
RETURN_VALUE, or PARAMETER.
If the type of the entityValue is PARAMETER, the zero-based parameterIndex indicates
the parameter on which to base the match.
JSON Example:
This metricDefinitions object defines two custom metrics: VisaTotal, which reports the sum of
the Visa payments processed and VisaAverage, which reports the average value of the Visa
payments processed.
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"metricDefinitions": [
{
"name": "VisaTotal",
"rollup": "SUM",
"data": {
"type" : "ENTITY",
"entityValue": {
"type": "RETURN_VALUE"
}
}
},
{
"name": "VisaAverage",
"rollup": "AVERAGE",
"data": {
"type" : "ENTITY",
"entityValue": {
"type": "RETURN_VALUE"
}
}
}
]

Sample JSON Information Point Configuration

This is an example that could be copied and pasted into the JSON text field in the PHP
information point window. It produces two metrics, named VisaTotal and VisaAverage.
{
"probe": {
"phpDefinition": {
"classMatch": {
"type": "MATCHES_CLASS",
"className": "CheckoutManager"
},
"methodMatch": {
"methodName": "process",
"matchCondition": {
"type": "EQUALS",
"comparisonOp": {
"lhs": {
"type": "ENTITY",
"entityValue": {
"type": "PARAMETER",
"parameterIndex": 1
}
},
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"rhs": {
"type": "STRING",
"stringValue": "VISA"
}
}
}
}
}
},
"metricDefinitions": [
{
"name": "VisaTotal",
"rollup": "SUM",
"data": {
"type" : "ENTITY",
"entityValue": {
"type": "RETURN_VALUE"
}
}
},
{
"name": "VisaAverage",
"rollup": "AVERAGE",
"data": {
"type" : "ENTITY",
"entityValue": {
"type": "RETURN_VALUE"
}
}
}
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]
}

Learn More

Business Metrics
Code Metrics
Data Collectors Versus Information Points

Monitor PHP Applications

PHP Agent
Dashboard
Business Transaction
Customizations
Learn More
The AppDynamics PHP Agent helps you monitor PHP applications in production to determine
which applications are slower than normal or producing a lot of errors. It also provides tools for
troubleshooting application problems so that you can take action before poor performance
becomes apparent to your users.
PHP Agent

The agent consists of two components:
PHP extension component: collects metrics from the PHP application
proxy component: reports metrics to the Controller, which stores, baselines and analyzes
the data collected by the agent.
The Controller can be the AppDynamics SaaS controller or an on-premise AppDynamics
controller at your workplace.
To access the data, you log in to the Controller from a Web browser using your AppDynamics
credentials. You can also access the data programmatically using the AppDynamics REST API.
Dashboard

After you install the agent and run some traffic through your application, log in to the Controller.
Typically the first thing you see is the application dashboard.
The flow map in the dashboard shows the flow of traffic through the entire application through the
various application servers (tiers) to the backends (databases, HTTP services, message queues,
caches, etc). The tiers are represented by circles.
The numbers inside the circles indicate how many nodes are in the tier. The node is the basic unit
of processing that the agent monitors; for the PHP Agent a node is a PHP-enabled web server
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instance. A tier represents a key service. The backends themselves are not instrumented by the
PHP Agent, but the agent reports metrics for flow from the tiers into them.
There are various pre-built dashboards throughout the AppDynamics UI. For details see Dashboar
ds.
Business Transaction

To get an idea of how a user experiences various interactions with an application, monitor the
application’s business transactions. A business transaction corresponds to a user request.
Business transactions offer a customer-centric approach that helps you isolate where in your app
users may be experiencing problems. Click Business Transactions in the left navigation pane or
the Top Business Transactions tab in the application dashboard the list to see a list of business
transactions in your application. Then double-click one of the business transactions in the list,
perhaps one that is reporting long response times, to examine a single business transaction in
depth.
You can examine individual instances of a business transaction taken at a point in time. These are
called transaction snapshots. Transaction snapshots let you drill down to a call graph for the
instance, to help you identify the root cause of the poor user experience for that transaction.
You may see business transactions in the flow map that pass through tiers that are not PHP
servers. For example they may be Java or .NET. Business transactions can be distributed over
multiple tiers, which may be built on different platforms. The type of the transaction is based on the
platform of the originating tier, which contains the entry point to the transaction. A business
transaction is a PHP business transaction if the user’s entry point into the transaction is a PHP tier.
Customizations

The PHP Agent collects a lot of metrics that do not appear in the standard dashboards. You can
see all the metrics in the tree in the Metric Browser. You can create custom dashboards that
display any of these metrics using a variety of widgets to create a visual display of information
customized for specific types of users in your organization: executives, ops, developers, qa and so
forth.
You can also create custom metrics, called information points, to capture additional metrics that
measure the performance of your Web application as well as business metrics that capture
business information not tied to the performance of your app.
You can also create health rules that stipulate certain levels of acceptable performance and then
create polices that automatically send an alert or take an automated action when those rules are
violated
Learn More

Distributed Transactions for PHP
Monitor PHP Backends
Organizing Traffic as Business Transactions
Transaction Snapshots
Metric Browser
Dashboards
Health Rules
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Policies
Business Metrics
Distributed Transactions for PHP

Distributed transaction tracing allows you to trace the performance of a business transaction
across multiple tiers. It provides metrics for the time spent in all the tiers through which the
business transaction passes and the ability to get call graphs displaying activity for all the tiers.
See Organizing Traffic as Business Transactions and Measure Distributed Transaction
Performance for general information.
The tiers in a distributed transaction can be heterogeneous. All combinations of PHP, Java, .NET,
and Node.js tiers are supported, whether they are an originating, continuing, or terminating tier in
the transaction.
Monitor PHP Backends

A backend is an entity in the AppDynamics model that the app agent does not instrument directly,
but traffic flows to it. The PHP Agent monitors flows to HTTP exit points, database exit points and
cache exit points. See Supported Environments and Versions for PHP for the current list of
supported backends.
You cannot configure detection and naming for PHP backends.
For general information about monitoring backends see:
Backend Monitoring
Monitor Databases
Monitor Remote Services
For special information about PHP backends see:
Monitor Predis Backends

Predis Dashboard
Learn More
The PHP Agent monitors exit calls from an app server to a Predis backend.
To see the list of Predis backends, click Servers->Remote Services.

Predis Dashboard

The dashboard for a Predis backend displays:
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a flow map showing the flow from the app server to the backend
the backend properties: host and port
graphs of the key performance indicators (KPIs) for flows to the backend
To see a backend dashboard, select it in the remote services list and either double-click or click Vi
ew Dashboard.

The agent allows you to monitor flows to master-slave replication configurations as well as
single-server configurations configurations. The dashboard for a master-slave Predis configuration
displays a single node for the entire configuration. The backend properties include the host:port of
the master separated by a pipe character (|) from a comma-separated list of host:port entries for
the slaves.
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The master/slave backend is tracked as a single server pool just as in a single-server
configurations configuration. The agent does not provide separate call graphs for flows to multiple
slaves.
Learn More

Monitor Remote Services
Monitor RabbitMQ Backends for PHP

RabbitMQ Dashboard
RabbitMQ Monitoring Extension
Learn More
The PHP Agent monitors messages sent from a PHP tier into a RabbitMQ backend.
The PHP Agent does not monitor messages received by a PHP tier from a RabbitMQ backend.
However, in a distributed transaction, the Java and .NET agents can monitor messages received
from a RabbitMQ backend when the messages originated from a PHP tier.
The PHP Agent RabbitMQ support requires the amqp extension.
To see the list of RabbitMQ backends, in the left navigation pane click Servers->Remote
Services.

RabbitMQ Dashboard
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The dashboard for a RabbitMQ backend displays:
a flow map showing the flow between app servers and the backend
the backend properties: exchange, host, port, and routing key
graphs of the key performance indicators (load, average response time, errors) for flows to
the backend. To see a backend dashboard, select it in the remote services list and either
double-click or click View Dashboard.

RabbitMQ Monitoring Extension

If you want to collect additional metrics from the RabbitMQ server itself, you can download the
RabbitMQ Monitoring extension. This extension requires the standalone Machine Agent.
Learn More

Monitor Remote Services
RabbitMQ Monitoring Extension
Install the Standalone Machine Agent

APM Overview - Node.js
This information covers using and configuring the Node.js Agent.
For general information about AppDynamics see Application Intelligence Platform and AppDynami
cs Features.
Monitor Node.js Applications
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Troubleshoot Node.js Application
Problems

Supported Environments and
Versions for Node.js

Install the Node.js Agent

Configure AppDynamics for Node.js

First Time Using the Node.js Agent

AppDynamics for Node.js Architecture
The AppDynamics Node.js Agent instruments your application running one or more Node.js
processes. Instrumentation enables the agent to discover, map and track metrics for business
transactions, application services, and backends in your Node.js application. Typically there is a
one-to-one correspondence between a process and a Node.js application but sometimes an
application consists of multiple processes.
This agent communicates with a Java proxy dameon that handles the communication between
the Node.js Agent and the AppDynamics Controller. The proxy reports the performance metrics to
the Controller, where the data is stored, baselined, and analyzed. You can access this
performance data interactively using the Browser UI or programmatically using the AppDynamics
REST API.
The proxy component is automatically started when you start the Node.js Agent.
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Supported Environments and Versions for Node.js
Supported Platform Matrix for the Node.js Agent
Node.js Versions
Operating Systems
Transaction Naming
HTTP Exit Points
Database Exit Points
Cache Exit Points
Supported Platform Matrix for the Node.js Agent
Node.js Versions

Supported Node.js Versions
0.8
0.10
Operating Systems

Supported Operating System
Linux 32-bit
Linux 64-bit
Mac OSX v10.9.2
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Transaction Naming

Entry Type

Default Transaction Naming

Node.js Web

URI

HTTP Exit Points

Supported HTTP Exit Points
Node.js HTTP client library
See http://nodejs.org/api/http.html for information about the Node.js HTTP client library.
Database Exit Points

Supported Database Exit Points
MongoDB
MySQL
PGSQL
Cache Exit Points

Supported Cache Exit Points
Memcached
Redis

Install the Node.js Agent
Requirements
AppDynamics Controller
Permissions
Installing the Node.js Agent
Testing the Installation
Advanced Instructions
Node.js Agent Settings
Older Node.js Versions
Instrumenting a Cluster of Node.js processes
3.9 Controller Temporarily Unavailable
Resolving Installation Issues for Node.js
Logs
Node.js Agent Log
Proxy Log
Installing the Standalone Machine Agent on a Node.js Node
Learn More
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Requirements
AppDynamics Controller

To use the AppDynamics Node.js Agent, you need an AppDynamics account on a running v3.9+
controller.
You can use the AppDynamics SaaS controller. If you do not already have an account on the
SaaS controller you can sign up for a subscription here.
Or you can use an on-premise controller that is installed at your site. You can download an
on-premise controller from here, and then follow these instructions on how to install it.
You need to know the controller host and port to complete the agent installation. Check your
welcome email from AppDynamics for the host and port if you signed up for a SaaS account.
Permissions

You need write access to the Node.js project.
Installing the Node.js Agent

To install the latest version you can run 'npm install appdynamics' for each application you want to
monitor, but we recommend matching the agent version to your AppDynamics Controller version:
npm install appdynamics@<version>

For example, if your AppDynamics controller version is 3.9.0, we recommend installing the 3.9.0
Node.js Agent:
npm install appdynamics@3.9.0

Then paste the following in your application as the very first line of your application source code,
before any other require statement. Replace the variables with the values for your setup:
require("appdynamics").profile({
controllerHostName: '<controller host name>',
controllerPort: <controller port number>,
controllerSslEnabled: false, // Set to true if controllerPort is
SSL
accountName: 'AppDynamics_account_name', // Required for SaaS
accounts
accountAccessKey: 'AppDynamics_account_key', // Required for SaaS
accounts
applicationName: 'your_app_name',
tierName: 'choose_a_tier_name',
nodeName: 'choose_a_node_name',
});
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Testing the Installation

1.
2.
3.
4.
5.
6.

Stop and restart your application.
Run some traffic through the application.
Wait a few minutes.
Log into your controller.
Select the newly instrumented application.
You should see metrics reported in the flow maps.

Advanced Instructions
Node.js Agent Settings

This is the complete list of settings in the require statement that you insert into your application
code. Not all these settings are required.
controller host name: the ip address or host name of your controller. SaaS customers
receive this url in their welcome email from AppDynamics. On-premise customers set them
when they install the controller.
controller port: 8080
controllerSslEnabled: set to true if connecting to the controller via SSL. Otherwise remove
this line.
accountName: your username on the SaaS controller or multi-tenant on-premise controller.
SaaS customers receive this their welcome email from AppDynamics. If you have a
single-tenant controller, remove this line.
accountAccessKey: your account access key on the SaaS controller or multi-tenant
on-premise controller. SaaS customers receive this their welcome email from AppDynamics.
If you have a single-tenant controller, remove this line.
applicationName: name that represents the entire application in the AppDynamics console
tierName: name that represents your Node.js app or service in the flow maps
nodeName: prefix to the name of the instrumented Node.js process(es) on a single
machine.
There can be multiple nodes. The agent uses this setting as the prefix to the node name and
then auto-numbers the suffixes for the remaining nodes on the same machine to create the
node name that you see in the AppDynamics UI. For example, if you set this value to
MyNode, nodes are named MyNode-0, MyNode-1, MyNode-2 . . . for multiple worker
processes on the same machine.
If you have only one process to monitor, the node is still named MyNode-0 according to this
convention. To suppress the -0 suffix use noNodeNodeNameSuffix.
If you have clusters of worker processes on different machines, the agent begins numbering
the suffixes at -0 on each machine. In this case you could specify different nodeName prefix
es for each server to name the nodes according to the pattern Server1-0, Server1-1,
Server1-2 . . ., then Server2-0, Server2-1, Server2-2 and so on.
Each applicationName/nodeName combination must be unique.
btEntryPointDelayDisabled: true|false - Optional: defaults to false. Setting to true can
accelerate the startup of business transactions, but it can adversely affect drilldown in
distributed transactions.
maxProcessSnapshotsPerPeriod: integer - Optional: defaults to 2. Number of automatic
process snapshots allowed in processSnapshotCountResetPeriodSeconds seconds (see
below).
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processSnapshotCountResetPeriodSeconds: Optional: defaults to 60. Frequency, in
seconds, at which the automatic process snapshot count is reset to 0.
proxyAutoLaunchDisabled: true|false - Optional: default to false. Set to true if you need to
manually launch the proxy for this agent. See Run the Proxy Daemon Manually for Node.js
Agents.
noNodeNameSuffix: Optional: Set to true if you do not want the agent to add a suffix (-0,
-1, -2, etc.) to the node name. In this case multiple worker processes appear in
AppDynamics as a single node.
proxyCtrlDir: directory path for the directory containing the domain control socket, which
the agent uses to start an AppDynamics node. Optional: set by the agent. Set manually if
you are setting up a multi-tenant proxy. See Set Up A Multi-Tenant Proxy for Node.js Agents
.
rootTmpDir: directory path for the root of the directory that stores the agent's files. Optional:
defaults to /tmp/appd.
tmpDir: directory path for the sub directory of the root directory for the monitored node.
Optional: defaults to a hash of the controller info for the instrumented node.
debug: true|false - Optional: defaults to false. Turn this option on for logging and
troubleshooting.
Older Node.js Versions

If your Node.js version is between 0.8.1 and 0.8.18 inclusive, you need to set the user-agent npm
property before you run the npm install command. The syntax is:
npm config set user-agent "node/<version> {linux|darwin} {x64|i86}"

For example:
npm config set user-agent “node/v0.8.14 linux x64"

Instrumenting a Cluster of Node.js processes

If you are launching a cluster of Node.js processes to implement your app, add the appdynamics
require statement to the master process code and to the code of each of the worker processes.
3.9 Controller Temporarily Unavailable

If you cannot obtain a 3.9 controller, it is possible to get started using the agent with a 3.8.6
controller, until you can upgrade. For more information, contact omed@appdynamics.com for
information on how to do this.
Resolving Installation Issues for Node.js

If you are trying to install the Node.js Agent on a version of Node.js that the agent does not
support, the installation will fail and you will see a message similar to the following:
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npm ERR! notsup Unsupported
npm ERR! notsup Not compatible with your version of node/npm:
appdynamics@3.9.3
npm ERR! notsup Required: {"node":">=0.8.0 <=0.10.31"}
npm ERR! notsup Actual:
{"npm":"1.4.28","node":"0.10.32"}
npm
npm
npm
npm
npm
npm
npm
npm
npm
npm

ERR!
ERR!
ERR!
ERR!
ERR!
ERR!
ERR!
ERR!
ERR!
ERR!

System Linux 2.6.18-348.16.1.el5
command "<your command>"
cwd <path>
node -v v0.10.32
npm -v 1.4.28
code ENOTSUP
Additional logging details can be found in:
<path>/npm-debug.log
not ok code 0

Check the AppDynamics release notes to find out the latest Node.js version supported by the
agent.
If you need an agent for an unsupported version, contact AppDynamics Support about getting an
agent for 0.8.X and 0.10.X versions of Node.js that is compatible with your environment.
Logs

There is an agent log and a proxy log for each application.
Node.js Agent Log

If the agent is running in debug mode, the agent component logs to stdout/stderr. This log contains
the transactions that the agent processes and sends to the proxy. This log is available in the same
location to which stdout/stderr streams are directed from the monitored application.
If debug mode is not enabled, no agent log is generated.
You may set debug mode in the require statement that instruments your Node.js application. See
Node.js Agent Settings.
Proxy Log

The proxy logs the transactions that it accepts from the agent and sends to the Controller. The
proxy generates logs whether or not the agent is running in debug mode.
When the agent component launches the proxy, it displays in the agent log the directory path to
which the proxy is logging.
Installing the Standalone Machine Agent on a Node.js Node

If you install the Standalone Machine Agent on the machine hosting the instrumented Node.js
node and you specify the tier and node name in the machine agent's controller-info.xml file, the
Node.js Agent will fail to register.
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To avoid this problem:
Install the Node.js Agent before you install the Standalone Machine Agent.
Do not specify the tier and node in the machine agent controller-info.xml, where it is
optional. The Standalone Machine Agent will pick up the tier and node from the app agent
configuration.
Learn More

Monitor Node.js Processes
Monitor Node.js Business Transactions
Upgrade the Node.js Agent
Uninstall the Node.js Agent

Upgrade the Node.js Agent
If you are upgrading both the Controller and agents, first upgrade the Controller and then upgrade
the agents.
Also, if you are upgrading multiple agents in your monitored environment, upgrade the agents for
the tiers on which business transactions originate last. For more information about this
requirement, along with Controller and agent compatibility information, see Agent - Controller
Compatibility Matrix.
To upgrade the app agent

1. Stop the Node.js application.
2. From the root directory of the application for which you want to upgrade the agent, uninstall
the old version of the agent by entering:
npm uninstall appdynamics

3. From the same directory install the new version by entering:
npm install appdynamics@<version>

The version is the three-digit version number of the new version that you are installing; for
example, 3.9.1.
4. Restart the Node.js application.

Learn More

Install the Node.js Agent
Uninstall the Node.js Agent
Agent - Controller Compatibility Matrix
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Uninstall the Node.js Agent
To uninstall the Node.js Agent

1. From the application root directory of the application from which you want to uninstall the
agent enter:
npm uninstall appdynamics

2. Remove the "require("appdynamics")" statement from your Node.js applications.

Run the Proxy Daemon Manually for Node.js Agents
By default, when the Node.js Agent starts up, it automatically executes the runproxy shell script.
This script runs the Java proxy daemon that handles communication between the Node.js Agents
and the controller. See AppDynamics for Node.js Architecture for information about how the Java
proxy daemon fits into the Node.js Agent architecture.
Automatic startup of the proxy works for the great majority of situations. However, you can
suppress the automatic startup of this script and run it manually. You would do this if you are
running a cluster of Node.js nodes on the same machine and you want to reduce overhead by
having them report to a single proxy. In this case, you need to configure the agents for a single
proxys and for manual proxy launch. Then you need to launch the proxy manually. See:
Execute the runProxy Script Manually
Set Up A Multi-Tenant Proxy for Node.js Agents

Set Up A Multi-Tenant Proxy for Node.js Agents
Multi-tenant Setup
To configure agents for a multi-tenant proxy
Limits on Agents Sharing a Proxy
Learn More
By default, if you are running multiple agents, each agent automatically launches its own Java
proxy to communicate with the controller.
In this single-tenant scenario, each agent has its own proxy control directory. In the require
statement for each agent, the proxy control directory is set to a unique path (a unique
app/tier/node combination). The agent creates these directories automatically.
This results in a configuration in which each agent has its own proxy. The Node.js Agents will
auto-launch their proxies when they start up.
If you want to run multiple Node.js Agents on the same machine, you can reduce your overhead
by setting up the agents to report to a single multi-tenant Java proxy. In this case, you would need
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to start that proxy manually and create the mutli-tenant proxy directory manually. This
configuration is appropriate for Node.js processes running in cluster mode.
Multi-tenant Setup

To set up a multi-tenant proxy, you need to configure the proxy control directory. This directory
contains the domain control socket, which the agent uses to start an AppDynamics node. This
directory is where the agent gets the configuration for the node. The permissions on this directory
must be readable and executable by the application user that the application and writable by the
proxy user.
To configure agents for a multi-tenant proxy

1. Configure each agent for manual launch of the proxy. To do this, in the require statement of
each agent, set the proxyAutoLaunchDisabled setting to true.
2. Manually create a single proxy control directory for use by all the agents that will share the
proxy.
3. In the AppDynamics require statement for all the agents reporting to the proxy,
set proxyCtrlDir to the directory that you created in step 2.
4. Verify that each agent reporting to the multi-tenant proxy is configured with a unique node
name.
5. Manually launch the multi-tenant proxy before you start the agents, passing the agent
control directory set in step 3 as the proxyCommunicationDir argument to the runproxy
script. See Run the Node.js Proxy Daemon Manually . AppDynamics recommends that you
launch the proxy on system startup.
Limits on Agents Sharing a Proxy

The proxy is set up to handle a maximum of 10 agents reporting to a single proxy. The proxy.out
file, visible if you are running in debug mode, indicates if the proxy is running out of heap. You may
need to adjust the maxHeapSize and maxPermSize settings in the runproxy script if you have
more than ten agents reporting to a single proxy. Contact AppDynamics Support if you need to
change these settings.
Learn More

Execute the runProxy Script Manually
Set User Preferences

Configure AppDynamics for Node.js
Configure Transaction Detection for Node.js

Accessing Transaction Detection
To Access Business Transaction Detection Configuration
Node.js Web Entry Point
Business Transaction Naming and Identification
Dynamic Transaction Naming Based on the Request
Default Detection for Node.js Web Entry Points
Configure Custom Match Rules for Node.js Web Entry Points
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To configure a custom match rule for a Node.js Web entry point
To modify a custom match rule for a Node.js Web entry point
To remove a custom match rule for a Node.js entry point
Configure Exclude Rules for Node.js Web Entry Points
To configure an exclude rule for a Node.js Web entry point
To modify an exclude rule for a Node.js Web entry point
To remove an exclude rule for a Node.js Web Web Services entry point
Learn More
Accessing Transaction Detection
To Access Business Transaction Detection Configuration

1. From the left navigation pane select Configure -> Instrumentation.
2. Click the Transaction Detection tab if it is not already selected.
3. Click the Node.js -Transaction Detection tab.
4. Do one of the following:
To configure transaction detection at the application level, in the left panel select the
application.
If you select the application, you can optionally click the button to configure all tiers to use
the application-level configuration.
To configure transaction detection at the tier level, in the left panel select the tier for which
you want to configure transaction detection.
You can choose the button to apply the application configuration to the selected tier or the
button to create a custom configuration just for this tier.
Node.js Web Entry Point

The entry point is where the business transaction begins. Typically an entry point is a method or
operation or a URI.
To enable transaction monitoring check the Transaction Monitoring check box. You can disable
monitoring at any time by clearing this check box.
For Node.js Web entry points to be automatically detected, check the Automatic Transaction
Detection check box.
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Both Transaction Monitoring and Automatic Transaction Detection have to be enabled for
the agent to collect metrics for business transactions.
If you disable automatic detection for a specific entry point type for which you have been
detecting transactions (by clearing the Automatic Transaction Detection check box for the
entry point type in the transaction detection configuration screen), the agent will stop
collecting metrics for transactions of those entry point types. It will also stop detecting new
transactions of those types.
But the transactions that the agent has already detected will still appear in the transaction
list, with metrics no longer being reported, unless you have explicitly deleted them from the
list. You can delete transactions from the business transactions list using the More
Actions->Delete Transactions item. See Business Transactions List.
Business Transaction Naming and Identification

The default convention for Node.js Web transactions is to use first two segments of the URI of the
application to name the transaction. Click Configure Naming if you want to change the naming
convention to the full URI or to use different segments of the URI to give the business transactions
more meaningful names.

If the first two segments of all your transactions are similar, you might want to base the business
transaction names on a different part of the URI:

Dynamic Transaction Naming Based on the Request

You can also configure dynamic transaction naming based on the details of the user request.
For example:
If the web context is http://example.com/store/checkout, the naming strategy would use the
default first two segments to name these transactions as /store/checkout.
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If the web context is http://example.com/store/secure/internal/updateinventory, the naming
strategy would use last two segments to name these requests as /internal/updateinventory.
If the web context is http://wines.com/store/orders.special, the naming strategy would use the
combination of the parameter value for "type" and the last two segments to name such requests
as /orders/process.special. Similarly, depending on the web could, you can use the cookie,
header, request method or any combinations of URI segments to configure useful business
transaction names.

Default Detection for Node.js Web Entry Points

By default, AppDynamics automatically names Node.js Web transactions based on the url of the
application.
You may be seeing too many or too few Node.js Web transactions. If you are not getting the
visibility that you need with the default configuration, create one or more custom match rules
for Node.js Web entry points.
If you are seeing too many transactions, create exclude rules to prevent the agent from
discovering the entry points that you do not need to monitor. Or create custom match rules that
group several entry points into a single entry point.
If you are seeing too few transactions, review your custom match rules rules to make sure that
they detect all the entry points that you want the agent to discover.
Configure Custom Match Rules for Node.js Web Entry Points

You can configure multiple match criteria for the agent to use to detect the transaction.
The agent determines the match using only the configured criteria.
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To configure a custom match rule for a Node.js Web entry point

1. Access the Node.js transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Custom Match Rules section.
3. Click the add icon to add a new custom match rule.
4. In the New Business Transaction Match Rule - Web window, enter a name for the rule.
5. Check the Enabled check box to enable the rule.
6. Optionally enter the priority of this rule for the app agent to use when multiple rules could apply
to the same entry point. See The Priority Parameter when Multiple Rules Apply.
7. In the Transaction Match Criteria section, for each match condition that you want to specify, do
the following:
a. Check the check box for the segment for which you are configuring a match.
b. In the text field, enter the value against which to match.
c. Select the condition to use to determine the match from the dropdown list.
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To reverse the condition, click the gear icon and check the NOT condition check box.
8. Click Create Custom Match Rule.
To modify a custom match rule for a Node.js Web entry point

1. Access the Node.js transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Custom Match Rules section.
3. From the Custom Match Rules list, select the rule that you want to modify.
4. Double-click the rule or click the edit icon.
5. Modify the rule as needed. See steps 6 and 7 in To configure a custom match rule for a Node.js
Web entry point. If you want to disable the rule, clear the Enabled check box.
6. Click Save.
To remove a custom match rule for a Node.js entry point

1. Access the Node.js transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Custom Match Rules section.
3. From the Custom Match Rules list, select the rule that you want to remove.
4. Click the delete icon.
5. In the Confirm Delete window click OK.
Configure Exclude Rules for Node.js Web Entry Points

You can configure an exclude rule to exclude from detection any entry point that matches the
configured match conditions. The match conditions are the same as those available for configuring
a custom match rule.
Transactions excluded through exclude rules are never detected and are not counted towards the
business transaction limit.
By default, a pre-configured exclude rule is provided to exclude business transactions for static
content such images, CSS files, JavaScript files, and static HTML pages.

You can modify or remove this exclude rule if it does not fit your needs.
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To configure an exclude rule for a Node.js Web entry point

1. Access the Node.js transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Exclude Rules section.
3. Click the add icon to add a new exclude rule.
4. In the New Exclude Business Transaction Match Rule - Web window, enter a name for the rule.
5. Check the Enabled check box to enable the rule.
6. In the Transaction Match Criteria section, for each match condition that you want to specify, do
the following:
a. Check the check box for the segment for which you are configuring a match.
b. In the text field enter the value against which to match.
c. Select the condition to use to determine the match from the dropdown list.
To reverse the condition, click the gear icon and check the NOT condition check box.
7. Click Create Exclude Rule.
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To modify an exclude rule for a Node.js Web entry point

1. Access the Node.js transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Exclude Rules section.
3. From the Exclude Rules list, select the rule that you want to modify.
4. Double-click the rule or click the edit icon.
5. Modify the rule as needed. See step 6 in To configure an exclude rule for a Node.js Web entry
point. If you want to disable the rule, clear the Enabled check box.
6. Click Save.
To remove an exclude rule for a Node.js Web Web Services entry point

1. Access the Node.js transaction detection instrumentation window. See Accessing Transaction
Detection.
2. Scroll down to the Exclude Rules section.
3. From the Exclude Rules list, select the rule that you want to remove.
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4. Click the delete icon.
5. In the Confirm Delete window click OK.
Learn More

Business Transaction Monitoring
Match Rule Conditions
Import and Export Transaction Detection Configuration for Node.js

Import and Export Auto-Detected Entry Point Configurations
To import or export the configurations for all the auto-detected entry-points to or from
an application
To import or export the configuration for a single auto-detected entry point type to or
from an application
To import or export the configurations for all the auto-detected entry-points to or from
a tier
To import or export the configuration for a single auto-detected entry point type to or
from a tier
Import and Export Custom Match Rules
To import or export a single custom match rule to or from an application
To import or export a single custom match rule to or from a tier
Import and Export Exclude Rules
To import or export a single exclude rule to or from an application
To import or export a single exclude rule to or from a tier
Overwrite Parameter
AppDynamics lets you migrate transaction detection configurations for Node.js entry points from
one application to another using a REST API. Use the API to copy transaction detection
configurations rather than manually re-configuring multiple applications in the Controller.
Import and Export Auto-Detected Entry Point Configurations

You can import and export all your entry point configurations or one entry point configuration in a
single request. Lists of multiple entry point names are not supported.
You can import to or export from the following application-level and tier-level configurations:
auto-detected entry point configurations
custom match rules
exclude rules
Here are some guidelines for exporting entry point configurations:
Use the HTTP GET method.
Encode the URI using UTF-8 URL encoding.
The base URI is the source application and, optionally, the source tier for your configuration
export.
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http://<controller host>:<controller
port>/controller/transactiondetection/<application
name>/<optional tier name>

The Controller exports the configurations to an XML file. If necessary, you can edit the XML
file before you import it.
For example, if you export the all the auto-detected entry points but don't want to import
them all, delete the ones you do not want from the file before import.
Here are some guidelines for importing entry point configurations:
Export the auto-detected entry point configuration, custom match rule, or exclude rule from
the Controller.
Alternately, you can manually create the XML, but that option is more work for you.
Use the HTTP POST method.
Encode the URI using UTF-8 URL encoding.
The base URI is the destination application and, optionally, the destination tier for your
configuration import.
http://<controller host>:<controller
port>/controller/transactiondetection/<application
name>/<optional tier name>

Include the XML configuration as a file attachment to the request.
Use UTF-8 URL encoding of the URI before posting. For example, use the plus symbol "+"
to replace the space character in the URI.
To overwrite an existing configuration with the same name see Overwrite Parameter.
A successful import request returns HTTP status code 200.
To import or export the configurations for all the auto-detected entry-points to or from an application

http://<controller host>:<controller
port>/controller/transactiondetection/<application name>/auto

exports all the auto-detected entry point types for all agents: ASP.NET, Java, PHP, NodeJS, etc.
For example:
http://appdcontroller.example.com/controller/transactiondetection/Ho
wdy+World+Travel/auto

produces the output in auto_all.xml.
To import or export the configuration for a single auto-detected entry point type to or from an application
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http://<controller-host>:<controller-port>/controller/transactiondet
ection/<application name>/auto/<entry point type name>

Entry point types names are case insensitive. The following entry point type name is valid:
nodeJsWeb
For example:
http://appdcontroller.example.com/controller/transactiondetection/Wi
ne+Cellar/auto/nodeJsWeb

To import or export the configurations for all the auto-detected entry-points to or from a tier

http://<controller-host>:<controller-port>/controller/transactiondet
ection/<application name>/<tier name>/auto

For example:
http://appdcontroller.example.com/controller/transactiondetection/Wi
ne+Cellar/wineTier/auto/

To import or export the configuration for a single auto-detected entry point type to or from a tier

http://<controller host>:<controller
port>/controller/transactiondetection/<application name>/<tier
name>/auto/<entry point type name>

For example :
http://appdcontroller.example.com/controller/transactiondetection/Wi
ne+Cellar/wineTier/auto/nodeJsWeb

Import and Export Custom Match Rules
To import or export a single custom match rule to or from an application

http://<controller host>:<controller
port>/controller/transactiondetection/<application
name>/custom/<entry point type name>/<custom rule name>
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For example:
http://appdcontroller.example.com/controller/transactiondetection/Wi
ne Cellar/custom/nodeJsWeb/Sample+Rule

To import or export a single custom match rule to or from a tier

http://<controller host>:<controller
port>/controller/transactiondetection/<application name>/<tier
name>/custom/<entry point type name>/<custom rule name>

For example:
http://appdcontroller.example.com/controller/transactiondetection/Wi
ne+Cellar/wineTier/custom/nodeJsWeb/Sample+Rule

Import and Export Exclude Rules
To import or export a single exclude rule to or from an application

http://<controller host>:<controller
port>/controller/transactiondetection/<application
name>/exclude/<entry point type name>/<exclude rule name>

For example:
http://appdcontroller.example.com/controller/transactiondetection/Wi
ne+Cellar/exclude/nodeJsWeb/My+Exclude+Rule

To import or export a single exclude rule to or from a tier

http://<controller host>:<controller
port>/controller/transactiondetection/<application name>/<tier
name>/exclude/<entry point type name>/<exclude rule name>

For example:
http://appdcontroller.example.com/controller/transactiondetection/Wi
ne+Cellar/wineTier/exclude/My+Exclude+Rule/My+Web+Service+Exclude+Ru
le
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Overwrite Parameter

Use the overwrite parameter to overwrite a configuration of the same name. Without this
parameter, if the import encounters a configuration for a component of the same name, the
request will fail.
For example, to import a configuration for a custom match rule named "My Rule" to an application
that has an existing "My Rule" custom match rule that you want to overwrite use:
http://appdcontroller.example.com/controller/transactiondetection/Wi
ne+Cellar/custom/nodeJsWeb/My+Rule?overwrite=true

The default is overwrite=false.
Configure Error Detection for Node.js
Accessing Error Detection Configuration for the Node.js Agent
To Access Error Detection Configuration
Ignoring Exceptions
To configure the Node.js Agent to ignore an exception
The Node.js Agent reports exceptions thrown by the Node.js application or by Node.js itself.
You can configure which exceptions the Node.js Agent reports.
Accessing Error Detection Configuration for the Node.js Agent
To Access Error Detection Configuration

1. From the left navigation pane select Configure -> Instrumentation.
2. Click the Error Detection tab.
3. Click the Node.js - Error Detection subtab.
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You can use the asterisk ("*") as a wild card to match zero or more characters in the
exception name.

Ignoring Exceptions

Exceptions in the Ignored Exceptions list are not reported and not counted. This feature especially
is useful if the application throws exceptions for certain conditions that are not really errors.
"Ignored exceptions" are not really ignored. The agent still detects the exception, logs the
exception, increments the exception count, and displays the exception in the Exceptions subtab of
the Errors tab of the tier and node dashboards. But it does not increment the business transaction
error count for errors caused by an ignored exception or report the transaction as an error
transaction in the transaction snapshot. See Configure Error Detection for more information.
To configure the Node.js Agent to ignore an exception

Click Add New Exceptions to Ignore under the Ignored Exceptions list.
1. In the Exception field, enter the name of the exception to ignore,.
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2. Optionally, further qualify the exceptions to ignore by configuring a match condition for the
exception message. Enter the string to match and the qualifier from the dropdown list
(Equals, Contains, Starts with, Ends with, Matches Reg Ex). .
For example, the following configuration specifies that all exceptions for which the exception
message contains the string "SQLRecoverableException" should not be reported or counted
as an error.

Click the gear icon to configure the NOT condition for the match.
3. Click Save.
4. Click Save Error Configuration in the top left corner of the window.
You can later edit an ignored exception configuration by selecting it in the Ignored Exceptions list
and clicking the Edit button. You can remove it by clicking the Delete icon in the upper right corner
of the list.

Monitor Node.js Applications

A node in the AppDynamics model is a single Node.js process instrumented by an AppDynamics
Node.js Agent.
The node dashboard for Node.js is like the node dashboards for the other app agent except:
It includes a Process Snapshots tab for accessing the process snapshots for the node.
It does not include a Memory tab for monitoring memory usage.
See Node Dashboard for general information about node dashboards.
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The tier dashboard for Node.js is similar to the tier dashboards for the other app agents except
that it includes a tab for accessing the process snapshots for the nodes contained by the tier.
See Tier Dashboard for general information about tier dashboards.
See Monitor Node.js Processes for information about process snapshots.
See also Troubleshoot Slow Response Times for Node.js.
Monitor Node.js Business Transactions
Node.JS Transaction Snapshots
EXIT CALLS in Transaction Snapshots
Distributed Business Transactions
Learn More
See Monitor Business Transactions and Transaction Snapshots for general information about
monitoring business transactions.
Node.JS Transaction Snapshots

This is a call drill down window for a transaction snapshot captured by the Node.js agent.

See Diagnostic Data Captured by a Transaction Snapshot in the Call Drill Down Window for
information about the tabs that the Node.js agent transaction snapshots have in common with the
transaction snapshots of other application agents.
Node.js transaction snapshots do not have call graphs. To view call graphs that reveal bottlenecks
in your Node.js code, use process snapshots.
If a business transaction snapshot was taken at approximately the same time as a process
snapshot, click the associated Process Snapshot GUID link in the transaction snapshot summary
to view the call graph in the process snapshot. For more information about business transactions
and process snapshots see Process Snapshots and Business Transactions.
The ADDITIONAL DATA tab displays the process snapshot GUID and process id of the process
associated with the snapshot.
SERVICE ENDPOINTS are not currently supported for this agent.
EXIT CALLS in Transaction Snapshots
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The EXIT CALLS tab traces exit calls from slow transactions made during the interval covered by
the snapshot. In the list, click the exit call that you want to examine.
If the exit call you are viewing makes another exit call, click Drill Down into Downstream call to
see a transaction snapshot of the call on the downstream tier.

Distributed Business Transactions

Distributed transaction tracing allows you to trace the performance of a business transaction
across multiple tiers. It provides metrics for the time spent in all the tiers through which the
business transaction passes and the ability to get call graphs displaying activity for all the tiers.
See Organizing Traffic as Business Transactions and Measure Distributed Transaction
Performance for general information.
The tiers in a distributed transaction can be heterogeneous. All combinations of Node.js, Java,
.NET, and PHP tiers are supported, whether they are an originating, continuing, or terminating tier
in the transaction.
Watch this short video to see a distributed business transaction in action:
<p> </p>
Direct link: https://appdynamo.wistia.com/medias/33m8tmpxb5
Learn More

Monitor Business Transactions
Transaction Snapshots
Process Snapshots and Business Transactions
Monitor Node.js Processes
Automatic Process Snapshot Generation
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Configure Automatic Collection
Set Up Process Snapshot Collection
Process Snapshots List
To filter the process snapshots list
More Actions Menu
Learn More
One reason for slow load times is inefficient code that uses a lot of CPU time. In a single-threaded
model, such as Node.js, one slow process forces other processes to wait.
You can monitor Node.js processes using lists of process snapshots to identify which processes
have high CPU times. From the list you can select and examine process snapshots of slow
processes to identify exactly which functions in your code are blocking the CPU.
A process snapshot describes an instance of a CPU process on an instrumented node.js node. It
generates a process-wide call graph for a CPU process over a configurable time range. Process
snapshots are independent of any running business transactions. Process snapshots persist for 14
days, unless you archive them in which case they are available forever.
You can monitor process snapshots at the tier level or the node level.
Automatic Process Snapshot Generation

When a business transaction snapshot is triggered by periodic collection or by a diagnostic
session, a ten-second process snapshot is automatically started. By default the agent starts no
more than two process snapshots per minute automatically, but this behavior is configurable.
You can also start process snapshots manually on demand. See Set Up Process Snapshot
Collection below.
It is common to have transaction snapshots with no corresponding process snapshots, if the
period of the transaction snapshot and the period of the process snapshot do not overlap. To
maximize the chances of corresponding snapshots, you can increase the maximum number of
process snapshots taken in a period. The tradeoff is increased overhead. For more information
see Process Snapshots and Business Transactions.
Configure Automatic Collection

You can configure automatic process snapshot collection using the following settings:
processSnapshotCountResetPeriodSeconds: Frequency, in seconds, at which the
automatic process snapshot count is reset to 0, default is 60
maxProcessSnapshotsPerPeriod: Number of automatic process snapshots allowed in
processSnapshotCountResetPeriodSeconds seconds, derfault is 2
To configure these settings, add them to the require statement in your application source code as
described in Install the Node.js Agent. Then stop and restart the application.
Set Up Process Snapshot Collection

1. Navigate to the dashboard for the tier or node for which you want to collect process
snapshots.
2. Click the Process Snapshots tab.
3. Click Collect Process Snapshots.
4.
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4. If you are in the tier dashboard, select the node for which you want to collect snapshots from
the Node dropdown list. If you are in the node dashboard, you can only set up snapshot
collection for that node.

5. Enter how many seconds you want to collect process snapshots for this node. The
maximum is 60 seconds.
6. Click Start.
The agent collects process snapshots for the configured duration.
Process Snapshots List

To access the process snapshots list:
1. Navigate to the dashboard for the tier or node for which you want to view process
snapshots.
2. Click the Process Snapshots tab.
For each process snapshot the list displays the time the process started, the process's execution
time in milliseconds, and the tier and node in which the process executed.
Click the Exe Time column and then toggle the direction to sort the snapshots in descending order
by execution time. The processes with the slowest CPU times will be at the top of the list. These
are the snapshots you will want to examine.
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To examine a process snapshot, double-click it in the list. See View Process Snapshots for details
about what you see.
To filter the process snapshots list

You can filter the process snapshot list to display only the snapshots that you are interested in.
You can filter by execution time, whether the snapshot is archived, and the GUID of the request. If
you access the list from the tier dashboard, you can also filter by node.
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More Actions Menu

Use the More Actions menu to select one or more process snapshots in the list and perform the
following actions on them.
Archive Use this option to archive the selected process snapshots. Normally snapshots are
purged after two weeks. You can archive a snapshot beyond the normal snapshot lifespan
to retain it for future analysis. You can view archived snapshots by checking the Archived
filter in the Filters panel.
Delete items Use this option to remove the snapshot from the list.
Copy a Link to this Snapshot to the clipboard Use this option to send a link to the
snapshot to someone.
Export Grid Data Use this option to export the snapshot data to a file.
Learn More

View Process Snapshots
Node.js Process Metrics
View Process Snapshots
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A process snapshot describes an instance of a CPU process on an instrumented Node.js node
From the process snapshots list, double-click the process snapshot that you want to view. See Pro
cess Snapshots List if you do not know how to access the list.
A process snapshot contain the following tabs:
SUMMARY: Displays the execution time of the process, timestamp of the snapshot, CPU
time used, tier and node the process ran on, GUID of the request, etc..
You can click the link icon to copy a link of the snapshot URL.

CALL GRAPH: Shows the execution time of methods on the process's call stack.
In the Time column you can identify which calls take the longest time to execute.
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Click the

at the end of the row to see more information about a call.

HOT SPOTS: Sorts calls by execution time, with the most expensive calls at the top.
To see the invocation trace of a single call in the lower panel, select the call in the upper
panel.
Use the slider in the upper right corner to filter which calls to display as hot spots. For
example, the following setting filters out all calls faster than 1.5 ms from the hot spots list.

BUSINESS TRANSACTIONS: Displays information about calls to the process captured in
the snapshot per associated associated business transaction when the entire business
transaction executes within the time covered by the process snapshot. See Process
Snapshots and Business Transactions for information about what you see in a call graph
when part of a business transaction is captured in a process snapshot.
The Calls column reports the number of instances of the business transaction that were
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running during the time of the process snapshot. The Total Time is the sum of the execution
time for all those business transaction instances.

See Process Snapshots and Business Transactions for information about what you see in a
call graph when part of a business transaction is captured in a process snapshot.
ADDITIONAL DATA : Displays the unique id of the process.

Learn More

Process Snapshots and Business Transactions
Process Snapshots List
Node.js Process Metrics

Process Metrics Defined
CPU Usage
Memory Metrics
Garbage Collection
Memory
I/O
Disk
Network
The Node.js Agent provides metrics related to CPU usage, memory, and I/O for each Node.js
process.
These per process metrics are available in the Metric Browser.
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Process Metrics Defined
CPU Usage

CPU Usage: % busy
Memory Metrics
Garbage Collection

Full GC: number of full garbage collection cycles the V8 JavaScript runtime has performed
in the selected time range
Incremental GC: number of incremental garbage collection cycles the V8 JavaScript
runtime has performed in the selected time range
Memory

Heap size change: total amount of memory reclaimed by the full and incremental garbage
collection cycles (as a percentage) in the selected time range
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Current usage (V8 heap used in MB):total size of the heap at the current time point. This
reports how much memory the node process is using for data storage.
RSS: Resident Set Size of the Node process. This reports the amount of memory (heap and
stack) that is allocated for the process and in RAM, not swapped out.
I/O
Disk

KB Read: KB read from disk per second for the selected time range
KB Written: KB written to disk per second for the selected time range
Network

Incoming: KB/sec received per second for the selected time range
Outgoing: KB/sec sent for the selected time range

Process Snapshots and Business Transactions

When you drill down to find the root cause of problems in application code, you can examine the
call graphs in the Node.js process snapshots.
The Node.js agent does not provide call graphs in business transaction snapshots.
If you are troubleshooting Node.js transactions using the process snapshot call graphs, be aware
that only the portion of the business transaction code that was executing at the time that the
process snapshot was taken is captured in the call graph.
The scenario sketched below shows a 30-second process snapshot that captured:
the execution of all of the code in Business Transaction 2 and Business Transaction 3
the code executing at the end of Business Transaction 1
the code executing at the beginning of Business Transaction 4
the code executing in the middle of Business Transaction 5 but not the beginning or the end
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Monitor Node.js Backends

A backend is an entity in the AppDynamics model that the app agent does not instrument directly,
but monitors traffic flows to it. The Node.js Agent monitors flows to database and cache exit points.
See Supported Environments and Versions for Node.js for the current list of supported backends.
You cannot configure detection and naming for Node.js backends.
For general information about monitoring backends see:
Backend Monitoring
Monitor Databases
Monitor Remote Services

Troubleshoot Errors for Node.js
Error Transactions and Exceptions
To Troubleshoot Error Transactions
To Troubleshoot Exceptions
Identifying and troubleshooting errors in your
application.

Error Transactions and Exceptions

The Node.js Agent reports an unhandled exception as a business transaction error if it occurred in
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the context of a business transaction. This includes exceptions occurring during an exit call that
prevent the transaction from working properly. If no business transaction context can be
established, unhandled exceptions are reported as application errors.
If a business transaction experiences an error, it is counted as an error transaction and not as a
slow, very slow or stalled transaction even if the transaction was also slow or stalled, unless the
exception that caused the error was configured to be an "ignored exception".
Operations returning HTTP status codes between 400 and 505 are reported as errors.
There is not a one-to-one correspondence between the number of errors reported and the number
of exceptions that occurred. For example, a business transaction may experience a single code
500 error in which several exceptions were logged as the transaction passed through multiple
tiers.

You can limit the types of exceptions that the agent reports. See Configure Error Detection for
Node.js.
To Troubleshoot Error Transactions

1. Click Troubleshoot -> Errors in the left navigation panel.
The error viewer opens.
2. Click the Error Transactions tab if it is not already selected.
3. From the time range drop-down menu select the time range for which you want to view
information about error transactions.
A graph of the error transactions displays at the top of the viewer. You can get an exact count of
the errors per minute at a particular point in time by hovering with your pointing device on the line
in the graph.
To the right of the graph is a summary of the load and the error transactions.
Check the Plot check box if you want the graph at the top of the viewer to show the load as well as
the errors over the selected time period. Clear this check box if you want the graph to show only
the error transactions.
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4. The error transaction snapshots are listed in the lower part of the viewer. To filter this list click S
how Filters and select the filter criteria.
5. To examine the root cause of an error, select a snapshot from the list and click View
Transaction Snapshot. See Transaction Snapshots for information about examining snapshots.
6. To identify the most expensive calls or queries:
Select one or more snapshots from the lists and click Analyze and then click Identify the
most expensive calls / SQL statements in a group of snapshots.
The Most Expensive Methods / SQL Statements viewer opens.
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In the upper panel you can click the links to the business transaction, tier and node
dashboards for those expensive calls. In the lower panel, click the Expensive Methods tab
to view the expensive methods with their total and average execution times and call counts.
Click the Expensive SQL tab to view the queries with their counts and execution times.
To Troubleshoot Exceptions

1. Click Troubleshoot -> Errors in the left navigation panel.
2. Click the Exceptions tab if it is not already selected.
The total exception count, HTTP Error Codes and Error Page Redirects for the selected time
range are reported in the upper panel. You can get an exact count of the exceptions per minute at
a particular point in time by hovering with your pointing device on the line in the graphs.
The exceptions list is displayed in the lower panel.
To filter the exception list, enter the filter term in the filter text field.
To see only exceptions with performance data, clear the Show Exceptions with 0 count
checkbox.
3. To view details of a particular exception, select the exception the list in the lower panel and click
View Details.
4. To view transaction snapshots for an exception:
a. In the exception detail window, click the Occurrences of this Exception subtab to view
information about the exception

b. In the exception detail window, click Stack Traces for this Exception to see a stack trace of
the exception.
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Resolve AppDynamics Issues for Node.js
Starting and Stopping an Instrumented Node.js Instance
Starting and Stopping an Instrumented Node.js Instance

Any scripts that you use to start and stop your instrumented Node.js instance should use
SIGTERM if at all possible.
If you use SIGKILL (kill -9), the agent's proxy component will not be cleaned up and will leak.

First Time Using the Node.js Agent
All Applications Dashboard
Application Dashboard
Time Range
Flow Map and KPIs
Events
Transaction Scorecard
Exceptions and Errors
Learn More
This topic assumes that an application is already instrumented and configured in AppDynamics
and that you have already logged in to the AppDynamics Controller.
It is an overview of how AppDynamics displays actual and potential problems that users may
experience while they are using your application - transactions that are slow, stalled or have
errors. After you know where your problems are, you can easily identify their root causes.
All Applications Dashboard

When you log into the Controller you see the Home page.
Click View All Applications to see the All Applications dashboard.
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The All Applications dashboard displays high-level performance information about one or more
business applications. Load, response time, and errors are standard metrics that AppDynamics
calls "key performance indicators" or "KPIs". Other dashboard information includes:
Health Rule Violations: AppDynamics lets you define a health rule, which consists of a condition
or a series of conditions based on metrics exceeding predefined thresholds or dynamic baselines.
You can then use health rules in policies to automate optional remedial actions to take if the
conditions trigger health rule violation events. AppDynamics also provides default health rules to
help you get started.
Business Transaction Health: The health indicators are a visual summary of the extent to which
a business transaction is experiencing critical and warning health rule violations. See Troubleshoot
Slow Response Times.
Server Health: Additional visual indicators track how well the server infrastructure is performing.
Application Dashboard

Click an application to monitor, one that has some traffic running through it. The Application
dashboard gives you a view of how well the application is performing.
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This dashboard shows the performance of the Wine Cellar application for the last 15 minutes. The
flow map displays your servers (application servers, databases, remote servers such as message
queues, etc.) and metrics for the calls between them. Click, hold and move the icons around to
rearrange the flow map. Use the slider on the left to change the scale.
The trend graphs at the bottom of the dashboard show the key performance indicators over the
selected time range for the entire application.
Time Range

From the time range drop-down in the upper-right corner select the time range over which to
monitor - the last 15 minutes, the last couple of hours, the last couple of days or weeks. Try a few
different time ranges and observe how the dashboard data changes.
Flow Map and KPIs

In the flow map, click any of the blue lines to see more detail on the aggregated key performance
metrics (load, average response time and errors) between two servers. For example, clicking the
data on the line from wineTier to the Redis backend displays the detail for that flow.
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Events

An event represents a change in application state. The Events pane lists the important events
occurring in the application environment.
See Monitor Events.
Transaction Scorecard

The Transaction Scorecard panel displays metrics about business transactions within the specified
time range, covering the percentage of instances that are normal slow, very slow, stalled or have
errors. Slow and very slow transactions have completed. Stalled transactions never completed or
timed out. You can configure the thresholds that define the level of performance for the slow, very
slow and stalled categories. See Scorecards and Transaction Snapshots.
Exceptions and Errors

An exception is a code-logged message outside the context of a business transaction.
An error is a departure from the expected behavior of a business transaction, which prevents the
transaction from working properly.
See Troubleshoot Errors.
Learn More

Dashboards
Flow Maps
Configure Thresholds
Monitor Events
Troubleshoot Application Problems - Node.js
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Monitor and Measure
This section describes how Application Performance Management
monitors your business applications.

Monitor Business Applications

An AppDynamics business application models all components or modules in an application
environment that provide a complete set of functionality. Business applications are defined during
app agent installation. To learn how AppDynamics maps your application environment to business
applications see:
Logical Model
Mapping Application Services to the AppDynamics Model
Name Business Applications, Tiers, and Nodes
Once you have modeled your application environment into one or more AppDynamics business
applications during installation, use the Controller UI to see how application traffic flows as
business transactions and to discover what metrics are monitored and reported. You can modify
the default business transactions and other configurations.
Visualize Application Performance
View Detailed Application Metrics
Monitoring Across the Business Application
Visualize Application Performance

The UI provides a graphical view of your business application performance. If you haven't already
familiarized yourself with the Controller UI, see Controller UI Guide.
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View Detailed Application Metrics

Use the Metric Browser to see and compare various metrics from your application. See Metric
Browser.
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Monitoring Across the Business Application

Use the the following features to monitor performance across the business application:
Detect Anomalies Using Dynamic Baselines
Set Performance Boundaries Using Thresholds
Fine-Tune Configurations Using Match Conditions
Detect Problems Caused by Application Data
Visualize Performance Using Custom Dashboards
Hierarchical Configuration Model
See the following sections to learn about monitoring various entities in your application:
Monitor Business Transactions
Monitor Errors and Exceptions
Monitor Infrastructure
Monitor Service Endpoints
Monitor Background Tasks

Detect Anomalies Using Dynamic Baselines
Anomalies in Application Performance
How Anomaly Detection Works
Defining Baselines
The Base Time Period
Trends: Data Segmentation
Choosing Trend Types
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Preconfigured Baselines
Selecting and Configuring the Best Baselines for Your Application
Using a Preconfigured Baseline
Changing Existing or Creating New Baseline Patterns
Using Baselines, Health Rules, and Alerts to Proactively Identify Performance
Problems
Learn More
This topic discusses dynamic baselines and how AppDynamics learns to detect performance
anomalies using baselines.
Anomalies in Application Performance

A complex distributed application has a large number of performance metrics and each metric is
important in one or more contexts. In such environments, it is difficult to:
manually determine the values or ranges that can be considered normal for a particular
metric.
set meaningful thresholds in order to receive relevant alerts.
maintain a sense of what is a "normal" metric when the application or infrastructure
undergoes change.
For these reasons anomaly detection based on dynamic baselines is one of the most important
features in AppDynamics.
AppDynamics automatically calculates dynamic baselines for all of your metrics, which, based on
actual usage, define what is "normal" for each metric. Then AppDynamics' anomaly detection uses
these baselines to identify any subsequent metrics whose values fall out of this normal range.
Static thresholds that are both tedious to set up and, in rapidly changing application environments,
too often error-prone, are no longer needed. Anomaly detection can be applied to all AppDynamics
metrics.
Baselines are not available immediately upon start-up. It takes a certain amount of time and
load for AppDynamics to collect data and create its initial baselines, depending on the type of
baseline being used. The longer the time frame required by the trend-type, the longer it takes for a
fully functional baseline to be set up.
How Anomaly Detection Works

AppDynamics creates baselines by collecting metrics from your application over defined
periods of time. This establishes what is "normal" for your application.
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You define what constitutes an "anomaly" for your purposes by setting performance
thresholds and establishing health rules in relation to those baselines. An anomaly is any
metric that deviates a certain amount from a particular baseline, either in terms of standard
deviations, percentages, or set values.
AppDynamics monitors these performance and behavior levels automatically. It can notify
you in multiple ways and it can even direct remedial action.
Defining Baselines

Different baseline types can be useful in different situations. You select the type of baseline you
wish to use by using two variables:
The time period that should serve as the base
The way the data collected during the time period should be segmented and sorted
The Base Time Period

The base time period, whose data is used to establish the baseline, can be defined in two different
ways:
A fixed time range - from some specific date and time to a second specific date and time.
For example, if you have a release cycle at a specific time you might limit your data
collection to that specific time.
A rolling time range, in which the most recent x number of days is always used. This is the
more common choice.
Trends: Data Segmentation

As the data is being collected, it can be segmented in four different ways. AppDynamics calls
these segmentation patterns trends.
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No trend: all data collected in the base time period is evaluated in the same set. This
produces a baseline that is a flat average over the entire time period.
Daily: all data collected in the base time period is broken down into sets based on the hour
of day they were collected. This produces a baseline that can vary based on the hour of
day.

Weekly: all data collected in the base time period is broken down into sets based on the
hour of day and the day of the week. This produces a baseline that can vary based on the
hour of day combined with the day of the week.

Monthly: all data is broken down into sets based on hour of day and day of the month. This
produces a baseline that can vary based on the hour of day combined with the day of the
month.

Choosing Trend Types

You should choose the trend types that are most useful to you based on the use patterns of your
application. For example, many applications have periodic load patterns:
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A retail application may experience heavier traffic on the weekend than the rest of the week.
A payroll application may experience higher load at the beginning and end of the month
compared to the rest of the month.
A Customer Relationship Management (CRM) application may experience heavy load
during business hours Monday - Friday, but relatively light traffic over the weekend.
In each of these cases, using the no trend trend-type would likely produce a less effective
baseline, because it would be skewed by periods of low application load. Match the trend type to
your load type to ensure that AppDynamics determines the relevant baseline.
It may be that some of metrics you are interested in follow different periodic patterns. In this case
you can define multiple baselines. You can configure any one of those baselines to be the default
baseline for defining performance health rules.
Preconfigured Baselines

AppDynamics provides four preconfigured baselines. To see them, click Configure->Baselines in
the left navigation bar.
The Baselines view opens:

The four baselines are as follows:
All Data - Last 15 days - This baseline is calculated using a rolling time range over the last
15 days using the no trend trend type.
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It allows you to compare the value of a particular metric to the value of all such metrics
captured during the last 15 days.

Daily Trend - Last 30 Day - This baseline is calculated using a rolling time range over the
last 30 days using the Daily trend type.
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It allows you to compare the value of a particular metric at a particular hour of the day to the
baseline value of all such metrics captured during that hour for the last thirty days.

Weekly Trend - Last 90 Days -This baseline is calculated using a rolling time range over
the last 90 days using the Weekly trend type.
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It allows you to compare the value of a particular metric at a specific hour of the day on a
specific day of the week to the baseline value of all such metrics captured during that hour of
the day and day of the week for the last 90 days.

Monthly Trend - Last 365 Days - This baseline is calculated using a rolling time range over
the last 365 days using the Monthly trend type. .
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It allows you to compare the value of a particular metric at a particular hour of the day for a
particular day in the month to the baseline value of all such metrics captured during that hou
r of the day and day of the month for the last 365 days.

Copyright © AppDynamics 2012-2014

Page 1755

Selecting and Configuring the Best Baselines for Your Application

Use the following options to configure baseline patterns in your environment:
Using a Preconfigured Baseline

If your application load patterns match one of the out-of-the-box patterns, use that.
Changing Existing or Creating New Baseline Patterns

If your application load patterns do not match one of the preconfigured patterns, you can change
the values of an existing baseline or create completely new ones. For instructions, see Configure
Baselines.
Using Baselines, Health Rules, and Alerts to Proactively Identify Performance Problems

Once you have set up your baselines, you can create health rules that use those baselines. For
more information, see Health Rules. The baseline you wish to use for most of your health rules is
called your default baseline, but you can use any baseline you have set up as the basis for any
health rule. You can then define policies tied to those health rules to trigger alerts or other
remedial actions to let you know when performance problems are occurring or may be about to
occur. See Alert and Respond.

Learn More

Health Rules
Configure Thresholds
Configure Baselines
Configure Baselines
Configuring Baselines
To change an existing baseline
To set a different baseline as the default baseline
To create a new baseline
Learn More
This topic discusses how to configure baselines. For an overview of baselines see Detect
Anomalies Using Dynamic Baselines.
Configuring Baselines

You use baselines to establish what is " normal" for various aspects of your application. Any of
your baselines can be selected as the default baseline.
To change an existing baseline

1. Click Configure-> Baselines.
AppDynamics lists all available baselines, both preconfigured and any created by you.
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1.

2. Select the baseline that you want to modify.
AppDynamics displays the configuration details.
3. Select the trend-type you want to use.
4. Select the time period type and the time range for that type.
5. Click Save.
To set a different baseline as the default baseline

The default baseline is used by all existing and future health rules if the baseline was not
specified during health rule creation. It is also used for setting Slow and Very Slow thresholds.
Changing the default baseline changes what is "normal" for all these things. Be aware of your
existing baselines and health rule definitions before you select this option.
1.
2.
3.
4.

Click Configure-> Baselines.
Select the baseline that you want to be the new default baseline.
Click Set as Default.
Click Save.

To create a new baseline

1.
2.
3.
4.
5.
6.

Click Configure-> Baselines.
Click +New.
Give your new baseline a Name.
Select the trend-type you want to use.
Select the time period type and the range for that type.
click Save.

Learn More

Detect Anomalies Using Dynamic Baselines
Configure Health Rules
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Set Performance Boundaries Using Thresholds
Applying Thresholds
Static and Dynamic Thresholds
Percentage Deviation
Standard Deviation
Learn More
This topic describes how AppDynamics thresholds help you to maintain the service level
agreements (SLAs) and ensure optimum performance levels for your system.
Thresholds provide a flexible way to associate the right business context with a slow request to
isolate the root cause.
Applying Thresholds

You can apply request thresholds at following levels:
Thresholds for a business application
Thresholds for individual business transactions
Thresholds for slow and stalled transactions and background tasks
Thresholds for diagnostic sessions
Static and Dynamic Thresholds

A static threshold is a static value, which when exceeded, violates the threshold.
A dynamic threshold is based on a changing value. You can specify dynamic thresholds using
either Percentages or Standard Deviation measures.
Percentage Deviation

Percentage deviation defines a threshold based on the moving average of the requests over a
certain interval. Default time interval is 2 hours. If the average response time for the last two hours
is X milliseconds, and if the request takes the percentage deviation over X ms, the transaction
violates threshold.
For example, a transaction occurs at 10:00:01 AM. The average of the requests between 8:00:00
and 10:00:00 is 100 ms and the slow threshold is defined as 20 % over threshold. If the
transaction takes 120 ms, it will be considered a slow transaction.
Standard Deviation

Standard deviation defines a threshold based on the moving average over a certain interval.
Default time interval is 2 hours. This means if the average response time for the last two hours is X
milliseconds, and if the request takes the standard deviation over X ms, it violates threshold.
For example, a transaction begins at 10:00:01 AM and the slow threshold is defined as 3 times the
standard deviation (variation from the mean). If the transaction takes more than 3 standard
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deviations, it will be considered a slow transaction.
Learn More

Configure Thresholds
Configure Thresholds
Configuring Business Transaction Thresholds
To Configure Slow Transaction Thresholds
Configuring Background Task Thresholds
Learn More
A threshold is a boundary of acceptable or normal business transaction or background task
performance. See Set Performance Boundaries Using Thresholds.
AppDynamics provides default thresholds and you can configure them for your own environment.
To access threshold configuration:
1. Click Configure -> Slow Transaction Thresholds in the left navigation pane.
2. Click the User Transaction Thresholds or Background Transactions Thresholds tab
depending on the type of entity for which you want to configure thresholds.
Thresholds for End User Monitoring (EUM) are configured separately. For information about EUM
thresholds see Configuring EUM Thresholds.
Configuring Business Transaction Thresholds

You can configure the thresholds for slow and very slow requests and for stalls. When a
transaction or task exceeds a threshold, AppDynamics starts capturing snapshots of it. See Trans
action Snapshots. Because the snapshots are not normally captured while performance is within
normal range, the snapshots may not contain the full call graph for the transaction.
You can configure dynamic thresholds using either percentage of standard deviation
measurements.
A percentage deviation threshold is based on the moving average of the transaction instances
over a certain interval. In the following example, if the average response time is x milliseconds, a
slow transaction would be one which is 50% over x milliseconds over the last two hours.
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A standard deviation threshold is also based on a moving average of the transaction instances
over a certain interval, but it uses a multiple of the standard deviation rather than a percentage.
The default configuration defines a transaction as very slow if it exceeds 4 times the standard
deviation over the last two hours.
For the slow transaction threshold and very slow transaction threshold, you can also configure a
static threshold. Specify the static threshold by setting the value to the time in milliseconds which,
if exceeded, indicates a slow or very slow transaction.
If you disable stalled transaction detection, if the transaction completes it is reported as very slow.
If it does not complete, nothing is reported for the incomplete transaction.
To Configure Slow Transaction Thresholds

1. In the left navigation pane, click Configure -> Slow Transaction Thresholds.
2. Click the User Transaction Thresholds tab to configure transaction thresholds.
3. In the thresholds tree list, select the scope of the threshold, either:
Default Thresholds for all business transactions, or
Individual Business Transaction
4. In the thresholds section, configure the thresholds by selecting the radio button for the type
of threshold (dynamic based on percentage, dynamic based on standard deviation or static)
and entering the threshold values in the text fields. You can also disable stall detection if
desired.
5.
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5. If you want these thresholds to apply to all Business Transactions already discovered in your
application, click Apply to all Existing Business Transactions.
6. Click Save Default Slow Thresholds (for default thresholds) or Save Slow Transaction
Thresholds (for individual thresholds).
AppDynamics displays the resulting performance data in the Transaction Scorecard section of the
application and business transaction dashboards.
Configuring Background Task Thresholds

To configure thresholds for background tasks see Configure Background Tasks.
Learn More

Scorecards
Set Performance Boundaries Using Thresholds

Fine-Tune Configurations Using Match Conditions
Example Match Criteria for a Servlet-based Request
Case-Sensitivity
To Negate a Match Condition
Learn more
AppDynamics uses match conditions in rules that specify entities to be monitored or excluded from
monitoring. You configure match conditions to fine-tune transaction detection, backend detection,
data collectors, EUM injection, health rules, etc.
A match condition is a comparison consisting of:
A match criterion (such as a method name, servlet name, URI, parameter, hostname, etc.)
A comparison operator typically selected from a drop-down list
A value
The entities and values being compared and the list of appropriate comparison operators vary
depending on the type of configuration.
Example Match Criteria for a Servlet-based Request

The following example is from a custom match rule named BuyBook used for detecting the
business transaction. Detection is based on the discovery of the string "/shopping" in the URI and
of a POST parameter with the value "Book" for the itemid parameter. When AppDynamics
receives a servlet-based request matching these conditions, it monitors the business transaction.
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Case-Sensitivity

Match rules are case sensitive. For example, a rule that specifies a match on "cart" will not match
the string "addToCart".

To force a match rule to be case-insensitive use a regular expression. The following match rule
matches "addToCart" as well as "addTocart".

To Negate a Match Condition

To reverse a match condition, use the gear icon and check the NOT condition check box.

For example, if you want to set a condition where "Port DOES NOT Equal 80":
1. Configure Port Equals 80.
2. Click the gear icon.
3. Check the NOT checkbox.
Learn more

Configure Business Transaction Detection
Regular Expressions In Match Conditions
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Regular Expression Engines
Regular Expression Examples
Custom Business Transaction Rules
Backend Discovery Rules
Regular Expression Testing Tools and Resources
Java
.NET
In AppDynamics you can use regular expressions (sometimes referred to as "regex") as an
extension to simple pattern matching. Regular expressions enable you to combine similar
transactions, rather than having to record and identify every variation. You can use regular
expressions in custom match rules, custom exit points, and other configurations.
Regular Expression Engines

The App Agent for Java uses Java libraries for regular expressions. For more information see:
Tutorial: http://download.oracle.com/javase/tutorial/essential/regex/index.html
Javadoc: http://download.oracle.com/javase/1.5.0/docs/api/java/util/regex/Pattern.html
The App Agent for .NET uses the built in .NET regular expressions engine: For more information,
see:
MSDN: .NET Framework Regular Expressions
The App Agent for PHP uses PHP's built-in PCRE regular expression engine and requires the
same syntax, including delimiters (for example: /^Foo/). For more information, see:
PCRE Manual
Regular Expression Examples
Custom Business Transaction Rules

Online retail applications might have URLs where the useful grouping information is distributed in
different segments of the URI. One example is
http://RetailStore.com/store/jump/category/shoes/departments/view-all/cat630006p. In this
example, a useful business transaction might be to match on “/store/jump” and “all” to group all
user requests to view all of an available category. A possible regex (regular expression) for this
case is:
\/store\/jump.*\b?all\b

Consider the following REST URL: /myapp/card/{cardnumber}/session. Say, you want a
transaction defined where the numeric card number is irrelevant. With URL patterns such as:
/group/1/nodsession/
/group/1/nodsession
/group/31/nodsession/
/group/2/nodsession
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This regular expression will match:
/group/\d.*/nodsession\/?$

To group URLs that contain letters then numbers into one business transaction, such as the
following:
mysite.com/aaa123.aspx
mysite.com/b1.aspx
But not match on this URL (because it has no digits after the letters)
mysite.com/z.aspx
Try the following:
mysite\.com/[a-z]+?[0-9]+?

Or, to handle upper case letters, the following:
mysite\.com/[a-zA-Z]+?[0-9]+?

If you want it to match mysite.com/lettersnumbers.aspx more strictly,
try this:
mysite\.com/[a-zA-Z]+?[0-9]+?\.aspx$

Backend Discovery Rules

For an example of a JDBC backend regular expression, see JDBC with complex URLs.
Regular Expression Testing Tools and Resources

You can find many regex testing pages and other resources online.
http://regex101.com/#pcre - Regex101.com is a multi-purpose regex testing website where you
can create and test regular expressions. The website supports JavaScript, PHP and other
languages.
http://www.regexplanet.com/advanced/java/index.html - RegexPlanet is a regular expression test
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page for all known engines (languages): Java, JS, .NET, PHP and more.
http://www.regular-expressions.info/ - general purpose site with numerous resources, including
quick starts, tutorials, examples, and more.
Java

http://java-regex-tester.appspot.com/ - a simple testing page for Java
.NET

http://www.regexlib.com/ - Regexlib is a .NET engine tester that also has a library of regular
expressions and a list of resources.

Detect Problems Caused by Application Data
Collecting Diagnostic Data from Application Payload
To view the data collectors for a particular
business transaction
To apply a data collector to a business
transaction
Learn More
Data collectors help you determine whether data that a
transaction passed into an application is causing problems.
When you configure data collectors AppDynamics
accesses information in application code arguments, return
values, and variables, as well as HTTP request data such
as headers and cookies, and displays the information in
Call Drill Down panels.
Watch a video on how to use a data
collector:

Collecting Diagnostic Data from Application Payload

Some application performance problems are related to the data processed in a request.
For example, consider a transaction that searches for a specific category. If a particular category
has a problem, it can be difficult to diagnose the problem. You would need to:
Isolate the name of the category that experienced a slow or failed search.
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Identify all the categories that experienced slow or failed searches.
Identify other details, such as which users experienced problems accessing the search
functionality.
AppDynamics can collect contextual business data either to correlate between different
performance problems or to correlate a particular performance problem with the business data.
The contextual data can be collected either from the HTTP payload data or from the methods that
are invoked as part of the transaction.
AppDynamics can capture the following diagnostic data about the business context attached to the
business transaction:
The basic details such as the type of business transaction, URI, and the time stamp
The HTTP parameters, cookies, session keys, and headers for the transaction
User data gathered from any POJO or POCO method executed during the transaction
AppDynamics provides data collectors to collect the business context for each incoming business
transaction. These data collectors capture the diagnostic data from all transactions that are slow,
very slow, stalled or that experience any error during execution.
There are two types of data collectors:
HTTP Diagnostic data collectors for HTTP payload
Method invocation data collectors capture parameters or the return value for a particular
method
HTTP data collectors are supported by the App Agent for PHP, but method invocation data
collectors are not supported for this agent.

If data collectors are configured, the data appears in various panels, such as the HTTP Params,
Cookies, and User Data sections, of a transaction snapshot. To access these panels see To view
call graphs.
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You can configure data collectors for a particular business transaction or for all business
transactions in a business application.
Data collectors are different than information points, which gather data outside the context of a
business transaction. See Data Collectors Versus Information Points.
To view the data collectors for a particular business transaction

1. In the business transactions list, select a business transaction.
2. Click the More Actions drop-down menu.
3. Click Configure Data Collectors to view the data collectors configured for that transaction.
To apply a data collector to a business transaction

1. Follow the instructions above in To View the Data Collectors for a Particular Business
Transaction.
2. Move the data collector from the Available Data Collectors list to the Data Collectors list.
3. Click Save.
Learn More

Configure Data Collectors
Data Collectors Versus Information Points
Data Collectors Versus Information Points
Differences Between Data Collectors and Information Points
Data Collectors
Information Points
Learn More
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Differences Between Data Collectors and Information Points

Sometimes there is confusion between Detect Problems Caused by Application Data and Informati
on Points because both enhance performance monitoring with information about data passed to
an application and both must be explicitly configured. It is also possible to create data collectors
and information points on the same method, but for different purposes.
A major difference between data collectors and information point metrics is that:
Data collectors exist in the context of a business transaction
Information points exist outside of business transactions
Data Collectors

Data collectors exist only in the context of a business transaction. They add information to a
business transaction snapshot, where they can highlight poor performance that may be associated
with data passed in by the request. Data from data collectors appear in the panels of the
transaction snapshot call drill down - HTTP PARAMS, COOKIES, or USER DATA - depending on
the type of the data collector. Data collectors do not appear in the Metric Browser and cannot be
used in health rules. You can filter transaction snapshots based on the value of a data collector in
the transaction snapshot list or using the AppDynamics REST API.
Here are some use cases for data collectors:
You want to identify which users are experiencing problems with a business transaction.
Often the userid is carried in the request as an HTTP query string or in the cookie. Create a
data collector on the userid so you can identify the users in transaction snapshots for slow
transactions. You can then filter transaction snapshots for those specific user ids.
You can identify a business context for slow transactions. Use a method invocation data
collector to extract some business information, such as the country or the orderid, to better
understand the execution context in which users are experiencing poor performance.
You can identify a technical context for slow transactions. For example, you may suspect
that a cache is performing poorly for a specific set of keys, so you create a data collector on
the cache retrieve method. Then the transaction snapshots can help determine if there is
correlation between the suspect keys and poor performance.
You can take advantage of the ability to filter transaction snapshots on a data collector to tag
snapshots. For example, create a data collector based on a header value or path pattern to
tag transaction snapshots initiated by synthetic transactions.
Information Points

Information points aggregate numeric data about invocations of a method outside the context of
any business transaction. Use information points to get metrics about method invocations across
multiple business transactions. Any time the method configured for the information point is
invoked, no matter from where, the information point is triggered.
Information points are visible in the Metric Browser.
Here are some use cases for code metric information points:
You can use a code metric information point to track the number of times a servlet is
invoked when the servlet is not part of a business transaction.
You have a slow XML parser used by many business transactions. Use an information point
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to report when the parser was called and how many lines it parsed.
The development team is trying to optimize common application code used by many
business transactions. Creating information points on the important methods can give them
KPIs to assess the success of their optimization efforts.
You can use two information points to track the number of concurrent users of an
application, regardless of the business transaction. Create an information point on the login
method, another on the logout method. The difference between them is the concurrent users
logged into the application in the specified time range.
Here are some use cases for business metric information points:
To report how many of a certain item were sold or returned.
To find the average value of credit card totals.
Because information points are not tied to a particular business transaction, it is possible that
an error that occurs in the context of a business transaction that happens to go through the
information point will not be counted as an error on the information point itself. Only downstream
exceptions that are unhandled by the end of the information point method or exceptions that are
handled upstream of the method and logged as ERROR or FATAL are counted as errors in the
context of the information point.
Learn More

Configure Code Metric Information Points
Code Metrics
Business Metrics
Configure Data Collectors
Data Collectors
To access data collector configuration
Configuring Method Invocation Data Collectors
To configure a method invocation data collector
To see the output from a method invocation data collector
Configuring HTTP Request Data Collectors
To configure an HTTP request data collector
To see the output from an HTTP data collector
Modifying Data Collectors
To modify a data collector
Learn More
Data Collectors

Data collectors help you determine whether data that a transaction passed into an application is
causing problems. When you configure data collectors, AppDynamics accesses information in
application code arguments, return values, variables, as well as HTTP Request data such as
headers and cookies, and displays this information in Call Drill Down panels. See Detect Problems
Caused by Application Data.
You can configure these types of data collectors:
Method Invocation Data Collectors
HTTP Request Data Collectors
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Note that method invocation data collectors are not supported for the PHP Agent.
To access data collector configuration

1. In the left navigation panel, click Configure -> Instrumentation.
2. Click the Diagnostic Data Collectors tab. (If you don't see the tab, click >> and then click
Diagnostic Data Collectors.)

Configuring Method Invocation Data Collectors

Configure custom method invocation data collectors to capture parameters or the return value or
the invoked object for a particular method. The captured data appears in the USER DATA panel of
the snapshot viewer.
This procedure involves the following tasks:
Name the data collector
Describe the class and method that the data collector is based on
If the method is overloaded, add its parameters
Optionally restrict the scope of the data collector by adding match conditions
Describe the data to collect from the method and how to process it
Select the business transactions that use the data collector
To configure a method invocation data collector

1. In the left navigation pane, choose Configure > Instrumentation, then click the Diagnostic
Data Collectors tab. (If you don't see the tab, click >> and then click Diagnostic Data Collectors.)
2. In the Method Invocation Data Collectors panel, click Add.
3. Enter a name for the data collector.
4. Check the Apply to new Business Transactions check box if you want to apply the collector to
new transactions.
What does this mean?
When you finish specifying conditions for the collector, you will choose which business
transactions use the collector. Over time, however, AppDynamics may monitor additional
business transactions, either through auto-discovery or through custom configurations you
implement (see Configure Business Transaction Detection).
If you want this collector to collect data only for the specific business transactions you
specify after you create it, do not check the Apply to new Business Transactions check
box. You can later select additional business transactions to use the collector if you want.
See Modifying Data Collectors.
If you want this collector to automatically collect data for any new business transactions
that are discovered after you create the collector, check the Apply to new Business
Transactions check box.
5. Specify the class name for the data collector by selecting the comparison to apply from the drop
down menu and entering the fully qualified class name in the adjacent text field.
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6. Enter the name of the method on which the data collector is based.
For Java:

For .NET:

7. If the method is overloaded:
a. Check the Is this Method Overloaded? check box.
b. For each method parameter, click Add Parameter to add the fully qualified class name for
each parameter.
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8. Optionally click Add Match Condition to specify match conditions for the source of the data
collector and the operation to run on the source of the data. Use match conditions to restrict the
data collector to method invocations or return values with certain values or to the invoked object.

If you are using a complex getter chain on the data, see
Getter Chains in Java Configurations
Getter Chains in .NET Configurations
9. To specify the data items that this collector will collect from this method invocation, click Add in
the Specify the Data to Collect from this Method Invocation panel. Repeat for each data item to be
collected.

10. In the Data Collection screen, specify a name for the data, which kind of data to collect
(parameter, return value, or invoked object), and, if necessary, which operation to use on it.
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11. Click Save.
12. To create the data collector, click Create Method Invocation Data Collector.
13. In the Apply to Business Transactions window that appears, specify the business transactions
to which this data collector will be applied by moving them from the Business Transactions NOT
using this Data Collector list on the right to the Business Transactions using this Data Collector list
on the left.

14. Click Save. The data collector is created and the Data Collectors tab is re-displayed.
In some environments, including JVM 1.5 and .NET, you must restart after changing the class
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name, method name, or method parameter settings. A popup will alert you.

To see the output from a method invocation data collector

1. Access transaction snapshots for the business transactions on which this data collector is
applied. See Transaction Snapshots.
2. Examine the USER DATA panel of the transaction snapshot.

Configuring HTTP Request Data Collectors

You can configure custom HTTP data collectors to collect HTTP payload data for diagnosis in the
transaction snapshot. For example, you might use a cookie to store information on what category
a user falls into, such as frequent buyer or first-time buyer. If you see multiple problems that all
affect frequent buyers, for example, that can alert you that there might be a problem in your code
that is triggered only for frequent buyers. And it might be a problem you want to fix immediately,
because these are people you definitely want to keep happy. You might also want to know their
user IDs, so you can contact them to follow up and perhaps email them an apology and a coupon
off a future purchase.
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To configure an HTTP request data collector
The following short video shows you how to configure an HTTP request data collector.
<p> </p>
Direct URL: http://appdynamo.wistia.com/medias/hkgerenpr5
1. In the left navigation pane, choose Configure > Instrumentation, then click the Diagnostic
Data Collectors tab. (If you don't see the tab, click >> in the menu bar and then click
Diagnostic Data Collectors.)
2. In the HTTP Request Data Collectors panel, click Add.
3. Enter a name for the data collector.
4. Check the Apply to new Business Transactions check box if you want to apply the collector
to new transactions.
What does this mean?
When you finish specifying conditions for the collector, you will choose which business
transactions use the collector. Over time, however, AppDynamics may monitor additional
business transactions, either through auto-discovery or through custom configurations
you implement (see Configure Business Transaction Detection).
If you want this collector to collect data only for the specific business transactions
you specify after you create it, do not check the Apply to new Business
Transactions check box. You can later select additional business transactions to
use the collector if you want. See Modifying Data Collectors.
If you want this collector to automatically collect data for any new business
transactions that are discovered after you create the collector, check the Apply to
new Business Transactions check box.
5. Click Add in the HTTP Parameters section to set the parameter values that you want to
collect.
6. Click Add in the Cookies section to set the cookie values that you want to collect.
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7. Configure the HTTP data collector to capture any of the following additional data:
- URL
- Session ID
- User Principal The User Principal setting is not used by the PHP Agent.
- Session Keys
- Headers
For informational purposes, you can add Content-Length to the Headers field to
display this value in the transaction snapshot. However, Content-Length is already
available in the Metric Browser for use in correlating with other metrics. You can use
it, for example, to determine whether certain transactions are slow because of the
size of the payload. In the Metric Browser, you can find this value under Business
Transaction Performance > Business Transactions > tier name > business
transaction name > Average Request Size. For more information, see Metric
Browser.
8. Click Create HTTP Request Data Collector.
9. In the Apply to Business Transactions window that appears, specify the business
transactions to which this data collector will be applied by moving them from the Business
Transactions NOT using this Data Collector list on the right to the Business Transactions
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using this Data Collector list on the left.

10. Click Save. The data collector is created.
In some environments, including JVM 1.5 and .NET, you must restart after changing the class
name, method name, or method parameter settings. A popup will alert you.
To see the output from an HTTP data collector

1. Access transaction snapshots for the business transactions on which this data collector is
applied. See Transaction Snapshots.
2. For URL, Session ID, or User Principal, examine the SUMMARY panel of the transaction
snapshot.
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3. For Parameters, Headers, or Session keys, examine the HTTP PARAMS panel of the
transaction snapshot.

4. For Cookies, examine the COOKIES panel of the transaction snapshot.
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Modifying Data Collectors

You can modify the specifications you have chosen for a data collector, change the list
of business transactions that use a collector, or delete a data collector.
To modify a data collector

1. In the left navigation pane, choose Configure > Instrumentation, then click the Diagnostic
Data Collectors tab. (If you don't see the tab, click >> in the menu bar and then click
Diagnostic Data Collectors.)
2. Select the data collector you wish to modify.
To change the specifications for the data collector, click Edit. Make any desired changes,
then click Save.
To change the list of business transactions that use a collector, click Configure Transactions
Using this Collector. Move transactions between the left and right panes as desired, then
click Save.
If you don't see business transactions on the right that you want to move to the left,
click Refresh List at bottom right.
If you want to disable a collector without deleting it, move all the business
transactions in the left pane to the right pane.
To delete the collector, click Delete.
Learn More

Detect Problems Caused by Application Data

Visualize Performance Using Custom Dashboards
Custom Dashboards
Dashboard Templates
Using Custom Dashboards
Examples of Custom Dashboards
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Executive Dashboard
Key Performance Indicator Dashboard
System Operations Dashboard
DevOps Dashboard
E-Com Hosts Dashboard
Learn More
Custom Dashboards

A custom dashboard brings together onto one screen various metrics and data that are important
for monitoring your applications.
Create a custom dashboard to:
Provide a view of application performance customized to your needs
Aggregate data from different applications
Compare data from different applications
Show a single view of both live and historical data
Share with other users and stakeholders
To learn how to create a custom dashboard see Create a Custom Dashboard.
Dashboard Templates

A custom dashboard template enables you to create your dashboard once and view it on several
nodes or tiers. This is efficient when you want to see the same type of metrics for each node or
tier.
Create a custom dashboard template to:
Compare overall application or infrastructure performance against individual tier or node
performance
Show a standard set of metrics for your tiers and nodes
Export the same dashboard template layout to other applications
To learn about custom dashboard templates see Creating and Managing Custom Dashboard
Templates.
Using Custom Dashboards

To learn how to share, grant permissions, copy, embed, export, and import custom dashboards
see Use a Custom Dashboard.
Examples of Custom Dashboards
Executive Dashboard
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Key Performance Indicator Dashboard
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System Operations Dashboard

DevOps Dashboard
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E-Com Hosts Dashboard
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Learn More
Use a Custom Dashboard
Create a Custom Dashboard
Configure Roles
Dashboards (prebuilt)
Creating and Managing Custom Dashboard Templates
Create a Custom Dashboard
Using Dashboard Widgets
Widget Properties
Available Widgets
Creating a Custom Dashboard
To create a custom dashboard
To add a widget
To specify a global dashboard time
range
To specify a Drilldown URL
To specify a metric for a Metric
Value widget
To display metrics in a Graph
To display metrics in a Pie Chart
To add a data series to a Graph or
Pie Chart
Advanced Data Series
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Options
To display information from another
website or dashboard
To display health rule status lights
Learn More
This topic describes how to create custom
dashboards. To use existing dashboards, see Us
e a Custom Dashboard.
From the Home page, click View Custom
Dashboards to see a list of existing dashboards
and to access the Dashboard design window. If
you have not yet created any dashboards, this
button says Create Custom Dashboard.
<p> </p>
Creating a Custom Dashboard for Mobile
Devices - 4:25
Direct link: http://appdynamo.wistia.com/medias/
4uvm15gewi
Using Dashboard Widgets

With dashboard widgets you can:
Add labels to your dashboard and status indicators
Display metrics using metric values, graphs or pie charts
Add health status indicators for critical metrics
Add images and other external content
Widget Properties

Widgets have basic display properties such as position, size, and design elements, as well as
widget-specific properties. You can arrange widgets on a dashboard to suit your needs.
Properties include:
Position/Size (Absoute layout only) These settings are the coordinates and dimensions of the
widget on the grid. You can specify these numbers for precise alignment.
Design: These properties define design elements such as font size and color, background color,
and widget border.
Misc: This optional section contains properties specific to a widget, such as the drill-down URL
and double-click action.
(Optional) Drilldown URL: Some widgets have an option to specify a Drilldown URL. You
can specify a Drilldown URL as a shortcut to help find the root cause of a performance
problem. For example, if you are monitoring slow requests for all the nodes of an application
you may see an increase in the number of slow requests and want to do further
investigatation. You want to reach a particular node from your dashboard. Clicking the Drilld
own URL takes you to the target URL for more details.
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(Optional) Doubleclick action: Some widgets have an option to define the result of
double-clicking the widget. The options are to open the Metric Browser or a specific URL
specified by the Drilldown URL value.
Time Range: Use this property to specify whether the widget uses the global time range of the
overall dashboard or a time range that is specific to the widget. This widget-specific time range can
be different from the global dashboard time range.
Available Widgets

Each widget has specific characteristics. Specific properties for each widget are described in the
widget-specific sections of this topic. Available widgets include:
Label: Text used to annotate the dashboard.
Graph: Display selected metrics in a graph format.
Metric Value: A string that displays the value of a metric.
IFrame: URL to display external content.
Image: URL to an image file. Use the full HTTP URL to the image.
Pie: Display selected metrics in a pie chart format.
Status Light: Indicates health rule violations.
As you set the properties, the appearance of the widgets update on the canvas
Creating a Custom Dashboard
To create a custom dashboard

1. From the central area on the Home page, click View Custom Dashboards. Note, this
button says Create Custom Dashboard if no custom dashboards have been created yet.
2. Click Create Dashboard.
3. In the Create Custom Dashboard window:

a. Name the dashboard. Names must be unique.
b.
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b. Confirm or change the Canvas layout type. The default type is Grid. Grid layout gives
you a flexible layout that is easy to rearrange on the canvas. Grid layout also scales in
size when viewed on mobile devices. If you select Absolute layout, confirm or change
the width and height.
c. Use Background Color to pick a color or enter the hex code. The default background
color is gray.
d. Confirm or change the Auto-refresh Interval to control how often the data in the
widgets refresh.
e. Click OK. The Dashboard design window opens.

4. Add widgets and select metrics according to your needs. The following sections describe
how to add widgets and specify other properties of your custom dashboard.
To add a widget

1. Click Add Widget
dashboard.

and select widgets from the dropdown list and drag them to the

2. Select the widget on the editing canvas to display its Properties window.
3.
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3. In the widget Properties window specify the values of its properties. The exact properties
vary based on the type of widget.
4. When you are finished click Save

.

To specify a global dashboard time range

Use the Dashboard Time Range dropdown list to select a global time range for the dashboard.
When you add widgets to your dashboard, you can specify whether the widgets use this global
time range or a widget-specific time range. If you do not specify a widget-specific time range, the
global time range is used.
To specify a Drilldown URL

For many widgets, you can specify a Drilldown URL, a shortcut to an AppDynamics window, that
opens when you click on the widget in the dashboard.
For example, if you are monitoring node health for all the tiers of an application you may see an
increase in the number of slow requests and want to investigate the cause. You want to reach the
App Servers List of all tiers from your dashboard by clicking the widget.
To get the URL from the Controller UI:
1. Navigate to the window that you want to open when the widget is clicked.
2. Click the link icon

and select Copy a link to this screen to the clipboard.

To set the URL in the dashboard design window:
1. Select the widget.
2. In the Properties window, select Misc to access the URL text box.
3. Paste the URL.
4. Click Save

.

To specify a metric for a Metric Value widget

1. After adding the Metric Value widget to the canvas, select the widget.
2. In the widget Properties window, click Select a metric and choose an application.
To display a metric in a series in a graph or pie chart, see To specify a series for display in a
graph or pie chart widget.
3. Browse the available metrics and select one. By default the Metric Value widget shows the
value of the selected metric. You can use the dropdown list in the Properties window to
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change the function of the selected metric. All values are calculated for the time range in
effect for the widget. Not all functions are available for all metrics.

Click here to expand...
Minimum: Minimum value, only available for averaged metrics
Maximum: Maximum value, only available for averaged metrics
Value: Contains the average or the sum across the time range depending on the
metric
Sum: Aggregated value of the metric over the time range
Count: A count of the observed values over the time range
Current: The sum of the most recent minute's metric data value across all the
included nodes
4. (Optional) Specify a format string using text and the following tokens:
${v} = value
${t} = time range specified in the widget Properties
${m} = name of the metric
${f} = name of the function (depends on your section, could be Value, Count, Sum and
so on).
For example:

5. Click Save

.

To display metrics in a Graph

1.
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1. Add the Graph widget to the grid and use the Properties window to configure the
widget. There are several panels in the Graph Properties window. If you are using a Grid
canvas layout, you do not see the Position/Size options because the positioning is handled
for you automatically as widgets are added to the canvas.

2. Working in the Properties window, click a panel to expand it and view the available settings.
3. Chose the data series to display in the graph. For details, see Add a series to a graph or pie
chart.
4. (Optional) In the Graph panel, enter values for the following:
a. Graph title
b. Vertical axis title
c. Horizontal axis title
d. To display the time range in the horizontal axis label, check Show Timerange.
e. Background colors lets you specify two colors that blend into each other. If you only
want one color, set the same color for both.
5. (Optional) Use the settings in the Design panel to change the font size, font color, or the
background color in the widget.
6. (Optional) In the Misc panel, specify a double-click action.
7. (Optional) In the Legend panel, check Enabled to display the name of the metric.
You can position the legend at the right or bottom of the widget. If the widget is on the
bottom, you can also specify the number of columns to display.

8. In the Time Range panel specify whether to use the user's dashboard global time range or a
widget-specific time range.
9. Click Save

.
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To display metrics in a Pie Chart

1. In the Graph panel of the Pie Chart Properties window:
a. Enter a title for the graph.
b. If you want to display a legend check Show Legend.
c. If you don't want to see the labels or values next to the pie chart, uncheck those
options.
d. If you want to show the values as percentages check Show Values as %.
e. Chose the data series to display in the graph. See To add a series to a graph or pie
chart. Add additional metrics that make sense for a pie chart; they will display in
correct proportion to each other.
2. (Absolute layout only) You can use the label widget with a transparent background to further
describe the pieces of the pie.
3. Click Save.
To add a data series to a Graph or Pie Chart

1. After adding the Graph or Pie Chart widget to the canvas, select the widget.
2. In the Graph panel of the properties window, click the + icon to open the Add Series
window.

Each series has an internal name that is not displayed on the widget but is shown in the
Properties window for convenience. You can use the default name or enter a name more
suited to your needs. The series internal name can be changed in the Advanced section of
the Add Series window.
3. Select an application.

4. Select a metric category. Each category has its own properties to define the metric, such as
from a particular tier or using names that meet certain match conditions. You can choose
from a variety of metrics in the system such as:
Overall Application Performance
Business Transaction Performance
Node Health - Transaction Performance and Node Health - Hardware
Node Health - JMX
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Error Rates
Custom - any metrics that are available
Click here to see details for each category...
Overall Application Performance: Use a predefined metric and refine it in Step 5.

Business Transaction Performance: Use the second dropdown to specify the scope of
the series by choosing which business transactions to use.
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For example you can show metrics for a specific tier. If you have a lot of tiers, you can
use the Search box to find the ones you want.

If you are selecting nodes, you can also specify the agent type, for example, all Java
Nodes:

Node Health - Transaction Performance and Node Health - Hardware, etc.: Use the
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options and dropdown lists to specify tiers and nodes. For example to show hardware
metrics by tier:

Node Health - JMX: Use the options and metric browser to select specific JMX objects.
For example to select all JDBC connection pools:

Error Rates: Use the pulldown to specify all errors, specific errors, errors in specific tiers,
or errors that match naming conditions, including regular expressions.
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Custom: Use any metrics that are available:

5. Select a Metric. By default the widget will show the value of the selected metric.
You can use the dropdown list to change the function of the selected metric. All values are
calculated for the time range in effect for the widget. Not all functions are available for all
metrics.
Click here to see function definitions...
Minimum: Minimum value, only available for averaged metrics
Maximum: Maximum value, only available for averaged metrics
Value: Contains the average or the sum across the time range depending on the
metric
Sum: Aggregated value of the metric over the time range
Count: A count of the observed values over the time range
Current: The sum of the most recent minute's metric data value across all the
included nodes

a. (Option 1) Specify a metric from the metric tree. Select a metric from those shown in
the metric tree window.
b. (Option 2) Specify a Relative Path Metric. To specify a relative path metric, go to the
metric browser (Analyze->Metric Browser) and locate the relative path of the metric
you wish to add. Right-click on the metric and select Copy Full Path.
6. Using the Advanced options, you can set display properties, apply filters to refine the data
that is displayed, add baseline data, and change the name of the Data Series displayed in
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6.
the Properties window. See Advanced Data Series Options.
Advanced Data Series Options

Display Properties: You can represent the data display in the following ways:
Line (default)
Area
Column
Series Colors: You can customize the colors used in the display. The default automatically uses
different colors for different series.
Metric Names: AppDynamics formats the metric name by default. If you want to use the original
metric name check Use Raw Metric Name in Legend.
Data Filters: Some metric categories return more than one value. AppDynamics displays them all
by default. You can limit the number of values that are displayed and change the sort order . For
example, you might want to display the "Top 10".
Baselines: It can be helpful to have baseline data in a graph to compare against current data. If
you want to add baseline data, check Include Baseline Data and select a baseline to use. See Det
ect Anomalies Using Dynamic Baselines for a discussion of baseline patterns and how they are
used in AppDynamics to monitor applications.
Series Names: This is the name displayed in the Properties window. The design window
automatically assigns a generic logical name such as Series 1, Series 2 and so on. For ease of
use, you can assign a name more descriptive of the metric.
To display information from another website or dashboard

Use the IFrame widget to display another URL inside a dashboard in HTML mode.
1. In the IFrame text box, enter the URL to display.
2. Adjust the size of the IFrame so that it is larger than the website or dashboard. If using a
dashboard, add space at the top for the embedded dashboard's header.
3. Click Save to save your updates.

If your dashboard URL is over secure HTTP and the dashboard contains an IFrame that is
not loaded over HTTPS, the IFrame may not render in the browser. For example, this
discrepancy causes issues in Chrome's security model. The alternatives are to serve the
embedded IFrame over HTTPS or run Chrome using the command line flag --allow-run
ning-insecure-content to prevent Chrome from checking for insecure content.
To display health rule status lights

1.
2.
3.
4.

Drag a status light widget from the Add Widgets dropdown to the dashboard.
In the Health Rules panell of the properties window, click Select Health Rule.
Select the application.
Choose a health rule and click Select Health Rule.

5.
Copyright © AppDynamics 2012-2014

Page 1796

5. Click Save

.

Learn More

Visualize Performance Using Custom Dashboards
Use a Custom Dashboard
Use a Custom Dashboard
Sharing a Custom Dashboard
To share a custom dashboard with other AppDynamics users
To share a custom dashboard using a URL
To share your dashboard for editing
To grant role permission to view a custom dashboard
Copying a Custom Dashboard
To copy a custom dashboard
Embedding a Dashboard in Another Dashboard
To embed a dashboard in another dashboard
Exporting a Custom Dashboard
To export a dashboard from the editor
To export a dashboard from the dashboard list
Importing a Custom Dashboard
To import a custom dashboard
Learn More
To learn how to create custom dashboards see Create a Custom Dashboard.
Sharing a Custom Dashboard
To share a custom dashboard with other AppDynamics users

1. In the Custom Dashboard List, select a dashboard.
2. Check the box in the Shared column, or click Share -> Share Dashboard. The Share menu is
also available in the Edit view.

The dashboard is immediately shared and made visible to other AppDynamics users who have
permission to view custom dashboards. They will be able to see it in their Custom Dashboards
List. See Custom Dashboard Permissions.
To share a custom dashboard using a URL
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You can share a URL of a custom dashboard for use on other computers as well as devices such
as tablets and phones. You can:
Copy the shared URL to the clipboard
Open the shared URL in a new browser window
Email the shared URL from your email program
The Share menu is available in the Custom Dashboards List (in the menu bar) and in the
dashboard editor (under More Actions). The dashboard must already be shared and your browser
must allow pop-ups from the controller URL.
From the Share menu, click Copy Shared URL to Clipboard and paste it into your email
program.
To share your dashboard for editing

You can share the link to your dashboard editing window using the Link icon on the right side of
the screen as shown in the following screen shot:

To grant role permission to view a custom dashboard

The custom dashboard viewer default role allows you enable a guest user to view a selected set of
metrics on a custom dashboard without giving them access to the regular AppDynamics
dashboards. You set user permissions and roles using the Administration window. See Configure
Roles.
Copying a Custom Dashboard

You can copy a dashboard as the basis for a new dashboard on the same Controller.
To copy a custom dashboard

1. In the Custom Dashboards List, select a dashboard.
2. Click Copy.
3. Enter the name of the copied dashboard.
4. Click OK.
The new dashboard opens in the design window.
Embedding a Dashboard in Another Dashboard

You can include a dashboard in another dashboard. This enables you to reuse graphs and charts.
You may want to do this when you have different operators who focus on particular dashboards
and you to roll them all up into a "Master Dashboard" for management.
To embed a dashboard in another dashboard

1.
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1.
2.
3.
4.

Create a dashboard. See Create a Custom Dashboard.
Share it via a URL. See To share a custom dashboard using a URL.
Create another dashboard.
Use the IFrame widget to display the shared dashboard.
See To display information from another website or dashboard.

Exporting a Custom Dashboard

You can export a custom dashboard so that you can import it into another controller and reuse it.
The Export function creates an XML file. You can export a dashboard two ways:
From the Custom Dashboard List
From the dashboard editor while in edit mode
If you have edit permissions for dashboards, you can use either method. If you do not have edit
permissions, use the Export option from the Custom Dashboard List.
To export a dashboard from the editor

1. In the Custom Dashboards List, select a dashboard.
2. Click Edit.
3. Click
More Actions -> Export Dashboard.
4. Select a location on your local machine to save the XML file. You can accept the default file
name or rename it before saving.
5. Save the file.
6. Import the dashboard into another controller to reuse the layout.
To export a dashboard from the dashboard list

1. In the Custom Dashboards List, select a dashboard.
2. Click Export in the menu bar.
3. Import the dashboard into another controller to reuse the layout.
Importing a Custom Dashboard

You can import a custom dashboard that you exported. The Import function places the exported
XML file into the proper location for use by the new controller.
To import a custom dashboard

1. From the Custom Dashboards List, click Import in the menu bar.
2. Navigate to the previously exported XML file and click OK to import.

If the metrics, nodes, tiers, or applications used in the exported dashboard do not
exist in the new controller environment, you will see warning messages. Even when
the metrics are not available in the new controller environment, your import succeeds
and preserves the widgets and layout of the dashboard. You can select new
application metrics to create a similar dashboard in the new environment.
Warning messages look similar to the following:
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Learn More

Create a Custom Dashboard
Visualize Performance Using Custom Dashboards
Configure Roles
To learn about the default dashboards see Dashboards.
Creating and Managing Custom Dashboard Templates
Creating Dashboard Templates
Watch: Create A Tier Dashboard Template
To build a dashboard template from the My Dashboards tab
To associate another node or tier with an existing custom dashboard template
To add or remove a custom dashboard template from a node or tier
Managing Dashboard Templates
To build a dashboard template from the Manage Tier/Node Dashboards window
To import a dashboard template
This topic describes how to create and manage custom dashboard templates. This special type of
custom dashboard is a template that enables you to create a dashboard on one node or tier and
view it on other tiers or nodes. The dashboard displays the tier and node metrics that are specific
to the tier or node that you are viewing. You can easily configure which of the dashboards appear
on the various tiers and nodes in your applications.
You can access the functionality for dashboard templates from multiple locations in the Controller
UI as follows:
From the My Dashboards tab on tier and node dashboards
Create and view dashboard templates
Associate dashboard templates with tiers or nodes
Access the Manage Tier/Node Dashboards window
From the left navigation pane, click Configure -> Tier/Node Dashboards
Manage Tier/Node Dashboards
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Creating Dashboard Templates

You create dashboard templates in
much the same way as standard
custom dashboards, but you typically
start on a tier or node. The following
widgets can be used in dashboard
template design:
Graph: Display selected metrics
in a graph format.
Pie: Display selected metrics in a
pie chart format.
Label: Text used to annotate the
dashboard.
Image: URL to an image file.
Use the full HTTP URL to the
image.
IFrame: URL to display external
content.
Each widget has specific
characteristics. Specific properties for
each widget are described in the
widget-specific sections of this
topic. As you set the properties, the
appearance of the widgets update on
the canvas. For more details on using
specific widgets, see Create a Custom
Dashboard.
Watch: Create A Tier Dashboard Template

<p> </p>
Direct URL: https://appdynamo.wistia.com/medias/cyr8h8opve
To build a dashboard template from the My Dashboards tab

1. Log into the Controller UI and select an application.
2. From the left navigation pane, access any tier or node by clicking Servers -> App Servers
-> <any tier or node>.
3. On the Node or Tier Dashboard, select the My Dashboards tab.
4. Create the dashboard template:
a. (No Existing Dashboards) Click Create a New Custom Dashboard in the center of
the screen.
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b. (Existing Dashboards) If the tier or node is already associated with existing
dashboards, click the action drop-down and select Create Dashboard.

5. Name the dashboard. Names must be unique.
6. Configure the other settings as follows:
a. Accept the default value or change the Canvas layout.
The default is Grid. Grid layout gives you a flexible layout that is easy to
rearrange on the canvas. Grid layout also scales in size when viewed on mobile
devices.
If you select Absolute layout, confirm or change the width and height.
b. Use Background Color to pick a color or enter the hex code. The default background
color is light gray.
c. Confirm or change the Auto-refresh Interval. The default value is 120 seconds.
7. Click OK to save the template.
The empty template appears on the My Dashboards tab of the tier or node.
8. Click Edit to design the dashboard.

9. Add widgets to the design canvas to complete the dashboard.
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9.
For details on using the available widgets and selecting metrics, see Create a Custom
Dashboard.
10. When you are finished, click Save
.
Your dashboard is periodically saved as you work, but it is a good practice to explicitly save
before you view the dashboard on the tier.

To associate another node or tier with an existing custom dashboard template

1. From the left navigation pane, click Servers -> App Servers -> <any tier or node> to navig
ate to a different tier or node.
2. From the My Dashboards tab for that node or tier, access the Associate Dashboards
window:
a. (No Existing Dashboards) Click Associate Existing Dashboard with this Tier (or
Node) in the center of the screen.

b. (Existing Dashboards) If the tier or node is already associated with existing
dashboards, click the action drop-down and select Associate Dashboards.

3. Select the dashboard from the Available Dashboards list on the right and click Add.
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To add or remove a custom dashboard template from a node or tier

1. From the My Dashboards tab where you are viewing the dashboard, click the action
drop-down and select Associate Dashboards.

2. Select the dashboard from the list on the left and click Remove.
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3. Similarly, to associate existing dashboards to nodes or tiers, select the dashboard from the
Available Dashboard list and click Add to add it to the node or tier.
4. Click OK.

The Associate Dashboards dialog reflects the label node or tier consistent with your
location in the UI.

Managing Dashboard Templates

You can also use Manage Tier/Node Dashboards window for operations on your dashboard
templates. The following operations are available:
Create Dashboard
Associate with Tiers or Nodes
Delete
Copy
Export
Import
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To build a dashboard template from the Manage Tier/Node Dashboards window

1. From the Home page or the All Applications dashboard, select an application.
2. From the left navigation pane, select Configure -> Tier/Node Dashboards.
3. Click Create Dashboard.

The Create and Associate Dashboard with Tiers/Nodes window appears.

4. Name the dashboard. Names must be unique.
5. Select the type: Node or Tier.
The type determines where the dashboard templates can be used, nodes or tiers.
You can not view a tier template on a node.You can not view a node template on the
tier level.
When you create a custom dashboard template directly from the My Dashboards tab,
the type is selected for you depending on which type of dashboard you are viewing.
6. Confirm or change the Canvas layout. The default is Grid. Grid layout gives you a flexible
layout that is easy to rearrange on the canvas. Grid layout also scales in size when viewed
on mobile devices. If you select Absolute layout, confirm or change the width and height.
7. Use Background Color to pick a color or enter the hex code. The default background color
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7.
is light gray (D0D4D9).
8. Select the tiers where you want to view this dashboard. A node dashboard template applies
to all nodes for its associated tiers.
9. Click OK. The dashboard appears in the list of dashboard templates.
10. To complete the design of the template, use these steps:
a. From the Tier/Node Dashboards window, select the dashboard template from the list
and select a tier.
b. Click View/Edit Dashboard.

The design window appears on the My Dashboards tab for the tier selected. For a
node template, the design window is displayed in the first node for the selected tier.
c. Click Edit.

d. Design the dashboard using the available widgets. For details on using the available
widgets and selecting metrics, see Create a Custom Dashboard.
To import a dashboard template

You can only import the custom dashboards which were exported as templates. You can
not import a non-template standard custom dashboard as a template.

1. From the Tier/Node Dashboard window, click Import in the menu bar.
The Custom Dashboard Import window appears.
2. Navigate to the previously exported XML file and click OK to import the file.
Import messages look similar to the following:
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2.

3.
4.
5.
6.

Click OK.
Select the imported template and click Associate with Tiers/Nodes.
Select the tiers where you wan to use this template and click OK.
To view the template, select the dashboard template, select a tier and click View/Edit
Dashboard. Alternately, you can navigate to the tier using the left navigation pane: click Ser
vers -> App Servers -> Tier.
Import and Export a Custom Dashboard using a REST API
To import and export custom dashboards using the controller UI, see Use a Custom Dashboard.
You can also import and export a custom dashboard using a REST API.
To export a custom dashboard using the REST API

This is a GET operation. It outputs the dashboard configuration to an XML file.

http://<controller
host:port>/controller/CustomDashboardImportExportServlet?dashboardId
=<unique_dashboard_ID>

For example:
http://cents-docdemo-01/controller/CustomDashboardImportExportServl
et?dashboardId=3

You can get the unique dashboard id from the URL of the dashboard that you are exporting when
you have it open the controller UI. For example, the end of the url of this custom dashboard shows
that the dashboard ID is 3:
location=CDASHBOARD_DETAIL&mode=MODE_DASHBOARD&dashboard=3
To import a custom dashboard using the REST API

This is a POST operation. Use the same syntax for the URI as used for the export but with no
parameter.
Upload the exported xml file as a multipart/form-data content type to the POST form. The form
field for the POST operation is "fileUpload".
For example:
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Hierarchical Configuration Model
Entry Point and Exit Point Inheritance
Node Inheritance
Switching Configuration Levels
Learn More
Transaction detection (entry point), backend detection (exit point), and node property
configurations are applied on a hierarchical inheritance model. This model provides a default
configuration for new tiers as well as the ability to re-use custom configurations in all tiers or tiers
that you specify, eliminating the need to configure custom entry and exit points for all tiers.
A tier can inherit all its transaction detection and backend detection configuration from the
application, or it can override the application configuration to use a custom configuration.
Similarly, a node can inherit its entire node property configuration from its parent, or it can override
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the parent configuration to use a custom configuration.
Entry Point and Exit Point Inheritance

By default, tiers inherit the entry point and exit point configurations of the application. You can
copy the application-level configuration to specific tiers or explicitly configure all tiers to use the
application-level configuration.

At the tier level, you can specify that the tier should use the application-level configuration.
Or you can an override the application-level configuration by creating a custom configuration for
the specific tier.
You can configure all tiers to use the custom configuration or copy the configuration for re-use in
specific tiers. You can also reset a tier that is currently using a custom configuration to use the
application-level configuration.

Node Inheritance

By default a node inherits the node properties of its parent tier (or of the application).
You configure node properties by selecting the node and clicking Action -> Configure App
Server Agent. Then you can specify that all nodes in a tier inherit the node properties of the
parent (tier or application) or that the node should use a custom configuration.

If you create a custom configuration for a node, you can copy that configuration to the application,
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tier or to another node.
Switching Configuration Levels

If you customize configuration at the tier or node level and then switch back to the application-level
configuration, you will not see the old configuration in the UI. However, the old tier or node level
configuration is stored, and if you will see these old settings if you switch to the lower-level
configuration again.
Learn More

Configure Backend Detection (Java)
Configure Backend Detection (.NET)
Configure Business Transaction Detection
App Agent Node Properties

Monitor Business Transactions

Business Transactions
Business
Transactions and
Application Health
Business
Transactions in
Distributed
Environments
How AppDynamics
Discovers Business
Transactions
Learn More
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Business Transactions

The business transaction is the mechanism by which AppDynamics Application Performance
Management orders and monitors application traffic. A business transaction represents a distinct
logical user activity such as logging in, searching for items, buying an item, etc. Organizing
application traffic into business transactions aligns the traffic with the primary functions of a web
business. This approach focuses on how your users are experiencing the site and provides
real-time performance monitoring.
Application users don’t complain that the server seems to be experiencing memory leaks or that
the code is not optimized. Instead, users say they cannot log into the application or notice that it
takes too long to complete a checkout. That is why AppDynamics uses business transactions,
such as the Login and Checkout processes, to identify and troubleshoot real-world problems in
production.
AppDynamics uses business transactions to:
Organize all user requests to represent the load on your business application.
Provide detailed diagnostic data into requests that experience errors or perform slower than
usual.
Business transactions represent either a category or a type of user request. They depict the
primary functions of your application. Examples of business transactions include:
In an e-commerce application, user actions such as logging in, searching for items, adding
items to the cart, etc.
In a content portal, the content sections that users navigate such as sports, world news,
entertainment, etc.
In a stock trading application, operations such as receiving a stock quote, buying and
selling stocks, etc.
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Business Transactions and Application Health

How well a business transaction performs is the most important factor when monitoring the health
of your application. The performance data for a particular business transaction in your system
provides information such as:
Availability: Is the functionality currently available? For example, are the users currently
able to log in to the site?
Performance: How is this task currently performing? For example, how much time, on
average, does it take to complete a check-out request? How is the business transaction
performing compared to what is considered acceptable performance? The picture below is a
summary view of what it means to say that "Checkout is OK".
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User Experience: How many users performing a particular task experienced slow response
times or stalls? Are there performance spikes or lulls due to end user patterns such as
holidays?
Historical Comparisons: How does historic data for particular time ranges compare to
current data?
Business Transactions in Distributed Environments

A distributed environment typically has multiple tiers deployed with multiple app servers,
databases, remote services, etc. A business transaction may span multiple nodes through remote
calls to external services, collecting data from all of these components and measuring the
processing time required to collect both synchronous and asynchronous data across all tiers.
The method call that starts the business transaction is called the entry point.
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For example, when an app server invokes the business logic associated with an eCommerce
checkout operation, it makes a database call plus multiple calls to services in other tiers.
AppDynamics discovers and groups these activities as a single "checkout" business transaction.
This business transaction captures processing time, which relates to the response time typically
experienced by a user.
How AppDynamics Discovers Business Transactions

When application requests are received by transaction entry points, AppDynamics automatically
discovers and identifies the requests as business transactions. AppDynamics uses information
from the transaction entry point to name the transaction.
Multiple user requests, as long as they follow the same code path, are categorized as instances of
a single business transaction. For example, one user-click results in the Checkout business
transaction being identified as a single request. Then, when another user performs the same
action, AppDynamics associates the two requests with the same Checkout business transaction.
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AppDynamics monitors and measures how well a business transaction performs and reports these
metrics. It analyzes trends in the data to establish dynamic baselines that act as known point of
reference against which ongoing performance is continuously measured.
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The business transaction monitors the distributed code paths, evaluates performance, and reports
anomalies. See Alert and Respond for setting up policies, alerts, and responsive actions such as
email notifications.
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If anomalies occur, AppDynamics business transactions and self-learning techniques provide
robust and rapid means to find and repair problems. See Troubleshoot and Resolve for tips and
tutorials.

Optimizing Business Transaction Monitoring
AppDynamics recommends that you configure your system to monitor important business
transactions and other operations that are key to your business. There are multiple techniques to
employ. For example, you can exclude certain operations from detection. You can combine
several operations into a single business transaction, or split a default business transaction to
provide more granularity. See Organizing Traffic as Business Transactions for other suggestions
and Configure Business Transaction Detection for detailed instructions.
Learn More

A Look at Business Transactions
Organizing Traffic as Business Transactions
Organizing Traffic as Business Transactions
Planning for Business Transactions
Fine-Tune Your Business Transactions
The Optimal Set of Business
Transactions
Learn More
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Managing Your Business Transactions
from AppDynamics, 10 minutes
If you organize your web site users' most important activities into business transactions, you will
get the maximum benefits and the shortest mean time to resolution (MTTR) from
AppDynamics. To get optimal benefits, make sure that your business transactions are set up to
describe the traffic that you need to monitor and that they are not set up to monitor extraneous
traffic that is not important. Leverage the auto-discovery mechanism and tune the business
transactions to best reflect your organization's needs.
Planning for Business Transactions

You can install AppDynamics and see how it auto-discovers business transactions in your
environment, and then configure it to focus on the transactions that get the most traffic. On the
other hand, you could do some upfront planning to select and name the operations you want to
monitor. For example, you could:
Interview the teams responsible for each application component or module to identify the
key 5-20 operations that they feel are important to monitor. Identify which key operations
must work well for the application to be successful. Ask questions about each operation
such as:
What is the business flow it represents?
What information and metrics are expected?
Who is interested and why?
Can the information be obtained in another way, using other features of
AppDynamics?
Name the operations so that they are recognizable to everyone who monitors your
application. Use these names for the business transactions. Show these names to
business-level stakeholders and make sure the names make sense to everyone.
Map the operations that you have identified to the appropriate business transaction entry
points. The entry point to a business transaction is typically a method that begins every time
the user request is invoked. Entry points are described in detail at Configure Business
Transaction Detection.
You can keep fine tuning your business transaction configuration, excluding some transactions
that you currently detect and adding others that you have not been detecting, as you learn more
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about which transactions give you the most useful information about your application.

Fine-Tune Your Business Transactions

AppDynamics automatically detects the business transactions in your application by looking for the
business transactions' entry points. You can fine-tune how AppDynamics detects entry points
and identifies your business transactions. There are many reasons why you might want to do this.
The most common are:
You are getting more monitoring information than you want about requests that are not
essential to understanding your business, such as administrative console requests,
heartbeat pings, and so on.
You want to exclude whole classes of transactions: for example, URIs that match or do not
match a certain pattern.
The default automatic detection mechanism is not identifying the appropriate entry points for
the business transactions. For example, you may want the agent to discover transactions
based on a class/method combination instead of at a higher component level.
The automatic detection mechanism is not identifying any business transactions in your
application. This is typically the case if your application is not built with a framework that
AppDynamics can auto-detect. You can configure AppDynamics to discover business
transactions by creating custom match rules for determining the correct entry points.
You want to split a single business transaction into multiple ones. For example, a login
request may be detected as a single transaction, but you want to split into two transactions
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based on whether the request branches to a new-user or existing-user operation.
If you have large number of transactions, you can analyze the All Other Traffic business
transaction to decide how to configure business transactions that reflect your application's
actual traffic patterns. For example, if one of the transactions in All Other Traffic is called
frequently, you could configure a new business transaction for that traffic.
Some auto-discovered business transactions may have little or no traffic, so there is no need
to monitor them.
Once you have identified and configured the most important business transactions, you can
create a "catch-all" transaction to capture and name all the traffic that is not mapped to other
business transactions.
To fine-tune your business transactions see Configure Business Transaction Detection.
The Optimal Set of Business Transactions

Before configuring the business transactions that are most helpful for your team, identify the
optimal or right set of business transactions to monitor. The most important factor for identifying
business transactions is functionality. When you analyze user requests, you can produce a
manageable list of functionality that is related to service levels.
For example, in an e-commerce application the individual requests that "add items to the shopping
cart" can be tracked as the "Add To Cart" business transaction. For a web portal or content site,
you could define business transactions by the category of the content, such as "Politics", "Sports",
etc. You could also create more granular business transactions, such as sub-transactions of
"Sports" based on the type of sports.
The easiest way to determine the optimal number of business transactions is to consider the
following:
The number of unique types of requests present in the application
The number of service levels per business transaction
AppDynamics recommends that you have only as many service levels as are necessary for a
particular transaction. For example, a Login transaction represents the performance characteristics
of all users who login to a system. The service level for a Login operation for any given time
indicates the performance of the transaction. This data translates directly to what end users
experience while logging in.
For web traffic, every unique URL is not a business transaction. Multiple URLs will map to the
same type of request and therefore map to the same business transaction.
Tip: One technique for deciding which business transactions are important is to look at
the default Business Transactions List to see what AppDynamics discovers
out-of-the-box and sort them by the Calls or Calls/Minute columns.

Organize Business Transactions into Groups
When multiple business transactions are similar and you want to roll up their metrics, you can put
multiple business transactions into a group.
Usually you group transactions together when they represent a single business service and for
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reporting purposes you want the metrics combined into a single object - the business transaction
group. For example, you have multiple services running on the same application server and they
belong to a single AppDynamics business application. You create a single business transaction
group for all transactions belonging to one service. In other words, you group the business
transactions based on the service to which they belong. Then you have multiple business
transaction groups and you can use the group metrics as indicators of the overall health of each
business service.
Grouping in the UI can also provide a hierarchy of existing business transactions that need to be
individually tracked but are related. For example, all transactions of a specific .war file (if one app
server is used to deploy multiple applications as .war files), or all transactions of a specific entity,
such as an organization, region, category and so on.
Grouping in the UI makes your lists and flowcharts easier to monitor. See Grouping Business
Transactions.
If you have business transactions that you don't need to see at all, consider using exclude rules
and/or modifying entry point detection. See Configure Business Transaction Detection.

Learn More

Configure Business Transaction Detection
Hierarchical Configuration Model
All Other Traffic Business Transaction
Business Transaction Dashboard
Business Transactions List
All Other Traffic Business Transaction

How Transactions are Gathered into All Other Traffic
Viewing All Other Traffic
To look at the All Other Traffic transactions
To get metrics for All Other Traffic using REST
Managing All Other Traffic
Business Transaction Limits for the Controller
Business Transaction Default Limits for Agents
Changing Business Transaction Default Limits
Learn More
You can select an All Other Traffic business transaction in the Business Transactions List, view its
dashboard, and see its key performance metrics in the Metric Browser.
How Transactions are Gathered into All Other Traffic

For optimal performance, there are default limits of 50
business transactions per app agent and 200 business
transactions per business application. There is no limit at
the tier level.
The app agent limit applies to each app agent, not to the
machine. If you have multiple app agents on a single
machine, the machine can handle the number of agents
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times 50.
If traffic exceeds the default limits, the traffic from what
would be 51st detected business transaction and greater
for the agent or the 201st and greater detected business
transaction for the application is collected into a default
business transaction called "All Other Traffic <tier_name>". There is one of these "All Other Traffic"
default transactions for each tier.
Some applications, such as those that create business
transactions dynamically, can exceed the default limits
very quickly. Since you want to monitor the business
transactions that are key to your business, look at All Other
Traffic and decide whether any of it needs to be
reconfigured. See Managing All Other Traffic and Configur
e Business Transaction Detection.

Viewing All Other Traffic

The All Other Traffic business transaction displays according to its tier name in the Business
Transactions List.

To look at the All Other Traffic transactions

You can look at the instances of a default business transaction in the Business Transaction
Dashboard.
1. Select it from the list of business transactions and click View Dashboard. Update the time
range as needed.
2. In the All Other Traffic dashboard click View Traffic Details.
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2.

The Traffic Details window displays a list of the auto-detected transactions that occurred
after the limits were exceeded.

The Business Transaction Name column contains auto-generated names for the
transactions. The Call column shows the number of instances of the transaction and the
Type column shows the entry point type.
3. If the Fetch more link is displayed, click it to see more calls. It retrieves 600 calls per click. If
the Fetch more link is not displayed, there are no more calls to retrieve for the selected time
range.
To get metrics for All Other Traffic using REST

The name used for All Other Traffic in the REST API is "APPDYNAMICS_DEFAULT_TX". See an
example at Use the AppDynamics REST API
Managing All Other Traffic

In most cases you want to examine the transactions in All Other Traffic and determine whether
they represent important business transactions that you want to monitor or not. For example, if an
All Other Traffic transaction is called frequently, you can define a custom rule for a new business
transaction for that traffic. You can "trade off" and keep within the limits by excluding other
business transactions, such as those that have little or no load, by using a custom exclude rule.
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To learn more about tuning business transactions see:
Business Transaction Configuration Methodology for Java
Calibrate PHP Entry Point Detection
rganizing Traffic as Business Transactions
Configure Business Transaction Detection.
Business Transaction Limits for the Controller

After every minute, the Controller aggregates and monitors service levels of each business
transaction and accepts data from multiple agents processing the same business transaction. The
Controller stores data about those agents which identify the business transaction or the entry
points and the data about other nodes (where the business transaction context is maintained).
The Controller I/O processing ability is affected by both the number of business transactions and
the number of nodes in the application.
To learn more about what type of hardware can efficiently manage how many nodes and business
transactions see Controller System Requirements.
Business Transaction Default Limits for Agents

The business transaction default limit for agents is very important because AppDynamics is
designed for production environments. AppDynamics agents do not simply collect data and report
it to the Controller, they also:
Observe service levels for each business transaction.
Observe metrics, such as the number of slow requests, and start diagnostic data collection
when thresholds are reached.
Imposing default limits on the number of business transactions is one way to manage the memory
requirements of the agent in any type of application environment.
Changing Business Transaction Default Limits

Before changing the limits, take into account the following factors:
Controller hardware. For details see Controller System Requirements.
Memory available for the agent on the managed JVM or CLR. To analyze the memory
allowed for the agent:
After the agent discovers 50 transactions, compare the current memory footprint of the
JVM or CLR with that of the agent.
Then, compare this data with the memory available for the agent.
To change the limits, contact AppDynamics Support.
Learn More

Organizing Traffic as Business Transactions
Configure Business Transaction Detection
Creating New Tiers

Creating a New Tier in an Application
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To create a tier
Monitoring a New Tier
Business Transactions
Policies and Health Rules
Custom Dashboards
Advanced Configuration
Viewing Detailed Information about a Tier or Node
To View Detailed Information about a Tier or Node
Learn More
Creating a New Tier in an Application
To create a tier

1. From the left navigation pane click Servers -> App Servers.
2. In the App Servers List, click Create Tier.

3. In the Create Tier window click the tier type icon that displays in the flow maps. You can choose
from:
.NET Application Server
Application Server (Java)
Database Server
Load Balancer
Messaging Server
PHP Application Server
Web Server
Other
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4. Click Next.
5. Enter the name and description of the tier.
6. Click Finish.
The new tier appears in the left navigation pane under the assigned type.
If the menu item for the type does not yet exist, it is created. For example, if you create a tier of
type Other, the tier appears under Other Servers in the left navigation pane.
7. When you create a new tier manually as described here, it does not have a node or nodes. To
reassign an existing node to a new tier use Action -> Move Node in the Node Dashboard. See M
ove an App Agent for Java Node to a New Application or Tier.
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See Mapping Application Services to the AppDynamics Model for more information about tiers and
nodes.
Monitoring a New Tier

After you have created a tier and assigned nodes to it, AppDynamics will start discovering new
business transactions for that tier, and will apply any existing policies and health rules to that tier.
However, to make sure that you are accurately monitoring all activity related to that tier, it's a good
idea to go through the same configuration process that you have already completed for your
application as a whole and for other tiers in your applications. Some questions to ask yourself
include:
Does the activity on this tier represent any new business functionality that should be
monitored as a new Business Transaction?
Is there any new business information that should be instrumented via an Information Point
or Service Endpoint?
Are there any new classes or methods that should be instrumented with custom
instrumentation?
Are there new conditions for which alerts should be configured?
Does a custom dashboard need to be created or updated to reflect activity on the new tier?
Go through the following documents whenever you add a new tier and customize your
configuration as needed.
Business Transactions

Best Practices for Business Transactions
Configure Business Transaction Detection
Policies and Health Rules
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Configure Policies
Configure Health Rules
Custom Dashboards

Visualize Performance Using Custom Dashboards
Create a Custom Dashboard
Advanced Configuration

Information Points
Monitor Service Endpoints
Viewing Detailed Information about a Tier or Node

From the App Server List you can access the Tier and Node Dashboards for specific tiers and
nodes.
To View Detailed Information about a Tier or Node

1. In the App Server List click the Tree View icon. Alternatively use the left navigation panel and
expand the listings.
2. In the listing, select the tier or node that you want to view and click View Dashboard.
The dashboard appears. From there you can select the various tabs for details about performance
of the tier or node. See Tier Dashboard or Node Dashboard.
Learn More

Logical Model
Dashboards
Measure Distributed Transaction Performance
Distributed Transactions
Transaction Tracing Across Tiers
Distributed Transaction Performance in the UI
Application Flow Map
Business Transaction Flow Map
Business Transaction KPIs
Multi-Threaded Transactions
Learn More
Distributed Transactions

In a service-oriented environment, when multiple teams are responsible for different services, the
performance indicators of an overall transaction (such as average response time) are insufficient
when you want to do both performance characterization and troubleshooting. The distributed
nature of the transaction is an integral aspect of characterizing transaction performance.
For example, when a transaction flows through multiple tiers, you may ask these questions about
the distributed activity:
How much time is spent in each of the tiers on an average?
How much time is spent over the network between tiers on an average?
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How many times is each tier being called on an average?
For a messaging tier, what is the average incoming message rate?
Are the correct infrastructure components being used (such as staging vs. production)?
What are the characteristics of an individual request?
AppDynamics applies distributed transaction tracing to answer these types of questions for all
business transactions as well as for the entire application.
Using a tag, trace, and learn approach, AppDynamics traces the transaction context across all
tiers, including JVMs, CLRs, PHP Web servers, and calls to HTTP, JMS, SOAP, databases, third
party web services, etc.
AppDynamics displays distributed communication performance in the business application and
business transaction flow maps.
Transaction Tracing Across Tiers

When two tiers communicate over a protocol supported by AppDynamics and both the tiers are
instrumented as part of the same business application, the application flow map automatically
connects the two corresponding tiers. By default, the flow map displays all measurements per tier.
You can drill down to see the performance data for individual nodes in the tier. For details see Appl
ication Dashboard and Flow Maps.
Inter-JVM or inter-CLR communication
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When a JVM or CLR communicates with the external component that is not being monitored as
part of the same business application, such as a database or a message queue, you can monitor
the performance data for the communication. For more information see Monitor Databases and Mo
nitor Remote Services.
CLR or JVM-Backend communication

Distributed Transaction Performance in the UI

Flow maps display distributed transaction performance information at the application and business
transaction levels. You can also see business transaction key performance indicators (KPIs) in the
UI.
Application Flow Map

The Application Dashboard flow map characterizes performance across the business application.
The application flow map provides information about the following performance indicators:
The time spent on an average for a tier
The time spent over the network between tiers
The time spent over the network between a tier and a database or remote service such as a
messaging service (backends).
See Monitor Databases and Monitor Remote Services.
Business Transaction Flow Map

The Business Transaction Dashboard flow map displays the performance characteristics of all
requests for a particular business transaction.
The business transaction flow map provides information about the following performance
indicators:
Rate of distributed activity specific to each tier
The percentage of time spent in each tier
In addition to providing performance data and showing bottlenecks, you can use flow maps to
compare against baselines. Comparisons against baselines help identify anomalies in distributed
communication performance. For more information see Detect Anomalies Using Dynamic
Baselines.
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Business Transaction KPIs

The KPIs that AppDynamics uses to measure business transaction performance are:
Load (calls per minute)
ART (average response time in milliseconds)
Errors (total number and errors per minute)
You can observe these metrics in KPI Graphs, the Business Transaction Dashboard, and the Busi
ness Transactions List.
You can see all the performance metrics that AppDynamics collects for business transactions (not
just the key metrics) in the Business Transactions tree of the Metric Browser.
Multi-Threaded Transactions

If your application spawns multiple threads to perform its task, you can use AppDynamics to
monitor individual threads.
See Trace Multi-Threaded Transactions for Java and Enable Thread Correlation for .NET.
Learn More

Detect Anomalies Using Dynamic Baselines
Monitor Databases
Monitor Remote Services
Distributed Transactions for PHP
Transaction Snapshots
Deep Code-Level Visibility in Production
Overview of Transaction Snapshots
When Transaction Snapshots are Captured
To view transaction snapshots
Transaction Snapshot Views
Snapshot Flow Map
Snapshot Waterfall View
The Snapshot List View
Transaction Snapshot Call Drill Downs
Diagnostic Data Captured by a Transaction Snapshot in the Call Drill Down Window
Using Transaction Snapshots
Sorting and Searching for Specific Transaction Snapshots
To filter transaction snapshots using search criteria
To filter transaction snapshots by refining the results list
Comparing Snapshots
To compare snapshots
Troubleshooting With Snapshots
To analyze the most expensive calls and SQL statements
Archiving Snapshots
To Archive a Transaction Snapshot
To Find Archived Transaction Snapshots
Learn More
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A transaction snapshot depicts a set of diagnostic data, taken at a certain point in time, for an
individual transaction across all app servers through which the transaction has passed.
Transaction snapshots are the vehicle for troubleshooting the root causes of performance
problems.
Deep Code-Level Visibility in
Production

Expert Advice

Code level visibility is essential
See how AppDynamics monitored performance
for troubleshooting performance
in real time during elections
problems in production. You
by Sandy Mappic
need details about the exact
code path taken by a particular
transaction and the time spent in
the methods that were
executed. A distributed environment presents a challenge because multiple code paths are
executed across multiple application servers.
AppDynamics generates a transaction snapshot to capture the code paths executed on
instrumented application servers involved in a distributed transaction.

Overview of Transaction Snapshots
When Transaction Snapshots are Captured

Transaction snapshots contain considerable amounts of data. They are generated by the
application server (tier) where the code they contain is running.
In the AppDynamics console, a Drill Down button on a tier in a transaction view indicates that
transaction snapshots exist on that tier and that you can drill down into them to learn more about
why your application is experiencing problems.
Typically in a distributed transaction you will see Drill Down buttons on all the tiers. In the
following very slow transaction, you can see that transaction snapshots have been captured by the
originating ECommerce server and by the downstream Inventory server:

Copyright © AppDynamics 2012-2014

Page 1833

Sometimes transaction snapshots are not captured by all the tiers in a distributed transaction. In
the next example, transaction snapshots were captured on the originating Apache server but not
the downstream ExpandSvc server. Why not?

Here are the rules governing whether transaction snapshots are captured on a tier. The rules are
slightly different for originating and downstream tiers. An originating tier is the tier that contains the
entry point to the transaction.
Transaction snapshots are captured by the originating tier in a distributed transaction:
When a diagnostic session is triggered by the originating tier.
The agent starts diagnostic sessions when it detects a pattern of performance problems. In
addition you can manually start a diagnostic session from the Business Transaction
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Dashboard. For details see See Detailed Data Using Diagnostic Sessions.
When the agent identifies slow, very slow, or stalled response times, or errors on the
originating tier.
These snapshots may have partial call graph information, because they start at the time
when the transaction slowed or experienced an error.
Based on the periodic collection schedule.
By default the agent captures one snapshot every 10 minutes. For details see Configure
Transaction Snapshots.
Any tier (originating, continuing and terminating tiers) can take a snapshot, thus enabling driil
down, when it knows that it is experiencing slow, very slow, or stalled response times or that it has
errors.
In addition, any downstream tier captures snapshots if the tier immediately upstream to it tells it
to take a snapshot. An upstream tier might direct its downstream tier to take a snapshot under
these circumstances:
The upstream tier is taking a snapshot for a diagnostic session.
The upstream tier is taking a snapshot based on the periodic collection schedule.
If none of these conditions exists, the downstream tier may not take a snapshot, hence no drill
down is available on that tier.
Bear in mind that in addition to these rules, there is a limit on the number of snapshots per minute
per tier, so if this limit is reached, snapshots will not be created for that minute notwithstanding
conformity to the rules.
To view transaction snapshots

You can get a list of transaction snapshots for the selected time range:
From the Transaction Snapshots tab of the application, tier, node, or business transaction
dashboards
From the links in the transaction scorecards in the application, tier, node, or business
transaction dashboards
From the Troubleshoot-> Slow Response Time or Troubleshoot-> Errors in the left
navigation pane
1. Navigate to an application, tier, node, or business transaction dashboard.
2. Click the Transaction Snapshots tab.
3. From the list of transaction snapshots that displays, select the snapshot that you want to view
and click View Transaction Snapshot.
4. In the transaction flow map click Drill Down.
Or
1. Navigate to an application, tier, node, or business transaction dashboard.
2. Click the individual slow, very slow, stalls or errors links in the Transaction Scorecard section of
the dashboard.
3. From the list of transaction snapshots that displays, select the snapshot that you want to view
and click View Transaction Snapshot.
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4. In the transaction flow map click Drill Down.
Or
1. Click Troubleshoot-> Slow Response Time or Troubleshoot-> Errors in the left navigation
pane.
2. Select a slow or error transaction from the list.
3. Click View Transaction Snapshot.
4. In the transaction flow map click Drill Down.
Transaction Snapshot Views
Snapshot Flow Map

When you double-click on any item in the list of transaction snapshots, a Transaction Snapshot
Flow Map displays. You can see the user experience, execution time, and timestamp of the
transaction. The flow map also provides details of the overall time that is spent in a particular tier
and in database and remote service calls.

Snapshot Waterfall View

When you click the Snapshot Waterfall View tab, you see a timing waterfall chart of the snapshots
collected for a business transaction. The chart visualizes the call execution times as they occur
during the end-to-end transaction time.
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If there is asynchronous activity the waterfall view displays those calls in a different color.

The Snapshot List View

The Snapshot List View shows a simple list. The list is very useful for sorting snapshots according
to execution time.
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Transaction Snapshot Call Drill Downs

An individual transaction snapshot contains diagnostic information for individual business
transaction instances. It provides information to help diagnose why a particular transaction or
series of transactions are not performing as well as expected.
To get the call drill down information:
In the Transaction Snapshot Flow Map view, click Drill Down on a tier.
In the Snapshot Waterfall View select a snapshot and double-click or click Drill Down.
In the Snapshot List View select a snapshot and double-click or click Drill Down.
The contents of a transaction snapshot containing async segments look slightly different if you
access the snapshot via the Business Transaction view or via the App/Tier/Server view. In the
Business Transaction view, only the originating segments are shown initially, and then you can drill
down to the async segments as desired. Because the App/Tier/Server view surfaces all the
segments that are relative to that entity, all segments, originating or async, are listed initially.
Diagnostic Data Captured by a Transaction Snapshot in the Call Drill Down Window

The following details are captured in a transaction snapshot:
Summary: Problem summary, execution time, CPU, timestamps tier, node process ID,
thread name, etc.
Call Graphs: Call graphs in which you can drill down to the method call that is causing the
problem. AppDynamics automatically filters non-application classes such as core Java
classes, third party libraries, application server and database driver implementation classes.
You can configure call graph settings to control which classes should be included or
excluded from the call graph. To configure, see Configure Call Graphs.
In the Node.js Agent, transaction snapshots do not include call graphs, but they do include
exit calls. See Monitor Node.js Business Transactions. Call graphs are included in Node.js
Agent process snapshots. See View Process Snapshots.
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Hot Spots: Sorts the calls by execution time, with the most expensive calls at the top. To
see the invocation trace of a single call in the lower panel, select the call in the upper panel.
Use the slider to filter which calls to display as hot spots. For example, the following setting
filters out all calls faster than 30 ms from the hot spots list.

Using the force-hotspot-if-diag-session and hotspot-collect-cpu node properties you can
respectively control whether or not hot spot snapshots are collected for manually started
diagnostic sessions and whether CPU time or real time is collected within the hot spot
snapshots.
SQL Calls: All SQL queries fired during a request. AppDynamics normalizes the queries
and by default does not display raw/bind values. You can configure SQL capture settings to
monitor raw SQL data in the queries. Calls taking less than 10 ms are not reported but when
they occur multiple times you may see <SQL Call(s)> in the Query column to identify these
calls. To configure, see Configure Call Graphs.

HTTP Params: HTTP payloads contain basic data such as the URL and session ID, and
additional data for Servlet entry points, Struts, JSF, Web Services, etc. You can use HTTP
data collectors to specify which query parameter or cookie values should be captured in the
transaction snapshot. To configure, see Configure Data Collectors.
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Cookies: The snapshot can use cookie values to help identify the user who initiated the
slow or error transaction. To configure, see Configure Data Collectors.
User Data: User data from any method executed during a transaction, including parameter
values and return values, to add context to the transaction. You can use method invocation
data collectors to specify the method and parameter index. To configure, see Configure
Data Collectors.
In cases where an exit call is made just before a business transaction starts, exit call
information can show up in this field, particularly if the transaction is marked as slow or
having errors. Please note that sensitive information on the exit call may be shown in this
situation.
Error Details: Exception stack traces and HTTP error codes.
Hardware/Mem: Graphs for hardware (CPU Memory, Disk IO, Network IO), Memory (Heap,
Garbage Collection, Memory Pools), JMX, etc.
Node Problems: Viewer to analyze node problems. See Troubleshoot Node Problems.
Additional Data
Transaction snapshots include distributed call graphs and response time distribution details only
when a series of bad transactions or a performance policy violation trigger a diagnostic session on
a node.
Using Transaction Snapshots
Sorting and Searching for Specific Transaction Snapshots
To filter transaction snapshots using search criteria

1. In the Transaction Snapshots tab click the All Snapshots subtab.
2. Click Show Filters if filters are not showing.
3. Click Search Criteria. Check the following criteria to sort the list:
User Experience
Slow
Very Slow
Stall
Execution Time in milliseconds
Business Transaction
Click Add (the + icon) to select a Business Transaction as a search criteria
Errors
Click Error Occurred to list all errors
Click Add (the + icon) to select a particular error as a search criteria
HTTP Request Data
URL
Session ID
User Principal
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Data Collector Data
Collector Type: Any, HTTP Parameter, Business Data, Cookie
Name
Value
Archived
Return Only Archived Snapshots
Advanced
Request GUIDs
3. Click Search.
To filter transaction snapshots by refining the results list

You can refine the results list of a previous query. AppDynamics instantly updates the list as you
select or deselect the Refine Results filters.
1. In the Transaction Snapshots tab of a dashboard click the All Snapshots subtab.
2. Click Show Filters.
3. Click Refine Results. Use the following criteria to sort the list:
User Experience
Normal
Slow
Very Slow
Stall
Business Transactions
Business Transactions by name
AppDynamics also shows the number of snapshots.
Tiers
Tiers by name
AppDynamics also shows the number of snapshots.
Nodes
Nodes by name
AppDynamics also shows the number of snapshots.
Errors
Snapshots where an error occurred
Comparing Snapshots
To compare snapshots

1. In the Business Transactions All Snapshots list, select two snapshots that you want to compare.
2. Click Analyze -> Compare Snapshots.
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The Snapshot Comparison window displays a comparison of the selected snapshots. Look at the
Time and Change columns to find slow methods.

Troubleshooting With Snapshots
To analyze the most expensive calls and SQL statements

1. In the Business Transactions All Snapshots list, select a single or a group of snapshots that you
want to analyze. You can select up to 30 snapshots.
2. Click Analyze -> Identify the most expensive calls / SQL statements in a group of
snapshots.
AppDynamics displays the most expensive calls (methods) in the snapshots and the most
expensive SQL statements.
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Archiving Snapshots

Normally transaction snapshots are purged after a configurable time - by default, two weeks. To
save a snapshot beyond the normal snapshot lifespan – for example, if you want to make sure a
snapshot associated with a particular problem is retained for future analysis – archive the
snapshot.
Customers with on-premise controllers can modify the default two-week period by configuring the
snapshots.retention.period in the Controller Settings section of the Administration console.
To Archive a Transaction Snapshot

1. Display the Transaction Snapshot flow map.
2. Click the Archive button in the upper right corner.
When you are viewing your snapshot list, a small icon in the far right column indicates that a
snapshot has been archived.
To Find Archived Transaction Snapshots

To display only archived snapshots in the snapshot list, filter the snapshot list and check Return
Only Archived Snapshots. See To filter transaction snapshots using search criteria.

Learn More
Configure Transaction Snapshots
Call Graphs
See Detailed Data Using Diagnostic Sessions
Configure Data Collectors
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Configure Call Graphs
Access the Administration Console
Monitor Node.js Business Transactions
Monitor Node.js Processes
View Process Snapshots
Configure Transaction Snapshots

Transaction Snapshots
To configure distributed snapshot correlation for backends
To configure periodic snapshot collection
To disable periodic snapshots
Learn More
Transaction Snapshots

A transaction snapshot depicts a set of diagnostic data, taken at a certain point in time, for an
individual transaction across all app servers through which the transaction has passed. See Trans
action Snapshots.
To configure distributed snapshot correlation for backends

To support transaction snapshots for a distributed transaction, correlation must be enabled for the
backends through which the transaction passes. You enable correlation in the backend
configuration window. Note that correlation is not supported for all types of backends. See Backen
d Monitoring.

To configure periodic snapshot collection

1. In the left navigation pane click Configure -> Slow Transaction Thresholds.
2. Select the scope, either:
Default for all business transactions
or
Individual Business Transaction
3. Modify the settings for periodic snapshots in the Configure Periodic Snapshot Collection section.
Important: If you have a high load production environment, AppDynamics recommends that
you do not use low values for snapshot collection. When there are thousands or millions of
requests per minute, collecting snapshots too frequently may result in many extra snapshots that
are not highly useful. Either turn OFF the periodic snapshots and apply to all Business
Transactions, or choose a very conservative (high) rate depending on the expected load. For
example, if you have high load on the application, choose every 1000th executions or every 20
minutes, depending on the load pattern. See Overview of Transaction Snapshots.
If your SLA-violation-based policies are enabled, you can safely disable the periodic snapshots.
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See Policies.
4. Optional: If you want to apply the new settings to existing business transactions, check Apply to
all Existing Business Transactions.
5. Click Save Default Diagnostic Session Settings.
To disable periodic snapshots

1. In the left navigation pane click Configure -> Slow Transaction Thresholds.
2. Select the scope, either:
Default for all business transactions
or
Individual Business Transaction
3. Clear the following check boxes: Take one Snapshot every xxx executions and Take one
Snapshot every xxx minutes.

4. Optional: If you want to apply the new settings to existing business transactions, check Apply to
all Existing Business Transactions.
5. Click Save Default Diagnostic Session Settings.
Learn More

Transaction Snapshots
See Detailed Data Using Diagnostic Sessions
Call Graphs
Policies
Percentile Metrics for Business Transactions

Demo of Percentile Metrics
Percentile metrics are available for business transaction response time. Percentiles are generally
a better indicator than averages because they are not sensitive to outliers while averages can get
distorted. Percentile metrics can provide a sense of how the response times are distributed. From
this information you can extrapolate the percentage of responses that are within and outside of
acceptable ranges.
Percentiles describe distributions of real world data sets in ways that are less sensitive to the
effect of outliers in the data set than simpler calculations such as the mean. Percentile metrics can
provide you with answers to questions such as the following:
What is the 95th percentile latency of transactions for a single web server?
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What is the 95th percentile latency of transactions for the entire web site (over all the
servers)?
What is the 95th percentile latency of transactions for the website during the last one hour?
Percentile metrics for business transaction response time are displayed in the Metric Browser or
Custom Dashboard.

Percentile metrics can be interpreted as follows: the 95th percentile point indicates that 95% of all
response times were less than the metric value. It provides a sense of how the response times are
distributed. For example if the metric Observed (Average) or percentile value is 300ms, it implies
that 95% of the business transaction response times are less than 300ms, and therefore implies
that 95% of the business transaction response times are within acceptable ranges. It also implies
that 5% of the requests have been taking more time and could be a cause for concern.
Learn More

Configure Mobile Percentile Metrics
Configure Web Percentile Metrics
Configure Percentile Metrics for Java
Metric Browser
Business Metrics
App Agent Node Properties Reference
App Agent Node Properties
Configure Business Transaction Detection
How AppDynamics Identifies Business Transactions
Using Entry Points
Example Entry Point
Auto-Discovered Default Entry Points
Configuring Entry Points
To access business transaction
detection configuration
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Custom Match Rules and Transaction Splitting
Sequence and Precedence for
Auto-Naming and Custom Match Rules
To create custom match rules
Sample custom match rule
Transaction Splitting for Dynamic Discovery
Sample custom match rule with split
The Priority Parameter when Multiple Rules
Apply
Collect Extra Traffic into a Catch-all
Transaction
Creating Exclude Rules
To view default exclude rules
Default exclude rules for Java platforms
Default exclude rules for .NET platforms
To create custom exclude rules
Excluding Business Transactions from the UI
To exclude a business transaction from the UI
Deleting Old Unwanted Business Transactions
To delete old unwanted business transactions
Renaming Business Transactions
To rename business transactions
Grouping Business Transactions
To group Business Transactions
Learn More
Transaction Detection

For details about your
platform, see:
Business Transaction
Configuration
Methodology for Java
Configure Business
Transaction Detection
for .NET
Configure Transaction
Detection for PHP
To get optimal value from AppDynamics, make sure that your business transactions are set up to
describe the relevant traffic that you need to monitor and that they are not set up to monitor
extraneous traffic that is not important to your success. Although you will derive some value from
AppDynamics auto-discovery, you will significantly increase the utility of the product if your
business transactions are tuned to reflect your organization's needs. See Organizing Traffic as
Business Transactions and All Other Traffic Business Transaction.
You specify how AppDynamics detects business transactions for your application by:
Understanding how business transactions are identified using entry points
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Configuring how AppDynamics detects your application's entry points
Creating exclude rules to prevent detection of business transactions that you don't need to
monitor.
Excluding business transactions from the UI to prevent detection of business transactions
that you don't currently need to monitor, but may want to re-enable in the future.
Deleting old unwanted business transactions so that only the newly-configured ones are
used.
After you configure entry point detection, improve the usability of the information by:
Renaming transactions so that everyone can understand their purpose.
Rolling up metrics and reducing clutter in the UI by grouping multiple business transactions.
How AppDynamics Identifies Business Transactions Using Entry Points

When application requests are received by transaction entry points, AppDynamics uses a
transaction auto-discovery mechanism to identify the requests as business transactions.
AppDynamics uses information from the transaction entry point to name the transaction. Automatic
naming conventions include:
When a Servlet method executes, name the business transaction after the first two
segments of the URI.
When a Struts action executes, name the business transaction after the Struts action name.
There are two scopes to identifying business transactions:
Automatic transaction naming configurations (sometimes called "global discovery rules"
and "auto-detection scheme") by default apply across the entire business application and
can be overridden at the tier level. AppDynamics provides default, out-of-the-box automatic
configurations. You can modify the automatic global transaction naming configuration across
the entire business application or tier in the Transaction Detection Entry Points and
Transaction Naming Configuration windows.
Custom transaction naming configurations (sometimes called "custom match rules") by
default apply across the entire business application and can be overridden at the tier level.
AppDynamics provides some platform-specific custom match rules that are disabled by
default. When you need different configurations for different parts of the application or
different web contexts, add custom match rules in the Transaction Detection and New
Business Transaction Match Rule window.
As you might expect, you can use a combination of the global and specific configurations to
effectively identify and represent the most important business transactions in your application.
Example Entry Point

The ACME Bookstore checkout operation uses the following URL:
http://acmeonline.com/checkout

When this request is received, the application triggers a sequence of actions:
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1. On the first tier that receives the request (called the originating tier), the /checkout URI is
mapped to a Servlet called CheckoutServlet.
2. On the execution of the doGet/doPost method, AppDynamics uses the URI /checkout to identify
the business transaction and name it "Checkout".
3. As the application makes calls to other tiers, AppDynamics maintains the context of this
particular transaction. On downstream tiers, entry points correlate to incoming http calls, web
service requests, and other communications from instrumented tiers.

Multiple user requests, as long as they follow the same code path, are grouped as a single
business transaction. In the ACME Bookstore example, one user-click results in the Checkout
Business Transaction being identified as a single transaction. Then, when another user performs
the same action, AppDynamics associates the two requests with the same Checkout Business
Transaction.
Auto-Discovered Default Entry Points

By default AppDynamics discovers many commonly-used entry points. AppDynamics classifies
entry points by the type of framework (such Web Service) and maintains a default detection
scheme for each type.
The UI displays the default entry points and allows you to:
Completely disable an entry point type.
Disable the default discovery mechanism so that only custom configurations can be used
instead.
Configure transaction naming schemes for some common entry points.
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See Web Entry Points and Messaging Entry Points.
If the default entry points do not provide all the business transactions you want to monitor, you can
configure how AppDynamics detects your application's entry points.
You may want to do this if the auto-discovered entry points for certain types do not map precisely
to the business perspective or if AppDynamics is detecting too many business transactions. When
AppDynamics detects too many entry points it creates a special business transaction called "All
Other Traffic - <Tier Name>" that you can use to fine-tune your entry points. See All Other Traffic
Business Transaction.
Both Transaction Monitoring and Automatic Transaction Detection have to be enabled for
the agent to collect metrics for business transactions.
If you disable automatic detection for a specific entry point type for which you have been
detecting transactions (by clearing the Automatic Transaction Detection check box for the
entry point type in the transaction detection configuration screen), the agent will stop
collecting metrics for transactions of those entry point types. It will also stop detecting new
transactions of those types.
But the transactions that the agent has already detected will still appear in the transaction
list, with metrics no longer being reported, unless you have explicitly deleted them from the
list. You can delete transactions from the business transactions list using the More
Actions->Delete Transactions item. See Business Transactions List.
Configuring Entry Points

To gain better visibility for selected types of user requests, you can customize how AppDynamics
detects business transactions at the tier or application level by configuring custom entry points.
You can:
Customize detection settings using custom match rules on entry points to establish a set of
transactions that represent important business activity while not being too granular.
Combine business transactions using custom match rules on entry points to reduce the
overall number of business transactions.
Use dynamic values to fine-tune transaction detection or exclusion based on a parameter or
user data.
For examples see the related topics for your app agent:
Business Transaction Configuration Methodology for Java
Configure AppDynamics for .NET
Configure Transaction Detection for PHP
Configuring entry points involves:
Custom Match Rules and Transaction Splitting: To refine entry point definitions.
The Priority Parameter when Multiple Rules Apply: To sequence how match rules are
applied.
To access business transaction detection configuration

1. From the left navigation pane select Configure -> Instrumentation.
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2. Click the Transaction Detection tab if it is not already selected.
3. Click the detection subtab that corresponds to your environment.
4. Select the tier for which you want to configure the transactions or select the application if you
want to configure at the application level.
5. To configure a custom configuration for the tier, select Use Custom Configuration for this tier.
For information about inheritance for transaction detection, see Hierarchical Configuration Model.
Custom Match Rules and Transaction Splitting

A custom match rule contains two parts:

The Match Part part defines different match conditions for various parts of a request, such as the
URI pattern, value of a HTTP parameter etc.
The Splitting Part (optional) defines the dynamic part of the rule, used to name the transaction,
such as a pointer to the third URI segment, a pointer to a parameter key, etc.
If a splitting part is configured, the transaction will be named as:
(custom match rule name) + (the name derived from the splitting part)

If no splitting part is configured, the name of the transaction will have the name of custom match
rule.
Sequence and Precedence for Auto-Naming and Custom Match Rules

AppDynamics transaction detection process uses following sequence for automatically naming the
transactions:
1. As soon as the entry point is discovered, AppDynamics checks for a custom match rule. If a
custom match rule exists, the business transaction is named based on that rule.
2. If no custom match rule exists, AppDynamics checks the custom exclude rules. If the custom
exclude rule exists, the transaction is excluded from discovery.
3. If no custom exclude rule exists, AppDynamics applies its auto-detection naming scheme.
The following illustration shows the sequence for the transaction discovery process:
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To create custom match rules

1. In the Custom Match Rules panel of the Transaction Detection tab, click Add (the plus icon).
2. From the dropdown menu select the Entry Point type for which you want to create the custom
match rule and click Next.
The New Business Transaction Match Rule window appears for the selected entry point type.
3. Check the check boxes and enter the match criteria for AppDynamics to use to detect business
transactions of this type.
The match criteria on which you can configure the rule vary with the entry point type.
4. Click Create Custom Match Rule.
Sample custom match rule

The following rule creates a custom match rule for a business transaction for Servlet-based
requests in which the URI begins with "/products/outdoor". This will also be the name of the
business transaction in the Business Transactions List, unless you rename it. See Business
Transactions List Operations for information about renaming.
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Transaction Splitting for Dynamic Discovery

The process of using a dynamic value to customize business transaction discovery is called
transaction splitting. Transaction spitting allows you to fine-tune transaction detection or exclusion
based on a parameter or user data.
For example, the following URL represents a Checkout transaction when a user checks out an
item from the electronics section:
http://nwtrader.com/checkout?category=electronics

You can configure the transaction auto-detection mechanism to identify these types of user
requests as a Checkout.electronics business transaction by specifying the user request data to
use to define the transaction.
With this configuration the business transaction is created dynamically based on the user request.
If the request is
http://nwtrader.com/checkout?category=clothing

the transaction would be Checkout.clothing and so on.
Transaction splitting is optional for the entry point types for which it is offered.
If a splitting part is configured, the transaction is named as:
<custom match rule name> + <name derived from the split configuration>
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Sample custom match rule with split

This example splits a custom match rule similar to the one created in Sample custom match rule in
to separate business transactions, one for each color value in the request.

After this configuration is applied, requests that were previously detected as the "/product/outdoor"
business transaction are now detected as "/product/outdoor/blue", "/product/outdoor/red" and so
on. Now that the "/product/outdoor" business transaction is split, metrics are no longer collected for
the old "/product/outdoor" business transaction. Now that the "/product/outdoor" business
transaction is split, metrics are no longer collected for the old "/product/outdoor" business
transaction.
The Priority Parameter when Multiple Rules Apply

You can use the Priority parameter on a custom rule to specify which rule to apply to the detection
of a business transaction if it could be detected by more than one rule. Priority applies from
highest number to lowest number. The rule with the highest number is matched first. 0 is the
lowest priority.
Custom rules with whatever priority always have higher precedence over the default
auto-discovery rules.
If none of the custom rules apply, and auto-discovery is enabled, then the auto-discovery rules
apply.
If none of the custom rules apply, and auto-discovery is disabled, then the business transaction is
not captured.
If a business transaction limit is reached before a match rule evaluates, use exclude rules to
prevent detecting transactions that you do not need to monitor.
Collect Extra Traffic into a Catch-all Transaction

After configuring the most important entry points, consider creating a new "catch-all" rule to collect
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all other website traffic. This will help keep down the number of business transactions.
Create a custom match "catch-all" rule where:
Entry point type is the default value for the platform (the most commonly encountered entry
point type)
Priority is "0"
Match value is "URI is not empty"
Make sure the Priority is "0" so that it will be discovered last. Any operations that don't match your
customized detection rules will be discovered by this "catch-all" rule.
Note: The "catch-all" rule also captures all web service and Struts traffic. This is because
custom rules are evaluated before exclude rules, and there are default exclude rules for web
service and Struts traffic. The "catch-all" rule will evaluate first and put what would normally be
excluded by default into the "catch-all" business transaction.
Creating Exclude Rules

Exclude rules prevent detection of business transactions that match certain criteria.
You might want to use exclude rules in the following situations:
AppDynamics is detecting business transactions that you are not interested in monitoring.
A detected business transaction has no traffic.
You want to trim the total number of business transactions.
You need to substitute a default entry point with a more appropriate entry using a custom
match rule.
For example, the Weblogic Jax RPC Servlets rule excludes any business transaction with a
servlet-type entry point based on a class with a name that starts with
"weblogic.wsee.server.servlet".
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The ASP.NET WebService Session Handler rule excludes any business transaction with an
ASP.NET-type entry point based on the System.Web.Services.Protocols.SyncSessionlessHandler
class.
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You can view the other default exclude rules for more examples. See To view default exclude
rules.
If you create an exclude rule after transactions based on the exclude criteria have already been
created, you need to remove the transactions manually using Actions -> Exclude in the Business
Transactions List. See Business Transactions List Operations.
AppDynamics provides and enables default exclude rules for Servlets and for ASP.NET.
You can view, modify, disable, or remove these rules.
To view default exclude rules

1. In the Exclude Rules panel of the Transaction Detection tab, select an existing exclude rule.
Default exclude rules for Java platforms

Default exclude rules for .NET platforms

2. Click Edit (the pencil icon).
3. To exit the exclude rule configuration screen without changing anything, click Cancel.
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To create custom exclude rules

1. In the Exclude Rules panel of the Transaction Detection tab, click Add (the plus icon).
2. From the drop-down menu select the Entry Point type for which you want to create the exclude
rule and click Next.
The New Exclude Business Transaction Match Rule window appears for the selected entry point
type.
3. Enter the match criteria for business transactions to be excluded from discovery.
The match criteria on which you can configure the rule vary with the entry point type. See Fine-Tun
e Configurations Using Match Conditions.
4. Click Create Exclude Rule.
Excluding Business Transactions from the UI

When you exclude a business transaction from the UI, AppDynamics retains existing metrics for
the business transaction, but no longer monitors it. Excluded transactions do not count against
business transaction limits.
Excluding transactions using this method is helpful if you think you may want to resume monitoring
the transaction in the future, as the underlying configuration is still present.
For example, AppDynamics may have discovered a business transaction that currently has no
traffic. You can find these easily by scanning the Business Transactions List with the Transaction
s With Performance Data option disabled:
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If you know you will never see interesting traffic for the business transaction, you can create an
Exclude Rule. If you anticipate traffic in the future, you can exclude it from the UI.
The exclude action in the UI is also useful for business transactions where a single class or
service detects many methods/operations, and you want to monitor some but not all of them. If you
would have to set up many custom exclude rules, it is simpler to select the subset you do not want
and exclude them via the UI.
To exclude a business transaction from the UI

1. In the left navigation panel click Business Transactions.
2. In the Business Transactions List select one or more transactions that you want to delete.
3. Either right-click -> Exclude Transactions or select Actions -> Exclude Transactions.
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To resume monitoring the business transaction, you can click More Actions -> View Excluded
Transactions and "un-exclude" it from the View Excluded Transactions window.
Deleting Old Unwanted Business Transactions

After you have modified the business transaction discovery configuration using custom match
rules, you then need to delete the old, unwanted business transactions.
If you delete a transaction and you have not changed the configuration, it will be rediscovered.
However, when you have revised the transaction discovery rules properly for what you want to see
and then delete the unwanted business transaction, it won't be rediscovered.
To delete old unwanted business transactions

1. In the left navigation panel click Business Transactions.
2. In the Business Transactions List select one or more transactions that you want to delete.
3. Click More Actions -> Delete.
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Renaming Business Transactions

By default, all business transactions are identified using default naming schemes for different
types of requests. For ease of use you can change the label associated with the name. Use the
names that are recognizable to everyone who monitors your application. See Organizing Traffic as
Business Transactions.
To rename business transactions

1. In the left navigation panel click Business Transactions.
2. In the Business Transactions List select the transaction that you want to rename.
3. Click More Actions -> Rename.

4. Enter the new name and click Rename.
Grouping Business Transactions
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Grouping in the UI makes your lists and flowcharts easier to read by reducing visual clutter. It does
not decrease the overall count of transactions; to do that see Configuring Entry Points.
For example, you may have a web service that has 20 methods and AppDynamics identifies them
as 20 business transactions. You can group them together in the flowmap, and still have access to
the metrics for individual transactions in the Business Transactions List. See Organize Business
Transactions into Groups.
To group Business Transactions

1. In the left navigation panel, click Monitor -> Business Transactions.
AppDynamics lists the Business Transactions for the application.
2. Select the business transactions you want to visually group together.
3. Right-click and select Create Group.

4. Provide a name for the group.
5. Save the information.
AppDynamics lists the group on the Business Transactions List.
Learn More

Organizing Traffic as Business Transactions
All Other Traffic Business Transaction
Business Transaction Configuration Methodology for Java
Monitor Business Transactions
Hierarchical Configuration Model
Fine-Tune Configurations Using Match Conditions
Business Transactions List
Web Entry Points
Messaging Entry Points
Java Web Application Entry Points
POCO Entry Points
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Messaging Entry Points

Messaging Entry Points
Default Naming Conventions
To Access the Default Configuration for Messaging Entry Points
Custom Match Rules for Messaging Entry Points
Grouping Example
Message Payload Example
Learn More
This topic discusses messaging entry points configuration.
Messaging Entry Points

When an application uses asynchronous message listeners or message driven beans, such as
JMS or equivalent MQ providers as the primary trigger for business processing on the entry point
tier AppDynamics can intercept the message listener invocations and track them as business
transactions. This is relevant only for the entry point tier.

You can define messaging entry points for queue listeners to monitor Service Level Agreements
(SLAs). An SLA is often reflected in the rate of processing by a queue listener. When you monitor
a messaging entry point, you can track the rate of processing by a particular queue listener.
Default Naming Conventions

AppDynamics automatically detects and names the messaging entry points. When a message
listener is invoked, the transaction is named after the destination name (the queue name) or the
listener class name if the destination name is not available.
To Access the Default Configuration for Messaging Entry Points
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1. Access the business transaction configuration page.
See To Access Business Transaction Detection Configuration.
2. Scroll down to message entry point entry for your framework.
Custom Match Rules for Messaging Entry Points

If you want finer control over naming messaging requests, you can use custom match rules either
to specify names for your messaging entry points or to group multiple queue invocations into a
single business transaction.
See To Create Custom Match Rules for general information about configuring custom match rules.
Grouping Example

The following custom match rule groups all transactions to queues starting with the word "Event"

Message Payload Example

The following custom rule uses message properties (headers) to define the custom match rule.
You can also use the message content. You can also use message properties or message content
to define custom exclude rules to exclude certain messaging entry points from detection.

Copyright © AppDynamics 2012-2014

Page 1864

Learn More

Configure Business Transaction Detection
Web Entry Points

Auto-Detected Entry Points
Enable or Disable Transaction Monitoring
Enable or Disable Automatic Transaction Detection
Business Transaction Names
Learn More
Entry points define where a business transaction begins.
Auto-Detected Entry Points

AppDynamics classifies entry points by the type of the app server platform and maintains a default
detection scheme for each type. The following screenshots show the configurable Java, .NET, and
PHP entry point types.
Auto-Detected Java Entry Points
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Auto-Detected .NET Entry Points

Auto-Detected PHP Entry Points
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Enable or Disable Transaction Monitoring

For each entry point type, you can enable and disable transaction monitoring. When monitoring is
disabled, the agent stops counting, measuring, recording, etc. all activity on servers of that entry
type throughout the application (if detection is being configured at the application level) or for
specific tiers (if transaction is being configured at the tier level). Transactions discovered by
automatic detection and those discovered by custom rules are equally affected.
Enable or Disable Automatic Transaction Detection

For each entry point type, you can also enable and disable automatic transaction detection.
If automatic detection was enabled and then you disable it:
The agent stops reporting metrics for the transactions previously detected by the now
disabled entry point and detects only transactions based on custom rules. However, the
disabled transaction is not deleted or excluded.
No new transactions based on auto detection for the disabled type are discovered.
Calls to methods and operations of the disabled entry point type are no longer
auto-detected.
Custom rules for the entry point type remain active and the agent reports metrics for
transaction detected by them.
Business Transaction Names

For Java Servlet, ASP .NET, and PHP Web transactions you can configure whether to use the
entire URI or just part of the URI as the transaction name. You can also name transactions
dynamically using a specific part of the request, such as a specific parameter value, cookie value,
session attribute value, etc. as the transaction name.
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Servlet Naming Configuration

ASP .NET Naming Configuration

PHP Web Naming Configuration
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Learn More

Hierarchical Configuration Model
Business Transactions List
Configure Business Transaction Detection
Messaging Entry Points
PHP Entry Points
Alerting for Business Transaction Health Problems
Default Health Rules for Business Transactions
Alerting with Notification Actions
Creating Policies to Match Health Rule Violations with Alerts
Learn More
Business transaction health refers to the extent to which a business transaction is experiencing
critical and warning health rule violations.
Use health rules, notification actions and policies to alert staff of business transaction performance
problems.
Default Health Rules for Business Transactions

AppDynamics provides the following default health rules for business transaction performance:
Business Transaction response time is much higher than normal
This rule defines a critical condition as the combination of an average response time greater
than the default baseline by 3 standard deviations and a load greater than 50 calls per
minute.
This rule defines a warning condition as the combination of an average response time
greater than the default baseline by 2 standard deviations and a load greater than 100 calls
per minute.
Business Transaction error rate is much higher than normal
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This rule defines a critical condition as the combination of an error rate greater than the
default baseline by 3 standard deviations and an error rate greater than 10 errors per minute
and a load greater than 50 calls per minute.
This rule defines a warning condition as the combination of an error rate greater than the
default baseline by 2 standard deviations and an error rate greater than 5 errors per minute
and a load greater than 50 calls per minute.
You can use these health rules as they are or you can modify them.
For information on how AppDynamics determines normal performance, see Detect Anomalies
Using Dynamic Baselines and Configure Baselines.
For information about modifying health rules see Health Rules and Configure Health Rules.
Alerting with Notification Actions

You can create notification actions to set up email and SMS addresses to receive notifications
when the health rules are violated. See Notification Actions.
You can also create email digests that are sent on a predefined schedule to email recipients
summaries of these (and other) health rule violations. See Email Digests.
Alerts in email notifications and digests provide a deep link to help the recipient start analyzing the
root cause of the problem.
Creating Policies to Match Health Rule Violations with Alerts

Create one or more polices to assign a notification action to a specific health rule violation. You
can optionally create different policies for warning and critical health rule violations. See Policies a
nd Configure Policies.
If you want simply to send an email notification to a single email address whenever any health rule
violation is started, you can use the Alerting Wizard.
Learn More

Detect Anomalies Using Dynamic Baselines
Configure Baselines
Health Rules
Configure Health Rules
Policies
Configure Policies
Notification Actions
Email Digests
Getting Started Wizard for Alerts
Backend Monitoring
Supported Backends
Backend Databases and
Remote Services
Monitor Backends
Troubleshoot
Backend
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Supported Environments and Versions for
Java
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Performance
Configure Backend
Detection
Delete Unnecessary
Backends
Learn More

Supported Environments and Versions for
.NET
Supported Environments and Versions for
PHP
Supported Environments and Versions for
Node.js

Backend Databases and Remote
Services

AppDynamics gives you visibility into calls made to uninstrumented destinations inside or outside
your application infrastructure. In AppDynamics, databases and remote services such as message
queues are collectively known as backends. AppDynamics discovers backends from exit point
calls in the application code. An exit point is a call from an instrumented node to another node or
to a backend. When the destination of an exit point call is not instrumented, the exit call results in a
backend discovery event. By default AppDynamics automatically discovers a wide range of
backends.
Monitor Backends

For details about monitoring backends see:
Monitor Databases
Monitor Remote Services
Troubleshoot Backend Performance

To troubleshoot slow response times related to backends see:
Troubleshoot Slow Database and Remote Service Calls
Compare Snapshots to Find Slow Calls
TroubleShooting Database Connection Issues (video)
Configure Backend Detection

If you know that the application flow map should be showing a specific backend and you are not
seeing it, you can modify the configuration to detect backends. You can:
Edit or disable the default backend discovery rules and create new ones. See Configure
Backend Detection or:
Configure Backend Detection for Java
Configure Backend Detection for .NET
Create custom exit points to provide visibility for backend types that are not automatically
discovered. See Configure Custom Exit Points or:
Configure Custom Exit Points for Java
Configure Custom Exit Points for .NET
Delete Unnecessary Backends

You can delete backends from the Database Server List.
See Databases List and Dashboard.
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You can also configure the Controller to automatically remove stale backends. See Remove Stale
Backends.
Learn More

Monitor Databases
Monitor Remote Services
Configure Backend Detection
Remove Stale Backends
Monitor Databases

Measuring Database
Auto-Detected Databases
Performance
Captured JDBC Exit
Calls
By default, many databases and data stores are
automatically detected when calls are made from
Response Time
nodes instrumented with AppDynamics app agents.
Calculations
See:
Metrics Collected
Auto-detecting and
Supported Environments and Versions for Java
Manually
Supported Environments and Versions for .NET
Configuring
Backends
Supported Environments and Versions for PHP
Database Visibility on
Supported Environments and Versions for Node.js
Flow Maps and
Dashboards
Databases on
Application Flow
Maps
Resolving an unexpected database on the flow map
Databases List
Databases Dashboard
Databases on Tier Flow Maps
Databases on Business Transaction Flow Maps
Use AppDynamics for Databases to See More Metrics
Troubleshoot Database Performance
Slow Database Calls
SQL Queries in Backend Calls
Configure Database Detection
Learn More
Measuring Database Performance

Calls from an instrumented node to a database are recognized as traffic related to specific
business transactions. AppDynamics monitors the performance of calls to databases in two ways:
Overall performance of calls to individual databases.
Call performance for specific business transactions
Captured JDBC Exit Calls
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The agent treats all of the below calls (for oracle jdbc driver example) as exit calls and captures
the time for them:
oracle/jdbc/driver/PhysicalConnection.prepareStatement
oracle/jdbc/driver/PhysicalConnection.prepareCall
oracle/jdbc/driver/PhysicalConnection.prepareStatement
oracle/jdbc/driver/PhysicalConnection.commit
oracle/jdbc/driver/PhysicalConnection.rollback
oracle/jdbc/driver/OracleStatement.executeQuery
oracle/jdbc/driver/OracleStatement.executeUpdate
oracle/jdbc/driver/OracleStatement.execute
oracle/jdbc/pool/OracleDataSource.getConnection
oracle/jdbc/driver/OraclePreparedStatement.executeQuery
oracle/jdbc/driver/OraclePreparedStatement.addBatch
oracle/jdbc/driver/OraclePreparedStatement.execute
oracle/jdbc/driver/OraclePreparedStatement.executeUpdate
oracle/jdbc/driver/OraclePreparedStatementWrapper.execute
oracle/jdbc/driver/OraclePreparedStatementWrapper.executeQuery
oracle/jdbc/driver/OraclePreparedStatementWrapper.executeUpdate
For a typical flow, the calls made in order will be getConnection, prepareStatement, execute, and
then commit.
Response Time Calculations

The response time for a database call is measured as the round trip time it takes for JDBC call to
return. The agent captures the database call as exit call from the tier, for example *.execute()
method calls, and captures the time it takes this call to return. so the response time for the
database call includes:
network round trip time + database connection time + SQL query time (or any other time
spent in DB)
Based on the calls per min rate and response time for these calls, the 'average response time' is
calculated.
Snapshots do not show any calls which take less than 10 ms. but the agent considers calls less
than 10ms when calculating the average response time.
Metrics Collected

Metrics for the database calls and response times are collected at four levels:
Business transaction metrics - the metrics for a specific business transaction for a specific
database are visible on the Transaction Flow Map.
Tier metrics - the metrics for all calls from a tier to the specified database are visible on the T
ier Flow Map.
Database metrics - the overall database access metrics across the application (all business
transactions) are visible on the Application Flow Map and the Database Dashboard.
Internal database metrics - see AppDynamics for Databases.
Auto-detecting and Manually Configuring Backends
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By default AppDynamics app agents automatically detect many common databases. See the Supp
orted Environments and Versions for lists of auto-detected databases per platform.
To monitor call performance to a database, first make sure it shows up in the Databases List and
has its own Databases Dashboard. If a service is not appearing, check the configuration. See Conf
igure Backend Detection.
Database Visibility on Flow Maps and Dashboards

For a discussion of the various KPI graphs on the flow maps, see KPI Graphs.
For a discussion of baselines, see Detect Anomalies Using Dynamic Baselines.
Databases on Application Flow Maps

Databases detected during the specified time window show up on the Application Dashboard flow
map. You can view the detected databases in the context of the entire application's transaction
flow. The application flow map displays calls per minute and average response time for calls made
to databases. These metrics include all calls made from a specific tier to a database across all
business transactions. The tier and node flow maps display a similar metric aggregating data from
calls across all business transactions by tier or node respectively.

Resolving an unexpected database on the flow map

If you intermittently see a connection from an application to a database on the flow map that you
do not think was being called by that application, try the following to determine why this database
appears:
From the left navigation menu, select application -> Servers -> App Servers ->
Databases. Select the Slowest Database Calls tab and drill down into the snapshots using
to see the code that is calling the database. See To troubleshoot slow database and remote
service calls.
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Run a diagnostic session to capture some transaction snapshots and look for calls to the
database. See See Detailed Data Using Diagnostic Sessions and Transaction Snapshots.
Are any exceptions thrown when the database is seen? If so, look for error snapshots that
point to the exception trace. See Tutorial for Java - Exceptions and Troubleshoot Errors.
Databases List

You can view a list of the detected database servers along with key performance indicators
including:
Response time
Total calls
Calls per minute
Errors
Errors per minute
The database list shows all databases that were ever detected. Stale databases can be configured
to be automatically removed.

Databases Dashboard

From the database list, you can select a database and click View Dashboard to see the Database
Dashboard. The dashboard displays a Database Flow Map, database properties, and graphs of
the key performance indicators (KPIs). The database properties indicate how the database is
identified and control how it shows in the display map and how the metrics are aggregated. For a
discussion of baselines and how they are used and configured, see Detect Anomalies Using
Dynamic Baselines.
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Databases on Tier Flow Maps

The detected databases show up on the Tier Flow Map. You can view the detected databases in
the context of the traffic on this specific tier. For example, the ECommerce Server tier is shown in
the following screen shot.
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Databases on Business Transaction Flow Maps

For business transactions involving calls to databases, the databases appear on the Transaction
Flow Map. You can view the detected databases in the context of the traffic for this specific
business transaction. The transaction flow map shows the average time spent in database calls for
the business transaction. The following transaction flow map for the Fetch catalog business
transaction shows that the average time per transaction spent on database calls to the MySQL
database is 5 ms and that time represents 13.9% of the time for the entire business transaction.

Use AppDynamics for Databases to See More Metrics
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Users of AppDynamics for Databases can link to that product by right-clicking on a database from
the database list or from the database icon on any flow map. See AppDynamics for Databases.

Troubleshoot Database Performance

Slow Database Calls

AppDynamics displays a list of
the slowest database calls with
call details. Click Troubleshoot
-> Slow Response Times -> Sl
owest DB & Remote Service
Calls tab to view specific call
details and related business
transaction snapshots that can
help you to troubleshoot.

Rapid Troubleshooting
Troubleshoot Slow Database and Remote Service
Calls
Troubleshoot Expensive Methods and SQL
Statements

The Slowest DB & Remote Service Calls tab lists up to ten calls to the database with the longest
execution time over the selected time frame, by tier and for all tiers. Each call shows the following
information:
Call: SQL Query
Avg. Time per Call (ms): the average time per call in milliseconds
Number of Calls: the number of calls executed during the time range
Max Time (ms): the maximum execution time in milliseconds
View snapshots: a link to view existing transaction snapshots
Max Time determines which calls are displayed in the Slowest Database Calls list. For example
for JDBC calls, Max Time must exceed 10 ms before AppDynamics tracks the call as a potential
candidate for this list. App agents aggregate and report call data to the Controller every 15
minutes.
To summarize, AppDynamics defines the slowest remote services calls list as:
Max Time greater than 10 ms
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Top ten worst
Reported every 15 minutes
NoSQL
AppDynamics displays NoSQL databases as Remote Services. The slow call threshold for
remotes services is 50ms. See Monitor Remote Services.
SQL Queries in Backend Calls

Normally AppDynamics reports SQL queries for database calls that have execution times
exceeding 10ms up to a default maximum of 500 queries.
If SQL queries are not visible, you may need to increase the number of queries for which details
are reported. Use the max-jdbc-calls-per-snapshot node property to meet your application's needs.
See App Agent Node Properties Reference.
Configure Database Detection

You can customize the discovery and naming rules and configure the detection of additional
databases. See Configure Backend Detection.
Learn More

Backend Monitoring
Monitor Remote Services
KPI Graphs
Troubleshoot Slow Response Times
TroubleShooting Database Connection Issues
AppDynamics for Databases
App Agent Node Properties Reference
Monitor Remote Services

Remote Service Visibility
Auto-Detected Remote Services
on Flow Maps and
Dashboards
Remote Services on
By default, many remote services are automatically
Application Flow
detected when calls are made from nodes
Maps
instrumented with AppDynamics app agents. See:
Remote Services
Supported Environments and Versions for Java
List
Supported Environments and Versions for .NET
Remote Services
Dashboard
Supported Environments and Versions for PHP
Remote Services on
Tier Flow Maps
Supported Environments and Versions for Node.js
Remote Services on
Business
Transaction Flow
Maps
Troubleshoot Remote Service Problems
Slow Remote Service Calls
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Configure Remote Service Detection
Learn More

Measuring Remote Service Performance
Calls from an instrumented node to a remote service, such as a message queue or web service,
are recognized as traffic related to specific business transactions. AppDynamics monitors the
performance of calls to remote services in two ways:
Overall performance of calls to individual remote services
Call performance for specific business transactions
A remote service provides a service to a distributed application. It resides outside of the
application server. Examples are a Java Message Server or a Web Service. The remote services
servers are not instrumented directly, but you can monitor calls to them from instrumented app
servers. By default AppDynamics app agents automatically detect many common remote services.
See the Supported Environments and Versions for lists of auto-detected services per platform.
To monitor call performance to a service, first make sure it shows up in the Remote Service List an
d has its own Remote Services Dashboard. If a service is not appearing, check the configuration.
See Configure Backend Detection.
Remote Service Visibility on Flow Maps and Dashboards

AppDynamics shows remote services on dashboard flow maps and lists.
Metrics about the remote service calls and response times are collected at three levels:
Business transaction metrics - the metrics for a specific business transaction for a specific
service are visible on the Transaction Flow Map.
Tier metrics - the metrics for all calls from a tier to the specified service are visible on the Tie
r Flow Map.
Remote service metrics - the overall remote service metrics across the application (all
business transactions) are visible on the Application Flow Map and the Remote Services
Dashboard.
For a discussion of the KPI graphs on the flow maps, see KPI Graphs.
Remote Services on Application Flow Maps

Remote services detected during the specified time window appear on the Application Dashboard f
low map. You can view the detected services in the context of the entire application's transaction
flow. The application flow map displays calls per minute and average response time for calls made
to remote services. These metrics include all calls made from a specific tier to a service across all
business transactions. The tier and node flow maps display the same metric in their respective
contexts.
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Remote Services List

You can view a list of the detected remote services that displays key performance indicators, such
as response time, total calls, calls per minute, errors, and errors per minute. The Remote
Services list shows all services that have been detected. Services that are not active are removed
after a configurable time period. See Remove Stale Backends.

Remote Services Dashboard

From the list, you can select a remote service and click View Dashboard to see the Remote
Service Dashboard. The dashboard displays a flow map, properties, and graphs of the key
performance indicators (KPIs). The remote service properties are its identity and control what
shows up in the display map and how the metrics are aggregated.
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From the Remote Service Dashboard you can select the Slowest Remote Service Calls tab to view
specific details and find related business transaction snapshots to troubleshoot issues and find the
root cause of database bottlenecks.

Remote Services on Tier Flow Maps

The detected remote services show up on the Tier Dashboard flow map. You can view the
detected services in the context of the traffic on this specific tier.
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Remote Services on Business Transaction Flow Maps

For business transactions involving calls to remote services, the services appear on the Business
Transactions Dashboard flow map. You can view the detected services in the context of the traffic
for this specific business transaction. The transaction flow map shows the average time spent in
remote service calls for the business transaction.

Troubleshoot Remote Service Problems
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Slow Remote Service Calls

Rapid Troubleshooting

AppDynamics displays a list of
the slowest remote service calls
Troubleshooting Slow Database and Remote
with call details. Click Troubles
Service Calls
hoot -> Slow Response Times
-> Slowest DB & Remote
Service Calls tab to view
specific call details and related business transaction snapshots that can help you to troubleshoot.

The Slowest DB & Remote Service Calls tab lists up to ten calls to a remote service with the
longest execution time over the selected time frame, by tier and for all tiers. Each call shows the
following information:
Call: call to the remote service
Avg. Time per Call (ms): the average time per call in milliseconds
Number of Calls: the number of calls executed during the time range
Max Time (ms): the maximum execution time in milliseconds
View snapshots: a link to view existing transaction snapshots
Max Time determines which calls are displayed in the Slowest DB & Remote Service Calls list.
Max Time must exceed 50 ms before AppDynamics tracks the call as a potential candidate for this
list. App agents aggregate and report call data to the Controller every 15 minutes.
To summarize, AppDynamics defines the slowest remote services calls list as:
Max Time greater than 50 milliseconds (ms)
Top ten worst
Reported every 15 minutes
Configure Remote Service Detection

You can customize the discovery and naming rules and configure the detection of additional
remote services. See Configure Backend Detection.
Learn More

Backend Monitoring
Configure Backend Detection
Remote Services Dashboard
Configure Backend Detection
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Default Automatic Backend
Detection and Discovery
Modify Automatic Discovery
Configurable Properties
and Naming
All Other Traffic Backends
Delete Unnecessary Backends
Organize Backends in Flow Maps
Learn More

Configuration per Platform
Configure Backend Detection for Java
Configure Backend Detection for .NET

Default Automatic Backend Detection and Discovery

Each type of supported database and remote service has a list of properties associated with it.
Each supported backend is identified by its type and the related properties. This set of
preconfigured properties are referred to as backend automatic-discovery rules. AppDynamics uses
these rules to identify and name the databases and remote services.
By default, the configuration for backend discovery is inherited from the tier or application level
configuration. See Hierarchical Configuration Model.
The Automatic Backend Discovery list in the Backend Detection tab shows the configurable
backend discovery rules.

The automatic discovery rules vary according to the type of backend being identified. The default
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discovery rules include settings to enable the following:
Automatic discovery
Cross-tier correlation
Properties used to identify and name the backend
Correlation across tiers enables tracking of distributed business transactions. When calls are
made from one tier to another, correlation enables AppDynamics' tag and trace functionality. For
more details, see Measure Distributed Transaction Performance.
Modify Automatic Discovery

If you know that the application flow map should be showing a specific backend and you are not
seeing it, you can modify the configuration to detect backends. You can:
Edit the default backend discovery rules.
Create new custom backend discovery rules.
Create new custom exit points to provide visibility for backend types that are not
automatically discovered.
Disable automatic discovery of backends that are not of interest.
For example, HTTP backend detection is enabled by default. HTTP backends are identified by
host and port (Java) or URL (.NET and PHP) and correlation is enabled (Java and .NET).
AppDynamics allows you to easily edit the HTTP automatic discovery rules for Java and .NET.
In the left navigation pane click Configure -> Instrumentation -> Backend Detection and select
the application. In many cases, you can achieve the level of customization that you need by editing
the default rules.

Configurable Properties and Naming

For many of the automatically discovered backend types, AppDynamics uses a set of configurable
properties to identify and name the backend. The properties are a list of name-value pairs. For
example, the properties for a messaging queue might look like this:
Property Name DESTINATION_TYPE
Value QUEUE
Property Name DESTINATION_NAME
Value OrderQueue
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Property Name VENDOR
*Value* Active MQ
On its dashboard flow map, this queue appears like this:

Values for each property appear on the dashboard as follows:

In this example, the default configuration uses all three properties for the ActiveMQ queue. You
can change the default configuration for the backend types shown in the UI to aggregate or split
the backends. For example, you could disable the Vendor property for JMS backend detection to
aggregate (join) all JMS backends with the same destination and destination type. The metrics for
all JMS backends with the same destination and destination type would be aggregated as one
backend.
For properties that you want to use, you can also configure how AppDynamics uses the property.
For example, if the URL property is used to identify a backend and your URLs include a file name,
the default configuration results in a separate backend for every file. To reduce the number of
backends identified using the URL property, configure which parts of the URL to use. For example,
run a regular expression on the URL to discard the file name or any other parts of the URL that
you do not want used for identification.
All Other Traffic Backends
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When you see "All other traffic for <type>" on an application flow map, your application has
reached the default backend limit and no new backends are tracked. There is a limit of 300
backends (combined total of discovered databases and remote services) per AppDynamics
business application. When the limit is reached, additional backends are not identified and tracked
as separate backends; instead AppDynamics groups the additional backends by type and
aggregates the metrics. The aggregate backends are represented on the flow maps as one
backend named "All other traffic for <type>". Type is the backend type such as HTTP, Web
Service, etc. HTTP calls and JMS queues are the most common types that hit the limit with the
default configuration rules.

Another way to know that the default backend limit is reaches is when you see a message like this
one in the logs:
[pool-1-thread-2] 21 Mar 2013 11:28:01,702 DEBUG AFastBackendResolver - Not
discovering backend call [Exit Point Type [WEB_SERVICE] Properties
[{SERVICE_NAME=ZipCodeService002.wsdl}] Display Name [ZipCodeService002.wsdl]]
because maximum limit of discovered backends [300] reached.

If the backend limit is reached, consider reducing the number of them. For practical reasons you
may not need to monitor them all.
Here are some common causes of large numbers of backends:
JMS queues that use the session ID in the destination. This causes each session to be
identified as a separate backend.
Calls to message queues hosted on the same server. In this case, you might not be
interested in seeing each queue separately, and instead want to aggregate everything for
the same host and port to the same backend.
Dynamic generation of IP addresses, such as when you host a service on Amazon Elastic
Compute Cloud (Amazon EC2).
Different JDBC drivers connecting to the same database may cause many backends. This
can happen when there are slight variations in the driver metadata that AppDynamics uses
to identify the database. For example, if two different JDBC drivers are used to access the
same database, something as simple as a different spelling or format of the database name
(ORACLE, oracle, or ORACL) can generate multiple database names when they are the
actually the same physical database.
To reduce the number of backends, change the configuration of the backend detection rules. For
example, if a property causes excessive unique identification, consider removing the property or
modifying its use in the detection and naming rule. If you created custom exit points, consider
refining or removing them.
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Delete Unnecessary Backends

Some backends may no longer have traffic. You can delete unused backends from the Remote
Services Dashboard and Databases List and Dashboard. If later the backend has new traffic, the
app agent will re-discover it and re-register it with the Controller.
You can also configure the Controller to automatically remove stale backends. See Remove Stale
Backends.
Organize Backends in Flow Maps

Once you have configured detection for all the backends you require, you may need to organize
the way they appear in the UI. See Group Backends on Flow Maps.
Learn More

Monitor Databases
Monitor Remote Services
Configure Backend Detection for Java
Configure Backend Detection for .NET
Configure Custom Exit Points

Custom Exit Points for Custom
Backend Detection
To create a custom exit
point
To split an exit point
To group an exit point
To define custom metrics
for a custom exit point
To define transaction
snapshot data collected
Learn More

Custom Exit Points per Platform
For configuration by platform, see:
Configure Custom Exit Points for Java
Configure Custom Exit Points for .NET

Custom Exit Points for Custom Backend Detection

Use custom exit points to identify backend types that are not automatically detected, such as file
systems, mainframes, and so on. For example, you can define a custom exit point to monitor the
file system read method. After you have defined a custom exit point, the backend appears on the
flow map with the type-associated icon you selected when you configured the custom exit point.
You define a custom exit point by specifying the class and method used to identify the backend. If
the method is overloaded, you need to add the parameters to identify the method uniquely.
You can restrict the method invocations for which you want AppDynamics to collect metrics by
specifying match conditions for the method. The match conditions can be based on a parameter or
the invoked object.
You can also optionally split the exit point based on a method parameter, the return value, or the
invoked object.
You can also configure custom metrics and transaction snapshot data to collect for the backend.
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To create a custom exit point
1. From the left navigation pane, click Configure -> Instrumentation and select the Backend
Detection tab.
2. Select the application or tier for which you are configuring the custom exit point.
3. Ensure Use Custom Configuration for this Tier is selected.
Backend detection configuration is applied on a hierarchical inheritance model. See Hierarchical
Configuration Model.
4. Scroll down to Custom Exit Points and click Add (the + icon).
5. In the Create Custom Exit Point window, click the Identification tab if it is not selected.
6. Enter a name for the exit point. This is the name that identifies the backend.
7. Select the type of backend from the Type drop-down menu.
This field controls the icon and name that appears on the flow maps and dashboards. Some of the
values are shown in this screen shot:

If the type is not listed, you can check Use Custom and enter a string to be used as the name on
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the dashboards.
8. Configure the class and method name that identify the custom exit point.
If the method is overloaded, check the Overloaded check box and add the parameters.
9. If you want to restrict metric collection based on a set of criteria that are evaluated at runtime,
click Add Match Condition and define the match condition(s).
For example, you may want to collect data only if the value of a specific method parameter
contains a certain value.
10. Click Save.
The following screenshot shows a custom exit point for a Cache type backend. This exit point is
defined on the getAll() method of the specified class. The exit point appears in flow maps as an
unresolved backend named CoherenceGetAll.

To split an exit point
1. In the Backend Detection configuration window, click Add.
2. Enter a display name for the split exit point.
3. Specify the source of the data (parameter, return value, or invoked object).
4. Specify the operation to invoke on the source of the data: Use toString() or Use Getter Chain (
for complex objects).
5. Click Save.
The following example shows a split configuration of the previously created CoherenceGetAll exit
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point based on the getCacheName() method of the invoked object.

To group an exit point
You can group methods as a single exit point if the methods point to the same key.
For example, ACME Online has an exit point for NamedCache.getAll. This exit point has a split
configuration of getCacheName() on the invoked object as illustrated in the previous screen shot.
Suppose we also define an exit point for NamedCache.entrySet. This is another exit point, but it
has the split configuration that has getCacheName() method of the invoked object.
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If the getAll() and the entrySet() methods point to the same cache name, they will point to the
same backend.
Matching name-value pairs identify the back-end. In this case, only one key, the cache name, has
to match. So, here both exit points have the same name for the cache and they resolve to the
same backend.
To define custom metrics for a custom exit point
Custom metrics are collected in addition to the standard metrics.
The result of the data collected from the method invocation must be an integer value, which is
either averaged or added per minute, depending on your data roll-up selection.
To configure custom business metrics that can be generated from the Java method invocation:
1. Click the Custom Metrics tab.
2. Click Add.
3. In the Add Custom Metric window type a name for the metric.
4. Select Collect Data From to specify the source of the metric data.
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5. Select Operation on Method Parameter to specify how the metric data is processed.
6. Select how the data should be rolled up (average or sum) from the Data Rollup drop-down
menu.
7. Click Create Custom Metric.
To define transaction snapshot data collected
1. Click the Snapshot Data tab.
2. Click Add.
3. In the Add Snapshot Data window, enter a display name for the snapshot data.
4. Select the Collect Data From radio button to specify the source of the snapshot data.
5. Select the Operation on Method Parameter to specify how the snapshot data is processed.
5. Click Save.
Learn More

Configure Backend Detection
Resolve Backends to Tiers

Backend Tiers
Resolve a Backend to a Tier to Change the Topological View
Logical Backend Tiers for Homogeneous Backends
Resolving Backends to Tiers
To resolve a backend to a tier
To see and configure backends associated with a tier
Learn More
Backend Tiers

Backend tiers help you organize backend calls and present a more useful topological view of your
application environment in flow maps. "Resolving" a backend to a tier means that the backend
metrics are gathered into a tier. The tier may already exist in AppDynamics, or you can create a
new one.
AppDynamics automatically resolves some backends to tiers. In general, those are custom
backends or HTTP, RMI, Thrift or Web Services since they are usually on another instrumented
node. If you want to see the backend on its own, you can "unresolve" it and it will appear on the
flow map.
Resolve a Backend to a Tier to Change the Topological View

Even if a database is hosted on the same node as an instrumented app server, it may be
displayed as a separate backend icon on the flow map. You may want to to resolve the database
to the app server tier so that topologically, the representation is more intuitive for your
environment.
Logical Backend Tiers for Homogeneous Backends

You can create a logical tier for a set of backends that are really the same, and resolve them to it.
This can make sense visually, and give you more helpful metrics.
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For example, if there appear to be multiple databases that are actually the same database using
different namespaces, the default flow map is likely to display the databases separately. You can
resolve the database backends to a new tier of type "Database Server" so they display as one and
the tier metrics are together.
Resolving Backends to Tiers

If backends are not automatically resolved, you can resolve them in the UI.
Resolving a backend to a tier makes it no longer appear in the flow maps. Its traffic resolves to the
tier.
You can resolve multiple backends to a tier. You also get tier-level metrics, so if a backend is
taken out you still retain the historic data at the tier level.
To resolve a backend to a tier

1. In a Remote Services or Databases Dashboard, click Action (lightning bolt) -> Resolve
Backend to Tier.
2. If the tier you want already exists, it will be listed and you can select it. Otherwise, select Cr
eate Tier.

1. Enter a user-friendly name for the new tier.
2. Select the Type from the pulldown menu.
3. Click OK.
To see and configure backends associated with a tier

1.
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1. In a Tier Dashboard, click Action (lightning bolt) -> Configure Backends Resolving to
this Tier.
2. Click a backend to see its properties.

You can delete the backend. Deleting the backend from the tier causes it to re-appear as
an unresolved backend in the flow map.
You can resolve it to a different tier. Associating it with another tier causes traffic to it to
resolve to the new tier.
Learn More

Backend Monitoring
Group Backends on Flow Maps
Group Backends on Flow Maps

Configure Backend Icons on Flow Maps
Rules for Grouping Backends on Flow Maps

When you edit existing flow maps or create new customized flow maps, you can group similar
databases or remote services into a single icon.
Some reasons to group similar backends into a single icon are to improve readability or focus on
nodes of specific business interest. For example if individual databases or remote service
instances are not important to the audience using this specific flow map, you can group them into
one icon.
Configure Backend Icons on Flow Maps

In the Edit Flow Map window you can configure how backends are displayed in flow maps.
In a flow map, click Flow Map Name -> Edit Flow Map.
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Group databases and remote services of the same type. By default AppDynamics groups
any two or more backends of the same type. Sometimes you want to see each database
and remote service in the flow map. If so, uncheck this option.
If there are specific database or remote services that you do not want to see or group in the
flow map, uncheck the Visible or Groupable check box.
Rules for Grouping Backends on Flow Maps

Not every backend can be grouped into the same tier. These rules govern how databases and
remote services can be grouped on flow maps.
A group consists of a minimum of two backends.
A backend that calls other backends or calls into any other tiers cannot be part of a backend
group.
A set of backends can be grouped under these conditions:
1. The backends are all of the same type.
2. The backends are called by the same tiers.
For example, consider the case shown in the top half of the following diagram where:
Tier 1 calls Backend 1, Backend 2, Backend 3, and
Tier 2 calls Backend 1, Backend 3, Backend 4, and
Backend 4 calls Backend 5
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The bottom half of the diagram shows that Backend 1 and Backend 3 can be grouped because
they are called by Tier 1 and Tier 2. However, Backend 2 and Backend 5 can not be grouped
because they are individual backends of a type within their tiers. Backend 4 cannot be grouped
because it calls Backend 5.
Remove Stale Backends

Stale or Orphaned Backends
To configure automatic stale backend deletion
Learn More
Stale or Orphaned Backends

A stale backend (also called an orphaned backend) is a backend for which AppDynamics has
previously captured metrics, but which has experienced no metric activity for the configured time
period.
You can configure AppDynamics to remove stale backends (database and remote service servers)
automatically at a regular interval by setting the Controller-level global
backend.permanent.deletion.period property.
If you are sharing a Controller on a SaaS account, contact AppDynamics Support.
When this Controller-wide property is enabled, AppDynamics removes all the stale backends in
the managed environment, including any metrics previously collected for them and any health
rules referencing their metrics. After a backend is removed, its metrics no longer appear in the
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Metric Browser and health rules that reference those metrics do not fire. You should remove any
health rules conditions that reference metrics in stale backends.
By default, automatic removal of stale backends is enabled with a default interval of one month.
The beginning of the interval is the last time that activity was reported on the backend (that Calls
per Minute > 0) and the end of the interval is the time at which the backend is deleted.
You can modify the interval. This may be advisable, especially for large installations, since the
maximum number of backends removed in one pass is 50. The minimum interval is one week.
You can also disable automatic removal by setting the interval to 0.
The automatic backend removal is logged in the server.log with the message:
BACKEND PURGER deleting unresolved stale backend ids:
followed by a list of the IDs being deleted.
To configure automatic stale backend deletion

1. Log into the Controller Administration Console using the admin account. See Access the
Administration Console.
2. Select Controller Settings.
3. Scroll down to the backend.permanent.deletion.period property.
4. Enter the new interval in hours.
5. Click Save.
Learn More

Backend Monitoring

Monitor Errors and Exceptions
Errors and Exceptions at the Business Transaction Level
Errors and Exceptions at the Business Application Level
Errors and Exceptions in the UI
Errors Shown in the Transaction Scorecard
Errors Shown in the KPI Widget
Errors Shown in the Metric Browser
Exceptions Shown in the Exceptions Widget
Health Rules for Error Rates
Learn More
AppDynamics Application Intelligence Platform collects metrics on errors and exceptions.
An error in AppDynamics indicates an unhandled exception in the context of a business
transaction, a logged error of the appropriate severity, or any exception called during an exit call,
which prevents the transaction from working properly.
An exception is a code-based anomalous or exceptional event, usually requiring special
processing. It can occur in the context of a business transaction and outside of a business
transaction.
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Errors and Exceptions at the Business Transaction Level

An error can be an unhandled exception in the context of a business transaction.
For example:
Business transaction entry point -> some code -> some exception thrown -> business
transaction finished -> exception caught. In this case AppDynamics reports the exception.
Business transaction entry point -> some code -> some exception thrown -> exception
caught inside a business transaction -> business transaction finished. In this case
AppDynamics does not report the exception.
If a business transaction experiences an error, it is counted as an error transaction and not as a
slow, very slow or stalled transaction, even if the transaction was also slow or stalled.
Errors and Exceptions at the Business Application Level

An error that is logged with a severity of Error or Fatal using Log4j or java.util.logging (in Java),
and Log4Net/NLog (in .NET) may occur outside the context of a business transaction. Depending
on the signature of the method being called, you might not see an exception stack trace:
logger.log(Level.ERROR, String msg, Throwable e) - stack trace available
logger.log(Level.ERROR, String msg) – no stack trace here
An exception may occur during an exit call, for example while calling SQL, a web service, or a
message queue server.
An application server exception is a code-logged message outside the context of a business
transaction.
There is not a one-to-one correspondence between the number of errors and the number of
exceptions. For example, a business transaction may experience a single code 500 error in which
several exceptions were logged as the transaction passed through multiple tiers.

See the Supported Environments and Versions for your app agent to determine if the loggers you
use are recognized by default by AppDynamics. If you expect to see errors from a custom logger
you first need to configure AppDynamics to recognize the logs. See Custom Logger Definitions.
You can configure the types of errors that AppDynamics detects as well as the types of exceptions
to ignore. See Configure Error Detection.
Errors and Exceptions in the UI
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By default AppDynamics displays errors and exceptions in various parts of the UI. You can also
display error metrics in a Custom Dashboard.
Errors Shown in the Transaction Scorecard

The Transaction Scorecard shows error metrics in the context of its dashboard.

Clicking on the Errors in the scorecard opens the snapshots for the error. Errors are indicated by
the red exclamation point icon. Click on the snapshot to drill down and find the root cause of the
error.

Clicking on the snapshot lets you drill down and find the root cause of the error.

Errors Shown in the KPI Widget

The Errors KPI shows error metrics in the context of its dashboard.
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Clicking on the number of errors opens the Metric Browser showing the errors per minute.
Errors Shown in the Metric Browser

Additional error metrics are available in the Metric Browser.

Exceptions Shown in the Exceptions Widget

The Exceptions widget shows exception metrics in the context of its dashboard.

Clicking on Exceptions opens the Exceptions tab of the Errors window.
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You can also use the Troubleshoot -> Errors menu to open the Error Transactions and
Exceptions tabs. See Troubleshoot Errors.

Health Rules for Error Rates

AppDynamics provides the default health rule "Business transaction error rate is much higher than
normal". You may want to define additional health rules for error rates on tiers or backends. See H
ealth Rules.
Learn More

Configure Error Detection
Troubleshoot Errors
Supported Environments and Versions
Configure Error Detection

Configuring Error Detection
Configuring Error Detection Using Calls to Loggers
To configure error detection using logs with Java
To configure error detection using logs, system trace, and event logs with .NET
To configure error detection using logs with PHP
Configuring Error Detection Using Custom Loggers
To define a custom logger
Configuring Errors based on HTTP Response Codes
Configuring Error Redirect Pages
Configuring Exceptions and Log Messages to Ignore
To define an exception to ignore
To configure a logged message to ignore
Learn More
You can configure which errors AppDynamics detects and which it ignores. For an overview see M
onitor Errors and Exceptions.
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Configuring Error Detection

You can configure:
how to understand calls to standard loggers
how to define custom loggers
which HTTP response codes should be defined as errors
which redirect pages should be tied to an error
which exceptions and messages to ignore
The error detection configuration is applied to all tiers in the application.
Always remember to click Save Error Configuration after you have made any changes.
Configuring Error Detection Using Calls to Loggers

By default AppDynamics instruments calls to loggers using common platform specific loggers.
AppDynamics captures any exception stack trace and automatically correlates it with the request.
To configure error detection using logs with Java

For details about the Java logging APIs see Java Logging. By default, AppDynamics can
instrument calls using Log4j and java.util.logging.To instrument calls using other loggers, see Cust
om Logger Definitions.
1. Click Configure -> Instrumentation.
2. Select the Error Detection tab.
3. Click the Java - Error Detection tab.

3. Select where you want AppDynamics to look for log messages and exceptions.
To mark as an error transaction any business transaction for which messages at ERROR
level or higher are logged, check the Mark Business Transaction as error checkbox
To exclude business transactions for which specific messages are logged from being
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marked as error transactions, check the checkbox and add the messages that you want to
exclude in the Ignored Messages list below.
To not mark any business transactions as error transactions, clear the checkbox.
Messages logged as higher than ERROR would include more severe levels such as CRITICAL or
FATAL.
4. Click Save Error Configuration.
To configure error detection using logs, system trace, and event logs with .NET

By default, AppDynamics can instrument calls using NLog and Log4Net. It can also gather
information from System Trace and the Event Log. To instrument calls using other loggers, see Cu
stom Logger Definitions.
1. Click Configure -> Instrumentation.
2. Select the Error Detection tab.
3. Click the .NET - Error Detection tab.

3. Select where you want AppDynamics to look for log messages and exceptions.
To mark as an error transactions any business transactions for which messages at ERROR
level or higher are logged check the *Mark Business Transaction as error checkbox
To exclude business transactions for which specific messages are logged from being
marked as error transactions, check the checkbox and add the messages that you want to
exclude in the Ignored Messages list below.
To not mark any business transactions as error transactions, clear the checkbox.
Messages logged as higher than ERROR would include more severe levels such as CRITICAL or
FATAL.
4. If you do not want system trace or event log errors to be monitored, check the appropriate box.
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System trace errors are anything written as an error message to the Listeners collection via
TraceError.
Event log errors are anything written to the EventLog when the type is set to error. For
example:
myEventLog.WriteEntry(myMessage, EventLogEntryType.Error, myID);

5. Click Save Error Configuration.
To configure error detection using logs with PHP

By default, AppDynamics can check for PHP errors using multiple thresholds.
1. Click Configure -> Instrumentation.
2. Select the Error Detection tab.
3. Click the PHP - Error Detection tab.

3. Select the appropriate error threshold (Notice, Warning, or Error) from the dropdown menu.
To mark as an error transactions any business transactions for which messages at the
chosen level or higher are logged, check the Mark Business Transaction as error checkbo
x
To exclude business transactions for which specific messages are logged from being
marked as error transactions, check the checkbox and add the messages that you want to
exclude in the Ignored Messages list below.
To not mark any business transactions as error transactions, clear the checkbox.
4. Click Save Error Configuration.
Configuring Error Detection Using Custom Loggers

To configure AppDynamics to look for errors from a custom logger, create a custom logger
definition. Custom loggers are supported in Java and .NET.
To define a custom logger

1. On the right side of the Definition panel, click Add Custom Logger Definition.
The Custom Logger Definition window opens.
2. Enter a name for the custom logger.
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3. Check the Enabled check box to enable it.
4. Use the drop-down menu and text field to define the logger's class.
5. Enter the name of the method that implements the logger.
6. Click Add Parameter to add a parameter to the logger. The Param list appears.
7. In the appropriate Param Index field, enter the fully qualified class name for each parameter.
8. Repeat steps 6 and 7 as necessary to define all of the logger method's parameters.
9. In the Exception Parameter field, enter the zero-based index of the parameter for the exception
object.
This index can be any type of Object, including Arrays. If the Object is not null, AppDynamics
converts the Object to a string to report the error details.
A custom logger only marks a BT as an having an error if there is a non-null exception object
passed to the logger method.
10. Click Save.
The following screenshot shows a logger definition for a method with two parameters. It uses the
array parameter to describe the exception.

The next screenshot shows a logger definition for a method with one parameter. It uses a string
parameter to describe the error details.
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Configuring Errors based on HTTP Response Codes

In Java and .NET, you can configure errors based on HTTP response codes.
HTTP response codes can convey errors that occur while the application is serving user requests
as well as business application errors.
For example, a 404 error is a page not found error whereas a 430 error might represent an item
out of stock situation.
By default, AppDynamics captures all HTTP error codes from 400 to 505. If the error code is set as
part of a business transaction, the transaction is marked as an error. You need to configure error
custom codes ranges and custom error codes with custom descriptions.
The following figure shows the error configuration for ACME Online store. This configuration
causes AppDynamics to detect the Inventory Empty Error and Custom Error codes.

To ignore an error code if you do not want it to appear, add it to the list by creating a custom error
code range and then disable that error code by clearing its Enabled checkbox.
Configuring Error Redirect Pages
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In Java and .NET you can configure errors based on custom error pages.
Applications can use custom redirect pages to identify application errors.
To specify a redirect page, click Add Error Redirect Page.

In this example, whenever an error in the system redirects to "AcmeErrorPage.jsp", AppDynamics
logs an error.
Configuring Exceptions and Log Messages to Ignore

Configuring exceptions and log messages to ignore is useful for excluding a temporary known
issue or any other exception you don't care about from the error count. This avoids skewing error
metrics and triggering unnecessary alerts from policies based on the error count. You can
configure AppDynamics to ignore specified exceptions and logged messages.
In the case of exceptions, when you configure an exception to be ignored, AppDynamics still
detects the exception, logs the exception, increments the exception count, and displays the
exception in the Exceptions subtab of the Errors tab of the tier and node dashboards.
In transaction snapshots, an ignored exception does not appear as an error in the Summary and
Error Details sections of any transaction snapshot that was in progress when the exception
occurred. The status of the User Experience header in the transaction snapshot Summary would
not be marked as ERROR. If the transaction was slow, very slow, stalled, or normal the User
Experience header in the snapshot reflects that experience.
Configure an exception to be ignored if you do not want AppDynamics to increment the business
transaction error count for errors caused by that exception. When an ignored exception occurs,
AppDynamics does not count the business transaction in which the exception occurred as an error
transaction. For example, consider a login business transaction in which the code generates
exceptions when someone tries to log in with invalid credentials. These exceptions are not errors,
because the transaction is functioning as it should be, so you might want to configure the agent to
ignore them.
To define an exception to ignore

1. Click Add New Exception to Ignore.
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The Configure dialog pops up.
2. Enter the fully qualified class name for the exception. You can use a colon (:) to separate
multiple names.

If you don't need to filter for specific messages in the exception, select "Is Not Empty". If you
want to filter for Null, select "Is Not Empty" and use the gear icon to select NOT. This sets the
condition to not(notempty), that is "empty".
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3. To filter for specific messages, define the message to be matched. For example, you can direct
AppDynamics to ignore an exception only when the exception.getMessage() call contains the
string "format", or does not contain the string "format".

4. To filter for specific nested exceptions, list the entire exception chain. The following
configuration directs AppDynamics to ignore all java.lang.Runtime exceptions that wrap a
javax.sql.SQLException. Other types of java.lang.Runtime exceptions will not be ignored.
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5. To filter for both nested exceptions and specific messages, specify both.The next configuration
defines the exceptions to ignore more narrowly. It directs AppDynamics to ignore all
java.lang.RuntimeExceptions that wrap a javax.sql.SQLException only when the
exception.getMessage() call contains the string "format".

4. Don't forget to Save your changes.
To configure a logged message to ignore

1. Click Add
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The Create dialog pops up.
2. Specify a match condition for log messages to ignore.

3. In .NET and Java, you can also specify that errors logged with certain loggers or logger
categories be ignored. Click Add New Category/Logger to Ignore.

Learn More
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Troubleshoot Errors
Monitor Errors and Exceptions

Monitor Infrastructure
Application Infrastructure Monitoring and Metrics
Infrastructure Metrics Can Help Identify Problems
Availability Alerts
Learn More
Application Infrastructure Monitoring and Metrics

Monitoring business transaction health gives you an inside view of how applications are
performing. AppDynamics encourages you to monitor your business transactions and make them
the focus of your performance monitoring strategy. However, infrastructure performance naturally
affects business transaction performance, and so infrastructure metrics can provide important
clues to the root causes of your application performance issues. AppDynamics can alert you to the
problem at the business transaction level and at the infrastructure level. In addition, you can
correlate metrics with each other to see the relationships among different events that occur in the
system.
AppDynamics provides preconfigured application infrastructure metrics and default health rules to
enable you to discover and correct infrastructure problems. You can also configure additional
persistent metrics to implement a monitoring strategy specific to your business needs and
application architecture.
Application infrastructure includes:
Application servers and IIS
JVMs and .NET CLRs
Hardware
OS
The following diagram illustrates the infrastructure associated with a Java application environment.

The Java Agent provides both infrastructure metrics for the JVM and the App Server, and
application metrics for your business application. When a Java Agent is installed on the same
machine, metrics are collected for CPU usage, disk I/O, network I/O, and memory usage.
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The following diagram illustrates the infrastructure associated with a .NET application
environment.

Infrastructure Metrics Can Help Identify Problems

Having the right infrastructure monitoring strategy is important because many times the root cause
of application issues is most obvious by looking at infrastructure metrics. For example, the
following infrastructure issues can slow down your application:
Too much time spent in garbage collection of temporary objects
Contention in connection pools
Some other process spinning on the CPU
In all these cases, transaction snapshots are able to correlate the infrastructure metrics for the
specific node so that you can identify the root cause of slow or stalled transactions. For example,
from the Node Dashboard, you can view the JVM tab, the JMX tab showing the connection pool
metrics, and the Hardware tab (when the machine agent is installed) respectively.
You can configure health rules on metrics such as garbage collection time, connection pool
contention, or CPU usage to catch issues early in the cycle before there is an impact on your
business transactions. In all cases, with the right monitoring strategy in place, you can be alerted
to problems and fix them before user transactions are affected.
Availability Alerts

You can configure alerts for JVM and CLR crashes respectively using JVM Crash Guard and the .
Net Machine Agent.
Use metrics in the Application Infrastructure Performance section of the Metric Browser in policies
that fire when the metric value reports a critical level and perform an action, such as: send an
email, start diagnostics, or perform a thread dump. If you have the Standalone Machine
Agent installed, you can have the agent run a script on the machine to, for example, restart the
application or JVM.
Alert on Application Availability: Use the Application Infrastructure Performance -> <Tier
Name> ->Agent -> App -> Availability metric. If you alert on Availability < 1, the policy will
fire when the application is not available on any of the nodes where it usually runs. You can
create a policy that alerts you if even one of the nodes is down by creating a policy that fires
when the Availability metric value is less than <number of expected nodes>. The Availability
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metric at the agent node level reports 1 only if the application is running and there are no
connectivity issues between the agent and the Controller.
Alert on Standalone Machine Agent Availability: Use the Application Infrastructure
Performance -> <Tier Name> ->Agent -> Machine -> Availability metric . If Availability is < 1,
then the agent is not reporting. The Machine Availability metric does not report the hardware
status, just whether or not the Standalone Machine Agent is reporting.

Utilizing JMX Metrics in Troubleshooting
Learn More

Monitor Java App Servers
Monitor Hardware
Monitor JVMs
Alert and Respond
Infrastructure Metrics
Machine Snapshots for .NET
Infrastructure Metrics
View of Infrastructure Metrics
Infrastructure Metric Collection
Java Environment
Standalone Machine Agent
.NET Embedded Machine Agent
Long-term Metrics for Baselining, Monitoring, and Alerting
Short-term Metrics for Correlating and Troubleshooting
Using Metrics in External Systems
Learn More
View of Infrastructure Metrics

The AppDynamics user interface organizes the infrastructure metrics for your application level by
tiers. For each application, you can see metrics gathered by the machine agent (when installed)
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and app server agents. In general, agents upload metrics to the Controller once a minute at
staggered intervals. The Controller rolls up the data and makes it available in the UI. You can get a
view of the health of the nodes in a tier using the App Servers Dashboard.
To access this dashboard, in the left navigation pane, click Servers -> App Servers.

Click the Hardware tab to see hardware metrics.

Click the Memory tab to see some of the key memory metrics.

You can see more detailed infrastructure metrics from the Node Dashboard. To access this
dashboard, in the left navigation pane, click Servers -> App Servers -> <tier> -> <node>.

You can also view metrics in the Metric Browser.
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Utilizing JMX Metrics in Troubleshooting
Infrastructure Metric Collection

Collection varies depending on the environment.
Java Environment

JVM and JMX infrastructure metrics are averaged over a period of one minute at 15-second
intervals. As the minute boundary starts, we take the value, and take three more values every 15
seconds until the end of the minute. The four values are averaged and reported to the controller.
Therefore, every minute the agent reports a tuple consisting of min, max, avg, sum, current for that
minute to the controller. For example, if we took 10,20,40,30 as values for that minute we have
10,40,25,100,30 for that particular metric. In other words:
min=10
max=40
avg=25
sum=100
current=30
Standalone Machine Agent

Machine agent CPU and memory metrics are gathered every 2 seconds and averaged over a
period of one minute.
Machine agent network and disk metrics are gathered at one minute intervals.
.NET Embedded Machine Agent

The .NET embedded machine agent collects IIS and CLR metrics every 60 seconds using Window
s Performance counters. The update interval is configurable using the update-interval-in-secs
property found in web.config.
Long-term Metrics for Baselining, Monitoring, and Alerting

Usually it is best to focus on detecting anomalies in business transactions, because infrastructure
problems always have an impact on the business transaction metrics. However there may be
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cases where you want to monitor infrastructure directly.
By default AppDynamics generates long-term metrics for the key machine, app server, and app
server attributes that represent the health of an application. By default AppDynamics includes
health rules at the node level for infrastructure metrics. You can modify these or create new health
rules to be notified of actual or impending problems. The default infrastructure health rules are
shown in the following screen capture.

For instructions to modify or add health rules see Health Rules.
Analyzing metrics over the long term enables AppDynamics to define baselines against which
anomalies are identified. A health rule can use a baseline as a condition. You can also compare
baselines against current metrics in the Metric Browser.
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For more information about using baselines see Detect Anomalies Using Dynamic Baselines.
Short-term Metrics for Correlating and Troubleshooting

When a problem is discovered in the application infrastructure, you can drill down to find the root
cause. The investigation may involve looking at the short-term trends of specific metrics, defining
new metrics, or comparing different metrics to find correlations between behavior in different parts
of the application environment.
The Metric Browser displays the metrics and enables you to graph different metrics onto the same
panel so that you can compare different data that was gathered in the same timeframe.
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The built-in Correlation Analysis graph is similar to the basic metric graph, but it enables you to
assign two metrics to X and Y coordinates. By default it uses a scatter plot view. The scatter plot
view also calculates the Best Fit line, which uses the quadratic least squares algorithm to find the
best fit curve line.
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A built-in Scalability Analysis graph compares the CPU usage to the load (calls per minute) on the
application, business transaction, tier, or node level. This comparison may be more easily
understood in the graphs view shown here.
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For details about how to compare and correlate metrics see Scalability Analysis and Correlation
Analysis.
Using Metrics in External Systems

You may want to add metrics to external reports, dashboards or systems. AppDynamics helps you
do this in a variety of ways:
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Exporting and importing application configuration baselines: Metric baselines (not the metric
data) are included when you export AppDynamics application configuration data.
For details see Export and Import Business Application Configurations.
Exporting metrics as comma-separated values (CSV): The Metrics Browser has an option to
export metrics on the graph to a CSV file. For each metric you can specify the columns to
use, and you see a preview that you can also copy to the clipboard.
For details about how to export data see To Export Metrics Data.
Accessing metrics using the REST API: The REST API provides access to all performance
data gathered by the Controller. You can also use a POST request to create an event of
type "APPLICATION_DEPLOYMENT" in your managed environment.
For details about the REST API see Use the AppDynamics REST API.
Learn More

Detect Anomalies Using Dynamic Baselines
Monitor App Servers
See:
Monitor Java App Servers
Monitor CLRs
Monitor Hardware
Default Hardware Metrics
CPU Utilization
Memory Utilization
Disk I/O
Network I/O
Accessing Hardware Metrics
Adding Custom Metrics
Java
.NET
Learn More
Default Hardware Metrics

AppDynamics gathers information about the operating systems and machines in the monitored
environment using the machine agents. By default, when a machine agent is installed, the
following metrics are collected:
CPU activity
Memory usage
Disk reads and writes
Network traffic
The scope of the monitoring is a node associated with the machine agent. See Server Monitoring.
CPU Utilization

This trend displays average, minimum, and maximum values in percentage for CPU Busy Time for
the selected point in the graph.
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Memory Utilization

This trend displays average, minimum, and maximum values in KB for Memory Used for the
selected point in the graph.

Disk I/O

This trend displays average, minimum, and maximum values for data (KB) written/sec for the
selected point in the graph.

Network I/O

This trend displays average, minimum, and maximum values for outgoing data in KB/sec for the
selected point in the graph.

Accessing Hardware Metrics

You can view hardware metrics from the Hardware tab of the Node Dashboard if a machine agent
is installed on the machine that hosts the node.
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You can also view hardware metrics in the Metric Browser in the Hardware Resources branch of
a tier, as shown in this example.

Adding Custom Metrics
Java

You can modify the machine agent data collection metrics. See Modify Machine Agent Data
Collection Metrics.
You can add script-based custom monitors. See Build a Monitoring Extension Using Scripts.
You can send metrics to the Machine Agent using its HTTP listener. See Standalone Machine
Agent HTTP Listener.
For a more complete discussion of adding custom metrics, see Extensions and Integrations.
.NET

The embedded .NET machine agent does not support adding script-based custom monitors. To
use extensions such as custom monitors and HTTP listener in the .NET environment, install the
AppDynamics standalone Machine Agent, which is a Java application. See Configure Machine
Agents in a .NET Environment for details on how to download, install, and configure the
standalone Machine Agent in a .NET environment.
Learn More

Install the Standalone Machine Agent
Configure Machine Agents in a .NET Environment
Machine Agent Install and Admin FAQ
Metric Browser
Add Metrics Using Custom Monitors
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Determine Whether a Server is Down

If an application server agent is not reporting to the Controller, the App Agent Status in the App
Servers list displays a red icon with a downward-facing arrow and a status of zero.

Similarly, if a machine agent is not reporting to the Controller, the Machine Agent Status in the App
Servers list displays the same icon.
If the agent is not reporting, it is possible that the server is down, although here could be other
reasons why the agent is not reporting.
To investigate further, in the Metric Browser locate the individual node in question in the Agent
branch of the Application Infrastructure Performance tree. If the value of the Availability metric for
the application is zero, the app server is down. If the value of the Availability metric for the
machine is zero, the machine is down.
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Learn More

App Servers List
Metric Browser

Monitor Service Endpoints
Service Endpoints for Monitoring Specific Services
Understand Service Endpoints
Service Endpoint Metrics in the UI
Key Performance Indicators and Transaction Scorecard
Service Endpoints in the Metric Browser
Learn More
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Service Endpoints for Monitoring Specific Services

In complex, large-scale applications, some application services may span multiple tiers. If you own
an application service, you may need metrics on that specific service as opposed to metrics from
across an entire business transaction or entire tier. Service endpoints allow you to obtain a subset
of metrics and associated snapshots for your service so that you can focus on the information truly
of interest to you.
Using service endpoints, you can define a set of entry points into your specific service to create a
customized view in the AppDynamics UI that displays the key performance indicators, associated
snapshots, and metrics that affect only that service. You can understand the performance of your
service and quickly drill down to snapshots that affect your service, instead of sifting through
snapshots for the entire tier or business transaction.

Understand Service Endpoints

Service endpoints are similar to business transactions except that they report metrics only at the
entry point and do not track metrics for any downstream segments. Service endpoints are not
automatically detected like business transactions are detected; you must specify the entry points
for service endpoints. Service endpoints support the same entry point types as business
transactions and you configure them in a similar way.
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Snapshot information for the service endpoint refers back to the originating business transaction
snapshot that goes through service endpoint-defined entry points.
All normal metric operations of metrics are observed for metrics collected by the service
endpoint; this includes metrics registration and metric rollups for tiers, limits on number of metrics,
and other standard operations. Captured metrics for service endpoints are limited to entry point
metrics. Custom metrics are not supported on service endpoints.
Diagnostic sessions cannot be started on the service endpoints; however, you can create
diagnostic sessions on the originating business transaction.
Service endpoints are supported for the Java Agent and the .NET Agent.
Additional load on the system for service endpoints is negligible. For example, with 1000 agents,
additional metric traffic amounts to only 30K. Approximately three metrics are captured per service
endpoint and the agent has a default limit of 100 service endpoints. This limit is configurable using
the max-service-end-points-per-node node property.
Service Endpoint Metrics in the UI
Key Performance Indicators and Transaction Scorecard

1. On the left-hand navigation menu, click a Tier.
2. On the right-hand side of the Tier Flow Map, click Service Endpoints.

Key performance indicator metrics along with transaction scorecards display.
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The information displayed relates only to the service endpoints entry points defined for the
tier.
If the Service Endpoints tab does not display, it means that there are no endpoints
configured or that they are not reporting data.
3. Double-click a service endpoint name to see the Service Endpoints Transaction Snapshots.
4. Click the snapshot or double-click the Business Transaction, Tier, or Node links for
additional details. These details help you to troubleshoot problems with your service.

Service Endpoints in the Metric Browser

At a glance, you can see the performance of your service by looking at the service endpoints in the
Metric Browser.
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To configure service endpoints for your business application see Configure Service Endpoints.
Learn More

Configure Service Endpoints
Configure Business Transaction Detection
Monitor Service Endpoints for .NET

Monitor Background Tasks
Background Tasks
Separating Background Tasks from Business Transactions
Background Tasks in the UI
Enabling and Configuring Background Task Monitoring
Learn More
Background Tasks

A background task or a batch job is a scheduled program that runs without user intervention.
These programs automate tasks that are performed on a regular basis. Batch jobs that are
required to be processed on a regular basis are incorporated into batch schedules.
By default AppDynamics does not automatically discover most background tasks. In some cases
AppDynamics may discover a task and interpret it as a business transaction.
Separating Background Tasks from Business Transactions

In some environments AppDynamics will automatically discover a background task and initially
identify it as a business transaction. In this case you want to reclassify the task so that it is not
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included in the business transaction metrics.
AppDynamics lets you treat background tasks differently than transaction-based requests because
background tasks usually take more time to execute. Monitoring background tasks together with
the business transactions would skew the averages for response time for the tier and for the node
where these background tasks are executed. Therefore, AppDynamics recommends that you
monitor background tasks separately from business transactions.
Background tasks are not counted toward the average response time of the tier or the node.
Background Tasks in the UI

Although background tasks are monitored separately, they are displayed along with the other
business transactions in the Business Transactions List. They show the background task icon:
.
AppDynamics provides visibility into the key performance metrics and code level visibility for
background tasks. You can monitor background tasks in the following areas of the UI:
The Business Transactions List shows currently executing background tasks and their
statistics.
The Metric Browser shows the response time for each background task.
AppDynamics creates transaction snapshots of each execution of a background task.
However, if a particular job runs too frequently then AppDynamics may not capture all
details for each execution.
The tier and application level metrics are not collected for background tasks. On an application
dashboard, background tasks will not show any call details.
Enabling and Configuring Background Task Monitoring

When you know that there are background tasks in your application environment and you want to
monitor them, or to reclassify a business transaction as a background task, see Configure
Background Tasks.
Learn More

Configure Background Tasks
Transaction Snapshots
Configure Background Tasks
Enabling Automatic Discovery for Background Tasks
To enable discovery for a background task
using a common framework
Configuring Thresholds for Background Tasks
To configure thresholds for all background
tasks
To configure thresholds for an individual
background task
Re-configuring a Business Transaction as a
Background Task
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To re-configure a business transaction as a
background task
Learn More
Background Task
Configuration

For details about your
platform, see:
Configure Background
Tasks - Java
POCO Transaction as
a Background Task .NET
Configuring background tasks consists of two basic steps:
1. Enabling automatic discovery so that AppDynamics will detect the background process and
monitor it.
2. Configuring thresholds for what you consider to be slow, very slow, or stalled performance
behavior.
Sometimes AppDynamics will discover a background task and interpret it to be a business
transaction. You can instruct AppDynamics to configure a business transaction as a background
task.
Enabling Automatic Discovery for Background Tasks

Automatic discovery of background tasks is disabled by default. When you know that there are
background tasks in your application environment and you want to monitor them, first enable
automatic discovery so that AppDynamics will detect the task.
AppDynamics provides preconfigured support for some common frameworks. If your application is
not using one of the default frameworks you can create a custom match rule.
To enable discovery for a background task using a common framework

1.
2.
3.
4.
5.

In the left navigation pane, click Configure -> Instrumentation.
On the Transaction Detection tab, select the tier for which you want to enable monitoring.
Click Use Custom Configuration for this Tier.
Scroll down to the Custom Match Rules pane.
Do one of the following:
If you are using a pre-configured framework, select the row of the framework and click the
pencil icon, or double-click on the row to open the Business Transaction Match Rule
window. By default the values are populated with rule name and the class and method
names for the particular framework. Verify that those are the correct names for your
environment, or
If you are using a custom framework, select the match criteria and enter the Class Name
and Method Name.
The Background Task check box should be already checked.

6.
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6. Check Enabled.
7. Click Save.
The custom match rule for the background task will take effect and the background task will
display in the Business Transactions List.
Once you enable discovery, every background task is identified based on following attributes:
Implementation class name
Parameter to the execution method name
Configuring Thresholds for Background Tasks

AppDynamics recommends that you configure a threshold that is suitable for the background task
in your environment.
AppDynamics also recommends that you use static thresholds for slow and very slow background
tasks, if they have infrequent load patterns such as once every night. This is because the dynamic
moving average-based thresholds are more suitable for production load scenarios and will
automatically classify a background process as slow or very slow.
To configure thresholds for all background tasks

1.
2.
3.
4.

In the left navigation pane click Configure -> Slow Transaction Thresholds.
Click the Background Tasks Thresholds tab.
Set the thresholds for all background tasks.
If you want these thresholds applied to existing background tasks, check Apply to all Existing
Background Task Business Transactions.
5. Click Save Default Background Task Thresholds.
All new background tasks will use the thresholds that are configured here.
You can override default thresholds for an individual background tasks by configuring individual
task thresholds.
To configure thresholds for an individual background task

1. In the Business Transactions List, right-click on the background task and select Configure
Thresholds. AppDynamics displays the threshold settings for that background task.
2. Update the thresholds.
3. Save the changes.
Re-configuring a Business Transaction as a Background Task

You can re-configure an auto-discovered business transaction as a background task.
To re-configure a business transaction as a background task

1. In the left navigation pane click Business Transactions.
2. In the Business Transactions List select the business transaction that you want to mark as a
background task.
3. Right-click on the selected business transaction and select Set as Background Task.
4. Verify that Set as Background Task is selected in the dialog.
5.
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5. Click OK.
If you discover that a background task is better represented as a regular business transaction,
repeat steps 1 and 2 then right-click and select Set as User Transaction.
Learn More

Configure Background Tasks - Java
POCO Transaction as a Background Task - .NET

Configure Service Endpoints
Prerequisite for Configuring Service Endpoints
To configure service endpoints
Learn More
See Monitor Service Endpoints.
Prerequisite for Configuring Service Endpoints

To configure service endpoints your user account must have "Configure Service Endpoints"
permissions for the business application. See To Configure the Default Application Permissions.
To configure service endpoints

1. Determine which object you want to instrument.
You can instrument service endpoints just as you would business transactions, on the same
objects, using the same matching and exclude rules, etc.
2. From the left-hand navigation menu, click Configure -> Instrumentation -> <Tier> ->
Service Endpoints, where <Tier> is the tier on which the service runs.
Or
From the left-hand navigation menu, click the tier on which the service runs, and then click S
ervice Endpoints -> Configure.

3. Select the tier where you want to insert the service endpoint.
4. On the Service Endpoints Definition panel, click the +, and then in the dialog that appears,
select the Entry Point Type.
5. Define the service endpoint as you would a business transaction.
For information on defining business transactions, see Configure Business Transaction
Detection.
Learn More
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Monitor Service Endpoints
Configure Business Transaction Detection
Monitor Service Endpoints for .NET

Alert and Respond
Alerts let you know when problems exist and
help you anticipate problems that might be
developing. Responses let you automate
preventative actions to address those problems
before they cause a severe slowdown or outage.
Think of alert and respond as the automation of
your runbooks.
The alert and respond system is made up of
three parts:
Health rules: Use these rules to define key
performance metric thresholds for your
application, across the stack.
Policies: Use policies to link health rule
violations, and other performance-based
events, with appropriate actions.
Actions: Use actions to specify what
should be done in a wide variety of
situations, including sending alerts and
performing diagnostic and remedial tasks.
Out of the box, AppDynamics recognizes some
broad-based health issues commonly
experienced by applications, such as "Business
Transaction response time is much higher than
normal" or "Memory utilization is too high". These
are configured as default health rules, which
define how high is "much higher than normal" or
"too high". Use policies to attach these rules to
alerts (whom to notify) and responses (what to
do) when these problems exist. You can use
these rules "as is" or modify them for your
environment. See Default Health Rules.
In addition to the broad-based rules, you can
customize precise automatic alerts and
responses for very narrowly circumscribed
situations. This lets you finely tune your system,
ensuring that the right alert goes to the right
person, the right action is taken for the right
problem on the right cluster or server.
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Notifications
Alerts
For example:
You do not want to alert your team if performance in a few clusters is lagging, but if more
than 20% of the clusters are unhealthy, or if servers in particular clusters or servers that
meet certain criteria are performing poorly, you do want to trigger an alert. You can define
health rules that apply to specific tiers or nodes. If these rules violate the system knows
exactly which entity is experiencing problems and therefore whom to alert. This rule affects
only one node: the order processing server.

Performance is deteriorating in one business transaction so you want to view snapshots for
that one transaction. You create a diagnostic action.
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You want to send an alert whenever an app agent stops reporting to the Controller. Create a
node health rule based on the value of the Availability metric reported by the agent. If
Availability is less than 1, the agent is not reporting.

You have a large operation with several development teams, each responsible for a different
service. You create a health rule for one service and then copy it. Then you create different
polices in which you can pair each copy of the health rule to an alert addressed to the
appropriate team.
You have an application that performs well for normal load. However, peak loads can cause
the application to slow. During peak load, AppDynamics not only detects the connection pool
contention, but also allows you to create a remediation script that can automate increasing
or decreasing the size of connection pool. You can require human approval to run this script
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or simply configure it to execute automatically when it is triggered. Create a Runbook and
associate it with a policy so that it will fire when the connection pool is exhausted.
To learn more about using policies, health rules, and actions:
See these topics:
Watch this walk through the process.
Notifications
Actions

Policies
Policy Structure
Policy Triggers
Policy Actions
Policy List
Learn More
Policies let you anticipate problems and take
actions to address those problems before they
cause a severe slowdown or outage.
Policies provide a mechanism for automating
monitoring and problem remediation. Instead of
continually scanning metrics and events for the
many conditions that could suggest problems,
you can proactively define the events that are of
greatest concern in keeping your applications
running smoothly and then create policies that
specify actions to start automatically when those
events occur.

Health Rules and Policies
from AppDynamics 6 minutes
Policy Structure
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A policy connects two things:
evaluated event triggers
actions to be taken in response to those triggers

Policy Triggers

Policy triggers are events that cause the policy to fire. The events can be health-rule violation
events or other types of events, such as hitting a slow transaction threshold or surpassing a
resource pool limit. See Health Rules, Troubleshoot Health Rule Violations and Events.
The triggering events can be broadly defined as affecting any object in the application or very
narrowly defined as affecting only specific objects. You can create a policy that fires when an
event involving all the tiers in the application occurs, or one involving only specific tiers. You can
create a policy that fires on events affecting only certain nodes, or only certain business
transactions or certain errors. You can very finely tune policies for different entities and situations.
For example, this very broadly-defined policy would fire whenever a resource pool limit (> 80%
usage of EJB pools, connection pools, and/or thread pools) is reached for any object in the
application.
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On the other hand, this narrowly-defined JVMViolationInWebTier policy fires only when existing
health rules on JVM heap utilization or JVM garbage collection time are violated.
Here the triggering events for this policy are configured:

and here the affected object is limited to a specific tier - the ECommerce Server.
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A policy is triggered when at least one of the specified triggering events occurs on at least one of
the specified objects.
Policy Actions

The second part of creating a policy is assigning one or more actions to be automatically taken in
response to the policy trigger.
For example, for the resource pool violation, you want to take a thread dump and then run a script
to increase the pool size.

Other common actions include restarting an application server if it crashes, purging a message
queue that is blocked, or triggering the collection of transaction snapshots. You can also trigger a
custom action to invoke third party systems. See Build an Alerting Extension for information about
custom actions.
See Actions for more information about the different types of actions.
See Actions Limits for information about limits on the number of actions that the Controller will
process.
Because the definition of health rules is separate from the definition of actions, and both health
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rules and actions can be very precisely defined, you can take different actions for breaching the
same thresholds based on context, for example, which tier or node the violation occurred in.
Policy List

To access the list of policies in an application, select Alert & Respond ->Policies.
The policy list lists all the policies created for your application, with its triggers and actions taken.
You can view and edit an action assigned to a specific policy by clicking the action in the policy list.

Learn More

Actions
Configure Policies
Custom Actions
See Detailed Data Using Diagnostic Sessions
Events
Health Rules
Workflow Overview
Build an Alerting Extension
Configure Policies
Using the Policy Wizard
To access the Policy Wizard
Configuring the Policy Trigger
To configure policy triggers
Configuring the Policy Actions
To configure policy actions
Learn More
Using the Policy Wizard

The Policy Wizard contains two panels:
Trigger: Sets the policy name, enabled status, events that trigger the policy, entities that are
affected by the policy
Actions: Sets the actions to take when the policy is triggered.
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To access the Policy Wizard

1. Click Alert & Respond -> Policies in the left navigation pane.
2. Do one of the following:
To create a new policy, click the plus icon.
To edit an existing policy, select the policy and click the pencil icon.
To remove an existing policy, select the policy and click the minus icon.
Configuring the Policy Trigger

The policy trigger panel defines the events and objects generating the events that cause the policy
to fire and invoke its actions.
For policy triggers that depend on health violation events, the health rules must be created before
you can create a policy on them. See Health Rules and Troubleshoot Health Rule Violations.
To configure policy triggers

1. Click the plus icon to create a new policy or select an existing policy and click the pencil icon.
The Policy Wizard opens.
2. Enter a name for the policy in the Name field.
3. To enable the policy, check the Enabled check box. To disable the policy, clear the Enabled
check box.
4. On the left, click Trigger if it is not already selected.
5. Check the type of event that should trigger the policy. You may need to click the arrow to
expose specific events within an event category.
If you check at least one health rule violation event, you can choose whether any (that is, all)
health rule violations or only specific health rule violations will trigger the policy.

To designate specific health rule violations to trigger the policy, select These Health Rules, click
the "+" icon, and then choose the health rules from the embedded health rule browser.
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To designate specific custom events to trigger the policy, use the Custom Events panel in the
lower right corner. Click the "+" icon. The Add Custom Event Filter pops up.

Define the custom event type and, if desired, particular properties on that event, as key/value
pairs. Selecting the match value All indicates a logical AND. Selecting the match value Any
indicates a logical OR. Click Save.
In the case of Any, at least one property must exist and match. In the case of All, all properties
must exist and match.
6. When you have finished selecting the events that trigger the policy, click "any object" to
configure which objects to monitor for those events in order to trigger the policy.

If you select Any Objects the policy will be triggered by the configured events when they occur on
any object in your application.
To restrict the policy to specific objects, select Any of these specified objects and then choose
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the objects.
For example, the following policy fires when selected events occur on the the ECommerce Server
tier. You can similarly restrict the objects to specific tiers, business transactions, and so forth.

If you wish to have policies triggered by Health Rule Violation Events, you should leave the
selection at Any object. Selecting Any of these specified objects means that only non-health
rule events - slow transactions, errors, and so forth - will trigger the policy.
7. Click Save to save the policy configuration.
Configuring the Policy Actions

The policy actions panel defines the actions that the policy automatically initiates when the trigger
causes the policy to fire.
The actions must be created before you can create a policy that fires them. See Actions and the
documentation for individual types of actions (notification actions, remediation actions, etc.) for
information on creating an action.
To configure policy actions

1. If you have not already done so, open the policy wizard and edit the policy to which you want to
add actions. See To access the Policy Wizard.
2. On the left, click Actions if it is not already selected.
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3. Click "+" icon. The list of defined actions appears.

You can filter the list by checking the check boxes for the types of actions you want to see.
4. In the list of actions, select the action that you want this policy to execute and click Select.
If you do not see an appropriate action for your needs, click Create Action to create an
action. For more information on creating actions, see Actions. After you have created the
action select it here to to assign it to the policy that you are configuring.
5. Click Save in the Policy Wizard.
Learn More

Policies
Events
Health Rules
Troubleshoot Health Rule Violations
Actions
Notification Actions
Diagnostic Actions
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Remediation Actions (Java only)
Auto-Scaling Actions
Custom Actions
Create a Workflow and Workflow Steps
Workflow Overview

Health Rules
Understanding Health Rules
Understanding the Health Rule Wizard
Heath Rule Types
Health Rule Schedules
Health Rule Enabled Schedule
Health Rule Evaluation
Window
Health Rule Wait Time After
Violation
Health Rule Entities
Entities Affected by a Health
Rule
Health Rule Evaluation Scope
Health Rule Conditions
Critical and Warning
Conditions
Default Health Rules
Preparing to Set Up Health Rules
Health Rule Management
Suggested Metrics for Additional Health
Rules
Additional Metrics for Business
Transactions
Additional Metrics for Tiers
Additional Metrics for Nodes
Additional Metrics for Backends
Learn More
Understanding Health Rules

AppDynamics collects a wide range of metric information covering your entire application. Some of
those metrics are key indicators of the overall state of the system. Being able to proactively track
the status of those indicators gives you a window into the health of your system and can inform
you when various important entities—nodes, business transactions, databases, etc.—may be in
trouble.
Health rules allow you to define acceptable values for key metrics
associated with specific entities, and to monitor those essential metrics
automatically. Should metric values exceed the ranges you have
specified, the health rule is said to violate, and a health rule violation
event occurs and is surfaced in the controller user interface.
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The violation event can also be used to trigger a policy, which can initiate pre-defined actions to
respond to the situation, from sending alerting emails to running remedial scripts. To understand
how to create policies and actions, see Policies and Actions.
The simplest way to create health rules is to use the basic health rule wizard. The wizard groups
commonly used system entities and related metrics to ease the process of setting up your
particular system's health rules. Should you need to create health rules that connect less
commonly used entities and/or metrics, you can use one of the custom methods in the wizard, the
Custom Health Rule Types or the Hybrid methods.
For specifics on using the health rule wizard, see Configure Health Rules.
Understanding the Health Rule Wizard

To understand how the health rule wizard works, you need to understand four basic concepts:
How the wizard groups entities and metrics
How the wizard schedules health rule evaluations
How the wizard defines which entities are affected
How the wizard defines the metric conditions that are to be evaluated on those entities
Heath Rule Types

To simplify creating health rules, the basic health rule wizard groups entities, like nodes or
business transactions, with metrics that are commonly associated with those entities, into health
rule types. Doing so allows the wizard to automatically show you relevant information during the
health rule creation process.
If your needs are not covered by these types, you can use one of the custom methods in
the wizard, Custom Health Rule Types or the Hybrid methods.
The health rule types are:
Transaction Performance
Overall Application Performance: groups metrics related to load, response time,
slow calls, stalls, with applications
Business Transaction Performance: groups metrics related to load, response time,
slow calls, stalls, etc. with business transactions
Error Rates: groups metrics related to exceptions, return codes, and other errors with
applications or tiers
Node Health
Node Health-Hardware, JVM, CLR: groups metrics like CPU and heap usage, disk
I/O, etc. with nodes
Node Health-Transaction Performance: groups metrics related to load, response
time, slow calls, stalls, etc. with nodes
Node Health-JMX: groups metrics related to connection pools, thread pools, etc with
nodes
Databases & Remote Services: groups metrics related to response time, load, or errors
with databases and other backends
End User Experience
Pages: groups metrics like DOM building time, JavaScript errors, etc. with the
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performance of application pages for the end user
Iframes: groups metrics like first byte time, requests per minute, etc. with the
performance of iframes for the end user
Ajax Requests: groups metrics like Ajax callback execution time, errors per minute,
etc. with the performance of Ajax requests for the end user
Information Points: groups metrics like response time, load, or errors with information
points
If you select one of these health rule types, AppDynamics automatically presents you with a list of
the commonly associated metrics, simplifying the health rule creation process by giving you a
manageable number of relevant options.
If the types do not cover the entities and/or metrics you wish to use, you can use one of the
custom options:
Select the Custom health rule type, which allows you to create a rule based on any metric
AppDynamics collects on any single entity that AppDynamics monitors
Use the Hybrid method, which allows you to create a rule based on any metric
AppDynamics collects across multiple entities. If you wish to create health rules based on
custom metrics that cover multiple entities, see Using the Hybrid Method.
Health Rule Schedules

The metrics associated with a health rule are evaluated according to a schedule that you control.
You can configure:
when a health rule is in effect
which data set should be used, based on time
what special rules should be in place during a violation event
Health Rule Enabled Schedule

By default, health rules are always enabled. But you can also configure your own schedules during
which the rule is in effect.
Built-in schedules are:
End of business hour
Weekday lunch
Weekday mornings
Weekdays
Weekends
You can also create a new schedule based on UNIX cron expressions using your custom values.
Health Rule Evaluation Window

Different kinds of metrics may provide better results using different sets of data. You can manage
how much data AppDynamics uses when it evaluates a particular health rule by setting the data
collection time period. The default value is 30 minutes.
For metrics based on an average calculation, such as average response time, AppDynamics
averages the response time over the evaluation window. A five minute window means that the last
five minutes of data is used to evaluate if the health rule is in range. For metrics based on a sum
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calculation, such as number of calls, AppDynamics uses the total number of calls counted during
the evaluation window. And so forth. Use values that work best with the kinds of metrics you are
interested in.
Health Rule Wait Time After Violation

The health rule wait time setting lets you control how often an action is taken while the conditions
found to violate a health rule continue to violate that health rule.
When the Controller first detects that a health rule's critical or warning condition has been violated,
a health rule violation is opened with the corresponding status of Critical or Warning. An Open
Critical or Open Warning event is generated to trigger any actions registered on policies that
match the health rule and event.
The Controller continues to evaluate the health rule every minute.
If the Controller continues to detect the same health rule critical or warning condition violation, the
health rule violation remains open with the same violation status. A corresponding Continues
Critical or Continues Warning event may be generated to trigger any actions registered on policies
that match the health rule and event.
The health rule's "Wait Time after Violation" setting is used to throttle how often these Continues
events are generated for continuing health rule violations. For example, every minute? Or every 60
minutes? The default is every 30 minutes.
In the event that the Controller is unable to evaluate the rule - for example, if a node simply stops
reporting - the Evaluation Status of the health rule is marked as a grey question mark or
"Unknown". The current violation event remains open until the "Wait Time after Violation" period
has elapsed, at which point the violation event is closed and a new event is triggered, causing the
Health status itself of the rule to display as "Unknown".
Note that the values presented in the Health Rules Violations page for violating health rule
conditions are only updated when a health rule violation event is triggered.
To use Continues Critical and Continues Warning events, adjust the default Wait Time after
Violation value to the desired frequency on a health rule. Then configure a policy matching that
health rule with the "Health Rule Violation Continues - Warning" and/or "Health Rule Violation
Continues - Critical" events selected in the "Health Rule Violation Events" section of the policy's
settings.
Health Rule Entities

A health rule can evaluate metrics associated with an entire application or a very limited set of
entities. For example, you can create business transaction performance health rules that evaluate
certain metrics for all business transactions in the application or node health rules that cover all the
nodes in the application or all the nodes in specified tiers. The default health rules are in this
category.
You can also create health rules that are very narrowly applied to a limited set of entities in the
application, or even a single entity such as a node or a JMX object or an error. For example, you
can create a JMX health rule that evaluates the initial pool size and number of active connections
for specific connection pools in nodes that are share certain system properties.
The health rule wizard lets you specify precisely which entities the health rule affects, enabling the
creation of very specific health rules. For example, for a business transaction you can limit the tiers
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that the health rule applies to or specific business transactions by name or by names that match
certain criteria.

For node health rules, you can specify that a health rule applies only to nodes that meet certain
criteria:

Entities Affected by a Health Rule

If you are using the basic health rule wizard and health rule types, AppDynamics provides a list of
commonly used sets of entities on which metrics can be evaluated.
For an Overall Application Performance health rule type, the health rule applies the entire
application, regardless of business transaction, tier, or node.
For a Business Transaction Performance health rule type, you can apply the health rule to:
All Business Transactions in the application
All Business Transactions within tiers that you select
Individual Business Transactions that you select
Business Transactions with names that have patterns matching criteria that you specify
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(such as all Business Transactions with names that start with "INV")
For an Error Rates health rule type, you can apply the health rule to:
All Errors in the application
Specific error types that you select
Errors with the specified tiers
Errors with names that have patterns matching criteria that you specify
For a Node Health – Transaction Performance or Node Health – Hardware, JVM, CLR health rule
types, you can apply the health rule to:
All tiers in the application
Individual tiers that you specify
All nodes in the application
Nodes types, such as Java nodes, PHP nodes, etc.
Nodes within specified tiers
Individual nodes that you specify
Nodes with names, meta-data, environment variables or JVM system environment
properties with matching criteria that you specify
For a Node Health – JMX health rule type, you select
the JMX objects on which the health rule is evaluated
and apply the health rule to:
All nodes in the application
Nodes within tiers that you specify
Individual nodes that you specify
Nodes with names matching criteria that you specify
For a Databases & Remote Services health rule type, you can apply the health rule to:
All databases and remote services in the application
Individual databases and remote services that you specify
Databases and remote services with name matching criteria that you specify
For End User Experience – Pages, iframes, and Ajax Requests health rule types, you can apply
the health rule to:
All such entities
Entities that you specify
Entities with names matching criteria that you specify
For Information Points health rule types, you can apply the health rule to:
All information points
Information points that you specify
Information points with names matching criteria that you specify
Using the Custom health rule type limits you to a single entity hard-coded in the metrics
themselves. If you want to use custom metrics but associate them with multiple entities, use the
hybrid method. See Using the Hybrid Method.
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Health Rule Evaluation Scope

The health rule evaluation scope defines how many nodes in the affected entities must violate the
condition before the health rule is considered violated.
Evaluation scope applies only to business transaction performance type health rules and
node health health rules in which the affected entities are defined at the tier level.
For example, you may have a critical condition in which the condition is unacceptable for any
node, or you may want to trigger the violation only if the condition is true for 50% or more of the
nodes in a tier.
Options for this evaluation scope are:
any node – If any node exceeds the threshold(s), the violation fires.
percentage of the nodes – If x% of the nodes exceed the threshold(s), the violation fires.
number of nodes – If x nodes exceed the threshold(s), the violation fires.
the tier average – Evaluation is performed on the tier average instead of the individual
nodes.
Health Rule Conditions

You define the acceptable range for a metric by establishing health rule conditions. A health rule
condition defines what metric levels constitute a Warning status and what metric levels constitute a
Critical status.
A condition consists of a Boolean statement that compares the current state of a metric against
one or more static or dynamic thresholds based on a selected baseline. If the condition is true, the
health rule violates. The rules for evaluating a condition using multiple thresholds depend on
configuration.
Static thresholds are straightforward. For example, is a business transaction's average response
time greater than 200 ms?
Dynamic thresholds are based on a percentage in relation to, or a standard deviation from, a
baseline built on a rolled-up baseline trend pattern. For example, a daily trend baseline rolls up
values for a particular hour of the day during the last thirty days, whereas a weekly trend baseline
rolls up values for a particular hour of the day, for a particular day of the week, for the last 90 days.
For more information about baselines, see Detect Anomalies Using Dynamic Baselines.
You can define a threshold for a health rule based on a single metric value or on a mathematical
expression built from multiple metric values.
The following are typical conditions:
IF the value of the Average Response Time is greater than the default baseline by 3 X the
Baseline Standard Deviation . . .
IF the count of the Errors Per Minute is greater than 1000 . . .
IF the number of MB of Free Memory is less than 2 X the Default Baseline . . .
IF the value of Errors per Minute/Calls per Minute over the last 15 days > 0.2 . . .
The last example combines two metrics in a single condition. You can use the expression builder
in the health rules wizard to create conditions based on a complex expression comprising multiple
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interdependent metrics
Often a condition consists of multiple statements that evaluate multiple metrics. A health rule is
violated either when one of its condition evaluates to true or when all of its conditions evaluate to
true, depending on how it is configured. You can correlate multiple metrics to focus the health
rules for your environment.
For example, a health rule that measures response time (average response time greater than
some baseline value) makes more business sense if it is correlated with the application load (for
example, 50 concurrent users or 10,000 calls per minute) on the system. You may not want to use
the response time condition alone to trigger a policy that initiates a remedial action if the load is
low, even if the response time threshold is reached. To configure this correlation, the first part of
the condition would evaluate the actual performance measurement and the second part would
ensure that the health rule is violated only when there is sufficient load.

Critical and Warning Conditions

Conditions are classified as either critical or warning conditions.
Critical conditions are evaluated before warning conditions. If you have defined a critical condition
and a warning condition in the same health rule, the warning condition is evaluated only if the
critical condition is not true.
The configuration procedures for critical and warning conditions are identical, but you configure
these two types of conditions in separate panels. You can copy a critical condition configuration to
a warning configuration and vice-versa and then adjust the metrics in the copy to differentiate
them. For example, in the Critical Condition panel you can create a critical condition based on the
rule:
IF the Average Response Time is greater than 1000
Then from the Warning Condition panel, copy that condition and edit it to be:
IF the Average Response Time is greater than 500
As performance changes, a health rule violation can be upgraded from warning to critical if
performance deteriorates to the higher threshold or downgraded from critical to warning if
performance improves to the warning threshold.
Default Health Rules

Out of the box, AppDynamics provides a default set of health rules:
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Health Rule Name

Health Rule Type

Business Transaction response time is much
higher than normal

Business Transaction Performance

Business Transaction error rate is much higher
than normal

Business Transaction Performance

CPU utilization is too high

Node Health – Hardware, JVM, CLR
Performance

Memory utilization is too high

Node Health – Hardware, JVM, CLR
Performance

JVM Memory Heap is too high

Node Health – Hardware, JVM, CLR
Performance

JVM Garbage Collection Time is too high

Node Health – Hardware, JVM, CLR
Performance

CLR Garbage Collection Time is too high

Node Health – Hardware, JVM, CLR
Performance

If any of these predefined health rules are violated, the affected items are marked in the UI as
yellow-orange, if it is a Warning violation and red, if it is a Critical violation.
In many cases the default health rules may be the only health rules that you need. If the conditions
are not configured appropriately for your application, you can edit them. You can also disable the
default health rules.
Preparing to Set Up Health Rules

AppDynamics recommends the following process to set up health rules for your application:
1. Identify the key metrics on the key entities that you need to monitor for your application. See
Suggested Metrics for Additional Health Rules for some common choices.
These metrics should be representative of the overall health of your application.
2. Click Alert & Respond -> Health Rules to examine the default health rules that are provided by
AppDynamics.
Compare your list of metrics with the metrics configured in these rules.
If the default health rules cover all the key metrics you need, determine whether the
pre-configured conditions are applicable to your environment. If necessary, modify the
conditions for your needs.
You can also view the list of affected entities for each of the default health rules and
modify the entities.
3. If the health rules do not cover all your needs or if you need very finely-applied health rules to
cover specific use cases, create new health rules.
First, identify the type of the health rule that you want to create. See Health Rule Types.
Then decide which entities should be affected by the new rule. See Entities Affected by a
Health Rule.
Then define the conditions to monitor.
4.
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4. Create schedules for health rules, if needed.
In some situations a health rules is more useful if it runs at a particular time. See Health Rule
Schedules.
5. If desired, configure policies and actions that should come into play when health rules are
violated. See Policies and Actions.
Health Rule Management

To view current health rules in an application, including the default health rules, and to access the
health rule wizard, click Alert & Respond -> Health Rules.
Current health rules are listed in the left panel. If you click one of these rules, a list appears in the
right panel showing what entities this selected health rule affects and what the status of the latest
evaluation is. You can also select the Evaluation Events tab to see a detailed list of evaluation
events.
In the left panel you can directly delete or duplicate a health rule. From here you can also access
the health rule wizard to add a new rule or edit an existing one.
To delete an existing health rule:
1. Select the health rule in the left panel.
2. Click the minus icon.
The health rule is removed.
To duplicate an existing health rule:
1. Select the health rule in the left panel.
2. Click the copy icon.
The health rule is duplicated under the name you assign.
To edit an existing health rule:
1. Select the health rule in the left panel.
2. Click the pencil icon.
The health rule wizard appears, with the rule's current values configured. You can modify these
values in the wizard.
To create a new health rule:
1. Click the plus icon.
2. The health rule wizard appears with some default values configured. You define the health rule
in the wizard.
See Configure Health Rules for details on using the health rule wizard.
Suggested Metrics for Additional Health Rules

The following are suggested metrics you might want to monitor with health rules, based on what
many customers have found useful.
Additional Metrics for Business Transactions
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Calls Per Minute
Slow Call Rate
Stalls
Additional Metrics for Tiers

Average Response Time
Calls Per Minute
Error Rate
Slow Call Rate
Stalls
Additional Metrics for Nodes

Some of these metrics might apply only to certain types of nodes, such as those running JVMs.
Availability
CPU Utilization
Memory & Heap Utilization
GC Time Spent
Thread Pool – Utilization Rate
Thread Pool - Average Wait Time
Thread Pool – Queue Size
Connection Pool – Utilization Rate
Connection Pool – Wait Time to Acquire a Connection
Thread Contention
Additional Metrics for Backends

Average Response Time
Calls Per Minute
Error Rate
Learn More

Notification Actions
Configure Health Rules
Configure Baselines
Events
Policies
Actions
Configure Health Rules
Accessing the Health Rule Wizard
The Structure of the Health Rule Wizard
Using the Basic Health Rules Wizard
Configure Generic Heath Rule Settings for the Basic Health Rule Wizard
To Create a New Health Rule Schedule
Configure Affected Entities for the Basic Health Rules Wizard
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Configure Health Rule Conditions for the Basic Health Rules Wizard
To Create a Condition
To Configure a Condition Component
To Remove a Condition Component
To Build an Expression
Using the Custom Health Rule Types Method
Using the Hybrid Method - Custom Health Rules for Multiple Entities
Additional Considerations
Learn More
This topic describes the detailed steps for configuring health rules using the health rule wizard.
Accessing the Health Rule Wizard

Click Alert & Respond->Health Rules.
1. To edit an existing health rule, in the left panel of the health rule list, select the health rule
and click the pencil icon.
2. To create a new health rule, click the plus icon.
The Structure of the Health Rule Wizard

The health rule wizard contains four panels:
Overview: Sets the health rule name, enabled status, health rule type, health rule enabled
period, and health rule evaluation time.
Affects: Sets the entities evaluated by the health rule. The options presented vary according
to the health rule type set in the Overview panel.
Critical Condition: Sets the conditions, whether all or any of the conditions need to be true
for a health rule violation to exist, and the evaluation scope (BT and node health policies
defined at the tier level only); it also includes an expression builder to create complex
expressions containing multiple metrics.
Warning Condition: Settings are identical to Critical Condition, but configured separately.
You can navigate among these panels using the Back and Next buttons at the bottom of each
panel or by clicking their entries in the left panel of the wizard. You should configure the panels in
order, because the configuration of the health rule type in the Overview panel determines the
available affected entities in the Affects panel as well as the available metrics in the Condition
panels.
The basic health rule wizard uses some short cuts to define the most commonly use health rules.
If you need to set up rules that are outside of that set you should use the Custom Health Rule
Types method or the Hybrid method.
Using the Basic Health Rules Wizard

Most of the time you should use the basic health rules wizard to set up your health rules.
Configure Generic Heath Rule Settings for the Basic Health Rule Wizard

You configure generic settings for your health rules in the Overview panel.
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1.Set a name. If a name already exists, you can change it if you like.
2. If you want the health rule in an enabled state (the default), check Enabled. Clear to disable.
3. Select a health rule type by clicking on the name in the list.
This setting affects metrics offered for configuration in subsequent panels in the basic wizard,
so you must select a health rule type before continuing to other panels. If none of the
predefined health rule types are applicable for your needs, you need to use the Custom
method or the Hybrid method.

4. If the health rule is always (24/7) enabled, check the Always check box.

If the health rule is enabled only at certain times, clear the Always check box and either:
Select a predefined time interval from the drop-down menu.
or
Click Create New Schedule.
The Create Schedule window opens. See To Create a New Health Rule Schedule.
The time is the time at the site of the controller, not the app agent. For example, if
the enabled time is set to 5pm-6pm, Mon-Fri and the controller is in San Francisco
but the app agent is in Dubai, the health rule engine uses San Francisco time.
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5. Click the dropdown menu Use the last <> minutes of data and select a value between 1 and
360 minutes for the evaluation window. This is the amount of recent data to use to determine
whether a health rule violation exists. This value applies to both critical and warning conditions.
See Health Rule Evaluation Window.
6. In the Wait Time after Violation section, enter the number of minutes to wait before evaluating
the rule again for the same affected entity in which the violation occurred. See Health Rule Wait
Time After Violation.
7. Click Save.
8. Click Next.
To Create a New Health Rule Schedule

1. In the Overview window of the Health Wizard, clear the Always check box if it is checked.
2. Click Create New Schedule.
2. Enter a name for the schedule.
3. Enter an optional description of the schedule.
4. Enter the start and end times for the schedule as cron expressions. See http://www.quartz-sche
duler.org/documentation/quartz-2.1.x/tutorials/crontrigger for details about and examples of cron
syntax.
5. Click Next.
Configure Affected Entities for the Basic Health Rules Wizard

The Affects panel lets you define which thing your health rule affects. These things are called entiti
es. For example, a business transaction, a node or set of nodes, or an information point are all
entities. The choices you are offered depends on the health rule type you chose in the Overview
panel. In this case, the health rule type selected affects Tiers or Nodes.

1. Use the dropdown menu to select the the entities affected by this health rule.
The entity affected and the choices presented in the menu depend on the health rule type
configured in the Overview window.
See Entities Affected by a Health Rule for information about the types of entities that can be
affected by the various health rule types.
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2. If you select entities based on matching criteria, specify the matching criteria.
3. If you are configuring a JMX health rule, select the JMX objects that the health rule is evaluated
on.
4. Click Next.

Configure Health Rule Conditions for the Basic Health
Rules Wizard
The high-level process for configuring conditions is:
1. Determine the number and kind of metrics the health rule should evaluate. For each
performance metric you want to use, create a condition.
You can use a single condition component or multiple condition components for a single
condition state.
You can use values based on complex mathematical expressions.
2. Decide whether the health rule is violated if all of the tests are true or if any single test is true.
3. For business transaction performance health rules and node health rule types that specify
affected entities at the tier level, decide how many of the nodes must be violating the health rule to
produce a violation event. See Health Rule Evaluation Scope.
4. To configure a critical condition use the Critical Condition window. To configure a warning
condition use the Warning Condition window.
The configuration processes for critical and warning conditions are identical.
You can copy the settings between Critical and Warning condition panels and just edit the
fields you desire. For example, if you have already defined a critical condition and you want
to create a warning condition that is similar, in the Warning Condition window click Copy
from Critical Condition to populate the fields with settings from the Critical condition.
To Create a Condition

1. In the Critical Condition or Warning Condition window, click + Add Condition to add a new
condition component.
The row defining the component opens. See To Configure a Condition Component. Continue to
add components to the condition as needed.
2. From the drop-down menu above the components, select All if all of the components must
evaluate to true to constitute violation of the rule. Select Any if a health rule violation exists if any s
ingle component is true.
3. For health rules based on the following health rule types:
business transaction
node health-hardware
node health-transaction performance
you must specify evaluation scope.
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If the Health Rule will violate if the conditions above evaluate to true section is visible, click
the appropriate radio button to set the evaluation scope.
If you select percentage of nodes, enter the percentage. If you select number of nodes, enter the
absolute number of nodes.
To Configure a Condition Component

1. In the first field of the condition row, name the condition.
This name is used in the generated notification text and in the AppDynamics console to
identify the violation.
2. To select the metric on which the condition is based, do one of the following:
To specify a simple metric, click the metric icon to open a small metric browser.
The browser display metrics appropriate to the health rule type. Select the metric to monitor
and click Select Metric.
The selected metric appears in the configuration.
or
To build an expression using multiple metric values, click the gear icon at the end of the row
and select Use a mathematical expression of 2 or more metric values.
This opens the mathematical expression builder where you can construct the expression to
use as the metric. See To Build an Expression.
3. From the Value drop-down menu before the metric, select the qualifier to apply to the metric
from the following options:
Qualifier Type
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Minimum

The minimum value reported across the
configured evaluation time length. Not all
metrics have this type.

Maximum

The maximum value reported across the
configured evaluation time length. Not all
metrics have this type.

Value

The arithmetic average of all metric values
reported across the configured evaluation time
length.

Sum

The sum of all the metric values reported
across the configured evaluation time length.

Count

The number of times the metric value has
been measured across the configured
evaluation time length.

Current

The value for the current minute.

4. From the drop-down menu after the metric, select the type of comparison by which the metric is
evaluated.
To limit the effect of the health rule to conditions during which the metric is within a defined
distance (standard deviations or percentages) from the baseline, select Within Baseline fro
m the menu.To limit the effect of the health rule to when the metric is NOT within that
defined distance, select Not Within Baseline. Then select the baseline to use, the numeric
qualifier of the unit of evaluation and the unit of evaluation. For example:
Within Baseline of the Default Baseline by 3 Baseline Standard
Deviations

To compare the metric with a static literal value, select < Specific value or > Specific Value
from the menu, then enter the specific value in the text field. For example:
Value of Errors per Minute >

100

To compare the metric with a baseline, select < Baseline or > Baseline from the drop-down
menu, and then select the baseline to use, the numeric qualifier of the unit of evaluation and
the unit of evaluation. For example:
Maximum of Average Response Time is > Baseline of the Daily Trend by
3 Baseline Standard Deviations

See Baselines and Periodic Trends for information about the baseline options.
Baseline Percentages
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The "baseline percentage" is the percentage above or below the established baseline at
which the condition will be triggered. If, for example, you have a baseline value of 850 and
you have defined a baseline percentage of "> 1%", then the condition should trigger if the
value is > [850+(850x0.01)] or 859. In addition, in order to prevent too small sample sets
from triggering health rules violations, these rules are not evaluated if the load (the number
of times the value has been measured) is less than 1000. So if, for example, a very brief
time slice is specified, the rule may not violate even if the conditions are met, simply
because the load is not large enough.
5. Click Save.
To Remove a Condition Component

You can remove a component condition by clicking the delete icon.
To Build an Expression

To access the expression builder to create a complex expression as the basis of a condition, click
the gear icon at the end of the row and select Use a mathematical expression of 2 or more
metric values.
In the expression builder, use the Expression pane to construct the expression.
Use the Variable Declaration pane to define variables based on metrics to use in the expression.
1. In Variable Declaration pane of the Mathematical Expression builder, click + Add variable to
add a variable.
2. In the Variable Name field enter a name for the variable.
3. Click Select a metric to open a small metric browser
4. From the drop-down menu select the qualifier for the metric.
5. Repeat steps 1 through 4 for each metric that you will use in the expression.
You can remove a variable by clicking the delete icon.
6. Build the expression by typing the expression in the Expression pane. Click the Insert Variable
button to insert variables created in the Variable Declaration pane.
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7. When the expression is built, click Use Expression.
The expression appears as the metric in the condition configuration window.

Using the Custom Health Rule Types Method

The procedure for using the Custom health rule type option in the health rules wizard is very
similar to using the basic health rules wizard. Use this procedure if you want to create a health rule
for a single entity based on a custom metric.
1.In the Overview section, select Custom (use any metrics) in the Type field.
2. In the Affects section, select the kind of entity that the health rule affects: Business Transaction
Performance, Node Performance, or Application Performance.
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If the health rule affects Business Transaction Performance:
Select the Business Transaction performance radio button
Select the Business Transaction affected from the drop-down menu. You can use the
search field in the Select a Business Transaction browser that opens to locate the
specific Business Transaction.
If the health rule affects Node Performance:
Select the Node Performance radio button.
Click Node (for new configuration) or Change (to modify an existing configuration).
In the Node browser that opens, navigate to the node which you want the health rule
to affect.
Click Select .
If the health rule is not specific to a Business Transaction or Node, select Application
Performance.
3. When you go on to Configure Health Rule Conditions for the Basic Health Rules Wizard you will
have access to the entire metric browser when you are choosing metrics.
Using the Hybrid Method - Custom Health Rules for Multiple Entities

If you use the Custom Health Rule Types method, you must set up your evaluation conditions on
an entity by entity basis. If you want to use the same custom metrics for evaluation across
multiple entities, you should use the Specify a Relative Metric Path method when you are setting
up your conditions instead.
1.In the Overview section, choose the health rule type that covers the kind of entity for which you
wish to set up custom rules. So, for example, if you wish to set up a custom rule that applies to all
nodes based on Perm Gen usage, select Node Health - Hardware, JVM, CLR as your health rule
type.
2. Go to the metric browser (Analyze->Metric Browser) and locate the relative path of the metric
you wish to add. Right click on the metric and select Copy Full Path.
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3. In the Affects section, select the correct type of entity. For example, select All Nodes in the
Application.
4. Go on to Configure Health Rule Conditions in the normal way. When you click to bring up the
metric list to use for evaluation, select Specify a Relative Metric Path instead of Specify a Metric
from the Metric Tree. Use a cropped value for the metric you located in the metric browser and
complete configuring your conditions as usual.
For all health rule types except Node Health-Hardware, JVM, CLR or Custom, use the
metric name alone - for example, Average Wait Time (ms))
For Node Heath-Hardware, JVM, CLR and Custom health rule types, use everything after
the entity, for example, after the Node name. In the example the path would look like this.
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Finish configuring your condition as you normally would.
Additional Considerations

When configuring health rules for business transactions with a very fast average response
time (ART), for example 25 ms, using standard deviation as a criterion can cause the health
rule to be violated too frequently. This is because a very small increase in response time can
represent multiple standard deviations. In this case, consider adding a second condition that
sets a minimum ART as a threshold. For example, if you don't want to be notified unless ART
is over 50 ms, you could set your threshold as: ART > 2 Standard Deviations and ART > 50
ms.

Similarly, when configuring health rules for calls-per-minute (CPM) metrics, the health rule
may never be violated if the condition is using standard deviations, and the resulting value is
below zero. In this case, consider adding a second condition that checks for a zero value,
such as: CPM < 2 Standard Deviations and CPM < 1.
Learn More
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Import and Export Health Rule Configurations
Import and Export Health Rule Configurations
Exporting Health Rules from an Application
To export the configurations for all health rules in an application
To export the configuration for a single health rule
Importing Health Rules to an Application
To import the configurations for health rules in an application
Learn More
You can export your health configurations from one application to another using a special
AppDynamics REST API. This capability allows you to re-use health rule configurations in different
applications instead of re-configuring each application manually from the AppDynamics console.
Exporting Health Rules from an Application

Exports are HTTP GET operations.
To export the configurations for all health rules in an application

http://<controller-host>:<controller-port>/controller/healthrules/<application-name|application-id>
Example
http://pm1.appdynamics.com:80/controller/healthrules/3

produces the output in all_health_rules.
To export the configuration for a single health rule

http://<controller-host>:<controller-port>/controller/healthrules/<application-name|application-id>?n
ame=<health_rule_name>
For example:
http://pm1.appdynamics.com/controller/healthrules/3?name=Business
Transaction response time is much higher than normal

produces the output in one_health_rule.
Importing Health Rules to an Application

Exports are HTTP POST operations.
After you have exported health rules you can import them to a different application passing the xml
file created by the export operation as payload to the POST. You can modify the exported file
before you import it. You might want to do this to add or remove one or more health rule
configurations or to change their names.
Use UTF-8 URL encoding of the URI before posting; for example, do not replace a space (" ") with
"%20" in the URI.
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The default behavior is not to overwrite an existing health rule of the same name. If you want to
overwrite an existing health rule of the same name, specify the overwrite=true parameter. since
the default is false.
The syntax is the same for importing one health rule configurations or several. All the health rule
configurations in the xml files are imported.
To import the configurations for health rules in an application

http://<controller-host>:<controller-port>/controller/healthrules/<application-name|application-id>?o
verwrite=true|false
This example imports the health rule in the uploaded file, overwriting any health rules of the same
name.

The next example imports the health rules without overwriting. In this case, any health rules in the
destination controller that have the same names as health rules in the all_health_rules file are not
overwritten.
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Learn More

Configure Health Rules
Import and Export Transaction Detection Configuration for Java

Actions
Types of Actions
Actions Limits
Actions Requiring Approval
Viewing and Creating Actions
To view and edit existing actions
To create an action
Action Suppression
Learn More
An action is a predefined, reusable, automated response to an event. You can use actions to
automate your runbooks.
A policy can trigger an action in response to any event. You configure which actions are triggered
by which events when you configure policies. See Policies.
Types of Actions

You can create the following types of actions:
Notifications
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Diagnostics
Remediation
Custom Actions
Cloud Auto-Scaling
Not all actions are applicable to all application environments or to all situations. Below are some
general guidelines concerning different types of actions. For more details, see the pages on the
specific actions before you assign an action to a policy.
The diagnostic thread dump actions can be performed only on nodes running a Java agent.
The diagnostic session actions can be triggered only by violations of business transaction
performance health rules or slow or stalled transaction events, since these are the events
that produce a view into transaction snapshots.
Remediation actions run a local script in a node and are available on nodes running on
machines that have an installed machine agent. See Install the Standalone Machine Agent.
Custom Actions require a dedicated controller, deployed using either the on-premise or
SaaS option. This feature is not supported for accounts on multi-tenant SaaS controllers.
Cloud Auto-Scaling actions require a previously created workflow. See Workflow Overview.
Actions Limits

The Controller limits the actions invoked based on the number of triggering events per event type.
There is a maximum of ten events for any single event type that can trigger actions in a given
minute. If the number of triggering events per type exceeds the limit, the actions that would have
been triggered by the excess events are not started. You will not see a visual indication that these
actions are not being started.
For example, your application can have up to ten Health Violation Started events triggering actions
and up to ten Resource Pool Limit Reached events triggering actions within the same minute. But
if you have eleven Health Violation Started events firing, the action that would be triggered by the
eleventh event is not started.
To reduce unnecessary actions, there is a limit on the number of diagnostic and remediation
actions that AppDynamics will invoke. The default limit is five actions per minute per machine for
each type of action.
If, for example, a policy is configured on all the nodes where there are 100 nodes triggering
actions, AppDynamics randomly selects five of the actions to execute.
To avoid exceeding the limits, design your policies so that they do not trigger an excessive number
of actions for any particular event. You can generate fewer events by configuring the affected
entities of your health rules at the tier level. See Entities Affected by a Health Rule.
Actions Requiring Approval

For actions that take thread dumps or run a local script, you can optionally require email approval
to run the action whenever it is triggered. If you configure this option, human intervention is
required before the "automated" action actually starts.
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If you specify the approval required option when you configure the action, when the action is
triggered an email containing a link is sent to the configured email address. The link presents a
login screen (if the user is not already logged in to AppDynamics) and after the user logs in, a
dialog requesting approval to take the thread dump or run the script. The user can click in this
dialog to approve and start the action or cancel the action.
If you do not check the Require approval option before executing the Action check box, the action
will start automatically with no human intervention.
Viewing and Creating Actions
To view and edit existing actions

1. Click Alert & Respond -> Actions in the left navigation pane.
The list of actions in the application appears.
To filter the types of actions displayed in the list, select the type at the top of the list. For example,
to see only diagnostic and remediation actions, check Diagnostics and Remediation and clear the
other check boxes.

2. To examine or modify an action, select the action in the list and double-click or click Edit.
3. To delete an action, select the action in the list and click Delete.
To create an action

1. Click Alert & Respond -> Actions in the left navigation pane.
2. Click the Create Action button.
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3. Select the type of action that you want to create.
4. Click OK.
The instructions beyond this point vary depending on the type of action you are creating. See the
topics for the action type you have selected.
Action Suppression

You can prevent policies from firing actions for a configurable time period. See Action Suppression
.
Learn More

Policies
Notification Actions
Diagnostic Actions
Remediation Actions
Cloud Auto-Scaling Actions
Custom Actions
Action Suppression
Install the Standalone Machine Agent
Notification Actions
Email Notifications
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To create an email notification
SMS Notifications
To create an SMS notification
Learn More
A notification action sends an email or SMS to a recipient list. The text of the notification is
automatically generated by the event that triggered the action.
For a SaaS Controller, all notification timestamps are in Pacific time (PT).
Email Notifications

An email notification contains a deep link to the details of the event that triggered it. Clicking this
deep link takes you directly to the place to start troubleshooting the problem.

To create an email notification

1. Follow the instructions in To create an action, selecting Notifications->Send an email in the
Create Action window.
2. Enter the email address to which to send the notification.
3. Click Save.
When you configure a policy to fire an email notification action, you have an opportunity to add a
note to the email. This note is applied only when the action is invoked by the particular policy. By
adding an optional note, you can customize email notifications for the policies that invoke them.
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If email and SMS settings have not been configured for AppDynamics, configure them now. See C
onfigure the SMTP Server.
SMS Notifications

The content of the SMS is automatically generated. It contains:
the notification header
the application name
the triggered time
Notifications of health rule violations also include:
name of health rule violated
Event notifications also include:
event notification configuration name
map of event types to number of these events
An SMS notification configuration specifies the phone number of the recipient.
To create an SMS notification

1. Follow the instructions in To create an action, selecting Notifications->Send an SMS message
in the Create Action window.
2. Enter the phone number to which to send the notification.
3. Click Save.
If email and SMS settings have not been configured for AppDynamics, configure them now. See C
onfigure the SMTP Server.
Learn More

Actions
Email Digests
Policies
Health Rules
Diagnostic Actions

Copyright © AppDynamics 2012-2014

Page 1979

Diagnostic Action Results
To get the details of a diagnostic session or a thread dump that has been initiated by
an action
Diagnostic Session Actions
To create a diagnostic session action
Thread Dump Actions (Java only)
Agent Limit on Thread Dumps
To create a thread dump action
Learn More
A diagnostic action can:
start a diagnostic session to collect snapshots
take a thread dump (Java only)
When performance is slow or your application is experiencing a lot of errors you can start a
diagnostic action to get to the root cause.
A diagnostic session gives you a view into captured transaction snapshots with full call graphs.
These snapshots help you diagnose violations of business transaction performance health rules or
slow or stalled transaction events. The affected entity of the event triggering a diagnostic session
must be a business transaction.
A thread dump is a general-purpose snapshot of the state of all threads that are part of a JVM
process. The state of each thread is presented with a stack trace that shows the contents of each
thread’s stack. Thread dumps are used for diagnosing JVM performance problems, such as code
deadlocks.
Thread dumps are not supported for .NET or PHP agents.
Diagnostic Action Results

The results of a diagnostic action that has executed are available in the events list for the event
that triggered the action.
To get the details of a diagnostic session or a thread dump that has been initiated by an action

1. Click Events in the left navigation pane.
2. Locate the row for the event that triggered the action for which you want to see the results.
3. In the Actions Executed column, click the diagnostic sessions or thread dump icon for the event
that you want to troubleshoot.

On disk, the thread dumps are stored in the app_agent_operation_logs directory in the controller
installation folder. The files are named based on the id in the app_agent_operation table.
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Diagnostic Session Actions

A diagnostic session is always associated with a business transaction. It shows transaction
snapshots with full call graphs to help you drill down to the root cause of a problem.
To create a diagnostic session action

1. Follow the instructions in To create an action, selecting Diagnostics->Start a diagnostic
sessions to collect snapshots in the Create Action window.
2. Enter a name for the action, the duration of the diagnostic session in minutes, and the number
of snapshots to take per minute.
3. Select whether a diagnostic session will be started for any business transaction affected by an
event or specific business transactions.
If you choose specific business transactions, specify the business transactions that will trigger the
diagnostic session by moving them from the "available" list to the "selected" list. The business
transactions that you can specify are not limited to those that triggered the action.

4. Click OK.
Thread Dump Actions (Java only)

You can direct the agent to take a thread dump for a specified number of samples (maximum of
50) with each sample lasting for a specified number of milliseconds (maximum of 500 ms). The
thread dump is executed on the node.
Thread dump actions are not supported on .NET or PHP.
Agent Limit on Thread Dumps

One thread dump operation is executed at a time. They are not executed in parallel. If additional
thread dump requests are received while one is being executed, they are queued with a limit of
five per agent.
If the five thread dumps per agent limit is exceeded, the console shows an event with a thread
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dump operation that was skipped because of the limit and the associated action dialog for the
executed policy links to this event.
To create a thread dump action

1. Follow the instructions in To create an action, selecting Diagnostics->Take a thread dump in
the Create Action window.
2. Enter a name for the action, the number of samples to take, and the interval between the thread
dumps in milliseconds.
3. If you want to require approval before the thread dump action can be started, check the Require
approval before this Action check box and enter the email address of the individual or group that is
authorized to approve the action. See Actions Requiring Approval for more information.
4. Click OK.

Learn More

Actions
Call Graphs
See Detailed Data Using Diagnostic Sessions
Policies
Transaction Snapshots
Install the Standalone Machine Agent
Cloud Auto-Scaling Actions
To Create a Cloud Auto-Scaling Action
Learn More
A cloud auto-scaling action allows you to move instances of your application into a cloud provider,
automatically, in response to load or any other criteria. To use this action, you must first set up
your cloud provider and create workflows to manage the steps. See Automation, Cloud
Computing Workflows, and Workflow Overview for more information on preparing this action.
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To Create a Cloud Auto-Scaling Action

1. Follow the instructions in To create an action, selecting Cloud Auto-Scaling->Run a workflow
to scale up/down your application in the Create Action window.
2. Give the workflow action a Name.
3. Select the name of the previously created Workflow from the dropdown list.
4. Click OK.
Learn More

Actions
Automation
Cloud Computing Workflows
Workflow Overview
Create a Workflow and Workflow Steps
Policies
Custom Actions
To Create a Custom Action
Learn More
A custom action is typically used to integrate third party alerting and ticketing systems with an
on-premise controller. Custom action scripts are not supported on SaaS controller. A custom
action is different from other actions in that it executes just once on the on-premise controller
instance.
The custom action is made up of a custom action script and a custom.xml file, which you must
create before you can create an action that uses them. The custom action scripts include
parameters for specifying the affected entity, for example the tier, node, business transaction, etc.
See Build an Alerting Extension for details on how to create the custom action script and xml file.
Custom actions are commonly used when you want to trigger a human work flow or leverage an
existing alerting system that is external to AppDynamics. For example, you could use a custom
action to file a JIRA ticket when AppDynamics reports that a connection pool is near saturation.
If you are using a SAAS controller, you may be able to use a remediation action on a local node to
accomplish similar results. See Remediation Actions for more information.
To Create a Custom Action

After the custom action script and custom.xml files have been tested manually and installed on the
Controller and you have restarted the Controller, you can create the custom action.
1. Follow the instructions in To create an action, selecting Automation->Run any custom action
that has been uploaded to the controller in the Create Action window.
2. Enter a name for the action.
3. Select the custom action from the dropdown list.
4. Click OK.
The custom action is now available for assignment to a policy.
Learn More

Build an Alerting Extension

Copyright © AppDynamics 2012-2014

Page 1983

Remediation Actions

Prerequisites for Local Script Actions
Remediation Scripts
Guidelines for Remediation Scripts
Troubleshooting Remediation Scripts
Remediation Example
Creating a Local Script (Remediation) Action
To create a local Script Action
To specify the nodes on which the action will run
To see the output of the local script
Learn More
A remediation action runs a local script in a node. The script executes on the machine from which
it was invoked or on the node specified by the remediation action configuration. You can use this
type of action to automate your runbook procedures.
By default the script is a shell script in /bin/sh invoked with the -ex option, unless the script has a
header, in which case the interpreter in the header is used. For example, if the script header is
"#!/bin/perl", the PERL interpreter is invoked.
You can optionally configure the remediation action to require human approval before the script is
started. See Actions Requiring Approval.
Remediation actions can be performed only on machines that are running the machine agent. See
Install the Standalone Machine Agent.
Prerequisites for Local Script Actions

The Standalone (Java-based) Machine Agent must be installed running on the host on
which the script executes.
To see a list of installed machine agents for your application, click View machines with
machine-agent installed in the bottom left corner of the remediation script configuration
window.
See Install the Standalone Machine Agent if you need to install a machine agent.
The machine agent OS user must have full permissions to the script file and the log files
generated by the script and/or its associated child processes.
The script must be placed in a sub-directory of the machine agent installation directory that
is named "local-scripts".
The script must be available on the host on which it executes.
Processes spawned from the scripts must be daemon processes
Remediation Scripts

A remediation script is run on the machines that you specify in the remediation script configuration.
You can run the script from the machine affected by the violation that triggered the action or from a
central management server. It is not necessary for an app agent to be running on the machine on
which the script executes, just a machine agent.
Guidelines for Remediation Scripts
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A process exit code of zero indicates that the script execution succeeded. A non-zero exit code
indicates that it failed.
The script should be written as generically as possible to allow it run on any of the nodes for which
is it invoked. AppDynamics exports the following environment variables to the script runtime to
provide context regarding the environment and the event that triggered the action.
Environment Variable

Cardinality (1 or N)

Notes

APP_ID

1

Name of the Application

EVENT_TIME

1

Timestamp of the event

EVENT_ID

1

Event Id

EVENT_TYPE

1

type of event, such as:
ERROR,
APPLICATION_ERROR,
APPLICATION_INFO, STALL,
BT_SLA_VIOLATION,
DEADLOCK,
MEMORY_LEAK,
MEMORY_LEAK_DIAGNOST
ICS, LOW_HEAP_MEMORY,
ALERT, CUSTOM,
APP_SERVER_RESTART,
BT_SLOW, SYSTEM_LOG,
INFO_INSTRUMENTATION_
VISIBILITY, AGENT_EVENT,
INFO_BT_SNAPSHOT,
AGENT_STATUS,
SERIES_SLOW,
SERIES_ERROR,
ACTIVITY_TRACE,
OBJECT_CONTENT_SUMM
ARY,
DIAGNOSTIC_SESSION,
HIGH_END_TO_END_LATE
NCY,
APPLICATION_CONFIG_CH
ANGE,
APPLICATION_DEPLOYMEN
T, AGENT_DIAGNOSTICS,
MEMORY, LICENSE

ENV_STARTUP_ARGS

1

Process args

ENV_SYSTEM_PROPERTIE
S

1

JVM System Props (When
Java)

AFFECTED_ENTITY

1

Affected Entity that triggered
the event
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Troubleshooting Remediation Scripts

To troubleshoot your remediation script, look for the process in the machine agent log. The log is
located at
<Machine_Agent_Installation_Directory>/logs/machine-agent.log
The snippet below from the machine agent log shows both error and success messages from
running a local script named "script.sh".

Remediation Example

The following remediation action, named increasePool, executes a local script named runbook.sh,
which increases the size of the connection pool on the JVM.
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A policy named ConnectionPoolPolicy triggers this action when the Resource Pool Limit Event
fires:

Creating a Local Script (Remediation) Action
To create a local Script Action

1. Follow the instructions in To create an action, selecting Remediation->Run a script or
executable on problematic Nodes in the Create Action window.
2. Enter a name for the action.
3. In the field that terminates the Relative path to script entry, enter the rest of the path to the
executable script.
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Remediation scripts must be stored in a sub-directory of the machine agent installation. The
sub-directory must be named "local-scripts". The following paths are all valid:
${machine.agent.directory}/local-scripts/runMe.sh
${machine.agent.directory}/local-scripts/johns_scripts/runMe.sh
${machine.agent.directory}/local-scripts/ops/johns_scripts/runMe.sh

4. Click the + to enter the absolute paths of any log files that the script writes to that you want
included in the script output.
5. Enter the timeout period for the script process in minutes.
6. If you want to require approval before the script action can be started, check the Require
approval before this Action check box and enter the email address of the individual or group that is
authorized to approve the action. See Actions Requiring Approval for more information.
7. Click OK.
To specify the nodes on which the action will run

When you bind the action to a policy, you specify the nodes on which the script should execute.
You can configure the number of nodes or the percentage of nodes or you can configure a specific
node. This flexibility allows you to configure scripts to run from a central management server, not
just the node on which the violation occurred.
In the Configure Action window, do one of the following:
1. Select Execute Action on Affected Nodes.
2. Enter the percentage of the nodes or the number of nodes on which to run the script.
or
1. To designate the specific node on which to run the script, select Execute Action on Specified
Node.
2. Click Select Node.
3. From the popup node browser select the node on which the script should run.
4. Click Select.
The selected node is displayed in the Configure Action window.
5. Click Save to save the configuration.
Click Change if you want to designate a different node.
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To see the output of the local script

1. Click Events in the left navigation pane to navigate to the Events list.
2. Locate the row for the event that triggered the action for which you want to see the results.
3. In the Actions column, click the remediation script icon.

4. In the script result list, select the script output that you want and click Download Local Script
Result.

Learn More

Actions
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Policies
Install the Standalone Machine Agent

Action Suppression
Create a New Action Suppression
Objects Affected by Action Suppression
Application-Level Action Suppression
Business Transaction Action Suppression
Tier-Level Action Suppression
Node-Level Action Suppression
Machine-Level Action Suppression
Health Rules Affected by Action Suppression
Cancelling Action Suppression
To delete/cancel an action suppression configuration
Learn More
You can temporarily suppress a policy's automatic invocation of actions and alerts. You may want
to do this while you are performing maintenance on or troubleshooting a component.
Suppressing an action does not suppress the evaluation of any health rules linked to the
action via a policy. Health rule violation events continue to be raised and surfaced to the
UI.
To turn off the evaluation of a specific health rule, click Alert & Respond->Health
Rules, select the Health Rule, click the edit pencil, and uncheck the Enabled box in
the Edit Health Rule Overview panel.
To turn off all health rule evaluation, uncheck Evaluate Health Rules at the top left of
the Health Rules screen.
To see action suppression configurations created for an application:
1. Click Alert & Respond -> Actions.
2. Click the Action Suppression tab.
The list of action suppression configurations displays in the left panel with the objects affected by a
selected configuration displayed in the right panel.
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Notice that the Object Scope list shows both Tiers and Nodes. Because the nodes are children
of the tiers, action suppression affects them as well. Selecting an Application as Object Scope can
produce a list of many items if the application is complex enough. All tiers and nodes are shown,
although no business transactions are shown in the list.
Create a New Action Suppression

1.Click the plus icon. The Create Action Suppression popup appears.
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2. In the Overview section, give the Action Suppression a name, define its scope, and set the
times it should cover. See Objects Affected by Action Suppression for more information on scope.

3. In the Object Scope section, drill down to the set of entities that it should cover.

4. If you wish to limit the particular health rules that this action suppression should effect, select
Only suppress Action for these specified Health Rules. A list of possible rules pops up. Select the
appropriate rules. See Health Rules Affected by Action Suppression for more information.
Objects Affected by Action Suppression

You configure action suppression for a specific time period to apply to a specific object or several
objects. The following entities can be the objects of action suppression:
Application
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Business Transaction
Tier
Node
Machine
Within the time period configured for the action suppression, no policy actions are fired for health
rule violation events that occur on the specified object(s).
You can also optionally disable reporting of metrics for an object for which actions are suppressed.
Using this option can cause reported metrics for those objects to change without notice. If you see
a sudden unexpected change in reported metrics for an object, check the action suppression
configurations list to see whether action suppression with reporting disabled is currently active for
that object.
If the object scope of an action suppression is at the node level, the suppression affects only node
health rules.
If the object scope of an action suppression is at the tier level, the suppression affects individual
node health rules as well as tier-level health rules.
For example, if a tier-level health rule is configured to fire an action when a percentage of the
nodes violates the condition, and then action suppression is configured on certain nodes in that
tier, those nodes are still evaluated by the tier-level health rule.
Application-Level Action Suppression

In an application-level configuration, all entities in the application are affected.
Business Transaction Action Suppression

In a business-transaction-level configuration, you can suppress actions in:
All business transactions in the application
All business transactions within specific tiers
Specific business transactions
Business transactions with names having patterns that match certain criteria (such as all
business transactions with names that start with "XYZ")
Tier-Level Action Suppression

In a tier-level configuration, all the nodes in the specified tier(s) are affected. You can suppress
actions for:
All tiers in the application
Specific tiers
Node-Level Action Suppression

In a node-level configuration, you can specify the types of nodes for which to suppress actions:
All nodes
Java nodes
.NET nodes
PHP nodes
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and within those types you can suppress actions for:
All nodes
Nodes in specific tiers
Specific nodes
Nodes with names, meta-data, environment variables or JVM system environment
properties with matching criteria that you specify
Machine-Level Action Suppression

You can suppress actions run on specific machines. Actions run on all the nodes on the specified
machine (s) are suppressed.
Health Rules Affected by Action Suppression

By default, an action suppression configuration applies to actions triggered by all events that are
generated by the configured objects.
You can refine the configuration to apply only to actions triggered by specific health rule violations.
For example, if an application contains HealthRuleA, HealthRuleB and HealthRuleC, but only
HealthRuleC is configured for action suppression, actions will continue to fire for violations of
HealthRuleA and HealthRuleB during the configured time period.
Cancelling Action Suppression

If action suppression is no longer needed (for example, where the estimated time to fix a problem
was longer than the fix actually required) you can delete it. Policies on the objects affected by the
action suppression configuration will start firing a few minutes after the suppression configuration
is cancelled.
To delete/cancel an action suppression configuration

1. From the action suppression configurations list, select the configuration to delete.
2. Click the Delete icon.
Learn More

Policies
Health Rules
Actions
Configure Action Suppression
Configure Action Suppression
To access action suppression configuration
Structure of the Action Suppression Wizard
Configuring General Action Suppression Settings
To configure general action suppression settings
Configuring Object Scope for Action Suppression
To configure object scope
Configuring Health Rules for Action Suppression
To suppress actions for all health rule violations
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To suppress actions triggered by only certain health rules
Learn More
Configure action suppression using the Action Suppression Wizard.
To access action suppression configuration

1. Click Alert & Respond -> Actions.
2. Click the Action Suppression tab.
3. To edit an existing action suppression configuration, select the configuration in the list and click
the Edit icon.
4. To delete an existing action suppression configuration, select the configuration in the list and
click the Delete icon.
5. To create a new action suppression configuration click the Add icon.
The Action Suppression Wizard appears when you edit or add a configuration.
Structure of the Action Suppression Wizard

The Action Suppression Wizard contains three panels:
1. Overview: Sets:
configuration name
scope
option to suppress metrics reporting by agents associated with the affected objects
schedule
2. Object Scope: Sets the objects affected by the configuration.
The options presented vary according to the scope set in the Overview panel.
3. Health Rule Scope: Sets the events that trigger action suppression.
By default, all events on the affected objects trigger action suppression. You can restrict action
suppression to apply only to violations of specific health rules
You can navigate among these panels using the Back and Next buttons at the bottom of each
panel or by clicking their entries in the left panel of the wizard. When you create a new
configuration, configure the panels in order because the configuration of the scope in the Overview
panel determines the available affected objects presented in the object scope panel.
Configuring General Action Suppression Settings

Configure general settings in the Overview panel.
To configure general action suppression settings

1. In the Overview panel of the Action Suppression Wizard:
If you are creating a new configuration, enter the configuration name in the Name field.
If you are editing an existing configuration, the name will already be there.
2. Click one of the object types in the Scope list to select the type of entity affected by the
configuration.
If you choose Application, policy actions are suppressed for all entities in the application.
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3. If you want to suppress metric collection and reporting while actions are being suppressed,
check the Disable reporting for associated agents checkbox.
If you want the agent to continue to report metrics while actions are being suppressed, this
checkbox should be clear.
4. Enter the time period that action suppression is in effect.
Start Time: Choose Now, or configure a starting Date/Time in the future.
Now is the time at which the configuration is enabled.
End Time: Configure After and the number of hours (as an integer) that the configuration is
in effect after the start time, or configure an ending Date/Time in the future.
5. Click Next.
Configuring Object Scope for Action Suppression

In the Object Scope panel of the Action Suppression Wizard you can define the object scope of
the configuration broadly or fine-tune it very precisely to suppress actions for specific objects in
your application.
To configure object scope

1. In the Object Scope panel, select the objects affected by this configuration.
The choices presented in this panel depend on the scope configured in the Overview panel.
See Objects Affected by Action Suppression for information about the types of objects that you
can select.
If the object scope is Application, there is no configuration to be done in this panel, so click Next a
nd skip to Configuring Health Rules for Action Suppression.
2. For types other than Application, configure the object scope using the tools in the panel. The
display varies depending on the type of object.
If your configuration includes selecting specific objects, move those objects from the other" list to
the "selected" list.

You can either drag and drop the objects from one list to the other or select them and click Add or
Remove as appropriate.
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3. Click Next.
Configuring Health Rules for Action Suppression

In the Health Rules panel of the Action Suppression Wizard you can specify the health rules
affected by the configuration.
To suppress actions for all health rule violations

1. Leave the Only suppress Action execution for these specified health rules checkbox clear.

2. Click Save to save the configuration.
To suppress actions triggered by only certain health rules

1. Check the Only suppress Action execution for these specified health rules checkbox.
2. For each health rule to be affected by the configuration, click + to select the health rule from a
list.

To delete a health rule from the suppression list select it and click the Delete icon.
3. Click Save.
Learn More

Action Suppression
Health Rules

Email Digests
An email digest is a compilation of messages sent to a recipient list by email at a configured time
interval.
The purpose of the digest is to notify the recipients of events that have occurred in the application.
The contents of the digest are automatically generated based on the context of the events that the
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digest reports.
See Configure Email Digests for configuration details.

Configure Email Digests

Structure of the Email Digest Wizard
Configuring the Email Digest
To configure content settings
To configure digest recipients
To configure the digest interval
Learn More
Structure of the Email Digest Wizard

To access the Email Digest Wizard:
1. Click Alert & Respond -> Email Digests.
2. To edit an existing email digest, select the digest and click the Edit icon.
3. To remove an existing digest click the delete icon.
4. To create a new digest, click "+" .
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The Email Digest Wizard opens. It contains four panels:
1. Contents: Sets the digest name, enabled status, health rule type, events and objects that trigger
the sending of the digest
2. Recipients Adds the email addresses of the digest recipients.
4. How Often: Sets how often the digest is sent, in hours.
You can navigate among these panels using the Back and Next buttons at the bottom of each
panel or by clicking their entries in the left panel of the wizard.
Configuring the Email Digest
To configure content settings

1. In the Content panel of the Email Digest Wizard, if you are creating a new digest, enter the
digest name in the Name field.
If you are editing an existing digest, the name will already be there. You can change the name of
the digest in the Name field.
2. To enable sending the digest check the Enabled check box. To disable sending the digest, clear
the Enabled check box.
3. Check the check boxes for the events that will be included in the digest. You may need to click
the down arrow to expose specific events within an event category.

4. When you have finished selecting the events in the digest, you can click "any object" to refine
the contents by specifying only events that affect certain objects in the application. If you select
Any Objects the digest will include configured events when they occur on any object in your
application.
To restrict the policy to specific objects, select Any of these specified objects and then choose the
objects from the embedded object browser.
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5. Click Save to save the digest configuration.
To configure digest recipients

Configuration of digest recipients involves selecting or creating an email notification action for
every recipient of the digest. You can create these notification actions from this Email Digest
Wizard as well as from the Actions menu.
1. In the Recipients panel of the Email Digest Wizard, if you are creating a new digest, enter the
digest name in the Name field. If you are modifying an existing digest, double-click the digest in
the list.
2. To edit an existing recipient, select the recipient from the list and double-click or click the Edit
icon.
3. To remove an existing recipient from the email digest, select the recipient from the list and click
the delete icon.
4. To add a recipient, click the "+" sign.
5. Do one of the following:
To add a recipient who has already been configured (i.e. an existing email notification
action), select the email notification from the list and click Select.
or
Click Enter Email Address and enter the email address of the recipient in the text field.
6. Optional: In the Configure Action screen, you can also add an optional note to include in the
email.
7. Click Save to add the recipient.
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8. Click Save in the Email Digest Wizard to save the digest configuration.
To configure the digest interval

1. Click How Often to access the How Often panel.
2 In the text field enter an integer to indicate the number of hours between digests.
3. Click Save to save the digest configuration.
Learn More

Email Digests
Policies
Health Rules
Notification Actions

Getting Started Wizard for Alerts
To access the Getting Started wizard
To edit or delete the generated policy
Learn More
When you are starting out, you can quickly configure an email notification to be sent when any
health rule violates, using the Getting Started Wizard. This wizard creates an automatic policy that
sends an alert to a single email address.
To access the Getting Started wizard

1. Click Alert & Respond in the left navigation pane. The first time you do this, the Getting
Started Wizard opens automatically.
2. If this is not the first time you have opened Alert & Respond, click the Getting Started Wizard
at the bottom of the Alert & Respond screen.
3. If your SMTP server is not set up, click Configure SMTP Server.
See Configure the SMTP Server for instructions on configuring the SMTP server for email and
SMS notifications.
4. Enter the email address to which alerts will be sent.
5. Click Save.
This wizard creates a policy named My Policy or My Policy n that sends email to the configured
address whenever any health rule violation is started in the application.
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To edit or delete the generated policy

1. Click Alert & Respond -> Policies to access the policy list.

2. Do one of the following:
To delete the automatically generated policy, select the policy and click the delete icon.
To edit the automatically generated policy, select the in the list and click the edit icon.
You can fine-tune the types of violations and events that trigger the alert by editing the policy
manually. For example, you can change the name of the policy, add or remove events that
trigger the notification, add additional notification email addresses or other actions to be
triggered by the policy.
You can also create entirely new health rules, policies and actions. See Policies.
3. Click Save.
Learn More

Health Rules
Policies
Actions
Notification Actions
Email Digests
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Configure Policies
Configure Email Digests

Troubleshoot and Resolve
Troubleshooting Scenarios
How AppDynamics Indicates Problems
How to Start Troubleshooting
Troubleshooting Techniques

Troubleshooting Scenarios

Troubleshoot per Platform

For common troubleshooting
scenarios see:
Troubleshoot Slow
Response Times
Troubleshoot Errors
Troubleshoot Health Rule
Violations
Troubleshoot Mobile Applications

Troubleshoot Application Problems - Java
Troubleshoot Application Problems - .NET
Troubleshoot Application Problems - PHP
Troubleshoot Application Problems - Node.js

How AppDynamics Indicates Problems
The dashboards show you when problems occur and you need to take action. For example the Tra
nsaction Scorecard monitors business transactions and categorizes their performance according
to thresholds.

The Events panel shows a Code Problems link. Click it to see details.
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How to Start Troubleshooting
When AppDynamics indicates a problem you can easily go right into troubleshooting mode.
From the left navigation menu click Troubleshoot.

From the All Applications dashboard click the Troubleshoot link.
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Troubleshooting Techniques
Set Time Ranges to Isolate Issues
Compare Snapshots to Find Slow Calls
See Detailed Data Using Diagnostic Sessions

Set Time Ranges to Isolate Issues
Set the Time Range
Drill Down to the Problem
Changing Other Time Windows
Baselines
Learn More
It's not uncommon to want to investigate an issue that occurred in the past. For example, over the
weekend there was a spike in stalled requests. The issue resolved, so there was no emergency,
but, come Monday morning, you want to look back at what happened, and what was going on at
the time in general in your system.
Set the Time Range

Use the Time Range dropdown menu to set the display to cover the timeframe needed.
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Drill Down to the Problem

1. Click Troubleshoot->Slow Response Times
2. Select the Slow Transactions tab.

3. Drag your mouse to select the the range where the problem occurred - in the example, the
spike in stalls.
A Time Range popup appears.

4. Select Drill Down Into Selected Time Range.
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4.
The Time Range Drill Down Workbench appears.

5. Select the Transaction Snapshots tab and the Slow and Error Transactions tab.
Those stalled transactions all seem to be for the Fetch Catalog business transaction.
6. Click the Exe Time column to find the very slowest of the stalled transactions and click View
Transaction Snapshot.
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The Transaction Snapshot Flow Map appears.

7. Click Drill Down to see the Call Drill Down window, including the call graph.

A slow database call was at the root of the problem.
Changing Other Time Windows

You can use the mouse select time range method in many places throughout the UI. For example,
in KPI listings in various dashboards:
Drill into Load from the top level dashboard
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Select snapshots occurring during a particular range in End User Response Time from the
Web EUM dashboard

You can even use it in the Metric Browser:

Baselines
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Whether or not some event in the past has been defined as an issue often depends on the baselin
e being used in the evaluation of that event. To understand how baselines work and what impact
they can have, see Detect Anomalies Using Dynamic Baselines.
Learn More

KPI Graphs
Troubleshoot and Resolve

Compare Snapshots to Find Slow Calls
Expensive Method Invocations and SQL Statements

If part of your application is showing performance degradation and you're not sure where to start
looking for the root cause, one approach is to search and compare multiple snapshots together.
You can do this to find the most expensive method invocations and SQL statements.
To troubleshoot by comparing multiple snapshots

1. Select the application dashboard and click the Transaction Snapshot tab.
2. Click the All Snapshots tab.
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3. Sort the snapshots in a way that makes sense to you, such as by tier and by business
transaction.
4. Select a few snapshots. You can compare up to 30 snapshots at a time.
5. Click Analyze -> Identify the most expensive calls/SQL statements in a group of
Snapshots.

Depending on how many snapshots you chose, it may take more time to process the results.
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6. The Expensive Methods and SQL Statements window shows the most expensive method
invocations sorted by total time. You can also sort by average execution time or call count.
7. You can click on a snapshot to see its details.
8. Select two snapshots for the same business transaction and select Analyze -> Compare
Snapshots to directly compare them.

Learn More

Transaction Snapshots
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See Detailed Data Using Diagnostic Sessions
Triggering a Diagnostic Session
On-demand Diagnostic Sessions
To Start a Diagnostic Session for a Business Transaction Manually
Automatic Diagnostic Sessions For Slow and Error Transactions
To Configure Diagnostic Session Thresholds
Accessing a Diagnostic Session
To View a Diagnostic Session
Learn More
This topic explains what a diagnostic session is and how to capture diagnostic session on a
transaction.
A diagnostic session captures detailed data about the processing of a transaction as transaction
snapshots over a defined period of time. This data includes full call graphs.
Diagnostic sessions can be triggered manually through the user interface or configured to start
automatically when thresholds for slow, stalled, or error transactions are reached. If the diagnostic
session is triggered manually, the diagnostic session collects snapshots on all the nodes that the
selected business transaction passes through. If the diagnostic session is triggered to start
automatically, the diagnostics session collects snapshots on the triggering node.
Triggering a Diagnostic Session

You can manually trigger a diagnostic session when you need one or configure them to start up
automatically.
On-demand Diagnostic Sessions

On-demand diagnostic sessions must be started manually.
To Start a Diagnostic Session for a Business Transaction Manually

1. Display the dashboard for the business transaction that you want to analyze. See Business
Transactions List.
2. Click Actions -> Start Diagnostic Session or right-click on the selected business transaction
and then click Start Diagnostic Session.
3. Specify the snapshot collection duration at the bottom of the Start Diagnostic Session window.
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AppDynamics will start collecting transaction snapshots for that business transaction.
Automatic Diagnostic Sessions For Slow and Error Transactions

AppDynamics provides default thresholds to detect slow, very slow, stalled and error transactions.
You can configure settings for triggering diagnostic sessions for these transactions.
To Configure Diagnostic Session Thresholds

1. In the left navigation pane, click Configure -> Slow Transaction Thresholds.
2. For configuring thresholds for business transactions click the User Transaction Thresholds ta
b. For thresholds for background tasks, click the Background Tasks Thresholds tab.
3. In the thresholds tree list, select the scope of the threshold, either:
Default Thresholds
or
Individual Transaction Thresholds
4. In the right panel configure thresholds for when diagnostic sessions will be started.
Here you can set a trigger based on the percentage of requests that exceed the Slow Request
threshold. For performance reasons you may not want to trigger a diagnostic session each time a
threshold is exceeded.
5. Configure diagnostic session duration and collection frequency. This includes:
Number of snapshots to collect over a specified time period
Number of unsuccessful attempts per minute
Wait period between sessions
For performance reasons you want to limit the duration and frequency of diagnostic sessions to
the minimum required time to obtain the maximum amount of information for troubleshooting
purposes.
When there are ongoing performance problems you do not want a diagnostic session to run
continuously. You can set a wait period between sessions and increase the time as needed.
Accessing a Diagnostic Session

You can access a diagnostic session from the transaction snapshot list.
To View a Diagnostic Session

1. Navigate to the transaction snapshot list.
See To View Transaction Snapshots.
2. Select a transaction snapshot from the list and either double-click it or click View Dashboard.
3. Click the Diagnostic Sessions tab.
4. From the list select a diagnostic sessions and click View Diagnostic Session.
From there you can double-click a transaction snapshot to dive deeper.
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Learn More

Transaction Snapshots
Actions
Diagnostic Actions
Configure Diagnostic Sessions For Asynchronous Activity - Java
Automatic Diagnostic Sessions For Asynchronous Activity

Diagnostic sessions are triggered based on the performance metrics for a business transaction.
The average response time of a business transaction does not include the execution time of its
asynchronous activity. If you have asynchronous processing in your application, it might be
possible for the originating transaction to execute within normal bounds even though the
asynchronous activity takes longer than normal. To diagnose an issue like this, you can create a
custom health rule based on the average response time (or other performance metric) of the
asynchronous activity and use that health rule to set up a policy that triggers a diagnostic session
on the transaction. The general steps to do this are described in the following example that uses a
metric for an async thread task.
1. Create a custom health rule based on the asynchronous metric, such as average response
time. The metrics for thread tasks are visible in the metric browser under the Thread Tasks
node for transactions with asynchronous activity. Each thread task has an individual node
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(usually its simple class name). Remember to select Custom as the type for the health rule.

2. Create a policy that is based on the baseline of the asynchronous metric of interest, for
example, the average response time.
3. Configure the policy to trigger a diagnostic session on the affected business transaction.

Troubleshoot Application Problems
Troubleshoot Slow Response Times

Troubleshoot per Platform
How You Know When
Response Times are Slow
Basic Troubleshooting
Techniques
Slow and Stalled
Transactions
To
troubleshoot
slow and
stalled
transactions
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Troubleshoot Slow Response Times for .NET
Troubleshoot Slow Response Times for PHP
Troubleshoot Slow Response Times for Node.js
Troubleshoot Slow Network Requests from Mobile
Applications
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Slow Database and
Remote Service Calls
To troubleshoot slow database and remote service calls
Learn More
How You Know When Response Times are Slow

There are many ways you can learn that your application's response time is slow:
You received an email or SMS alert from AppDynamics (see Alert and Respond). The alert
provides details about the problem that triggered the alert.
Someone reported a problem such as "it's taking a long time to check out" or "the app timed
out when I tried to add an item to the cart."
A custom dashboard shows a problem.
An AppDynamics dashboard shows a problem. In AppDynamics, look at:
Business Transaction health metrics in the Transaction Scorecard pane. The bar
charts show slow or stalled transactions (as based on health rules) as compared to
normal.
The Response Time graph. If you see spikes in the graph, the problem is slow
response time.
Events in the Events List. Scroll the list and look for red or yellow icons related to
performance health rules based on response time.
Traffic flow lines in a flow map. If you see yellow or red flow lines the problem is likely
to be slow response time.
Business Transaction Health status in the Business Transaction Health pane. If you
see yellow or red bars, there are health rule violations that may affect response time.
Tier icons in the flow map. If the icon is yellow or red there is a problem with one or
more nodes that may affect response time.
Health rule status in the Server Health pane. If you see red or yellow, the problem
reflects a server health rule violation that may affect response time.
Basic Troubleshooting Techniques

At any time you can click Troubleshoot -> Slow Response Times and the Slow Response Times
window opens showing two tabs. You can drill down into transaction issues in the Slow
Transactions tab, and into database or remote services issues in the Slowest DB & Remote
Services tab.
Slow and Stalled Transactions

There are many reasons why a business transaction may be slow or stalled. The Slow Response
Times tab helps you find the root cause whether that be resource or thread contention, deadlock,
race condition, or something else.
By default AppDynamics considers a slow transaction one that lasts longer than 3 times the
standard deviation for the last two hours, a very slow transaction 4 times the baseline for the last
two hours, and a stalled transaction one that lasts longer than 300 deviations above the average
for the last two hours.
You can configure these thresholds to better match your environment. See Set Performance
Boundaries Using Thresholds and Configure Thresholds.
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To troubleshoot slow and stalled transactions
1. Click Troubleshoot -> Slow Response Times.
You can also access this information from tabs in the various dashboards.
2. Click the Slow Transactions tab if it is not selected.
In the upper pane AppDynamics displays a graph of the slow, very slow, and stalled
transactions for the time period specified in the Time Range drop-down menu. If the load is
not displayed, you can click the Plot Load checkbox at the upper right to see the load.
In the lower pane AppDynamics displays the transaction snapshots for slow, very slow, and
stalled transactions.
3. In the lower pane, click the Exe Time column to sort the transactions from slowest to fastest.

To drill down to the root cause of the slow or stalled transaction, select a snapshot from the list
and click View Transaction Snapshot. See Transaction Snapshots.
Slow Database and Remote Service Calls

Although AppDynamics does not instrument database and remote service servers directly, it
collects metrics about calls to these backends from the instrumented app servers. This allows you
to drill down to the root cause of slow database and remote service calls.
To troubleshoot slow database and remote service calls

1. Click Troubleshoot -> Slow Response Times.
You can also access this information from tabs in the various dashboards.
2. Click the Slowest DB & Remote Service Calls tab if it is not selected.
In the Call Type panel, you can select the type of call for which you want to see information,
or select All Calls.
The Call panel displays the average time per call, number of calls, and maximum execution
time (Max Time) for the calls with the longest execution time.
In the lower panel, you can see details or correlated snapshots for the selected call.
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3. Sort by Average Time per Call to display the slowest calls at the top of the list.
4. To see transaction snapshots for the business transaction that is correlated with a slow call, you
can:
Click the View Snapshots link in the right column to display correlated snapshots in a new
window.
Select the call and click the Correlated Snapshots tab in the lower panel to display
correlated snapshots at the bottom of the screen.

5. Click the Exe Time column to sort the transactions from slowest to fastest.
To drill down to the root cause of the slow call, select a snapshot from the list and click View
Transaction Snapshot. See Transaction Snapshots.
Learn More

Transaction Snapshots
Configure Thresholds
Troubleshoot Errors

Error Transactions and Exceptions
To Troubleshoot Error Transactions
To Troubleshoot Exceptions
Learn More
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Error Transactions and Exceptions

Troubleshoot per Platform

For an overview see Monitor Errors and Exceptions.
Troubleshoot Errors for PHP
To Troubleshoot Error Transactions

1. Click Troubleshoot -> Errors in the left navigation
panel.
The error viewer opens.
2. Click the Error Transactions tab if it is not already selected.
3. From the time range drop-down menu select the time range for
which you want to view information about error transactions.
A graph of the error transactions displays at the top of the viewer.
You can get an exact count of the errors per minute at a particular
point in time by hovering with your pointing device on the line in the
graph.
To the right of the graph is a summary of the load and the error
transactions.
Check the Plot check box if you want the graph at the top of the
viewer to show the load over the selected time period. Clear this
check box is clear, if you want the graph to show only the error
transactions .
4. The error transaction snapshots are listed in the lower part of the
viewer. To filter this list click Show Filters and select the filter
criteria.
5. To examine the root cause of an error, select the snapshot from
the list and click View Transaction Snapshot. See Transaction
Snapshots for information about examining snapshots.
6. To identify the most expensive calls or queries, select a snapshot
from the list and click Analyze and then click Identify the most
expensive calls / SQL statements in a group of snapshots.
The Most Expensive Methods / SQL Statements viewer opens.
7. In the lower panel click the Expensive Methods tab to view the
methods with their total and average execution times and call
counts. Click the Expensive SQL tab to view the queries with their
counts and execution times.
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This two-minute interactive
video traces the typical steps
of identifying the cause of an
error in your application.
To Troubleshoot Exceptions

1. Click Troubleshoot -> Errors in the left navigation panel.
2. Click the Exceptions tab if it is not already selected.
The total exception count, HTTP Error Codes and Error Page Redirects for the selected time
range are reported in the upper panel. You can get an exact count of the errors per minute at a
particular point in time by hovering with your pointing device on the line in the graphs.
The exceptions list is displayed in the lower panel.
To filter the exception list, enter the filter term in the search text box on the upper right.
For example, to see only HTTP errors - and to see the breakdown of HTTP errors by code
type - type HTTP in the search box. The list of HTTP errors by code is displayed.
To see only errors with performance data, clear the Show Exceptions with 0 count
checkbox.
3. To view details of a particular exception, select the exception the list in the lower panel and click
View Details.
The exception detail window displays.
4. To view transaction snapshots for an exception:
a. In the exception detail window, click the Occurrences of this Exception tab.
b. Select a snapshot from the list.
c. Click View Details.
d. in the snapshot flow map that displays, click Drill Down. See Transaction Snapshots.
5. To view a stack trace for an exception:
a. In the exception detail window, click the Stack Traces for this Exception tab.
b. Click an exception in the left panel.
The right panel displays the stack trace for the selected exception.
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Learn More

Monitor Errors and Exceptions
Configure Error Detection
Transaction Snapshots
Troubleshoot Health Rule Violations
Health and Health Rules
Troubleshoot Heath Rule Violations
To find all health rule violations
To troubleshoot a health rule violation
To see health rule status in the UI
Learn More
Health and Health Rules

"Health" throughout the AppDynamics UI refers to the extent to which the component being
monitored is operating within the acceptable limits defined by health rules. Health rules allow you
to automate pro-active monitoring and problem mediation in your managed environment. By
default, AppDynamics provides a set of basic health rules, which you can extend, add to, or
remove as your needs dictate.
A health rule violation exists when the conditions that define the rule are true. For example, you
might have defined a health rule condition that states that a CPU%Busy rate of more than 90% on
any node is a critical condition. If the rate on a node then goes over 90%, the health rule is said to
"violate" and the AppDynamics UI displays a notification of that violation.
Because there is a set of default health rules, you may see health rule violations reported for your
application even if you have not set up your own health rules. If you see violations reported for the
APPDYNAMICS_DEFAULT_TXT business transaction, these are for default health rule violations
in the All Other Traffic business transaction. If you are not interested in monitoring these business
transactions, you may want to examine your business transaction setup. See Organizing Traffic as
Business Transactions.
For general information about health rules, see Health Rules. For information on setting up your
own health rules, see Configure Health Rules.
Troubleshoot Heath Rule Violations

To start troubleshooting health rule violations, you can:
Get a list of all the health rule violations by clicking Troubleshoot -> Health Rule
Violations.
Click on a particular health rule violation you see displayed in the UI.
You can access the list of health rule violations in your application for the selected time range.
To find all health rule violations

1. In the left navigation pane, click Troubleshoot -> Health Rule Violations.
The list of health violations displays.
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2. Select View All Health Rule Violations in the Time Range or View Only Health Rule
Violations Open Now.
It is possible that health rule violations that were reported are no longer open because remedial
action has been taken or performance has improved on its own.
3. To see the filters click Show Filters. To hide them click Hide Filters.
With the filters showing in the left filters panel you can select the health rule violations that you
want to troubleshoot. You can view all health rule violations or expand the nodes in the tree to
select by health rule type (such as business transaction health rules or node health rules) or
affected entity (such as business transaction, tier or node).
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You can filter health rule violations by entering the name of the health rule in the search field on
the upper right.
The health rule violations are displayed in the right panel, with their status, description, start time,
end time and duration (if ended), and the affected entity.
To troubleshoot a health rule violation

Once you have located the violation you are interested in, you can get more information in three
ways:
To see the health rule definition that was violated for a specific violation, find the health rule
violation in the list and in the Health Rule column, click the link to the health rule
configuration. The Edit Health Rule window for the specific definition appears.
To see the dashboard for the entity, such as a business transaction or a node, affected by
the violation, click the link to the entity in the Affects column. The Transaction Flow Map
appears.
To troubleshoot a specific health rule violation, select the health rule violation row from the
list and click Health Rule Violation Details in the top bar.
The Health Rule Violation Event window displays a summary of the violation and any actions that
were executed to respond to it.
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You can click the View Dashboard During Health Rule Violation in the details window to view
the dashboard at the time the violation occurred. The time range in this and all other dashboards is
set to the time range of the health rule violation. From the dashboard you can get an overall
picture of the application at the time of the violation. If you select the Transaction Snapshots tab
you get a list of relevant snapshots which allows you to drill down to the root cause of the problem.
See Transaction Snapshots for more information.
To see health rule status in the UI

Across the UI, health rule status is color-coded: green is healthy; yellow/orange is a warning
condition; red is a critical condition; and grey indicates that the status of the health rule is unknown
- for example if the Controller cannot gather the data necessary to evaluate the rule. If you see a
health rule violation reported in the UI, you can click it to get more information about the violation.
Here are the health summary bars on the dashboards:

There is a health column in the business transaction list:
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In the Events panel on the dashboards, health violations are displayed as events.

To see a summary of the violation, click a health rule violation from the Events list, then select the
violation you are interested in from the list that appears. Click View Event Details in the top bar
and the Health Rule Violation Started window appears. It displays detailed information and a link
to the appropriate dashboard at the time of the violation. If any Policy actions were executed in
response to the violation, they are also displayed.

Learn More

Health Rules
Configure Health Rules
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Organizing Traffic as Business Transactions
Policies
Alert and Respond
Transaction Snapshots
Troubleshoot Node Problems
To Access the Node Problem Viewer
Node Problem Viewer
Filter Options for Node Problem Analysis
Baseline to Use
Data to Analyze
Analysis Type
Learn More
AppDynamics categorizes the ten items that deviate the most from the baseline performance as
node problems.
You can analyze node problems from the Node Problems viewer.
The Machine Agent must be installed on the machine hosting the node that you are
troubleshooting.
To Access the Node Problem Viewer

To access the Node Problems viewer do one of the following:
In the Node dashboard, from the Actions drop-down menu click Analyze Node Problems.
or
In the left navigation panel of the Snapshot viewer, click NODE PROBLEMS.
Node Problem Viewer

The right panel of the Node Problem viewer displays the metrics that deviate the most from their
baselines for the specified time range.
The left panel of the Node Problem viewer lets you filter the types of data reported as node
problems.
If accessed from the Snapshot viewer, the Node Problem viewer displays node problems for the
time range of the snapshot. If accessed from the Node dashboard, it uses the time range set in the
Node dashboard. You can edit the time range in the Node Problem viewer and then apply the new
time range. You can also define and save a custom time range.
The selection of metrics displayed depends on the configured filter options.
The following Node Problem viewer shows a transaction that took over 10 seconds (10069 ms) to
execute.
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It shows that the request count was 62 standard deviations from its normal baseline and that the
DB connection pool was 1.6 standard deviations above its normal baseline. It maxed out at 30
concurrent connections.
The Hot Spots tab for this snapshot shows the details of the connection pool latency.

In this case, the Node Problems viewer reveals how excessive web requests saturated the DB
connection pool.
Filter Options for Node Problem Analysis

You can filter the following options in the Filter Options panel of the Node Problem viewer:
Baseline to Use
Data to Analyze
Analysis Type
Baseline to Use
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Specify which baseline to use to define node problems:
No baseline
All data - Last 15 days
Daily Trend - Last 30 days (default)
Weekly Trend - Last 6 months
Monthly Trend - Last year
For information about baselines, see Detect Anomalies Using Dynamic Baselines.
Data to Analyze

Select the type of data to analyze from the drop-down menu. AppDynamics analyzes the ten items
that deviate the most from the baseline performance for the specified type.
Analysis Type

Specify whether to display problems with values that are:
higher than baseline
lower than the baseline
higher and lower than baseline
For example, if you are only interested in CPU that is too high, set the Analysis Type to Higher for
Hardware Resources. On the other hand, if you want to monitor the load on your machine
continuously because low CPU usage would also be a problem, set the Analysis Type to Higher
and Lower.
Learn More

Detect Anomalies Using Dynamic Baselines
Troubleshoot Application Problems - Java
Troubleshoot Slow Response Times for Java

How Do You Know Response Time is Slow?
Troubleshooting Steps
Step 1 - Slow or stalled business transactions?
Step 2 - Slow DB or remote service calls?
Step 3 - Affects 1 or more nodes?
Step 4 - Backend problem?
Step 5 - CPU saturated?
Step 6 - Significant garbage collection activity?
Step 7 - Memory leak?
Step 8 - Resource leak?
None of the above?
How Do You Know Response Time is Slow?

There are many ways you can learn that your application's response time is slow:
You received an email or SMS alert from AppDynamics (see Alert and Respond). The alert
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provides details about the problem that triggered the alert. If the problem is related to slow
response time, start troubleshooting at Step 1.
Someone reported a problem such as "it's taking a long time to check out" or "the app timed
out when I tried to add an item to the cart."
The problem is slow response time related to one or more business transactions. Start
troubleshooting at Step 1.
A custom dashboard shows a problem. If the problem is related to slow response time, start
troubleshooting at Step 1.
You are looking at the Application Dashboard for a business application, shown below:

1. Look at the traffic flow lines in the flow map, the Business Transaction Health pane, the
Transaction Scorecard pane, and the Response Time graph. If you see problems (yellow or
red lines, spikes in response time), the problem is slow response time, and is probably
related to your AppDynamics business application. Start troubleshooting at Step 1.
2. Look at the Tier icons in the flow map. If you see yellow or red, you have a problem with one
or more nodes, which may or may not result in slow response time. Start troubleshooting at
Step 3.
3. Look at the Events pane. If you see red or yellow, the problem reflects a change in
application state that is of potential interest, which may or may not result in slow response
time. See Tutorial for Java - Troubleshooting using Events.
4. Look at the Server Health pane. If you see red or yellow, the problem reflects a server health
rule violation, which may or may not result in slow response time. See Tutorial for Java Server Health.
Need more help?

Application Dashboard
Flow Maps
Troubleshooting Steps
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The following steps help you determine whether your problem is related to your business
application or to your hardware or software infrastructure. Each step shows you how to display
detailed information to help you pinpoint the source of the problem and quickly resolve it.
Step 1 - Slow or
stalled business
transactions?

Are there any slow or stalled business transactions?
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How do I know?
How do I know if business transactions are slow or stalled?

1. Click Troubleshoot -> Slow Response Times
You can also access this information from tabs in the
various dashboards.

2. Click the Slow Transactions tab if it is not selected.

In the upper pane AppDynamics displays a graph of
the slow, very slow, and stalled transactions for the
time period specified in the Time Range drop-down
menu. If the load is not displayed, you can click the
Plot Load checkbox at the upper right to see the load.
In the lower pane AppDynamics displays the
transaction snapshots for slow, very slow, and stalled
transactions.
If you see one or more slow transaction snapshots on this
page, the answer to this question is Yes. Otherwise, the
answer is No.
No – Go to Step 2.
Yes – You have one or more slow or stalled transactions, and
need to drill down to find the root cause.
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1. In the lower pane of the Slow Transactions tab, click the
Exe Time column to sort the transactions from slowest to
fastest.
2. Select a snapshot from the list and click View
Transaction Snapshot. You see the Transaction Flow
Map. Choose the Flow Map tab if it is not already
selected.

3. Click a Drill Down icon to display a call graph for a
problematic part of the transaction. Once you are in the
call graph you can look for methods that have a
significant response time. In this example, the
executeQuery method is responsible for 54.5% of
response time.

Copyright © AppDynamics 2012-2014

Page 2033

4. Click the Information icon in the right column to see more
details. Provide this information to the personnel
responsible for addressing this issue.

If there are multiple slow or stalled transactions, repeat this
step until you have resolved them all. However, there may
be additional problems you haven't resolved. Continue to S
tep 2.
Need more help?

Transaction Snapshots

Step 2 - Slow DB
or remote service
calls?

Is there one or more slow DB or remote service call?
How do I know?
How do I know if I have slow DB or remote service calls?

1. Click Troubleshoot -> Slow Response Times, then click
the Slowest DB & Remote Service Calls tab if it is not
selected.

If you see one or more slow calls on this page, the answer to
this question is Yes. Otherwise, the answer is No.
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No – Go to Step 3.
Yes – You have one or more slow DB or remote service calls,
and need to drill down to find the root cause.
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1. In the Call Type panel select the type of call for which you
want to see information, or select All Calls.
2. Sort by Average Time per Call to display the slowest calls
at the top of the list.
3. To see transaction snapshots for the business
transaction that is correlated with a slow call, you can:
Click the View Snapshots link in the right column
to display correlated snapshots in a new window.
Select the call and click the Correlated Snapshots
tab in the lower panel to display correlated
snapshots at the bottom of the screen.
4. Select a snapshot from the list and click View
Transaction Snapshot. Choose the Flow Map tab if it is
not already selected, then click a Drill Down icon to
display a call graph for a problematic part of the
transaction.

5. Once you are in the call graph you can look for methods
that have a significant response time. In this example, an
Oracle query is responsible for 99.7% of response time.
Provide this information to the personnel responsible for
addressing this issue.
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If there are multiple slow calls, repeat this step until you have
resolved them all. However, there may be additional problems
you haven't resolved. If any of the tier icons on the flow map
show yellow or red, continue to Step 3. Otherwise, you have
isolated the problem and don't need to continue with the rest of
the steps below.
Need more help?

Business Transaction Dashboard
Monitor Business Transactions
Business Transactions List
Transaction Snapshots

Step 3 - Affects 1
or more nodes?

Is the problem affecting all nodes in the slow tier?
How do I know?
How do I know if the problem is affecting all nodes?

In the Application or Tier Flow Map, click the number
that represents how many nodes are in the tier. This
provides a quick overview of the health of each node
in the tier. The small circle icon indicates whether the
server is up with the agent reporting, and the larger
circle icon indicates Health Rule violation status.

If all the nodes are yellow or red, the answer to this
question is Yes. Otherwise, the answer is No.
Yes – Go to Step 4.
No – The problem is either in the node's hardware or in the
way the software is configured on the node. (Because only
one node is affected, the problem is probably not related to
the code itself.)
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In the left navigation pane, click Servers -> App Servers
-> <slow tier> -> <problematic node> to display the
Node Dashboard (flow map).

Click the Dashboard tab to get a view of the overall
health of the node.
Click the Hardware tab; if the problem is
hardware-related, contact your IT department.
Click the Memory tab; sort on various column headings to
determine if you need to add memory to the node,
configure additional memory for the application, or take
some other corrective action.
You have isolated the problem and don't need to continue
with the rest of the steps below.
Need more help?

Node Dashboard

Step 4 - Backend
problem?

Are the nodes in the slow tier linked to a backend (database or
other remote service) that might be causing your problem?
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How do I know?
How do I know if the nodes are linked to a backend (database or other remote
service) that might be causing my problem?

Display the Tier Flow Map. If any nodes are linked to a
backend, links to those backends are displayed in the
flow map.

If a backend or the line connecting to a backend is
yellow or red, the answer to this question is Yes.
Otherwise, the answer is No.
No – Go to Step 5.
Yes –
Click the line connecting to the backend to see an
information window about the backend. (The
contents of the information window vary depending
on the type of backend.) Use the various tabs to
find the source of the issue, or contact the team
responsible for that backend.
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If the backend is a database, right-click the database icon.
You have a number of options that let you see the
dashboard, drill down, etc. If you have AppDynamics for
Databases, choose Link to AppDynamics for Databases.
You can use AppDynamics for Databases to diagnose and
resolve any backend issues, or work with your internal
DBAs to troubleshoot the database, which is not
instrumented in AppDynamics.

You have isolated the problem and don't need to continue
with the rest of the steps below.
Need more help?

Backend Monitoring
Configure Backend Detection for Java
AppDynamics for Databases

Step 5 - CPU
saturated?
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Is the CPU of the JVM saturated?
How do I know?
How do I know if the CPU of the JVM is saturated?

1. Display the Tier Flow Map.
2. Click the Nodes tab, and then click the Hardware tab.
3. Sort by CPU % (current). Show me how.

If the CPU % is 90 or higher, the answer to this
question is Yes. Otherwise, the answer is No.
Yes – Go to Step 6.
No – The issue is probably related to a custom
implementation your organization has developed. Take
snapshots of the affected tier or node(s) and work with
internal developers to resolve the issue.
You have isolated the problem and don't need to continue
with the rest of the steps below.
Need more help?

Monitor JVMs

Step 6 Significant
garbage collection
activity?
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Is there significant garbage collection activity?
How do I know?
How do I know if there is significant garbage collection activity?

Display the Tier Flow Map.
Click the Nodes tab, and then click the Memory
tab.
Sort by GC Time Spent to see how many
milliseconds per minute is being spent on GC;
60,000 indicates 100%. Show me how.

If GC Time Spent is higher than 500 ms, the answer to
the question in Step 5 is Yes. Otherwise, the answer is
No.
Yes – Go to Step 7.
No – Go to Step 8.
Need more help?

Memory Usage and Garbage Collection

Step 7 - Memory
leak?
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Is there a memory leak?
How do I know?
How do I know if there is a memory leak?

1. From the list of nodes displayed in the previous step
(when you were checking for Garbage Collecting
activity), double-click a node that is experiencing
significant GC activity.
2. Click the Memory tab, then scroll down to display the
Memory Pool graphs at the bottom of the window.
3. Double-click the PS Old Gen memory pools. Show
me how.

If memory is not being released (use is trending
upward), the answer to this question is Yes. Otherwise,
the answer is No.
Yes – Use various AppDynamics features to track down
the leak. One useful tool for diagnosing a memory leak is
object instance tracking, which lets you track objects you
are creating and determine why they aren't being released
as needed. Using object instance tracking, you can
pinpoint exactly where in the code the leak is occurring.
For instructions on configuring object instance tracking, as
well as links to other tools for finding and fixing memory
leaks, see Need more help? below.
No – Increase the size of the JVM. If there is significant GC
activity but there isn't a memory leak, then you probably
aren't configuring a large enough heap size for the
activities the code is performing. Increasing the available
memory should resolve your problem.
Whether you answered Yes or No, you have isolated the
problem and don't need to continue with the rest of the
steps below.
Need more help?

Troubleshoot Java Memory Leaks
Troubleshoot Java Memory Thrash
Configure and Use Object Instance Tracking for Java

Copyright © AppDynamics 2012-2014

Page 2043

Step 8 - Resource
leak?
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Is there a resource leak?
How do I know?
How do I know if there is a resource leak?

1. In the left Navigation pane, go to (for example) Analyz
e -> Metric Browser -> Application Infrastructure
Performance <slow tier> -> Individual Nodes ->
<Problematic node> -> JMX -> JDBC Connection
Pools -> <Pool name>
2. Add the Active Connections and Maximum
Connections metrics to the graph.
3. Repeat as needed for various pools your application is
using.

If connections are not being released (use is trending
upward), the answer to the question in Step 7 is Yes.
Otherwise, the answer is No.
Yes – To determine where in your code resources are
being created but not being released as needed, take a
few thread dumps using standard commands on the
problematic node. You can also create a diagnostic action
within AppDynamics to create a thread dump; see Thread
Dump Actions.
No – Restart the JVM. If none of the above diagnostic
steps addressed your issue, it's possible you're simply
seeing a one-time unusual circumstance, which restarting
the JVM can resolve.
Need more help?

Diagnostic Actions

Copyright © AppDynamics 2012-2014

Page 2045

None of the
above?

If slow response time persists even after you've completed the
steps outlined above, you may need to perform deeper
diagnostics.
If you can't find the information you need on how to do so in the
AppDynamics documentation, consider posting a note about
your problem in a community discussion topic. These
discussions are monitored by customers, partners, and
AppDynamics staff. Of course, you can also contact
AppDynamics support.
Need more help?

AppDynamics Application Intelligence Platform
Community Discussion Boards (If you don't see
AppDynamics Pro as a topic, click Sign In at the upper
right corner of the screen.)

Troubleshoot Java Memory Issues
Troubleshoot Java Memory Leaks

Memory Leaks in a Java Environment
AppDynamics Java Automatic Leak Detection
Automatic Leak Detection Support
Conditions for Troubleshooting Java Memory Leaks
Workflow to Troubleshoot Memory Leaks
Monitor Memory for Potential JVM Leaks
Enable Memory Leak Detection
Troubleshoot Memory Leaks
Select the Collection Object to Monitor
Use Content Inspection
Use Access Tracking
Learn More

Memory Leaks in a Java Environment

While the JVM's garbage collection greatly reduces the opportunities for memory leaks to be
introduced into a codebase, it does not eliminate them completely. For example, consider a web
page whose code adds the current user object to a static set. In this case, the size of the set grows
over time and could eventually use up significant amounts of memory. In general, leaks occur
when an application code puts objects in a static collection and does not remove them even when
they are no longer needed.

Copyright © AppDynamics 2012-2014

Page 2046

In high workload production environments if the collection is frequently updated, it may cause the
applications to crash due to insufficient memory. It could also result in system performance
degradation as the operating system starts paging memory to disk.
AppDynamics Java Automatic Leak Detection

AppDynamics automatically tracks every Java collection (for example, HashMap and ArrayList)
that meets a set of criteria defined below. The collection size is tracked and a linear regression
model identifies whether the collection is potentially leaking. You can then identify the root cause
of the leak by tracking frequent accesses of the collection over a period of time.
Once a collection is qualified, its size, or number of elements, is monitored for long term growth
trend. A positive growth indicates that the collection as potentially leaking!
Once a leaking collection is identified, the agent automatically triggers diagnostics every 30
minutes to capture a shallow content dump and activity traces of the code path and business
transactions that are accessing the collection. By drilling down into any leaking collection
monitored by the agent, you can manually trigger Content Summary Capture and Access Tracking
sessions. See Configure Automatic Leak Detection for Java
You can also monitor memory leaks for custom memory structures. Typically custom memory
structures are used as caching solutions. In a distributed environment, caching can easily become
a prime source of memory leaks. It is therefore important to manage and track memory statistics
for these memory structures. To do this, you must first configure custom memory structures. See
Configure and Use Custom Memory Structures for Java.
Automatic Leak Detection Support

Ensure AppDynamics supports Automatic Leak Detection on your JVM. See JVM Support.
Conditions for Troubleshooting Java Memory Leaks

Automatic Leak Detection uses On Demand Capture Sessions to capture any actively used
collections (i.e. any class that implements JDK Map or Collection interface) during the Capture
period (default is 10 minutes) and then qualifies them based on the following criteria:
For a collection object to be identified and monitored, it must meet the following conditions:
The collection has been alive for at least N minutes. Default is 30 minutes, configurable with
the minimum-age-for-evaluation-in-minutes node property.
The collection has at least N elements. Default is 1000 elements, configurable with the mini
mum-number-of-elements-in-collection-to-deep-size node property.
The collection Deep Size is at least N MB. Default is 5 MB, configurable with the minimum-si
ze-for-evaluation-in-mb property.
The Deep Size is calculated by traversing recursive object graphs of all the objects in
the collection.
See App Agent Node Properties and App Agent Node Properties Reference by Type.

Workflow to Troubleshoot Memory Leaks

Use the following workflow to troubleshoot memory leaks on JVMs that have been identified with a
potential memory leak problem:
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Monitor Memory for Potential JVM Leaks
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Use the Node Dashboard to identify the memory leak. A possible memory leak is indicated by a
growing trend in the heap as well as the old/tenured generation memory pool.

An object is automatically marked as a potentially leaking object when it shows a positive and
steep growth slope.

The Automatic Memory Leak dashboard shows:
Collection Size: The number of elements in a collection.
Potentially Leaking: Potentially leaking collections are marked as red. You should start
diagnostic sessions on potentially leaking objects.
Status: Indicates if a diagnostic session has been started on an object.
Collection Size Trend: A positive and steep growth slope indicates potential memory leak.

Tip: To identify long-lived collections compare the JVM start time and Object Creation Time.
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If you cannot see any captured collections, ensure that you have correct configuration for detecting
potential memory leaks.
Enable Memory Leak Detection

Before enabling memory leak detection, identify the potential JVMs that may have a leak. See Det
ect Memory Leaks.
Memory leak detection is available through the Automatic Leak Detection feature. Once the
Automatic Leak Detection feature is turned on and a capture session has been started,
AppDynamics tracks all frequently used collections; therefore, using this mode results in a higher
overhead. Turn on Automatic Leak Detection mode only when a memory leak problem is identified
and then start an On Demand Capture Session to start monitoring frequently used collections and
detect leaking collections.

Turn this mode off after you have identified and resolved the leak.
To achieve optimum performance, start diagnosis on an individual collection at a time.
Troubleshoot Memory Leaks

After detecting a potential memory leak, troubleshooting the leak involves performing the following
three actions:
Select the Collection Object that you want to monitor
Use Content Inspection
Use Access Tracking
Select the Collection Object to Monitor
1. On the Automatic Leak Detection dashboard, select the name of the class that you want to
monitor.
2. Click Drill Down on the top left-hand side of the memory leak dashboard.
Alternatively right-click the class name and click Drill Down.
IMPORTANT: To achieve optimum performance, start the troubleshooting session on a
single collection object at a time.
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Use Content Inspection
Use Content Inspection to identify which part of the application the collection belongs to so that
you can start troubleshooting. It allows monitoring histograms of all the elements in a particular
collection.
As described above in Workflow to Troubleshoot Memory Leaks, enable Automatic Leak
Detection, start an On Demand Capture Session, select the object you want to troubleshoot, and
then follow the steps listed below:
1.
2.
3.
4.
5.

Click the Content Inspection tab.
Click Start Content Summary Capture Session to start the content inspection session.
Enter the session duration. Allow at least 1-2 minutes for data generation.
Click Refresh to retrieve the session data.
Click on the snapshot to view details about an individual session.
Exporting Troubleshooting Information
You can also export the troubleshooting information into Excel files using the Export button
under Content Summary.
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Use Access Tracking
Use Access Tracking to view the actual code paths and business transactions accessing the
collections object.
As described above in Workflow to Troubleshoot Memory Leaks, enable Automatic Leak
Detection, start an On Demand Capture Session, select the object you want to troubleshoot, and
then follow the steps listed below:
1.
2.
3.
4.
5.

Select the Access Tracking tab
Click Start Access Tracking Session to start the tracking session.
Enter the session duration. Allow at least 1-2 minutes for data generation.
Click Refresh to retrieve session data.
Click on the snapshot to view details about an individual session.
Exporting Troubleshooting Information
You can also export the troubleshooting information into Excel files using the Export button
under Content Summary.
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The troubleshooting information pane shows the Java stack trace associated with the session. By
default, the stack trace is shown to a depth of 10 lines. If you would like to temporarily increase the
number of lines captures, you can use the maximum-activity-trace-stack-depth Java Agent
property described on App Agent Node Properties Reference.
Increasing the stack trace depth can consume a significant amount of system resources. Be sure
to remove the property or set it back to the default value of 10 after you have captured the desired
information.
Learn More

App Agent Node Properties
Monitor JVMs
Metric Browser
Troubleshoot Java Memory Thrash

Memory Thrash and Object Instance Tracking
Prerequisites for Object Instance Tracking
Specifying the Classpath
Classpath for application only
Classpath for entire environment
Workflow for Detecting and Troubleshooting Memory Thrash
Analyzing Memory Thrash
To analyze memory thrash problems
To verify memory thrash
Troubleshooting Java Memory Thrash Using Allocation Tracking
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To use allocation tracking
Memory Thrash and Object Instance Tracking

Memory thrash is caused when a large number of temporary objects are created in very short
intervals. Although these objects are temporary and are eventually cleaned up, the
garbage collection mechanism may struggle to keep up with the rate of object creation. This may
cause application performance problems. Monitoring the time spent in garbage collection can
provide insight into performance issues, including memory thrash. For example, an increase in the
number of spikes for major collections either slows down a JVM or indicates potential memory
thrash Use object instance tracking to isolate the root cause of the memory thrash. To configure
and enable object instance tracking, see Configure and Use Object Instance Tracking for Java.
AppDynamics automatically tracks the following classes:
Application Classes
System Classes
The Object Instance Tracking feature maps a histogram of every object in the JVM. The Object
Instance Tracking dashboard not only provides the number of instances for a particular class but
also provides the shallow memory size (the memory footprint of the object and the primitives it
contains) used by all the instances.

Prerequisites for Object Instance Tracking

Object Instance Tracking can be used only for Sun JVM v1.6.x and later.
If you are running with the JDK then tools.jar will probably be setup correctly, but if you are
running with the JRE you must add tools.jar to JRE_HOME/lib/ext and restart the JVM for
this feature to start working. You can find the tools.jar file in JAVA_HOME/lib/tools.jar.
In some cases In some cases you might also need to copy libattach.so (Linux) or attach.dll
(Windows) from your JDK to your JRE.
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Depending on the JDK version, you may also need to specify the classpath as shown below
(along with other -jar options).
Specifying the Classpath

When using a JDK tool, set the classpath using the -classpath option.
Classpath for application only
This sets the classpath for the application only. For example:
On Windows
java -classpath <complete-path-to-tools.jar>;%CLASSPATH% -jar myApp.jar
OR
On Unix
java -Xclasspath/a:<complete-path-to-tools.jar> -jar myApp.jar
Classpath for entire environment
Alternatively, you can set the CLASSPATH variable for your entire environment. For example:
On Windows
SET CLASSPATH=%CLASSPATH%;%JAVA_HOME%\lib\tools.jar
On Unix
CLASSPATH=$CLASSPATH:$JAVA_HOME/lib/tools.jar

Workflow for Detecting and Troubleshooting Memory Thrash

The following diagram outlines the workflow for monitoring and troubleshooting memory thrash
problems in a production environment.
To monitor memory leaks, on the node dashboard, use the Memory -> Automatic Leak
Detection subtab. See Troubleshoot Java Memory Leaks.
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Analyzing Memory Thrash
To analyze memory thrash problems

Once a memory thrash problem is identified in a particular collection, start the diagnostic session
by drilling down into the suspected problematic class.
1. Select the class name to monitor and click Drill Down at the top of the Object Instance
Tracking dashboard.
Or right click the class name and select the Drill Down option.
For optimal performance, trigger a drill down action on a single instance or class name at
a time.
After the drill down action is triggered, data collection for object instances is performed every
minute. This data collection is considered to be a diagnostic session and the Object Instance
Tracking dashboard for that class is updated with this icon
, to indicate that a diagnostic
session is in progress.

The Object Instance Tracking dashboard indicates possible cases of memory thrash.
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The following provides more detail on the meaning of each of the columns on the Object Instance
Tracking dashboard.

Prime indicators of memory thrash problems are:
Current Instance Count: A high number indicates possible allocation of large number of
temporary objects.
Shallow Size: A large number for shallow size signals potential memory thrash.
Instance Count Trend: A saw wave is an instant indication of memory thrash.
If you suspect you have a memory thrash problem at this point, then you should verify that this is
the case. See To verify memory thrash.
To verify memory thrash
1. Select the class name to monitor and click Drill Down at the top of the Object Instance
Tracking dashboard.
2. On the Object Instance Tracking window, click Show Major Garbage Collections.
The following Object Instance Tracking Overview provides further evidence of a memory thrash
problem.
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If the instance count doesn’t vary with the garbage collection cycle, it is an indication of potential
leak and not a memory thrash problem. See Troubleshoot Java Memory Leaks.
Troubleshooting Java Memory Thrash Using Allocation Tracking

Allocation Tracking tracks all the code paths and those business transactions that are allocating
instances of a particular class.
Allocation tracking detects those code path/business transactions that are creating and throwing
away instances.
To use allocation tracking
1. Using the Drill Down option, trigger a diagnostic session.
2. Click the Allocation Tracking tab.
3. Click Start Allocation Tracking Session to start tracking code paths and business
transactions.
4. Enter the session duration and allow at least 1-2 minutes for data generation.
5. Click Refresh to retrieve the session data.
6. Click on a session to view its details.
7. Use the Information presented in the Code Paths and Business Transaction panels to
identify the origin of the memory thrash problem.
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Detect Code Deadlocks for Java

Code Deadlocks and their Causes
Finding Deadlocks using the Events
List
To Examine a Code Deadlock
Finding Deadlocks Using the REST
API
Learn More
Read a real-life story about how
AppDynamics helped identify code
deadlocks and reduce the risk to
revenue!
By default the agent detects code deadlocks. You can find deadlocks and see their details using
the Events list or the REST API.
Code Deadlocks and their Causes

In a multi-threading development environment, it is common to use more than a single lock.
However sometimes deadlocks will occur. Here are some possible causes:
The order of the locks is not optimal
The context in which they are being called (for example, from within a callback) is not correct
Two threads may wait for each other to signal an event
Finding Deadlocks using the Events List

Select Code Problems (or just Code Deadlock) in the Filter By Event Type list to see code
deadlocks in the Events list. See Filter and Analyze Events. The following list shows two
deadlocks in the ECommerce tier.
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To Examine a Code Deadlock

1. Double-click the deadlock event in the events list.
The Code Deadlock Summary tab displays.

2. To see details about the deadlock click the Details tab and scroll down.

Finding Deadlocks Using the REST API

You can detect a DEADLOCK event-type using the AppDynamics REST API. For details see the
example Retrieve event data.
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Learn More

Use the AppDynamics REST API
Troubleshoot Application Problems - .NET
Troubleshoot Slow Response Times for .NET

How Do You Know Response Time is Slow?
You Received an Alert
You are Viewing the Application Dashboard for a Business Application
Initial Troubleshooting Steps
Troubleshooting Methodology
Step 1 - All nodes?
Step 2 - Most business transactions?
Step 3 - Backend problem?
Step 4 - CPU saturated?
Step 5 - Significant garbage collection activity?
Step 6 - Memory leak?
None of the above?
How Do You Know Response Time is Slow?

There are two primary ways you can learn that your application's response time is slow: receiving
an alert and looking at an Application Dashboard.
You Received an Alert

If you have received an email alert from AppDynamics that was configured through the use of Heal
th Rules, Policies, Actions or Workflow Overview, the email message provides a number of details
about the problem that triggered the alert. See Email Notifications.
If the problem is related to slow response time, see Initial Troubleshooting Steps.
You are Viewing the Application Dashboard for a Business Application

NOTE: If you know the slow response time relates to a particular business transaction, e.g. an
internal tester reported "Searching for a hotel is slow," skip to the answer No in Step 2.
1. Display the Application Dashboard (flow map). Look for lines that are yellow or red or tiers
that are not entirely green.
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If multiple tiers are red or yellow, the problem might be related to a backend (database or
other remote service). Skip to Step 3.
Otherwise, begin troubleshooting with Initial Troubleshooting Steps.
Need more help?
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Application Dashboard
Flow Maps
Initial Troubleshooting Steps

In some cases, the source of your problem might be easily diagnosed by choosing Troubleshoot
-> Slow Response Times in the Navigation Pane. See Troubleshoot Slow Response Times.
If you've tried to diagnose the problem using those techniques and haven't found the problem, use
the following troubleshooting methodology to find other ways to determine the root cause of your
issue.
Troubleshooting Methodology

Step 1 - All
nodes?

Is the problem affecting all nodes in a slow tier?
How do I know?
How do I know if the problem is affecting all nodes?

In the Application or Tier Flow Map, click the number
that represents how many nodes are in the tier. This
provides a quick overview of the health of each node
in the tier. The small circle icon indicates whether the
server is up with the agent reporting, and the larger
circle icon indicates Health Rule violation status.

If all the nodes are yellow or red, the answer to the question
in Step 1 is Yes. Otherwise, the answer is No.
Yes – Go to Step 2.
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No – The problem is either in the node's hardware or in the way
the software is configured on the node. If only one node in a tier
is affected, the problem is probably not related to the
application code.
In the left navigation pane, click Servers -> App Servers
-> <slow tier> -> <problematic node> to display the
Node Dashboard flow map.

Click the Dashboard tab to get a view of the overall
health of the node.
Click the Hardware tab to see if there is a hardware
resource issue.
Click the Memory tab and sort on various column
headings to determine if there is a shortage of memory or
other memory issue.
You have isolated the problem and don't need to continue with
the rest of the steps below.
Need more help?

Node Dashboard

Step 2 - Most
business
transactions?

Is the problem affecting most of the business transactions?
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How do I know?
How do I know if the problem is affecting most of the business transactions?

1. On the Application Dashboard, look at the Business
Transaction Health pane on the right side of the
screen.

If the bar representing business transaction health is
primarily yellow or red, the answer to the question in Step 2
is Yes. Otherwise, the answer is No.
Yes – Go to Step 3.
No –
1. In the left navigation pane, click Business Transactions.
2. Sort by Health, Server Time, or other column headings to
find the business transaction that is experiencing issues.
3. Double-click the problematic business transaction to see
its Dashboard, then use the tabs to diagnose the
problem.

You have isolated the problem and don't need to continue with
the rest of the steps below.
Need more help?
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Business Transaction Dashboard
Monitor Business Transactions
Business Transactions List
Transaction Snapshots

Step 3 - Backend
problem?

Are the nodes linked to a backend (database or other remote
service) that might be causing your problem?
How do I know?
How do I know if the nodes are linked to a backend (database or other remote
service) that might be causing my problem?

Display the Tier Flow Map. If any nodes are linked to a
backend, links to those backends are displayed in the
flow map.

If a backend or the line connecting to a backend is red, the
answer to the question in Step 3 is Yes. Otherwise, the
answer is No.
Yes –
Click the line connecting to the backend to see an
information window about the backend. The contents of
the information window vary depending on the type of
backend. Use the various tabs to find the source of the
issue.
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If the backend is a database, right-click the database
icon. You have a number of options that let you see the
dashboard, drill down, etc. If you have AppDynamics for
Databases, choose Link to AppDynamics for Databases.
You can use AppDynamics for Databases to diagnose
database issues.

You have isolated the problem and don't need to continue with
the rest of the steps below.
No – Go to Step 4.
Need more help?

Backend Monitoring
Configure Backend Detection for .NET
AppDynamics for Databases
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Step 4 - CPU
saturated?

Is the CPU of the CLR saturated?
How do I know?
How do I know if the CPU of the CLR is saturated?

1. Display the Tier Flow Map.
2. Click the Nodes tab, and then click the Hardware tab.
3. Sort by CPU % (current).

If the CPU % is 90 or higher, the answer to the question in
Step 4 is Yes. Otherwise, the answer is No.
Yes – Go to Step 5.
No – Review various metrics in the Metric Browser to pinpoint
the problem.
In the left navigation pane, click Servers -> App Servers ->
<slow tier>. Review these metrics in particular:
ASP.NET -> Application Restarts
ASP.NET -> Request Wait Time
ASP.NET -> Requests Queued
CLR -> Locks and Threads -> Current Logical Threads
CLR -> Locks and Threads -> Current Physical Threads
IIS -> Number of working processes
IIS -> Application pools -> <Business application name>
-> CPU%
IIS -> Application pools -> <Business application name>
-> Number of working processes
IIS -> Application pools -> <Business application name>
-> Working Set
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You have isolated the problem and don't need to continue with
the rest of the steps below.
Need more help?

Monitor .NET Applications

Step 5 Significant
garbage collection
activity?

Is there significant garbage collection activity?
How do I know?
How do I know if there is significant garbage collection activity?

1. Display the Tier Flow Map.
2. Click the Nodes tab, and then click the Memory tab.
3. Sort by Time Spent on Collections (%) to see what
percentage of processing time is being taken up with
garbage collection activity.

If Time Spent on Collections (%) is higher than acceptable
(say, over 40%), the answer to the question in Step 5 is Yes.
Otherwise, the answer is No.
Yes – Go to Step 6.
No – Use your standard tools to produce memory dumps;
review these to locate the source of the problem.
You have isolated the problem and don't need to continue with
the rest of the steps below.
Need more help?

Monitor .NET Applications
Step 6 - Memory
leak?
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Is there a memory leak?
How do I know?
How do I know if there is a memory leak?

1. From the list of nodes displayed in the previous step
(when you were checking for garbage collecting
activity), double-click a node that is experiencing
significant GC activity.
2. Click the Memory tab, then review the committed
bytes counter and the size of the Gen0, Gen1, Gen2
and large heaps.

If memory is not being released (one or more of the above
indicators is trending upward), the answer to the question in
Step 6 is Yes. Otherwise, the answer is No.
Yes – Use your standard tools for troubleshooting memory
problems. You can also review ASP.NET metrics; click Servers
-> App Servers -> <slow tier> -> ASP.NET.
No – Use your standard tools to produce memory dumps;
review these to locate the source of the problem.
Whether you answered Yes or No, you have isolated the
problem and don't need to continue with the rest of the steps
below.
Need more help?

Monitor .NET Applications
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None of the
above?

If slow response time persists even after you've completed the
steps outlined above, you may need to perform deeper
diagnostics.
If you can't find the information you need on how to do so in the
AppDynamics documentation, consider posting a note about
your problem in a community discussion topic. These
discussions are monitored by customers, partners, and
AppDynamics staff. Of course, you can also contact
AppDynamics support.
Need more help?

AppDynamics Application Intelligence Platform
Community Discussion Boards (If you don't see
AppDynamics Pro as a topic, click Sign In at the upper
right corner of the screen.)
Troubleshoot Application Problems - PHP

The Dashboards show you when problems occur and you need
to take action. For example the Transaction Scorecard monitors
business transactions and categorizes their performance
according to thresholds.
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Troubleshooting Your
Application

For common
troubleshooting
scenarios see:
Troubleshoot
Slow Response
Times for PHP
Troubleshoot
Errors for PHP
Troubleshoot
Health Rule
Violations
When AppDynamics indicates a problem you can easily go right into troubleshooting mode.
From the All Applications dashboard click the Troubleshoot link.

Alternatively, after you have selected the application, from the left navigation menu click Tro
ubleshoot .

For more information about troubleshooting see:
Troubleshoot Slow Response Times for PHP
Troubleshoot Errors for PHP
Troubleshoot Health Rule Violations
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Troubleshoot Node Problems
Transaction Snapshots
Call Graphs
See Detailed Data Using Diagnostic Sessions
Operational Metrics
Troubleshoot Slow Response Times for PHP

Slow and Stalled Transactions
To troubleshoot slow and stalled transactions
Slow Database and Remote Service Calls
To troubleshoot slow database and remote service
calls
Learn More
When you click Troubleshoot -> Slow Response Times the
Slow Response Times window opens showing two tabs. You
can drill down into transaction issues in the Slow Transactions
tab and into database or remote services issues in the Slowest
DB & Remote Services tab.
This interactive video traces the
typical steps of identifying the
cause of a slow transaction.

Slow and Stalled Transactions

There are many reasons why a business transaction may be slow or stalled. The Slow Response
Times tab helps you find the root cause whether that be resource contention, deadlock, race
condition, or something else.
By default AppDynamics considers a slow transaction one that lasts longer than 3 times the
standard deviation for the last two hours and a very slow transaction 4 times the baseline for the
last two hours.
By default AppDynamics considers a transaction that lasts longer than 300 times the standard
deviation to be stalled.
You can configure these thresholds to better match your environment. See Set Performance
Boundaries Using Thresholds and Configure Thresholds.
To troubleshoot slow and stalled transactions
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1. Click Troubleshoot -> Slow Response Times.
You can also access this information from tabs in the various dashboards.
2. Click the Slow Transactions tab if it is not selected.
In the upper pane AppDynamics displays a graph of the slow, very slow, and stalled transactions
for the time period specified in the Time Range drop-down menu. Click the Plot Load checkbox to
see the load.
In the lower pane AppDynamics displays the transaction snapshots for slow, very slow, and stalled
transactions.
Click the Exe Time column to sort the transactions from slowest to fastest.

To drill down, select a snapshot from the list and click View Transaction Snapshot. A transaction
snapshot shows the details of an instance of a business transaction, including a call graph that
helps you identify the root cause of the slow response time. See Transaction Snapshots.
Slow Database and Remote Service Calls

Although AppDynamics does not instrument database and remote service servers directly, it
collects metrics about calls to these backends from the instrumented app servers. This allows you
to drill down to the root cause of slow database and remote service calls.
To troubleshoot slow database and remote service calls

1. Click Troubleshoot -> Slow Response Times.
You can also access this information from tabs in the various dashboards.
2. Click the Slowest DB & Remote Service Calls tab if it is not selected.
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3. In the Call Type panel select the type of call for which you want to see information or select All
Calls.
The Call panel displays the call or query with the average time per call, number of calls, and
maximum execution time (Max Time) for the calls with the longest execution time.
If transaction snapshots are available for a slow call, you can click View Snapshots link or you
can select the call and click the Correlated Snapshots tab in the lower panel. From there you can
select a snapshot and click View Transaction Snapshot to drill down to the root cause of the
slow call.

See Transaction Snapshots.
Learn More

Transaction Snapshots
Configure Thresholds
Troubleshoot Errors for PHP

Error Transactions and Exceptions
To Troubleshoot Error Transactions
To Troubleshoot Exceptions
Learn More
Troubleshooting Errors 1:14
Direct Link: https://www.youtube.com/watch?v=5
ESfBnAgvj8&index=3&list=PLbH8EadIRdvIXYrT
0oJ5bok382SRIZ993
Error Transactions and Exceptions

An error transaction is a business transaction that experienced an error during the transaction
execution. The error can be:
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A runtime error reported by the PHP server and captured by the agent. These include Fatal
Errors, Warning and Notices thrown by the PHP runtime. These types of errors do not
provide a stack trace.
Certain exceptions thrown by the application. These include unhandled exceptions (when an
exception is thrown and there is no try block) and handled exceptions during an exit call
(when there is a try block during an exit call). These types of errors do provide a stack trace.
If a transaction experiences an error, it is counted as an error transaction and not as a slow, very
slow or stalled transaction even if the transaction was also slow or stalled.
There is not a one-to-one correspondence between the number of errors and the number of
exceptions. For example, a business transaction may experience a single code 500 error in which
several exceptions were logged as the transaction passed through multiple tiers.

You can configure the types of errors that AppDynamics detects as well as the types of exceptions
to ignore. See Configure Error Detection for PHP.

To Troubleshoot Error Transactions

1. Click Troubleshoot -> Errors in the left navigation panel.
The error viewer opens.
2. Click the Error Transactions tab if it is not already selected.
3. From the time range drop-down menu select the time range for which you want to view
information about error transactions.
A graph of the error transactions displays at the top of the viewer. You can get an exact count of
the errors per minute at a particular point in time by hovering with your pointing device on the line
in the graph.
To the right of the graph is a summary of the load and the error transactions.
Check the Plot check box if you want the graph at the top of the viewer to show the load over the
selected time period. Clear this check box if you want the graph to show only the error
transactions.
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4. The error transaction snapshots are listed in the lower part of the viewer. To filter this list click S
how Filters and select the filter criteria.
5. To examine the root cause of an error, select the snapshot from the list and click View
Transaction Snapshot. See Transaction Snapshots for information about examining snapshots.
6. To identify the most expensive calls or queries, select a snapshot from the list and click Analyze
and then click Identify the most expensive calls / SQL statements in a group of snapshots.
The Most Expensive Methods / SQL Statements viewer opens.

7. In the lower panel click the Expensive Methods tab to view the methods with their total and
average execution times and call counts. Click the Expensive SQL tab to view the queries with
their counts and execution times.
To Troubleshoot Exceptions
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1. Click Troubleshoot -> Errors in the left navigation panel.
2. Click the Exceptions tab if it is not already selected.
The total exception count, HTTP Error Codes and Error Page Redirects for the selected time
range are reported in the upper panel. You can get an exact count of the exceptions per minute at
a particular point in time by hovering with your pointing device on the line in the graphs.
The exceptions list is displayed in the lower panel.
To filter the exception list, enter the filter term in the filter text field.
To see only exceptions with performance data, clear the Show Exceptions with 0 count
checkbox.
3. To view details of a particular exception, select the exception the list in the lower panel and click
View Details.
4. To view transaction snapshots for an exception:
a. In the exception detail window, click the Occurrences of this Exception subtab.

b. Select a snapshot from the list.
c. Click View Details.
d. In the snapshot flow map that displays, click Drill Down to get the details of the snapshot. See
Transaction Snapshots.
5. To view a stack trace for an exception:
a. In the exception detail window, click the Stack Traces for this Exception tab.
b. Click an exception in the left panel.
The right panel displays the stack trace for the selected exception.

Copyright © AppDynamics 2012-2014

Page 2079

Learn More

Configure Error Detection for PHP
Transaction Snapshots
Troubleshoot Application Problems - Node.js
Troubleshoot Slow Response Times for Node.js

Slow and Stalled Transactions
To troubleshoot slow and stalled
transactions
High CPU Times
To troubleshoot slow processes
Learn More
When you click Troubleshoot -> Slow Response Times, the Slow Response Times window
opens showing two tabs. You can drill down into transaction issues in the Slow Transactions tab
and into database or remote services issues in the Slowest DB & Remote Services tab.
Slow and Stalled Transactions

There are many reasons why a business transaction may be slow or stalled.
By default AppDynamics considers a slow transaction one that lasts longer than 3 times the
standard deviation for the last two hours and a very slow transaction 4 times the baseline for the
last two hours.
By default AppDynamics considers a transaction that lasts longer than 300 times the standard
deviation to be stalled.
You can configure these thresholds to better match your environment. See Thresholds and Config
ure Thresholds.
To troubleshoot slow and stalled transactions

1. Click Troubleshoot -> Slow Response Times.
2. Click the Slow Transactions tab if it is not selected.
In the upper pane AppDynamics displays a graph of the slow, very slow, and stalled
transactions for the time period specified in the Time Range drop-down menu.
Check the Plot Load check box to see the load n the graph.
In the lower pane AppDynamics displays the transaction snapshots for slow, very slow, and
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stalled transactions.

3. In the lower pane, click the Exe Time column, then toggle the direction to sort the
transactions from slowest to fastest.
4. To drill down, select a slow or very slow snapshot from the list and click View Transaction
Snapshot or just double-click. A transaction snapshot shows the details of an instance of a
business transaction.
5. Click Drill Down on the icon for the slow or very slow transaction
insert image
6. See Transaction Snapshots for information about drilling down into a snapshot.

High CPU Times
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Your users' experience may be slow because of processes that consume a lot of CPU time
blocking other processes.
To troubleshoot slow processes

1. Navigate to the Node dashboard from the left navigation pane by clicking Servers->App
Servers-><your-node-name>.

2. In the node dashboard click the Process Snapshots tab. You may have to click the >> in the
tab line to see the Process Snapshots tab.
3. Click Collect Process Snapshots.

4. In the Collect a Process Snapshot window set the duration to between 1 and 60 seconds.
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By default, process snapshots are taken automatically at regular intervals, but this window
lets you take them whenever you need them.
5. Click Start.
In a few minutes you should see some new process snapshots in the list.
6. Sort the list by toggling the Exe Time column in the process snapshots list so that the
snapshots for the slowest processes are at the top of the list.

7. Double-click one of the slow process snapshots.
8. In the process snapshot, click the CALL GRAPH tab if it is not selected.
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9. Examine the Time column in the call graph to identify which of the calls are slow.
10. Click the

at the end of the row for the slow call to see details.

11. To see business transaction associated with the slow process click the BUSINESS
TRANSACTIONS tab. This tab displays business transactions associated with the process
snapshot when the entire business transaction executes within the time covered by the
process snapshot.

Learn More

Monitor Node.js Business Transactions
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Monitor Node.js Processes
Transaction Snapshots
Configure Thresholds
View Process Snapshots
Process Snapshots and Business Transactions

Analyze and Improve
Reports
Using the Report Templates
Business Transaction Summary
Business Transaction Trend
Hardware Utilization
Memory Utilization
Node Performance Summary
Node Trend
Other Reports
Reporting enables you to create reports based on metrics that AppDynamics collects and then
export them to PDF documents. Reports provide information to use for long-term analysis and
planning.
AppDynamics provides report templates that you can configure for your purposes. You can also
create a report from the data displayed in the Metric Browser.
Using the Report Templates

To access and use any of the report templates:
1. From the left navigation pane, click Analyze -> Reporting.
The Report Browser is displayed.
2. Click the Generate Report button on the report template that you want to use.
The report template is displayed.
3. Configure the report in the template.
4. Click the Export PDF button to export the report to a PDF document. In the dialog that appears,
name the report and click Save.
Business Transaction Summary

The Business Transaction Summary Report summarizes the following indicators for the Business
Transactions that you select:
Service Levels
Time in Milliseconds
Calls
Calls / Minute
Errors
Error %

Copyright © AppDynamics 2012-2014

Page 2085

Slow Requests
Very Slow Requests
Stalled Requests,
Tier
Type
In the template, configure time range covered by the report, the Business Transactions to be
summarized, and the sorting parameters.
You can start entering the name of the Business Transaction in the search field to locate the
Business Transactions.
Business Transaction Trend

The Business Transaction Trend Report shows the following key performance indicators for the
specified Business Transaction.
Problems
Policy Violations
Stalls
Abnormal Slow Rate
Abnormal Error Rate
Other Problems
Summary Statistics
Load in Calls
Load in Calls / Minute (includes graph)
Average Response Time in Milliseconds (includes graph)
Error %
Total Errors
Errors / Minute (includes graph)
Response Time Breakdown - absolute and percentage
Normal
Slow (includes graph)
Very Slow (includes graph)
Stalls (includes graph)
In the template, configure the time range covered by the report and the Business Transaction to
be covered in the report,
You can start entering the name of the Business Transaction in the search field to locate the
Business Transaction.
Hardware Utilization

The Hardware Utilization Report shows the following hardware utilization metrics for the selected
tiers:
Number of Nodes
Current CPU %
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Average CPU %
Current Memory %
Average Memory %
Disk IO Reads / Second in KB
Disk IO Writes / Second in KB
Network IO Writes / Second in KB
For hardware utilization per node, see Node Trend.
In the template, configure the time range covered by the report, the tier or tiers to report on, the
sorting parameters, and the format of the report (tree or grid).
Memory Utilization

The Memory Utilization Report shows the following memory utilization metrics for the selected tiers
and nodes:
Max Heap
JVM CPU Burnt in Milliseconds per Minute
GC Time Spent in Milliseconds per Minute
Major Collections
Major Collection times
Minor Collections
Minor Collection Times
In the template, configure the time range covered by the report, the tier or tiers to report on, the
sorting parameters, and the format of the report (tree or grid).
Node Performance Summary

The Node Performance Summary Report summarizes the following performance indicators for the
selected tiers and nodes:
Number of Nodes in the Tier (if using tree format)
Response Time in Milliseconds
Number of Calls
Number of Errors
Number of Slow Requests
Number of Very Slow Requests
Number of Stalled Requests
In the template, configure the time range covered by the report, the tiers and nodes to report on,
the sorting parameters, and the format of the report (tree or grid).
Node Trend

The Node Trend Report shows the following information for the selected node:
Problems
Policy Violations
Stalls
Abnormal Slow Rate
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Abnormal Error Rate
Other Problems
Summary Statistics
Load in Calls
Load in Calls / Min (includes graph)
Average Response Time in Milliseconds (includes graph)
Number of Errors
Errors Per Minute (includes graph)
Response Time Breakdown
Normal
Slow - Number and Percentage
Very Slow - Number and Percentage
Stalls - Number and Percentage
If there is a machine agent installed on the node, the report includes the graphs of the following
hardware metrics on the node if the data is available:
Network-Outgoing KB / Sec
Network Incoming KB / Sec
Disks KB Written / Sec
Disks KB Read / Sec
Memory % Used
CPU % Busy
In the template, configure the time range covered by the report and the node to report on.
Other Reports

You can also create PDF-formatted reports of the data displayed in the following components:
Application Dashboard: In the Actions drop-down menu, click Export as PDF Report.
Tier Dashboard: In the Actions drop-down menu, click Export as PDF Report.
Node Dashboard: In the Actions drop-down menu, click Export as PDF Report.
Snapshot Viewer: In the Call Drill Down window, click Export to PDF.
Metric Browser: In the Export Data drop-down menu, click Export as PDF Report.

Business Metrics
Accessing Business Metrics
Business Metrics in Call Graphs
Configuring Business Metrics Using Information Points
Business Metrics and Health Rules
Metrics for Ignored Errors
Example
Learn More
Business metrics capture data from a method's parameters or return values to report on the
performance of the business.
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For example:
What is the average value of the credit card total?
How many credit cards did my application process in a certain time period, regardless of the
business transaction?
What was the average time spent processing a credit card transaction?
What is the current rate of rejected credit cards?
Which items were best-sellers in a certain time period?
AppDynamics gathers business metrics using information points. Information points instrument
methods in your application code outside the context of a particular business transaction and
extract data from code. When the method configured for the information point is invoked, the
information point metric is captured.
Accessing Business Metrics

To access the Information Points List, in the left navigation pane click Analyze -> Information
Points.
The Information Point List summarizes metrics for all the information points in an application.
Business metrics show a value in the # of Custom Metrics column.

From the Information Points List you can:
Filter the list
Select an information point
View one of its metrics in the Metrics Browser
View a graph all its metrics on a dashboard
Each information point has its own dashboard, which reports KPIs (average response time, load,
and errors) for the information point, as well as any custom business metrics defined for the
information point.
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Business metrics appear in the Information Points tree of the Metric Browser.
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Business metrics can be accessed from the AppDynamics REST API, just like any other metric.
See To Copy the REST URL for a Metric.
Business Metrics in Call Graphs

You can configure snapshots to display information point invocations in call graphs by setting the
enable-info-point-data-in-snapshots node property to true. By default the property is false. See Ap
p Agent Node Properties.
When the enable-info-point-data-in-snapshots node property is set, information point calls appear
in the User Data section of the call graph.
Configuring Business Metrics Using Information Points

You define an information point based on the class and method signature of the method being
monitored. See Configure Business Metric Information Points. For PHP agents see Configure
Information Points for PHP.
Business Metrics and Health Rules

You can use any parameter or return value of the method to generate a custom business metric
across multiple business transactions. You can then create a custom health rule based on the
performance of such a custom metric. See Health Rules.
Metrics for Ignored Errors
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Exceptions are expensive to create even in modern JVMs. If a particular exception is ignored but
still happens often, it can contribute to a CPU spike in the JVMs. The metrics for ignored errors
can provide insights into such situations.
Example
{
// AppDynamics Exit Point interceptor is applied on this method, so we will
automatically track this exception
service.connect(URL);
}
catch(ServiceException sEx)
{
service.connect(backupURL);
}

In the above code the 'ServiceException' is not really fatal since the code has logic to handle it, so
you may decide to add it to 'ignore' list. But if this exception is not truly an exceptional case and
happens every time the code executes, having the metric for ignored errors will help you become
aware of the additional overhead.
Learn More

Code Metrics
Configure Code Metric Information Points
Call Graphs
Data Collectors Versus Information Points
Configure Percentile Metrics for Java
Configure Business Metric Information Points
To create a business metric information point
Learn More
AppDynamics provides information points to specify code and business metrics. See Code Metrics
and Business Metrics.
To create a business metric information point

Configuring business metrics, also called custom metrics, involves:
Identify the parameter or the return type of a method invocation.
Derive a value from the method invocation to represent the metric.
Choose either to generate the sum of the value over a period of time or to average it.
For PHP agents see Configure Information Points for PHP.
1. Select your application.
2. Click Analyze -> Information Points.
3. Click Add (the + symbol).
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4. Enter a name for the information point.
5. Select the agent type.
6. Define the class and the method on which the information point is based.

7. (Optional) If the method is overloaded, check the Is this Method Overloaded option and add
the parameters.
8. (Optional) Define match conditions. A match condition ensures that only those invocations that
match the configured conditions for the Information Point will be captured.
9. In the Define Custom Metrics section, click Add. Choose the parameter or return value from
which the metric needs to be generated.
10. Choose the data rollup over time.
11. Click Save.
12.

Important: Restart the application server on which this rule will be applied.

For example, this definition counts the sum of books ordered in the Acme Bookstore application.
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Learn More

Business Metrics
Information Points
Configure Information Points for PHP
Business Metric for Revenue Data
You can use an information point to create a custom metric that extracts revenue information from
your application. Then you can view the revenue over time in the information point's dashboard, in
the Metric Browser or in a graph in a custom dashboard.
This example can be extrapolated to capturing and displaying other types of business metrics,
such as number of items sold or returned, current inventory, sales tax collected, and so on.
Create the Information Point

The first step is to create an information point based on a method in your application that passes
or returns the revenue information that you want to capture. In this example we create an
information point named Acme Revenue based on the saveOrder method.
Then in the information point we create a custom metric named Revenue based on the sum of the
invoked object's getAmount method. This method returns the revenue from each order that is
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processed. We select SUM for the data rollup to accumulate the revenue totals.

View the Revenue Metric

There are several ways to view the revenue data:
In the Custom Metrics panel of the information point's dashboard:

In the Information Point's tree in the Metric Browser:
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In a graph widget that you configure in a custom dashboard:

To configure the widget, specify the Revenue metric as the data to represent:
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Learn More

Business Metrics
Configure Business Metric Information Points
Create a Custom Dashboard

Operational Metrics
AppDynamics provides tools to help you analyze patterns and discover relationships between
different metrics and performance data over time. See:
Code Metrics

Accessing Code Metrics
Code Metrics in Call Graphs
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Configuring Code Metrics Using Information Points
Code Metrics and Health Rules
Learn More
Code metrics capture how a method is performing. For example:
How many times was the method executed?
How long did it take to execute on average?
How many concurrent users are using my application? (extrapolated by comparing
information points on the login and logout methods)
AppDynamics gathers code metrics using information points. Information points instrument
methods in your application code outside the context of a particular business transaction. Use
them when you need to track data from the same method across multiple business transactions.
Accessing Code Metrics

To access the Information Points List, in the left navigation pane click Analyze -> Information
Points.
The Information Point List summarizes metrics for all the information points in an application.
Code metrics appear in the Information Points tree of the Metric Browser and can be accessed
from the AppDynamics REST API, just like any other metric. See To Copy the REST URL for a
Metric.

From the Information Points List you can:
filter the list
select an information point
view one of its metrics in the Metrics Browser
view a graph all its metrics on a dashboard
Code Metrics in Call Graphs

You can configure snapshots to display information point invocations in call graphs by setting the
enable-info-point-data-in-snapshots node property to true. By default the property is false. See Ap
p Agent Node Properties.
When the enable-info-point-data-in-snapshots node property is set, information point calls appear
in the User Data section of the call graph.
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Configuring Code Metrics Using Information Points

You define an information point based on the class and method signature of the method being
monitored. See Configure Code Metric Information Points. For PHP agents see Configure
Information Points for PHP.
Code Metrics and Health Rules

You can then create a custom health rule based on the performance of such a custom metric. See
Health Rules.
Learn More

Business Metrics
Configure Code Metric Information Points
Data Collectors Versus Information Points
Configure Information Points for PHP
Configure Code Metric Information Points

To create a code metric information point
Learn More
AppDynamics provides information points to specify code and business metrics. See Code Metrics
and Business Metrics.
For PHP agents see Configure Information Points for PHP.
To create a code metric information point

1. Select your application.
2. Click Analyze -> Information Points.
3. Click Add (the + symbol).
4. Enter a name for the information point.
5. Select the agent type.
6. Define the class and the method on which the information point is based.
7. (Optional) If the method is overloaded, check the Is this Method Overloaded option and add
the parameters.
8. (Optional) Define match conditions. A match condition ensures that only those invocations that
match the configured conditions for the Information Point will be captured. For example, the ACME
Bank AccountManager.updateAccount(String customerType, Account newAccountData) method,
you can capture only those requests that invoke the parameter "customerType" with value
"platinum".
For example, the following configuration counts the number of calls to the method that deletes
items from the cart:
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Learn More

Code Metrics
Information Points
Configure Information Points for PHP
Scalability Analysis
Scalability Analysis Comparisons
To access Scalability Analysis
To use scalability data
Learn More
Scalability problems in a distributed environment can cause remote communication overhead.
Examples of scalability problems include:
Increased inter-tier time when tiers are newly separated
Increased inter-tier time in conjunction with chattiness
Over-sized payloads with network saturation
Scalability Analysis Comparisons

You can compare:
Response Time vs Application Load
You can compare average response time versus calls per minute for a business application,
a business transaction, a tier, or a node.
CPU Utilization vs Application Load
You can compare CPU % usage versus calls per minute for a business application, a tier, or
a node.
To compare CPU % usage, a standalone or embedded machine agent must be installed on
the node machine.
The following graph shows Response Time vs Load at the application level for the past three days.

Copyright © AppDynamics 2012-2014

Page 2101

To access Scalability Analysis

In the left navigation pane for an application click Analyze -> Scalability Analysis.
To use scalability data

1. Select the time range to be covered by the analysis from the Time Range menu.
Modifying the time range in this window does not modify the time range settings in other parts of
the UI.
2. Click either the Response Time vs Load tab or the CPU Utilization vs Load tab, depending
on which analysis you want to perform.
3. In the left panel of the scalability viewer either:
Select Application for analysis at the application level.
or
Navigate to the business transaction, tier, or node that you want to analyze.
4. Browse the graph and explore:
You can change between a scatter plot view and a side-by-side graph view.

You can toggle the Best Fit Line in the scatter plot view. The Best Fit Line is calculated using
the Quadratic Least Squares algorithm.
You can hover over data points to view metrics at particular times.
Double-click on a data point to open its metrics in the Metric Browser.
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Click the tab header Analyze Response Time Vs Load or Analyze CPU vs Load to update
the graph.
You can export the data as a comma-separated values file:

Learn More

Infrastructure Metrics
Metric Browser
Correlation Analysis
To perform correlation analysis between two metrics
Learn More
Correlation analysis lets you compare two metrics on different axes to see how one metric
correlates with the other.
To perform correlation analysis between two metrics

1. In the left navigation pane, click Analyze -> Correlation Analysis.
2. Click Select X Axis Metric.
3. From the metric browser navigate to the metric that you want to graph on the X axis and
double-click the metric.
4. Click Select Y Axis Metric.
3. From the metric browser navigate to the metric that you want to graph on the Y axis and
double-click the metric.
The graph is displayed when metrics for both the axes are selected.
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Hover over one or more of the data points to view their metrics at particular times.

Learn More

Metric Browser
Compare Releases
Entities to Compare
Metrics to Compare
To Compare Releases
Learn More
You can compare metrics for two different time periods on a split screen.
This feature is particularly useful for comparing different versions of a release.
Entities to Compare

You can compare summary metrics:
for the entire application
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for a specific business transaction
for a specific tier
for a specific node
Metrics to Compare

The metrics you can compare are:
Summary Key Performance Indicators (KPIs)
Displays the KPI summaries from the dashboards for the selected entity
(application/business transaction/tier/node).
Transaction Snapshots
Displays the transaction snapshots for the selected entity.
Graphical Flow
Displays flow graphs for the selected entity.
KPI Trend Graphs
Displays the KPI summaries from the dashboards for the selected entity
(application/business transaction/tier/node).
Select which sets of metrics you want to compare from the View drop-down menu.

To Compare Releases

1. In the left navigation pane, click Analyze -> Compare Releases.
2. Set the time ranges to compare from the Time Range drop-down menus in both panes.
3. Select the entities to compare in the Select What to Compare panel.
4. Select the metrics that you want to compare from the View drop-down menu.
5. Click Compare.
Whenever you change the entities or the metrics, click Compare to refresh the display.
Learn More

Dashboards
Transaction Snapshots
Time Ranges
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Server Monitoring
AppDynamics provides machine agents to monitor your
hardware and operating systems.
There are two machine agents:
The Standalone Machine Agent, sometimes called the
Java Machine Agent, is a separate installation. See Stan
dalone Machine Agent.
The embedded .NET Machine Agent is automatically
installed with the .NET Agent. See Configure the .NET
Machine Agent.
Combined with app agents, the machine agents help you
monitor your entire infrastructure. See Monitor Infrastructure.
You can leverage machine agent metrics in health rules to proactively monitor your infrastructure.
See Health Rules.

Standalone Machine Agent
Standalone Machine Agent Architecture
Metrics Collected by the Standalone Machine Agent
Limiting Disk Metrics Collection
To switch from the Java Hardware Monitor to the Hardware Monitor
Standalone Machine Agent and the Flow Maps
Standalone Machine Agent and the Server Health Indicator
Using the Standalone Machine Agent
To access the Machine Agents window
Resetting a Standalone Machine Agent
To reset (stop/restart) a Standalone Machine Agent
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Associate a Standalone Machine Agent with an Application
To associate a Standalone Machine Agent with a business application
To associate multiple agents with multiple business applications
To associate one Standalone Machine Agent agent with multiple JVMs, each
running on separate VMs on the same machine
Resolving Problems
Learn More
This topic covers the Standalone Machine Agent. It does not cover the embedded .NET Machine
Agent included with the App Agent for .NET.
The Standalone Machine Agent uses a built-in hardware monitor to report metrics and hardware
usage data. The hardware monitor is a script that writes data to STDOUT of a process. Once
installed, the Standalone Machine Agent runs and reports to the Controller once a minute.
Use the Standalone Machine Agent to:
Collect basic metrics from the operating system that display in the hardware tabs of the Nod
e Dashboard. See Monitor Hardware.
Report the metrics passed in by custom monitors. See Add Metrics with a Monitoring
Extension.
Run remediation scripts for policy actions. See Remediation Actions.
Run the JVM crash guard feature. See JVM Crash Guard.

Standalone Machine Agent Architecture

Copyright © AppDynamics 2012-2014

Page 2107

Metrics Collected by the Standalone Machine Agent
The agent automatically collects the following performance data:
1. CPU
a. Busy, Free
2. Memory
a. Used, Free, Total
3. Disk
a. Network mounted disks (Free, Used, IO Writes/Reads in KB/s and packets)
b. Local disks (Free, Used, IO Writes/Reads in KB/s and packets)
You can configure the agent to monitor virtual disks.
4. Network interfaces
a. No Loopback
b. No disabled or unconnected
c. Incoming KB, KB/s, packets, packets/s
d. Outgoing KB, KB/s, packets, packets/s
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There are many more metrics collected which you can view in the Metric Browser ->
Application Infrastructure Performance ->Hardware Resources or add them to your Custom
Dashboard. To add CPU metrics to your Custom Dashboard, add the metrics for only one
node per server because the metrics collected for a node are for the entire server hosting
that node.

Limiting Disk Metrics Collection

By default, the Standalone Machine Agent uses the Java Hardware Monitor (Sigar API-based),
which may collect more metrics than you need.
For example, you may not want to see backup metrics such as the following, where out of a total
3315 metrics reported by the Standalone Machine Agent, 2584 are due to back up disk metrics :
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Instead of using the default Java Hardware Monitor the Standalone Machine Agent can use the
Hardware Monitor which uses an OS specific script file (linux-stat.sh in this case) to capture stats,
which will not track backup porcesses.
To stop tracking backup process and limit future disk metrics switch from the Java Hardware
Monitor to the Hardware Monitor.
To switch from the Java Hardware Monitor to the Hardware Monitor

1. Stop the Standalone Machine Agent by stopping its process. See below for info on
identifying the agent process.
2. Switch from the Java Hardware Monitor to Hardware Monitor as follows:
a. Open for edit monitor.xml from <Agent install directory>/monitors/HardwareMonitor/m
onitor.xmll
b. Change <enabled>false</enabled> to <enabled>true</enabled> and then save the
file.
c. Open for edit <Agent install directory>/monitors/JavaHardwareMonitor/monitor.xml.
d. Change <enabled>true</enabled> to <enabled>false</enabled> and then save the
file.
3. Restart the Standalone Machine Agent.
From the command line, enter java -jar <Agent install directory>/machineagent.jar.
This limits the future disks metrics but will not delete the existing metrics.
Which process is the machine agent process?
For Linux
Use the following command to identify which process is running the Standalone Machine
Agent.
ps -ef | grep machine

For Windows
Process Explorer is a free application from Microsoft that can help you identify the
Standalone Machine Agent process. When there are multiple java processes running,
hover over a java process in Process Explorer to identify the process that was started
using the machineagent.jar file.
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For example, in Process Explorer, hover over a process to see information about how the
process was started as you can see in the following window:

You can download Process Explorer at http://technet.microsoft.com/en-us/sysinternals/bb8
96653.aspx.

Standalone Machine Agent and the Flow Maps
The Standalone Machine Agent monitors a particular machine and not a particular application
server. The agent can therefore refer to multiple nodes running on the same machine. A flow map,
on the other hand, displays the communication between different nodes during application
execution, or the business transaction flow from tier to tier. A Standalone Machine Agent cannot
be a part of the flow and therefore is not shown in the flow map.

Standalone Machine Agent and the Server Health Indicator
Metrics monitored by the agent are included in the infrastructure health indicator in the
dashboards.
The health indicator is driven by health rule violations in the given time period and health rule
violations are configured on hardware metrics collected by the Standalone Machine Agent. Health
rules for all possible metrics are not configured out-of-the-box, so you might want to configure
additional health rule according to your requirements. For details see Configure Health Rules.

Using the Standalone Machine Agent
To access the Machine Agents window

In the upper right menu bar of the controller UI, click Settings -> AppDynamics Agents.
AppDynamics lists all agents for all business applications.
Resetting a Standalone Machine Agent

The reset operation purges all existing metrics for an agent and starts gathering them again. It
stops the agent and starts it again.
To reset (stop/restart) a Standalone Machine Agent
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1. In the Machine Agents window of the Controller UI, select an agent.
2. Click Reset Selected Machine Agent.
Associate a Standalone Machine Agent with an Application

If no configuration details are provided during installation, or if the node has been moved to
another application, then the Standalone Machine Agent appears in the System -> Agents tab as
"not associated with any applications". To have the Standalone Machine Agent start sending
metrics or executing workflow tasks, manually associate it with an application.
The following message in the agent log (<machine_agent_home>/logs/machine-agent.log)
indicates that there is no application associated with the agent:
Received Metric Registration request for a machine id:<NNNNN> that is NOT
registered to any nodes yet, sending back null response!

To associate a Standalone Machine Agent with a business application

1. In the AppDynamics Agents window, select an agent.
2. Click Associate with an Application.
To associate multiple agents with multiple business applications

If the machine is hosting servers that belong to multiple business applications, you may need
multiple agents.
If there are nodes belonging to multiple business applications, you can run multiple agents each
configured to report metrics for a different node, tier, and application.
You cannot "assign" a single Standalone Machine Agent to multiple business application per se. A
Standalone Machine Agent on a specific machine is automatically associated with all nodes
running on that machine. A node is associated with a single business application. Therefore an
application is associated with the agents of its nodes. By default a Standalone Machine
Agent inherits the application/tier/node names of the App Agent installed on the same hardware.
To associate one Standalone Machine Agent agent with multiple JVMs, each running on separate VMs on the
same machine

If you have an application where a tier has three nodes running on the same machine and you
want the Standalone Machine Agent to report the metrics for their host machine to each node do
the following
1. Stop the agents for all app agent nodes and the machine agent node associated with the
application. If this is is fresh application association ignore this step.
2. Start the appserver agent node for each VM (using the app, tier and node details provided in
<AppAgent install directory>/conf/controller-info.xml) with the -D JVM arg, in addition to the
-javaagent argument as below .
-Dappdynamics.agent.uniqueHostId=myTierAHostName1 -javaagent
3.
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3. Start the Standalone Machine Agent with same uniquehostid used for agent nodes
associated above.
java -Dappdynamics.agent.uniqueHostId=myTierAHostName1 -jar
machineagent.jar
Ensure sure you have not provided application-name, tier-name, and node-name details in
<machineagent install directory>/conf/controller-info.xml file.
Resolving Problems

Switch from the Java Hardware Monitor to the Hardware Monitor if you see messages similar to
the following in the logs:

[Worker-7] 12 Sep 2014 07:27:49,449 WARN MonitorOutputHandler - Metric Reporter
type mismatch for metric [Hardware Resources|Network|Incoming packets/sec]
com.singularity.ee.agent.commonservices.metricgeneration.metrics.MetricReporterT
ypeMismatchException: Aggregator of OBSERVATION already exists for metric Metric
Identifier[Hardware Resources|Network|Incoming packets/sec] ID[0]

Learn More
Administer Standalone Machine Agents
Configure the .NET Machine Agent
Install the Standalone Machine Agent

Install the Standalone Machine Agent
The Standalone Machine Agent
Prerequisites for Installing the Standalone Machine Agent
To install the Standalone Machine Agent
Resolve Standalone Machine Agent Installation Issues
To verify that the agent is running
To resolve agent connectivity problems
Learn More
The Standalone Machine Agent

The AppDynamics Standalone Machine Agent, also called the Machine Agent, is a standalone
Java program that collects performance statistics about your environment. It can be deployed on
any machine that hosts application servers, database servers, messaging servers, Web servers,
etc. It has an extensible architecture.
The Standalone Machine Agent supports hardware monitoring on most platforms. You can also wri
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te custom plugins for monitoring particular hardware metrics.
The following illustration shows the architecture for the Standalone Machine Agent. A Standalone
Machine Agent collects hardware metrics using the default and custom plugins and sends task
execution data to the Controller.

Prerequisites for Installing the Standalone Machine Agent

The Standalone Machine Agent requires Java 1.5 or later to be installed on the machine. You can
download Java 1.6 from the Oracle website.
A machine can have only one active Standalone Machine Agentinstallation at a time. Make sure
you do not have any previous running installation processes before you install.
To install the Standalone Machine Agent

1. Download the Standalone Machine Agent.
Download the agent from AppDynamics Download Center.
You can also download from the Linux command line.
The Standalone Machine Agent is packaged as a zip file.
2. Extract the zip file to the destination directory.
Do not use spaces in the destination directory path.
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For Windows environments, unblock the zip file before you extract it. To unblock the zip file,
right-click on the zip file and select the Properties tab. On the Properties tab, choose unblock
to unblock the file.
3. Configure how the agent connects to the Controller.
Configure properties for the Controller host name and port number using either the
<Machine_Agent_Installation_Directory>/conf/controller-info.xml file or by adding system
properties to the JVM startup script file.
Configure using

Configure using

Required

Default

controller-info.x
ml

System
Properties

<controller-host>

-Dappdynamics.c
ontroller.hostNa
me

Yes

None

<controller-port>

-Dappdynamics.c
ontroller.port

Yes

For On-premise
Controller
installations:
By default, port
8090 for HTTP
and 8181 for
HTTPS
communication.
For SaaS
Controller
service:
By default, port
80 for HTTP and
port 443 for
HTTPS
communication.

If you start a Standalone Machine Agent on a machine that already has an App Agent for
Java or the App Agent for PHP installed, the Machine Agent will automatically associate itself
with the app agent's application, tier, and node settings. If you install an App Agent for PHP
on the same machine as the Machine Agent, install the App Agent before the Machine Agent,
and do not specify the tier and node in the machine agent configuration.
To configure agent to use SSL see Enable SSL for Communicating with the Controller.
To configure the agent to use proxy settings see Proxy Settings for the Controller.
4. (For Multi-tenant mode or SaaS installations only.) Configure the agent account information.
This step is required only when the AppDynamics Controller is configured in Controller Tenant
Mode or when you Use a SaaS Controller. Skip this step if you are using single-tenant mode.
Specify the properties for Account Name and Account Key. This information is in the welcome
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email sent by AppDynamics Support Team.
Configure using

Configure using

Required

Default

controller-info.x
ml

System
Properties

<account-name>

-Dappdynamics.a
gent.accountNa
me

Required only if your
Controller is
configured for
multi-tenant mode or
if your
Controller is hosted.

None.

<account-access-key
>

-Dappdynamics.agent
.accountAccessKey

Required only if your
Controller is
configured for
multi-tenant mode or
if your
Controller is hosted.

None.

5. Configure the business application, tier, and node.
If there is an App Agent already installed on the machine, AppDynamics automatically makes
the association.
If there is no App Agent installed on the same machine, specify the application, tier, and node
names.
Edit the agent <Agent_Install_Directory>/conf/controller-info.xml file and specify the following
elements:
Configure using
controller-info.xml

Configure using
System Properties

<application-name>

-Dappdynamics.agent.applicationName

<tier-name>

-Dappdynamics.agent.tierName

<node-name>

-Dappdynamics.agent.nodeName

If you do not provide configuration details the Standalone Machine Agent will not be
associated with a business application. You can manually associate the agent in the UI at a
later time. See Administer Standalone Machine Agents.
6. (Optional) Configure the agent to run automatically when the machine starts.
See Machine Agent Install and Admin FAQ.
7. Start the agent.
In a command line console, execute the following command to start the Standalone Machine
Agent:
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java -Xmx32m -jar machineagent.jar

Alternatively, in a Linux environment, you can execute the following command in the
background:
nohup java -Xmx32m -jar machineagent.jar &

If your application uses a large number of AppDynamics extensions with the machine agent,
you may need to increase the size of the memory allocation as follows:
java -Xms64m -Xmx64m -jar machineagent.jar &

8. Verify the agent installation.
Open the <Agent_Install_Directory>/logs/machine-agent.log file. After successful installation,
this file should contain the following message:
Started AppDynamics Machine Agent Successfully

This message is also printed on the STDOUT of the process.
9. Verify that the agent is reporting to the Controller.
In the left navigation panel, click Servers -> App Servers -> <Tier> -> <Node>.
AppDynamics displays the Tier Dashboard for the selected tier.
When Standalone Machine Agentis reporting to the Controller, the Machine Agent Status
column shows a green up arrow icon.
You should see an "up" arrow symbol listed for the agent.
Resolve Standalone Machine Agent Installation Issues
To verify that the agent is running

Use the following command to verify that the agent script is running:
Linux:
ps -ef | grep machine

Windows:
1. Open a command line console.
2. Start the Task Manager and click the Processes tab.
3. The agent process should be running. If the script is not running, terminate the Standalone
Machine Agent Java process and restart it.
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To resolve agent connectivity problems

If when you start the Standalone Machine Agent, it cannot register with the controller or associate
with the same node in the controller, looking at the stack trace may reveal the reason why.
For example, the following message in the stack trace may indicate that the application, tier, and
node information was not provided during the Standalone Machine Agent startup or in the
controller-info.xml file.
<execution-output>System agent 239590 not associated with application, metric
registration request refused.</execution-output>

Make sure that the application, tier, and node information is either provided during the Standalone
Machine Agent startup or in the controller-info.xml file. For information on configuring
the Standalone Machine Agent, see Machine Agent Configuration Properties.
After providing the above information, restart the Standalone Machine Agent and check the agent
behavior. Standalone Machine Agent log files may also provide some insight into problems.

Which process is the machine agent process?
Process Explorer is a free application from Microsoft that can help you identify the
Standalone Machine Agent process. When there are multiple java processes running,
hover over a Java process in Process Explorer to identify the process that was started
using the machineagent.jar file.
For example, in Process Explorer, hover over a process to see information about how the
process was started as you can see in the following window:

You can download Process Explorer at http://technet.microsoft.com/en-us/sysinternals/bb8
96653.aspx.
Learn More

Configure the Machine Agent to Automatically Start on Linux
Configure the Machine Agent to Automatically Start on Windows
Metrics Limits
Shut down the Machine Agent
Monitor Hardware
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Machine Agent Install and Admin FAQ
Standalone Machine Agent Configuration Properties
Metric Browser
Add Metrics Using Custom Monitors
Installing the Machine Agent on a PHP Node
Install the Standalone Machine Agent as a Windows Service
To install the Standalone Machine Agent as a service
To uninstall the Standalone Machine Agent as a service
Known Issues
Most Windows server software runs as a service when the machine boots up. To secure your
environment and ensure Standalone Machine Agent availability, you can install the Standalone
Machine Agent as a Windows service using the SRVANY.EXE and SC.EXE utilities that are part of
the Microsoft Resource Kit for Windows 2003 Server. The SRVANY.EXE tool creates a Windows
service that launches the JVM processes for the agent in non-GUI mode using parameters
specified in the registry of the service. The SC.EXE command is used to install and uninstall the
agent service.
Advisement
This procedure involves editing the registry. Before proceeding, ensure you understand
how to backup and restore the registry as described in the WIndows Registry Editor online
help topics.
To install the Standalone Machine Agent as a service

1. Download and install the Standalone Machine Agent.
Install the agent as usual, described in Install the Standalone Machine Agent.
2. Obtain the INSTSRV.EXE and SC.EXE utilities.
Download the Windows Server 2003 Resource Kit Tools, at http://www.microsoft.com/en-us/
download/details.aspx?id=17657. The required utilities are included in this resource kit
3. Prepare registry and batch command files.
To simplify service creation and deregistration, have included two batch command files,
InstallService.cmd and UninstallService.cmd. InstallService.cmd requires the information in
the MachineAgent.reg file to set the registry key for the service.
Using a plain text editor, such as Notepad, create three files as indicated below and
customize them for your environment. For convenience, save these files at the root of
<agent install dir>/. You can alternatively download these files, which are attachments to
this topic, by clicking their names below and then edit the downloaded files.
MachineAgent.reg to set the registry key values for the service
InstallService.cmd to install the service
UninstallService.cmd to uninstall the service
a. Customize MachineAgent.reg
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a.

MachineAgent.reg - Standalone Machine Agent registry settings, used in
InstallService.cmd
Windows Registry Editor Version 5.00
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\AppDynamics
Machine Agent Service\Parameters]
"Application"="d:\\AppDynamics\\MachineAgent\\jre6\\bin\\java.exe"
"AppParameters"="-jar MachineAgent.jar"
"AppDirectory"="d:\\AppDynamics\\MachineAgent"

Edit the service name, Application, AppParameters, and AppDirectory values of this
file for your environment.
The service name is specified on the first line of this file.
AppDynamics Machine Agent Service in the example above. If you
change this name, you must also change the service name in the
InstallService.cmd file.
Application is the path to the JDK you use for Standalone Machine Agent.
d:\\AppDynamics\\MachineAgent\\jre6\\bin\\java.exe in the
example above.
AppParameters is everything you want to pass to the JVM as arguments.
-jar MachineAgent.jar in the example above.
AppDirectory points to the agent working directory.
d:\\AppDynamics\\MachineAgent in the example above.
b. Customize InstallService.cmd

InstallService.cmd - Installs the Standalone Machine Agent as a service
@echo off
rem Install AppDynamics Machine Agent Service using srvany.exe from
the Windows Resource Kit
echo Installing AppDynamics Machine Agent Service into the Service
Manager
sc create "AppDynamics Machine Agent Service" binPath=
d:\AppDynamics\MachineAgent\srvany.exe
echo done.
echo Setting Registry settings for AppDynamics Machine Agent Service
regedit /S MachineAgent.reg
echo done.
echo Setting Service to AutoStart
sc config "AppDynamics Machine Agent Service" start= auto
echo Starting Service
sc start "AppDynamics Machine Agent Service"
pause

Edit the create and binPath values in this file for your environment.
create is an option of the sc command. The name of the service to create is
specified in quotes after the create option. If you change this name, you must
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also change the service name in the MachineAgent.reg and
UninstallService.cmd files.
"AppDynamics Machine Agent Service" in the example above
binPath is the path to the SRVANY.EXE Windows Resource
d:\AppDynamics\MachineAgent\srvany.exe in the example above
The service installed runs with the permissions of the user logged in
when service is created. To change the user running the installed
process, modify InstallService.cmd by inserting the following anywhere
before "pause" at the end of the file.
sc config <service> obj= <username> password=
<password>
Note: There is a required space between obj= and <username> .
c. Customize UninstallService.cmd

UninstallService.cmd - Uninstalls the Standalone Machine Agent Service
@echo off
rem UnInstall AppDynamics Machine Agent Service
echo "Stopping AppDynamics Machine Agent Service - maybe running"
sc stop "AppDynamics Machine Agent Service"
echo "Uninstalling AppDynamics Machine Agent Service from the Service
Manager"
sc delete "AppDynamics Machine Agent Service"
echo "done."
pause

stop and delete are options of the sc command. The name of the service to
stop or delete is specified in quotes after the stop or delete option. If you change
this name, you must also change the service name in the MachineAgent.reg
and InstallService.cmd files.
"AppDynamics Machine Agent Service" in the example above.
4. From the Windows Explorer, right-click InstallService.cmd and select Run as Administrator
.
To uninstall the Standalone Machine Agent as a service

This stops and removes the service from Windows.
1. From the Windows Explorer, right-click UninstallService.cmd and select Run as
Administrator.
Known Issues

In Windows Server 2003 you must install and start or stop the service from the console window. If
you do a normal RDP connection to the 2003s Terminal Services the service will be stopped when
you log-out. Therefore issue the command "mstsc /console <machinename>" to connect to the
console session of Windows Server 2003.
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Deploy the Standalone Machine Agent
Deploy Standalone Machine Agents

1. Download the latest Standalone Machine Agent ZIP file from http://download.appdynamics.com/
.
2. Unzip the downloaded file on the destination machine in the desired directories.
3. Modify the <MachineAgent Install Directory>/conf/controller-info.xml files to set the application
name, tier name, node name, Controller host and Controller port properties. The -D settings
allowed for Standalone Machine Agent are not the same as those for Java Agent. The only one
supported, agent.runtime.dir is described below.
4. Configure the startup script for the machine to start the Standalone Machine Agent every time
the machine reboots. For example, you could add the machine startup command to .bashrc.
To handle large values for metrics, run the Standalone Machine Agent using a 64-bit JDK.
Deploy Multiple Standalone Machine Agent Instances from a Common Directory

If want to deploy your agents from a common directory, such as an NFS mounted, shared
directory, you can launch the Standalone Machine Agent installation executable from multiple
servers which have access to the same NFS mounted, shared directory.
All properties common to the Standalone Machine Agents can be in the controller-info.xml file,
such as controller host, controller post, and account name.
Properties unique to each Standalone Machine Agent such as app name, tier name, node name
and log directory must be provided with -D parameters in the JVM startup script on each machine
that is running the Standalone Machine Agent such as the following:
java -Dappdynamics.agent.runtime.dir=<your_custom_log_dir>
-Dappdynamics.agent.applicationName=xyz -Dappdynamics.agent.tierName=123
-Dappdynamics.agent.nodeName=abc -jar machineagent.jar

You can use either of the following methods to specify where the log files for the agent should be
stored.
Add a Property to the JVM Startup Script

Add the following system property to the system properties of the JVM start up script for
the Standalone Machine Agent:
-Dappdynamics.agent.runtime.dir=<$Absolute-path-to-local-logs-directory>
Add an Element to controller-info.xml

Add the agent.runtime.dir element to specify the absolute path to the local logs directory
the <machine agent install directory>/conf/controller-info.xml file, but in this case you must also
edit the agent installation\logs\log4j.xml file to provide the absolute path to the local logs directory
as follows:
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Example log4j.xml entry
<appender name="FileAppender"
class="com.singularity.ee.agent.systemagent.SystemAgentLogAppender">
<param name="File" value="/opt/mypath/logs/agent.log"/>
<<<<<<<<<<<<<<<<<<<<<<<PATH TO LOCAL LOGS DIR HERE
<param name="MaxFileSize" value="5000KB"/> <param name="MaxBackupIndex"
value="5"/>
<layout class="org.apache.log4j.PatternLayout">
<param name="ConversionPattern" value="%d{ABSOLUTE} %5p [%t] %c{1}:%L %m%n"/>
</layout>
</appender>

Configure the Machine Agent to Automatically Start on Linux

Create a Start Script for the Machine Agent
To have the Machine Agent start automatically on Linux
Learn More
Create a Start Script for the Machine Agent

You can configure the Machine Agent to run automatically when the machine starts.
To have the Machine Agent start automatically on Linux

1. Create an initialization script that starts the Machine Agent, as in the example below:
#!/bin/bash
#
# Init file for AppDynamics Machine Agent
#
# chkconfig: 2345 60 25
# description: machine agent for AppDynamics
#CHANGE ME: Set to the Java install directory
JAVA="/path/to/java_home"
#CHANGE ME: Set to the agent's install directory
AGENT_HOME="/opt/AppDynamics/MachineAgent"
AGENT="$AGENT_HOME/machineagent.jar"
# Agent Options
AGENT_OPTIONS=""
#AGENT_OPTIONS="$AGENT_OPTIONS
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-Dappdynamics.agent.applicationName=<application-name>"
#AGENT_OPTIONS="$AGENT_OPTIONS -Dappdynamics.agent.logging.dir="
#AGENT_OPTIONS="$AGENT_OPTIONS -Dmetric.http.listener=true |
false
#AGENT_OPTIONS="$AGENT_OPTIONS
-Dmetric.http.listener.port=<port>"
#AGENT_OPTIONS="$AGENT_OPTIONS -Dserver.name=<hostname>"
#AGENT_OPTIONS="$AGENT_OPTIONS
-Dappdynamics.agent.tierName=<tiername>"
#AGENT_OPTIONS="$AGENT_OPTIONS
-Dappdynamics.agent.nodeName=<nodename>"
start()
{
nohup $JAVA $AGENT_OPTIONS -jar -Xmx32m $AGENT > /dev/null
2>&1 &
}
stop()
{
ps -opid,cmd |egrep "[0-9]+ java.*machineagent" | awk
'{print $1}' | xargs --no-run-if-empty kill -9
}
case "$1" in
start)
start
;;
stop)
stop
;;
restart)
stop
start
;;
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*)
echo "Usage: $0 start|stop|restart"
esac

In your script, set the JAVA and AGENT_HOME values to the paths for your system. Also
configure Agent options, as needed.
2. Enable execution permissions for the script. For example, given an initialization script
named machineagent, enter:
sudo chmod 775 machineagent

3. Place the script in the initialization directory on your system, typically /etc/init.d. Alternatively,
create a symbolic link to the script from the init.d directory to the script if you want to keep it in
another location.
4. Add the script as a service as follows:
On Red Hat and most Linux Operating Systems, run these commands, replacing "mac
hineagent" with the name of your file or symbolic link:
chkconfig --add controller
chkconfig --level 2345 machineagent on

On Ubuntu and Debian Operating Systems, run this command, replacing
"appdcontroller" with the name of your file or symbolic link:

update-rc.d -f machineagent start 99 2 3 4 5 .

In the command:
start is the argument given to the script (start, stop).
99 is the start order of the script (1 = first one, 99 = last one)
2 3 4 5 are the runlevels to start
Be sure to include the dot (.) at the end of the command.
The Machine Agent now starts automatically upon machine startup.
Learn More

Install the Standalone Machine Agent
Standalone Machine Agent Configuration Properties
Start the Controller Automatically on Linux
Configure the Machine Agent to Automatically Start on Windows
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To Configure the Standalone Machine Agent to Run Automatically on Windows Startup
Learn More
You can configure the Machine Agent to run automatically when the machine starts.
To Configure the Standalone Machine Agent to Run Automatically on Windows Startup

1. Make sure that Java is installed on the machine.
2. Create a batch file containing the following line:
java -Xms32m -jar <pathtomachineagent>/machineagent.jar

If your application uses a large number of AppDynamics extensions with the machine agent,
you may need to increase the size of the memory allocation as follows:
java -Xms64m -Xmx64m -jar <pathtomachineagent>/machineagent.jar

3.
4.
5.
6.
7.
8.

Click Control panel -> Scheduled Tasks.
Select the batch file to execute. This is the file created in step 2.
Create a new task.
Select When my computer starts.
Enter the administrator's credentials to run the Machine Agent as that user.
Click Finish.

To start the Machine Agent for the first time, right-click on the scheduled task, and click Run.

Learn More
Install the Standalone Machine Agent
Standalone Machine Agent Configuration Properties
Upgrade the Standalone Machine Agent
Planning the Upgrade
Upgrading the Standalone Machine Agent
To upgrade the Standalone Machine Agent
Planning the Upgrade

If you are upgrading both the Controller and agents, first upgrade the Controller and then upgrade
the agents.
Also, if upgrading multiple agents in your monitored environment, upgrade the agents for the tiers
on which business transactions are originated last. For more information about this requirement,
along with Controller and agent compatibility information, see Agent - Controller Compatibility
Matrix.
Upgrading the Standalone Machine Agent

Before starting, download the latest version of the Standalone Machine Agent from the AppDynami
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cs Download Center.
To upgrade the Standalone Machine Agent

1. Shut down the Standalone Machine Agent process. For help to identify the agent process,
see the info box below.
2. Create a backup copy of the current agent installation directory.
3. Extract the Standalone Machine Agent archive to a new directory
4. Rename the existing agent directory.
5. Rename the new directory to the original name of the old agent directory. The new agent
directory and its containing files should have the same directory path as the original one. Using
the same directory path avoids the task of manually changing agent-related configurations.
6. Modify the <Agent Install Directory>/controller-info.xml as appropriate. For information on the
properties you need to configure in the controller-info file, see Install the Standalone Machine
Agent.
7. Restart the Standalone Machine Agent.
When done you can archive the original directory and remove it from the application server home.

Which process is the machine agent process?
For Linux
Use the following command to identify which process is running the Standalone Machine
Agent.
ps -ef | grep machine

For Windows
Process Explorer is a free application from Microsoft that can help you identify the
Standalone Machine Agent process. When there are multiple java processes running,
hover over a java process in Process Explorer to identify the process that was started
using the machineagent.jar file.
For example, in Process Explorer, hover over a process to see information about how the
process was started as you can see in the following window:
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You can download Process Explorer at http://technet.microsoft.com/en-us/sysinternals/bb8
96653.aspx.

Database Monitoring
This section documents the new Database Monitoring functionality within AppDynamics Pro 3.9
that is under development. When drilling down to a database from the AppDynamics Pro GUI, you
will still be using the AppDynamics for Databases product, which is a standalone product that can
work in conjunction with AppDynamics Pro.

PLACEHOLDER FOR OVERVIEW VIDEO
Overview of Database Monitoring with
AppDynamics Pro
approximately 4 minutes
Database Monitoring Beta Release Notes
Known Issues

Get Started
Supported Environments and Versions for
Database Monitoring
Install and Get Started with AppDynamics
Database Monitoring
Introduction to AppDynamics for
Databases Monitoring
Setup Database Monitoring
Add a License
Add and Modify Database Collectors

Monitor
Use AppDynamics Database Monitoring
Monitor Databases

Troubleshoot and Resolve
Alert on Performance Metrics
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Create Health Rules

Administer Database Monitoring
Administer AppDynamics Database
Monitoring
Add a License
Add and Modify Database Collectors

Beta Disclaimer
This documentation mentions features that are currently beta. AppDynamics reserves the
right to change the features at any time before making them generally available as well as
never making them generally available. Any buying decisions should be made based on
features that are currently generally available.

Introduction to AppDynamics Database Monitoring
This section documents the new Database Monitoring functionality within AppDynamics Pro 3.9
that is under development. When drilling down to a database from the AppDynamics Pro GUI, you
will still be using the AppDynamics for Databases product, which is a standalone product that can
work in conjunction with AppDynamics Pro.
Today’s applications are increasingly complex. From the web user interfaces to the backend
databases and all services between, it's a big challenge for DevOps and DBAs to keep
applications running efficiently. AppDynamics Pro along with AppDynamics for Databases gives
you end-to-end visibility into the performance of your applications, helping you dramatically reduce
the time it takes to find and fix database performance issues.
Nearly all applications rely on a large database. Data volumes are constantly growing and usage
patterns and user volumes can suddenly change; any loss of performance can have damaging
consequences. In an Agile development environment, performance management is essential to
rapidly rolling out updates. Visibility into these ever-changing environments is critical to successful
operations.
AppDynamics Database Monitoring takes a time-based approach to monitoring, providing you with
visibility of the database performance over time. You can see the current performance of
connected sessions, drill down into SQL Explain plans and view database statistical information.
You can see what is happening now as well as what occurred over the last day, the last week or
the last month. The product answers important questions such as “What happened to the online
application yesterday to make it slow down?” and “Why is the overnight batch job still running this
morning at 8:55?”
AppDynamics Database Monitoring sorts database activity by efficiency, showing you the worst
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performing activities. You can immediately see potential problems, such as which SQL statement
or stored procedure is consuming system resources, which machine is experiencing lags, and
which programs are causing the bottlenecks. For example, AppDynamics for Databases shows
how much time is spent fetching, sorting or waiting on a lock.
AppDynamics Database Monitoring takes tiny sub-second snapshots and builds a complete
picture of what is happening on the database instance. This information tells you exactly what is
active within the instance and most importantly what SQL statements are executing. The depth of
data collected from AppDynamics Database Monitoring is comprehensive and allows detailed drill
down. An expert DBA can view the resource consumption profile of an instance, drill into
a performance spike, and then find the underlying root cause within seconds. When your SQL
code is running well, AppDynamics Database Monitoring shows this without requiring you to
analyze configuration parameters and metrics.

This documentation mentions features that are currently beta. AppDynamics reserves the right to
change the features at any time before making them generally available as well as never making
them generally available. Any buying decisions should be made based on features that are
currently generally available.

Top Five Features of a Database Monitoring Tool
There are many database monitoring tools available today, so choosing the right one can be time
consuming. Many traditional tools and methodologies of looking at database performance don't
work and many companies waste time and money looking at the wrong statistics.
This topic describes the features experts agree that an efficient and effective database monitoring
tool should provide. Proudly, AppDynamics for Database provides all these features.
Top Five Features of a Database Monitoring Tool

Low Overhead - Production safe and does not impact database workload.
Detailed Data Collection - Provides the details required to locate the root cause of performance
issues. The types of performance data that are the most useful are resource consumption and wait
event statistics; for example, how much CPU a program has used during a specific time period, or
which wait events were most prevalent during a problematic period. Other important information
pertains to statistics relating to the SQL statements; for example, how many buffer gets an Oracle
query initiates over time or per execution. The higher the number of buffer gets, the more
expensive the query is.
Current and Historical Data - Provides both current performance information and detailed
performance history, assisting in problem diagnosis after an event and facilitating performance
over time trend analysis.
Low Total Cost of Ownership - Easy to install, implement, and maintain.
Common GUI for all Database Types - Monitors and facilitates performance analysis of the most
prevalent enterprise databases with a common GUI.
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This documentation mentions features that are currently beta. AppDynamics reserves the right to
change the features at any time before making them generally available as well as never making
them generally available. Any buying decisions should be made based on features that are
currently generally available.

Install and Get Started with AppDynamics Database Monitoring
This section documents the new Database Monitoring functionality within AppDynamics Pro 3.9
that is under development. When drilling down to a database from the AppDynamics Pro GUI, you
will still be using the AppDynamics for Databases product, which is a standalone product that can
work in conjunction with AppDynamics Pro.
AppDynamics Database Monitoring can monitor the following databases:
MySQL
Oracle
SQL Server
Database Monitoring can monitor the following operating systems that host the database servers.
Windows
Linux
Solaris
The following topics help you install AppDynamics for Database Monitoring, and add and license
your database collectors.
Supported Environments and Versions for AppDynamics for Databases
Required Database Permissions
Setup Database Monitoring
Setup Database Monitoring on Windows
Setup Database Monitoring on Linux
Add a License
Add a Collector
Verify Collector Setup
This documentation mentions features that are currently beta. AppDynamics reserves the right to
change the features at any time before making them generally available as well as never making
them generally available. Any buying decisions should be made based on features that are
currently generally available.

Supported Environments and Versions for AppDynamics Database Monitoring
For large scale deployments, or where monitored systems are extremely busy, please contact
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AppDynamics Support for installation recommendations and assistance.
Systems that AppDynamics Database Monitoring Supports
Hardware Requirements
Software Requirements
Network Requirements
Compatible Operating Systems
Compatible Browsers
GUI Performance Considerations
Systems that AppDynamics Database Monitoring Supports

Once Database Monitoring is available, you can create collectors that run on the AppDynamics
Controller to monitor any of the following systems:
System Category

System Type

Version

MS SQL Server

2000, 2005, 2008, and 2012

MySQL

all versions including Percona
and MariaDB

Oracle

8i, 9i, 10g, 11g, and 12c

Linux Server

32-bit and 64-bit

Solaris Server

all versions

Windows Server

32-bit (will also work on 64-bit
systems)

Databases

Hardware Monitoring

Database Monitoring is accomplished by two components, the Database Agent and the
AppDynamics Pro Controller. The agent collects the data from the database server and passes it
to the AppDynamics Controller for interpretation and display in the Controller UI. The Database
Agent does not need to be installed on the same system hosting the database server.
Hardware Requirements

The Database Agent used for Database Monitoring can be installed on physical or virtual
machines.
Installation package: ? MB Windows, 47 MB Linux
Disk space usage after installation: 100 MB
Disk space required for historical data storage:
100 MB per database collector (for data retention period = 1 week)
10 MB per server collector (for data retention period = 1 week)
Minimum recommended hardware:
1-10 collectors: 2 GB RAM, Single CPU, 1 disk
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10-20 collectors: 4 GB RAM, 2 CPU cores, 1 disk
More than 20 collectors: 8 GB RAM, 4 CPU cores, fast disk
Minimum Memory requirements:
512 MB for AppDynamics Database Monitoring Repository
100 MB per collector
For information on hardware requirements of the AppDynamics Controller, see AppDynamics Pro,
Controller System Requirements.
Software Requirements

The Database Agent runs on a Java Virtual Machine. All JVMs version 1.5 to 1.8 are
supported.
Network Requirements

The machine on which the database is running or the machine you want to monitor must be
accessible from the machine where the Database Agent is installed and running. This
machine must have a network connection, internet or intranet.
If there is a firewall, the database listener port (and optionally the SSH or WMI port) must be
open.
Compatible Operating Systems

The Database Agent can run on the following operating systems:
Microsoft Windows platforms, including Windows 7 and Windows 8. The Database Agent is
compatible with both 32-bit and 64-bit servers. There is a different installation package for
each server type
Linux versions/platforms. 64-bit systems are supported. The Asynchronous I/O library, libaio
must be installed.
Compatible Browsers

For better navigation and performance, use Chrome or Safari.
Google Chrome 1.x and later
Safari 4.x and later
Mozilla FireFox 3.x and later
Internet Explorer 7.x and later
GUI Performance Considerations

The charts and reports within AppDynamics Pro are created with JavaScript; consequently, the
speed at which they are rendered depends on the performance of the JavaScript engine within the
Browser. For this reason, although AppDynamics Pro is supported on any browser, we
recommend using better performing browsers, such as Chrome and Safari.
Beta Disclaimer
This documentation mentions features that are currently beta. AppDynamics reserves the
right to change the features at any time before making them generally available as well as
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never making them generally available. Any buying decisions should be made based on
features that are currently generally available.

Required Database Permissions
Each monitored database requires permissions for the Database Monitoring user so that it can
gather important monitoring data. The database user is specified when you are adding a collector.
Before adding the collector, ensure a user for the collector is available with the required
permissions as stated below. The monitor user must be able to connect to the database remotely
from the machine running the Database Agent. The permissions required are database
dependent.
MySQL Database Permissions
SQL Server Database Permissions
Minimum Permissions Required for SQL Server Authentication
Oracle Database Permissions
For versions of Oracle prior to 10g
For versions of Oracle 10g and later
MySQL Database Permissions

The MySQL user the Database Agent uses to monitor the MySQL database, must have
"SELECT", "PROCESS", and "SHOW DATABASES" privileges on all databases.
If you do not have a suitable existing user, you can use a command such as the following to create
a new user; where “host” is the hostname or IP address of the machine running AppD4DB, and
“password” is a suitably secure password:
GRANT SELECT,PROCESS,SHOW DATABASES on *.* to 'appd4db'@'host' identified by
'password';
FLUSH privileges;

SQL Server Database Permissions

The SQL Server user AppDynamics Database Monitoring uses to monitor the SQL Server
database must be a SQL Server Authenticated user that is a member of the sysadmin server role
or a Windows Authenticated Account with sysadmin permissions. If you don't have access to
a SQL Server Authenticated user that is a member of the sysadmin server role, you can use the
procedure below to create a user with the minimum permissions required.
Minimum Permissions Required for SQL Server Authentication

Use the following to create a logon user that provides the minimal level of permissions required in
order to gain full AppDynamics Database Monitoring functionality.
1. Using SQL Server Management Studio, create a new login for AppDynamics Database
Monitoring.
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The user can be a Windows authenticated account (if monitoring via a Database Agent running on
Windows) or SQL Server authenticated. The above example displays a SQL Server authenticated
account.
Note: You must disable the Enforced password policy option as shown above. This account will
login in a non-interactive manner (via the Database Monitoring collector) and therefore will not be
able to modify its password at login.
2. From the User Mapping tab, map the new user to the master and msdb databases.
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3. Once you have created the login, give the following privileges to the user, substituting
<userName> with the name you specified on the Login - New window:
Note: You can execute the following as a batch from a query window in Management Studio.
use master
GRANT VIEW ANY DATABASE TO <userName>
GRANT VIEW ANY definition TO <userName>
GRANT VIEW server state TO <userName>
GRANT SELECT ON sys.sysaltfiles TO <userName>
GRANT execute on sp_helplogins TO <userName>
GRANT execute on sp_readErrorLog TO <userName>
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use msdb
GRANT SELECT on dbo.sysjobsteps TO <userName>
GRANT SELECT on dbo.sysjobs TO <userName>
GRANT SELECT on dbo.sysjobhistory TO <userName>

Oracle Database Permissions
For versions of Oracle prior to 10g

The permissions required for the Oracle user are:
CONNECT
SELECT ANY DICTIONARY
To create a user with these permissions, you can run the following SQL. In this SQL, change
"password" to a safe and secure password, and change the tablespace names, "users" and "temp"
to those available in your Oracle instance.
CREATE user appd IDENTIFIED BY password
default tablespace users
temporary tablespace temp;
GRANT CONNECT, SELECT ANY DICTIONARY, resource to app;

For versions of Oracle 10g and later

The permissions required for the Oracle user are :
CREATE SESSION
SELECT_CATALOG_ROLE
To create a user with these permissions, you can run the following SQL. In this SQL, change
"password" to a safe and secure password, and change the tablespace names, "users" and "temp"
to those available in your Oracle instance.
CREATE USER appd IDENTIFIED BY password
default tablespace users
temporary tablespace temp;
GRANT CREATE SESSION, SELECT_CATALOG_ROLE TO appd;

Beta Disclaimer
This documentation mentions features that are currently beta. AppDynamics reserves the
right to change the features at any time before making them generally available as well as
never making them generally available. Any buying decisions should be made based on
features that are currently generally available.
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Setup Database Monitoring
Multiple Database Agents
Do not install more than one instance of the Database Agent on the same machine for the
same account.
Although it is possible to install more than one Database Agent on the same machine
reporting to the same controller, AppDynamics does not recommend this. Metrics could be
multiplied by the number of Database Agents installed and there will be unnecessary
resource consumption due to running multiple agents.

Beta Disclaimer
This documentation mentions features that are currently beta. AppDynamics reserves the
right to change the features at any time before making them generally available as well as
never making them generally available. Any buying decisions should be made based on
features that are currently generally available.
Setup Database Monitoring on Windows

If you don't already have an AppDynamics Pro Controller and Database Agent installed, complete
steps 1 - 5, otherwise proceed to step 6.
1. Download AppDynamics Pro Controller. See Get Started with Application Intelligence
Platform.
2. Run the Controller installer application. The Controller starts up automatically at the end of
the installation.
3. Start the Events Service.
Open a cmd shell and enter the following substituting <controller install directory> with the
path to the directory where you installed the Controller.

cd <controller install directory>
bin\controller start-events-service.exe

4. Download the Database Agent for the same build as the Controller.
5. On a host that has network access to the database, unzip the dbagent, into a folder, named
dbagent for example.
6. Configure the Database Agent as follows:
Edit the file dbagent/conf/controller-info.xml, make sure your controller host, port, account
name, account access key settings are correct. Get the account access key from the
controller UI.
Once you have a Controller and Database Agent installed:
7.
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7. Obtain a license.lic file with Database Monitoring licensing from your sales or support
representative and put the license file in the same directory as where you installed the
Controller.
After placing the license in the directory, the Controller may take a minute or two to detect
the new license. Alternatively, you can restart the Controller to force it to detect the new
license.
8. Start the Database Monitoring agent. From the command line enter
java -jar <pathtodbagent>/db-agent.jar -cp "lib/"

9. In the Controller UI, select Database Monitoring from the left navigation menu and
configure the database collector. (The configuration depends on the specific database to be
monitored.)
10. Wait for a few minutes for metrics to come in and look at the databases list.
Troubleshooting:
Look at the dbagent log file: dbagent/logs/agent.log

Beta Disclaimer
This documentation mentions features that are currently beta. AppDynamics reserves the
right to change the features at any time before making them generally available as well as
never making them generally available. Any buying decisions should be made based on
features that are currently generally available.
Setup Database Monitoring on Linux

If you don't already have an AppDynamics Pro Controller and Database Agent installed, complete
steps 1 - 8, otherwise proceed to step 9.
1. Download AppDynamics Pro Controller. See Get Started with Application Intelligence
Platform.
2. Run the Controller installer application.
3. Once the controller is running, start the events service as follows:
cd controller
./bin/controller.sh start-events-service
4. Download the Database Agent for the same release as the Controller.
5. On a host that has network access to the database, unzip the Database Agent, into a folder,
named dbagent for example.
unzip -d dbagent dbagent-4749-master.zip
6. Configure the Database Agent as follows:
Edit the file dbagent/conf/controller-info.xml, make sure your controller host, port, account
name, account access key settings are correct. Get the account access key from the
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6.

controller UI.
7. Run the dbagent (as a background process)
cd dbagent
nohup java -jar db-agent.jar --classpath "lib/*" >& /dev/null &
Once you have a Controller and Database Agent installed:
8. Obtain a license.lic file with Database Monitoring licensing from your sales or support
representative and put the license file in the same directory as where you installed the
Controller.
After placing the license in the directory, the Controller may take a minute or two to detect
the new license. Alternatively, you can restart the Controller to force it to detect the new
license.
9. In the Controller UI, select Database Monitoring from the left navigation menu and
configure the database collector. (The configuration depends on the specific database to be
monitored.)
10. Wait for a few minutes for metrics to come in and look at the databases list.
Troubleshooting:
Look at the dbagent log file: dbagent/logs/agent.log

Beta Disclaimer
This documentation mentions features that are currently beta. AppDynamics reserves the
right to change the features at any time before making them generally available as well as
never making them generally available. Any buying decisions should be made based on
features that are currently generally available.

Add a License
You require a license for each database you want to monitor.
1. Obtain a license.lic file with your existing licenses plus the new database licenses you want
to add from your sales or support representative.
2. Put the license file in the same directory as where you installed the Controller.
After placing the license in the directory, the Controller may take a minute or two to detect
the new license. Alternatively, you can restart the Controller to force it to detect the new
license.
From the top menu bar click Settings
-> License to see information about the
AppDynamics licenses installed on your system.
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The License that appears will be similar to the following. This window shows all the licenses
available on the AppDynamics Controller.
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Beta Disclaimer
This documentation mentions features that are currently beta. AppDynamics reserves the
right to change the features at any time before making them generally available as well as
never making them generally available. Any buying decisions should be made based on
features that are currently generally available.
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Add and Modify Database Collectors
Adding a Collector
Change Collector Attributes
Complete the Database Connection Details Section
Complete the Hardware Collector Section
You can create AppDynamics Database monitoring collectors to monitor any of the following
systems:
Databases: MySQL, MS SQL Server, and Oracle
Operating Systems: Windows, Linux, Solaris, AIX, and NetApp
Adding a Collector

1. If this is the first collector you are adding, click Monitor New Databases in the Database
Monitoring section of the window.
If you have already added a collector, click the name of any database to open the Database
Monitoring window
.

2. From the left navigation menu, click Configuration and then click New.
3. In the Select a database type window, click the type of database that you want to start
monitoring and then click OK.
4. Complete each field of the Create a New Database Collector window and then click OK.
Your database administrator can provide you with the necessary details.
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4.

After you add a collector, the new collector appears on the Collector Administration window.

You will also now see your collectors on the AppDynamics Pro Home window.
Change Collector Attributes

To change any of the collector attributes, click its name in the Name column of the Collector
Administration window.
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The Edit Database Collector window appears where you can change the collector attributes
except the Type and Name attributes. The Edit Database Collector window is the same as the
Add Database Collector window, except the Type and Name attributes are locked on the edit
window.

Complete the Database Connection Details Section

Use the following to help you complete the fields of the Add
New Collector and Edit Collector windows. The fields that display depend on the type of collector
you selected.
The fields that appear differ depending on which type of database collector you are adding.
Name: (for all databases) Enter the name of the database exactly as it is appears on the
license. This name uniquely identifies the monitored instance as it appears in the Name column of
the Collector Administration window.
Hostname or IP Address: (for all databases) Specify the hostname or IP address of the machine
serving the database. The hostname or IP address appears in the Hostname column of
the Collector Administration window.
Listener Port: (for all databases) Specify the TCP/IP address of the port the database uses for
communicating with the AppDynamics Database Monitoring agent. The database list port appears
in the Listener Port column of the Collector Administration window.
SID or SERVICE_NAME: (for Oracle) Specify the services name or SID of the database to
monitor. Click either SID or SERVICE_NAME to indicate which database identifier you are using.
Failover Partner: (for Microsoft SQL Server) If you use Database Mirroring, enter the hostname of
the IP address of the Failover Partner here.
Connect as a sysdba: (for Oracle) Click if you want to connect as user sys and enable password
files. Running the collector using a sysdba account allows the collector to monitor an Oracle
instance in standby mode, an instance that is used for failover which is being replicated from the
main active instance.
Username: (for all databases) Specify the name of the user the Database Agent uses to connect
to the database. This user must have the Required Database Permissions
Password: (for all databases) Specify the password of the user the Database Agent uses to
connect to the database.
Complete the Hardware Collector Section

Monitor Operating System: Click if you want CPU consumption metrics collected from the
monitored host.
Operating System: Specify the operating system of the monitored host: Windows, Linux, Solaris,
AIX, and NetApp.
Hostname: Specify the hostname or IP address of the monitored host.
Domain: Specify the name of the domain where the monitored host is registered.
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SSH Port (Linux/Unix Only): Specify the Secure Shell (SSH) port number the Controller should
use for encrypted communications with the monitored host. The default port number of 22 will be
used if you do not specify a different port number here. AppDynamics also supports
certificate-based authentication via Privacy Enhanced Mail (PEM). To implement certificate-based
authentication, copy the PEM file to the <dbagentInstallDir>\agent directory.
Username: Specify the name of the user the Database Agent uses to log on to the monitored
host. To collect OS metrics from a Windows host, the configured user (or Collector Service user if
using Windows Authentication) must be able to establish a WMI connection to the target host and
collect Windows Performance Counters.
Password: Specify the password of the user the Database Agent uses to log on to the monitored
host. The number of echo characters shown in the password text field should not be interpreted to
imply the number of characters stored for the (encrypted) user password.

Beta Disclaimer
This documentation mentions features that are currently beta. AppDynamics reserves the
right to change the features at any time before making them generally available as well as
never making them generally available. Any buying decisions should be made based on
features that are currently generally available.
Verify Collector Setup

Congratulations you have set up your first collector!
Once the collector is up and running, in just a short time you can start viewing the historical activity
data.
The Collector Administration window now has a collector icon you can click to edit the details of
the collector if required. The collector will also appear in the list of Databases shown in the left
navigation menu. It might take a few minutes before the collector and its metrics are reported.

From the left navigation menu, click Databases to see a highlevel view of the activity of all the
configured collectors.
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Click the name of the database to see more details of the metrics AppDynamics Database
Monitoring has captured for you!
For information on using and interpreting the collector windows, see Use AppDynamics Database
Monitoring.
Beta Disclaimer
This documentation mentions features that are currently beta. AppDynamics reserves the
right to change the features at any time before making them generally available as well as
never making them generally available. Any buying decisions should be made based on
features that are currently generally available.

Use AppDynamics Database Monitoring
This section documents the new Database Monitoring functionality within AppDynamics Pro 3.9
that is under development. When drilling down to a database from the AppDynamics Pro GUI, you
will still be using the AppDynamics for Databases product, which is a standalone product that can
work in conjunction with AppDynamics Pro.

Access Database Monitoring
From the AppDynamics Home window, click the name of any database
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Use the Main Window
The Main Menu window links to all areas within the product:
The Main Menu toolbar gives you access to the Main Menu, Setup, Dashboard, Alerts,
and Help windows. The toolbar contents changes when you access the various features of
AppD4DB/
Quick buttons access Setup, Alerts, and the Multi-Instance Dashboard.
The Monitored Databases section lists all the databases being monitored by vendor. Each
row shows how many instances of the database platform are being monitored and the
version of the AppD4DB collector in use. Click the representative icon in the row for the
specific database platform to access the Activity windows for that specific database
technology.
This documentation mentions features that are currently beta. AppDynamics reserves the right to
change the features at any time before making them generally available as well as never making
them generally available. Any buying decisions should be made based on features that are
currently generally available.
The following topics provide in-depth information on using AppDynamics Database Monitoring.
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Administer AppDynamics Database Monitoring
This section documents the new Database Monitoring functionality within AppDynamics Pro 3.9
that is under development. When drilling down to a database from the AppDynamics Pro GUI, you
will still be using the AppDynamics for Databases product, which is a standalone product that can
work in conjunction with AppDynamics Pro.

This documentation mentions features that are currently beta. AppDynamics reserves the right to
change the features at any time before making them generally available as well as never making
them generally available. Any buying decisions should be made based on features that are
currently generally available.

Monitor Database Server Hardware
Hardware Metrics
When Hardware Monitoring has been configured for a database collector AppDynamics is
monitoring, AppDynamics gathers information about the operating systems and machines in the
monitored environment using the database agent The following metrics are collected:
CPU activity
Memory usage
Disk reads and writes
Network traffic
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You can click anywhere on the graphs to get details about activity at that point in time.

CPU Utilization

This trend displays CPU usage percentage over time.
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Memory Utilization

This graph displays memory used over time.

Disk I/O

This graph displays disk input and output for data in kb over time.

Network I/O

This graph displays network input and output in kb/sec over time.
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Accessing Hardware Metrics
In addition to the graphs of hardware metrics available on Databases->Dashboard You can view
hardware metrics from the Hardware tab of the Node Dashboard if a machine agent is installed on
the machine that hosts the node.
You can also view hardware metrics in the Metric Browser in the Hardware Resources branch of
a tier, as shown in this example.

Beta Disclaimer
This documentation mentions features that are currently beta. AppDynamics reserves the
right to change the features at any time before making them generally available as well as
never making them generally available. Any buying decisions should be made based on
features that are currently generally available.

Database Monitoring Beta Release Notes
AppDynamics Pro 3.9 provides a beta version of Database Monitoring.

This section documents the new Database Monitoring functionality within AppDynamics Pro 3.9
that is under development. When drilling down to a database from the AppDynamics Pro GUI, you
will still be using the AppDynamics for Databases product, which is a standalone product that can
work in conjunction with AppDynamics Pro.

Known Issues
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Although it is possible to install more than one Database Agent on the same machine
reporting to the same controller, AppDynamics does not recommend this. Metrics could be
multiplied by the number of Database Agents installed and there will be unnecessary
resource consumption due to running multiple agents.

This documentation mentions features that are currently beta. AppDynamics reserves the right to
change the features at any time before making them generally available as well as never making
them generally available. Any buying decisions should be made based on features that are
currently generally available.

Platform Release Notes
3.9.x Updates
3.9.4 Updates
Controller
Node.js Agent
.NET Agent
EUEM
Licensing
Analyze
Web
EUEM On-Premise Processor
Dev Ops
Resolved Issues
3.9.3.2 Updates
Resolved Issues in 3.9.3.2
3.9.3.1 Updates
Resolved Issues in 3.9.3.1
3.9.3 Updates
.NET Agent
Controller
Java Agent
Node.js Agent
Dev-Ops
EUEM On-Premise Processor
Web EUEM
Mobile EUEM
Resolved Issues in 3.9.3
3.9.2.3 Updates
Resolved Issues in 3.9.2.3
3.9.2.2 Updates
Controller
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3.9.2 Updates
Controller
DevOps
Java Agent
.NET Agent
Node.js Agent
EUEM Licensing
Web EUEM
Mobile EUEM
Resolved Issues in 3.9.2
3.9.1.1 Updates
Controller
Resolved Issues in 3.9.1.1
3.9.1 Updates
Controller
Node.js
Resolved Issues in 3.9.1
New and Enhanced Features in 3.9
End User Experience Management
Web End User Experience Management Updates
Mobile End User Experience Management Updates
Controller Updates
Installation and Platform Changes
Policies and Alerts
User Interface
Custom Dashboards
Java Agent Updates
.NET Agent Updates
PHP Agent Updates
Node.js Agent Updates
Agent-Controller Compatibility Matrix
Security Notes
Security Vulnerability Addressed
Edit Widget Functionality XSS Vulnerability Addressed
CVE-2014-3120
SSL Certificate Monitoring Extension
Controller Notes
Installation Notes for the Controller
Known Issues for Installation
MySQL Shut Down Failure on Windows as a service
.NET Framework 3.5 Requirement Issue
Upgrade Notes for the Controller
Non-English Language Setting Workaround
Mobile APM Notes
App Agent for Java Notes
.NET Agent Notes

Copyright © AppDynamics 2012-2014

Page 2154

Deprecation Notice
This topic covers release information for AppDynamics Pro versions 3.9.x.
If you are reading this in PDF format, many links will open in the product documentation wiki.
AppDynamics continuously improves its product documentation. The most current release notes
are on the wiki at Platform Release Notes.

3.9.x Updates
3.9.4 Updates
Controller

The Controller installer now checks to ensure that its bitness (whether 32 or 64 bit) matches
that of the operating system before performing an installation or upgrade. It presents an
error if the 32-bit installer is used on a 64-bit system or the 64-bit installer on a 32-bit
system.
Node.js Agent

The Node.js Agent supports Node.js version 0.10.32.
.NET Agent

The .NET Agent now includes finer-grained agent-level security settings. See the Default
Profiler Element on .NET Agent Configuration Properties.
EUEM
Licensing

Behavior corrected in situations where an attempt is made to provision a license when a
license already exists.
Analyze

Format for Analyze queries has been updated
Web

Error message added when there is an error downloading resource details
Potential race condition in JavaScript Agent on Firefox 25 corrected
Additional detail displayed in map of Poland in Geo Dashboard
EUEM On-Premise Processor

The HTTP and HTTPS beacon ports for the EUEM Processor are now configurable in the
installer. Previously the installer set the ports to port 80 and 443 respectively. If you have set
up a reverse proxy, changing the ports requires an update to the adrum.js file after upgrade.
You can now configure an HTTPS port as the Processor listening port in the installer. The
port number is 7002, by default. For instructions on setting up the keystore for the
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Processor, see Install the On-Premise End User Experience Management Processor.
If you are upgrading an existing EUEM installation, it is important to note the following
change made by the installer. During upgrade, if the existing HTTP or HTTPS port on which
the EUEM Processor listens is 80 or 443 (or another port that requires root permissions to
open the port on the machine), the installer requires you to change the port numbers. Be
sure to change the port number to one that does not require root permissions for a process
to open, such as the default numbers 7001 or 7002.
Dev Ops

Health rules which cannot currently be evaluated (when a necessary metric is not available,
when a necessary baseline is not available, when a new health rule has just been added, or
when the system has just restarted) are now displayed with a status of "Unknown"
Resolved Issues

Component/S

Summary

.NET Agent

Fixed an issue with HTTPClient backend
naming

.NET Agent

Fixed an issue instrumenting BizTalk Service

.NET Agent

Fixed an issue with Unattended Install when
the AD_SetupFile path contains a space

Agent

Fixed an issue with tracking jobs in Tibco
BusinessWorks

Controller-DevOps

Handle Health Rule data unavailability
gracefully "Unknowns"

Controller-DevOps

ASW with HRs selection fails to work as
expected

Controller-EUM

Fixed an issue with the display of resource
timings in EUM Browser snapshots

Controller-APM, Controller-EUM

Fixed an issue selecting EUM-related metrics
for custom dashboards

Controller-Platform

Fixed an issue with remediation scripts

EUMCloud, UI

Added more granularity to Poland geo
locations

EUMCloud

Allow specifying http and https port during
install of on-prem processor

EUMCloud

Provide stop command for stopping eum
processor on Windows

Installer

Fixed Known Issue when running the
Controller installer from a shell launched by
the su command
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Node.js Agent

Business transactions correctly display call
graph icons, which is only when a process
snapshot was captured in the same time range
as the transaction snapshot

UI

Agent Internal events are no longer displayed
by default on Controller UI

UI

Issue with script timeouts on BT List using IE9
and IE10

3.9.3.2 Updates
Resolved Issues in 3.9.3.2

Component

Summary

UI/EUEM

Page Composition data now correctly displays
on the Page Dashboard - fixes a UI regression
in 3.9.3

3.9.3.1 Updates
Resolved Issues in 3.9.3.1

Component

Summary

Controller-DevOps

Reduces the activity an enabled entity logger
on a controller records in the FINE logs for
com.appdynamics.RULES.PROCESSING.

3.9.3 Updates
.NET Agent

Previous versions of the .NET Agent required that you instrument executable Windows
services as standalone applications. Now the agent allows you to instrument them as
Windows services.
Controller

The static stall threshold option is no longer available across agent types, including PHP
and Node.js Agent. For more information, see the update notes for release 3.9.2.1. If you
had a static stall threshold configured prior to 3.9.3, when you upgrade your PHP or Node.js
agent your static stall threshold will automatically change to a standard deviation of 300.
A security vulnerability affecting version 3.9.x Controllers has been addressed. Note that
version 3.8.x and earlier Controllers are not affected by this vulnerability. If using a 3.9.x
version of the Controller, it is strongly recommended that you upgrade to 3.9.3.
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Java Agent

Java Agent performance problems that occur when JDBC backend naming rules are
changed to non-default values have been fixed.
URLs now appear in the URL entry point column of the snapshot list for transactions
originating in Apache Synapse Enterprise Service Bus (ESB).
Node.js Agent

Error reporting has been improved. The agent now reliably reports errors for unhandled
exceptions. You can restrict the errors that are reported and counted by configuring errors to
be ignored. See Configure Error Detection for Node.js.
When you monitor nodes in a cluster, to reduce overhead you can configure them to use a
multi-tenant proxy by setting all agents to use the same proxy. This involves setting the
control directory for the agents that will share a proxy and proxy script, and then starting the
proxy manually. See Set Up A Multi-Tenant Proxy for Node.js Agents.
See also the Controller update regarding static stall thresholds.
Dev-Ops

Health rules with very long names fired but did not show up in the Health Rule Violations
List. They are now visible.
Can now fire policies based on custom events,including by property, if desired. See Configu
re Policies.
Can now add custom event "type" and key/value properties to custom events. See Use the
AppDynamics REST API.
Can now filter events based on custom events in the Events dashboard. See Filter and
Analyze Events.
Can now post a custom event to a tier, node, and/or business transaction. See Use the
AppDynamics REST API.
Can now customize the name of a multi-tenant controller as it shows up in notifications for a
single tenant. See Use the AppDynamics REST API.
EUEM On-Premise Processor

When you are installing the EUEM On-Premise Processor, avoid permissions issues by
using localhost rather than the host name or the IP address in the Database Information
setup screen, in Demo mode, and in the Database Information setup screen for the
Controller host, in Production mode. See Install the On-Premise End User Experience
Management Processor.
It is now possible for users to specify the beacon HTTP and HTTPS ports for the controller if
the installation is not using a reverse proxy. See Install the On-Premise End User
Experience Management Processor.
Web EUEM

The User Data field in the Browser Snapshot was accidentally removed as the page was
migrated from FLEX to HTML. It is now visible in the page.
Assisted Injection Using Attribute Injection for MVC Razor Version 5 is now supported. See
Supported Environments and Versions - Web EUEM.
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A potential race condition using Firefox 25 has been resolved.
The JavaScript agent downloaded from the Getting Started agent wizard now has the
correct port numbers.
The Lite version of Web EUEM now includes the following features: Geo-Dashboard,
Page/Iframe List, and Usage Stats for the previous 24 hour period for up to 500 million page
views. Access via APIs is supported. See Web EUEM License.
Clicking on the Geo-Dashboard tab now navigates to appropriate page.
End User Experience in left navigation bar refreshes more quickly.
Mobile EUEM

The Lite version of Mobile EUEM now provides the Crash Dashboard and Crash Snapshots,
the latter covering the previous 365 days. It covers up to 5 million devices. See Mobile
EUEM Licenses.
End User Experience in left navigation bar refreshes more quickly.
Resolved Issues in 3.9.3

Component/s

Summary

.NET Agent

Blacklisted instrumentation of certain
assemblies.

.NET Agent

.NET Agent now supports multiple information
points on the same method.

.NET Agent

.NET Agent now detects HttpClient.GetAsync
exit points.

.NET Agent

WCF service/operation name now shows in
the Exit Call window.

.NET Agent

Fixed an issue with ASP.NET service
endpoints.

Agent

Memory leak no longer occurs when using
custom JMX metric rules.

Agent

URL now displays in snapshot for Apache
Synapse.

Agent

There is no longer any performance
degradation with non-default JDBC
configuration.

Agent

Instrumentation no longer causes
java.lang.Throwable:
java.lang.ClassCircularityError.

Agent

Servlet Splitting on custom expression now
works with 3.8.5 agent and above.
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Agent

EUM auto injection configuration now works
when notxdetect=true is received from struts.

Agent

Stall standard deviation threshold no longer
miscategorizes transactions.

Controller

Can now post an event to a tier, or to a
particular node via REST API.

Controller

Can now create policies based on Custom
Events.

Controller

JMX metrics now display correctly.

Controller

Email alerts now point to the correct Controller
URL.

Controller

Fixed application and Business Transaction
flow map rendering issue.

Controller

Controller metric cache issues no longer
causes gaps in data on UI.

Controller

Health rules with long names fire now display
in Health Rule Violations.

Controller

Status light widget is now working in custom
dashboard.

Controller

Business Transactions are now shown in "End
User Experience" request page.

Controller

Special characters in MySQL root password
no longer break controller.bat and
controller.sh.

Controller

Default logging location for Controller
analytics-processor modified.

Controller

There are no longer problems with computing
rollups when a subset of agents are not
reporting any data.

Docs

You can now view the video on the App list.

EUMCloud

Information is now correct for Blackberry
devices in EUM.

EUMCloud

The EUEM web agent downloaded from the
Getting Started area of the UI now has the
correct port numbers.

EUMCloud

EUM installer now checks that the EUEM
database account can be created.

Copyright © AppDynamics 2012-2014

Page 2160

EUMCloud

NullPointerException no longer appears in the
crash processor.

EUMCloud, UI

Redefined EUEM Lite entitlements for Web
and Mobile.

EUMCloud, UI

Clicking on GeoDash tab now navigates to the
correct window.

Node.js Agent

Uncaught exceptions are now reported as BT
errors if the BT context can be established or
as application errors if there is no BT context.

Node.js Agent

tmpDir is now derived from a hash of controller
host, controller port, application name, tier
name, and node name.

Node.js Agent

Added a ctrlDir setting to the options in the
profile statement that has precedence over the
default "folder schema" in /tmp/appdynamics.
This directory is auto-created if not available.

PHP Agent

A null pointer exception introduced in the
upgrade from 3.9.0 to 3.9.2.1 that prevented
metrics from being reported in some
circumstances was fixed.

UI

Improved resizing left nav bar response.

UI

Switching locations no longer resets your
browser choice.

UI

SEP Configuration screen now flows smoothly.

UI

[MhSS] Clone Delete and Archive buttons on
the horizontal panel.

UI

Drilling down to specific URL now works in
Custom Dashboards on Chrome and Internet
Explorer.

UI

Strengthened authorization controls.

UI

[Custom Dashboard] Added a column Tier on
graph properties and series.

UI

Drilling down from alert emails to Node/Tier
now works correctly.

UI

App/BT Dashboard and flow map now displays
fully when the screen is maximized.

UI

Improved agent download using Getting
Started Wizard.
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UI

Improved End User Experience to prevent it
from hanging.

UI

Improved Transaction Scorecard display.

UI

Charts at bottom of flow maps now show
correct time ranges.

UI

BT list no longer has filters open by default.

UI

User Data is now displays properly in browser
beacon's snapshot view.

UI

Improvements to Custom Events API ensure
they show up correctly in the Events
workspace.

UI

You can now have Policies filter on custom
events.

3.9.2.3 Updates
Resolved Issues in 3.9.2.3

Component

Summary

Controller

Custom Dashboards no longer blank in UI
after Controller upgrade to 3.9.2.2 build 43
from 3.8.5.1

Controller, UI

Node level flow map now shows links between
tiers

UI

Flow map now shows inbound async calls

3.9.2.2 Updates
Controller

Addresses a security vulnerability that affects 3.9.x Controllers. Controllers versions 3.8.x
and earlier are not affected by this vulnerability.

3.9.2.1 Updates
Static stall thresholds are no longer available. The change has the following effect on Java
and .NET agents by version:
Agents version 2.x support dynamic thresholds. All stall configuration that were static
will be changed to standard deviation threshold of 300.
Agents versions 3.0 through 3.7.21.1 do not support dynamic thresholds. If static stall
threshold was enabled for those agents, they are reverted back to 45-second static
thresholds.
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Agents version 3.8 and above support dynamic thresholds. If stall configuration was
disabled for transactions prior to upgrading, you will experience no impact.
Addressed a XSS security vulnerability in the edit widget functionality. For more information,
see the Security Notes.

3.9.2 Updates
Controller

The modifyJvmOptions utility has been enhanced to provide additional error handling if
adding duplicate system parameters. Also, the command for listing existing Java Options in
the domain configuration has been added for the Windows version of the utility. To use it,
enter:
modifyJvmOptions.bat list

For more information about modifyJvmOptions, see Modify GlassFish JVM Options
DevOps

Previously action suppression created unnecessary event traffic to the database. This has
been removed. All information continues to be logged.
Previously setting up action suppression events showed in the UI only the top level entity
and not any children that might also be affected. Children are now shown. See Action
Suppression.
Java Agent

Introduces a new Java Agent node property, disabled-features. This property specifies data
collection mechanisms that should be disabled at the agent, allowing application owners to
limit data reported by the agent for security or privacy reasons. For more information, see di
sabled-features in the App Agent Node Properties Reference.
.NET Agent

The log-request-payload node property includes logging for HTTP parameters in WCF calls.
Configure async backend detection and thread correlation separately.
Object instance tracking no longer requires you to install Microsoft CLR Memory
Diagnostics.
Node.js Agent

The Node.js Agent supports Node.js version 0.10.31.
The Node.js Agent supports node-redis v12.X.
EUEM Licensing

Known Issue: If you add an EUEM license to an existing application, you may need to log
out of the controller and log in again before the Configure->Instrumentation->End User
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Experience tab correctly shows that you are currently licensed for End User Monitoring.
Web EUEM

AD-X-Forwarded-For header added to allow customer to specify the IP address to use for
geo resolution. See Use a Custom Geo Server For Web EUEM.
Schema for custom Geo server updated as part of new header support. See Use a Custom
Geo Server For Web EUEM.
Status column removed from Browser Snapshots list. See Browser Snapshots.
Ajax Dashboard now includes With Load checkbox. See The Ajax Dashboard.
DOM Ready location in all snapshots now correctly located.
Mobile EUEM

@InfoPoint annotation added to simplify creating Information Point extensions to Android
mobile instrumentation. See Customize Your Android Instrumentation.
Custom Data tab now includes With Load checkbox. See Monitor Custom Data.
EUEM Account Name now visible on License Panel. See Instrument an iOS Application and
Instrument an Android Application.
Resolved Issues in 3.9.2

Component

Summary

Agent

Agent node backend limit exceeded

Agent

Java Agent Scala support — JVM throws
malformed class name due to scalac bug

Agent

Spring RMI instrumentation not applied

Agent

Servlet split using POST request parameters
not working

Controller

Issues using modifyJvmOptions utility when
adding proxy host and port Java properties

Controller

Event email body has
${eventInfo.getEventMessage()}

Controller

Action Suppression object scope (runtime)
screen does not show full information

Controller

restoreJvmOptions.bat fails on Windows
Controller

.NET Agent

Custom correlation configuration subsections
do not inherit supersection values

.NET Agent

Error in onMethodEndTracked:
System.OverflowException: Arithmetic
operation resulted in an overflow

Copyright © AppDynamics 2012-2014

Page 2164

.NET Agent

Async tracking: Web Service
BeginXXX/EndXXX callback logic is missed in
the snapshot

UI

Add checkbox to show BT / Ajax with Load

UI

Status of "Completed" for EUM snapshots is
confusing

UI

Resource waterfall should show idle time in a
different color

UI

Selecting an entry in Processes tab scrolls the
list back to top

UI

Fix computation of DOM Ready Time

UI

Inconsistent filter UX in mobile Custom Data;
missing "Load" filter

3.9.1.1 Updates
Controller

Resolves an issue that permitted users with custom roles to access applications in the UI for
which their roles have not been intentionally granted permission. This issue affected any
Controller upgraded from 3.8.x and earlier to 3.9.x, and resulted from the upgrade process
inadvertently granting custom dashboard permissions by default to all custom roles.
If you have manually modified the custom dashboard permissions for roles, you should
verify and if necessary reapply your manual changes after completing the upgrade
to 3.9.1.1.
Resolves an issue that caused Controller upgrade on Windows to sometimes fail with an
error message of “Unable to restore JVM options.” This happens if the
modifyJVMOptions.bat utility has been previously used to modify domain.xml settings on the
Controller instance.
Resolved Issues in 3.9.1.1

Component

Summary

Controller

Users allowed to view un-permitted
application.

Controller

Upgrade fails on Windows Controller due to
changes by modifyJVMOptions.bat

3.9.1 Updates
Controller

If a policy is deleted while there are open incidents associated with the policy or modified so
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that the health rule is no longer in violation, the health rule violation incident is canceled.
Previously, the canceled event was not available as an actionable event and not evident in
the event browser UI. You can now configure notifications for the canceled event.
Node.js

The Node.js Agent supports Node.js version 0.10.30.
Resolved Issues in 3.9.1

Component

Summary

Agent

IndexOutOfBoundsException exception
generated due to cross-tier correlation errors
when business transaction limit is exceeded

Controller

JRE bundled with installer updated to 1.7 to
match Controller JRE version

Controller

Unused security certificates generate errors in
the Controller server log

Analytics (Event Service)

Disable dynamic scripting in bundled
Elasticsearch

New and Enhanced Features in 3.9
The following components have new and enhanced features in release 3.9.

End User Experience Management
On-prem version of EUEM Processor (previously known as the EUEM Cloud) now
supported
Expanded percentile support across the UI
Known Issue: The installer does not return control to the command prompt after installation
and startup of the production mode EUEM Processor on Windows is complete. As a result,
after installation, you cannot log off from the terminal session without terminating the EUM
processor. For more about EUEM Processor installation, see Install the On-Premise End
User Experience Management Processor.
Web End User Experience Management Updates

Resource timing details in browser snapshots
Beta: on-demand synthetic snapshots
Beta: faceted search on full data event store
Mobile End User Experience Management Updates

Updated crash dashboard, using faceted search on full data event store
Crash grouping on crash dashboard
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APIs for creating custom metrics, timers, and information points in mobile agents
New tab for displaying custom data

Controller Updates
Installation and Platform Changes

The Controller installer contains an additional configuration option, the location of an Elastic
Search file store. The file store is used by the Event Service, which is used by Database
Monitoring.
The Controller administration script now includes additional command options for stopping
and starting the Event Service on the Controller. The Event Service is not started by default.
The command options are start-events-service and stop-events service. For example to start
the Event Service on Linux, run the script from the bin directory under the Controller home,
as follows:
./controller.sh start-events-service

On Windows, from an elevated command prompt, run:
controller.bat start-events-service

Policies and Alerts

Instead of suspending health rule evaluation after a health rule violation for a period of time,
the Controller now continues to evaluate violating health rules every minute. It throttles
actions for a continuing condition using the new health rule violation events, "Health Rule
Violation Continues - Warning" and "Health Rule Violation Continues - Critical". For more
information, see Health Rules.
User Interface

HTML5 pages and flow maps as follows:
HTML5 flow maps for the Application and Business Transaction dashboards. The new flow
maps include better automatic layout, filtering by performance data, updated visual design,
and more.
Business Transaction List
All Applications Dashboard
Custom Dashboards

Grid Layout option: This is the default option for creating custom dashboards. Grid layout
gives you a flexible layout that is easy to rearrange on the canvas. Grid layout also scales in
size when viewed on mobile devices. See Create a Custom Dashboard.
Custom Dashboard Templates: This special type of custom dashboard is a template that en
ables you to create a dashboard which can be reused effortlessly across different nodes and
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tiers without remapping metrics.

Java Agent Updates
Business Transaction Discovery assists you in instrumenting your applications. Within this
tool you can see the business transactions being captured, modify the auto-discovery
business transaction detection criteria or the configuration you are currently using, view the
expected results of these changes, and repeat the change/view process until you are
satisfied with the results. Then you can choose to apply the changes if you want. To help
you decide what types of transactions you should monitor, you can use Class/Method
Browser within the Business Transaction Detection tool that provides full visibility into the
classes and methods detected, including snapshots of those transactions.
Percentile Metrics configuration can now be accomplished through the Controller.
Callgraphs can now be configured to capture slow transaction collections through the
Enable Aggressive Slow Snapshot Collection option. This feature is enabled by default.
When enabled, this feature ensures that full call graphs are captured for business
transactions monitored using Java Agent.
jdbc-resultsets App Agent for Java node property: Use this property to indicate the
implementation classes of the java.sql.ResultSet interface that should be instrumented.
New Platforms supported:
Oracle Java SE 8
Oracle Java Message Service 2.0
WebSockets 1.0
Teradata all versions
See Supported Environments and Versions for Java.

.NET Agent Updates
The .NET Machine Agent takes machine snapshots that capture critical details about CPU
usage, memory usage, and the IIS queue on a server at a specific moment in time.
The .NET Machine Agent reports CLR crash events.
The .NET Agent supports service endpoints.
The .NET Agent supports object instance tracking. See Monitor Memory Usage with Object
Instance Tracking for .NET for prerequisites and usage.
See Supported Environments and Versions.

PHP Agent Updates
The installer now writes controller information to the PHP configuration files (php.ini
or appdynamics_agent.ini depending on your setup), instead of to controller-info.xml. If you
need to modify controller information settings post-installation, do so in the PHP
configuration files. The old controller-info.xml file is no longer used.
Existing customers should update their environments to reflect this change. If you use an
automated release process to install and update your app agent, modify that procedure to
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write the controller information properties to the ini file. If you create or modify agent settings
via apache, set them accordingly at the apache.conf level.
See Controller Information in the PHP Configuration Files.
HTTP Data Collectors are now supported for the PHP agent. See Data Collectors and Confi
gure Data Collectors.
Information points, which provide business metrics and code metrics, are now supported.
See Configure Information Points for PHP.
A version (-v) option has been added to the installer to specify the version of PHP being
instrumented. Required only if the default install directory is not used.
A multi-tenant proxy has been implemented. Formerly a separate proxy was started for each
app server. Now multiple agents report to a single proxy.

Node.js Agent Updates
AppDynamics introduces the new Node.js application agent. This agent was in beta prior to
3.9. A 3.9 controller is required.
A multi-tenant Java proxy has been implemented. The agent now supports a Node.js
application running in cluster mode and reports each child process as a unique node in the
controller.
The root node in the process snapshot call graph no longer includes the idle time.
Custom match and exclude rules can be configured for Node.js business transactions. See
Configure Transaction Detection for Node.js.
Business transaction configurations by default provide an exclude rule for static content,
such as as images, CSS files, JavaScript files, and static HTML pages, so that business
transactions are no longer automatically detected for this type of content. You can view and
modify this rule in the business transaction configuration screen.
Business transaction invocation details are available in process snapshots. See the
BUSINESS TRANSACTIONS tab in View Process Snapshots.
In the summary of business transaction snapshot, you can link to the call graph of the
associated process snapshot if there is one.
New metrics for CPU usage, memory, and I/O are available per Node.js process. See Node.
js Process Metrics.
Exit call information is now available in transaction snapshots. See the EXIT CALLS tab in Vi
ew Process Snapshots.
If you are running EUEM or Mobile APM and server-side correlation has been set up for
those agents, correlation is available between associated web browser / mobile data and
Node.js business transactions. This means that a business transaction link in a browser or
mobile snapshot takes you to the flow map for the associated business transaction on the
Node.js side. You may also occasionally transaction snapshots linked with associated
browser/mobile snapshots, but this is not common for the Node.js agent.

Agent-Controller Compatibility Matrix
The Controller supports older Agents. Newer Agents will not work with an older Controller
version. See the Agent - Controller Compatibility Matrix.
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Security Notes
The following sections list general security information for AppDynamics. For release-specific
security information, see the update notes for that release.

Security Vulnerability Addressed
Release 3.9.2.2 and 3.9.3 address security vulnerabilities affecting 3.9.x Controllers. Controllers
version 3.8.x and earlier are not affected by the vulnerabilities.

Edit Widget Functionality XSS Vulnerability Addressed
Release 3.9.2.1 address a cross-site scripting vulnerability exposed by the edit widget functionality.

CVE-2014-3120
Release 3.9.1 addresses CVE-2014-3120 by modifying the default Elastic Search configuration to
disable dynamic scripting.

SSL Certificate Monitoring Extension
The SSL Certificate Monitoring Extension is a new extension on the AppDynamics eXchange that r
eports the expiration date of SSL certificates on the machine as a metric to the Controller. The
extension reports the certificate expiration date metric for the domains and at the interval you
configure.
For more information, see the SSL Certificate - Monitoring Extension listing.

Controller Notes
The following notes apply to on-premise Controller users. You can download the Controller for
installation on premises from the AppDynamics Download Center.
Installing or upgrading the Controller on any Windows system that does not use English as its
system language will fail. For the workaround, see Non-English Language Setting Workaround
.
An exception may appear in the logs on startup indicating that an Apache .jar file is missing.
This is harmless and the exception can be ignored.
An exception sometimes occurs during application configuration export.
The Controller installation or upgrade may fail to complete if a loopback entry is missing
from the hosts file. This error is sometimes indicated by an error message in the installer
screen output similar to the following:
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Failed to reach Controller at
http://127.0.0.1:<port>/controller/createAccount?action=ping!

Where <port> is usually an ephemeral port number.
If the Controller installation or upgrade fails, verify that your hosts file includes a mapping
between the loopback address (127.0.0.1) and the hostname of your system. The hosts file
is typically found in the /etc/hosts directory in Linux systems, and
C:\Windows\System32\drivers\etc on Windows.
The mapping in the hosts file should look something like:
127.0.0.1 localhost <your-hostname>
If the entry is missing, back up the existing hosts file, add the localhost mapping, and try
upgrading or installing again. You can get the actual hostname you need to map by entering
the hostname command on Linux, or entering "ipconfig /all" at the Windows command
prompt.

Installation Notes for the Controller
Before you install or upgrade the Controller, validate the hardware requirements as listed at
Controller System Requirements. The sizing requirements have been updated and now
include recommendations based on metrics per minute in addition to the number of nodes in
the installation. Features such as monitoring asynchronous threads and End User
Monitoring increase the number of metrics per minute flowing to the Controller.
AppDynamics strongly recommends that you install the Controller on a dedicated machine
for adequate stability and performance.
The disk space requirements differ for each of the Controller performance profiles. Verify the
disk space requirements for your performance profile at Controller System Requirements.
If installing on Windows, note the operational and configuration guidelines listed in Install the
Controller on Windows for preventing the possibility of Controller data corruption due to
conflicts with existing Windows processes. Also note the workaround if installing or
upgrading a Windows machine that does not use English for its regional settings, see Non-E
nglish Language Setting Workaround.
Known Issues for Installation

The Controller installation may fail to complete if a loopback entry is missing from the hosts
file. See known issues in the previous section for more information.
Fixed in 3.9.4: Running the Controller installer from a shell launched by the su command may
cause Controller installation or upgrade to fail with errors indicating that the process was unable
to create or write to database files.
This error results from the installer attempting to perform database update operations as the
user associated with environment settings rather than the one specified by the su command
(usually the root user).
To work around this issue, invoke the su command with a dash character (“su -“). This
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causes the user environment settings for the shell to be updated with the identity specified
by the su command.
.NET 3.5 features are required in some cases to install the Controller as a Windows service.
If you try to install the Controller as a service, the following error appears: "The following
feature couldn't be installed: .NET Framework 3.5". See .NET Framework 3.5 requirement
issue for more information and a workaround.
When the MySQL database is registered and running as a Windows service and the host
machine is shut down or rebooted, Windows may kill the service before it has finished
shutting down gracefully. See MySQL Shut Down Failure for more information and a
workaround.
After installation, the Controller log server.log contains error messages logged at the
severity level SEVERE indicating that certificates have expired. The certificates are unused
by the Controller, and it is safe to disregard the errors.
MySQL Shut Down Failure on Windows as a service

When the MySQL database is registered and running as a Windows service and the host machine
is shut down or rebooted, Windows may kill the service before it has finished shutting down
gracefully.
If this occurs, MySQL will consider its databases crashed and will perform crash recovery
operations the next time it starts up. This crash recovery may result in the MySQL startup
exceeding the Windows service startup timeout. If this happens, then the Controller app server
will fail to start automatically.
This issue is due to Microsoft service manager default timeouts that are too short for the MySQL
shutdown operation and MySQL crash recovery on startup.
To work around this issue, modify the WaitToKillServiceTimeout and the ServicesPipeTimout
settings in the registry, as described below.
Note that there is a bug in Windows 7 and Server 2008 R2 that causes the service manager to
ignore WaitToKillServiceTimeout. If using Windows 7, or Server 2008 R2, the following hotfix must
be installed before performing the workaround: http://support.microsoft.com/kb/2549760.
To check for the presence of KB2549760 hotfix, run the following command in an elevated
command prompt, (run as administrator):
wmic qfe list | findstr KB2549760

View and set WaitToKillServiceTimeout
To see the current WaitToKillServiceTimeout setting, run the following command in an elevated
command prompt (run as administrator):
reg query HKLM\SYSTEM\CurrentControlSet\Control /v
WaitToKillServiceTimeout
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The time out is reported in milliseconds.
To set the WaitToKillServiceTimeout to the recommended value, 10 minutes, enter the command:
reg add HKLM\SYSTEM\CurrentControlSet\Control /v
WaitToKillServiceTimeout /t REG_SZ /d 600000 /f

View and set ServicesPipeTimeout
Extending the ServicesPipeTimeout setting allows MySQL crash recoveries and long Controller
application server startups to be handled gracefully. We strongly recommend that you extend this
setting as well.
The following command gets the current value of ServicesPipeTimeout (note that this registry key
may not be present on all systems):
reg query HKLM\SYSTEM\CurrentControlSet\Control /v
ServicesPipeTimeout

The following command sets ServicesPipeTimeout to two hours:
reg add HKLM\SYSTEM\CurrentControlSet\Control /v ServicesPipeTimeout
/t REG_SZ /d 7200000 /f

.NET Framework 3.5 Requirement Issue

Feature of the .NET 3.5 Framework are required in order to install the Controller as a Windows
service. .NET Framework 4.0 alone may not be sufficient. If you try to install the Controller as a
service, the following error appears: "The following feature couldn't be installed: .NET Framework
3.5".
This occurs on the following versions of Windows Server:
Server 2012
Server 2012 R2
The following instructions assume the use of Windows Server operating systems (which have the
Windows Server Manager). If you encounter this issue on a non-server version, such as Windows
8, you need to download the .NET 3.5 executable and perform the equivalent installation.
To install .NET 3.5 features:
1. As a user in the Administrators group on the local computer, open Windows Server
Manager.
2. Select "Add Roles and Features" and click Next.
3. Click Next until you get to the Server Selection screen.
4. Select the server on which you want to install the Controller as a service.
5. Click Next in the Server Roles.
6. In the Select features screen, expand .NET Framework 3.5 Features and select .NET
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6.
Framework 3.5. Keep the .NET Framework 4.0 option selected.
7. Click Install.

You can now install the Controller as a service as described in the documentation.

Upgrade Notes for the Controller
For all major upgrades, AppDynamics recommends that you upgrade both the Controller
and Agents. This ensures that you get all the latest Agent features and fixes.
If you are upgrading both the Controller and the Agents, first upgrade the Controller then
upgrade the Agents.
Make sure that you have saved a backup of the following files before starting the upgrade
procedure:
<Controller_Installation-Directory>/db/db.cnf
<Controller_InstallationDirectory>/appserver/glassfish/domains/domain1/config/domain.x
ml
<Agent_Installation_Directory>/conf/controller-info.xml
If you are applying the upgrade by passing a response file to the installer, you must pass the
response file generated by the installer at first installation. This response file is at
.install4j/response.varfile under the Controller home directory. Make sure that the settings in
the file reflect any configuration changes you have made since installation.
Known issue: An issue prevents you from changing the database port number at upgrade
time if using a response file. If you set a different database port in the response file,
response.varfile, from the one used by the Controller, the installation times out while
attempting to start the database.
Known issue: In certain scenarios, the Controller upgrade on Windows may fail with an error
message of “Unable to restore JVM options.” This happens if the modifyJVMOptions.bat
utility has been previously used to modify domain.xml settings on the Controller instance. If
you encounter this error on an attempted upgrade, upgrade to 3.9.1.1 or contact AppDynami
cs Support for the workaround.
Known issue: The Controller upgrade may fail to complete if a loopback entry is missing
from the hosts file. See known issues in the previous section for more information.
For more information, see Upgrade the Controller.

Non-English Language Setting Workaround
When installing or upgrading the Controller on Windows systems that use a regional and language
setting other than English (United States), the Controller installation or upgrade fails. The error
message may indicate that the Controller database failed to start or that the setup processes failed
to reach the Controller. The error occurs when the installer is attempting to start the Controller, and
causes the installer to abort the installation or upgrade.
To work around this issue:
1. Change the regional and language setting on the system to English (United States).
2. Perform the upgrade or installation.
3. When the upgrade or installation is finished, edit the
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3.
<Controller_installation_directory>\bin\controller.bat and replace the following line:
IF %TIME% == %START_TIMEOUT% (

With:
IF "%TIME%" == "%START_TIMEOUT%" (

This line appears in the :startControllerDB section of the file. Notice the addition of quotes
around both values used in the value comparison.
4. Save your changes.
5. Change the regional and language settings back to its original value.

Mobile APM Notes
Known Issue: the Mobile Geo Dashboard may time out if there are a large number of apps
and large amounts of data.
The Mobile APM Agent increases the number of metrics reported, which may affect the
hardware requirements for an on-premise controller. See Additional Sizing Requirements.

App Agent for Java Notes
Obtain the AppDynamics App Agent for Java download for your system from the AppDynamics
Download Center:
For Sun and JRockit JVMs, download AppServerAgent-x.x.x.zip
For IBM JVMs, download AppServerAgent-ibm-x.x.x.zip
For more information see:
Install the Java Agent
Java Server-Specific Installation Settings
App Agent for Java Configuration Properties
Known Issue: the new JVM Guard feature may not consistently report JVM crashes.

.NET Agent Notes
Obtain the AppDynamics App Agent for .NET download for your system from the AppDynamics
Download Center:
For Windows 32-bit, download dotNetAgentSetup.msi
For Windows 64-bit, download dotNetAgentSetup64.msi
For more information see:
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Install the .NET Agent
.NET Agent Configuration Properties
Resolve .NET Agent Installation and Configuration Issues
Configure the .NET Machine Agent

Deprecation Notice
AppDynamics will no longer support Microsoft’s Internet Explorer 8 effective October 2014 for the
Controller user interface. Deprecation of IE 8 becomes necessary as the Controller UI makes
increasing use of rich, dynamic HTML 5.
Who does this affect?
All SaaS customers accessing AppDynamics Controller environments will need to upgrade
their Internet Explorer browser to a newer version, or use another supported browser
platform.
On-premise customers deploying versions of AppDynamics Controllers shipped after
October 2014 will need to upgrade their Internet Explorer browser to a newer version, or use
another supported browser platform.
AppDynamics will continue to support IE 8 on Controllers from earlier releases.
This does not affect EUM clients. The JavaScript Agent will continue to capture End User
Experience metrics from IE 8 browsers.

Agent - Controller Compatibility Matrix
Java Agent - Controller Compatibility
App Agent for .NET - Controller Compatibility
App Agent for PHP - Controller Compatibility
App Agent for Node.js - Controller Compatibility
AppDynamics for Databases - Controller Compatibility
SSL Compatibility between Java Agent and Controller
Learn More
AppDynamics agents are not backwards compatible with the AppDynamics Controller. The
Controller version must be equal to or greater than the versions of any agents connecting to
it. This page describes compatibility mappings between the Controller and older versions of the
agents.
A monitored environment may have agents of different versions deployed in it at a given time, as
long as all agents are compatible with the Controller version. However, in this environment the
oldest agents should be on the originating tiers of any business transactions. This ensures that
agents on downstream nodes can process the correlation header created by the originating tier.
This is an important point to consider when rolling out agent upgrades: be sure to start upgrading
the agents on the nodes of downstream tiers first, and then upgrade the agents on the originating
tier nodes last.
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Java Agent - Controller Compatibility
The Controller supports older agents. Prior to 3.6.2, newer agents will not work with an older
Controller. 3.6.2 and newer agents will work with the Controller that has the same major and minor
version (X.x).
The 3.9 Controller supports the following versions of the Java Agent:
3.5.2 - 3.5.7
3.6.0 - 3.6.7
3.7.x
3.8.x
3.9.x
For the notes on SSL protocol compatibility between versions of the agent and Controller, see SSL
Compatibility Matrix for App Agent for Java - Controller.

App Agent for .NET - Controller Compatibility
The Controller supports older Agents. Prior to 3.6.2, newer agents will not work with an older
Controller. 3.6.2 and newer agents will work with the Controller that has the same major and minor
version (X.x).
The 3.9.x Controller supports the following versions of the App Agent for .NET:
3.5.3 - 3.5.7
3.6.0 - 3.6.7
3.7.x
3.8.x
3.9.x

App Agent for PHP - Controller Compatibility
The 3.9.x Controller supports the following versions of the PHP Agent:
3.7.7 and newer 3.7.x
3.8.x
3.9.x

App Agent for Node.js - Controller Compatibility
The 3.9.x Controller supports the following versions of the Node.js Agent:
3.8.5 +
3.9.x

AppDynamics for Databases - Controller Compatibility
The 3.8.x Controller supports the following versions of AppDynamics for Databases:
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3.6.0 - 3.6.7
3.7.x
3.8.x
Note: AppDynamics for Databases version 2.7.4 is required for AppDynamics for Databases to
correlate with the App Agent for PHP.

SSL Compatibility between Java Agent and Controller
The default protocol used by the Controller and Java Agent are:
Controller: TLSv1.2
Java App Agent:
For Java 8 SE applications, TLSv1.2.
For Java 7+ applications, TLSv1.2. You can change the agent to use SSLv3 if desire.
See Security for information on changing the default security protocol used by the
Controller or agent.
For Java 5/6 applications, SSLv3. You must enable SSLv3 connection on the
Controller if the agents connect directly to the Controller. See Security for information
on changing the default security protocol used by the Controller or agent.
The default SSL protocols for the Controller and agent changed in 3.8.x. See Agent - Controller
Compatibility Matrix in the 3.8 documentation for SSL compatibility information for previous
versions.

Learn More
Supported Environments and Versions
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